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EKTRON INC. SOFTWARE LICENSE AGREEMENT
Important: ** READ THIS BEFORE LOADING SOFTWARE**

1. License: Licensor hereby grants to Licensee a worldwide, fully paid, royalty free, irrevocable non-exclusive license (the
“License”) to use the following Software:

CMS400.NET [specify Professional with number of URLs and seats, or Enterprise Package with Unlimited Users and
Unlimited URLs on a single server]

The Software is licensed for use only in delivered code form. Delivered code is defined as the code base delivered by the
Licensor to the Licensee and is comprised of Ektron’s compiled and un-editable source code as well as additional modifiable
and customizable code layers. Each copy of the Software is licensed for the number of seats, URLs, or servers listed above.
Any use of the Software beyond the number of authorized seats or servers contained in the Professional or Enterprise
Package as provided herein shall cause this license to terminate. Should Licensee wish to add seats or servers beyond the
Professional / Enterprise Package, Licensee may add seats or servers at the then current price for additional seats.

For purposes of this section, the term “seat” shall mean an individual user provided access to the capabilities of the
Software. A “server” should be defined as a specific physical or virtual server managed by the software.

Licensee may not modify, alter, reverse engineer, disassemble, or decompile the Software. The Software is licensed, not
sold.

2. Duration: This License shall continue so long as Licensee uses the Software in compliance with this License. Should
Licensee breach any of its obligations hereunder and the License is terminated in accordance with Section 6 hereof,
Licensee agrees to return all copies of the Software and this License upon notification and demand by Licensor.

3. Copyright: The Software (including any images, “applets,” photographs, animations, video, audio, music and text
incorporated into the Software) as well as any accompanying written materials (the “Documentation”) is owned by Licensor
or its suppliers, is protected by United States copyright laws and international treaties, and contains confidential
information and trade secrets. Licensee agrees to protect the confidentiality of the Software and Documentation. Licensee
agrees that it will not provide a copy of this Software or Documentation nor divulge any proprietary information of Licensor
to any person, other than its employees or contractors, without the prior consent of Licensor; Licensee shall use its best
efforts to see that any user of the Software complies with this License.

4. Limited Warranty: Licensor warrants that the Software will perform in all material respects in accordance with the
description in the RFP response submitted by Licensor to Licensee and that the Software will be free from defects in material
and workmanship under normal, proper and intended usage for a period of three (3) months from the date of purchase.
Licensor warrants that the Software at the time of purchase will be free of malicious code and disabling code and shall not
infringe on the intellectual property rights of any third party. Except as provided in the preceding sentence, Licensor does
not warrant the use of the Software will be uninterrupted or error free, nor that program errors will be corrected. This
limited warranty shall not apply to any error or failure resulting from (i) machine error, (ii) Licensee's failure to follow
operating instructions, (iii) negligence or accident, or (iv) modifications to the Software by any person or entity other than
Company. In the event of a breach of warranty, Licensee’s sole and exclusive remedy is repair of all or any portion of the
Software. If such remedy fails of its essential purpose, Licensee’s sole remedy and Licensor’s maximum liability shall be a
refund of the paid purchase price for the defective Software only. This limited warranty is only valid if Licensor receives
written notice of breach of warranty no later than thirty days after the warranty period expires.

5. Limitation of Warranties and Liability: EXCEPT AS SET FORTH IN SECTION 4, THE SOFTWARE AND DOCUMENTATION ARE
SOLD “AS IS” AND WITHOUT ANY WARRANTIES AS TO THE PERFORMANCE, MERCHANTIBILITY, DESIGN, OR OPERATION OF
THE SOFTWARE. NOWARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED. EXCEPT AS DESCRIBED IN SECTION
4, ALL WARRANTIES EXPRESS AND IMPLIED ARE HEREBY DISCLAIMED. NEITHER LICENSOR OR ITS SUPPLIERS SHALL BE
LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS OR GOODWILL, LOSS OF DATA OR USE OF DATA, INTERRUPTION OF
BUSINESS NOR FOR ANY OTHER INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY KIND UNDER OR
ARISING OUT OF, OR IN ANY RELATED TO THIS AGREEMENT, HOWEVER, CAUSED, WHETHER FOR BREACH OF WARRANTY,
BREACH OR REPUDIATION OF CONTRACT, TORT, NEGLIGENCE, OR OTHERWISE, EVEN IF LICENSOR OR ITS
REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS.

6. Indemnification:

(a) General. Except as otherwise expressly provided, each Party to this agreement shall defend, indemnify and hold
harmless the other Party and any of the other Party’s agents, employees, and invite es against all claims, liability, loss and
expenses, including reasonable costs, collection expenses, court costs and attorney’s fees, which may arise because of the
negligence, misconduct, or other fault of the first Party in the performance of its obligations under this agreement.



(b) Indemnification for Infringement. Licensor will, at its expense, defend, and indemnify Licensee against any actual or
threatened action or proceeding by a third party (a “Claim”) that the Software infringes a United States patent or copyright
of any third party, and will pay all losses, liabilities, damages and claims and all related costs and expenses (including
reasonable attorneys' fees, litigation, settlement, judgment, interest and penalties) either awarded by a court or agreed to
in an out-of-court settlement approved in advance in writing by Licensor. Licensor may, at its option, either procure for
Licensee the right to continue using the Software or replace or modify the Software so that it becomes non-infringing. If,
in Licensor’s reasonable business or legal opinion, neither option is feasible, Licensee will return the infringing Software
to Licensor, the License will be terminated and Licensor will reimburse Licensee a full refund. If Licensee elects to
continue using the Software rather than return it to Licensor, Licensor will have no further liability to Licensee. Licensor
will not indemnify Licensee for infringement if Licensee has modified the Software without Licensor’s assistance.

(c) Indemnification Procedures. If Licensee becomes aware of a Claim that may require indemnification, Licensee will
promptly notify Licensor in writing of the Claim and will allow Licensor to assume sole and full control of the defense and
settlement of the Claim. Licensee will provide Licensor with reasonable assistance and information necessary to defend
and settle the Claims. Licensee’s counsel will have the right to participate in the defense and settlement of the Claim, at
Licensee's own expense.

9. Assignment: Both parties shall be entitled to assign this Agreement in whole or in part, and its rights and obligations
hereunder, without advance notice and without cost, to any current and future parent, subsidiary or affiliate of such
assigning party and to a business entity in connection with a merger, or sale or contribution of some or all of its assets.
Written confirmation notice of any assignment will be given by the assigning party to the other party to this Agreement as
soon as commercially reasonable. Otherwise, all rights and obligations are not assignable without prior written consent of
the other party, which consent shall not be unreasonably withheld.

10. Transfer: Upon completion of payment for the software referenced herein the Licensee shall receive perpetual, non-
expiring license keys for their production environment. Once delivered to the Licensee, these keys exist in perpetuity in
the Licensee’s possession. In the event that the Licensee requests a change to the perpetual keys referenced above,
Licensor requires a mutually signed license transfer document and Licensee must remit a license transfer fee equal to
thirty (30) percent of the initial license purchase cost.

11. Miscellaneous: This Agreement and its performance and all claims arising from the relationship between the parties
contemplated herein shall be governed by, construed and enforced in accordance with the laws of the State of Missouri
without regard to conflict of laws principles thereof. The parties agree that any action brought in connection with this
Agreement shall be maintained only in a court of competent subject matter jurisdiction located in the State of Missouri or
in any court to which appeal there frommay be taken. The parties hereby consent to the exclusive personal jurisdiction of
such courts in the State of New Hampshire for all such purposes. The United Nations Convention on Contracts for the
International Sale of Goods is specifically excluded from governing this License. If any provision of this License is to be
held unenforceable, such holding will not affect the validity of the other provisions hereof. Failure of a party to enforce any
provision of this Agreement shall not constitute or be construed as a waiver of such provision or of the right to enforce
such provision. This Agreement may not be modified other than in a writing signed by both parties. This Agreement and
the Schedules hereto represent the entire understanding between the parties with respect to its subject matter. This
Agreement may be executed in counterparts, each of which shall be deemed an original and which together shall
constitute one document. Facsimile copies of signatures shall be acceptable as originals.

LICENSEE HEREBY ACKNOWLEDGES THAT IT HAS READ THIS AGREEMENT AND THAT IT UNDERSTANDS THIS
AGREEMENT.

Copyright 1999 - 2009 Ektron, Inc. All rights reserved. LA10031, Revision 3.0
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Securing Ektron
CMS400.NET

Security Checklist
Complete this a checklist to secure Ektron CMS400.NET.

For the latest updates to Ektron’s security guidelines, see
http://dev.ektron.com/kb_article.aspx?id=30982.

This section also contains the following topics.

Change the Admin and Builtin Users’ Passwords v
Remove Sample Users and Sample Membership Users vi
Removing CMS400.NET Users vi
Removing Membership Users vii
Do Not Allow the Use of Group User Accounts vii

Change the Admin and Builtin Users’
Passwords
Make sure you change the password for the Admin and Builtin user.

Change Admin user password

Change the Admin user’s password in the Workarea by following these steps.

1. In the Workarea, navigate to Settings > Users

2. Click the Admin user.

3. Click the Edit Users button.

4. In the Password and Confirm Password fields, enter the new
password.

5. Click the Save button.

Change builtin user password

Warning! If you changed the builtin user password during the site setup, you do not need to
change it again. See Additional Information on page vii for additional information.

Warning! The “builtin” user does not appear in the Users list. This user appears on the
application setup screen.

Change the builtin user’s password in the Workarea by following these steps.

1. In the Workarea, navigate to Settings > Configurations > Setup.

2. Click the Edit button.

Securing Ektron CMS400.NET
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3. Find the Built In User field.

4. In the Password and Confirm Password fields, enter the new
password.

5. Click the Update button.

Note: If you cannot sign in to Ektron CMS400.NET because the builtin user password was
changed and you don’t know the new password, use the BuiltinAccountReset.exe utility. This
resets your Ektron CMS400.NET user \ password to Builtin \ Builtin. This utility is located in
C:\Program Files\Ektron\CMS400versionnumber\Utilities.

Remove Sample Users and Sample
Membership Users
Some sample users and sample membership users are included with Ektron
CMS400.NET for evaluation and demonstration purposes. These users should be
removed when they are no longer needed.

CMS users have access to the Workarea. They can be content authors,
administrators or even developers who need access to information in the
Workarea. These people count towards the number of users in your license.

Membership users are typically people who only interact with your Web site.
Membership users are a category of users who have limited privileges to Ektron
CMS400.NET. They cannot use the Workarea and do not count towards the
number of users in your license.

Remove Sample Users and Sample Membership Users

Warning! Some users in this list might not appear in your User list. Also, you might have sample
users that appear in your users lists. This depends on which version of the software you have
installed.

Ektron CMS400.NET Users Membership Users

jedit

tbrown

jsmith

vs
See Also:Managing Users and User
Groups on page 15-1

jmember

member@example.com

north

supermember

west
See Also:Membership Users and Groups
on page 16-3

Removing CMS400.NET Users
To remove Ektron CMS400.NET users in the Workarea, follow these steps.

vi ReferenceManual
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1. In the Workarea, navigate to Settings > Users.

2. Click the check box next each user you want to remove.

3. Click the Delete button ( ).

4. Click OK in the dialog box that appears.

Removing Membership Users
To remove Membership users in the Workarea, follow these steps.

1. In the Workarea, navigate to Settings > Community Management
> Memberships > Users.

2. Click the check box next each user you want to remove.

3. Click the Delete button ( ).

4. Click OK in the dialog box that appears.

Do Not Allow the Use of Group User
Accounts

Do Not Allow the Use of Group User Accounts

A group account is an account that multiple people use to log in to Ektron
CMS400.NET using the same username and password. This is a serious security
issue it prevents you from tracking user activities in your Workarea. Group
accounts violate Ektron CMS400.NET's license agreement.

Additional Information
You do not need to make these changes if you are using the Ektron CMS400.NET
for demonstration or evaluation purposes. These changes should be completed
once the decision is made to purchase the product and go live with your site.

Warning! Ektron recommends creating your own Administrator user and deleting the Admin
user. Also, delete unnecessary users from Ektron CMS400.NET.

The Everyone Group
By default, the root folder in Workarea provides the Everyone Group with all
permissions except Overwrite Library. Ektron recommends reviewing the
permission needs of the Everyone Group when you add a folder. See Also:
Folder Permissions on page 4-40

RemovingMembership Users
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ServerControlWS.asmx

Best Practice
For improved security, Ektron recommends renaming or removing theWeb services
file when youmove it to your production server. After installation, this file is named
ServerControlWS.asmxand resides in thewebroot/siteroot/Workarea folder.

ServerControlWS.asmx is the Web service that enables the server controls interact with
Ektron CMS400.NET. The path is coded in theweb root/web.config file. This is how it
appears:
<!-- Web Service URL for Server Controls design time --> <add key="WSPath"
value="http://localhost/CMS400Developer/Workarea/ServerControlWS.asmx" />

Edit this line if you change the location or name of the ServerControlWS.asmx file.
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Installing Ektron
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System Requirements
The following components are required when developing or viewing an Ektron
CMS400.NET based application.

n Server Requirements below

n PC Client Requirements on the facing page

n Apple Macintosh Client Requirements on page 1-4

Server Requirements
Component Requirements

Recommended hardware
configuration

n Intel® Core 2 or Greater

n 4GBRAM or higher

n RAID array for hard drives

Web server operating system

MicrosoftWindowsServer 2008

n 32 and 64 bit versions

Microsoft ®Windows® Server 2003

n 32 and 64 bit versions

MicrosoftWindows

n Windows7

n Vista Business&Ultimate

MicrosoftWindowsXPProfessional

Note: Only useWindowsXP for testing and development. Do not use it
on your production server.

Web application server Microsoft .NET™ Framework3.5 SP1

Web server Microsoft® Internet Information Server (IIS) 6.0 or higher

File System NTFS (FAT 32 isnot supported)

Database

n Microsoft SQL™Server 2008

n Microsoft SQL™Server 2005 SP2 and higher (including Express
version)

Warning! Ektron CMS400.NET doesnot support case sensitive
databases.

Note: VirtualServers are not recommended for database
environments.

Installing Ektron CMS400.NET
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PC Client Requirements
Component Requirements

Operating
system

n Any IBM-PC compatible system runningWindows, including Vista® Ultimate, Vista®
BusinessandWindows7

- minimum 166MHzwith at least 64MB RAM

n MacOSX

Browsers for
viewing

Allmajor browsers including:

n Mozilla Firefox

n Microsoft ® Internet Explorer 6.0 or higher

n Google Chrome

n Apple Safari

Browsers for
editing

n Mozilla Firefox (but see FirefoxSupport Summary)

n Microsoft ® Internet Explorer 7.0 or higher

Note: Only released versionsare supported.

Warning! If using Firefox, uncheck theBlock Popup Windows setting. To access this
setting, go to Tools > Options > Content.

Hardware

Suggestedminimum requirements: Pentium 166MHzor faster with at least 64MBof RAM

Note: If a client computer is 64-bit, you cannot use eWebEditPro to create Smart Forms.
To create Smart Formson a 64-bit machine, youmust use Release 8.0 or higher and the
eWebedit400 editor.

Web
development
tools

n VisualStudio 2005 / 2008

n VisualWebDeveloper 2005 / 2008 Express

For Web site development

n VisualC# 2005/2008 Expressand VisualVB 2005 Express

For Plug-in Extensions creation

n Adobe Dreamweaver

PC Client Requirements
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Apple Macintosh Client Requirements
Component Requirements

Operating system MACOSX

Browsers for viewing

Allmajor browsers including:

n Microsoft ® Internet Explorer

n Mozilla Firefox

Browsers for editing n Mozilla Firefox

Hardware AppleMacintosh

Note: Ektron does not guarantee support of beta releases for components listed above.

Installing Ektron CMS400.NET
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License Keys

Introduction
Ektron controls the use of Ektron CMS400.NET through a license key, a unique
code assigned to your domain when you purchase Ektron CMS400.NET. Your
license key is included in the email that Ektron sends when you request or
purchase Ektron CMS400.NET.

This section also contains the following topics.

License Key Types 1-5
License Key Format 1-6
Inserting the License Key 1-6
Changing License Keys Upon Upgrade 1-6
WebImageFX License Keys 1-7
License Key Check 1-7
Invalid License Key Message 1-7
Using Ektron CMS400.NET without a License Key 1-7
Domains in which You Can Use the License Key 1-8
Register Domains, not IP Addresses 1-8
More Information 1-8

License Key Types
There are three levels of license keys available for use with Ektron
CMS400.NET. The features that are available in your specific version of Ektron
CMS400.NET depend on the license key you purchase. The table below shows
the major features at each level.

Feature Enterprise Professional Standard

Analytics

Document Management

eCommerce Optional Optional

eSync Optional

Multi-site Optional

License Keys
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Feature Enterprise Professional Standard

Personalization

SocialNetworking

XLIFF Support

AllOther Ektron CMS400.NET Features

Important: An Ektron CMS400.NET license key cannot be used with Ektron eIntranet, and vice
versa. The two keys are not interchangeable.

License Key Format
A license key typically begins with a base URL (domain name, computer
network name, or IP address) followed by descriptor tags, a question mark, a
series of numbers, a hyphen and one or two digits signifying release number.
For example:

dev.mysite.com(exp-2008-10-25)(modifiers)(users-10)?51510837796786063064924334416-XX

License keys cannot contain spaces or line breaks.

Inserting the License Key
If you download the executable (.exe) file, you are prompted to enter a license
key during installation. If you choose not to install the license key during the
installation, you can enter it by navigating to Workarea > Settings > Setup and
clicking the Edit button. Once you are in edit mode, add the license key to the
License Key(s) text box.

Changing License Keys Upon Upgrade
If you upgrade to a new release of Ektron CMS400.NET and want to replace the
old license key with a new one, navigate to Workarea > Settings > Setup and
click the Edit button. Once you are in edit mode, add the license key to the
License Key(s) text box. On the other hand, if you want to add new keys in
addition to old keys, create a comma delimited list of keys in the License Key(s)
text box.

When cutting and pasting license keys, keep the full license key intact without
adding or deleting characters. License keys that are changed in any way render
Ektron CMS400.NET inoperable.

Installing Ektron CMS400.NET
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WebImageFX License Keys
If you are installing WebImageFX with Ektron CMS400.NET, a WebImageFX
license key is included in the email you receive when you purchase Ektron
CMS400.NET. A WebImageFX key resembles a Ektron CMS400.NET key but
includes the string wifx.

To add the key to Ektron CMS400.NET, navigate to Workarea > Settings >
Setup and clicking the Edit button. Once you are in edit mode, add the license
key to the Module Licenses text box.

License Key Check
When you login to a Web site that contains Ektron CMS400.NET, it checks the
license key(s) against the domain.

If the URL of a valid license key matches the URL of the site being accessed, the
Workarea appears.

If no valid license key is found for the URL of the site being accessed, Ektron
CMS400.NET is disabled and you must log in the with Builtin account to change
the License Key.

Invalid License Key Message
If you have a broken license key or a license key with an incorrect base URL, an
error message appears in the Ektron CMS400.NET Login window. The message
states, “Error: A license violation has occurred and the application is presently
locked. Please see your administrator.”

If this message appears, you can login with the Builtin account and reenter your
license key. If the message continues to appear and you are sure you have a
valid key, contact Ektron Support.

Using Ektron CMS400.NET without a
License Key
For evaluation purposes, when you install Ektron CMS400.NET, you do not need
a license key. During the installation process, leave the License Key field blank
and click the next button on the License screen. This allows you to use
CMS400.NET as localhost.

WebImageFX License Keys
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Domains in which You Can Use the License
Key
The license key is assigned to your base URL, which is typically your domain
name. For example, if your domain name is www.mycompany.com, the license
key follows this pattern:
www.mycompany.com(expdate)(Modifiers)?1234567890.

Each domain name requires its own license key. For example, to support the
domain names, www.mycompany.com, sales.mycompany.com and
support.mycompany.com, you need three license keys.

Register Domains, not IP Addresses
When you purchase a license key, be sure to register a domain name, not an IP
address. For example, register www.mycompany.com, not 192.168.0.1.

Although Ektron CMS400.NET supports IP addresses, the domain that you
license becomes the required URL in the browser address. For example, if you
register 192.168.0.1, you would need to access the site as
http://192.168.0.1/somedirectory/myloginpage.aspx.

Since users would typically not identify a Web page by its IP address, you
should register the domain name instead.

More Information
Additional information about licenses is available at
http://www.ektron.com/display.aspx?id=1346.

Installing Ektron CMS400.NET
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Development and Staging
Configurations
This chapter presents five examples of how to configure your Ektron
CMS400.NET Web site. Reading this will help you decide which configuration is
the best fit for your particular situation.

Configuration Properties
Implementation
Guidelines

VirtualStaging
n Use Ektron CMS400.NET’s approval processand
scheduled publishing of content to manage when content goes
live

VirtualStaging on
next page

Multiple sites,
Same Server,
SameDatabase

n Production and development/staging sites use separate
copiesof Ektron CMS400.NET but reside on same server and
point to same database

n Ektron CMS400.NET’s settings, managed content, and
library files are identical between sites

SameServer,
SameDatabase on
page 1-12

Multiple sites,
Same Server,
Different
Databases

n Production and development/staging sites use separate
copiesof Ektron CMS400.NET’s display layer, reside on same
server, but point to different databases

n Changes to content, configuration, or library filesmade in
one site must be copied to other site

SameServer,
Different
Databaseson next
page

Multiple sites,
Separate Servers,
SameDatabase

n Production and development/staging sites reside on
separate servers, which point to the same database.

n Ektron CMS400.NET settings, content, and library files are
identical between sites.

n Changes to templatesmust be copied between servers.

Separate Servers,
SameDatabase on
page 1-13

Multiple sites,
Separate Servers,
Separate
Databases

n Production and development/staging sites are installed to
separate servers and point to different databases

n Changes to content, configuration, or filesmust be copied
between sites.

Separate Servers,
Separate
Databaseson
page 1-14

After deciding which configuration is best, read the following sections to learn
about procedures for working with multiple sites, servers, and databases.

This section also contains the following topics.

Virtual Staging 1-10
Same Server, Different Databases 1-10
Same Server, Same Database 1-12
Separate Servers, Same Database 1-13
Separate Servers, Separate Databases 1-14

Development and Staging Configurations
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Installing Ektron CMS400.NET on Several Servers 1-15
Copying the Site and Database to Other Environments 1-16

Virtual Staging

n Best choice when changes to templates and library files assets are
infrequent

n No special implementation guidelines; just an installation on one
server

n When upgrading this type of site, make a temporary copy of the site
(both display layer and database) on a separate server to test the
upgrade

Same Server, Different Databases

Installing Ektron CMS400.NET
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To set up this configuration, follow these guidelines.

n To maintain file paths between sites, follow these steps.

- Create separate Web Sites in IIS.

- Assign different ports to the production and development/staging sites.
For example, the production site is http://www.example.com, and the
development/staging site is http://www.example.com:8080.

- Separate the databases for isolation.

- One database is the master, and the other is a copy

- Only edit content in the site connected to the master database

- Remove the Ektron CMS400.NET login page from the site connected to
the copy database

n To copy the Ektron CMS400.NET database, your best choice is
Ektron’s eSync feature. This is described in Synchronizing Servers
Using eSync on page 18-1 .

n If you have not implemented eSync, copy site content using a
replication tool for the database.

- SQL Server 2000 SDK Replication - see
http://msdn.microsoft.com/library/en-us/replsql/replover_694n.asp

n Library files - Make sure the Ektron CMS400.NET uploadedimages/
and uploadedfiles/ folders IIS virtual directories point to the same
physical directory.

n Templates and other file system assets - The best way to move these
is eSync. If that was not implemented and changes to these items
are infrequent, you can manually copy them. For automated
replication, use a product such as Microsoft Application Center.

n Upgrading Ektron CMS400.NET - To test an upgrade, make a
temporary copy of the site’s display layer on a separate server
connected to the development/staging database. If the
development/staging database is the master, back it up before
upgrading.

SameServer, Different Databases
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Same Server, Same Database

To set up this configuration, follow these guidelines.

n To maintain file paths between sites, follow these steps.

- Create separate Web Sites in IIS.

- Assign different ports to the production and development/staging sites.
For example, the production site is http://www.example.com, and the
development/staging site is http://www.example.com:8080.

n Both sites must use the same pathing relative to the Web root. For
example, www.example.com\Workarea\applicationAPI.asp and
dev.example.com\Workarea\applicationAPI.asp.

n Because both sites use the same database, editing and publishing
content on one site affects the other site. As a result, the
development/staging server always has the freshest content.

n Make the Ektron CMS400.NET uploadedimages/ and
uploadedfiles/ folders IIS virtual directories that point to the same
physical directory.

n Template changes must be copied between sites. The best way to
copy site templates and other file system assets is eSync. This is
described in Synchronizing Servers Using eSync on page 18-1.

- If eSync was not implemented and changes to these items are
infrequent, you can manually copy them.

To test and QA an upgrade, make a temporary copy of the site’s display layer
on a separate server connected to the development/staging database.

If the development/staging database is the master, back it up before upgrading.
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Separate Servers, Same Database

To set up this configuration, follow these guidelines.

n Configure Ektron CMS400.NET’s Load Balancing feature to copy
uploaded images and files between the servers.

n The best way to move site templates and other file system assets is
eSync. This is described in Synchronizing Servers Using eSync on
page 18-1.

- If that was not implemented and changes to these items are
infrequent, you can manually copy them. For automated replication, use
a product like Microsoft Application Center.

n When upgrading Ektron CMS400.NET, follow these steps.

- Back up the file system of the development/staging server

- Make a temporary copy of the production server database

- Switch the development/staging site to use the copy

- Test and QA the upgrade on the development/staging server

Separate Servers, SameDatabase
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Separate Servers, Separate Databases

To set up this configuration, follow these guidelines.

n Both sites must have the same pathing relative to the Web root, for
example, www.example.com\Workarea\applicationAPI.asp and
dev.example.com\Workarea\applicationAPI.asp.

n Separate the databases for isolation.

- One database is the master, and the other is a copy

- Only edit content in the site connected to the master database

- Remove the Ektron CMS400.NET login page from the site connected to
the copied database

n The best way to copy site templates and library files is eSync. This is
described in Synchronizing Servers Using eSync on page 18-1.

- If that was not implemented and changes to these items are
infrequent, you can manually copy them. For automated replication, use
a product like Microsoft Application Center.

n To copy the Ektron CMS400.NET database (containing HTML and XML
content), your best choice is Ektron’s eSync feature.

- If you have not implemented eSync, copy site content using a
replication tool for the database, such as SQL Server 2000 SDK
Replication. See http://msdn.microsoft.com/library/en-
us/replsql/replover_694n.asp.
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n Make sure the Ektron CMS400.NET uploadedimages/ and
uploadedfiles/ folders IIS virtual directories point to the same
physical directory.

n When upgrading Ektron CMS400.NET, follow these steps.

- Back up the file system of the development/staging server

- Make a temporary copy of the production server database

- Switch the development/staging site to use the copy

- Test and QA the upgrade on the development/staging server

Installing Ektron CMS400.NET on
Several Servers
Perform these steps on the development server.

1. Download and run the Ektron CMS400.NET installation file,
CMS400Basev80.exe. (This procedure is fully documented in
Performing the Installation on page 1-21.)

2. In Windows Explorer, create a folder to be used for development (for
example, c:/cmsdev).

3. Run the Site Setup utility by clicking Start > Programs > Ektron
> Utilities > CMS400 Site Setup. This installs the site on the
development server. (This procedure is fully documented in Setting
up a Site on page 1-25.)

- At the Setup Type page, select CMS 400 (Complete).

- On the Site Setup screen, at the Select Site dropdown, select the site
you created in Step 3, dev.example.com. At Select Host, select the
host you entered for dev.example.com.

- On the Site Path Directory screen, browse to the C:\cmsdev folder.

- On the Host screen, enter http://dev.example.com or an IP
address.

- The following windows prompt you to define the Asset Storage
Location. Enter C:\assetlibrary\cmsdev and
C:\assetcatalog\cmsdev.

4. The Database Setup utility begins. (This procedure is fully
documented in Setting up a Database on page 1-28.)

- Enter your database name, cmsdev to continue the example. (Do not
leave it as localhost.)

- Enter your database server information, then the host, user and
password.

- The database is created.

Installing Ektron CMS400.NET on Several Servers
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5. The cmsdev folder should now look like this.

The site is ready for use. Open Internet Explorer and go to
http://dev.example.com/login.aspx to test the site. Log in to make sure the
database is working.

6. Using steps 1 through 5 above, install sites to your staging and
production servers.

Copying the Site and Database to Other
Environments
Once your project is ready to be tested in house, move the site to a staging
server. When the project is ready to go live, move the site to a production (live)
server.

You can use the same database for all environments. Back up that database
often to keep it safe. Alternatively, create a separate database for each server.
For more information about how to configure your Ektron CMS400.NET Web
site, see Development and Staging Configurations on page 1-9.

Tips on Creating Additional Environments
To create new environments, follow these steps.

1. On the same server or a separate server, create new folders for
Ektron CMS400.NET: C:/cmsstage and/or C:/cmsproduct.

2. In IIS, create a new domain for each server.
http://stage.example.com points to c:/cmsstage and
http://www.example.com points to c:/cmsproduct.

3. If all environments are on the same server, you don't need to copy
other folders. But, if you are using a separate server for each
environment, copy the c:/assetcatalog and c:/assetlibrary
folders to the other servers.
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4. For the database, access the SQL manager and make a backup of the
development database. Then, create new databases for staging and
production. Finally, restore the backup of the development database
to the staging and production databases.

5. In the staging and production environments, open web.config. Then,
update the database connection information so that it points to the
new databases.

6. Test the staging and production environments.

Tips on Creating Additional Environments
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Installing Ektron
CMS400.NET
Thus sections explains how to install Ektron CMS400.NET.

This section also contains the following topics.

Before You Install 1-18
Installing the Minimum and Starter Sites 1-20
Performing the Installation 1-21
Document Management Client Install for Firefox 1-36
eWebEditPro+XML Client Install 1-36
Results of Installation 1-37
Changes to the Ektron CMS400.NET web.config File 1-38
After Installation 1-39
Setting Up an Additional Site 1-39
Moving a Site to Another Directory or Server 1-40

Before You Install
Prior to installing Ektron CMS400.NET, complete these tasks.

Prerequisites:  See Installing Ektron CMS400.NET on page 1-1

1. Create a folder for the site. Make sure the drive and folder to which
you install your Ektron CMS400.NET Web site have sufficient space.
Anticipate future needs, since the site is likely to grow over time.

2. Make sure that Internet Information Server (IIS) is installed in your
server. See Creating a Web Site in IIS on page 1-105.

3. Enable the ASP.NET 2 Web Service Extensions. To do this, open IIS
Manager, and click the Web Service Extensions folder. Then, click
ASP.NET v2.0 and Allow (as shown below).

4. Install and configure your Web Application Server. For more
information, see http://www.asp.net.
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5. If you are setting up one Web site that uses multiple CMS servers and
points to a single database server, make sure both servers connect to
the same database. This configuration ensures that membership user
registrations, forum/blog posts, statistics, etc., are the same on both
servers. For more information, see Moving a Site to Another
Directory or Server on page 1-40.

6. If the server to which you are installing has IIS7 (that is, it’s running
Windows Vista or Server 2008), enable IIS 6 metabase compatibility.
To do that, follow these steps.

- Open the Control Panel.

- Click Programs and Features.

- From the left panel, click Turn Windows Features On or Off.

- Click to open Internet Information Services > Web
Management Tools > IIS 6 Management Compatibility.

- Check IIS Metabase and IIS 6 configuration compatibility.

- Press OK.

Before You Install
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Installing the Minimum and Starter Sites
The installation scheme has changed for version 7.0.2 or higher. Previously,
when you installed Ektron CMS400.NET, the installation created a site with
sample content. (Sample content provides an example of how Ektron
CMS400.NET’s features can be implemented.) Beginning with 7.0.2, however,
the base installation file provides no sample content.

To supplement the base installation, Ektron provides several sample sites. You
can install as many as you wish. Many customers install sample content that
resembles their environment. For example, a legal practice might install the
legal starter site.

Sample sites are available from http://www.ektron.com/cms400-web-
cms.aspx?id=4189.

Note: To get the technical information for developers, which was previously available on the
Developer’s Sample page, install the developer starter site.

This section also contains the following topics.

Installing a Starter Site 1-20
No Current Ektron CMS400.NET Installation 1-20
Upgrading an Existing Installation 1-21
Starter Applications 1-21

Installing a Starter Site

No Current Ektron CMS400.NET Installation
To install one or more sample sites, download them plus the base install file
(CMS400Basev80.exe) from www.ektron.com to the same folder on your Web
server. Then, click a starter site’s .exe file, such as Legal.exe. When you do, it
copies the templates and database to your machine. Next, the base install runs
until it completes phase 1 of the installation steps listed in Performing the
Installation on the facing page.

Once the base installation is complete, the Site Setup portion of the install is
run. Once the setup is complete, you can install any number of additional
sample sites by downloading and clicking them.

If you want to re-install a Starter Site, click the Site Setup link in Start >
Programs > Ektron > CMS400v8X > Utilities > CMS400 Site Setup.

If you are familiar with Ektron CMS400.NET, you do not need to install a starter
site. Simply use the base installation and proceed with site development.
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Upgrading an Existing Installation
If you have an earlier version of Ektron CMS400.NET, first upgrade to Release
8.0. Then, select one or more starter sites and install them.

Starter Applications
Ektron has also developed several starter applications that you can install to
better learn Ektron CMS400.NET’s capabilities. Starter applications are built on
the Ektron CMS400.NET engine and leverage Ektron CMS400.NET's flexible API
made available via its SDK. Starter applications are tailored to address the
needs and requirements for specific business processes for organizations of
any size, but are flexible enough to meet your custom requirements.

Starter applications are shipped open source and are free of charge. They work
out of the box and, if needed, can easily be extended. Starter applications are a
perfect starting point for building your own web application. The only
requirement is that a Ektron CMS400.NET base install exist on your server.

If you install the legal starter site, the Case Management Starter App is
automatically installed. If you install any other starter site, the Project
Management Starter App is automatically installed.

Starter Applications are available from
http://www.ektron.com/products.aspx?id=5948.

Performing the Installation
Note: The installation program checks for an installation of MSSQL on your server. If it is not
installed, it will attempt to install SQL Express.

Installing Ektron CMS400.NET involves these actions. The installation program
guides you through them.

Phase Action What it does For details, see

1
Copy installation files
to C:\Program
Files

n ensures system
requirements

n installs non-working copy
of files needed to set up site

A screen displaysEktron’s License
Agreement. Please read the
agreement. on page 1-23
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Phase Action What it does For details, see

2
Set up a site - (can be
started any time after
Phase 1)

n moves files based on
selectedWeb folder

n creates IIS application
directories

n sets upload folder
permissions

n updatesweb.config (path,
version, and build number)

Setting up a Site on page 1-25

3 Set up a database

n referencesdatabase
folder for scripts needed to
create a database

n createsnew tablesand
populates them

n addsand sets user
permissions

n updates the web.config
file

n tests database connection

Setting up a Database on page 1-28

Set Up a User for the Ektron
CMS400.NET Database on page 1-
32

This section also contains the following topics.

Running the Installation and Setup Program 1-23
Setting up a Site 1-25
Setting up a Database 1-28
Set Up a User for the Ektron CMS400.NET Database 1-32
Possible Error Messages During Installation 1-35
Error 1-35
Possible Causes and Solutions 1-35
Error 1-35
Cause and Solution 1-36
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Running the Installation and Setup Program
Step Setup Screen

1. Go to the EktronWeb site
((http://www.ektron.com/cms400-web-cms.aspx?id=2283)and download Version 8.01 Rev4 of Ektron
CMS400.NET.

2. Double click the downloaded CMS400Basev80.exe file.

3. A screen displaysEktron’s License
Agreement. Please read the
agreement.

n Click I Accept... to accept the
agreement.

n Click I do not accept. If you do not
accept the agreement, this action ends the
setup.

4. SelectComplete to install all
components.

Or, selectCustom to choose which
components to install. You can also choose
where the components are installed.

Note: Once you click next, the install checks to see if you have SQL or SQL 2005
Express installed on the server. If you do not, a dialog appears asking if you would like
to install SQL 2005 Express.
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Step Setup Screen

5. TheReady to Install the Program
screen appears. Click Install.

6. The installation program copies the
necessary files to the C:\Program
Files folder.

Warning! - After completing the installation,
you should further configure your
permissionsbased on your network security
model before using Ektron CMS400.NET.

7. ClickYes to check for updates. This
verifies that you have the latest version
of Ektron CMS400.NET.
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Step Setup Screen

8. Youmight be prompted to restart your
server. If so, Ektron recommendsdoing
a restart now.

Once you restart, the site setup procedure beginsupon completing the restart.

If the site setup doesnot start once the restart is complete, you can launch the site setup fromStart > Programs >
Ektron > CMS400 > Utilities > CMS400 Site Setup.

Warning! If the above dialog appears, do not run the site setup until the system has
been rebooted.

Setting up a Site
This section allowsyou to setup a Ektron CMS400.NET site. The installation copies the following folders from
C:\Program Files\Ektron\CMS400v8x to theWeb root folder you specify:

n BIN

n workarea

n documentation

n uploaded files and uploaded images

n a login page

n the VS 2005 solution file

The site setup can be runmanually by clicking the cms400sitesetup.exe file located in C:\Program
Files\Ektron\CMS400v80\Utilities\SiteSetupor by clickingStart >Programs >Ektron >CMS400vXX
Utilities >CMS400 Site Setup.

Setting up a Site
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Step Setup Screen

9. This is the Site SetupWelcome screen.
It lets you set up aWeb site.

10. The Setup Type screen appears.
Choose an option and clickNext.

n CMS400 Full Installation - For setting
up a new site installation.

n CMS400 Upgrade - For upgrading
existing site. Upgrades the database and site
files asnecessary.

n CMS400 Database Setup - For setting
up a new site database. Site files, such as
.aspxpagesare not included in this setup.

11. In the License Key field, enter your
primary license key for Ektron
CMS400.NET.

License keysare typically emailed to your
organization when you request a copyof the
application.

When cutting and pasting a license key, keep
the full license key intact without adding or
deleting characters.

If you do not have license keysnow, you can
insert them later. SeeUpdating Setup
Information on page 2-28.
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Step Setup Screen

12. This dialog boxallowsyou select which
site you want to install. This screen does
not appear the first time you run the site
setup for a starter site. If you run it again
and havemultiple sites, this dialog box
will appear.

13. If your server operating system
accommodatesmultipleWeb sites (for
example,WindowsServer 2003), select
the site to which you want to install
Ektron CMS400.NET from the
dropdown list.

Otherwise, accept the default.

14. Enter the destination folder for the site.

If your Web site resides in a folder other than
the default, clickBrowse and navigate to the
correct folder. The default reflects your
selection in the previousdialog.

Warning! Do not install under another
application’s folder within theWeb root.

Important: Ektron doesnot support the
installation of nested sites, each having its
ownweb.config file. Nested sites can disrupt
manyCMS features, such asAliasing,
Menus, and eSync.
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Step Setup Screen

15. Enter the path of the Secure Asset
Location.

Warning! If you plan to load balance
several servers, make sure this path is the
same for all servers in the cluster. See Also:
Balancing the Load on Your Serverson
page 22-1

Note: Be sure the drive to which you
install the asset library has sufficient
storage space plus room for growth.

16. Next, theMoving Files dialog appears and the following thingshappen.

n files are copied to the site

n permissionsare set for the site’s directories

n ASPNET, IIS_WPG, or NetworkService user and IUSR are given permissions to the directories

n the indexing catalogsare setup

n the site is set up to use .NET 3.5

n web.config settingsare configured

n IIS is configured

Setting up a Database
Your database contains information such asusers and content blocks. The database setup program:

n checks for SQL or SQL Express server. If either is installed on your server, a appropriate database is set up.

n loadsdatabase tables

n updates the web.config file with information about your database connection, based on your responses

17. You are asked if you want to set up a
database.

ClickYes.
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Step Setup Screen

If you are using a separate database server, you need the following information

n database server host name or IP address

n if the database server is on the same domain as the application server, it must support NT or SQL
authentication

n if the database server is on a separate domain from the application server, it must support SQL authentication

n youmust have database administrator or database creator privileges

18. Enter the name of the database you are
creating.

Warning! Ektron strongly urges you to change the user name and password for the builtin user.

19. Change the builtin user’s name and password. For instructionson editing the builtin account in theWorkarea,
seeBuiltIn User on page 2-35.
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Step Setup Screen

20. This screen prompts for database
connection information.

Server - List the database server on this
system. To setup the database on this server,
accept the default.

Otherwise, enter a SQL or SQL Express
server that alreadyexists. For SQL, this
would typically be (local) if it’s installed on the
local server. Otherwise, enter the Server’s
name. For SQL Expressenter
(local)\SQLEXPRESS.

Username - Enter the username you will use to access the database.

Password - Enter the password you will use to access the database.

Note: If you want to use NT authentication, leave the username and password blank. Thiswill set up a
trusted connection.

After you complete the screen, the setup tests the database connection to verify the information is valid. If the
database name alreadyexists, you are asked to assign a different name. Once a connection ismade and the name
is available, the installation program createsa database using the provided information.

21. If your server hasVisualStudio.NET
installed, the following prompt appears.

22. If you want to install Ektron CMS400.NET’sSoftware Developer’sKit (SDK), clickYes. Otherwise, clickNo.

If you clickNo, skip to The site and database setup portion of the install is complete. on the facing page.

See Also: Ektron’sDeveloper SDK.
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Step Setup Screen

23. Choose the type of Setup for the
CMS400.NET SDK.

ClickNext.

24. Click Install to begin the installation.

25. The Setup Status screen appears.

26. When the SDK install is finished, the
following screen appears. ClickFinish.

The site and database setup portion of the
install is complete.
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Step Setup Screen

27. If your license key supports
eCommerce, this screen appears. To
learnmore about PCI Compliance, see
the following KBarticle:
http://dev.ektron.com/kb_
article.aspx?id=26304

28. If your license key isEnterprise-level or
Professionalwith an eSyncmodifier, this
screen appears.

For details on how to complete it, see
Managing eSyncSecurityCertificateson
page 18-43.

Set Up a User for the Ektron CMS400.NET
Database
The installation automatically sets up user permissions based on data collected
during setup. However, if there is a problem setting permissions for the user,
this section describes how to set the permissions manually.

Note: If you are using SQL Authentication, you only need to set up the SQL user. If you are
using Windows Authentication, you need to set up IUSR and an ASPNET, IIS_WPG, or
Network Service user. The IIS_WPG user replaces ASPNET in Microsoft Windows 2003 server
and Windows Vista. The Network Service user replaces ASPNET in Microsoft Windows 2008
server and Windows 7.
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Step Setup Screen

1. In the SQL Enterprisemanager, selectSecurity
> Logins.

2. Right click themouse and selectNew Login.

3. On the Login Properties dialog, click the button to
the right of theName field.

4. Select your server.

5. From the user list, select theASPNET , IIS_
WPG, or Network Service user (depending on
your Windowsversion) and IUSR user.

6. ClickAdd thenOK.

Set Up a User for the Ektron CMS400.NET
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Step Setup Screen

7. On theDatabase Access tab, select your
Ektron CMS400.NET database. Then, assign
permission to read and write to that database (as
illustrated).

8. Run the grant permission script.

Note: Before doing this, review your users and their permissions. Adjust asnecessary for your configuration.
Also, if you useWindowsAuthentication and all users are domain users (and the database administrator
wants it thisway), youmaynot have to perform this step.

Follow these steps to do that.

n Open the SQLQueryAnalyzer.

n From the dropdown list, select the Ektron CMS400.NET database.

n ClickFile > Open.

n Open C:\Program Files\Ektron\CMS400vnn\Utilities\SiteSetup\Database\cms400_
permissions.sql. (nn represents the release number)

n Within that file, replace [MACHINENAME or DOMAINNAME\USERNAME] with your domain name, backslash
(\), and ASPNET (the ASP.NET machine account). For example, [ws10080\ASPNET].

Note: If you are usingMicrosoftWindows2003 Server or MicrosoftWidowsVista, the user isIIS_WPG. For
example, [ws10080\IIS_WPG].
If you are usingMicrosoftWindows2008 Server or Windows7, the user isNetwork Service.

n Click the Execute Query button ( ).

n Replace the text between square bracketswith your domain name, backslash (\), and the IIS Internet Guest
Account. For example, [ws10080\IUSR_ws10080]. Click the Execute Query button.

n If using SQL server authentication, replace the text between square bracketswith the SQL server
authentication name only. Do not include the domain name. Click the Execute Query button.
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Possible Error Messages During Installation

Error

Possible Causes and Solutions

Possible cause Suggested solution

User doesnot have
permission to create
objects

Grant user permission to create objects. For information on how to, read IIS
Security help topic “Setting NTFSPermissions for a Directory or File.”

http://localhost/iishelp/iis/htm/core/iidfpsc.htm

IIS is not installed Make sure IIS is installed on the server.

Host is not localhost Install Ektron CMS400.NET on localhost machine only.

Error
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Cause and Solution

Cause Solution

You installed Ektron CMS400.NET for .NET 2.0 but
have the 1.1 .NET framework.

Install the .NET 2.0 framework.

Or, install the version of Ektron CMS400.NET for
the 1.1 .NET framework.

Document Management Client Install for
Firefox
See Installing FireFox Plug In on page 7-401.

eWebEditPro+XML Client Install
Note: If you are using eWebEdit400 as the default editor, you do not need to deploy anything.
See Also: Ektron CMS400.NET Editors on page 7-26

There are two options for deploying Ektron CMS400.NET’s editor,
eWebEditPro+XML, to client machines.

n Silently deploy the ewebeditproclient.msi file, which is installed to
C:\Program
Files\Ektron\CMS400v8x\workarea\ewebeditpro\clientinstall.
To do this, use this command-line:

msiexec /i "c:\Program
Files\Ektron\CMS400v8x\workarea\ewebeditpro\clientinstall\ewebeditproclient.msi" /qn

The command line parameters are explained on this Web page:
http://helpnet.installshield.com/robo/projects/HelpLibDevStudio9/IHelpCmdLineMSI.htm.

n Each time a user connects to Ektron CMS400.NET, his PC is checked
for eWebEditPro+XML. If an older version or no version exists, the
user is prompted to download ewebeditproclient.exe from the
server’s C:\Program
Files\Ektron\CMS400v8x\workarea\ewebeditpro\clientinstall
folder.
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The user clicks Install Now to install eWebEditPro+XML.

To use this procedure, the user must be authorized to install programs on his
computer.

Results of Installation
This section also contains the following topics.

File Locations 1-37
File Permissions 1-38
Indexing Service 1-38

File Locations
By default, the installation inserts files into two locations on the server:

n C:\Program Files\Ektron\CMS400vXX: sample and minimal
databases, documentation, utilities, site setup files (for creating
additional sites)
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n C:\Inetpub\wwwroot\cms400Min: bin folder, Web Services, scripts,
supporting files, uploaded files and images, graphics used in the
application, CustomAPI (used to customize Ektron CMS400.NET), etc.

Note: The bin folder stores Ektron CMS400.NET’s binary executable files. The .NET
environment automatically searches this folder when looking for .dll files.

File Permissions
During installation, the ASPNET or IIS_WPG and IUSR users are given
permission to create folders in the following directories:

n C:\Inetpub\wwwroot\[Your Site]\uploadedfiles

n C:\Inetpub\wwwroot\[Your Site]\uploadedimages

Indexing Service
The installation automatically starts the Indexing service. Ektron CMS400.NET’s
search uses this service.

If you want the Indexing service to work manually, you need to change the
settings. These steps explain how to disable Indexing of the site.

1. Navigate to Administrator Tools > Internet Information
Services.

2. In the IIS window, find the Web site.

3. Right click the site and choose properties.

4. On the Directories tab, uncheck the Index this resource box.

5. Click OK.

Changes to the Ektron CMS400.NET
web.config File
See Also:Managing the web.config File on page 1-71

After you install Ektron CMS400.NET, the web.config file is updated as follows.

web.config setting Assigned this value by installation

ek_sitePath webroot/siteroot

ek_buildNumber current build number of Ektron CMS400.NET

ek_version current version of Ektron CMS400.NET

Connection String Information about the how the database is
connected to Ektron CMS400.NET.
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After Installation
Ektron strongly recommends configuring a secure socket layer (SSL),
especially if you are using Active Directory Integration. SSL encrypts
passwords that are otherwise sent as clear text to the Ektron CMS400.NET
server. See Configuring SSL on page 1-95 for more information.

Setting Up an Additional Site
After installing Ektron CMS400.NET, it is easy to create another site. While
creating the new site, you can create a sample or minimal site and database.
To create a site for your content, you would typically install a minimal site and
database, then create your Web page templates. Later, you can add users and
content.

Note: Because of Windows Indexing Service limitation, your server can support eight Ektron
CMS400.NETWeb sites. If you want to install more than 8, you must merge the Indexing
Service catalogs. This is documented Merging Indexing Service Catalogs on page 9-19.

This section also contains the following topics.

Step 1: Set up New Site 1-39
Step 2: Set up New Database 1-39
Step 3: Create Project in Visual Studio.NET 1-40

Step 1: Set up New Site
1. Create a new folder in the Web root folder to contain the site files.

2. From the Windows Start menu, follow this path:

Start > Programs > Ektron > CMS400 > Utilities > SiteSetup

3. Follow the steps for creating a new site, as described in Setting up a
Site on page 1-25. When prompted to select a folder to which you
want to install the files, choose the folder you created in Step 1.

Step 2: Set up New Database
After installing an Ektron CMS400.NET site, it is easy to create a new database.
You can create either a sample or minimal database. When creating a database
for your content, you typically install a minimal database.

To set up a database, follow these steps.

1. From the Windows Start menu, follow this path:

Start > Programs > Ektron > CMS400 > Utilities > SiteSetup

2. On the Setup Type screen, choose Database Setup only.
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3. Follow the steps for creating a new database, as described in Setting
up a Database on page 1-28.

Step 3: Create Project in Visual Studio.NET
To work with the new site in Visual Studio.NET, you must create a new project
for it. To do that, follow these steps.

1. Navigate to the folder that contains the new site.

2. Double click Ektron CMS400.NET’s solution file. If you are using the
minimal database, the file is CMS400Min.sln.

At this point, you can build the project and log in. If you cannot log in because
you have not set up the license key, use the builtin account: by default, the
username is builtin and password is builtin.

Important: You should only use the builtin account temporarily. As soon as possible, you should
insert the license key and log in under a user name assigned in Ektron CMS400.NET.

To learn about creating templates and using server controls, see Working with
Ektron CMS400.NET Server Controls on page 24-1.

Moving a Site to Another Directory or
Server
Use this procedure to move an Ektron CMS400.NET Web site to a new folder or
even a different server. For example, you complete work on a site that resides
on a development server and want to move it to a production server.
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Within this documentation, the original site’s folder is referred to as the source
directory, and the new site’s folder is called the destination directory. The
directories can reside on the same server or different ones.

Moving the site consists of the following major steps. Each step is described
below.

n Step 1: Set up an IIS Site on the Destination Server on next page

n Step 2: Copy Files to Destination Directory on next page

n Step 3: Set Permissions on the New CMS Web Site on next page

n Step 4: Make the New Directory an IIS Application on page 1-43

n Step 5: Back up the Database on page 1-43

n Step 6: Create a New Database on page 1-44

n Step 7: Restore the Database on page 1-44

n Step 8: Set Security on the Copied Database on page 1-46

n Step 9: Update web.config on the Destination Site on page 1-46

Moving a Site vs. Using the eSync Feature
In addition to the Site Move procedure described below, Ektron CMS400.NET
offers an eSync feature. That feature automatically pushes new and updated
site files to a production server. eSync is especially useful when your site
contains sensitive information (for example, pricing) that needs to be carefully
reviewed for quality assurance before it goes live. For more information, see
Synchronizing Servers Using eSync on page 18-1.

When You Would Use the eSync feature
You'd use the eSync feature in these cases.

n Moving a site from staging to production

n Distributing a site among load-balanced servers

When You Would Use the Move Site Procedure
You'd use the Move Site procedure in cases listed below. Additional information
that may help you move your site manually can be found at
http://dev.ektron.com/kb_article.aspx?id=16408

n You do not have the eSync feature.

n The initial move of a site up to a shared server (or any other server
on which you cannot run the .exe installer). Subsequently, you could
use eSync if you have it.

n Moving a site to a new server. For example, you purchase a new
server to replace your existing one.

Moving a Site vs. Using the eSync Feature
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n Moving a site between two servers that are not connected by a
network.

Step 1: Set up an IIS Site on the Destination
Server
Note: This procedure assumes your Web server runs Windows 2003 server.

1. On the destination server, go to Start > Control Panel >
Administrative Tools > Internet Information Services.

2. Click the plus sign (+) next to the computer’s name so that you can
see the Web Sites folder.

3. Right click the Web Sites folder and select New Web Site.

4. The Web Site Creation wizard walks you through the steps of creating
a new Web site.

5. At the TCP Port field, make sure the IP address/host header/ port
combination does not conflict with an existing Web site. For example,
if the destination server already publishes a Web site on IP address
172.23.23.231 with host header dev.example.com on port 80, your
new site could use the same settings on port 81. The new site is
accessible through http://dev.example.com:81/.

6. When prompted for the path to the new site, create a new folder for
the site in the destination server's file system.

7. When prompted to assign permissions to the new folder, assign read
and run scripts permissions.

Step 2: Copy Files to Destination Directory
1. In the Web root of the destination directory, create a folder with the

same name as the folder in the source directory.

Note: You do this in order to set the destination site on the same URL path as the source site
on the source server. For example, if you the source site’s login page is
http://localhost/MySite/login.aspx and you're moving it to dev.example.com port 81,
place the destination site at http://dev.example.com:81/MySite/login.aspx.

Note: It is important for both sites to use the same URL path because Ektron CMS400.NET
uses root relative pathing in links to pages and images. This means that any managed content
item can be displayed on any page in the Web site. Since the path may be embedded in
hyperlinks and image paths, changing the URL path on the destination server may cause
problems.

2. Copy all files in the source directory to the destination directory.

Step 3: Set Permissions on the New CMS
Web Site

1. Open Windows Explorer.
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2. Navigate to new Web site’s folder.

3. Right click the uploadedfiles directory, and choose Properties.

4. On the General tab of the properties dialog, ensure the Read-Only
attribute is not checked.

5. On the Security tab of the properties dialog, ensure that the IIS
anonymous user (usually named “IUSR_COMPUTERNAME”) has Write
permission.

6. Right click the uploadedimages directory, and choose Properties.

7. Repeat steps 4 and 5 for the uploadedimages directory.

Step 4: Make the New Directory an IIS
Application

1. Within IIS manager, right mouse click the folder created in Step 2:
Copy Files to Destination Directory on previous page.

2. Select Properties.

3. In the Application Settings area, click Create.

4. Click OK.

Step 5: Back up the Database
Warning! Do not use SQL Server Data Transformation Services to move the database. This
feature is not compatible with Ektron CMS400.NET.

Step 4: Make the New Directory an IIS Application
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Ektron recommends backing up the database in the source folder then restoring
the database backup to the destination folder. This procedure is described
below.

1. In the Ektron CMS400.NET source folder, open the web.config file and
verify the name of the database. The database name appears after
key="ek_dbCatalog" value= .

2. On the source server, open SQL Enterprise Manager and navigate to
the database you identified in Step 1.

3. Right mouse click the database then select All tasks > Backup
database.

4. Select a destination file name by clicking the Add button in the
Destination area of the SQL Server Backup screen.

Step 6: Create a New Database
1. On the Destination server, open SQL Enterprise Manager.

2. Expand the display until you see the Databases folder.

3. Right click the Databases folder.

4. Choose New Database....

5. Assign a name to the database.

6. The remaining options can remain as defaults, or you can be edit
them as needed.

Step 7: Restore the Database
Restore the database to the new destination folder. To do this, follow these
steps.
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1. Right click the database you created in Step 6: Create a New
Database on previous page.

2. Select All Tasks > Restore database.

3. In the Restore as database field, verify that the database you
created in Step 6 appears.

4. In the Restore section, click From device (circled above).

5. Click the Select Devices button (circled above).

6. The Choose Restore Devices screen appears. Click the Add button
(circled below).

Step 7: Restore the Database
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7. On the Choose Restore Destination screen (below), select File name
and navigate to the backup file you copied to the destination folder.

8. Click OK three times. SQL copies the data to the database you
created in Step 6: Create a New Database on page 1-44.

Step 8: Set Security on the Copied Database
1. This procedure is described in Set Up a User for the Ektron

CMS400.NET Database on page 1-32. Do this for the following users.

n IUSER

n ASPNET User

Step 9: Update web.config on the
Destination Site

1. Within the destination site folder, open the web.config file.

2. Update your connection string values (see example below).
<connectionStrings>

<add name="Ektron.DbConnection" providerName="System.Data.SqlClient"
connectionString="server=1ER80\SQLExpress;database=CMS400Developer;Integrated
Security=TRUE;user=;pwd=;" />

</connectionStrings>

3. Modify the following values as needed.

Web.config element How to modify

ek_sitePath The path to the new folder, relative to the server’swebroot folder.

WSPath The full path to the folder that stores theWeb Service URL for
Server Controls at design time.
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Upgrading Ektron
CMS400.NET
Warning! If you are upgrading from a version prior to 7.6, run Ektron’s Big Int Utility on all Web
sites you want to upgrade. If you do not run this utility, your Web site will not compile, and you
receive errors related to the int (VB) or int32 (C#) data type. See Using the Big Int Utility on page
1-59

This section also contains the following topics.

Upgrading From Version 6 or higher to Version 8.X 1-47
Using the Big Int Utility 1-59
Backing Up Databases 1-64
Updating Application Messages 1-65
Troubleshooting Upgrade Problems 1-69

Upgrading From Version 6 or higher to
Version 8.X
The upgrade procedure copies Ektron CMS400.NET’s latest features to your
Web server. Ektron CMS400.NET is installed to its own folder, CMS400v8x. This
means it can coexist on the same machine with previous versions -- the
template directories are independent.

Warning! During the upgrade procedure, your Web site’s Bin, Workarea and Documentation
folders are removed. Any customized files in these folders will be lost. So, only store custom files
in these folders when absolutely necessary. Even then, you should keep a back-up file in
another folder.

This section also contains the following topics.

The Base Folder 1-47
The Upgrade Procedure 1-48
Performing the Upgrade 1-50
What Happens Next? 1-55
Upgrading Your Database 1-55
Performing the Database Upgrade 1-56

The Base Folder
The upgrade installs a base folder (C:\\Program Files\Ektron\CMS400v8x),
which provides a template for setting up Ektron CMS400.NET Web sites. The
Site Setup utility uses the files in the base folder to create and upgrade Ektron
CMS400.NET sites.
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The base folder contains the following subfolders.

Subfolder Includes

AssetManagement Folders and files for the Document Management Functionality

Bin Required .NET assemblies for Ektron CMS400.NET

CommonFiles Location for application GlobalResources,WebReferencesand Starter
Application files.

Documentation Documentation. The site setup procedure copies this directory to the workarea
directorywhen setting up a site.

EktronAsyncProcessor_
Service Files needed to add AsynchronousProcessor for Web Alerts

StarterSites Files for any starter sites that have been added.

StudioHelp Files necessary for adding the API help to VisualStudio 2005

Utilities

Utilities for

n database upgrade

n database application stringsupdate

n email encrypt password tool

n a setup Sharepoint Portal

n Document Management Registration tool

n Load Balancing service files

Workarea

Scripts used for theWorkarea

Note: The contents of this folder are later copied to aWeb site folder, typically
in theWeb server’sweb root. The sample providesa good way to learn how to
workwith an Ektron CMS400.NET site. An alternative is theminimum
database. Use thiswhen you understand how to create a site and do not want
to place extra, sample files on your server.

The Upgrade Procedure
Upgrading involves the following tasks.

1. Install new files to the new directories. See Also: Running the
Installation and Setup Program on page 1-23

2. Remove the following folders (and their subfolders) from your site’s
directory and copy the new folders to the site directory.

n bin

n workarea

n Documentation
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Warning! The upgrade procedure removes these folders. Any customized files in these folders
will be lost. So, only store custom files in these folders when absolutely necessary. Even then,
you should keep a back-up file in another folder.

3. Update the web.config file with new settings.

4. Update your databases using the upgrade and language update
utilities. See Also: Performing the Upgrade on next page

5. If needed, modify the site to use the server controls. See Also:
Updating the Server Controls on page 24-6.

Note: After you upgrade Ektron CMS400.NET, you may notice that, for some content that
inherits the following property from their folders, the field is not checked: The content in this
folder is private and can only be viewed by authorized users and members. To resolve this
problem, edit the content’s View Permissions for Content screen and manually check the
box.

Note: Before you can check the checkbox, you must disable inheritance. After checking the
box, enable inheritance.

Note: The upgrade automatically starts the IIS and Indexing services.

This section walks you through the upgrade process.

TheUpgrade Procedure
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Performing the Upgrade
1. Follow the stepsof the installation procedure,Running the Installation and Setup Program on page 1-23. These

steps instruct you to install Ektron CMS400.NET and restart your server. Return to step two when the Site Setup
Selection appears.

2. The Setup wizard appears.

(If this screen doesnot appear, launch it by following
this path from theWindowsStart menu:

Start > Programs > Ektron > CMS400 >
Utilities > Site Setup)

3. The Setup Type screen appears. Choose the
Upgrade radio button, and clickNext.
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4. Choose an application directory. If you are not
sure, use the default (C:\\Program Files\
Ektron\CMS400v8x).

This directory storesEktron CMS400.NET
components and utilities.

Warning! This dialog appears onlywhen the Setup
cannot detect where the site’s application is directory
located.

5. If your server operating system accommodates
multipleWeb sites, select the site to which you
want to install Ektron CMS400.NET from the
dropdown list.
Otherwise, accept the default.

6. Select the path of theWeb site you are
upgrading.

Note that the upgrade only updates the web.config
file, Ektron CMS400.NET assembly files, andWeb
Service components. It doesnot update your
templatesnor other files not mentioned above.
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7. Select Yes to backup your site.

Warning! Ektron strongly recommendsbacking up
your site before continuing the upgrade. If you
choose No and the upgrade fails, you will not be able
to revert the files back.

8. If you choose to backup your site, a dialog asks
where to store the backup.

9. You are asked if you want to update your siteroot/widgetsdirectory.

ClickYes if you want to install the latest widgets. However, if you customized widgets in that folder and did not rename
them, the customized versionswill be overwritten.

To prevent this, rename anywidgets that you customize.

10. You are notified that files aremoving to the starter site directory.

11. The Choose Destination Location screen
appears. Enter the path to your
AssetManagement Directory.

Warning! This dialog appears onlywhen the Setup
cannot find the AssetManagement directory.
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12. If you chose to do so, your site is now being backed up. Next, the bin,Workarea and other files are updated. Any
missing permissionsor Index catalogsare added.

Warning! The previous version’s bin andWorkarea folderswill be removed from
your Web site. Any customized fileswithin these folders are lost. If possible, do not
store custom files in them unlessabsolutely necessary. Even then, you
should always keep a separate back-up file in another folder.

13. Your web.config file is updated with information needed to run Ektron CMS400.NET. If other applicationsuse the
web.config file, the upgrade doesnot affect their sections.

14. A dialog boxappears asking if you want to
upgrade the database. SelectYes to upgrade.

If you selectNo, the site will not work properly until the
database upgrade hasbeen run. To upgrade the
database at a later time, run the Site Setup and select
Database Upgrade. The site setup is located inStart
>Programs >Ektron >CMS400v8X >Utilities >
CMS400 Site Setup.

15. If you selected yes, the Database Upgrade
Wizard starts.

16. This screen prompts for database connection
information.

Server - List the database server on this system. To
setup the database on this server, accept the default.

Otherwise, enter a SQL or SQL Express server that
alreadyexists. For SQL, thiswould typically be (local)
if it’s installed on the local server. Otherwise, enter the
Server’s name. For SQL Expressenter
(local)\SQLEXPRESS.

Note: This dialog appears if you are using SQL
Authentication. If you are usingWindows
Authentication, skip to the next step.
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17. A dialog boxappears asking you to backup your
database.

18. If you clicked Yes in the previous step, select the
location of your database backup. If this path
doesnot exist on your databasemachine, the
backup will fail.
Otherwise, skip to the next step.

If the backup fails, the followingmessage appears.

Warning! In this case, you shouldmanually backup
your database before clickingOK. See Also:Backing
UpDatabaseson page 1-64

19. Select whether to generate a summary for all
content blocks.
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20. If your license keywasnot generated for the 8.xRelease, you are prompted to enter an 8.x license key. If you do
not have an 8.x license key, follow these steps.

n Complete the upgrade.

n Obtain an 8.x license key from Ektron. (http://dev.ektron.com/requestlicense.aspx)

n Log in asbuiltin user. See Also:BuiltIn User on page 2-35

n Insert the key into theSettings >Configuration >Setup screen's >General tab >License Key(s): field.

21. If it is installed, select whether to upgrade you
Ektron CMS400.NET SDK.

22. Once the SDK is installed, clickFinish on the final screens to complete the upgrade.

23. A dialog appears asking if you want to enable PCI
compliance.

SelectingYes changes the following web.config keys
to “true”.

<add key="ek_ecom_ComplianceMode"
value="false" />
<add key="UseSSL" value="false" />

Warning! Enabling compliance requires you to have
an SSL certificate installed for your web site.

Note: This dialog only appears if you are
upgrading from version 7.6.5 or earlier and have
the eCommerceModifier (E) in your license key.

What Happens Next?
After upgrading your site and rebuilding the solution, you are ready to use
Ektron CMS400.NET.

If you did not run the database upgrade or language update during the
installation, you need to do it manually. The next sections explain how to do
that.

Upgrading Your Database
If the database upgrade was unsuccessful during installation, or you chose to
do it outside of the install, you need to manually upgrade your database. Use
the Database Upgrade within the Site Setup utility to do so.
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ReferenceManual
Version 8.01 Rev 4

1-55

http://dev.ektron.com/requestlicense.aspx


Performing the Database Upgrade
Warning! Ektron recommends backing up your database before performing an upgrade. For
information on backing up a database, see Backing Up Databases on page 1-64.

To perform the database upgrade, follow these steps.

1. Click theWindowsStart button then follow this path:Programs >Ektron >CMS400 >Utilities >CMS400 Site
Setup. (If this path doesnot work, click the cms400sitesetup.exe file, located under the C:\Program
Files\Ektron\CMS400v8x\Utilities\SiteSetup folder.)

2. TheWelcome screen appears. ClickNext.

3. The Setup Type screen appears. Select
CMS400 Database Setup and clickNext.
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4. SelectCMS400Database Upgrade (SQL
Only!) from the Setup Type screen.

5. A dialog warns you to upgrade your site files
before you perform the database upgrade.
ClickOK.

6. If you selected yes to the database upgrade,
the Database UpgradeWizard starts.
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7. Choose an application directory. If you are not
sure, use the default (C:\\Program Files\
Ektron\CMS400v8x).

This directory storesEktron CMS400.NET
components and utilities.

8. Choose the path to your Web site’s directory.

9. The upgrade process checks the connection to your database. If it connects, continue on to the next step.
Otherwise, a connection dialog appears.

10. A dialog boxappears asking if you want to
upgrade your database.

Warning! Important: Ektron strongly
recommendsbacking up the CMSdatabase.
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11. If you choose to backup your database, a
dialog appears asking you where you to store
the backup. If you chose not to upgrade,
proceed to the next step.

12. Select whether to generate a summary for all
content blocks.

13. If your license keywasnot generated for the 8.xRelease, you are prompted to enter an 8.x license key. If you do
not have an 8.x license key, follow these steps.

n Complete the upgrade.

n Obtain an 8.x license key from Ektron. (http://dev.ektron.com/requestlicense.aspx)

n Log in asbuiltin user. See Also:BuiltIn User on page 2-35

n Insert the key into theSettings >Configuration >Setup screen's >General tab >License Key(s): field.

14. After the your database is backed up and updated theDatabase Upgrade Complete screen appears. Click
Finish.

Using the Big Int Utility
Warning! Only use this utility if you are upgrading from a version of Ektron CMS400.NET that
precedes 7.6.

The Big Int Utility changes certain references of the Data Type int (VB) or int32
(C#) to long (VB) or int64 (C#) inside Ektron methods used in your Web site.
See Also:Why Ektron Changed the Data Type on next page.

It is important to note that this utility might not catch all instances that need to
be changed. After running the Big Int Utility, you should precompile your Web
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site. Next, check for error messages that state: during the compile process, the
system cannot convert int (VB) or int32 (C#).

If these messages appear, go to the line of code and change the data type to
long (VB) or int64 (C#). For example, The Big Int Utility will not change the
Return Type of a function. For information on scenarios where the Big Int Utility
does not change a data type, view the following KB article.

http://dev.ektron.com/kb_article.aspx?id=21436

Another way to verify that all the necessary int and int32 references have been
changed to long and int64 is to run the Bad link checker located in Workarea >
Reports > Contents >Bad Link Report.

This section also contains the following topics.

Why Ektron Changed the Data Type 1-60
Running the Big Int Utility 1-60
The Log File 1-64

Why Ektron Changed the Data Type
In version 7.6 of Ektron CMS400.NET, Ektron changed the Data Type for its
primary IDs from int (VB) or int32 (C#) to long (VB) or int64 (C#). For
example, Ektron now uses the long or int64 data type for user IDs and content
IDs.

This change was implemented to handle the larger IDs needed for eSync. See
Also: Unique ID Numbering on page 18-42

While Ektron made this change to accommodate eSync, the change affects all
Ektron CMS400.NET sites being upgraded to version 7.6 or higher.

Running the Big Int Utility
1. Navigate to

C:\Program Files\Ektron\CMS400v8x\Utilities\BigIntUtility

2. Double click CtrlH.exe.

3. The Big Int Utility screen appears.
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4. Click the Browse button.

5. Select the site root folder and click OK.

6. Next, click the other Browse button to select a location to store the
backup.
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7. Select the folder where your site will be backed up. If you want to
create a new folder, click Make New Folder.

8. Click the Convert button.
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9. The utility goes through your Web site's files, finds references to int
(VB) or int32 (C#) in your Ektron methods, and changes them to long
(VB) or int64 (C#). An int or int32 is changed only when used inside
an Ektron method.

Warning!Whenever a file is changed, a copy of the original is added to the backup directory.

Note: Depending on the size of your Web site, the conversion might take a while to complete.

10. Once the conversion is complete, close the utility by clicking the red
X in the upper right corner. Your site has been updated to use long
(VB) or int64 (C#) instead of int (VB) or int32 (C#) in Ektron
methods.
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11. Precompile your Web site.

12. After compiling, check for error messages that state: during the
compile process, the system cannot convert int (VB) or int32 (C#). If
these messages appear, go to the line of code and change the data
type to long (VB) or int64 (C#).

Another way to verify that all the necessary int and int32 references
have been changed to long and int64, is to run the Bad link checker
located in Workarea > Reports > Contents > Bad Link Report.

The Log File
A log file of the changes is located in C:\Program
Files\Ektron\CMS400v8x\Utilities\BigIntUtility. The log file's name is
based on the date and a series of numbers.

This log contains a list of files that were processed. If a file was changed, the
log lists the line number and what was changed. For example:
Line 487 - Changed 'ByVal content_id As Integer' to 'ByVal
content_id As Long'.

Backing Up Databases
To protect the information in your database, Ektron recommends backing it up
before upgrading. During the upgrade, Ektron CMS400.NET attempts to create a
backup of your database. If that fails, use the following MSDN links for
instructions on backing up and restoring your database via SQL Server.
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To work with this
database version

See this MSDN article

Backup SQLServer 2008

http://msdn.microsoft.com/en-us/library/ms187510.aspx

Note: The bottom of the above page provides links to options for
restoring the backed-up database.

Backup SQLServer 2005

http://msdn.microsoft.com/en-us/library/ms187510(SQL.90).aspx

Note: The bottom of the above page provides links to options for
restoring the backed-up database.

Warning! Before restoring an SQL database, either stop the Ektron Windows service or force all
connections closed. You need to do this because the Ektron Windows Service accesses the
database. To view and update the status of the service, go to Computer Management > Services
and Applications > Services. For more information, see Ektron Windows Service on page 22-7.

Updating Application Messages
Warning! If upgrading from version 5.0 or later, this section does not need to be completed.

Ektron CMS400.NET provides language support for French and German. If you
are upgrading from a previous version and are using your old database, the
translated strings are not included. Because of this, the installation includes a
utility that lets you populate your old database with the translated strings.

This section also contains the following topics.

Prerequisites 1-65
Using the Language Update Utility 1-65

Prerequisites
Before using the language upgrade utility, you must upgrade your version of
Ektron CMS400.NET. For information on this, see Performing the Upgrade on
page 1-50. During the upgrade, if you opt to keep your previous database,
proceed with this section.

Using the Language Update Utility
To use the language update utility, follow these steps.

1. Go toStart > Programs > Ektron > CMS400 > Utilities > Application Strings Update.
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2. The Language Update Utility opens.

3. Select the DSN for the database from the drop
down list.

4. Enter a username and password with permissions to the DSN if required.
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5. Select the type of database you are using. It will
be updated with the language strings.

6. Select the action you want to perform.

n Repopulate - deletesall stringsand repopulates
the database

n Add New Strings - addsonly new strings in the
current release of Ektron CMS400.NET.
(Recommended if you changed existing strings)
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7. Select the languages that you would like to be
updated/added to the database.

8. Click theUpdate button.

9. When the language update is complete, the
following screen appears.

10. ClickOK to close the window.

11. ClickClose on the LanguagesUpdate Utilitywindow.
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Troubleshooting Upgrade Problems
Problem Solution

After upgrade, Ektron CMS400.NET doesnot
load properly. Also, an error icon appears next to
your templateswhen you open the project in
VisualStudio.NET, as illustrated below.

The problem is that your .NET referencesneed to
be updated.

To verify the problem, open the Ektron CMS400.NET
solution file in VisualStudio.NET
(webroot\siteroot\cms400sitename.sln; for
example, cms400Intranet.sln) and lookat the
template files.

If your referencesare broken (as shown in the sample
screen on the left), delete all Ektron references. Then,
add new referenceswith the same name from the
webroot\siteroot\bin folder.

When viewing a page containing CMS400.NET
Server controls or API calls, the page returnsa
fatal error Compiler failed with Error Code
2000.

Detailed compiler output maysayFatal error
BC2000: compiler initialization failed
unexpectedly: The filename, directory name,
or volume label syntax is incorrect.

This error messagemight appear after an
upgrade.

See Ektron Knowledge Base article “ERRMSG:
Compiler failed with Error Code 2000”

(http://dev.ektron.com/kb_
article.aspx?id=2029)
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Problem Solution

After upgrading from Ektron CMS400.NET
version 4.8 or earlier, Metadata is no longer
applied or required when adding or editing
content.

In Ektron CMS400.NET version 4.8 or earlier,
Metadata is applied globally. In later versions, metadata
is applied to each folder individually. Child folders can
inherit themetadata from a parent folder or they can
have their ownmetadata settings.

To set themetadata settingsback to global, follow
these steps.

1. In theWorkarea, click on the site’s root folder.

2. Next, clickView>Folder Properties.

3. Click the Edit Properties button ( ).

4. Click theMetadata tab.

5. Check the all of the appropriate checkboxes for
Assigned andRequiredMetadata.

6. Click theSave button ( ).

If you have not broken inheritance on anyof the folders,
your metadata settingsare applied globally.

See Also:AssigningMetadata to a Folder on page 7-
159

Installing Ektron CMS400.NET

1-70 ReferenceManual
Version 8.01 Rev 4



Managing the web.config File
Ektron CMS400.NET’s web.config file lets you control many key functions of the
content management system. When you install Ektron CMS400.NET, web.config
is placed into webroot/siteroot.

This section explains the settings in the web.config file.

If your server is currently running another .NET application, you must merge
that web.config file with this one. To distinguish Ektron CMS400.NET’s tags
from others, all Ektron CMS400.NET settings begin with ek_ and reside within
the <appSettings> tags of the web.config file.

Managing the web.config File
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Settings in the web.config File
Setting Description

Analytics - see Setting up Google Web Traffic Analytics on page 7-781 and Business
Analytics Feature on page 7-747

Connection Strings

For SQL Server

Use this connection string to define an SQL server.

n name=“Ektron.DbConnection”

n providerName=“System.Data.SqlClient”

n connectionString - this part of the connection string contains the
following element.

n server - the name of the database server to which Ektron
CMS400.NET is installed. If installed locally, the value is localhost. This
value is set during installation, at the Host screen.

n database - use the name of the database.

n Integrated Security - use True or False. True - use integrated
security.

n user - If required, specify the username used to connect to the DSN.
This user account must have at least read and write permissions to the
database.

Note: This value can be blank if you are usingWindows
authentication.

n pwd - If required, specify the password for the username given. It
shouldmatch your database name.

Note: This value can be blank if you are usingWindows
authentication.

Warning! After changing anydatabase settings, youmust stop and
restart the EktronWindowsService. See Also:EktronWindowsService
on page 22-7

appSettings
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Setting Description

ek_RedirectFromLoginKeyName

Providesamechanism to return from the login page to the previous
page, specify the query string key-name. Bydefault the value is
RedirectUrl.

Currently, the redirect works in two instances.

1. When a user tries to use a forum but is not logged in, it sends them
to a login page and returns them. The value in this keyused in
conjunction with the ek_RedirectToLoginURLkey sends the user
from a forum page to a login page and back to the previouspage.

For example, a user tries to reply to a forum post, but he is not logged in.
He is sent to the login page and then returned to the original page.

2. When a user sendsa privatemessage to another user or group
administrator from the SocialBar server control, he is returned to
the page where he clicked privatemessage once themessage is
sent.

For example, a user visits a community group’s page and clicksPrivate
Message Admin. The user is taken to the privatemessage screen and
once he clicks post, he is returned to the community group’s page. For
additional information, seePrivateMessaging from the Social Bar on
page 16-238.

ek_RedirectToLoginURL TheURL of the login page to automatically redirect to when a site visitor
is not logged in asa user or membership user.

GoogleMap
Enter connection information for using GoogleMapswith theMapping
feature in Ektron CMS400.NET. See Also:MapServer Controlon page
7-654

VirtualEarthMap
Enter connection information for using BingMaps for Enterprise with the
Mapping feature in Ektron CMS400.NET. See Also:MapServer Control
on page 7-654

ek_TreeModel

Choose whether or not to use Ajax for the folder tree in theWorkarea.

n 0 - use the legacy folder tree in theWorkarea.

n 1 - use Ajax for the folder tree in theWorkarea.

Warning! This keyhasbeen removed from theWeb.config file.
However, you can still use this keybyadding it between the
<appSettings> tags. For example, <add key=”ek_TreeModel”
value=”0”>changes the folder tree in theWorkarea back to legacy.

ek_workareaDateFormat

Choose how you want to display dates in some areasof theWorkarea.

n long - for example, SaturdayMay21, 2005

n short - for example, 5/21/2005

ek_sitePath

The location of Ektron CMS400.NET relative to theWeb root. This value
is set during installation at the Site Path Directory screen.

If youmove Ektron CMS400.NET to another folder, youmust update this
value.

Settings in the web.config File
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Setting Description

ek_buildNumber This value is set by the installation program. You typicallywould not
change it.

ek_version This value is set by the installation program. You typicallywould not
change it.

ek_appPath
This element is prefixed by the ek_sitePath value and describes the
location of the workarea folder. This file storesexternal applications
(such aseWebEditPro and eWebDiff), templates, and the images folder.

ek_xmlPath

The location of the xmlfiles directory. The ek_sitePathpath is prefixed
to this location.

You would only change this value if you want to move the location of the
xml files relative to theWeb root.

ek_pluginDir not used currently -- for future use

ek_appName The name of the application, CMS400. You typicallywould not change
this value.

ek_RedirectorInstalled

Setswhether the redirector is turned on or off in the Ektron
CMS400.NETWorkarea. Turning the redirector on enables the option
of aliasing the URL of your Web site. The default is false.

n True =Aliasing turned on

n False =Aliasing turned off

See Also:Creating User-FriendlyURLswith Aliasing on page 10-1

ek_RedirectorManualExt

Set a comma-delimited list ofWeb page extensions for which you will
want to create aliased pages. For example, .aspx,.htm,.html. By
default the list contains .aspx.

Note: You can enter one or more extensions. Each extensionmust
begin with a period, and the last extensionmust be followed bya
comma (,).

See Also:Creating User-FriendlyURLswith Aliasing on page 10-1

ek_LDAPMembershipUser
Integratemembership userswith LDAPor Active Directory. Set the
value to True for Membership Users to be authenticated using
LDAP/AD.

ek_appImagePath

The folder that stores the imageswithin Ektron CMS400.NET, such as
toolbar icons. You would only change this value if you need tomove the
images folder to another location.

Note that this value is prefixed by the value set in the ek_appPath
variable. Bydefault, ek_appPath is set to
webroot/cms400Min/workarea/. So, bydefault, this folder is set to
webroot/cms400Min/workarea/images/application/.

Installing Ektron CMS400.NET

1-74 ReferenceManual
Version 8.01 Rev 4



Setting Description

ek_appeWebPath

The folder that storeseWebEditPro, Ektron CMS400.NET’s editor. You
would only change this value if you need tomove the editor to another
location.

Note that this value is prefixed by the value set in the ek_appeWebPath
variable. Bydefault, ek_appeWebPath is set to
webroot/CMS400Min/workarea/. So, bydefault, this folder is set to
webroot/CMS400Min/workarea/ewebeditpro.

ek_appeXSLTPath

The folder that storesXSLTs. You would only change this value if you
need tomove the XSLT folder to another location.

Note that this value is prefixed by the value set in the ek_appPath
variable. Bydefault, ek_appPath is set to
webroot/CMS400Min/workarea/. So, bydefault, this folder is set to
webroot/CMS400Min/workarea/Xslt.

Images - These imagesappear before the user signs in, so cannot be stored in the database. Update as
needed.

Their location is set in the ek_appImagePathvariable. See Also: ek_appImagePath on previouspage

ek_Image_1
close button

ek_Image_2 small login button

ek_Image_3
big login button

SMTP server configuration - See Configuring SMTP Settings on page 1-87

ek_SMTPServer The server that processesemail

ek_SMTPPort The port your system uses to retrieve email

ek_SMTPUser The username set up to send and receive email

ek_SMTPPass The password set up to send and receive email

Mail Format

ek_MailFormat
The format of the email created in Ektron CMS400.NET. A value of
HTML generatesemail in HTML format, while a value of Text generates
plain text email.

SSL Support - See Configuring SSL on page 1-95

ek_UseSSL Determines if server will use SSL for security

ek_SSL_Port SSL port used byWeb server.
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Setting Description

Active Directory Server Configuration - See Active Directory Feature on page 15-39

ek_ADEnabled Whether your Ektron CMS400.NET usesActive Directory support.

ek_ADAdvancedConfig Enable Active Directory advanced configuration.

ek_ADUsername User name for the Active Directory server.

ek_ADPassword Password for the Active Directory server.

ek_AUTH_Protocol
The directory accessprotocol used with the Active Directory feature. The
default value is LDAP. Other protocols are GC (global catalog) and
WINNT.

Menu Settings - SeeWorking with Menus on page 9-133

ek_UserMenuType

Determines the appearance of themenu that appearswithin every
content blockafter the user signs in.

n 0 - New dynamicmenu - only appearswhen user moves cursor over
content block

n 1 - Old classicmenu - alwaysappears

n 2 - Menu without borders - a silver pin head appears above content
that hasamenu available. Hovering over this pin producesamenu.

See Also:Changing the Appearance of theWeb Site Content Menu on
page 7-6

ek_MenuDisplayType

Note:  This setting onlyworks if ek_UserMenuType is set to zero
(0).

Determines the appearance of themenu that appearswithin every
content blockafter the user signs in.

n 0 - Horizontal - menu iconsare arranged horizontally

n 1 - Vertical - menu iconsare arranged vertically and include the
tooltip text

Multilingual Settings

ek_EnableMultilingual

Enable or disable support for multilingual content

n 1 - enable

n 0 - disable

See Also:Enabling/Disabling Support for Multiple Language Content on
page 14-4
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Setting Description

ek_DefaultContentLanguage

Sets the four-digit, decimal representation of the default content
language. For example, American English is 1033.

If you have a version of Ektron CMS400.NET that precedes than 4.7, all
content blocksare set to this value during the upgrade.

See Also: TheDefault Language on page 14-8

ek_ServerURL

Mainly used inWeb services to determine the location of a remote
server.

For example, in aWeb farm environment, the content server can reside
in a remote location. In this case, the developer’s content is replaced with
this value, so all<img src=””…/>and <href…. referencespoint to
server named here instead of the local one.

Miscellaneous Settings

WSPath Determines the location of theWeb servicespage used by the server
controls at design time.

ek_BatchSize

The amount of files that can be uploaded at the same time. The default is
4, but it can be anynon negative number.

Note: Users can upload anyamount of files. The system handles
them four at a time.

ek_CacheControls

Choose whether to enable caching for Ektron CMS400.NET server
controls or not. For information, seeCaching with Server Controlson
page 24-33

n 0 - Disable

n 1 - Enable

ek_WorkareaSearchResultMode

Sets theWorkarea search-resultsmode.

n text - returnsa text only version of the search results.

n mixed - returns text and imagesassociated with search results.

n graphical - returnsa imagesassociated with search results. See
Also:Searching theWorkarea on page 9-89

ek_
WorkareaLibSearchResultMode

Sets theWorkarea Library search-resultsmode.

n text - returnsa text only version of the library search results.

n mixed - returns text and imagesassociated with library search
results.

n graphical - returnsa imagesassociated with library search results.
Result DisplayOptionson page 8-9

ek_
ShowWorkareaRetErrorReferrer

Choose whether to enable referrer debug information on the
RetError.aspxpage.

n True - enable

n False - disable
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ek_QueueName Path to themessage queue.

ek_LogFileName Path to the log file name for themessage queue

ek_loginAttempts

Ektron CMS400.NET hasa login security feature that, by default, locks
out a user after five unsuccessful attempts to log in. That feature is
controlled by this element.

See Also: Restricting Login Attemptson page 2-22.

ek_passwordCaseSensitive

Bydefault, passwordsare case insensitive. So for example, if the
password isTOKEN and the user enters token, the sign-on is successful.

If you want to make passwords case sensitive, change the value of this
element from false to true.

If you do, and the password isTOKEN and the user enters token, the
sign-on is unsuccessful. The user would have to enter TOKEN to sign on.
See Also:Making PasswordsCase Sensitive on page 2-25

ek_LinkManagement

This setting determines if Ektron CMS400.NET uses linkit.aspxwhen
inserting a quicklink. Bydefault, it is set to true.

If set to true, when a user inserts a quicklink, Ektron CMS400.NET
inserts a special link instead of a quicklink. A special link determines the
correct quicklink to use when a site visitor clicks it.

For example, a user addsa content block to folder A. A quicklink to that
content isa.aspx?id=10. Later, if an administrator changes the folder’s
template but doesn’t update the quicklinkwithin the content block, the
quicklink is broken.

To avoid this problem, enable linkmanagement.

ek_LoginScreenWidth The width of the login screen in pixels. Youmayneed to widen the screen
if you are using Active Directory and the database namesare long.

ek_ToolBarFormatTag

Note: This setting only appliesafter a user signs in to your site.

Change this setting if the colored border that surrounds content looks
wrong. (The border color indicates the content’s status.)

Bydefault, <table> tags create the border. If the border lookswrong or
inappropriate, change setting to div. If you do, <div> tagsare used to
draw the border instead of <table> tags.

This change typically solves the problem.
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Setting Description

ek_PageSize

This setting determines themaximum number of items that can appear
on a page before it “breaks.” When a page breaks, additional entries
appear on another screen, and the following text appears near the
bottom of the items list:

Page 1 of 2

[First Page] [Previous Page] [Next Page] [Last Page]

Note: The above text changesdepending on the page you are
viewing.

Youmust click an option to see and update the remaining items.

This setting affects pages that let you edit the following items:

n content

n library items

n menu items

n collection items

n membership users

n membership users not verified

forums

ek_XliffVersion Define the XLIFF version to use when exporting files. See Also:What is
XLIFF? on page 14-15

ek_extensionServiceEnabled Enable ExtensibilityPlug-in service. For more information on Plug-ins,
see Introduction.

ek_EnableDeveloperSamples

Enable the API developer sampleson the Developer demo site shipped
with CMS400.NET.

n True - enable developer samples

n False - disable developer samples

ek_assetPath

The folder that storesAssets. You would only change this value if you
need tomove the Assets folder to another location.

Note that this value is prefixed by the value set in the ek_appPath
variable. Bydefault, ek_appPath is set to webroot/CMS400Min. So, by
default, this folder is set to webroot/CMS400Min/assets.

ek_InvitationFromEmail
The “From” email address the system useswhen a user sendsan
Invitation. Invitationsare emails that are sent to non-system users asking
them to join your site. See Also: Invite Server Controlon page 16-223
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Setting Description

ek_EnableMessageBoardEmail

Setting this key to True enables the system to send e-mail notifications
when a user posts amessage to a user or community group’smessage
board.When a user posts amessage to another user’smessage board,
the user who owns the board receivesa notification stating amessage
hasbeen posted.When a user posts amessage to a community group’s
message board, allmembersof the group receive e-mail notifications.

It is important to note that when this key is set to True, it activatese-mail
notifications for all user and communitymessage boards. However,
content message boardsare not affected. See Also:Notificationson
page 16-122

ek_EditControlWin

Select which editor will be used byMicrosoftWindowsoperating system
users. Choice are:

ContentDesigner - Use the eWebEdit400 editor. This editor doesnot
require an ActiveX installation on the user’s computer.

eWebEditPro - Use the eWebEditPro editor. This editor requires an
ActiveX install on the user’s computer. See Also:Ektron CMS400.NET
Editorson page 7-26

ek_EditControlMac
Defines the editor that is usedMacintosh operating system user. This
must beContentDesigner.

See Also:Ektron CMS400.NET Editorson page 7-26

system.diagnostics

LogLevel

Enter a numeric value that determines the level of message logging. By
default, diagnosticmessagesare logged in the Event Log. Choicesare:

1 =Error: log errors.

2 =Warning: log errors and warnings.

3 = Information: log errors, warningsand informationals.

4 =Verbose: Everything is logged.

ektronCommerce - See Conducting eCommerce with Ektron CMS400.NET on page 17-1

ek_ecom_TestMode When set to true, payments are sent to a test gateway instead of the
actual one.

ek_ecom_DefaultCurrencyId

Select the default currencyand enter itsNumeric ISOcode. This should
be done before creating your product catalog.

Warning! Do not change the default currencyafter your eCommerce
site is live.

See Also: TheDefault Currencyon page 17-56

ek_MeasurementSystem Select whether to use English or Metricmeasurements for your
packages. See Also:Packageson page 17-87
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Setting Description

mediaSettings See Also: Managing Multimedia Assets on page 7-438

WindowsMedia-CLSID The class ID for theWindowsMedia Player.

Quicktime-CLSID The class ID for the Quicktime player.

Realplayer-CLSID The class ID for the Real player.

Flash-CLSID The class ID for the Flash player.

WindowsMedia-Codebase Location of the code base plug-in for WindowsMedia Player.

Quicktime-Codebase Location of the code base plug-in for Quicktime player.

Realplayer-Codebase Location of the code base plug-in for Real player.

Flash-Codebase Location of the code base plug-in for Flash player.

application/x-shockwave-flash Define the relationship between the Shockwave Flashmime type and
the Flash player.

audio/x-wav Define the relationship between theWAVmime type and theWindows
Media, Quicktime and Real players.

audio/x-wav-default Define the relationship between theWAVdefault mime type and the
WindowsMedia Player.

video/x-avi Define the relationship between the AVImime type and theWindows
Media, Quicktime and Real players.

video/x-avi-default Define the relationship between the AVI default mime type and the
Quicktime player.

video/x-msvideo Define the relationship between themsvideomime type and the
WindowsMedia, Quicktime players.

video/x-msvideo-default Define the relationship between themsvideo default mime type and the
WindowsMedia Player.

audio/x-ms-wma Define the relationship between theMS-WMAmime type and the
WindowsMedia Player.

video/mpeg Define the relationship between theMPEGvideomime type and the
WindowsMedia Player.

audio/mpeg Define the relationship between theMPEGaudiomime type and the
WindowsMedia Player.

video/x-realvideo Define the relationship between the realvideomime type and the Real
player.
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Setting Description

video/x-ms-wmv Define the relationship between theMS-WMVmime type and the
WindowsMedia Player.

audio/x-realaudio Define the relationship between the realaudiomime type and the Real
player.

video/quicktime Define the relationship between the quicktimemime type and the
Quicktime player.

Miscellaneous

session state
mode - This setting determines the storage option for session data.
Ektron CMS400.NET only supportsInProc. Other session statemodes
are not supported.

HttpHandlers

This section sets how the URL Aliasing feature handlesURLswith
certain extensions. If you have anyextension you do not want aliased,
add it below the following line using the same syntax.
add verb="*" path="*.png"
type="URLRewrite.StaticFileHandler,
Ektron.Cms.URLRewriter" />

maxRequestLength

This setting determines themaximum size of files that can be uploaded to
your server. The default setting is 204,800 kilobytes, or 200MB.

Enter the desired value in kilobytes. To convert megabytes to kilobytes,
go to http://www.onlineconversion.com/computer.htm.
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email Features
This section also contains the following topics.

Configuring email for Tasks and Content 1-83
Automatic eMail Notification 1-88
Customizing Ektron CMS400.NET email 1-89
Instant eMail 1-92

Configuring email for Tasks and Content
An email is sent to notify users when a task (such as approving a content block
or submitting a form) was performed or needs to be performed. This section
explains the steps needed to use Microsoft’s SMTP service to enable this kind of
e-mail notification in Ektron CMS400.NET.

To learn about email notification for Web Alerts, see Administering the Web
Alert Feature on page 23-1.

This section also contains the following topics.

CDOSYS 1-83
Set up SMTP Server 1-84
Verification for Relay 1-84
Configuring SMTP Settings 1-87
The Encrypt Password Utility 1-87
Error Messages 1-88

CDOSYS
To process email, Ektron CMS400.NET uses the CDOSYS model. Using the
Simple Mail Transport Protocol (SMTP) and the Network News Transfer Protocol
(NNTP) standards, CDOSYS enables applications based on Windows XP,
Windows 2000 or Windows 2003 to route e-mail and USENET-style news posts
across multiple platforms.

CDOSYS, the successor to CDONTS, is as easy to use as CDONTS but is more
powerful by letting authors create and view sophisticated emails using html and
data sources.

Note: If the SMTP server that is processing email does not find CDOSYS installed, it tries to
use CDONTS as a mail server protocol.
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Set up SMTP Server
For CDOSYS to work, set up the SMTP server on your local system (to which you
installed Ektron CMS400.NET) or a remote system that sends and receives
email.

Note: To access an SMTP server on a local or remote system, consult the system administrator
who manages email in your organization. This administrator may not be the same as the
Ektron CMS400.NET administrator.

n Local - Before setting up an SMTP server on your local system,
install IIS. The SMTP server settings on a local system would be
something like this:

“ek_SMTPServer" value=“localhost”

“ek_SMTPServer" value=“127.0.0.1”

“ek_SMTPServer" value=“myname”

n Remote - Set up an SMTP server on a remote system. The SMTP
server on a remote system can be something like this:

“ek_SMTPServer" value= “smtp.example.com”

“ek_SMTPServer" value= “example.com”

After the SMTP server is set up, configure it as described in Verification for
Relay below.

Verification for Relay
To verify that your Ektron CMS400.NET Web server’s IP address supports relay
through your SMTP server, follow these steps.

Note: The WWW and SMTP components of IIS must be installed on the Web server that hosts
Ektron CMS400.NET.

1. On your SMTP server, access your Internet Services Manager in the
Administrative Tools.

2. In the IIS Management Console, select the SMTP virtual server.

3. On the Action menu, click Properties.
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4. The SMTP properties window opens.

5. Click the Access tab.

6. The access properties appear.

Verification for Relay
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7. In the Relay Restrictions section, click the Relay... button.

8. The Relay Restrictions window opens. Set or remove relay
restrictions.
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Note: For more information, see “Configuring SMTP Virtual Server Relay Restrictions” from
this Web page:
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/58f05ef9-
55a3-42b3-9f57-27fdc8723b8a.mspx?mfr=true

Configuring SMTP Settings
Next, configure Ektron CMS400.NET to use SMTP.

1. Open the <siteroot>/web.config file. (See Managing the web.config
File on page 1-71.)

2. Move to the section of the file that has these settings.
<!-- SMTP Server configuration -->

<add key="ek_SMTPServer" value="localhost" />

<add key="ek_SMTPPort" value="25" />

<add key="ek_SMTPUser" value="" />

<add key="ek_SMTPPass" value="" />

3. Set the ek_SMTPServer value. See Set up SMTP Server on page 1-84.

4. Set ek_SMTPPort to the port your system will access to retrieve email.
In most cases, the port is set to 25. If that is not the case, see your
System Administrator.

5. Set ek_SMTPUser to the username that is set up for the SMTP Server to
send and receive email. Typically, the username takes the form of an
email address, such as “ek_SMTPUser“
value=“yourname@example.com“.

This retrieval of email is based on how basic authentication is set up
for you, though you do not need a username when using a local
SMTP server. Check with your System Administrator for details.

If you are using a remote system for accessing email, you must
provide an authenticated username before you can send or receive
email.

6. Set the "ek_SMTPPass" value to the password that is set up for
the SMTP server to send and receive email. This password is
based on the basic authentication. By default, the Ektron
CMS400.NET only accepts passwords in the encrypted form.

To encrypt the password, Ektron provides a password encrypting tool.
See The Encrypt Password Utility below.

The Encrypt Password Utility
To use the utility tool EncryptEmailPassword.exe, follow these steps.

1. Open C:\Program Files\Ektron\CMS400\Utilities

2. Run EncryptEmailPassword.exe.

Configuring SMTP Settings

ReferenceManual
Version 8.01 Rev 4

1-87

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/58f05ef9-55a3-42b3-9f57-27fdc8723b8a.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/58f05ef9-55a3-42b3-9f57-27fdc8723b8a.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/58f05ef9-55a3-42b3-9f57-27fdc8723b8a.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/58f05ef9-55a3-42b3-9f57-27fdc8723b8a.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/58f05ef9-55a3-42b3-9f57-27fdc8723b8a.mspx?mfr=true


3. The Encrypt Utility dialog appears.

4. Enter your SMTP password in the Text field.

5. Click the Encrypt button.

6. The screen displays an encrypted password in the Encrypted field.

7. Copy the encrypted password and paste it into the web.config file
after "ek_SMTPPass" value=.

Error Messages
When submitting a form or a content block in an approval process, if you get an
error message listed below, it is generated by the SMTP server on which you set
up the mail system, not by Ektron CMS400.NET.

n The Transport failed to connect to the server. [CBR SendMail
R1] [CBR R65] [DIO R 36]

n The server rejected one or more recipient addresses. The
server response was: 550 5.7.1 Unable to replay for
yourname@example.com [CBR SendMail R1] [CBR R1] [DIO
R36]

Automatic eMail Notification
Ektron CMS400.NET has an automated email system that sends emails to the
proper users when an action has been, or needs to be, performed. Emails are
generated when any of the following actions takes place.

email sent to When content is

Next approver Submitted to be published
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email sent to When content is

Next approver Submitted to be deleted

Author Published toWeb site

Author Declined to be published or deleted

In order for users to be notified of these actions, the following criteria must be
met:

n Valid system email address

n Enabled email notification

n User email address

n User email notification enabled

These values are set in the Edit User screen. See Also:Managing Users on page
15-3

The Tasks feature also has automatic email notification. For more information,
see Task Email Notification on page 12-35.

Content of Automatic email
The automatic emails are stored in and received from the database. Each email
consists of one string for the subject and one for the body. Ektron CMS400.NET
does not currently support HTML emails, but the messages are fully
customizable. For more information, see Customizing Ektron CMS400.NET
email below.

Customizing Ektron CMS400.NET email
Ektron CMS400.NET can send email notification to users, informing them that
actions have either taken place or are requested of them. For example, a
content contributor receives an email that his content has been published to the
Web site.

These emails are stored in the resource files. In that file, each email consists of
one string for the subject and one for the body. Ektron CMS400.NET does not
support HTML email, however the message text is fully customizable.

The procedure for customizing resource files is documented in Procedure for
Translating Workarea Strings on page 14-41.

The body of an email can include variables, located between@ symbols. Ektron
CMS400.NET replaces these variables with the information for that instance of
the email. For example, @appContentTitle@ in the following sentence is
replaced with the email’s title.

Content of Automatic email
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Before The content “@appContentTitle@” hasbeen deleted.

After The content “HomePageContent” hasbeen deleted.

These emails can be customized. The variables can be taken out or moved
around. More text can be added; text can be rewritten or reorganized.

Before “@appContentTitle@” hasbeen deleted from the XYZWeb site.

After “About Us” hasbeen deleted from the XYZWeb site.

Each message is called in the presentation layer by its message title.

Carriage Return/Line Feeds are represented by the variable @appCRLF@.
These cause the email to move down one line. For example:

Before The content wasapproved.@appCRLF@Thank you!

After
The content wasapproved.

Thank you!

This section also contains the following topics.

Variables 1-90
List of Ektron CMS400.NET Default email 1-91
Notify Approval Process Complete 1-91
Decline Approval Request 1-92
Send Approval Message 1-92

Variables
The following table lists variables you can use to customize email messages.
When the email is sent, the corresponding description replaces the variable.

Variable Inserts

@appCRLF@ Acarriage return.

@appContentTitle@ The title of the content block.

@appDeletionDateTime@ The date and time the content will be deleted from theWeb site.

@appChangeDateTime@ The date and time changeswill be updated on theWeb site.

@appDeclinerFirstName@ The first name of the user who declined the content block.
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Variable Inserts

@appDeclinerLastName@ The last name of the user who declined the content block.

@appSubmitterFirstName@ The first name of the user who submitted the content block.

@appSubmitterLastName@ The last name of the user who submitted the content block.

@appFolderPath@ The location of the content block in the folder tree in the Ektron CMS400.NET
Workarea.

@appContentLink@
The link to the content blockon theWeb site.

Note: Youmust be logged in to see the changes.

@appSubmitterDateTime@ The date and time the content blockwassubmitted.

@appApprovalList@ The current approval list that the content blockmust pass through.

@appComment@ Displays the comments for the content block.

@appPassword@ Displays the account password for ResetPassword and
RequestResetPasswordmessage types.

@appEmailFrom@ The addressof the email sender.

@appEmailTo@ The addressof the email receiver.

List of Ektron CMS400.NET Default email

Notify Approval Process Complete
Because of the logic, there are four emails for notifying that the approval
process is complete.

Deletion of Content Approved
Message Title: email subject: content deletion approved.

Message Text: Deletion of content has been approved.

Immediate Deletion of Content
Message Title: email subject: content has been deleted.

Message Text: Content has been deleted.

Approved Content Awaiting Go Live Date
Message Title: email subject: content changes approved.

Message Text: Content changes have been approved.

List of Ektron CMS400.NET Default email
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Approved Content Published Immediately
Message Title: email subject: content has been changed.

Message Text: Content changes have been made.

Decline Approval Request
Message Title: email subject: approval request declined.

Message Text: Content approval request declined.

Send Approval Message
Message Title: email subject: request for approval.

Message Text: Request for content approval.

Instant eMail
In addition to automatic email, Ektron CMS400.NET lets you send email
instantly to a user or user group from many screens. Your ability to send instant
mail is indicated by either

n a small mail icon next to a user or group name, as indicated in red
below

n a small mail icon on the toolbar, as indicated in red below

When you click one or more user/group names then the email icon, the email
screen appears, as shown below. Once you complete the screen and click Send,
an email is sent to designated users.
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This section also contains the following topics.

Condition for Instant eMail 1-93
Where Instant email is Available 1-93
Modifying Instant eMail 1-93

Condition for Instant eMail
n The email software must be configured for your server. See

Configuring email for Tasks and Content on page 1-83

Where Instant email is Available
Instant email is available from several screens that display users and user
groups. Typically, you click a user name or the email icon to launch an email.
Screens in the following Ektron CMS400.NET features support instant email.

n Tasks

n Approvals

n Reports

Wherever instant email is available, an email icon appears (circled in the
illustration below).

Modifying Instant eMail

Condition for Instant eMail
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When the email screen appears, the following information is copied from Ektron
CMS400.NET into the email.

Field Source of Default Information Editable?

To

User you selected to receive email. If the user doesnot have
valid email address, an error message appears. If you then
insert a valid email address, the email is sent.

If you specify a group to receive themessage, as long asone
groupmember hasa valid email address, all groupmembers
with valid addresses receive the email.

Yes.

If desired, you can
add recipients by
typing them into this
field.

From User who signed on to Ektron CMS400.NET. No

Subject If the emailmessage is linked to content, its title appears. Yes

Bodyof
message

If the emailmessage is linked to content, a content link
appears. Yes
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Configuring SSL
In Ektron CMS400.NET, you can use SSL when users log in to your Web site.
SSL encrypts the username and password during transmissions to the server.

When you set up the SSL certificate, and configure Ektron CMS400.NET to use
it, the login page is launched in a Secure Socket Layer. This section explains
how to set up SSL for Ektron CMS400.NET.

This section also contains the following topics.

Setting Up the Certificate 1-95
Updating the web.config File 1-97

Setting Up the Certificate
If your Web server does not have a certificate installed, you need to install one.
To do so, follow these steps.

1. Access the Internet Information Server Administrator Console on
your Web server.

2. Navigate to the computer and Web site to which Ektron CMS400.NET
is installed.

3. Right click on the Web site.

4. Click Properties.

5. Click the Directory Security tab.

Configuring SSL
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6. In the Secure communications area, click the Server Certificate
button.

7. Use the wizard to set up a certificate for your Web site.

8. Close the wizard. You return to the Properties window.
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9. Click theWeb Site tab at the top of the Properties window.

10. Set the SSL Port that the Web server will use.

11. Click OK.

Updating the web.config File
Next, configure Ektron CMS400.NET to use the SSL certificate.

1. Open the web.config file. (See Managing the web.config File on page
1-71.)

2. Move to the section of the file that has these settings.

<add key="ek_UseSSL" value="false" />
<add key="ek_SSL_Port" value="443" />

3. Set the ek_UseSSL value to true.

Warning! If the ek_UseSSL value is true, but you did not install the certificate to the Web
Server, you cannot log into Ektron CMS400.NET.

4. Set the ek_SSL_Port value to 443 (unless you specified another SSL
port).

5. Save and close the file.

Updating the web.config File
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You are ready to use the SSL support for Ektron CMS400.NET.
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Migrating Your Site to Ektron
CMS400.NET
This chapter explains how to migrate your Web site to Ektron CMS400.NET. This
chapter explains

n What to copy to your Web site

n Setting up and deploying templates

This chapter assumes you installed Ektron CMS400.NET and have read the
Ektron CMS400.NET documentation, so that you have an understanding of basic
concepts, some of which are mentioned here.

This section also contains the following topics.

Initial Steps 1-99
Setting up Your New Site 1-100
Creating a Login Page 1-101
Modifying Configuration Settings 1-101
Creating Ektron CMS400.NET Users 1-102
Configuring Content and Forms Folders 1-103
Creating your Templates 1-103
Migrating/Creating Content 1-104
Deployment 1-104
Advanced Features 1-104

Initial Steps
The following section describes tasks you need to perform before migrating
your Web site.

Installation
Ektron CMS400.NET requires a physical installation of the product. If you do not
have physical access to the machine, someone with access to the machine must
run the install.

Note: For more information, see Installing Ektron CMS400.NET on page 1-18.

Verify Installation
After you install Ektron CMS400.NET, verify that it is properly installed by using
the starter site. By default, the sample Web site is located at the following
address on the machine to which Ektron CMS400.NET is installed.
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http://localhost/siteroot/default.aspx

If you can browse the starter site and it works properly, Ektron CMS400.NET is
properly installed.

Best Practice
Ektron recommends keeping a working version of the starter site. This
can be used to help you debug problems.

For instance, if you encounter errors on your site, you can refer to the
starter site to see if the same errors occur. If they do, that may indicate
a problem with the installation. If they do not, the installation is
probably OK and an external factor is causing the problem.

Setting up Your New Site
Note: You can use the Site Setup utility to perform these tasks. To launch this utility, go to Start
> Programs > Ektron > CMS400 > Utilities > Site Setup. To read about it, go to Setting up a
Site on page 1-25.

This section also contains the following topics.

Copy Application Core Files 1-100
Set up the Database 1-100
Modify Application Parameters 1-100

Copy Application Core Files
Copy the application core files from the siteroot/workarea folder into your
site’s folder. These files operate the workarea, library, and content functions.

Set up the Database
Since the content is stored in a database, you need to create one. To learn how
to set up a database, see Setting up a Database on page 1-28.

Modify Application Parameters
After you install and create the Ektron CMS400.NET database, modify the
web.config file that installed to the directory to which you installed Ektron
CMS400.NET.

Edit that file and modify the following settings
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Setting Type in...

ConnectionString

Update the information between the <Con-
nectionString> tags to point to your:
n server

n database

n user

n pwd

Note: If you are using SSL, the settings you need to modify are explained in Configuring
SSL on page 1-95.

Creating a Login Page
Now that everything is set up, you can create a login page. You can either copy
the one from the starter site or create your own.

See Also: Login Server Control on page 2-10

Log In
To log into your Ektron CMS400.NET Web site, follow these steps.

1. Browse to the login page you created and click the Login button.

2. A login dialog box opens asking for a username and password.

3. Enter the default username (admin) and password (admin) and
click Login.

4. You are logged into Ektron CMS400.NET

Note: If you get a message that the application is locked, log in using the username and
password builtin/builtin. You get the message if your license key is invalid or has not been
entered yet.

Modifying Configuration Settings
After you log in, access the Workarea by clicking on the Workarea button. From
there, you can modify the configuration settings.

This section also contains the following topics.

Set up Active Directory 1-102
Modify the Setup Screen 1-102
Set up Metadata 1-102
Set up Smart Forms 1-102
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Set up Active Directory
If plan to use Active Directory, configure this now. The settings for Active
Directory can be found in the Settings > Configuration folder. Refer to Active
Directory Feature on page 15-39.

Modify the Setup Screen
The Ektron CMS400.NET setup section is located under the Settings >
Configuration folder. The setup section allows you to configure items such as
your license key, style sheet support, max summary size, and default language.

See Modifying the Application Setup Screen on page 1.

Set up Metadata
Ektron CMS400.NET includes extensive metadata support. Settings for
metadata definitions can be found under the Settings > Configuration folder
in the Workarea. You can have as many metadata definitions as needed.

See Working with Metadata on page 7-141 for more information.

Set up Smart Forms
You can also set up your Smart Forms. You create XML files externally or via
the Data Designer. Next, a Smart Form is assigned to content blocks and
folders.

See Working with Smart Forms on page 7-278 for additional information.

Creating Ektron CMS400.NET Users
If you are not using Active Directory support, add your users manually. The
maximum number of users is determined by your license key. For instance, if
you purchase a 10-user license, you can enter 10 users.

Note: If you exceed the licensed number of users, you may get locked out of Ektron
CMS400.NET.

Every user must belong to a group. When you first add a user, he or she is
automatically added to the Everyone group. You can create more user groups
and add users to them as desired.

For more information, see Managing Users and User Groups on page 15-1.

Installing Ektron CMS400.NET

1-102 ReferenceManual
Version 8.01 Rev 4

../../../../../Content/Main_Import_file/setup screen.htm#setup_screen_398861007_51035
../../../../../Content/Main_Import_file/setup screen.htm#setup_screen_398861007_51035
../../../../../Content/Main_Import_file/setup screen.htm#setup_screen_398861007_51035
../../../../../Content/Main_Import_file/setup screen.htm#setup_screen_398861007_51035
../../../../../Content/Main_Import_file/setup screen.htm#setup_screen_398861007_51035
../../../../../Content/Main_Import_file/setup screen.htm#setup_screen_398861007_51035
../../../../../Content/Main_Import_file/setup screen.htm#setup_screen_398861007_51035
../../../../../Content/Main_Import_file/setup screen.htm#setup_screen_398861007_51035


Configuring Content and Forms Folders
Next, create folders to organize content blocks and forms. Create as many
folders as you want. Each folder level can go as deep as you want.

Best Practice
Keep your folder structure simple so it’s easy for your users to
navigate. Organize folders in a way that makes sense to the users
who will navigate through them. So, you may have 6 or so top level
folders, and each folder may go 4 or so deep.

This folder structure is replicated under the Library folder.

As you create folders, you can assign a default template and style sheet. The
default template is used when a new content block is created and Ektron
CMS400.NET creates a Quicklink that points to the new content block. If you do
not provide a default template, it is inherited from the parent folder.

After creating the folders, assign permissions and workflow to them.
Permissions can be assigned to a user or a user group. The same is true for the
approval process.

Best Practice
Limit permissions for the “Everyone” group, as this gives every user
permissions to that content. Similarly, you should limit the “Everyone”
group’s inclusion in the approval chain if you want to restrict which
users can publish content.

Creating your Templates
Now you can create your templates. Templates contain the look and feel of the
site. Masthead, navigation, and footer graphics are all part of the template. Use
server controls to insert Ektron CMS400.NET content into a template. For a list
of server controls, see Working with Ektron CMS400.NET Server Controls on
page 24-1.

Best Practice
Since dynamic templates include URL parameters, make each main
landing page and other important pages static tags. This makes it
easier for you to remember if you need to provide that link to
someone.

For instance, each main landing page from your home page could
use the static tag. Then, as you go deeper into that section,
subsequent pages use a dynamic tag.
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Migrating/Creating Content
At this point, you can begin to create/migrate your content. If you are migrating
content from an existing site, add a new content block, and cut and paste the
content into the Ektron CMS400.NET editor.

Note: All images and files must be uploaded and inserted into the content separately.

Deployment
Deployment from development to production is as simple as moving the files
over. To properly deploy your new Ektron CMS400.NET Web site, follow these
steps.

1. Copy all assets (templates, images, files, etc.) from your
development box to your production machine.

2. Move the database. You have two choices

n point your data source on the production machine to the database you
were using

n copy the database, move it to your production box, and point a data
source to that

Advanced Features
The previous information allows you to create a basic Ektron CMS400.NET Web
site from scratch. This section explains some advanced features that you may
implement, although they are not needed for the Web site to function properly.

Email Notification
For email notification to work in Ektron CMS400.NET, make sure the SMTP
service is setup and running in IIS, and that it points to a valid mail server.

Refer to Configuring email for Tasks and Content on page 1-83 for additional
information.

Installing Ektron CMS400.NET

1-104 ReferenceManual
Version 8.01 Rev 4



Creating a Web Site in IIS
Note: This text is adapted from Microsoft’s IIS help.

Adding Web Sites to Your Server
IIS lets you create multiple Web sites on a single server. To create a new Web
site, you must

n prepare the server and associated network services

n create a unique identity for the site

This section also contains the following topics.

Preparing to Add a Web Site 1-105
Adding a Web Site 1-106
Adding a Web site with the Web Site Creation Wizard 1-107
Adding a Web Site with the iisweb.vbs Command-Line Script 1-110
Related Topics 1-110

Preparing to Add a Web Site
Adding a Web site to a server requires careful preparation before running the
Web Site Creation Wizard. Consider these recommendations.

n Review the methods of hosting multiple Web sites, and determine
which one is appropriate for your environment.

n Multiple Web sites can use the same IP address. But if you decide to
use a unique IP address for the new Web site, obtain a static IP
address from your organization or ISP. Then, configure the server’s
TCP/IP settings.

n If you use a host header name to identify the new Web site, select a
unique name. On a private network, the host header can be an
intranet site name. But on the Internet, the host header must be a
publicly available Domain Name System (DNS) name, such as
support.microsoft.com. Register a public DNS name with an
authorized Internet name authority.

n Update your name resolution system (typically DNS) with a new
record that contains the new IP address and site name. For more
information, see Domain Name Resolution in IIS help.

n Standard Internet services use TCP port 80 by default. It is not
recommended to use any other port for HTTP services.

Creating aWeb Site in IIS
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If you use a non-standard TCP port number to identify a new Web
site for special situations (such as a private Web site for
development/testing), select a TCP port number above 1023. In this
way, the number does not conflict with well-known port numbers
assigned by the Internet Assigned Numbers Authority.

n Use Windows Explorer to create a home directory for the content.
Create subdirectories to store HTML pages, image files, and other
content as needed.

To organize home directories for multiple Web sites on one server,
create a top-level directory for all home directories, then
subdirectories for each site.

You can create a home directory

- on the local server

- as a uniform naming convention (UNC) path on a network share

- as a URL that redirects clients to a different Web server

You can also create virtual directories that map to physical
directories. For more information, see “Setting Home Directories”
and “Using Virtual Directories” in IIS help.

n Determine whether to generate the Web site’s identification number
incrementally or from the Web site name. When you create a new
site using IIS 6.0, a Web site identification number is randomly
generated using the Web site name.

With IIS 5.1 and previous versions, site identification numbers were
generated incrementally. For example, because the default Web site
is created first, its Web site identification number is 1. The next site
created is 2. For more information, see
“DisableLazyContentPropagation in Global Registry Entries” in IIS
help.

n Create a home page that clearly identifies the new site.

Adding a Web Site
IIS provides two methods for adding a new Web site.

n The Web Site Creation Wizard

n The iisweb.vbs command-line script

Important: You must be a member of the Administrators group on the local computer to perform
the following procedure (or procedures), or you must have been delegated the appropriate
authority. As a security best practice, log on to your computer using an account that is not in the
Administrators group, and then use the Run as command to run IIS Manager as an administrator.
From the command prompt, type runas /user:administrative_accountname "mmc
%systemroot%\system32\inetsrv\iis.msc".
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Adding a Web site with the Web Site Creation
Wizard

1. In IIS Manager, expand the local computer, right-click the Web Sites
directory, point to New, and clickWeb Site.

2. Click Next.

Adding aWeb site with theWeb Site Creation
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3. In the Description box, enter the name of the Web site and click
Next.

4. In the Enter the IP address to use for this Web site box, click
All Unassigned to allow HTTP to respond to all unassigned IP
addresses on the server, or click a specific IP address for the site.

Note: In the Web Site Creation Wizard, All Unassigned refers to IP addresses assigned to a
computer but not a specific site. The default Web site uses all IP addresses not assigned to
other sites. Only one site can be set to use unassigned IP addresses for a given port number.
For more information on how sites are identified, see Creating Multiple FTP Sites in IIS help.

5. The TCP port is assigned to port 80 by default. To use a nonstandard
port number to create a unique identity for a private Web site, use the
TCP port this Web site should use box, and type a new port
number above 1023.

6. In the Host Header for this Web site (Default:None) box, type a
host header name to identify a Web site. If you are adding additional
sites to a single IP address by using host headers, you must assign a
host header name containing the full name of the site, for example,
www.ektron.com.

7. If SSL encryption is enabled on the server, the SSL port box appears.
Type the SSL port number, and then click Next.
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8. In the Path box, type or browse to the path of your Web site home
directory.

9. Web sites are configured for anonymous access by default. To create
a secure or private Web site, clear the Allow anonymous access to
this Web site check box, and click Next.

10. In the Web Site Access Permissions dialog box, select the
permissions for the home directory. Click Next, and then click
Finish.

Adding aWeb site with theWeb Site Creation
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Adding a Web Site with the iisweb.vbs Command-
Line Script
If the new Web site will be in a new directory, create the new directory. Follow
these steps to do that.

1. From the Start menu, and click Run.

2. In the Open box, type cmd, and click OK.

3. From the command prompt, switch to the systemroot\system32
directory.

4. Type cscript iisweb.vbs /create Home DirectorySite
Description" /i IP Address /b Port and click <Enter>.

For example, the following command creates a Web site called MyWebSite on
port 80 at IP address 123.456.789 with c:\inetpub\wwwroot\newdirectory as
its home directory.

cscript iisweb.vbs /create c:\inetpub\wwwroot\newdirectory "MyWebSite" /i 123.456.789 /b
80

Note: The iisweb.vbs script supports additional options for creating a Web site. To see them,
search for iisweb.vbs in Windows Help.

Related Topics
The following IIS help topics provide additional information.

To change properties on existing Web or FTP sites, see “Changing Default Web
Site Settings.”

To add virtual directories, see “Using Virtual Directories.”

To perform common tasks from command-line scripts, see “Using Command-
Line Administration Scripts.”
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Chapter 2

Getting Started with Ektron
CMS400.NET
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Using Ektron CMS400.NET to manage Web content is easy once you know the
basics of setting up and maintaining your site. This documentation explains how
to maintain an Ektron CMS400.NET site. By reading this documentation, you will
gain an understanding of how Ektron CMS400.NET works.

This section introduces basic concepts that you should understand when
beginning to work with Ektron CMS400.NET.

This section also contains the following topics.

About Ektron CMS400.NET 2-2
What is a Content Block? 2-2
Types of Content 2-3
Workflow in Ektron CMS400.NET 2-5
Editing Content 2-5
The Lifecycle of Content 2-6
Logging In and Out 2-6
Using the Application Setup Screen 2-27
Updating Setup Information 2-28
Enabling WebImageFX 2-34
Enabling CMS to Create File System Folders 2-34
BuiltIn User 2-35

About Ektron CMS400.NET
Ektron CMS400.NET is a powerful, easy-to-use, and affordable XML content
management solution that empowers anyone to take an active role in managing
Web content and optimizing online strategies. It streamlines site management,
automates workflow processes, and supports collaboration. Ektron CMS400.NET
reduces costs, saves time and makes Web sites, extranets, and intranets more
effective – while generating rapid ROI.

Business users, like marketing or PR pros, can author, manage and publish Web
content, build and deploy Web forms, and collect and leverage visitor info. Our
browser-based editor supports the industry’s best in-context editing
environment – ensuring user adoption and project success.

Ektron CMS400.NET also helps to move paper-based forms processes to the
Web. Our editor lets users create Web forms such as expense reports, health
records, and insurance forms, deploy them to internal users, collect data, apply
validation and math functions, and run forms through workflow – all within a
browser.

What is a Content Block?
A Web site consists of several pages. Each page is made up of one or more
blocks of content. For example, the home page from one of Ektron
CMS400.NET’s sample sites is below.
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You can work with content from the Web site or after logging into the Ektron
CMS400.NET Workarea. See Also:

n Working with Content From Workarea vs. Web Site on page 7-3

n Using The Workarea and Smart Desktop on page 3-1

Types of Content
Every piece of content in Ektron CMS400.NET is one of the following types. The
table below summarizes all types.

Type Description
For more
information,
see

HTML content Content designed to be published on theWorldWideWeb

Ektron
CMS400.NET
Editorson
page 7-26

XMLSmart Forms Online forms, polls, or surveysdesigned to collect information
from site visitors and save it in an XML format

Working with
Smart Forms
on page 7-
278

HTML form/survey Online forms, polls, or surveysdesigned to collect information
from site visitors and save it in an HTML format

Working with
HTML Forms
on page 7-
212

DMSDocuments, which
consist of Office
documents, managed
files, andmultimedia
files

See details below

Types of Content
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Type Description
For more
information,
see

Office documents Files normally created and edited usingMicrosoft Office

Working with
Microsoft
Office
Documents
on page 7-
403

Managed files
Files created outside of Ektron CMS400.NET, such asPDFs
and .jpeg files. You cannot create or edit these fileswithin
Ektron CMS400.NET - you can only store them.

Working with
Managed
Fileson page
7-428

Multimedia Files that run in amedia player, such as sound andmovie files

Managing
Multimedia
Assetson
page 7-438

Blogs
Blogs (short for Web Logs) are a form of online information
sharing. A blog is often set up so a group of people can share
their thoughts on a subject.

Blogson page
7-472

WebCalendars
WebCalendars keep visitors informed about upcoming events.
They can be displayed to all visitors to your Web site, and any
authorized user can add events to a calendar.

Calendarson
page 7-527

DIscussion Boards

The Discussion Board feature providesan opportunity for topic
discussionson your Web site. A site or membership user with
Add Topic permission createsa topic and posts a starter ques-
tion. Site visitors can then reply.

Discussion
Boardson
page 7-576

When creating new content, you must assign a type.
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As you can see, the New menu lists all types of content you can work with.

Workflow in Ektron CMS400.NET
Organizations typically want a Web site that is updated frequently with the
latest information. They also want to decentralize the update process, so that
non-technical users from any department can make changes. Further,
organizations want oversight over those changes to ensure the accuracy of the
information, that the content adheres to corporate guidelines, etc.

Ektron CMS400.NET manages the lifecycle of content, from creation through
approval and publication. It helps your organization set up a process for
overseeing changes to a Web site, indicate content’s status within that lifecycle,
and inform the next approver that it is their turn to review the content.

Editing Content
Click the Edit button ( ) or menu option to open content in an editor. Below is
an example of content within the editor.

Workflow in Ektron CMS400.NET
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The editor resembles popular word processing software. You can enter text,
then select it and click a button to change its display properties. For example,
you can make text bold, change the color, or copy and paste it. You can also
insert images, tables, links to other Web pages, and check spelling. See Also:
Ektron CMS400.NET Editors on page 7-26

The Lifecycle of Content
After you edit content, you typically submit it for approval to one or more
individuals who oversee changes to your Web site. These people can review,
edit and approve the change. When the last approver signs off, the new content
becomes available on the Web site.

In some cases, you are one of the content approvers. In this case, you receive
an email notifying you that content needs approval. You look it over, change it
as needed, then pass it on to the next approver. If you do not agree with the
changes, you can decline the request. In this case, the user who made the edits
is informed that the change is not approved.

The following graphic illustrates the content approval cycle.

To help track content’s position in this workflow, Ektron CMS400.NET assigns a
status to each content item. The status determines what you can do with it, and
indicates what must occur in order for it to get published to the Web site. For
more information, see Content Statuses on page 7-130.

Logging In and Out
This section explains how to log in and out of Ektron CMS400.NET, use the Site
Preview feature, and password/login management.

This section also contains the following topics.

Prerequisites 2-7
Logging into an Ektron CMS400.NET Web Site 2-8
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Site Preview 2-9
Toggling Site Preview 2-9
Logging Out of the Sample Site 2-10
Login Server Control 2-10
Placing a Login Button 2-11
Login Server Control Properties 2-11
Facebook Login 2-14
Samples of the Facebook Login Feature 2-14
Using Facebook Login with Active Directory 2-15
User Experience 2-15
Developer Experience: Setup Instructions 2-16

Step 1: Connect Facebook to Your Ektron CMS400.NET Web Site
2-
17

Step 2: Create or Modify a Facebook Login/Signup Page 2-18
Alternative to Redirecting to the Signup Form 2-20
Step 3: Place the Facebook Login Server Control on a Page 2-20
Using Facebook Connect Extension with the Targeted Content
Widget

2-
21

Restricting Login Attempts 2-22
Changing the Number of Unsuccessful Login Attempts 2-23
Unlocking a Locked Account 2-23
Manually Locking a User from Signon 2-23
Disabling the Login Attempts Feature 2-23
Preventing CMS Users from Signing On 2-24
Preventing All Users from Signing On 2-24
Changing Images Used for Logging In and Out 2-24
Resolving Problem with Login Screen 2-24
Password Management 2-25
Making Passwords Case Sensitive 2-25
Forcing Password Change Every 90 Days 2-26
Password Character Minimum, Include Alpha and Numeric Char-
acters

2-
26

New Passwords Cannot Match the Last Four Passwords 2-26
After 15 Minutes of Inactivity, User Must Log in Again 2-26

Prerequisites
Once your Webmaster or administrator installs Ektron CMS400.NET, you need
the following items before you can use it.

URL (Web address) of Ektron CMS400.NET Web site

Username and password

Once you acquire both, you can log into Ektron CMS400.NET and begin
managing Web site content.

Prerequisites
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Logging into an Ektron CMS400.NET Web
Site
To sign on to an Ektron CMS400.NET site, follow these steps.

1. In your Web browser, navigate to the URL of your Ektron CMS400.NET
Web site. Your system administrator provides this.

2. Click the Login button on the screen. The Login dialog box appears.

3. Enter your username and password.

If you are using one of Ektron’s sample sites, you can use any of three standard
users that demonstrate Ektron’s flexible user-permissions model. The table
below lists the username and password needed to log in as each user type, as
well as the permissions assigned to each user.

User Type Username Password Permissions

Administrator admin admin All

Standard user jedit jedit Basic (for example, add/edit content, manage library files,
etc.)

Membership
user jmember jmember Read-only permission to private content

4. Click the Login button. The Web page appears.

Getting Started with Ektron CMS400.NET
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You can navigate around your Web site as you could before signing in. But now,
the content is either surrounded by a border or has a Silver Access Point in the
top left corner (illustrated below).

For more information, see Web Site Content Menu Options on page 7-4.

Site Preview
While logged into Ektron CMS400.NET, you can preview the Web site as it would
appear to visitors, or view it in regular view.

Button
Appearance

Status Description

Preview
Mode

Content appears as last edited. The advantage of thismode is that you can see
aWeb page as it will appear when published to your site. Continue editing until
you are satisfied with its appearance.

In Preview mode, click thePreview button to switch to regular mode.

Regular
View

Themost recentlypublished version of content appears.

In thismode, colored borders surround content when youmove the cursor over
it.

In regular view, click thePreviewbutton to switch to preview mode.

Toggling Site Preview
To toggle site preview on and off, follow these steps.

1. Navigate to a page that includes the login/logout button.

2. Click the Preview button:
3. The Web site is now in preview mode.

Site Preview
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4. To turn preview mode off, click the ( ) button on the login
screen.

Logging Out of the Sample Site
To log out of Ektron CMS400.NET, follow these steps.

1. Click the Logout option from the content menu, or click the Logout

button ( ) on the Web page.
2. The Logout confirmation box appears.

3. Click the Logout button.

4. You return to the Web page from which you logged out. However, it is
in standard view, not Ektron CMS400.NET view.

Login Server Control
The Login server control paints a login button on the template when displayed in
a browser. When the Login server control is inserted and the project is built, the
control displays the following buttons on a Web page.

Getting Started with Ektron CMS400.NET
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Button Description

When user is not logged in, this button appears. Clicking the button opens the login
window, where a user can enter a username and password. Upon authentication, the
user is logged in to the Ektron CMS400Web site.

After a user logs in, this button replaces the login button to let the user log out.

When logged in, this button appears under the logout button, allowing the user to
access theWorkarea.

Lets the user preview the entireWeb site as if all checked-in content were published.
For more information, seeSite Preview on page 2-9Logging In andOut on page 2-6

Turnsoff site preview mode.

Launchesonline help for Ektron CMS400.NET.

This subsection contains the following topics:

n Placing a Login Button below

n Login Server Control Properties below

Placing a Login Button
You can add any number of login buttons to a template. You can insert a login
button on each template, or set up a special Web page, called login.aspx, from
which users can log into the CMS400 site without the public being able to access
the page.

Login Server Control Properties
The following table explains the properties of the Login server control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value Data Type

Authenticated

Indicates if you are logged in to the CMS
Explorer and can use it to browse to Content,
Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-
8

String

Placing a Login Button

ReferenceManual
Version 8.01 Rev 4

2-11



Property Value Data Type

AutoAddType

When using Single Signon, the Login Server Control
can be used to add users to Ektron CMS400.NET. In
this scenario, when a user signson with hisActive
Directory credentials, that user is created within the
Ektron CMS400.NET database.

Use this property to define the type of user that is
automatically added to Ektron CMS400.NET.

Author=Ektron CMS400.NET user

Member=membership user

See Also:Single SignOn on page 15-71

Common.EkEnumeration.
AutoAddUserType

AutoLogin

If this property is set to true and Active Directory
Integration is enabled, users are automatically
logged in using Active Directory authentication. They
do not need to enter a username or password.

The default is False.

True =Use Active Directory authentication when
logging in.

False =Do not use Active Directory authentication
when logging in.

Warning! For this property to function
properly, youmust be using Active Directory
authentication with your Ektron CMS400.NET Site.
See Also:Active DirectoryFeature on page 15-39

Boolean

DoInitFill

By default, Fill occurs during the Page_Init event. Set
to false if you want to postpone the fill-action until
later. In this case, FIll is automatically called during
the Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

Hide

Used to hide login button in design time and run time.

True =Hide login button

False =Show login button

Boolean

Language
Set a language for the Login server control. This
property shows results in design-time (in Visual
Studio) and at run-time (in a browser).

Integer

Getting Started with Ektron CMS400.NET
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Property Value Data Type

OnlyAllowMemberLogin

Allowsonlymembership users to log in. This property
prevent users from logging asan Ektron
CMS400.NET user and accessing the Ektron
CMS400.NETWorkarea.

If a CMSuser tries to log in using this control, this
message appears: “Onlymembersare allowed to
login here.”

The default isFalse.

True =Onlymembership users can log in

False =Ektron CMS400.NET users and
membership users can log in

Boolean

PromptLogout

When set to False, the logout processomits the
Logout window (shown below).

True =Usersmust click the Logout button to log out.

False =The Logout window doesnot appear

Boolean

SuppressHelpButton

Hides the Help button that appears below the Login
button when set to true. The default is False.

True =Do not display the Help button.

False =DisplayHelp button.

If you are editing this server control from a text file
and want to suppress the Help button, add the
following code to the login tag source:

<CMS:Login ID="Login1" runat="server"
SuppressHelpButton="True" />

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround
the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

Login Server Control Properties
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Property Value Data Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line
portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply
attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

Facebook Login
The Facebook Login is an alternative to Ektron CMS400.NET's standard login. Its
advantage is that users can log in using their Facebook username and
password, instead of having to set up and remember a separate Ektron
CMS400.NET username and password.

Here is an example of Facebook Login control on a Web page.

The Facebook Login control allows both Membership users and Ektron
CMS400.NET users log in to an Ektron CMS400.NET Web site. If users already
have an Ektron CMS400.NET user profile, they can be prompted to link the
Facebook username and password with that profile.

The Facebook Login only provides an ability to log in to an Ektron CMS400.NET
site. It provides no other Facebook features, such as viewing or sending
messages.

This section explains how to set up and use the Facebook Login feature through
these topics. Facebook

n Samples of the Facebook Login Feature below

n Using Facebook Login with Active Directory on the facing page

n User Experience on the facing page

n Developer Experience: Setup Instructions on page 2-16

n Using Facebook Connect Extension with the Targeted Content Widget
on page 6-50

Samples of the Facebook Login Feature
You can see samples of the Facebook Login feature in these sites.

n Developer Sample site > Social Networking > Facebook Connect

- site root/developer/FacebookConnect/Login.aspx

Getting Started with Ektron CMS400.NET
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- site root/developer/FacebookConnect/CustomSignup.aspx

n Ektron Tech site has Facebook Login on the home page

Using Facebook Login with Active Directory
You cannot use the Facebook Login feature with Active Directory.

User Experience
Note: The user experience is only enabled after a developer sets up the feature. See Also:
Developer Experience: Setup Instructions on next page

If a user clicks a Facebook Login button but is not logged into Facebook, the
page below appears

When the user completes this screen or if the user is already logged into
Facebook, he is forwarded to a page (see example below) that prompts him to
register or log in to Ektron CMS400.NET.

Using Facebook Login with Active Directory
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This screen asks the user if he has a membership account and, if so, would he
like to connect his Facebook username and password with the Ektron
CMS400.NET account. If the user agrees, he will access his membership
account via the Facebook Login control with Facebook credentials from now on.

If the user does not have a membership account, he completes the lower half of
the screen. This is the same screen that new members use to create accounts.
See Also: Membership Server Control on page 16-19

From then on, the user can click the Facebook Login button to log into Ektron
CMS400.NET using his Facebook username and password.

When the user logs out of Ektron CMS400.NET, that action does not log him out
if Facebook. Conversely, if a user logs out of Facebook, he is not logged out of
Ektron CMS400.NET.

Note: Facebook often caches some information in your browser. If you see JavaScript errors or
other odd behavior, clear the browser cache, close all browser windows, and try again.

Developer Experience: Setup Instructions
To set up the Facebook Login feature, follow these steps.

n Step 1: Connect Facebook to Your Ektron CMS400.NET Web Site on
the facing page

n Step 2: Create or Modify a Facebook Login/Signup Page on page 2-18

Getting Started with Ektron CMS400.NET
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n Alternative to Redirecting to the Signup Form on page 2-20

Step 1: Connect Facebook to Your Ektron
CMS400.NET Web Site
Follow these steps to obtain Facebook keys, paste them into the web.config
file, and identify your site to Facebook.

1. In you don't have one, create a Facebook account. Go to
www.facebook.com and follow the sign up instructions.

2. Sign in to the Facebook Developer site,
http://www.facebook.com/developer.

3. Click +Set up New Application.

4. Enter a name for your application. The name cannot include
facebook or any variations, such as FB.

5. A new screen appears, showing your Application ID, API key, and
Secret key.

6. Open your Web site's root folder/web.config file.

7. Copy the corresponding Facebook keys into these web.config
elements

n ek_FacebookApiKey

n ek_FacebookSecret

Note: Keys shipped in Ektron sample sites are for localhost.

Note: Make sure the Facebook keys were generated for the host header/URL to which you're
applying them. Also, if you are testing using secure site setup, verify that the web.config
element ek_useSSL is true.

8. Save and close web.config.

9. Return to the Facebook Basic screen.

10. Click the Connect tab from the left panel.

11. Into the Connect URL field, enter the URL of your Web site.

Step 1: Connect Facebook to Your Ektron
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n for a public site, enter its URL. For example, www.ektron.com.

n for a shared server or if you are accessing the site from a remote
machine, use the IP address. As examples, http://192.168.14.10,
http:// 192.168.14.10/QA

n for a local server, use localhost. As examples, http://localhost,
http://localhost/EktronTech

12. Save and close the Facebook screen.

After setting up your application, you can return to this screen at any
time to view the keys, edit the Connect URL setting, etc.

Step 2: Create or Modify a Facebook Login/Signup
Page
Facebook provides a sample form (shown below) that appears if a user clicks a
Facebook Login button and is not currently logged into Facebook.

Getting Started with Ektron CMS400.NET
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The above form is created by Facebook, not Ektron CMS400.NET.  You can
customize parts of it, such as the title and site image) using Facebook's
Application settings.

When the user completes the form, he is forwarded to an Ektron CMS400.NET
form (see example below) that prompts him to register or login to Ektron
CMS400.NET.

You specify which form appears via the Facebook Login server control's
SignupTemplate property. The default form in the Developer sample site, site
root/Developer/FacebookConnect/register.aspx, is shown above. You can
use the default form as is, modify it, or create your own.

The logic to connect a Facebook user with an Ektron CMS400.NET account
(circled below) is not part of the Facebook Login server control. However,
sample code for that functionality is included in the Ektron Tech sample site's
register.aspx page.

Step 2: Create or Modify a Facebook Login/Signup
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Alternative to Redirecting to the Signup Form
If you do not want to redirect the user to a signup form after the Facebook
login, you can instead hook the Ektron_FacebookNewMemberLoggedIn
javascript event and do whatever you want with it. For example, you could
raise a modal dialog with a short signup form.

You can see an example of hooking this javascript event in the Developer site
under Social Networking > Facebook Connect > Custom signup (site
root/developer/facebookconnect/customsignup.aspx).

Step 3: Place the Facebook Login Server Control
on a Page

1. In Visual Studio, open the template onto which you want to place a
Facebook Login server control. See Also:Working with Ektron
CMS400.NET Server Controls on page 24-1

2. Drag and drop the control.

3. Use the following table to complete its properties.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMS

Explorer and can use it to browse to Content,
Collections, etc. See Also: ”Using CMSExplorer to
Browse Your Ektron CMS400.NET Site” on page 21-
12

String
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Property Description Data Type

FacebookButtonText Enter the text that appears on the FacebookLogin but-
ton. The default text isConnect with Facebook. String

Hide

Used to hide output of the control in design time and run
time.

True =Hide control

False =Display control

Boolean

InstructionDetail
Enter additional text that appears above the Facebook
Login button. The default text isSign in using your
Facebook account.

String

InstructionHeader
Enter the text that appears above the FacebookLogin
button. The default text isSign in using your Face-
book account.

String

Language
Set a language for viewing the FacebookLogin control.
This property shows results in design-time (in Visual
Studio) and at run-time (in a browser).

Integer

SignupTemplate

Enter the path to the template that appears after a user
completes the Connect with Facebook screen.Step 2:
 Create or Modify a FacebookLogin/Signup Page on
page 2-18

String

You can customize the markup for the form using the LoginTemplate and
LogoutTemplate server controls. You can find examples of this on the developer
site at siteroot/developer/facebookconnect/login.aspx

Note: After you update web.config with the Facebook keys, wait a few minutes before logging
into Ektron site via the Facebook Login server control.

Using Facebook Connect Extension with the
Targeted Content Widget
By using Facebook Login, you can retrieve profile information from the user's
facebook account using Facebook Connect Extension.

This is information available in Facebook profiles.

Age

Gender

Marital Status

Likes

Employment

Using FacebookConnect Extension with the

ReferenceManual
Version 8.01 Rev 4

2-21



For more information about code to do this, see the Knowledge Base article
entitled "INFO:Targeted Content Widget: Facebook Connect Extension" located
at http://dev.ektron.com/kb_article.aspx?id=32156.

To learn more about the Targeted Content Widget, see Creating a Targeted
Content Widget on page 6-42.

Restricting Login Attempts
Ektron CMS400.NET has a login security feature that, by default, locks out a
user after five unsuccessful attempts to log in by a user on one computer. This
section explains the flexibility you have in controlling this feature.

You can control the following capabilities.

n Changing the Number of Unsuccessful Login Attempts on the facing
page

n Unlocking a Locked Account on the facing page

n Manually Locking a User from Signon on the facing page

n Disabling the Login Attempts Feature on the facing page

n Preventing CMS Users from Signing On on page 2-24

n Preventing All Users from Signing On on page 2-24

n Changing Images Used for Logging In and Out on page 2-24

n Resolving Problem with Login Screen on page 2-24

You control login security feature by changing the value of the ek_
loginAttempts element in the web.config file. The following table summarizes
your options.

Warning! If you want your Ektron CMS400.NET eCommerce feature to comply with Payment
Application Data Security Standard (PA DSS) certification, the ek_loginAttempts value must be
between 1 and 6.

Value Description

anynumber
between 1 and
254

The number of unsuccessful login attempts after which the user is
locked out.

0 Lockout all users

-1 Disable feature; unlockall locked users

-2 Lockout CMSusers only; membership users can still log in
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Changing the Number of Unsuccessful Login
Attempts
By default, if a user unsuccessfully tries to log in five times, the following error
message appears: The account is locked. Please contact your
administrator. Afterwards, even if the user enters the correct password, he is
locked out, and the error message reappears.

Note: You can change the text of the error message in the resource file. To learn about editing
the resource file, see Procedure for Translating Workarea Strings on page 14-41.

To change the number of unsuccessful login attempts that occur prior to
lockout, edit the value of the ek_loginAttempts element in the
siteroot/web.config file. For example, to allow only three unsuccessful logins,
change the value to 3. You cannot enter a value greater than 254.

Unlocking a Locked Account
Once an account is locked out, the Account Locked field is checked in the user
settings.

To unlock the account, an administrator user (or a user assigned to the user-
admin role) accesses the Edit User screen and unchecks the box. At this point,
the user can attempt to sign in again.

Note: If you want to unlock all locked users at once, set the value of the ek_loginAttempts
element in the web.config file to -1. For more information about the effects of this setting, see
Disabling the Login Attempts Feature below.

Manually Locking a User from Signon
You can use the Account Locked field (described above) to manually lock a
user out of Ektron CMS400.NET. To do so, go to the Edit User screen, identify
the user, and check the Account Locked field.

That user cannot sign in until either you uncheck the box or change the value of
the ek_loginAttempts element in the web.config file to -1.

Disabling the Login Attempts Feature
To disable the Login Attempts feature, set the value of the ek_loginAttempts
element in the web.config file to -1. If you do, any user can try to log in as
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many times as he wants. The error message never appears, and he is not
prevented from entering a password.

Note: Setting the value of the ek_loginAttempts element in the web.config file to -1
automatically unlocks all locked accounts.

Preventing CMS Users from Signing On
If you want to lock all CMS users out, set the ek_loginAttempts element in the
web.config file to -2. If you do, only membership users can sign in.

Note: The builtin user cannot sign in if ek_loginAttempts is set to -2.

Preventing All Users from Signing On
If you want to lock out all users (including membership users), set the ek_
loginAttempts element in the web.config file to 0. If you do, no one can sign
in to Ektron CMS400.NET until you change the value.

Note: The builtin user cannot sign in if ek_loginAttempts is set to 0.

Changing Images Used for Logging In and Out
You can change the images used for the login and logout buttons. To do so,
follow these steps.

1. Move the new images to the following folder: webroot\your site’s root
directory\Workarea\images\application.

2. Open the web.config file in your Web site’s root directory.

3. Change the images referenced in this section of the file:
<add key="ek_Image_1" value="btn_close.gif" />

<add key="ek_Image_2" value="btn_login.gif" />

<add key="ek_Image_3" value="btn_login_big.gif" />

Note: You must update the images and web.config each time your system is updated.

Resolving Problem with Login Screen
You may find that in certain browsers, the login screen occupies the entire
browser window instead of just a small box (see illustration below).
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Browsers such as Internet Explorer 8 and Firefox have a feature called tabs.
When the login window pops up, it appears as a new tab as shown above.

You can change this behavior by turning off tabs within the browser.

Password Management
This section contains the following topics relating to managing passwords.

n Making Passwords Case Sensitive below

n Forcing Password Change Every 90 Days on next page

n Password Character Minimum, Include Alpha and Numeric
Characters on next page

n New Passwords Cannot Match the Last Four Passwords on next page

n After 15 Minutes of Inactivity, User Must Log in Again on next page

Making Passwords Case Sensitive
By default, passwords are case insensitive. So for example, if the password is
TOKEN and the user enters token, the signon is successful.

If you want to make passwords case sensitive, change the value of the ek_
passwordCaseSensitive element of the siteroot/web.config file from false to
true.

PasswordManagement
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If you do, and the password is TOKEN and the user enters token, the signon is
unsuccessful. The user would have to enter TOKEN to successfully sign on.

Forcing Password Change Every 90 Days
Ektron CMS400.NET has a password security feature that forces an
administrator or user with the Commerce Admin role to change his password at
least every ninety days. This feature is only enabled when the ek_ecom_
ComplianceMode key in the site’s Web.config file is set to true.

Once such a user goes eighty-five days without changing his password, a dialog
box appears at next log-in, asking to change the password. If they do not want
to do so at that time, they can click the Skip button. They are allowed to do this
for the next five days. Once ninety days have passed, they must change their
password before they can log into Ektron CMS400.NET.

Password Character Minimum, Include Alpha and
Numeric Characters
Ektron CMS400.NET has a password security feature that forces an
administrator or user with the Commerce Admin role to use at least seven
characters in his password. Further, the password must contain at least one
alphabetic and one numeric character.

This feature is enabled only when the ek_ecom_ComplianceMode key in the
site’s Web.config file is set to true.

New Passwords Cannot Match the Last Four
Passwords
Ektron CMS400.NET has a password security feature that forces an
administrator or user with the Commerce Admin role to create a password that
does not match his last four passwords. This feature is enabled only when site’s
Web.config file has the ek_ecom_ComplianceMode key is set to true and the
ek_ecom_PasswordHistory key is set to at least four.

You can set ek_ecom_PasswordHistory to a number higher than four if you
want a higher level of security. If you set this key to less than four and the ek_
ecom_ComplianceMode key is set to true, Ektron CMS400.NET enforces at least
four.

After 15 Minutes of Inactivity, User Must Log in
Again
Ektron CMS400.NET has a password security feature that automatically logs out
an administrator or user with the Commerce Admin role after 15 minutes of
inactivity. Activity is based on requests made to the server.
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This feature is enabled when the site’s Web.config file‘s ek_ecom_
ComplianceMode key is set to true. In addition, if you are using IIS7, the line
in red below needs to appear between the <modules> tags in the Web.config
file. This line is a part of the default install. You should make sure it has not
been removed.

<modules>

<add name="MyDigestAuthenticationModule"
type="Ektron.ASM.EkHttpDavHandler.Security.DigestAuthenticationModule,
Ektron.ASM.EkHttpDavHandler" />

<add name="ScriptModule" type="System.Web.Handlers.ScriptModule, System.Web.Extensions,
Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"
preCondition="integratedMode" />

<add name="EkUrlAliasModule" type="UrlAliasingModule" preCondition="integratedMode" />

</modules>

If you are using IIS 6, the line in red below needs to appear between the
<httpModules> tags in the Web.config file. This line is a part of the default
install. You should make sure it has not been removed.

<httpModules>

<add name="DigestAuthenticationModule"
type="Ektron.ASM.EkHttpDavHandler.Security.DigestAuthenticationModule,
Ektron.ASM.EkHttpDavHandler " />

<add name="ScriptModule" type="System.Web.Handlers.ScriptModule, System.Web.Extensions,
Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"/>

<add name="EkUrlAliasModule" type="UrlAliasingModule" />

</httpModules>

Using the Application Setup Screen
To view Ektron CMS400.NET setup information, follow these steps.

1. Access the Workarea. See Also: Accessing the Workarea on page 3-3

2. Click Settings > Configuration > Setup.

3. The Application Setup screen is displayed. For more information, see

n Fields on the Application Setup Screen: General Tab on next page

n Fields on the Application Setup Screen: Editor Tab on page 2-30

n Fields on the Application Setup Screen: Workarea Tab on page 2-31

n Fields on the Application Setup Screen: System Tab on page 2-33

Using the Application Setup Screen
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Updating Setup Information
To update setup information, follow these steps.

1. Access the Application Setup screen, as described in Using the
Application Setup Screen on previous page.

2. Click the Edit button ( ).
3. The Application Setup screen appears with the General Tab first

showing. Update the fields as needed. The following tables explain
the fields.

n Fields on the Application Setup Screen: General Tab below

n Fields on the Application Setup Screen: Editor Tab on page 2-30

n Fields on the Application Setup Screen: Workarea Tab on page 2-31

n Fields on the Application Setup Screen: System Tab on page 2-33

Fields on the Application Setup Screen:
General Tab
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Field (General
Tab)

Description

Version This number shows the Ektron CMS400.NET version and build numbers. This number is
important to know if you place a call to Ektron Support.

License Key(s) Enter the license key sent to you from Ektron.

Module
Licenses

Enter the license key for WebImageFX that was sent to you via email. SeeEnabling
WebImageFX on page 2-34 for more information.

Default
Application
Language

Select a default language for Ektron CMS400.NET.

How User Application Language Affects Use of Ektron CMS400.NET

This user’s language determines the screensandmessages that appear in Ektron
CMS400.NET.

How System Default Language Relates to User Language Setting

In the user profile, you can set anyuser’s language to system default. Each user set to
system default uses the language assigned here.

Note: Do not confuse the default application language with the ek_
DefaultContentLanguage variable in web.config. For more information on that, see
TheDefault Language on page 14-8.

Maximum
SummarySize

In characters, limit the size of each summaryby specifying amaximum size. If a user’s
changes to a summary result in exceeding this limit, the user is told to reduce the summary
before he can save it.

It cannot exceed 65,000 characters.

SystemE-mail
Address

Enter a valid email address. This addresswill appear in the From field in the notification
emails. See Also:Customizing Ektron CMS400.NET emailon page 1-89

Server Type:

Staging Server

Check this box if you want your library links to refer to the staging server domain, as
opposed to the production server domain. Thiswould help you verify that the linked items
exist on the staging server. See Also:Step 3: AssignMulti-Site Capabilities in Ektron
CMS400.NET on page 20-14

Warning! Checking this boxdisables theWeb Alerts feature on your server.

Asynchronous
Processor
Location

If your site uses theWeb Alerts feature, enter or update the location of the asynchronous
processor Web Services file. The default location is “[none specified].” See Also:Setting
Up theMessageQueue and AsynchronousProcessor on page 23-7

Enable Office
documents to
be published in
other format

Check the box to allow Ektron CMS400.NET to render Office documents in PDF format.
When a checked, PDF generation is available for individual folders.

See Also:PDF Generation on page 7-445

Fields on the Application Setup Screen: General
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Field (General
Tab)

Description

Enable CMS to
create file
system folders
for library
assets

Check the box if you want to create physical folders on your file system server that match
the Ektron CMS400.NET library folder tree. See Also:Enabling CMS to Create File
System Folderson page 2-34

Built - in User

Edit the username and/or password for the built in user. Bydefault, the username and
password combination is builtin/builtin.

Warning! Ektron strongly urges you to change the default password assigned to the
builtin user. An opportunity to do this is presented during installation.

See Also:BuiltIn User on page 2-35

Fields on the Application Setup Screen:
Editor Tab

Field (Editor tab) Description

PreserveMS-Word
Styles

WhenMicrosoftWord content is pasted into the editor, it removes someWord styles by
default. Check this box if you want to prevent the editor from removing them.

Note: Ektron doesnot recommend enabling this feature.

PreserveMS-Word
Classes

Similar to styles, whenMicrosoftWord content is pasted into the editor, it removes
someWord classesbydefault. Check this box if you want to prevent the editor from
removing them.

Getting Started with Ektron CMS400.NET

2-30 ReferenceManual
Version 8.01 Rev 4



Field (Editor tab) Description

Enable Font
Buttons

Checking this option displays the following font-related buttonson the editor toolbar:

n Font Face

n Font Size

n Font Color

n Font Background Color

See Also:Enable Font Buttonson page 2-36;Controlling Available Fonts on page 28-
1

Accessibility/Section
508 Evaluation

If your editor is eWebEditPro+XML: Dialogs that Allow Input of Accessibility Information

If your editor iseWebEdit400: Setting up and Customizing AccessibilityValidation on
page 7-677

Fields on the Application Setup Screen:
Workarea Tab

Field (Workarea
tab)

Description

The following fields change

n whether button text appears in the title bar

n the default Web page after sign-in

n the default Workarea page

The default valuesare automatically applied to all new users, and to all existing userswhen you upgrade.

Normally, you canmodify these values for anyuser via the Edit User screen. But, you can force these valueson
all users, removing the ability to personalize them.

Fields on the Application Setup Screen:Workarea

ReferenceManual
Version 8.01 Rev 4

2-31

../../../../../Content/Main_Import_file/validation ewp dialogs allow input.htm#validation_ewp_dialogs_allow_input_1386707334_1010288
../../../../../Content/Main_Import_file/validation ewp dialogs allow input.htm#validation_ewp_dialogs_allow_input_1386707334_1010288
../../../../../Content/Main_Import_file/validation ewp dialogs allow input.htm#validation_ewp_dialogs_allow_input_1386707334_1010288
../../../../../Content/Main_Import_file/validation ewp dialogs allow input.htm#validation_ewp_dialogs_allow_input_1386707334_1010288
../../../../../Content/Main_Import_file/validation ewp dialogs allow input.htm#validation_ewp_dialogs_allow_input_1386707334_1010288
../../../../../Content/Main_Import_file/validation ewp dialogs allow input.htm#validation_ewp_dialogs_allow_input_1386707334_1010288
../../../../../Content/Main_Import_file/validation ewp dialogs allow input.htm#validation_ewp_dialogs_allow_input_1386707334_1010288


Field (Workarea
tab)

Description

Landing Page After
Login

If you want one page in your Web site to appear after users sign in, enter the URL to
that page. You can clickSelect Page to browse to the landing page. The last
published version of the page appears. If the page hasnever been published,
nothing appears.

Bydefault, the page fromwhich the user logged in reappears.

Set Smart Desktop as
Start Location in the
Workarea

If you want the Smart Desktop to appear as soon asusers enter theWorkarea, click
this box.

See Also:Personalizing the Smart Desktop on page 3-4

Bydefault, the user sees the Smart Desktop after sign in.

If you leave this checkboxblank, when you enter theWorkarea, you go to the folder
of the content specified at the Landing Page after login field.

Workarea Page Size

Width

If desired, change the width of the screen in which Ektron CMS400.NET appears.
The width in pixelsmust be between 400 and 2400.

This field accommodatesuserswho have larger monitors and/or prefer a higher
resolution, such as1280 x1024.

The default value is 790.

Height

If desired, you can change the height of the screen in which Ektron CMS400.NET
appears. The height in pixelsmust be between 300 and 1800.

This field accommodatesuserswho have larger monitors and/or prefer a higher
resolution, such as1280 x1024.

The default value is 580.

Displaybutton text in
the title bar

Check this box if you want every toolbar button’s caption text to appear on the
screen title whenever a user hovers themouse over the button. Note the word
Publish, describing the button, in the illustration below

If you do not check this box, the screen title remains in the title bar when the user
moves themouse over the button, as illustrated below.

Force Preferences to
all users

To force these settingson all Ektron CMS400.NET users, check this box. If you do,
users can see the values in the user profile screen but not change them.

If you leave this boxblank, users can personalize these values in their User Profile.
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Field (Workarea
tab)

Description

Enable Verify email?

Check this box if users should be notified whenever they subscribe to an email
notification list. See Also:What Happens if Verification email isUsed on page 23-28

Warning! When using the Checkout Server Control on an eCommerce site, the
Enable Verify Email settingmust be unchecked. Otherwise, new userswill receive
an error message when they sign-up using this control. See Also:Checkout Server
Controlon page 17-20

Enable PreApproval
Group

Use this field to enable Automatic TaskCreation. See Also:AutomaticCreation of
TasksAssociated with Content on page 12-30

Fields on the Application Setup Screen:
System Tab

Field
(System
tab)

Description

Restart
button

Use this button if you need to clear Ektron CMS400.NET's cache, which recycles the application
pool. For example, you updated the web.config file but cannot yet see the changes.

Under certain circumstances, Ektron's support groupmay instruct you to click this button.

Administratorswould use this button if they cannot access the hosting servers yet need to reset
their web site. The button is an alternative to submitting a request to their IT department or
hosting company.

Impact on Ektron CMS400.NET

After you clickRestart, the first request takes longer than usual since the application needs to
recompile. Subsequent requests should be processed normally.

Tominimize the impact on site visitors, visit your home page immediately after the restart, so
that your request is the first "hit."

See Also: How Application PoolsWork (IIS 6.0)

Managing Application Pools in IIS 7

Fields on the Application Setup Screen: SystemTab
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Enabling WebImageFX
When purchasing Ektron CMS400.NET, you had the option to purchase Ektron
WebImageFX as well. WebImageFX is an imaging application that allows users
to edit images online.

If you purchased WebImageFX when you purchased Ektron CMS400.NET, you
should have received an email with a license key for WebImageFX as well.

To enable WebImageFX within Ektron CMS400.NET, from the application setup
page, insert the WebImageFX license key in the Module License field.

Enabling CMS to Create File System
Folders
If this option is enabled, each time a new content/library folder is created in
Ektron CMS400.NET, a corresponding physical folder is created on the file
system. This helps organize library assets on your file server.

The following illustration compares the library folder tree with the file system’s
folder structure.

Note: If upgrading, the installation does not the create sample Web site’s folders on the file
server. These folders must be added manually. However, all folders created by you are also
created on the file server when enabled.

Getting Started with Ektron CMS400.NET

2-34 ReferenceManual
Version 8.01 Rev 4



BuiltIn User
The builtin user is a user that is defined in the Ektron CMS400.NET setup
screen. Primarily, he’s an emergency user if you cannot log in to Ektron
CMS400.NET as the administrator.

Note: The builtin user can log in to Ektron CMS400.NET whether or not Active Directory or
LDAP is enabled.

Only use the builtin user to correct a bad or expired license key. It is not
designed for regular CMS operations. If you try to edit content while signed on
as this user, you see errors.

Warning! By default, the builtin user's username and password combination is builtin/builtin. For
security reasons, Ektron recommends changing them upon installation.

This section also contains the following topics.

Limitations on Builtin User's Workarea Access 2-35
Editing the BuiltIn User 2-35
Enable Font Buttons 2-36
Disable Font Buttons 2-36

Limitations on Builtin User's Workarea
 Access
If you log into the Ektron CMS400.NET Workarea as the builtin user, you can
only access the following screens on the Settings tab.

n Active Directory

n Asset Server Setup

n Setup

n User

n User Group

You cannot access other areas of the CMS.

Editing the BuiltIn User
To edit the builtin user’s username and password, follow these steps.

1. Access the Edit Application Setup Information screen's General tab,
as described in Updating Setup Information on page 2-28.

2. Locate the Built In User field.

3. Change the username and password.

4. Click the Update button ( ).

BuiltIn User
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Note: If you cannot sign in to Ektron CMS400.NET because the builtin user password was
changed and you don’t know the new password, use the BuiltinAccountReset.exe utility. This
resets your Ektron CMS400.NET user \ password to Builtin \ Builtin. This utility is located in
C:\Program Files\Ektron\CMS400versionnumber\Utilities.

Enable Font Buttons
Here is the editor with font related buttons enabled. To enable these buttons,
check the Enable Font Buttons checkbox in the Settings > Configurations
> Setup Screen.

Disable Font Buttons
Here is the editor with the font buttons disabled. To disable these buttons,
uncheck the Enable Font Buttons checkbox in the Settings >
Configurations > Setup Screen.
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Chapter 3

Using The Workarea and
Smart Desktop
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The Ektron CMS400.NET Workarea contains 6 pages that you use to manage and
develop content for your Web Site.

Note: To access the Workarea, you must be logged into your Ektron CMS400.NETWeb Site.
See also Logging In and Out on page 2-6.

Page For more information see

Smart Desktop Personalizing the Smart Desktop on page 3-4

Content Managing Content in Ektron CMS400.NET on page 7-1

Library Storing Files in the Libraryon page 8-1

Settings Settingson page 3-13

Reports Reportson page 3-14

Help Ektron Documentation

This section also contains the following topics.

Accessing the Workarea 3-3
The Workarea Menu Tabs 3-4
Personalizing the Smart Desktop 3-4
Workarea Style Sheets 3-12
Settings 3-13

Using TheWorkarea and Smart Desktop
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Reports 3-14

Accessing the Workarea
To access the Workarea, follow these steps.

1. Log in to your Web site, as described in Logging into an Ektron
CMS400.NET Web Site on page 2-8.

2. Click the Workarea button ( ) on a login page.
3. Your Smart Desktop is displayed.

Note: In the Application Setup screen, you can determine which screen appears when you
access the Workarea. See Also: Updating Setup Information on page 2-28

The Smart Desktop contains useful information that pertains to you. You may
personalize this page by adding, moving or deleting Workarea Widgets. To
learn how, see Personalizing the Smart Desktop on next page.

Closing the Workarea
There are two ways to close the workarea.

n Close by logging-out of the Web Site from either a Logout link on the

web page or the Logout button ( ).

Accessing theWorkarea
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n Close by using the Windows Close button ( ) in the upper right
corner of the browser. When you do this, you remain logged into the
Ektron CMS400.NET Web Site.

The Workarea Menu Tabs
Ektron CMS400.NET’s menu tabs appear in the upper right corner of the Smart
Desktop. Use this menu to access all other pages.

Personalizing the Smart Desktop
By personalizing your Smart Desktop, you can choose and rearrange Widgets
that pertain to your work.

To see the Smart Desktop, click the Desktop menu tab ( ) in the
Workarea’s upper right corner.

The Smart Desktop looks like this.

The default Smart Desktop page contains several Widgets that provide
information about your Web Site. The page above shows the default widgets for
the Ektron Medical starter site.

This section also contains the following topics.

How Customizing the Smart Desktop Works 3-5
Adding a Widget to the Smart Desktop 3-6
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Adding a Tab to the Smart Desktop 3-6
Adding Columns 3-7
Deleting Columns 3-8
Restoring Tabs and Widgets 3-8
Setting the Default Widgets 3-9
Standard Desktop Widgets 3-10
Customizing the Widgets Available to the Smart Desktop 3-11

How Customizing the Smart Desktop Works
The Smart Desktop can have multiple tabs, letting you organize content by
subject – think of tabbed browsing. You can easily add new tabs and switch
between them.

Within a tab, you can add, move, or delete Widgets to personalize your Smart
Desktop.

Smart Desktop Widgets are stored in a widget tray. You drag and drop widgets
from the tray onto any tab and column on the Smart Desktop.

How Customizing the Smart DesktopWorks
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Adding a Widget to the Smart Desktop
1. Go to theWorkarea > Desktop.

2. Click the Toggle Widget Tray down arrow, located in the upper right
corner of the Smart Desktop window (circled below).

3. You see the Widget Tray containing widgets you can drag and drop

onto your Smart Desktop. Use the left arrow ( ) or right arrow ( )
buttons to see more widgets.

4. To choose a widget, drag it from the tray and drop it into the Smart
Desktop panel.

After placing a widget on the Smart Desktop, you may drag it to any desktop
location.

Adding a Tab to the Smart Desktop
Tabs help you organize your Smart Desktop. By default, there is one tab
containing a few standard widgets. You may add other tabs, for example to
place eCommerce or Analytics type widgets.

To add an eCommerce widget, follow these steps.

1. Click the Options button on the upper right of the Smart Desktop.

Using TheWorkarea and Smart Desktop
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2. Click Add Tab.

3. The Add Tab dialog window appears.

4. Enter the Tab Label for the tab. For example, eCommerce.

5. Click OK.

6. The new tab appears at the top of the Smart Desktop.

Adding Columns
By default, 3 columns are placed on the Smart Desktop. You may add columns
by following these steps.

1. Click the Options button on the upper right of the Smart Desktop.

Adding Columns
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2. Click Add Column.

3. Click the Options button to see the new column below the Widget tray.

Deleting Columns
1. Click the Toggle Widget Tray button (circled below) to show the

Widget Tray and Columns.

2. Click the Remove Column button (circled below) inside the column
you wish to delete.

Restoring Tabs and Widgets
All users can restore their Smart Desktops to the Default Widget set. To do this,
follow these steps.

Using TheWorkarea and Smart Desktop
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Warning! This action removes all tabs and widgets you have modified on your Smart Desktop.
Only the default set of tabs and widgets will be shown.

1. Click the Options button on the right side of the Smart Desktop.

2. Click Remove Widgets and Tabs.

3. A dialog box appears prompting you to confirm you want to delete all
Tabs and Widgets. Click OK.

Setting the Default Widgets
Note: To restore the Default Widget set, you must be a member of the Administrators group.

By using the previous procedure Restoring Tabs and Widgets on previous page,
the user restores their Smart Desktop to the Default Widget set. The Default
Widget set is defined by users in the Administrators group by doing the
following.

1. Click the Options button on the right side of the Smart Desktop.

2. Click Edit Default Widgets.

Setting the Default Widgets
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3. Arrange the Smart Desktop with tabs and widgets that you wish to be
the default.

4. Click the Options button.

5. Click Done to save the Default Smart Desktop.

Standard Desktop Widgets
The following table describes the standard Smart Desktop Widgets.

Widget Description
For more information,
see

Content
Awaiting
Approval

All content itemsawaiting your approval ApprovalsReportson page 7-
706

Content
CheckedOut All content in a checked out status CheckedOut Report on page

7-709

Content Flags The tenmost recently added content flags Flagging on page 16-209

Content
Reviews Content reviewsawaitingmoderation Content Review on page 7-

724

Content to
Expire

All content that will expire between todayand a
number of days you specify

Content to Expire Report on
page 7-714

Customer List The top five eCommerce customers ranked accord-
ing to account date, sales, and orders

Customer Reportson page
17-228

Forum Topics
and Posts

KeyPer-
formance Indi-
cators

CompareseCommerce salesand orders for two dif-
ferent time periods

KeyPerformance Indicators
Report on page 17-229

Order on Hold All eCommerce orders currently on hold

Recent Orders Recent eCommerce orders

Using TheWorkarea and Smart Desktop
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Widget Description
For more information,
see

Reconciliation
report Lists payments for a specific time period Payment Reportson page 17-

230

SalesTrend The number of eCommerce orders for the past 8
periods

SalesTrendsReport on page
17-231

Top Products Themost popular products on your site Top ProductsReport on page
17-232

Analytics
Report The Direct Traffic report for the past seven days ViewingWeb TrafficAnalytics

Data on page 7-785

Customizing the Widgets Available to the
Smart Desktop
The Widgets used in the Smart Desktop are located on the web server in the
workarea\widgets folder.

You can also use widgets developed for Personalization and Page Builder on the
Smart Desktop.

The following example demonstrates how to add a Calendar Widget to a Smart
Desktop.

Note: Access to the Web Server folders is required to perform the following steps.

1. On the web server, copy the widget files you want to use from the
siteroot\widgets folder into the siteroot\workarea\widgets
folder. Be sure that all files related to the widget are copied.

The example below shows all files related to the Calendar Widget.

2. Click theWorkarea > Settings tab.

3. Choose the Configuration > Personalizations > Widgets folder.

4. Click the Synchronize Widgets button shown below.

Customizing theWidgets Available to the Smart
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5. At the prompt, click OK.

6. Add the Widget to the Smart Desktop using the procedure described
in Adding a Widget to the Smart Desktop on page 3-6.

For example, after you drag and drop a Calendar widget onto the Smart
Desktop, it looks like this.

Workarea Style Sheets
Ektron CMS400.NET’s Version 8.0 Workarea uses two primary style sheets:

n Ektron.workarea.css - the primary CSS file for the workarea. It
replaces the previous CMS version’s global.css file.

n Ektron.workarea.ie.css - is used for Internet Explorer browsers, and
generally targeted at IE7 or less. It includes overrides for some CSS
rules in Ektron.workarea.css that get around IE CSS bugs or
deficiencies.
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Using widely accepted style sheet classes and class attributes, you can modify
the Workarea, including colors, spacing, fonts, etc. Also, if you later upgrade or
re-install Ektron CMS400.NET, you can reuse this file and retain your changes.

Language Images
Several language specific Images are used at the top of the Workarea. They
reside in the language folders and always start with the word “Workarea” and
end with “_top.”

These images are 467 pixels wide by 77 pixels high. Their width can change but
the height cannot.

There are approximately six images in each language folder. an Adobe
Photoshop file, Workarea_top.psd, can be found under
\Workarea\images\English folder. You can modify these images as needed.

Settings

To view the Settings page, click the Settings menu tab in the upper right corner
of the workarea.

Note: You must be logged into the Ektron CMS400.NET in order to see these pages. See also
Logging In and Out on page 2-6.

The Settings page contains these folders.

Page For more information see

Commerce Conducting eCommerce with Ektron CMS400.NET on
page 17-1

Community
Management Managing User Communitieson page 16-1

Configuration Storing Files in the Libraryon page 8-1

Language Images
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Page For more information see

Roles Defining Roleson page 15-31

BusinessRules Creating BusinessRules for Your Web Site on page 13-1

Import XLIFF Files Importing Translated Files into Ektron CMS400.NET on
page 14-20

User Groups Accessing the Users and User GroupsFolderson page
15-2

Users Managing Userson page 15-3

Reports

To view the Reports page, click the Reports menu tab in the upper right corner
of the workarea.

Note: You must be logged into the Ektron CMS400.NET in order to see these pages. See also
Logging In and Out on page 2-6.

The Reports page contains these folders.

Page For more information see

eCommerce eCommerce Reports andWidgetson page 17-228
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Page For more information see

Contents Content Reportson page 7-698

Site Analytics Analyticson page 7-747

Tasks Assigning and Reviewing Taskson page 12-1

Reports
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An administrator can control every aspect of the content and the folders that
hold them. The controls include setting permissions, approvals, and adding,
editing, publishing, and deleting content. Below is a typical content folder.

This section also contains the following topics.

Folder Types 4-3
Viewing a Folder 4-3
New Menu 4-6
View Menu 4-6
Delete Menu 4-7
Action Menu 4-8
Workarea Content Menu 4-9
Dropdown Menu Options 4-10
Folder Properties 4-13
Accessing the Folder Properties Screen 4-13
Folder Properties Toolbar 4-17
Editing Folder Properties 4-18
Adding Folders 4-19
Copying/Moving Folders 4-21
Procedure for Copying/Moving Folders 4-21
Who Can Copy or Move Folders 4-22
Rules for Copying/Moving Folders 4-22
Which Folder Types Can be Moved/Copied 4-23
Deleting Folders 4-25
Purge History 4-26
WorkFlow 4-27
Approval Chains 4-27
The Approval Method 4-39
Folder Permissions 4-40
Who Is Authorized to Set Permissions 4-41
Setting Permissions through the Permissions Table 4-41
Inheritance 4-42
Standard & Advanced Permissions 4-43
Setting Permissions for a Content Folder 4-44
Setting Permissions for Content 4-48
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Folder Types
Folder types are listed in the following table.

Folder Type Icon For more information, see

Standard Managing Folderson page 4-1

Root

Site SupportingMulti-Site Configurationson page 20-
1

Community CommunityFolderson page 16-110

Blog Blogson page 7-472

Discussion Board Discussion Boardson page 7-576

eCommerce catalog Creating a Catalog Folder on page 17-121

WebCalendar Calendarson page 7-527

This chapter explains how to add, edit, publish, and delete content.

Viewing a Folder
To view any folder under the content folder, follow these steps.

1. Access the Workarea, as described in Site Preview on page 2-9.

2. Click Content Tab on top menu area.

Folder Types
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3. All content in the root folder and the selected language appear in the
right frame. Subfolders appear in the left frame.

Note: The View menu option lets you filter content by type. For example, you can set it to view
only HTML content. Therefore, you may only see content of a selected type in the folder. See
Also: View Menu on page 4-6

4. To work with any folder or its content, click the folder. When you do,
its content appears in the right frame.

Note: You can only view folders for which your system administrator has granted permission.

5. If your system supports more than one language, you can select
content for a particular language or all languages using the View >
Language menu option (illustrated below).

Each folder lists the following information about its content.

Managing Folders
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Field Description

Title The name of the content.

Language The language of the content. See Also:Working with Multi-
Language Content on page 14-1

ID
The number assigned to the content byEktron
CMS400.NET . It is used to retrieve the content from a
database.

Status The statusof the content. See Also:Content Statuseson page 7-
130

DateModified Themost recent date the content wasadded, edited, or
published.

Last Editor The last user who accessed the content.

The following menus and button appear across the top of the View Contents of
Folder screen.

Note: Depending on your permissions, you may not see all menu options.

n New Menu on next page

n View Menu on next page

n Delete Menu on page 4-7

n Action Menu on page 4-8

n Add Asset button ( ) See Importing Office Documents on page 7-
405

n Workarea Content Menu on page 4-9

Viewing a Folder
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New Menu
Menu
Option

Lets you create or upload this new
item into folder For more information, see

Folder Folder Managing Folderson page 4-1

Blog Blog Blogs on page 7-472

Discussion
Board Discussion Board Discussion Boardson page 7-576

Community
Folder

Folder whose content can be updated by
membership aswell as regular users CommunityFolderson page 16-110

Calendar WebCalendar Calendarson page 7-527

Catalog eCommerce Catalog Creating a Catalog Folder on page 17-121

HTML
Content HTML content Adding HTMLContent on page 7-15

HTML
Form/Survey HTML Form, Poll, or Survey Working with HTML Formson page 7-212

Smart Form Smart Form Working with Smart Formson page 7-278

DMS
Document

n Office Document

n Managed file, any supported type

n Multimedia file, any supported type

n Working with Microsoft Office
Documentson page 7-403

n Working with Managed Fileson page 7-
428

Multiple DMS
Documents

SeveralOffice documents, managed files,
multimedia files

Adding DocumentsUsing theMultiple DMS
DocumentsOption on page 7-409

Collection Collection Working with Collectionson page 9-102

Menu Menu Working with Menuson page 9-133

View Menu
The View Menu provides the following functions.

Managing Folders
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Menu Option Function
For more
information, see

All types Displaysall content typesof selected language.

n HTML content

n HTML Form/Survey

n DMSDocument, which
includesOffice
Documents, Managed
Files, Multimedia

Limits folder display to selected content type. For
example, chooseView > DMS Document and
see onlymanaged assets in the folder -- other
content typesare suppressed.

This is especially helpful if the folder hasa lot of
items, and you are looking for only one type of
content.

Note that the icon for the selected type appears to
the left ofView, as illustrated below.

n Adding HTML
Content on page 7-15

n Working with HTML
Formson page 7-212

n Working with
Microsoft Office
Documentson page 7-
403

n Working with
Managed Fileson page
7-428

n Managing
Multimedia Assetson
page 7-438

Language

Limits display of content within folder to one
language, or lets you displayall languages.
If set to one language, this also determines the
language of new itemsyou create or upload into
the folder.

Menu Lets user view and workwith menusassigned to
this folder

Adding aMenu Item via
Content Folder on page
9-143

Collection Lets user view and workwith Collectionsassigned
to this folder

Working with
Collectionson page 9-
102

Archived Events

Lets user view and workwith content that passed
its scheduled End Date and whose archive option is
either Archive and remove from site or
Archive and remain on Site.

Setting Archive Options
on page 7-191

Properties

Onlymembersof administrators group and those
assigned to the folder-admin role see this option. It
lets you assign folder properties, such aswhich
users can edit a folder’s content.

See Also:Defining Roleson page 15-31

Folder Propertieson
page 4-13

Delete Menu
This menu lets you perform the following functions.

DeleteMenu

ReferenceManual
Version 8.01 Rev 4

4-7



Menu option Lets you For more information, see

Delete this folder
Delete current folder and all of its content

Note: You cannot delete the Root folder.
Deleting Folderson page 4-25

Delete content Delete one or more content items in folder Deleting Content on page 7-127

Action Menu
This menu lets you perform the following functions.

Menu
option

Lets you More Information

Export for
translation

Prepare content for translation bya translation
agency

Using the Language Export
Feature on page 14-14

Cut/Copy
content Move or copy content to another folder Moving or Copying Content on

page 7-110

Search Search content in theWorkarea Searching theWorkarea on page
9-89

Synchronize
folder

Sync this folder on the current server with the same
folder on another server

Content and Folder SyncOptions
on page 18-76
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Workarea Content Menu
The View Contents of Folder screen features a context-sensitive, dropdown
menu of options you can perform for a content item.

The options depend on several factors, such as

n your folder permissions

n your position in the approval chain (if any)

n the content’s status

n whether the item is a Microsoft Office document

To see the menu options for any content item, follow these steps.

1. After signing in, navigate to the folder that contains the content.

2. Hover the cursor over the content item. It is surrounded by a blue
rectangle.

3. Hover the cursor over the triangle ( ) and click.
4. A menu of options for that content item appears. For example, if you

have permission to edit it, Edit appears on the dropdown menu.

Workarea Content Menu
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Dropdown Menu Options

Option Allows you to...
For more information,
see

Approve Approve content that hasbeen submitted for publishing Approve/Decline Content
on page 4-33

Check in

Change statusof selected content to checked in. Might use
if you checked out and saved a document then it became
lost or corrupted.

This option changesoriginal document’s status to checked
in. However, it doesnot replace the version of the file in
Ektron CMS400.NET. To replace content that was
checked out and edited, drag and drop it into Ektron
CMS400.NET. See Also:CheckingOut, Saving, and
Replacing anOffice Document on page 7-423

Note: PreviousEktron CMS400.NET releases
included aWorkOffline option, whoseCheck In
function replaced the version of the file in Ektron
CMS400.NET. In contrast, this release’sCheck In
function only changes the content’s status.

Checked-In Content on
page 7-132

Checkout and
Save As

Change a content item’s status to checked out and save it
to your local computer.When you finish editing the item,
drag and drop it into Ektron CMS400.NET.

CheckingOut, Saving, and
Replacing anOffice
Document on page 7-423

Decline

Decline an approval request submitted to you. This option
reject the changesand keeps the current version live on
Web site. You are prompted to enter a reason for the
decline.

After you decline

n The author whomade the change is notified byemail

n The content is removed from the ApprovalChain

If the author updated content then submitted it for
approval, the updated content remains in the file. If you do
not want it to remain, choose theEdit option.

Youmaybe asked to decline both a content change and a
request to delete content.

Approve/Decline Content
on page 4-33

Delete Submit content for deletion.

n Deleting Content on
page 7-127

n Deleting anOffice
Document on page 7-422

n Deleting aManaged
File on page 7-431

Managing Folders
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Option Allows you to...
For more information,
see

Edit

n HTML, HTML form, or XML Smart Form content - edit
content within an Ektron CMS400.NET editor

n Asset - First, useCheck out and Save As or Save
As to save asset to your computer and edit it. Then, use
Edit to replace version in Ektron CMS400.NET.

n Editing HTMLContent
on page 7-20

n Editing Smart Formson
page 7-375

n Editing aManaged File
on page 7-430

Edit in Microsoft
Office

Edit Office document within Ektron CMS400.NET, which
launchesOffice

Editing anOffice Document
on page 7-420

Edit Properties

Edit item’sEktron CMS400.NET information, such as
Summary, Metadata, Schedule, and Taxonomy.

After you complete the edit screen, you proceed to the
View Content screen. From here, you can perform
additional content activities, such asmove/copy, delete,
and view history.

n Working with Content
Summaryon page 7-137

n Working with Metadata
on page 7-141

n Scheduling Content to
Begin and End on page 7-
187

n Taxonomyon page 9-
202

Force Check In

Only appears if user is amember of the Administrator
group or assigned the folder admin role and content is
checked out.

Allowsan admin to check in content even though he is not
the one who checked it out.

Publish Accept changes to content and publish it to the site.

Request Check
In

Allowseither admin user or non-admin user with edit
permission for the content’s folder to email the user who
checked out content. The email asks the check-out user to
check it in.

Save As SaveOffice document or asset to your computer. Saving anOffice Document
on page 7-424

Submit
Submit current version of content for publishing.When you
do this, the next person in the ApprovalChain is notified
that your content is ready for review.

AssetWorkflow on page 7-
432

Synchronize Synchronize content or folders between two servers Synchronizing Servers
Using eSyncon page 18-1

View

View item’sEktron CMS400.NET information, such as
Summary, Metadata, Schedule, and Taxonomy. After
viewing, you can also edit that information if you have
permission.

Next, you proceed to the View Content screen. From here,
you can perform additional content activities, such as
move/copy, delete, and view its history.

DropdownMenuOptions
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Option Allows you to...
For more information,
see

View in
Microsoft Office

View Office document within Office application. Cannot
change.

View Properties

View Office document’sEktron CMS400.NET information,
such asSummary, Metadata, Schedule, and Taxonomy.
After viewing, you can also edit that information if you have
permission.

After you complete the edit screen, you proceed to the
View Content screen. From here, you can perform
additional content activities, such asmove/copy, delete,
and view its history.
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Folder Properties
The folder properties screen lets you set permissions and approvals for a
folder. You can also assign or modify the folder’s metadata, Web Alerts, and
Smart Forms.

Note: Only members of the Administrator User Group and those defined in the Manage
Members for Role: Folder User Admin screen can view, add, or edit folder properties. (See
Also: Defining Roles on page 15-31) In addition, if a user is not a member of the
Administrators group, he must be given permission for individual folders on the Folder
Properties > View Permissions for Folder screen. (See Also: Folder Permissions on page 4-
40)

Note: If you are using an eCommerce catalog, see Product Types on page 17-103 for a
description of the Product Types screen.

Note: If you are using a Web Calendar folder, see Viewing System Calendar Folder Properties
on page 7-530.

This section also contains the following topics.

Accessing the Folder Properties Screen 4-13
Folder Properties Toolbar 4-17
Editing Folder Properties 4-18

Accessing the Folder Properties Screen
To access the folder properties screen, follow these steps.

1. Select the folder.

2. From the View Contents of Folder screen, click View > Properties.

Alternatively, from the left panel, right click the mouse and select View
Properties.

3. The folder’s View Properties screen appears.

Folder Properties
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4. To change any properties, click the Edit button ( ) to proceed to the
edit screen. The table below describes the fields on the Folder
Properties screen.

This section also contains the following topics.

Fields on the Folder Properties Screen 4-15
Tabs on the Folder Properties Screen 4-17
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Fields on the Folder Properties Screen
Field Description

Foldername
Edit the name of the content folder.

Note: You cannot change the root folder name.

Description Edit the description of the content folder.

Style Sheet filename for this
folder: (leave blank to inherit)

Specify a style sheet that defines styles that maybe applied to content in this
folder. The style sheet that you identifymust reside in the site root folder. Or,
leave this field blank to inherit the parent folder’s style sheet.

The style sheet populates the style dropdown list (see below) within the editor.

Note: This style sheet affects content being edited. It doesnot necessarily
affect the content’s appearance on your Web site. To set or edit the style
sheet that determines your Web pages’ appearance, open the page’sWeb
form and place a <link rel=”stylesheet”... tag within its<HEAD> tags.
If desired, you can identify the same style sheet in both locations. To include
user-selectable styles, theymust be generic classes.

Caption and Visible Properties

eWebEdit400 ignores the CSS custom propertiescaptionand visible. To
address this problem for the Internet Explorer browser, replace themwith the
customCSSpropertieslocaleRef, caption and visible.

For other browsers, use the customCSS selectorslocaleRefand
unselectable (same asvisible: false).

To achieve cross-browser compatibility, use both approaches.

Note: Non-IE browsers have no equivalent for caption.

Page Templates
Lets you specify one or more templates for content in this folder. This folder’s
content uses the specified template when appearing on your Web site. See
Also: Inheritance of Folder Templateson page 7-181

Fields on the Folder Properties Screen
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Field Description

Inherit Parent Template
Configuration

Check this box to inherit the template from the parent content folder.

Or, do not check this boxand specify one or more templatesbelow. See Also:
Inheritance of Folder Templateson page 7-181

Taxonomy

n If you want this folder to inherit taxonomyconfigurations from the parent
folder, check Inherit Parent Taxonomy Configuration.

If you uncheck Inherit Parent Taxonomy Configuration, you can then
select taxonomies that can be applied to content in this folder.

n If you want all content in this folder to be assigned at least one taxonomy
category, checkRequired at least one category selection.

See Also: Inheriting Taxonomies from a Parent Folder on page 9-217;
Taxonomyon page 9-202

Flagging

Check this box if content in this folder inherits a flagging definition from its parent
folder. If you do not check the box, use the dropdown list to apply a flagging
definition to content in this folder.

See Also: Flagging on page 16-209,Assigning a Flagging Definition to a Folder
on page 16-212

Multi-site Domain

Configuration

Note: Only appears for
Site folders.

Lets you set up andmanage severalWeb sites under one

CMS. See Also:SupportingMulti-Site Configurationson page 20-1.

Should Office documents
added to this folder be
published in other format?

Note: This field only
appears if theEnable
Office documents to be
published in other
format property is checked
in the Settings>
Configuration >Setup
screen. See Also: Modifying
the Application Setup
Screen

Publish Office documents as PDF

Check this option if Office documents in this folder are published asPDF files.
See Also: PDF Generation on page 7-445

Note: This property is not inherited from a parent folder, nor is it inherited by
any subfolders below this folder.
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Tabs on the Folder Properties Screen
Tab For more information, see

Taxonomy How AdministratorsAssign Taxonomies to a Folder on page 9-216

Templates Assigning Templates to Folderson page 7-182

Flagging Assigning a Flagging Definition to a Folder on page 16-212

Metadata AssigningMetadata to a Folder on page 7-159

Web Alerts AssigningWeb Alert Information to Folders and Content on page 23-20

Smart Forms Working with Smart Formson page 7-278

Breadcrumb Creating SiteMap Breadcrumbson page 9-276

Product Types (only
appearswith
eCommerce folder)

Product Typeson page 17-103

Folder Properties Toolbar
The Folder Properties screen contains these toolbar buttons.

Button Name Description More Information

Edit Properties Access the Edit Folder
Properties screen Editing Folder Propertieson next page

Permissions Access the folder’sPermissions
Table Folder Permissionson page 4-40

Modify
Preapproval
Group

Set or update preapproval group
assigned to folder

AutomaticCreation of TasksAssociated
with Content on page 12-30

Approvals Access the folder’s approvals
table ApprovalChainson page 4-27

Purge History Access the folder’s purge history
table Purge Historyon page 4-26

RestoreWeb
Alert
Inheritance

Assigns the folder’sWeb Alert
properties to all content in folder

Inheriting Content-LevelWeb Alert
Information from ItsFolder on page 23-
26

Tabs on the Folder Properties Screen
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Button Name Description More Information

Back Go to previous screen

Editing Folder Properties
A content folder’s properties consist of

n name

n description

n style sheet

n template (see Creating/Updating Templates on page 7-178)

n Metadata (see Assigning Metadata to a Folder on page 7-159)

n Web Alerts (see Assigning Web Alert Information to Folders and
Content on page 23-20)

n Working with Smart Forms on page 7-278

n Creating SiteMap Breadcrumbs on page 9-276

To edit any properties for a folder, follow these steps.

1. Access the View Properties screen for the folder you want to edit, as
described in Accessing the Folder Properties Screen on page 4-13.

2. Click the Edit button ( ).
3. The folder’s Edit Properties screen appears.

4. Make the necessary changes to the content folder’s properties. See
Fields on the Folder Properties Screen on page 4-15.

5. Click the Update button ( ).

Managing Folders
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Adding Folders
To further organize content on your Web site, create folders to store related
content. To add a folder, follow these steps.

1. Navigate to and click the folder within which you want to create the
new folder (that is, the parent folder).

2. Each folder has a default language. By default, it is inherited from the
parent folder. To change a folder’s default language, use the parent
folder’s View > Language selection (shown below).

Note:When a user adds content to a folder, the default language is applied to the content
unless the user explicitly changes the language. So, you should select a default language in
which you expect the majority of folder’s content to be created.

3. Click New > Folder.

Alternatively, you can hover the cursor over the folder, right click the mouse,
and select Add Folder.

4. The Add a folder screen appears.

5. Complete the fields. See Fields on the Folder Properties Screen on
page 4-15.

6. Click the Save button ( ).

Adding Folders
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You can modify the folder’s properties, permissions, approval chain, etc. For a
list of options, see Folder Properties Toolbar on page 4-17.

If this is a Community Folder, see Community Folders on page 16-110.

If this is a Site Folder, see Supporting Multi-Site Configurations on page 20-1.
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Copying/Moving Folders
This section also contains the following topics.

Procedure for Copying/Moving Folders 4-21
Who Can Copy or Move Folders 4-22
Rules for Copying/Moving Folders 4-22
Which Folder Types Can be Moved/Copied 4-23

Procedure for Copying/Moving Folders
Note: This section summarizes the copy/move folder procedure. Rules governing which users
can do this, which folder types can be moved, etc., are explained below.

You can copy a folder and paste it into another folder. Or you can cut and paste
one folder into another. Cut and paste is synonymous with move.

To copy or move a folder, follow these steps.

1. In the left panel of the Ektron CMS400.NET Workarea, hover the
cursor over the folder you want to copy/move.

2. Right click the mouse.

3. Click Copy or Cut folder name.

4. Hover the cursor over the folder to which you want to paste the
copied/cut folder.

5. Right click the mouse and select Paste Folder.

Copying/Moving Folders
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6. A warning message appears.

7. Click OK.

Who Can Copy or Move Folders
Any of the following users can copy or move folders.

n users who have Add, Edit and Delete permissions for the folder being
moved/copied and the destination folder See Also: Folder
Permissions on page 4-40

n members of the Administrators user group

n users assigned in the Roles > Folder Specific > Folder User Admins
screen

n users assigned in the Roles > Folder Specific > Move or Copy screen

See Also: Defining Roles on page 15-31; Guidelines for Using the Folder-User
Admin Role on page 15-35;

Rules for Copying/Moving Folders
n When you copy or move a folder, you also copy/move all of its

subfolders.
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n All properties assigned to a folder (permissions, metadata,
templates, etc.) remain assigned after the copy or move. However,
you can edit the folder in its new location and adjust its properties as
needed.

n Any Inherit checkboxes (see example below) that were checked are
now unchecked. After the copy/move, you can check them again as
needed.

n The Root folder cannot be copied or moved

n You cannot copy or move a folder into its own subfolder

n You cannotmove a folder to same level in the folder structure

You can copy a folder to same level in the folder structure. If you do,
a number is appended to the copied folder's name, such as
calendar(1).

n If youmove a folder, its content retains its status. That is, if
content's status was checked out (O) before the move, it is checked
out after the move. See Also: Content Statuses on page 7-130

If you copy a folder, only content in Approved status is copied to the
new folder. Content in any other status is not copied.

n All folder content that follows the above rules is moved/copied. This
includes all language versions of those items.

Which Folder Types Can be
Moved/Copied
The following table describes which folder types can be copied/moved into
other folder types.

Destination Folder

Source
Folder Content Blog Forum

Comm-
unity

Web
Calendar

Catalog Site Root

Content

Which Folder TypesCan beMoved/Copied
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Destination Folder

Source
Folder Content Blog Forum

Comm-
unity

Web
Calendar

Catalog Site Root

Blog

Discussion
Board

Forum

Community

Web
Calendar

Catalog * * * *

Site

* Although you can copy or move a catalog folder to a non-catalog folder, its
content is not copied/moved -- only the folder.
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Deleting Folders
You can delete obsolete folders from the Ektron CMS400.NET Web site.

Note: The top-level folder, Root, cannot be deleted nor renamed.

Warning! Deleting a folder permanently deletes the content and Quicklinks that belong to the
folder and all of its subfolders. There is no way to retrieve the deleted content.

To delete a content folder, follow these steps.

1. In the Workarea, navigate to the content folder you want to delete.

2. From the options across the top of the screen, click Delete > This
Folder.

Alternatively, you can hover the cursor over the folder in the folder display
panel , right click the mouse, and select Delete folder name (shown below).

3. A confirmation message is displayed.

4. Click OK.

Deleting Folders

ReferenceManual
Version 8.01 Rev 4

4-25



Purge History
The Purge History option lets you delete historical versions of content in a
folder. When purging, your options are

n specify a date before which historical versions are purged

n indicate whether the purge includes a folder’s subfolders

n purge published as well as checked-in versions of content

Note: Only Ektron CMS400.NET administrators and users identified on the Manage Members
for Role: Folder User Admin screen can purge history.

To purge the history for a content folder, follow these steps.

1. Access the View Folder Properties screen for the content folder you
want to purge the history for, as described in Accessing the Folder
Properties Screen on page 4-13.

2. Click the Purge History button ( ).
3. The Purge History screen appears.

4. Use the following table to customize the Purge History options.

Field Description Required?

Only purge
historical
versionsbefore

Specify a date to limit the number of historical versions to purge.When
specified, only historical versionswith a date before this date are purged. Yes

Recursive Purge Purgeshistorical records for content in this folder’s subfolders. No

Purge versions
marked as
Published

Purgespublished versionsof content aswell as checked-in versions. No

5. Click the Purge History button ( ).
6. A confirmation message is displayed.

7. Click OK to continue.

8. Ektron CMS400.NET executes the purge and displays a confirmation
when complete.
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WorkFlow

Approval Chains
This section also contains the following topics.

What is an Approval Chain? 4-27
Conditions for Membership in Approval Chain 4-28
Approval Chain Scenarios 4-29
Inheritance and the Approval Chain 4-29
Creating an Approval Chain for a Content Folder 4-30
Viewing a Folder’s Approval Chain 4-30
Actions You can Perform from the Approvals Screen 4-30
Adding Approvers 4-31
Editing the Approval Order 4-31
Deleting Approvers 4-32
Editing an Approval Chain For Content 4-33
Viewing an Approval Chain for Content 4-33
Approve/Decline Content 4-33
Example of an Approval Chain 4-35
Creating Content 4-35
First Approver 4-36
Second Approver 4-38

What is an Approval Chain?
An approval chain is a series of users or user groups who must approve content
before it can be published on your Web site. When the last person in the chain
approves content, it goes live.

Also, if a user deletes content, before it is removed from Ektron CMS400.NET, it
must pass through the approval chain.

When a new, edited, or deleted content is submitted to the approval chain, it is
reviewed by users who may

n change it

n approve or decline it

n publish it (it’s published when the last user in the chain approves it)

The chart below illustrates the approval process.
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You can approve, edit, or decline all content submitted to you from the approval
folder.

Ektron CMS400.NET can automatically send email notification, informing users
that content workflow events have either taken place or are requested of them.
As examples

n as soon as one member of the approval chain approves content, the
next user or group is notified that the content is ready for their
approval

n a content contributor receives an email that his content has been
published to the Web site.

The list of automatic emails and directions for customizing their content are
described in Customizing Ektron CMS400.NET email on page 1-89.

Conditions for Membership in Approval
Chain
An approval chain can include any number of users or user groups. However,
only users or user groups with read-only or higher permission to the folder or
content item can be added to the approval chain. See Also: Folder Permissions
on page 4-40

Note: If you assign a user group to an approval chain, only one member of the group needs to
approve the content, not all members.

Note: Also, if a user appears in an approval chain twice (both as a user and part of a user
group), the approval chain skips the second approval because the user has already approved
the content.
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You can set up an approval chain for a content folder or a content item as well
as a language. See Also: Multi-Language Approval Chains on page 14-24

Finally, the Approval Method determines if content must be approved by all
users in the chain, or only users higher up the chain than the one making the
edits.

Note: Only Ektron CMS400.NET administrators and users identified on the Manage Members
for Role: Folder User Admin screen can modify the approval chain.

Approval Chain Scenarios
An approval chain lets you control how and when your Web site is updated. For
example, if your Webmaster needs to approve every new content item or
update of an existing item, he would be last user in every approval chain and
exert total control over the site.

Alternatively, you could set up a less centralized organization, where each
department head controls his section. To accommodate this, set up an approval
chain for each department, and assign the department head as the last person
in the chain.

On the opposite extreme, you can delete the approval chain for a content item
or folder. In this case, every item in that folder is published as soon as a user
submits it for publication.

Inheritance and the Approval Chain
An approval chain’s inheritance is determined by the corresponding permission
table. So, if a folder’s permission table inherits settings from its parent folder,
that folder’s approval chain also inherits. To learn about enabling and disabling
permission table inheritance, see Inheritance on page 4-42.

The Approval Chain screen only displays its inheritance status; it does not let
you set it.

Approval Chain Scenarios
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Creating an Approval Chain for a Content
Folder
Before you can create or edit an approval chain, you must access the View
screen.

Viewing a Folder’s Approval Chain
To view a folder’s approval chain, follow these steps.

1. Select a folder from the left frame of the Workarea.

2. Click View > Language.

3. Select the language of the approval chain you want to view.

4. Click View > Properties.

5. Click the Approvals button ( ).
6. The approval chain appears in the lower section of the screen.

This screen shows the following information about the approval chain.

n its language

n every user and user group in the approval chain

n the approval order

n the approval method (See Also: The Approval Method on page 4-39)

n toolbar buttons for modifying the approval chain and method

See Also: Creating an Approval Chain for a Content Folder above

Actions You can Perform from the Approvals
Screen
From this screen, you can perform these actions.
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Action Button See this section for details

Add approvers Adding Approversbelow

Remove approvers Deleting Approverson next page

Change the order of users in the
approval chain Editing the ApprovalOrder below

Change the approvalmethod The ApprovalMethod on page 4-39

Change the language of the approval
chain

Content
Language

Multi-Language ApprovalChainson page
14-24

Adding Approvers
To add a user or user group to the approval chain, follow these steps.

1. Access the approval table, as described in Viewing a Folder’s
Approval Chain on previous page.

2. Select the language of the approval chain. The chain only applies to
content in this language.

3. Click the Add button ( ).
4. The Add Approvals screen appears.

Note: Only users and user groups with permissions to the folder appear. See Adding a User or
User Group to the Permissions Table on page 4-47 for more information.

Best Practice
Ektron suggests assigning user groups to the approval chain, as opposed to
individual users. In thisway, if someone is out of the office for a day, another group
member can approve the content.

5. Click the user or user group to add to the approval chain.

6. A confirmation message appears.

7. Click OK.

See Also: Creating an Approval Chain for a Content Folder on previous page

Note: If you assign a user group to an approval chain, any member of the group can approve
the content, not all members.

Editing the Approval Order
After you assign approvers to a folder, you may want to adjust the approval
order. Place the user or group with final review at the end of the approval chain
(that is, the highest number).

Adding Approvers
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For example, if you have a content contributor whose edits must be approved
by a department head, and the Webmaster has final review of all content, the
approval order would look like this.

User or Group Name Approval Order

Content contributor 1

Department Head 2

Webmaster 3

To edit the approval order, follow these steps.

1. Access the approval table as described in Viewing a Folder’s Approval
Chain on page 4-30.

2. Select the language.

3. Click the Reorder button ( ).
4. The Edit Approval Order screen appears.

5. Click the user or group whose approval order you want to change.

6. Click the Up ( ) or Down ( ) arrow to move the user or group to
the desired order.

7. Click the Save button ( ).
See Also: Creating an Approval Chain for a Content Folder on page 4-30

Deleting Approvers
Note: If a user in an approval chain is deleted from the permissions table, he or she is
automatically deleted from the approval chain.

To delete a user or user group from an approval chain, follow these steps.

1. Access the approval table as described in Viewing a Folder’s Approval
Chain on page 4-30.

2. Select the language.

3. Click the Remove button ( ).
4. The Remove Approval screen appears.
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5. Click the user or group that you want to remove from the approval
chain.

6. A confirmation message appears.

7. Click OK.

See Also: Creating an Approval Chain for a Content Folder on page 4-30

Editing an Approval Chain For Content
At times, you may need to change the approval chain for a specific content
item. Use the Approvals button ( ) on the View Content screen to change a
content item’s approval chain.

Viewing an Approval Chain for Content
To view the approval chain for content, follow these steps.

1. Navigate to the folder that contains the content.

2. Click the content.

3. Click the View Approvals button ( ).
4. Uncheck the checkbox next to Allow this object to inherit

permissions.

5. Return to the View Content screen.

6. Click the Approvals button ( ).
7. The content’s approvals table appears.

After viewing the content’s approval chain, you can perform the same actions
on it as you can perform on a folder. This list of actions is available from .

Approve/Decline Content
1. Form the Smart Desktop, click Reports > Contents > Approvals.

2. Click the content you want to approve or decline.

To select all displayed content, click Select All at the top of the screen.

Editing an Approval Chain For Content
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3. The content appears. You can view the content, summary, metadata,
etc.

A toolbar at the top of the screen lists tasks you can perform on the
content.

Button Name Result of Clicking

Publish

Accept changes to the content and publish it to the site.

Note: If there is another approver in the content’s approval chain, this is
replaced byaSUBMIT button.

If you clickPublish but the content item hasan incomplete taskassigned to
another user, the content cannot be published. Instead, the following error
message appears.

The user to whom the task is assignedmust complete it before you can
publish the content.

Decline

Reject changesand keep current version of content live onWeb site. You
are prompted to enter a comment that providesa reason for the decline.
The author whomade the change is notified byemail of the decline.

The content inserted by the last editor remains in the file. If you do not want
it to remain, choose theEdit option.

Edit Checkout content and change it if desired.

View
Published/Staged

Toggle between published and submitted versionsof content. This can
help you compare versions. See Also:Staged Content on page 7-136

View Diff
View differencesbetween the version awaiting approval and the published
content.

See Also:Comparing Versionsof Content on page 7-118

Back Return to previous screen.
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Example of an Approval Chain
The approval chain begins when a content contributor submits a new or edited
content. If email is enabled, an email is sent to the next approver in the
approval chain.

The following example follows a typical content block from creation to
publication. Three users make up this approval chain.

n Sports Writer - creates sports content

n Sports Editor - edits and publishes all sports articles

n Editor In Chief - edits and publishes all articles

Each user has different permissions that correspond to their roles.

This section also contains the following topics.

Creating Content 4-35
First Approver 4-36
Second Approver 4-38

Creating Content
The first step is to create content. To create new content, follow these steps.

1. Log in to Ektron CMS400.NET as a SportsWriter.

2. Create content, as described in Adding HTML Content on page 7-15.

3. Click the Submit button ( ).
4. The content is placed into the approval chain. The next user in the

chain receives an email saying the content is ready for approval.
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Note: Emails are only sent if your administrator enables them.

The content contributor, Sports Writer, has completed his role in the approval
chain but continues to receive emails notifying him of changes in the content’s
status.

First Approver
After Sports Writer submits the content, the first user in the approval chain,
Sports Editor, receives an email stating content needs his approval. He can
change and approve the content or decline it.

Sports Editor logs into Ektron CMS400.NET, navigates to his desktop, where he
sees the Content Awaiting Approval panel.
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He clicks the View All link and sees all content awaiting his approval.

The approvals folder window displays information such as title, who submitted
it, go live date, etc. The Sports editor clicks the submitted content.

The View Content Awaiting Approvals window appears listing all information
necessary to decide whether to approve or decline the content.

At the approval window, the Sports Editor has these options.

Button Result

Approve
Send content to next approver in approval chain.

Decline
1. Send email to creator, notifying him/her that content wasdeclined.

2. Remove content from approval chain.

Edit Invokes the editor. From here, the approver can change the content.

For demonstration purposes, we‘ll choose Approve.

First Approver
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Second Approver
After the content is approved, the next approver in the approval chain receives
an email saying that the content is ready for approval.

EditorInChief logs in to Ektron CMS400.NET and accesses his Workarea. The
Workarea has an Approval folder with the content awaiting his approval.
EditorInChief navigates through the Approval folder until he finds the content
Red Sox win World Series.

From this window, EditorInChief can view information about the content,
including title, go live date, user who created it, etc. He then clicks the content
he wants to approve.

This window is similar to the previous approver’s but includes a Publish button
at the top of the screen. The EditorInChief has a publish button (instead of a
submit button) because he is the last approver in the approval chain. When he
approves the content, it is published to the Web site.

Like the Sports editor, the EditorInChief has the following options.
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Button Description

Publish Publish the content.

Decline
1. Sendsan email to the creator, notifying him/her that content wasdeclined.

2. Removes content from the approval chain.

Edit Invokes the editor. The approver changes the content.

After reviewing the content, the EditorInChief decides it is great and publishes
it. At this point, the content becomes live on the Web site, and the approval
chain is complete.

The user who created the content receives an email notifying him that it was
published.

The Approval Method
The Approval Method determines if content must be approved by all users in the
chain, or only users higher up in the chain than the user making the edits. The
approval method only affects the approval process if the person submitting
content for publishing is a member of the approval chain.

Two approval methods are available.

Approval Method Description

Force All Approvers Allusers in approval chainmust approve the content, beginning with the first

Do Not Force All
Approvers

Approversafter the user submitting content in the approval chainmust approve
the content

For example, assume the approval chain is set as below.

The Approval Method
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User or Group Name Approval Order

Content contributor 1

Department Head 2

Webmaster 3

If the Approval Method is Force All Approvers, and the Department Head
submits content, the content must be approved by the content contributor, then
the department head, and the Webmaster before it is published.

If the Approval Method is Do Not Force All Approvers, and the Department
Head submits content, the content must only be approved the Webmaster
before it is published.

Changing the Approval Method
By default, the approval method is set to Do Not Force All Approvers. To
change the approval method for a content folder or item, follow these steps.

1. Access the approval table, as described in Viewing a Folder’s
Approval Chain on page 4-30.

2. Click the Edit button ( ).
3. The Edit Approval Method screen appears.

4. Select an approval method by clicking the radio button.

5. Click the Save button ( ).

Folder Permissions
Permissions determine which actions users and members of user groups can
perform on content, library items, and content folders. For example, you allow
your Webmaster to perform the most advanced actions, such as adding folders,
editing folder properties, and deleting folders. At the same time, you could
restrict content contributors to viewing, editing, and adding new content.

You can set permissions for a content folder or content item. When you assign
permissions to a content folder, it affects all of its subfolders unless you break
inheritance for a subfolder.

This section also contains the following topics.

Who Is Authorized to Set Permissions on the facing page

Setting Permissions through the Permissions Table on the facing page

Inheritance on page 4-42

Standard & Advanced Permissions on page 4-43
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Setting Permissions for a Content Folder on page 4-44

Setting Permissions for Content on page 4-48

Who Is Authorized to Set Permissions
Only Ektron CMS400.NET administrators and users identified on the Manage
Members for Role: Folder User Admin screen can set permissions. See Also:
Using the Roles Screens on page 15-31

Setting Permissions through the
Permissions Table
Important: All members of the Administrators group are automatically granted all permissions to
all Ektron CMS400.NET folders. Although these users do not appear when you view a folder’s
permission settings, they have full permissions.

You manage the following permissions through the Permission Table (illustrated
below).

n Content management: view, add, edit, delete, restore

n Library File Management: view, add images, add other types of files,
add hyperlinks, overwrite files

n Folder management: add, edit, delete, traverse

n Work with Collections and Menus

Note: You can use the Roles screens to assign additional permissions that are not defined in
the Permission Table, such as the ability to create tasks. See Also: Defining Roles on page 15-
31

The Permission Table appears when you click the Permission button ( ) from a
folder’s or content item’s Properties window.

Best Practice
If you need to assignmultiple users the same permission, Ektron recommends
placing them in a user group and assigning the group to the Permission Table. If you
assign toomanyusers in the Permission Table, your system's response timemay
degrade.

Who Is Authorized to Set Permissions
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Inheritance
By default, all content folders and items inherit permissions from their parent
folder. You have two options for modifying permissions.

n Modify the permissions of the parent folder - see Setting Permissions
for a Content Folder on page 4-44

n Break inheritance and add permissions to a folder

Breaking Inheritance
To break inheritance from a parent folder, follow these steps.

1. Access the Permissions Table for a content folder or content in your
Workarea, as described in Accessing the Permissions Table on page
4-45.

2. Remove the check mark from the box that says Allow this object to
inherit permissions.

3. A confirmation message appears.

4. Click OK.

Restoring Inheritance
To restore inheritance for a content folder or content, follow these steps.

1. Access the Permissions Table as described in Accessing the
Permissions Table on page 4-45.

2. Place a check in the box that says Allow this object to inherit
permissions.

3. A confirmation message appears.

4. Click OK.
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Standard & Advanced Permissions
There are two categories of permissions. You assign permissions in each
category from a different screen.

n Standard Permissions - basic functions

n Advanced Permissions - administrator level functions

The following table explains the permissions in Ektron CMS400.NET.

Category Permission
Allows user/user group to perform this action on content in
selected folder

Standard

ReadOnly View content

Edit Edit content

Add Add content

Delete Delete content

Restore Restore old versionsof content

Library
ReadOnly

View items in the corresponding library folder

See Also:Storing Files in the Libraryon page 8-1

Standard
Add Images

Upload images to the corresponding library folder

Add Files Upload files to the corresponding library folder

Standard Add
Hyperlinks Add hyperlinks to the corresponding library folder

Standard & Advanced Permissions
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Category Permission
Allows user/user group to perform this action on content in
selected folder

Overwrite
Library

Overwrite
imagesand
files to the
corresponding
library
folder

Advanced

Collections Manage collectionsSee Also:Working with Collectionson page 9-102

Add Folders Add sub foldersSee Also:Adding Folderson page 4-19

Edit Folders Edit folder propertiesSee Also: Folder Propertieson page 4-13

Delete
Folders Delete the current folder or its subfolders

Traverse
Folders

Access folders under the root folder. Bydefault, theEveryone user
group haspermission to view all subfolders.

If you disable or modify the Everyone user group, and you want to grant
users/groupspermission to a folder other than the root folder, youmust
also assign Traverse permission. If you do not, the user cannot access
the folder. In that case, the user cannot perform anyother granted
permissions.

Modify
Preapproval

Set or update a folder’s preapproval group. See Also:Automatic
Creation of TasksAssociated with Content on page 12-30

Note: To grant users the ability to copy or move content, assign to them the Move or Copy
Role. See Also: Defining Roles on page 15-31

Setting Permissions for a Content Folder
You can set permissions for any content folder and language from the Folder
Properties screen. Circled below is the Permissions button on the Folder
Properties screen.

See Also: Setting Permissions for Content on page 4-48

This section also contains the following topics.

Accessing the Permissions Table 4-45
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Actions You Can Perform from the Permissions Table 4-46
Adding a User or User Group to the Permissions Table 4-47
Editing User or User Group Permissions 4-47
Deleting Users or User Groups from the Permissions Table 4-48

Accessing the Permissions Table
To access the Permissions Table, follow these steps.

1. Select a content folder from the left frame of the Workarea.

2. Click View.

3. From the language dropdown, select the language whose folder
properties you want to update.

4. Click View > Properties. The Folder Properties screen appears.

5. Click the Permissions button ( ).
6. The Permissions Table appears.

Accessing the Permissions Table
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The Permissions Table displays each user’s abilities to perform actions on
content within the selected folder. Since all permissions cannot fit on one
screen, click View Advanced Permissions to see the other group.

After viewing permissions, you can change them. Below is a list of actions you
can perform from this screen.

Actions You Can Perform from the Permissions
Table
The following table summarizes actions available from the Permission Table
screen.

Action How to perform it For more information, see

View advanced
permissions Click View Advanced Permissions Setting Permissions for a

Content Folder on page 4-44

Add user or group to
permission table Click

Adding a User or User Group to
the PermissionsTable on the
facing page

Remove user or group
from permission table Click

Deleting Users or User Groups
from the PermissionsTable on
page 4-48

Viewmembership
users ClickView MemberShip users CommunityFolderson page

16-110

Have this folder inherit
permissions from
parent folder

Checkboxnext toAllow this object to
inherit permissions

Setting Permissions for a
Content Folder on page 4-44

Make content in this
folder private

Checkboxnext to The content in this
folder is private and can only be viewed
by authorized users and members

Note: IfAllow this object to inherit
permissions is checked, you cannot
check this box. In that case, this folder is
inheriting this setting from its parent folder.

Private Content on page 7-184

See Also:

n Adding a User or User Group to the Permissions Table on the facing
page

n Editing User or User Group Permissions on the facing page

n Deleting Users or User Groups from the Permissions Table on page 4-
48
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Adding a User or User Group to the
Permissions Table
To add a user or user group to the Permissions Table, follow these steps.

Note: Before adding users or groups, you must break inheritance. See Setting Permissions for
a Content Folder on page 4-44.

Note: If a user and the user group to which that user belongs are both given permission to a
folder, the user has all permissions to which he/she is assigned as well as permissions
assigned to the user group.

Note: You can only assign Read Only permission to a Membership user or user group. See
Also:Membership Users and Groups on page 16-3

1. Access the Permissions Table for the content folder or content, as
described in Accessing the Permissions Table on page 4-45.

2. Click the Add button ( ).
3. The Add Permissions screen appears. Only users and groups not

assigned to the Permissions Table appear.

4. Click a user or group to add to the Permissions Table.

5. The Add Permissions screen appears.

6. Check the standard and advanced permissions for the user or group.
Refer to Setting Permissions for a Content Folder on page 4-44 for a
description of permission options.

Note: Check Enable All to assign all standard permissions. If you do, you still must assign
advanced permissions by hand.

7. Click the Save button ( ).

Editing User or User Group Permissions
To add or remove permissions for a user or group, editing the user or group in
the Permissions Table. To do so, follow these steps.

1. Access the Permissions Table for the content folder or content, as
described in Accessing the Permissions Table on page 4-45.

2. Click the user or group for which you want to edit permissions.

3. The Edit Permissions screen appears.

4. To assign any permission, check the box. To remove any permission,
uncheck the box.

Note: Remember to toggle between standard and advanced permissions.

5. Click the Update button ( ).

Adding a User or User Group to the Permissions
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Deleting Users or User Groups from the
Permissions Table
To remove permissions from a user or user group, use the Delete button on the
View Permissions window. To do so, follow these steps.

1. Access the Permissions Table for the content folder or content, as
described in Accessing the Permissions Table on page 4-45.

2. Click the Delete button ( ).

3. The Remove Permissions screen appears.

4. Click the user or group to remove from the Permissions Table.

5. A confirmation message appears.

6. Click the OK button.

Note:When you delete the permissions of a user or user group, that change is propagated to
all subfolders and content. Also, if the user or group was part of an approval chain, they are
removed from it.

See Also: Folder Permissions on page 4-40

Setting Permissions for Content
You can assign permissions to a single content item, overriding the default
permissions inherited from the folder. To do so, follow these steps.

1. Access the content by navigating to its folder, selecting a language,
and clicking on it.

2. Click the View Permissions button ( ).
3. Uncheck the box next to Allow this object to inherit

permissions.

4. A confirmation message appears. Press OK.

5. You can perform any action on the content that you can perform on a
folder. These options are described in Actions You Can Perform from
the Permissions Table on page 4-46.
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Overview
As the name suggests, PageBuilder is a tool that enables you to build Web pages
in the Ektron CMS400.NET. What makes PageBuilder unique as a Web page
creation tool is two-fold:

n First, it allows non-technical users a simple way to build rich and
fully-featured Web pages.

n Second, the Ektron development community can leverage
PageBuilder as a simple way to reuse and share common
functionality from one Ektron-powered site to another.

PageBuilder leverages the versatility of Ektron Portal Framework to streamline
the process of building new pages on your Web site. Members of an
organizations’ Web team can now more efficiently make changes to pages and
content, without relying on the availability of developers. Ultimately,
PageBuilder helps not only redefine roles within an organization, but also
maximizes efficiency and productivity.

In a typical PageBuilder scenario, the initial layout is managed by developers,
while the final content, design, and placement of functionality is managed by
non-technical users who have a need for creating specific Web pages. These
non-technical, content authors would typically be marketing departments or
similar organizations.

PageBuilder for Developers
To someone new to PageBuilder, it might seem as though PageBuilder takes the
work of building and maintaining a Web site out of the IT department’s hands.
However, this is not the case. Web page developers still create page templates,
building wireframes into which content authors place functional widgets that will
make the Web page a success. PageBuilder allows the IT department to
concentrate on what they do best: develop the back end of a system and
address the technical nuances that today’s Web sites generate. Content and
messaging is out of their hands and squarely where it belongs: in Marketing.

Wireframes, Dropzones, and Widgets
PageBuilder requires developers to create a wireframe template. This
wireframe is the basic architecture for a Web page. As developers build
wireframes, they add dropzone user controls where non-technical users need to
insert the content, design, and messaging of the site. These zones are literally
the areas into which someone can “drop” a widget.

Widgets are mini-applications that can provide either specific functionality
(calculators, search, and social bars, etc) or areas into which you can add
Ektron CMS400.NET content (content blocks, list summaries, collections, etc.).

Building PageBuilder Pages
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It is simple for developers to apply classes to these pages. Developers can also
manage the level of control non-technical users have. For example, a
developer can configure hard limits for the width of dropzones.

After a wireframe is created, an administrator assigns it to a folder, creates a
page, and selects the widgets that will be available to place on that page.

PageBuilder for Everyday Users
Marketing teams (technical and non-technical alike) can build out entire pages
on the wireframe templates by dragging-and-dropping widgets. This creates
the user experience on the page while maintaining a consistent “look and feel.”
With PageBuilder, they can launch campaigns as needed and respond to market
conditions rapidly with unique Web pages that have targeted and effective
content.

PageBuilder pages have the same business-level controls as content blocks.
Like other Ektron CMS400.NET content, PageBuilder pages maintain
permissions, approval chains, enable SEO (through metadata), Taxonomy,
Aliasing, and allow users to view histories and restore past versions.

Approvers can preview PageBuilder pages before they go live, and pages can
be cloned and then modified to maintain look and feel across campaigns or to
support A/B split testing.

PageBuilder for EverydayUsers
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Streamline Process and Improve
Efficiency
PageBuilder adds a level of agility to key processes that overlap marketing and
IT departments. By using it to streamline the workflow of launching new pages,
time and expenses can be minimized. Moreover, your IT infrastructure remains
secure because non-IT resources do not need to access mission-critical servers
— all needed assets are accessible through the Workarea.

The CMS400.NET PageBuilder is the logical evolution of the WYSIWYG editor,
extending the concept of content management beyond single elements of
content. Now, that philosophy can be applied to whole pages and even entire
sites, boosting productivity and giving you the tools you need to make your Web
site do exactly what you want it to do.

PageBuilder Video
You can see a video explaining PageBuilder in more detail by visiting this URL:
http://ektron.vo.llnwd.net/o28/flashvideos/pagebuilder/FinalPageBuilder.html.

This section also contains the following topics.

Building Pages on the facing page

PageBuilder Code Samples on page 5-37

Advanced PageBuilder Topics on page 5-40

Building PageBuilder Pages
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Building Pages

Use Case: AcmeBooks.com
AcmeBooks.com is a fast growing company that specializes in foreign and hard-
to-find books. Recognizing it needed a stronger presence on the Web, it
recently installed and deployed Ektron CMS400.NET.

The Chief Information Officer of Acme Books is especially excited about the
company’s recent move to CMS400.NET. She is particularly interested in
PageBuilder, feeling it will enable the Marketing team to respond to changing
market conditions and quickly launch and communicate promotions on the
AcmeBooks.com Web site. She is also pleased that PageBuilder promises to
appease the company’s Web site developers. No longer will they have to deal
with numerous daily requests for content changes from Marketing.

So, she wonders, “How does it all work? How will the Web team work together
to use PageBuilder?” Right now, the team is composed of herself and:

Pete. He runs the Web Development team (including designers).

Grace. She is the CMS/Web site administrator.

Pierre. Acme Books' Marketing guru. He is also in charge Marketing and Acme
Books’ content authors.

PageBuilder Workflow
Let’s start with the general PageBuilder workflow. Basically, there are three
stages:

Envisioning the “Big Picture”
In the beginning, stakeholders define functionality and “look” needed on Web
pages. At Acme Books, this includes the CIO, the Marketing team, the
CMS400.NET Administrators, and the Web designers and developers in the IT
department.

When a consensus is reached, Pete’s designers and developers define the page
layout and present it to the whole team for review and approval.

Building Pages
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Designing and Development
Here, Pete’s developers identify page areas and build wireframes based on
design specifications. At this point, they should understand the functionality
needed and use, modify or build widgets based on the requirements.

Implementation and Maintenance
When complete, a PageBuilder page is active and in use by Pierre and his team
on a daily basis. Pierre can create pages, drag-and-drop widgets, and edit
properties as necessary. Subject matter experts create and maintain content.

Building PageBuilder Pages
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Steps to Creating a “PageBuilder” Page
Creating a Web page with PageBuilder functionality at Acme Books consists of
the following tasks:

n Create a PageBuilder Wireframe below. This is performed by Pete
and his developers.

n Enable Manual Aliasing on page 5-12. This is performed by Grace, the
Web site administrator.

n Adding the Wireframe and Widgets into the CMS on page 5-13. This is
performed by Grace, the Web site administrator.

n Assign the PageBuilder Wireframe to a Folder on page 5-14. This is
performed by Grace, the Web site administrator.

n Create the New Page on page 5-17. This is performed by Pierre and
his team.

n Place Widgets on the Page on page 5-19. This is performed by Pierre
and his team.

n PageBuilder Master Layout on page 5-28

Note: Internet Explorer cannot accommodate more than 32 style sheets in one page. This
problem can easily affect PageBuilder pages, because each widget may include one or more
style sheets, and a page can host any number of widgets.

Create a PageBuilder Wireframe
As explained earlier, Pete first creates a wireframe. Next, he defines
dropzones, areas of the page on which a content creator drags and drops
widgets.

Steps to Creating a “PageBuilder” Page
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The relationship between a wireframe, a dropzone, and a widget is illustrated
below.

Here is how Pete creates a wireframe that contains one dropzone.

1. He opens the Web site in Visual Studio.

2. He adds a new Web form to the site by clickingWeb Site > Add
New Item.

3. He selectsWeb Form.

4. Pete sets the Name to PageLayout.aspx, the Language to Visual C#,
and checks Select master page.

Building PageBuilder Pages
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5. He clicks Add, then changes to Source view.

6. He registers the user controls directly below the @ Page directive (at
the top of the file).

<%@ Register Assembly="Ektron.Cms.Controls" Namespace="Ektron.Cms.Controls"
TagPrefix="CMS" %>

<%@ Register Src="~/Workarea/PageBuilder/PageControls/PageHost.ascx" TagPrefix="PH"
TagName="PageHost" %>

<%@ Register Src="~/Workarea/PageBuilder/PageControls/DropZone.ascx" TagPrefix="DZ"
TagName="DropZone" %>

<%@ Register Assembly="Ektron.Cms.Widget" Namespace="Ektron.Cms.PageBuilder"
TagPrefix="PB" %>

7. Next, he’ll add code for a PageBuilder Menu (PageHost) and
Dropzone. To do this, he locates the ContentPlaceHolder1 and enters
this code.

Warning!When inserting the following code, be sure to begin the <ColumnDefinitions>
statements with the prefix on the widget assembly registration line (PB in the example above). Do
not use IntelliSense when entering the <ColumnDefinitions> statements as it may insert an
incorrect prefix.
<PH:PageHost ID="PageHost1" runat="server" DefaultPageID="937" SelTaxonomyID="94" />

<DZ:DropZone ID="Middle" runat="server" AllowAddColumn="false"
AllowColumnResize="false">

<ColumnDefinitions>

<PB:ColumnData width="100" columnID="0" unit="pixels"></PB:ColumnData>

<PB:ColumnData width="100" columnID="1" unit="pixels"></PB:ColumnData>

<PB:ColumnData width="100" columnID="2" unit="pixels"></PB:ColumnData>

</ColumnDefinitions>

Create a PageBuilder Wireframe
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</DZ:DropZone>

With the PageBuilder menu (PageHost) and Dropzone in place, the template will
look like this when he is logged in and ready to configure his PageBuilder page.

This control lets a content author drop widgets on the page. It also provides the
save/check in/publish functions, and lets the author preview how the page will
look when it’s published.

When rendered on a page, a Dropzone user control looks like this.

The content author uses a Dropzone control as a placeholder, into which he will
insert widgets. He can also use it to insert additional placeholders as needed.

Note: See Advanced PageBuilder Topics on page 5-40 for information on customizing user
controls.

8. The pagelayout.aspx code now looks like this.

Building PageBuilder Pages
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Best Practice
Ektron Best Practice is to set values for the FolderIDand SelTaxonomyID
properties. SeeHow a Page’sDefault Folder isSet on page 5-40 andAssigning a
Default Taxonomy to aWireframe on page 5-45

Note: Pete adds only one dropzone now. He plans to add more later.

9. Pete is finished with the aspx template file and is ready to begin
working on his codebehind file.

10. Pete opens the codebehind page, PageLayout.aspx.cs.

11. He adds a reference to the PageBuilder namespace by adding the
following line after the last using statement.

using Ektron.Cms.PageBuilder;

12. Inherit the PageBuilder class instead of System.Web.UI.Page. To do
this, change:

public partial class PageLayout : System.Web.UI.Page

To:

public partial class PageLayout : PageBuilder

13. Pete adds the following code after the Page_Load event to handle
errors and notifications.

Note: You can copy the following code from
siteroot/cms400developer/developer/pagebuilder/pagelayout.aspx.cs.

public override void Error(string message)

{

jsAlert(message);

}

public override void Notify(string message)

{

jsAlert(message);

}

public void jsAlert(string message)

{

Literal lit = new Literal();

lit.Text = "<script type=\"\" language=\"\">{0}</script>";

lit.Text = string.Format(lit.Text, "alert('" + message + "');");

Form.Controls.Add(lit);

}

Create a PageBuilder Wireframe
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Pete does not need to use the jsAlert system defined here but if he does not, he
must somehow add overrides to handle errors and notifications.

The code page for pagelayout.aspx.cs looks like this when he is done.

14. He saves the PageLayout.aspx and PageLayout.aspx.cs files.

Enable Manual Aliasing
Best Practice
The Ektron “best practice” is to enableManual and Auto aliasing.

Pete’s development team needs to make sure that manual aliasing is enabled
within Ektron CMS400.NET. Doing this allows you to apply a user-friendly URL
when you’re creating a PageBuilder page, as shown below.

Building PageBuilder Pages
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Note: See “Creating User-Friendly URLs with Aliasing on page 10-1 for more information.

To enable manual aliasing, the development team does these steps.

1. In the Ektron CMS400.NET Workarea, they go to Settings >
Configuration > URL Aliasing > Settings.

2. They selectManual, then click Save ( ).

Adding the Wireframe and Widgets into
the CMS
In this step Grace, the CMS administrator, makes the wireframe that Pete
created available within the Ektron CMS400.NET Workarea. Grace also
determines which widgets will be available on this wireframe.

1. In the Ektron CMS400.NET Workarea, she goes to Settings >
Configuration > Template Configuration.

2. She clicks the Add button ( ).
3. The Add a New Template screen appears.

4. Grace clicks the browse button and navigates to PageLayout.aspx,
the wireframe Pete created earlier in Create a PageBuilder
Wireframe on page 5-7.

5. She clicks the PageBuilder Wireframe check box. This box tells
Ektron CMS400.NET that this template can be used to create a
PageBuilder page.

6. All widgets that can be applied to the template appear. Ektron
CMS400.NET provides many standard widgets. See Widget Reference
on page 6-5.

Note: Customizing Widgets on page 6-28 explains how to create a custom widget.

Adding the Wireframe andWidgets into the CMS

ReferenceManual
Version 8.01 Rev 4

5-13



7. Grace clicks the ContentBlock and List Summary widgets. When she
does, their background color changes.

8. She clicks the Save button ( ).

Assign the PageBuilder Wireframe to a
Folder
Here, Grace creates a folder for the content that will appear on the new page.
To accomplish this, she does the following.

1. Grace clicks the Content tab in the Ektron CMS400.NET Workarea. All
folders appear in the left panel.

2. She clicks the Root folder (highlighted below).

Note: For more information about folder permissions and approval chains, seeWorkFlow on
page 4-27.

Building PageBuilder Pages
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3. She clicks New > Folder.

Grace knows that it is an Ektron best practice to keep content and PageBuilder
pages in separate folders, so she will later create and configure a folder called
“Content”. The content folder will simply contain content blocks and other
assets, as well as sub-folders.

4. She accesses the folder properties for the new folder.

5. In the Name field, she types Pages.

Next, Grace assigns the template created earlier as the default (and only)
template for this folder. This will ensure that only PageBuilder pages can be
created in this folder.

6. Grace clicks the Templates tab.

7. Grace clears the Inherit Parent Template Configuration option and
clicks OK at the prompt.

Note: For more information about folder inheritance, see Folder Permissions on page 4-40.

Assign the PageBuilder Wireframe to a Folder
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8. She selects PageLayout.aspx from the template list. This is the
wireframe Pete created earlier.

9. She clicks the Add button ( ) to the right of the pull-down menu.
PageLayout.aspx is now added to the list of page templates.

10. She deletes CMSlogin.aspx from the list to ensure that no content is
placed in the folder.

11. Grace selects PageLayout.aspx (the default option, circled below) and
clicks Save ( ).

.

12. Grace will follow steps 3 through 6 to create a folder for content.
However, this time, instead of assigning pagelayout.aspx as the
template, she will assign a template used to create Ektron
CMS400.NET content.

Building PageBuilder Pages
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Create the New Page
It’s time for Pierre and his team to create a PageBuilder page. Currently, at
AcmeBooks.com, there is a pressing need to market a new series of mystery
novels from an up-and-coming Australian novelist. So, the Marketing team
needs to quickly create a Web page to announce the new series. Here’s how
they build the page with PageBuilder.

Warning!When you edit PageBuilder pages in the Ektron CMS400.NETWorkarea via Internet
Explorer, version 7 or higher is required.

1. They click the Pages folder, which was created in Assign the
PageBuilder Wireframe to a Folder on page 5-14.

2. They click New > Page Layout.

3. The Add New Page screen appears.

Create the New Page
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4. Since only one template is assigned to the folder, it appears as the
default. Click Next.

5. A new screen appears.

This allows the team to assign a title, taxonomy, and aliasing information to the
page.

6. The team enters New Australian Mystery Series in the Page Title
field.

7. By default, the Manual Alias matches the Page Title. The Marketing
team changes it to Australian_Mystery.

They do this in the Alias field so the new page has a user-friendly name. For
example, by default, the page’s name is www.acmebooks.com/new_mystery_

Building PageBuilder Pages
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series.aspx. The alias Australian_Mystery lets the page display as
www.acmebooks.com/Australian_Mystery.

8. Click Next.

9. The following screen appears.

This allows the team to assign metadata and a summary to the page. See Also:
Working with Content Summary on page 7-137;Working with Metadata on page
7-141

10. Click Finish.

11. The following message appears. Press OK.

Place Widgets on the Page
Note: For information about how to create a widget, see Creating the “Hello World” Widget on
page 6-15.

After Pierre and the Marketing team create the page, a new page opens. It
contains one dropzone, which consists of two columns (shown below).

PlaceWidgets on the Page
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The top of the page contains a PageBuilder menu control. Pierre will use it to
perform actions on the page, such as check in, view properties, and drop
widgets onto the page.

Pierre uses the right/left arrow buttons (circled below) to open and close the
PageBuilder menu.

Pierre could choose to stop the Auto Hide feature for the PageBuilder menu by
clicking the thumbtack (circled below).

Pierre determines that the page needs a two-column layout, as shown below.

Building PageBuilder Pages
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Note: Although you can drop existing content onto the page, the Marketing team will create
new content on the page.

n The left column is 35% wide and displays a list of all content in the
Marketing folder. Web site visitors use the list to access all Marketing
collateral for AcmeBooks.com.

n The right column is 65% wide and displays a single content block.

Pierre’s Marketing team creates this layout in three steps:

n Part 1: Add New Column and Set Column Widths below

n Part 2: Insert New Content Block Widget into Right Column on next
page

n Part 3: Insert a List Summary Widget into Left Column on page 5-26

Part 1: Add New Column and Set Column
Widths
In this part of the procedure, the Marketing team adds a second column to the
right of the top one. Then, they set the width of both columns.

Note: If your developer set dropzone’s column widths programmatically (as explained in Part
1: Add New Column and Set Column Widths above), the user cannot add a column as
described here.

c

1. They click Add Column ( ) and a new column appears to the right of
the existing one.

2. They set the left column width to 35% by clicking the pencil icon
(circled below).

Part 1: Add New Column and Set ColumnWidths
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3. A field lets them enter a width and measurement (pixels or percent).

4. So, they enter 35 into the New Width field, change the
measurement to Percent, and click Save.

5. Then, the team sets the right column to 65% width by clicking the
pencil icon, changing its width to 65 Percent, and clicking Save.

6. Now the screen looks like this.

Part 2: Insert New Content Block Widget
into Right Column
Now that Pierre’s team has set up the columns, Pierre is eager to try inserting a
ContentBlock widget into the right column.

1. From the small block in the center of the PageBuilder menu, Pierre
clicks the down arrow (circled below).

Building PageBuilder Pages
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Note: Pierre tells his team that if they do not see the PageBuilder Menu, look for small block
with two arrows, one orange and one blue (shown below). Click the orange arrow to open the
menu.

2. All widgets that the Web site administrator (Grace) assigned to the
page wireframe in Adding the Wireframe and Widgets into the CMS
on page 5-13 appear.

3. Pierre places the cursor over the content block widget and drags it
below the widget panel.

4. The widget panel disappears.

5. Pierre drops the content block widget in the right column.

6. That column looks like this.

7. Pierre clicks the pencil icon (circled above), and the following screen
appears.

Part 2: Insert New Content BlockWidget into Right
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8. He selects the Content folder, and clicks New in the lower right corner
(circled above).

9. The Add Content screen appears.

10. In the Title field, Pierre enters New Australian Mystery Series.

11. In the content area, he enters some text about the series of books,

and clicks the Check In button ( ).
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12. The content displays as shown below.

13. When the Marketing team wants to edit content on this page, they can
click the Access Point in the upper left corner. A menu displays.

Part 2: Insert New Content BlockWidget into Right
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Part 3: Insert a List Summary Widget into
Left Column
Now that Pierre has inserted content in the right column, he can insert a List
Summary widget in the left column.

1. From the PageBuilder menu, he clicks the down arrow (circled
below).

2. All widgets Grace (the CMS administrator) assigned to the page
wireframe in Adding the Wireframe and Widgets into the CMS on page
5-13 appear.

3. Pierre places the cursor over the List Summary widget and drags it
below the widget panel.

4. The widget panel disappears.

5. He drops the List Summary icon in the left column.
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6. That column looks like this.

7. The widget displays a list summary for content in the root folder.
Pierre needs to change it to refer to the Content folder. To do that, he
clicks the pencil icon in the widget’s top right corner (circled above).

8. The following screen appears.

9. He clicks the Folder tab and selects the Content folder.

10. He clicks Save, and the list summary shows content in the Content
folder.

Part 3: Insert a List SummaryWidget into Left
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11. From the PageBuilder menu, Pierre clicks File > Check In.

12. The whole Marketing team can now review the page in Preview mode
and make sure it is formatted properly.

13. If they need to change it, they can click File > Edit from the
PageBuilder menu.

PageBuilder Master Layout
A special type of PageBuilder page called a Master Layout has a dropzone called
aMaster Zone. The Master Zone is unchangeable on all PageBuilder pages that
use the Master Layout template.

An example of the use of this type of page is where a department head reserves
one dropzone of his department pages for content he maintains. Other pages
created by his team may make changes to any other dropzones on pages they
create from his master layout.

This section also contains the following topics.

How a Master Layout works 5-29
Layout Zones and Master Zones 5-30
Creating a Master Layout Page 5-30
Setting a Dropzone to a Master Zone type 5-31
Changing a DropZone Type to Master Zone 5-32
Assign a Master Layout to the Pages Folder 5-33
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Using a Master Layout to Create a New Page 5-33
Changing a Master Zone to a Layout Zone 5-35

How a Master Layout works
The diagram below shows a wireframe that contains two dropzones and 4
widgets. A Master Layout lets you designate any of the dropzones as a Master
Zone. Master Zones are only editable by users with an Administrator or
MasterLayout-Create roles. All other dropzones are called a Layout Zone.

PageBuilder pages can use a Master Layout as their template. By doing this,
widgets can only be changed in the Layout Zones while the Master Zone
remains uneditable. In the example below, the Master Zone contains a Flckr
widget.

Once the Master Layout is published, it can be used like any other wireframe or
template by adding it to the list of available templates on a content folder.

An example of a Master Layout used on a PageBuilder template looks like this.

How aMaster Layout works
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Layout Zones and Master Zones
Each dropzone on a Master Layout is designated as either a Layout Zone or a
Master Zone. Only users with the role of Administrator or MasterLayout-Create
can modify widgets in a Master Zone.

Creating a Master Layout Page
In the previous topics about Acme Books, Pete created a wireframe with two
dropzones - both of which are editable by Pierre and his marketing team. Now,
Pierre wants to create pages with one dropzone in the upper right corner which
is not editable by the marketing team. In this zone, he wants to show the Flickr
widget on all pages. In the other zone, he wants to allow any type of widget to
be dropped.

Since Pierre has a MasterCreate-Layout role in the CMS, he follows these steps
to create the Master Layout.

1. In the Workarea > Content folder, create a new folder called Master
Layouts.

2. In the Template tab, add a wireframe template that shows in the list
of templates. In the example below, he chooses "threeCol.aspx
(Wireframe Template)" from the list.

3. Click Update ( ) to add the template to the folder.
4. Click the Master Layouts folder.

5. Select New > Master Layout from the menu as shown below.
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6. Set the title to MasterLayout1.

7. Click Next.

.

8. Select the wireframe that you wish to use for this layout. It is
highlighted green when chosen.

9. Click Next.

10. Set Metadata, Summary, and Taxonomy Categories if desired.

11. Click Finish.

12. You see Page Creation Successful.

13. Click OK to continue editing.

Setting a Dropzone to a Master Zone type
After the wizard is finished, you see the new Master Layout page with the
dropzones that can be used for Master Layout areas. You need to unlock a
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dropzone to change it into a Master Zone. An example of a Master Layout with
three dropzones is shown below.

In the steps below, we change one dropzone to a Master Zone type.

Changing a DropZone Type to Master Zone

1. Click the Lock button ( ) to change the dropzone type from Layout
Zone to Master Zone.

2. The following warning pops up. Click OK to continue.

Warning! Unlocking this dropzone will delete columns and widgets that are on templates based
on this master layout. Click OK to unlock this dropzone.

3. You see a dropzone onto which you can drag-and-drop a widget - such
as a Flickr widget as shown below.

4. On the PageBuilder Menu, select File > Publish.
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Pierre now has a PageBuilder Master Layout that contains three dropzones. One
zone is a Master Zone containing a Flickr widget. All PageBuilder Pages that use
this layout will have two zones to edit plus a zone with the Flickr widget they
cannot change.

Assign a Master Layout to the Pages Folder
Before Pierre's group can create new PageBuilder pages based on the new
Master Layout, it must first become a part of the list of templates available to
Pages folder. To do this, he follows these steps.

1. In the Workarea, click the Pages folder.

2. Select the menu View > Properties.

3. Click Edit ( ).
4. Click the Templates tab.

5. Select the Master Layout. In the example below it is called /Master
Layouts/MasterLayout1

6. Click Add ( ) to add the new Master Layout to the template list.

7. Click Update ( ) to save the changes for this folder.

Using a Master Layout to Create a New Page
Now that Pierre has created the Master Layout page and assigned it to the
Pages folder, he instructs his team to use it for their PageBuilder pages.

To do this, they follow these steps.

1. In the Workarea, click the Pages folder.

2. Click New > Page Layout.
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3. The Add New Page screen appears.

4. Select the new Master Layout as shown below.

5. Click Next.

6. Complete the settings for Title, Taxonomy, and Aliasing.

7. Click Next.

8. Enter Metadata and a Summary.

9. Click Finish.

10. The following message appears. Press OK.

Widgets can now be placed onto the new PageBuilder page's Layout Zone. The
Master Zone will appear the same on each new PageBuilder page Pierre's team
creates.
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Changing a Master Zone to a Layout Zone
Note: To make this change, you must be a member of the Administrators group or have the
role of or MasterLayout-Create.

At some point, you may want to reverse the previous steps on a Master Layout
and convert a Master Zone back to a Layout zone. To do this, follow these
steps.

1. Access the Master Layout page that you want to edit.

2. Click Edit Page.

3. Click the lock ( ) (circled below) to change the dropzone type from
Master Zone to Layout Zone.

4. The following warning pops up. Click OK to continue.
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Warning! Locking this dropzone deletes columns and widgets in the master zone, and affects all
templates based on this Master Layout.

5. The Master Zone now appears Locked. PageBuilder editors can use
this Layout Zone for widgets on PageBuilder pages derived from this
Master Layout.

Final Assessment
The CIO of AcmeBooks.com can see the power of the PageBuilder, and is
convinced that this will greatly increase effectiveness of the company’s
Marketing and sales goals. The simple workflow and ease of use will help the
Marketing team quickly launch marketing campaigns and keep the Web site
fresh.

She still has one lingering question:

“How on earth do you build a widget?”
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PageBuilder Code Samples
The following shows a complete example of AcmeBooksMasterPage.master and
pagelayout.aspx

AcmeBooksMasterPage.master
<%@ Master Language="C#" AutoEventWireup="true" CodeFile="AcmeBooksMasterPage.master.cs"
Inherits="AcmeBooksMasterPage" %>

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">

<html xmlns="http://www.w3.org/1999/xhtml">

<head runat="server">

<title>Acme Books</title>

<asp:ContentPlaceHolder id="head" runat="server">

</asp:ContentPlaceHolder>

</head>

<body>

<form id="form1" runat="server">

<div>

<asp:ContentPlaceHolder id="ContentPlaceHolder1" runat="server">

</asp:ContentPlaceHolder>

</div>

</form>

</body>

</html>

PageLayout.aspx
<%@ Page Language="C#" MasterPageFile="~/AcmeBooksMasterPage.master"
AutoEventWireup="true" CodeFile="PageLayout.aspx.cs" Inherits="PageLayout"
Title="Untitled Page" %>

<%@ Register Assembly="Ektron.Cms.Controls"
Namespace="Ektron.Cms.Controls" TagPrefix="CMS" %>

<%@ Register Src="~/Workarea/PageBuilder/PageControls/PageHost.ascx"
TagPrefix="PH" TagName="PageHost" %>
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<%@ Register Src="~/Workarea/PageBuilder/PageControls/DropZone.ascx"
TagPrefix="DZ" TagName="DropZone" %>

<%@ Register Assembly="Ektron.Cms.Widget"
Namespace="Ektron.Cms.PageBuilder" TagPrefix="PB" %>

<asp:Content ID="Content1" ContentPlaceHolderID="ContentPlaceHolder1"
runat="Server">

<PH:PageHost ID="PageHost1" runat="server" DefaultPageID="937"
SelTaxonomyID="94" />

<DZ:DropZone ID="Middle" runat="server" AllowAddColumn="false"
AllowColumnResize="false">

<ColumnDefinitions>

<PB:ColumnData width="100" columnID="0" unit="pixels"></PB:ColumnData>

<PB:ColumnData width="100" columnID="1" unit="pixels"></PB:ColumnData>

<PB:ColumnData width="100" columnID="2" unit="pixels"></PB:ColumnData>

</ColumnDefinitions>

</DZ:DropZone>

</asp:Content>

PageLayout.aspx.cs
The following shows a complete example of pagelayout.aspx.cs

using System;

using System.Data;

using System.Configuration;

using System.Collections;

using System.Web;

using System.Web.Security;

using System.Web.UI;

using System.Web.UI.WebControls;

using System.Web.UI.WebControls.WebParts;

using System.Web.UI.HtmlControls;

using Ektron.Cms.PageBuilder;

public partial class PageLayout : PageBuilder

{

protected void Page_Load(object sender, EventArgs e)

{
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}

public override void Error(string message)

{

jsAlert(message);

}

public override void Notify(string message)

{

jsAlert(message);

}

public void jsAlert(string message)

{

Literal lit = new Literal();

lit.Text = "<script type=\"\" language=\"\">{0}</script>";

lit.Text = string.Format(lit.Text, "alert('" + message + "');");

Form.Controls.Add(lit);

}

}

PageLayout.aspx.cs
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Advanced PageBuilder
Topics
This section covers the following advanced topics that help you implement
PageBuilder more fully.

This section also contains the following topics.

Customizing the PageBuilder Menu Control 5-40
Customizing the Dropzone User Control 5-41
Customizing the Wireframe 5-43

For information about advanced widget use, see Customizing Widgets on page
6-28.

Customizing the PageBuilder Menu
Control
This section explains how to customize the PageBuilder Menu user control’s
behavior.

This section also contains the following topics.

Determining the Ektron CMS400.NET Folder to Which Pages are
Saved

5-
40

How a Page’s Default Folder is Set 5-40
Overriding the Default Folder 5-41
Changing the Page’s Cache Interval 5-41

Determining the Ektron CMS400.NET Folder
to Which Pages are Saved

How a Page’s Default Folder is Set
By default, when a site user creates a new PageBuilder page from an existing
one, it is saved to the same Ektron CMS400.NET folder. For example, consider
this folder/content structure.

Root (folder id 0)

Products (folder id 20)

PageLayout: “Omaha Mailorder Steaks” (content id 35)

Services (folder id 30)
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If you are viewing content id 35 and click New Page or Copy/Save as, the
new page is saved to that content’s folder (Products, folder id= 20).

Note:When you create a new page layout from theWorkarea, you first select a folder then
begin creating the page layout.

Overriding the Default Folder
Use the PageBuilder control’s FolderID property to override the default and
specify an Ektron CMS400.NET folder to which new pages are saved. Here is an
example of that property:

<ucPageBuilder:PageHost ID="ucPageHost1" FolderID="25" runat="server" />

When a user is working on a page that hosts this PageBuilder control, and he
saves a new page, it is saved to folder id 25.

Changing the Page’s Cache Interval
Use the CacheInterval property to cache a page and its Widgets that represent
Ektron CMS400.NET server controls, such as a Collection Widget.

This property sets the amount of time, in seconds, that data is cached. The
default is 0 (zero).

<ucPageBuilder:PageHost ID="ucPageHost1" CacheInterval="25" runat="server" />

Customizing the Dropzone User Control
Several properties let you customize the Dropzone user control’s behavior.

This section also contains the following topics.

Letting Users Add Columns to a Dropzone 5-42
Letting Users Resize a Dropzone 5-42
Setting a Dropzone’s Column Widths Programmatically 5-42
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Letting Users Add Columns to a Dropzone
Use the AllowAddColumn property to let users add columns to a Dropzone.

<ucPageBuilder:DropZone ID="ucDropZone1" AllowAddColumn="true" AllowColumnResize="true"
runat="server" />

For example, a Dropzone initially contains one column, but the page creator
wants three. If this property is set to true, this change is possible.

This property’s default value is true.

Note: If you set dropzone’s column widths programmatically (as explained in Setting a
Dropzone’s Column Widths Programmatically below), the user will not be able to add a
column, regardless of this setting.

Letting Users Resize a Dropzone
Use the AllowColumnResize property to let users change the width of columns
in a Dropzone.

<ucPageBuilder:DropZone ID="ucDropZone1" AllowAddColumn="true" AllowColumnResize="true"
runat="server" />

For example, column width is 100% by default. A page creator wants to change
it to 50%. If this property is set to true, this change is possible.

This property’s default value is true.

Note: If you set dropzone’s column widths programmatically (as explained in Setting a
Dropzone’s Column Widths Programmatically below), the user will not be able to add a
column, regardless of this setting.

Setting a Dropzone’s Column Widths
Programmatically
If you want to set a dropzone’s column widths programmatically, follow these
steps.

1. Add the following Register statement to the page’s <head> tags.
<%@ Register Assembly="Ektron.Cms.Widget" Namespace="Ektron.Cms.PageBuilder"
TagPrefix="PB" %>

Warning! The Widget and Dropzone assemblies must have the same Tag Prefix. See example.
<%@ Register Src="~/Workarea/PageBuilder/PageControls/PageHost.ascx" TagPrefix="PB"
TagName="PageHost" %>

<%@ Register Src="~/Workarea/PageBuilder/PageControls/DropZone.ascx" TagPrefix="PB"
TagName="DropZone" %>
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<%@ Register Assembly="Ektron.Cms.Widget" Namespace="Ektron.Cms.PageBuilder"
TagPrefix="PB"%>

2. Within the page’s <body> tags, add the following code. The following
example adds three columns of 100 pixels each.

<PB:DropZone ID="Middle" runat="server">

<ColumnDefinitions>

<PB:ColumnData width="100" columnID="0" unit="pixels"></PB:ColumnData>

<PB:ColumnData width="100" columnID="1" unit="pixels"></PB:ColumnData>

<PB:ColumnData width="100" columnID="2" unit="pixels"></PB:ColumnData>

</ColumnDefinitions>

</PB:DropZone>

Set width to an appropriate number. For the unit, the options are

n pixels

n percent

n em

If you set a dropzone’s column widths programmatically, you must also set the
AllowAddColumn and AllowColumnResize properties to false. If you do not,
users working with widgets can add columns and adjust column widths on the
page, but their changes will revert to these settings when they try to save.

Customizing the Wireframe
This section also contains the following topics.

Assigning a Default Page to a Wireframe 5-43
Assigning a Default Taxonomy to a Wireframe 5-45

Assigning a Default Page to a Wireframe
You can assign a default page to a wireframe. If you do, and a site visitor
enters a URL with a path to that wireframe that lacks a query string ID, the
default page appears. The following example explains this feature.

URL Returns this Page Layout content

http://siteroot/
/cms400developer/developer/PageBuilder

/PageLayout.aspx?pageid=1036

In the PageBuilder folder, PageLayout ID 1036
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URL Returns this Page Layout content

http://site
root/cms400developer/developer

/PageBuilder/PageLayout.aspx

(Note lackof query string parameter)

The Page Layout page identified in the
PageLayout.aspx file’sPageBuilder menu user
controlDefaultPageIDproperty.

To assign a default page to a wireframe, follow these steps.

1. In the Ektron CMS400.NET Workarea, create a PageBuilder page that
will be used as the default pageid for a wireframe.

2. In Visual Studio, open the wireframe file assigned to that folder.

3. Find the PageBuilder menu user control (circled below).

4. Add a new property, DefaultPageID.

5. For the property’s value, enter the ID of the page you created in Step
1.

Here is an example of that line with the DefaultPageID property added.

<ucPageBuilder:PageHost ID="ucCms400Developer" DefaultPageID=”1035” runat="server" />

6. Save your changes.

To continue the above example, if someone opens a browser and enters
http://site
root/cms400developer/developer/PageBuilder/PageLayout.aspx, he is
redirected to

http://site root/cms400developer/developer/PageBuilder/PageLayout.aspx?pageid=1035
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Assigning a Default Taxonomy to a
Wireframe
While creating a new PageBuilder page in the Ektron CMS400.NET Workarea,
the user can assign one or more of the taxonomy categories that are set in the
page’s folder properties. See example below.

As a developer, you can assign a default taxonomy category to a wireframe. If
you do, and the user creating a page using that wireframe makes no changes,
the default category is assigned to the page. However, the user can change the
taxonomy when the Add New Page screen appears.

Note: Default taxonomies are applied only when a user logs into a Web site and adds a new
page -- they are not applied when creating new pages within the Workarea.

To assign a default taxonomy category to a wireframe, follow these steps.

Prerequisite:The ID number and the name of the top-level parent taxonomy
for the default taxonomy category. For example, the screen below shows that
the Photo category’s ID is 138, and its parent taxonomy is Photo Gallery.
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1. In the Ektron CMS400.NET Workarea, navigate to the folder
properties screen of the folder to which the wireframe is applied.

2. Click the Edit button ( ).
3. Locate the Taxonomy tab of the Edit Folder properties screen.

4. If you will assign to the wireframe a top-level taxonomy (that is, one
of those in the area circled above), check its box.

5. If you will assign a taxonomy category (that is, a child node below a
top-level taxonomy), check the box of its parent Taxonomy.

6. Save your changes to folder properties.

7. Open Visual Studio.

8. Open the wireframe to which you will assign a default taxonomy.

9. Find the PageBuilder menu user control (circled below).
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10. Add a new property, SelTaxonomyID.

11. For the property’s value, enter the ID of the default taxonomy or
category.

Here is an example of that control with the SelTaxonomyID property added.

<ucPageBuilder:PageHost ID="ucCms400Developer" SelTaxonomyID=”13” runat="server" />

12. Save your changes.

To continue the above example, the next time someone creates a page based
on that wireframe, taxonomy ID 13 will be the page’s default taxonomy
category. If desired, the user can change it by navigating to the Taxonomy tab
and assigning different or additional categories.
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Widgets are mini-applications that can provide either specific functionality
(calculators, search, and social bars, etc) or areas into which you can add
Ektron CMS400.NET content (content blocks, list summaries, collections, and so
on). You can drag and drop widgets onto a page using PageBuilder. To open the
widget bar from the PageBuilder menu, click on the up/down ( ) or
down ( ) controls.

A widget consists of three file types.

.ascx - contains a widget’s source code

.ascx.cs or .vb - contains widget’s codebehind

.ascx.jpg - image that represents a widget in the widget selection tool

Note: Your widget might use additional files, such as .css or .js files.You should place these
files in a folder within
site root/widgets, and give the folder the same name as the custom widget.

When you create a widget, save files to the site _root/widgets folder. This
folder path is defined in the site root/web.config file, so if Pete needs to
change the folder name or path, he must update the following web.config ek_
widgetPath element:

<add key=”ek_widgetPath” value=”Widgets/" /> .

After widgets are integrated into Ektron CMS400.NET, you can add them to a
Dashboard in your profile page or a community group’s page. You also can
drag-and-drop these building blocks onto a PageBuilder page (as shown below).

This section also contains the following topics.

Widgets, DropZones, and Pages 6-3
Widget States 6-4
Widget Reference 6-5
Removing a Widget from the Workarea 6-15
Creating the “Hello World” Widget 6-15
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Customizing Widgets 6-28
Creating Conditions with the Targeted Content Widget 6-38
Working with the Flash Widget 6-52

Widgets, DropZones, and Pages
The following figure shows the relationship between a wireframe, dropzones,
and widgets.

A wireframe can have several dropzones.

Each dropzone can have several columns.

Each column can have several widgets.

Ektron CMS400.NET stores each page’s data (a serialized XML string) as a type
of content within the Ektron CMS400.NET Workarea. The string is stored like
other content types, such as HTML content and XML Smart Forms. The following
figure shows a widget’s page data within the Workarea.
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Widget States
Widgets placed on a PageBuilder page have three possible combinations of
states.

Page
mode

Widget
mode

State Illustration

View View Widget content appears on
page.

Edit View
Widget can be
dragged/dropped, moved,
deleted.

UsingWidgets
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Page
mode

Widget
mode

State Illustration

Edit Edit User defineswidget information.

In a widget’s user control file, you create an asp:MultiView element that
determines available actions when a widget is in View mode and Edit mode.
See sample below:

<%@ Control Language="C#" AutoEventWireup="true" Code-
File="HelloWorld.ascx.cs" Inherits="widgets_HelloWorld" %>

<%@ Register Assembly="System.Web.Extensions, Version=1.0.61025.0, Cul-
ture=neutral, PublicKeyToken=31bf3856ad364e35"

Namespace="System.Web.UI" TagPrefix="asp" %>
<asp:MultiView ID="ViewSet" runat="server" ActiveViewIndex="0">
<asp:View ID="View" runat="server">
<!-- You Need To Do .............................. -->
<asp:Label ID="HelloTextLabel" runat="server"></asp:Label><br />
<asp:Label ID="CheckBoxLabel" runat="server"></asp:Label>
<!-- End To Do .............................. -->
</asp:View>
<asp:View ID="Edit" runat="server">
<div id="<%=ClientID%>_edit">
<!-- You Need To Do .............................. -->
<asp:TextBox ID="HelloTextBox" runat="server" Style="width: 95%"> </asp:Te-

xtBox><br />
<asp:CheckBox ID="MyCheckBox" runat="server" Checked="false" /> <br /><br

/>
<!-- End To Do .............................. -->
<asp:Button ID="CancelButton" runat="server" Text="Cancel" OnClick="C-

ancelButton_Click" /> &nbsp;&nbsp;
<asp:Button ID="SaveButton" runat="server" Text="Save" OnClick="Sa-

veButton_Click" />
</div>
</asp:View>

</asp:MultiView>

Widget Reference
Widgets are typically located in the Ektron CMS400.NET in the
<webroot>/<siteroot>/Widgets/ folder. The following table shows a widget
icon and brief description and a link to more information about each widget.
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Note: The widget names below are standard names that Ektron assigns. Ektron
CMS400.NETadministrators can change a widget's name on the Synchronize Widgets Screen.

Widget Description Files

ActivityStream

Displaysactivities of a user or group, depending on
the type of page on which it is placed

See Also:Making the ActivityStreamWidget Available
on page 16-169

ActivityStream.ascx

ActivityStream.ascx.cs

ActivityStream.ascx.jpg

and

Files in widgets/ActivityStream

Atom Feed

Lets user enter path to an AtomPublishing Protocol
feed. Also lets user limit the number of feed results.

AtomFeed.ascx

AtomFeed.ascx.cs

atomfeed.ascx.jpg

and

Files in widgets/AtomFeed

BaseBall ESPNMlb

Displays latest newsabout the baseball team
selected byediting the widget. Provided byESPN.

BaseBallEspnMlb.ascx

BaseBallEspnMlb.ascx.cs

BaseBallEspnMlb.acx.jpg

Blog

After you select a blog id , thiswidget displaysposts
from that blog.

blogs.ascx

blogs.ascx.cs

blogs.acx.jpg

and files in widgets/Blogs

Bookmarks

Lets user create a list of URLsbyentering each
one’sweb addressand title.

Bookmarks.ascx

Bookmarks.ascx.cs

bookmarks.ascx.jpg
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Widget Description Files

BrightCove Video

PlaysanyBrightCove video

BrightCoveVideo.ascx

BrightCoveVideo.ascx.cs

BrightCoveVideo.ascx.jpg

and

Files in
widgets/BrightCoveVideo

Calculator

Providesa calculator

Calculator.ascx

Calculator.ascx.cs

Calculator.ascx.jpg

and

Files in widgets/Calculator

Calendar

Displaysa calendar. A user can add events to any
dayand time.

Calendar.ascx

Calendar.ascx.cs

Calendar.ascx.jpg

and

Files in widgets/Calendar

Clock

Providesa clock that displays time in the current time
zone.

Clock.ascx

Clock.ascx.cs

clock.ascx.jpg

Collection

Displaysa collection. You select a Collection ID.

Collection.ascx

Collection.ascx.cs

Collection.ascx.jpg

Content Block

Lets user enter a content ID and display that content
in theWidget. Alternatively, user can create new
HTML content from the widget.

ContentBlock.ascx

ContentBlock.ascx.cs

contentblock.ascx.jpg

and

Files in widgets/ContentBlock
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Widget Description Files

ContentEdit
Displays content items that have been added or
edited within the number of days set in the widget's
property screen. For example, if you accept the
default of 7 days, any content edited or added within
the past seven daysappears.

ContentEdit.ascx

ContentEdit.ascx.cs

contentedit.ascx.jpg

ContentInWorkflow

Displays content items that were submitted for pub-
lication and remain in the approval chain within the
number of days you set in the widget's property
screen.

ContentInWokflow.ascx

ContentInWokflow.ascx.cs

ContentInWokflow.ascx.jpg

Content List

Displaysa list of content blocks. In contrast to a List
Summary, where content must be in a specified
folder, the ContentList control displays content from
anyEktron CMS400.NET folder.

ContentList.ascx

ContentList.ascx.cs

ContentList.ascx.jpg

Content Review

Placesa ContentReview server control on the page.
This control allows site visitors to rate and review the
current page.

ContentReview.ascx

ContentReview.ascx.cs

ContentReview.ascx.jpg

and

Files in widgets/ContentReview

EmbedHTML

Inserts a browser plugin into your page.

EmbedHTML.ascx

EmbedHTML.ascx.cs

EmbedHTML.ascx.jpg

ESPN

Displays selected ESPN news feed.

espn.ascx

espn.ascx.cs

espn.ascx.jpg
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Widget Description Files

FaceBookFan List

Allowssite users to become your fan and view your
FacebookPage stream.

See Also:
http://wiki.developers.facebook.com/index.php/Fan_
Box

FaceBookFanList.ascx

FaceBookFanList.ascx.cs

FaceBookFanList.ascx.jpg

and

Files in
widgets/FaceBookFanList

FaceBookLive
Stream

AllowsFacebookusers to connect, share, and post
updates in real-time.

See Also:
http://wiki.developers.facebook.com/index.php/Live_
Stream_Box

FaceBookLiveStream.ascx

FaceBookLiveStream.ascx.cs

FaceBookLiveStreamt.ascx.jpg

and

Files in
widgets/FaceBookLiveStream

Flash

Displaysa selected flash file which resides in Ektron
CMS400.NET. You can also set the display’s height
and width. See Also: Working with the FlashWidget
on page 6-52

Flash.ascx

Flash.ascx.cs

Flash.ascx.jpg

and

Files in widgets/Flash

Flickr

DisplayFlickr’sMost Recent or Most Interesting
photos. The user also can select the number of rows
and columns for the image display.

Flickr.ascx

Flickr.ascx.cs

flickr.ascx.jpg

and

Files in widgets/Flickr

Google
Gadget

Select from severalGoogle feeds to display in the
widget.

GoogleGadget.ascx

GoogleGadget.ascx.cs

GoogleGadget.ascx.jpg

and

Files in widgets/GoogleGadget
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Widget Description Files

HelloWorld

Very simple widget. Created byEktron to help
developers understand how to create their own
widgets.

HelloWorld.ascx

HelloWorld.ascx.cs

HelloWorld.ascx.jpg

iFrame

Lets user enter a path to aWeb page or an item on
theWeb page.

IFrame.ascx

IFrame.ascx.cs

iframe.ascx.jpg

Image

Lets you insert a single image to the widget. The
image can be either an asset or a library file.

Image.ascx

Image.ascx.cs

Image.ascx.jpg

and

files in widgets/Image

ITune Podcast

Displayspodcasts from the ItunesWeb site.

ITunePodcast.ascx

ITunePodcast.ascx.cs

ITunePodcast.ascx.jpg

and

Files in widgets/ITunePodcast

List Summary

Displaysan Ektron List Summary, a list of certain
typesof content in a selected folder.

ListSummary.ascx

ListSummary.ascx.cs

ListSummary.ascx.jpg

and

Files in widgets/ListSummary

MessageBoard

Allowsuser to leave comments on the page.

MessageBoard.ascx

MessageBoard.ascx.cs

MessageBoard.ascx.jpg

and

Files in widgets/MessageBoard

UsingWidgets
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Widget Description Files

Metadata List

Displays content whosemetadata fits a selected
folder location and keywords. For additional details,
see theMetaDataList Server Controlon page 7-169

MetaDataList.ascx

MetaDataList.ascx.cs

MetaDataList.ascx.jpg

and

Files in widgets/MetaDataList

Most Popular

Reports on the following categories of content on
your Web site: Most Viewed, Most Emailed, Most
Commented, or Highest Rated.

See Also: TheMost Popular Widget on page 7-759

MostPopular.ascx

MostPopular.ascx.cs

MostPopular.ascx.jpg

and

Files in widgets/MostPopular

Multivariate
Experiment This controls the experiment. Settings include the

target content number, start/stop button and the
Report hide/show button.

See Also: "Widgets used byMultivariate Testing" on
page 1

MultivariateExperiment.ascx

MultivariateExperiment.ascx.cs

MultivariateExperiment.ascx.jpg

and

Files in
widgets/MultivariateExperiment

Multivariate
Section Thiswidget allowsyou to drag and drop various

content widgets into it. These produce the variations
used during the experiment.

See Also: "Widgets used byMultivariate Testing" on
page 1

MultivariateSection.ascx

MultivariateSection.ascx.cs

MultivariateSection.ascx.jpg

and

Files in
widgets/MultivariateSection

Multivariate Target

When a page view occurs on a page containing this
widget, the conversion count is increased.

See Also: "Widgets used byMultivariate Testing" on
page 1

MultivariateTarget.ascx

MultivariateTarget.ascx.cs

MultivariateTarget.ascx.jpg
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Widget Description Files

News

Lets you select a news feed from a group of major
newsproviders.

News.ascx

News.ascx.cs

News.ascx.jpg

Recent blog posts

Displaysa selected number of themost recent blog
posts.

RecentBlogs.ascx

RecentBlogs.ascx.cs

RecentBlogs.ascx.jpg

RecentDocuments

Displaysa selected number of themost recently
published documents.

RecentDocuments.ascx

RecentDocuments.ascx.cs

RecentDocuments.jpg

Recent forum posts

Displaysa selected number of themost recent forum
posts.

RecentForumPosts.ascx

RecentForumPosts.ascx.cs

RecentForumPosts.ascx.jpg

Rotating Banner

Displaysa slide show from a collection of images. See
Also:Working with Collectionson page 9-102

RotatingBanner.ascx

RotatingBanner.ascx.cs

RotatingBanner.ascx.jpg

and

Files in widgets/RotatingBanner

RSSFeed

Allowsa user to enter the path of a feed that uses
ReallySimple Syndication (RSS).

RSSFeed.ascx

RSSFeed.ascx.cs

rssfeed.ascx.jpg

UsingWidgets
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Widget Description Files

SalesForce Chart

Allowsusers to enter username, password and
information about a SalesForce chart to display that
chart.

SalesForceChart.ascx

SalesForceChart.ascx.cs

SalesForceChart.ascx.jpg

and files in
widgets/SalesForceChart

StockTicker

Allowsusers to define a list of stock ticker symbols
and display the price for each symbol.

StockTicker.ascx

StockTicker.ascx.cs

StockTicker.ascx.jpg

StockTicker.css

Targeted Content
The Targeted Content widget lets you create a set of
conditions. As soon asany condition evaluates to
true, an appropriate widget appears.

See Also: Creating Conditionswith the Targeted
ContentWidget on page 6-38

TargetedContent.ascx

TargetedContent.ascx.cs

TargetedContent.ascx.jpg

and files in
widgets/TargetedContent

Taxonomy
Summary

Displays content assigned to that taxonomycategory.

TaxonomySummary.ascx

TaxonomySummary.ascx.cs

TaxonomySummary.ascx.jpg

and files in
widgets/TaxonomySummary

Text Box

Displaysa single field to capture text. The text is
stored in the database.

TextBox.ascx

TextBox.ascx.cs

TextBox.ascx.jpg

Trends Bydefault, the Trendswidget shows theMost
Viewed content on your Web site. You can edit the
widget's properties so that it displaysanyof the
following categories of content instead: Most
Emailed, Most Commented, or Highest Rated.

See Also: The TrendsWidget on page 7-764

Trends.ascx

Trends.ascx.cs

Trends.jpg

and

Files in widgets/Trends
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Widget Description Files

Twitter Feed

DisplaysRSS feed from Twitter. You can configure
one or more feeds.

TwitterFeed.ascx

TwitterFeed.ascx.cs

TwitterFeed.jpg

and

Files in widgets/TwitterFeed

Weather

Allows the user who is dropping the widget to enter a
Zip Code, then displays itsweather information.

Weather.ascx

Weather.ascx.cs

Weather.ascx.jpg

WebCalendar

Provides full calendar functionality including adding
events.

See Also:Calendarson page 7-527

WebCalendar.ascx

WebCalendar.ascx.cs

WebCalendar.jpg

Files in widgets\WebCalendar

YouTube

Select from a list of YouTube feeds.When the page
appears, videos in the category appear.

YouTube.ascx

YouTube.ascx.cs

YouTube.ascx.jpg

You Tube Video

Lets you embed code for anyYouTube video.

YouTubeVideo.ascx

YouTubeVideo.ascx.cs

YouTubeVideo.ascx.jpg

Files in widgets\YouTubeVideo

Zip Code

Allowsusers to find the information shown below
about a location byentering one of the following
items: Zip Code, Area Code, State, or City.

ZipCode.ascx

ZipCode.ascx.cs

ZipCode.ascx.jpg
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Removing a Widget from the Workarea
When you need to remove a widget from use, follow these steps:

1. Delete the widget’s files from the site root/widgets folder.

2. Navigate to Settings > Configuration > Personalizations >
Widgets and click Synchronize ( ).

The widget is removed from the list of widgets, and from the Dashboard of any
users and community groups.

Creating the “Hello World” Widget
To gain an understanding of how to create a widget, create a simple widget in the site
root/widgets folder. This widget is based on the Hello World widget that is installed with
the Developer Sample site with the following files:

HelloWorld.ascx - user control file

HelloWorld.ascx.cs - user control codebehind file

HelloWorld.ascx.jpg - image that represents this control on the
widget menu

This section also contains the following topics.

Step 1: Copy, Paste and Rename HelloWorld.ascx and Hel-
loWorld.ascx.jpg

6-
15

Step 2: Update the Class Names in the New Files 6-19
Step 3: Add Widget in Ektron CMS400.NET Workarea 6-20
Understanding the User Control (.ascx) File 6-22
Understanding the Codebehind (.ascx.cs) File 6-24

Step 1: Copy, Paste and Rename
HelloWorld.ascx and HelloWorld.ascx.jpg

1. Open your Web site in Visual Studio.

2. In the Visual Studio Solution Explorer, open the widgets folder.

Removing aWidget from theWorkarea
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3. Within that folder, scroll down to and select HelloWorld.ascx.
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4. Right click the mouse and choose Copy.

5. Scroll up to the widgets folder.

6. Right click the mouse and choose Paste.

Step 1: Copy, Paste and RenameHelloWorld.ascx
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7. Scroll down until you see Copy of HelloWorld.ascx.

8. Right click the mouse and choose Rename.

UsingWidgets
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9. Rename the file new_widget.ascx. Notice that Visual Studio also
renames the codebehind file to new_widget.ascx.cs.

10. The image file is 48 x 48 pixels and 72 dpi.

11. Copy, paste, then rename the helloworld.ascx.jpg file to new_widg-
et.ascx.jpg. Ektron CMS400.NET administrators (like Grace) and
content authors (like the Marketing team) use a widget’s image to
select it, as shown below.

Step 2: Update the Class Names in the New
Files

1. Open new_widget.ascx.

2. On the first line of that file, replace the reference to HelloWorld (cir-
cled below) with new_widget.

Step 2: Update the ClassNames in the New Files
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3. Open the codebehind file, new_widget.ascx.cs.

4. Again, replace the class HelloWorld with new_widget.

5. Save new_widget.ascx and new_widget.ascx.cs.

6. Check both files for errors by choosing Build > Build Page. Correct
any errors before proceeding.

Step 3: Add Widget in Ektron CMS400.NET
Workarea

1. Open the Ektron CMS400.NET Workarea.

2. Choose Settings > Configuration > Personalizations > Widg-
ets.

3. Click Synchronize ( ).
4. You see the new user control file, new_widget.ascx, at the bottom of

the screen.
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5. Choose Settings > Configuration > Template Configuration.

6. Find the template that you created in Building Pages on page 5-5,
PageLayout.aspx. Or, any Wireframe template that you are using to
create a PageBuilder page.

7. Click Update.

8. On the Update Template screen, scroll down until you see the new
widget.

Step 3: AddWidget in Ektron CMS400.NET
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9. Click Select All (circled in the figure).

10. Click Save ( ).
11. For directions on creating a PageBuilder page, see Steps to Creating a

“PageBuilder” Page on page 5-7

12. Go to Content and select a folder that has a PageBuilder page.

13. Edit the PageBuilder page.

14. Open the Widget menu.

15. Make sure your new widget appears on the menu.

After you create a new widget and enable it in the Ektron CMS400.NET
Workarea, you can begin to customize it. For more information about
customizing widgets, see Customizing Widgets on page 6-28.

Understanding the User Control (.ascx) File
Here is the new_widget.ascx file that Pete uses as the basis of his widget.
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<%@ Control Language=”C#” AutoEventWireup=”true” CodeFile=”new_widg-
et.ascx.cs” Inherits=”widgets_new_widget” %>
<%@ Register Assembly="System.Web.Extensions, Version=1.0.61025.0, Cul-
ture=neutral, PublicKeyToken=31bf3856ad364e35"

Namespace="System.Web.UI" TagPrefix="asp" %>
<asp:MultiView ID="ViewSet" runat="server" ActiveViewIndex="0">

<asp:View ID="View" runat="server">
<!-- You Need To Do .............................. -->

<asp:Label ID="TextLabel" runat="server"></asp:Label><br />
<asp:Label ID="CheckBoxLabel" runat="server"></asp:Label>

<!-- End To Do .............................. -->
</asp:View>
<asp:View ID="Edit" runat="server">

<div id="<%=ClientID%>_edit">
<!-- You Need To Do .............................. -->

<asp:TextBox ID="TextTextBox" runat="server" Style="width: 95%"> </asp:Te-
xtBox><br />
<asp:CheckBox ID="MyCheckBox" runat="server" Checked="false" /> <br />

<!-- End You Need To Do .............................. -->
<asp:Button ID="CancelButton" runat="server" Text="Cancel" OnClick="C-
ancelButton_Click" />
<asp:Button ID="SaveButton" runat="server" Text="Save" OnClick="SaveButton_
Click" />

</div>
</asp:View>

</asp:MultiView>

Notice the following elements of the file.

n The asp:MultiView element declares that the control has two
possible modes: View and Edit.

<asp:MultiView ID="ViewSet" runat="server" ActiveViewIndex="0">

in view mode, Pierre and the marketing team can see the control but
not change it.

in editmode, Pete’s developers can change the control’s content and
properties.

n Between the multiview tags is information about the control in view
mode. It has two fields: one is a text field, and the other is a check
box.

<asp:View ID="View" runat="server">
<asp:Label ID="HelloTextLabel" runat="server"></asp:Label><br />
<asp:Label ID="CheckBoxLabel" runat="server"></asp:Label>
</asp:View>

n Also between the multiview tags is information about the control in
edit mode. In edit mode, a text box, a check box, and a Save button

Understanding the User Control (.ascx) File
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appear. The text box and check box collect end-user input, and the
Save button saves that input to the database.

<asp:View ID="Edit" runat="server">
<div id="<%=ClientID%>_edit">
<!-- You Need To Do .............................. -->
<asp:TextBox ID="HelloTextBox" runat="server" Style="width: 95%"> </asp:Te-
xtBox><br />
<asp:CheckBox ID="MyCheckBox" runat="server" Checked="false" /> <br />
<!-- End You Need To Do .............................. -->
<asp:Button ID="CancelButton" runat="server" Text="Cancel" OnClick="C-
ancelButton_Click" />
<asp:Button ID="SaveButton" runat="server" Text="Save" OnClick="SaveButton_
Click" />

Understanding the Codebehind (.ascx.cs)
File
Review the codebehind file, new_widget.ascx.cs.

n A series of using statements are at the top of the file. Notice the
Ektron ones in particular:

using Ektron.Cms.Widget;
using Ektron.Cms;Marketing team
using Ektron.Cms.API;
using Ektron.Cms.Common;
using Ektron.Cms.PageBuilder;
using System.Text.RegularExpressions;

n Next, note a widget host class, which inherits the
system.Web.UI.UserControl and IWidget classes.

public partial class widgets_new_widget : System.Web.UI.UserControl, IWidget

The following figure summarizes the remaining elements of the codebehind file.
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n In the next line, notice the widget’s properties: a string for the text
field, and a boolean for the check box. You define the variables and
their type here. Possible types are string, integer, long and date.

#region properties
private string _HelloString;
private bool _CheckBoxBool;
[WidgetDataMember(true)]
public bool CheckBoxBool { get { return _CheckBoxBool; } set { _CheckBoxBool
= value; } }
[WidgetDataMember("Hello Wolrd")]
public string HelloString { get { return _HelloString; } set { _HelloString =
value; } }
#endregion

n The following is a widget host declaration.

private IWidgetHost _host;

n The following is the widget’s page_init events.

Understanding the Codebehind (.ascx.cs) File
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protected void Page_Init(object sender, EventArgs e)
{

_host = Ektron.Cms.Widget.WidgetHost.GetHost(this);
_host.Title = "Hello World Widget";
_host.Edit += new EditDelegate(EditEvent);
_host.Maximize += new MaximizeDelegate(delegate() { Visible = true; });
_host.Minimize += new MinimizeDelegate(delegate() { Visible = false; });
_host.Create += new CreateDelegate(delegate() { EditEvent(""); });
PreRender += new EventHandler(delegate(object PreRenderSender, EventArgs
Evt) { SetOutput(); });
ViewSet.SetActiveView(View);

}

Comments on the above code

The gethost method returns a reference to the container widgethost
for this widget. This is the case in both Personalization and Page-
Builder.

The Title property is the title of this widget. By setting it in page_
init for the widget, we inform the host what text to put in the title bar
above the widget. This works in both PageBuilder and Personalization.

The events below host.Title are raised by the widgethost. It’s up to
the widget to subscribe to them. In all cases, if we don’t subscribe to
them, the icons don’t show up. This is a method of attaching widget
code to button clicks and other events that occur outside the widget.

For PreRender: Ektron CMS400.NET renders the contents of this
widget on pre-render, thus ensuring a single render event. Another
option is to call SetOutput on the Load event, but you can only do that
if the widget is not in edit mode currently.

The final line sets the view to display mode.

The following is the declaration of the widget’s edit events.

void EditEvent(string settings)
{

string sitepath = new CommonApi().SitePath;
ScriptManager.RegisterClientScriptInclude(this, this.GetType(), "widg-
etjavascript", sitepath + "widgets/widgets.js");
ScriptManager.RegisterOnSubmitStatement(this.Page, this.GetType(), "gadg-
etescapehtml", "GadgetEscapeHTML('" + HelloTextBox.ClientID + "');");
HelloTextBox.Text = HelloString;
MyCheckBox.Checked = CheckBoxBool;
ViewSet.SetActiveView(Edit);
}

Comments on the above code

Warning! You must register JavaScript and cascading style sheet (css) instructions in an external
file. SeeWorking with JavaScript and Cascading Style Sheets on page 6-28
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The Edit event is triggered by the widgethost, and since Pete sub-
scribed to it already, it calls the delegate here.

sitepath is used to ensure that the correct path for included files is
used across installations.

By calling the scriptmanager to include the script, Pete ensures it
works inside update panels. Alternatively, he can use
Ektron.Cms.Api.Js.RegisterJSInclude Script-
Manager.RegisterOnSubmitStatement(this.Page, this.Ge-
tType(), "gadgetescapehtml", "GadgetEscapeHTML('" +
HelloTextBox.ClientID + "');");

The onsubmitstatement is JavaScript that is run when the widget is
submitted. It calls escape html, which cleans the submitted text to
avoid any XSS.

Pete notices the editing fields, so users can see the existing data.

HelloTextBox.Text = HelloString;

MyCheckBox.Checked = CheckBoxBool;

ViewSet.SetActiveView(Edit);

The following is the widget’s save events.

protected void SaveButton_Click(object sender, EventArgs e)
{

HelloString = ReplaceEncodeBrackets(HelloTextBox.Text);
CheckBoxBool = MyCheckBox.Checked;
_host.SaveWidgetDataMembers();
ViewSet.SetActiveView(View);

}

n The following is the widget’s SetOutput events.

protected void SetOutput()
{

HelloTextLabel.Text = HelloString; // client javascript remove brack-
ets, server side adds back

CheckBoxLabel.Text = CheckBoxBool.ToString();
}

n The following is the widget’s Cancel events.

protected void CancelButton_Click(object sender, EventArgs e)
{

ViewSet.SetActiveView(View);
}

n The following is the encoding of the greater and less than signs.

Understanding the Codebehind (.ascx.cs) File

ReferenceManual
Version 8.01 Rev 4

6-27



protected string ReplaceEncodeBrackets(string encodetext)
{

encodetext = Regex.Replace(encodetext, "&lt;", "<");
encodetext = Regex.Replace(encodetext, "&gt;", ">");
return encodetext;

}

Customizing Widgets
The following topics let you further customize widget behavior.

Working with JavaScript and Cascading Style Sheets below

Verifying that a Page is a PageBuilder Page on the facing page

Applying Global and Local Properties to Widgets on the facing page

Adding a Field to a Widget on page 6-33

Including Help for a Widget on page 6-35

Opening a Widget’s Edit Properties Screen in a Modal Dialog on page
6-36

Working with JavaScript and Cascading Style
Sheets
You can use JavaScript or a cascading style sheet to add custom functionality or
styling to a widget. To do this, place the JavaScript or cascading style sheet
(css) instructions in an external file, then register it in the codebehind file.

Here is an example of including a JavaScript file.

void EditEvent(string settings)
JS.RegisterJSInclude(this, _api.SitePath + "widg-
ets/contentblock/jquery.cluetip.js", "EktronJqueryCluetipJS");

Here is an example of including a .css file.

Css.RegisterCss(this, _api.SitePath + "widg-
ets/contentblock/CBStyle.css","CBWidgetCSS");

You must register JavaScript and .css files in an external file, as shown above.
If you do not, the OnSubmit event places HTML in the TextArea field in encoded
brackets (< >) and generates a dangerous script error.

The JS.RegisterJSInclude and Css.RegisterCss functions take three
arguments.
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Argument Description Example (from above code)

1
A reference to the control that needs the
script or style sheet on the page. Typically,
‘this’ or ‘me’.

this

2

The URL of the script or style sheet being
included.

Ektron recommendsprefixing the URLwith a
site path, so it can be used with URLs like
http://localhost/ektrontechand
http://ektrontech.

n _api.SitePath +
"widgets/contentblock/jquery.cluetip.js"

n _api.SitePath +
"widgets/contentblock/CBStyle.css"

3

A unique key.

Only include the script specified bya key
once.

Your organization should develop a standard
way to define JavaScript and .css keys.

n "EktronJqueryCluetipJS"

n “CBWidgetCSS”

Widgets use an update panel for partial postbacks. As a result, the ASP.NET
tree view and file upload controls do not work with widgets. Ektron
CMS400.NET has workarounds for these functions. For an example of a tree
view, see the content block widget (site root/widgets/contentblock.ascx). For
an Ajax file uploader, see the flash widget (site root/widgets/flash.ascx).

Verifying that a Page is a PageBuilder Page
Whenever your code is interacting with a widget, you need to verify that it is on
a page builder page (as opposed to another Ektron CMS400.NET page that hosts
widgets, such as personalization).

To check for this, insert the following code:

Ektron.Cms.PageBuilder.PageBuilder p = (Page as PageBuilder);
If(p==null) // then this is not a wireframe
When you want to check the mode, use code like this.
If(p.status == Mode.Edit) // we are in edit mode

Applying Global and Local Properties to
Widgets
Global and local widget properties reduce your development effort by
eliminating settings data classes. While you can still use these classes and
manage your own serialization, for the vast majority of types, the built-in
engine performs all the work necessary.

Verifying that a Page is a PageBuilder Page
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Global properties apply to every instance of a widget. Local properties can
apply to one instance of a widget. If both local and global values are assigned to
a property, the local overrides the global.

As an example of using a local property to override a global, consider a
ListSummary widget. You may want its sort to mostly be by modified date in
descending order, but in certain instances you want to override that and sort by
title in ascending order.

The following table explains how to set the different property types.

Type Setting default value in codebehind file How to change default

Global

[GlobalWidgetData()]

public string NewWidgetTextData {

get {return _NewWidgetTextData;}

set {_NewWidgetTextData = value;

}}

Workarea >Settings>Configuration >
Personalizations>Widgets

Local

[WidgetDataMember()]

public string NewWidgetTextData {

get { return _NewWidgetTextData; }

set { _NewWidgetTextData = value;

} }

User dropswidget onto PageBuilder
page, then clicks edit button.

See Also: Setting a Widget’s Global Properties below; Setting a Widget’s Local
Properties on page 6-32

Setting a Widget’s Global Properties
A global property lets an Ektron CMS400.NET developer or administrator assign
properties and values that apply to all instances of a widget. You apply a global
property to the widget’s codebehind page. Administrators could then set or
update the property’s value in the Workarea’s Widgets screen.

For example, the BrightCove Video widget requires a player ID. You could insert
that in the widget’s codebehind file. Then, an administrator could review and
possibly update that information in the Workarea widgets screen. Whenever a
user drops a BrightCove Video widget onto a page, the player ID is already
assigned.

If the developer does not set a default value in the codebehind, an
administrator must set one on the Workarea’s Widgets screen.

If the developer does set a default value in the codebehind, it will be applied
unless changed by an administrator on the Workarea’s Widgets screen.

Steps for Setting a Global Property
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Follow these steps to set a global property.

1. Open the widget’s codebehind file, which is located in the site
root/widgets folder.

2. In the properties section, insert the GlobalWidgetData attribute
(shown below) to set the global property’s name and type.

[GlobalWidgetData()]
public string NewWidgetTextData { get { return _NewWidgetTextData; } set { _
NewWidgetTextData = value; } }

Here is an example.

The supported types for GlobalWidgetData are

Date Time

int

long

double

boolean

string

any enumeration

1. Save the codebehind file.

2. In the Ektron CMS400.NET Workarea, go to Settings > Con-
figuration > Widgets.

3. Click the edit icon ( ) for the widget whose codebehind file you
edited in Step 1.
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4. A dialog lets you view and edit global properties set in the codebehind
file. See example below.

Setting a Widget’s Local Properties
A local property lets an Ektron CMS400.NET user assign property values that
apply to a particular instance of a widget. For example, the BrightCove Video
widget requires a Video ID, which identifies the video that appears where you
drop the widget.

To set a local property, follow these steps.

1. Open the widget’s codebehind file, which is located in the site
root/widgets folder.

2. In the properties section, insert the WidgetDataMember attribute to
set the property. See example below.
[WidgetDataMember(150530105432)]1

public long VideoID { get { return _VideoID; } set { _VideoID =
value; } }
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3. If you want to set a default value for the widget, use the attribute’s
optional argument, which follows [WidgetDataMember. In the exam-
ple above, the value is 150530105432.

4. Save the settings in your properties by populating them as you nor-
mally would.

5. In the Save event, call _host.SaveWidgetDataMembers();. See
example below.

Adding a Field to a Widget
This section provides an example of adding a Content type drop down to the List
Summary widget. The drop down lets the person dropping the widget on the
page select from these choices.

all types of content

HTML content only

assets only

Here is what the drop down looks like once it is implemented.

To add this drop down to the List Summary widget, follow these steps.

Adding a Field to aWidget
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1. In Visual Studio, open the ListSummary widget, site root/wid-
gets/ListSummary.ascx.

2. Find the text DisplaySelectedContent.

3. Below DisplaySelectedContent, add the following code to create a
drop down list for the ContentType property.

<tr>
<td>
DisplaySelectedContent:</td>
<td>
<asp:CheckBox ID="DisplaySelectedContentCheckBox" runat="server" />
</td>
</tr>
<tr>
<td>
ContentType:
</td>
<td>
<asp:DropDownList ID="ContentTypeList" runat="server">
<asp:ListItem Value="AllTypes">AllTypes</asp:ListItem>
<asp:ListItem Value="Content">Content</asp:ListItem>
<asp:ListItem Value="Assets">Assets</asp:ListItem>
</asp:DropDownList>
</td>
</tr>

4. Save the ListSummary.ascx file.

5. Open the codebehind file, ListSummary.ascx.cs.

6. In the properties region, declare a string variable for the Con-
tentType property, as shown below.
private string _ContentType;

7. Create a local property with default setting of AllTypes, as shown
below.
[WidgetDataMember("AllTypes")]

public string ContentType { get { return _ContentType; } set { _
ContentType = value; } }

8. In the EditEvent area, set the select list's value to ContentType.
ContentTypeList.SelectedValue = ContentType;

9. In the SaveButton_Click event, set ContentType as the select list's
value.
ContentType = ContentTypeList.SelectedValue;

10. In the SetListSummary() function, set the List Summary server con-
trol's ContentType to the CMSContentType property.
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ListSummary1.ContentType =
(CMSContentType)Enum.Parse(typeof(CMSContentType),
ContentType);

11. Save the ListSummary.ascx.cs file.

Including Help for a Widget
You can include help for any widget that has the help icon ( ).

The help icon only appears when a user is editing a PageBuilder page. The icon
appears both when a user is viewing a widget and editing its properties.

It is not available to a page’s site visitors.

Defining a Widget’s Help File
To create a widget’s help file, follow these steps.

1. Create an HTML file with information for users who will drop the
widget on the PageBuilder page.
You could create a content block within Ektron CMS400.NET then
switch to source view, copy the content into a word processor (like
Notepad), and save it with an HTML extension.

2. Save the help file to the folder that contains the widget.

3. Add the WidgetHost’s HelpFile property to the codebehind of the
page that hosts the widget. See example below.

protected void Page_Init(object sender, EventArgs e)
{
_host = Ektron.Cms.Widget.WidgetHost.GetHost(this);
_host.HelpFile = "~/widgets/myWidget/help.html";

Including Help for aWidget
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Opening a Widget’s Edit Properties Screen in
a Modal Dialog
If your PageBuilder page has several columns, some property screens do not
have adequate space for data entry.

If desired, you can display a widget’s properties screen in a modal dialog, which
is much wider and provides room for data entry.
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To do this, use the ExpandOptions property in the widget’s codebehind file. Its
type is Ektron.Cms.Widget.Expandable, and it is an enumeration with three
possible values.

To have the edit button Use this option

Open amodal dialog, where the user can edit
properties

Within the widget’spage_init event, set

_host.ExpandOptions =
Expandable.ExpandOnEdit;

Provide a button that a user can click to open amodal
dialog

1. Within the widget’spage_init event, set

_host.ExpandOptions =
Expandable.DontExpand;

2. In your Edit Event callback, update the
property to

_host.ExpandOptions =
Expandable.ExpandOnExpand;

SeeOption to DisplayPropertiesScreen as
ModalDialog below.

Show edit options in a regular window

Note: This is the default setting. You can do nothing
to achieve this result.

Within the widget’spage_init event, set

_host.ExpandOptions =
Expandable.DontExpand;

Option to Display Properties Screen as Modal
Dialog

Option to Display Properties Screen asModal
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Creating Conditions with the Targeted
Content Widget
The Targeted Content widget lets you personalize your site visitors' experience
by providing content that matches their interests, thereby placing your site
information in the context of your users. For example, the search keywords
used to find your site might determine the best offer to show a prospect. Or,
site members might explicitly state their interests by adding to their user
profile or filling out a survey.

In both cases, the Targeted Content widget ensures the delivery of the right
experience to compel each site visitor to take action. The widget lets you gather
information from each interaction, and use that information to direct visitors to
content that relates to their specific interests.

Targeting content is as easy as building an email rule in Microsoft Outlook, or a
playlist in Itunes. No custom development or IT resources are required.

To achieve these goals, the Targeted Content widget lets you create a set of
conditions. Along with the conditions, you define widgets to provide content for
users who satisfy the conditions, as shown below. As soon as any condition
evaluates to true, an appropriate widget appears as shown.

The Targeted Content widget can evaluate the following information about a
page's site visitor.
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search engine that directed him to the page

the page's URL parameters

the page from which he was directed

whether a certain cookie is on his computer

if logged in
user or membership group to which he belongs

any of his custom user properties that match your criteria

the current date and time on the Ektron CMS400.NET server

This section further explains the Targeted Content widget through the following
topics.

Example Uses of the Targeted Content Widget below

Creating Conditions for the Targeted Content Widget on next page

Creating a Targeted Content Widget on page 6-42

Using Multiple Criteria in a Condition on page 6-47

Editing a Condition on page 6-48

Customizing the Targeted Content Widget on page 6-50

Using Facebook Connect Extension with the Targeted Content Widget
on page 6-50

Using Targeted Content Configurations

Example Uses of the Targeted Content
Widget
The following table shows examples of how you might use the Targeted Content
widget.

Your Situation Strategy
If condition = true,
Targeted Content
widget displays

**Your jewelry store is promoting
gold necklaces

You create a hyperlinkwith a Campaign ID of
gold. For example
http://www.mystore.com/product.aspx?
cid=gold.

In the Targeted Content widget, you set the
conditionURL Parameter CID contains
gold.

AContentBlockwidget that
promotesGold necklaces

Example Uses of the Targeted ContentWidget
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Your Situation Strategy
If condition = true,
Targeted Content
widget displays

You're promoting a race to
NASCAR fans

Your site hasamembership group for
NASCAR fans, and anyone visiting the site can
join.

In the Targeted Content widget, you create a
condition If user is in Group NASCAR.

AWebCalendar widget that
lists upcoming NASCAR
races

On SundayFeb. 28, you are
running a sale: all couchesare
50%off

In the Targeted Content widget, you set the
Date is 2010-02-28.

A TaxonomySummary
widget that lists all couches
and the discounted price

Display the "Engineering"
CommunityGroup's activity
stream to itsmembers

You have a CommunityGroup for the
Engineering Department.

In the Targeted Content widget,setUser is In
GroupEngineering.

An ActivityStreamwidget
set up as follows:

n ObjectID= ID of the
Engineering group

n FeedType=
Community Group

If the referring page is a Search
Engine, and its keywords include
Pizza you want to show a list
summaryPizza shops.

Assumesyour content includes restaurant
listings, and taxonomycategories are applied
to this content. One category is pizza.

In the Targeted Content widget,setSearch
Engine Keywords is Pizza.

A TaxonomySummary
widget that lists all content
assigned to the category
Restaurants> Pizza

Creating Conditions for the Targeted
Content Widget
The Targeted Content widget lets you personalize your site visitors' experience
by providing content that matches their interests, thereby placing your site
information in the context of your users. For example, the search keywords
used to find your site might determine the best offer to show a prospect. Or,
site members might explicitly state their interests by adding to their user
profile or filling out a survey.

In both cases, the Targeted Content widget ensures the delivery of the right
experience to compel each site visitor to take action. The widget lets you gather
information from each interaction, and use that information to direct visitors to
content that relates to their specific interests.

Targeting content is as easy as building an email rule in Microsoft Outlook, or a
playlist in Itunes. No custom development or IT resources are required.

To achieve these goals, the Targeted Content widget lets you create a set of
conditions. Along with the conditions, you define widgets to provide content for
users who satisfy the conditions.
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Each widget consists of one or more conditions. Each condition can have one or
more criteria. For example, a condition may stipulate that the URL parameter
terms contains either "pizza" or "Italian."

After assigning conditions to a Targeted Content widget, you assign one or
more widgets to it. The widgets appear on the page only if a condition evaluates
to true.

To continue the example, if the page has a URL parameter that contains "pizza,"
display a Taxonomy Summary widget showing content to which the Taxonomy
category "pizza" is assigned.

Creating Conditions for the Targeted Content
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You can assign any number of conditions to the Targeted Content widget. As
soon as one is true, its associated widgets appear, and any remaining
conditions are ignored.

Creating a Targeted Content Widget
To create a Targeted Content widget, follow these steps.

Prerequisite:  The Targeted Content widget must be on the list of widgets
assigned to the page's template. See Also: Adding the Wireframe and Widgets
into the CMS on page 5-13

1. Drag and drop the Targeted Content widget onto a PageBuilder page.

2. By default, Condition 1 is added to the widget. Click Edit Condition.

3. Give the condition a name.

4. Click the +or button to set up the first condition.

5. A dropdown list of condition criteria appears.

The following table describes the criteria options.
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Criterion Use this criterion to specify widgets that will appear if

Search
Engine

n If the site visitor was referred to this page from anysearch engine (or not)

Or

n If the search engine fromwhich the site visitor was referred is one of the following

- Google

- Bing

- Yahoo

- Other

- None

Or

n If the search engine's keywordsare (are not, contain, start with, or end with) a specified
value

Referring
URL

The referring host matchesa string value (for example, www.example.com).

This is helpful for determining the site fromwhich a visitor came to your site, such asa
Facebook fan page.

URL
 parameter

The current page contains the specified URL parameter.

For example, you create a campaign selling gold jewelry and base its content on the URL
 parameter cid=gold.

If the URL of the page that hosts the Targeted Content widget containscid=gold (for
example, http://www.mystore.com/product.aspx?cid=gold), then displaywidgets
assigned to that Targeted Content widget.

Cookie

A cookiematching the specified pattern is found on the site visitor's computer.

Cookiesare generally stored asname value pairs, such asUserID - A9A3BECE0563982D.
When checking for a cookie, you complete three fields.

n cookie ID

n logic (is, is not, contains, startswith, endswith)

n a value

For example, if a certain campaign placed cookiesbeginning with A9A, you would set up the
criterion like this:

Note:  The cookie criterion doesnot support subkeys, such asecm.useridor
ecm.sitepath.
To work around this problem, use a contains operator and enter the text following
.ecm, such assitepath.

Creating a Targeted ContentWidget
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Criterion Use this criterion to specify widgets that will appear if

User is in
group

Note:  Only applies to logged-in users.

User is amember of a Ektron CMS400.NET User or Membership Group that you select from
dropdown list. See Also:Membership User Groupson page 16-11,Managing User Groups
on page 15-27

User is in
community

Note:  Only applies to logged-in users.

User is amember of an Ektron CMS400.NET CommunityGroup that you select from
dropdown list. See Also:CommunityGroupson page 16-83

User
Properties

Note:  Only applies to logged-in users.

The value of the logged-in user's custom property satisfies the logic for the value you specify.
See Also:CustomUser Propertieson page 15-12

Example:

Zip code is a CustomUser Property. You want to display a list of stores in New Hampshire for
userswhose Zip Code beginswith 03.

Condition / result

Zip code =03458 true

Zip code =02103 false

Date and
Time: Day

The actual date (according to the web server's clock) and a date you enter satisfy the
specified logic.

Logic operators:

n is

n is not

n less than

n greater than

n equal to or less than

n equal to or greater than

Examples:

Assume today's date is 2010-01-01

Condition / result

Date = 2010-01-01 true

Date < 2010-01-01 false

Date >=2009-12-01 true
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Criterion Use this criterion to specify widgets that will appear if

Date and
Time: Dayof
Week

The current day (according to the web server's clock) satisfies the specified logic.

Logic operators:

n is

n is not

Examples:

Assume today's date is 2010-03-01 (Monday)

Condition / result

Dayof week isMonday true

Dayof week isTuesday false

Dayof week is not Tuesday true

Date and
Time: Dayof
Month

The actual date (according to the web server's clock) and a date you enter satisfy the
specified logic.

Logic operators:

n is

n is not

n less than

n greater than

n equal to or less than

n equal to or greater than

Examples:

Assume today's date is 2010-03-01 (Monday)

Condition / result

Dayof month is 01 true

Dayof month is not 01 false

Date >=2009-12-01 true

Creating a Targeted ContentWidget
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Criterion Use this criterion to specify widgets that will appear if

Date and
Time: Hour
of Day

The actual hour (according to the web server's clock) and number between 1 and 23 you
enter satisfy the specified logic. The numbersare based on a 24 hour clock so, for example, 5
p.m. is 17.

Logic operators:

n is

n is not

n less than

n greater than

n equal to or less than

n equal to or greater than

Examples:

Assume current time is 18:30:00

Condition / result

Hour of day is 18 true

Hour of day is 23 false

Hour of day>=12 true

Otherwise

No condition evaluates to true

Note:  You would typically place a condition using this criterion last, since it always
evaluates to true. Any conditionsbelow this are ignored.

6. Add additional criteria as desired. See Also: Creating a Targeted Con-
tent Widget on page 6-42

7. Click the Save button.

8. Drag to the area below the new condition one or more widgets that
appear if the condition evaluates to true.

9. If the widget requires you to fill out properties, click the edit button ( )
and complete the screen. See example below.

Show me.
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See Also:Widget Reference on page 6-5

Using Multiple Criteria in a Condition
Any condition can have several criteria joined by and an AND operator.

In this example, all conditions must be true in order for the widgets assigned to
this Target Content widget to appear.

the user is logged in

his profile has a custom user property, Zip Code, and its value
begins with 03

today's date must be later that March 1, 2010

the user is a member of the Ektron CMS400.NET user group Gold
Level Authors

If any of these condition is not true, the next condition assigned to the widget is
evaluated, if one exists.

If all conditions are true, the widgets assigned to this Targeted Content widget
appear. Additional conditions assigned to this widget are ignored.

Using an OR Operator
You can also specify an OR relationship among criteria in one condition. To do
so, click the +or button below any condition (circled below), then enter the OR
 condition.

UsingMultiple Criteria in a Condition
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For example, assume you want the zip code criteria to include codes that begin
with 01 or 02 or 03. You would set up those conditions as follows.

Each set of criteria is evaluated independently.

If any criteria set is true (that is, all of its statements are true), the widgets
assigned to this Targeted Content widget appear. Additional conditions assigned
to this widget are not evaluated.

If none of the criteria sets is true, the next condition assigned to the widget is
evaluated, if one exists.

Editing a Condition
There are two aspects to editing a condition within a Targeted Content widget.
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Editing a Condition's Criteria below

Editing Widgets Assigned to the Condition below

Editing a Condition's Criteria
To edit the criteria assigned to a condition, follow these steps.

Note: This assumes you are on the PageBuilder page that contains the widget and in Edit
mode.

1. Click the condition you want to edit.

2. The area below it expands. Any widgets assigned to the condition
appear.

3. Click the Edit Condition button.

4. Edit the condition then click the Save button.

See also Using Multiple Criteria in a Condition on page 6-47 and Creating a
Targeted Content Widget on page 6-42

Editing Widgets Assigned to the Condition
To edit properties for, add, or remove a widget assigned to a condition, follow
these steps.

Note: This assumes you are on the PageBuilder page that contains the widget and in Edit
mode.

1. Click on the condition that has the widget you want to edit.

2. The area below it expands. Any widgets assigned to the condition
appear.

Editing a Condition's Criteria
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3. If you want to delete the widget, click the X in its upper right corner
(circled above).

4. To edit the widget's properties, click the pencil icon in the upper right
corner (circled above). Click the Save button. See Also:Widget Ref-
erence on page 6-5

Customizing the Targeted Content Widget
To create a custom version of the Targeted Content widget (for example, to add
rule templates), follow these steps.

1. Open the site root/widgets/Edit TargetedContent.ascx.cs file.

2. Create a class, for example, MyRuleTemplate, that inherits
Ektron.RuleEditor.RuleTemplate in #region Rule Templates.

3. Modify private void AddAllRuleTemplates.

4. Add an instance of your class to the rest of the rule templates. For
example, AddRuleTemplate(new MyRuleTemplate());

Using Facebook Connect Extension with the
Targeted Content Widget
Use the Facebook Login feature to gain access to a visitor's profile information
that you use in your Targeted Content widget rules. For more information about
Facebook Login, see Facebook Login on page 2-14.

You can add conditions to the targeted content widget once the visitor has
logged into the site using their Facebook profile. Conditions can be based on any
of the following characteristics.
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Age

Gender

Marital Status

Likes

Employment

Here is some examples of how to use Facebook profile information with the
Targeted Content Widget.

Your
Situation

Strategy
If condition = true,
Targeted Content
widget displays

Facebook:
gender

You create a hyperlinkwith product sales for men's shoes.
For example
http://www.mystore.com/product.aspx?cid=male.

In the Targeted Content widget, you set the conditionURL
 Parameter CID contains male.

AContentBlockwidget that
promotes shooes fomen.

Facebook:
likes

You create content for visitors interested in Sony
televisions.

For example: http://www.mystore.com/tv.aspx?cid=sony.

In the Targeted Content widget, you set the conditionURL
 Parameter CID contains sony.

Displaysa ContentBlock
widget containg SonyTV pro-
motions.

For example code to do this, see the Knowledge Base article entitled
"INFO:Targeted Content Widget: Facebook Connect Extension" located at
http://dev.ektron.com/kb_article.aspx?id=32156.

To learn more about Facebook Login, see Facebook Login on page 2-14.

Using FacebookConnect Extension with the
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Working with the Flash Widget

This widget supports both .flv and .swf file types.

If you will use .flv files, make sure it is added as a file type. See Also:
Supported Types of Assets on page 7-400

If the Flash file you want to display has already been added to Ektron
CMS400.NET, use the Select File tab to it.

If the file has not been added to Ektron CMS400.NET, first use the
Select File tab to select a folder for the Flash file. Then, use the
Upload tab to navigate your computer’s file system, and upload the
file to the selected folder.

The thumbnail feature only works with .flv file types. If you select a
Thumbnail, it appears within the Flash player when the page loads.
See example below.

The thumbnail is only applied to this instance of the widget - not the
Flash file. If you apply this video to a different widget on this page,
you must reapply a thumbnail.

The thumbnail is an image file that was dropped into Ektron
CMS400.NET as an asset. It cannot be a library image.
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The autostart feature only works with .flv files.

If you log in then upload a flash file, and certain requirements are not
met for that file, you see the following image where the widget
appears.

The following conditions cause this image to appear.

The flash file’s folder properties require certain metadata and/or a
taxonomy category to be applied, and they have not.

The folder has an approval chain, and this content has not been
approved.

Working with the FlashWidget
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Chapter 7

Managing Content in Ektron
CMS400.NET
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Most of your time in Ektron CMS400.NETis spent creating, editing, and
performing other activities with content. Content encompasses all of the
articles, news, forms, blogs, discussion forums and even calendars that appear
on your Web site. Authors can conveniently update content directly from the
Web site (after logging in). To access the full functionality, however, users
complete tasks within the Ektron CMS400.NET Workarea.

For an introduction to Ektron CMS400.NET content concepts, see

n What is a Content Block? on page 2-2

n Workflow in Ektron CMS400.NET on page 2-5

n The Lifecycle of Content on page 2-6

This chapter explains everything you can do to manage Ektron
CMS400.NETcontent through these top-level topics.

This section also contains the following topics.

Working with Content From Workarea vs. Web Site 7-3
The Web Site Content Menu 7-4
Viewing Content 7-9
Adding HTML Content 7-15
Editing HTML Content 7-20
Ektron CMS400.NET Editors 7-26
Translating Content to Another Language 7-108
Moving or Copying Content 7-110
Viewing and Restoring Previous Content 7-115
Deleting Content 7-127
Content Statuses 7-130
Content Properties 7-137
Displaying Content on your Web Site 7-194
Working with HTML Forms 7-212
Working with Smart Forms 7-278
Using the Document Management System 7-399
Blogs 7-472
Calendars 7-527
Discussion Boards 7-576
Map Server Control 7-654
Validating XHTML Content and Accessibility 7-676
Content Reports 7-698
Content Reviews and Content Ratings 7-724
Analytics 7-747
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Working with Content From
Workarea vs. Web Site
You can perform many actions from either the Ektron CMS400.NET Workarea or
your Web site. In both cases, you must sign in before you can work with
content.

Ektron CMS400.NETprovides three types of dropdown menus that let you edit
content. The first menu is available within the Workarea. The second and third
menus are available after you log into your Web site.

n Workarea Content Menu - available within the Ektron CMS400.NET
Workarea; lets you edit content from the View Contents of Folder
screen. See Also:Workarea Content Menu on page 4-9

Note: The Web site menus do not appear if you are in site preview mode. See Also: Site
Preview on page 2-9.

n Web Site Server Control Menu - available after signing into an Ektron
CMS400.NET Web site. Lets you edit content from most server
controls on a Web page. The options depend on the control and user’s
folder permissions. To display this menu, click the triangle to right of
content (see below).

n Web Site Content Menu - available after signing into an Ektron
CMS400.NET Web site. See Also: The Web Site Content Menu on next
page

Working with Content FromWorkarea vs.Web Site
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The Web Site Content Menu
After you sign in to your Web site, just above content you have permission to
edit is a silver access point (see illustration below). When you hover the cursor
over it, a menu appears.

You can perform Ektron CMS400.NET tasks from the menu. Menu options vary
depending on the content’s status, your permissions, etc. The advantage of this
feature is that you can see how a Web page will appear to site visitors.

This section also contains the following topics.

Web Site Content Menu Options 7-4
Changing the Appearance of the Web Site Content Menu 7-6
Hiding and Showing the Content Border 7-6
Hiding the Border 7-7
Showing the Border 7-8

Web Site Content Menu Options
The following table describes the menu options that may appear.

Button Name Description
More
Information

Add
Appears if you selected a language and the content is not
available in that language. Use this button to copyexisting
content into new content and translate it to the new language.

Creating New
Content on page
14-9
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Button Name Description
More
Information

Approve Approve or decline a request to publish or delete content
Approve/Decline
Content on page
4-33

Add Task Add a task to a user
Assigning and
Reviewing Tasks
on page 12-1

Delete Open View Content page. From it, you can delete the content. Viewing Content
on page 7-9

Edit Checkout content for editing; open in separate window
Editing HTML
Content on page
7-20

Edit in
Context

Checkout content for editing; content remainswithinWeb
page

Edit in Context on
page 7-22

Logout Log out ofWeb site
LoggingOut of
the Sample Site
on page 2-10

New Poll Create new poll or survey
Creating Polls
and Surveyson
page 7-264

Preview Preview content before it is published Site Preview on
page 2-9

Properties Open content’sView Content page Viewing Content
on page 7-9

View
Content
Difference

Displaydifferencesbetween previousand currently-published
version of content

Comparing
Versionsof
Content on page
7-118

View
History

Open View History screen, where you can view previous
versionsof content

Viewing and
Restoring
PreviousContent
on page 7-115

Workarea OpenWorkarea. From here, you can perform all Ektron
CMS400.NET tasks.

Using The
Workarea and
Smart Desktop
on page 3-1

WebSite Content MenuOptions
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Changing the Appearance of the Web
Site Content Menu
You have three choices for determining the appearance of the Web Site Content
menu. To make your choice, edit the ek_UserMenuType element of the
siteroot/web.config file. By default, ek_UserMenuType is set to 2.

Value set in ek_
UserMenuType

Description Illustration

2 (default)
Dropdown Interface - No borders; dropdown
menu appearswhen user clicks the Silver Access
Point in top left corner of server control.

1

Classic Interface - Colored borders andmenus
alwaysappear; menu optionsappear as icons in
the top row.

Note: If you use this interface, the page layout
is not depicted accurately because of the fixed
toolbars.

0

Hover Interface - Colored border appearswhen
user hoversmouse over area; menu appears
when user right clicksmouse inside border.

This interface has two displayoptions: vertical
(shown on right) and horizontal.

To change:

1. Open the siteroot/web.config file.

2. Find ek_MenuDisplayType.

3. Change its value:

n 0 (zero) = horizontal

n 1 = vertical

Hiding and Showing the Content Border
By default, Ektron CMS400.NET provides the silver access point to indicate the
edit menu. An alternate view of the edit menu uses borders around content
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areas. This is optional and can be set in the web.config file. To learn how to set
this option, see Changing the Appearance of the Web Site Content Menu on
previous page.

Warning! If you change the border to hidden, the Add and Edit buttons for menus are also
hidden. This displays the page as it appears when you are not logged in. For information on
menus, seeWorking with Menus on page 9-133.

You can hide the border that surrounds content when you are logged into Ektron
CMS400.NET. This lets you view the page as it appears when not logged in.

If the border is hidden and you hover over a content area, there is no indication
that it is Ektron CMS400.NET content. However, you can right click to access
the menu.

Note: Information about whether a border is hidden is stored in a cookie on a user’s system.
This preserves the information between sessions.

Hiding the Border
To hide the content border, right click a content block while logged in. Next,
select Hide Borders. This image shows content with a border.

This image shows the same content without a border.

Hiding the Border
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Showing the Border
To show the border, right click a content block while logged into Ektron
CMS400.NET. Next, select Show Borders.

Managing Content in Ektron CMS400.NET
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Viewing Content
You can view all content in your Ektron CMS400.NET Web site. Viewing content
allows you to see the content, metadata, summaries, and other information.

Viewing Content from a Web Page
See Also: Viewing Content from the Workarea below

To view content from a Web page, follow these steps.

1. Sign in.

2. Browse to the content you want to view.

3. Hover over the silver access point.

4. A menu appears.

5. Click Properties.

6. Continue reading from The View Content screen appears. on next
page

Viewing Content from the Workarea
1. Navigate to the folder that contains the content, as explained in

Viewing a Folder on page 4-3.

2. To change the type of content being displayed, click View then select
a type.

Viewing Content
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3. If your system supports more than one language, you can view only
content in any language via the View > Language menu option
(illustrated below).

4. Hover the cursor over the content, click the triangle ( ), and select
View from the dropdown menu.

Alternatively, click the content’s title.

5. The View Content screen appears.

Managing Content in Ektron CMS400.NET
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After selecting content, you may have the following options.

Your options depend on your permissions and the content's status.

Button or
Tab

Name Description
For more information,
see

Properties
tab

Content
Properties View the content’s properties Propertieson page 7-13

Content
tab

View
Content Displays content

Summary
tab

Edit
Summary Edit content’s summary Working with Content

Summaryon page 7-137

Metadata
tab

Edit
Metadata Edit content’smetadata Working with Metadata on

page 7-141

Alias tab Edit Alias
n View and edit the content item’s primary
alias

n View all secondary aliases

ManualAliasing on page
10-28

Comment
tab

View
Comment

View comments on changesmadewhen
editing content.

This comment also appears on the View
Content and Content History screens. Use it to
help distinguish one version from another.

Tasks tab Add/edit
tasks Add or edit tasks for this content Assigning and Reviewing

Taskson page 12-1

Web
Alerts tab

Add/edit
Web Alerts Add or edit Web Alerts for this content

Administering theWeb
Alert Feature on page 23-
1

Templates
tab

Add/edit
Templates

The template currently assigned to the
content.

Creating/Updating
Templateson page 7-178

Viewing Content from theWorkarea
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Button or
Tab

Name Description
For more information,
see

Category
tab

Add/edit
Taxonomy
Category

Any taxonomycategories currently assigned to
the content.

Only appears if at least one Taxonomy is
applied to the folder in which the content
resides.

Taxonomyon page 9-202

Numberson the View
CategoriesScreen on
page 9-213

Edit
Content Open content for editing Editing HTMLContent on

page 7-20

View
History

View older versionsof content; restore older
version

Viewing and Restoring
PreviousContent on page
7-115

View
Published Displays content as it is currently published

View
Difference

Compares current and earlier versionsof
content

Comparing Versionsof
Content on page 7-118

Delete Delete content Deleting a Single Content
Item on page 7-127

 View per-
missions View and edit permissions for content Setting Permissions for

Content on page 4-48

View
approvals

View and possibly edit the content's approval
chain

Editing an ApprovalChain
For Content on page 4-33

Link search Find all content with Quicklinks to this content LinkChecking on page 7-
129

Add Task Attach a task to content
Creating a Task via the
View Content Screen on
page 12-20

View Ana-
lytics View Analytics for this content

Viewing Page-LevelWeb
TrafficAnalytics from the
Workarea on page 7-787

Edit Prop-
erties

View and edit content'sContent Searchable
checkboxand flagging definitions

TheContent Searchable
Field on page 9-29
Flagging on page 16-209

Return Go back to previousmenu

Export for
translation

Copy content to XLIFF files that can be sub-
mitted to a translation agency

Using the Language
Export Feature on page
14-14

Managing Content in Ektron CMS400.NET
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Button or
Tab

Name Description
For more information,
see

View
(language) View

If you can view content in more than one
language, select a language from the drop
down list.

Add

-select
language-

Add

-select
language-

Lets you copy current content into a new item
and translate it to selected language.

Translating Content to
Another Language on
page 7-108

Properties
The content properties screen contains information about the content.

Field Description

Content Title The title assigned to the content

Content ID The ID number assigned to the content. The ID number is used to retrieve content from a
database.

Content
language The content’s language

Status The current statusof the content. See Also:Content Statuseson page 7-130

Last User to
Edit The last user to edit this content

Last Edit
Date When the content was last edited

Start Date When the content will go live on theWeb site

End Date When the content will be removed from theWeb site

Action on End
Date

What happens to the content when its end date and time are reached. See Also:Setting
Archive Optionson page 7-191

Date Created When the content was created

Approval
Method

Whether all approversmust sign off on content before it is published; managed by your
system administrator. See Also: The ApprovalMethod on page 4-39

Approvals The users in the approval chain for this content. See Also:Approve/Decline Content on page
4-33

Smart Form
Configuration

The Smart Form applied to the content. This is typicallymanaged by your system
administrator. See Also:Working with Smart Formson page 7-278

Properties
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Field Description

Template The template currently assigned to the content. This is typicallymanaged by your system
administrator. See Also:Creating/Updating Templateson page 7-178

Path The folder path to the content’s folder. A slash (\) represents the Content folder.

Rating
Ektron CMS400.NET providesa Content Rating feature that lets site visitors rate any
content item on a scale of 1 to 10. If this feature is enabled for the content item, the average
numerical rating appears. See Also:Content Rating on page 7-739

Content
Searchable

True appears if the content can be found when someone searches your Web site.

However, even if content isnot searchable, theWorkarea Advanced search still finds it. See
Also: The Advanced Search Tab on page 9-93

Managing Content in Ektron CMS400.NET
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Adding HTML Content
You can only add content to a folder if you have permission to do so. The
following flowchart illustrates a typical sequence of events when creating
content.

After you create content, you or your system administrator typically make it
available on the site. For example, you can add a hyperlink to it from another
page, or place it in a collection or menu. Your administrator can add it to a list
summary or content list.

Note: Only users with Add permission for a folder can add content to it. See Also: Folder
Permissions on page 4-40

Note: This section only explains how to create HTML content. Procedures for
creating/uploading other types content are in the appropriate chapters, listed below

Content Type Create/Upload Procedure

HTML Form/Survey Creating a New Form on page 7-214

XMLSmart Forms Working with Smart Formson page 7-278

Assets (including
multimedia) Working with Managed Fileson page 7-428

Microsoft Office documents Working with Microsoft Office Documentson page 7-403

PageBuilder Page Building PageBuilder Pageson page 5-1

Adding HTMLContent
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To add HTML content, follow these steps.

1. Browse to the folder where you want to create the new content.

2. Click View > Language and select a language from the list.

3. Click New > HTML Content.

4. The Edit Content window opens.

5. Create content in the editor using the following table.

To learn about the content editor, which you use to create or update
content, see Ektron CMS400.NET Editors on page 7-26.

This section also contains the following topics.

Responding to the Fields on the Add Content Screen 7-17
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Buttons on the Add Content Screen 7-18
Tabs on the Edit Content Screen 7-19

Responding to the Fields on the Add
Content Screen
Field Description

Title
Enter a title for the content. It cannot include these characters:

\, /, *,>, <,|

Content
Searchable

Note: This checkboxonly appears if you are amember of the AdministratorsUser
Group.

Check this box if the content should be found when someone searches your Web site.
However, even if content isnot searchable

n theWorkarea Advanced search still finds it. See Also: The Advanced Search Tab on
page 9-93

n it can appear among Suggested Results. See Also:Suggested Resultson page 9-36

After you respond to the above fields, the following buttons are available.

Responding to the Fields on the Add Content
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Buttons on the Add Content Screen
Button Name Description

Submit
Submit the content into the approval chain. This action also returns the new or updated
content to the database and exits the editor.

See Also:Approve/Decline Content on page 4-33

Publish

Publish the content to theWeb site.

Note: Only the last approver in the approval chain sees this button. If no approval
chain is assigned to the content’s folder, every authorized user sees this button.

See Also:Approve/Decline Content on page 4-33

This action updates the content in the database and exits the editor.

Check
In

Save and check-in the document. This action updates the content in the database and
exits the editor. It doesnot submit the content into the approval chain. Rather, it allows
you and other users to continue changing it.

Save Save the content without leaving the editor. It is a good idea to save your work
frequently.

Preview
Preview the current version of the page within its template.

This button is not available with all file types.

Cancel Close the editor without saving changes.

Managing Content in Ektron CMS400.NET
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Tabs on the Edit Content Screen
Tab Description

Content Insert content. For more information about using Ektron CMS400.NET’s editors, seeEktron
CMS400.NET Editorson page 7-26.

Summary
Enter or edit the content summary.

See Also:Working with Content Summaryon page 7-137

Metadata

Enter or edit the content metadata.

Note: All requiredmetadatamust be added before content can be checked in or
submitted into the approval chain.

See Also:Working with Metadata on page 7-141

Alias Enter or edit the content'smanual alias, and view its automatic alias. See Also:Creating User-
FriendlyURLswith Aliasing on page 10-1

Comment Briefly describe the content, or comment on changesmadewhen editing content.

The history comment appears on the View Content and Content History screens.

Schedule

Use this tab to set a future publication date/time. In order to be published, this content must be
approved and reach its publication date/time.

See Also:Scheduling Content to Begin and End on page 7-187

If appropriate, enter a date when the content will no longer be viewable on theWeb site.

See Also:Setting an EndDate on Content on page 7-190

Web
Alerts

SeeAdministering theWeb Alert Feature on page 23-1.

Templates

This content’s folder must have a default template. It can also have additional templates
assigned.

When content is created, the default template is automatically assigned to it. If you want to
change the template assigned to this content, click this tab and choose a template from the
dropdown list.

See Also:Creating/Updating Templateson page 7-178

Category Assign taxonomycategories to this content. See Also: Taxonomyon page 9-202

Tabs on the Edit Content Screen
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Editing HTML Content
Ektron CMS400.NET HTML content can be in any of several statuses, as
described in Content Statuses on page 7-130. You can only edit content for
which you have permission and in one of the following statuses:

n published

n checked in

n checked out by you

n submitted for your approval

Note: If you check content out, you, a member of the Administrators group, or a user assigned
the folder admin role must check it in before other users can edit it.

Note: Editing content is a privilege granted by the system administrator. If you do not see an
Edit option on the dropdown menu, you do not have permission to do so.

This section also contains the following topics.

Finding Content 7-20
Steps in Editing HTML Content 7-21

Finding Content
Much of your work involves editing existing content or creating new content.
Ektron CMS400.NET provides three methods for finding content to be updated.
You can use whichever method is easiest.

n Navigate through your Web site to the content you want to edit

n Find the content through the Workarea, which resembles Windows
Explorer and helps you find content by navigating through a folder
tree. See Also: Using The Workarea and Smart Desktop on page 3-1

n Use the Action > Search option, which appears on every folder.
When clicked, a screen prompts you to enter keywords and then finds
content containing the keywords. See Also: Searching the Workarea
on page 9-89

Managing Content in Ektron CMS400.NET

7-20 ReferenceManual
Version 8.01 Rev 4



Steps in Editing HTML Content
There are several ways to edit content.

n from a web page after you log in

- Edit

- Edit in Context

n from the Ektron CMS400.NET Workarea

This section also contains the following topics.

Editing Content from a Web Page 7-21
Edit in Context 7-22
Edit Option 7-23
Editing Content from the Workarea 7-24

Editing Content from a Web Page
Options for editing content from a Web page are illustrated below.

This table compares the editing options.

Edit in Context Edit

How editor is displayed Within the page you are
viewing In new window

Editing functions Only a few Complete set

What you can update Content only Content plus all editor tabs (Summary, Metadata,
etc.)

Typesof content
available HTML only

n HTML

n HTML forms

n XMLSmart Forms

Steps in Editing HTMLContent
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Edit in Context Edit

What you can do after
editing Submit/Publish

n Check in

n Submit/Publish

Available from Web Site Content Menu

Web Site Content Menu andWeb Site Server
ControlMenu

See Also: TheWeb Site Content Menu on page 7-
4

For more information,
see Edit in Context below Edit Option on the facing page

Edit in Context
The Web Site Edit in Context option offers content authors quick access and
editing within a page. But it has a limited set of editing functions (listed below).
See Also: Editing Content from a Web Page on previous page

To Edit in Context from a Web page, follow these steps.

Prerequisite: You have permission to edit the content See Also: Folder
Permissions on page 4-40

1. Sign in to a Web site.

2. Browse to the content you want to edit.

3. Click Edit in Context from the menu.

4. The content opens within the page, as shown below.

5. Use the following table to help you edit and save the content.
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Toolbar button/
menu option

Description For more information, see

Save changesand submit content to the
approval chain

Note: Unlike other edit options, the check-
in button is not available.

Approve/Decline Content on
page 4-33

Undo checkout, discard your edits, and close
the editor

Spell check Checking Spelling on page 7-43

Add/remove a hypertext link Using Hyperlinkson page 7-61

Insert library item Adding a LibraryFile to Content
on page 8-16

, Apply bold or italic formatting

Right clickmenu options

Cut selected text Cut on page 7-30

Copyselected text Copyon page 7-31

Paste text Paste on page 7-31

Paste text fromWord Copying fromMicrosoftWord
on page 7-39

Paste plain text

Set Image Properties (appearswhen you
select an image)

Editing an Image’sProperties
on page 7-47

Note: System administrators can remove toolbar buttons by editing the C:\Program
Files\Ektron\CMS400v8x\workarea\ContentDesigner\configurations\InterfaceEditInContext.aspx
file.

Note: The content block server control’s Suppresswrappertags property must be set to
false.

Edit Option
The Web Site Edit option offers content authors full access to all editing
functions.

To access the Edit Content screen from a Web page, follow these steps.

Edit Option
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1. Sign in to the Web site.

2. Browse to the content you want to edit.

3. Click Edit from the menu.

4. The Edit Content in Folder screen appears. One of two editors may
appear. See Also: Ektron CMS400.NET Editors on page 7-26

From here, you can

n edit content. For a description of the toolbar buttons, see Table of
Toolbar Buttons on page 7-30.

n create or edit a summary

n specify metadata for the content

n enter or update a comment

n enter or update start and end dates

n review and update Web Alert information (To learn more, see
Administering the Web Alert Feature on page 23-1)

n if aliasing is enabled and you are an alias administrator, an Alias
tab appears (To learn more, see Manual Aliasing on page 10-28)

n assign or change available templates (To learn more,
Creating/Updating Templates on page 7-178)

n assign taxonomy categories (To learn more, see Taxonomy on
page 9-202)

n save changes

n check in content

n submit content for approval

n publish content to the Web site

n access the library

5. Edit the content. See Also: Toolbar Buttons on page 7-30

Or, you can choose a toolbar option or tab from the top of the Edit
Content window. These options are described in Buttons on the Add
Content Screen on page 7-18 and Tabs on the Edit Content Screen on
page 7-19.

Editing Content from the Workarea
To access the Edit Content screen from the Workarea, follow these steps.

1. Access the View Content screen for the folder that contains the
content you want to edit, as described in Viewing Content on page 7-
9.

2. Select View > Language then the language whose content you want
to view.
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3. Hover the cursor over the triangle ( ) and click.

4. Select Edit from the menu.

5. The editor opens with the content block inserted. One of two editors
may appear. See Also: Ektron CMS400.NET Editors on next page

6. From the Edit Content window, you can

n edit content

n create or edit a summary

n specify metadata for the content

n enter or update a comment

n enter or update start and end dates

n review and update Web Alert information (To learn more, see
Administering the Web Alert Feature on page 23-1)

n review and update templates (To learn more, see
Creating/Updating Templates on page 7-178)

n review and update categories (To learn more, see Taxonomy on
page 9-202)

n save changes

n check in content

n submit content for approval

n publish content to the Web site

n access the library

7. Make the necessary edits to the content.

Or, you can choose a toolbar option or tab from the top of the Edit
Content window. These options are described in Buttons on the Add
Content Screen on page 7-18 and Tabs on the Edit Content Screen on
page 7-19.

Editing Content from theWorkarea
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Ektron CMS400.NET Editors
Ektron CMS400.NET has two choices for a main content editor, depending on
your computer’s operating system.

Operating
System

Possible editors

Windows
n eWebEditPro+XML

n eWebEdit400

Macintosh n eWebEdit400

Note: eWebEdit400 does not require installation of an ActiveX control to each client computer.

Each editor’s toolbar is illustrated below.

eWebEdit400 Toolbar

eWebEditPro+XML Toolbar

Note: Your choice of editors only affects the main HTML content editor. It does not affect other
screens which use eWebEdit400, such as the Task Description.

This section also contains the following topics.

Setting the Editor for Ektron CMS400.NET Users 7-27
Introduction to eWebEdit400 7-28
Using eWebEdit400 7-29
Toolbar Buttons 7-30
Using Temporary Markers 7-37
Copying from Other Applications 7-38
Finding and Replacing Text 7-39
Checking Spelling 7-43
Working with Images 7-45
Using Bookmarks 7-59
Using Hyperlinks 7-61
Inserting email Links 7-65
Working with HTML 7-66
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Using Ektron CMS400.NET’s Wiki Feature 7-68
Working with Tables 7-71
Creating a Table 7-72
Modifying Table Properties 7-74
Deleting a Table 7-76
Inserting a Table within a Table 7-77
Choosing the Number of Rows and Columns 7-77
Specifying Table Width 7-79
Specifying Horizontal Alignment 7-83
Table Backgrounds 7-84
Setting Table Borders 7-89
Section 508 Tables 7-92
Working with Table Cells 7-96
Selecting Cells to Modify 7-97
Specifying the Height and Width of a Cell 7-98
Deleting a Cell 7-99
Specifying a Cell’s Background Color 7-100
Specifying a Background Image for a Cell 7-100
Spanning Rows or Columns 7-101
Aligning Text Within a Cell 7-103
Splitting a Cell 7-104
Merging Two Cells 7-105
Word Wrap 7-105
Setting Cell Padding and Spacing 7-106

Setting the Editor for Ektron
CMS400.NET Users
Each Web server that hosts Ektron CMS400.NET has two editor options: one for
clients that run Windows and another for clients using MacIntosh. Your system
administrator determines the editor options in the site’s web.config file, using
the following settings.

<appSettings>

.

!-- EditControlWin may be either "ContentDesigner" or "eWebEditPro" or "User-
Preferred" -->

<add key="ek_EditControlWin" value="UserPreferred" />

Setting the Editor for Ektron CMS400.NET Users
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<!-- EditControlMac Only "ContentDesigner" -->

<add key="ek_EditControlMac" value="ContentDesigner" />

.

</appSettings>

The table below contains information about both editors.

Operating
System

Web.Config file
key

Possible editor key values

Windows
ek_
EditControlWin

n eWebEditPro

n ContentDesigner (use to load eWebEdit400)

n UserPreferred (loadseditor selected byuser atContent and
Forum Editor field in User Profile) See Also:Content and ForumEditor
on page 15-5

Macintosh
ek_
EditControlMac

n ContentDesigner (use to load eWebEdit400)

The following section explains how to use the eWebEdit400 editor.

To learn abouteWebEditPro+XML, see
http://www.ektron.com/manuals/CMS400/76/usermanual.pdf > “Introduction
to eWebEditPro+XML”.

Introduction to eWebEdit400
eWebEdit400 is a browser-based, Web content editor designed for dynamic Web
sites. It lets you create and publish Web content in any language supported by
the operating system and your Web site.

Note: To learn how to enable eWebEdit400 for all clients that connect to your server, see
Setting the Editor for Ektron CMS400.NET Users on previous page.

More specifically, eWebEdit400 lets you perform Web page editing functions,
such as

n copy content from any Windows-based application

n cut, copy, and paste

n find and replace text
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n check spelling

n change font style, size, attributes (bold, italics, underline), and color

n begin lines with bullets or numbers

n adjust indentation

n right, center, or left justify text and images

n add a bookmark, hyperlink, image, or table

n view your text as WYSIWYG or HTML code

n insert or clean HTML source code

You gain access to these functions from the toolbar at the top of the editor, or
from a menu that appears when you right click inside the editor.

Also, if you create and maintain HTML forms, this chapter describes how to do
that using eWebEdit400.

Using eWebEdit400
eWebEdit400 is like many other word processing applications. You type text and
then use toolbar buttons (illustrated below) and menu options to change the
text’s appearance or perform functions on it, such as spell checking.

To learn more about using eWebEdit400, see these topics.

n Toolbar Buttons on next page

n Using Temporary Markers on page 7-37

n Copying from Other Applications on page 7-38

n Finding and Replacing Text on page 7-39

n Checking Spelling on page 7-43

n Working with Images on page 7-45

n Using Bookmarks on page 7-59

n Using Hyperlinks on page 7-61

n Inserting email Links on page 7-65

n Working with HTML on page 7-66

n Using Ektron CMS400.NET’s Wiki Feature on page 7-68

n Working with Tables on page 7-71

Using eWebEdit400
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n Working with HTML Forms on page 7-212

Toolbar Buttons
This section explains how to use the buttons and drop-down lists on the toolbar.
(The toolbar is the row of buttons across the top of the editor window,
illustrated below.)

The buttons let you perform functions such as cutting and pasting text, inserting
images, and creating tables.

All buttons may not appear. Your Webmaster determines which buttons appear
on your toolbar.

Note: The following Ektron Knowledge Base article explains how a Webmaster adds a custom
toolbar button to eWebEdit400: http://dev.ektron.com/kb_article.aspx?id=16550.

This section also contains the following topics.

Table of Toolbar Buttons 7-30
Form Elements Toolbar 7-36

Table of Toolbar Buttons
eWebEdit400’s toolbar buttons are explained below.

Button

Equivalent
Keystroke

(Internet
Explorer only)

Function
For more
information,
see

Select All <Ctrl>+<A> Select all content

Cut <Ctrl>+<X>

Remove selected text and
graphics. Place that data into
temporarymemory, also known as
the “clipboard.”

(If you later cut or copymore
information onto the clipboard, the
new information overwrites the
original information.)
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Button

Equivalent
Keystroke

(Internet
Explorer only)

Function
For more
information,
see

Copy <Ctrl>+<C>

Copyselected text and graphics
into temporarymemory. Leave
selected data where it is.

(If you later cut or copymore
information intomemory, the
original information is lost.)

Copying from
Other
Applicationson
page 7-38

Paste <Ctrl>+<V>
Insert themost recently cut or
copied text and graphics at the
current cursor location.

Copying from
MicrosoftWord
on page 7-39

Paste fromWord,
Cleaning Fonts&Styles

Designed for pastingMicrosoft
Word content, this button strips
fonts and classes. For example, if
you use the Paste button,Word
content contains these tags.

<p class="MsoNormal"
style="MARGIN: 0in 0in
0pt"><span
style="BACKGROUND: lime;
mso-highlight: lime"><font
size="3"><font face="Times
New Roman">

But if you paste that content using
this button, only <p> tagsare
preserved.

Copying from
MicrosoftWord
on page 7-39

Paste Plain Text

Paste the clipboard’s contents as
plain text. That is, all HTML tags
(including images) are stripped out.

This button is helpfulwhen you
want to eliminate HTML formatting
from the copied text.

Copying from
MicrosoftWord
on page 7-39

Find and Replace

Launch the Search and Replace
dialog box. The dialog searches for
(and lets you optionally replace)
text that you specify.

Finding and
Replacing Text
on page 7-39

Print <Ctrl>+<P> Print the editor content.

Undo <Ctrl>+<Z>
Reverse themost recent action, as
if it never occurred. You can undo
asmanyactionsas you wish.

Table of Toolbar Buttons
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Button

Equivalent
Keystroke

(Internet
Explorer only)

Function
For more
information,
see

Redo <Ctrl>+<Y> Reverse the undo action.

SpellCheck Begin spell checker.
Checking
Spelling on
page 7-43

Anchor Tag Insert a bookmarkanchor.
Using
Bookmarkson
page 7-59

Add/edit Hyperlink
Change information about a
hyperlink.

Using
Hyperlinkson
page 7-61

Remove Hyperlink Remove a hyperlink.
Removing a
Hyperlinkon
page 7-65

Library Insert a library file.

Adding a
LibraryFile to
Content on
page 8-16

AddWiki Link
Create a wiki link.

Using Ektron
CMS400.NET’s
Wiki Feature on
page 7-68

Translate
Translate content into another
language

Translating
Content to
Another
Language on
page 7-108

Horizontal Line Insert a horizontal line.

Insert Symbol
Insert symbols and special
characters.

Validate

Check content for adherence to
XHTML and accessibility
standards.

Validating with
eWebEdit400
on page 7-676
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Button

Equivalent
Keystroke

(Internet
Explorer only)

Function
For more
information,
see

Hide/Show Elements

Toggle to show/hide temporary
markers in content.

Using
Temporary
Markerson
page 7-37

ApplyCSSClass

Displaya list of style sheet classes.
Users can select from the list to
apply a class to selected text. The
list can change depending on the
selected text.

Your Webmaster determineswhich
styles are available.

Paragraph Style

Displaya list of paragraph styles.
Users can select from the list to
apply a style to selected text. The
list can change depending on the
selected text.

Your Webmaster determineswhich
styles are available.

Bold <Ctrl>+<B> Make selected text bold.

Italic <Ctrl>+<I> Make selected text italic.

Underscore <Ctrl>+<U> Make selected text underlined.

Strikethrough
Apply strikethrough to selected text.
For example: Here is some text

Superscript
Make selected text appear smaller
and above text line.

Subscript
Make selected text appear smaller
and below text line.

Relative Font Size Change the relative font size. Your
Webmaster determineswhich
relative font sizesare available.

Table of Toolbar Buttons

ReferenceManual
Version 8.01 Rev 4

7-33



Button

Equivalent
Keystroke

(Internet
Explorer only)

Function
For more
information,
see

Font
Style

Change the font style.

Your Webmaster determineswhich
fonts are available.

Note: If more than one font
appears in a selection, the
browser on the reader’sPC
tries to display text using the first
font. If the browser cannot find
that font, it tries to use the
second, etc.

Note: Your system
administrator can enable or
disable the font toolbar buttons
(style, size, color, and
background color). See ”Enable
Font Buttons” on page 19-12.

Controlling
Available Fonts
on page 28-1

Font Size

Change the font size in points. Your
Webmaster determineswhich font
sizes in points are available.

Font Color Change the font color.

Background Color
Change the background color of
the selected content.

Number

Begin the line on which the cursor
restswith a number. If the line
above this line is

n not numbered, assign this line 1

n numbered, assign a number
onemore than the line above

Note: TheNumber toolbar
button applies a number to each
paragraph. If you want to switch
to regular (that is, non-
numbered) paragraphs, click
the button a second time.
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Button

Equivalent
Keystroke

(Internet
Explorer only)

Function
For more
information,
see

Bullet

Begin the line on which the cursor
rests (or all selected lines) with a
bullet ( ).

Note: The Bullet toolbar button
applies a bullet to each
paragraph. If you want to switch
to regular (that is, non-bulleted)
paragraphs, click the button a
second time.

Indent
Increase or decrease the current
line’s distance from the left margin.

Left, Center, and Right
Justify

Align paragraph so that it is
arranged

n evenly on the left side (uneven
on the right)

n in the center of each line

n evenly on the right side (uneven
on the left)

n evenly on right and left side

Use the last button to remove
justification.

Insert table Insert a table.
Working with
Tableson page
7-71

Insert row above
Insert a new row above current one
(that is, the one in which the cursor
currently resides).

Insert row below
Insert a new row below current one
(that is, the one in which the cursor
currently resides).

Insert column left
Insert a new column to the left of
the current one.

Insert column right
Insert a new column to the right of
the current one.
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Button

Equivalent
Keystroke

(Internet
Explorer only)

Function
For more
information,
see

Delete row Delete current row.

Delete column Delete current column.

Delete cell Delete current cell.
Deleting a
Cell on page
7-99

Merge cells
horizontally

Merge current cell with cell to its
right.

Merging Two
Cells on
page 7-105

Merge cells
vertically

Merge current cell with cell below it.
Merging Two
Cells on
page 7-105

Split cell
Divide a cell into two. After you split,
each cell occupiesone half the size
of the original cell.

Splitting a
Cell on page
7-104

Table properties Adjust a table’s properties

Modifying
Table
Properties on
page 7-74

Cell properties Adjust properties of current cell
Working with
Table Cells
on page 7-96

Show/hide border
Display/suppress internal table
border

Setting Table
Borderson
page 7-89

Form Elements Toolbar
These toolbar options appear when you are working with an HTML form, poll, or
survey.

See The Form Toolbar Options on page 7-221.
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Using Temporary Markers
Temporary markers lets you insert your cursor in a place that is otherwise
inaccessible. For example, if two tables are adjacent to each other, as shown in
the following example, you cannot insert text between the tables without
temporary markers.

This section also contains the following topics.

Recognizing Temporary markers 7-37
Hiding Temporary Markers 7-38

Recognizing Temporary markers
The following image shows temporary markers in Ektron CMS400.NET.

Using TemporaryMarkers
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You can click on any marker and begin inserting new content. When you save
the content, temporary markers are removed.

Hiding Temporary Markers
You can toggle the temporary markers on and off by clicking the Hide/Show
Elements button ( ), shown in the following figure.

Copying from Other Applications
You can copy information from most other Windows applications into
eWebEdit400 and retain most or all of the original application’s formatting. In
general, copying from another application involves these steps.

1. Sign on to the application that contains the information.

2. Select the text to be copied.

3. Press <Ctrl>+<C>.

4. Go to eWebEdit400.

5. Press <Ctrl>+<V> to paste the selected information.
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Note that you can only copy content, not background information that generates
content. So, for example, you can copy the values in a spreadsheet but not the
formulas used to generate them. Also, copying dynamic fields from Microsoft
Word retrieves the current value of the fields but not the variables that
generate the values.

It’s a good idea to experiment with copying from different sources to test the
results.

Copying from Microsoft Word
eWebEdit400 is very flexible in handling content pasted from Word. The table
below presents your options and how your users can achieve them.

To preserve
Apply this Application Setup screen
setting

Press this
toolbar button

MSWord styles, classattributes,
and allHTML tags

Check Preserve MS-Word Styles,Preserve
MS-Word Classes

Paste ( ) or
<Ctrl> + <V>

AllHTML tags Uncheck Preserve MS-Word Styles,
Preserve MS-Word Classes

Paste ( ) or
<Ctrl> + <V>

HTML tagsexcept <span>and
<font> tags Not applicable

Paste fromWord

( )

Visual line breaksonly Not applicable
Paste Plain Text

( )

Finding and Replacing Text
To find (and optionally replace) text on your Web page, click the Find and

Replace button ( ). When you do, the Find and Replace dialog box appears.

Copying fromMicrosoft Word
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You can use this dialog to simply find text, or to find then replace the text with
other text. Each option is explained below.

Note: You can also use this dialog to delete text that appears repeatedly. To do so, follow the
directions in Finding and Replacing Text below and enter nothing in the Replace With field.

This section also contains the following topics.

Finding Text 7-40
Finding and Replacing Text 7-40
Additional Options on the Dialog Box 7-41
Searching Selected Text 7-41
Specifying a Search Direction 7-41
Considering the Case of a Search Term 7-42
Whole Word Match 7-43

Finding Text
1. In the Find field, type the text you want to find.

2. Set dialog box options (see Additional Options on the Dialog Box on
the facing page).

3. Click Find Next to find the next occurrence of the “find” text.

Finding and Replacing Text
1. In the Find field, type the text you want to find.

2. Click the Replace tab.

3. In the Replace With field, type the text to replace the “find” text.

4. Set dialog box options (see Additional Options on the Dialog Box on
the facing page).

5. If you want to

- replace all occurrences of the “find” text with the “replace” text, click
Replace All.

Note: You can undo replacements one at a time using the Undo button ( ).

- replace only the highlighted term with the “replace” text, click
Replace.

- find the next occurrence of the “find” text (and optionally replace it
with the “replace” text), click Find Next.

- change the highlighted term using the editor, exit the Find and Replace
dialog, move to the term and edit as needed. To restart the search,

press the Find button ( ).

6. Continue to find and optionally replace or edit until you reach the end
of the text.
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Additional Options on the Dialog Box
The dialog box also lets you do the following.

n Searching Selected Text below

n Specifying a Search Direction below

n Considering the Case of a Search Term on next page

n Whole Word Match on page 7-43

Searching Selected Text
You can search and replace text in a selected portion of content. To do so,
follow these steps.

1. Select text that you want to search and replace by dragging the
cursor over it.

2. Click the Find and Replace button ( ).
3. In the Find & Replace dialog, enter the search string.

4. If desired, click the Replace tab and enter a replacement string.

5. Under Search, click Selection only.

6. Click Find Next.

7. The search runs but is limited to text you selected in Step 1.

Specifying a Search Direction
The search begins where the cursor is when you click Find Next. To make sure
you find every occurrence of a term, place the cursor at the top of the content
before beginning the search.

If you begin the search somewhere other than the top of the page, use the
Direction field to search from the current location to the top or bottom of the
content.

Additional Options on the Dialog Box
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To search from the
cursor location to
the

Click this option in
the Direction field

end of the page Down

top of the page Up

Considering the Case of a Search Term
By default, the search ignores the case (upper or lower) of a search term. In
other words, if you enter Bob in the Find field, the search finds bob, Bob, BOB,
etc.

If you want the search to be case sensitive, use the Match case check box. If
you enter Bob in the Find field and place a check in the Match case box, the
search only stops at Bob, not bob or BOB.
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Whole Word Match
By default, the search finds any occurrence of the text that you type into the
Find field. For example, if you enter the, the search finds the word the, as well
as those letters embedded in other words, such as others and theater.

If you want the search to find only whole word occurrences of the text in the
Find field, click the Match whole words only box.

Checking Spelling
Note: This section describes the spell check software installed with eWebEdit400. If you use
the FireFox browser, it has its own spell check software. To eliminate confusion between
eWebEdit400’s and Firefox’s spell checker, Ektron suggests disabling Firefox’s. This is set on
Firefox’s Tools > Options dialog > General Tab > Check my spelling as I type check box.

To begin spell checking, click the spell check button ( ).

When you do, eWebEdit400 underscores in red each word that’s not in the
dictionary. Then, it stops at the first misspelled word and displays your options
for fixing the problem.

WholeWordMatch
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This section also contains the following topics.

The Spelling Options 7-44
Using the Spell Checker 7-44

The Spelling Options

Option Use this option if you want to...

One or more
similar, correctly-
spelled words

Replace highlighted word with one from the list. To do this, click the correct word.

Ignore,
Ignore All

Don’t want to change the highlighted word, nor do you want to add it to the dictionary.

If the word appears repeatedly in the content, Ignore All also appears. Use this to
skip all occurrencesof the word in this spell check session.

ChangeManually

Retype the highlighted word.

If the word appears repeatedly in the content, the followingmessage asks if you want
to change alloccurrences to the fixed version.

This word occurs more than once in the text. Would you like to
replace all instances?

Add to Dictionary

Add the selected word to the “dictionary.” Do this if it is correctly spelled, and you
expect to use the word in the future.

Once you add a word to the dictionary, it will no longer be highlighted by the spell
checker. The word can also now appear on the correctly-spelled words list.

Note: Technical note:Wordsadded using this option are placed in a .txt file
located in the host server’ssite
root/Workarea/Foundation/RadControls/Spell/TDF folder. The file’s
name beginswith the selected language, and endswith custom.txt. For
example, if the language isU.S. English, the file is en-US-custom.txt.

Using the Spell Checker
n As soon as you select an option, the spell checker moves to the next

misspelled word and displays its options.

n If you finish spell checking all words, you return to edit mode.

n Instead of stopping at every misspelled word, you can place the
cursor on any highlighted word. When you do, its spelling options
appear.

n If you are done before fixing every misspelled word, click Finish
spell checking from the toolbar (circled below). If you do, your
changes are saved, and you return to edit mode.
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n If you want to exit the spell checker and ignore all changes you have
made since beginning it, click Cancel (circled above) at any time.

Working with Images
eWebEdit400 makes it easy to insert images in to your content.

First, you import the image into library or as a Ektron CMS400.NET asset. Then,
add it to the content. Next, you can edit its properties, such as border width and
color, spacing, width and height, etc.

This section also contains the following topics.

Inserting an Image 7-45
Procedure for Inserting an Image 7-45
Deleting an Image from Content 7-46
Inserting an Image Thumbnail 7-47
Editing an Image’s Properties 7-47
Pixels 7-50
Setting a Border 7-51
Aligning the Picture 7-52
Adding Space around the Picture 7-53
Editing an Image 7-54
Resizing the Image 7-55
Adjusting Brightness 7-57
Rotating an Image 7-58
Cropping an Image 7-58

Inserting an Image
Prerequisite

Before you can insert an image into eWebEdit400, it must be either uploaded to
the Library or imported as an asset.

n Copying Files to the Library on page 8-10 explains how to upload an
image to the Library

n Importing Managed Files on page 7-429 explains how to import an
asset

Procedure for Inserting an Image
To insert an image into the editor, follow these steps.

1. Place the cursor where you want the image to appear

Working with Images
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2. Click the library button ( ).
3. Make sure Images is selected in the content type dropdown.

4. From the folder display in the left panel, select the folder that
contains the image you want to insert.

If you don’t know the image’s folder, use the search button ( ) to find
the image by title, description, or internal file name.

5. Select the image you want to insert.

6. Click the insert button ( ).
7. The image is inserted into the content.

Deleting an Image from Content
If you want to delete a picture, follow these steps.

1. Move the cursor over the picture.

2. Click the mouse to select the picture.

3. Click the Cut button ( ).

Note: If you want to remove an image from content created from an XML Smart Form and

eWebEdit400 is your editor, click the image icon ( ), open the Image Properties dialog, and
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delete the image path (circled below).

Inserting an Image Thumbnail
As an alternative to inserting an image, you can insert a thumbnail, a miniature
version of the image. When the thumbnail appears on a Web page, a site visitor
can click it to view a full-sized version of the image. See example below.

To insert an image thumbnail, follow the steps in Procedure for Inserting an
Image on page 7-45, but when you get to Step 5, click the image’s thumbnail

button ( ).

Note: You can change the thumbnail image by right clicking it, selecting Set Image
Properties and editing the Image Src field. If you do that, however, and someone clicks it, the
original full-sized image appears. If you want to change both the thumbnail and the full-sized
image, delete it then enter a new thumbnail.

Editing an Image’s Properties
After an image in inserted, you can adjust the following properties for it.

n border width

n border color

Inserting an Image Thumbnail
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n alt text

n description

n alignment

n the image itself

n horizontal and vertical spacing

n width and height

To access the Image Properties dialog, follow these steps.

1. Select the image.

2. Right click the mouse.

3. Click Set Image Properties.
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The following explains the fields on the Image Properties dialog.

Field Description

Border
Width

Set the width of the image’s border in pixels. See Also: Setting a Border on page
7-51

Border
Color

To set the color of the image’s border, click the X circled below. When you do, a
palette of colors appears. Click the border color from the palette.

If a color hasalreadybeen assigned, it appears next to this field label. To change it, click down
arrow next to the color to display the color palette.

Image Alt
Text

The image’s title is used as the default alt text. Change if desired.

The alt text appears in place of the image on theWeb page if the image doesnot display.
Examplesof when an image doesnot display include:

n a speech browser (for example, a visually impaired person)

n a text-only browser (for example, browsing from amobile phone)

n a graphical browser with images turned off

Image
Alignment

The alignment of the image relative to adjacent text and images. If you choose
left or right alignment, the text wraps around the image. For more information,
see Aligning the Picture on page 7-52

Editing an Image’s Properties
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Field Description

Image Src

The path to the image.

If you want to change the image, click the ellipsis ( ) button to open the library. From there,
select a replacement image.

Horizontal
Spacing,
Vertical
Spacing

The amount of horizontal and vertical space around the picture. See Also:Adding Space
around the Picture on page 7-53

Width

The width of the picture in pixels. See Also:Pixelsbelow

Note: TheWidth andHeight settingsdetermine the area on aWeb page in which the
image is displayed. To displayan image correctly, its height and width settings shouldmatch
its actual size (set using the resize button). See Also:Resizing the Image on page 7-55

Height The height of the picture in pixels. See Also:Pixelsbelow

Constrain

The constrain feature lets you determine if an image’s height and width can be adjusted
independently. Typically, you want Constrain on, as shown below.

In this state, if one dimension is adjusted, the other is automatically adjusted in proportion to it.
For example, if you change the height from 100 to 200, the width is also doubled.

To turn Constrain off, click it. When you do, it looks like this.

WhenConstrain is off, the adjusted picture can be disproportionate, as shown below.

Warning! If you substantially adjust the picture’s height and/or width, the picture may be distorted
when users view your Web page.

Pixels
A pixel is a single point in a graphic image.
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Computer monitors display pictures by dividing the screen into thousands of
pixels, arranged in rows and columns. The pixels are so close together that
they appear connected.

Below is an image shown at regular size and then enlarged so you can see the
pixels that make up the picture.

regular size

enlarged to show pixels

Setting a Border
To add a border around a picture, enter the border’s thickness in pixels in the
Border Width field on the Image Properties dialog. See Also: Pixels on
previous page

Here is a picture with a 1 pixel border.

Here is the same picture with a 10 pixel border.

Setting a Border
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If the picture is not a hyperlink, its border is black. If the picture is also a
hyperlink, the border is the same color as a hyperlink (for example, blue or
purple if visited).

Aligning the Picture
To align a picture, use the Image Alignment field on the Image Properties
dialog.

The following table lists your alignment choices.

To align
Click this
Alignment
option

Illustration

The picture on
the left margin,
allowing
subsequent text
to wrap around it

The picture on
the right margin,
allowing
subsequent text
to wrap around it
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To align
Click this
Alignment
option

Illustration

The top of the
picture with the
first line of text

The vertical
center of the
picture with the
first line of text

The bottom of
the picture with
the first line of
text

Adding Space around the Picture
On the Image Properties dialog box, you can use the Spacing fields
(Horizontal and Vertical) to add space around the picture. You enter a
number of pixels to determine spacing value.

The following graphic illustrates the effect of adding spacing to a picture.

Adding Space around the Picture
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Editing an Image
You can perform the following tasks on any image inserted into eWebEdit400
content.

n crop

n resize

n rotate

n adjust brightness

To access the image editing tool, edit a piece of eWebEdit400 content, right
click an image, then click Image Modification Tool.

When you do, the following dialog appears.

Note:When you save an image, a version is placed in the site root/uploaded
images/CMS folder folder. The version is named filename.nextnumber.file extension.
For example, if a library image is named ektronlogo.png, and someone inserts it into content
and saves it, a new version is created and named ektronlogo.1.png. If someone later saves

Managing Content in Ektron CMS400.NET

7-54 ReferenceManual
Version 8.01 Rev 4



that image in another content block (or even another section of the same content), that version
is named ektronlogo.2.png. Also, whenever someone edits and saves the image, a new
version is created and assigned the next highest number.
These edits have no effect on the original image stored in the library.

The following table explains the toolbar buttons. After changing the image, click
the Save button ( ) to finalize changes.

Button Description For more information, see

Save changes Note above

Exit without saving changes

Crop image (that is, remove a portion of it).

Drag the boxaround the area you want to keep and click
Done.

Cropping an Image on page 7-58

Change image size Resizing the Image below

Rotate image Rotating an Image on page 7-58

Adjust brightness Adjusting Brightnesson page 7-
57

Note: If you begin editing an image then click the cancel button ( ), and later try to edit that
image, you may see a small, red x instead of the image. (This problem only occurs if your
browser is Internet Explorer.) To remedy the problem, go to Tools > Internet Options >
Browsing History > Settings (or Temporary Files > Settings in Internet Explorer 6). Set Check
for newer versions of stored pages to Every Visit.

Resizing the Image

To change an image’s size, click the Resize button ( ). When you do, the
following dialog appears.

Resizing the Image
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Change the image to the desired size then click Done.

Keeping the Aspect Ratio
Aspect ratio is the relationship between an image’s width and height. For
example, if a graphic has an aspect ratio of 2:1, its width is twice as large as its
height.

If you check the Keep Ratio box, just specify a new width or height - the other
dimension is calculated for you.

Effect of Changing Image Size on the Image Properties
Dialog
TheWidth and Height settings on the Image Properties dialog (shown below)
determine the area on a Web page in which the image is displayed.
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To display an image correctly, its height and width on this dialog should match
its actual size (that you set using the Resize button).

Adjusting Brightness

To adjust the image’s brightness, click the brightness button ( ). When you
do, a brightness control appears.

The red dot indicates the current brightness level.

n To brighten the image, place your cursor to the left of the red dot and
click.

n To darken it, move the cursor to the right of the red dot and click.

Adjusting Brightness
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When you click, the image redisplays using the new brightness level. When you
are satisfied, click Done.

Rotating an Image

To rotate an image, click the Rotate Image button ( ). When you do, image
rotation buttons appear.

Use the buttons to rotate the image clockwise or counterclockwise in ninety
degree increments. When you are satisfied, click Done.

Cropping an Image
Cropping an image removes the portion of the image that is not within the

cropping tool. To crop an image, click the Crop Image button ( ). When you
do, the crop image box appears.

Drag the crop tool’s handles to frame how the image is cropped. When you are
satisfied, click Done. Everything outside the crop box is removed.
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Using Bookmarks
Use a bookmark to let a user “jump” from any word or phrase to another place
in the same content block. On your Web page, text appears in a different color
to indicate the bookmark.

Bookmarks are particularly helpful if your page is very long. For example, if
your Web page contains minutes from several meetings, the top of the page
could list the meeting dates. You could then assign a hyperlink to each date and
a bookmark to each set of minutes. The user sees that a date is in a different
color, so clicks it to “jump” (using the bookmark) to the correct minutes.

Creating a Bookmark below describes how to set up a bookmark within a file.
You can also set up hyperlink to

n another Web page. This procedure is described in Using Hyperlinks
on page 7-61.

n a bookmark within another Web page. This procedure is described in
Creating a Hyperlink to a Location Within a Web Page on page 7-64.

Creating a Bookmark
When creating a bookmark, you must specify a

n source, the text a user clicks to move to the bookmark

n bookmark, the destination to which the cursor jumps when a user
clicks the source

To continue with the above example, a meeting date is the source, and the
meeting minutes are the bookmark.

To create a bookmark, follow these steps.

1. Select the bookmark text.

2. Click the Insert Bookmark button ( ).
3. The Hyperlink Manager dialog appears with the Bookmark Tab

selected.

4. Enter a name for the bookmark.

5. Click OK.

Using Bookmarks
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6. The editor screen redisplays. (The bookmark does not appear on the
page.)

7. Select the source text.

8. Click the Hyperlink Manager button ( ).
9. The Hyperlink Manager dialog appears with the Hyperlink tab

selected.

10. Click the down arrow below the Existing Anchor field and click the
bookmark you created in Step 4.

11. If desired, use the Target dropdown to change the destination text ‘s
window. For details, see Changing the Destination Window below.

If you leave the Target Frame field blank, the new window replaces
the current window.

12. Click OK.

Changing the Destination Window
Use the Target Frame field on the Hyperlink Manager dialog to change the
window that displays the destination page.
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Target Frame values are explained below.

If you want the destination page to appear
Click this in the Target
Frame field

In a new browser window, on top of the current browser. NewWindow

In the same position within the browser window. The new window
replaces the current one.

Same Window

Note: this is the default.

If your page contains frames, in the frame that contains the frame
with the hyperlink. Parent Window

If your page contains frames, in the full display area, replacing the
frames. Browser Window

Using Hyperlinks
Use hyperlinks to let a user “jump” from any word or phrase to another Web
page. The page can be within your network (that is, on an intranet) or
anywhere on the internet.

Note: If you want to create jumps within a content block, see Using Bookmarks on page 7-59.

For example, if your Web page should include a link to the Ektron Web site, you
would enter the text to indicate the jump (for example Ektron Web Site), then
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create a hyperlink to www.ektron.com. When users see Ektron Web Site in a
different color, they can click the text to “jump” to the site.

Although most jumps go to the top of another Web page, you can also jump to a
bookmark within a Web page.

This section also contains the following topics.

Creating a Hyperlink 7-62
Entering a Hyperlink 7-62
Creating a Hyperlink to a Location Within a Web Page 7-64
Editing a Hyperlink 7-64
Removing a Hyperlink 7-65
Preventing a URL from Becoming a Hyperlink 7-65

Creating a Hyperlink
When creating a hyperlink, you must specify a

n source, the text the user clicks to move to the destination

n destination, the Web page that appears when someone clicks the
source

To continue with the above example, Ektron Web Site is the source, and
www.ektron.com is the destination.

Entering a Hyperlink
To create a hyperlink, follow these steps.

1. Select the source text.

Note: Alternatively, you can select an image and apply a hyperlink to it.

2. Click the Hyperlink Manager button ( ). The Hyperlink dialog
appears.
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3. Click in the URL field after http://. Then, enter the address of the
destination Web page. For example, www.ektron.com.

If your version of Ektron CMS400.NET has URLs that have been entered

into the library as hyperlinks, click the ellipsis button ( ) to browse
the library and insert a hyperlink. See Also: Hyperlinks on page 8-18

4. If desired, use the Target Frame field to change the window in
which the destination text appears. For details, see Changing the
Destination Window on page 7-60.

If you leave the Target Frame field blank, the new window replaces
the current window.

5. You can enter text to appear in a small window when someone hovers
his cursor over this link. For example:

To add such text, use the Tooltip field.

6. The style of this hyperlink is normally determined by the style sheet
assigned to the content’s page template. However, if you want to
apply a special style sheet class to this link, select it from the CSS
Class dropdown.

7. Click OK.
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Creating a Hyperlink to a Location Within a
Web Page
Sometimes, the destination Web page contains bookmarks, and you want to
jump from your page to a bookmark on another page. (Bookmarks are
described in Using Bookmarks on page 7-59.)

To create a hyperlink that jumps to another page’s bookmark, follow these
steps.

1. Open a browser and your Web site.

2. Go to the Web page that contains the bookmark link.

3. Click the bookmark that you want to jump to. For example, on the
illustration below, the text Benefits to Partners jumps to a
bookmark further down the page.

4. When you click the bookmark, its full address appears in the browser
address bar. This bookmark’s address looks like this.

http://www.example.com/single.aspx?id=35#Benefits2

5. Click the address bar. The address is selected.

6. Press <Ctrl>+<C> to copy the address into the Windows clipboard.

7. Go to eWebEdit400.

8. Select the text or image from which you want to jump to the
bookmark.

9. Click the Hyperlink button ( ). The hyperlink dialog box appears.
10. Move the cursor to the Link field.

11. Press <Ctrl>+<V> to paste the address you copied in Step 4 into the
Link field.

12. Click OK.

Editing a Hyperlink
If you need to change a hyperlink’s destination Web page or target frame,
follow these steps.

1. Select the hyperlinked text.
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2. Right click your mouse.

3. Click Set Link Properties.

4. The Hyperlink Manager dialog appears.

5. Edit the fields as needed. Several fields are explained in Entering a
Hyperlink on page 7-62.

6. Press OK.

Removing a Hyperlink
If you want to remove a hyperlink from text, select the text and press the

Remove Link button ( ).

Preventing a URL from Becoming a
Hyperlink
If you enter a URL or an email address into eWebEdit400, it automatically
becomes a hyperlink. To avoid this, select the text and click the Remove Link
toolbar button ( ).

Inserting email Links
You can easily insert email links into your content. Such links provide an easy
way for your site visitors to communicate with your organization.

An email link resembles a hyperlink. But, when a site visitor clicks the link,
instead of opening a different Web page, his email application is launched.

The address and subject are retrieved from the mail link and inserted into the
user’s email screen, as shown above.

To insert an email link, follow these steps.

1. Within eWebEdit400 content, insert text that a site visitor will click to
open the email link. For example: Contact us today!

If the text does not exist yet, insert it.

2. Select the text.
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3. Click the Hyperlink Manager button ( ). The Hyperlink dialog
appears.

4. Click the E-mail tab.

5. Note that the selected text appears in the Link Text field.

6. In the Address field, enter the email address to which the message
will be sent.

7. In the Subject field, enter default text for the email’s Subject line if
desired. The user sending the mail can edit this text if desired.

8. Press OK.

Working with HTML
eWebEdit400 creates pages for display on the internet or an intranet. These
pages use HTML (hypertext markup language) to format text and images for
display in a browser. You do not need to know HTML to use eWebEdit400.

However, if you know HTML, you can view, insert or edit your Web page’s HTML
code.

This section also contains the following topics.

Viewing and Editing HTML 7-66
Adding Custom Tags to the Content’s Source 7-67

Viewing and Editing HTML
To view your page’s HTML, follow these steps.

1. Scroll to the bottom of the screen.

2. Click the HTML button (circled below).
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3. The HTML code appears, as shown below.

4. You can edit the HTML using functions like Cut, Copy, Paste, and
Delete. To access them, right click the mouse.

5. To return to normal view, click the Design button (circled below).

Adding Custom Tags to the Content’s
Source
You can insert custom tags into your content. The tags can be used to provide
all kinds of functionality, such as video/object tag support, JavaScript and .css
file support.

To insert custom tags, edit the source of your content, as explained in Viewing
and Editing HTML on previous page. Then, enter the custom tags. Here is an
example.
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Using Ektron CMS400.NET’s Wiki
Feature
The Wiki feature lets registered site visitors (that is, membership users) and
CMS users insert hyperlinks to other content. The hyperlinks can connect to
existing content or to content that doesn’t exist yet. If the hyperlink’s
destination does not yet exist, the wiki creates both the hyperlink and the new
content.

This collaborative authoring style is used in wiki sites such as Wikipedia
(http://en.wikipedia.org), where any author can contribute new content and
articles.

This section also contains the following topics.

Creating a Wiki 7-68
Using the Wiki Button 7-68
Creating a Wiki Link Using Square Brackets 7-70
Effect of Linking to Existing Content 7-70
Effect of Linking to New Content 7-71

Creating a Wiki
To create a wiki hyperlink, the user needs permission to add content to the
folder that contains the content being edited.

There are two ways to create a wiki link. They are contrasted below.

Method Advantage For more infromation, see

Surround text with square
brackets ([[ ]]) Quick Creating aWiki LinkUsing Square

Bracketson page 7-70

Use the wiki button ( )

n Can link to existing content or create new
content

n Can choose new content’s folder

Note:  Membership users cannot
choose a folder. The new content is
created in the same folder as the content
being edited.

n Can change title of new content

n Can select new window’s target frame

Using theWikiButton below

Using the Wiki Button
To create a wiki link using the wiki button, follow these steps.
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1. Begin editing a content item. (For CMS users, this is explained in
Steps in Editing HTML Content on page 7-21. For membership users,
this is explained Community Folders on page 16-110.)

2. Select the text to which you want to assign a wiki hyperlink. It can be
one or several words.

3. Click the Wiki button ( ).

Note: The Wiki button only appears if you have permission to add content to the folder that
contains the current content.

4. The Add/Edit Wiki Link screen appears. It has two tabs.

n Use the New Content tab to create new content to which you will
add information later. The new content item will appear when a site
visitor clicks the link text.

If you want to place the new content item in the folder that contains
the text you are editing, do nothing. To place new content in a
different folder, click Change and navigate to that folder.

Note: Membership users cannot assign a folder. New content is saved to the folder that
contains the source content.

You can also edit the Title and the Target Frame. To learn about
target frames, seeChanging the Destination Window on page 7-60.

n Use the Related Content tab to link to existing content. If you click
this tab, Ektron CMS400.NET uses the selected text to search your
Web site. All content with that text then appears on the screen. Each
content item’s title appears followed by its summary. Click the radio
button next to the content you want to link to.
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5. To indicate that a wiki to new content has been applied, the text color
changes to blue and bold, and small dots appear under the wiki text.

If you applied a link to related content, a regular hyperlink appears.

Creating a Wiki Link Using Square Brackets
To create a wiki link using square brackets, follow these steps.

1. Begin editing a content item. (For CMS users, this is explained
inSteps in Editing HTML Content on page 7-21. For membership users,
this is explained in Community Folders on page 16-110.)

2. Move the cursor to the left of the text to which you want to assign a
wiki hyperlink. It can be one or several words.

3. Insert two open square brackets ([[).

4. Move the cursor to the end of the text to which you want to assign a
wiki hyperlink.

5. Insert two close square brackets (]]).

6. Save the content.

Effect of Linking to Existing Content
If you link to existing content, the link is the same as quicklink.
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Effect of Linking to New Content
If you are creating new content, Ektron CMS400.NET assigns a <span> tag to
the selected text. See example below.

<Span class = "makelink">selected text here</span>

When the content is published, Ektron CMS400.NET

1. Detects the <span class = "makelink"> tag.

2. Finds text surrounded by the <span> tag.

3. Creates a new content block in the selected folder.

- its name is typically the selected text. However, if the user used the
wiki button, he can modify the new content block’s title on the Add/Edit
Wiki Link screen.

- its initial text is New Content: content for selected text. (Fill in the
topic text as you or other collaborators have time.)

4. Gets the quicklink for the newly-created content block.

5. Opens the original content and replaces the <span> tag with the
quicklink to newly-created content.

Working with Tables
Sometimes, the information on your Web page looks better when displayed on
a table. Here is an example.

City Baseball Team Hockey Team

Boston Red Sox Bruins

New York Yankees / Mets Rangers

Chicago White Sox / Cubs BlackHawks

This section also contains the following topics.

Creating a Table on next page

Modifying Table Properties on page 7-74

Deleting a Table on page 7-76

Inserting a Table within a Table on page 7-77

Choosing the Number of Rows and Columns on page 7-77

Specifying Table Width on page 7-79

Specifying Horizontal Alignment on page 7-83

Effect of Linking to New Content
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Table Backgrounds on page 7-84

Setting Table Borders on page 7-89

Section 508 Tables on page 7-92

Working with Table Cells on page 7-96

Creating a Table
When creating a table, you need to specify a number of rows and columns. A
row is a horizontal series of cells, while a column is a vertical series.

If you know how many rows and columns the table will be, enter those
numbers. If you don’t know the exact number when you create the table,
estimate how many you need. You can easily add or remove rows and columns
later.

There are two ways to create a table. If your table will be six rows by six
columns or less, use the Table Builder. See Also: Creating a Table above

If it will exceed 6 x 6, use the Table Wizard. See Also: Creating a Table above

Either way, once the table is created, you use the features described in
Modifying Table Properties on page 7-74 to add borders, background color, set
width and height, etc.

This section also contains the following topics.

Creating a Table Using the Table Builder 7-72
Creating a Table Using the Table Wizard 7-73

Creating a Table Using the Table Builder
To create a table, follow these steps.

1. Click the table button ( ).
2. Drag the cursor over rows and column to indicate the size of the

table.

The following example shows a table that is 4 rows by 5 columns.

Managing Content in Ektron CMS400.NET

7-72 ReferenceManual
Version 8.01 Rev 4



3. Click the mouse.

At this point, the table looks like this.

4. Begin entering text and images into the table cells. To further modify
the table, see Modifying Table Properties on next page.

You can also select the table and drag its right border to the right and/or down
to enlarge it for ease of use.

Creating a Table Using the Table Wizard
1. Click the table button ( ).
2. Click Table Wizard (circled below).

Creating a Table Using the TableWizard
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3. The Table Wizard dialog appears.

4. To change the number of columns or rows, click the plus or minus
signs (+ -) next to Columns and Rows.

5. The image adjusts to show the number of rows and columns.

6. Press OK.

7. Begin entering text and images into the table cells. To further modify
the table, see Modifying Table Properties below.

Modifying Table Properties
To modify a table’s properties, follow these steps.

1. Click inside the table.

2. Right click the mouse.

3. Click Set Table Properties.
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4. The Table Wizard dialog appears.

The dialog has four tabs, described below.

Tab Description For more information, see

Table
Design

Lets you

n adjust the number or row and columns

n span rowsor columns (that is, two or more
adjacent cells aremerged)

Choosing the Number of Rowsand
Columnson page 7-77

Spanning Rowsor Columnson page 7-
101

Table
Properties

Lets you set the table’s

n width

n height

n background color

n background image

n alignment

n cell spacing and padding

n Id

n css class

n border

Specifying TableWidth on page 7-79

Table Backgroundson page 7-84

Specifying HorizontalAlignment on
page 7-83

Setting Cell Padding and Spacing on
page 7-106

Setting Table Borderson page 7-89

Modifying Table Properties
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Tab Description For more information, see

Cell
Properties

Lets you set the selected cells’

n alignment

n background color

n background image

n height and width

n ID

n css class

n abbreviation

n categories

Aligning TextWithin a Cellon page 7-
103

Specifying a Cell’sBackground Color
on page 7-100

Specifying a Background Image for a
Cellon page 7-100

Specifying a Cell’sBackground Color
on page 7-100

SpanningMore thanOneRow or
Column on page 7-102

Accessibility

Lets you assign accessibility information for the
table.

n heading rowscaption

n heading columnscaption

n caption alignment

n caption

n summary

Section 508 Tableson page 7-92

Deleting a Table
To delete a table, follow these steps

Deleting a Table Using Internet Explorer
1. Move the cursor over the table until the cursor becomes a four-

headed arrow ( ).
2. Click the mouse button. The table becomes selected (small squares

appear around it).

3. Press <Delete>.
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Deleting a Table Using Firefox or Google
Chrome

1. Add a blank line above and below the table

2. Select the line above, the table, and the line below the table.

3. Press <Ctrl> + <X>.

Inserting a Table within a Table
You can insert a table within a table. You might want to do this to arrange text
in columns.

Note: HTML does not let you use tabs or spaces to align text in columns. You must use a table
to align columns. You can remove the table’s border, so that no lines appear between the
columns and rows.

To insert a table within a table, follow these steps.

1. Place the cursor in the cell into which you want to insert a table.

2. Click the Insert Table button ( ).
3. Drag the cursor over rows and column to indicate the size of the

table.

4. Click the mouse.

Choosing the Number of Rows and
Columns
Use the Table Design tab of the Table Properties box to change the number of
rows or columns in a table.
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Use the plus (+) or minus (-) signs next to Columns or Rows to adjust the
number.

Alternatively, place the cursor within the table then add or remove columns
relative to that cell. See Adding or Removing Rows and Columns below.

Adding or Removing Rows and Columns
To add or remove table rows and columns, follow these steps.

Note: You can also adjust the number of rows and columns using the Table Wizard. See Also:
Creating a Table on page 7-72.

1. Place the cursor in the cell from which you want to add or delete rows
or columns.

2. Right click the mouse. A menu appears.

Menu options relating to adding/removing rows or columns are
highlighted below.
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3. Click the appropriate menu option. For example, to add a row above
the current cursor location, click Insert Row Above.

Note: These options are also on the toolbar.

Specifying Table Width
After you create a table, you can set its width by specifying one of the
following:

n percentage of the window: the table’s width varies as a user adjusts
the browser size

n fixed number of pixels, the table’s width stays the same as a user
adjusts the browser size

You can also not set a width but instead let information you enter into the
table’s cells determine its width.

Note: To set the width of a column, adjust the width of one of the cells within the column (as
described in Specifying the Height and Width of a Cell on page 7-98). Usually, this change
affects the other cells in the column.

This section also contains the following topics.

Specifying Table Width by Percentage 7-80
Setting Table Width or Height by Percentage 7-81
Specifying Table Width or Height by Pixels 7-81
Setting Table Width by Pixels 7-82
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Specifying Table Width by Percentage
Specify table width and height by percentage if you want the table to be resized
as the user resizes the browser.

Note: In order for the table to resize with the browser, the Word Wrap attribute must be turned
on in all table cells. For details, seeWord Wrap on page 7-105.

For example, if you specify that a table is 100% wide and high, and your
browser displays 14 inches across when it is maximized, the table fills the
screen (except for the browser border).

If you resize the browser to half the screen, the table will be about 7” wide. You
still see both columns, but some of the data is moved down.
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Setting Table Width or Height by Percentage
To specify table width by percentage, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. In the Dimensions section of the Table Properties tab, specify the
percentage at theWidth or Height field. Follow the number with the
percent sign (%), as shown below.

Specifying Table Width or Height by Pixels
Specify table width or height by pixels if you want the table size to remain the
same when a user resizes the browser.
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For example, if you specify that a table is 610 pixels wide, and the user’s
browser is set to low resolution (640 x 480 pixels), the table occupies the full
width of the browser when it is maximized.

If the user resizes the browser so that it only occupies the left half of the
screen, only the left half of the table appears. A scroll bar appears at the
bottom of the browser. The user must scroll to see the rest of the table.

Setting Table Width by Pixels
To specify table width or height by pixels, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. In the Dimensions section of the Table Properties tab, enter the
number of pixels at theWidth or Height field.

Managing Content in Ektron CMS400.NET

7-82 ReferenceManual
Version 8.01 Rev 4



Specifying Horizontal Alignment
You can specify your table’s horizontal alignment (left, right, or center) within
the browser.

Alignment Example

left

right

center

If you specify right or left justify, you can wrap text around the table. To do
this, move the cursor to the right or left of the table and begin typing.

To specify table alignment, follow these steps.

1. Place the cursor within the table.

Specifying Horizontal Alignment

ReferenceManual
Version 8.01 Rev 4

7-83



2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. Specify table alignment at the Alignment field.

Table Backgrounds
You can specify a background color or image for your table.

This section also contains the following topics.

Specifying a Table’s Background Color 7-84
Deleting a Table’s Background Color 7-86
Specifying a Table Row’s Background Color 7-86
Specifying a Table’s Background Image 7-87
Deleting a Background Image 7-89

Specifying a Table’s Background Color
You can assign a background color to a table to give it more visual appeal. Here
is an example.

To assign a background color to your table, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.
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3. Select Set Table Properties.

4. Click the Table Properties tab.

5. Click the Background dropdown list.

6. A selection of colors appears. Click a color for the table’s
background.

From the dropdown, you can add custom colors by selecting a color patch or
entering a color’s hex value. Follow these steps to get help on how to use the
color box.

Note: The custom colors box is only available with Internet Explorer. If you are using Firefox or
Google Chrome, you can enter a custom color by its hexadecimal value.

1. Click the question mark in the top right corner.

2. A large question mark appears next to your cursor.

Specifying a Table’s Background Color

ReferenceManual
Version 8.01 Rev 4

7-85



3. Drag the question mark to the area of the dialog box that you want to
learn about.

4. Click the mouse button. A box appears with instructions for that area.

Deleting a Table’s Background Color
To delete a table’s background color, click the Background dropdown list on
the Table Properties tab of the Table Wizard.

Then, click the top left choice (circled above).

Specifying a Table Row’s Background Color
To assign a background color to a table row, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Cell Properties tab.

5. Within the Table Wizard dialog, hold down the <Ctrl> key while
clicking all cells in the row. In the following illustration, the second
row from the top is selected (dark gray).
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6. Click the Background dropdown list (circled above).

7. A selection of colors appears. Click a color for the table’s
background.

8. Click OK.

Specifying a Table’s Background Image
You can specify a background image for your table. Here is an example.

Specifying a Table’s Background Image
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Note that when you apply a background image to a table

n if the table is larger than the image, the image repeats until it fills the
table.

n if the image is larger than the table, the top left corner of the image
aligns with the top left corner of the table. The rest of the image fills
as much of the table as possible.

n you can also apply an image to individual cells (see Specifying a
Background Image for a Cell on page 7-100).

n make sure the image does not obscure the table’s legibility

To insert a table background image, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. In the Background Image field, click the ellipsis button ( ) to
open the Library. From there, select an image for the table’s
background. See Also: Storing Files in the Library on page 8-1

6. Click Update.
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Deleting a Background Image
1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. Select the value in the Background Image field.

6. Press <Delete>.

7. Click OK.

Setting Table Borders
A table border consists of the lines that separate a table’s cells form each
other, and the table from the rest of your Web page. There are two types of
table borders.

Border type
Used by this type
of user

Illustration

internal content author

external site visitor

This section also contains the following topics.

Assigning an Internal Table Border 7-89
Assigning External Table Border Attributes 7-90
Assigning Table Border Color 7-90
Assigning Border Size 7-90
Determining Which Table Border Lines Appear 7-91

Assigning an Internal Table Border
A table’s internal border is either on or off. You cannot specify other attributes.

To turn a table’s internal border off or on, follow these steps.

Note: If the table’s border is on, these steps turn it off. If it is off, they turn it on.

1. Place the cursor inside the table.

2. Right click the mouse.
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3. Click Show/Hide border.

Assigning External Table Border Attributes
You can modify these external border attributes

n color - see Assigning Table Border Color below

n size (thickness) - see Assigning Border Size below

n line selection - see Determining Which Table Border Lines Appear on
the facing page

Assigning Table Border Color
This section explains how to change the color of a table’s border (see example
below).

To assign the color of your table’s border, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. Click the Border Color drop down (circled below).

6. A color selection box appears. Click a color to apply to the table’s
border.

Assigning Border Size
You can also adjust the size of a table border. Size is measured in pixels.
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The border size only adjusts a table’s exterior border - it has no effect on the
border between cells.

To assign a border size to your table, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. Enter a number of pixels into the Border field (circled below).

If you set a table’s border size to zero (0) but wish to view boundary lines while
editing, see Assigning an Internal Table Border on page 7-89.

Determining Which Table Border Lines Appear
You may want to suppress some table borders. For example, the table below
only shows horizontal lines.

To modify which border lines appear, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Table Properties.

4. Click the Table Properties tab.

5. Use the icons within the Border area to indicate which border lines
should appear. Each icon has tooltip text that explains its function.

DeterminingWhich Table Border Lines Appear
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Note: In order to view the selected borders on the dialog, a border color must be assigned.
See Assigning Table Border Color on page 7-90.

Note that if a table already has border lines but you want to start “fresh,” it is a
good idea to remove all borders using the icons indicated below. Then, you can
begin adding new ones.

Section 508 Tables
You can apply the following information to any table to make it 508 compliant.
Narrative software uses the information from the Accessibility table fields
(heading rows, columns, caption alignment and summary) to produce a Tooltip
message for each table cell. Users with impaired vision can see those Tooltips
as they hover over the cells.

Information Where applied For more information, see

Heading Rows Accessibility dialog AccessibilityDialog on page 7-94

Heading Columns Accessibility dialog AccessibilityDialog on page 7-94

Summary Accessibility dialog AccessibilityDialog on page 7-94
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Information Where applied For more information, see

Caption Accessibility dialog AccessibilityDialog on next page

HorizontalCaption
Alignment Accessibility dialog AccessibilityDialog on next page

VerticalCaption Alignment Accessibility dialog AccessibilityDialog on next page

Abbreviation Cell properties
dialog

Accessibility Fields on Cell PropertiesDialog on page
7-96

Categories Cell properties
dialog

Accessibility Fields on Cell PropertiesDialog on page
7-96

This section also contains the following topics.

Creating a 508 Compliant Table 7-93
Accessibility Dialog 7-94
Setting Abbreviation and Category Attributes 7-95
Accessibility Fields on Cell Properties Dialog 7-96

Creating a 508 Compliant Table
To create a 508 compliant table, follow these steps.

1. Create a new table or edit an existing one, as explained in Creating a
Table on page 7-72.

2. Place the cursor inside the table.

3. Right click the mouse.

4. Click Set Table Properties.

5. The Table Properties dialog appears.

6. Click the Accessibility tab.

Creating a 508 Compliant Table
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n Accessibility Dialog below

n Setting Abbreviation and Category Attributes on the facing page

Accessibility Dialog
The fields on the tab are described below.

Field Description

Heading
Rows

If you want your table to have a horizontal header, enter the number of rows that it should
occupy. The number cannot exceed five.

Beginning with the top, all cells in the specified number of rowsare designated as table headers.

Heading
Columns

If you want your table to have a header, enter the number of columns that it should occupy. The
number cannot exceed three.

Beginning with the left column, all cells in the specified number of columnsare designated as
table headers.
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Field Description

Caption
Alignment

To choose the caption’s alignment, click the down arrow next to this field as shown below.

Click the box that represents the alignment style you want.

Caption If desired, enter a table caption. The caption appears above the table. The caption’s alignment is
set in theCaption Alignment field.

Summary

If desired, enter the table summary. Non-visual browsers use the summary to explain the table’s
contents.

From http://www.w3.org/TR/WCAG10-HTML-TECHS/#data-tables

“A summaryof the relationshipsamong cells is especially important for tableswith nested
headings, cells that spanmultiple columnsor rows, or other relationships that maynot be
obvious from analyzing the structure of the table but that maybe apparent in a visual rendering
of the table. A summarymayalso describe how the table fits into the context of the current
document. If no caption is provided, it is evenmore critical to provide a summary.”

Associate
Cellswith
Headers

Check this box if you want to associate the table’s data cellswith the appropriate headers. See
Also: http://www.w3.org/TR/WCAG20-TECHS/H43.html

After you complete the Table Properties dialog, click OK to make the table
Section 508 compliant.

Setting Abbreviation and Category Attributes
You can modify abbreviation (ABBR) and category (AXIS) attributes within a
table. To do so, follow these steps.

1. Select one or more cells.

2. Right click the mouse.

3. Select Set Cell Properties.

4. The Cell Properties dialog appears. It includes the Abbreviation and
Categories fields (see illustration below).

Setting Abbreviation and Category Attributes
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The following explains how to respond to these fields.

Accessibility Fields on Cell Properties Dialog

Field Description

Abbreviation

Sets or retrievesabbreviated text for the content in the tag. Can be used to render non-visual
media, such as speech or Braille.

For more information, seehttp://msdn2.microsoft.com/en-
us/library/ms533058.aspx

Categories
Sets or retrievesa comma-delimited list of conceptual categories associated with that tag.
Can be used to render non-visualmedia, such as speech or Braille.

For more information, see http://msdn2.microsoft.com/en-us/library/ms533489.aspx

Working with Table Cells
Along with functions for managing tables (described inWorking with Tables on
page 7-71), eWebEdit400 also lets you perform actions on individual cells within
a table.

You can perform the following actions on individual table cells.

n Specifying the Height and Width of a Cell on page 7-98

n Deleting a Cell on page 7-99

n Specifying a Cell’s Background Color on page 7-100

n Specifying a Background Image for a Cell on page 7-100

n Spanning Rows or Columns on page 7-101

n Aligning Text Within a Cell on page 7-103
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n Splitting a Cell on page 7-104

n Merging Two Cells on page 7-105

n Word Wrap on page 7-105

n Setting Cell Padding and Spacing on page 7-106

Note: HTML does not allow you to adjust the width of a cell’s border.

You can also select several cells or a row of cells and change them as described
above. However, you cannot select and change a column of cells.

Selecting Cells to Modify
n Modifying a Single Cell below

n Modifying Several Cells below

Modifying a Single Cell
To make modifications described in this section to a single cell, follow these
steps.

1. Place the cursor in that cell.

2. Right click the mouse.

3. Select Set Cell Properties from the menu.

4. Make the changes on the Cell Properties dialog.

5. Click Update.

Modifying Several Cells
If you want to make any of the modifications described in this section to
several cells, follow these steps.

Note: Most procedures in this section tell you to select Cell Properties from the right click
menu. To perform an action on several cells, select Set Table Properties from the right click
menu, then click the Cell Properties tab.

1. Place the cursor anywhere in the table.

2. Right click the mouse.

3. Select Set Table Properties from the menu.

4. Click the Cell Properties tab.

5. Select the cells that you want to change. Hold down the <Ctrl> key
while selecting.

As you select a cell, its color changes from light to dark gray.

Selecting Cells to Modify
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6. Make changes to fields on the lower part of the Cell Properties tab.
The fields are described later in this section.

7. Click OK.

Specifying the Height and Width of a Cell
As described in Specifying Table Width on page 7-79, there are several ways to
set the width of a table. Within a table, you can also specify the height and
width of an individual cell.

When you set a cell width, there is no guarantee that the cell will occupy that
width when displayed in a browser. This is because the cell is part of a column,
and changes to other cells in the column can affect the cell whose width you set.
Setting cell width only guarantees that the cell will not be less than the width
you specify.

If you want to ensure that a cell’s size does not change, set all cells in a column
to that width.

To specify a cell’s height and width, follow these steps.

1. Place the cursor in the cell whose height or width you want to set.

2. Right click the mouse.

3. Click Set Cell Properties from the menu.

4. Click Cell Properties from the menu.

5. The Cell Properties dialog appears.
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6. Enter the cell width and height in the fields circled above. You can
enter the width in pixels or percentage. These choices are explained
in Table Backgrounds on page 7-84.

7. Click Update.

Deleting a Cell
To delete one or more cells, follow these steps.

1. Move the cursor to the cell you want to delete.

2. Right click the mouse.

3. Click Delete Cell from the menu.

Cells to the right of the deleted cell shift left to occupy the vacant space. In this
example, the cursor was in cell “b” when the user clicked on Delete Cells.

Before

After

Deleting a Cell
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Specifying a Cell’s Background Color
Specifying a Table’s Background Color on page 7-84 explains how to apply a
background color to a table. You can also apply a background color to a cell.

To apply a background color to a cell, follow these steps.

1. Move the cursor to the cell.

2. Right click the mouse.

3. Click Set Cell Properties.

4. Click the Background dropdown.

5. A color selection box appears.

6. Click a color to apply to the cell’s background.

Deleting a Cell’s Background Color
To delete a cell’s background color, click the square in the top left corner of the
Background area (circled below).

Specifying a Background Image for a Cell
Specifying a Table’s Background Image on page 7-87 explains how to apply a
background image to a table. You can also apply a background image to a cell.

To insert an image into a cell, follow these steps.

1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Cell Properties.
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4. In the Background Image field, click the ellipsis button ( ) to
open the Library. From there, select an image for the cell’s
background. See Also: Storing Files in the Library on page 8-1

5. Click Update.

Note that when you apply a background image to a cell

n If the cell is larger than the image, the image repeats until it fills the
cell.

n If the cell is smaller than the image, the top left corner of the image
appears in the top left corner of the cell. The rest of the image fills as
much of the cell as possible.

n Make sure the image does not obscure a user’s ability to read the cell
text (if any exists).

Deleting a Background Image
1. Place the cursor within the table.

2. Right click the mouse.

3. Select Set Cell Properties.

4. Delete the value in the Background Image field.

5. Click Update.

Spanning Rows or Columns
You can create a table cell that stretches across more than one row or column.
In the following table, notice how the “Sports Teams” row spans three columns.

Sports Teams

City Baseball Team Hockey Team

Boston Red Sox Bruins

New York Yankees Rangers

Chicago White Sox BlackHawks

You can also create a column that spans several rows, as illustrated below.
Notice that Boston spans three rows.

Deleting a Background Image
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Colleges

City Name

Boston

Boston College

Northeastern University

Boston University

New York Columbia University

This section also contains the following topics.

Spanning More than One Row or Column 7-102
Effect of Spanning a Cell 7-103

Spanning More than One Row or Column
To have a table cell span more than one row or column, follow these steps.

1. Place the cursor in the cell that will span rows or columns.

2. Right click the mouse.

3. Click Merge Cells Horizontally or Merge Cells Vertically from
the menu.

n Merge Cells Horizontally merges the cell in which the cursor
resides with the cell to its right.

n Merge Cells Vertically merges the cell in which the cursor resides
with the cell below.

Note: You can also merge cells on the Table Design tab of the Table Wizard.
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Effect of Spanning a Cell
When you set a cell to span rows or columns, eWebEdit400 does not remove the
cells that are in the way. Instead, it moves those cells across or down to the
next available position.

For example, the following table has two rows and two columns.

If you set cell A to span two rows, note that cell C moves across to make room
for cell A. This action pushes cell D to the next column.

Aligning Text Within a Cell
Within a cell, you can specify how your text aligns horizontally and vertically.

Effect of Spanning a Cell
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You have nine choices for specifying the horizontal and vertical alignment of a
cell, illustrated below.

To set cell alignment, follow these steps.

1. Place the cursor in the cell that you want to edit.

2. Right click the mouse.

3. Click Set Cell Properties.

4. The Cell Properties dialog appears.

5. Click the down arrow to the right of Content Alignment.

6. Click your alignment choice.

7. Click Update.

Splitting a Cell
You can divide a cell into two. If you split a cell, each cell occupies one half the
size of the original cell.

Row before split

Row after split

To split a table cell into two cells, follow these steps.

1. Place the cursor in the cell that you want to split.

2. Right click the mouse.

3. Click Split Cell from the menu.
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4. Two cells now appear where only one appeared before.

Merging Two Cells
You can merge two cells into one. If you merge two cells, the new cell contains
all of the information from both. The new cell’s width or height equals the sum
of the two cells that were merged.

Cells Before Merge

Cell After Merge

The above example shows a horizontal merge. You can also merge cells
vertically.

To merge two or more cells, follow these steps.

1. Place the cursor in the left or upper cell.

2. Right click the mouse.

3. Click Merge Cells Horizontally or Merge Cells Vertically.

Word Wrap
Word Wrap is a text formatting feature of cells. It causes text to move down to
the next line when the width of the characters on a line equals the column

Merging TwoCells
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width. For example, if you set column width to 50%, with word wrap turned on,
a table looks like this.

If you turn Word Wrap off for the same table, you get this result.

If Word Wrap is turned off, text stays on one line until the user entering table
text presses <Enter>. That keystroke causes text to move down to the next
line.

By default, all cells have the Word Wrap feature turned on.

Turning Word Wrap On and Off
To turn Word Wrap on or off for a cell, follow these steps.

1. Place the cursor in the cell that you want to edit.

2. Right click the mouse.

3. Click Set Cell Properties.

4. The Cell Properties dialog box appears.

5. To turn off Word Wrap, click the No Wrapping checkbox.

6. Click Update.

Setting Cell Padding and Spacing
Cell padding is the space between a cell’s data and its border.
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Cell spacing is the space between a cell and surrounding cells.

Assigning Cell Padding and Spacing
To assign cell padding and spacing to your table, follow these steps.

1. Place the cursor in the table.

2. Right click the mouse.

3. Click Set Table Properties.

4. The Table Properties dialog appears.

5. Click the Table Properties tab.

6. In the Cell Padding and Cell Spacing fields, enter the number of
pixels.

7. Click Update.
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Translating Content to
Another Language
Note: The following procedure only works with HTML or XML content. You cannot translate
other file types as described below.

Use this procedure when you want to initialize a new foreign language content
item with content from a source language. This copying should facilitate the
translation.

For example, an editor is translating content from French to German. The editor
copies the French edition to new content whose language is German. As the
editor translates the French edition into German, he deletes the French content.
Any images in the content would usually remain, and all formatting (tables,
bullets, etc.) is retained.

Note: Ektron CMS400.NET also has a Language Export feature copies content into XLIFF files
for submission to a translation agency. For more information, see Using the Language Export
Feature on page 14-14.

To copy content into new content block of a different language, follow these
steps.

1. Go to the View Content screen for the content you want to translate.
See Also: Viewing Content on page 7-9

2. Use the Add: dropdown list in the upper right corner to select the
language into which you want to translate the content.

3. The Edit Content screen appears with original language content.

4. Translate into the new language then delete the original content.

If desired, you can click the Translate button ( ). If you do, a new
screen prompts you to identify the original language, new language, and
a glossary. Then, the content is translated. If you like the translation,
click Paste Content, and the translated content replaces the original.

Once the translated content is inserted into the editor, you can edit it as
needed.

5. Edit the content's title, Summary, Metadata, etc. as needed.
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6. When you save the content, it is saved as the edition of that content
in the selected language. It has the same ID number as the original
content but a different language identifier.

Translating Content to Another Language
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Moving or Copying Content
You canmove content from a folder to another folder. Or, you can copy content
between folders. At the end of both procedures, the copied or moved content
resides in the new folder. Moved content retains the original ID number, while
copied content gets the next available ID number.

When copying, you leave the content in its original folder, while moving deletes
the content from the original folder. Other than that difference, the procedure
for performing both actions is virtually identical.

This section also contains the following topics.

Steps for Moving or Copying Content 7-110
How Folder Types Affect Copying/Moving Content 7-112
Who Can Move or Copy Content 7-112
Only Approved Items Can Be Moved and Copied 7-113
How Workflow Affects Status of Moved/Copied Content 7-113
What is Moved Or Copied? 7-113

Steps for Moving or Copying Content
To move or copy content between folders, follow these steps.

1. Navigate to the folder that contains the content you want to move or
copy.

2. Select content to be moved/copied by placing the cursor near the
language column and clicking the mouse.

To select several items, hold down the <Ctrl> key and while clicking. The
background color changes to indicate that items are selected.

3. Right click the mouse. The menu circled below appears.
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4. Click Cut or Copy.

Alternatively, you can click Action > Cut or Copy.

Cut removes content from this folder. Both Cut and Copy
place a copy of the content into the memory buffer, where it
can be pasted into another folder

5. In the left panel of the Workarea, navigate to the folder to which you
want to paste the selected content.

6. Right click the mouse

7. Click Paste Content.

8. If you are copying, the following question appears.

Steps for Moving or Copying Content

ReferenceManual
Version 8.01 Rev 4

7-111



You can copy the content in only the languages you selected, or in all
languages that the content exists in the source folder. Click you choice.

If you are moving, the following confirmation appears. When moving,
you must move the content in all languages in which it exists in the
source folder. Click your choice.

9. The content is moved or copied to the destination folder.

How Folder Types Affect
Copying/Moving Content
You can only move/copy content between two regular folders or between two
eCommerce catalog folders. You cannot move or copy from or to other folder
types. See Also: Folder Types on page 4-3

If you copy an eCommerce catalog entry whose product type is not assigned to
the destination catalog folder, the new product type gets assigned to the folder.
See Also: Product Types on page 17-103

Who Can Move or Copy Content
n a user with Add, Edit and Delete permissions for the source and

destination folders

n a user is a member of a group with those permissions

n members of the Administrators user group

n users assigned in the Roles > Folder Specific > Folder User Admins
screen

n users assigned in the Roles > Folder Specific > Move or Copy screen

See Also: Defining Roles on page 15-31; Guidelines for Using the Folder-User
Admin Role on page 15-35; Folder Permissions on page 4-40
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Only Approved Items Can Be Moved and
Copied
Your can only move or copy content in the Approved status. If you select
several content items and only some are Approved, you see this message.

Only the Approved items are moved/copied.

How Workflow Affects Status of
Moved/Copied Content
If a destination folder has an approval chain, the moved/copied content's status
changed to Submitted unless the person performing the move/copy is the last
person on the approval chain. In this case, its status is set to Approved.

Note: The folder's Approval Method can affect the status of the moved/coped content. See
Also: The Approval Method on page 4-39

If the destination folder does not have an approval chain, the moved/copied
content's status remains Approved.

What is Moved Or Copied?
When content is moved or copied, the following changes are made.

n The content inherits permissions, the approval chain, and the default
template from the new folder

n The content’s Quicklink is moved or copied in the library to the
destination folder. However, the Quicklink remains the same (that is,
the default template doesn’t change). You can update this by editing
the Quicklink. This procedure in Updating Default Template for
Multiple Quicklinks on page 8-22.

Note: If the Link Management setting in the web.config file is set to true, you do not need to
update the quicklink. Link Management automatically finds the correct template based on the
current folder.

Only Approved ItemsCan BeMoved and Copied
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n If the new folder already contains content with the same title, Ektron
CMS400.NET appends a number to the title to make it unique. For
example: ASP.NET Unleashed(2).

n Library image paths inside the content remain the same

n If a destination folder has required metadata that the pasted content
lacks, the paste action is not affected. But, the next time a user edits
that content, he must complete the required metadata before he can
save the edits.

n If the content’s template is a Smart Form, it remains assigned even if
the Smart Form is not assigned to the new folder
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Viewing and Restoring
Previous Content
You can view and restore past versions of published content unless your system
administrator purged them. Your ability to restore a previous version of a
content item is determined by the Restore folder permission. See Also: Folder
Permissions on page 4-40

After viewing previous versions of content, and comparing any two versions,
authorized users can replace the current version with any previous one.

Note: The Purge History feature deletes historical versions of content according to user-
defined criteria. Therefore, some previous versions may be unavailable. See Also: Purge
History on page 4-26

This section also contains the following topics.

Accessing Content History 7-115
The Content History Window 7-116
Comparing Versions of Content 7-118
Restoring a Previous Version 7-125
Removing Applied XSLT 7-125

Accessing Content History
By default, all users can view the history of Ektron CMS400.NET content. You
can access content history from two places:

n The Workarea’s View Content page

n A Web page

Once you access the history, the functionality is identical.

The following sections explains how to access the content history from both
places.

Accessing the Content History from the
Workarea
To access content history from the Workarea, follow these steps.

1. Navigate to the View Content page for the content whose history you
want to view.

2. Click the item whose history you want to view.

3. The View Content Screen appears.

Viewing and Restoring PreviousContent
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4. Click the View History button ( ).

Accessing the Content History from a Web
Page
To access the content history from a Web page, follow these steps.

1. Sign in.

2. Browse to the content whose history you want to view.

3. Open the Content Menu. See Also: The Web Site Content Menu on
page 7-4

4. Click the View History menu option.

5. The Content History window opens.

The Content History Window

The View Content History window lists every version of the content available in
Ektron CMS400.NET. The window displays the following information for each
version.

n version number See Also: The Content Version Number on the facing
page
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n a green circle indicates a version that was published. Versions
without a green circle indicate content that was checked-in but not
published.

n date and time version was checked in or published

n title of content

n last user who edited content

n comments entered by user to describe nature of changes made

To view any version, click its title. When you do, the Content History window
appears for that content.

This section also contains the following topics.

The Content Version Number 7-117
The Detail History Window 7-117

The Content Version Number
Ektron CMS400.NET assigns a unique number to each saved version of a
content block. The number is increased by one tenth if the content is checked in
but not published. If the content is published, the next whole number is
assigned.

For example, if the current version is 1.0 and you check in that content, the
new version is 1.1. If the next editor publishes it, the new version is 2.0.

If content versions are purged, the numbering scheme restarts with the
remaining content.

The Detail History Window
After viewing the View Content History window, you can click any version to
see the detail for it. The detailed History window has two sides:

n The left side redisplays information from the content history window.
See Also: The Content History Window on previous page

n The right side displays the selected version of the content. After
viewing a version of content, you can perform these actions on it.

Action Button Description More Information

View Difference Compare historical version to current
version

Comparing Versionsof
Content on next page

Restore Restore historical version of content Restoring a Previous
Version on page 7-125

TheContent Version Number
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Action Button Description More Information

Remove XSLT

XML Content
Only

Remove XSLT applied to XML content Removing Applied XSLT
on page 7-125

Comparing Versions of Content
There are two versions of this procedure. Consult your system administrator to
determine the correct procedure for you.

If the Ektron
CMS400.NET server
is

And your
client is

See

32 bit 32 bit The View Content Difference Screen below

64 bit 32 bit

The View Content Difference Feature on page 7-120

Note: This procedure was the only one prior to 7.5.2. It
downloadsan ActiveX control to your computer.

64 bit 64 bit The View Content Difference feature is not available

This section also contains the following topics.

The View Content Difference Screen 7-118
When Can I Compare Content? 7-119
Accessing the View Content Difference Feature 7-119
The View Content Difference Feature 7-120
When Can I Compare Content? 7-120
The Compare Content Window 7-121
Toolbar 7-121
Setup 7-122
Content Area 7-123
View Tabs 7-124
First Use of the View Content Difference Feature 7-124

The View Content Difference Screen
Note: Use this procedure if both your computer and the Ektron CMS400.NET server are 32 bit.

The View Content Difference screen highlights changes to selected content.
Below is an example of the View Content Difference screen, showing the default
tab, Difference.
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Each tab is explained below.

Tab Shows this content

Difference

Both versions:

n content that only appears in the version on the This Content tab is highlighted in yellow

n content that only appears in the currently published version is red

n unchanged content is black

Last Published Currently-published.

ThisContent The version you are comparing the currently-published content against.

Note: If there is no difference between the versions, you see Content is Identical.

When Can I Compare Content?
The View Content Difference feature is available when

n you are viewing a version of content

n a staged version of that content is available (See Also: Staged
Content on page 7-136)

Accessing the View Content Difference
Feature
To Access the View Content Difference feature, follow these steps.

1. Navigate to the content whose versions you want to compare.

2. Click View Properties.

WhenCan I Compare Content?
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3. Click the History button ( ). The View Content History screen
appears. See Also: Comparing Versions of Content on page 7-118

4. Click a version that you want to compare with the most recently
published version.

5. Click the View Content Difference toolbar button ( ).

The View Content Difference Feature
Note: Use this procedure if your computer is 32 bit, and the Ektron CMS400.NET server is 64
bit.

The View Content Difference feature highlights changes that were made to
selected content. Below is an example of the View Content Difference screen,
showing two versions of content. The changes are indicated by

n redlining deleted content

n highlighting in yellow added content

Within the View Content Difference feature, you can perform several tasks, as
well as view different versions of the content separately, or compared.

The View Content Difference feature is explained through the following topics:

n When Can I Compare Content? on previous page

n The Compare Content Window on the facing page

n First Use of the View Content Difference Feature on page 7-124

When Can I Compare Content?
The View Content Difference feature is only available when

n you are viewing an historical version of content

n a staged version of the content is available (See Also: Staged Content
on page 7-136)
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The following table explains when you can use the feature, and which versions
are compared.

Content Status Compares current published version with

Published Historical version stored in the content history area

Checked-In Most recently checked-in version

Submitted Submitted version

Pending Start Date Scheduled version pending start date

CheckedOut Not available

If content can be compared with another version, the View Difference button (
) appears in the content history area or the Web page view.

The Compare Content Window
Note: The first time the View Content Difference feature is opened, a simple installation
program runs. See Also: First Use of the View Content Difference Feature on page 7-124.

The Compare Content window consists of the following:

n Toolbar below

n Content Area on page 7-123

n View Tabs on page 7-124

Each area is explained below.

Toolbar
The content comparison toolbar has five buttons, explained below.

TheCompare ContentWindow
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Button Name Description

Print

Sends content to local or network printer.

Note: This option prints the currently displayed content, whether it is the
compared, published, or staged content.

Save

Savesa copy in HTML format on your localmachine or network.When saved
asa physical file, the HTMLmaybe edited. However, the changesare not
saved to theWeb Server.

Note: The save option saves the version of the content you are viewing.

Setup
Opens setup dialog box to configure the settings. Typically, only an
administrator would use this.

For more information, seeSetup below.

Help Displaysadditional information about the compare feature.

Exit Closes the window.

Setup

Click the Setup button ( ) to open the setup dialog box. Typically, a system
administrator would edit these settings.

You can change the setup options to better suit your needs. The following table
explains each option.
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Option Description

CompareOptions

Compare visual aspect Compares content as it would appear on aWeb page.

Compare source code Displays compared content as source HTML.

WhitespaceOptions

Ignore All Blank (whitespace) characters are ignored.

Smart Detect
One or more consecutive whitespace characters are treated asa
single separation sequence. That is, multiple whitespace characters
are ignored.

Detect All Blank (whitespace) characters are treated asanyother character.

Other Options

Ignore Case
Determineswhether comparison is case sensitive. For example, if you
check this box, the strings “Bob” and “BOB” are not highlighted
because their only difference is the case of the characters.

Ignore Format Attributes Determineswhether comparison ignores changes in text-formatting
attributes (HTMLVisualAnalysis only).

After updating setup information, click OK to save changes.

Content Area
The content area displays the content comparison.

The following table describes the change indicators.

Content Area
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Symbol Example Content state

Plain black text Unchanged

Yellow highlighted text Added

Red, struck-through text Deleted

View Tabs
When viewing content in the View Content Difference feature, there are three
view modes, explained below.

View Description

Diff Comparespublished version of content to staged version

Published Displays currently published version

Staged Displays the staged version of content. See Also:Staged Content on page
7-136

To switch between views, click the corresponding View tab.

First Use of the View Content Difference
Feature
The first time the View Content Difference screen is used on a client machine, a
simple installation program is performed.

Click Yes when the following screen appears.
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When the installation program completes, close and reopen the View Content
Difference feature.

Actions are explained below.

Restoring a Previous Version
Note: The ability to restore content is a permission granted by the system administrator. If you
do not see a Restore button ( ) on the View Content History screen, you do not have
permission to do so.

1. Open the content folder that contains the content.

2. Click the content item.

3. Click the History toolbar button ( ).
4. Select an historical version of the content that you want to restore.

5. Click the Restore button ( ).
6. The content history window closes, and you return to the View

Content page or the Web page, with the content in a checked in
status.

7. If desired, check out the content to make additional changes.

8. Select the workflow to perform on the content.

9. When the historical version is placed in the approval chain and
approved, it is published to the Web site.

Removing Applied XSLT
You can only remove an applied XSLT when viewing historical versions of XML
content. If you remove the applied XSLT, you can view the content without the

Restoring a Previous Version
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irrelevant XML tags.

The following table compares the views.

With XSLT

Without XSLT
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Deleting Content
Note: The ability to delete content is a permission granted by the system administrator. If you
do not see a Delete option on the View Contents of Folder screen, you do not have permission
to do so.

Note: It is good practice to check for broken quicklinks before deleting content. See Link
Checking on page 7-129.

The Delete command lets you permanently delete obsolete content from your
Web site.

There are two ways to delete content.

n A folder-level Delete option ( ) removes several content
items from the current folder. This option only deletes Approved
content. For more information, see Deleting Several Content Items
in a Folder on next page.

n Depending on the content’s status and your permissions, you may be
able to delete one item at a time. The options for doing so are

- a Delete option when viewing content from a Web page

- a Delete menu option that appears after selecting content on the View
Contents of Folder screen

For more information, see Deleting a Single Content Item below.

Like publishing, deleted content must proceed through the approval chain
before it is removed. If you are the last approver in the approval chain, the
content is deleted immediately. See Also: Approve/Decline Content on page 4-
33

Deleting a Single Content Item
To delete one content item, follow these steps.

This section also contains the following topics.

Deleting One Content Item from a Web Page 7-127
Deleting One Content Item from the Workarea 7-128

Deleting One Content Item from a Web Page
To delete content from a Web page, follow these steps.

1. Sign in.

2. Browse to the content you want to delete.

Deleting Content
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3. Open the Content Menu. See Also: The Web Site Content Menu on
page 7-4

4. Click the Delete menu option.

5. The View Content screen for the selected content appears. (See
Viewing Content on page 7-9.)

6. Click the Delete button ( ).

7. A confirmation message appears.

8. Click OK to delete the content.

Deleting One Content Item from the
Workarea

1. Access the View Contents of Folder screen for the content you want to
delete, as described in Viewing Content on page 7-9.

2. Hover the cursor over the triangle ( ).
3. Select Delete from the dropdown menu.

Note: If you do not see Delete, either you lack permission to delete the content, or its status
makes it ineligible for deleting.

4. A confirmation message appears.

5. Click OK to delete the content.

Deleting Several Content Items in a
Folder
On the View Contents of Folder screen, you can delete several Approved content
items at once. To do so, follow these steps.

Note: If you are working with an eCommerce catalog entry, you can only delete it if it is not on
an order nor checked out.

1. Navigate to the folder that contains the Approved content you want to
delete.

2. Hover the cursor over the Delete menu ( ).
3. Select Content from the dropdown menu.
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Alternatively, you can hover the cursor over the folder, right click the mouse,
and select Delete Content from folder name.

4. Check boxes next to Approved content items you want to delete.

Note: Check the box in the header cell to select all or deselect all.

5. Click the Delete Content button ( ).

6. A confirmation message appears.

7. Click OK to continue.

Link Checking
The link checker button locates all content with a link to the displayed content.
This feature is useful if you decide to delete content. You can use this to remove
links that will not work after the deletion.

1. Access the View Content screen for the content you want to execute
the link checker for, as described in Viewing Content on page 7-9.

2. Click the Link Search button ( ).
3. A screen displays each content item with a link to the current content.

4. Click the content title to access the View Content screen for the
selected content.

5. Remove or change the Quicklink.

Link Checking
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Content Statuses
The table below lists all content statuses. The rest of this section explains each
status in more detail.

Letter Meaning Content state
More
Information

A Approved Through the workflow and published on the
Web site.

Approved
Content below

O Checked Out Currently being edited. Hasnot been checked
in.

CheckedOut
Content on
page 7-133

I Checked In Checked in for other users to edit.
Checked-In
Content on
page 7-132

S Submitted for
Approval

Saved and submitted into the approval chain.

See Also:ApprovalChainson page 4-27

Submitted
Content on
page 7-134

M Marked for Deletion Requested for deletion.

Marked for
Deletion
Content on
page 7-135

P Pending Go Live Date Approved but the Go Live date hasn’t occurred
yet.

Pending Start
Date Content
on page 7-136

T Awaiting Completion
of Associated Tasks

Task(s) assigned to content are not complete

D Pending Deletion

Content was created with a future start date
then checked in and deleted.

This statusonly remainsuntil the start date is
reached. At that point, the content is deleted.

Approved Content
Approved content is live on the Web site. The Web page dropdown menu
(illustrated below) lists actions you can perform on the content.
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When content is approved, you can perform the following actions on it,
depending on your permissions.

Button
Dropdown
Menu Option

Description For more information, see

Checkout and
Save as

Check content out and save on your
computer

CheckingOut, Saving, and
Replacing anOffice
Document on page 7-423

Save as Save copyof file to your computer Saving anOffice Document
on page 7-424

Edit or Edit in
Office Checkout the content to change it

n Editing Content from a
Web Page on page 7-21

n Edit in Context on page 7-
22

n Edit Option on page 7-23

n Editing Content from the
Workarea on page 7-24

Edit Properties Edit content’s summary, metadata, schedule,
comment, etc.

n Working with Content
Summaryon page 7-137

n Working with Metadata on
page 7-141

n Scheduling Content to
Begin and End on page 7-187

View, View in
Office, or View
Properties

View all information about content Viewing Content from the
Workarea on page 7-9

Approved Content
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Button
Dropdown
Menu Option

Description For more information, see

Delete

Submit a request to delete the content. If you
are the last or only approver, the content is
immediately deleted.

See Also:Example of an ApprovalChain on
page 4-35

Deleting Content on page 7-
127

Checked-In Content
A checked-in content item is one to which changes were made, after which it
was checked in instead of being submitted or published. When content is
checked in, all users who have permission to edit it can check it out and change
it.

Keep in mind that the content seen on the template is not the same as the
content in the editor view.

Options you may perform on checked-in content are described below.

Button Name Description For more information, see

Checkout and Save as Check content out and save on
your computer

CheckingOut, Saving, and
Replacing anOffice
Document on page 7-423

Save as Save copyof file to your
computer

Saving anOffice Document
on page 7-424

Edit or Edit in Office Checkout the content to
change it.

n Editing Content from a
Web Page on page 7-21

n Edit in Context on page 7-
22

n Edit Option on page 7-23

n Editing Content from the
Workarea on page 7-24

Edit Properties
Edit content’s summary,
metadata, schedule, comment,
etc.

n Working with Content
Summaryon page 7-137

n Working with Metadata on
page 7-141

n Scheduling Content to
Begin and End on page 7-
187
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Button Name Description For more information, see

View, View in Office, or
View Properties

View all information about
content

Viewing Content from the
Workarea on page 7-9

Delete

Submit a request to delete the
content. If you are the last or
only approver, the content is
immediately deleted.

See Also:Example of an
ApprovalChain on page 4-35

Deleting Content on page 7-
127

Submit/Publish

Submit content into approval
chain.

If you are last approver in the
approval chain, the publish
button/option appears. If you
click it, the content is
immediately posted toWeb site.

ApprovalChainson page 4-
27

Checked Out Content
While content is in checked out status, other users are prevented from editing
it. The content remains checked out until it is checked in by the user who
checked it out or a system administrator. Only the user who checked out
content can edit it.

Each option you may perform on checked-out content is described below.

Button Name Description
For more
information, see

Check In Check in content. Only appears to user who
checked content out.

Check in on page 4-
10

Force Check In

Only appears if user is amember of the
Administrator group and content is checked out.

Allows the admin to check in content even though
he is not the one who checked it out.

Request Check
In

Allowsanyuser to send an email to the user who
checked out content. The email asks the check-out
user to check in the content.

CheckedOut Content
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Button Name Description
For more
information, see

Save as Save copyof file to your computer
Saving anOffice
Document on page
7-424

Edit or Edit in
Office

Checkout content to change it. (Only available to
user who checked content out.)

n Steps in Editing
HTMLContent on
page 7-21

n Editing a
Managed File on
page 7-430

n Editing anOffice
Document on page
7-420

Edit Properties Edit content’s summary, metadata, schedule,
comment, etc.

View, View in
Office, or View
Properties

View all information about content
Viewing Content
from theWorkarea
on page 7-9

Submitted Content
Once a user submits content into the approval chain, no other user can check it
out. The content remains in this status until it is published or declined.

See Also: Example of an Approval Chain on page 4-35

Each toolbar button is described below.

Button Name Description

Approve

Approve and publish the content to theWeb site.

Note: Only the last approver in the chain has this option.

See Also:Example of an ApprovalChain on page 4-35
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Button Name Description

Decline

Refuse to publish the submitted content, and change its status to checked-in.

Note: Onlymembersof the approval chain have this option.

This button rejects the changesand keeps the current version live onWeb site.
The approver is prompted to enter a reason for the decline. After the decline
option is completed

n The author whomade the change is notified byemail

n The content is removed from the ApprovalChain

If an author updated content then submitted it for approval, the updated
content remains in the file. If you do not want it to remain, choose theEdit
option.

Edit

Checkout the content and edit it. Only the user who submitted the content has
this option.

Note: If you edit the content, you need to resubmit it to the approval chain.

View, View in
Office, or View
Properties

View all information about content

Marked for Deletion Content
Content that is marked for deletion has been requested to be removed from the
Web site by a user. When content is marked for deletion, it passes through the
approval chain like content that is submitted for publishing. When the content
completes the approval chain, it is deleted from the Web site.

See Also: Example of an Approval Chain on page 4-35

The table below describes the toolbar buttons for content in this status.

Button Name Description

Delete

Approve the deletion request.

Note: If you are the last user in the approval chain, the content is deleted
when you click this.

Decline Refuse the deletion request. This sends the content back into a checked-in
status.

Save As...

(for assets
only)

Save copyof file to your computer. See Also:Saving anOffice Document on page
7-424

Marked for Deletion Content
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Button Name Description

View View information about content

Pending Start Date Content
Content that is pending a start date has been approved, but its start date and
time have not occurred yet.

Button Name Description

Edit

Checkout the content and edit it. Only the user who submitted the
content has this option.

Note: If you edit the content, you need to resubmit it to the
approval chain.

View, View in Office, or View
Properties View all information about content

Staged Content
A staged version of content is one that is not published. It can be content that is
checked in, or content that is approved with a pending a start date.

Staging lets you make changes to content, while keeping it from the Web site
until you are ready to publish it.

See Also: After selecting content, you may have the following options. on page
7-11; Content Statuses on page 7-130;Workflow in Ektron CMS400.NET on page
2-5
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Content Properties
This section explains the properties of Ektron CMS400.NET content, such as the
summary, metadata, and the ability to schedule start and end dates.

This section also contains the following topics.

Working with Content Summary 7-137
Automatic Creation of a Summary 7-138
Creating a Summary for New Content 7-139
Creating a Summary for Existing Content 7-139
Editing a Summary 7-140
Working with Metadata 7-141
Types of Metadata 7-141
Meta Tags 7-142
Title Tag 7-143
Searchable Metadata 7-145
Related Content Metadata 7-146
Simple Dublin Core Metadata 7-149
Working with Metadata Definitions 7-150
Assigning a Metadata Image to Content 7-165
MetaData Server Control 7-165
MetaDataList Server Control 7-169
Creating/Updating Templates 7-178
Private Content 7-184
Making a Folder Private 7-185
Making Content Private 7-186
Making Assets Private 7-186
Scheduling Content to Begin and End 7-187
Setting a Start Date 7-188
Setting an End Date on Content 7-190
Setting Archive Options 7-191
Viewing Archived Content 7-193

Working with Content Summary
A content summary is a short description that supplements the title when
several content items appear on a Web page. A good example is a news Web
site, which lists titles and summaries of top stories (illustrated below)
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TOP STORIES
Ektron Named aRising Star (08-15-2010)
August 15, 2010, Nashua, New Hampshire, USA — Ektron, Inc., an
innovator in Web content management and authoring, has been
named a Rising Star as part of the prestigious New England
Technology Fast 50 Program.

Ektron Launches InternationalDistribution Program (08-08-2009)
August 8, 2009, Nashua, New Hampshire, USA — Ektron, Inc., an
innovator in dynamic Web content authoring and management
with over 350,000 users, today announced the launch of its
international distribution program.

Like content, summaries can include images as well as various font styles and
sizes.

You create a summary when creating or editing content. Then, your Web site
developer can create Web pages that display just the title and summary to
attract readers to the full story.

This chapter explains how to create summaries. Your system administrator
determines how and where to display summaries on your site.

See Also:

n Automatic Creation of a Summary below

n Creating a Summary for New Content on the facing page

n Creating a Summary for Existing Content on the facing page

n Editing a Summary on page 7-140

n ListSummary Server Control on page 9-266

Automatic Creation of a Summary
Ektron CMS400.NET automatically generates a summary for new content if none
exists. To do this, it checks the summary when new content is first published. If
the summary is blank, Ektron CMS400.NET copies the first 40 words of the
content to the summary.

After the content is published, you can update or delete the summary. If it is
deleted, the summary remains blank and is never again automatically
generated for that content item.

You can disable this feature in Ektron CMS400.NET if desired. See
http://dev.ektron.com/kb_article.aspx?id=30107

Membership User Summary Editing
If a membership user edits content and wants to update the summary, he can
automatically copy the first 40 words of the content into the summary. To do
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this, the user checks the Auto Generate New Summary field on the
membership editing screen (shown below).

There is no limit on the number of times a membership user can automatically
generate a new summary.

Creating a Summary for New Content
1. Navigate to the folder in which you want to create the content.

2. Click New then pick the content type from the dropdown menu.

3. The Add Content screen appears.

4. Insert a Title and content. See Also: Adding HTML Content on page 7-
15

5. Click the Summary tab.

6. Enter summary information for the content. The summary can
include images, files, and hyperlinks. Its length can be restricted by
your system administrator in the configuration setup file.

7. When done, click the appropriate button.

Creating a Summary for Existing Content
1. Navigate to the folder that contains the content.

Creating a Summary for New Content
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2. Hover the cursor over the content, click the triangle ( ), and select
Edit or Edit Properties from the dropdown menu.

3. The View Content screen appears.

4. Click the Summary tab to enter or edit summary information for the
content. The summary can include images, files, and hyperlinks. Its
length can be restricted by your system administrator in the
configuration setup screen.

5. When done, click the appropriate button.

6. The View Content page reappears.

Note:When you enter or edit existing content’s summary, its status changes to checked out.
After you create the summary, click the Check-In button to check the content in. From that point,
you need to submit or publish it.

Editing a Summary
Note: You can only edit the summary of content that is published, checked in, or checked out
by you.

To edit a content’s summary, follow these steps.

1. Access the View Content page for the content whose summary you
want to edit, as described in Viewing Content on page 7-9.

2. Click the Summary tab.

3. The Edit Summary window opens.

4. Click the Edit button. The summary opens within the editor.

5. Make the necessary changes.

6. When done, click the appropriate button.

7. The View Content page reappears.

Note:When you edit an existing content summary, it goes into a checked out state. After
creating the summary, check the content back in. From that point, you must submit it or publish
it.
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Working with Metadata
Metadata is information about a content item, such as its title and language.
Ektron CMS400.NET provides extensive and flexible support for metadata,
which it uses in both standard and innovative ways.

This section explains the types of metadata available, and procedures for
working with metadata through the following subtopics.

n Types of Metadata below

n Meta Tags on next page

n Title Tag on page 7-143

n Searchable Metadata on page 7-145

n Related Content Metadata on page 7-146

n Simple Dublin Core Metadata on page 7-149

n Working with Metadata Definitions on page 7-150

n Assigning a Metadata Image to Content on page 7-165

n MetaData Server Control on page 7-165

n MetaDataList Server Control on page 7-169

Types of Metadata
The following kinds of metadata can be added to Ektron CMS400.NET content.

Metadata
type

Description
For more
information,
see

Meta tag Resides in a content item’s source code, helping search engines find it. Meta Tagson
next page

HTML tag
Information about the content used byaWeb browser. For example,
<title> identifies the content in the screen title, favorites list, and
browser history.

Title Tag on page
7-143

Searchable
Metadata that can be found byEktron CMS400.NET’s search.

This kind of metadata can also be found using theWorkarea Search
screen.

Searchable
Metadata on
page 7-145;

Searching for
Metadata on
page 9-56
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Metadata
type

Description
For more
information,
see

Related
content

A related content item, collection, List Summary, or library item that
accompaniesa content item on aWeb page.

Related Content
Metadata on
page 7-146

Simple Dublin
Core

A set of fifteen standard fields that cover themost useful information
about content.

Simple Dublin
CoreMetadata
on page 7-149

Content tags Keywords that can be assigned to content and library itemsand allows
for tag-based searching.

”Tags” on page
16-280

Image Not part of ametadata definition; automatically appears for every
content item and lets you assign an image to that content

Assigning a
Metadata Image
to Content on
page 7-165

Best Practices
n When anyone createsa newMetadata definition, it is assigned the next available
ID number. The ID numbersdetermine the order in whichmetadata definitionsare
arranged on the Folder Properties screen’sMetadata tab.

So, byplanning ahead, you can enter metadata definitions in logical groupings, which
willmake it more intuitive for the person assigning themetadata to pick the correct
ones.

n Metadata can be used asa search criterion to find content on your Web site. In
order for this to work, themetadata definition name cannot include a space. So, it is a
good idea to eliminate spaces frommetadata definition names.

Meta Tags
The META element is an extensible container for use in identifying specialized
document meta-information. Meta-information has two main functions:

n to provide a means to discover that a data set exists and how it might
be obtained or accessed

n to document the content, quality, and features of a data set,
indicating its fitness for use

(Above copied from www.w3.org/MarkUp/html-spec/html-spec_5.html.)

Example Meta Tags
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Creating and Deploying Meta Tag Definitions
1. While creating a metadata definition, enter the metadata name at the

Name field. For example, Description and Keywords. See Also:
Adding a Metadata Definition on page 7-151

2. Reply to the standard fields. See Metadata Definition Fields on page
7-153.

3. Respond to the additional fields for meta tags. See Meta Tag
Additional Fields on page 7-153

4. Add the definition to all applicable folders. See Assigning Metadata to
a Folder on page 7-159

5. Add the definition to applicable content within the folder. See Adding
Metadata to Content on page 7-161

6. Add a Metadata server control to every Web form (.aspx page) on
which the content will appear. See MetaData Server Control on page
7-165.

Title Tag
The title should identify the contents of the document in a global context. A
browser may display the title of a document in a history list or as a label for the
window displaying the document.

(Above text copied from www.w3.org/MarkUp/html-spec/html-spec_5.html.)
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This section also contains the following topics.

Creating and Deploying Title Tag Definitions 7-144
Creating and Deploying Search Tag Definitions 7-144

Creating and Deploying Title Tag Definitions
1. While creating a metadata definition, enter Title at the Name field.

See Also: Adding a Metadata Definition on page 7-151

2. Reply to the standard fields. See Metadata Definition Fields on page
7-153.

3. Respond to the additional field for HTML tags. See HTML Tag
Additional Field on page 7-153.

4. Add the definition to a folder. See Assigning Metadata to a Folder on
page 7-159.

5. Add the definition to content within the folder. See Adding Metadata to
Content on page 7-161.

6. Add a metadata control to every Web form (.aspx page) on which this
content will appear. See MetaData Server Control on page 7-165.

Creating and Deploying Search Tag
Definitions

1. While creating a metadata definition, in the Name field, enter a
description of the kind of data to be searched. (See examples circled
above.) This title describes the search data on the

n Metadata tab of the Folder Properties screen

n Metadata tab of the View Content Screen

n Workarea search screen

Note: Searchable metadata field names should not include a space. If they do, the search
cannot find the metadata.

See Also: Adding a Metadata Definition on page 7-151

2. Reply to the standard fields. See Metadata Definition Fields on page
7-153.

3. Respond to additional fields for Searchable Property definitions. See
Searchable Additional Fields on page 7-155.

4. Add the definition to a folder. See Assigning Metadata to a Folder on
page 7-159.

5. Add the definition to content within the folder. See Adding Metadata to
Content on page 7-161.

6. The next time you visit the Workarea search screen, you will see the
new field.
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7. If you want site visitors to use this field when searching your Web
site, ask your developer to set the ShowExtendedSearch property of
the Search Server Control to true. This value enables the Web site
search to find searchable metadata.

Searchable Metadata
This type of metadata allows content to be found by a search phrase that you
add to the content’s metadata. The content is typically found by both a Web site
search as well as a Workarea search.

Note:When your system administrator sets up metadata, he determines whether or not is it
“publicly viewable.”
If it is, the search field appears on the search screen that site visitors use along with the search
screen in the Ektron CMS400.NETWorkarea. If the data is not publicly viewable, it can only be
found by the Workarea search.

For example, each document stored in the Document Management functionality
has a unique part number. You want to let site visitors and Ektron CMS400.NET
users locate the document by its part number.

First, your system administrator would add a custom metadata definition called
Part Number, and specifies that only numbers can be inserted into the field.
Then, he adds that metadata definition to all folders that contain the
documents. Finally, when you add a document, you click its Metadata tab, and
insert the part number for the document (illustrated below).
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Then, anyone visiting your Web site can find that document by its part number
using your Web site’s search screen.

See Also: Searching for Metadata on page 9-56

Related Content Metadata
You can associate the following types of content with a content item.

n another content item

n a collection

n a list summary

n a menu

n a user

n one of the following types of library items

- image

- hyperlink

- file

Next, you can set up a Web page so that whenever the source content item
appears, the related information appears next to it.

For example, your Web site sells motorcycle helmets. On a page that shows a
particular helmet, the left column lists a collection of motorcycle drivers who
wear that helmet. Another example might show the profile of a user when a
certain content item is displayed.

This section also contains the following topics.

Related Content vs. MetadataList Server Control 7-146
Creating and Deploying Related Content Definitions 7-147

Related Content vs. MetadataList Server
Control
This capability is similar to the MetadataList Server control. The difference is
that MetadataList shows a link to every content item with a selected term in the
keywords or title. Also, a MetadataList is associated with a Web form (.aspx
page), not a content item.

Related content lets you connect a content item with several types of related
content (see list above), and is associated with a content item, not a web form.
For example, you can display a library image of the company logo on a page
whenever content in a certain folder appears. For content in a different folder, a
different logo could appear.
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Creating and Deploying Related Content
Definitions

1. While creating a metadata definition, in the Name field, enter a title
for this kind of data. This title describes the metadata on the

n Metadata tab of the Folder Properties screen

n Metadata tab of the View Content screen

See Also: Adding a Metadata Definition on page 7-151

2. Reply to the standard fields. See Metadata Definition Fields on page
7-153.

The Type must end with the word Selector. Choices are highlighted
below.

For example, if you choose ListSummary Selector, a specified List
Summary will appear on the page along with its associated content
item.

Your choices are

n Collection Selector

n ListSummary Selector

n Content Selector

n Image Selector (associates a library image with content)

n Hyperlink Selector (associates a library hyperlink with content)

n File Selector (associates a library file with content)

n Menu Selector

n User Selector
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3. Add the metadata definition to all appropriate folders. See Also:
Assigning Metadata to a Folder on page 7-159

4. For each content item with which you want to associate related
content, access its Metadata tab and identify the related item(s).

Warning! If you are using Collection Selector type, only users with permission to work with
collections can select a collection. Also, if you are using Image, Hyperlink or File Selector type,
only users with permission at least read-only Library permissions can select a library item. See
Also: Folder Permissions on page 4-40.

For example, a collection of pages describes popular books. You want
this collection to appear whenever a medical topic is being viewed.

To set this up, you would

- edit the medical content item

- click its Metadata tab

- find the metadata definition for the collection

- click Change

- select the Popular Books

5. Have your Web developer add code to each page on which the related
item appears. To learn how to do this, access the developer sample
page
(http://localhost/cms400developer/developer/default.aspx)
and read the Metadata > Meta Associations description.

Note: To download the developer sample site, go to
http://www.ektron.com/solutions/startersites/.
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Simple Dublin Core Metadata
Simple Dublin Core is a set of fifteen standard names for metadata fields
designed to cover the most useful items of information on a document. From
the Dublin Core site FAQ: “Dublin Core metadata provides card catalog-like
definitions for defining the properties of objects for Web-based resource
discovery systems.” For more information, refer to the Usage
Guide:http://www.dublincore.org/documents/usageguide/.

By using the Metadata Server Control, you automatically create seven of the
fifteen Dublin Core metadata fields. These fields are automatically filled with
the information from the equivalent Ektron CMS400.NET property. Below is a
list of the seven fields and their Ektron CMS400.NET equivalent. For more
information on the Metadata Server Control, see MetaData Server Control on
page 7-165.

Dublin Core Field Name Ektron CMS400.NET Property

DC.title Content block title

DC.description Plain text version of a content summary

DC.contributor Content block last editor name

DC.date Content block last edit date

DC.format “text/html”

DC.identifier URL of current page (from ASP.NET Server.Request
object)

DC.language CMS language cookie / current site language, expressed
asa .NET System.Globalization Culture Name

Creating the Additional Eight Fields
To fully comply with the Simple Dublin Core metadata element set, the
administrator must create the remaining eight Dublin Core fields as standard
Ektron CMS400.NET Metadata definitions and apply them to all Ektron
CMS400.NET folders. Next, CMS users complete the appropriate values for each
content block.

Warning!When creating the Dublin Core metadata fields in the Metadata section of the
Workarea, you do not need to create the first seven fields in the table above. In addition, the
names of the fields you create must match the names below. For example, in the name field,
enter “DC.subject”. The DC identifies the metadata as Dublin Core metadata.

The remaining eight Simple Dublin Core fields are described below:
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Note: These descriptions are from the Dublin Core Metadata Initiative site. For a more detailed
description, visit http://www.dublincore.org.

n DC.subject - The topic of the content of the resource. Typically, a
Subject is expressed as keywords, key phrases, or classification
codes that describe the topic of the resource.

n DC.type - The nature or genre of the content of the resource. Type
includes terms describing general categories, functions, genres, or
aggregation levels for content.

n DC.source - A reference to a resource from which the present
resource is derived. For example, DC.source=”Image from page 54
of the 1922 edition of Romeo and Juliet”

n DC.relation - A reference to a related resource.

n DC.coverage - The extent or scope of the content of the resource.
Coverage typically includes spatial location (a place name or
geographic co-ordinates), temporal period (a period label, date, or
date range) or jurisdiction (such as a named administrative entity).
Examples: DC.coverage=”1995-1996”, DC.coverage=”Boston, MA”,
DC.coverage=”17th century” or DC.coverage=”Upstate New York”.

n DC.creator - An entity primarily responsible for making the content
of the resource.

n DC.publisher - The entity responsible for making the resource
available.

n DC.rights - Information about rights held in and over the resource.
Typically, a Rights element contains a rights management statement
for the resource, or reference a service providing such information.

Working with Metadata Definitions
Note: Only members of the Administrator User Group and those defined in the Manage
Members for Role: Metadata-Admin screen can view, add, or edit metadata definitions. See
Also: Using the Roles Screens on page 15-31

This section also contains the following topics.

Adding a Metadata Definition 7-151
Metadata Definition Fields 7-153
HTML Tag Additional Field 7-153
Meta Tag Additional Fields 7-153
Searchable Additional Fields 7-155
Select from a List 7-156
Multiple Selections 7-156
Converting the Style of a Metadata Definition 7-156
Viewing Metadata Definitions 7-158
Editing a Metadata Definition 7-158
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What Happens When a Metadata Definition is Edited? 7-158
Deleting a Metadata Definition 7-159
Assigning Metadata to a Folder 7-159
Requiring Users to Enter Metadata 7-160
Effect of a Default Value on Required Metadata 7-160
Inheritance of Metadata by Folder 7-161
Adding Metadata to Content 7-161

Adding a Metadata Definition
Use the Add Metadata Properties screen to define metadata (such as keywords
and title). You can define as many instances of metadata as you wish.

If your site supports multiple languages, you create metadata definitions for
each supported language.

See Also:Working with Metadata on page 7-141

To define a metadata definition, follow these steps.

Warning! After creating a definition, you must assign it to folders whose content should use it.
You do this via the folder’s properties. See Assigning Metadata to a Folder on page 7-159.

1. From the Workarea’s left frame, click Settings > Configuration >
Metadata Definition.

2. The View Metadata Definitions screen appears.

3. Select the language for the metadata you are about to define. This
metadata will be available only to content in this language.

4. Click the Add Metadata Definition button ( ).
5. The Add Metadata Definition screen appears. Using the following

table, add the needed information.
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After you create a metadata definition, you may see the following error in the
Windows Event Viewer Log.

To learn more about this problem and how to resolve it, see the following
Microsoft KB article: http://support.microsoft.com/kb/310680.
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Metadata Definition Fields

Field Description

Name

Enter a name to identify thismetadata.

Note: Searchablemetadata field namesshould not include a space. If theydo, the search
cannot find themetadata.

Ektron CMS400.NET reservesa list of names that you cannot use. If you enter one of them, the
following error message appearswhen you try to save the definition.

Type

From the drop-down list, select whether this tag is

n a searchable property - See Also:Searchable Additional Fieldson page 7-155

n an HTML tag (for example, <title>) - See Also:HTML Tag Additional Field below and
Related Content Metadata on page 7-146

n aMeta tag (<meta>) - See Also:Meta Tag Additional Fieldsbelow andRelated Content
Metadata on page 7-146

n Collection Selector, ListSummarySelector, Content Selector, Image selector, Hyperlink
Selector, File Selector - See Also:Related Content Metadata on page 7-146

Editable
Check this box if you want to allow users to edit the contents of themetadata when creating or
editing themetadata.

Uncheck this box if you want uniformmetadata text for each content item that uses thismetadata.

HTML Tag Additional Field
See Also: Related Content Metadata on page 7-146

Field Description

Default
Text

Enter default content for the HTML tag. For example:

content="document management web content management content management
cms"

Meta Tag Additional Fields
Note: For background information about metadata, see http://www.w3.org/TR/REC-
html40/struct/global.html#edef-META.

See Also: Related Content Metadata on page 7-146
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Field Description

Style

Select from the drop-down list to indicate whether you want the style to be name or http-
equiv.

For more information, see http://www.w3c.org/TR/REC-html40/struct/global.html#h-
7.4.4.2

Remove
Duplicates Check this box to remove duplicate wordsor phrases from themetadata.

Case
Sensitive Check this box to remove duplicatesonly if the letters and case of each letter match.

Separator Enter a character to separate themetadata values. The default is a semicolon (;).

Selectable
Metadata

Check this box to force users to select from the options specified in theAllow Selectable
Text andDefault Text fields.

If you do not check this box, users can create their ownmetadata.

Allow Multiple
Selections

Check this box to let users select multiple metadata values instead of one. If multiple values
are allowed, use the separator character to delimit them.

If this box is not checked, all valuesappears in a drop-down list, and the user selects the
correct one.

This field is only active if theSelectable Metadata box is checked.

Allowed
Selectable
Text

Enter standardmetadata that can be selected byusers. Separate each option by the
separator specified for themetadata definition.

This field is only active if theSelectable Metadata box is checked.

Default Text Enter default content for themetadata tag.
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Searchable Additional Fields

Field Description

Publicly
Viewable

If you check the box, site visitors can find themetadata value when searching your Web site.
Otherwise, site visitors cannot find themetadata value.

Note: Regardlessof whether this is checked, thismetadata value can be found using the
Workarea’sSearch Content Folder screen. Only logged-in users can access theWorkarea.

Style

Select the style of the response field from these choices (available in a dropdown list). You are
specifying the kind of information that a user adding searchable properties to content will enter to
describe the data. Later, anyone using the search can search on that information.

See Also:AssigningMetadata to a Folder on page 7-159

n Text - The user enters free text to describe the content.

n Number - The user enters a number to describe the content.

n Byte - 1 byte. 0 through 255 (unsigned)

n Double - 8 bytes. -1.79769313486231570E+308 through -4.94065645841246544E-324 †
for negative values; 4.94065645841246544E-324 through 1.79769313486231570E+308 † for
positive values

n Float - (single-precision floating-point) 4 bytes. -3.4028235E+38 through -1.401298E-45 †
for negative values; 1.401298E-45 through 3.4028235E+38 † for positive values

n Integer - 4 bytes. -2,147,483,648 through 2,147,483,647 (signed)

n Long - 8 bytes. -9,223,372,036,854,775,808 through 9,223,372,036,854,775,807
(9.2...E+18 †) (signed)

n Short - 2 bytes. -32,768 through 32,767 (signed)

n Date - The user enters a date to describe the content.

n Yes or No - The user answers yesor no to describe the content. For example, if the content
describesautomobile parts, the user could answer yes to include new and used parts or no to
search for new parts only.

n Select from a list - The user picksa from a list to describe the content.

For an illustration of this style on the Edit Content screen/Searchable Properties tab and theWeb
site search screen, seeSelect from a List on next page.

n Multiple selections - The user selects an item from a dropdown list.

For an illustration of this style on the Edit Content screen/Searchable Properties tab and theWeb
site search screen, seeMultiple Selectionson next page.

See Also:Converting the Style of aMetadata Definition on next page

Default

If desired, enter themost common response to this definition.

The default value is automatically applied to all existing content within folders to which this
definition is assigned.

While editing content that uses this definition, a user can accept the default value or change it.

See Also:Effect of a Default Value on RequiredMetadata on page 7-160
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Select from a List
Appearance on Edit Content Screen > Metadata Tab

Multiple Selections
Appearance on Edit Content Screen > Metadata Tab

Converting the Style of a Metadata Definition
This section explains how Ektron CMS400.NET handles changing the style of a
searchable property type of metadata. For example, you create a definition to
collect Part Number. Originally, the style is text, but you later decide its style
should be number.

When you change the style of searchable property type metadata, Ektron
CMS400.NET attempts to maintain any data stored in content blocks that use the
definition. For example, if the data style was number and you change it to text,
the number stored for that metadata definition is converted to text and
maintained in all content that uses it.

However, sometimes Ektron CMS400.NET cannot maintain the data when you
change the style. For example, if you change a metadata definition style from
number to date, Ektron CMS400.NET cannot convert those styles. In this case,
any data stored in metadata definitions is lost.
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The following table illustrates all conversion scenarios and how Ektron
CMS400.NET handles each one. It indicates whether data is maintained after
you convert from a data style in the left column to a style to its right.

Text Number Date Boolean Single Select Multiple Select

Text - OK OK NO NO NO

Number OK - NO NO NO NO

Date OK NO - NO NO NO

Boolean OK NO NO - NO NO

Single Select OK NO NO NO - OK

Multiple Select OK NO NO NO NO -

Table legend

n OK - Data is maintained

n NO - Data is lost during conversion

When you change the style of a metadata definition, the screen often gives you
these choices:

n Use existing data if possible, else default

n Use default value

Following these choices is a field that lets you define a default value. If you
want to simply replace any existing data, select Use default value and enter
the new value in the Default field.
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If the data is convertible (according to the table above), and you want to
maintain existing data if possible, select Use existing data if possible, else
default. Then, enter a default value below. If the existing data cannot be
maintained, the default value replaces it.

Viewing Metadata Definitions
You may view any metadata definition. To do so, follow these steps.

1. From the Workarea’s left frame, click Settings > Configuration >
Metadata Definition.

2. The View Metadata Definitions screen appears.

3. Select a language from the drop-down list.

4. Click the Metadata definition you want to view.

5. The View Metadata Definition screen appears. From here, you can
edit and delete this definition.

See Also: Metadata Definition Fields on page 7-153

Editing a Metadata Definition
Note: You cannot edit the definition for the following Ektron standard metadata: MapLatitude,
MapLongitude, MapAddress, MapDate

To edit a metadata definition, follow these steps.

1. Access the View Metadata Definition screen whose definition you want
to edit, as described in Viewing Metadata Definitions above.

2. Click the Edit button ( ).
3. The Edit Metadata Definition screen is displayed.

4. Make the necessary changes to the definition.

See Also: Metadata Definition Fields on page 7-153

5. Click the Update button ( ).

What Happens When a Metadata Definition is
Edited?
If you create a metadata definition, assign it to a folder, then users insert
metadata information into their content, the collected information takes on the
characteristics of the metadata definition. For example, if the metadata is title
and its type is HTML tag, this is how it appears in the Web page’s source code.

<title>CMS Developer</title>

If you later change its type to Meta, the following effects occur:

n metadata to which the definition has already been assignedmaintains
the previous style definition. For example, <title>CMS Developer</title>.
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n when you create a new content item that uses the metadata
definition, its metadata takes on the new style. For example, <meta
name="title" content="CMS developer">.

Deleting a Metadata Definition
You can remove metadata definitions that are no longer used from the Ektron
CMS400.NET site. When you delete a definition, it is removed from every
content item that uses it.

To delete a definition, follow these steps.

1. Access the View Metadata Definition screen for the definition, as
described in Viewing Metadata Definitions on previous page.

2. Click the Delete button ( ).

3. A confirmation message is displayed.

4. Click OK.

5. Another confirmation message is displayed.

6. Click OK.

Assigning Metadata to a Folder
After creating a metadata definition (see Adding a Metadata Definition on page
7-151), assign it to folders whose content will use it.

On each folder’s properties screen, you determine which metadata definitions
can be used.The section of the folder properties screen used to assign metadata
appears below. Only metadata definitions whose Assigned box is checked can
be completed by users working with content in the folder.

See Also:Working with Metadata on page 7-141

Then, while creating or updating content, the user can insert the metadata
information via the Metadata tab (illustrated below).
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Requiring Users to Enter Metadata
You can determine that a metadata value must be inserted before content can
be saved (see the Required checkboxes in the illustration above). This occurs
both when new content is added and existing content is edited.

If you set a kind of metadata to be required, its label is red and includes an
asterisk (*) on the Metadata tab of the Edit Content screen, as shown below.

If the user does not complete a required metadata field, a message informs him
that it must be completed before he can save the content.

Effect of a Default Value on Required Metadata
A default value can be defined when creating or editing a field within a
metadata definition. See Also: Adding a Metadata Definition on page 7-151

If a default value is defined for a required metadata field, the default value is
used when the user saves the content. In this case, the user is not prompted to
enter a value because the default value is sufficient.
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Inheritance of Metadata by Folder
Each folder can inherit metadata fields from its parent folder or have a unique
set of them. The information includes the kinds of metadata that are assigned
and which of those are required. For example, you could assign the top folder
(Content) all metadata definitions, while you assign the Contacts folder
(directly below it) none.

On every folder’s Metadata tab, use the Inherit Parent Configuration
check box (illustrated below) to determine if metadata definitions are the same
as the parent folder or unique.

By default, Inherit Parent Configuration is checked, which means that all
folders inherit metadata definitions from the root folder (Content).

When you uncheck Inherit Parent Configuration, you can change the
settings as desired. All inherited values appear by default (that is, Assigned
and Required boxes are either checked or unchecked).

Adding Metadata to Content
When a user creates or updates content, he can define its metadata within the
assignments specified for its folder. Default metadata values are applied
without user intervention.

To enter or edit content’s metadata, follow these steps.

Warning! You may only edit metadata of content that is published, checked in, or checked out by
you.

1. Access the Edit Content screen for the content whose metadata you
want to enter or edit, as described in Editing HTML Content on page 7-
20.

2. Click the Metadata tab.
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3. The Edit Metadata screen opens with the current metadata displayed.
In order to add metadata to content, an administrator must have
created definitions for it in the language of the content.

Note: Your system administrator determines the appearance of the Metadata screen.

4. Edit the metadata. Note that

n Required field labels are red and marked with an asterisk (*). You
must place at least one response in such fields before you can save
the metadata.

n Your system administrator may prevent you from editing a field. In
this case, the field has a gray background, and you cannot place the
cursor there.

n Fields may appear in two columns. In this case, the system
administrator provides a list of terms that you can apply to the
content. You can select terms from the list or enter free text.

One column is labeled Not Included and the other Included. Move
terms between lists by clicking the Add and Remove buttons.
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n You may see a list of terms in one box, and a field labeled Text
above it.

With such a list, you can

- add a new term by typing it into the Text field and clicking

- remove any term by selecting it and clicking Remove

- modify any term by selecting it. It appears within the Text field,
where you can change it. Then, press the Edit button.

- restore the terms to their default settings by pressing the Default
button

- change the sequence of terms by selecting one then pressing the up

and down arrows ( )

n If related contentmetadata is available for the content, its name
appears followed by None Selected (ID) Change Clear.

Click Change to display a window of choices. For example, if the
related content type is a collection, all collections appear in the
popup. Select the appropriate data for this content.

Selected items appear in the bottom of the screen. You can reorder
them by selecting an item then clicking the up and down arrows. To
remove items from the bottom of the screen, select them and click
the delete ( ) button.
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If the related content type is either content item or library image,
hyperlink, or file, the following window appears when you click
Change.

Use this screen to identify the related content. To do this,

- Select a folder from the left frame

- Double click the related-content item from the top right frame

- The item appears in the lower right frame

- When all items are in the lower right frame, click the Save button ( )
directly below Select Metadata

n If default metadata is defined for a specific data type, you can click
the Default button at the bottom of each field to restore it.

n Below each field is a Characters Left field, which counts the
number of metadata characters. You cannot exceed the maximum
(500 characters).

5. Click the Save button ( ).
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6. The View Content screen reappears.

The content is now in a checked out state to you. For the changes to take effect
on the Web site, check in the content and submit it to the approval chain. See
Also: Approval Chains on page 4-27

Assigning a Metadata Image to Content
You can assign an image to any content item’s metadata. It is a standard field
automatically available to every content item. It is not a definition in the
Metadata fields.

Use the Image field to identify an image that can be retrieved by Ektron
Markup Language’s (EKML) [$Image] and [$ImageThumbnail] variables. See
Also: Controlling Output with Ektron Markup Language on page 26-1.

An example of using Image data is a list summary that includes a photo of
every item on the list. For example, your site promotes a soccer team. The list
summary shows every player on the team. To the left of each player’s name is
a thumbnail of his image.

MetaData Server Control
The Metadata server control lets you add the metadata from content blocks to a
Web page. This lets developers add metadata quickly without having to type it
in. You can add metadata from a single content block, multiple content blocks,
or by dynamically passing a content ID from a URL.

This section also contains the following topics.

MetaData Server Control vs. MetaDataList Server Control 7-165
MetaData Server Control Properties 7-166
Using the Simple Dublin Core Metadata Standard 7-167
Using the MetaData Server Control 7-168

MetaData Server Control vs. MetaDataList
Server Control
With the MetaData server control, you add metadata from content blocks to
your Web page. With the MetaDataList server control, you create a list of
content blocks to display on your site, based on the Metadata in each content
block. For Information on the MetaDataList server control, see MetaDataList
Server Control on page 7-169.
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MetaData Server Control Properties
The Metadata server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it
to browse to Content, Collections, etc. See Also:Using CMS
Explorer to Browse Your Ektron CMS400.NET Site on page
24-8

String

CacheInterval

Sets the amount of time the server control’s data is cached. The
default is 0 (zero). This is the amount of time, in seconds, a
control’s data is cached. For example, if you want to cache the
data for fiveminutes, set this property to 300 (three hundred).
See Also:Caching with Server Controlson page 24-33

Double

DefaultContentID

The content block ID fromwhich the server control gets the
metadata.

If you want to addmetadata from several content blocks, set this
property to 0 (zero) and use theDefaultItemList
property to identify the content blocks.

If you don’t know the ID number of the content block, use the
CMSExplorer to browse to it. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

Long

DefaultItemList

A bracket separated list of content block IDs fromwhich to get
metadata. The DefaultContentID propertymust be set to 0
(zero) to add IDs to the list.

You can also specifymetadata keys for each content block. To
assignmetadata keys to a content ID, add a semicolon after the
ID and add the name of the key. For example,

This allowsyou to select whichmetadata for each content block
is added to the page.

String
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Property Value
Data
Type

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if
you want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes
shown.

Boolean

DynamicParameter Gets or sets the QueryString parameter to read a content ID
dynamically. String

GenerateDublinCore

When enabled, this property automatically creates seven of the
Simple Dublin Coremetadata fields from standard Ektron
CMS400.NET system properties. The default is false.

True =Generate Simple Dublin Coremetadata fields

False =Do not generate Simple Dublin Coremetadata fields

The seven fields and how theyare associated with the Ektron
CMS400.NET properties is explained inUsing the Simple
Dublin CoreMetadata Standard below

Boolean

Hide

Used to hide aMetadata server control in design time and run
time.

True =HideMetadata server control

False =ShowMetadata server control

boolean

Language
Set a language for viewing form content. This property shows
results in design-time (in VisualStudio) and at run-time (in a
browser).

Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.
The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of
an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to
a blockof code.

Custom - Allowsyou to use a custom tag.

String

Using the Simple Dublin Core Metadata
Standard
See Also: Simple Dublin Core Metadata on page 7-149.
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To generate Dublin Core metadata, set the GenerateDublinCore property to True.
This creates seven of the fifteen Dublin Core metadata fields. These fields are
automatically filled with the information from the equivalent Ektron
CMS400.NET property. Below is a list of the seven fields that are created and
their Ektron CMS400.NET equivalent property.

Warning! These seven Dublin Core fields are automatically populated with information from their
equivalent Ektron CMS400.NET property.

Dublin Core Field Name Ektron CMS400.NET Property

DC.title Content block title

DC.description Plain text version of a content block teaser
(summary)

DC.contributor Content block last editor name

DC.date Content block last edit date

DC.format "text/html"

DC.identifier URL of current page (from ASP.NET
Server.Request object)

DC.language
CMS language cookie / current site
language, expressed asa .NET
System.Globalization Culture Name

To fully comply with the Simple Dublin Core metadata element set, the
administrator must create the remaining eight Dublin Core fields as standard
Ektron CMS400.NET Metadata fields and apply them to all Ektron CMS400.NET
folders. Next, the CMS users must fill in the appropriate values for each content
block.

For information on the remaining eight Simple Dublin Core fields, see Simple
Dublin Core Metadata on page 7-149.

Using the MetaData Server Control
These steps show how to use the MetaData server control.

1. Drag a MetaData server control into a template.

2. Set the properties of the Metadata server control. This will create the
following HTML in the HTML body.

<cms:MetaData id="MetaData1" runat="server" Default-
ContentID="12"></cms:MetaData>
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Or if you are using multiple content block IDs In the DefaultItemList, the
following HTML will be created.

<cms:metadata id="MetaData1" runat="server" Defaul-
tItemList="[12,7,4]"></cms:metadata>

3. Click on the HTML tab and copy that line from the <body> tag into the
<head> tag.

4. Save the Web form and rebuild the solution.

5. Open the Web page in the browser.

6. Right click on the Web page and click View Source. Look in the head
tag. The meta tags from the content block are added to the page.

The metadata information added is shown below.

MetaDataList Server Control
Use the MetaDataList server control to create lists based on Keyword Names
and Keyword Values contained within the metadata of content. In the example
below, KeyWord names are circled in red, and KeyWord values are circled in
green.
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The list can display the information as a list of hyperlinks. You can choose,
based on properties you set, to display the summary and how to order the
display. For general information Metadata, see Working with Metadata on page
7-141.

This subsection contains the following topics:

n MetaData Server Control vs. MetaDataList Server Control on page 7-
165

n MetaDataList Server Control Properties below

n Retrieving the XML Structure of a MetadataList on page 7-177

MetaDataList Server Control Properties
The MetaDataList server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to browse to
Content, Collections, etc. See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Data Type: String
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Property Value

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero).
This is the amount of time, in seconds, a control’s data is cached. For example, if you
want to cache the data for fiveminutes, set this property to 300 (three hundred).
See Also:Caching with Server Controlson page 24-33

Warning! If theEnablePaging property is set to True, theCacheInterval
property is disabled.

Data Type: Double

ContentType

Select a type of content for this control. Choicesare:

n All Types

n Content

n Forms

n Archive_Content

n Archive_Forms

n Assets

n Archive_Assets

n LibraryItem

n Multimedia

n Archive_Media

n NonLibraryContent

n DiscussionTopic

To learn about archived content, seeSetting Archive Optionson page 7-191.

Data Type: Ektron.Cms.Controls.CmsWebService.CMSContentType

DisplayXslt

Determineshow the information on the page is displayed

n None-databind only

n ecmNavigation - lists the title of every content block in the folder

See Also:Example of ecmNavigation Displayon page 9-127

n ecmTeaser - lists the title of every content block in the folder plus the content
summary.

See Also:Example of ecmTeaser Displayon page 9-128

n Path to Custom Xslt - Enter the path to an Xslt that determines the display of
the page

Data Type: String

Warning! If you specify an external file, it is strongly recommended that you do not
store this file in your site'sWorkarea folder. If you store this file in theWorkarea
folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at theMarkupLanguage property, the
Displayxslt property value is ignored.
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Property Value

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you want to
postpone the fill-action until later. In this case, FIll is automatically called during the
Page Render event.

Youmight do this if you need to set or change a property on the control in
codebehind and have it render with your changes shown.

EnablePaging

This property, in conjunction with theMaxNumber property, lets site visitors view
an unlimited number of content itemswhile controlling the amount of screen space.
To accomplish this, the content display is limited to the number set in the
MaxNumber property.

If you set this property to true, and the number of content itemsexceeds the
MaxNumber number, navigation aidsappear below the last item. The site visitor
uses the aids to view additional items. See example below.

Data Type: String

So, for example, if specifiedmetadata is found in 9 itemsand theMaxResults
property is set to 3, the screen displaysonly the first three items.When the site
visitor clicks [Next], he sees items4, 5 and 6, etc.

Warning! If theEnablePaging property is set to True, theCacheInterval
property is disabled.

Data Type: Boolean

ExactPhrase

Determineswhether the KeyWordValue needs tomatch themetadata value
exactly.

For example, if “site” is the KeyWordValue, the title of a content block is “Welcome to
the site” and ExactPhrase is set to true, you would not see the content block in the
metadata list. This is because “site” doesnot equal “Welcome to the site”.

True =Match the exact phrase

False =Doesn’t need tomatch exact phrase

Data Type: Boolean

FolderID
The folder ID fromwhich content is retrieved. At theRecursive property, you
determine if content in this folder’s subfolders is also retrieved.

Data Type: Long
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Property Value

GetAnalyticsData

Set this property to True if you want the following information for each content in
the list.

ReturnsContent View Count,Content Rating,Content Rating Average.

Create your own XSLT styles to display this data.

Warning! This property only provides reliable data when the BusinessAnalytics
Feature is on.Enabling the BusinessAnalyticsFeature on page 7-748.

Data Type: Boolean

GetHtml

Set to True if you want to display the content (html body) for all content to appear on
thismetadata list. For example, you want to display content inside aWeb server
control such asaGridView.

Data Type: Boolean

Hide

Used to hide ametadata list in design time and run time.

True =Hidemetadata list.

False =Showmetadata list.

Data Type: Boolean

IncludeIcons

Choose whether to display iconsnext to themetadata list’s links.

Warning! This property onlyworkswhen ecmSummaryor ecmTeaser are used
in theDisplayXslt property.When the[$ImageIcon] variable is used in an
EkML file and that file is assigned to theMarkupLanguage property, this
property acts asTrue.

Data Type: Boolean
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Property Value

KeyWordName

KeyWordName represents ametadata definition, that is, the container for the
KeyWordValues. Examplesof a KeyWordName areKeywords and Title.

To view an illustration of the relationship between KeyWordName and
KeyWordValues, seeMetaDataList Server Controlon page 7-169.

If you are authenticated, you can click the ellipsis button and select from a list of
existingmetadata definitions. SeeUsing CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8.

For information on creatingmetadata definitions, seeWorking with Metadata
Definitionson page 7-150.

Data Type: String

KeyWordValue

Enter the valuesassociated with the KeyWordName. Only content whosemetadata
(defined at theKeyWordName property) matches this value appears on the
metadata list.

Examplesof a KeyWordValue are “home; page; company.” To view an illustration
of the relationship between KeyWordName and KeyWordValues, see
MetaDataList Server Controlon page 7-169.

Note: The character that separatesmultiple items is defined at the
KeyWordValueSeparatorproperty.

Note: At the KeyWordValueMatchAllproperty, you determine if allmetadata
definition valuesmust match or anyone of them.

Data Type String

KeyWordValueMatchAll

This property is only used if you enter more than one keyword value.

If you do, and onlywant content to appear on themetadata list if all valuesentered
at the KeyWordValue field match itsmetadata values, enter true.

If metadata can appear on the list as long asany value defined at the
KeyWordValue field matches the selectedmetadata value for a content item, enter
false.

Example:

KeyWordValue for Title (assigned for this server control): home; page; company.

Metadata values for a content item’sTitlemetadata definition field: software;
ektron; company.

IfKeyWordValueMatchAll = true, content doesnot appear onmetadata
list because some itemsdo not match.

IfKeyWordValueMatchAll=false, content item appears onmetadata list
because one item (company) matches.

Data Type: Boolean

KeyWordValueSeparator
Enter the character used to separate the list of keyword values. An example is a
semicolon(;).

Data Type: String
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Property Value

Language
Set a language for viewing theMetaDataList. This property shows results in design-
time (in VisualStudio) and at run-time (in a browser).

Data Type: Integer

LinkTarget

Defines the waya link actswhen a link is clicked.

Choicesare:

_blank - This target causes the link to alwaysbe loaded in a new blankwindow.
Thiswindow is not named.

_self - This target causes the link to always load in the samewindow the anchor
was clicked in. This is useful for overriding a globally assigned BASE target.

_parent - This target makes the link load in the immediate frameset parent of the
document. This defaults to acting like “_self” if the document hasno parent.

_top - This target makes the link load in the full bodyof the window. This defaults to
acting like “_self” if the document is alreadyat the top. It is useful for breaking out of
an arbitrarily deep frame nesting.

Data Type: ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the display of themetadata list. For
example, mymetadatalistmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing the server
control, just enter its name. If the file is in another folder, enter the path relative to
site root. For example,
\siteroot
\workarea\customfiles\markup\mymetadatalist.ekml

See Also:Controlling Output with EktronMarkup Language on page 26-1 and
metadatalist.ekmlon page 26-57

Note: If you enter a valid EkML file, theDisplayXslt property value is
ignored. If the EkML file contains the[$ImageIcon] variable, the
IncludeIcons property acts asTrue.

Data Type: String
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Property Value

MaxNumber

Enter themaximum number of items to appear in the initial display of this server
control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount of space being
occupied, enter themaximum number of results per page here. Then, set the
EnablePaging property to true.

If you do andmore than the number ofMaxResults are available, navigation aids
appear below the last item to help the site visitor view additional items. See example
below.

Data Type: Integer

OrderBy

The order of the list to be returned.

n Title - The title of the content block

n ID - The content block ID number

n Date Created - The date the content blockwascreated

n Date Modified - The date the content blockwas last modified

n LastEditorLname - The last editor’s last name

n LastEditorFname - The last editor’s first name

n ContentRatingAverage - BusinessAnalyticsContent Rating

n ContentViewCount - BusinessAnalyticsContent Views

Data Type: Ektron.Cms.Controls.CmsWebService.ContentOrderBy

Recursive

Whether to search sub-folders of the identified root folder. The starting folder is
identified in theFolderID property.

Data Type: Boolean

SortOrder
Choose the order direction of the list, Ascending or Descending.

Data Type: String

SuppressWrapperTags

This property is set tofalse because Ajaxuses<div> tags to rewrite the region
around the tag. You cannot change the value totrue.

Data Type: Boolean

Managing Content in Ektron CMS400.NET

7-176 ReferenceManual
Version 8.01 Rev 4



Property Value

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of an HTML document
asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

Data Type: String

Retrieving the XML Structure of a
MetadataList
Retrieving the XML structure of XML content allows for greater control over
developing XSLs. The following is an example of how to retrieve the XML
structure:

1. Open a new Web form.

2. Drag and drop a MetadataList server control onto it.

3. Set the KeyWordName and KeyWordValue properties.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.

Textbox1.Text = Metadata1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

9. The XML structure of the MetadataList appears in the textbox.

For an additional example, see the MetadatList XML page on the
CMS400Developer samples page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/MetaDataList/MetadataListXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/MetaDataList/MetadataListXML.aspx and
MetadataListXML.aspx.vb
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Creating/Updating Templates
During the setup of your Ektron CMS400.NET Web site, templates are created
for your Web pages. A template typically includes page headers and footers as
well as placeholders for content, forms, summaries, calendars, collections, or
other page elements.

A template included with Ektron’s sample site appears below. Notice that the
top of the screen contains headers that appear on several pages. Other areas
contain links to Ektron CMS400.NET objects, such as menus and text. The
developer can easily modify the content inside these areas.

Note: To learn more about creating templates, see Setting Up a Template on page 24-4.
Another good resource is the Ektron technical article “Templating in CMS400.NET”
(http://dev.ektron.com/articles.aspx?id=6724).

This section also contains the following topics.

How Templates are Used 7-179
Declaring Templates 7-179
Adding a New Template 7-180
Deleting a Template 7-180
Updating a Template 7-181
Inheritance of Folder Templates 7-181
Assigning Templates to Folders 7-182
Adding a Template to a Folder 7-183
Removing a Template from a Folder 7-183
Assigning Templates to Content 7-183
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How Templates are Used
Except for your Web site’s home page, all pages on your site are made
accessible by hyperlinks. Hyperlinks can appear within content. They are also
used to link content items from list summaries, menus, and collections.

The template is a key component of the hyperlink definition -- it defines the
template in which to display the content. As seen in the example below, when
the user selects Email, that content item (ID 87) will display within the
contactinformation.aspx template.

Declaring Templates
After creating your templates, declare them within Ektron CMS400.NET. To do
this, go to the Active System Templates screen, available from Settings >
Configuration > Template Configuration.
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From this screen, you can add new templates, or delete or update existing
ones.

Note: Only members of the Administrators group and users defined in the Manage Members
for Role: Template Configuration screen have permission to add, delete or update templates.
See Also: Defining Roles on page 15-31

This section also contains the following topics.

Adding a New Template below

Deleting a Template below

Updating a Template on the facing page

Adding a New Template
To add a new template, click the Add button ( ). The Add a New Template
screen appears.

Enter the path to the new template and click the Save button ( ).

See Also: Creating/Updating Templates on page 7-178

Deleting a Template
To delete a template, click Delete next to the template.

You can only delete a template if it is not assigned as any folder’s default
template. If you choose a template that is assigned as a default, a screen tells
you why you cannot delete it and lists the folders for which it is the default.

If you delete a template that is not used as a default but is applied to content,
that content’s template is changed to its folder’s default template.
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Updating a Template
Use the update command to change all references from an old to a new
template. For example, your old template is named MyTemplate.aspx. You can
want to replace all references to it to Updatetemplate.aspx.

To do this, follow these steps.

1. Click Update next to the template.

2. A new screen appears.

3. Enter the new template name.

4. Click the Save button ( ).

Inheritance of Folder Templates
By default, all folders below the root folder inherit a template from their
parent. However, you can override the default and assign a unique set of
templates to any folder. See Also: Creating/Updating Templates on page 7-178

Before changing a folder’s template assignment, you must break inheritance
from the parent folder. To do this, go to the Edit Folder Properties screen and
uncheck the box next to Inherit Parent Template Configuration (illustrated
below). See Also: Editing Folder Properties on page 4-18
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Each folder must have at least one template. Also, one template must be
chosen as the default.

If the folder’s default template is changed, all existing template assignments
remain. However, any new content added or moved into the folder will assume
the new default template.

Assigning Templates to Folders
If you break template inheritance, all inherited templates are initially assigned
to the folder. You can then remove unwanted templates or add new ones.

All available templates appear in the template dropdown list (illustrated below).
Select any that you want to be available from the folder and click Add.

The list of available templates is managed through the Active System
Templates screen. See Also: Declaring Templates on page 7-179

This section also contains the following topics.

Adding a Template to a Folder on the facing page

Removing a Template from a Folder on the facing page
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Adding a Template to a Folder
To add a new template, click the Add button ( ). The Add a New Template
screen appears.

Enter the path to the new template and click the Save button ( ).

Removing a Template from a Folder
n If you try to delete a template that is the default for a folder, you are

notified that you must assign a new default to that folder before you
can delete it.

n If you try to delete a template that is assigned to a content block,
you are notified via the following message If you wish to continue
and delete this template, the above content will be set to
their parent folder's default template. Do you wish to
continue?

Assigning Templates to Content
A folder’s default template is automatically applied to all content in the folder.
However, you can change a content item’s template to any of those assigned to
the folder.

This relationship is illustrated below.
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To change the template applied to a content item, edit that content, and go to
the Templates tab as shown above. Then, select a template to apply to the
content.

As explained in How Templates are Used on page 7-179, the template assigned
to the content will be used whenever a hyperlink is created to it.

Private Content
Private content is only available to CMS users or membership users with at
least Read-Only permissions for its folder. Those users must log in to work with
the private content. Unauthorized site visitors cannot see it.

Note: All members of the Administrators group have access to private content, even if they are
not granted permission on the View Permission for Folder screen.

You can designate a folder to be private. In that case, all content in it and its
subfolders is private (if they inherit permissions). Alternatively, you can
designate specific content items as private.
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To demonstrate private content, the following table shows how a user’s status
affects the display of content in three scenarios.

Scenario Private Content Web Page

Site visitor

Logged in user with
read-only permission

Logged-in user with
edit permissions

Note: You can determine the appearance of themenu shown above. See
Changing the Appearance of theWeb Site Content Menu on page 7-6.

Making a Folder Private
Note: You can only set content to private when inheritance is broken. See Also: Inheritance on
page 4-42.

To make a folder private, follow these steps.

1. In the Workarea, navigate to the folder that you want to make
private.

2. Click View > Properties.

3. Click the View Permissions button ( ).
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4. If necessary, uncheck the box that says Allow this object to
inherit permissions. (Inheritance must be disabled before you can
make the content private.)

5. Check the box that says The content in this folder is private and
can only be viewed by authorized users and members.

6. A confirmation message is displayed.

7. Click OK.

All content in the folder is now private. As new content is added, it is
automatically set to private.

Making Content Private
To make any content private, follow these steps. See Also: Making Assets
Private below

1. In the Workarea, navigate to the folder that contains the content you
want to make private.

2. Click the content item you want to make private.

3. Click the View Permissions button ( ).
4. If necessary, uncheck the box that says Allow this object to

inherit permissions. (Inheritance must be disabled before you can
make the content private.)

5. Check the box that says This content is private and is NOT
viewable on the public Web site.

6. A confirmation message is displayed.

7. Click OK.

The content is now private.

Making Assets Private
If assets are set to private, they are handled like other private content with one
important exception: Unless you follow the procedure described below, anyone
can access an asset by typing the URL of the asset into the browser’s address
field.

If a user attempts to access the asset in any other way (such as, linking to it
from a Web page), the regular methods of making content private work. See
Making a Folder Private on previous page and Making Content Private above.

To make assets private even if someone types their URL into the browser’s
address field, follow these steps.

Note: If site users receive a 404 Page Not Found error when trying to view private assets,
make sure you have completed all steps below.

1. Open your Web site’s web.config file, located in the site root folder.
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2. Make sure the following line is uncommented.
<remove verb="GET,HEAD,POST" path="*"/>

3. Comment out the eight lines indicated below.
<httpHandlers>

<remove verb="GET,HEAD,POST" path="*"/>

<add verb="HEAD,OPTIONS,PROPFIND,PUT,LOCK,UNLOCK,MOVE,COPY,GETLIB,PROPPATCH,
MKCOL,DELETE,(GETSOURCE),(HEADSOURCE),(POSTSOURCE)" path="*"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<!--<add verb="GET,POST" path="*.doc"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.docx"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.xls"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.xlsx"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.ppt"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.pptx"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.vsd"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.vsdx"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>-->

Eight add verb statements in the middle are commented out.

4. Make sure the following line is uncommented.
<add verb="GET,HEAD,POST" path="*"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

5. Save web.config.

Scheduling Content to Begin and End
Scheduling lets you control when a version of content becomes visible on the
Web site. Similarly, you can remove content on a predetermined date and time.
When used together, a start and end date can relieve you of much work by
managing how long a version of content is viewable on your Web site.

You can also set options for what happens to a content version upon reaching its
end date.

This section also contains the following topics.

How Does It Work? on next page

Setting a Start Date on next page

Scheduling Content to Begin and End
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Setting an End Date on Content on page 7-190

Setting Archive Options on page 7-191

Viewing Archived Content on page 7-193

How Does It Work?
When you create or modify content, you can select a “go-live” date and time. If
you do, and the content makes it through the approval chain, Ektron
CMS400.NET publishes the content to the live site at that time.

For example, your company is having a sale of the century in a month, and
everything is ready except the announcement. You decide to update your Web
site to let the public know about the sale. With this feature, you create the Web
content now and set it to go live a week before the sale.

The Ektron Windows Service manages these changes to your site. See Also:
Ektron Windows Service on page 22-7

Setting a Start Date
To set a start date, follow these steps.

1. Access the editor by adding new content or editing existing content.

2. If adding new content, enter a title and the content.

3. Click the Schedule tab.

4. Click the calendar button next to the Start Date field.

5. A calendar pops up. Select the date and time when this version of the
content will become visible on the Web site.
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6. Click the Done button.

7. The date and time appear in the Start Date field.

Note:When you select a time for content to go live, that time depends on the server’s system
clock. If the clock is incorrect, the content will not go live at the intended time.

This section also contains the following topics.

What Happens After I Set a Start Date? 7-189
Setting the Go-Live Date on New Content 7-189
Setting the Go-live Date on Existing Content 7-190

What Happens After I Set a Start Date?
After you save the content, it appears on the Content Pending Start Date report,
which helps you keep track of content with a future start date. See Also:
Content Pending Start Date Report on page 7-712

After you set a go-live date and the content completes the approval chain, two
scenarios may occur:

n The content is new

n The content already exists, and you are publishing a new version

Each scenario is now explained.

Setting the Go-Live Date on New Content
When you set a go-live date on new content, it becomes viewable on the
specified date and time as long as it completes the approval chain. If a site
visitor accesses the page that contains the content before then, he sees only
the template.

What Happens After I Set a Start Date?
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If a logged-in CMS user browses your Web site, he sees a gray border around
the content until the date specified. If he clicks within the gray border, he can
use the Preview option to see the new content.

Setting the Go-live Date on Existing Content
When you set a go-live date for changes to existing content, and it completes
the approval chain, a logged-in CMS user sees a gray border around the content
until the date specified.

When you view content on the Web site, you see the previously published
version. When the go-live date occurs, the new content replaces the previous
version, and its status changes to Active.

Setting an End Date on Content
To set an end date for content, follow these steps.

1. Edit content. See Editing HTML Content on page 7-20.

2. Click the Schedule tab.

3. Click the calendar icon next to the End Date field.

4. A calendar pops up.

5. Select the date and time you want the content to be removed from
the Web site.

6. Click the Done button.

7. The date and time appear in the End Date field

Note:When you select a time for content to end, that time depends on the server’s system
clock. If the clock is incorrect, the content will not be removed at the intended time.

This section also contains the following topics.

What Happens After I Set an End Date? 7-190
Appearance on Content Reports 7-191

What Happens After I Set an End Date?
You have three choices for what to do with content when it reaches its end date.
These are explained in Setting Archive Options on the facing page.

If your choice means the content will not appear on the Web site, Ektron
recommends having another content item ready to replace it. If not, and a site
visitor visits the page containing the content, he sees the template without the
content.
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Appearance on Content Reports
After content reaches its end date, it appears on the Expired Content report,
which helps you track expired content. See Also: Content to Expire Report on
page 7-714

The report lists all content whose end date will occur within a number of days
that you specify.

Setting Archive Options
Use content’s archive options to determine what happens upon reaching its end
date/time. To be eligible for any option, the content must reach its end
date/time, progress through its approval chain, and be published. Until those
events occur, the content remains visible both within its content folder and on
the site.

The archive options (illustrated below) appear below the Start Date and End
Date fields on the content’s Schedule screen.

This section also contains the following topics.

Archive Options 7-192
Restoring Content from Archived to Active State 7-192

Appearance on Content Reports
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Archive Options

Option
Can site visitors
view content upon expiration?

Can users view and edit
content within Ektron
CMS400.NET upon expiration?

Archive
and
remove
from site
(expire)

No

Yes, within its folder by clicking the
View > Archive Content option.

Archived content can be found via
theWorkarea Advanced search (if
theArchived checkbox is
checked).

Archive
and
remain on
Site

n Content appears in a List Summary if the
ListSummary control’scontentypeproperty is set to
Archive_Content.

n If content is an HTML form, the response page
option appears. For example, if the form displaysa
message after the user completes it, that message
appears.

n Content is found by the search (Workarea and site)

n Content is visible within its taxonomydisplay

n Content is visible if site visitor enters exact path, such
ashttp://localhost/CMS400Developer
/dynamic.aspx?id=1014&__taxonomyid=14

Yes, within its folder by clicking the
View > Archive Content option.

Also, can be found via BasicSearch
and Advanced search (if the
Archived checkbox is checked).

Add to
CMS
Refresh
Report

Yes

Yes, in the active area of its folder
and on the Refresh Report.

See Also:Refresh Reminder
Report on page 7-713

Restoring Content from Archived to Active
State
To restore content from archived state to active, follow these steps.

1. Navigate to its folder.

2. Click View > Archived Content. (See Setting Archive Options on
previous page).

3. Hover the cursor over the content, click the triangle ( ), and select
Edit from the dropdown menu.

4. The Edit Content in Folder screen appears.

5. Click the Schedule tab.

6. Remove the End Date or change it to a future date.

7. Submit the content for publishing. When the content is published, it
will no longer be archived.
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Viewing Archived Content
The Archived content folder shows content in the selected folder whose end
date has passed and which meets all other archiving criteria. These are
explained in Setting Archive Options on page 7-191.

This content cannot appear on your Web site, although there are ways to
reactivate it.

To return to the regular folder view, click View > Content.

See Also:

n Deleting Several Content Items in a Folder on page 7-128

n Accessing the Search Content Folder Screen on page 9-90

Viewing Archived Content
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Displaying Content on your
Web Site
Two Ektron CMS400.NET server controls can display HTML content on your Web
site.

Server Control Displays More Information

ContentBlock One content block ContentBlockServer Controlbelow

ContentList A comma-delimited list of content blocks ContentList Server Controlon page 7-202

ContentBlock Server Control
The ContentBlock server control displays a content block on an Ektron
CMS400.NET Web page.

Ektron CMS400.NET has two types of content blocks:

n Static - displays one specified content block

n Dynamic - displays the content block of the ID passed through a URL
parameter

In addition, a content block can contain XHTML or XML content.

For an example of using the ContentBlock server control programmatically, see
Using the ContentBlock Server Control Programmatically on page 7-201

This section also contains the following topics.

Static Content Block 7-194
ContentBlock Server Control Properties 7-195
Dynamic Content Block 7-196
XML Content Block 7-198
The OverrideXslt and DisplayXslt Properties 7-199
Retrieving the XML Structure of an XML Content Block 7-201
Using the ContentBlock Server Control Programmatically 7-201
Retrieving the XML Structure of a ContentList 7-202

Static Content Block
A static content block displays one identified content block on a Web page. The
following table explains how to complete the server control properties to insert
a static content block on a Web page.
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ContentBlock Server Control Properties
The following table explains the properties of the ContentBlock server control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
this property to 300 (three hundred). See Also:Caching with Server
Controlson page 24-33.

Double

DefaultContentID

The ID of a content block that appearswhere you insert this server
control.

If you don’t know the ID number of the content block, use the CMS
Explorer to browse to it. See Also:Using CMSExplorer to Browse Your
Ektron CMS400.NET Site on page 24-8

Note: If you identify a content block that displaysanOffice
document which will be published asHTML,make sure the
template sets<span> tags to display the content asa block.

Long

DisplayXslt Ignore for a non-XML content block. String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

DynamicParameter SelectNone - Use Default. This parameter is used for dynamic
content blocks. String

Hide

Used to hide a content block in design time and run time.

True =Hide content block

False =Show content block

Boolean

Language Set a language for viewing content. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

ContentBlock Server Control Properties
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Property Value
Data
Type

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Warning! - If you want to let content authors edit this content using
Ektron CMS400.NET’sEdit in Context feature, thismust be set to
false.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block
of code.

Custom - Allowsyou to use a custom tag.

String

In the above example, the server control retrieves content block id=28 and
displays it in the browser.

Dynamic Content Block
Use a dynamic content block to display a content block whose ID is passed
through a URL parameter. You would use this server control with a dynamic
template.

The following table explains how to complete the ContentBlock server control’s
properties to insert a dynamic content block on a template.
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Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String

DefaultContentID

The ID of a content block that appearswhere you inserted this server
control if no other content block is identified, or is not available.

If you don’t know the ID number of the content block, use the CMS
Explorer to browse to it. See Also:Using CMSExplorer to Browse Your
Ektron CMS400.NET Site on page 24-8

Long

DisplayXslt Ignore for a non-XML content block. String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

DynamicParameter Select id. When you do, this server control uses the content block
passed asa URL parameter. String

Hide

Used to hide a content block in design time and run time.

True =Hide content block

False =Show content block

Boolean

Language Set a language for viewing content. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Warning! - If you want to let content authors edit this content using
Ektron CMS400.NET’sEdit in Context feature, thismust be set to
false.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block
of code.

Custom - Allowsyou to use a custom tag.

String

Dynamic Content Block
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The following example shows how the ContentBlock server control can be used
to pass the id as a URL parameter.

When a user clicks a link that passes the content block ID as a URL parameter,
that content block appears. If that content block is not available, content block 1
appears.

XML Content Block
Use an XML content block to display an XML content block on an Ektron
CMS400.NET Web page.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String

CacheInterval

Sets the amount of time, in seconds, a server control’s data is cached.
The default is 0 (zero).

For example, if you want to cache the data for fiveminutes, set this
property to 300. See Also:Caching with Server Controlson page 24-
33

Double

DefaultContentID

The ID of a content block that appearswhere you inserted this server
control if no other content block is identified, or is not available.

If you don’t know the ID number of the content block, use the CMS
Explorer to browse to it. See Also:Using CMSExplorer to Browse
Your Ektron CMS400.NET Site on page 24-8

Long
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Property Value
Data
Type

DisplayXslt

Specify an externalXSLT file. See Also: TheOverrideXslt and
DisplayXslt Propertiesbelow

Warning! If you specify an external file, it is strongly recommended
that you do not store this file in your site'sWorkarea folder. If you
store this file in theWorkarea folder, the file will be lost when you
upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes shown.

Boolean

DynamicParameter Tomake this content blockdynamic, select id. When you do, this
server control uses the content blockpassed asa URL parameter. String

Hide

Used to hide a content block in design time and run time.

True =Hide content block

False =Show content block

Boolean

Language Set a language for viewing content. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

Custom - Allowsyou to use a custom tag.

String

The OverrideXslt and DisplayXslt Properties
The DisplayXslt property is optional. If used, it specifies an external XSLT
file. If the DisplayXslt property is not defined, the OverrideXslt property
specifies an XSLT identified in the Edit Smart Form Configuration screen.

The following table provides more information about these properties.

TheOverrideXslt and DisplayXslt Properties
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To use this display XSLT
Enter this value for
XSLT

Enter this value
for Override
XSLT

The default XSLT specified in the Edit Smart Form
Configuration screen (illustrated below). Note that, in this
example, theXSLT Packaged option is the default XSLT,
since it is selected.

XSLT Packaged is the XSLT from the Edit Smart Form
Configuration screen (that is, the XSLT created in the Data
Designer).

Default

XSLT 1 from the Edit Smart FormConfiguration screen 1

XSLT 2 from the Edit Smart FormConfiguration screen 2

XSLT 3 from the Edit Smart FormConfiguration screen 3

An absolute or relative path to an XSLT file.

An externalXSLT file
not specified in the Edit
Smart Form
Configuration screen.

For
example:sample.xslt

Doesnot matter - if
XSLT value exists,
OverrideXSLT is
ignored.

See Also:Working with Smart Forms on page 7-278l
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Retrieving the XML Structure of an XML Content
Block
Retrieving the XML structure of XML content allows for greater control over
developing XSLs. The following is an example of how to retrieve the XML
structure.

1. Open a new Web form.

2. Drag and drop a Content Block server control onto it.

3. Set the DefaultContentID to an XML content block.

Warning! This does not work with HTML content blocks, as there is no XML structure to output.

4. Drag and drop a Text box on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400 px.

6. On the code behind page, add the following line.
TextBox1.Text = ContentBlock1.EkItem.Html

7. Build the project.

8. View the form in a browser.

9. The XML structure of the content block appears in the text box.

Using the ContentBlock Server Control
Programmatically
The following code will display a content block:

Note: Before adding these lines of code, drag and drop a literal box on your Web form.

Dim MyContentBlock As New ContentBlock

MyContentBlock.DefaultContentID = 8

MyContentBlock.Page = Page

MyContentBlock.Fill()

Literal1.Text = MyContentBlock.EkItem.Html

To display a content block with the content block title, do the following:

Note: Before adding these lines of code, drag and drop a two literal boxes on your Web form.

Dim MyContentBlock As New ContentBlock

MyContentBlock.DefaultContentID = 8

MyContentBlock.Page = Page

MyContentBlock.Fill()

Retrieving the XMLStructure of an XMLContent
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Literal1.Text = MyContentBlock.EkItem.Title

Literal2.Text = MyContentBlock.EkItem.Html

Retrieving the XML Structure of a
ContentList
Retrieving the XML structure of XML content allows for greater control over
developing XSLs. The following is an example of how to retrieve the XML
structure:

1. Open a new Web form.

2. Drag and drop a ContentList server control onto it.

3. Add at least one content ID to the ContentID property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: Ektron recommends setting the text box width to at least 400 px.

6. On the code behind page, add the following line.
Textbox1.Text = ContentList1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

The XML structure of the ContentList appears in the textbox.

For an additional example, see the ContentList XML page on the
CMS400Developer samples page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/ContentList/ContentListXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/ContentList/ContentListXML.aspx and
ContentListXML.aspx.vb

ContentList Server Control
The ContentList server control displays a list of content blocks on a Web page.
In contrast to a List Summary, where content must be in a specified folder, the
ContentList server control displays content from any Ektron CMS400.NET folder.

When added to a template and visited, a ContentList Summary looks like this.
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Depending on the setting you choose for DisplayXslt, you can change
information displayed for each content block. See Also:DisplayXslt on next page.

There are two options for how the ContentList server control displays a content
list.

n Define a content list in a content block's metadata. Then, assign that
content block’s ID in the DefaultContentID property. See Also:Using
Metadata to Display an Associated Content List on page 7-208

When using this option, an administrator typically sets up the
Workarea portion of the process. Then, a developer adds the server
control to a Web form and assigns the content block ID and the
metadata name to the appropriate properties. Because the content
list is assigned to a content’s metadata, you can pass the content ID
dynamically in a Web form and display a list for each content block
you defined.

n Assign a comma-delimited list of content blocks to the ContentIds
property. See Also:Using the ContentID Property to Display a Content
List on page 7-210

Using the ContentIds process, a developer adds the ContentList
server control to Web form. Then, he defines a list of content IDs in
the ContentIds property. If the server control or the list in the
ContentIds property is deleted, it is not available and will have to
be created again.

This section also contains the following topics.

ContentList Server Control Properties 7-203
Using Metadata to Display an Associated Content List 7-208
Using the ContentID Property to Display a Content List 7-210

ContentList Server Control Properties
The ContentList server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer. See
Also:
Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

String
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Property Description Data Type

CacheInterval

Sets the amount of time the server control’s data is
cached.
The default is 0 (zero). This is the amount of time, in
seconds, a control’s data is cached. For example, if you
want to cache the data for fiveminutes, set this property
to 300 (three hundred). See Also:Caching with Server
Controlson page 24-33

Double

ContentIds
A comma delimited list of content block IDs.

See Also: :Using the ContentID Property to Displaya
Content List on page 7-210

String

DefaultContentID

Set content ID value. Once set, content IDsare
generated from theMetaTag value for this content.

See Also: :MetaTag on page 7-206

UsingMetadata to Displayan Associated Content List
on page 7-208

Long

DisplayXslt

Determineshow information on the page is displayed.

None - databind only

ecmNavigation - lists the title of each content block
See Also:Example of ecmNavigation Displayon page
9-127

ecmTeaser - lists the title of each content blockplus the
content summary

See Also:Example of ecmTeaser Displayon page 9-
128

ecmUnOrderedList - sorts the list in no particular
order. Shows the title and content summary

Path to Custom Xslt - Enter the path to an XSLT that
determines the display of the page

Warning! If you specify an external file, it is strongly
recommended that you do not store this file in your
site'sWorkarea folder. If you store this file in the
Workarea folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at the
MarkupLanguageproperty, the Displayxslt
property value is ignored.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to
false if you want to postpone the fill-action until later. In
this case, FIll is automatically called during the Page
Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean
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Property Description Data Type

DynamicParameter

Uses theQueryString parameter to read a content ID
dynamically.

None - Use Default - use the default content ID list.

ID - readsa content block’s ID dynamically.

ekfrm - readsa form block’s ID dynamically.

String

GetAnalyticsData

Set this property to True if you want the following
information for each content in the list.

ReturnsContent View Count,Content Rating,
Content Rating Average.

Create your own XSLT styles to display this data.

Warning! This property only provides reliable data
when the BusinessAnalyticsFeature is on.Enabling
the BusinessAnalyticsFeature on page 7-748.

Boolean

GetHtml

Set to True if you want to retrieve and display content
(html body) for all content blocks in the list summary.
For example, to display content inside a web server
control such asaGridView.

True =Get and displayHTML for each content block in
the list summary

False =Do not get and displayHTML.

Boolean

Hide

Used to hide output of the content list in design time and
run time.

True =Hide results

False = show results

Boolean

IncludeIcons

Choose whether to display iconsnext to the content
list’s links.

Warning! This property onlyworkswhen
ecmSummaryor ecmTeaser are used in the
DisplayXsltproperty.When the [$ImageIcon]
variable is used in an EkML file and that file is assigned
to the MarkupLanguageproperty, this property acts as
True. Boolean

Language
Set a language for viewing the list summary. This
property shows results in design-time (in VisualStudio)
and at run-time (in a browser).

Integer
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Property Description Data Type

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe loaded
in a new blankwindow. Thiswindow is not named.

_self - This target causes the link to always load in the
samewindow the anchor was clicked in. This is useful
for overriding a globally assigned base target.

_parent - This target makes the link load in the
immediate frameset parent of the document. This
defaults to acting like “_self” if the document hasno
parent.

_top - This target makes the link load in the full bodyof
the window. This defaults to acting like “_self” if the
document is alreadyat the top. It is useful for breaking
out of an arbitrarily deep frame nesting.

ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the
display of the content list. For example,
mycontentlistmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb
form containing the server control, just enter its name. If
the file is in another folder, enter the path relative to site
root. For example, ..\workarea\customfiles
\markup\mycontentlistmarkup.ekml.

See Also:Controlling Output with EktronMarkup
Language on page 26-1 and contentlist.ekmlon page
26-36

Note: If you enter a valid EkML file, the
DisplayXsltproperty value is ignored. If the EkML
file contains the [$ImageIcon]variable, the
IncludeIconsproperty acts asTrue.

String

MetaTag

Specify aMetadata definition whose type isContent
Selector.When you do, the associated list of content
itemswill appear where you place the server control.

Warning! You cannot insert other metadata types.

Thisworkswith the DefaultContentIDproperty.

See Also: :DefaultContentID on page 7-204Using
Metadata to Displayan Associated Content List on
page 7-208

For more information about usingmetadata to assign a
list of related content to a content item, seeRelated
Content Metadata on page 7-146.

String
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Property Description Data Type

OrderByDirection

Determineswhich direction to sort content determined by the OrderBy
property.

n ascending - itemsare arranged A, B, C or 1,2,3.

n descending - itemsare arranged. Z,Y,X or 3,2,1.

If sorting bydate, descending puts themost recent first.

When ascending is selected and the OrderByproperty is set to
OrderOfTheIds, the order of the IDsare preserved.When set to descending,
the order is reversed.

Datatype:
Ektron.Cms.Controls.CmsWebService.
ContentListOrderByDirection

OrderBy

Sort the list by one of these values:

Title - the order of the content’s title.

DateModified - the last date the content wasmodified.

DateCreated - the date the content was created.

LastEditorFname - the last editor’s first name.

LastEditorLname - the last editor’s last name.

OrderOfTheIds - preserves the content ID order based on the list in the
ContentIdsproperty.

ContentRatingAverage - BusinessAnalyticsContent Rating

ContentViewCount - BusinessAnalyticsContent Views

Datatype:
Ektron.Cms.Controls.CmsWebservices.
ContentListOrderBy

(must be one of the values)

Random

Set to True if you want to randomlydisplay one content
block link from the content list. The content changes
each time a user views the page.

True - randomly display one content block in
the specified folder.

False - display the content list normally.

Note: If you use a customXSLT or EkML file, the
type of content displayed can bemanipulated. For
example, if you use an EkML file that has the [$Html]
variable in it, the actual content is displayed instead
of a link. See Also:Controlling Output with Ektron
Markup Language on page 26-1 and [$Html] on
page 26-17

Boolean

SuppressWrapperTags
This property is set to false because Ajaxuses<div>
tags to rewrite the region around the tag. You cannot
change the value to true.

Boolean

ContentList Server Control Properties
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Property Description Data Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline
portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply
attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

Using Metadata to Display an Associated
Content List
You can use the ContentList server control to display a list of content associated
with a given content item. First, you define a content list in the metadata of a
content block. Then, assign the ID of the content block to the ContentID
property and specify a Metadata definition in the MetaTag property. The
ContentList server control pulls information defined in the metadata of the
content to display the list of content.

The steps below show an example of using the DefaultContentID and MetaTag
properties to create a content list.

1. In the Ektron CMS400.NET Workarea, create a metadata definition, in
the Name field, enter a title of the data. This name is used in the
MetaTag property for the server control.

2. Fill in all standard fields. See Also:Metadata Definition Fields on page
7-153

The Type must be Content Selector.

3. Add the definition to all appropriate folders. See Also:Assigning
Metadata to a Folder on page 7-159
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4. For each content item to which you want to associate related content,
access its Metadata tab and identify the related item(s).

For example, a list of content blocks associated with motorcycle
helmets. You want this list to appear whenever a helmet is being
viewed.

To set this up, you would

- edit the content block

- click its Metadata tab

- find the metadata definition for the Content List

- click the Edit Button

- select the content blocks to be in the list

5. On a Web form in Visual Studio, add the ContentList server control.

6. Set the DefaultContentID property to the content block’s ID.

7. Add the name of the Metadata field in the Workarea to the MetaTag
property.

UsingMetadata to Display an Associated Content
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8. Set all other properties using the table in ContentList Server Control
Properties on page 7-203.

9. Once the Web form is saved, navigate to the page. The content list is
displayed.

Using the ContentID Property to Display a
Content List

1. On a Web form in Visual Studio, insert the ContentList server control.

2. Add a comma delimited list of content IDs to the ContentIds
property.
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3. Set all other properties using the table in ContentList Server Control
Properties on page 7-203.

4. Once the Web form is saved, navigate to the page. The content list is
displayed.

Using the ContentID Property to Display a Content
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Working with HTML Forms
Note: This section explains how to create/edit HTML forms using eWebEdit400. If your editor is
eWebEditPro+XML, see http://www.ektron.com/manuals/CMS400/v76/usermanual.pdf
>”Working with HTML Forms.”

Ektron CMS400.NET provides powerful online form capabilities, allowing you to
create an online dialog with visitors. Now anyone in your organization – not just
a developer or Webmaster– can create and deploy Web forms to capture visitor
information. Support marketing strategies by getting feedback on their needs.
Follow up on their interest in your products and services. Register people for
events.

Form capabilities include

n Creating a form and its postback message

n Creating polls and surveys

n Adding validation criteria to form fields

n Automatically assigning tasks for follow-up activities to form
submissions

n Reporting on form information

n Exporting results to Microsoft Excel

A sample form appears below. Toolbar buttons for working with forms are
circled.

This section also contains the following topics.

Overview of Form Processing 7-213
Form Permissions 7-213
The Structure of Form Data 7-214
Creating a New Form 7-214
Creating a Form’s Content 7-220
Form Validation 7-224
Form Fields 7-224
Editing a Form Field 7-243
Inserting or Editing Buttons on the Form 7-244
Implementing a Form on a Web Page 7-245
Sending Data as XML 7-245
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Redirecting Submitted Form Data 7-249
Assigning a Task to a Form 7-251
Viewing Form Reports 7-252
Viewing Form Information 7-258
Editing a Form 7-262
Deleting a Form 7-264
Creating Polls and Surveys 7-264
Forms Must Use Template with FormBlock Server Control 7-270
FormBlock Server Control 7-271
Poll Server Control 7-274

Overview of Form Processing
Step For more information, see

1. Create a form Creating a New Form on next page

2. Assign it to aWeb page Implementing a Form on aWeb Page on page 7-245

3. Site visitor goes to your Web site and
completes form. Form ismailed to an email
address, saved to a database, or both.

4. View submitted form data and download it to
a spreadsheet. Viewing FormReportson page 7-252

Form Permissions
This section also contains the following topics.

Folder Permissions 7-213
Administrator Permissions 7-213
User Permissions 7-214

Folder Permissions
By default, form permissions are inherited from a form’s folder. To customize
permissions for any folder that contains forms, access the corresponding folder
under Content and assign permission as described in Setting Permissions for a
Content Folder on page 4-44.

Administrator Permissions
Similar to content, users in the administrator user group have full control over
form features. Youmust be a member of the administrator group to:

n Add a form

Overview of FormProcessing
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n Edit a form

n Delete a form

n Assign content to a form

You may also perform all actions on a form’s content.

User Permissions
Users who are not members of the administrator user group can add, edit,
delete, and restore form content if granted these permissions for the content
folder or item.

The Structure of Form Data
A form has the following components.

n Form (title, ID number, whether the form data is sent as email,
and/or saved to a database, etc.)

n Content information (title, start and/or end date, status, postback
message, etc.)

n Form fields (text field, password field, text area, hidden text,
choices, checkbox, select list, calendar, submit button, etc.)

Creating a New Form
The screen you use to create a form follows five simple steps. After completing
the steps, you have a new form that’s ready to collect the information you need.
To make the task easier, Ektron CMS400.NET provides sample forms that you
can start with then customize.

As explained in Mailto or Database Form on page 7-264, form data can be
emailed and/or saved to a database. Forms created using the procedure
described below are saved to a database by default, but not emailed. To change
either setting, use the Edit Properties screen. See Editing a Form’s Properties
on page 7-263.

This section also contains the following topics.

Procedure for Creating a Form 7-215
Composing the Postback Message 7-216
Inserting Fields into the Postback Message 7-216
Redirect to an Action Page and Forward Form Data 7-217
Making Form Results Available to Site Users 7-218
Chart Types 7-219
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Procedure for Creating a Form
To create a new form, follow these steps.

Note: You can also create a new edition of a form in another language by copying an existing
form and translating it. For more information, see Translating Content to Another Language on
page 7-108.

Note: For the steps to create a new poll, seeWorking With Polls on page 7-265. For the steps
to create a new survey, see Creating a Survey on page 7-269.

1. Consult with your Ektron CMS400.NET administrator about the folders
in which you should create forms. See Also: Forms Must Use
Template with FormBlock Server Control on page 7-270

2. From the View menu, click Language, and select the language in
which to create the form.

3. Click the New menu > HTML Form/Survey.

4. The New Form screen appears.

Note:When you choose Standard Poll or Blank Survey, the number of steps in the Forms
Wizard changes from five to four. This happens because the Assign Tasks step is removed.
See Also:Working With Polls on page 7-265 and Creating a Survey on page 7-269.

5. Choose the form that you want to begin with. You can click the

preview icon ( ) next to any sample form to see it before choosing
it.

Select a sample that most closely matches the form you want to create.
After you create it, you can add fields, remove fields, modify possible
responses, etc.

6. Click Next.

7. Enter or edit the form’s Title and Description.

n Title - used to reference the form within the Workarea (required)

n Description - an extended description of the form

Procedure for Creating a Form
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8. The next screen lets you assign a task to a user or user group. If you
do, a task will be created every time a site visitor submits this form.
See Also: Assigning a Task to a Form on page 7-251

9. A new screen lets you determine what happens after the site visitor
completes the form. The choices are:

n Display a message - See Composing the Postback Message below

Warning! If your form/survey/poll uses either Redirect option, your Web developer must use a
FormBlock server control to display this form on a Web page. He cannot use a Poll Server
Control when redirecting to an action page.

n Redirect to a file or page - Identify a file or a page on your Web
site that is launched when the visitor completes the form

- An example of a file is a white paper (a common file format is
.PDF) that a visitor requested

- An example of a page is one that prompts the visitor to download
your product

n Redirect to form data to an action page - See Redirect to an
Action Page and Forward Form Data on the facing page

n Report on the form - See Making Form Results Available to Site
Users on page 7-218

10. Now that you have completed information about the form, you can
enter the form’s content. This procedure is described in Creating a
Form’s Content on page 7-220.

Composing the Postback Message
The postback message can contain text or graphics, just like any other HTML
content. Typically, it acknowledges a site visitor’s completion of the form.

For most sample forms provided, sample text appears in the editor. Modify it as
you wish, using Ektron CMS400.NET’s editor to change the style sheet class,
insert library items, etc.

Inserting Fields into the Postback Message
You can also insert fields into the Postback Message that retrieve form
information. For example, your postback message may be

Thank you «Full Name» for completing the «[Form Title]».

When the postback message appears, it looks like this.

Thank you Jay Kohler for completing the breakroom survey.

When you click the Post back message tab and select Display a message,
the Merge Field button ( ) appears on the toolbar.
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When you click that button, a dialog like the one below appears.

All form fields appear on the list. In addition, the list includes the following
fields, which can retrieve form information into the postback message.

n Form title

n Form description

n Date submitted

Redirect to an Action Page and Forward
Form Data
Redirecting Submitted Form Data on page 7-249 explains how your
administrator sets up the action page. After your administrator follows that
procedure, he identifies a folder and hyperlink that you use to select an action
page.

Redirect to an Action Page and Forward FormData
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Warning! You must have the folder and hyperlink name from your administrator to complete this
procedure.

To redirect submitted form data to an action page, follow these steps.

1. Go to the page on which you determine the form’s response. If this is
a new form, it is page 3 of the Forms Wizard.

To modify an existing form, select the form’s folder, then the form.
Next, select Edit and click the Post back message tab.

2. Select Redirect form data to an action page.

3. Click the icon next to File or page.

4. The Hyperlink Manager dialog appears. Click the URL button.

5. The library appears. In the left panel, select the folder that contains
the hyperlink.

6. In the right panel, select Hyperlinks from the file type dropdown.

7. Select the hyperlink whose name was given to you by your system
administrator.

8. Click the insert button ( ).

Making Form Results Available to Site Users
When you create polls and surveys, you can choose to display the results after a
site visitors completes the form. The results can display in the same window or
a new window. In addition, you can choose how to chart the data. For a
description of chart types, see Chart Types on the facing page.

To show site visitors poll/survey results, follow these steps.
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1. Go to the page on which you determine the form’s response. If this is
a new form, it is page 4 of the Forms Wizard.

To modify an existing form, select the form’s folder, then the form.
Next, select Edit and click the Post Back Message tab.

2. Select Report on the form.

3. Choose whether you want the results to appear in the Same
Window or a New Window.

4. Choose the style of the report.

Chart Types
The following table describes the types of charts available.

Chart
Type

Description Sample

Data Table The poll or surveyanswersare displayed with the
percentage of userswho responded to each item.

Chart Types
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Chart
Type

Description Sample

Bar Chart
The poll or surveyanswersare displayed with a bar
graph. Use this chart type when you want a quick visual
representation of the responses.

Pie Chart
Displaysa standard pie chart. Poll or surveyanswersare
color coded, and the percentage of people who chose
each answer is shown.

Combined Combines the Data Table and the Bar Chart.

Warning! You cannot chart data entered into a text box. For example, if one choice in a poll is
Other, and the survey has a text box for site users to enter additional information, the text in the
box is not charted. However, the fact that a user chose Other is charted.

See Also: The Structure of Form Data on page 7-214

Creating a Form’s Content
Here is an example of form content that you can create.
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Note that some fields are required, and some provide a dropdown list of
choices. You can learn how to create such a form by following the directions
below.

This section also contains the following topics.

The Form Toolbar Options 7-221
Adding a Field to the Screen 7-222

The Form Toolbar Options
Creating form content is similar to creating standard content. (See Adding
HTML Content on page 7-15). The big difference is a form toolbar (illustrated
below), which lets you insert form elements.

When using the form toolbar, place the cursor where you want field. Then, click
the appropriate toolbar button.

The Form Toolbar Options
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Adding a Field to the Screen
The final screen of the Forms setup lets you arrange a form that collects exactly
the information you want. To create the form, insert fields that prompt a site
visitor to enter information. Then, add a button that enables the user to submit
data.

If you chose a sample form at the beginning of the Forms Wizard, the form
includes fields. If you did not, the screen has only a Submit button.

Note: In addition to inserting fields, you can add explanatory text, lines, images, etc. to the
form. To lay out fields in columns, insert a table and place the fields within table cells.

The table below explains each field type you can enter.

Button
Inserts
this kind
of field

Description
For more
information, see

Checkbox User’s response is either checked or unchecked
Inserting a
CheckboxField on
page 7-225

Text Free text field; user cannot format text
Inserting a Text
Field on page 7-
226

Choices Several choicesappear on screen. User checksanynumber
of appropriate responses.

Inserting a Choices
Field on page 7-
236

Calendar Lets user insert a date by clicking a calendar
Inserting a
Calendar Field on
page 7-240

Insert
Button

Button with no text. You can easily add text to it.

When a site visitor completing the form presses this button,
the data on the screen is submitted to your Web server.

Inserting or Editing
Buttonson the
Form on page 7-
244

Insert
Reset

Button withReset as its text. When a site visitor completing
the form presses this button, the form’s field valuesare set to
their state when the form first loaded.

Inserting or Editing
Buttonson the
Form on page 7-
244

Insert
Submit

Button withSubmit as its text.

When a site visitor completing the form presses this button,
the data on this screen is submitted to your Web server.

Inserting or Editing
Buttonson the
Form on page 7-
244

After you complete the form, you have the following options.
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Button or
Tab

Description

Postback
Message

SeeComposing the PostbackMessage on page 7-216

Metadata Edit themetadata for the form. See Also:Working with Metadata on page 7-141

Schedule Assign start or end dates, or both, for when the form is published toWeb site See Also:
Scheduling Content to Begin and End on page 7-187

Comment Enter history comment to indicate changesmade to the form

Templates

The template assigned to the form.

Note: TechnicalHTML formsmust reside in a folder whose template uses the FormBlock
server control.

See Also:Creating/Updating Templateson page 7-178

Category Any taxonomycategories assigned to the content. See Also: Taxonomyon page 9-202

Web
Alerts

Assign or updateWeb Alert information for the form. SeeAdministering theWeb Alert
Feature on page 23-1.

Submit Submit content into approval process.

Publish

Publish content toWeb site.

Note: If the content hasanyactive tasks, a commentswindow popsup. You can insert
comments to describe how approving or declining the content affects the task.

Note: Only the last approver in the approval chain sees this button.

Check
In

Save and check-in content. This button doesnot submit the content into the approval process,
but rather lets other users change it.

Save
Save the content without submitting it into the approval process.

If a user clicks save and then closes the editor, other users cannot edit the content.

Decline

This button appears if you are the next approver in the approval list. Click it to decline the
changesmade to the content.

Note: If content hasanyactive tasks, a commentswindow popsup. You can insert
comments to describe how approving or declining the content affects the task.

Cancel Close the editor without saving changes.

Adding a Field to the Screen
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Next, click the Save and Submit or Publish button ( ). The form only appears
on your Web site after it is published.

After you complete and save the form, it may need to go through the approval
process. When that is complete, add it to the site by assigning it to a page
template. See Implementing a Form on a Web Page on page 7-245.

Form Validation
You can apply validation rules to text or calendar field types. Validation rules
ensure that the information entered by site visitors meets your criteria. For
example, a validation rule specifies that a response to the Telephone field is
10 digits. If the response does not conform, an error message indicates the
problem. The input must conform before the form can be submitted.

For a list of validation rule types, see Validation Options on page 7-229.

When Validation Rules are Applied
Validation rules are applied when a site visitor submits an entire form, not when
the input is entered. If an invalid response is found, the error message that you
define appears.

The site visitor must change his response to conform to the validation rule.
When he does, the next field is checked and, if that is invalid, its error message
appears, etc.

Note: If you want to change the visual indicator that a field’s response is invalid, see the
following Ektron CMS400.NET KB article: http://dev.ektron.com/kb_article.aspx?id=7070.

Note: If you apply validation rules to more than one field, include the field name in the error
message. For example, enter The name field only allows text.
This is good practice because error messages only appear after a form is submitted. If the
message does not identify the field, the user may not know which field needs correction.

Form Fields
You can insert several types of fields onto an HTML form.

This section also contains the following topics.

Inserting a Checkbox Field 7-225
Fields on the Checkbox Dialog 7-226
Inserting a Text Field 7-226
Fields on the Text Field Dialog - General Tab 7-227
Fields on the Text Field Dialog - Validation Tab 7-228
Validation Options 7-229
Custom Validation 7-232
Example of Creating Custom Validation 7-233
Fields on the Text Field Dialog - Data Style Tab 7-236
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Inserting a Choices Field 7-236
Fields on the Choices Dialog 7-238
Inserting a Calendar Field 7-240
Fields on the Calendar Field Dialog - General Tab 7-242
Fields on the Calendar Field Dialog - Validation Tab 7-243
Fields on the Calendar Field Dialog - Data Style Tab 7-243

See Also: Inserting or Editing Buttons on the Form on page 7-244

Inserting a Checkbox Field
A Checkbox field is one character wide and accepts one of two possible values:
checked or unchecked. For example

To insert a checkbox field, follow these steps.

1. Place the cursor where you want the check box field to appear.

2. Click the Checkbox field button ( ).

3. The following dialog appears.

Inserting a Checkbox Field
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Fields on the Checkbox Dialog

Field Description

Descriptive
Name Enter a descriptive name for this checkbox.

Field
Name

Enter a name for this checkbox. This text identifies the field in the database and in email (if the
form ismailed).

Note: You cannot enter spacesnor most special characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~)
into this field. If you do, theyare replaced byunderscores.

Tool Tip
Text

Enter text that appearswhen a site visitor hovers the cursor over this field (circled in red below).

Default
value

If you want this field to be checked when the screen first appears, clickTrue. Otherwise, click
False.

A site visitor can change the default value while completing the screen.

Caption
Enter text to guide the user’s response to this field. The caption appears on the screen to the
right of the checkbox.

To continue the above example, the caption would beCheck if you are over 65.

Inserting a Text Field
Use a text field when you want the user to enter a free text response, or to
display text on the screen. There are many variations you can apply to such a
field, such as

n a default value

n text can be read-only or hidden

n the field can expand to accommodate user input

n validation, requiring user input to meet criteria such as a non-
negative whole number or a zip code

To insert a text field, follow these steps.

1. Enter a field label. For example, Name.

2. Place the cursor where you want the text field to appear.

3. Click the Text field button ( ).
4. The following dialog appears.
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Fields on the Text Field Dialog - General Tab
Note: If you are using FireFox, you cannot enter text into a text field while creating or editing
the form. If you need to prefill a text field with text, use the field’s Default Value property.

Field Description

Descriptive
Name

Enter a description of the field. This text describes the field on form reports. SeeViewing Form
Reportson page 7-252.

Field
Name

Enter a name for this field. This text identifies the field in the database and in email if the form is
mailed.

Note: You cannot enter spacesnor most special characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~)
into this field. If you do, theyare replaced byunderscores.

Tool Tip
Text

Enter text that appears if a site visitor hovers the cursor over this field (circled in red below).

Default
value

If you want to set a default value for this field, enter it here. For example, if this field collects a
city, andmost users enter New York, enter New York as the value.

A site visitor can change the default value while completing the screen.

Allow
multiple
lines

Check this box if you want this field to scroll vertically to allow the person completing the form to
enter asmuch text asneeded.

Note: This setting cannot be applied if this is aPassword field.

Fields on the Text Field Dialog - General Tab
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Field Description

Cannot be
changed

Check this box to prevent the person completing this field from changing its content. For
example, you want to display a license agreement.

Below this field, youmight place a checkboxprompting the site visitor to check it to indicate he
has read the agreement.

Asanother example, you could provide instructions for completing the screen.

Invisible

Check tomake this field hidden. This option lets you store unseen information in each
document. An examplemight be putting a version number on the form.

If you apply this property to a form, theAllow multiple lines andCannot be changed fields
are automatically checked and cannot be unchecked. Also, theValidation tab is disabled.

Password
field

Use a password field when you want the user to enter a password. A password is like a text field
but the user’s entry is disguised. This prevents an onlooker from seeing the password.

Passwords cannot exceed 18 characters.

Fields on the Text Field Dialog - Validation Tab

Field Description

Validation
Select the kind of validation to apply to this field. SeeValidation Optionson the facing page

Your system administrator determineswhether a user can save an invalid document.
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Field Description

Message

Enter text that appears on the screen if a site visitor‘s response violates the validation criterion.
For example, if the validation criterion is telephone number, the error message could bePlease
enter 7 or 10 digits. It would appear if the user entered, for example, S061882.

Bydefault, the error messagematches the selected validation criterion. Use this field to
customize the text.

Note: You can only enter double-byte characters if your Windowssettings include that
language. If you enter characters that are not in a language defined in your Windows
settings, questionmarks (?) appear instead of the characters.

Custom
Validation SeeCustomValidation on page 7-232.

Validation Options
Note: Your Web developer can customize validation options. For details, see ”Customizing
Validation” on page -1211. However, the file that maintains custom validation is different for
HTML forms: it is siteroot/workarea/ContentDesigner/ValidateSpace.xml.

**Option Characteristics of Valid Response

Used
with
text
field

Used
with
calendar
field

No
validation Response is not checked.

Cannot be
blank Response is required. The format of the response is not checked.

Allow
Maximum
of 1000
characters

Response cannot exceed 1000 characters. (Only available if text field
is set toAllow Multiple lines.)

Minimum
of 8
characters
with at
least one
digit

Site visitor’s entrymust be at least 8 characters and include one digit.
(Only available if text field is set toPassword field.)

Non-
negative
whole
number or
blank

A positive whole number or no response.

Validation Options
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**Option Characteristics of Valid Response

Used
with
text
field

Used
with
calendar
field

Non-
negative
whole
number
(required)

Decimal
number or
blank

A decimal number (for example, 12.345 or 12) or blank. A leading
minus sign “-” is allowed. The decimal point must be a period (.), even
in locales that normally use a comma (,).

Note: Decimal numbers include whole numbersbecause the
decimal point is implied. That is, 12 is 12.0000.

Decimal
number
required

A decimal number (it cannot be blank) of none, one, or two decimal
places.

A leadingminus sign “-” is allowed. The decimal point must be period
(.), even in locales that normally use a comma (,).

Note: Decimal numbers include whole numbersbecause the
decimal point is implied. That is, 12 is 12.0000.

Percent:
(0-100)
required

Awhole number from 0 to 100. A response is required.

email
address a@a, where a is one or more characters.

email
address
required

a@a, where a is one or more characters. A response is required.

email
address
list

Several email addresses. Each address’s format isa@a, where a is
one or more characters. The user must separate each addresswith a
semicolon (;).

email
address
list
required

Several email addresses. Each address’s format isa@a, where a is
one or more characters. The user must separate each addresswith a
semicolon (;). A response is required.

Zip code
(US) 5 (nnnnn) or 9 digits. If 9, a dash appears after the fifth (nnnnn-nnnn).
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**Option Characteristics of Valid Response

Used
with
text
field

Used
with
calendar
field

Zip code
(US)
required

5 (nnnnn) or 9 digits. If 9, a dash appears after the fifth (nnnnn-nnnn).
A response is required.

Social
Security
(US)

Nine digits in this pattern: nnn-nn-nnnn.

Social
Security
(US)
required

Nine digits in this pattern: nnn-nn-nnnn.A response is required.

Postal
Code
(Canada)

ana nan, where a is an alphabetic character and n is numeric.

Postal
Code
(Canada)
-
(required)

ana nan, where a is an alphabetic character and n is numeric. A
response is required.

Social
Insurance
Number
(Canada)

A nine digit number in the format: nnnnnnnnn.

Social
Insurance
Number
(Canada)
Required

A nine digit number in the format: nnnnnnnnn.A response is required.

Telephone
number
(US and
Canada)

A seven or 10 digit number in the format nnnnnnn or nnnnnnnnnn.

The site visitor can insert separator characters, such asdashes (-),
between numbers.

Telephone
number
(US and
Canada)
(required)

A seven or 10 digit number in the format nnnnnnn or nnnnnnnnnn.

The site visitor can insert separator characters, such asdashes (-),
between numbers.

A response is required.

URL Aweb site address.
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**Option Characteristics of Valid Response

Used
with
text
field

Used
with
calendar
field

ISBN

The InternationalStandard BookNumber (ISBN) is a 10 or 13-digit
number that uniquely identifies booksand book-like products
published internationally.When printed, the ISBN number is
preceded by the letters ISBN.

(Above copied fromwww.isbn.org.)

For more information, go to www.isbn.org.

ISSN

The ISSN (InternationalStandard SerialNumber) is an eight-digit
number which identifies periodical publicationsas such, including
electronic serials.

The ISSN takes the form of the acronym ISSN followed by two groups
of four digits, separated bya hyphen. The eighth character is a control
digit calculated according to amodulo 11 algorithm on the basis of the
7 preceding digits; this eighth control character maybe an “X” if the
result of the computing is equal to “10”, in order to avoid ambiguity.

(Above copied from www.issn.org.)

Custom Validation
The Text and Calendar field dialog’s Validation tab features a validation area
(illustrated below).

The validation feature can ensure the following aspects user input.

n The data type - the default types are
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- text

- URL

- whole number

- decimal number

- floating point number (Floating point includes scientific notation, so is
appropriate for scientific numbers. Decimals usually suffice for business
numbers.)

- date (calendars only)

n The field value has one of the following relationships with another
field, a number, or an expression. The default expressions are

- between two values (either another field or a number that you specify)

- less than

- equal to

- not equal to

- maximum length (usually for text responses)

Note: Your Web developer can customize validation options. For details, see Customizing
Validation on page 7-680. However, the file that maintains custom validation is different for
HTML forms: it is siteroot/workarea/ContentDesigner/ValidateSpace.xml.

Your system administrator determines if a user can save the invalid data.

When the Custom Validation option is selected from the Validation field, the
Custom Validation screen area becomes active.

n The Data Type field is the value’s basic type, for example, text,
number, or URL.

n The Condition field displays the validation logic.

n The Examples drop-down list shows validation expressions that you
can apply to the field.

Example of Creating Custom Validation
As an example of custom validation, assume that a field collects telephone
numbers, and you want to make sure the user enters 10 digits. To accomplish

Example of Creating CustomValidation
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this, follow these steps.

1. Insert a Text Field.

2. Complete the Text Field dialog’s General tab.

3. Click the Validation tab.

4. In the Validation dropdown list, select (Custom).

5. In the Data Type field, selectWhole Number from the drop down
list. This ensures that the user can only enter digits.
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6. Click the down arrow to the right of the Examples field to see
sample logic.

7. Click Maximum text length... . This option lets you specify the
length of the user’s response.

8. string-length(.) <= {X} appears in the Condition field.

9. Since you want the user’s input to equal 10, remove the less than
sign (<) from the calculation. Now it looks like this: string-length(.)
= {X}.

10. Replace the {X} with 10. Now, it looks like this: string-length(.) =
10.

11. Move the cursor up to the Message field and compose a relevant
error message. For example: must be 10 digits.

12. Your screen should look like this.

Example of Creating CustomValidation
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13. Press OK.

Fields on the Text Field Dialog - Data Style Tab
Click the Data Style tab to apply formatting to a field that accepts user input.
When you do, the following tab appears.

Use the tab to assign the following formatting attributes to a response field.

n Font style and size

n Bold and italic

n Text alignment (especially helpful for formatting dollar amounts in a
plain text field)

n Underline or strikethrough

n Font color and/or background color

Inserting a Choices Field
Use a Choices field when you want a site visitor to select from a predetermined
list. You can allow a site visitor to select only one or more than one choice. You
can also determine the list’s items and appearance.

To insert a choices field, follow these steps.

1. Enter a field label. For example, Country.

2. Click the Choices field button ( ). See Also: Adding a Field to the
Screen on page 7-222

3. The following dialog appears.
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Fields on the Choices Dialog

Field Description

Descriptive
Name

Enter a description of the field.

This text describes the field on form reports. SeeViewing FormReportson page 7-252.

Field Name

Enter a name for this field. This text identifies the field in the database and in email if the form is
mailed.

Note: You cannot enter spacesnor most special characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~)
into this field. If you do, theyare replaced byunderscores.

Tool Tip
Text

Enter text that appearswhen a site visitor hovers the cursor over this field (circled in red
below).

List

Custom - You create your own set of choices. Use the Item List area to do this. See Also:
Item List on page 7-240

Languages - A standard list of languages

Countries - A standard list of countries

U.S States and Territories - A standard list of United States of America states
and territories

Canadian Provinces - A standard list of Canadian provinces

Age Ranges - A standard list of age ranges

Numeric Ranges - A standard list of numeric ranges

Years - A standard list of years

Gender - Male or female

Marital Status - A standard list marital statuses

Allow
Selection

ClickMore than one to let a site visitor select more than one item for this field. Otherwise, click
Only one to limit the user to one choice.

A selection is required - Check this box if the user must select at least one item.

First item is not a valid selection - You can use the first list item to prompt the user to
make a selection instead of being a valid response. For example, the first itemmaysaySelect
from the list. To do so, check this box.

If you do, the site visitor must choose any selection except the first item. If he tries to file the
screen without choosing a different item, this error message appears: First item is not a
valid selection.

Note: This option is only available ifAppearance is set toDrop List.
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Field Description

Appearance

Option Example

Vertical List - arranges
choices vertically

Horizontal List - arranges
the choiceshorizontally

List Box - displaysall choices
in a box. If more than four
choicesare available, the user
scrolls to see additional
options.

Drop List - displaysall
choices in a dropdown list.
When the user clicks the down
arrow, all entries appear.

Fields on the ChoicesDialog
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Field Description

Item List

This section of the screen displays the list items. It is only editable if the list type isCustom.

The Context-Sensitive Menu

Buttons to the left of each item (circled below) display amenu. Themenu lets you remove
items, rearrange them, and insert additional itemsanywhere on the list.

The Selected Box

Place a check in the boxof any item to be checked bydefault on the data entry screen. If you
do, the user can accept the default or uncheck the item byclicking in the checkbox. Note that if
Only One is selected under Allow selection (above), only one item can be selected.

If theAppearance is set to Drop-Down list, this value is ignored.

Display Text

Enter text to describe this item on the data entry screen.

Value

Enter the value that is collected when the site visitor selects this item.

For example, if Interests appears in the Name field, and you want music to be collected
when the data entry user selects this item and saves the page, entermusic here.

The Disabled Checkbox

Check the boxnext to any selection that you want to disable. If you do, the option appears on
the form but the user cannot select it.

Option

Click this button to add a row to the bottom of the list.

Inserting a Calendar Field
To insert a field that lets a site visitor select a date, use a Calendar Field. To do
that, follow these steps.

1. Enter a field label. For example, Expiration Date.

2. Click the Calendar field button ( ). See Also: Adding a Field to the
Screen on page 7-222

3. The following dialog appears.
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Respond to the fields on the screen.

See Also:

n Fields on the Calendar Field Dialog - General Tab on next page

n Fields on the Calendar Field Dialog - Validation Tab on page 7-243

n Fields on the Calendar Field Dialog - Data Style Tab on page 7-243

Inserting a Calendar Field
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Fields on the Calendar Field Dialog - General Tab

Field Description

Descriptive
Name

Enter a description of the field.

This text describes the field on form reports. SeeViewing FormReportson page 7-252.

Field
Name

Enter a name for this field. This text identifies the field in the database and in email if the form is
mailed.

Note: You cannot enter spacesnor most special characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~)
into this field. If you do, theyare replaced byunderscores.

Tool Tip
Text

Enter text that appearswhen a site visitor hovers the cursor over this field (circled in red below).

Default
value

If you want to set a default date, enter it here. The site visitor can change the default value while
completing the screen.

Validation

Select the kind of validation to apply to this field. The choicesare:

n No validation - response is not checked

n Cannot be blank - Response is required. The format of the response is not checked. If
you assignCannot be blank, the field is surrounded by red dasheswhen it appears on your
Web site.

n Custom - SeeCustomValidation on page 7-232

Error
Message

Enter text that appears if a site visitor‘s response doesnot satisfy the validation criterion. For
example, if the validation criterion isCannot be blank, the error message could bePlease
enter a response.

Bydefault, the error message is the same as the validation criterion. Use this field to customize
its text.

Note: You can only enter double-byte characters if your Windowssettings include that
language. If you enter characters that are not in a language defined in your Windows
settings, questionmarks (?) appear instead of the characters.
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Fields on the Calendar Field Dialog - Validation
Tab

Field Description

Descriptive
Name

Enter a description of the field.

This text describes the field on form reports. SeeViewing FormReportson page 7-252.

Validation

Select the kind of validation to apply to this field. The choicesare:

n No validation - response is not checked

n Cannot be blank - Response is required. The format of the response is not checked. If
you assignCannot be blank, the field is surrounded by red dasheswhen it appears on your
Web site.

n Custom - SeeCustomValidation on page 7-232

Message

Enter text that appears on the screen if the site visitor‘s response doesnot satisfy the validation
criterion. For example, if the validation criterion isCannot be blank, the error message could
bePlease enter a response.

Bydefault, the error message is the same as the validation criterion. Use this field to customize
it.

Note: You can only enter double-byte characters if your Windowssettings include that
language. If you enter characters that are not in a language defined in your Windows
settings, questionmarks (?) appear instead of the characters.

Fields on the Calendar Field Dialog - Data Style
Tab
See Fields on the Text Field Dialog - Data Style Tab on page 7-236

Editing a Form Field
To edit a form field, follow these steps.

1. Click inside the field. It becomes surrounded with small squares.

2. Click the toolbar button that corresponds to the field type. See Also:
The Form Toolbar Options on page 7-221

3. The dialog appears for that field type.

4. Edit as needed. See Also: Form Fields on page 7-224

5. Press OK.
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Inserting or Editing Buttons on the Form
A form typically includes one or more buttons, which let a site visitor submit a
completed form.

eWebEdit400’s form toolbar has three buttons that you can place on a form
(circled below.) The buttons are described below.

Toolbar

Button
Name Description

Insert Submits form information to your Web server. Bydefault, it hasno text. To learn how to
add button text, seeEditing a Button’sPropertiesbelow.

Reset Changesa form’s field valuesback to their state when the form first loaded.

Submit Submits form information to your Web server. Its default text isSubmit.

Editing a Button’s Properties
After you insert a button, you may want to enter or change its properties, such
as its text, height, and width. To edit a button’s properties, follow these steps.
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1. Click the button so that it is selected. A selected button is surrounded
by small squares, as shown below.

2. Below the editor screen, several fields appear, as shown below.

3. Update the button fields as needed.

Field Description

Name Give the button a unique name.

Id If needed, give the button a unique ID.

Width Enter or change the button’swidth in pixels.

Height Enter or change the button’s height in pixels.

Value Enter or change the button text.

Tooltip Enter or change the button’s tooltip (that is, text that appears in a smallwindow when someone
hovers themouse over the button).

Classname Enter or change the style sheet classassigned to the button.

Implementing a Form on a Web Page
After you create the form, you need to link it to another page on your Web site.
You would insert the link as you would any form link. See Adding a Library File
to Content on page 8-16

Next, open your Web Site, navigate to the host page, and click the hyperlink to
access the form. Now, you can test the form and make sure it works as you
expected. If needed, you can return to edit mode, change the form, and test it
again until you are happy with it.

Sending Data as XML
While creating a form that generates email, you can specify that the email be
sent as XML data or plain text.

XML has the following advantages over plain text.

Implementing a Form on aWeb Page
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n Because XML data is structured, you can easily parse the content to
store and retrieve important information.

n If you download the form data to an Excel spreadsheet, the XML tags
become the spreadsheet’s column headers. See Also: Exporting a
Form’s Raw Data on page 7-258

This section contrasts XML and plain text email using the form displayed below
as the example. Here is an example of a form before it is submitted.

The following table displays the resulting email, depending on the method used.

Form sent as Generated email

Plain Text
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Form sent as Generated email

XML

XML email Structure
A form’s XML structure consists of two groups of XML tags:

n Form and mail elements

n Data elements

The following image illustrates the sections of XML email structure.

The following explains the sections of the XML email.

Root Tag
The XML email is wrapped in <cmsMail> root tags.

XML email Structure
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Form and Mail Tags
The form and mail tags display information about the form that was generated
from the form information.

This illustration compares the information defined for the form with the
information in the XML email.

The following table explains each XML tag in the form and mail sections of the
email.

XML Tag Description

<FormTitle> Title given to the form that was submitted.

<FormDescription> Description given to the form that was submitted.

<date> Date and time the formwassubmitted.

<MailTo> To email address(es) defined in the form.

<MailFrom> From email address(es) defined in the form.

<MailCc> CC address(es) defined in the form.

<MailSubject> Subject for the generated email defined in the form.

<MailPreamble> Preamble for the generated email defined in the form.
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Data Tags
The XML email’s data tags wrap the information entered by the form’s
submitter. Each form element in the content becomes an XML tag.

The following image illustrates how a form is edited in the editor, displayed on
a Web page, and then converted to XML for the email.

As shown in the graphic, the content is comprised of form elements that are
converted to XML tags.

Redirecting Submitted Form Data
This section explains how to redirect submitted form data to an action page.
Because the data is redirected via server transfer, you can easily customize the
handling of a multi-page form.

Users can select this option when creating or editing a form response, as
illustrated below.

Data Tags
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Instructions for how a user chooses a hyperlink to an action page are in
Redirecting Submitted Form Data on previous page.

Important: If your form will redirect the user to an action page, it must be implemented using a
FormBlock server control. You cannot use a Poll server control when redirecting to an action
page.

Note: If a form’s specifications indicate that its data is saved to a database, the data is saved
before being forwarded to an action page.

The following section explains how to set up a hyperlink to the action page in
preparation for a user’s selection.

Setting Up the Action Page
1. Create the action page. It must

- load and use the form variables

- have an .aspx extension

- reside in the same web application as your Web site

Warning! If your site is using URL Aliasing, the action page’s header must include the following:
EnableEventValidation="false" EnableViewStateMac="false"

2. Place the action page in your Web site’s root folder.

3. Set up a library hyperlink to the .aspx page. Here’s how to do that:

- In Ektron CMS400.NET, go to the Library.

- Select Hyperlinks from the file type dropdown.

- Click the Add button ( ).
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- In the URL Link field, enter the path relative to the Web root to the
.aspx file you created in Steps 1 and 2. For example:

http://localhost/siteroot/ServerVariables.aspx

- Give the hyperlink a title and save it.

4. Inform your users of the hyperlink. They will select it when selecting
the form response.

Assigning a Task to a Form
While tasks typically help Ektron CMS400.NET users track content activities,
you can also assign a task to users or user groups whenever a form is
submitted.

For example, your Web site offers a free product demonstration to anyone who
completes a form. Whenever a site visitor submits the form, a task is assigned
to your sales department’s administrative assistant. He uses the information on
the form to schedule a demonstration. The sales manager can review the task
history to audit sales leads and ensure demonstration requests are being
handled in a timely manner.

To set up a task that it is assigned to users or groups whenever a site visitor
completes the form, follow these steps.

Note: You should be familiar with tasks before beginning this procedure. See Also: Assigning
and Reviewing Tasks on page 12-1

1. If you are creating a new form, assign the task at Step 3 of the Forms
Wizard.

If you are editing a form, assign the task on the form’s Edit Properties
screen.

In both cases, you identify only users and groups to whom the task will
be assigned whenever a site visitor completes the form. Ektron
CMS400.NET assigns the remaining task information.

2. You complete the form and make it available on your Web site.

3. A site visitor completes and submits the form.

4. A task is created and assigned to the users and groups you identified
in Step 1.

This section also contains the following topics.

Task Information 7-251
email Automatically Generated Upon Form Submission 7-252

Task Information
The task created upon form submission has the following information.

Assigning a Task to a Form
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Field Value

Title Form title, as entered by the author

Assigned to As set up by the user who created or edited the form

Assigned by User who created or last edited form

Priority Normal

TaskCategory Form Submission TaskCategory

Task type Form Submission Task

Created by User who created or last edited form

State Not specified

Due date Not started

Start date Not specified

Description

Data from form “form name” was received on date time.

form description

Name of every field on the form: value submitted by user into that field

email Automatically Generated Upon Form
Submission
An email is automatically sent to every user named in Step 1 above who has a
valid email address in the User Information Screen. The email’s subject line is
the form name. The body of the email contains the following information for
each field on the form.

n name

n value submitted by user

Viewing Form Reports
If a form is set to store data in the database, you can run a report that displays
the submitted data. To view a form report, follow these steps.

1. Navigate to the folder for which you want to view the report. The
View Contents of Folder screen appears.
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2. Click the form you want to view. (If you do not see your form in the
folder, make sure the Content Type drop-down box is set to All Types
or Forms.)

3. Click the View Reports button ( ).
4. The View Forms Report screen appears.

5. Enter report criteria using the following table as a reference.

Field Description

Start Date If desired, specify a start date. The report displaysonly
forms that were submitted on or after the start date.

End Date If desired, specify an end date. The report displaysonly
forms that were submitted on or before the end date.

Report Display Specify the format to display the report.

Select LegacyReport
Specify the version of the form or poll for which to get a
report. Using this option allowsyou to see the results from
previouspolls and forms.

6. Click the Get Result button to display the report.

This section also contains the following topics.

Display Formats 7-253
Table with Totals 7-253
Summary of Selected Choices 7-254
Table of Values 7-255
List of Submitted Values 7-256
Submitted Data as XML 7-257
Exporting a Form’s Raw Data 7-258

Display Formats
The submitted form data can be viewed in any of these formats.

n Table with Totals below

n Summary of Selected Choices on next page

n Table of Values on page 7-255

n List of Submitted Values on page 7-256

n Submitted Data as XML on page 7-257

Table with Totals
The table of values shows the following information for each completed form.

n a checkbox that lets you delete the response

Display Formats
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n an internal identification number of the response

n the name of the user who submitted the form, if he signed in to
Ektron CMS400.NET beforehand. If the user did not sign in,
anonymous appears.

n date response was submitted

n The name of each field on the survey

- under each field name is the submitted response for the each user

n the bottom line sums the numerical and percentage totals for each
response

Sample of Table with Totals Format

Summary of Selected Choices
This format totals, for choice and select type fields, the number of times each
choice was selected. Only choices that were selected at least once appear.
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Sample Summary of Selected Choices Format

Table of Values
The table of values shows the following information for each completed form.

n a checkbox that lets you delete the response

n an internal identification number of the response

Sample Summary of Selected Choices Format
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n the name of the user who submitted the form, if he signed in to
Ektron CMS400.NET beforehand. If the user did not sign in,
anonymous appears.

n date response was submitted

n descriptive name of each form field appears in the column header

- the value entered for each field appears below the header

Sample of Table of Values Format

List of Submitted Values
The List of Submitted Values format provides the same information as the Table
of Values, but is formatted vertically rather than horizontally. See Also: Table
of Values on previous page
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Sample List of Submitted Values Format

Submitted Data as XML
Displays the results of the form in an XML format. The following information is
included:

n <Title> - title of the form block

Warning!With polls you can create a new poll question to replace an existing poll question. By
default the poll still has the same Title, ID, and other properties. You can change the title of a new
poll question when you are editing the poll.

n <Description> - description of the form

n <SubmittedData> - information that was submitted

Sample List of Submitted Values Format
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Sample of Submitted Data as XML

Exporting a Form’s Raw Data
After you run a report, you can export its data to a Microsoft Excel spreadsheet
file (.xls) for further analysis. If a form uses an XML structure, each XML tag
becomes a column header in the spreadsheet.

To export form data, follow these steps.

1. Access the View Form Reports screen for the report you want to
export, as described in Viewing Form Reports on page 7-252.

2. Click the Export Report button ( ).
3. A File Download dialog box is displayed. Choose the option that best

suits your needs.

4. After the data is exported, you can analyze and modify the .xls file.

Viewing Form Information
After a form is created, you can view its information in the Forms folder. To
view a form, follow these steps.

1. Access the folder that contains the form you want to view.

2. Click the form you want to view.

3. The View Form screen displays.

4. Click the Form Properties tab.

5. The following table explains the information on the screen.
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Field Description

Form Title Title used to reference the form

FormID ID number automatically assigned to form

Status The form’s current status

Description Extended description for the form

FormData The type of form data: Mail or Database.

Form Submissions
Themaximum number of timesa user can submit the form. This is
typically used with polls and surveys to limit one user’s influence over
the results.

Assign Task to Users and groups to whom a taskwill be automatically assigned
whenever a site visitor completes the form.

Content Properties Displays the properties of the form’s content

Content Title
Title of content associated with form

Note: The content name is the same as the Form name.

Content ID Content ID number assigned to content

Status The statusof the content

Last Editor Last user to edit the content

Start Date Date and time when content will go live onWeb site (if set for future
date)

End Date Date and time when content will be removed fromWeb site (if set for
future date)

Date Created Date and time when content was created

This section also contains the following topics.

Mail Properties 7-260
Retrieving email Address from the Submitted Form 7-260
Retrieving Form Data Into the Subject and Preamble Fields 7-262

Viewing and Editing a Form’s Properties

To see and update additional form information that does not appear on the View
Form screen, view its properties. To do so, follow these steps.

1. Navigate to the form’s View Form screen, as described in Viewing
Form Information on previous page.
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ReferenceManual
Version 8.01 Rev 4

7-259



2. Click the Form Properties button ( ).
3. The Form Properties screen displays a subset of form information.

n Title and Description

n Database or Mail - if form data is emailed whenever a site visitor
submits it, enter mail property information below. See Mail
Properties below

n Autofill form values - checked by default, this allows the form’s fields
to fill automatically when a logged-in site visitor has previously
completed the form.

n Limit Submission - when checked, you can enter the number of times
a user can submit a form in the Number of Submissions text field

n Assign task to - see Viewing Form Information on page 7-258

n Form block’s ID number

n Mail Properties

Mail Properties
Field Description

To
Email address to which the form is sent when submitted.

See Also:Retrieving email Address from the Submitted Form below

From Text that appears in the email’s From field. See Also:Retrieving
email Address from the Submitted Form below

CC Text that appears in the email’s CC field. See Also:Retrieving email
Address from the Submitted Form below

Subject Text that appears in the email’s subject field. See Also:Retrieving
FormData Into the Subject and Preamble Fieldson page 7-262

Preamble Beginning text of the email. See Also:Retrieving FormData Into the
Subject and Preamble Fieldson page 7-262

Send data in XML
Format

A green checkmeansemail data will be in a structured XML packet.

A red Xmeans the email data will be in a standardmailto format.

For more information, seeSending Data asXML on page 7-245.

Retrieving email Address from the Submitted
Form
In the Mail Properties section of the Edit Form screen, you can select email
addresses submitted on the form to be inserted into these Mail Property
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fields:

n To

n From

n CC

So, instead of entering a static email address, it can be dynamically retrieved
from the user’s form submission. For example, you want to retrieve the “from”
field of an email from the information a user enters when completing the form.

To do this, use the OR to addresses in field dropdown lists circled below.
These lists contain fields that dynamically retrieve data from the submitted
form.

Note that the To and CC fields can accept fields whose validation type is email
address or email address list. On the other hand, the From field can only
accept fields whose validation type is email address (that is, a single email
address).

To set this up, follow these steps.

1. Add a form field whose Validation type is Email address or Email
address list . The field prompts the user completing the form to
enter his email address. Label the field something like Enter your
email address.

Note: If the field allows more than one address, add on-screen instructions to separate each
address with a semicolon (;).

2. Go to the Edit Form screen > Mail Properties section.

3. Move to the field labeled From:.
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4. At the dropdown list following OR to addresses in field, select the
field you created in Step 1.

Now, when a user completes the form, the value he enters in the field created
in Step 1 is used for the email’s From address.

Retrieving Form Data Into the Subject and
Preamble Fields
You can retrieve data from a submitted form directly to the form’s Subject and
Preamble fields. (The subject is a standard mail field, and the preamble is text
that appears at the beginning of the email.)

For example, the form may provide a list of your products. While the user is
completing the form, he selects a product that he is interested in. The product
then becomes the subject line of the email.

Note: Since a Textarea field can span multiple lines, it can only be used with the preamble.
However, a plain text field can be used with both the subject and preamble.

To retrieve data dynamically from a form field into the email’s subject line or
preamble, follow these steps.

1. Add a form field that collects the information you want to insert into
the email’s subject line or preamble. See Also: Adding a Field to the
Screen on page 7-222

2. Go to the Edit Form screen > Mail Properties section.

3. Move to the field labeled Subject or Preamble.

4. At the dropdown list following OR use text in field, select the field
you created in Step 1.

Editing a Form
After you create a form, it can easily be edited if information needs to be
changed. You can update the following information by following the procedure
below.

n the form fields

n post back message

n metadata

n schedule

n comments

n Web Alerts

However to edit a form’s Title, Description, form data, or task values, use the
Edit Properties screen.

To edit a form, follow these steps.
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1. Access the View Form screen for the form you want to edit, as
described in Viewing and Editing a Form’s Properties on page 7-259.

2. Click the Edit button ( ).
3. The Edit Form screen is displayed. The screen is the same as the Add

New Form screen. For documentation of individual fields, see
Creating a New Form on page 7-214.

4. Make the necessary changes to the form.

5. Click the Save button ( ).
This section also contains the following topics.

Editing a Form's Content 7-263
Editing a Form’s Properties 7-263
Mailto or Database Form 7-264
Advantages of a Mailto Form 7-264
Storing Form Data in a Database 7-264

Editing a Form's Content
You can edit the content associated with the form by a variety of methods,
including:

n Accessing the content by the floating toolbar on the Web page

n Editing the content by the View Form screen

n Accessing the content by the View Form content properties screen

This section explains how to edit a form’s content from the View Form screen.
To edit a form’s content, follow these steps.

1. Access the View Form screen for the content, as described in Viewing
Form Information on page 7-258.

2. Click the Edit Content button ( ).
3. The Edit Content screen appears.

4. Make the necessary changes to the form’s content.

5. If you want to edit any field’s properties, place the cursor in the field,
right click the mouse, and choose Field Properties.

6. If needed, click the Postback Message, Metadata, Schedule,
Comment or Web Alerts tab to edit that information.

7. Click a workflow button (Submit for Publication or Publish).

Editing a Form’s Properties
See Viewing and Editing a Form’s Properties on page 7-259
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Mailto or Database Form
The Forms feature lets you create a mailto or a database form to use on your
Web site. When creating or editing a form, you must specify the type of form
you are creating. The options are:

n Send it via email

n Store it in a database

n Send it via email and store in a database

See Viewing and Editing a Form’s Properties on page 7-259 for information
about toggling this option on and off.

Advantages of a Mailto Form
By creating a mailto form, any email generation is done on the server-side, not
on the client. This means that site visitors can submit email whether or not the
client has email software.

Storing Form Data in a Database
By storing form data in the Ektron CMS400.NET database, you can keep
information submitted by site visitors and view reports on that information. You
can also export the form data to a spreadsheet.

Deleting a Form
You can easily delete forms that are no longer needed.

Note: Deleting a form also deletes its associated content and information.

To delete a form, follow these steps.

1. Access the View Form screen for the form you want to delete.

2. Click the Delete Form button ( ).

3. A confirmation message is displayed.

4. Click OK.

Creating Polls and Surveys
Polls and surveys are a type of form. All of the same functionality is available
and applies.

Important: For complete understanding of forms, polls, and surveys, you should read the entire
chapterWorking with HTML Forms on page 7-212.
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n A poll is generally one question and appears on a site for a very short
time: an hour or a day.

n A survey is usually multiple questions and appears on your site for a
longer time than a poll.

Note: For information on scheduling when your polls and surveys appear on the site, see
Scheduling Content to Begin and End on page 7-187.

With polls and surveys, you can show ongoing results to site visitors after they
submit their answers.

The following sections provide information about creating a poll or survey
beyond the normal form information.

n Working With Polls below

n Creating a Survey on page 7-269

n Making Form Results Available to Site Users on page 7-218

n Viewing Form Information on page 7-258

For information on how to display a poll or survey on a Web site, see Poll
Server Control on page 7-274.

Working With Polls
Below is an example of a poll. Note that when a site visitor hovers over the
poll, the question also appears as Tooltip text.

This subsection contains the following:

n Creating a New Poll in the Workarea on next page

n Replacing a Poll from the Web Site on page 7-267

n Editing a Poll from the Web Site on page 7-268
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Creating a New Poll in the Workarea
To create a new poll, follow these steps.

Note: You can also create a new edition of a poll in another language by copying an existing
poll and translating it. For more information, see Translating Content to Another Language on
page 7-108.

Note: For the steps to create a new form, see Creating a New Form on page 7-214. For the
steps to create a new survey, see Creating a Survey on page 7-269.

1. From the View menu, click Language, and select the language in
which to create the poll.

2. Click New > HTML Form/Survey.

3. The New Form screen appears.

Note: If you choose Standard Poll or Blank Survey, the number of steps in the Forms Wizard
changes from five to four. This happens because the Assign Tasks step is removed.

4. Choose Standard Poll. You can click the preview icon ( ) next to
any sample form to preview it before choosing it.

5. Click the Next button.

6. Enter or edit the form’s Title and Description.

n Title - used to reference the poll within the Workarea (required)

n Description - an extended description of the poll

7. Click the Next button.

8. This screen lets you add a poll question and possible replies.

Note: This screen allows you to add up to eight replies. If you have more than eight replies,
you can add them in the forms editor after clicking the Done button.

9. Click the Next button.
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10. This screen indicates that you have entered the basic poll information
and should click the Done button to further edit and view the form’s
fields.

11. After clicking the Done button, the form editor launches so you can
edit existing fields and properties. In addition, you can set post back
and schedule information, add metadata and comments, change the
title, and submit the poll for publication.

Note: From this screen, you can add more replies to your poll by right clicking on the choices
field and clicking properties. See Also: Inserting a Choices Field on page 7-236.

Replacing a Poll from the Web Site
When logged into Ektron CMS400.NET, you can right click on a poll and choose
New Poll to replace the current one. The title of the poll, its ID, and properties
stay the same. Only the questions and answers change.

To replace a poll, follow these steps.

1. Log into Ektron CMS400.NET.

2. Navigate to the Web page that hosts the poll.

3. At the location of the poll, click the silver access point and choose
New Poll.

4. The Workarea opens, indicating you are at step three of the Poll
Wizard.
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5. Add a new question to the Question text box.

6. Add possible responses to the Choices text boxes.

7. Click Next.

8. Click Done.

9. The form editor launches, allowing you to edit the fields and
properties. In addition, you can set post back and schedule
information, add metadata and comments, change the title and
submit the poll for publication.

10. Once published, the updated poll appears on the site.

Editing a Poll from the Web Site
To edit an poll on a Web site, follow these steps.

Warning! If you are logged into the site and create a new poll by right clicking on a poll selecting
New, the existing poll is replaced by the new one.

1. Log on to the Ektron CMS400.NET Web site.

2. Click the sliver access point on the poll you want to change and click
Edit.
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3. Make changes to the poll using the Forms editor.

4. Submit the poll to the Approval Process.

Creating a Survey
To create a new survey, follow these steps.

Note: You can also create a new edition of a survey in another language by copying an
existing form and translating it. For more information, see Translating Content to Another
Language on page 7-108.

Note: For the steps to create a new poll, seeWorking With Polls on page 7-265. For the steps
to create a new form, see Creating a New Form on page 7-214.

1. Consult with your Ektron CMS400.NET administrator about the folders
in which you should create polls. See Also: Forms Must Use Template
with FormBlock Server Control on next page

2. From the View menu, click Language, and select the language in
which to create the form.

3. Click the New > HTML Form/Survey.

4. The New Form screen appears.

Note:When you choose Standard Poll or Blank Survey, the number of steps in the Forms
Wizard changes from five steps to four steps. This happens because the Assign Tasks step is
removed.

5. Choose Blank Survey. You can click the preview icon ( ) next to
any sample form to preview it before choosing it.

6. Click the Next button.

7. Enter or edit the form’s Title and Description.

n Title - used to reference the survey within the Workarea (required)

n Description - an extended description of the survey.

8. Click the Next button.
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9. This screen lets you determine what happens after the site visitor
completes the survey. The choices are:

n Display a message - See Composing the Postback Message on
page 7-216

n Redirect to a file or page - Identify a file or a page on your Web
site that is launched when the visitor completes the form

- An example of a file is a white paper (a common file format is
.PDF) that the visitor requested

- An example of a page is one that lets the visitor download your
product

n Redirect to an action page and forward form data - See
Redirect to an Action Page and Forward Form Data on page 7-217

n Report on the form - See Making Form Results Available to Site
Users on page 7-218

10. Click the Next button.

11. A screen indicates that you have entered basic information about the
survey and should click the Done button to enter the survey’s
content. This procedure is described in Creating a Form’s Content on
page 7-220.

Forms Must Use Template with
FormBlock Server Control
HTML forms can only be created in a folder whose template uses a FormBlock
or Poll server control. In the Intranet sample site supplied with Ektron
CMS400.NET, the Contact Information folder uses such a template,
contactinformation.aspx (illustrated below).
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You can modify this template as needed or create your own form template and
assign it to any folder via its Folder Properties screen.

Since, by default, folders inherit properties from their parent folder, any new
folders created under a parent folder use the correct template. Of course, you
can break inheritance and assign a custom template for any folder.

FormBlock Server Control
The FormBlock server control displays a content block associated with a form.

Warning! If you create a template for an existing form content block, youmust
manually change its quicklink to point to the new template. This change does not
occur automatically. This procedure is described inUpdating Default Template for
Multiple Quicklinks on page 8-22.

When added to a template and visited, the form content block might look like
this. You can change the display to suit your needs by modifying its properties.

This section also contains the following topics.

FormBlock Server Control Properties 7-272
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Automatic versus Manual Generation of Form Tags 7-273

FormBlock Server Control Properties
The following table explains the properties of the FormBlock server control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value Data Type

AddValidation The AddValidation property is obsolete and ignored. It has
no effect. It is always true. Boolean

Authenticated

Indicates if you are logged in to the CMSExplorer and can
use it to browse to Content, Collections, etc. See Also:Using
CMSExplorer to Browse Your Ektron CMS400.NET Site on
page 24-8.

String

CacheInterval

Sets the amount of time the server control’s data is cached.
The default is 0 (zero). This is the amount of time, in
seconds, a control’s data is cached. For example, if you want
to cache the data for fiveminutes, set this property to 300
(three hundred). See Also:Caching with Server Controlson
page 24-33

Double

DefaultFormID

The ID of a FormBlock that appearswhere you inserted this
server control if no other form block is identified.

If you don’t know the ID number of the form block, use the
CMSExplorer to browse to it. See Also:Using CMSExplorer
to Browse Your Ektron CMS400.NET Site on page 24-8.

Long

DoInitFill

By default, Fill occurs during the Page_Init event. Set to
false if you want to postpone the fill-action until later. In this
case, FIll is automatically called during the Page Render
event.

Youmight do this if you need to set or change a property on
the control in codebehind and have it render with your
changes shown.

Boolean

DynamicParameter
Tomake this form blockdynamic, select id. When you do,
this server control uses the form blockpassed asa URL
parameter.

String

Fields

Displaysa list of fields that are defined in the form. These
fields are read only. This is an excellent wayof displaying the
field namesused on the form.

With this list of names, you can create events using the fields
without having to enter theWorkarea to see the names.

FormFieldCollection
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Property Value Data Type

Hide

Used to hide a form block in design time and run time.

True =Hide form block

False =Show form block

Boolean

IncludeTags
Determines if tagsare generated automatically of manually.
See Also:Automatic versusManualGeneration of Form
Tagsbelow

Boolean

Language
Set a language for viewing form content. This property
shows results in design-time (in VisualStudio) and at run-
time (in a browser).

Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the
control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line
portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes
to a blockof code.

Custom - Allowsyou to use a custom tag.

String

Automatic versus Manual Generation of
Form Tags
When using the FormBlock Server control’s IncludeTags property, you have
two options.

Option
Recommended if
you are developing

How to Enable

Let Ektron
CMS400.NET generate
form tagsautomatically

A pure script .aspx
page Set IncludeTagsproperty to True.

Automatic versusManual Generation of Form Tags
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Option
Recommended if
you are developing

How to Enable

ModifyHTML form tags
in .aspx file

An .aspxpage and
associated code-
behind web form

Set IncludeTagsproperty to False.

Here is the default .NET generated form tag:

<form id="Form1" method="post"
runat="server">

Modify the form tag as indicated in red:

<form id="Form1" method="post"
runat="server" OnSubmit=”return
EkFmValidate(this);”>

Poll Server Control
The Poll server control displays a poll or survey created from an Ektron
CMS400.NET form on a Web page. When added to a template and visited, the
poll might look like this. You can change a poll‘s appearance by modifying its
properties.

Ektron recommends displaying a poll or survey with a Poll server control,
because it provides great flexibility with the poll’s appearance. Typically,
developers want a poll or survey in a small section of a Web page, not the main
content. By using the EnableAjax property, you can display the results in the
same area as the poll or survey without refreshing the entire page.

However, if you want the form/poll/survey’s response to be either Redirect to
a file or page or Redirect form data to an action page, you must use a
Form Block server control to display the form on a Web page. See Also:
FormBlock Server Control on page 7-271

This section also contains the following topics.

Poll Server Control Properties 7-275
Automatic versus Manual Generation of Form Tags 7-276
Editing the Poll Result Display: Bar Chart 7-277
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Poll Server Control Properties
The following table explains the properties of the poll server control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

(Poll ID)

The ID of the poll that appearswhere you inserted this server control.

If you don’t know the ID number of the form block, use the CMS
Explorer to browse to it. See Also:Using CMSExplorer to Browse Your
Ektron CMS400.NET Site on page 24-8

Long

AddValidation The AddValidation property is obsolete and ignored. It hasno effect. It
is always true. Boolean

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
this property to 300 (three hundred). See Also:Caching with Server
Controlson page 24-33

Double

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

DynamicParameter Tomake this form blockdynamic, select ekfrm. When you do, this
server control uses the form blockpassed asa URL parameter. String

EnableAjax

Can displays the poll or results using an iFrame in the area of the page
that contains the poll. Asa result, the surrounding contents are not
disturbed . The default is true.

True - Polls and results are shown in an iFramewithout modifying or
refreshing the surrounding contents.

False - Poll and the results replace theWeb page’s content.

Boolean

Fields

Displaysa list of fields that are defined in the form. These fields are
read only. This is an excellent wayof displaying the field namesused on
the form.With this list of names, you can create events using the fields
without having to enter theWorkarea to see the names.
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Property Value
Data
Type

Hide

Used to hide a form block in design time and run time.

True =Hide form block

False =Show form block

Boolean

Include Tags Determines if tagsare generated automatically of manually. See Also:
Automatic versusManualGeneration of Form Tagsbelow Boolean

Language Set a language for viewing form content. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - Use to designate an in-line portion of an HTML document asa
span element

Div - Use to apply attributes to a blockof code

Custom - Allowsyou to use a custom tag

String

Automatic versus Manual Generation of Form
Tags
When using the poll server control’s IncludeTags property, you have two
options.

Option
Recommended if
you are developing

How to Enable

Let Ektron
CMS400.NET generate
form tagsautomatically

A pure script .aspx
page Set IncludeTagsproperty to True.

ModifyHTML form tags
in the .aspx file

An .aspxpage and
associated code-
behind web form

Set IncludeTagsproperty to False.

Here is the default .NET generated form tag:

<form id="Form1" method="post"
runat="server">

Modify the form tag as indicated in red:

<form id="Form1" method="post"
runat="server" OnSubmit=”return
EkFmValidate(this);”>
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Editing the Poll Result Display: Bar Chart
To edit the style and appearance of the bar chart, modify the following files

n siteroot/workarea/csslib/reportchart.css

n siteroot/workarea/controls/forms/HistogramReportPoll.xslt

Those files include extensive comments that explain how to customize the bar
chart's appearance.

Note: In the current version of Ektron CMS400.NET, pie charts are not editable.

Editing the Poll Result Display: Bar Chart
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Working with Smart Forms
Important: This section explains how to create and manage Smart Forms using the
eWebEdit400 editor. For documentation on doing this via eWebEditPro+XML, see
http://www.ektron.com/manuals/CMS400/v76/adminmanual.pdf > “Managing Content “> “Working
with Smart Forms” > Using the Data Designer with eWebEditPro +XML.

Important: You cannot use eWebEditPro+XML to edit Smart Forms created with eWebEdit400.

Ektron CMS400.NET’s Smart Forms give you access to the power of XML by
separating Web content from presentation. In addition to hiding the XML tags
from users, Ektron CMS400.NET can serve content to various presentation
devices (PDAs, mobile phones, etc.), saving users from the tedium of creating
duplicate content. Review and revision are drastically reduced because the
accuracy and format of your Web content are managed using XML schema
validation.

Using Smart Forms with Ektron CMS400.NET provides the following benefits:

n Strictly enforce content and page layout with Ektron's editor, XSLT,
and WYSIWYG templates for content contributors

n Deliver content to multiple devices (for example, PDAs, mobile
phones, etc.)

n Easily share content across B2B transactions

n Advanced XML authoring: Ektron's highly-acclaimed XML editor lets
developers hide XML tags from content contributors and provides an
easy-to-use WYSIWYG editing interface

The following are examples of industries that can benefit from XML Indexing.

Industry Use XML indexing to find

Health Care A cardiologist whose practice is located in your city

HumanResources Sick time policy

RealEstate A house with a zip code of 03031 priced under
$200,000

Hospitality A hotel in Boston

Online Retail Fleece gloves for men

Educational A course in .NET programming

Smart Forms are used in Ektron CMS400.NET to define the necessary files to
display, save, and validate the content properly. This section explains how to
take advantage of Ektron CMS400.NET’s Smart Forms.
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This section also contains the following topics.

Benefits of Using XML Data 7-279
Before You Manage Smart Forms 7-280
Adding a New Smart Form 7-281
Using eWebEdit400to Create Smart Forms 7-286
Designing a Screen 7-287
Inserting a Field Type 7-288
Sample Screen Design 7-293
Data Designer Field Types 7-297
Assigning Smart Forms to a Folder 7-368
Viewing Smart Forms 7-370
Editing Smart Forms 7-375
Creating Smart Forms Based on Existing Configurations 7-378
Viewing Data Designer XSLTs 7-378
Deleting Smart Form Configurations 7-379
XML Indexing 7-380
User vs. Developer Selected Search Criteria 7-381
Types of Search Criteria 7-381
Setting up a User-Defined Search 7-382
Setting up a Developer-Defined Search 7-382
Specifying Which XML Elements are Indexed 7-382
Search Dialog Setup 7-383
IndexSearch Server Control 7-384

Benefits of Using XML Data
This section explains why you should use XML as opposed to HTML content for
your Web site. Because of XML’s advantages, Ektron recommends using XML
content whenever possible. Below are several reasons why XML is the
preferred format for managing content.

n Standardized format for capturing content

- You can create an XML Smart Form then require anyone creating
content in a folder to use the form. The result is more uniform and
consistent information.

- Within an XML Smart Form, you can require authors to complete fields
in a specified format. So, for example, if you want the author to enter a
date, XML can ensure that it’s captured in a standard format. Several
standard formats are provided (email address, zip code), and you can
create your own.

n Superior control over content display

- Authors contribute XML content but have virtually no control over its
format. The Web administrator determines the format through an XSLT
file. By customizing the XSLT, you can exert maximum control over your
Web site’s appearance.
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- Since one file controls several (even hundreds of) pages, you can
update just that file to efficiently change the look of all pages whose
content is based on the Smart Form.

n Improved search capabilities

- Because XML data is captured in individual fields, you can focus a
search on relevant fields. For example, if your XML content captures
data about books, you can place an author search on your Web site.
Since that search only looks through content in the Author field, it is
much faster and returns more reliable results than a search of HTML
content.

Before You Manage Smart Forms
You must define each Smart Form that will be used in your Web site. Each form
is assigned to a content folder or content item and lets you specify how XML
content appears in the editor, is validated, and is displayed in an output device.

There are two ways to create a Smart Form.

n Using the WYSIWYG Data Designer

n Using external XML files

This section also contains the following topics.

The Smart Form Toolbar 7-280
Accessing Smart Forms 7-281

The Smart Form Toolbar
During the process of creating and managing Smart Forms, several toolbar
buttons are available. The following table describes the buttons and their
actions.

Button Name Description More Information

Add
Smart
Form

Create a new Smart Form from scratch or based
on properties of an existing one

Adding a New Smart Form on
the facing page

Back Return to previous screen

Delete Delete a Smart Form Deleting Smart Form
Configurationson page 7-379

Edit Edit a Smart Form created with external files Editing Smart Formson page
7-375
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Button Name Description More Information

Edit Data
Design

Edit a Smart Form created with the Data
Designer

Editing Data Design Packages
on page 7-375

Save Save changes

View
XSLT Display the XSLT for a Smart Form Viewing Data Designer XSLTs

on page 7-378

Accessing Smart Forms
Note: Only members of the Administrators group or those defined in Manage Members for
Role: Smart Forms Admin screen can create or edit Smart Forms. See Also: Defining Roles on
page 15-31

To access the Smart Form section of the Workarea, follow these steps.

1. In the Workarea, go to Settings > Configuration > Smart Form
Configuration.

2. The View Smart Forms screen is displayed.

From here, you can view, add, edit, and delete Smart Forms.

See Also:

n Working with Smart Forms on page 7-278

n Before You Manage Smart Forms on previous page

Adding a New Smart Form
When adding a new Smart Form, you have two options. The following sections
explain both.

n Adding a Smart Form Using the Data Designer on next page
(recommended)

n Adding a Smart Form Using External XML Files on page 7-283 (for
example, XSLTs, schemas, etc.)

Accessing Smart Forms
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Note: To create a new Smart Form by copying and editing an existing one, see Creating Smart
Forms Based on Existing Configurations on page 7-378.

Adding a Smart Form Using the Data
Designer
To add a Smart Form using the WYSIWYG Data Designer, follow these steps.

1. In the Workarea, go to Settings > Configuration > Smart Form
Configurations.

2. Click the Add Smart Form button ( ).
3. The Add Smart Form screen is displayed.

4. Enter a Title for the Smart Form.

5. Click the Save button ( ).
6. The Smart Form Data Designer screen appears.

Note: If your computer runs Windows and your server’s web.config file is set to use
eWebEditPro+XML, Ektron CMS400.NET checks to see if eWebEditPro+XML is installed on
your computer. If it is not, you are prompted to install it.

7. If eWebEditPro+XML is being installed, you may get the following
error dialog.
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To learn about why the dialog is appearing and help decide whether to
click Yes or No, click the link More information about Local
Machine Lockdown. A Windows Help topic appears and explains your
options.

8. Design your Smart Form configuration in the Data Designer.

See Using eWebEdit400to Create Smart Forms on page 7-286 for
information about creating XSLTs using the Data Designer.

9. Click the Update button ( ).
You are ready to assign the Smart Form to a folder or content item. See
Assigning Smart Forms to a Folder on page 7-368 for more information.

Adding a Smart Form Using External XML
Files
Warning! Release 7.5.2 and up of Ektron CMS400.NET supports two editors: eWebEditPro+XML
and eWebEdit400. If you want users to insert Smart Form information using eWebEdit400, you
cannot create or edit Smart Forms using external files. However, you can access eWebEdit400's
source view, paste the external file's XML, then return to design view.

To add a Smart Form using eWebEditPro+XMLand external XML files, follow
these steps.

1. In the Workarea, go to Settings > Configuration > Smart Form
Configuration.

2. Click the Add Smart Form button ( ).
3. The Add Smart Form screen is displayed.

4. Enter a Title for the Smart Form.

5. Click the Save button ( ).
6. The Smart Form Data Designer screen is displayed.

7. Click the Back arrow ( ) to exit.
8. The View Smart Form screen for the new Smart Form is displayed.

Adding a Smart FormUsing External XML Files
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9. Click the Edit button ( ).
10. The Edit Smart Form screen is displayed.

11. Enter the necessary information using the following table as a
reference.
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Smart Form Fields

Section Field Description

Generic
Information

Title Name given to Smart Form.

ID (displayonly) ID number assigned when configuration is created.

Description Detailed description given to configuration by its creator or last editor.

Editor
Information

Edit XSLT XSLT applied to content while being edited.

Save XSLT XSLT used to transform the XMLwhen saved to the database.

Advanced
Configuration

XML file that contains display information, schema validation, and
other advanced XML data.

Validation
Information

XMLSchema The .xsd file used to validate the XML content

Target
Namespace The default namespace used for outgoing XML

Display
Information

XSLT1 XSLT 1 applied to XML data when viewed on a device

XSLT2 XSLT 2 applied to XML data when viewed on a device

XSLT3 XSLT 3 applied to XML data when viewed on a device

XSLT Packaged XSLT package applied to XML data when viewed on a device

Note:When a Smart Form is created using the Data Designer, a default XSLT is created
based on the configuration. To learn about modifying the packaged XSLT, see Editing a Smart
Form’s XSLT on page 7-377.

12. Specify the default display XSLT for the configuration by clicking the
corresponding radio button.

13. Click the Save button ( ).
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XML File Verification
A verification button ( ) appears to the right of some fields on the Add Smart
Form screen. After you identify an XSLT or schema, you can click this button to
verify that the file

n exists in the location specified

n contains well-formed XML

Note: The XML Verification feature does not validate the contents of the XML file.

The following table explains possible results when clicking the verification
button.

Display Result Description

Verified File passesall verification parameters

Not
Verified

The file either:

n Doesnot exist in the specified location

n Doesnot contain well-formed XML

Review current settings. Ensure the file is in the proper location, and that it contains
well-formed XML

Using eWebEdit400to Create Smart
Forms
When you use the Data Designer, eWebEdit400 changes in the following ways.

n An additional row of toolbar buttons (circled below) lets you add Data
Designer fields to the screen.

To edit the properties of any field on the screen, select the field,
right click the mouse, and select Field Properties.
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n two buttons at the bottom of the screen let you switch between
Design mode and Data Entry mode. (For more information, see
Inserting a Field Type on next page.)

- Data Design mode - lets you insert and remove fields from the screen

- Data Entry mode - simulates the screen’s appearance during data
entry

See Also: Designing a Screen below, Inserting a Field Type on next page

Designing a Screen

This section assumes you have completed the steps in Adding a New Smart
Form on page 7-281

For each field on the screen, follow these steps.

1. Insert a field label.

2. Place the cursor at the desired location.

3. Click the button corresponding to the desired field type.

Inserting a Field Type on next page explains the field type represented by each
button.

You can also use Ektron CMS400.NET’s rich formatting capabilities to design the
screen. For example, you can format text, and use tables, images and
hyperlinks to guide the user through the data entry process. Below is a sample
screen created with the Data Designer.

Designing a Screen
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If you are familiar with XML and want to manually edit the page, use the View
Source button (at the bottom of the screen, circled below), to edit the source
code.

If the edited source XML is not well-formed, you are notified and must remain in
source view until you fix it.

Inserting a Field Type
Ektron CMS400.NET provides several options that let you insert or edit fields in
the editor. Each field type is described below.

Field type Icon Description
For more
information,
see

Group Box Groups related fields, which can be surrounded bya boxand
have a caption

Group Box on
page 7-299
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Field type Icon Description
For more
information,
see

Tabular Same asgroup box, but fields can be presented in a table
format

Tabular Data
on page 7-
308

Text Lets user insert and format free text using editor Text on page
7-316

Choices
Several choicesappear on screen. User checksappropriate
boxes. All user choicesare inserted as valueswithin single
XML tag.

Choices on
page 7-320

Checkbox User’s response is either checked or unchecked Checkboxon
page 7-314

Calculated Performscalculationsusing other fields on the screen Calculated on
page 7-325

Calendar Lets user insert a date by clicking a calendar Calendar on
page 7-333

ImageOnly Lets user insert an image
ImageOnly
on page 7-
337

LinkField Lets user insert a link to a file, such asa PDF document File Linkon
page 7-339

Resource
Selector Lets user place content or folders on a Smart Form

Resource
Selector on
page 7-343

Field
Properties

Lets you change the properties of any field. Select field then
click this button.

Note: This option is also available on the right clickmenu.

Validate
Ensure the screen contains valid XML.

This button is available in data entry and data designmodes.

Inserting a Field Type
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Field type Icon Description
For more
information,
see

Display
internals of
Data Design

SeeViewing an InternalRepresentation of the Design below

Validate Validatesdata when previewing data entry

This section also contains the following topics.

Deleting a Field from the Screen 7-290
Previewing the Screen 7-290
Viewing an Internal Representation of the Design 7-290

Deleting a Field from the Screen
To remove a field from the screen, follow these steps.

1. Move the cursor to the field. The field’s background color changes.

2. Press <Ctrl>+<X> to remove the field.

Note: Usually, the field label is not deleted when you delete a field. To delete the label, select
it and press <Ctrl>+<X>.

Previewing the Screen
If you want to view how the screen will appear to the person who will complete
the screen, click the View Data Entry button ( ) at the bottom of the editor.
(See Also: Inserting a Field Type on page 7-288.)

Viewing an Internal Representation of the
Design
Several toolbar buttons display an internal representation of the Data Design.
The buttons are described below.
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Button Description Example

The XML data
document

- <root>

- <Information>

<LastName />

<FirstName />

<MiddleName />

<Gender>male</Gender>

<Address />

<city />

<state>MA</state>

<Zip />

<SSN />

<BDate />

<HomeTel />

<WorkTel />

<x-ray />

- <Dental_Insurance>

<Field1 />

<OtherInsurance>N/A</OtherInsurance>

<Account_Number>N/A</Account_Number>

</Dental_Insurance>

<medication />

<lastAppointment />

<clincal />

</Information>

</root>

Viewing an Internal Representation of the Design
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Button Description Example

The structure,
content, and
semantics of an
XML document

- <xs:schema elementFormDefault="qualified"
attributeFormDefault="unqualified"
xmlns:xs="http://www.w3.org/2001/XMLSchema">

- <xs:element name="root">

- <xs:complexType>

- <xs:sequence>

- <xs:element name="Information">

- <xs:complexType>

- <xs:sequence>

- <xs:element name="LastName">

- <xs:simpleType>

- <xs:restriction base="xs:string">

<xs:minLength
xmlns:xs="http://www.w3.org/2001/XMLSchema" value="1" />

</xs:restriction>

</xs:simpleType>

</xs:element>

- <xs:element name="FirstName">

- <xs:simpleType>

- <xs:restriction base="xs:string">. .. ..

A list of all fields
and information
about them (as
XML)

<fieldlist>

<field name="LastName" datatype="string" basetype="text"
xpath="/root/Information/LastName" title="Last Name">Last
Name</field>

<field name="FirstName" datatype="string"
basetype="text" xpath="/root/Information/FirstName"
title="First Name">First Name</field>

<field name="MiddleName" datatype="string"
basetype="text" xpath="/root/Information/MiddleName"
title="Middle Name">Middle Name</field>

<field name="Gender" datatype="choice" basetype="text"
xpath="/root/Information/Gender" title=""
datalist="IDAPK3KC">Gender</field> . .. .. ..

Index

xpath
information for
any indexed
field on the
screen

<indexable>

<xpath type="string">/root/Information/SSN</xpath>

<xpath type="string">/root/Information/HomeTel</xpath>

<xpath>/root/Information/WorkTel</xpath>

</indexable>

Managing Content in Ektron CMS400.NET

7-292 ReferenceManual
Version 8.01 Rev 4



Button Description Example

TheData
Design
document’s
presentation
XSLT

<xsl:stylesheet version="1.0"
xmlns:xsl="http://www.w3.org/1999/XSL/Transform">

<xsl:output method="xml" version="1.0" omit-xml-
declaration="yes" indent="yes" encoding="utf-8" />

<xsl:strip-space elements="*" />

<xsl:variable name="ektdesignns_fieldlist"
select="/*/ektdesignpackage_list/fieldlist" />

- <xsl:template match="/" xml:space="preserve">

<p> </p>

- <fieldset id="Information" title="Demographic
Information">

<legend>Patient Information</legend>

- <div>

- <p>

<strong>Last Name</strong>

<xsl:text> </xsl:text>

<xsl:value-of select="/root/Information/LastName" />

<strong>First Name</strong>

<xsl:text> </xsl:text>

<xsl:value-of select="/root/Information/FirstName" /> .. ..
... ..

Sample Screen Design
This section provides an example of designing a screen, so that you can learn
how the pieces fit together. Let’s assume you want the screen to look like this.

Note: The following example helps you understand how to create a simple data entry screen.
It does not explain how to save a screen so that a user can enter data into it. When you are
ready to create a screen, ask your system administrator to help determine a method for saving
it and making it available to users for data entry.

To create such a screen, follow these steps.

1. Sign on to the Ektron CMS400.NET Workarea as an administrator or a
Smart Form administrator. See Also: Defining Roles on page 15-31
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2. Go to Settings > Configuration > Smart Form Configurations.

3. Click the Add button ( ).
4. Assign the form a title. For example, Sample Smart Form.

5. Click the Save button ( ).
6. The screen refreshes and the editor appears.

7. Reviewing the screen design (shown above), you notice that the fields
are surrounded with a box and a caption. To achieve this, click the

Group Box button ( ). Then, complete the dialog as shown below.

Note: Later, each field on the dialog is documented. Since this section provides an overview, it
does not delve into those details.

At this point, the screen looks like this.
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8. The first field, Street, should let the user enter text. So, place the
cursor into the Address box and type Street.

9. Place the cursor to the right of Street and click the text field button (

).
10. Complete the dialog as shown below.

Now, the screen looks like this.

11. The next field, City, should also let the user enter text. Assume City
should appear below Street. Move the cursor to the end of the
Street field and press <Enter> to create a new line. Then type City.

12. Click the plain text field button ( ) .
13. Complete the dialog as shown below.

Sample Screen Design
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Now, the screen looks like this.

14. The next field, State, should let the user choose from several states.
Assume you want the state list to appear to the right of City. Move
the cursor to the end of the City field and type State.

15. Click the Choices Field button ( ) and complete the dialog as shown
below. Note the choice of U.S. States & Territories in the List field
(below), which provides a set of those entities.
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Now, the screen looks like this.

The above example is very simple and does not use the Data Designer’s more
powerful and flexible features. To learn more about Data Designer, read the
rest of this chapter.

Data Designer Field Types
To help you use all of the Data Designer’s capabilities, this section explains
each field type you can insert. They are very flexible and can accommodate all

Data Designer Field Types
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of your needs when designing a data entry screen.

This section also contains the following topics.

Group Box 7-299
Advantages of Grouping Fields 7-299
Dialog Box 7-301
Dialog Box 7-301
Fields on the Group Box Dialog 7-302
Using a Tag Other Than <Root> 7-302
Relevance Tab 7-303
Tabular Data 7-308
Creating a Table 7-308
Editing Tabular Data 7-309
How Tabular Data Forms XML Structure 7-309
Dialog Box 7-312
Fields on the Tabular Data Dialog 7-313
Checkbox 7-314
Dialog Box 7-315
Fields on the Checkbox Dialog 7-316
Text 7-316
Dialog Box 7-317
Fields on the Text Field Dialog 7-318
Choices 7-320
Flexibility of the Choices Field 7-320
Dialog Box 7-321
Fields on the Choices Dialog 7-322
Using a Standard List 7-322
Creating a Custom List 7-323
Creating a Custom List in Configuration File 7-324
Calculated 7-325
Dialog Box 7-326
Fields on the Calculated Field Dialog 7-327
Using the Formula Field 7-327
Referencing Other Calculated Fields 7-329
Explanation of Examples 7-329
Calendar 7-333
Dialog Box 7-334
Fields on the Calendar Field Dialog 7-335
Custom Validation with a Calendar Field 7-335
Example of Creating Custom Validation 7-336
Image Only 7-337
Using an Image Only Field in Data Entry Mode 7-338
Dialog Box 7-338
Fields on the Image Only Dialog 7-339
File Link 7-339
Using a File Link Field in Data Entry Mode 7-340
Dialog Box 7-341
Fields on the File Link Field Dialog 7-342
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Resource Selector 7-343
Resource Selector Examples 7-344
Overview of Using a Resource Selector 7-345
Adding a Resource Selector Field 7-347
Letting a Content Author Add Content 7-348
Letting a Content Author Add a Folder, Taxonomy or Category 7-354
How a Content Author Adds Resource Selector Field 7-359
Fields that Appear on Several Dialogs 7-359
Advanced Tab 7-359
The Use Field 7-362
The Allow Field 7-362
The Data Style Field 7-363
Custom Validation 7-364
Adding Standard Validation Options 7-365
Creating Custom Validation Criteria 7-365
Example of Creating Custom Validation 7-367

Group Box
A Group Box field lets you group related fields together on a screen by
surrounding them with a box and optionally placing a caption above them.

After you insert a Group Box field, to insert other kinds of fields within the box,
place the cursor inside the box then select a field type button.

Note: The tabular data field type might better accommodate your needs. See Tabular Data on
page 7-308.

The following topics explain a Group Box field in more detail.

n Advantages of Grouping Fields below

n Dialog Box on page 7-301

n Fields on the Group Box Dialog on page 7-302

n Using a Tag Other Than <Root> on page 7-302

n Relevance Tab on page 7-303

Advantages of Grouping Fields
One advantage of grouping fields is that you can allow the user in Data Entry
mode to add another instance of a group. For example, if a screen collects
several fields of information about each telephone call, the user could click the
Insert Below button to insert a new group of fields, ready to collect
information about the next call.

Group Box
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Another advantage of grouping fields is that you can suppress a group of
irrelevant fields. For example, if a screen includes two groups of fields that
collect information about hardcover and paperback books, and you are adding
information about a hardcover book, you can collapse the paperback book
questions because they are not relevant to your current task.

Use the eyeglass icon to expand or collapse the display of fields within a group.

Expanded Group Field with glasses icon highlighted

Collapsed Group Field
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Dialog Box

Dialog Box

Dialog Box
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Fields on the Group Box Dialog

Field Description

Descriptive
Name

Enter the name of this field.

Internally, the name is used as the field’s caption.

The Name Field’s Default Value

Bydefault, the Data Designer assignsa namemade up of Field followed by the next available
number. So, the first field’s default name isField1, the second field’s default name isField2,
etc. You can change the default if you want.

Field Name Enter the field’s element name. This defines the field in the XML.

Use See TheUse Field on page 7-362

Allow See The Allow Field on page 7-362

Appearance
ClickShow border and caption if you want to surround the fields in this group with a box.
You can also create a caption to appear in the top line of the box.

ClickNo border if you do not want to surround the fields in this group with a box.

Caption

If desired, enter text to describe this group of fields on the data entry screen. For example:

After you insert this field onto the screen, you can use the editor's formatting capabilities to
modify its size, font, color, and other attributes.

Note: TheCaption field only appears on this dialog when you create the Group Box field. If
you later try to edit the field, the Caption field is not on the dialog. However, you can edit
Caption text within the editor.

Advanced
Tab SeeAdvanced Tab on page 7-359.

Relevance SeeRelevance Tab on the facing page.

Using a Tag Other Than <Root>
By default, Ektron CMS400.NET surrounds your Data Design with <root> tags.
If you would like to replace the <root> tags with another element name, follow
these steps.

1. After creating a new Data Design screen, insert a Group Box as the
first field.

2. In the Group Box Dialog’s Field Name field, enter the root text.

3. On the Group Box Dialog box, click the Advanced tab.
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4. In the Root tag section of that screen, select Use this element as
the Root tag and press OK.

5. Place all other screen elements within the Group Box field.

Relevance Tab
The Relevance tab allows a group of fields to appear or disappear according to
the value of other fields in the configuration. It appears on both the Group Box
and Tabular Data Box dialogs.

Here are some example uses.

n Questions about pregnancy that appear only if the patient is female.

n A list of states that appears only if the user selects United States as
his country.

n A list of car manufacturers. When a user chooses one, all of its
models appear in a second list.

Fields that can be Used in Relevance Conditions
Only the following field types can be used in a Relevance condition.

n Check box

n Text

n Calculated

n Choices

Note: If using a Choices field, in the Appearance area of the dialog, you can only choose List
Box or Drop Box. Vertical List and Horizontal List are not supported.

Relevance Tab
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Applying Relevance to a Group Box Field
To apply relevance to a Group Box field, follow these steps.

1. Edit a Smart Form configuration in Data Design mode to which you
want to apply Relevance.

2. If necessary, insert the field(s) on which the group box’s appearance
depends.

3. Insert a Group Box field. See Also: Group Box on page 7-299

Note: The location of the Group Box field is independent of the location of the fields to which
you will apply conditions.

4. Click the Group Box dialog’s Relevance tab (circled below).

5. The Relevance tab appears.

6. Scroll through the list of sample conditions to determine which one
best fits your situation.

7. Select a field from the lower half of the screen to replace the first
variable (X or Y) in the condition.

For example, if the condition is A checkbox field is checked ({X} =
'true'), click the check box field whose value must be true in order
for this group to appear.

8. Click Replace {X} in Condition.

Managing Content in Ektron CMS400.NET

7-304 ReferenceManual
Version 8.01 Rev 4



9. Notice that, in the Condition field, the variable was replaced by the
selected field (see example below).

10. If the condition has another variable, repeat Steps 7 and 8.

11. Press OK.

Ektron recommends switching to Data Entry mode and testing the Relevance
conditions.

Example of Applying Relevance to a Group Box Field
Assume you want a list of states in the United States to appear only if a user
selects United States from the Country field.

Example of Applying Relevance to aGroup Box
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To accomplish this, follow these steps.

1. Create a Choices field and assign it three values:

n United States

n Canada

n Other

See Also: Choices on page 7-320

2. Create a Group Box field and name it States.

3. With that Group Box field, create a new Choices field.

- Name it US States.

- In its List field, select U.S. States & Territories.

- In Allow Selection, check First item is not a valid selection

- In the Appearance field, select Drop List.
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4. Place the cursor on the States Group Box field and click the Group
Box toolbar button.

5. Click its Relevance tab.

6. Pull down the Examples list.

7. Click A field has a given value ({X} = 'value').

8. Scroll through the lower half of the screen until you see the country
Choices field.

9. Click Replace '{X}' in Condition.

10. Notice that the Condition field now reads ../Country/Country =
'value'.

11. In the Condition field, replace Value with United States.

Example of Applying Relevance to aGroup Box
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Important: The text that replaces Value must exactly match the desired value of the selected
field.

12. Click OK.

Tabular Data
The Tabular data button inserts a table into which you can place other types of
fields. It’s similar to a group box.

Tabular data’s main advantage over a group box is that it lets you place fields in
columns (see below).

Note: Group Box on page 7-299 describes many features that also apply to tabular data.
Read that section to gain a full understanding of working with tabular data.

The following topics explain a tabular data field in more detail.

n Creating a Table below

n Editing Tabular Data on the facing page

n How Tabular Data Forms XML Structure on the facing page

n Dialog Box on page 7-312

Creating a Table
First you insert the table. Then, you insert an appropriate type of field into each
column. As examples, in the table above, the Description field type would be
plain text, while the In Stock? field type would be choices.

If you insert a field into a table and its caption appears to the left of the data
entry region (see below), move the caption to the column header (see second
illustration below).
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To access table commands (such as add row and add column), place the cursor
inside a table cell and right click the mouse.

Warning! Only table cells into which you place a field are available to visitors of your Web page.

Editing Tabular Data
To edit tabular data, hover the cursor over a table border line until you see a
four-headed arrow. Then, click the right mouse button and select Field
Properties.

Note: You cannot reduce the number of columns by editing the Tabular Data dialog’s
Columns field. To delete a column, place the cursor in the column, right click the mouse, and
select Delete Column.

How Tabular Data Forms XML Structure
Tabular data creates three levels of XML tags:

n inner level: each field in the table

n middle level: each row in the table

n outer level: the entire set of table data

To explain how this works, we’ll use the following contact list as an example.

Name Phone Email

John Doe 555-1212 john.doe@example.com

MarySmith 555-8765 msmith@example.net

How XML Tags are Assigned to Field Names
When you insert a field into a table, a dialog helps you define the field type. For
example, when inserting a plain text field, the Plain Text Field dialog appears.
On that dialog, the value of the Phone field defines the tags that enclose that
field’s contents.

To continue our example, every contact is represented in XML as:

Editing Tabular Data
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<Name>John Doe</Name>

<Phone>555-1212</Phone>

<Email>john.doe@example.com</Email>

and

<Name>Mary Smith</Name>

<Phone>555-8765</Phone>

<Email>msmith@example.net</Email>

How XML Tags are Assigned to Table Rows
Each row of the table collects information for one contact. On the Tabular Data
Box dialog, the Row Name field defines the XML tag that groups information
for each contact. For example, the Row Name field value is Contact.

</AddressBook>

<contact>

<Name>John Doe</Name>

<Phone>555-1212</Phone>

<Email>john.doe@example.com</Email>
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</Contact>

<Contact>

<Name>John Doe</Name>

<Phone>555-1212</Phone>

<Email>john.doe@example.com</Email>

 </Contact>

Contact>

<Name>Mary Smith</Name>

<Phone>555-8765</Phone>

<Email>msmith@example.net</Email>

</Contact>

</AddressBook>

How XML Tags are Assigned to Table Rows
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Fields on the Tabular Data Dialog

Field Description

Descriptive
Name

Enter the name of this table.

The Name Field’sDefault Value

Bydefault, the Data Designer assignsa namemade up of Field followed by the next available
number. So, the first field’s default name isField1, the second field’s default name isField2,
etc. You can change the default if you want.

Field
Name

Enter the table’s element name. Thiswill define the table in the XML. See Also:How Tabular
Data FormsXMLStructure on page 7-309

Tool Tip
Text Enter the text that appearswhen a user hovers the cursor over the table’s column headers.

Use See TheUse Field on page 7-362

Allow

See The Allow Field on page 7-362

Note: If you checkMore than one here, you are allowing the user to insert an entirely new
table, not an additional table row.

Rows

Row
display
name

Enter the text that appearswhen a user hovers the cursor over the table’s cells. Use this field to
describe the kind of information to be inserted into the table’s cells.

Row name
Enter the name of the XML tag used to collect data for each entry in the table.

See Also:How Tabular Data FormsXMLStructure on page 7-309

Minimum
number

If desired, enter theminimum number of rows for this table.

If you enter a number and the data entry user tries to save the screen without inserting at least
theminimum number of rows, he is informed thatElement content is incomplete
according to the DTD/Schema.

Bydefault, the user is allowed to cancel or save the screen anyway. However, the system
administrator determineswhether or not the user can save an invalid document.

Fields on the Tabular Data Dialog

ReferenceManual
Version 8.01 Rev 4

7-313



Field Description

Maximum
number

If desired, enter themaximum number of rows for this table. If you don’t want to assign a
maximum number, check theUnlimited checkbox.

Result of Assigning a Maximum

When this table appears on a data entry screen, and a user adds themaximum number of
rows, the Insert Above and Insert Belowoptionsare grayed out on themenu (see example
below).

Columns
Enter the number of columns to appear in the table.

See Also:Editing Tabular Data on page 7-309

Caption

If desired, enter text to describe this table on the data entry screen. The caption appears
centered above the table.

After you insert this field onto the screen, you can use eWebEditPro+XML’s formatting
capabilities tomodify the caption’s size, font, color, and other attributes.

Advanced
Tab SeeAdvanced Tab on page 7-359

Relevance SeeRelevance Tab on page 7-303

Checkbox
A Checkbox field is only one character wide and accepts one of two possible

values: checked or unchecked. For example:
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Fields on the Checkbox Dialog

Field Description

Descriptive
Name

Enter text to guide the user’s response to this field. To continue the above example, the caption
would beCheck if you are over 65.

After you insert this field onto the screen, the Descriptive Name appears to the right of the
checkbox. You can use the editor's formatting capabilities tomodify its size, font, color, and
other attributes.

Note: TheDescriptive Name field only appears on this dialog when you create the Check
Box field. If you later try to edit the field, it is not on the dialog. However, you can edit the
Descriptive Name text within the editor.

Indexed
Check if you want to index this field. See Also:XML Indexing on page 7-380

The Indexed field maynot appear, depending on how your administrator set up your system.

Field
Name Enter the field’s element name. Thiswill define the field in the XML.

Tool Tip
Text

Enter text that appearswhen a user hovers the cursor over this field (circled in red below).

Default
value

If you want this field to be checked when the screen first appears, clickTrue.

Otherwise, clickFalse.

Validation
tab You can use this screen to specify that the checkboxmust be checked or unchecked.

Advanced
tab SeeAdvanced Tab on page 7-359

Text
Use a text field when you want the user to enter a text response.

Note: If a plain text field tries to perform a numerical calculation with a value that is blank or
contains letters, NaN appears in the field. (NaN stands for “not a number.”) If a plain text field
tries to divide by zero, Infinity appears.

Note: If a plain text field collects a URL, add on-screen instructions to prefix it with http:\\. If
the user does not, the URL address is not stored properly.

The following capabilities are available with a text field.

n Text can be read-only or hidden

n You can only allow plain text, or let the Smart Form author format it
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n The text field can consist of a single or multiple lines

Dialog Box
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Fields on the Text Field Dialog

Field Description

Descriptive Name Enter the name of the field.

Indexed

Check if you want to index this field. For more information, seeXML Indexing on
page 7-380.

The Indexed field mayor maynot appear, depending on how your
administrator set up your system.

Field Name Enter the field’s element name. This defines the field in the XML.

Tool Tip Text Enter the text that appearswhen a user hovers the cursor over this field.

Default Value

If you want to set a default value for this field, enter that value here. The default
value appears in Data Entrymode, where the user can accept, change, or
delete it.

For example, if this field collects a city, andmost users enter New York, enter
New Yorkas the value.

Use See TheUse Field on page 7-362

Allow See The Allow Field on page 7-362

Allow Rich Formatting Check this box if you want to let the Smart Form author format the text in this
field. If you do not check the box, the author can only enter plain text.

Allow Multiple Lines
Checkhere to let this text boxexpand to accommodate the user’s input.

If you do not check this box, a single line input boxappears on the data entry
screen to accept user input.

Cannot be Changed
Checkhere tomake this field read-only. That is, the user cannot insert data into
it in Data Entrymode.

Youmight use this option to provide instructions for completing the screen.

Invisible

Checkhere tomake this field hidden in Data Entrymode.

This option lets you store unseen information in an XML document. An example
might be putting a version number for the data design so that XML documents
can be upgraded to newer versionsusing an XSL transform.
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Field Description

Validation

Select the kind of validation to apply to this field. Your choicesare:

n No validation - the user’s response is not checked

n Cannot be blank - the user must enter a response

n Non-negative whole number or blank - the user must enter a positive
whole number or no response

n Non-negative whole number (required) - the user must enter a positive
whole number

n Decimal number or blank - must be a decimal number (for example,
12.345 or 12) or blank. A leadingminus sign “-” is allowed. The decimal point
must be a period (.), even in locales that normally use a comma (,).

Note: Decimal numbers include whole numbersbecause the decimal point
is implied. That is, 12 is 12.0000.

n Decimal number required - must be a decimal number (it
cannot be blank) of none, one, or two decimal places.

A leadingminus sign “-” is allowed. The decimal point must be period (.), even in
locales that normally use a comma (,).

n Percent: (0-100) required - the user must enter a whole
number from 0 to 100

n email address/email address required - a user name followed
by an at sign (@) followed by a domain name

n email address list/email address list required - several email
addresses separated bya semicolon (;)

n Zip code (US only) - the user’s responsemust consist of 5 (nnnnn) or 9
digits separated bya dash after the fifth (nnnnn-nnnn)

n Social Security number (US only) - the user’s responsemust consist of
nine digits in this pattern: nnn-nn-nnnn

n Postal Code (Canada)/Postal Code (Canada) required - the user’s
responsemust consist of six characters in the format ANA NAN, where A is an
alphabetical character and N is a numeric.

n Social Insurance Number (Canada)/Social Insurance Number
(Canada) required - nine digits See Also:
http://en.wikipedia.org/wiki/Social_Insurance_Number

Validation (continued
from above)

n ISBN code - 13 digit ISBN code. See Also: http://isbn-
information.com/13-digit-isbn.html

n ISSN code - See Also: http://www.issn.org/2-22635-What-is-
an-ISSN.php

n Custom - You can create custom validation.

For more information, seeCustomValidation on page 7-364.

If you assign to this field any value other thanNo validation, the field is initially
surrounded by red dashes in Data Entrymode. If the user’s response doesnot
meet the validation criterion, the field remains surrounded by red dashes. The
system administrator determineswhether or not the user can save an invalid
document.

Fields on the Text Field Dialog
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Field Description

Data Style See TheData Style Field on page 7-363

Advanced SeeAdvanced Tab on page 7-359

Choices
Use the Choices field when you want to give the data entry user several options.
For example, you create a Choices field named Interests that lists these
options.

n music

n art

n sports

The data entry user could check the first two and leave the third blank.

The following topics explain a tabular data field in more detail.

n Flexibility of the Choices Field below

n Dialog Box on the facing page

n Using a Standard List on page 7-322

n Creating a Custom List on page 7-323

n Creating a Custom List in Configuration File on page 7-324

n Creating the List on page 7-324

n Creating a Dynamically Populated Choice List on page 7-325

Flexibility of the Choices Field
The following capabilities are available with a Choices field.

n You can limit a user’s response to one item, or allow more than one.

n You can require a response.

n You can determine the list’s appearance from these choices.

List type Example Description

vertical All choicesappear, arranged vertically.
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List type Example Description

horizontal All choicesappear, arranged horizontally.

list box All itemsappear. The default one is selected when the screen first
appears, but can be changed.

drop list Only the top item appears. To its right, a down arrow appears (circled).
The user clicks the arrow to display all itemsand select one.

n You can choose from a standard list of choices or create your own
list.

See Also: Creating Your Own Predefined List on page 7-324

Dialog Box

Dialog Box
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Fields on the Choices Dialog

Field Description

Descriptive
Name Enter the name of the field.

Indexed
Check if you want to index this field. For more information, seeXML Indexing on page 7-380

The Indexed field mayor maynot appear, depending on how your administrator set up your
system.

Field Name Enter the field’s element name. This defines the field in the XML.

Tool Tip
Text Enter the text that appearswhen a user hovers the cursor over this choice list.

List See You can choose from a standard list of choicesor create your own list. on previouspage

Allow
selection

ClickMore than one to let the data entry user select more than one item on the data entry
screen. Otherwise, clickOnly one.

For example, if you clickMore than one, and the choicesare: music, art, sports, the user
could select all three choices.

A selection is required - Check this box if the user must select at least one
list item.

First item is not a valid selection - Check here if the first item on the list is
not a valid value but instead text that prompts the user to respond to the
field. An example of such text for a list of states is Select a state.

If you check this boxand the user selects the first value on the list (most likely bydefault), an
error message appearswhen he tries to save the screen.

Appearance SeeYou can determine the list’s appearance from these choices. on page 7-320

Item List SeeCreating a Custom List on the facing page

Value
Enter the value that is collected when the data entry user selects this item.

For example, if Interests appears in the Name field, and you want music to be collected
when the data entry user selects this item and saves the page, entermusic here.

Data Style See TheData Style Field on page 7-363

Advanced SeeAdvanced Tab on page 7-359

Using a Standard List
To use a standard list, click the black down arrow next to the List
field to see your options.
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If you choose a standard list, it appears in the lower half of the
screen. You cannot change its values.

Creating a Custom List
To create your own set of list options, accept the List field’s default
value, Custom. Then, enter the list values using the Item List
section of the screen, shown below.

To indicate an option is the default choice, check the Selected
checkbox.

In the Display Text field, enter text to describe this item on the
data entry screen. After you insert this field onto the screen, you can
format it. For example, you can apply bold, assign a style, etc.

In the Value field, enter the value that is collected when the data
entry user selects this item.

For example, if Interests appears in the Name field, and you want
music to be collected when the data entry user selects this item and
saves the page, enter music here.

To add a new choice, delete an existing choice, or move a choice up
or down within the list, click the menu icon ( ) to the left of that
choice. The select a menu option.

Creating a Custom List
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Creating Your Own Predefined List

An administrator can create a predefined list of options to appear when a user is
inserting a Choices Field.

Creating a Custom List in Configuration File
Although a user can create a custom list of choices via the Item List area of
the Choices Field dialog, that list is only available in that field of that screen. If
the user wants to insert the same list in another section of the screen or a
different screen, he must re-enter all options.

However, if you create a list according to the steps below, your custom list is
stored in the configuration file (along with the standard choice lists, such as
Countries). As a result, any user connected to your server can insert the list
into any Choices Field on any screen.

Creating the List
To insert a custom list of choices, follow these steps.

1. Open the Ektron CMS400.NET configuration file, site
root/workarea/contentdesigner/DataListSpec.xml.

2. Insert the new list following the pattern of the other lists in the file.
Below is an example of such a list.

<datalist name="MyNewList">

<schema datatype="string" />

<item default= "true" value= "Green" />

<item value= "Red" />

<item value= "Blue" />

</datalist>

Notes:

n you can specify a data type. Values are: string, nonNegativeInteger,
date, decimal.

n as shown in the third line above, you can specify a default value
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Creating a Dynamically Populated Choice List
You specify the elements of the custom options list described above in the
configuration data. You can also create a dynamically-populated list from any
XML source. The source can be on your server or on a remote Web site. Follow
these steps to add a dynamic data list to the Choices field.

1. Follow steps 1 through 3 in Creating the List on previous page.

2. Insert a new datalist item according to this pattern.
<datalist name="MyNewList" src="{url to xml data source}" select="{xpath to data item
element}" captionxpath="{relative xpath to data item's display text}"
valuexpath="{relative xpath to data item's value}">

Warning! The datalist namemust match the listchoice data attribute.

For example
<datalist name="USPS-CA" src="[eWebEditProPath]/uspsca.xsd"
select="/xsd:schema/xsd:simpleType/xsd:restriction/xsd:enumeration"
captionxpath="xsd:annotation/xsd:documentation" valuexpath="@value"
namespaces="xmlns:xsd='http://www.w3.org/2001/XMLSchema'" validation="select-req">

In this example, the data list is stored in the uspsca.xsd file, located
within the ewebeditpro folder. However, it could be in any XML data
source.

Calculated
Use a calculated field to perform a calculation based on values in other fields.
For example, if your screen collects mortgage information, you could create
one field to collect the mortgage and interest payment and another to collect
taxes and insurance. The calculated field could sum those two numbers and
display the monthly payment.

You can validate a calculated field. For example, you can require a positive
number between 100 and 1,000.

Calculated fields are display only -- users cannot edit them.

Warning! If a field will be referenced in a calculation, use the validation feature to require a value
for that field. This forces the user to enter a number to be used in the calculation.

The following topics explain a tabular data field in more detail.

n Dialog Box on next page

n Fields on the Calculated Field Dialog on page 7-327

n Using the Formula Field on page 7-327

n Notes on page 7-329

n Referencing Other Calculated Fields on page 7-329

n Explanation of Examples on page 7-329

Creating a Dynamically Populated Choice List
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Dialog Box
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Fields on the Calculated Field Dialog

Field Description

Descriptive
Name Enter the name of the field.

Indexed
Check if you want to index this field. For more information, seeXML Indexing on page 7-380.

The Indexed field mayor maynot appear, depending on how your administrator has set up
your system.

Field
Name Enter the field’s element name. This defines the field in the XML.

Tool Tip
Text Enter the text that appearswhen a user hovers the cursor over this field.

Formula Enter the calculation that this field will perform. See Also:Using the Formula Field below

Select
Field

Click this button to select a field to reference in the calculation. For more information, seeUsing
the Formula Field below.

Examples
Click the down arrow to the right of this field to see examplesof calculations you can perform.
When you select an example, it is copied into the Formula field.

See Also:Explanation of Exampleson page 7-329

Validation

Select the kind of validation to apply to this field. Your choicesare:

n No validation - the user’s response is not checked

n Non-negative number (required) - the result of the calculationmust be a positive
number

If you assign to this field any value other thanNo validation, the field is surrounded by red
dashes in Data Entrymode. If the user’s response doesnot meet the validation criteria, the field
remains surrounded by red dashes. Your system administrator determines if a user can save a
screen with invalid data.

Error
message

If you selectNon-negative number above, insert text that appears on the screen if the user’s
response doesnot meet this criterion.

Custom
Validation SeeCustomValidation on page 7-364

Data Style See TheData Style Field on page 7-363

Advanced SeeAdvanced Tab on page 7-359

Using the Formula Field
You can copy a sample calculation into the Formula field by clicking the
Examples field and selecting an operation from the drop down list. For

Fields on the Calculated Field Dialog
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example, if you click Examples Add two numbers {X}+{Y}, {X}+{Y}
appears in this field.

Next, replace the variables with fields on the screen. Be sure to select the curly
brackets ({}) as well as the letter between them. Then, when the user enters
data into those fields, the calculation is performed using the current field
values.

If a calculated field tries to perform a numerical calculation with a value that is
blank or contains letters, NaN appears in the field. (NaN stands for “not a
number.”)

If a calculated field tries to divide by zero, Infinity appears.

Warning! If the user does not replace all variables with a field or a number, when the content is
validated, validation will fail.

To do this, follow these steps.

1. Select the first variable to replace. To continue the example, select
{X}.

2. Select a field to replace that variable in the calculation.

3. Click Replace X in Formula.

Warning! If a variable appears more than once in a formula (for example, {X} * number({X}<=
{Y}) + {Y} * number({X}>{Y}), you only need to replace the first occurrence -
eWebEdit400 replaces subsequent occurrences for you.

4. Continue replacing all variables in the formula.
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Notes
n If an XML document contains several occurrences of a field that is

referenced in a formula, the value is derived as follows:

- When using the XPath functions sum() and count(), all values with the
field name are considered. For example, a document includes three
books whose prices are $10, $20 and $30. In this case, sum’s value is
$60.

- When using all other functions, the first value is used. For example, a
document includes three books whose prices are $10, $20 and $30. If a
calculation formula refers to <price>, its value is $10.

n You can replace a variable with a number instead of a field. For
example, replace {X} * {Y} with ../price * 1.15.

n The expression can be complex, such as (round(Field1 * 0.80) +
(1 div Field2)) - 2.

n You can use a string expression that creates a text message. For
example, to calculate a full name from its parts: concat( title, '
', givenname, ' ', familyname), which could produce “Dr.
Jonathan Smythe”.

Referencing Other Calculated Fields
A calculated field can only reference other calculated fields that appear before
it in a document. For example, a document collects a series of numbers.

n One calculated field counts the number of numbers.

n Another totals their values.

n A third computes the average by dividing the total by the count.

In this example, you must place the third field below or to the right of the first
two fields. Calculated fields that are defined later in a document do not appear
in the Select Field or Group dialog.

Explanation of Examples
The following table explains the standard examples that appear in the
Examples drop-down list of the Calculated Field dialog. Note that your system
administrator can customize the list, so it may not match what is below.

**Example
Field Text

Example Field Formula Description

Add two
numbers {X} + {Y}

Add the value in the first field (X)
to the value in the second field
(Y).

Notes
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**Example
Field Text

Example Field Formula Description

Subtract two
numbers {X} - {Y}

Subtract the value in the second
field (Y) from the value in the
first field (X).

Multiply two
numbers {X} * {Y}

Multiply the value in the first field
(X) by the value in the second
field (Y).

Divide two
numbers format-number({X} div {Y},'0.###')

Divide the value in the first field
(X) by the value in the second
field (Y).

Format asa
percentage format-number({X} div {Y},'#0%')

Determine what percentage
one number (X) is of another
(Y).

For example, if {X}=10 and
{Y}=100, the result of the
calculation is 10%.

Absolute
value of a
number

{X} * (number({X} > 0)*2-1) The number regardlessof the
sign (negative or positive).

Minimum of
two numbers {X} * number({X} <= {Y}) + {Y} * number({X} > {Y}) The smaller of two field values.

Maximum of
two numbers {X} * number({X} >= {Y}) + {Y} * number({X} < {Y}) The larger of two field values.

Zero if
subtraction is
negative

({X} - {Y}) * number(({X} - {Y}) >; 0)
Subtract one number (Y) from
another (X). If the difference is
less than zero, insert zero.

Multiply by
another
number if
checkbox is
checked

{X} * ( {Y} * number( {Z} ='true') +
number( {Z} !='true'))

X is a numeric field.

Y is another numeric field to
multiply byX if a checkbox is
checked.

Z is the checkbox.

For example, {X}=2 and {Y}=3

n if the checkbox is checked,
the result is 2 * 3, which is 6

n If the checkbox is not
checked, the result is 2

Round a
decimal
number

round({X})
Rounds the number to the
nearest integer. For example,
round(3.14). The result is 3.

Managing Content in Ektron CMS400.NET

7-330 ReferenceManual
Version 8.01 Rev 4



**Example
Field Text

Example Field Formula Description

Round up a
decimal
number

ceiling({X})

Returns the smallest integer
that is greater than the number.
For example, ceiling(3.14).
The result is 4.

For negative numbers:

ceiling(-3.14) = -3

Round down
a decimal
number

floor({X})

Returns the largest integer that
is not greater than the number
argument. . For example,
floor(3.14). The result is 3.

For negative numbers:

floor(-3.14) = -4

Format
decimal
number 0.00

format-number({X},'0.00')

Roundsa value either up or
down to the hundredth place.
Asexamples, 100 becomes
100.00, and 3.14159265
becomes3.14.

Total numeric
values from
multiple fields

sum({X}[text()] | {Y}[text()] | {Z}[text()]))

Add the values in all referenced
fields.

Only elements that contain a
value are summed. Empty
elements are excluded.

Total a list of
numeric
values

sum({X}[text()])

Total all values in a single
repeating field. Here’s an
example.

Plain Text Field properties

Name:Miles

Allow: more than one

Validation: non-negative whole
number

XMLData

<root>
<Miles>89</Miles>
<Miles>12</Miles>
<Miles>23</Miles>
<Miles>19</Miles>
</root>

sum(Miles) equals
89+12+23+19=143

Only elements that contain a
value are summed. Empty
elements are excluded.

Explanation of Examples
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**Example
Field Text

Example Field Formula Description

Average a list
of numeric
values

format-number(sum({X}[text()])
div count({X}),'0.###')

Calculate the average of all
values in a single repeating
field.

To continue the example from
the Total a list of numeric
values field (above):

Plain Text Field properties

Name:Miles

Allow: more than one

Validation: non-negative whole
number

XMLData

<root>
<Miles>89</Miles>
<Miles>12</Miles>
<Miles>23</Miles>
<Miles>19</Miles>
</root>

Average=89+12+23+19=143

divided by the number of values
(4)= 35.75

Only elements that contain a
value are summed. Empty
elements are excluded.

Count the
number of
values in a list

count({X})

Calculate the number of values
in a single repeating field.

To continue the example from
the Total a list of numeric
values field (above):

Plain Text Field properties

Name:Miles

Allow: more than one

Validation: non-negative whole
number

XMLData

<root>
<Miles>89</Miles>
<Miles>12</Miles>
<Miles>23</Miles>
<Miles>19</Miles>
</root>

Count = 4
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**Example
Field Text

Example Field Formula Description

Lowercase
text

translate({X},'ABCDEFGHIJKLMNOPQRSTUVWXYZ',
'abcdefghijklmnopqrstuvwxyz')

Replace all uppercase
characterswith the lowercase
version of that character

Uppercase
text

translate({X},'abcdefghijklmnopqrstuvwxyz',
'ABCDEFGHIJKLMNOPQRSTUVWXYZ')

Replace all lowercase
characterswith the uppercase
version of that character

Remove
extra spaces normalize-space({X}) Remove extra space

characters from content\

Concatenate
text concat({X}, ', ', {Y})

Link text strings together into a
single string. For example,
concat('The',' ','XML')
yieldsThe XML.

Size of a text
string string-length({X})

Count the number of
characters in a selected field’s
value. For example, if the
referenced field’s value isHello,
string-length = 5.

Calendar
Insert a calendar field when you want the Smart Form author to enter a date.
The user clicks a date from an interactive calendar.

Because users cannot enter digits, a standard date format is ensured. The date
is stored as a standard XML date (in the format yyyy-mm-dd), and localized to
the computer of the user viewing it.

Calendar
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Dialog Box
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Fields on the Calendar Field Dialog

Field Description

Descriptive
Name Enter the name of the field.

Indexed
Check if you want to index this field. For more information, seeXML Indexing on page 7-380

The Indexed field mayor maynot appear, depending on how your administrator has set up
your system.

Field
Name Enter the field’s element name. This defines the field in the XML.

Tool Tip
Text Enter the text that appearswhen a user hovers the cursor over this field.

Default
value

If you want this screen to have a default date when the user first sees it, click the calendar icon to
the right and select a date. The user can change the date in Data Entrymode.

Note: If you enter a default date, you cannot later remove it. You can change it. If
necessary, you can delete the field and enter a new one.

Use See TheUse Field on page 7-362

Allow

See The Allow Field on page 7-362

Warning! Do not insert a calendar field into a Smart Form that allowsmultiple entries (using
theAllow more than One option on the dialog). If you do, you cannot search the Smart
Form using that field.

Validation If you want to require the user using the calendar to enter a response, click the down arrow to
the right of this response field and selectCannot be blank.

Error
Message

If you selectCannot be blank above, insert text that appears on the screen if the user’s
response doesnot meet this criterion.

Custom
Validation SeeCustomValidation with a Calendar Field below

Data Style See TheData Style Field on page 7-363

Advanced SeeAdvanced Tab on page 7-359

Custom Validation with a Calendar Field
The Calendar Field dialog features a Custom Validation area (illustrated below).

Fields on the Calendar Field Dialog
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The Custom Validation area can ensure the user’s input is greater or less than
the date you are inserting on the Data Design screen.

n The Data Type field shows Date.

n The Condition field displays the validation logic.

n The Examples drop-down list shows validation expressions that you
can apply to the field.

n Any Error Message displays in Data Entry mode when the user
inserts an invalid value. Your system administrator determines if a
user can save the invalid data.

n The Select a Field to Insert area displays fields that can be
inserted into the Condition field. You must choose a calendar type
field (note the calendar to the left of these fields).

Example of Creating Custom Validation
As an example of custom validation, assume a field collects the date when a
patient’s health insurance policy expires. You want to make sure the date is
later than today. To accomplish this, follow these steps.

1. Create a calendar field that prompts for today’s date.

2. Create another calendar field that prompts for a patient’s health
insurance policy expiration date.

3. While creating the second field, in the Validation section, click
Custom Validation.

4. The Custom validation screen appears.

5. Click the down arrow to the right of the Examples field to see sample
logic.
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6. Click Date After (not(. >={X}). This option lets you specify that
the user’s response must be later than a specified date.

7. In the Condition field, select {X} and click the Select Field button.

8. The Select Field or Group screen appears.

9. Select the field that prompts for today’s date, which you created in
Step 1.

10. That field replaces {X} in the Condition field.

11. Move the cursor to the Error Message field and compose an error
message. For example: Must be after today.

12. Your screen should look like this.

13. Press OK.

14. Press OK to save that dialog and test the validation on the date field.
To do this, switch to Data Entry mode and enter a date earlier than
today to verify that validation works as expected.

Image Only
Use an Image Only field to place an icon on the screen, which the user in Data
Entry mode can click to insert an image into the Web content. You can insert a
default image if desired.

To let the user insert any file, such as a Microsoft Word document, use a File
Link field. See Also: File Link on page 7-339

ImageOnly
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Using an Image Only Field in Data Entry Mode
In Data Entry mode, the image’s caption appears, followed by a default image
(if you specify one) and this icon:

Note: The user can only insert a file whose extension is defined within the <validext>
element of the configdataentry.xml file. Your system administrator can help you do this.

Dialog Box
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Fields on the Image Only Dialog

Field Description

Descriptive
Name Enter the name of the field.

Indexed
Check if you want to index this field. For more information, seeXML Indexing on page 7-380.

The Indexed field mayor maynot appear, depending on how your administrator has set up
your system.

Field Name Enter the field’s element name. This defines the field in the XML.

Tool Tip
Text Enter the text that appearswhen a user hovers the cursor over this field.

Use See TheUse Field on page 7-362

Allow See The Allow Field on page 7-362

Value

Whether the value is an element or plain text.

Value is an element renders the field as<img src=”url” alt=”text” /> for an image.

Value is plain text renders the field as just the url.

Default
Image
Location

If desired, you can insert a default image, whichmight be themost common image or simply a
reminder that an image needs to be inserted.

To help find the image, click the From File button and navigate to image file.

You can only insert an image file whose extension appears between the <validext> tags in
the configdatadesign.xml file. For example:

<validext>gif,jpg,png,jpeg,jpe,doc,txt
</validext>

Cannot be
blank

If you want to require the user completing this field to enter a response, click inside this check
box.

Description Enter the image’s alt text, which is used asa replacement for an image whenever it cannot be
seen. For example, a visually impaired person is using a screen reader.

Advanced SeeAdvanced Tab on page 7-359

File Link
Use a File Link field to place an icon on the screen which the user in Data Entry
mode can use to link to any Library file, such as a Microsoft Word document or
a .gif image file. (You can also use an Image Only field to let the user insert an
image. See Also: Image Only on page 7-337)

The File Link field does not let you link to Ektron CMS400.NET assets.

Fields on the ImageOnly Dialog
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Using a File Link Field in Data Entry Mode
In Data Entry mode, the file link field’s caption appears, followed by this icon:

.When the user clicks the icon, this screen prompts the user to specify
information about the link.

Note: The user can only insert a file whose extension is defined within the <validext>
element of the configdataentry.xml file. Your system administrator can help you do this.
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Dialog Box

Dialog Box
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Fields on the File Link Field Dialog

Field Description

Descriptive
Name Enter the name of the field.

Indexed
Check if you want to index this field. For more information, seeXML Indexing on page 7-380

The indexed field mayor maynot appear, depending on how your administrator has set up
your system.

Field
Name Enter the field’s element name. This defines the field in the XML.

Tool Tip
Text Enter the text that appearswhen a user hovers the cursor over this field.

Use See TheUse Field on page 7-362

Allow See The Allow Field on page 7-362

Value

Whether the value is an element or plain text.

n Value is an element renders the field as<img src=”url” alt=”text” /> for an
image.

n Value is plain text renders the field as just the url.

Default
Location

If desired, you can insert a default link, which can be themost common link or simply an
example.

To help find the link, click theSelect button and navigate to a file. You can only insert a file
whose extension appears between the <validext>element of the configdatadesign.xml file.
For example:

<validext>gif,jpg,png,jpeg,jpe,pdf,doc</validext>

Cannot be
blank If you want to require the user completing this field to enter a response, click this checkbox.

Description If desired, enter text that the user can click to access the linked file.

Target
Frame

Use this field to indicate how the hyperlinked fileswill appear when clicked.

n New Window(_blank) - In a new browser window, on top of the current browser.

n Same Window(_self) - In the same position within the browser window. The new window
replaces the current one.

n Parent Window(_parent) - If your page contains frames, in the frame that contains the
framewith the hyperlink.

n Browser Window(_top) - If your page contains frames, in the full display area, replacing
the frames.

Data Style See TheData Style Field on page 7-363

Advanced SeeAdvanced Tab on page 7-359
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Resource Selector
A Resource Selector field lets you place elements of Ektron CMS400.NET
content, taxonomies, collections or folders on a Smart Form. For example, on
the page below, all content in a selected folder appears.

Each content item in the folder is represented as a hyperlink followed by its
summary. A site visitor can click the hyperlink to view the content.

An alternative display of the content, showing hyperlinks only, appears below.

Resource Selector
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So, a Resource Selector field acts like server controls that let you place content
on a Web page, such as the Content Block and List Summary controls. The
advantages of the Resource Selector field are:

n You can add individual content items or all content in a folder,
collection or taxonomy category to a Smart Form. This means you
can easily position resources then surround them with text, images,
etc., to place them into proper context.

n Management is handled within the Workarea. This means CMS
administrators and content contributors can create a Smart Form
without needing a developer to create/modify templates and server
controls.

The following topics explain using the Resource Selector field in more detail.

n Resource Selector Examples below

n Overview of Using a Resource Selector on the facing page

n Adding a Resource Selector Field on page 7-347

n Letting a Content Author Add Content on page 7-348

n Letting a Content Author Add a Folder, Taxonomy or Category on
page 7-354

n How a Content Author Adds Resource Selector Field on page 7-359

Resource Selector Examples
You could use Resource Selector fields to create a KB article that provides links
to other, related KB articles.

Another benefit of using a Resource Selector is the ability to do single sourcing,
that is, reuse the same content on different pages. This is helpful for content
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that needs to appear repeatedly (copyright information, license agreement,
contact information, etc.), but you want to maintain only one version.

Overview of Using a Resource Selector
Note: Before reading this section, you should be familiar with the process of creating Smart
Forms. See Also: Adding a New Smart Form on page 7-281

When creating an XML Smart Form that uses a Resource Selector, you follow
these steps. You would follow most of the steps with any Smart Form.

Step Illustration

1. An XMLSmart FormDesigner createsa Smart Form
configuration.

2. While editing the Data Design, he placesa Resource
Selector field on the configuration.

3. While placing a Resource Selector field, a dialog lets
the designer determine its properties.

For example, can the content author select content, a
taxonomycategory, a collection or a folder? These
properties are described inAdding a Resource Selector
Field on page 7-347.

Overview of Using a Resource Selector
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Step Illustration

4. An administrator assigns the Smart Form
configuration to an Ektron CMS400.NET folder.
See Also:Assigning Smart Forms to a Folder on page
7-368

5. An author createsa Smart Form based on that
configuration.

6. He adds content, a collection, a taxonomycategory, or
a folder to the Smart Form, along with other field
types.
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Step Illustration

7. A site visitor browses to the page and views the
assigned content.

Adding a Resource Selector Field
1. To add a Resource Selector field to a Smart Form configuration, click

the button shown below.

2. The following dialog appears.

3. Complete the first three fields as described below.

Adding a Resource Selector Field
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Field Description

Descriptive Name

Enter the name of this field.

Internally, the name is used as the field’s caption.

The Name Field’sDefault Value

Bydefault, the Data Designer assignsa namemade up of Field followed by the
next available number. So, the first field’s default name isField1, the second field’s
default name isField2, etc. You can change the default if you want.

Field Name Enter the field’s element name. This defines the field in the XML.

Tool Tip Text Enter the text that appearswhen a user hovers the cursor over the table’s column
headers.

4. Decide if this resource selector field will let the content author insert
content, a collection, a taxonomy category or a folder. The following
sections walk through these options.

n Letting a Content Author Add Content below

n Letting a Content Author Add a Folder, Taxonomy or Category on
page 7-354

Letting a Content Author Add Content
To add a Resource Selector field that lets an author add content to a Smart
Form, follow these steps.

Prerequisites: You completed the first three fields on the Resource Selector
Field dialog. See Also: Adding a Resource Selector Field on previous page

1. On the Resource Selector Field dialog, at the Resource Type
dropdown, select Content Resource.
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2. The Default Value field lets you define a default content item. If you
do, when a content author places this field on a Smart Form, he sees
the default content (as shown below).

The author can accept the default or change it.

To specify a default content item, click the folder icon next to Default
Value. The Select Content dialog appears (shown below).

Use the Folder, Taxonomy, or Search tab to identify the default
content. See Also: Taxonomy on page 9-202, The Search Published Tab
on page 9-90

Note:When browsing by folder, you only see content folders. You do not see eCommerce
catalog, Blog, Community, or Discussion Board folders.

3. Use the Allow section of the dialog to define a minimum and
maximum number of content items that can appear where you are
inserting this Resource Selector.

Letting a Content Author Add Content
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These settings affect the content author’s work with this field on a Smart
Form in the following way. Assume you set a Minimum of 1 and a
Maximum of 2. After the content author adds two content items for this
resource selector, his only options (shown below) are to remove or
rearrange fields -- he cannot add more.

4. Click the Type tab of the Resource Selector Field dialog.

All content types that a content author may add appear. Uncheck types
that you do not want to let a content author add. See Also: Types of
Content on page 2-3

5. Click the Configuration tab. This tab lets you determine how a
content author can select content for the Smart Form.

If you check all three options (as shown above), when a content author clicks
this Resource Selector, he sees the following dialog.
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Note that the dialog lets the author browse the folder structure, taxonomy
structure, or use search to select content.

Note:When browsing by folder, you only see content folders. You do not see eCommerce
catalog, Blog, Community, or Discussion Board folders.

On the other hand, if you uncheck Browsing taxonomy categories and
Searching for key words, the content author could only use the Folder tab
to select content.

6. Click the Appearance tab. This tab lets you determine the default
appearance of this Smart Form on your Web site.

Note: Unlike other settings on this dialog, the content author is not involved in the
Appearance settings.

The table below provides a sample of each Appearance option.

Letting a Content Author Add Content
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Appearance option How content appears on Web site

Content

Content Title
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Appearance option How content appears on Web site

Title followed by content

Quick Link

Quicklinkwith Summary

Letting a Content Author Add Content
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7. Save the dialog and configuration.

8. To learn how a content author works with this configuration, see How
a Content Author Adds Resource Selector Field on page 7-359.

Letting a Content Author Add a Folder, Taxonomy
or Category
To add a Resource Selector field that lets an author add a folder, taxonomy, or
collection to a Smart Form, follow these steps.

Prerequisites: You completed the first three fields on the Resource Selector
Field dialog. See Also: Adding a Resource Selector Field on page 7-347

1. On the Resource Selector Field dialog, at the Resource Type
dropdown, select Folder Resource, Taxonomy Resource, or
Collection Resource.

2. The Default Value field lets you define a default folder, taxonomy or
collection. If you do, when a content author places this field on a
Smart Form, he sees the default item (see example of folder below).
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The author can accept the default or change it.

To specify a default folder, taxonomy, or collection, click the folder icon
next to Default Value. A Select dialog appears (see example of folder
selector below).

Use it to select the default folder, taxonomy, or collection.

Note:When browsing by folder, you only see content folders. You do not see eCommerce
catalog, Blog, Community, or Discussion Board folders.

3. Use the Allow section of the dialog to define a minimum and
maximum number of folders, collections, or taxonomy categories
that can be placed on the screen where you are inserting this
Resource Selector.

These settings affect the content author’s work with this field on a Smart
Form in the following way. Assume you set a Minimum of 1 and a

Letting a Content Author Add a Folder, Taxonomy
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Maximum of 2. After the content author adds two items for this
resource selector, his only options (shown below) are to remove or
rearrange fields -- he cannot add more.

4. Click the Configuration tab. This tab lets you determine the starting
folder for this folder.

Note: The Configuration tab is not available for Collection and Taxonomy Resource Types.

You can browse the structure to pick a starting item. You can also determine if
the content author will have access to

n all folder in the structure

n this folder and its subfolders
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n this folder only

Note:When browsing by folder, you only see content folders. You do not see eCommerce
catalog, Blog, Community, or Discussion Board folders.

5. Click the Appearance tab. This tab lets you determine the default
appearance of this Smart Form on your Web site.

Note: Unlike other settings on this dialog, the content author is not involved in the
Appearance settings.

The table below provides a sample of each Appearance option.

Appearance option
for ...

How folder appears on Web site

Folders

List Quicklinksand
summaryof folder
contents

All content in folder appears in format shown above.

List Quicklinksof
folder contents

All content in folder appears in format shown above.

Letting a Content Author Add a Folder, Taxonomy

ReferenceManual
Version 8.01 Rev 4

7-357



Appearance option
for ...

How folder appears on Web site

Breadcrumb

The folder’s breadcrumb path appears, as defined on the folder Properties
screen’sBreadcrumb tab. See Also:Creating SiteMap Breadcrumbson page 9-
276

Taxonomy

DirectoryServer Con-
trol

This is the only option if the Resource Type isTaxonomy Resource. See Also:
DirectoryServer Controlon page 9-258

Collection

List Quicklinksand
summaryof collection
items

Content in collection appears in format shown above.

List Quicklinksof
collection items

Content in collection appears in format shown above.

6. Save the dialog and configuration.

7. To learn how a content author works with this configuration, see How
a Content Author Adds Resource Selector Field on the facing page.
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How a Content Author Adds Resource Selector
Field
When a content author creates a Smart Form whose configuration uses
Resource Selector fields, they appear as shown below.

In the above example above, the top field lets the content author select content
(id 30 is the default), and the lower one lets him select a folder (id 20 is the
default).

To select either one, he clicks the folder to its right, then uses the dialog to
make the selection. If working with content, the tabs which appear on the
dialog are determined when the resource is placed on the Smart Form
configuration. See Also: Click the Configuration tab. This tab lets you determine
how a content author can select content for the Smart Form. on page 7-350

Fields that Appear on Several Dialogs

Advanced Tab
The Advanced tab screen lets you control the XML that the field produces.

How aContent Author AddsResource Selector
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This dialog has two sections.

n Type - lets you generate XML microformats. See Also: The Type Area
of the Advanced Tab below

n Root Tag - lets you replace the <root> tag with another element
name. See Also: Using a Tag Other Than <Root> on page 7-302

The Type Area of the Advanced Tab
The dialog lets you generate XML microformats made up of standard XHTML
tags and attributes that contain a specific structure and values. The types are
described below.

Important: In order for Smart Form fields to searchable, they must be stored as elements not
attributes. See Also: Advanced Tab on previous page If you are upgrading to version 8.0, inspect
your Smart Forms and change field properties as needed so they are stored as elements not
attributes.

Type This field defines Example

Element A unique tag. The user’s response to the field becomes its
value.

<Lastname>Rogers</Lastname>

Attribute

An attribute of the containing field. The containing field is
typically a Group Box.

If you insert anAttribute field type, the Field Name field on
the dialog box is grayed out. The field name and type can
only be edited on the Advanced Field properties screen.

<PtInformation
Lastname="Rogers">
</PtInformation>
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Type This field defines Example

Content

The content of the containing field, typically a Group Box.

Note that, in this case, field name is not used. Asa result, the
Field Name field is grayed out. The field name and type can
only be edited on the Advanced Field properties screen.

Sincemost fields define their own content, this option is
typically used to define a value to aGroup Box that contains
other fields defined asattributes.

Warning! Only one Content type field is valid within a
containing field.

<PtInformation>
Rogers
</PtInformation>

Sample Microformat
For example, the microformat of an event looks like this.

<span class="event">

<a class= "url" href="https://www.lisa.org/events/2006nyc/package_
registration.html?from=fn1206 ">LISA Global Strategies Summit</a>

</span>

The Data Entry view looks like this.

The Data Design view looks like this.

SampleMicroformat
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Additional Notes about the Type Area of the Advanced Tab
n If the element is a group box or table, its type must be Element

because it surrounds other elements.

n If the element is a Rich Area field, its type must be Element or
Content.

The Use Field

Click May not be removed if this field must be included on the screen.
Otherwise, click May be removed.

If you check May be removed, when this field appears on a data entry screen,
an icon ( ) appears to the left of the field.

If the user clicks the icon, a dropdown menu provides an option to remove the
field, as shown below.

If the user removes the field, field name replaces the field on the data entry
screen to indicate that the field was removed and can be re-added if necessary.

For example, if the field’s display name is street address, and the user
removes the field, appears in place of the field.

Note: The menu icon ( ) can also indicate that the user can add instances of a field (see the
Allow field, below). So, if a field is required, the icon could appear but omit a Remove option.

The Allow Field
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Checkmore than one if you want to let the user entering data add instances
of this field. Otherwise, check only one.

Warning! Do not insert a calendar field into a Smart Form that allows multiple entries (using the
Allowmore than One option on the dialog). If you do, you cannot search the Smart Form using
that field.

For example, if a screen is collecting names and addresses and you want to let
the user enter several of them, checkmore than one.

If you checkmore than one, when this field appears in Data Entry mode,
appears to the left of the field, as shown below.

If the user entering data clicks , a menu appears (shown above), which lets
the user click Duplicate to add instances of the field to the screen.

Note: The menu icon ( ) can also indicate that the user can remove a field (see the Use field,
above). So, even if a field allows only one instance, the icon could appear but the menu would
only display Remove.

The Data Style Field
Click the Data Style button to apply formatting to the field that accepts user
input. When you do, the following dialog appears.

TheData Style Field
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Use the dialog to assign the following formatting attributes to a user response
field.

n Font style and size

n Bold and italic

n Text alignment (especially helpful for formatting dollar amounts in a
plain text field)

n Underline or strikethrough

n Font color and background color

Note: The configuration data controls a command's appearance on the toolbar and on the
Data Style dialog. For example, if <button command="cmdfontname" /> is removed from
configdatadesign.xml, it disappears from the toolbar and the Data Style dialog.

Below is an example of a response field whose font, size, alignment,
background, and foreground colors were modified via this dialog.

Custom Validation
The Plain Text and Calculation field dialogs feature a Validation tab (illustrated
below).
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Adding Standard Validation Options
By default, the Data Designer provides several standard validation options. You
can see them by clicking the down arrow to the right of the Validation
dropdown.

For a description of standard validation options, see Validation on page 7-319.

If you will frequently use a validation format that does not appear on the list,
the following Ektron KB article provides instructions for creating additional
validation options: http://dev.ektron.com/kb_article.aspx?id=7420

Creating Custom Validation Criteria
If the standard validation options do not provide the flexibility you need, use
the custom validation feature to ensure the following about the user’s input.

n The data type - the default types are

- text

- URL

- whole number

- decimal number

- floating point number (Floating point includes scientific notation, so is
appropriate for scientific numbers. Decimals usually suffice for business
numbers.)

Note: Your system administrator may customize the choices.

n The field value has one of the following relationships with another
field, a number, or an expression - the default expressions are

- between two values (either another field or a number that you specify)

- less than

- equal to

Adding Standard Validation Options
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- not equal to

- maximum length (usually for text responses)

Note: Your system administrator may customize the choices.

If the user’s response fails to meet the criteria, you can compose an error
message that appears when that happens. Your system administrator
determines if a user can save the invalid data.

When the Custom Validation button is clicked, the Custom Validation dialog
appears.

n The Data Type field is the value’s basic type, for example, text
number or URL.

n The Condition field displays the validation logic.

n The Examples drop-down list shows validation expressions that the
data design creator can apply to the field.

n Any Error Message displays in Data Entry mode when the user
inserts an invalid value.

n This dialog displays fields that can be inserted into the Condition
field. Some field types, like the RichArea field, are not listed. See
Also:Referencing Other Calculated Fields on page 7-329
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Example of Creating Custom Validation
As an example of custom validation, assume that a field collects telephone
numbers, and you want to make sure the user enters 10 digits. To accomplish
this, follow these steps.

1. Click the Plain Text Field dialog and complete the screen.

2. In the validation section, click Custom Validation. The Custom
validation screen appears.

3. In the Data Type field, selectWhole Number from the drop down
list. This ensures that the user can only enter digits.

4. Click the down arrow to the right of the Examples field to see
sample logic.

5. Click Maximum text length... . This option lets you specify the
length of the user’s response.

6. string-length(.) <= {X} appears in the Condition field.

Example of Creating CustomValidation
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7. Since you want the user’s input to equal 10, remove the less than sign
(<) from the calculation. Now it looks like this: string-length(.) =
{X}.

8. Replace the {X} with 10. Now, it looks like this: string-length(.) =
10.

9. Move the cursor to the Error Message field and compose a relevant
error message. For example: must be 10 digits.

10. Your screen should look like this.

11. Press OK and return to the Plain Text field dialog.

12. Press OK to save that dialog and test the validation on the phone
number field. To do this, switch to Data Entry mode and enter more
or fewer than 10 digits, as well as non-digit characters to verify that
validation works as expected.

Assigning Smart Forms to a Folder
When creating new content in a folder, the New menu provides a list of Smart
Forms that you can use to create new XML content. (See graphic below.)
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This section explains how to determine the list of Smart Forms available when
creating content.

This section also contains the following topics.

Inheritance and Smart Forms 7-369
Assigning a Smart Form to a Folder 7-369
Requiring Smart Forms 7-370

Inheritance and Smart Forms
A folder’s Smart Forms can be inherited from the parent folder, or you can
break inheritance and assign a unique group of Smart Forms. Use the Inherit
Parent Configuration checkbox to retain or break inheritance.

Assigning a Smart Form to a Folder
If you break inheritance, you then select the Smart Forms that can be assigned
to content in the folder using the Smart Forms dropdown list (shown below).

Inheritance and Smart Forms
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You can preview any Smart Form by clicking the Preview button ( ). To add
any Smart Form, select it from the dropdown list and click Add.

To remove a Smart Form, click Remove.

Requiring Smart Forms
You can require a Smart Form to be the only type of content that can be added
within a folder. To enable this, click the Require Smart Forms check box on
the Smart Forms tab.

If you do, the user can only choose enabled Smart Forms when viewing that
folder’s New menu -- all other content types are suppressed.

Viewing Smart Forms
To view a Smart Form, follow these steps.
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1. In the folder tree on the left side of the Workarea, go to Settings >
Configuration > Smart Form Configuration.

2. Click the form you want to view.

The View Smart Forms screen appears with a more detailed description of the
configuration.

This section also contains the following topics.

Smart Form Created with Data Designer 7-371
Smart Form Created with External Files 7-372
Properties Tab 7-373
Editor Information 7-373
Validation Information 7-374
Preview Tab 7-374
Display Information Tab 7-375

Smart Form Created with Data Designer

Smart FormCreated with Data Designer
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Smart Form Created with External Files

The View Smart Form screen has three tabs.

n Properties Tab on the facing page

n Display Information Tab on page 7-375

n Preview Tab on page 7-374

Each tab is explained below.

After viewing, you can perform the following actions on the Smart Form.

Button Name Description More Information

Edit Edit a Smart Form Editing Smart Formson
page 7-375

Edit Data
Design OpenData Designer

Editing Data Design
Packageson page 7-
375

Add Smart
Form

Create a new Smart Form from scratch or
based on an existing one

Viewing Smart Forms
on page 7-370

View XSLT Displaya Smart Form’sXSLT Viewing Data Designer
XSLTson page 7-378
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Button Name Description More Information

Delete Delete a Smart Form
Deleting Smart Form
Configurationson page
7-379

Back Return to previous screen

Properties Tab
Field Description

Title Name given to Smart Form.

ID ID number assigned byEktron CMS400.NET upon creation of
the configuration.

Description Detailed description of configuration given by creator or last
editor.

If the Smart Form was created using external XML files (instead of the Data
Designer), the following information also appears:

n Editor Information below

n Validation Information on next page

Editor Information
Note: This section only appears if you do not use the Data Designer to create your Smart
Form.

The editor information contains the file names of the XSLTs used when editing
and adding content in the editor.

Field Description

Edit XSLT

XSLT applied to the content when being edited.

Note: If no edit XSLT is specified, the Edit Data Design
option is enabled in the toolbar.

Save XSLT XSLT used to transform the XML created in the editor when
the Smart Form is saved to the database.

Advanced
Configuration

XML file that contains display information, schema validation,
and other advanced XML data.

Properties Tab
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Validation Information
Note: This section only appears if you do not use the Data Designer to create your Smart
Form.

You can validate the content created and edited with Ektron CMS400.NET with a
schema if desired. The validation information contains information about the
schema.

Field Description

XMLSchema Specify the .xsd file used to validate the XML content that the
Smart Formwill be assigned to.

Target
Namespace Specify the default namespace used for outgoing XML.

Preview Tab
The Preview tab displays the XSLT applied to the editor when XML content is
created. This is the XSLT that was created for the Smart Form.

Managing Content in Ektron CMS400.NET

7-374 ReferenceManual
Version 8.01 Rev 4



Display Information Tab
The display information tab lists the XSLTs that are used when displaying XML
in the respective environment.

Field Description

XSLT1 DisplayXSLT 1

XSLT2 DisplayXSLT 2

XSLT3 DisplayXSLT 3

XSLT Package DisplayXSLT Package (created
using the Data Designer)

Note:When a Smart Form is created using the Data Designer, a default display XSLT is also
created which looks similar to the edit XSLT created in the editor. This default XSLT can be
applied to the XML content.

The asterisk (*) denotes the default XSLT for the Smart Form.

The tab also displays the Smart Form’s xpaths.

Editing Smart Forms
After creating a Smart Form, you can modify it when files defined in the
configuration have changed. Since there are two ways to create a Smart Form,
there are two ways to edit one. Editing a Smart Form Created with External
Files on next page

This section also contains the following topics.

Editing Data Design Packages 7-375
Before You Edit the Data Package! 7-375
Editing a Data Design Package 7-376
Editing a Smart Form Created with External Files 7-376
Editing a Smart Form’s XSLT 7-377

Editing Data Design Packages
After you create a Smart Form, you can modify it.

Before You Edit the Data Package!
Before editing a Smart Form data package, it is important to understand the
effects of the modifications. If an XML data package is edited, all content to

Display Information Tab
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which the configuration is applied is updated. Information that was originally
created may be lost, depending on the changes you make to the package.

To ensure that information is not lost, use the Create New Smart Form Based on
Existing Smart Form option on the view Smart Form screen. See Creating
Smart Forms Based on Existing Configurations on page 7-378 for more
information.

Editing a Data Design Package
To edit a data design package, follow these steps.

1. In the Workarea, go to Settings > Configuration > Smart Form
Configuration.

2. Click the Smart Form configuration you want to edit.

3. The View Smart Form screen appears with a more detailed
description of the configuration.

4. Click the Data Design Mode button ( ) at the top of the screen.
5. The Edit Data Design Package screen displays the current package.

6. Make the necessary changes to the Data Design package in the editor.
See Using eWebEdit400to Create Smart Forms on page 7-286 for
information about creating XSLTs using the Data Designer.

7. Click the Update button ( ).

Editing a Smart Form Created with External
Files
Warning! Release 7.5.2 and up of Ektron CMS400.NET supports two editors: eWebEditPro+XML
and eWebEdit400. If you want users to insert Smart From information using eWebEdit400, you
cannot create or edit Smart Forms using external files. You must create and edit them using
Ektron CMS400.NET’s Data Designer.
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1. In the Workarea, go to Settings > Configuration > Smart Form
Configuration.

2. Click the Smart Form configuration you want to edit.

3. The View Smart Form screen is displayed.

4. Click the Edit button ( ).
5. The Edit Smart Form screen is displayed.

6. Edit the necessary fields to update the Smart Form. See Smart Form
Fields on page 7-285.

7. Click the Update button ( ).
Now, all content and folders that use the Smart Form take their properties from
the updated configuration.

See Also: XML File Verification on page 7-286

Editing a Smart Form’s XSLT
Every Smart Form has a packaged XSLT, which is a default XSLT created from
the configuration’s display information. If you want to modify the Smart Form’s
appearance, follow these steps.

1. Go to Settings > Configuration > Smart Form Configurations.

2. Click the Smart Form configuration whose XSLT you want to
customize.

3. Click the View XSLT button ( ).

4. Select and copy the XSLT.

5. Paste it into an XSLT editor.

6. Customize the file.

7. Save it with an .xslt extension to your site root/xmlfiles folder.

8. Return to the Smart Form configuration you selected in Step 2.

9. Click the Edit button ( ).
10. In the XSLT1 field, enter the Xslt you saved in Step 5.

11. Click the radio button next to XSLT1.

12. Click Save ( ).
You can edit the custom XSLT at any time. The changes immediately affect the
appearance of the Smart Form on your Web site. So, the XSLT is quite different
from other aspects of the Smart Form configuration, which generally cannot be
edited for existing content.

Editing a Smart Form’s XSLT
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Creating Smart Forms Based on Existing
Configurations
Whenever major changes must be made to a Smart Form, Ektron recommends
making a copy of it and modifying the copy. In this way, you do not affect the
content controlled by the original configuration.

To create a new Smart Form based on an existing one, follow these steps.

1. In the Workarea, go to Settings > Configuration > Smart Form
Configuration.

2. Click the Smart Form configuration you want to view.

3. The View Smart Form screen appears with a more detailed
description of the configuration.

4. Click the Create New Smart Form button ( ).
5. The Add Smart Form screen is displayed.

6. Enter a Title for the new Smart Form.

7. Click the Add Smart Form button ( ).
8. The View Smart Form screen for the new Smart Form is displayed.

From here, you can perform the necessary actions on it.

Viewing Data Designer XSLTs
When a Smart Form is created using the Data Designer, an XSLT is produced to
assist you with creating your display XSLT. This XSLT includes the structure for
your XML documents.

If a display XSLT is not applied to a Smart Form, content is displayed using the
default XSLT displayed in the View XSLT screen.

To view the XSLT for a Smart Form, follow these steps.

1. In the folder tree on the left side of the Workarea, go to Settings >
Configuration > Smart Form Configuration.

2. Click the Smart Form configuration whose XSLT you want to view.
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Note: The XSLT only appears if the Smart Form was created using the Data Designer.

3. The View Smart Form screen appears with a more detailed
description of the configuration.

4. Click the View XSLT button ( ).
5. The View XSLT screen is displayed.

You can use this information to create your display XSLT.

Deleting Smart Form Configurations
You can delete Smart Form configurations that are no longer needed. To do so,
follow these steps.

Note: If any Smart Form that uses this configuration has one or more indexed fields, you must
delete all content that uses the configuration before you can delete it. See Also: Specifying
Which XML Elements are Indexed on page 7-382

1. In the Workarea, go to Settings > Configuration > Smart Form
Configuration.

2. Click the Smart Form configuration you want to delete.

3. The View Smart Form screen is displayed.
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4. Click the Delete button ( ).

5. A confirmation message is displayed.

6. Click OK.

XML Indexing
XML Indexing lets site visitors search XML information collected via Smart
Forms and view the results. The results appear as a list of topic titles, optionally
followed by the content summary.

The Data Designer lets you choose which XML fields to index. You can also
validate those fields to be numbers, dates, Boolean, or string values. After you
identify fields to be indexed, a search dialog is created. Where appropriate, the
dialog automatically populates drop down lists from the indexed data.

Note: As the name implies, XML indexing is only available for information collected on XML
Smart Forms. It cannot find information in other types of content.

See Also:

n User vs. Developer Selected Search Criteria on the facing page

n Types of Search Criteria on the facing page

n Setting up a User-Defined Search on page 7-382

n Setting up a Developer-Defined Search on page 7-382

n Specifying Which XML Elements are Indexed on page 7-382

n Search Dialog Setup on page 7-383

n IndexSearch Server Control on page 7-384

n If you are upgrading from an earlier version of Ektron CMS400.NET to
7.5 or higher, the Knowledge Base article “INFO: 7.5 Upgrade:
Changes to 7.5 XML Index Search” lists upgrade considerations.

Managing Content in Ektron CMS400.NET

7-380 ReferenceManual
Version 8.01 Rev 4

http://dev.ektron.com/kb_article.aspx?id=13708
http://dev.ektron.com/kb_article.aspx?id=13708
http://dev.ektron.com/kb_article.aspx?id=13708
http://dev.ektron.com/kb_article.aspx?id=13708
http://dev.ektron.com/kb_article.aspx?id=13708
http://dev.ektron.com/kb_article.aspx?id=13708
http://dev.ektron.com/kb_article.aspx?id=13708
http://dev.ektron.com/kb_article.aspx?id=13708
http://dev.ektron.com/kb_article.aspx?id=13708


User vs. Developer Selected Search
Criteria
There are two ways that XML Indexing can make XML content available to your
site visitors.

n Present a screen of search criteria. A site visitor uses the screen to
select the kind of information he is looking for. For example, your
site sells outdoor clothing, and a user searches for wool hats under
$20.00.

n Determine the search and display criteria programmatically using a
custom function. Your Web developer inserts a control that specifies
search and display criteria. For example, your site sells books. A site
visitor sees a navigation link Find books under $5.00. When he
clicks that link, the control searches your XML content and returns all
books whose price is less than $5.00.

Note: The Ektron Windows Service manages the background processing that creates XML
indexes. See Also: Ektron Windows Service on page 22-7.

Note: Ektron CMS400.NET content has a Content Searchable check box, which is checked
by default. It must be checked if you want the Index Search to find Smart Form content. See
Also: The Content Searchable Field on page 9-29

Types of Search Criteria
XML Indexing allows multi-dimensional searches on all types of XML data.

Data Type XML Index Search can

Plain text Use an exact phrase, or anyword or letter in a phrase

Numerical and date information Use expressions such asgreater than, less than, or between two values

List and choice fields
Display the field valuesand let the user select relevant ones.

Note: Choices field values can consist of single letter.

ImageOnly Use the altor srcattribute value

Link Use the text or hrefattribute value

For every search field, NoSelection is a value. If this is chosen, the search
disregards that field when compiling results. However, the user must select a
value (or range of values) in at least one field to get results.
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Warning! Do not insert a calendar field into a Smart Form that allows multiple entries (using the
Allowmore than One option on the dialog). If you do, you cannot search the Smart Form using
that field.

Warning! In order for Smart Form fields to searchable, they must be stored as elements not
attributes. If you are upgrading to version 7.5 or higher, inspect your Smart Forms and change
field properties as needed so they are stored as elements not attributes.

Setting up a User-Defined Search
To create a user-defined search, follow these steps.

Step For more information, see

1. Select a Smart Form Accessing Smart Formson page 7-
281

2. Assign indexing to each field to be searched SpecifyingWhich XMLElements are
Indexed below

3. Set up the search screen Search Dialog Setup on the facing
page

4. Have your Web developer set up a page that displaysa
search control and a results control

IndexSearch Server Controlon page
7-384

Setting up a Developer-Defined Search
To set up a developer-defined search, which defines both the criteria and the
results page, use the SearchParmXML property of IndexSearch Server Control.
For more information, see IndexSearch Server Control on page 7-384.

Specifying Which XML Elements are
Indexed
You can index the following types of fields:

n Checkbox

n Plain Text

n Choices

n List

n Calculated

n Image Only

n Link
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n Calendar

Warning! Do not insert a calendar field into a Smart Form that allows multiple entries (using the
Allowmore than One option on the dialog). If you do, you cannot search the Smart Form using
that field.

To enable indexing for any field on an XML Smart Form configuration, follow
these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Smart Form Configuration.

2. Select a Smart Form configuration that you want to index. See Also:
Accessing Smart Forms on page 7-281

3. Open its Data Design.

4. Move the cursor to the first field you want to index.

5. Right mouse click the field.

6. Choose Field Properties.

7. A dialog box appears.

8. Check Indexed.

9. Repeat these steps for every field by which you want site visitors to
search the Smart Form.

Validation
Validation ensures that the user completing an XML form enters the right type
of data. You can decide if the user’s input should be a number, boolean, date,
string, zip code, etc. If you do not specify type attributes using validation data,
the field is a string.

Validation is especially important when users search XML data, because it helps
the search find the correct information. For example, if a field collects a zip
code but you set its type to plain text, a user completing the form can insert
anything into the field. If the user inserts the letter “o” instead of the number
zero (0), the field accepts that input but the search will not find that record. On
the other hand, if you set validation to zip code, the user can only insert five or
nine digits -- any other entry is rejected.

Search Dialog Setup
When you save a Data Design form, a dialog appears that lets you view all and
modify indexed fields (illustrated below).

Validation
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The information on this screen is explained below.

Screen
section

Description

Xpath The xpath to each indexed field.

Label The index field’s field name, asdefined on its dialog.

Multiple

Check this box if you want to allow the user performing the search to select more than one
value. This checkboxonly appearswith List and Choice fields.

Note: To select more than one value on the search screen, the user holdsdown the <Ctrl>
keywhile selecting additional options.

IndexSearch Server Control
Use the IndexSearch server control to display a Smart Form’s search screen on
any Web form. The control lets a site visitor search Smart Form content and
displays the results.

Note: The xmlConfigID property identifies the Smart Form that appears on the page on which
you are placing this server control.

See Also: XML Indexing on page 7-380

Below is a sample screen that the IndexSearch server control can generate.
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Alternatively, you can predefine a search and have the results appear on a Web
form via the SearchParmXML property. See Also: SearchParmXML Property on
page 7-390

In addition, you can run an XML search programmatically. See Using the
IndexSearch Server Control Programmatically Example on page 7-393 and
Predefined Search Results Replaced By Specific Search Results on page 7-395.

This section also contains the following topics.

IndexSearch Server Control Properties 7-385
SearchParmXML Property 7-390
Using the IndexSearch Server Control Programmatically Exam-
ple

7-
393

Predefined Search Results Replaced By Specific Search Results
7-
395

Turn Off Caching In Mozilla Firefox 7-398
Setting Page Size for Smart Form Search Results 7-398

IndexSearch Server Control Properties
The IndexSearch server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description
Data Type &
Values

Authenticated

Indicates if you are logged in to CMSExplorer and
can use it to browse to the folder needed for the
FolderID property. See Also:Using CMSExplorer
to Browse Your Ektron CMS400.NET Site on page
24-8

String

ButtonImgSrc If you want to display an image on the submit
button, enter the server path to it. String

IndexSearch Server Control Properties
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Property Description
Data Type &
Values

ButtonText
Text that appears on the submit button.

The default is:Search

String

ContentParameter

Checks theQueryString for the content block ID
value and replaces the search with content when ID
is specified. Leave blank to alwaysdisplay the
search.

n None - Use default.
n ID - The server control uses the content block
passed asa URL parameter.

String

CustomOrderBy

Provide the XPATH of an indexed field to order
search results by that field. For example, if your
XPATH is /root/Event/Location/city, resultswill be
sorted by city. Results can be ascending or
descending based on OrderByDirection. If you
enter an invalid XPATH, resultswill be ordered by
rank. If you specifyCustomOrderByand OrderBy,
the OrderByproperty is ignored.

String

DisplayXslt

Determineshow search results display on the page.

None - databind only

ecmNavigation - lists the title of every content
block in the folder

See Also:Example of ecmNavigation Displayon
page 9-127

ecmTeaser - lists the title of every content block in
the folder plus the content summary

See Also:Example of ecmTeaser Displayon page
9-128

Path to Custom Xslt - Enter the path to an Xslt
that determines the display of the page

Warning! If you specify an external file, it is
strongly recommended that you do not store this
file in your site'sWorkarea folder. If you store this
file in theWorkarea folder, the file will be lost when
you upgrade.

String

EmptyResultMsg

The resource file string that appears if the search
returnsno hits.

The default value is:

Your search did not match any
documents.

To learn about editing the resource file, see
Procedure for TranslatingWorkarea Stringson
page 14-41.

String
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Property Description
Data Type &
Values

EncodeContentHtml

Determines if HTML content is encoded when
returned.

True =Content HTML is encoded

False =Content HTML is not encoded

Boolean

FolderId

The numeric id of the folder that you want to search.
See Also:Using CMSExplorer to Browse Your
Ektron CMS400.NET Site on page 24-8

Any folder’s numeric ID.

0 (zero) is the root folder.

The Recursiveproperty determineswhether the
search includes this folder’s child folders.

Long

Hide

Use to hide output of the index search in design time
and run time. For example, you want to pass the
results to code behind for further manipulation.

True =Hide results

False = show results

Boolean
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Property Description
Data Type &
Values

Labelafter

Labelbefore

LabelBetween

LabelContains

LabeldateBetween

LabelEqual

LabelExactPhrase

LabelGreaterThan

Labelinputdate

Labelinputnumber

LabelLessThan

Labelon

LabelSelect

All properties let you change their label names. This
is useful for multi-language issues.

For example, if you have a French site, change
Equal toÉgale.

Examplesof what the user seeson the site in
French and English.

Note: These labels do not change based on the
Languageproperty’s setting. For example,
setting the Languageproperty to 1036 doesnot
change these labels to French.

String

Language
Set a language for viewing index search results.
This property shows results in design-time (in Visual
Studio) and at run-time (in a browser).

Integer
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Property Description
Data Type &
Values

LinkTarget

Use to define a link’s behavior
when clicked.

_blank - Causes the link to alwaysbe loaded in a
new blankwindow. Thiswindow is not named.

_self - Causes the link to always load in the same
window the anchor was clicked in. This is useful for
overriding a globally assigned base target.

_parent - Causes the link to load in the immediate
frameset parent of the document. This defaults to
acting like “_self” if the document hasno parent.

_top - Causes the link to load in the full bodyof the
window. This defaults to acting like “_self” if the
document is alreadyat the top. Useful for breaking
out of an arbitrarily deep frame nesting.

ItemLinkTargets

MaxResults Themaximum number of content blocks returned
(0=unlimited) Integer

OrderBy

The search results’ sort criterion. For example, to
sort results by last modified date, chooseDate
Modified.

n Title - The content block title

n ID - The content ID number

n Date Created - The date the content blockwas
created

n Date Modified - The date the content block
was last modified

n AuthorLName - The last author’s last name

n AuthorFname - The last author’s first name

n StartDate - TheGoLive Date

Use the OrderByDirectionproperty to determine
the direction of the sort.

String

OrderByDirection

The sort direction of the search results.

n Ascending

n Descending

This propertyworkswith the OrderByproperty.

String

Recursive
Determineswhether the search uses the selected
folder’s child folders. The folder is selected at the
FolderIDproperty.

Boolean

IndexSearch Server Control Properties
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Property Description
Data Type &
Values

SearchParmXML

Opensa new window that lets you predefine a
search. For example, you want mystery books from
a AcmePublishing published in the current year to
appear on aWeb page.

To access the window click the graybutton.

For more information, seeSearchParmXML
Propertybelow

ShowSearchBoxAlways If set to false, the search boxdoesnot appear on
PostBack. Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround
the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

Weighted

Bydefault, this property is false, whichmeans the
search only finds content that matchesall search
criteria. So, the search criteria have an AND
relationship.

If set to true, content items that meet any search
criterion are found. This is anOR relationship.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-
line portion of an HTML document asa span
element.

Div - The <div> tag is used when you want to apply
attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

xmlConfigID ID of the Smart Formwhose indexed fields appear
on the search screen. Long

SearchParmXML Property
Use the SearchParmXML property to create a predefined XML search whose
results appear upon page load. Click the gray box in this property to open a
window where you define the search. The window’s parameters are defined by
the Smart Form Configurations selected at the xmlConfigID property.
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If you are not logged in, this property launches the CMS Explorer login. For
more information, see ”Using CMS Explorer to Browse Your Ektron CMS400.NET
Site” on page 21-12

The following example uses the SearchParmXML property to create a list of
books, based on publishers with “press” in their name.

1. To activate the window, click the gray box in the SearchParmXML
property.

2. The Build Search Parameter screen appears.

3. Click the check boxes for the parameters you want to search with.

SearchParmXMLProperty
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4. Define the parameter.

The drop down box in this example contains the following variables:

Select One - Prompts you to choose a variable

Exact Phrase - Enter a phrase and search for that exact phrase within
the XML content

Contains - Enter a word or phrase and search for any XML content that
contains that word or phrase

5. Click OK.

6. Build the Web form.

7. Browse to the Web page in your browser.

Managing Content in Ektron CMS400.NET

7-392 ReferenceManual
Version 8.01 Rev 4



8. The page shows XML content on your site that matches the
parameters.

Using the IndexSearch Server Control
Programmatically Example
Note:When creating an IndexSearch server control form using code behind only, the control
must be connected with the page events. Otherwise, you cannot submit search parameters.

You can use the IndexSearch server control in code behind to manipulate how
users view search results. The following example shows how to return values
associated with an XPath. This example shows a list of book titles.

1. Open a Web form.

2. Drag and drop an IndexSearch server control onto it.

3. Set the properties in the properties window.

Note: In this example, the hide property must be true. Remember also to set the XmlConfigID.
This example uses ID number 4.

4. Drag and drop a Literal on the Web form.

Using the IndexSearch Server Control
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5. Add the following to the code behind.
IndexSearch1.Parm.XPath = "/root/subject"

Dim arStr As String()

Dim Str As String

Dim strRet As String

arStr = IndexSearch1.GetXPathValues("/root/subject")

For Each Str In arStr

 strRet += Str & "<br/>"
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Next

Literal1.Text = strRet

Here is a breakdown of the code.

Code snippet Description

IndexSearch1.Parm.XPath = "/root/subject" Defines the parameter XPath location:

Dim arStr As String()
Dim Str As String
Dim strRet As String

Creates variables

arStr =
IndexSearch1.GetXPathValues("/root/subject")

Sets the variable arStr as an arrayof the
XPathValues

For Each Str In arStr
 strRet += Str & "<br/>"

Next

The for next loop iterates through the arrayof
XPathValues

Literal1.Text = strRet Displays valueson your Web form

6. Build the project.

7. Browse to your web form.

8. The list of book subject titles appears.

Predefined Search Results Replaced By
Specific Search Results
This code behind example shows a predefined search appearing on a Web page,
then being replaced by more specific search results. This example creates a
hyperlink list of book publishers. When you click a specific publisher, it replaces
the publisher list with a book list from that publisher.

Follow these steps.

1. Add an IndexSearch server control to a Web form.

Predefined Search Results Replaced BySpecific
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2. Set the following properties:
n DisplayXslt = ecmTeaser

n Hide = True

n ShowSearchBoxAlways = False

n Weighted = True

n XmlConfigId = 4

3. Add two Literals.

4. Add the following code to the Page Load Event in code behind.
Dim bRet As Boolean

 If Request.QueryString("publisher") <> "" Then

 IndexSearch1.Hide = False

 IndexSearch1.Parm.XPath = "/root/publisher"

 IndexSearch1.Parm.DataType = Ektron.Cms.Common.EkEnumeration.XMLDataType.String

 IndexSearch1.Parm.SearchType =

Ektron.Cms.Common.EkEnumeration.XMLSearchRangeType.ExactPhrase

 IndexSearch1.Parm.Value1 = Request.QueryString("publisher")

 bRet = IndexSearch1.AddParm()

 IndexSearch1.Search()

 Literal1.Text = "<h1>Publisher " & Request.QueryString("publisher") & " -
Books</h1>"

 Literal2.Text = "<a href=""webform.aspx"">Back</a>"

 Else

 Literal1.Text = "<h1>Publishers</h1>"

 Dim arStr As String()

 Dim Str As String

 Dim strRet As String

 arStr = IndexSearch1.GetXPathValues("/root/publisher")

 For Each Str In arStr

 strRet += "<a href=""webform.aspx?publisher=" & Server.UrlEncode(Str) & """>" &
Str & "</a><br/>"

 Next

 Literal1.Text += strRet

 End If

5. Save your Web form.

6. Build your Web form.
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7. Browse to the Web form in your browser.

8. The list of publishers appears.

9. Click a publisher.

10. A list of books with teasers by that publisher appears.

Notice the second Literal now contains a hyperlink to go back.

11. Click on a book.

12. The XML content for that book appears.
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Turn Off Caching In Mozilla Firefox
When using Mozilla Firefox to perform an index search some parameters
become cached. To prevent caching in Mozilla Firefox, add the following line to
the Page Load Event in code behind:

Response.Cache.SetNoStore()

Setting Page Size for Smart Form Search
Results
Paging support is available for XML Index Search results. You set the number of
results per page in this Web.config file tag:

<web search>

<providers>

<add name="MSIndexDialectServer"

pageSize

If the number of results exceeds the pageSize value, the display terminates
and the user see Next Page below the last entry.
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Using the Document
Management System
The Document Management System (DMS) lets you import Microsoft Office files
along with other types of files into Ektron CMS400.NET. (Non-Office files are
known as managed files.) Collectively, these files are known as assets.

After being saved to Ektron CMS400.NET, assets can be updated and tracked
like other content. If you’re familiar with how content is handled, most of what
you know applies to assets. For example, assets

n can be stored in folders with other content, or in separate folders
that you create just for them

n are assigned content ID numbers

n can have summary, metadata, comment, task, schedule, and
taxonomy information

n inherit permissions and approvals from their folder properties

n progress through the workflow (check out, check in, publish)

n retain a history so you can restore earlier versions

n can be searched

n support foreign language editions

n can have a task assigned to them

n appear on content reports

n update the Smart Desktop listing of files awaiting approval, checked
out, to expire, etc.

When an asset is imported to the CMS then saved, a copy of it is saved to the
Document Management server. Then, whenever a user edits and saves the
asset, a new copy is stored. In this way, you can review and, if needed, restore
a prior version.

This section also contains the following topics.

Supported Types of Assets 7-400
Security 7-400
Software Requirements 7-400
Working with Microsoft Office Documents 7-403
Importing Office Documents 7-405
Working with Managed Files 7-428
Asset Workflow 7-432
Asset Reports 7-432
Document Management Configuration 7-433
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Checking Document Management Permissions 7-436
Managing Multimedia Assets 7-438
PDF Generation 7-445
Troubleshooting 7-448
Removing Front Page Server Extensions 7-466
AssetControl Server Control 7-466
ImageControl Server Control 7-469

Supported Types of Assets
Ektron CMS400.NET can support all file types. By default, only the following
types are supported. However, your administrator can add or remove any file
type via the Settings > Configuration > Asset Server Setup screen.

Warning! Ektron CMS400.NET does not support double extensions, such as filename.aspx.vb.

n Microsoft Office 2000 or later documents: Word, Excel, Powerpoint,
Project, Publisher, Visio, etc.

n Managed files: *.zip files, PDFs, *.txt files, graphic files such as *.gif
and *.jpeg,

n Open Office documents such as *.odf, *.odt

n Multimedia files such as *.swf, *.mp3, *.wav. *.avi

Note: The file types that can be uploaded are determined by your administrator. If you try to
upload the wrong type of file, the following error message appears.

Security
For the purposes of security, assets are treated like other content. Your system
administrator applies security to each folder, determining which user groups
can perform which tasks on the content in a folder. For more information, see
Folder Permissions on page 4-40.

Software Requirements
See

n Browser Requirements on the facing page

n Installing FireFox Plug In on the facing page
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Browser Requirements

Feature Browser Requirements
For more
information, see

Edit Microsoft
Office
documents
within Ektron
CMS400.NET

Internet Explorer. Option doesnot appear with Firefox.

Note: Firefoxusers can checkanOffice document out to
their computer, edit it using Office, then drag and drop
the file back intoEktron CMS400.NET. SeeEditing a
Managed File on page 7-430.

Note: If your computer hasWindowsVista, youmust
turn off itsUser Account Control to use this feature. For
details, see
http://www.microsoft.com/technet/technetmag
/issues/2007/06/uac/default.aspx

Edit in Microsoft Office
on page 7-420

Multiple DMS
Documents
Option

Internet Explorer. Option doesnot appear with other
browsers.

Adding Documents
Using theMultiple
DMSDocuments
Option on page 7-409

Installing FireFox Plug In
If you want to use the Document Management’s drag and drop feature with the
Firefox browser, you need to install software to enable it. You only need to do
this once on a computer.

Follow these steps to install the Firefox plug-in software.

1. Launch the FireFox browser.

2. In the Ektron CMS400.NET Workarea, open a content folder.

3. Click the Add Assets button (circled below).

4. The following box appears in the center of the screen.

Browser Requirements

ReferenceManual
Version 8.01 Rev 4

7-401

http://www.microsoft.com/technet/technetmag/issues/2007/06/uac/default.aspx
http://www.microsoft.com/technet/technetmag/issues/2007/06/uac/default.aspx


5. Click the word here.

6. The following dialog appears.

7. Click the down arrow next to Netscape (default) and select Other.

8. Browse to C > Program Files > Mozilla Firefox > Firefox.exe.

9. Click Open.

10. Firefox.exe appears next to the Open with field.

11. Press OK.

12. The following dialog appears.
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13. Click Install Now.

14. Close then reopen the Firefox browser.

Working with Microsoft Office
Documents
This section explains how to work with Microsoft Office documents.

This section also contains the following topics.

MS Office Document Menu Options 7-403
Notes on Working with Microsoft Office Documents 7-404

See Also: Importing Office Documents on page 7-405

MS Office Document Menu Options
Depending on a document’s status, your role, and position in the document’s
approval chain, any of the following options may be available when you display
the dropdown menu for an Office document.

See Screen Sample

Working with Microsoft Office Documents
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See Also: Dropdown Menu Options on page 4-10

Notes on Working with Microsoft Office
Documents
Prerequisites

n MS Office 2003 or higher

n Internet Explorer to work with Office documents within Ektron
CMS400.NET.

Note:While you cannot edit within Ektron CMS400.NET using Firefox, you can save an Office
document to your computer, edit it, then drag and drop the updated version to Ektron
CMS400.NET.

n Verify the following settings for every Office document type that you
work with.

- Open Windows Explorer.

- Click Tools > Folder Options > File Types.

- Click an Office file type you work with (for example, DOC Microsoft
Word Document).

- Click the Advanced button.

- Change the checkboxes at the bottom of the screen so they look like
this.
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- Click OK

n Problems can arise if you try to open a document created with Office
2007 or 2010 and your computer has an earlier version of Office. The
best solution is to upgrade your computer to Office 2007/2010.

If you cannot do this, install the Microsoft Windows Compatibility
Pack. See
https://www.microsoft.com/downloads/details.aspx?FamilyId=941B3470-
3AE9-4AEE-8F43-C6BB74CD1466&displaylang=en .

Once installed, you can work with Office 2007/2010 documents with
an earlier version of Office.

n If you import an Excel spreadsheet then click it from its Ektron
CMS400.NET folder, you see Download this file name. Click the
download link to view the file.

Importing Office Documents
DMS can store and help you manage Office documents. This section explains
how to import any document into Ektron’s Document Management System.

This section also contains the following topics.

Methods for Importing Documents 7-405
How Imported Documents are Named 7-407
Adding Documents Using the DMS Document Option 7-408
Adding Documents Using the Multiple DMS Documents Option 7-409
Adding Documents Using the Add Assets Button 7-410
Adding Documents to a Mapped Network Folder 7-416
Editing an Office Document 7-420
Edit in Microsoft Office 7-420
Edit Using a Mapped Network Folder 7-421
Status of Document Saved to Mapped Network Folder 7-422
Deleting an Office Document 7-422
Checking Out, Saving, and Replacing an Office Document 7-423
Saving an Office Document 7-424
Saving an Office Document in .html Format 7-425
Warnings About Saving in .html Format 7-425
Saving an Office Document as a Web Page 7-425
Handling Images Embedded within a Word Document 7-426
Saving an Office Document as .html from Ektron CMS400.NET 7-426
Saving Office Document as .html from Your Computer 7-427

Methods for Importing Documents
Ektron CMS400.NET provides several ways to import Microsoft Office
documents. They are described below.

Importing Office Documents
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Warning! You cannot simply place files in the siteroot/assets or siteroot/PrivateAssets
folder then manage them using Ektron CMS400.NET. You can only import documents using one
of the methods listed below.

Note: Only users with Add permission for a folder can import documents to it. See Also: Folder
Permissions on page 4-40.
Also, you cannot import to a folder for which XML Smart Forms are required. See Also:
Requiring Smart Forms on page 7-370

Method Advantages Disadvantages
Supported
browsers

For more
information, see

New > DMS
Document
from View
Contents of
Folders screen

n Can enter
Summary, Metadata,
etc. for each
document

n Can create
unique title for each
document

n Can check in or
submit for approval

n Can only upload
one document at a
time

n Internet
Explorer

n Firefox

n Google
Chrome

n Safari

Adding
DocumentsUsing
the DMS
 Document Option
on page 7-408

New > Multiple
DMS
Documents
from View
Contents of
Folders screen

n Can upload
several files at once

n Can apply same
summary, metadata,
etc. to all files

n Can check in or
submit for approval

n Document title
taken from
Windows file name

n Internet
Explorer with
MS Office

Adding
DocumentsUsing
theMultiple DMS
DocumentsOption
on page 7-409

Add Asset tool-
bar button >File
Upload tab

n Document title
taken from
Windows file name

n Can only upload
one document at a
time

n No check-in or
save option

n Internet
Explorer

n Firefox

n Google
Chrome

n Safari

Add AssetsBut-
ton: File Upload
Tab on page 7-
411

Managing Content in Ektron CMS400.NET

7-406 ReferenceManual
Version 8.01 Rev 4



Method Advantages Disadvantages
Supported
browsers

For more
information, see

Add Asset
toolbar button >
Drag and drop
tab

n Can upload
several files at once

n Can drag/drop
folder structure;
Ektron
CMS400.NET
recreates it in
Workarea

n Can apply same
metadata and
taxonomycategory
to all uploaded
documents

n Document title
taken from
Windows file name

n No check-in or
save option

n Firefox

Add Assets
Button: Drag Drop
Tab on page 7-
413

Add Asset tool-
bar button >Mul-
tiple DMS
 Documents
tab

n Can upload
several files at once

n Document title
taken from
Windows file name

n No check-in or
save option

n Internet
Explorer with
MS Office

Same asAdding
DocumentsUsing
theMultiple DMS
DocumentsOption
on page 7-409
except there is no
check-in option

Drag and drop
tomapped
network folder

n User doesn’t
need to install or
learn CMSsoftware

n Can drag/drop
folder structure;
Ektron
CMS400.NET
creates it in
Workarea

n Document title
taken from
Windows file name

n Content is in
checked in status;
submitting for
publishing is
separate step

n Cannot assign
language to content

n Cannot work
with content in
language other
than computer’s
default

Adding
Documents to a
Mapped Network
Folder on page 7-
416

How Imported Documents are Named
When you use the New > DMS Document file import option, you enter an
Ektron CMS400.NET title for the file. When you import a file using any other
method, its name is the file name without the extension. So for example,
mypicture.jpg becomes mypicture in Ektron CMS400.NET.

While it may appear that the file extension was removed, it is retained and
reappears for assets when you use the Edit option, on the View Contents of
Folder screen (circled below).
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The original file extension also appears when you check out.

You cannot import a file whose name and extension match a file already in the
folder.

If you import a file of the same name but a different extension into the folder,
the next available number is appended to the file name. For example,
mypicture(2).

Adding Documents Using the DMS Document
Option
To add an Office document via the New > DMS Document menu option,
follow these steps.

1. From the Workarea, select the Content tab.

2. Select the folder in which you want to place the document.

3. The default language icon appears next to the screen title. To create a
document for a different language, click View > Language and
select the language.

4. Click New > DMS Document.

5. The following screen appears.

Managing Content in Ektron CMS400.NET

7-408 ReferenceManual
Version 8.01 Rev 4



6. Click the Browse and navigate to the file you want to import.

7. Enter a Title. It cannot include these characters: \, /, *,>, <,|

Note: If you want to retain the original document name, insert the full filename into the Title
field. For example, you could enter mydocument.doc.

8. Use the Content Searchable checkbox to determine if the content
should be searchable. See Also: Content Searchable on page 7-14.

9. If desired, add a summary, metadata, a schedule, and comments.
See Also:

n Working with Content Summary on page 7-137

n Working with Metadata on page 7-141

n Scheduling Content to Begin and End on page 7-187

10. Check in or submit the content for publishing as you would HTML
content.

Adding Documents Using the Multiple DMS
Documents Option
To add Office documents to Ektron CMS400.NET via the New > Multiple DMS
Documents menu option, follow these steps.

Note: This option requires Internet Explorer and Office 2003 or higher. Also, you must enable
ActiveX controls in your browser settings.
To do this, open Internet Explorer and go to Tools > Internet Options > Security Tab >
Custom Level button. Within that screen, under ActiveX controls and plugins, find Script
ActiveX controls marked safe for scripting* and click the Enable button.

Warning! If you will apply the same information (Summary, Metadata, Categories, etc.) to several
files, place those files in the same Windows folder before starting this procedure.

1. From the Ektron CMS400.NET Workarea, select the Content tab.

2. Select the Ektron CMS400.NET folder in which you want to place the
documents.

3. The default language appears next to the screen title. To create a
document for a different language, click View > Language and
select the language.

4. Click New > Multiple DMS Documents.

5. The Edit Content in Folder screen appears. The lower portion of the
screen resembles Windows Explorer.

Adding Documents Using theMultiple DMS
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The left frame shows folders on your computer. The right frame shows
files in the selected folder.

6. In the left frame, select the folder that contains files you want to
upload.

7. In the right frame, check the box next to each file you want to upload.
To select all files in the folder, check the box in the header (circled
below).

Note: You can only import files from one folder at a time.

8. If appropriate, enter the files’ summary, metadata, schedule, tasks,
comments, or category. Any information you enter is applied to all
selected files. See Also:

n Working with Content Summary on page 7-137

n Working with Metadata on page 7-141

n Scheduling Content to Begin and End on page 7-187

9. To check in the files, click the Check In button ( ) from the top left
corner.

To submit the files into the approval chain, click the Submit ( ) or
Publish ( ) button.

Adding Documents Using the Add Assets Button
The following table describes your options when using the Add Assets toolbar
button (circled in the figure below) to add documents.
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The options that appear when you click the Add Assets button vary depending
on your browser, as shown below.

Browser
Add Asset
screen
options

For more information, see

n Internet Explorer
without MS Office

n Google Chrome

n Safari

File Upload Add AssetsButton: File Upload Tab below

Internet Explorer with
MS Office

n File Upload

n Multiple DMS
 Documents

n Add AssetsButton: File Upload Tab below

n Same as Importing Office Documentson page 7-
405except there is no check-in option

Firefox
n File Upload

n Drag and Drop

n Add AssetsButton: File Upload Tab below

n Add AssetsButton: Drag Drop Tab on page 7-413

Add Assets Button: File Upload Tab
When using File Upload tab, you upload one file at a time. Follow these steps
to upload files.

1. From the Ektron CMS400.NET Workarea, select the Content tab.

2. Select the folder in which you want to place the documents.

3. The default language appears next to the screen title. To create the
documents in a different language, click View > Language and
select the language.

4. Click the Add Assets button (circled below).

Add Assets Button: File Upload Tab
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5. The File Upload screen appears. As explained in Adding Documents
Using the Add Assets Button on page 7-410, the screen's appearance
can vary.

6. Click the File Upload tab.

7. Click the Browse or Choose File button

8. Navigate to the folder whose asset you want to upload.

9. Select a file.

10. Click the Upload button.

If the asset's file type is not supported, an error message appears.
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Note: If your Web site uses an https secure site setting, you may see errors after uploading
assets. If this occurs, open your site’s web.config file and change the value of the add
key="ek_UseSSL" setting to true.

11. If Ektron CMS400.NET requires you to apply metadata or a taxonomy
category to the content, the following screen appears.

Note: Your system administrator creates the metadata screen. The image below is an
example of how it might look.

12. Required metadata field labels are red and have an asterisk (as title
does above). Complete all required metadata. See Also:Working
with Metadata on page 7-141

13. If the Category tab appears, apply at least one taxonomy category
to this asset. See Also: Taxonomy on page 9-202

The status of an uploaded asset depends on the approval chain.

n If you are the last approver, or if there is no approval chain, its
status is Approved.

n If there is an approval chain and you are not the last approver, its
status is Checked In (I).

Add Assets Button: Drag Drop Tab

Note: The Drag Drop tab is available only if your browser is Firefox.

When using drag and drop, you can choose individual files or a folder. If you
choose a folder, its structure is recreated in Ektron CMS400.NET even if it is
several levels deep.

1. From the Ektron CMS400.NET Workarea, select the Content tab.

Add Assets Button: Drag Drop Tab
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2. Select the Ektron CMS400.NET folder in which you want to place the
documents.

3. The default language appears next to the screen title. To create the
documents in a different language, click View > Language and
select the language.

4. Click the Add Assets button (circled below).

5. The drag and drop window appears.

Note: If you are using Ektron CMS400.NET with the FireFox browser for the first time, see
Installing FireFox Plug In on page 7-401.

6. Click the Drag Drop tab.

7. Resize Ektron CMS400.NET so that it occupies the left half of the
screen.

8. Open Windows Explorer. Resize it so it occupies the right half of the
screen.

9. Find the folder or assets you want to upload.

10. From Windows Explorer, drag and drop a folder or assets into the
drag and drop window.
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11. The following screen appears.

If an unsupported asset is chosen, an error message appears: An error
occurred copying some or all of the selected files. However, all
supported assets are uploaded. See Also: Importing Office Documents on page
7-405

Note: If your Web site uses an https secure site setting, you may see errors after dragging an
dropping assets. If this occurs, open your site’s web.config file and change the value of the
add key="ek_UseSSL" setting to true.

12. If Ektron CMS400.NET requires you to apply metadata or a taxonomy
category to the content, the following screen appears.

Note: Your system administrator creates the metadata screen. The image below is an
example of how it might look.

13. Required metadata field labels are red and have an asterisk (as title
does above). Complete all required metadata. See Also:Working
with Metadata on page 7-141

14. If the Category tab appears, apply at least one taxonomy category
to this asset. See Also: Taxonomy on page 9-202
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The status of the dragged and dropped documents depends on the approval
chain.

n If you are the last approver, or if there is no approval chain, its
status is Approved.

n If there is an approval chain and you are not the last approver, its
status is Checked In (I).

Adding Documents to a Mapped Network Folder
You can set up a mapped network folder then drag and drop folders or assets
into it. The advantage of this method is that you can upload documents without
installing or learning how to use Ektron CMS400.NET.

When using drag and drop, you can choose individual assets or a folder. If you
choose a folder, Ektron CMS400.NET recreates that folder structure, even if it is
several levels deep. After the assets are uploaded, they are set to Checked In
status.

You can also delete and move assets using the mapped network folder.

This section explains these procedures.

n Language Restrictions on Content in a Mapped Network Drive below

n Setting up a Mapped Network Drive below

n Dragging and Dropping Assets into a Mapped Network Drive on page
7-418

n Viewing Managed Files in a Mapped Network Drive on page 7-419

n Removing Mapped Network Drives on page 7-419

Language Restrictions on Content in a Mapped Network
Drive
You cannot choose a language for assets in a mapped network folder-- they are
automatically assigned the Ektron CMS400.NET default language (set in the
siteroot/web.config file at the ek_DefaultContent Language element).

And, you cannot work with assets of a language other than your computer’s
default language. For example, if your computer’s default language is English
and your version of Ektron CMS400.NET has Spanish content, you cannot edit
that content in a mapped network folder.

Setting up a Mapped Network Drive
Prerequisites:

n The path to your Ektron CMS400.NET Web site. It is something like
this: http://server23/CMS400. If you do not know the path, ask
your system administrator.

n an Ektron CMS400.NET user name and password

Managing Content in Ektron CMS400.NET

7-416 ReferenceManual
Version 8.01 Rev 4



1. Open Windows Explorer.

2. Click Tools > Map Network Drive.

3. The Map Network Drive screen appears. Click Sign Up for Online
Storage or Connect to a Network Server.

4. A wizard screen appears. Click Next.

5. Another wizard screen appears. Click Choose another network
location. Click Next.

6. A third wizard screen appears. Enter the path to your Ektron
CMS400.NET site, followed by the ekdavroot folder. For example,
http://server23/CMS400/ekdavroot. Click Next.

Warning! If your computer runs Microsoft Vista and you see this error message The folder you
entered does not appear to be valid. Please choose another, refer to this Ektron KB article:
http://dev.ektron.com/kb_article.aspx?id=15176.

7. A login screen appears (see below). Enter your Ektron CMS400.NET
username and password. Click OK.
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8. Another wizard screen appears. Name the folder. You will use this
name to identify the folder when you want to drag and drop assets to
it. Click Next.

9. The Finish screen appears.

Dragging and Dropping Assets into a Mapped Network Drive
Use Windows Explorer to drag and drop folders or assets into the mapped
network folder.

Warning! If a Windows folder has more than 1500 files, Windows Explorer may time out while
trying to open it. To remedy this problem, divide your files in that folder into several child folders.

1. Open Windows Explorer. Resize it so it occupies the left half of the
screen.

2. Open the folder that contains the folders or assets you want to upload
to Ektron CMS400.NET.

3. Open a second instance of Windows Explorer. Resize it so it occupies
the right half of the screen.

4. In that window, openMy Network Places. Under that, find the
mapped network folder you created in Setting up a Mapped Network
Drive on page 7-416.

5. A login screen appears. Enter your Ektron CMS400.NET username and
password. Click OK.

6. Open the Ektron CMS400.NET folder into which you want to upload
assets or folders.

7. From the left window, drag and drop assets or folders into the
mapped network folder.

If any of the assets being uploaded is not supported, an error message appears:
An error occurred copying some or all of the selected files. However,
all supported assets are uploaded. See Also: Importing Office Documents on
page 7-405
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Viewing Managed Files in a Mapped Network Drive
If you want to view individual managed files within a mapped network drive
folder, follow this procedure.

1. Open the site root/web.config file.

2. Go to this line:
<!--remove verb="GET,HEAD,POST" path="*"/-->

3. Remove the comment characters (in red above).

4. In the following lines, insert beginning and ending comment
characters as shown in red below.

<!--add verb="GET,POST" path="*.doc"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.docx"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.xls"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.xlsx"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.ppt"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.pptx"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.vsd"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

<add verb="GET,POST" path="*.vsdx"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/-->

<!-- Enable the line below and remove all office specific mappings above for Server 2003
with

private assets and enable remove verb command-->

5. Go to this line:
<!--add verb="GET,HEAD,POST" path="*"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/-->

6. Remove the comment characters (in red above).

After you make this change, you can click to view any image file in the
ekdavroot folder.

Removing Mapped Network Drives
Ektron CMS400.NET’s DMS feature creates a mapped, ekdavroot network drive
for many functions. For example, if you sign on to Ektron CMS400.NET and
create a new folder, a new mapped, ekdavroot network drive is created.

ViewingManaged Files in aMapped Network Drive
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If you find that ekdavroot folders clutter up your My Network Places folder, you
can delete them. Deleting ekdavroot folders has no impact on your ability to
use Ektron CMS400.NET.

Editing an Office Document
There are two ways to edit an Office document if you are using the Internet
Explorer browser and Office is installed on your computer.

n Edit in Microsoft Office below

n Edit Using a Mapped Network Folder on the facing page

Note: Firefox users should download the Office document to their computer, edit it using Office,
then drag and drop the asset back into CMS400.NET.

Edit in Microsoft Office
Prerequisites

n Your computer has MS Office.

n The Internet Explorer browser. You cannot use Firefox.

To use this option, click the document from the Ektron CMS400.NET folder and
select Edit in Microsoft Office from the dropdown menu.
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The document opens within Office. Make your changes and save it. When you
do, the revised version is saved to Ektron CMS400.NET.

Note: If you want to edit the document’s Summary, Metadata, Schedule, Comment, Task, or
Taxonomy category information, click the asset from the Ektron CMS400.NET folder, then
select Edit Properties from the dropdown menu.

When you begin to edit the document, its status changes to Checked Out (0).
When you make your changes and save, it is Approved.

See Also:

n Working with Content Summary on page 7-137

n Working with Metadata on page 7-141

n Assigning and Reviewing Tasks on page 12-1

n Scheduling Content to Begin and End on page 7-187

n Administering the Web Alert Feature on page 23-1

Edit Using a Mapped Network Folder
You can edit an Office document directly from a mapped network folder. To do
that, follow these steps.

1. Set up a mapped network folder, as described in Setting up a Mapped
Network Drive on page 7-416.

2. Use Windows Explorer to open the folder.

Note: If any Windows folder has more than 1500 files, Windows Explorer may time out while
trying to open it. To remedy this problem, divide your files in that folder into several child
folders.

3. Open a document using Office, make changes, and save it.

You can also delete and move documents using the mapped network folder.

The document is now in checked into Ektron CMS400.NET, and can appear on
your Web site when approved. Also, a history of every saved version is

Edit Using aMapped Network Folder
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retained so you can restore previous ones if necessary. You cannot enter or
change Ektron CMS400.NET document information (Summary, Metadata, etc.)
in the mapped network folder -- someone must use Ektron CMS400.NET to do
that.

Status of Document Saved to Mapped Network
Folder
The status of a document saved to a mapped network folder depends on the
approval chain and the user who signed in when the mapped network folder was
created.

n If you are the last approver, or if there is no approval chain, its
status is Approved.

n If there is an approval chain and you are not the last approver, its
status is Checked In (I).

Also, if the content’s folder requires metadata or a taxonomy category which
has not been entered, its status is Checked In (I).

Deleting an Office Document
Note: You must have delete permissions for the folder that contains the document. See Also:
Folder Permissions on page 4-40.

Note: It is good practice to check for broken quicklinks before deleting documents. See Link
Checking on page 7-129.

To delete an Office document, follow these steps.

1. Navigate to the Workarea’s Content folder.

2. Open the folder that contains the document.

3. Place the cursor over the document

4. Hover the cursor over the triangle ( ) on the right end of the
document and click. A dropdown menu appears.

5. Click Delete.
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Note: If you do not see Delete, either you lack permission to delete the content or its status
makes it ineligible for deleting.

6. The following message appears.

7. Click OK to delete the document.

Like publishing, deleted content must go through the approval chain before it is
removed. If you are the last approver in the approval chain, the content is
deleted immediately. See Also: Approve/Decline Content on page 4-33

Checking Out, Saving, and Replacing an
Office Document
If you check out and save an Office document to your computer, you would
typically edit it using Office. While it is checked out, only you or a system
administrator can check it back in. Other users cannot edit it. You may use this
feature to work on the document on your computer, copy it to another
computer, or even email it to someone who does not have access to Ektron
CMS400.NET.

You can also use the Check Out and Save As option to edit an Office
document if you use the Firefox browser. Firefox does not let you edit Office
documents within Ektron CMS400.NET, as you can with Internet Explorer. To
work around this limitation, check out the Office document, save it to your
computer, and edit it.

When all edits have been entered, drag and drop the document back to Ektron
CMS400.NET.

Follow these steps to copy an Office document to your computer, edit it, then
replace the version in Ektron CMS400.NET.

Warning! There are several ways to import a document into Ektron CMS400.NET. Some
methods retain the original file name while others let the user assign a name.

Warning!When you check out and save a document to your computer, it is saved under the
original file name, which may be different from its Ektron CMS400.NET name. The original file
name is on the screen that appears after you select Check out and Save as (circled below).
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Warning!
Make note of the original file name, because you use it to identify the file after it is saved to your
computer.

1. In Ektron CMS400.NET, open the folder that contains the Office
document.

2. Hover the cursor over the triangle ( ) on the right end of the
document and select Check out and Save As.

3. You are prompted to open or save the document. Click Save.

4. Select a folder to which you want to save the document.

5. The document’s status changes to checked out (O).

6. Edit the document in Office.

Note: If you change your mind and do not change the document, but simply close Office, the
document remains Checked Out (O). Use the Check Inmenu option to check it in.

7. Drag and drop the edited document. See Importing Office Documents
on page 7-405.

8. You are asked to confirm the file replace. Click Yes.

9. The document is submitted for approval.

10. The revised document is saved in Ektron CMS400.NET.

Saving an Office Document
You would typically save an Office document to your computer in order to
distribute it to others, or if you want a personal copy. You should not save a
document to your computer if you plan to edit it then replace the version in
Ektron CMS400.NET -- doing this may overwrite edits made by other users.

If you want to edit a document, use the Edit in MS Office or Check out and
Save As menu option. Both options set the content to checked out status, which
prevents non-administrator users from editing it until you check it back in.

Follow these steps to save an Office document.
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1. In Ektron CMS400.NET, open the folder that contains the Office
document.

2. Hover the cursor over the triangle ( ) on the right end of the
document and click Save As.ddcouemnts

3. You are asked if you want to open or save the document. Choose
Save.

4. Select a folder to which you want to save the document.

Saving an Office Document in .html Format
This feature converts Office documents to HTML format, which means they are
formatted to display within a browser. As a result, anyone visiting your site can
view the document, whether or not Microsoft Office is installed on their
computer.

Warning! Only Microsoft Word and Excel documents can be published as HTML. Ektron
CMS400.NET does not support saving Powerpoint or Visio documents as HTML.

There are two ways to save an Office document in .html format.

Method Advantages For details, see

1. Drag and dropOffice
document into Ektron
CMS400.NET.

2. UseEdit in MS Office
option to save it in html
format.

You don’t need to know the path
to your Web site’s root folder.

Saving anOffice Document as .html
from Ektron CMS400.NET on next
page

1. Open anOffice
document on your
computer.

2. Save it in html format to
the ekdavroot folder in
your Web root.

You don’t need to drag and drop
document to Ektron
CMS400.NET

SavingOffice Document as .html
from Your Computer on page 7-427

Warnings About Saving in .html Format
Regardless of how you save Office documents as HTML, be careful to set up
procedures that prevent HTML content from being overwritten. For example:

1. You save a Word document as .html.

2. Someone edits the .html version.

3. You save the original Office Document as .html again.

In this scenario, the edits made in step 2 are overwritten by step 3.

It is important to establish procedures that avoid such problems.

Saving an Office Document as a Web Page

Saving anOffice Document in .html Format
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When saving a Word document, after you choose Save as from Word’s File
menu, there are two choices for saving as .html.

Note:When saving an Excel document, Save as Web Page (*.htm, *.html) is the only option.

n save as Web Page

n save as Web Page Filtered

Note: For a description of the differences between these options, see
http://office.microsoft.com/en-us/help/HP030852781033.aspx.

Ektron recommends save as Web Page, Filtered because the resulting HTML
is almost identical to the original document. The save as Web Page is not a
good option because its HTML content does not match the original document and
may cause problems when being edited.

Handling Images Embedded within a Word
Document
If you save an Office document that includes images, they appear when anyone
is editing the document as well as when it appears on your Web site. In
addition, the images are saved to the corresponding Ektron CMS400.NET Library
folder. In this way, other Ektron CMS400.NET users can apply the images to
HTML content as needed.

See Also: Storing Files in the Library on page 8-1

Saving an Office Document as .html from Ektron
CMS400.NET
This procedure assumes the Office document has been saved to Ektron
CMS400.NET. Procedures for doing this are explained in Importing Office
Documents on page 7-405.

See Also:Warnings About Saving in .html Format on previous page

1. Within the Ektron CMS400.NET Workarea, open the Content area.

2. Open the folder that contains the Office document you want to save as
.html.

3. Hover the cursor over the triangle ( ) on the right end of the
document you want to save

4. Click Edit in Microsoft Office. The document opens within Office.

5. From Office’s File menu, select Save as Web Page.
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6. In the Save as Type field, selectWeb page, Filtered (*,htm,
*.html). See Also: Saving an Office Document as a Web Page on
page 7-425

7. Click the Save button.

8. You may be warned about formatting features not supported in HTML.
Press Continue.

9. A dialog prompts you to enter your Ektron CMS400.NET user name
and password.

10. Ektron CMS400.NET’s folders appear in a Save as window. The folder
that contains the Word document is the default folder. Select that or
any other Ektron CMS400.NET folder and click Save.

11. The Office document is saved as an .html file into Ektron
CMS400.NET.

12. Close the document and exit from Office.

Saving Office Document as .html from Your
Computer

1. Open the Office Document.

2. Click File > Save as (*,htm, *.html).

3. Click My Network Places and navigate to ekdavroot folder on the
server that hosts Ektron CMS400.NET.

4. Ektron CMS400.NET’s folders appear. The folder that contains the
Word document is the default folder. Select that or any other Ektron
CMS400.NET folder.

5. In the Save as Type field, selectWeb page (*.htm, *.html) or
Web Page, filtered (*.htm, *.html). See Also: Saving an Office
Document as a Web Page on page 7-425.

6. Click the Save button.

7. You may be warned about formatting features not supported in HTML.
Press Continue.

8. A dialog prompts you to enter your Ektron CMS400.NET user name
and password.

9. The Office document is saved as an .html file into Ektron
CMS400.NET.

10. Close the document and exit from Office.

SavingOffice Document as .html fromYour
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The status of the document depends on the approval chain and the user who
signed in when the mapped network folder was created.

n If you are the last approver, or if there is no approval chain, its
status is Approved.

n If there is an approval chain and you are not the last approver, its
status is Checked In (I).

Working with Managed Files
Ektron CMS400.NET can track and manage any non-Office type of file that runs
on your computer (for example, .PDF, .gif and .zip).

You use a host application to create the file. For example, you use Photoshop to
create a .jpg file. Next, save it to Ektron CMS400.NET using any method
explained in Importing Office Documents on page 7-405. While importing, add
supporting information, such as summary, metadata, taxonomy category, and
schedule. Once the file is imported, you use standard toolbar buttons to perform
actions like view history, submit for publishing, and delete.

If you want to edit a managed file, use the Check out and Save As menu
option to place a copy of it on your computer. Then, edit it using the host
application. When done, drag and drop the changed file to Ektron CMS400.NET.

This section also contains the following topics.

Managed File Menu Options 7-428
Creating a New Managed File 7-429
Importing Managed Files 7-429
Editing a Managed File 7-430
Deleting a Managed File 7-431

Managed File Menu Options
Depending on a managed file’s status, your role, and position in the document’s
approval chain, any of the following options may be available for a managed
file. They appear when you display the dropdown menu from the Workarea
Content Menu. See Also:Workarea Content Menu on page 4-9.

Note: The referenced topics (below) describe working with Office documents. Everything
works the same with managed files.

Menu option Description
For more information,
see

View
View and edit managed file and itsEktron CMS400.NET
information (Summary, Metadata, History, etc.). Can also be
used to replace file.
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Menu option Description
For more information,
see

Save As Save copyof managed file to your computer
Saving anOffice
Document on page 7-
424

CheckOut and
Save As

Change amanaged file’s status to checked out and save a
copy to your computer

CheckingOut, Saving,
and Replacing anOffice
Document on page 7-
423

Edit

Overwrite amanaged file in Ektron CMS400.NET with a
version on your computer.

The file name can be different but its typemust match the file
being edited. A file’s type appears after you clickEdit, on the
Edit Content in Folder screen (circled below).

CheckingOut, Saving,
and Replacing anOffice
Document on page 7-
423

Check In

Change a checked-out managed file’s status to checked in.

Useful if you checked out and saved amanaged file then it
became lost or corrupted. This option lets you change its
statusback to checked in.

Submit/Publish Submit managed file into approval chain AssetWorkflow on page
7-432

Delete Deletemanaged file; deleted file cannot be retrieved Deleting aManaged File
on page 7-431

Creating a New Managed File
You cannot create a managed file within Ektron CMS400.NET. Instead, create it
on your computer using the host application then import it into DM.

Importing Managed Files
Warning! You cannot import files whose name includes a percentage sign (%) or ampersand
(&).

You import managed files into Ektron CMS400.NET using the same methods you
use to import MS Office documents. See Importing Office Documents on page
7-405.
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If you do not see a file you uploaded, verify that the View Menu box is
displaying the type of file you are looking for. Files upload to the correct type
regardless of what is selected when you drag and drop them.

Editing a Managed File
You do not edit a managed file within Ektron CMS400.NET. Instead, you check it
out, save it on your computer, edit it using the host application, then check it
back in to Ektron CMS400.NET. While it is checked out, only you or a system
administrator can edit the managed file within Ektron CMS400.NET.

Note: Alternatively, you can edit within a mapped network folder. See Edit Using a Mapped
Network Folder on page 7-421.

Follow these steps to edit a managed file.

1. From the Workarea, select the Content folder.

2. Select the managed file’s folder.

3. Select the managed file you want to edit.

4. Hover the cursor over the triangle ( ) on the right end of the file and
click.

5. Click Check out and Save As from the dropdown menu.

6. Select a folder on your computer in which to save the file.

7. Open the host application.

8. Edit and save the file.

9. Return to Ektron CMS400.NET and open the file’s folder.

10. Click the Add Assets button (circled below).
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11. Use the Add Asset File Upload tab to import the file. See Also: Add
Assets Button: File Upload Tab on page 7-411

Deleting a Managed File
Note: You must have delete permissions for the folder that contains the document. See Also:
Folder Permissions on page 4-40.

Ektron Best Practice
Check for broken quicklinksbefore deleting documents. See LinkChecking on
page 7-129.

1. From the Workarea, select the Content folder.

2. Select the managed file’s folder.

3. Find the managed file you want to delete.

4. Hover the cursor over the triangle ( ) on the right end of the file and
click.

5. Click Delete from the dropdown menu.

6. You are asked to confirm the deletion. Press OK.

7. The asset enters its approval chain.

Like publishing, deleted content must go through the approval chain before it is
removed. If you are the last approver in the approval chain, the content is
deleted immediately. See Also: Approve/Decline Content on page 4-33
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Asset Workflow
An asset proceeds through the same workflow as any other type of content. A
diagram is below.

Approving Assets
Assets are placed into the approval chain, like other types of content. For more
information, see Approve/Decline Content on page 4-33.

Adding Assets to Collections and Menus
You can add an asset to a collection or menu as you would any other type of
content. For more information, see Working with Collections on page 9-102 and
Working with Menus on page 9-133.

Asset Reports
Ektron CMS400.NET provides several reports that track assets by status.

Report Displays assets in this status
For more information,
see

Approvals Requiring your approval ApprovalsReportson
page 7-706
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Report Displays assets in this status
For more information,
see

Checked In Content Checked in Checked In Report on
page 7-708

CheckedOut Content Checked out CheckedOut Report on
page 7-709

New Content New (that is, created and saved but never
published)

New Content Report on
page 7-710

Submitted Content Submitted for publication Submitted Report on page
7-711

Pending Content Approved and pending a start date
Content Pending Start
Date Report on page 7-
712

Refresh Reminder
Report End date hasbeen reached Refresh Reminder Report

on page 7-713

Expired Content Expired date hasbeen reached Expired Content Report
on page 7-714

Content to Expire Will expire within specified number of days Content to Expire Report
on page 7-714

Document Management Configuration
This section explains configuring the Document Management feature. By
changing these settings, you can

n update Document Management server settings

n change which file types are allowed on the Document Management
server

n set the View Type

There are two ways you can configure a Document Management server:

n the Asset Server Setup screen in the Workarea See Also: Updating
Asset Configuration Settings on next page

n the AssetManagement.Config fileSee Also: The
AssetManagement.Config File on next page

In either case, you are editing the AssetManagement.Config file. While the
Workarea screen provides a quick way to update this information without
accessing the Ektron CMS400.NETserver, some tags can only be updated in the
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AssetManagement.Config file. The table in The AssetManagement.Config File
below indicates which tags can be edited in the Workarea.

This section also contains the following topics.

Updating Asset Configuration Settings 7-434
The AssetManagement.Config File 7-434
Allowing File Types 7-435
Adding or Removing a File Type 7-435

Updating Asset Configuration Settings
You can update some AssetManagement.Config tags from the Ektron
CMS400.NET Workarea. To do that, follow these steps.

Note: Only members of the Administrator User Group can view, add, or edit the Asset Server
Setup.

1. In the Workarea, go to Settings > Configuration > Asset Server
Setup.

2. The Asset Management Configuration screen appears.

3. The Value field for that tag changes to a text box.

4. Change the information in the text box.

5. Click the Save button ( ).
.

The AssetManagement.Config File
The following table describes the AssetManagement.Config file’s tags.
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Element Description
Editable
within
Workarea?

DomainName
Can be Domain Name, IP Addressor Machine Name. An example is: localhost.
This is the addressaWeb client system uses to openmanaged documents through
HTTP.

FileTypes

Files types that users are allowed to upload to Document

Management. For more information, seeAllowing File Typesbelow.

The default file types installed are:

*.doc,*.xls,*.ppt,*.pdf,*.gif,*.jpg,*.jpeg,*.log,*.vsd,*.dot,*.zip,*.swf,*.wma,*.wav,*.avi,
*.mp3, *.mp4, *.rm, *.wmv, *.ra, *.mov, *.odb, *.odt, *.odf, *.odp, *.odg, *.ods,
*.png,*.docx,*.xlsx,*.pptx, *.vsdx, *.wmf, *.xml, *.htm, *.html, *.flv

LoadBalanced
EnablesLoad Balancing for assets. Set to “1” to enable. See Also:

Load Balancing Assetson page 22-3

ServerName The name of the server that hostsEktron CMS400.NET.

StorageLocation The folder location where published assets are stored. For example:
“C:\assetslibrary”.

WebShareDir The folder where temporary data files that are waiting to be checked in, saved, or
published are stored. For example: ”dmdata”.

Allowing File Types
Administrators control which file types are allowed by editing the
AssetManagement.config file. Reasons for limiting the file types include:

n Security - For example, you do not want users to load .exe files to
your Ektron CMS400.NET server

n Ease of management - For example, you want your Ektron
CMS400.NETserver to store .doc files only

The <FileTypes> tag in the AssetManagement.config file contain the file types
users can upload.

Adding or Removing a File Type
To add or remove a file type from the list, follow these steps.

1. Edit theWorkarea > Settings > Configuration > Asset Server
Setup > Update Asset Configuration Settings screen.

Or
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Open the AssetManagement.config file. The default location is
(webroot)/(site root).

2. Find the FileTypes=”” element. All file types must appear between
the quotes. For example, FileTypes=”*.doc,*.xls”.

Note: Use a comma to separate file types. Also, format file types as wildcard.extension. For
example, adding an .mp3 file type after *.zip looks like this: *.zip,*.mp3

3. Add or remove any file type.

4. Save and close the AssetManagement.config file.

Checking Document Management
Permissions
If you are having any problems with permissions, use this section to verify that
your user and folder settings are assigned properly.

This section also contains the following topics.

User Permissions 7-436
Advanced Permissions 7-437
Folders Used by Document Management 7-438
The assetLibrary Folder 7-438

User Permissions
When the Document Management functionality is installed, permissions are
granted to several users for the following folders:

n webroot\site root\AssetManagement\dmdata

n webroot\site root\Assets

n root\assetlibrary

The assigned permissions vary depending on your server’s operating system.

The following table lists users and their required permissions. Scan the table to
determine which users and permissions should be enabled for the folders listed
above.

You can use this information to troubleshoot permission problems.

Managing Content in Ektron CMS400.NET

7-436 ReferenceManual
Version 8.01 Rev 4



User
Needs these
permissions

Windows
2000 Pro
or XP Pro

Windows
2003
Server

Windows
2003
Enterprise
Edition

IIS_WPGUser

See
Advanced
Permissions
below

IUSR_

(The IUSR_ account is required only if
Impersonate is set to True in web.config,
and its username and password attributes
are not specified. If impersonate is set to
false (default setting), the IUSR_ account
maybe harmlessly removed from the
folders listed.)

See
Advanced
Permissions
below

IUSR_Group

See
Advanced
Permissions
below

ASP.NET User

See
Advanced
Permissions
below

User Defined (The User Defined user
account is required only if Impersonate is
set to True in web.config, and its
username and password attributesare
specified.)

See
Advanced
Permissions
below

Advanced Permissions
The following are extended permissions for use with the Document
Management functionality.

n Traverse Folder / Execute File

n List Folder / Read Data

n Read Attributes

n Read Extended Attributes

n Create Files / Write Data

n Create Folders / Append Data

n Write Attributes

n Write Extended Attributes

Advanced Permissions

ReferenceManual
Version 8.01 Rev 4

7-437



n Delete Subfolder and Files

n Read Permissions

Folders Used by Document Management

Folder Set by Description

assetLibrary User

Defined byuser during installation. The path to this folder can be
viewed and changed in theWorkarea under Settings >
Configuration > Asset Server Setup > Storage Location.
See Also: The assetLibraryFolder below

dmdata Ektron
CMS400.NET

Defined during Ektron CMS400.NET installation. Located in the
AssetManagement folder. Has settings for both the File System
and IIS.

assets Ektron
CMS400.NET

Defined during Ektron CMS400.NET installation. Located in site
root folder.

The assetLibrary Folder
The Asset Library folder contains file assets uploaded to and managed by DMS.
You can view and update the path to this folder in the Workarea under Settings
> Configuration >Asset Server Setup > Storage Location.

Managing Multimedia Assets
Multimedia files contain audio, video, or both. File types include .wav, .mpeg.,
.swf, .avi, and .wma.

These files' unique characteristics warrant special treatment within Ektron
CMS400.NET.

This section also contains the following topics.

Supported Multimedia Players 7-439
Downloading Media Players 7-439
Multimedia File Types 7-439
Adding Players for a MIME Type 7-440
Adding MIME Types 7-440
Adding a MIME Type’s Default Player 7-440
Working with Multimedia Files in Ektron CMS400.NET 7-441
Importing Multimedia Files into Ektron CMS400.NET 7-441
Changing Supported Media Players 7-441
Changing File Properties 7-442
Inserting a Multimedia File into Content 7-442
Replacing Multimedia Files 7-443
Viewing and Listening to Multimedia Files 7-444
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Modifying Style Properties of the Multimedia Player 7-444

Supported Multimedia Players
Ektron CMS400.NET supports the following media players.

n WindowsMedia®

n Quicktime®

n Realplayer®

n Flash®

This means that Ektron CMS400.NET only supports multimedia files that run on
one of these players. If you import a multimedia file that does not play on a
supported player, it is treated like any other asset but cannot be played within
Ektron CMS400.NET.

Downloading Media Players
If a Ektron CMS400.NET user within the Workarea, or a site visitor, tries to play
a file but no supporting media player exists on the user’s computer, the user is
prompted to download and install the player.

If the file uses the Quicktime or Flashmedia player, the web.config file
contains information that prompts the user to immediately download and install
the player.

If the file uses the Realplayer or WindowsMedia media player, the user must go
to the host Web site and download it.

Multimedia File Types
Every multimedia file type has a corresponding MIME type. For example, an
mp3 file's MIME type is audio/mpeg.

All supported MIME types are defined within the mediasettings element of the
web.config file. That section of the web.config file is reproduced below.

<add key="application/x-shockwave-flash" value="Flash" />

<add key="audio/x-wav" value="WindowsMedia, Quicktime, Realplayer" />

<add key="audio/x-wav-default" value="WindowsMedia" />

<add key="audio/x-pn-realaudio" value="WindowsMedia, Quicktime, Realplayer" />

<add key="video/x-avi" value="WindowsMedia, Quicktime, Realplayer" />

<add key="video/x-avi-default" value="Quicktime" />

<add key="video/x-msvideo" value="WindowsMedia, Quicktime"/>

<add key="video/x-msvideo-default" value="WindowsMedia"/>
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<add key="audio/x-ms-wma" value="WindowsMedia"/>

<add key="audio/mpeg" value="WindowsMedia,Quicktime"/>

<add key="video/x-realvideo" value="Realplayer"/>

<add key="video/x-ms-wmv" value="WindowsMedia"/>

<add key="audio/x-realaudio" value="Realplayer"/>

<add key="video/quicktime" value="Quicktime"/>

Note: A good reference of file and corresponding MIME types is
http://www.w3schools.com/media/media_mimeref.asp.

To determine if a multimedia file type is supported, go to the Web site listed
above to find its MIME type. Then, go to the web.config file section shown above
to see if the MIME type exists and, if so, the supported media players.

Adding Players for a MIME Type
You can add to the list of supported media players for any MIME type. To do so,
open the web.config file, find the MIME type, and insert the player name within
the value element.

Here is an example: <add key="audio/mpeg" value="WindowsMedia"/>

As shown, WindowsMedia is the only supported player for mp3 files. If you know
that other players can run mp3 files, insert additional players after
WindowsMedia. To get the exact name of the player, review the value elements
in web.config file section shown above.

Adding MIME Types
If you want Ektron CMS400.NET to support additional MIME types, add them
within the <mediaSettings> element using the following syntax:

<add key="MIME type/subtype" value="supported media player(s)"/>

For example

<add key="video/x-ms-asf" value="WindowsMedia"/>

You must also add new file types to the supported file list in the
assetmanagement.config file. See Also: Allowing File Types on page 7-435

Adding a MIME Type’s Default Player
To identify a player as the default for a MIME type, use the following syntax
within web.config.

<add key="MIME Type/subtype" value="default player"/>

For example

<add key="video/x-msvideo-default" value="WindowsMedia"/>
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Working with Multimedia Files in Ektron
CMS400.NET

Importing Multimedia Files into Ektron
CMS400.NET
You import multimedia files into Ektron CMS400.NET the same way you import
other assets. See Working with Managed Files on page 7-428 and Importing
Office Documents on page 7-405.

Once imported into Ektron CMS400.NET, a document proceeds through the
same workflow as any other type of content. See Also: Approval Chains on
page 4-27

Changing Supported Media Players
After a multimedia file is imported into Ektron CMS400.NET, you can view
supported media players’ properties on the Edit Content screen's Content tab.
All players defined for the file’s MIME type are checked. You may uncheck any
media players that you do not want to operate a particular file.
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If a default media player is defined for a MIME type in web.config, you cannot
uncheck its checkbox. In the above graphic, WindowsMedia is the default
player.

Changing File Properties
After a multimedia file is imported into Ektron CMS400.NET, you can edit its
properties on the Content tab of the Edit Content screen.

If the file is supported by several players, first check the player whose
properties you want to modify, then edit its properties.

TheWidth and Height fields determine the size (in pixels) of the media player
when it appears in the Workarea and on your Web site. The remaining
properties are determined by the media player (QuickTime in the example
above).

Inserting a Multimedia File into Content
To insert a multimedia file into content, follow these steps.

1. Either create a new HTML content item or edit an existing one. See
Also: Adding HTML Content on page 7-15
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2. Within the content, type text or insert an image that you want site
visitors to click to launch the multimedia file. For example: Click
here to begin playing.

3. Select the image or text you inserted in Step 2.

4. Apply to the selection a quicklink to the multimedia file. This
procedure is described in Quicklinks and Forms on page 8-20.

Replacing Multimedia Files
If you want to replace a multimedia file but maintain all CMS information about
that file (for example, its properties, summary, metadata, etc.), follow these
steps.

1. Browse to the folder that contains the multimedia content item.

2. Double click the item.

3. The bottom of the Edit screen has a gray rectangle with the text
Please drag and drop to replace.

4. Open Windows Explorer and navigate to the folder that contains the
updated multimedia file.
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5. Drag and drop the file into the lower section of the Edit Content
screen.

6. Save, check in, or approve the content.

Note that after you complete the replacement, you can play and restore older
versions of the file through the content’s history. For more information, see
Viewing and Restoring Previous Content on page 7-115.

Viewing and Listening to Multimedia Files
Users in the Workarea and visitors to your Web site play interact with
multimedia files in the same way.

When either type of user visits a page that hosts a multimedia file, Ektron
CMS400.NET tries to match media players on the user’s computer with those
defined in the web.config file for the file’s MIME type. Ektron CMS400.NET then
displays a list of choices for every supported media player for the file. The user
selects the preferred one.

Modifying Style Properties of the Multimedia
Player
You can change the multimedia player’s style properties by modifying the
EKTTabs.css style sheet. This file is installed to site
folder/Workarea/csslib.

For example, you can change the color of the text that selects a player to red by
changing the property highlighted below.

.EktTabActive

{

padding: 2px 2px 2px 2px;

top:10px;

text-decoration:none;

position: relative;

background-color:white;

border: solid thin navy;

color:Red;

font-weight:bolder;

}

Here is the result.
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PDF Generation
PDF (Portable Document Format) is a file type designed for distributing
compact, platform-independent documents. Each document is self-contained,
packing text, graphics, and fonts into a single file.

You can automatically convert Office documents stored in Ektron CMS400.NET
to the PDF format. As a result, when a site visitor accesses a page containing
such a document, he sees the PDF version. Since most computers have a PDF
reader, the visitor needs no additional software to view the file.

This section also contains the following topics.

Why use PDF? 7-445
PDF Conversion Process 7-446
Local PDF Generation 7-447
Modifying the PdfGenerator Information in Asset-
Management.config

7-
447

Enabling or Disabling PDF Generation 7-447
Part One: Enable PDF Generation in the web.config file 7-447
Part two: Enable PDF Generation in the Workarea 7-448
Designating a Folder to Generate PDFs Automatically 7-448

Why use PDF?
n Files easily cross multiple platforms, including Microsoft, Apple,

Linux, and Unix.

n Documents keep their formatting and appear the same on a
computer screen or when printing.

n File size is typically smaller, which means less bandwidth usage.

n Converted Office documents can be viewed by anyone with a PDF
viewer.

n Site visitors do not need a different viewer for each file type.

Note: Ektron CMS400.NET also supports saving MS Office documents in .html format, which is
also formatted for a browser.
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The following sections explain creating PDFs with the Document Management
feature.

n PDF Conversion Process below

n Local PDF Generation on the facing page

n Enabling or Disabling PDF Generation on the facing page

n Designating a Folder to Generate PDFs Automatically on page 7-448

PDF Conversion Process
The PDF conversion of an Office document starts when it is published. At that
point, a copy of the file is sent to an Ektron server for PDF generation. After the
server generates the PDF, it is returned to your Document Management server.

The PDF file doesn’t appear in the Ektron CMS400.NET Workarea -- only the
originally-published Office document appears. Ektron CMS400.NET stores the
PDF file in a secure location. Subsequent editing is done in the original Office
document. Each time it’s published, a new PDF is generated.

Once the Office document is added to a Web page, the Web page shows the PDF
version. This means site visitors only need a PDF viewer to view any Office
document on your site.

The Ektron Windows Service runs the Office-to-PDF conversion process. See
Also: Ektron Windows Service on page 22-7
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Local PDF Generation
If you purchase software from a PDF generation software vendor, you can
create PDF documents on a local network instead of sending them an Ektron
server. Reasons for generating a PDF locally include:

n Speed: Office documents can be converted more quickly

n Security: Office documents never leave the local network

n Quality: You can configure the output quality

The following sections explain setting up local PDF generation.

Modifying the PdfGenerator Information in
AssetManagement.config
When setting up local PDF generation, use the PdfGenerator parameter in the
AssetManagement.Config file to provide the location of the local PDF generator.
To modify the file, follow these steps.

1. Open the AssetManagement.Config file, located in your site root
folder.

2. Change the location of the PDF generator.

For example:
PdfGenerator=”http://aspnet20.ektron.com/PdfManager/PdfGeneratorService.asmx”

might become
PdfGenerator=”http://localhost/PdfManager/PdfGeneratorService.asmx”

3. Save and Close the file.

Enabling or Disabling PDF Generation
Administrators decide if this feature is enabled and to which folders it applies.
After enabling this feature, administrators can change any folder’s properties to
allow PDF generation.

Follow these steps to enable or disable this feature.

Part One: Enable PDF Generation in the
web.config file

1. Open the site root/web.config file.

2. Find the PdfGeneratorEnabled property.

3. Set it to true.
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Part two: Enable PDF Generation in the Workarea
1. In the CMS Workarea, go to Settings > Configuration > Setup.

2. Click the Edit button ( ).
3. Click the Enable Office Documents to be Published in other

Format checkbox.

4. Click the Save button ( ).

Designating a Folder to Generate PDFs
Automatically
By setting a folder’s properties to allow PDF generation, all Office documents
published in that folder have a PDF created for them. For an introduction to PDF
generation, see PDF Generation on page 7-445.

The steps below explain how to update the folder property to enable PDF
generation.

Note: Existing subfolders do not inherit PDF generation. Each subfolder needs to be set
individually. However, a new subfolder inherits the PDF generation setting from its parent
folder. Administrators can change the setting while creating a new subfolder.

1. In the Workarea, click the Content folder button.

2. Click the folder for which you want to enable PDF generation.

3. Click View > Properties.

4. Click the Edit Properties button ( ).
5. Click the Office Documents Publish as PDF check box.

6. Click Save ( ).

Troubleshooting
This section explains how to fix problems that may occur with Ektron
CMS400.NET assets.

Symptom See this section

Error message: Install Indexing Service Setting Up the Indexing Service on the facing
page

A search of asset files findsno assets on your Web site

Turning on the Asset Indexing Service on page
7-461

or

Troubleshooting above
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Symptom See this section

You cannot drag and drop assets into Ektron
CMS400.NET

Removing Front Page Server Extensionson
page 7-466

When a user dragsa document, the file opens in the
browser instead of generating an “Uploading”
notification

Ektron KBArticle: http://dev.ektron.com/kb_
article.aspx?id=14204

The server running Ektron CMS400.NET is running
slowly; much of its resourcesare being used even though
the computer is idle

Disabling the System Indexing Service on page
7-456

Error message after trying to upload documents: Failed
with error -2147217911

Removing aspnet_isapi.dll from the List of
Wildcard ApplicationMapson page 7-458

Error message:WindowsServer 2003 no longer ships
MSDAIPP.DLL, thus connecting to an FPSE server
throughWebfolders, is no longer possible.

UsingMicrosoftWindowsServer 2003 asa
Client (Web FoldersSetup) on page 7-462

While trying to drag and drop an asset, an error message
appears: The target directory already exists.

Check the impersonateelement of the
web.config file. If it is set to true, make sure the
anonymousaccessaccount hasat least write
access to the dmdataand assetsdirectories.

When you try to publish DMSdocuments, Ektron
CMS400.NET sometimesdoesnot allow them to
update.

Make sure your production server is not
runningWindowsXP. You cannot use XPasa
production server for DMS.

After recentlymoving the ASM database to a new SQL
server that hasnever hosted an ASM database, the
following error appearswhile adding a DMSasset:

AssetManagement error: Failed to save asset. Internal
Message: RAISERROR could not locate entry for error
2000000002 in sysmessages. at
Ektron.ASM.Documents.Asset.Create(enAssetStatus
state) at ... ....

ERRMSG: AssetManagement error: Failed to
save asset on page 7-464

Setting Up the Indexing Service
If you see the following error during installation, you need to set up the
indexing service manually.
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The following steps explain how to do that.

Step Screen

1. ClickStart > Control
Panel > Administrative
Tools > Computer
Management.

The Computer Management
screen appears.

2. Click the plus sign (+)
next toServices and
Applications.

3. Click Indexing Service.

4. Click the stop button to
halt the indexing service if
it is running.

Note: If the Index service
is running, the start button
is grayed out.
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Step Screen

5. Right click Indexing
Service, then clickNew >
Catalog.

6. At the Add Catalog
Screen:

n In theName field, add the
catalog name.

n In the Location field,
identify the folder that will store
the asset catalog.

Note: Bydefault, during
installation, Ektron
CMS400.NET names the
catalogAsset and
associates it with the
location
c:\assetcatalog. The
installer can change the
default location.

7. ClickOK.

The Computer Management
screen showsyour new
Indexing Service.
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Step Screen

8. Right click theAsset
catalog, then clickNew >
Directory.

This is the directory the service
indexes.

9. In thePath text box, add
the folder of the secure
storage location. Make
sure the Include in
Index radio button is
markedYes.

Note: Bydefault, during
installation, Ektron
CMS400.NET uses
c:\(Domain Name, IP

Address or Machine

Name)\assetlibrary.

10. ClickOK. Then, click the
plus sign (+) next to
Asset to view the
Directories folder.

In the Directories folder, the
new directory is displayed.
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Step Screen

11. Right click Assets, then
clickProperties.

12. On the Tracking tab,
uncheckall boxesand
chooseNone forWWW
Server.
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Step Screen

13. On theGeneration tab,
uncheck Inherit above
settings from Service.
Then clickOK.

The Index files with
unknown extensions and
Generate abstracts check
boxes can be checked or
empty. It is your choice.

14. Right click Indexing
Service, then clickAll
Tasks > Tune
Performance.
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Step Screen

15. Click theCustomize
radio button.

16. Click theCustomize
button.
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Step Screen

17. Change Indexing to
Instant.

18. ClickOK and OK again to close both dialog boxes.

19. Click theStart button to
start the service again.

Disabling the System Indexing Service

Symptom
The server running Ektron CMS400.NET is running slowly; much of its resources
are being used even when the computer is idle.

Cause
The Microsoft Windows Indexing service is turned on during installation. This
service indexes every file on the server, and the resources required to carry out
that task slow down other activities.
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Note: Ektron recommends turning off all indexing services other than the DMS Asset indexing
service.

Resolution
Follow these steps to disable the Windows indexing service. This change does
not affect DMS’s ability to find files because it uses a different indexing service.

Step Screen

1. ClickStart > Control Panel >
Administrative Tools > Computer
Management.

The Computer Management screen appears.

2. Click the plus sign (+) next toServices and
Applications.

3. Click Indexing Service.

Resolution

ReferenceManual
Version 8.01 Rev 4

7-457



Step Screen

4. Click the Stop button to stop the indexing
service.

Removing aspnet_isapi.dll from the List of
Wildcard Application Maps

Symptom
When you try to upload an asset, you get the error message “Failed to upload
documents.”

Cause
Remove the aspnet_isapi.dll from the list of Wildcard Application Maps.

Resolution
1. Open IIS.

2. Go to your Ektron CMS400.NET Web site.

3. Underneath the Web site, click Asset Management > dmdata.
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4. Right click dmdata and choose Properties.

5. Click the Virtual Directory tab.

6. Click the Configuration button.

7. Look in theWildcard Application Maps area. If aspnet_isapi.dll
appears, remove it.

Resolution
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8. Click OK.

Managing Content in Ektron CMS400.NET

7-460 ReferenceManual
Version 8.01 Rev 4



Turning on the Asset Indexing Service

Step Screen

1. ClickStart > Control Panel >
Administrative Tools > Computer
Management.

The Computer Management screen appears.

2. Click the plus sign (+) next toServices and
Applications.

3. Click Indexing Service.

Turning on the Asset Indexing Service
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Step Screen

4. Click the Start button to start the indexing
service.

Using Microsoft Windows Server 2003 as a
Client (Web Folders Setup)

Symptom
You receive the following error message:

n Windows Server 2003 no longer ships MSDAIPP.DLL, thus connecting
to an FPSE server through Webfolders, is no longer possible.

Resolution
Per MS Licensing, you can obtain webfldrs.msi from any down-level OS, or any
Office product that shipped before Windows2003 (not Office 2003) and install
the WebFolders client. Doing so will keep you compliant with licensing.

Installing WebFolders from Office 2003 is only allowed if you have an Office
2003 license for each Windows2003 server you plan to install WebFolders on.

Web Folders Setup for Microsoft Windows Server
2003
Note: You only need to run the Web Folders Setup if there is a problem during the install. The
Ektron CMS400.NET install performs the setup when needed.

The MSDAIPP.DLL is no longer shipped with Microsoft Windows Server 2003,
making communication with Web folders impossible. To correct this, Ektron
CMS400.NET setup runs the Web folder setup when it detects Microsoft Windows
Server 2003.
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The following steps explains installing Web Folders. You will need to obtain a
copy of the webfldrs.msi file.

Step Setup Screen

1. Double click thewebfldrs.msi file.

2. TheWeb Folders install screen appears.
ClickNext to continue.

3. TheWeb Folders Identity dialog box
appears.

n Add your Name.

n Add yourOrganization.

n ClickNext.

4. TheWeb FoldersProduct ID dialog box
appears.

This dialog boxdisplays the your product ID
number.

ClickNext.

5. TheWeb FoldersSelection Choice dialog
boxappears.

n Complete - installs all components.

n Custom - you choose the components to
install.

n Typical - installs themost frequently used
components.

After making a selection, clickNext.

6. The VerifyReadyAll dialog boxappears.
Click Install Now.

Web Folders Setup for Microsoft WindowsServer
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Step Setup Screen

7. The Action dialog boxappears. The Setup is
installingWeb folders.

8. TheWeAre Done dialog boxappears. ClickOK.

ERRMSG: AssetManagement error: Failed to
save asset

Symptom
After recently moving the ASM database to a new SQL server that has never
hosted an ASM database, the following error appears while adding a DMS asset.

AssetManagement error: Failed to save asset. Internal Message: RAISERROR could not
locate entry for error 2000000002 in sysmessages. at
Ektron.ASM.Documents.Asset.Create(enAssetStatus state) at
Ektron.ASM.Documents.AbstractAssetManagement.Create(AssetMetaData assetMetaData,
enAssetStatus state) at Ektron.ASM.PluginManager.PluginHandler.Create(AssetMetaData
assetMetaData, enAssetStatus state) at
AssetManagement.AssetManagementService.Create(AssetMetaData assetMetaData, enAssetStatus
state) at Mojave.AssetManagementProxy.Create(AssetMetaData assetMetaData, enAssetStatus
state) at Ektron.Cms.DataIO.EkContentRW.AddContentv2_0(Collection ContObj) at
Ektron.Cms.EkException.ThrowException(Exception ex) at
Ektron.Cms.DataIO.EkContentRW.AddContentv2_0(Collection ContObj) at
Ektron.Cms.Content.EkContent.AddNewContentv2_0(Collection ContObj)

Cause
During the creation of the ASM database, a total of 7 messages are written to
the sysmessages table in SQL Server’s master database. Each installation of
SQL Server has its own master database and, in a typical move from one
location to another, changes to the master database are not brought over.

If the ASM database was moved, and these messages are not in the
sysmessages table in the new location's master table, the above error appears
instead of a standard error message.

Resolution
Run this set of SQL scripts against your database. They add appropriate
messages to the sysmessages table in the master database.

/****************************************************************************************-
********/
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sp_addmessage 2000000001, 10, N'Error in %s: Error %d inserting into %s. %s', US_
ENGLISH, FALSE, REPLACE

go

/***************************************************************************************-
*********/

sp_addmessage 2000000002, 10, N'Error in %s: Insert into %s returned %d rows. %s', US_
ENGLISH, FALSE, REPLACE

go

/***************************************************************************************-
*********/

sp_addmessage 2000000003, 10, N'Error in %s: Failed creating record because primary key
already exists. %s', US_ENGLISH, FALSE, REPLACE

go

/***************************************************************************************-
*********/

sp_addmessage 2000000004, 10, N'Error in %s: Error %d updating into %s. %s', US_ENGLISH,
FALSE, REPLACE

go

/***************************************************************************************-
*********/

sp_addmessage 2000000005, 10, N'Error in %s: Update into %s returned %d rows. %s', US_
ENGLISH, FALSE, REPLACE

go

/***************************************************************************************-
*********/

sp_addmessage 2000000007, 10, N'Error in %s: Error %d deleting into %s. %s', US_ENGLISH,
FALSE, REPLACE

go

/***************************************************************************************-
*********/

sp_addmessage 2000000008, 10, N'Error in %s: Delete into %s returned %d rows. %s', US_
ENGLISH, FALSE, REPLACE

go

This snippet utilizes the sp_addmessage stored procedure from the master
database, which adds the appropriate messages to the correct table.

Note: Although it is possible to recode these as an INSERT statement that can run directly
against the sysmessages table, that procedure is not recommended.

Resolution
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Removing Front Page Server Extensions
Follow these steps to remove FrontPage Server Extensions from the Web root.
When you do, the extensions are also removed from all folders below that.

1. Click the Windows Start button.

2. Click Control Panel > Administrative Tools > Computer
Management.

3. Open Services and Applications > Internet Information
Services > Web Sites > Default Web Site.

4. Right click the mouse and select All Tasks > Remove Server
Extensions.

AssetControl Server Control
The AssetControl server control, when viewed on a Web form, displays a drag
and drop icon that lets users upload new assets or update an existing one. When
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this icon is clicked, a drag and drop box appears. This box is similar to the
upload box in the Workarea. See Also: Importing Office Documents on page 7-
405”

The difference between the Workarea and the server control is, in the
Workarea users can only upload assets. With the AssetControl server control,
users can upload a new asset or update an existing one by overwriting it. Even
though the asset is overwritten, the previous version is still available through
Ektron CMS400.NET’s history feature. See Also: Viewing and Restoring Previous
Content on page 7-115

The appearance of the AssetControl server control can vary depending on your
browser. For more information, see Methods for Importing Documents on page
7-405.

AssetControl Server Control Properties
The AssetControl server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMS
Explorer and can use it to browse to Content,
Collections, etc. See Also:Using CMSExplorer
to Browse Your Ektron CMS400.NET Site on
page 24-8

String

DefaultAssetID

The ID of the asset you want to update. This
property is used when the UploadType
property is set toUpdate. See Also:
UploadType on page 7-469

If you don’t know the ID number of the asset,
use the CMSExplorer to browse to it. See Also:
Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long

DefaultFolderID

The ID of the folder where assets are added.
This property is used when the UploadType
property is set toAdd. See Also:UploadType
on page 7-469

If you don’t know the ID number of the folder,
use the CMSExplorer to browse to it. See Also:
Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long
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Property Description Data Type

DoInitFill

By default, Fill occurs during the Page_Init
event. Set to false if you want to postpone the
fill-action until later. In this case, FIll is
automatically called during the Page Render
event.

Youmight do this if you need to set or change a
property on the control in codebehind and have
it render with your changes shown.

Boolean

DynamicParameter

Gets or sets the QueryString parameter to read
a content ID or folder ID dynamically. The
content ID is read when the UploadType
property is set to Update. The folder ID is read
when UploadTypeproperty is set to Add. To
use the default content ID or default folder ID,
leave blank.

See Also:UploadType on the facing page

String

Hide

Used to hide output of AssetControl in design
time and run time.

True =Hide AssetControl

False =DisplayAssetControl

Boolean

IsImage

Setting this control to 1 (one) restricts the
control so only images can be uploaded.

1 (one) - restrict the control to uploading
imagesonly.

0 (zero) - upload all typesof assets.

Integer

Language
Set a language for viewing the collection. This
property shows results in design-time (in Visual
Studio) and at run-time (in a browser).

Integer

OverrideExtension

Allowsyou to restrict the type of asset that can
be uploaded by its extension. For example, to
restrict the control to uploadingWord
documents, enter doc in the property.

Warning! When using this property, enter
only the extension’s letters not the wildcard (*)
or the dot (.).

You can addmultiple extensionsby creating a
comma separated list of extensions. Ektron
recommends limiting the list to five extensions.

String
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Property Description Data Type

SuppressWrapperTags

Suppresses the output of the span/div tags
around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TaxonomyID The ID of the taxonomywith which to associate
the asset. See Also: Taxonomyon page 9-202 Long

UploadType

Select whether the control addsnew assets or
updatesexisting ones.

n SelectAdd to add assets and use the
DefaultFolderIDproperty. See Also:
DefaultFolderID on page 7-467.

If a file of the same name alreadyexists in the
folder, the new file is created using the naming
convention filename(2).

n SelectUpdate to update assets. In this
case, youmust identify an asset at the
DefaultAssetID property. See Also:
DefaultAssetID on page 7-467.

The default isAdd.

UploadTypeEnum

WrapTag

Allowsa developer to specify a server control’s
tag.

The default isSpan.

Span - The <span> tag is used to designate an
inline portion of an HTML document asa span
element.

Div - The <div> tag is used when you want to
apply attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

ImageControl Server Control
The ImageControl server control, when viewed on a Web form, displays an
image stored within the Ektron CMS400.NET document management feature.
When a user is logged in and has permission to edit the image, he can right
click the image and select edit. This creates a drag and drop box that the user
can use to update the file.
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Warning! Images are stored as assets using the Document Management feature. This control
does not use the Ektron CMS400.NET Library.

ImageControl Server Control Properties
The ImageControl server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String

DefaultImageID

The image asset’s content ID you want to display.

If you don’t know the ID number of the asset, use the CMSExplorer to
browse to it. See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

DynamicParameter Gets or sets the QueryString parameter to read an image asset’s ID
dynamically. To have the default image ID used, leave blank. String

FolderID

The ID of the folder where imagesare added.

If you don’t know the ID number of the folder, use the CMSExplorer to
browse to it. See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long
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Property Description
Data
Type

Hide

Used to hide output of AssetControl in design time and run time.

True =Hide AssetControl

False =DisplayAssetControl

Boolean

Language Set a language for viewing the collection. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TaxonomyID The ID of the taxonomy to which assets are added. Long

Title Set the Image’s alt/title text. Bydefault the image file name is used. String

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block
of code.

Custom - Allowsyou to use a custom tag.

String
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Blogs
Blogs (short for Web Logs) are a form of online information sharing. A blog is
often set up to allow a group of people to share their thoughts on a subject. One
person creates a main post, and others comment it. In addition, blogs can be
used to create an online diary of everyday life.

In the Ektron CMS400.NET Workarea, the relationship between blogs and blog
posts resembles that of folders and content. The blog is the equivalent of a
folder, and the posts are like content. While blogs and blog posts have a few
unique properties, they mostly work the same as folders and content.

On your Web site, a blog’s latest post appears at the top. As a result, site
visitors can quickly find the most recent entries.

Blogs are made up of multiple elements which allow site visitors to

view or create a blog post

add comments

see a roll call of associated blogs

In addition, if a blog calendar appear on the page, days with blog posts are
highlighted.
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In the Workarea, blogs look like a content folder but have a distinct icon, as
shown below.

This section also contains the following topics.

The Elements of a Blog 7-474
Blog Workflow 7-475
Adding a Blog 7-475
Blog Properties 7-476
The Blog Roll 7-481
Permissions and Approvals 7-487
Language Support 7-489
Deleting a Blog 7-490
Searching Blogs 7-490
Subscribing/Unsubscribing to a Blog 7-490
Blog Posts 7-493
Blog Comments 7-498
Adding or Editing Blog posts with Windows Live Writer 7-505
Introduction to Blog Server Controls 7-507
Blog Server Control 7-508
BlogEntries Server Control 7-513

Blogs
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BlogPost Server Control 7-516
BlogCalendar Server Control 7-518
BlogRoll Server Control 7-519
BlogCategories Server Control 7-520
BlogRecentPosts Server Control 7-522
BlogRSS Server Control 7-523
BlogArchive Server Control 7-524

The Elements of a Blog
The following table lists elements commonly found in a blog.

Element Description
More
information

Blog Title The name of your blog as you want it to appear on the site. For example, “My
Life Story.”

Blog Post

Themain entry for each topic. A blog post ismade up of several sub elements:

n Headline - the title of the post

n Commentary - the details of the post

n Comment Link - links to a comments page, where site visitors can view or
add comments

n TrackBackURL - a URL visitors can use to notify you when theyare talking
about the blog post on their site

n PingBack - PingsbackanyURLs in the blog post

n Images - add images to a blog post. You add images to a blog post the
samewayyou add them to content. See Also:Adding a LibraryFile to Content
on page 8-16

Blog Posts
on page 7-
493

Blog
Comments

AComments link appears at the end of the blog post. The link includesa
number in parentheses, for example (3).

This number denoteshowmanycomments have beenmade. Click this link to
move to the comments page, where you can read comments on the post and
possibly enter your own.

Blog Com-
mentson
page 7-498

Blog Roll Other blog sites that the blog’s creator wants site visitors to view.
The Blog
Rollon page
7-481

Blog
Subjects

Subjects associated with the blog. If you click a subject, links to all posts
associated with the subject appear.

Blog Prop-
ertieson
page 7-476

Calendar Indicateswhen blog postsweremade. This lets site visitors navigate your blog
by clicking a day that hasblog posts.
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Blog Workflow
The following table explains the workflow of a blog.

Workflow Description See Also

Phase 1
An administrator createsa blog in theWorkarea. He assignsblog
subjects, createsa blog roll, and decideshow comments are
handled.

Adding a Blog below

Phase 2 A developer adds the blog to aWeb form using the blog server
control. He then publishes the form.

Introduction to Blog
Server Controlson
page 7-507

Phase 3

Ektron CMS400.NET users can add blog posts, either from the
Workarea or theWeb site.

Depending on the user’s permissions, the post is either published
immediately or submitted to the blog’s approval chain.

Blog Postson page 7-
493

Phase 4

The blog post is published. Now, site visitors can view it and add
comments.

Depending on the blog’s comment settings, theyeither appear
immediately or must be approved first.

Blog Commentson
page 7-498

Adding a Blog
Note: To be able to create a blog, you must have permission to Add Folders on the blog’s
Advanced Permissions screen. See Also: Permissions and Approvals on page 7-487

To add a blog, follow these steps.

1. Go to the Workarea’s Content folder.

2. Click the folder in which the blog will reside.

3. Click New > Blog.

Alternatively, you can hover the cursor over any content folder, right click the
mouse, and select Add Blog.

4. The Add a Blog screen appears.

BlogWorkflow
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5. Fill out the Properties tab according to the table below.

Field Description

Blog Name The name of your blog as it appears in the content folder tree.

Blog Title The title of your blog as it appears on theWeb site.

Visibility

Choose whether the blog is private or public.

Public Any site visitor can view the blog.

Private
A site visitor must log in to view the blog. This
includesmembership and Ektron CMS400.NET
users.

Comments Choose how to handle comments by checking the appropriate boxes. For more
information, seeControlling Blog Commentson page 7-499.

6. On the Subjects tab, add subjects to the blog. For more information
on blog Subjects, see Blog Properties below.

7. On the Blog Roll tab, add blog sites that you want blog readers to
visit. For more information on blog rolls, see The Blog Roll on page 7-
481.

Note: See Editing a Blog’s Properties vs. Adding a Blog on the facing page for additional
properties that are only available when editing a blog’s properties.

Blog Properties
Note: To be able to edit blog properties, you must have permission to Edit Folders on the
blog’s Advanced Permissions screen.
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By clicking the blog edit properties button, you can change the following groups
of information about a blog.

This section also contains the following topics.

Editing a Blog’s Properties vs. Adding a Blog 7-477
Blog Properties and Settings Availability 7-478
Blog Folder Properties 7-479
Metadata 7-480
Web Alerts 7-480
Smart Forms 7-481

Editing a Blog’s Properties vs. Adding a Blog
When you edit a blog’s properties and settings, more properties and settings
are available than when you created it. This is done to save time when adding
multiple blogs to a site.

The table below shows which properties or settings are available when adding
and editing a blog.

Editing a Blog’s Properties vs. Adding a Blog
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Blog Properties and Settings Availability

Property or Setting
Available When Adding
a Blog

Available When
Editing a Blog

Visibility

Blog Name

Blog Title

Tagline

# of Visible Posts

Comment Control

Update Services

Style sheet filename for this folder

Template filename for this folder

Smart Forms

Metadata

Subjects

Web Alerts

Blog Roll

Permissions

ApprovalChain
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Blog Folder Properties
The following table shows the fields on the Blog’s Properties tab. To edit these
properties

- from the Workarea: navigate to the blog folder, click View >
Properties, then the Edit Properties button ( )

- from the Web site: log in, navigate to the blog, open the menu for the
blog, and select Properties

When you are finished, click Save ( ).

To learn about the other tabs on the Properties screen, see

n Metadata on next page

n Blog Properties on page 7-476

n Web Alerts on next page

n Smart Forms on page 7-481

n The Blog Roll on page 7-481

n Creating SiteMap Breadcrumbs on page 9-276

Field Description

Visibility

Choose whether the site is a private blog or public.

Public Anyone who visits the site is able to view the
blog.

Private

A site visitor must log into the site to be able
to
view the blog. This could include
membership users, CMS400 users or both.

Blog Name The name of your blog as it appears in the content folder tree.

Blog Title The title of your blog as it appears on theWeb site blog. It only appears if the
ShowHeaderblog server control property is set to true.

Blog Folder Properties

ReferenceManual
Version 8.01 Rev 4

7-479



Field Description

ID

The ID number of the blog. This number is assigned byEktron CMS400.NET and cannot be
changed.

Note: ID only appearswhen viewing the Properties screen. It doesnot appear while
editing.

Tagline

A line of additional information that describes the blog. It appears below the title if the
ShowHeaderblog server control property is set to true.

For example, the title of a blog is “John’sBlog Page.” The tag line could be “A place to learn
about John's past, present, future, and his current state of mind!”

# Posts
Visible

The number of posts visible on the blog page. If the number of posts exceeds this number,
only thismanyof themost recent posts appear.

For example, if this property is set to 10 and you add 11 posts, only the tenmost recent posts
appear.

This number can be from 1 to 999.

If you leave this field blank, all postsmade during the current dayare visible.

Comments Choose how to handle comments by checking the appropriate boxes. For more information,
seeControlling Blog Commentson page 7-499.

Update
Service

Enter a service that notifies a blog search site when blog posts are added to your blog site.
These blog search sites allowWeb users to search content contained in blogsaround the
world.

To use this feature, check theNotify blog search engines of new posts boxand enter a
path to a search site. An example path is: http://rpc.technorati.com/rpc/ping.

Style sheet
filename for
this folder.

If you want to provide a custom style sheet for the blog, enter the path to it relative to the site
root. For example, WorkArea/csslib/my_custom_blogs.css.

Leave this field blank to inherit the default style sheet, blogs.css, located in
Workarea/csslib.You can customize the default style sheet but your modificationswill get
overwritten when you upgrade Ektron CMS400.NET.

Page
Templates

Lets you specify one or more templates for content in this folder. For more information, see
Creating/Updating Templateson page 7-178.

Metadata
There is no difference when working with Metadata for blogs or folders. For
more information, see Working with Metadata on page 7-141.

Web Alerts
Web Alerts notify users when a blog post is published. This feature is explained
in Assigning Web Alert Information to Content on page 23-23.
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Smart Forms
Use a Smart Form when you want to create structured blogging. Structured
blogging provides a form for the blogger to fill out instead of free form writing.
For example, you create a blog for book reviews. You want to make sure that,
when someone submits a review, he provides the following information:

n Book title

n Author

n Date of review

n Review text

For information on working with Smart Forms, see Working with Smart Forms
on page 7-278.

Note: Unlike the Smart Forms you can assign to regular folders, you cannot require the user to
select a Smart Form when creating a new post. It is only an option.

The Blog Roll
A blog roll lets you add a list of Web site links to your blog page. Think of this as
a roll call of blog pages, a list of related blogs, or blogs that you want your
visitors to view. Below is an example of a blog roll.

This section also contains the following topics.

Adding a Blog Roll Link 7-482
Editing a Blog Roll 7-484
Removing a Blog Roll Link 7-485
Removing the Last Blog Roll Link 7-485
Removing a Blog Roll Link 7-486

Smart Forms
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Adding a Blog Roll Link
Follow these steps to add a blog roll link.

Note: To add a blog roll link from the Web site, you must be logged in.

1. In the Workarea, navigate to the blog folder.

or

From the Web site

- open the menu for the blog.

- click Properties.

2. Click View > Properties.

3. Click the Edit Properties button ( ).
4. On the Blog Roll tab, click Add New Roll Link.

5. The Add Blog Roll Link form appears.

6. Fill out the form according to the table below.
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Field Description

LinkName Describes the link in the blog roll.

URL The URL of the blog you are adding to the blog roll. It must begin with http://.

Short Description Add a short description of the site.

Relationship
Enter the relationship of the blog roll link to you or to the site. For example, brother.

ClickEdit for a pop up screen that helps you choose the site's relationship.

The table below explains each relationship type.

Type of
Relationship

Description

URL Check this box if the address is owned by the same person or company.

Friendship

What level of friendship do you have with the person who owns the site? Choose
one.

n Contact

n Acquaintance

n Friend

n None

Physical Check this box if you have physicallymet the person who owns this blog.

Professional

Does the person who owns this site have a work level relationship with you.?
Select all that apply.

n Co-worker

n Colleague

Geographical

Select one.

n co-resident

n neighbor

n none

Adding a Blog Roll Link
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Type of
Relationship

Description

Family

If the site owner is family, what is the relationship? Select one.

n Child

n Parent

n Sibling

n Spouse

n Kin

n None

Romantic

What are your feelings toward the owner of the site? Checkall that apply.

n Muse

n Crush

n Date

n Sweetheart

7. Click Close.

Note: Add as many links to the blog boll as you would like. Just click Add a New Roll Link. To
remove a blog roll link, see Removing a Blog Roll Link on the facing page.

8. Click Save ( ).

Editing a Blog Roll
To edit a blog roll link, follow these steps.

Note: To edit a blog roll link from the Web site, you must be logged in.

1. In the Workarea, navigate to the blog folder.

or

From the Web site

- open the menu for the blog.

- click Properties.

2. Click View > Properties.

3. Click the Edit Properties button ( ).
4. Click the Blog Roll tab.

5. Find the Blog Roll Link for which the information needs to be edited.

6. Edit the information.

7. Click Save ( ).

Note: As with adding a blog roll link, you can edit multiple blog roll links before clicking Save.
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Removing a Blog Roll Link
There are two ways to remove blog roll links.

n Remove the last link that was added.

n Remove any link in the list individually.

The steps to each task are documented below.

Removing the Last Blog Roll Link
Using this method to remove the last blog link on the page.

1. In the Workarea,

- navigate to the blog folder.

or

From the Web site

- access the blog’s menu from the site.

- click Properties.

Note: To remove a blog roll link from the Web site, you must be logged in.

2. Click View > Properties.

3. Click the Edit Properties button ( ).
4. Click the Blog Roll tab.

5. Click Remove Last Roll Link.

6. A dialog box asks you to confirm.

Removing a Blog Roll Link
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7. Click OK to remove the last blog roll link.

Note: You can continue to remove subjects at the end of the list by clicking the Remove Last
Roll link.

8. Click Save ( ).

Removing a Blog Roll Link
To remove any blog roll link on the list, follow these steps.

1. In the Workarea,

- navigate to the blog folder.

or

From the Web site

- access the blog’s menu from the site.

- click Properties.

Note: To remove a blog roll link from the Web site, you must be logged in.

2. Click View > Properties.

3. Click the Edit Properties button ( ).
4. Click the Blog Roll tab.

5. Find the blog roll link to be removed.

6. Click Remove Roll Link above the Link Name to be removed.

7. A dialog box asks you to confirm.

8. Click OK to remove the blog roll link.

Note: You can continue to remove links by clicking the Remove link.

9. Click Save ( ).
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Permissions and Approvals
Permissions for blogs work like folder permissions. The same functionality and
features are available. For more information, see Approval Chains on page 4-
27 and Folder Permissions on page 4-40.

This section also contains the following topics.

User Blog Permission/ Approval Table 7-488
Membership User Blog Permission Table 7-489
Purge History 7-489
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User Blog Permission/ Approval Table

Function
Permissions that affect this function when
performed fromWeb Site

Permissions that affect this
function when performed
fromWorkarea

Blog

View Published blogsare viewable byany site visitor Blog properties standard
permissionView-Only

Add Not available Blog properties advanced
permissionAdd Folders

Edit Not available Blog properties advanced
permissionEdit Folders

Delete Not available Blog properties advanced
permissionDelete Folders

Post

View Published posts are viewable byany site visitor Blog properties standard
permissionView-Only

Add Not available Blog properties standard
permissionAdd

Edit Not available Blog properties standard
permissionEdit

Delete Not available Blog properties standard
permissionDelete

Approve Not available User must bemember of blog’s
approval chain

Comment

Add
Three blog folder properties control how comments can
be submitted fromWeb site. SeeControlling Blog
Commentson page 7-499.

Blog properties standard
permissionAdd

Edit Not available Blog properties standard
permissionRead Only
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Function
Permissions that affect this function when
performed fromWeb Site

Permissions that affect this
function when performed
fromWorkarea

Delete Not available Blog properties standard
permissionRead Only

Approve Not available Blog properties standard
permissionEdit

Membership User Blog Permission Table
Membership users can be given permission to edit and add blog posts in the
blog. Depending on the level of permissions, they can perform any of these
functions.

Permission Lets membership user

ReadOnly
Read blog posts.

This boxmust be checked before you can add Edit and Add permissions.

Edit Edit blog posts.

Add Add blog posts.

LibraryReadOnly Add items to the library.

Add Images Upload images to the corresponding library folder.

Add Files Upload files to the corresponding library folder.

Purge History
Purge History works the same way for blogs as it does for the rest of the Ektron
CMS400.NET. See Also: Purge History on page 4-26

Language Support
Language Support for blogs and blog posts work the same way as it does for
folders and content. See Working with Multi-Language Content on page 14-1.

Membership User Blog Permission Table
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Deleting a Blog
Note: To delete a blog, you must have permission to Delete Folders on the blog’s Advanced
Permissions screen.

Deleting a blog removes the blog and all posts, comments, and quicklinks for
the blog.

Warning! After a blog is deleted, you cannot retrieve its posts, comments, or quicklinks.

The following steps explain how to delete a blog.

1. In theWorkarea, navigate to Content then the blog folder.

Or

From the Web site, open the menu for the blog and click Properties.

Note: To delete a blog from the Web site, you must be logged in.

2. Click the Delete > This Blog.

Alternatively, you can right-click the mouse then choose Delete Blog.

3. A dialog box asks you to confirm.

4. Click OK.

Searching Blogs
Searching blogs works the same as searching HTML content. See the following
topics for an explanation of using the Search feature.

n Web Site Search on page 9-6

n Searching the Library on page 8-6

Subscribing/Unsubscribing to a Blog
Logged-in site users and Membership users can subscribe to a blog or a blog
post.

By subscribing to a blog, users are notified whenever posts are added to it. By
subscribing to a blog post, users are notified whenever comments are added to
a post. If you want to stop receiving notices, you can unsubscribe.

This section also contains the following topics.

Subscribe to a Blog 7-491
Unsubscribe to a Blog 7-491
Subscribe to a Blog Post 7-492
Unsubscribe to a Blog Post 7-492
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Subscribe to a Blog
To subscribe to a blog, follow these steps.

1. Navigate to the blog on the site.

2. Click the blog's Subscribe icon ( ), circled below.

3. The Subscribe/Unsubscribe screen appears.

4. Select the Notification Type.

5. Click Add Subscription.

Unsubscribe to a Blog
To unsubscribe to a blog, follow these steps.

1. Navigate to the blog on the site.

2. Click the Subscribe icon ( ).

3. The Subscribe/Unsubscribe screen appears.

4. Select a Notification Type.

5. Check the Unsubscribe check box.

Subscribe to a Blog
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6. Click Update Subscription.

Subscribe to a Blog Post
To subscribe to a blog post, follow these steps.

1. Navigate to the blog post on the site.

2. Click the Subscribe icon ( ) for the blog post.
3. The Subscribe/Unsubscribe screen appears.

4. Select the Notification Type.

5. Click Add Subscription.

Unsubscribe to a Blog Post
To unsubscribe to a blog, follow these steps.

1. Navigate to the blog post on the site.

2. Click the Subscribe icon ( ) for the blog.
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3. The Subscribe/Unsubscribe screen appears.

4. Select the Notification Type.

5. Check the Unsubscribe check box.

6. Click Update Subscription.

Blog Posts
For a definition of blog posts, see The Elements of a Blog on page 7-474.

From your Web site, only published blog posts are visible. But, from the
Workarea, you can see all blog posts, regardless of status. Using the Workarea,
you can also create, edit, delete, and archive blog posts in the same way that
you work with content.

This section also contains the following topics.

Blog Posts on the Site 7-493
Blog Posts in the Workarea 7-495
Adding a Blog Post 7-496
Tags on the Summary Page 7-497
Editing a Blog Post 7-497
Approving a Blog Post 7-497
Deleting a Blog Post 7-498

Blog Posts on the Site
You can view published blog posts on the Web site. A blog post has a Title,
Content, Comments Link, Post Time, Date, and Editor Information. Below is a
breakdown of a blog post on a site.

Blog Posts
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Item Description

Title The headline of the post. Usuallywhat a site visitor scans through to find a post to read.

Permanent
Link

If you click this link, a new screen appears. The new screen indicates the permanent link to this
blog post. As long as the blog post is active within Ektron CMS400.NET, you can access it via
the URL in the browser’s addressbar.

Most blog pages show only recent posts. After a post ismoved off the blog’s front page, it is still
accessible via this link.

Content The bodyof the post.

Comments
Information

The comments link shows the number in parenthesesof comments for a post .When this link is
clicked, a new page of comments for the post appears.

Also on the page is a form to add comments about the post. The comments only appear if a site
visitor has logged in or authentication is not required for blog comments.

Editor
Information The person who created or last edited the blog post.

Post Time
and Date The date and time a blog post was created or last edited.
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Blog Posts in the Workarea
Viewing a blog post in the Workarea is similar to viewing content in the
Workarea. Navigate to the folder that contains the blog. Next, in the View Posts
in Blog screen, click the title of the blog post. Below is an example of a blog
post in the Workarea.

The View Posts in Blog screen shows the following information about each blog
post.

See Also: Blog Posts on page 7-493; Permissions and Approvals on page 7-487

Item Description

Title The headline of the post. Usuallywhat a site visitor scans through to find a post to read.

Comments
Information

The comments link shows the number in parenthesesof comments for a post .When this link
is clicked, the View Comments for Post screen appears.

If a red flag ( ) appears next to the comments icon, theyare awaiting approval.

Editor
Information The person who created or last edited the blog post.

Post Time
and Date The date and time the blog post was created or last edited.

Status
The statusof the blog post. For example, if the blog post is checked in, the status is I.

See Also:Content Statuseson page 7-130

From this screen, you can perform all functions with a blog post that you can
with content. You can give it a summary, add metadata, associate a task,

Blog Posts in theWorkarea

ReferenceManual
Version 8.01 Rev 4

7-495



assign Web Alerts, etc. You must have Edit permission for the blog to perform
these functions.

Note: You can also add a history comment to a blog post by clicking the Comment tab. This is
not the same as adding a comment to a blog post on a site. A history comment has the same
properties as a comment associated with content.

Adding a Blog Post
Note: To be able to add a blog post, you must have Add permission on the blog’s Standard
Permissions screen.

Follow these steps to add a blog post.

1. In the Workarea, navigate to the blog folder. Click New > HTML
Post.

Or

From the Web site, open the menu for the blog then choose New Post.

Note: To add a blog post from the Web site, you must be logged in.

2. When the Add Content screen appears, use the editor to create the
blog post. You create a blog post the same way you create content.
See Also: Adding HTML Content on page 7-15.

Warning! If you are using subjects or tags, they can be assigned to a blog post by clicking the
Summary tab and choosing a subject. For more information, see Blog Properties on page 7-
476and Tags on the Summary Page on the facing page.

3. If the user creating the post is a member of the blog’s approval chain,
it is published immediately. If not, it is surrounded by a yellow
border, and a member of the approval chain must approve it before it
appears on the Web site. (For more information, see Approval Chains
on page 4-27.)
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4. Once the post is published, it appears within the blog on the Web site.

Tags on the Summary Page
You can add tags to a blog post to further define information about the post for
blog search engines. For example, you create a blog post about your favorite
band, Ektronica, and enter the following tags: Music, Guitars, Rock & Roll.

When a person visits a blog search site and searches for Rock & Roll music,
your blog post appears. Some blog search sites have a page specifically for
searching blog tags.

See Also: Blog Posts on page 7-493

Editing a Blog Post
Note: To be able to edit a blog post, you must have Edit permission on the blog’s Standard
Permissions screen.

Follow these steps to edit a blog post.

Note: If another editor changes a blog post, the posting information reflects the new editor, the
date, and the time the information was changed. This is important to remember if you want the
original person who posted the blog to get credit for the post.

1. In the Workarea, navigate to the blog folder.

Or

From the Web site, open menu for the blog then choose Properties.
Next, choose the post.

Note: To add a blog post from the Web site, you must be logged in.

2. Click the blog post title you want to edit.

3. Click the Edit button ( ).
4. Change the blog post.

5. When the blog is published, the changes appear in the blog post on
the Web site.

See Also: Blog Posts on page 7-493

Approving a Blog Post
If someone who is not a member of the blog’s approval chain creates or edits a
blog post, its status is set to Submitted. It only appears on the Web site after a
member of the approval chain approves it. While its status is Submitted, it has
yellow border on the View Posts in blog screen.

To approve a blog post, see Approve/Decline Content on page 4-33.

Tags on the Summary Page
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Deleting a Blog Post
Note: To be able to delete a blog post, you must have Delete permission on the blog’s
Standard Permissions screen.

The following steps explain how to delete a blog post.

1. In the Workarea, navigate to the blog folder.

Or

From the Web site, log in, open the menu for the blog, then choose
Properties. Next, choose the post.

Note: To delete a blog post from the Web site, you must be logged in.

2. From the menu, click the Delete > Posts.

3. The Delete Contents screen appears.

4. Click the check box next to each post you want to delete. To select all
posts, click the check box next to Title.

5. Click the Delete Contents button ( ).

6. A dialog box asks you to confirm.

7. Click OK to delete the selected posts.

Blog Comments
Important: Do not confuse blog comments with history comments. You can add a history
comment to the blog post by clicking the Comment tab. This is not the same as adding a
comment to a blog post on a site. When you add a history comment, it has the same properties as
a comment associated with content.

Blog comments allow site visitors to interact with a blog by adding their
thoughts about a blog post. The blog administrator controls commenting by
deciding who can add comments and if they require approval for publication.

This section also contains the following topics.

Controlling Blog Comments 7-499
Comments on the Site 7-501
The Comment Form 7-501
Comments in the Workarea 7-502
Adding a Comment 7-503
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Editing a Comment 7-503
Deleting a Comment 7-504
Approving a Comment 7-504

Controlling Blog Comments
Ektron CMS400.NET provides three properties for controlling comments. Use
the Blog Properties screen to set them. See Also: Blog Properties on page 7-
476. The following table describes these properties.

Field Description

Enable
Comments

Allowsuser inWorkarea and site visitor to add blog
comments. Also displays comments on site and inWorkarea.

Note: Amember of the Administrators group can alwaysadd comments, regardlessof
how this checkbox is set.

Controlling Blog Comments
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Field Description

Moderate
Comments

Determines if commentsmust be approved before theyappear on site.

If this field is checked, onlyEktron CMS400.NETuserswith permission to edit the post can
approve comments (see illustration of this permission below).

Note: Membership users cannot approve blog comments.

If userswithout this permission add comments, theyonly appear on theWeb site after being
approved by someonewith permission to edit the post.

If someone hasedit post permission and authenticatesbefore submitting a comment, it is
approved automatically.

Appearance of Unapproved Comments

On theWorkarea’sView Posts in Blog screen, an unapproved comment is indicated bya red
flag .

On the View Comments for Post screen, an unapproved comment is indicated bya yellow
border.

Require
Authentication

Determines if a user must be authenticated (that is, logged in asan Ektron CMS400.NET
user or membership user) to add comments via theWeb site.

Comments by default are fully controlled. This means they are enabled, must
be approved, and a site visitor must be authenticated to create them.

If comments are enabled but not moderated, any site visitor can add a
comment. If you don’t want censorship, this is the way to go.

Warning!While you can delete a comment at any time, if comments are not moderated, they
appear on your site as soon as a site visitor submits them.

However, to make sure comments on your site meet certain criteria, moderate
them.
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Comments on the Site
On the site, blog post comments appear when one of the following blog post
items is clicked:

n the Comments link

n the Title of the blog post

The comment page contains the original post, any comments that have been
added, and a form to post new comments. Depending on how the page is
designed, the calendar and blog roll can also appear.

The Comment Form
Note: See Controlling Blog Comments on page 7-499 to learn about how an administrator
determines if and by whom comments can be submitted.

Site visitors, regular users, and Membership users can add comments by filling
out a form on the comments page. The form has five fields.

Comments on the Site
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Field Description

Name

The person submitting the comment. This information is required.

Note: This text boxappears only if a site visitor, who is not an Ektron CMS400.NETor
membership user, addsa comment. If an Ektron CMS400.NETor membership user addsa
comment, the name and email addressare retrieved from the user profile.

Email

The email addressof the person submitting the comment. This information is required.

Note: This text boxappears only if a site visitor, who is not an Ektron CMS400.NETor
membership user, addsa comment. If an Ektron CMS400.NETor membership user addsa
comment, the name and email addressare retrieved from the user profile.

Homepage AURL for the person’sweb site.

Comment
Section A text area to insert comments about the post.

Post
Comment
button

Post a comment by clicking this button.

Depending on the comment’s settings, it either posts immediately or is submitted for approval.
See Also:Controlling Blog Commentson page 7-499

Comments in the Workarea
In the Workarea, you can add, view, approve, edit, and delete comments for a
blog post. See Also: Blog Comments on page 7-498

The comment link (illustrated below) indicates the number of comments. To
work with comments, navigate to the blog folder and click the comment link
next to a blog post.

This leads you to View Comments screen. Here, you can view approve, edit,
delete, and add new comments.

Note: To learn about recognizing unapproved comments and approving them, see Controlling
Blog Comments on page 7-499.

See Also:

n Adding a Comment on the facing page

n Editing a Comment on the facing page

n Deleting a Comment on page 7-504

n Approving a Comment on page 7-504
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Adding a Comment
Note: To be able to add a comment, you must have Add permission on the blog’s Standard
Permissions screen.

To add a blog post comment from the Workarea, follow these steps.

1. From the Content area, navigate to the blog.

2. Click the Comments icon to the left of the post that you want to
comment on.

3. Click New > Comment.

4. The Add Comment screen appears.

For a description of the fields on this screen, see The Comment Form on page
7-501.

Note that Add Comment screen provides an additional field, State. This field
lets the submitting user set the comment’s state to approved or pending.
Approved comments appear on the site immediately. Pending comments must
be approved before they appear.

To learn about the approval process for pending comments, see Moderate
Comments on page 7-500. See Also: Blog Comments on page 7-498;
Permissions and Approvals on page 7-487

Editing a Comment
1. From the Content area, navigate to the blog.

2. Click the Comments icon to the left of the post whose comment you
want to edit.

3. Locate the comment you want to edit.

4. Click edit.

5. The Edit Comment screen appears.

For a description of the fields on this screen, see The Comment Form on page
7-501.

Adding a Comment
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Note that Edit Comment screen provides an additional field, State. This field
lets the submitting user set the comment’s state to approved or pending.
Approved comments appear on the site immediately. Pending comments must
be approved before they appear.

To learn about the approval process for pending comments, see Moderate
Comments on page 7-500.

See Also: Blog Comments on page 7-498; Permissions and Approvals on page
7-487

Deleting a Comment
Once a comment is deleted, you cannot retrieve it.

1. From the Content area, navigate to the blog.

2. Click the Comments icon to the left of the post whose comment you
want to delete.

3. Click delete.

4. A dialog box asks you to confirm.

5. Click OK to delete the comment.

Approving a Comment
Comments can require approval if

n they are submitted from the Web site andModerate Comments is
checked in the blog’s folder properties

n a user submits the comment from the Workarea set its state to
Pending

Only users with permission to edit content (posts) within the blog folder can
approve comments. To learn about the approval process for pending comments,
see Moderate Comments on page 7-500.

To approve a comment, follow these steps.

1. From the Content area, navigate to the blog.

2. Click the Comments icon to the left of the post whose comment you
want to approve. (Unapproved comments are indicated by a red flag (
)).

3. Click approve.

4. The comment’s status changes to approved.

See Also: Blog Comments on page 7-498;

Managing Content in Ektron CMS400.NET

7-504 ReferenceManual
Version 8.01 Rev 4



Adding or Editing Blog posts with
Windows Live Writer
Ektron CMS400.NET authors and membership users can use Windows LiveTM
Writer to add and edit blog posts to your site. If users have the proper
permissions, they upload images and attach files from their system. See Also:
Permissions and Approvals on page 7-487.

For additional Windows Live Writer help from Microsoft, click here.

Follow these steps to set up Windows Live Writer to work with your Ektron
CMS400.NET Blog. If you have previously set up Windows Live Writer, click
Weblog > Edit Weblog Settings. Then, skip to step four.

Step Windows Live Writer Setup Screen

1. Download and StartWindowsLiveWriter.

When theWelcomewindow appears, click theNext button.
Do not create aWindowsLive Spacesaccount.

2. In the Choose Blog Type window, select theAnother
weblog service radio button.

ClickNext.

Adding or Editing Blog posts withWindows Live
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Step Windows Live Writer Setup Screen

3. In theWeblog Homepage and Login window, enter the
following information:

n Weblog Homepage URL - this is the page that
contains the blog. For example, http://<your
site>/CMS400Min/blogs.aspx.

n Username - your username to log on to the Ektron
CMS400.NET site.

n Password - your password to log on to the Ektron
CMS400.NET site.

Edit Proxy Settings... - edit the proxy settingsasneeded.

ClickNext.

4. In the Select Provider widow, chooseCustom
(Metaweblog API) from the Type of weblog that
you are using dropdown box.

5. In theRemote posting URL for your weblog
textbox, add a link to the xmlrpc.aspx file for the site.
The default location for the file in the demo site is
http://<your
site>/CMS400Min/Workarea/Blogs/xmlrpc.aspx
.

ClickNext.
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Step Windows Live Writer Setup Screen

6. When theWeblog Configuration Complete window
appears, Add a blog name in theWeblog Name field.

ClickFinish.

Introduction to Blog Server Controls
Note: In addition to reading this section on the Blog server controls, you should also read
Blogs on page 7-472.

Ektron provides nine server controls that relate to displaying a Blog on a Web
site. One of these, the Blog server control, allows you to display all pieces that
typically make up a blog site on a Web form. These items are blog entries, blog
posts, blog categories, a blog’s recent posts, a blog’s RSS feed, an archive, a
blog calendar, and a blog roll.

The other Blog server controls allow you to display each item individually. The
individual Blog server controls offer additional ways to customize the page
layout and appearance of the items.

The nine Blog server controls provided by Ektron are

n Blog Server Control on next page

n BlogEntries Server Control on page 7-513

n BlogPost Server Control on page 7-516

n BlogCalendar Server Control on page 7-518

n BlogRoll Server Control on page 7-519

n BlogCategories Server Control on page 7-520

n BlogRecentPosts Server Control on page 7-522

n BlogRSS Server Control on page 7-523

n BlogArchive Server Control on page 7-524

Introduction to Blog Server Controls
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Using Blog Server Control vs. Individual Blog
Controls
When you use the Blog server control to display a blog, you only have to deal
with one server control and its settings. This makes the work of adding a blog to
your site quick and easy.

However, the individual Blog server controls are more flexible as they let you
control which parts of a Blog you want to display. For example, you might to
display Blog entries and a Blog roll but not a Blog calendar. The individual Blog
server controls also let you further define the display details.

Blog Server Control
The Blog server control allows you to quickly add a blog to a Web form. It has
all of the items commonly found on a blog page in one server control. These
items include: blog posts, a comments link, a blog roll, blog categories, recent
blog posts, the RSS feed for a blog, an archive and a blog calendar. To learn
more about each item, see Blogs on page 7-472.

The Blog server control allows you to easily maintain the overall look of the
blog. Any change to display properties, such as the background color or font,
affects the entire blog.

While you can change display properties, you cannot change the location of
each item in the server control. The title always appears on top, with the tagline
below it. The blog posts always appear to the left and the calendar, blog roll,
blog categories, recent blog posts, RSS feed, archive and blog roll to the right.

Note: You can use the individual blog servre controls to change the page layout. See Also:
Introduction to Blog Server Controls on previous page
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To customize a blog's styling, edit the Blog.css file located in
webroot\siteroot\Workarea\csslib.

Blog Server Control Properties
The following table explains the properties of the Blog control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

ArchiveMode

Select whether the archive appears inmonth format
or year format. The default ismonth.

String

Authenticated

Indicates if you are logged in to the CMSExplorer and
can use it to browse to Content, Collections, etc. See
Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

String

Blog Server Control Properties
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Property Value
Data
Type

BlogID

The ID of the blog in Ektron CMS400.NET. For
example: 41.

If you don’t know the blog ID, use the CMSExplorer to
browse to it. See Also:Using CMSExplorer to Browse
Your Ektron CMS400.NET Site on page 24-8

Long

BlogStartDateRange

Set the date range of the Blogs to show. For example,
if you want to display blogs for only the past 3months,
set this value toQuarterly.

n None - no start date range

n Monthly - current month

n Quarterly - past 3months

n BiYearly - past 6months

n Yearly - past 12months

String

CacheInterval

The amount of time, in seconds, the server control’s
data is cached. The default is 0 (zero).

For example, if you want to cache the data for five
minutes, set this property to 300 (three hundred). See
Also:Caching with Server Controlson page 24-33

Double

DateToStart

The date of the last blog entries you want to appear.
For example, if you want to display blog entries for
January 1, 2007 and before, you enter 1/1/2007.
Clicking the dropdown boxprovides you with a
calendar.

DateTime

DefaultUserID

The ID of the user who owns the blog to be displayed.
This property is used when the server control displays
a user's blog.

To displaya blog not associated with a user, leave this
property set to 0 (zero) and enter the blog's ID in the
BlogIDproperty.

Long

DoInitFill

By default, Fill occurs during the Page_Init event. Set
to false if you want to postpone the fill-action until
later. In this case, FIll is automatically called during the
Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean
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Property Value
Data
Type

DynamicParameter

Gets or sets the QueryString parameter to read a Blog
ID dynamically. Set toNone - Use Default if you
want to alwaysdisplay the default blog.

None - Use Default - use the default Blog ID list.

ID - readsa Blog’s ID dynamically

ekfrm - readsa form block’s ID dynamically

String

DynamicUserParameter
Gets or sets the QueryString parameter to read a user
ID dynamically. Set toUse Default if you wish to
alwaysdisplay the default user's blog (static).

String

EditorHeight Sets the height of the blog editor in pixels. Integer

EditorWidth Sets the width of the blog editor in pixels. Integer

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

JavascriptEditorHTMLMode

Note: Asof version 7.6, the JavaScript editor has
been removed from Ektron CMS400.NET. This
property hasbeen deprecated.

Set to True to allow users to edit their posts and
replies in HTML. The default isFalse.

String

Language
Set a language for viewing blog posts. This property
shows results in design-time (in VisualStudio) and at
run-time (in a browser).

Integer

MaxResults

Set themaximum number of posts to display. If set to 0
(zero), there is no limit. If set to -1, all posts for the day
are shown. If set to -2, all posts for themonth are
shown, If set to -3, the control uses the # of Post
Visible setting in theWorkarea. The default is -3.

See Also: # of Visible Postson page 7-478

Integer
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Property Value
Data
Type

PostParameter

Works like the DynamicParameter for content blocks.
When id is selected, this server control passes the
blog post ID asa URL parameter.

The default setting is id.

Blank - the list of blog posts is static. The links in the
blog posts are inactive.

id - the id of the blog post is passed to the URL asa
parameter.

None use default - the list of blog posts is static. The
links in the blog posts are inactive.

String

RecentPosts The number of post links contained in the Recent
Posts list. The default is 5 (five). Integer

RssTemplate
Specify the .aspxpage to use to render the RSS for
blogs. The default value isWork-
Area/blogs/blogrss.aspx.

String

ShowHeader

Shows the title and tagline when set to True.

The default isTrue.

True - show title and tagline.

False - do not show header and tagline.

Boolean

ShowRSS

Displays the icon for the RSS feed ( ) when set to
True. The default isTrue.

True - show RSS feed icon.

False - do not show RSS feed icon.

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the
control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.
The default isSpan.

Span - The <span> tag is used to designate an in-line
portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply
attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String
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BlogEntries Server Control
The BlogEntries server control allows you to display a list of multiple blog posts
on from a blog on a Web form. It also lets you display a user’s Journal
(personal blog). This server control can display blog posts or journal entries to
a Web form without having to work with other items normally contained in a
blog.

This server control, along with the other individual blog server controls,
provides flexibility to change the appearance of this control without changing
other blog controls. In addition, you can layout the controls any way you like,
unlike the Blog server control. Below is an example of a BlogEntries server
control.

To use this server control to dynamically display a blog’s entries, set the
following properties:

n DynamicParameter - set this property to the parameter name used
to pass a blog ID to the QueryString. The default is blogid.

n BlogPostParameter - set this property to the parameter name used to
pass a blog post’s ID to the QueryString. The default is id.

To use this server control to dynamically display a user’s Journal, set the
following properties:

n DynamicUserParameter - Set this property to the parameter name
used to pass a user’s ID to the QueryString.

n BlogPostParameter - set this property to the parameter name used to
pass a blog post’s ID to the QueryString. The default is id.

BlogEntries Server Control
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BlogEntries Server Control Properties
The following table explains the properties of the BlogEntries control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer
to Browse Your Ektron CMS400.NET Site on page 24-8

String

BlogID

The ID of the blog in Ektron CMS400.NET fromwhich blog entries
are displayed; for example, 41. This is the default ID that is used
when a blog ID is not passed dynamically to the QueryString. To
passa blog ID dynamically, set the DynamicParameterproperty.

If you don’t know the ID of the blog, use the CMSExplorer to browse
to it. See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long

BlogPostParameter

Set this property to the parameter name used to passa blog post’s
ID to theQueryString. The default is id. When a parameter is
defined, this server control passes the blog post’s ID asa URL
parameter. If you do not set this parameter to id, you will not be
forwarded to the blog post’s page when you click on any links in the
post.

The default setting is id.

Blank - the list of blog posts is static. The links in the blog posts are
inactive.

id - the ID of the blog post is passed to the URL asa parameter.

None use default - the list of blog posts is static. The links in the
blog posts are inactive.

String

BlogStartDateRange

Set the date range of the Blogs to show. For example, if you want to
display blogs for only the past 3months, set this value toQuarterly.

n None - no start date range

n Monthly - current month

n Quarterly - past 3months

n BiYearly - past 6months

n Yearly - past 12months

String

CacheInterval

Sets the amount of time the server control’s data is cached. The
default is 0 (zero). This is the amount of time, in seconds, a control’s
data is cached. For example, if you want to cache the data for five
minutes, set this property to 300 (three hundred). See Also:Caching
with Server Controlson page 24-33

Double
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Property Value
Data
Type

DateToStart

The date of the last blog entries you want to appear. For example, if
you want to display blog entries for January 1, 2006 and before, you
enter 1/1/2006. Clicking the dropdown boxprovides you with a
calendar.

DateTime

DefaultUserID

The ID of the user who ownsa Journal fromwhich to display journal
entries. To display journal entries not associated with a user, leave
this property set to 0 (zero) and enter the blog's ID in the BlogID
property.

Warning! If you define a DefaultUserID, it overrides the BlogID
property.

Long

DisplayXslt

Specify an externalXSLT file.

Warning! If you specify an external file, it is strongly recommended
that you do not store this file in theWorkarea folder. If you store this
file in theWorkarea folder, the file will be lost when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes shown.

Boolean

DynamicParameter

Gets or sets the QueryString parameter to read a Blog ID
dynamically. Set to “None - Use Default” if you want to alwaysdisplay
the default blog. The default isblogid.

Note: If an ID for this property is passed on theQueryString and
a an ID for the DynamicUserParameter property is passed the
control displaysblog entries for a user.

String

DynamicUserParameter

Gets or sets the QueryString parameter to read a User ID
dynamically. Set to “Use Default” if you wish to alwaysdisplay the
default user's blog (static.)

Note: If an ID for this property is passed on theQueryString and
a an ID for the DynamicUserParameter property is passed the
control displaysblog entries for a user.

String

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language
Set a language for viewing the blog entries. This property shows
results in design-time (in VisualStudio) and at run-time (in a
browser).

Integer
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Property Value
Data
Type

MaxResults

Set themaximum number of posts to display.

0 (zero) - no limit

-1 - all posts for the day

-2 - all posts for themonth

-3 - the # of Post Visible Workarea setting

The default is -3.

See Also:Blog Propertieson page 7-476

Integer

ShowHeader

Shows the title and tagline when set to True.

The default isTrue.

True - show title and tagline.

False - do not show header and tagline.

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

BlogPost Server Control
The BlogPost server control allows you to display an individual blog post on a
page.

There are two ways this server control displays a blog post.

n If a user is logged in as a Ektron CMS400.NET user or a Membership
user, the control displays the blog post, comments, and comments
from the Web page.

n If a user is not logged in, the control displays only the blog post.

Note: The Enable Comments property in the Workarea must be enabled for comments and
the comments form to appear.

BlogPost Server Control Properties
The following table explains the properties of the BlogPost control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
this property to 300 (three hundred). See Also:Caching with Server
Controlson page 24-33

Double

DefaultContentID

The ID of a default blog post that appearswhere you inserted this
server control if no other content block is identified, or is not available.

If you don’t know the ID number of the blog post, use the CMSExplorer
to browse to it. See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long

DisplayXslt

Specify an externalXSLT file.

Warning! If you specify an external file, it is strongly recommended
that you do not store this file in theWorkarea folder. If you store this file
in theWorkarea folder, the file will be lost when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

DynamicParameter Tomake this blog post dynamic, select id. When you do, this server
control uses the blog post passed asa URL parameter. String

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language Set a language for viewing the blog posts. This property shows results
in design-time (in VisualStudio) and at run-time (in a browser). Integer

ShowType

Showsa blog post’s content and its comments or just the blog post’s
comments. The default isContent.

Content - Show a blog post’s content and its comments.

Description - Show a blog post’s comments only.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Value
Data
Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block
of code.

Custom - Allowsyou to use a custom tag.

String

BlogCalendar Server Control
The BlogCalendar server control allows a user to display a calendar on a Web
page and associate it with a blog. When a blog calendar is associated with a
blog, the days that have blog posts are highlighted on the calendar.

You can use a BlogCalendar server control with a BlogEntries server control.
This gives site visitors a way to view blog posts for a given day.

BlogCalendar Server Control Properties
The following table explains the properties of the BlogCalendar control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String

BlogID

The ID of the blog in Ektron CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMSExplorer to browse to
it. See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
this property to 300 (three hundred). See Also:Caching with Server
Controlson page 24-33

Double
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Property Value
Data
Type

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language Set a language for viewing the calendar. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block
of code.

Custom - Allowsyou to use a custom tag.

String

BlogRoll Server Control
The BlogRoll server control displays the blog roll for a blog on a Web form. A
blog roll is a list of links to other blogs. Blog rolls are created in the Workarea
for each blog. This control reads that list and displays a clickable list of links.
For more information, see The Blog Roll on page 7-481.

Typically this control is displayed along side other individual Blog server
controls. Using the individual server controls, such as the BlogRoll server
control, allows you more flexibility for layout and appearance than using the
Blog server control.

Note: Clicking a blog roll link opens the destination page in a new window.

BlogRoll Server Control Properties
The following table explains the properties of the BlogRoll control.
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Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String

BlogID

The ID of the blog in Ektron CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMSExplorer to browse to
it. See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
this property to 300 (three hundred). See Also:Caching with Server
Controlson page 24-33

Double

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language Set a language for viewing the Blog roll. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

BlogCategories Server Control
The BlogCategories server control displays a blog’s categories on a Web form.
Blog categories are created in the Workarea for each blog. This control reads
that list and displays a clickable list of links. When a link is clicked it displays all
the posts associated with the category.

Typically this control is displayed along side other individual Blog server
controls. Using the individual server controls, such as the BlogCategories server
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control, allows you more flexibility for layout and appearance than using the
Blog server control.

BlogCategories Server Control Properties
The following table explains the properties of the BlogCategories control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use
it to browse to Content, Collections, etc. See Also:Using CMS
Explorer to Browse Your Ektron CMS400.NET Site on page
24-8

String

BlogID

The ID of the blog in Ektron CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMSExplorer to
browse to it. See Also:Using CMSExplorer to Browse Your
Ektron CMS400.NET Site on page 24-8

Long

CacheInterval

Sets the amount of time the server control’s data is cached.
The default is 0 (zero). This is the amount of time, in seconds, a
control’s data is cached. For example, if you want to cache the
data for fiveminutes, set this property to 300 (three hundred).
See Also:Caching with Server Controlson page 24-33

Double

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if
you want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes
shown.

Boolean

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language
Set a language for viewing the Blog categories. This property
shows results in design-time (in VisualStudio) and at run-time
(in a browser).

Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.
The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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BlogRecentPosts Server Control
The BlogRecentPosts server control displays a list of recent blog posts links on a
Web form. When a link is clicked, it takes you to the blog post. You can control
how many recent post links are displayed by setting the NumberofPosts
property.

Typically, this control is displayed along side other individual Blog server
controls. Using the individual server controls, such as the BlogRecentPosts
server control, allows you more flexibility for layout and appearance than using
the Blog server control.

BlogRecentPosts Server Control Properties
The following table explains the properties of the BlogRecentPosts control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String

BlogID

The ID of the blog in Ektron CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMSExplorer to browse to
it. See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long

BlogStartDateRange

Set the date range of the Blogs to show. For example, if you want to
display blogs for only the past 3months, set this value toQuarterly.

n None - no start date range

n Monthly - current month

n Quarterly - past 3months

n BiYearly - past 6months

n Yearly - past 12months

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
this property to 300 (three hundred). See Also:Caching with Server
Controlson page 24-33

Double
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Property Value
Data
Type

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language
Set a language for viewing the blog’sRecent Posts list. This property
shows results in design-time (in VisualStudio) and at run-time (in a
browser).

Integer

NumberofPosts Sets the number of post links to display. The default is 5 (five). Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

BlogRSS Server Control
The BlogRSS server control displays the icon ( ) for the blog’s RSS feed on the
Web form. When the icon is clicked, the RSS feed for the blog appears.

Typically this control is displayed along side other individual Blog server
controls. Using the individual server controls, such as the BlogRSS server
control, allows you more flexibility for layout and appearance than using the
Blog server control.

BlogRSS Server Control Properties
The following table explains the properties of the BlogRSS control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String

BlogID

The ID of the blog in Ektron CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMSExplorer to browse to
it. See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
this property to 300 (three hundred). See Also:Caching with Server
Controlson page 24-33

Double

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language Set a language for viewing the RSS feed. This property shows results
in design-time (in VisualStudio) and at run-time (in a browser). Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

BlogArchive Server Control
The BlogArchive server control displays a list of past months or years that have
posts. This server control can be used with the BlogEntries server control and
the calendar control to allow site users to scan for older Blog posts.
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By clicking a month in the archive, the calendar changes and the entries appear
for that month.

BlogArchive Server Control Properties
The following table explains the properties of the BlogArchive control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

ArchiveMode

Select whether the archive appears inmonth format or year format.
The default ismonth.

String

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String

BlogID

The ID of the blog in Ektron CMS400.NET. For example: 41.

If you don’t know the ID of the blog, use the CMSExplorer to browse to
it. See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
this property to 300 (three hundred). See Also:Caching with Server
Controlson page 24-33

Double
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Property Value
Data
Type

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

DynamicParameter Sets the QueryString parameter to read a Blog ID dynamically. Leave
blank to alwaysdisplay the default blog. String

Language Set a language for viewing the Blog’s archive. This property shows
results in design-time (in VisualStudio) and at run-time (in a browser). Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block
of code.

Custom - Allowsyou to use a custom tag.

String
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Calendars
Web Calendars in Ektron CMS400.NET perform the same function as a paper
calendar - they keep visitors informed about upcoming events. They can be
displayed to all visitors to your Web site, and any authorized user can add
events to a calendar.

Typical calendar events could include

n company meeting

n reserving a conference room for an interview

n company holidays

n community group events

n personal events

n training dates

Web Calendars allow you to create many calendars for your Web site. Users
may add events that are posted for visitors to see.

Create a Web Calendar in Ektron CMS400.NET using three basic steps.

1. Create the Calendar within Ektron CMS400.NET. See Also: Adding a
System Calendar Folder on page 7-529

2. Place either the WebCalendar Server control or the WebCalendar
Widget on a template. See Also: Using the WebCalendar Server
Control on page 7-563 or Web Calendar Widgets on page 7-548
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3. Add appointments. See Also: Adding Web Calendar Events on page 7-
538

This section also contains the following topics.

Calendar Types 7-528
Displaying Calendars 7-529
Adding a System Calendar Folder 7-529
Viewing System Calendar Folder Properties 7-530
Changing System Calendar Permissions 7-534
Using the Web Calendar page 7-534
Adding Web Calendar Events 7-538
Using iCal to Put Appointments into Other Calendars 7-546
Web Calendar Widgets 7-548
Using Community Web Calendars 7-555
Creating a Calendar in My Profile 7-556
Creating a Calendar in My Group 7-559
Web Calendar Server Control 7-563
Customizing the Web Calendar 7-567
Web Calendar Mashups 7-569
Using Taxonomy with Web Calendars 7-573
Using Previous Calendar Versions 7-575

Calendar Types
There are three calendar types in Ektron CMS400.NET :System, User, and
Group. The calendar type determines where events are stored in the database
and what permissions are needed to edit them.

System Calendar User Calendar Group Calendar

Where events
are stored

Workarea Content
Calendar Folder

CommunityUser
Calendar

CommunityGroup
Calendar

Where events
are added or
edited

TheWeb page or
Workarea folder

The community user’s
profileWeb page

The community group’s
Web page

Where
permissionsare
set

Folder Permissions CommunityUsers and
Colleagues

CommunityGroup
Membership

How it appears
on aWeb page Web page with Server Control or Widget

For more
information see

Adding a SystemCalendar
Folder on the facing page

Creating a Calendar in
MyProfile on page 7-
556

Creating a Calendar in
MyGroup on page 7-
559
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Displaying Calendars
There are two ways to display Web Calendars on a Web page.

n Web Calendar Server Control (see Web Calendar Server Control on
page 7-563)

n Web Calendar Widget (Web Calendar Widgets on page 7-548).

Adding a System Calendar Folder
A system calendar folder contains events shown in various places within a Web
site.

To add a System Calendar into an Ektron CMS400.NET Web site, follow these
steps.

Note: To add/edit or delete a calendar folder, you must be a member of the Administrators
Group or have permission to Add, Edit, and Delete folders on the Advanced Permissions
screen. See Also: Standard & Advanced Permissions on page 4-43

1. In the Workarea, click the Content tab.

2. Click the folder into which you want to add a Calendar.

3. Click New > Calendar.

Alternatively, you can hover the cursor over a folder, right click the mouse, and
select Add Calendar. In the example below, we add a new calendar into the
CMS400Demo folder.

4. You see this Add Calendar window.

Displaying Calendars
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5. Enter the Calendar Name.

6. Enter the Description.

7. If needed, enter the path and name of the Style Sheet. See Also:
Style Sheet filename for this folder: (leave blank to inherit) on page
7-532.

8. Click the Add Calendar button ( ) to save your changes and create
the new calendar folder.

Notice that the System Calendar folder is different from the other Folder
icons, as shown below.

After you create a System Calendar folder, you can add events. See Also:
Adding Web Calendar Events on page 7-538.

Viewing System Calendar Folder
Properties
The Calendar folder properties screen lets you set permissions as well as
modify the folder’s metadata, taxonomy, templates, flagging, Web Alerts and
Breadcrumbs.

This section also contains the following topics.

Fields on the Calendar Folder Properties Tab 7-532
Calendar Properties Template Tab 7-532
Other Calendar Properties Tabs 7-533
Folder Properties Toolbar 7-533
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Editing Calendar Folder Properties 7-534

To view the System Calendar properties, follow these steps.

1. Open the Workarea.

2. Click the Content Tab.

3. Click the calendar folder you wish to view.

4. The View Events screen appears.

5. Click View > Properties.

6. The View Properties screen appears.

Viewing SystemCalendar Folder Properties
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Fields on the Calendar Folder Properties Tab
Field Description

ID The Calendar Id is automatically assigned by the system.

Name The name of theWebCalendar folder.

Description The description of theWebCalendar folder.

Style Sheet
filename
for this
folder:
(leave
blank to
inherit)

Specify a style sheet that defines styles that maybe applied to event content in this folder. The
style sheet that you identifymust reside in the site root folder. Or, leave this field blank to inherit
the parent folder’s style sheet.

The style sheet populates the style dropdown list (see below) within the editor.

Note: This style sheet affects event content being edited. It doesnot necessarily affect the
content’s appearance on your Web site. To set or edit the style sheet that determines your
Web pages’ appearance, open the page’sWeb form and place a <link
rel=”stylesheet”... tag within its<HEAD> tags. If desired, you can identify the same
style sheet in both locations. To include user-selectable styles, theymust be generic classes.

Calendar Properties Template Tab
Field Description

Inherit Parent
Template
Configuration

Check this box to inherit the template from the parent content folder.

Or, do not check this boxand specify one or more templatesbelow. See Also: Inheritance of
Folder Templateson page 7-181.

Page
Templates

Specify one or more templates for Calendar events in this folder. This folder’s content uses
the specified template when appearing on your Web site. See Also: Inheritance of Folder
Templateson page 7-181.
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Other Calendar Properties Tabs
Tab Description

Taxonomy
Tab

n If you want this folder to inherit taxonomyconfigurations from the parent folder, check
Inherit Parent Taxonomy Configuration.

If you uncheck Inherit Parent Taxonomy Configuration, you can then select taxonomies
that can be applied to content in this folder.

n If you want all content in this folder to be assigned at least one taxonomycategory, check
Required at least one category selection.

See Also: Inheriting Taxonomies from a Parent Folder on page 9-217; Taxonomyon page 9-
202

Flagging
Tab

Check this box if content in this folder inherits a flagging definition from its parent folder. If you
do not check the box, use the dropdown list to apply a flagging definition to content in this
folder.

See Also: Flagging on page 16-209,Assigning a Flagging Definition to a Folder on page 16-
212

Metadata
Tab AssigningMetadata to a Folder on page 7-159

Web Alerts
Tab AssigningWeb Alert Information to Folders and Content on page 23-20

Breadcrumb
Tab Creating SiteMap Breadcrumbson page 9-276

Folder Properties Toolbar
The Folder Properties screen contains these toolbar buttons.

Button Name Description More Information

Edit Properties Access the Edit Folder
Properties screen

Editing Calendar Folder Propertieson
next page

Permissions Access the folder’sPermissions
Table Folder Permissionson page 4-40

Purge History Access the folder’s purge history
table Purge Historyon page 4-26

RestoreWeb
Alert
Inheritance

Assigns the folder’sWeb Alert
properties to all content in folder

Inheriting Content-LevelWeb Alert
Information from ItsFolder on page 23-
26

Back Go to previous screen

Other Calendar Properties Tabs
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Editing Calendar Folder Properties
To edit any properties for a calendar folder, follow these steps.

1. Access the View Properties screen for the folder you want to edit, as
described in Viewing System Calendar Folder Properties on page 7-
530.

2. Click the Edit button ( ).
3. The folder’s Edit Properties screen appears.

4. Make the necessary changes to the content folder’s properties. See
Fields on the Calendar Folder Properties Tab on page 7-532.

5. Click the Update button ( ).

Changing System Calendar Permissions
You control System Calendar permissions in the same way you set permissions
for other content folders.

For further information about setting permissions see Folder Permissions on
page 4-40.

Using the Web Calendar page
A Web Calendar shows the current day, month, or week when you first view it in
either a Web site page or in the Workarea.

When logged in, you can add or edit events to the calendar. See Adding Web
Calendar Events on page 7-538 .

You must have permission to add or edit events. See Changing System Calendar
Permissions above for more information.
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This section also contains the following topics.

Month, Week, Day Views 7-535
Month View 7-536
Week View 7-536
Day View 7-537
Selecting the Day, Week or Month View 7-537
Selecting the Previous or Next Period 7-537
Choosing a Date 7-538

Month, Week, Day Views
The calendar displays a Month, Week or Day view. To change the view, use the
settings in the upper right corner of the calendar. See Also: Selecting the Day,
Week or Month View on page 7-537

Month,Week, Day Views

ReferenceManual
Version 8.01 Rev 4

7-535



Month View

Week View
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Day View

Selecting the Day, Week or Month View
Click one of the buttons on the top right corner of the calendar to choose the
view

The appearance of these buttons is controlled by the WebCalendar server
control property DisplayType=”All”. See Also:WebCalendar Server Control
Properties on page 7-564

Selecting the Previous or Next Period
Click the left or right arrow (circled below) to move the calendar forward or
backward by one period of time.

DayView
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In the example above, if you click the right arrow, you see Nov, 2009. If you
click the left arrow, you see Sept, 2009.

Choosing a Date
Click the arrow shown circled below to open the Date popup.

Find and click the date you wish to show on your calendar.

Adding Web Calendar Events
Note: You must log in to Ektron CMS400.NET and have permission to edit events in the
calendar folder. See Also: Setting Permissions through the Permissions Table on page 4-41

This section also contains the following topics.

Step 1 - Use the Edit Appointment page 7-539
Step 2 - Edit the Event Title, Location and Description 7-540
Step 3 - Change the Start Time and the All Day Option 7-540
Time Zones for Events 7-541
Step 4 - Set Recurrences 7-541
Editing a Recurring Appointment 7-542
Step 5 - Select a Taxonomy Category 7-543
Step 6 - Set Metadata for the Event 7-543
Save Your Appointment 7-544
Setting Calendar Events with Approval Chain Workflow 7-545
Showing Calendar Events on Activity Streams 7-545
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Step 1 - Use the Edit Appointment page
To add or edit an event on the calendar, follow these steps

1. Navigate to your calendar from either the Web page containing the
calendar or from theWorkarea -> Content Tab and select the
appropriate calendar folder.

2. From the Calendar view, double click any day to add a new event for
it. The example below adds an event to the 27th of the month.

Alternatively, you can add a new event by clicking the New > Add
Calendar Event Menu.

3. The Edit Appointment screen appears.

Step 1 - Use the Edit Appointment page
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Step 2 - Edit the Event Title, Location and
Description

1. Enter the title of the event into the Title text box. “Training Day” for
example.This title shows on the calendar and in the pop-up.

2. Enter the location. This appears in the pop-up.

3. Enter the Description. This appears in the pop-up.

Mouse-over the event to see these fields as shown below.

This pop-up can be customized. See Customizing the Web Calendar Tooltip on
page 7-567 for more information.

Step 3 - Change the Start Time and the All
Day Option
At the bottom of the Edit Appointment page, notice that the selected date
appears as the Start Time, and All Day is checked as the time.

All day events appear differently in the calendar than those with fixed starting
and ending times. For example, in a weekly view, all day events appear at the
top and others appear in their proper time slot as show below.

To change the start and end date/time, follow these steps.

1. Uncheck the All Day option to add the time of day.
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2. For start date, click the calendar button ( ) and set the start date.

3. For start time, enter the time text or click the clock button ( ).
4. If you use the clock button, choose the values and click the Set

button when finished.

5. To set the end date and time, repeat steps 2-4.

Time Zones for Events
Event times are stored in the Ektron CMS400.NET database as UTC (also known
as Greenwich Mean Time - GMT). For members or visitors that login, events
show in the member’s time zone. For visitors that are not logged in, the events
show in the Web server’s time zone.

For information about setting the User time zone, see Time Zone Field on page
15-21.

Step 4 - Set Recurrences
Appointments can be set to recur Daily, Weekly, Monthly, or Yearly. They can
be spaced at various intervals and have a finite duration or recur indefinitely.

Follow these steps to set a recurrence for a Weekly event that occurs on each
Wednesday for the next 5 weeks.

1. Click the Recurrence tab on the Edit Appointment window.

2. Check the Recurrence checkbox, as shown below.

Time Zones for Events
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3. Click theWeekly option.

4. Enter 1 to set the recurrence to occur every week.

5. Click theWednesday checkbox.

6. Enter 5 to end after this many occurrences.

7. Save your changes.

Editing a Recurring Appointment
When you edit a recurring event, you see the following prompt.

Edit only this occurrence to change just one event. Edit the series to change all
events.
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Step 5 - Select a Taxonomy Category
A typical calendar taxonomy helps screen events a Web site visitor might wish
to see. For example, a College Sports Web site might show all sports, but the
visitor may only want to view Football games.

To show only those events related a specific category on your calendar page,
use a Taxonomy. See Also: Taxonomy on page 9-202.

Follow these steps to set taxonomy categories for your event.

1. Click the Taxonomy tab on the Edit Appointment window.

2. Check the appropriate categories.

In the example below, we selected the User Training and Training
Center categories.

See Also: Using a Taxonomy Filter for Calendar Events on page 7-574

Step 6 - Set Metadata for the Event
Each event can have Metadata associated to it. To learn more about metadata,
see Working with Metadata on page 7-141.

In the example below, a map address is associated to an event so that the
event’s location can show on a map. See Also: Map Server Control on page 7-
654

To set the metadata, follow these steps.

1. Click the Metadata tab on the Edit Appointment window.

2. Fill in the Metadata values in the fields provided.

An example of metadata fields for an event is shown below.

Step 5 - Select a TaxonomyCategory
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Save Your Appointment
At any time, click the Save button to display it on the Calendar.

When you finish, the calendar looks like this.
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Setting Calendar Events with Approval Chain
Workflow
To set an Approval Chain for Calendar events, follow the same instructions as
other content. For more information about Workflow and Approval Chains,
WorkFlow on page 4-27.

Showing Calendar Events on Activity
Streams
A new or updated Calendar event appears on a Community Activity Stream if
the following notification settings are checked on a user's or Membership
Group's Profile > Activities tab.

n Add Calendar Event

n Update Calendar Event

n Add Calendar Event

n Update Group Calendar Event

For more information, see Notifications on page 16-122.

Setting Calendar Events with Approval Chain
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Using iCal to Put Appointments into
Other Calendars
Each appointment on a Web calendar can be placed onto any calendar that can
import an iCalendar *.ics file. This is helpful when you want to keep track of
appointments on both your Web calendar and a mobile device calendar for
example.

Note: In order to perform the following steps, you must first be logged into the CMS400.NET
 Web site and be a member of the Administrators group or be assigned the Calendar-Admin
role.

Follow these steps to place a Web Calendar event on another Calendar.

1. Hover over an event on your Web calendar.

2. Click the download link circled below.

3. You see this prompt window.

4. Click Save and place the file into a folder on your PC.

5. When the file is downloaded, click Open Folder.

Managing Content in Ektron CMS400.NET

7-546 ReferenceManual
Version 8.01 Rev 4



6. Double click the .ics file you saved to open the appointment setting
page for your default calendar. For example, this file name was
event-997.ics.

Note: If you are adding the appointment to a Calendar other than the default calendar on your
PC, first open that calendar and import or add the *.ics file to it. For example,when using a
Google Calendar, click the Add link then choose import.
See instructions on your specific calendar type to learn more about importing iCalendar
appointments.

7. Below is an example of the Outlook appointment window.

8. Save and close this appointment and it will appear on your calendar.

Note: Ektron uses the accepted standards for producing the iCalendar ics file. This does not
however mean that all calendar types use the recurring appointment data properly. Contact
your calendar vendor if more help is needed about their support of iCalendar.

Warning! Changes to recurring appointments do not work correctly for iCal files used in Microsoft
Office 2003.

Using iCal to Put Appointments into Other
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Web Calendar Widgets
You place Web Calendars on a Web page by using either a WebCalendar server
control or a Web Calendar Widget in a PageBuilder page.

The Web Calendar widget provides an easy way to add calendars to a Web
page. It is one of the standard widgets provided in Ektron CMS400.NET. See
Also:Widget Reference on page 6-5.

You can drag-and-drop the web calendar widget into these page types.

n PageBuilder (See Also: Building PageBuilder Pages on page 5-1)

n Smart Desktop (See Also: Personalizing the Smart Desktop on page
3-4)

The web calendar widget looks like this when you are logged in.
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For more information about using the Web Calendar interface, see Using the
Web Calendar page on page 7-534.

This section also contains the following topics.

Adding a System Calendar to a Widget 7-549
Adding User Calendars to a Widget 7-550
Searching Users to Add to Your Personal Calendar Widget 7-551
Adding a Group Calendar to a Widget 7-553

See Also: Calendar Types on page 7-528

Adding a System Calendar to a Widget
A system calendar is managed as a Calendar folder within the Workarea. For
more information, see Adding a System Calendar Folder on page 7-529.

To add a system calendar to this widget, follow these steps.

1. Click the edit icon (circled below) in the upper right corner of the Web
Calendar widget.

2. Click the Folder tab.

3. Locate the Calendar Folder to add.

Adding a SystemCalendar to aWidget
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4. Click the Add button ( ).
5. The System Calendar (ID 724 ins this example) is added to the

Selected Calendars list. .

Adding User Calendars to a Widget
To show one or more user calendars on a Web Calendar widget, follow these
steps.

1. Click the edit icon (circled below) in the upper right corner of the Web
Calendar widget.

2. Click the User tab.
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3. Click Add My Calendar to add your own calendar.

4. Your calendar is added to the Calendar Widget.

Searching Users to Add to Your Personal
Calendar Widget
In addition to your own calendar, you may wish to add colleague's calendars to
yours. This way, you can quickly compare their important dates (vacations,
meetings, etc.) with your own.

To add additional users to your calendar, continue with these steps.

1. Click the User Tab.

2. In the Search box, enter a name, such as John.

3. Click the Search Users button.

The example below shows all the users named John.

Searching Users to Add to Your Personal Calendar
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4. Click the Add Calendar button ( ) next to any user.
5. That calendar appears on the Selected Calendars tab, as shown

below. You will see both calendars merged together on your Web
page.

6. Click the Event Color dropdown to choose the background color of
events on the recently added calendar. AutoSelect uses the next
available color in the list.
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7. To remove any calendar, click the Remove button ( ).
8. Click the Save button.

Adding a Group Calendar to a Widget
To show one or more Group calendars on a Web Calendar widget, follow the
steps below.

1. Click the widget edit icon (circled below) in the upper right corner of
the web calendar widget.

2. Click the Group tab.

3. Search for other group calendars by entering their group name and
click the Search Groups button.

The example below shows a search for groups that contain “information”
in their title.

Adding aGroup Calendar to aWidget
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4. Click the Add Calendar button ( ) next to a calendar you wish to
add.

5. The group calendar you selected appears on the Selected
Calendars tab, as shown below.

6. Click the Event Color dropdown to choose the background color for
events on the calendar. AutoSelect uses the next available color in
the list.
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7. To remove any calendar, click the Remove button ( ).
8. Click the Save button.

Using Community Web Calendars
Both community group and community user profile pages can show a Web
Calendar.

In the following example, the profile page contains a personal calendar

Using CommunityWebCalendars
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The calendar displayed on a personal community page obeys the same
community rules as other features in the community. You can restrict the
visibility of your events to only colleagues or make them public.

Creating a Calendar in My Profile
A web calendar can be used inside of individual community profiles to track
personal appointments. This section describes how to use the WebCalendar
server control on a user profile template.

Note: An alternate way to use a personal calendar is to use a Web Calendar Widget on the
user dashboard. SeeWeb Calendar Widgets on page 7-548 for more information.

This section also contains the following topics.

Adding a WebCalendar ServerControl to a User Profile 7-557
Creating the User Calendar in the Database 7-557

Managing Content in Ektron CMS400.NET

7-556 ReferenceManual
Version 8.01 Rev 4



Adding a WebCalendar ServerControl to a
User Profile
The example below shows code to place a Web Calendar server control on a
User Profile template.

<CMS:WebCalendar ID="WebCalendar1" runat="server" >

<DataSource>

<CMS:CalendarDataSource sourceType="UserCalendar" dynamicParameter="id” />

</DataSource>

</CMS:WebCalendar>

The following properties must be set for CalendarDataSource.

Property Set to this value

sourceType UserCalendar

dynamicParameter id

Creating the User Calendar in the Database
To use a personal calendar, you must add your personal Calendar into the
database. Each user needs to do this one time when they decide to have a
calendar for their own profile.

To add a User Calendar into the database, follow these steps.

1. Login to your Website.

2. Navigate to your personal web page.

3. Click the Edit Profile link.

In this example, Edit Profile(circled below) is located on a personal
profile page of the eIntranet Starter Site.

Adding aWebCalendar ServerControl to a User
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4. The Edit Profile window appears.

5. Click the Custom tab.

6. Check the Create User Calendar box (circled below) to create a
User Calendar in the database.

Managing Content in Ektron CMS400.NET

7-558 ReferenceManual
Version 8.01 Rev 4



Warning! After you save this profile, you cannot later uncheck this option.

7. Click the Save button.

Now, your calendar exists in the database and can appear on your profile page.
To add events, see Adding Web Calendar Events on page 7-538.

Creating a Calendar in My Group
You can add a Web Calendar to any Ektron CMS400.NET community group. The
following is an example of a calendar on a community group page

Creating a Calendar in MyGroup
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This calendar could show group events, such as:

n Group meetings

n Team schedules

n Project Milestones

The calendar on a community group page obeys the same community rules as
other community features. You can restrict the visibility of group events to
group members, or make the calendar public.

The following section describes how to use the WebCalendar server control to
do this.

Note: An alternate way to use group calendars is using the WebCalendar Widget on a group
dashboard. SeeWeb Calendar Widgets on page 7-548 for more information.

This section also contains the following topics.

Adding a WebCalendar ServerControl to a Group Profile 7-560
Creating the Group Calendar in the Database 7-561

Adding a WebCalendar ServerControl to a
Group Profile
The example below provides the code for placing a Web Calendar server control
on a Group Profile template.

<CMS:WebCalendar ID="WebCalendar1" runat="server" >

<DataSource>

<CMS:CalendarDataSource sourceType="GroupCalendar" dynamicParameter="id” />
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</DataSource>

</CMS:WebCalendar>

Set the following properties for CalendarDataSource.

Property Set to this value

sourceType GroupCalendar

dynamicParameter id

Creating the Group Calendar in the
Database
To use a group calendar, you must add the group calendar into the database.
Each group needs to do this one time when they decide to have a calendar for
their group.

To add a group calendar database, follow these steps.

1. Log in to your Website.

2. Navigate to your group web page.

3. Click the Edit Group link.

In this example, the Edit Group link (circled below) is located on this
group profile page of the eIntranet Starter Site.

Creating the Group Calendar in the Database

ReferenceManual
Version 8.01 Rev 4

7-561



4. The Edit Group Link window appears

5. Check the Create Group Calendar checkbox (circled below) to
create a group calendar in the database.
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Warning! After you save this profile, you cannot later uncheck this option.

6. Click the Save button.

Now, a group calendar exists in the database and can appear on the group
page. To add events, see Adding Web Calendar Events on page 7-538.

Web Calendar Server Control
The Web Calendar server control displays any calendars managed by Ektron
CMS400.NET.

This section also contains the following topics.

Using the WebCalendar Server Control 7-563
WebCalendar Server Control Properties 7-564
CalendarDataSource Properties 7-565

Using the WebCalendar Server Control
The Web Calendar server control code looks like this.

<cms:WebCalendar ID="webcalendar" runat="server" DynamicParameter="calendar_id"
DisplayType="Day">

<DataSource>

<cms:CalendarDataSource defaultId="724" sourceType="SystemCalendar" />

</DataSource>

WebCalendar Server Control
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</cms:WebCalendar>

The two parts of the WebCalendar Server Control are:

n cms:WebCalendar Server Control. See Also:WebCalendar Server
Control Properties below

n cms:CalendarDataSource, located inside the WebCalendar tags. See
Also: CalendarDataSource Properties on the facing page

WebCalendar Server Control Properties
The WebCalendar server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

AllowEventEditing
Determineswhether Events can be added and edited on the calendar.
Default is “True”. See Also:Changing SystemCalendar Permissions
on page 7-534

Boolean

DefaultDisplayType

Specify the Calendar view type. The default isMonth, whichmeans
that theMonth view of the calendar appears on theWeb page.

The site visitor can change the view. See Also:Selecting the Day,Week
or Month View on page 7-537.

String

DisplayTemplatePath
Specify the path to the code that controls how events are displayed.
Default is blank. See Also:Customizing theWebCalendar Tooltip on
page 7-567

String

DisplayType

Determineswhich time period choicesare presented on the calendar.
ChoicesareAll,Day,Month,Week.

Default isAll.

See Also:Selecting the Day,Weekor Month View on page 7-537

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean
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Property Value
Data
Type

DynamicParameter

Tomake this calendar dynamic, select calendar_id. When you do, this
server control uses the calendar passed asa URL parameter. To
exclude this function, choose “None- Use Default”.

OnlyCalendarswith sourcetype=”SystemCalendar” maybe used in
the querystring for this value.

For example, where DyanamicParameter=”calendar_id”, the
URLmay read http://mysite.com/calendar.aspx?calendar_
id=”55”. In this case, calendar 55must be of the SystemCalendar
type.

String

Hide

Used to hide the output of a calendar in design time and run time.

True =Hide calendar

False =Display calendar (Default setting)

Boolean

Language Set a language for viewing a calendar. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block
of code.

Custom - Allowsyou to use a custom tag.

String

CalendarDataSource Properties
The table below shows properties set inside the CalendarDataSource tag.

CalendarDataSource Properties
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Property Value
Data
Type

backColor

The background color of the event shown on the calendar. This example shows
backColor=“yellow”.

If you set this value to “AutoSelect”, the next available color in the list is chosen
automatically. This is the list of color choices.

String

defaultId The Id of the SystemCalendar, GroupCalendar or UserCalendar to display on the
Web page. String

queryParam

The parameter that maybe in the query string tomash-up additional calendars.
This can be anyCalendar SourceType.

For example, if the value is set to uid, then the querystring can be:

.../calendar.aspx?calendar_id=”55”&uid=”440”

String

sourceType ChoicesareSystemCalendar, GroupCalendar, UserCalendar. String

See the following for additional information about the using the
CalendarDataSource properties.

n Web Calendar Mashups on page 7-569

n Using Taxonomy with Web Calendars on page 7-573
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Customizing the Web Calendar
The Web Calendar can be customized in many ways. Two methods are shown
as follows:

n Customizing the Web Calendar Tooltip below

n Changing Web Calendar Style Sheets on next page

Customizing the Web Calendar Tooltip
When you hover over a Calendar event, a tooltip automatically shows its
details.

You can change how this tooltip looks and behaves. Do this by modifying the
telerik:RadToolTip properties.

Changing the Event Tooltip Control
You can apply many changes to a tooltip, but for a simple explanation, we will
choose just two. In this example, we make the tooltip appear without delay and
have fade-in animation. The example below uses the EktronTech starter site.

Before starting, be sure to add an event to your calendar so that you see the
default behavior. See Also: Adding Web Calendar Events on page 7-538.

Then follow these steps.

1. Open the EktronTech Website file folder in your editor.

2. Make a copy of the Display.ascx and Display.ascx.cs files from this
folder

<siteroot>\workarea\WebCalendar\DefaultTemplate

3. Paste them into a new folder in the Web site such as
<siteroot>\CustomUserControls.

Warning! Ektron recommends that you make a copy of these files and move them to a folder that
is not inside the \Workarea folder. Upgrades overwrite files in the \workarea folder.

4. Edit the new ascx file you just created.

5. Change these properties on the Telerik:RadToolTip server control.

Customizing theWebCalendar
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Property Value Default Value

ShowDelay 0 400

Animation Fade None

6. Save your changes.

7. Edit your template.

8. Change the following properties on the WebCalendar server control to
set the location of this revised display.ascx file.

Property Value (example)

DisplayTemplatePath /CustomUserControls/display.ascx

See Also: Using the WebCalendar Server Control on page 7-563

9. Save your changes.

10. Refresh the browser page containing the calendar.

11. Mouse-over the event on the calendar to see the new behavior.

Changing Web Calendar Style Sheets
The Web Calendar style sheet is WebCalendar.css. It is located in the folder
<siteroot>\workarea\WebCalendar\View.

By modifying the various .RadScheduler classes, you can change style for your
web calendar. Below are some sample changes you can make.
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Example CSS Style Change

Color

Uppercase

Web Calendar Mashups
A Calendar Mashup shows events from different calendars combined into one
calendar view. As an example, you could combine upcoming company meetings
from one calendar with a special seminar series from another calendar.

There are several ways to combine the events on a calendar.

This section also contains the following topics.

Combining Calendars Using the Dynamic Method 7-569
Combining Calendars Using the Static Method 7-571
Combining a Static Mashup and Dynamic Parameter 7-572

Combining Calendars Using the Dynamic
Method
The dynamic method uses URL query string parameters to specify which
calendars to see. This allows you to maintain one calendar template that can be
used by many calendars on your Web site.

Using the EktronTech starter site, the exercise below combines calendars using
a URL query parameter cal2.

http://<servername>/ektrontech/calendar.aspx?cal2=376

Follow these steps to combine two calendars.

1. Log in to the site.

WebCalendar Mashups
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2. Create two calendar folders in the workarea. See Also: Adding a
System Calendar Folder on page 7-529.

3. Determine the ID number (circled below) for each calendar by
examining the Calendar Folder Properties.

See Also: Viewing System Calendar Folder Properties on page 7-530. In
our example, we use Calendar folder Ids 375 and 376

4. Edit the calendar.aspx template that contains the web calendar. In
this example, the template is located on the web server in this folder:
d:\inetpub\wwwroot\EktronTech.

5. Add two CalendarDataSource tags - one for a static calendar the other
for a dynamic calendar.

6. In the first (static) CalendarDataSource properties, add defaultId =
“375”.

7. In the second (dynamic) CalendarDataSource properties, add
queryParam = “cal2”.

8. In both CalendarDataSource tags, be sure to set the sourceType =
“SystemCalendar” property.

The finished code looks like this.

<cms:WebCalendar ID="webcalendar" runat="server" DynamicParameter="calendar_id"
DisplayType="All" SuppressWrapperTags="True">

<DataSource>

<cms:CalendarDataSource defaultId="375" sourceType="SystemCalendar"/>

<cms:CalendarDataSource queryParam="cal2" sourceType="SystemCalendar"/>

</DataSource>

</cms:WebCalendar>

The code above has a CalendarDataSource defaultId for calendar 375.
By adding the second CalenderDataSource line with a queryParam, we
can display any calendar by referring to it in the query string.

9. Save the calendar.aspx page.

10. Enter the following URL to see the calendar:
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http://<servername>/ektrontech/calendar.aspx?cal2=376

You see the combined calendar events. When there are too many events to
show on a specific date, you will see a link that says “more...”. Click this link to
see all of the events.

Combining Calendars Using the Static
Method
The static method of combining calendars hard codes the calendar id numbers
instead of using a query string parameter. This creates a calendar whose
events source does not change dynamically.

For example, follow these steps.

1. Log in to the EktronTech starter site.

2. Create two calendar folders in the workarea. See Also: Adding a
System Calendar Folder on page 7-529

3. Determine the ID number for each calendar by examining the
Calendar Folder Properties. See Also: Viewing System Calendar
Folder Properties on page 7-530

4. Edit the calendar.aspx template.

In the CalendarDataSource properties, add the defaultId values for each
calendar as shown in the code below.

<cms:WebCalendar ID="webcalendar" runat="server" DynamicParameter="calendar_id"
DisplayType="All" SuppressWrapperTags="True">

<DataSource>

<cms:CalendarDataSource defaultId="375" sourceType="SystemCalendar"/>

<cms:CalendarDataSource defaultId="376" sourceType="SystemCalendar"/>

</DataSource>

In this example, all events for calendars 375 and 376 are combined on the
calendar.aspx page.
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ReferenceManual
Version 8.01 Rev 4

7-571



Combining a Static Mashup and Dynamic
Parameter
The following example show how to display a specific calendar according to a
dynamic parameter in the query string. If the query string parameter is not
used, the calendar shows a mashup of three calendars.

The following example assumes you created three calendars with events with
ids 374, 375, and 376.

This is the code for the events.aspx template.

<cms:WebCalendar ID="webcalendar1" runat="server">

<DataSource>

<cms:CalendarDataSource sourceType="SystemCalendar" >

</cms:CalendarDataSource>

</DataSource>

</cms:WebCalendar>

This is the code behind for events.aspx.vb, which listens for a query parameter.
If none is found, display a static calendar mashup.

‘This code is located in the Page_Load event

Protected Sub Page_Load(ByVal sender As Object, ByVal e As
System.EventArgs) Handles Me.Load

‘Create a CalendarDataSource instance and set the sourceType and queryParam

Dim cds As New Ektron.Cms.Controls.CalendarDataSource()

cds.queryParam = "calid"

cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar

‘Add the DataSource object

webcalendar1.DataSource.Add(cds)

‘If the queryString is used, show that calendar,
otherwise show the following mashup

If (Request.QueryString("calid") = String.Empty) Then

‘Create three CalendarDataSource instances and add the sourceType and defaultId for
each.

cds = New Ektron.Cms.Controls.CalendarDataSource()

cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar
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cds.defaultId = 374

webcalendar1.DataSource.Add(cds)

cds = New Ektron.Cms.Controls.CalendarDataSource()

cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar

cds.defaultId = 375

webcalendar1.DataSource.Add(cds)

cds = New Ektron.Cms.Controls.CalendarDataSource()

cds.sourceType = Ektron.Cms.Controls.SourceType.SystemCalendar

cds.defaultId = 376

webcalendar1.DataSource.Add(cds)

End If

‘Fill and return

webcalendar1.Fill()

End Sub

To see a single calendar such as 376, use this URL:

http://<server>/cms400developer/events.aspx?calid=376

To see all calendars together, do not use the query string parameter, as shown
below.

http://<server>/cms400developer/events.aspx

Using Taxonomy with Web Calendars
You can use taxonomy categories to filter events on a calendar. The categories
for a calendar could include the meeting rooms, the audience, or whether the
event should show on a special public calendar.

To see more information about Taxonomy, see Introduction to Creating a
Taxonomy on page 9-203.

This section also contains the following topics.

An Example of a Calendar Taxonomy 7-574
Using a Taxonomy Filter for Calendar Events 7-574
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An Example of a Calendar Taxonomy
The following example shows how to organize events based on locations and
audience.

Once a Taxonomy is created, these categories can be assigned to events. See
Also: Step 5 - Select a Taxonomy Category on page 7-543

Using a Taxonomy Filter for Calendar Events
Use a CategoryID value in the CalendarDataSource to filter events according to
taxonomy categories.

In the example below, the calendar shows events for the Training Center
(category 123) or Administrators (category 124).

<cms:WebCalendar ID="webcalendar" runat="server">

<DataSource>

<cms:CalendarDataSource defaultId="726" sourceType="SystemCalendar">

<CMS:CategoryID categoryId="123" />

<CMS:CategoryID categoryId="124" />

</cms:CalendarDataSource>

</DataSource>

</cms:WebCalendar>

By using an id of a higher category in the taxonomy tree, you can show all
events under it.

For example, this taxonomy has two higher level branches with id 100 and 200.
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If you set the category id to 100, you see any events associated with categories
100, 111 or 112.

Using Previous Calendar Versions
To enable Version 7.6.5 Calendar functionality, make the following change to
the siteroot\web.config file.

<add key="ek_enableClassicCalendar" value="True"/>

Both versions of the Calendar may exist on a Web Site.

For more information about using Calendar Version 7.6 and earlier, refer to
Calendars in the Version 7.6 Ektron Administrator Manual.

Using PreviousCalendar Versions
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Discussion Boards
The Discussion Board feature provides an opportunity for topic discussions on
your Web site. A site or membership user with Add Topic permission creates a
topic and posts a starter question. Site visitors can then reply.

An example of a Discussion Board is below. As you can see, the first screen has
general topics, the second screen’s topics are more specific, and a third screen
displays posts to the forum.

As an administrator, you can determine the following Discussion Board
features.

n The subjects being discussed

n A starter post, which initiates a discussion

n If users must sign in before posting to the forum

n If a post appears as soon as someone submits it, or must be
approved first

- If a post requires approval, you can edit or delete it before it appears

Whether or not posts must be approved, anyone with permission to the board
can perform the following tasks on a post from the Workarea

n edit

n delete

n reply

This section also contains the following topics.

Hierarchy of Discussion Board Elements 7-577
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Implementing Discussion Boards 7-579
Working with Discussion Boards and Subjects 7-579
Working with Forums 7-588
Working with Topics 7-594
Working with Posts 7-601
Restricting an IP Address 7-611
Setting Up Post Reporting 7-612
Assigning Permissions to a Discussion Board 7-613
Sending Notifications When a New Forum Topic or Post is
Created

7-
619

Inserting Discussion Board Server Controls 7-622
Using Discussion Boards on Your Web Site 7-622
Using Discussion Boards in Community Groups 7-637
Discussion Board Server Controls 7-639
Forum Server Control 7-640
ActiveTopics Server Control 7-650
PostHistory Server Control 7-652

Hierarchy of Discussion Board Elements
A Discussion Board consists of a five-level hierarchy, illustrated below. Before
creating a Discussion Board, it is important to understand the elements of the
hierarchy.
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Ektron CMS400.NET supports an unlimited number of Discussion Boards. Each
board must follow the hierarchy. Below is the hierarchy with sample data, to
explain how each element is used.

Within the Workarea, Discussion Boards appear as top-level folders in the

folder structure. Forums appears under them. Both folders us this icon ( ) to
distinguish them from content and blog folders.

If you click a Discussion Board, you see its Subjects and Forums on the right
side of the Workarea, as shown below.

Managing Content in Ektron CMS400.NET

7-578 ReferenceManual
Version 8.01 Rev 4



If you click a Discussion Forum, you see its topics. If you click a topic, you see
its posts, as shown below.

Implementing Discussion Boards
To implement a Discussion Board into your Web site, place a Forum server
control on a Web page. Then, select a Discussion Board.

All Subjects and Forums within that board appear on the Web page. You cannot
selectively suppress Subjects or Forums. Keep this in mind when determining
the contents of a Discussion Board.

Working with Discussion Boards and
Subjects
This section also contains the following topics.

Creating a Discussion Board 7-580
Discussion Board Properties 7-581
Viewing a Discussion Board 7-584
Editing a Discussion Board 7-585
Deleting a Discussion Board 7-585
Changing Page Size for Discussion Boards 7-585
Editing Subject Name and Sort Order 7-586
Creating a New Subject 7-586
Terms & Conditions 7-586
Adding Terms and Conditions to a Discussion Board 7-587

See Also: Implementing Discussion Boards above
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Creating a Discussion Board
To create a Discussion Board, follow these steps.

1. From the Workarea’s Content tab, navigate to the folder in which
you want to place the Discussion Board.

2. Click New > Discussion Board.

Alternatively, you can hover the cursor over the folder, right click the mouse,
and select Add Discussion Board.

3. The Add a Discussion Board to folder screen appears.

Complete the screen using the following table.

Note: Some items in this table only appear when editing an existing Discussion Board’s
properties.
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Discussion Board Properties

Field Description
When
Available

Name Enter the name of the Discussion Board. This text describes the board within
theWorkarea and on your Web site.

Enter or
edit

Title Enter the title of the board. Enter or
edit

Accepted
HTML

A comma-delimited list of HTML tagsallowed in the editor.When left blank,
all tagsare available.

The default list is:
br,hr,b,i,u,a,div,ol,ul,li,blockquote,img,span,
p,em,strong,font,pre,h1,h2,h3,h4,h5,h6,address,embed

Site visitors posting to the forum can apply these HTML tags to content when
their Forum editor iseWebEdit400, as set in the user profile.

Note: Youmust add the embed tag if you want users to be able to insert
WMV files into their posts. See Also:Adding Video to a Post on page 7-
627

Enter or
edit

Accepted
Extensions

A comma delimited list of file extensions that can be uploaded. You can enter
the extension with or without the period (.). Use a comma to separate each
extension.

The default list is: bmp,conf,doc,gif,jpe,jpeg,jpeg,png

The list appears at the bottom of the editor screen to notify the person
entering a post which file typeshe can attach.

Edit only

MaxFile Size Themaximum size of a file, in bytes, that a user can upload.
The default is 200000 bytes (.19megabytes). Edit only

Discussion Board Properties
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Field Description
When
Available

Topics:
Require
Authentication

Effect of this Field on the Web Site

Check this box if a site visitor must sign in before he can post to the
Discussion Board. If the user cannot accessa login screen, he cannot post.

If this box is unchecked, site visitors can post without signing in.

Effect of this Field within the Workarea

If this field is checked, only userswith Add Topic or Edit Topic permissions for
the Discussion Board can create or reply to posts.

See Also:Assigning Permissions to a Discussion Board on page 7-613

Enter or
edit

Lock

Check this box if you want to prevent all posting to thisDiscussion Board. You
can do this temporarily or permanently.

If a Board is locked, onlyAdministrator user groupmembers can post to it, or
edit or delete posts. Those users can post from theWeb site or the
Workarea.

You can alternatively lockanyForum underneath thisBoard via the Forum
properties screen.

Edit only

CSSTheme

Choose a style sheet to determine the appearance of the Discussion Board
on your Web site. Select any theme available in the CSSTheme dropdown.
The default issite
root/Workarea/threadeddisc/themes/standard.css.

Alternatively, enter a path below the site root folder to your customCSS file in
the path box.

Note: If you edit a CSS file, Ektron recommendssaving it under a new
name. This prevents your changes from being overwritten during an
upgrade.

See Also: Using a Custom Theme on page 7-647.

Enter or
edit

Page
Template

Lets you specify a template for the Forum. If you do not specify a template,
the search results do not link properly to the Forum. See Also:
Creating/Updating Templateson page 7-178

To preview what the Forum looks like within the selected template, click the

preview icon to the right ( ).

Enter or
edit

Taxonomy:
Required
category
selection

If you want all topics in thisDiscussion Board to be assigned a taxonomy
category, checkRequired category selection. If you do, a signed-in user
is prompted to select a taxonomycategorywhen creating a topic.

This checkboxhasno effect when creating new topicswithin the Ektron
CMS400.NETWorkarea.

See Also: Taxonomyon page 9-202

Edit only
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Field Description
When
Available

Taxonomy:All
taxonomies
appear

Select a taxonomywhose categorieswill be assigned to Forum topics. The
Taxonomiesare created in the TaxonomyTab. The Discussion Board’s
taxonomydisplay represents another way to organize the Forum’s posts.

See Also: Taxonomyon page 9-202

Effect of Assigning Taxonomy Categories to a Topic

When aDiscussion Board server control is placed on aWeb page, its display
includesa small taxonomy icon (circled below).

When a site visitor clicks this icon, he seesall taxonomycategories.When he
selects a category, he sees its subcategories followed byall Forum posts
assigned to that category.

Below is an example of how aDiscussion Board’s postsmight be organized
by taxonomycategory.

See Also:Using the TaxonomySearch on page 9-252
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Field Description
When
Available

SubjectsTab

Enter asmanySubjects as you wish. Each Subject contains one or more
Discussion Forums.

Youmust create at least one Subject for each Discussion Board.

To learn how Subjects fit into the Discussion Board hierarchy, seeHierarchy
of Discussion Board Elementson page 7-577.

Note: You can also add a Subject by selecting a Discussion Board then
selectingNew > Subjects.

Subject Sort Order

Subjects are the highest level of the hierarchy that appears on your Web site.
In the sample Forum below, Latest Discoveries andPatient Care are
Subjects.

Subjects appear in alphabetical order unless you use theSort Order field.
TheSort Order field accepts a number and uses it to arrange the Subjects
of a Discussion Board on theWeb site. The lowest numbersappear near the
top of the page.

To access theSort Order field, follow these steps.

1. Save the Discussion Board.

2. Click the Discussion Board in theWorkarea.

3. ClickView > Properties.

4. Click theSubjects tab.

5. Modify the number in theSort Order field asneeded.

Enter or
edit

Terms&
Conditions
Tab

Add the Terms&Conditions for using the Discussion Board. Byentering text
in this text boxand saving, you activate the Termsand Conditions feature.
See Also: Terms&Conditionson page 7-586

Edit only

Viewing a Discussion Board
To view a Discussion Board, select it from the Folders display. When viewing
the Board, you see all of its Forums. You can click any Forum to see details
about it.

See Also: Implementing Discussion Boards on page 7-579;
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Editing a Discussion Board
When editing a Discussion Board, you can change information entered when it
was created plus additional fields only available when editing. See theWhen
Available column of the Discussion Board Properties on page 7-581.

To edit a Discussion Board, follow these steps.

1. Click the Workarea’s Content tab.

2. Form the folder structure in the left frame, click the Discussion
Board.

3. Click View > Properties.

4. Click the Edit button ( ).
5. Update the screen as needed. Fields are described in Discussion

Board Properties on page 7-581.

6. Click Save ( ).

Deleting a Discussion Board
You can delete any Discussion Board. When you do, its Subjects, Forums, and
posts are also deleted. Once deleted, they cannot be retrieved.

1. Click the Workarea’s Content tab.

2. From the folder structure in the left frame, click the Discussion
Board.

3. Click Delete > This folder.

4. A message appears asking you to confirm.

5. Press OK If you are sure.

Changing Page Size for Discussion Boards
You can change the number of Topics or Posts shown on a page by changing the
ek_PageSize value in the Web.config file.

See Also: ek_PageSize on page 1-79
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Editing Subject Name and Sort Order
You can change any Subject’s name or sort order. To do so, follow these steps.

1. Click the Workarea’s Content tab.

2. From the folder structure in the left frame, click the Discussion Board
that contains the Subjects.

3. Click View > Properties.

4. Click the Subjects tab.

5. Click the Subject that you want to edit.

6. The current Subject name and sort order appear on a new screen.
Edit as needed. See Also: Subject Sort Order on page 7-584.

7. Click Save ( ).

Creating a New Subject
Use this procedure when you want to add a new Subject to a Discussion Board.

Note: For more information about how Subjects fit into the Discussion Board hierarchy, see
Hierarchy of Discussion Board Elements on page 7-577.

1. Click the Workarea’s Content tab.

2. From the folder structure in the left frame, click the Discussion Board
to which you want to add a Subject.

3. Click New > Subject.

4. Enter a Subject name and sort order. See Also: Subject Sort Order on
page 7-584

5. Click Save ( ).

Terms & Conditions
A discussion board's Terms & Conditions convey your expectations to its users.
If you add Terms & Conditions, anyone posting to that board sees the following
screen the first time he tries to post or reply to a Forum. Users can only post to
a Forum after agreeing to its Terms & Conditions
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The circled text is a sample of what Terms & Conditions might be. The rest of
the text, the checkbox, and the button are provided by Ektron CMS400.NET.

When new membership users are added, you can have them accept the Terms
& Conditions during registration. See Also: Membership Server Control on page
16-19

Adding Terms and Conditions to a
Discussion Board

1. Click the Workarea’s Content tab.

2. From the folder structure in the left frame, click the Discussion Board
to which you want to add terms and conditions.

3. Click View > Properties.

4. Click the Edit button ( ).
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5. Click the Terms & Conditions tab.

6. Add the terms and conditions text to editor.

7. Click the Save ( ) button.
See Also: Implementing Discussion Boards on page 7-579

Working with Forums
A Forum is a particular thread within a Discussion Board. To learn about how
Forums fit into the Discussion Board hierarchy, see Hierarchy of Discussion
Board Elements on page 7-577.

For each Forum, you define the following:

n name and Description

n whether posts to it must be approved before appearing on your Web
site

n if it’s accepting new postings

n its sort order, which determines its sequence on the Web page within
its Subject

n its Subject

This section also contains the following topics.

Creating a Forum 7-588
Editing a Forum 7-590
Deleting a Forum 7-590
Ranking Forum Users 7-591
Ranks Independent of the Ladder System 7-591
Adding a User Rank 7-592
Deleting a User Rank 7-593
Changing a User’s Rank 7-593

Creating a Forum
You can only create a Forum after a Discussion Board and at least one Subject
have been created.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board.

3. Click New > Discussion Forum.

4. The Add a Discussion Forum to Board screen appears.
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Complete the screen using the following table.

Field Description

Name

Enter the name of the discussion Forum.

The name identifies the Forum in the left side of theWorkarea. The Forum’s name appears

next to a forum icon ( ). This icon distinguishes it from content and blog folders.

It also appears on theWeb site (see example below).

Description
Enter amore detailed description of the Forum.

The description appears on theWeb site, as illustrated above.

Moderate
Comments

Checking this box causes

n comments to require approval before appearing on theWeb site See Also:Approving a
Topicon page 7-600

n a post to be reported to allmoderators of the Forum. See Also:Reporting a Post on page 7-
627 andSetting Up Post Reporting on page 7-612

Only userswho are grantedModerate permission can approve comments, therebyallowing
them to be published on the site. See Also:Discussion Board Permissionson page 7-615

The Smart Desktop hasa Forum Topics and Posts category. This tells you howmanyposts
currently require your approval before theyappear on the site.
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Field Description

Lock
Forum

Check this box if you want to prevent all posting to this Forum. You can do this temporarily or
permanently.

If a Forum is locked, onlymembersof the Administrators user group can post to it, or edit or
delete posts. Those users can post from theWeb site or theWorkarea.

ADiscussion Board can also be locked. If a board is locked, amessage on this screen indicates
that. In that case, no posting is allowed to this Forum regardlessof this setting.

Sort Order
Enter a number if you want to arrange the sequence of Forumswithin the Subject.

If you do not, Forumsappear in alphabetical order within a Subject.

Subject
Enter the Subject within which this Forumwill appear on theWeb site. To learnmore about the
relationship of Subjects to Forums, seeHierarchyof Discussion Board Elementson page 7-
577.

5. Click Save ( ).

Editing a Forum
Follow these steps if you want to change any information about a Forum.

1. Click the Workarea’s Content tab.

2. From the folder structure in the left frame, click the Discussion Board
that contains the Forum.

3. Click the Forum.

4. Click the View Properties button ( ).

5. Click the Edit button ( ).
6. Update the screen as needed. The fields are described in Complete

the screen using the following table. on previous page.

7. Click Save ( ).

Deleting a Forum
You can delete any Forum. When you do, its topics and posts are also deleted.
Once deleted, they cannot be retrieved.

To delete a Forum, follow these steps.

1. In the Workarea, click the Content tab.

2. Select the Discussion Board that contains the Forum.

3. Click the Forum.

4. Click the Delete Forum button ( ).

5. A message appears asking you to confirm.

6. Press OK if you are sure.
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Ranking Forum Users
The User Ranking feature lets you recognize users for their Forum
contributions. You can create a ranking system that determines the number of
posts a user must submit to move up to the next level. Here’s an example.

Rank Number of posts

Newbie 0 - 9

Intermediate 10 - 19

Expert 20 and up

This is known as a ladder system, because users move to the next level after a
designated number of posts.

This system lets Forum users build credibility. You can assign each rank an
image, which appears below the user’s name on any post (see illustration
below).

The rank also appears on a user’s forum profile. See Also: Suppressing User
Information from the Forum Profile Display on page 7-628

Ranks Independent of the Ladder System
You can also create ranks that are independent of the ladder system. Such a
rank bears no relationship to the number of posts a user has made. For
example, after a Forum user acquires Ektron Developer Certification, he is
assigned the Ektron Developer rank.

Users can be moved from a non-ladder rank to the ladder system and vice
versa. Whether or not a user is in a ladder system, Ektron CMS400.NET keeps a
tally of posts. So, if the user is moved into a ladder system at any time, he is
placed into the correct rank.

Ranking ForumUsers
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Adding a User Rank
To add a user rank, follow these steps.

Note: You can also access the User Ranks screen from Workarea > Settings > Configuration >
Discussion Board > User Ranks. If you have more than one Forum, this screen lets you pick
the Discussion Board to which a rank is assigned.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board.

3. Click New > User Ranks.

4. The User Ranks screen appears.

5. Complete the screen using the following table.

Field Description

Name The name of the rank. For example, Newbie, Expert, Developer, or Associate.

Rank
Image

Click the upload link to browse and select an image to upload. Once uploaded the path where the
image is stored appears in the text box. Imagesare optional.

If you assign an image, it appears below the user’s name on anypost.

Number
of Posts

Enter the number of posts it takes to reach this rank. If theStarting Rank checkbox is checked,
the number is 1 and cannot be changed.

Ladder
System

Check this box if this rank is part of a ladder system. That is, a rankbased on the number of posts a
user has submitted to thisDiscussion Forum. See Also:Ranking ForumUserson previouspage

If you uncheckLadder System, bothStarting Rank andNumber of Posts become inactive,
since those fields set up andmanage the ladder system.

Starting
Rank

If you are using a ladder system, use this checkbox to designate this rank the Starting Rank. A
user is assigned to this rankwhen he submits the first post.

ADiscussion Forum can only have one Starting Rank. Also, If this is the Starting Rank, you cannot
enter a number of posts.

Applies
To

If you accessed this screen fromWorkarea > Settings > Configuration > Discussion Board
> User Ranks, use this field to select the Discussion Forum to which this rankapplies.

6. Click the Save button ( ).
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Deleting a User Rank
1. In the Workarea, click the Content tab.

2. Select a Discussion Board.

3. Click View > User Ranks.

4. Select the rank you want to delete.

5. Click the delete ( ) button.

6. Press OK to the confirmation message.

Changing a User’s Rank
In order to change a user’s current rank, you must know it. As mentioned
above, a user’s rank appears below the user name on any post he has made.

You can only move a user into and out of a ladder system. You cannot change
his rank within a ladder system -- that is determined by the number of posts.

To change a user’s rank, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Content and navigate to
the forum to which the user has posted.

2. Click View > User Ranks.

3. Select the rank that you want to move the user out of.

4. The User Ranks screen appears. The lower half shows all users
assigned that rank.
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ReferenceManual
Version 8.01 Rev 4

7-593



5. Click the user that you want to move out of the rank.

6. The screen display all ranks. The current one is selected.

7. Click next to the desired rank.

8. Click the Save ( ) button.

Working with Topics
Topics are specific issues to be discussed in a Forum. For example, in a medical
research Forum, a topic might be New Cancer Treatments. Topics can only be
started within the Workarea.

Before creating a topic, you must create a Forum into which to place it. To learn
more about how Topics fit into the Discussion Board hierarchy, see Hierarchy of
Discussion Board Elements on page 7-577.

This section also contains the following topics.

Adding a Topic to a Forum 7-595
Setting and Changing the Topic Priority 7-596
Priority Levels 7-596
Locking a Topic 7-597
Viewing a Topic 7-598
Editing a Topic's Title 7-599
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Approving a Topic 7-600
Deleting a Topic 7-600

Adding a Topic to a Forum
When a new Topic is created, the first post is created from the message of the
Topic.

To create a Topic, follow these steps.

Note: If the user adding the Topic is not a Forum moderator, that user does not see the Topic
in the workarea until it is approved. See Also: Approving a Topic on page 7-600.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then a Forum from the folder structure.

3. Click the New Topic button ( ).
4. The Post New Topic screen appears.

5. Complete the screen using the following table.

Field Description

Subject

Enter a short description of the topic. The TopicSubject appears on the Forum page, as
shown below.

Adding a Topic to a Forum
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Field Description

Priority
Set the priority level for the topic. This determineswhere the topic appears in the topic list
on the site. The default setting isNormal. See Also:Setting and Changing the Topic
Prioritybelow

Lock

Check this box if you want to prevent posting of replies to this Topic. You can do this
temporarily or permanently.

If a Topic is locked, onlyAdministrator user groupmembers can post to it, or edit or delete
posts. Those users can post from theWeb site or theWorkarea.

Message

Enter the topic text. This text appears on a newWeb page after aWeb site visitor clicks a
Topic’sSubject line.

6. Click Save ( ).

Setting and Changing the Topic Priority
You can set a topic’s priority when creating it. Within a Forum, topics are sorted
by priority.

Anyone with Moderate permission can change a topic’s priority. To do so, edit a
Forum’s properties and click the View Properties button ( ).

Priority Levels
There are three priority levels:

n Announcement - topic always appears at the top of the list. If a list
has more than one announcement, they are sorted by date with most
recent on the top.

The Announcement icon ( ) indicates its priority to the left of the
title.
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n Sticky - topic appears near the top of the list, just below the
announcements. If a list has more than one sticky topic, they are
sorted by date with most recent on the top.

The Sticky icon ( ) indicates its priority to the left of the title.

n Normal - Topics with this priority follow Announcements and Sticky
topics. The Normal icon ( ) next to the topic indicates its priority.

Locking a Topic
Locking a Forum Topic prevents users from posting a reply to the Topic. For
example, you might create an announcement, but don’t want people replying to
it. Or, you might feel as though a topic has had enough discussion and want to
stop further replies.

If a Topic is locked, only Administrator user group members can post to it, or
edit or delete posts. Those users can post from the Web site or the Workarea.

To lock a Topic, follow these steps.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then a Forum from the folder structure.

3. Click a topic.

Locking a Topic
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4. Click the Properties button ( ).
5. Click the Lock Topic check box.

Note: To unlock a topic, remove the check mark from the Lock Topic check box.

6. Click Save ( ).

Viewing a Topic
Note: To learn about viewing a topic from your Web site, see Using Discussion Boards on
Your Web Site on page 7-622.

To view a topic from the Workarea, follow these steps.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then select a Forum from the folder
structure.

3. The Forum’s topics appear in the right frame. Click the one that you
want to view.

The View Topic screen displays each post within the topic. If a post is
surrounded by a yellow border (illustrated below), it must be approved before it
can appear on the Web site. Only users with Moderate permission can approve a
post. See Also: Assigning Permissions to a Discussion Board on page 7-613
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The following options may appear across the top of the screen, depending on
your permissions.

Button Description For more information, see

Delete topic and all of its posts Deleting a Topicon next page

View and edit the topic’s title and priority Editing a Topic's Title below

Return to previous screen

Under each post is a set of options that you may be able to perform on any
post, depending on your permissions and the status of the post.

If an option is underlined, you have authority to perform it. If not, you cannot.
For example, if a post’s status is approved, the approve option is not underlined
because it is already approved.

See Also:

n Approving a Post in the Workarea on page 7-602

n Adding a Reply to a Post on page 7-601

n Editing a Post on page 7-603

n Deleting a Post on page 7-603

Editing a Topic's Title
The only part of topic you can edit is its title.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then select a Forum from the folder
structure.

3. The Forum’s topics appear in the right frame. Click the one that you
want to edit.

4. Click the View Properties button ( ).
5. The Edit Topic screen appears. Modify the title as needed.

Editing a Topic's Title
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6. Click Save ( ).

Approving a Topic
A topic needs approval when a user without moderate permissions for the
Forum adds a Topic. To approve a Topic, follow these steps.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then select a Forum from the folder
structure.

3. The Forum’s topics appear in the right frame. Click the one that you
want to approve.

4. The View Topic screen appears.

5. Click the Approve Topic link (shown in red box above).

6. The Topic is approved.

Deleting a Topic
You can delete any Topic. When you do, its posts are also deleted. Once
deleted, they cannot be retrieved.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then select a Forum from the folder
structure.

3. The Forum’s topics appear in the right frame. Click the one that you
want to delete.

4. The View Topic screen appears.

5. Click the Delete link (shown in red box above).
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6. A confirmation message appears.

7. Click OK if you are sure you want to delete it.

Working with Posts
When a new Topic is created, the first post is created from the message of the
Topic. Essentially, all posts to the Topic are replies to the first.

This section also contains the following topics.

Adding a Reply to a Post 7-601
Approving a Post in the Workarea 7-602
Editing a Post 7-603
Deleting a Post 7-603
Attaching Images and Files to a Post 7-603
Attaching a File 7-604
Viewing an Attached File 7-604
Removing an Attached File 7-604
Searching a Forum’s Posts 7-605
Moving a Topic and Its Posts to Another Forum 7-605
Replacing Words in a Post 7-606
Using Regular Expressions 7-606
Adding a Replacement Word 7-607
Viewing Existing Replacement Words 7-608
Editing a Replacement Word 7-608
Deleting a Replacement Word 7-608
Creating and Editing Emoticons 7-608
Inserting Emoticon Images 7-609
Viewing Emoticons 7-609
Editing Emoticons 7-609
Deleting Emoticons 7-610
Creating Emoticons 7-610

Adding a Reply to a Post
Note: You can also reply to a post from the Web site. See Posting a Reply on page 7-624.

1. In the Workarea, click the Content tab

2. Select a Discussion Board, then select a Forum from the folder
structure.

3. The Forum’s topics appear in the right frame. Click the one that has
the post that you want to reply to.

4. The next screen, View Topic, displays all posts to the selected topic.

5. Find the post that you want to reply to by reading its text (illustrated
below).
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6. Click reply.

7. Enter a Title for the post.

8. In the Description field, enter the text of your post.

Approving a Post in the Workarea
When defining a Forum, you can check the Moderate Comments field. If you
do, posts to the Forum must be approved before they appear on the Web site.
Only users who are assigned the Moderate permission are allowed to approve
a post. See Also: Discussion Board Permissions on page 7-615

You can approve a post from the Workarea or the Forum on the site. See also
Approving a Post on page 7-626.

To approve a post in the Workarea, follow these steps.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then a Forum from the folder structure.

3. The Forum’s topics appear in the right frame. Click the one that has
the post that you want to reply to. (Unapproved posts have an
“Approval Needed” icon in the left column, as highlighted in red
below.)

4. The next screen, View Topic, displays all posts to the selected topic.

5. Find the post you want to reply to. Unapproved posts have a yellow
border (Illustrated below).

Managing Content in Ektron CMS400.NET

7-602 ReferenceManual
Version 8.01 Rev 4



6. Click approve under the post icon.

Editing a Post
You can edit the text of a post but you cannot edit its title.

Note: You can also edit a post from the Web site. See Editing a Post on page 7-626.

1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then a Forum from the folder structure.

3. The Forum’s topics appear in the right frame. Click the one that has
the post that you want to edit.

4. The next screen, View Topic, displays all posts to the selected topic.

5. Find the post that you want to edit.

6. Click edit under the post icon.

7. The Edit Reply screen appears. Within the editor, update the text as
needed.

8. Click Save ( ).

Deleting a Post
1. In the Workarea, click the Content tab.

2. Select a Discussion Board, then a Forum from the folder structure.

3. The Forum’s topics appear in the right frame. Click the one that has
the post you want to delete.

4. The next screen, View Topic, displays all posts to the selected topic.

5. Find the post that you want to delete.

6. Click delete under the post icon.

Attaching Images and Files to a Post
When creating a topic or post, you can add an attachment. In the Attached Files
field, A list of the files of files that will be attached appears, In addition, a list of
valid file extensions appear. The list of valid file extensions and maximum size
of the file upload are defined at the Discussion Board level. See Accepted
Extensions on page 7-581 and Max File Size on page 7-581.
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Attaching a File
To add an attachment to a topic or post, follow these steps.

1. Click the Attachments button below the editor.

2. The Attachments window appears.

3. Click the Browse... button to find the file.

4. Browse to the location of the file and select it.

5. Click Open.

6. Click the Attach button to attach the file to the post.

7. The file appears in the list of Current File Attachments.

8. Click the Close button.

Viewing an Attached File
To view an attached file, click its name in the post.

Removing an Attached File
To remove a file from the list of attachments, follow these steps.
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1. Click the Attachments button below the editor.

2. Highlight the attached item.

3. Click the Remove button.

4. Click the Close button.

Searching a Forum’s Posts
The Forum server control includes a search feature that lets site visitors search
through all posts on your site. Any user can access the search from the Forum
screen (see below).

When a site visitor clicks Search, he can search the current Forum (the default
value), select a different Forum, or search all Forums.

Moving a Topic and Its Posts to Another
Forum
If you want to move a topic and its associated posts in one forum to another,
follow these steps.

Prerequisite: The forum to which you want to move the topic and posts must
exist. See Creating a Forum on page 7-588.

1. Access a page on your Web site that has a login button.

2. Sign in as a member of the Administrators group or as a Moderator of
the board.

3. Navigate to a page with Discussion Board.

4. Select a forum from the Discussion Board.

5. Navigate to a topic page.

6. Click the Move to... dropdown list. (It appears in the right corner
above the posts.)
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7. Select the topic to which you want to move.

8. Confirm that you want to move all posts.

Replacing Words in a Post
You can configure Ektron CMS400.NET to replace unwanted words in a post. This
feature is useful for changing words that are obscene, indecent, or should not
appear on your site. In addition, Replace Words can fix commonly misspelled
words. For example, the can replace teh. See Also: Adding a Replacement Word
on the facing page

The Replace Words feature works with exact matches but does not append
words. For example, if you replace car with auto, the sentence I bought the car
from the cartel becomes I bought the auto from the cartel. Note that cartel did
not change to autotel even though the word car appears in cartel.

This feature is more fully explained through the following topics.

n Using Regular Expressions below

n Adding a Replacement Word on the facing page

n Viewing Existing Replacement Words on page 7-608

n Editing a Replacement Word on page 7-608

n Deleting a Replacement Word on page 7-608

Using Regular Expressions
If you would like the Replace Words feature to modify words that contain a
word you do not want used, you can use Regular Expressions. A Regular
Expression, often referred to as regex, is a pattern of metacharaters placed
around a word that describes a string. Used for string manipulation, regex
allows you to detail a succinct description of a group of words without having to
detail each word in the group.

Regular
Expression

Description

. Matchesany character, similar to a wildcard. For example, .ar matchesany three letter word
ending in ar, such as car, bar, tar or far.

| Acts asan or operator. For example, steak|stake would find steakor stake.

[ ]
Matchesone character that is between the brackets. For example, [rst] matches r, sor t. [d-g]
matchesd, e, f, or g. Another example, [bc]ar matchesbar and car. If you need tomatch a
dash (-), use it a the beginning or end of the group. For example, [xyz-] or [-xyz].
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Regular
Expression

Description

[^ ]
Matchesone character that is not in the group. For example, [^rst] matchesany character
other than r, sor t. Another example, [^bc]ar doesnot match bar or car, but doesmatch
words, such as tar or far.

^ Matches the beginning of any line. For example, ^[bc]ar matchesbar or car, but only at the
beginning of a line.

$ Matches the end of any line. For example, ^[bc]ar matchesbar or car, but onlywhen it
appears at the end of a line.

( ) Marksa sub expression. For example, alt(a|e)r findsaltar or alter.

* When an expression is followed by *, it matches zero or more versionsof the expression. For
example, [rst]* finds (blank), r, s, t, rs, sr, rt, tr, st, ts, rst, rts, srt, str, trsand tsr.

+
When an expression is followed by+, it matchesone or more versionsof the expression. This
differs from * because it doesnot match (blank). It must match at least one character. For
example, r+matches r, rr, rrr and so on.

{x,y}
Must match at least x timesand not more than y times. For example, s{2,4} matches ss, sss
and sss. You can also use {x} to specify an exact match. For example, s{3} matches sss. You
can use {x,} to specify that thematch is at least xamount of times. For example, s{4} matches
ssss, sssss, ssssssand so on.

? Must match the preceding character zero or one times. For example, Boa?rder matches
boarder and border.

Adding a Replacement Word
To add a replacement word to a Forum, follow these steps.

Note: In addition to using Replace Words for a specific Forum, you can access the Replace
Word feature from the Workarea > Settings > Configuration > Discussion Board > Replace
Words. If you have more than one Forum, this allows you select to which Discussion Boards
the Replace Words feature is applied.

1. In the Workarea, click the Content tab.

2. Select a Forum from the folder structure.

3. Click New > Replace Word.

4. The Replace Word screen appears.

5. Add the word to be replaced in the Old Word textbox.

6. Add the replace word in the New Word textbox.

7. Select the language for the Replace Word.

8. Click the Save button ( ).
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Viewing Existing Replacement Words
To view a list of existing words that are replaced, follow these steps.

1. In the Workarea, click the Content tab.

2. Select a Forum from the folder structure.

3. Click View > Replace Words.

4. A list of word to be replaced appears.

Editing a Replacement Word
1. In the Workarea, click the Content tab

2. Select a Forum from the folder structure.

3. Click View > Replace Words.

4. Click either the Old Word or the New Word to edit.

5. Click the Edit button ( ).
6. Change the Old Word, New Word or Language.

7. Click the Save button ( ).

Deleting a Replacement Word
1. In the Workarea, click the Content tab.

2. Select a Forum from the folder structure.

3. Click View > Replace Words.

4. Click either the Old Word or the New Word to delete.

5. Click the Delete button ( ).
6. A dialog box asks if you are sure you want to delete.

7. Click OK.

Creating and Editing Emoticons
An emoticon is an icon used to express emotion in a Forum post. For example,

.

There are two ways to insert an emoticon.

n A Forum participant clicks the emoticon toolbar button . Next,
a small window appears with available emoticons (shown below). The
user clicks one to insert it.
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n A Forum participant enters a few characters that resemble the

image. For example, to insert , the user enters O:\).

While working in a post, the user only sees the text. But when the
post is saved, Ektron CMS400.NET converts the text to the
corresponding emoticon. In all subsequent work with the post, users
see only the emoticon.

Viewing Emoticons below explains how to find the list of available emoticons
and the characters used to insert each one.

You can view and modify or delete a standard set of emoticons. You can also
create your own.

Inserting Emoticon Images
Place emoticon images in the following folder:
webroot\Workarea\threadeddisc\emoticons. Administrators reference these
files when editing or creating new emoticons.

Viewing Emoticons
A standard set of emoticons is supplied with Ektron CMS400.NET. After viewing
them, you can add new ones as well as delete or modify standard ones.

To see Ektron CMS400.NET’s emoticons, follow these steps.

1. Within the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Discussion Boards > Emoticons.

2. A list of emoticon images and text appears.

Editing Emoticons
To edit an emoticon, follow these steps.

Inserting Emoticon Images
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1. Within the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Discussion Boards > Emoticons.

2. Click the emoticon text or image that you want to edit.

3. Click the Edit button ( ).
4. Use the following table to guide you through the screen’s fields.

Fields on the Emoticons Properties Screen

Field Description

Emoticon
Text Enter or update the characters a Forum participant would enter to insert this emoticon.

Emoticon
Image

Enter the name of the image file that will appear after a user enters the above Emoticon text
and saves the post. Administrators place emoticon images in the
siteroot\Workarea\threadeddisc\emoticons folder.

Regex SeeUsing Regular Expressionson page 7-606

Language Select the emoticon’s language from the dropdown list. If a Forum is language-specific, only
emoticonsassigned to that language or all languagesare available.

See Also: Creating and Editing Emoticons on page 7-608

Deleting Emoticons
To delete an emoticon, follow these steps.

1. Within the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Discussion Boards > Emoticons.

2. Click the emoticon that you want to delete.

3. Click the Delete button ( ).

4. Reply to the confirmation message.

Creating Emoticons
To create an emoticon, follow these steps.

1. Within the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Discussion Boards > Emoticons.

2. Click the Add button ( ).
3. Respond to the fields on the screen. SeeEditing Emoticons on previous

page.

4. Click Save ( ).
See Also:Working with Posts on page 7-601
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Restricting an IP Address
If you are not using authentication for the Forums and want to block a site
visitor from posting to the Forum, you can use the Restricted IP feature to block
site visitors from posting to the Forum.

This section also contains the following topics.

Adding an IP Address the Restricted List 7-611
Editing a Restricted IP Address 7-611
Deleting a Restricted IP Address 7-612

Adding an IP Address the Restricted List
Note: In addition to using Restricted IPs for a specific Forum, you can access the Restricted IP
feature from the Workarea > Settings > Configuration > Discussion Board > Restricted IPs. If
you have more than one Forum, this allows you select to which Discussion Boards the
Restricted IPs are applied.

To add an IP address to the restricted list, follow these steps.

1. In the Workarea, click the Content tab.

2. Select a Forum from the folder structure.

3. Click New > Restricted IP.

4. Enter the IP Address to be blocked.

5. Click the Save button ( ).
6. A list of restricted IP addresses appear.

Editing a Restricted IP Address
1. In the Workarea, click the Content tab.

2. Select a Forum from the folder structure.

3. Click View > Restricted IPs.

Restricting an IP Address

ReferenceManual
Version 8.01 Rev 4

7-611



4. A list of restricted IP addresses appears.

5. Click the IP address to be edited.

6. Click the Edit button ( ).
7. Edit the IP address in the Block IP text box.

8. Click the Save button ( ).

Deleting a Restricted IP Address
1. In the Workarea, click the Content tab.

2. Select a Forum from the folder structure.

3. Click View > Restricted IPs.

4. A list of Restricted IP addresses appears.

5. Click the IP address to be deleted.

6. Click the Delete button ( ).
7. A dialog asks if you are sure you want to delete the restricted IP

address.

8. Click OK to continue.

9. A list of the remaining restricted IP addresses appear.

See Also: Restricting an IP Address on previous page

Setting Up Post Reporting
When you set up the Forum Post Reporting feature, it adds a Report button to
the bottom of each post. The button lets site visitors report posts to Forum
moderators. For example, users can report posts that are offensive or spam
posts.

When a user clicks the Report button, an email notification is sent to
moderators. A moderator can then view the post and decide whether to edit,
delete or leave the post. See Also: Reporting a Post on page 7-627

To set up a Forum for Post Reporting, follow these steps.
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Warning! Your Ektron CMS400.NETWeb server must be set up to send emails. See Configuring
email for Tasks and Content on page 1-83 .

1. In the Workarea, click the Content tab.

2. Select a Discussion Board from the folder structure.

3. Click View > Permissions.

4. Make sure Forum moderators have Moderate permission. See Also:
Assigning Permissions to a Discussion Board below

5. Click the Back button ( ).
6. Select a Forum.

7. Click the Properties button ( ).
8. Make sure the Moderate Comments box is checked. If it is not,

click the Edit button ( ) and check the Moderate Comments box.

9. Click the Save button ( ).

Assigning Permissions to a Discussion
Board
Like regular content folders, Discussion Boards have a permission table that
lets you determine which users can perform which functions. (To learn more
about folder permissions, see Folder Permissions on page 4-40.) Because
Discussion Boards have different functions than folders, their permission table
is slightly different.

In addition, each Forum has permission settings. By default, a Forum inherits
permissions from its parent Discussion Board. But, you can break this
inheritance and customize permissions for a Forum. If you break a Forum’s
inheritance, only the Forum’s permission table is checked -- the parent
Discussion Board’s permissions are ignored.

This section also contains the following topics.

Modifying a Discussion Board’s Permission Table 7-614
Initialization of Discussion Board Permission Values 7-614
Discussion Board Permissions 7-615
Discussion Forum Permissions for Membership Users 7-616
Granting Discussion Board Permissions 7-617
Removing Discussion Board Permissions 7-617
Editing Discussion Board Permissions 7-617
Assigning User Permissions to Forums 7-618
Setting a Forum’s Permission Table Values 7-618
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Modifying a Discussion Board’s Permission
Table
To access a Discussion Board’s permission table, navigate to and click the board
so it appears in the Workarea. Then, click View > Permissions.

Note: Only Administrators group members can access the Discussion Board Permission
Table.

Below is an example of a Discussion Board permission table for regular users.
Membership users have fewer permissions. See Also: Discussion Board
Permissions on the facing page

Initialization of Discussion Board Permission
Values
When you create a Discussion Board, Ektron CMS400.NET seeds its permission
table with values from the parent folder, as described in the following table.

Parent Folder Permission Discussion Board Permission

Read only Read only

Edit Edit Topic
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Parent Folder Permission Discussion Board Permission

Add Add Topic

Delete Delete Topic

Add Folders Add Forum

Edit Folders Edit Forum

Delete Folders Delete Forum

Note: Because there are no corresponding permissions for the Discussion Board’s Moderate
and Post/reply permissions, their initial value is blank.

So for example, if the user JSmith has permission to perform all functions for a
folder, and a Discussion Board is created in that folder, JSmith initially receives
all permissions listed above for the Discussion Board. However, you can edit
the permissions as needed.

As soon as you create a Discussion Board, it is disconnected from the parent
folder’s permission table. Subsequent changes to the parent’s permissions have
no effect on Discussion Board permissions.

Discussion Board Permissions
The following table lists all permissions that may be granted to regular users.
Only some permissions can be granted to membership users (that is, site
visitors who register to participate in the Forum).

Permission Give the user ability to

Can be
assigned to
membership
users

For more
information, see

Read only View Forumsand posts; cannot
submit a post Yes

Edit Topic Edit a topic’s title No Editing a Topic's Title
on page 7-599

Add Topic Add new topics Yes Adding a Topic to a
Forum on page 7-595

Delete Topic Delete a topic No Deleting a Topicon
page 7-600
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Permission Give the user ability to

Can be
assigned to
membership
users

For more
information, see

Post/Reply
Post a new topic or reply to an
existing one, either from the
Workarea or the site

Yes

Adding a Topic to a
Forum on page 7-595;

Adding a Reply to a
Post on page 7-601

Moderate

Warning! Everyone
who hasModerate
permission will receive
notificationswhen a post
is reported. See Also:
Reporting a Post on
page 7-627

Approve and delete posts and
topics. Also, receive notifications
when a post is reported using the
report post feature; only
applicable if the Forum’s
Properties fieldModerate
Comments is checked.

Yes Moderate Comments
on page 7-589

Add Forum Create a new Forum No Creating a Forum on
page 7-588

Edit Forum Edit a Forum No Editing a Forum on
page 7-590

Delete Forum Delete a Forum No Deleting a Forum on
page 7-590

Discussion Forum Permissions for
Membership Users
By default, membership users are assigned the following permissions:

n Read only

n Add Topic

n Post Reply

They cannot be granted Edit or Delete topic nor advanced permissions (Add,
Edit or Delete Forum). However, if a membership user creates a new topic, he
can delete it.

To change the default permissions, follow these steps.

1. Navigate to and click the Discussion Board so it appears in the
Workarea.

2. Click View > Permissions.

3. Click the User Type dropdown field and choose Membership
Users.
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4. The View Permissions for Board screen appears.

5. Add new member users and groups, remove them, or change their
permissions.

Granting Discussion Board Permissions
To give a CMS user or user group permissions to work with a Discussion Board,
follow these steps.

1. Navigate to and click the Discussion Board so it appears in the
Workarea.

2. Click View > Permissions.

3. Click the Add button ( ).
4. All users and groups who are not currently assigned permissions

appear. Click any user or group.

5. The Add Permission for Folder screen appears with the selected user
or group.

6. Assign appropriate standard and advanced permissions then click the
Save button ( ). See Also: Assigning Permissions to a Discussion
Board on page 7-613

Removing Discussion Board Permissions
To remove a user or user group from the Discussion Board permission table,
follow these steps. After you remove a user, Discussion Boards do not appear
in his Workarea.

1. Navigate to and click the Discussion Board so it appears in the
Workarea.

2. Click View > Permissions.

3. Click the Delete icon ( ).

4. Select a user or group that you want to remove from the Permission
table.

5. A confirmation message. Click OK.

6. The user is removed.

Editing Discussion Board Permissions
To edit a user or user group’s Discussion Board permissions, follow these steps.
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1. Navigate to and click the Discussion Board so it appears in the
Workarea.

2. Click View > Permissions.

3. Click the user or group whose permissions you want to edit.

4. The Edit Permissions screen appears.

5. Change the settings as appropriate. See Also: Discussion Board
Permissions on page 7-615

6. Click the Save button ( ).

Assigning User Permissions to Forums
You can use all of the permission features available to Discussion Boards with
any Forum. To access a Forum’s Permission Table, follow these steps.

1. Open CMS Workarea > Content.

2. Click the Forum.

3. Click the View Permissions button on the Contents of Forum screen
(circled below).

4. A Permission Table appears. See Also: Discussion Board Permissions
on page 7-615

Setting a Forum’s Permission Table Values
A Forum initially inherits (that is, copies all permissions from) its parent
Discussion Board’s permission settings.

When you first view a Forum’s permission table, you see these settings plus a
check box that allows you to maintain the inheritance or break it (circled
above).
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If you break inheritance by unchecking the Allow this object to inherit
permissions box, the Forum permission screens change from view-only to
edit. At this point, you can modify the Forum’s permissions as needed.

To later restore inheritance, check the box. When you do, the parent Discussion
Board’s permissions overwrite any Forum-specific changes. The Forum then
reverts to a read-only state. Any permission changes must be made at the
Discussion Board level while inheritance is enabled.

Sending Notifications When a New
Forum Topic or Post is Created
The Discussion Board’s Email Notification feature enables Ektron CMS400.NET
to generate email for a list of registered users whenever a new forum topic or
post is created.

For example, anyone may register to be notified whenever a new forum topic
or post is created. As soon as the new forum topic or post is created on the
discussion board, registered users receive an email announcement with a link
to the new topic or post. The recipient clicks the link and immediately accesses
the page.

As a result, a self-selected group of users can be instantly notified when user’s
post information to your discussion board relating to their interests. Once the
messages are set up, you don’t need to do anything -- everything happens in
the background.

This section also contains the following topics.

Sample Discussion Board Email Notification 7-620
Creating the Email Message 7-620
Including Variables in the Default Message 7-620
Inserting the Forum Server Control 7-621

Sending NotificationsWhen a New ForumTopic or
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Sample Discussion Board Email Notification

See Also: Creating the Email Message below

Creating the Email Message
You can create an email message to be sent when a new post is added to the
discussion board or when a new topic is added. A simple editor lets you apply
some XHTML formatting the message.

Including Variables in the Default Message
The messages can include variables that retrieve information about the new
post or topic and display it in the message text. The variables are surrounded
by at signs (@). For example:

@appPosterDisplayName@ has created a thread you have subscribed to.

In the email, this text might read:

Alan Administrator has created a thread you have subscribed to.

You can use the following variables in the body of an email notifications.

Variable Displays this information in the email

@appTopicTitle@ The title of the topic.
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Variable Displays this information in the email

@appTopicId@ The integer ID of the topic.

@appRecipientDisplayName@ The displayname of the person receiving the email.

@appRecipientId@ The recipient’s integer ID.

@appRecipientFirstName@ The first name of the person receiving the email.

@appRecipientLastName@ The last name of the person receiving the email.

@appRecipientEmail@ The email addressof the person receiving the email.

@appHostUrl@ The host site’sURL.

@appForumUrl@ The forum’sURL.

@appPostMessage@ The text of themessage that wasposted to the discussion board.

@appPosterId@ The integer ID of the person who created the post.

@appPosterDisplayName@ The displayname of the person who created the post.

@appPosterProfileUrl@ The profile URL for the person who created the post.

@appPostUrl@ TheURL of the post on theWeb site.

To create a message, follow these steps.

1. In the Workarea, go to Settings > Configuration > Discussion
Boards > Messages.

2. Click the Add button ( ).
3. Enter a title that describes the message.

4. At the Type field, select either NewForumTopic or ForumPost.

5. Select whether to make the email message a Default message.

6. In the editor, enter the message text. Use the variables listed in the
table above to retrieve information about the about the new post or
topic and display it in the message.

7. Click the Save button ( ).

Inserting the Forum Server Control
After creating at least one hierarchy of Discussion Board elements, place a
Forum server control on a Web page. See Forum Server Control on page 7-640.

If you want require site visitors to authenticate, the web page that hosts the
Forum should also contain
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n a Membership server control (or a link to page that has one). This
lets site visitors/membership users register for Discussion Boards.

n a Login server control that lets the site visitor/membership user log
in

Note: Ektron recommends adding text below the Login server control to remind the site visitor
to enter his email address at the User field. For example, “At the User field, enter your email
address.”

Inserting Discussion Board Server
Controls
Ektron CMS400.NET provides three server controls for use with the Discussion
Boards. See Discussion Board Server Controls on page 7-639.

Inserting the Forum Server Control
After creating at least one hierarchy of Discussion Board elements, place a
Forum server control on a Web page. See Forum Server Control on page 7-640.

If you want require site visitors to authenticate, the web page that hosts the
Forum should also contain

n a Membership server control (or a link to page that has one). This
lets site visitors/membership users register for Discussion Boards.

n a Login server control that lets the site visitor/membership user log
in

Note: Ektron recommends adding text below the Login server control to remind the site visitor
to enter his email address at the User field. For example, “At the User field, enter your email
address.”

Using Discussion Boards on Your Web
Site
This section explains what can be done when using a Discussion Board on your
site.

This section also contains the following topics.

Approving a Topic 7-623
Sorting Topics 7-623
Deleting a Topic 7-624
Posting a Reply 7-624
Quoting a Post 7-625
Editing a Post 7-626
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Approving a Post 7-626
Deleting a Post 7-627
Reporting a Post 7-627
Adding Video to a Post 7-627
Suppressing User Information from the Forum Profile Display 7-628
Information Contained in the Profile 7-629
How Users Suppress Profile Information 7-629
How Administrators Suppress Profile Information 7-630
Outputting a Forum as an RSS Feed 7-630
Subscribing to a Discussion Board 7-631
Reviewing Subscriptions 7-632
Deleting a Subscription 7-632
Sending a Private Message 7-632
Using the Control Panel 7-633
Viewing and Replying to Messages 7-634
Deleting a Private Message 7-635
Viewing a User Profile From the Control Panel 7-636
Moderating From the Control Panel 7-636

Approving a Topic
A Topic needs to be approved when a user who does not have moderate
permission for the Forum adds a Topic. When you view topics on the site, any
that need approval are highlighted with a different color background.

From this screen, you can click the Approve link next to the topic’s title. You
could also click the Topic’s title to view it and click the Approve button (

) on that screen.

Sorting Topics
Topics can be sorted by the columns of a Forum. To sort a Forum:

1. Go to the Web page that hosts the Discussion Board.

2. Click the Forum of interest.

3. Click any of the column titles to sort by alpha or numerical order.
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On the first click, items are sorted first by any numeric (1-10) values, then by
alpha values (A to Z). Clicking a column title a second time sorts the items in
reverse.

When the page is first viewed, the list is sorted by Last Post.

Deleting a Topic
Topics on the site can be deleted from a Forum by the users who created them
or by users with the Moderate permission. This includes Membership users. See
Also: Moderate on page 7-616 and Discussion Board Permissions on page 7-615.

Warning!When you delete a topic, any replies or posts associated with the topic are also
deleted.

To delete a topic:

1. Go to the Web page that hosts the Discussion Board.

2. Click the Forum of interest.

3. Click the topic you wish to delete.

4. Click Delete Topic.

5. A dialog appears asking you to confirm the deletion.

6. Click OK.

The topic and all associated posts and replies are deleted.

Posting a Reply
1. Go to the Web page that hosts the Discussion Board.

2. Click the Forum of interest.

3. Click Add Reply.

Note: If a topic is moderated, a message appears stating that your reply is pending moderator
approval.
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There are two editors that site visitors can use when replying:

n eWebEditPro (scaled-down version)

n eWebEdit400

For users who sign in before posting, this decision is made for the user at the
Forum Editor field on the Edit User screen.

If users does not sign in, eWebEdit400 is the editor.

If a site visitor is using an Apple Macintosh computer, eWebEdit400 is the editor
regardless of the Forum Editor field value on the Edit User screen.

Quoting a Post
Quoting a post’s comments means that your reply begins with the original
post’s comments. You can then add your comments and even edit the quoted
post, so that you can include only the portion on which you are commenting.

To quote a post, follow these steps.

1. Go to the Web page that hosts the Discussion Board.

2. Click the Forum of interest.

3. Click a Topic.

4. Find the post you want to quote.

5. Click the Quote button.

6. The editor appears with the quoted information at the top of the text
area.

7. Add your comments below the quote.

8. Click Post.
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Editing a Post
1. Go to the Web page that hosts the Discussion Board.

2. Click the Forum of interest.

3. Find the topic you want to edit.

4. Click Edit.

Approving a Post
When defining a Forum, you can check the Moderate Comments field. If you
do, posts to the Forum must be approved before they appear on the Web site.
Only users who are assigned the Moderate permission are allowed to approve
a post. See Also: Discussion Board Permissions on page 7-615

You can approve a post from the Workarea or the Forum on the site. See also
Approving a Post in the Workarea on page 7-602.

To approve a post from the Forum, follow these steps.

1. Log into the site.

2. Navigate to the Forum.

3. Click the Moderate button ( ).
4. The Forum’s Control Panel appears.

5. Click the topic.

6. The topic appears. Posts requiring approval have an Approve button (

).
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7. Click the Approve button ( ).
8. A screen appears stating that the post has been approved.

9. The post now appears on your Web site.

Deleting a Post
1. Go to the Web page that hosts the Discussion Board.

2. Click the Forum of interest.

3. Find the topic you want to delete.

4. Click Delete.

Reporting a Post
You can allow site visitors to inappropriate report posts, such as spam or
offensive posts.

When a site visitor clicks the Report Post button (located at the bottom of the
post), an email notification is sent to all Forum moderators. Any moderator can
review the post and decide to edit, delete, or leave it alone. See Also: Using
Discussion Boards on Your Web Site on page 7-622

Adding Video to a Post
A user can add video to a post by clicking the Add Video button ( ) in a Forum
post using eWebEdit400. The following prerequisites must be in place for a user
to perform this action:

n the embed tag must be added to the Accepted HTML property in the
Workarea Forum’s properties. See Also: Accepted HTML on page 7-
581.

n a user must be using eWebEdit400 See Also: Using eWebEdit400 on
page 7-29

n the video must be in the .wmv format

n the video must reside in a hosted location. For example,
http://www.example.com/myvideos/fridaylunch.wmv
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Once you click the Add Video button ( ), enter the path to the video in the
dialog box and click OK. A place holder is then added to the post.

Suppressing User Information from the
Forum Profile Display
Anyone browsing to a Discussion Forum can view information about its
contributors by clicking the user name, as shown below.
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However, if the Forum server control’s HideUserProfile property is true,
non-administrator users cannot see the profile, even if the Private Profile
setting is set to Public. For more information, see How Users Suppress Profile
Information below and How Administrators Suppress Profile Information on
next page.

Administrators can see the profile, regardless of how the HideUserProfile
property is set.

Information Contained in the Profile
The profile contains the following information about a user:

n First Name - the first name of the user

n Last Name - the last name of the user

n Email - the email address of the user

n Joined - the date the user joined

n Last Visit - the date the user last visited the site

n Number of Posts - the amount of posts a user has contributed

n Post History - a list of posts the user has contributed

How Users Suppress Profile Information
Users can determine if their profile is viewable via the Private Profile drop
down box on the Membership Registration screen (shown below) and the Edit
Profile screen. If Private Profile is set to Private, profile information is
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suppressed. If it is set to Colleagues, only a user’s colleagues can see his
profile. When set to public, everyone can see a user’s profile information.

Note: If the Forum server control’s HideUserProfile property is set to true, non-
administrator Forum visitors cannot see a user profile, even if the Private Profile drop down
box is set to Public.

Note: The Membership Registration screen appears wherever your developer inserts the
Membership Server Control. For more information, see Membership Server Control on page
16-19.

How Administrators Suppress Profile Information
If you want to suppress the display of user names as an administrator, follow
these steps.

Note: If the Forum server control’s HideUserProfile property is set to true, non-
administrator Forum visitors cannot see the profile, even if the Private Profile check box is
unchecked.

1. If the user is a regular user, go to Settings > Users and select the
user whose information you want to suppress.

If the user is a membership user, go to Settings > Community
Management > Memberships > Users and select the user whose
information you want to suppress.

2. In the User Properties area of the screen, check the Private Profile
checkbox.

Outputting a Forum as an RSS Feed
You can output a Forum as an RSS feed by clicking the RSS feed button ( ).
Each level of the Forum has an RSS feed button. This allows you to output a
specific topic as an RSS feed.

This following is an example of the output.
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<?xml version="1.0" encoding="UTF-8" ?>
- <rss version="2.0">
<!-- Generated byEktron CMS400.NET -->
- <channel>
<title>Ektron Medical Center Forum</title>
 <link>http://test/webform.aspx</link>
<description>Ektron Medical</description>
- <item>

<title>Research</title>
<link>http://test/webform.aspx?g=topics&f=108</link>

- <description>
<![CDATA[ Latest medical research ]]>
</description>
<pubDate>Wed, 11 Oct 2006 17:50:04 GMT</pubDate>
</item> </

channel>  </
rss>

Subscribing to a Discussion Board
After logging in, discussion board users can subscribe to Forum posts and
replies by clicking the Subscribe button ( ) (highlighted below).

The button appears at each Discussion Board level, so that a user can subscribe
to Forums and topics of interest. After clicking the button, the following screen
appears.

The user selects a notification type, listed below.

n All Posts - notifies you when any post or reply is added

n Replies to Me - notifies you when someone replies to your post
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Next, he clicks the Add Subscription button. A page notifies him that his
subscription was added.

Reviewing Subscriptions
To review your Forum subscriptions, go to the Control Panel and click
Notifications in the lower left corner. A screen indicates each Discussion
Board level to which you have subscribed, as illustrated below.

Deleting a Subscription
To delete any subscription, check the corresponding check box and click the
Delete button (highlighted above).

Sending a Private Message
Logged in users can send a private message to the person who created a post or
reply. Only the sender and receiver can view private messages. This requires
both users to be either a CMS400.NET user or a Membership user.

To send a private message, follow these steps.

1. Navigate to a post.

2. Click the User’s name.

3. When the User Profile appears, click the Message button.
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4. The Message screen appears.

Note: The To: field is filled automatically. Users cannot add additional members.

5. Enter a Subject.

6. Enter a Message.

7. Click the Post button.

8. Users are notified that a message was sent.

Using the Control Panel
The Control Panel allows logged in users to view your profile, read, reply to and
delete private messages. It also allows users with moderate permissions to
moderate the Forum. The Control Panel button is located at the Forum level.

Clicking the Control Panel button opens control panel.

Using the Control Panel
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The Inbox view appears by default. From this view, users can read a message
by clicking on it. Once a message is read, its icon changes from unread ( ) to
read ( ).

In addition, users can view information about the person who sent the message
by clicking their name. Users can also delete the message by clicking the
corresponding check box then the delete button. To switch to a different view,
click its link.

The user can also check his subscriptions. See Reviewing Subscriptions on page
7-632.

Viewing and Replying to Messages
From the Inbox or Sent Items in the Control Panel, users can view a message
by clicking on it. On the View Message screen, users can see who sent the
message, to whom the message was directed, when it was sent, the subject and
the contents of the message.

Users can reply to a message by clicking the reply button ( ). Once clicked,
the editor opens in the control panel, and a user can reply.

Warning!When replying to a private message, users add their response to the existing message.
Only one message is created.
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Once a user adds a reply to the private message, he clicks the Post button. He
is then informed that the message was sent.

Deleting a Private Message
To delete a private message, follow these steps.

1. Click the Control Panel button on the front page of the Discussion
Board.

2. Click the check box next to the message.

3. Click the Delete Selected button.
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4. A confirmation box asks if you want to delete all selected messages.
Click OK.

5. The message is deleted.

Viewing a User Profile From the Control Panel
To view a profile from the Control Panel, click the Profile link in the Control
Panel. See Also: Information Contained in the Profile on page 7-629

Once the Profile link is clicked, the user’s profile page appears.

Moderating From the Control Panel
Users who have permission to moderate a Forum can do so from the Control
Panel by clicking the Moderate link.
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Once Moderate is clicked, the user sees a list of items that need approval.

Clicking an item opens the post. From this screen, you can edit, approve, or
delete the post. See Also: Approving a Post on page 7-626.

Using Discussion Boards in Community
Groups
Community groups can have their own discussion board. This provides a forum
for community-based discussions that are limited to the forum members.

All Discussion Board features are available to a forum in a community group.
However, only one step is needed to first create a Discussion Board in the
database.

The following example shows a discussion forum on a community group page.
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Creating a Community Discussion Board in
the Database
To use a group discussion board, you must first add the group discussion forum
into the database. Each group needs to do this one time when they decide to
have a discussion forum for their group.

Add a group discussion forum database by following these steps.

1. Log in to your Web site.

2. Navigate to your group web page.

3. Click the Edit Group link.

In this example, the Edit Group link (circled below) is located on this
group profile page of the eIntranet Starter Site.
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4. The Edit Group Link window appears

5. Check the Create Group Forum checkbox (circled below) to create
a group forum in the database.

Important: After the group forum database is created, you cannot uncheck this option.

6. Click the Save button ( ).
Now a group forum exists in the database and can appear on the group page.

Discussion Board Server Controls
The Discussion Board feature provides a forum where topics can be discussed
on your Web site. A CMS or membership user with Add Topic permission
creates a topic and posts a starter question. Any site visitor can then reply.

Ektron provides three server controls for use with Discussion Boards.

n Forum Server Control on next page - use to place a Discussion Board
on a Web page

n ActiveTopics Server Control on page 7-650 - use to display the most
active or most recent topics and posts

n PostHistory Server Control on page 7-652 - use to display a list of
posts for a user

For more information about Discussion Boards, see Discussion Boards on page
7-576. When using the Forum server control, see Inserting the Forum Server
Control on page 7-622.
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Forum Server Control
Warning! After placing a Forum server control on a page, follow the procedure described in
Updating the Page Command on page 7-647. Otherwise, the user may get an error when posting
a reply.

The Forum server control displays a Discussion Board on a Web page.

This section also contains the following topics.

Forum Server Control Properties 7-640
Updating the Page Command 7-647
Using a Custom Theme 7-647
Adding Video to a Post 7-648
Adding and Removing Toolbar Items From the Editor 7-648

Forum Server Control Properties
Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Value Data Type

AllowAnonymousPost

Set to True to allow site visitors the option of
posting anonymously to the forum.When true, aPost
Anonymous checkboxappears above the text editor used to
create a post.

If a site visitor addsa checkmark to this box, the word
Anonymousappearswhere the DisplayName normally
appears. The default isTrue.

True - make the Post Anonymouscheckboxavailable to site
visitorswhen they create a post.

False - disable Post Anonymouscheckbox.

Boolean

Authenticated Indicates if you are logged in to CMSExplorer and can use it to
browse to Content, Collections, etc. Boolean

BoardID

The ID of the Discussion Board to display on this page if one is
not defined in a query string parameter.

If you don’t know the ID, click the Ellipsesbutton ( ), then
sign in and select a Discussion Board.

Long

CacheInterval

Sets the amount of time, in seconds, a server control’s data is
cached. The default is 0 (zero).

For example, if you want to cache the data for fiveminutes, set
this property to 300. See Also:Caching with Server Controls
on page 24-33

Double

CustomOrderBy

Provide a property’s FriendlyName defined in the Indexing
Service to order search results by that property. For example,
if you define DocAuthor, resultswill be sorted by the
document’s author. Results can be ascending or descending
based on OrderDirection. If you enter an invalid property,
no search results are returned. If you specify both
CustomOrderByand OrderBy, the OrderByproperty is
ignored. The FriendlyName of a property can be found in
Computer Management >Services and Applications >
Indexing Service >Your Index >Properties >Friendly
Name column.

String
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Property Value Data Type

DefaultObjectID The Static ID of a community group. Long

DynamicForumParameter
Gets or sets the QueryString parameter to read a forum ID
dynamically. The default is “f”. Note that a Forum residesone
level below aDiscussion Board.

String

DynamicGroupParameter Gets or sets the QueryString parameter to read a group’s ID
dynamically. The default is “g”. String

DynamicObjectParameter DynamicParameter for the community group id. Default is
“id”. String

DynamicParameter

Gets or sets the QueryString parameter to read a discussion
board’s ID dynamically. Set to “None - Use Default” if you
want to alwaysdisplay the default discussion board. Note that
a Discussion Board is one level above a Forum.

boardid - readsa Threaded Discussion Board’s ID
dynamically.

None - Use Default - use the default discussion board’s ID.

ID - readsa discussion board’s ID dynamically.

String

DynamicThreadParameter

Gets or sets the QueryString parameter to read an individual
thread’s ID dynamically. The default is “t”. Note that a Thread
resides two levels below aDiscussion Board and one level
below a Forum.

String

EditorCSS

Set the style sheet for the Editor when a site visitor createsor
edits a post. Bydefault, this property is blank.When a style
sheet is not supplied, the style sheet defined in the Theme
property is used.

String

EditorToolbar

Enter a comma separated list of items that you want to appear
on the Editor’s toolbar. The default is
StyleMenu,FontMenu,ParagraphMenu,
TextFormatMenu,LinkMenu,ClipBoardMenu,
SymbolsMenu,EmoticonSelect,WMV,Table

See Also:Adding and Removing Toolbar ItemsFrom the
Editor on page 7-648.

String

EnableForumQuickSelect

If you set this property to true, a dropdown list of all forums
appears below the Topic list.

The site visitor can click a forum and jump immediately to it.

Boolean
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Property Value Data Type

EnableThreadRating

If you set this property to true, a ContentReview server
control appears on any topic screen run by this server control.
The site visitor can use the control to rate the topic thread.

An average rating for the thread appears next to each topic on
the forum screen.

Boolean

ExcludeList

Enter a comma-separated list of custom user properties to
exclude from the Forum’s profile page. For example, to
suppress theSubscriptions field value, enter
subscriptions.

See Also:CustomUser Propertieson page 15-12 and
Suppressing User Information from the ForumProfile Display
on page 7-628

String

FilterXslt

Enter the path to an XSLT file used to filter forum content,
such as, HTMLAttributes, Tagsand unwanted words in a
user’s forum post. This path can be relative or absolute. The
user’s post is filter once he clicks theSubmit button.

Bydefault, this property points to <webroot>/<siteroot>
/Workarea/Xslt/ForumFilter.xslt

The above file removeshrefswith javascript:, vbscript: and
“on” events in the link. You canmodify this file or create a new
one.

Warning! If you want to edit this file, it is strongly
recommended that youmake a copy, change its name and
move it outside of your Web site’sWorkarea folder. If you
make changes to this file and do not move it out of the
Workarea folder, this file and the changeswill be lost when
you upgrade.

For additional sample code used to create a filter XSLT, see
the following KBarticle:

http://dev.ektron.com/kb_article.aspx?id=485

String
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Property Value Data Type

Hide Select False to display this server control on the page. Select
True to suppress it. Boolean

HideUserProfile

Set to True to suppressuser profiles. The default isTrue.

True - hidesuser profiles from non-administrator users.

False - displaysuser profiles from non-administrator users.
However, an administrator can view a profile regardlessof
how this property is set.

On the other hand, if thePrivate Profile is set to Private for
anyuser, his profile information is not visible, regardlessof this
setting. If Private Profile is set to Colleagues, only colleagues
can see profile information.

When the profile is visible, only properties and their valuesnot
listed in the ExcludeListproperty (above) appear.

For more information, seeSuppressing User Information
from the ForumProfile Displayon page 7-628.

Boolean

JavascriptEditorHeight Set the height in pixels for the eWebEdit400 content designer.
The default is400. Theminimum height is 300. Integer

JavascriptEditorHTMLMode

Note: Asof version 7.6, the JavaScript editor hasbeen
removed from Ektron CMS400.NET. This property has
been deprecated.

Set to True to allow users to edit their posts and replies in
HTML. The default isFalse.

String

JavascriptEditorToolbar

Note: Asof version 7.6, the JavaScript editor hasbeen
removed from Ektron CMS400.NET. This property has
been deprecated.

Decide which buttonsare available in the JavaScript Editor.

String

JavascriptEditorWidth Set the width in pixels for the eWebEdit400 content designer.
The default is625. Theminimumwidth is 500. Integer

Language

Set a language for viewing content. This property shows
results at run-time (in a browser).

Setting this property to -1 (negative one) causes the Forum
server control to display topics from all available languages.

Integer

ObjectType

Describes the type of forum displayed by this server control.

CommunityGroup - Used for forums inside a Community
page.

DiscussionBoard - Used for forumson templates that are
not Community pages.

String
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Property Value Data Type

OrderBy

The order of search results. For example, you want to sort
search results by last modified date.

Title - The content title (alphabetical).

ID - The content ID number.

Date Created - The date the content was created.

Date Modified - The date the content wasmost recently
modified.

Editor - The user who last edited the content (alphabetical).

Rank - The rankassigned to the content. See Also:Search
Result Ranking on page 9-32

Note: TheOrderDirection field determines the direction
of the search results. For example, if you sort by ID and
OrderDirection is set toDescending, the results sort by
ContentID number with the highest number at the top of
the list.

Warning! Specifying a CustomOrderBy property overrides
this property.

String

OrderDirection

The direction in which search results are sorted. The default is
Ascending.

Ascending - Alphabetical results from A to Z; numeric values
low to high; dates from oldest to most recent

Descending - Alphabetical results from Z to A; numeric
valueshigh to low; dates frommost recent to oldest

String

ProfileLink

Enter a link to the user’s social networking profile page, a part
of ektron’s community platform. This allowsa user to click
another user’s name link or avatar and be taken to the user’s
profile page. There are two variablesused within the link that
represent the user’s ID and the user’s display name.

{0} - represents the user’s ID.

{1} - represents the user’s display name.

You need to have both variables in the link. TheWeb form can
be relative or absolute. Below is an example.

userprofilepage.aspx?uid={0}&dn={1}

The default for this property is?g=profileu={0}.

When the default for this property is used, users are
forwarded to a user’s profile page that is included with the
forum control.

ItemLinkTargets
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Property Value Data Type

ProfileLinkTarget

Determines the type of window that appears on thisWeb form
when a user clicks an item in the Friends control. The default is
_self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

String

ShowCategories

If set to true, when this server control appears, the user see a
Filter by Category option. This option helpsa site visitor
zero in on relevant content.

If false, the Filter by Category option doesnot appear.

See Also: Filtering Search Results byCategoryon page 9-84

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the
control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TaxonomyCols

Use this property to determine the number of columnson the
Taxonomyscreen available from thisDiscussion Board.

In the illustration below, taxonomycategories are arranged in
three columns (the default value).

Integer

TaxonomyMarkupLanguage

If you want to use an .ekml file to format the Taxonomyscreen
available from thisDiscussion Board, enter it here.

If the *.ekml file is located in the same folder as theWeb form
containing the server control, just enter its name. If the file is in
another folder, enter the path relative to site root. For
example, \CMS400Developer
\workarea\customfiles\markup\mylistsummary.ekml.

See Also:Controlling Output with EktronMarkup Language
on page 26-1

String
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Property Value Data Type

Theme

Enter the custom theme’s folder name. The theme can be
relative to the site root or located in the current folder. For
example:

Relative - Theme=”/workarea/csslib/themes/winter”

Current Folder - Theme=”mytheme”

If you do not specify a theme, the property uses the location
defined by the Discussion Board’sCSS theme property in the
Workarea.

See Also:Using a Custom Theme below

String

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion
of an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes
to a blockof code.

Custom - Lets you use custom tag.

String

Updating the Page Command
To prevent an error from appearing when a user posts a reply to the Web page
that hosts the Forum server control, follow these steps.

1. Open the Web form onto which you inserted the Forum server
control.

2. Access Source view.

3. Go to the top line of the Web form, which begins with @ Page.
<%@ PageLanguage="VB"AutoEventWireup="false"
CodeFile="Default2.aspx.vb"Inherits="Default2" %>

4. Near the end of the line, enter validaterequest=false.

5. Build the page.

Using a Custom Theme
This property allows you to specify a custom location for your themes. By doing
so, you prevent them from being overwritten when you upgrade.

If you do not specify a theme in the server control, Ektron CMS400.NET uses
what is defined in the Discussion Board’s properties CSS Theme field located
in the Workarea.

To create a custom theme, follow these steps.

1. Create a new subfolder on your site. In this example, we use a
winter theme:

Updating the Page Command
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<web root>/<your site>/Workarea/csslib/winter.

2. Copy all files in the /Workarea/Threadeddisc/themes folder to the
winter folder.

3. Change the image files to match your theme.

Note: To find the name of an image, right click on it while viewing it in a browser. Next, select
properties. The name appears at the top of the dialog box.

4. Change the Discussion Board’s .css file to match your theme and save
it with a custom name. (You do not need to do this if an existing .css
file meets your theme’s needs.)

Important: Make sure the CSS theme property in the Workarea is pointing to the proper CSS file.
See Also:Working with Discussion Boards and Subjects on page 7-579

5. View the Discussion Board in a browser to see the changes.

Adding Video to a Post
A user can add video to a post by clicking the Add Video button ( ) in
eWebEdit400. The following prerequisites must be in place for a user to perform
this action:

n the embed tag must be added to the Accepted HTML property in the
Workarea Forum’s properties. See Also:Accepted HTML on page 7-581

n a user must be using eWebEdit400

n the video must be in the .wmv format

n the video must reside in a hosted location. For example,
http://www.example.com/myvideos/fridaylunch.wmv

Once you click the Add Video button ( ), enter the path to the video in the
dialog box and click OK. A place holder is then added to the post.

Adding and Removing Toolbar Items From
the Editor
Warning! You cannot create new buttons and add them to the Forum Editor. You can only add
and remove existing buttons.

Toolbar items on the Forum Editor can be added and removed by editing
EditorToolbar property. This property contains a series of string values that
represent each item, listed below.
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String Value Item Description

StyleMenu
Displaya list of paragraph styles. Users can
select from the list to apply a style to selected
text.

FontMenu Displaya list of available font styles, sizesand
colors.

ParagraphMenu

Controls the display of buttons that affect a
paragraph. This includes:

n Numbered List

n Bullet List

n Outdent

n Indent

n Align Left

n Align Center

n Align Right

n Justify

n HorizontalRule

TextFormatMenu

Controls the display of buttons that format text.
This includes:

n Bold

n Italics

n Underline

LinkMenu

Controls the display of buttons that allow a user
to add and remove hyperlinks links and workwith
the library. This includes:

n HyperlinkManager

n Remove Link

n Library

ClipBoardMenu
Controls the clip board buttons that allow a user
to cut, copyand paste content. This item also
controls the Undo and Redo buttons.

Adding and Removing Toolbar Items From the
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String Value Item Description

SymbolsMenu
Controls the display of the Symbol button which
allowsusers to insert symbols and special
characters.

EmoticonSelect Controls the display of the Emoticon button.

WMV Controls the display of the InsertWMVbutton.

Table Controls the display of the Insert table button.

ActiveTopics Server Control
The ActiveTopics server control displays either the most active topics for a
forum or the most recent ones. The most active are determined by how many
new posts are added to a topic or how many replies a post receives. The most
recent are determined by the date of the post.

Below is an example of two ActiveTopics server controls. One control is set to
Active, the other is set to Recent.

The items in the list are clickable links, which open to the topic.

ActiveTopics Server Control Properties
Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Value Data Type

Authenticated Indicates if you are logged in to the CMSExplorer and can use it
to browse to Content, Collections, etc. Boolean

BoardID

The ID of the board fromwhich to get entries.

If you don’t know the ID, click the Ellipsesbutton ( ), then
sign in, browse to, and select a Discussion Board.

Long

CacheInterval

Sets the amount of time, in seconds, the server control’s data is
cached. The default is 0 (zero). For example, if you want to
cache the data for fiveminutes, set this property to 300. See
Also: Caching with Server Controlson page 24-33

Double

DisplayMode

Choose between Active or Recent. In Activemode, the server
control displaysa list of themost active posts. In Recent mode,
the server control displaysa list of recently added posts. The
default isActive.

Active - display a list of themost active posts.

Recent - display a list of the recently added posts.

eDisplayMode

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if
you want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes
shown.

Boolean

Hide Select False to display this server control on the page. Select
True to suppress it. Boolean

Language Set a language for viewing content. This property shows results
in design-time (in VisualStudio) and at run-time (in a browser). Integer

MaxNumber Themaximum number of topics listed. The default is10. Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.
The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

ActiveTopics Server Control Properties
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Property Value Data Type

URLPath

Enter the path to the Forum server control’sWeb page. For
example:

http://<your site>/siteroot/forum.aspx.

or

/CMS400Developer/forum.aspx.

If your Forum page and your Active Topics page are in the
same folder, you can just enter the name of the page. For
example:

forum.aspx.

String

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of
an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes
to a blockof code.

Custom - Lets you use custom tag.

String

PostHistory Server Control
The PostHistory server control displays a list of forum posts for a given user.
The posts are displayed in order by date and contain the following:

n Topic - the topic that contains the post

n Posted - the date the post was created

n Content - the content within the post

PostHistory Server Control Properties
Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Value
Data
Type

Authenticated Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. Boolean

BoardID

The ID of the Discussion Board fromwhich to get a user's posts.

If you don’t know the ID, click the Ellipsesbutton ( ), then sign in,
browse to and select the Discussion Board.

Long

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
this property to 300 (three hundred). See Also:Caching with Server
Controlson page 24-33

Double

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

Hide Select False to display this server control on the page. Select True to
suppress it. Boolean

Language Set a language for viewing content. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

MaxNumber Themaximum number of posts listed. The default is10. Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

URLPath The URL path to the page the where the Forum server control is
located. String

UserID The ID of the user for whom to get the post history. Long

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

Custom - Lets you use custom tag.

String
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Map Server Control
The Map server control displays a map that flags locations of interest to your
site visitors. Each location is a CMS content item to which map information was
added. For example, if your site hosts a school district, each map location could
represent one school in the district.

A visitor can zoom the map in and out, get directions to any location, and
narrow the list of locations using a text search. For example, if your map
initially flags all schools in a geographic area, the visitor can redraw the map to
show only schools with a gym.

If you want the map to show events, you can apply dates to Ektron CMS400.NET
content. If you do, a site visitor using the map can search by date as well as
location to find events of interest.

Warning! As a map’s location boundaries change, only locations within the boundaries appear.
Likewise, if a date is assigned to content, only content within the selected date range appears.

If a map has at least one flagged location, a box can appear to its right with
information about each flagged location. The locations are sorted by distance to
starting location. From this box, you can

n view the content to which the location is assigned

n find the distance to a location

n center the map on a location

n get directions to a location

If you click any flagged location, a box appears showing a link to that content in
Ektron CMS400.NET, additional information about the item, and a link to
directions.
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This section also contains the following topics.

Using Maps on the Sample Site 7-655
Obtaining a License to Use Google Maps 7-656
Changing the Map's Zoom Level 7-657
Using the Search Tab to Recenter the Map 7-657
Using the Find What Tab to Find Locations with a Search Term 7-658
Using the Directions Tab 7-658
The Display on Map Button 7-659
Displaying Icons on the Category Popup Screen 7-660
Text Box 7-660
Bubble Text 7-661
Controlling the Visitor Experience with Maps 7-662
Displaying/Suppressing Map Elements 7-662
Determining a Map’s Initial Boundaries 7-663
Determining which Content is Found by a Map 7-663
Restricting Content for a Particular Map 7-665
Map Server Control Properties 7-665

Using Maps on the Sample Site
You can view maps on Ektron CMS400.NET’s sample site. To do so, open the
home page (http://your server address/siteroot/default.aspx). Then, click
Contact Information > Map VE or Contact Information > Map Google.

Note: If you want to work with these maps in VisualStudio.NET, the Bing Maps for Enterprise
map is on the map.aspx page. The Google map is on mapgoogle.aspx.

UsingMaps on the Sample Site
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Note: Ektron CMS400.NET provides a Google map key that you can use for testing on
localhost. But, if you want to use Google map with your production server, you must install a
license key. See Obtaining a License to Use Google Maps below.

Obtaining a License to Use Google Maps
Before your production server can use Google’s map feature, follow these steps
to obtain and install a license key. For Google Map’s terms and conditions, see
http://code.google.com/apis/maps/terms.html

1. Go to http://www.google.com/apis/maps.

2. Click Sign up for a Google Maps API key.

3. Read the terms and conditions. At the bottom of the page, check the
box next to I have read and agree with the terms and
conditions.

4. Enter your URL in the My web site URL: field. For example,
http://www.example.com/maps.

Warning! A single Maps API key is valid for a single “directory” on your web server. If you sign up
for the URL http://www.example.com/maps, the key you get is good for all URLs in the
http://www.example.com/maps/ directory.

5. Click the Generate API Key button.

6. You are asked to sign in to Google. If you don’t have an account,
create one.

7. A new page appears with your license key at the top. Copy the key.
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8. Without closing that page, open the web site root/web.config
file.

9. Go to the line that begins <add key="GoogleMap".

10. Within that line, replace the localhost key (shown below) with the one
copied in Step 7

key=ABQIAAAAKS0eaO74jIASu1UolJlxPRQAPC5zwhKxdscXMmLMOnW7z2LmSRQrVhfXVp1hq2cv_
ZsOvqP4GQ69eg"/>

Changing the Map's Zoom Level
If the map has a zoom control, the site visitor can use it to zoom in and out. As
the map’s boundaries change, flagged locations may appear or disappear. This
is because the map only shows content whose location lies within the map’s
boundaries. See Also: Controlling the Visitor Experience with Maps on page 7-
662

Using the Search Tab to Recenter the Map
The Search tab lets a site visitor recenter the map on a location. He can enter
any combination of street address, city, state and zip code.

When he does and presses Search, only content within that geographic area
which satisfies other search criteria appears.

Changing theMap's Zoom Level
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Using the Find What Tab to Find Locations with a
Search Term
The site visitor can use the Find What tab to find only locations that include a
search term. For example, if a map flags hotels, the visitor can click the Find
What tab then insert pool in the text box above to view only hotels with a pool.

The Find What tab uses the same logic used in the Web Search to find content
on your site. This is described in Searching Your Web Site on page 9-5.

Using the Directions Tab
The site visitor can use the Directions tab to get directions between any two
locations. Simply enter any combination of street address, city, state, and zip
code into both text boxes above the tabs (circled below).

When you do this and press Get Directions, the map screen displays text
directions on the left, and a map of the directions on the right.
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The Display on Map Button
If you use Ektron CMS400.NET’s Taxonomy feature to classify mapped content,
a site visitor can click the Display on Map button to restrict the map’s
locations to content in your categories.

Note: The popup window also prompts the site visitor select one or a range of dates, and only
retrieves content to which one of the selected dates is assigned. See DateSearch on page 7-
668.

A good example is presented in Ektron CMS400.NET’s sample site. Here, the
Taxonomy “Map Category” has the following categories.

Notice that the category Restaurant has five subcategories.

TheDisplay onMap Button
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When a site visitor is using the map, he can click the Display on Map button,
see your content’s categories, and select those of interest. When he does, the
map updates to show content in selected categories only.

Note:While an OR logical relationship among selected categories is the most intuitive and
common, you can alternatively set up an AND or NOT logical relationship among selected
categories. See SelectedCategoryLogicalType on page 7-672.

To learn about assigning taxonomy categories to content, see Taxonomy on
page 9-202.

Displaying Icons on the Category Popup Screen
See CustomIcon on page 7-667.

Text Box
The text box appears to the right of the map if at least one location is flagged.

The text box’s columns are described below.

Column

Header
Description

No. Map item’s number. The lowest numbered item is closest to themap’s
center.

Title

The content item that corresponds to the numberedmap location. The site
visitor can click the title to proceed to that content on your Web site.

The text below the title is theMetadataMap Address field, followed by
theMetadataDescription field (see illustration below).
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Column

Header
Description

Distance Distance from themap’s center to this content location.

Map Click icon to recenter map on this content’s location.

Directions
Click icon to select theDirections tab and paste this content location’s
address into the end location box. The site visitor could then enter a
starting location to get directions to this location.

Bubble Text
When a site visitor hovers the cursor over a numbered map location, a text
“bubble” appears.

The bubble shows the following information.

n Title - The content item that corresponds to the numbered map
location. The site visitor can click the title to proceed to that content
on your Web site.

Bubble Text
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n Summary - Whatever is entered into the content item’s Summary
tab.

n Metadata description - Whatever is entered into the content item’s
Metadata Description field.

n Get Directions - Click To Here or From Here to select the
Directions tab and paste this location’s address into the To or From
location box. The site visitor would then supply the missing (starting
or ending) location to get directions between the locations.

Controlling the Visitor Experience with Maps
Note:Within Visual Studio, you cannot see the map in design mode. But, you can right click
the mouse and select View in Browser to see the effect of changing properties in a browser.

This section explains how to customize the following elements of the map
display.

n Displaying/Suppressing Map Elements below

n Determining a Map’s Initial Boundaries on the facing page

n Determining which Content is Found by a Map on the facing page

For information on customizing the display using the Ektron Markup Language,
see map.ekml on page 26-42.

Displaying/Suppressing Map Elements
You can use Map server control properties to display or suppress the following
map elements.
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Screen Area Use this Map server control property to display or suppress

Tabs/Search box GeoControl

Text box DisplayTextResult

Zoom/direction

ZoomControl

Note: For BingMaps for Enterprisemaps, this property also controls
theMap type selection.

Map type (road, satellite,
combination)

TypeControl

Note: Only affectsGooglemaps.

Determining a Map’s Initial Boundaries
Because the map only displays content whose address lies within the map’s
boundaries, focus the initial display on your businesses/locations. Map server
control properties let you specify a beginning address (or longitude/latitude)
and a starting zoom level. All content with address data within that area is
flagged on the map.

If your locations are too spread out to appear on a single map, create several
regional maps. Each map server control must appear on a separate web form.

Warning! You cannot place more than one map server control on a Web form.

Determining which Content is Found by a Map

Preparing CMS Content to Appear on a Map
Whether you use Google or Bing Maps for Enterprise maps, content must have
latitude and longitude values in order to appear on a map.

Determining aMap’s Initial Boundaries
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Google maps provides a service that takes the address of content and returns
its latitude and longitude.

Note: You don’t need to use Google’s automatic retrieval of latitude and longitude. Instead,
you can enter the values manually. To do so, open the content item, go to its metadata, and
enter the latitude and longitude values under Search Data.

To automatically obtain latitude and longitude information for any content item,
follow these steps.

Warning! The following procedure assumes you are using Ektron CMS400.NET’s sample site. If
you are using the Min site, you must create searchable metadata definitions for Map Address,
Map Latitude and Map Longitude. When defining Map Latitude and Map Longitude, set their
Style to Double. If you are using dates with metadata, setMapDate’s style to Date.

1. Obtain a Google maps license key. See Obtaining a License to Use
Google Maps on page 7-656
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2. Create the content if necessary. On the content’s Metadata tab,
under Search Data, enter a MapAddress (that is, any combination
of street, city, state, and zip code).

If you enter only a zip code, the latitude and longitude are set to that
post office.

3. Publish the content. This action creates the Web Service call to
Google maps, which retrieves the latitude and longitude for each
address.

If Google maps cannot find a latitude and longitude (usually due to insufficient
or conflicting information), it writes failure information to your server. You can
view this under Windows Event Viewer > EktronLog. Any event’s properties
explain why the retrieval of latitude and longitude failed.

Restricting Content for a Particular Map
You may want a map to show a subset of all content with a latitude and
longitude. For example, your business includes restaurants and bakeries, and
you want a map to show only bakeries.

To accomplish this, place content for restaurants in one folder, and bakeries in
another. Then, in the map server control that shows bakeries only, at the
FolderID property, identify the bakeries folder.

If you want another map to show both restaurants and bakeries, create the
restaurant and bakery folders under a parent folder. Then, in that map server
control’s FolderID property, identify the parent folder, and set the Recursive
property to true.

Map Server Control Properties
Warning! You cannot place more than one map server control on a form.

Restricting Content for a Particular Map
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Note:Within Visual Studio, you cannot see the map in design mode. However, you can right
mouse click the mouse and select View in Browser to see the effect of changing the
properties.

The following table explains the Map server control properties.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Note: Do not use a percentage value to set the native .NET properties Height and Width.
Percentages do not work with these properties.

Property Value Data Type

Address

To set a default map center, enter its
addresshere.
If you only enter a zip code, themap centers on its post office.

The addressappears in theSearch field when themap first displays.

If you enter an address, the latitudeand longitudeproperties
are ignored.

String

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to
browse to content and a Taxonomy. If you are not logged it but want
to, change the value to true.

See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Boolean

ContentId

Use this field in conjunction with theEnableSearchResult field to
limit themap to a single content item. Here, you identify the content

item to bemapped. See Also:EnableSearchResult on page 7-669

Asexplained inPreparing CMSContent to Appear on aMap on
page 7-663, contentmust have latitude and longitude values in order
to appear on amap.

Long
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Property Value Data Type

CustomIcon

Use this field if you want the Category popup box to display an icon to
the left of each category, as shown below.

Prerequisite

To use this value, open the
webroot/Workarea/images/application/maps/tree folder. In
that folder, create a new folder whose name is the same as the
Taxonomycategory assigned to theMap server control at the
MapCategoryproperty. In the sample site, this Taxonomy’s name is
MapCategory.

Then, place the icons in that folder by category title namewith a .png
extension. Use an underscore (_) to separate taxonomy levels. For
example, the image for the categoryRestaurant >Americanmust be
named Restaurant_American.png.

Boolean

MapServer Control Properties
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Property Value Data Type

DateSearch

If you want to assign a date to content so that site visitors can select
bydate, enter true. This feature is helpful for date-related content,
such as concerts, meetings, or sporting events. The site visitor can
filter what appears on themap bydate.

If you set this property to true, assign a date to date-related content
using theMapDate standardmetadata field. Then, publish the
content.

When a site visitor clicks amap’sDisplay on Map button, the popup
screen includesdate criteria, as shown below.

See Also: TheDisplayonMap Button on page 7-659

The site visitor can select map itemsbya single date or a range of
dates. If he does, only content to which one of the selected dates is
assigned appears.

Boolean

DisplayTextResult

If you want the site visitor to see a boxof information about eachmap
item to the right of amap, enter true. To suppress the text box, enter
false.

See Also:Displaying/SuppressingMap Elementson page 7-662

Boolean

DistanceUnit Enter the units of distance on themap. Choicesaremiles and
kilometers. The default value ismiles. Unit

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes shown.

Boolean
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Property Value Data Type

EnableSearchResult

Use to determine if theMap server control accesses the CMSsearch
to return results. True is the default value.

You would change it to False if you want to display amapwith only
one content item, that is, a single location. Specify this item at the
ContentIDproperty. In this case, themap doesnot find other CMS
content whose longitude and latitude are within themap’s
boundaries.

Site visitors viewing themap can still use theSearch andDirections

tabs to get directions to the location.

See Also:Using the Search Tab to Recenter theMap on page 7-
657;Using the DirectionsTab on page 7-658

For example, your site featureshomes for sale, and you want amap
to show a featured home of the week. To do so, set this property to
False, and enter the content block that describes that home in the

ContentID field.

See Also:ContentId on page 7-666

Boolean

FolderId
Enter the ID number of the folder whose content is searched on this
map. If the recursiveproperty is true, folders below this folder are
also searched.

Long

ForceCategory

When set to true, this property causes themap to only show content
associated with the taxonomycategory defined in the MapCategory
property.When set to false, themap showsall content within the
map’s boundaries.

For example, if you have five content blocks that appear on amap
and three of them are associated with a taxonomy, set this property
to True and the MapCategoryproperty to the ID of the taxonomy.
When a user views themap, it will only display the three content
itemsassociated with the taxonomy.

See Also:MapCategoryon next page

Boolean

GeoControl
If you want the site visitor to see a search boxwith tabsabove amap,
enter true. To suppress the text box, enter false.

See Also: Displaying/SuppressingMap Elementson page 7-662
Boolean

Hide

Used to hide themap server control in design time and run time.

True =Hidemap server control

False =Showmap server control

Boolean

Language

Set a language for theMap server control. To allow the language to
be set dynamically, enter zero (0).

This property shows results in design-time (in VisualStudio) and at
run-time (in a browser).

Integer

Latitude To set a default map center via latitude and longitude (asopposed to
an address), enter the latitude here. Decimal
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Property Value Data Type

Longitude To set a default map center via latitude and longitude (asopposed to
an address), enter the longitude here. Decimal

MapCategory

Enter the ID number of the taxonomywhose categories appear
when a site visitor clicks thismap’sDisplay on Map button.

When amap first appears, all eligible content appears. If a site visitor
clicks theDisplay on Map button, he can choose one or more
categories and limit themap to itemsassigned to them. For example,
the user could view restaurants only (as shown below).

Asanother example, your map could display all campuses in your
state’s college system. A site visitor could use theDisplay on Map
popup window to limit themap to community colleges.

Note: While anOR logical relationship among selected
categories is themost intuitive and common, you can alternatively
set up an AND or NOT logical relationship among selected
categories. SeeSelectedCategoryLogicalType on page 7-672.

To learnmore about Taxonomy, see Taxonomyon page 9-202.

Long

MapProvider Select the service that provides themap, either Google or BingMaps
for Enterprise. Provider

MapStyle
Enter themap’s displaymode: Road, Satellite or Hybrid.

Note: This setting only affectsBingMaps for Enterprisemaps.
Style
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Property Value Data Type

Markup Language

Enter the templatemarkup file that is used to control the display of
themap page. For example, mymapmarkup.ekml.

If you enter no EkML file, the default one at
Workarea\Template\map\map.ekml is used.

If the *.ekml file is located in the \workarea\template\map folder,
just enter its name. If the file is in another folder, enter the path
relative to site root. For example,
\workarea\customfiles\markup\mymapmarkup.ekml

See Also:Controlling Output with EktronMarkup Language on page
26-1 andmap.ekmlon page 26-42

String

MinZoomLevel

If you want to set amap zoom level below whichmap locationswill
not appear, enter that value.

The default value is 4. Possible valuesare between 1 (most detailed)
and 19.

Integer

PageSize

Enter the number of locations that can appear on one page of the

text boxafter a search is executed.

See Also: Displaying/SuppressingMap Elementson page 7-662

If more than this number of locationsare available, the site visitor
sees [First] [Previous] [Next] [Last] at the bottom of the page.
He can use the navigation aids to view additional locations.

Integer

Recursive
In the FolderIDproperty, you specify a folder whose content is
searched on thismap. To extend the search to all folders below this
folder, set this property to true.

Boolean
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Property Value Data Type

SelectedCategoryLogicalType

Use this property to determine the logical relationship among several
categories on the DisplayonMap tab. (See TheDisplayonMap
Button on page 7-659). There are three choices: OR, AND, and
NOT.

Bydefault, an OR relationship exists among the site visitor’s
selections. So, for example, if all three Restaurant categories are
checked, then any restaurant that is defined asAmerican, Chinese
or Pizza appears on themap.

If you change this property’s value to AND, only content to which all
selected categories apply appear on themap. In the above example,
only restaurants defined asAmerican andChinese andPizza
appear on themap.

Alternatively, you can set the property’s value to NOT. In this case,
only content to which the selected categories are not applied appear
on themap. To continue the above example, if the site visitor selects
Chinese, only restaurants that are not assigned the Chinese
category appear on themap.

LogicalType
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Property Value Data Type

StartZoomLevel

Enter the zoom level at which themap initially appears. See Also:
Determining aMap’s Initial Boundarieson page 7-663

Zoom level 1 is the least detailed, showing the entire world map.
Zoom level 19 is themost detailed, showing the smallest streets. By
default, maps in the sample site have a zoom level of 12, which
showsan area of about 10miles (16 kilometers).

A site visitor viewing themap can adjust the zoom level using the
zoom control (circled below).

Integer

Stylesheet

Specify the path to a style sheet for use with this server control. The
location can be relative or absolute. Leave blank to use the default
style sheet.

Warning! If you enter a valid EkML file at the MarkupLanguage
property, the Stylesheetproperty is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags

False - Allow wrap tags

Boolean

TemplateParamName

Sets a QueryString parameter for the ID of users that are returned in
the search results. This parameter is passed to the template page
defined in the TemplateUserProfilepropertywhen a user clicks
the Location (map) icon associated with a user.

String

TemplateUserProfile The URL path of the user profile template. This path can be relative
or absolute. String
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Property Value Data Type

TypeControl

If thismap usesBingMaps for Enterprisemaps, this property
enablesor disables the zoom/direction/type control (highlighted
below). It lets a site visitor zoom themap in and out, move the center
in anydirection, and change the display style (Road or Aerial).

If thismap usesGoogle Earthmaps, this property enablesor
disables the type control (highlighted below). It lets the site visitor
change the display style (Map, Satellite, or Hybrid). Use the
ZoomControlproperty to display or suppressGoogle Earth’s zoom
and direction controls.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

Custom - Allowsyou to use a custom tag.

String
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Property Value Data Type

ZoomControl

Use this property to display or suppress theGooglemap zoom
control (highlighted below).

For BingMaps for Enterprisemaps, the display of the zoom control is
determined by the TypeControlproperty.

Boolean
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Validating XHTML Content
and Accessibility
By validating XHTML content and accessibility, you can ensure your content is
XHTML compliant and that individuals with disabilities can navigate and
understand your site.

This section also contains the following topics.

Validating with eWebEdit400 7-676
Setting up and Customizing Accessibility Validation 7-677
Validating Content for Compliance with XHTML Standards 7-679
Customizing Validation 7-680

Validating with eWebEdit400
eWebEdit400 can check content for the following types of compliance.

n Design - checks for the design standards such as proper closing tags
and unique field names.

Note: There is nothing you need to do to enable this type of validation, nor can you customize
it.

n XHTML standards - see Validating Content for Compliance with
XHTML Standards on page 7-679.

n Section 508 Validation - accessibility standards established by
agencies such as W3C Markup Validation Service - see Setting up and
Customizing Accessibility Validation on the facing page.

n Smart Form Data - makes sure that data entered into a smart
form’s field is the correct type and format. This selection only checks
smart form fields if validation for the field was turned on when it was
added to the Smart Form. Validation for each field type is explained
in Data Designer Field Types on page 7-297.

Note: An additional type of validation ensures that when a site visitor completes an HTML
form, the information is formatted correctly. For example, a Social Security number must have
three numbers, a dash, two numbers, another dash, and four numbers. This type of validation
is explained Form Validation on page 7-224.

An editor can validate content while editing by clicking the Validate button ( )
(illustrated below).

Managing Content in Ektron CMS400.NET

7-676 ReferenceManual
Version 8.01 Rev 4



In addition, eWebEdit400 automatically validates content whenever the user
tries to save, check in or (submit for) publish content. See Also: Step 1: Enable
Accessibility below

When validation is checked, any errors appear on the screen. If the content
passes validation, a message states The content is valid.

The rest of this section provides details about validating XHTML content through
these topics.

n Validating Content for Compliance with XHTML Standards on page 7-
679

n Setting up and Customizing Accessibility Validation below

Setting up and Customizing Accessibility
Validation
To have eWebEdit400 check content for compliance with accessibility
standards, follow these steps.

See Also:

n Step 1: Enable Accessibility below

n Step 2: Use Dialogs to Enter Accessibility Information on next page

n Customizing Accessibility Checks on next page

Step 1: Enable Accessibility
In the Ektron CMS400.NET Workarea, accessibility options appear on the
Settings > Configuration > Setup screen under Accessibility/Section
508 Evaluation (below Editor Options). The options are explained below.

n Do not validate - do not check content for compliance with
accessibility standards

n Warn if fails - the user is warned but allowed to publish the content

n Enforce - the user must bring the content into compliance before
submitting it for publication or publishing it; however, can save it or
check it in after being warned.

Setting up and Customizing Accessibility Validation
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Step 2: Use Dialogs to Enter Accessibility
Information
Several dialog boxes let the content editor enter accessibility information. An
example is below.

The table below lists dialog boxes in which accessibility information can be
entered.

Dialog Field How filled if no value exists

Image Properties Image Alt Text: Uses the image’s title

TableWizard - Cell PropertiesTab
Abbreviation:

Categories:
Not automatically filled when no value exists

TableWizard - Accessibility Tab
Caption:

Summary:
Not automatically filled when no value exists

HyperlinkManager

(IncludesQuicklinks)
Tooltip: Contents of Link Text field copied

Customizing Accessibility Checks
All standard accessibility checks are stored in the site root/Workarea/Content
Designer/ektaccesseval.xslt file. If you want to customize which checks are
applied, edit that file.

To change or disable the .xslt file that eWebEdit400 uses to validate for
accessibility, edit this line of site root/Workarea/Content
Designer/ValidateSpec.xml.

<validate>
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<xslt id="ektaccesseval" name="Section 508 Validation" enabled="true"
src="[srcPath]/ektaccesseval.xslt"/>

Validating Content for Compliance with
XHTML Standards
Ektron CMS400.NET content can be validated against the XHTML 1.1 standard.
To do so, you must define the Web sites that validate schema files and schema
namespaces.

Here are two sites that can validate content using the WC3 Markup Validation
Services.

n schema files - http://www.w3.org/2002/08/xhtml/xhtml1-
transitional.xsd

n schema namespaces - http://www.w3.org/1999/xhtml

Defining the XHTML Validation Schemas
To validate content against XHTML standards, follow these steps.

1. Using Visual Studio, open site root/Workarea/edit.aspx.vb.

2. Find the section indicated below.

3. Using Intellisense, enter SchemaFiles and SchemaNamespaces
properties to define the validating Web sites. They accept an array of
strings and go in pairs. Here are examples.

C#

Validating Content for Compliance with XHTML
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ContentDesigner1.SchemaFiles = new string[] {"http://www.w3.org/2002/08/xhtml/xhtml1-
transitional.xsd"};

ContentDesigner1.SchemaNamespaces = new string[] { "http://www.w3.org/1999/xhtml" };

VB.Net
With m_ ContentDesigner1

.SchemaFiles = New String() {" http://www.w3.org/2002/08/xhtml/xhtml1-transitional.xsd"}

.SchemaNamespaces = New String() {"http://www.w3.org/1999/xhtml”}

End With

Customizing Validation
In the site root folder\Workarea\ewebeditpro\cms_config.aspx file, you
can specify a set of validation options for plain text and calculation field types.
(Data in other field types cannot be validated.) For these field types, you can
assign standard and custom validation checks. The checks are applied when
data is inserted into one of the field types, and when the user tries to save a
Data Design document whose fields have validation attributes.

You can modify the standard options and enter your own criteria for each field.
You can also establish dependencies between fields. For example, a value is
only required for a field if a certain Checkbox field is checked.

This section also contains the following topics.

Validation Elements in the Configuration Data 7-681
Validation Attributes 7-681
Validation Sub-elements 7-682
Choice Sub-element 7-682
Choice Attributes 7-682
Choice Sub-Elements 7-683
Defining a Schema Fragment 7-683
Simple Data Types 7-683
Examples 7-684
Defining a Calculation 7-684
DefiningValidation 7-686
Defining an Error Message 7-686
Defining Custom Validation 7-686
Saving Invalid Documents 7-690
Custom Script that Handles Saving Invalid Files 7-690
The onerror Event 7-691
Calculated Fields 7-691
Icons on the Select Field or Group Screen 7-691
Learn More about XPath 7-693
Xpath Operators 7-693
Xpath Functions 7-695
XPath References 7-697
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Validation Elements in the Configuration
Data
The default configuration file includes standard validation options for plain text
and calculation field types.
<validation name="calculation">

 <choice name="none" treeImg="text">

 <caption localeRef="dlgNV8n" />

 <schema datatype="string" />

and
<validation name="plaintext" visible="false">

 <choice name="none" treeImg="text">

 <caption localeRef="dlgNV8n" />

The validation sections let you control the drop-down list of validation choices
for a field type (for example, Plain Text). Here is an overview of that section of
the cms_config.aspx file.
<datadesign>

<validation> (0 or more)

<choice> (0 or more)

<caption>

<schema>

<calculate>

<regexp> OR

<script> OR

<xpath>

<validate>

<regexp> OR

<script> OR

<xpath>

<errormessage> (optional)

Details are provided below.

Validation Attributes
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Attribute Description Possible values

visible Controlswhether theValidation field appears on the
field'sProperties dialog. true, false

enabled

Controlswhether theValidation field is active or
“grayed out” on the field'sProperties dialog.

If set to true, theValidation field is active; if false, it
appears but is grayed out.

true, false

name

The field type to which the validation configuration data
applies.

A separate <validation>element must exist for each
field type.

plaintext, calculation

Validation Sub-elements
Element Description For more information, see

Choice The calculation or validation expression for
standard fields Choice Sub-element below

Custom The calculation or validation expression for
custom fields Defining CustomValidation on page 7-686

Choice Sub-element
Every item in the validation drop-down list must be defined within a set of
<choice> tags. Within the <choice> tags, you define a caption, a schema, and
either a calculation or validation expression.

The default validation choices appear below.

Choice Attributes
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Attribute Description

name Assign a new name to each choice.

treeImg

The icon to display for this field in the Select Field or Group dialog.
See Iconson the Select Field or Group Screen on page 7-691.

Unlike toolbar icons, you cannot create your own icons.

Note: This attribute only applies to the Data Design of a
Smart Form -- it doesnot apply to HTML forms.

Choice Sub-Elements

Element Description
For more
information,
see

caption Defines the displayed text for this choice. The attributesand description are
the same as<caption>elements for commands.

schema

DefinesaW3C XML schema (WXS) definition for this choice. The definition
maybe a simple type defined by the datatypeattribute and/or aWXS
fragment.

Note: This attribute only applies to the Data Design of a Smart Form --
it doesnot apply to HTML forms.

Defining a
Schema
Fragment below

calculate Definesan expression which normalizesa value prior to checking validation
Defining a
Calculation on
next page

validate Definesan expression that determines if a value is valid DefiningValidation
on page 7-686

Defining a Schema Fragment
When defining a schema fragment, the “xs” namespace prefix is required for
WXS tags. Also, the WXS fragment must be valid for inclusion in an
xs:restriction (simple type). That is,
<xs:simpleType>

<xs:restriction>

...fragment...

</xs:restriction>

</xs:simpleType>

Simple Data Types
The simple data types are defined by W3C XML Schema definition language 1.0.

Choice Sub-Elements
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Note: The datatype value should not include a namespace prefix. For example
datatype=”string” is correct; datatype=”xs:string” is incorrect

Examples
n Using only a datatype attribute

<schema datatype="string"/>

n Using only a schema fragment

<schema>

<xs:simpleType>

<xs:union memberTypes="xs:nonNegativeInteger">

<xs:simpleType>

<xs:restriction base="xs:string">

<xs:length value="0"/>

</xs:restriction>

</xs:simpleType>

</xs:union>

</xs:simpleType>

</schema>

n Using a datatype attribute and a schema fragment

<schema datatype="string">

<xs:minLength value="1"/>

</schema>

Defining a Calculation
Use the <calculate> element to define an expression that normalizes a value
prior to checking validation. For example, a calculation can truncate digits in a
decimal, remove excess white space, or capitalize text. The expression must
return a value of the same data type and format as the original value.

Several sample calculations are delivered with Ektron CMS400.NET. They
appear when the user clicks the Examples drop-down on the Calculated Field
dialog. These calculations are explained in Explanation of Examples on page 7-
329.
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You can only define one expression for <calculate> and <validate>.

The expression element choices are listed below. Use whichever language is
easiest.

n Regular Expression (JScript)

n JavaScript

n XPATH

Expression Description

Regular Expressions (JScript)

<regexp>

Definesa regular expression supported by JScript. You can define a regular
expression either between the tagsor using attributes.

If between the tags, the expressionmust begin with a slash (/) character. The g, i,
andm flagsare allowed. For example: <regexp>/\S+/</regexp>.

<regexp patternings-
exp-pattern” A regular expression pattern (without the “/” chars).

<regexp
global=”true|false”

Specifieswhether the patternmatchesonly the first occurrence or all occurrences
within the text. This corresponds to the g flag.

<regexp
ignorecase=”true|false” Specifies if thematch is case-sensitive. This corresponds to the “i” flag.

<regexp
multiline=”true|false”

Specifies if thematch, when using ^ and $, is applied to each line in text that has
multiple lines. This corresponds to the “m” flag.

<regexp
wholeline=”true|false”

Specifieswhether the pattern applies to the whole text or not. This is the same as
placing “^(“at the beginning of

the pattern, and “)$” at the end of the pattern.

JavaScript

Defining a Calculation
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Expression Description

<script
value=”javascript-
expression”

Specifies a JavaScript expression to be evaluated. The field's value is available in a
property named 'this.text'. For example

<script value="this.text.toUpperCase()"/>

XPATH (See Also: Learn More about XPath on page 7-693)

<xpath select=”xpath-
expression”

Specifies an XPath expression to be evaluated. The field's value is available using
“.”.

DefiningValidation
Use the <validate> element to define an expression that determines if a value
is valid. The expression must return a Boolean (true or false) result. For
example:
<validate>

 <regexp>/^\d+$/</regexp>

</validate>

To construct the <validate> element, use the same expression element
options as <calculate>. See Also:Defining a Calculation on page 7-684

Defining an Error Message
Use the <errormessage localeRef="id"> element to define a message to
display when the data is not valid. For example, “Must be a number between 1
and 10, inclusive.”

The text may be within the <errormessage> tags or referenced using localeRef
into the localeNNNN.xml file.

Defining Custom Validation
Note: This section only applies to the Data Design of a Smart Form -- it does not apply to
HTML forms.

Use the <custom> element to change the standard values that appear in the
following fields of the Custom Validation dialog.
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Field Screen image

Data Type

Examples

To change the list of options, modify the <custom> element of the cms_
config.aspx file. This section describes the <custom> element’s attributes and
child elements.
<datadesign>

<validation>

:

<custom> (optional tag)

<caption>

<selections name="datatype">

<listchoice> (0 or more)

<selections name="examples">

<listchoice> (0 or more)

Element or Attribute Description

<custom> Specifies basic data typesavailable when customizing validation. The typesare
defined in the <listchoice>elements (see below).

<custom
visible=”true|false”

Controlswhether theCustomValidation field appears on the Properties
dialog.

Defining CustomValidation
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Element or Attribute Description

<custom
enabled=”true|false”

Controlswhether theCustom Validation field is active or “grayed out” on the
Properties dialog.

If set to true, theCustom Validation field is active; if false, it is grayed out.

<caption localeRef=”id”> Specifies text to display in the validation drop-down list. The default caption is
“(Custom)”.

Selections element for Data Type field

<selections
name=”datatype”> The namemust be datatype.

<selections
enabled=”true|false”

Controlswhether the drop-down list is active or “grayed out” on the Properties
dialog.

<selections
visible=”true|false” Controlswhether the drop-down list appears on the Properties dialog.

Listchoice element for Data Type field

<listchoice> Defines the values in the CustomValidation dialog Data Type drop-down list.

<listchoice value=”simple-
data-type”

Enter each data type that should appear in the CustomValidation dialog’sData
Type drop-down list.

The simple data typesare defined byW3C XMLSchema definition language
1.0.

See Also:Defining a Schema Fragment on page 7-683

<listchoice treeImg=”id”
Specifies the icon to display for this field in the Select Field or Group dialog. See
Iconson the Select Field or Group Screen on page 7-691.

Unlike toolbar icons, you cannot create your own.

<listchoice localeRef=”id”
The text that describes thisData Type on the CustomValidation dialog.

This element can refer to a string in the localeNNNN.xml file. Or, you can enter
the string between the <listchoice> tags.

<listchoice
default=”true|false”

Use this attribute to indicate the default choice in the CustomValidation dialog’s
Data Type drop-down list.
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Element or Attribute Description

Selections element for Examples field

<selections
name=”examples”> The namemust be “examples”.

<selections
enabled=”true|false”

Determines if theExamples drop-down list and label are active or “grayed out”
in the CustomValidation dialog.

<selections
visible=”true|false” Determines if theExamples drop-down list and label appear.

Listchoice Element for Examples field

<listchoice> Defines the values in the Examplesdrop-down list.

<listchoice value=”xpath-
expression-example”

The XPath expression appears in theExamples drop-down list of the Custom
Validation dialog.

Defining CustomValidation
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Element or Attribute Description

<listchoice localeRef=”id” -

The text that describes the exampleson the CustomValidation dialog.

This element can refer to a string in the localeNNNN.xml file. Or, you can enter
the string between the <listchoice> tags.

Saving Invalid Documents
Use the publishinvalid attribute of the <standard> element to determine if
an invalid document should be saved. This attribute lets you decide if a user can
save an XML document when the data in one or more fields does not satisfy the
validation criteria.

In Data Entry mode, an example would be if a field requires a non-negative
whole number, but the user does not insert a value in that field.

If the publishinvalid attribute’s value is true, content is not checked for
validity when it is saved.

If false, the content is checked for validity during a save. If the content is
valid, it is saved. If it is invalid, the user is notified, and a custom script can be
created to allow the content to be saved or prevent it.

Note: If the publishinvalid attribute is not defined in the <standard> element, the default
is true so that Ektron CMS400.NET is backwards compatible with previous releases.

Custom Script that Handles Saving Invalid Files
To determine whether or not an invalid XML document should be saved, write a
client-side script that is called when invalid content is found. The routine should
ask if the user wants to save the invalid content. The script should return True
to save the content, or False to abort the save.

Below is an example of such a script.
<script language="JavaScript1.2">

<!--

eWebEditPro.instances["MyEditor1"].onerror = myOnErrorHandler;

function myOnErrorHandler()
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{

 if (EWEP_STATUS_INVALID == this.status && "save" == this.event.source)

 {

 var strMsg = "Content is invalid.";

 strMsg += "\nError Code: " + this.event.reason;

 strMsg += "\nError Reason: " + this.event.message;

 alert(strMsg);

 return false; // prevent save

 }

}

//-->

</script>

The onerror Event
If the content is invalid, an onerror event is generated. This event provides two
additional properties for the event object when it fires:

n reason (a numeric error code)

n message (text describing the error)

As with the regular onerror event, the source property is available. You can
display the values of these properties in an error message that informs the user
why the document is not valid.

Calculated Fields
A Calculated Field lets you include values that are calculated, typically from
values in other fields. For example, you can multiply two field values. The
equation used is an XPath expression.

You can validate a Calculated Field, just like the Plain Text Field. For instance,
the total of a series of numbers should be less than 100.

For more information about calculated fields, see

Icons on the Select Field or Group Screen
Note: This section only applies to the Data Design of a Smart Form -- it does not apply to
HTML forms.

Use the following icons to denote a field on the Select A Field or Group Screen
(illustrated below). These are the valid values for the treeImg attribute.

The onerror Event
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Icon Name

calculation

calendar

checkbox

droplist

fieldset

hidden

hyperlink

number

password

picture

richarea

text

textbox
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Learn More about XPath

Xpath Operators
Content copied from www.w3schools.com/xpath.

Operator Description Example Result

Numerical expressions perform arithmetic operations on numbers. XPath converts each
operand to a number before performing an arithmetic expression.

+ addition 6 + 4 10

- subtraction 6 - 4 2

* multiplication 6 * 4 24

div division 8 div 4 2

mod division remainder 5mod 2 1

Equality/ greater/ less than expressions test equality between two values

= equals price = 9.80 true (if price is 9.80)

!= is not equal price! = 9.80 false

< less than price < 9.80 false (if price is 9.80)

< = less than or equal to price <=9.80 true

> greater than price > 9.80 false

>= greater than or equal to price >=9.80 true

Boolean expressions compare two values

or or price = 9.80 or price =
9.70 true (if price is 9.80)

and and price <=9.80 and price =
9.70 false

Identifying a path and element

. the current element . >100 true if element exceeds100

LearnMore about XPath
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Operator Description Example Result

.. the current element’s
parent count(../*)

counts the number of elements
at the same level as the current
element

Grouping and separating

[ ] predicate ../*[0] ../*[0] - returns the parent's first
child element

| specifymultiple elements sum( X | Y | Z ) If X=1 and Y=2 and Z=3, sum(
X | Y | Z ) = 6
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Xpath Functions

Operator Description Example

last
Returns the position number of the last node in the processed node
list

Syntax: number=last()

position
Returns the position in the node list of the node that is currently being
processed

Syntax: number=position()

count
Returns the number of nodes in a node-set

Syntax: number=count(node-set)

name
Returns the name of a node

Syntax: string=name(node)

string
Converts the value argument to a string

Syntax: string(value)

string(314)

Result: '314'

concat
Returns the concatenation of all its arguments

Syntax: string=concat(val1, val2, ..)

concat('The',' ','XML')

Result: 'The XML'

starts-with
Returns true if the first string startswith the second string.
Otherwise, it returns false.

Syntax: bool=starts-with(string,substr)

starts-with('XML','X')

Result: true

contains
Returns true if the second string is contained within the first string.
Otherwise, it returns false.

Syntax: bool=contains(val,substr)

contains('XML','X')

Result: true

substring-
after

Returns the part of the string in the string argument that occurs after
the substring in the substr argument

string=substring-after(string,substr)

substring-
after('12/10','/')

Result: '10'

substring-
before

Returns the part of the string in the string argument that occurs
before the substring in the substr argument

Syntax: string=substring-before(string,substr)

substring-
before('12/10','/')

Result: '12'

substring
Returnsa part of the string in the string argument

Syntax: string=substring(string,start,length)

substring('Beatles',1,4)

Result: 'Beat'

string-
length

Returns the number of characters in a string

Syntax: number=string-length(string)

string-length('Beatles')

Result: 7

Xpath Functions
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Operator Description Example

normalize-
space

Returns the whitespace-normalized version of a passed string. All
leading and trailing whitespace is stripped, and all sequencesof
whitespace get combined to one single space.

Syntax: normalize-space('string')

normalize-space('
some text ') would
return some text

translate
normalize

Syntax: string=translate(value,string1,string2)

n translate

('12:30','30','45')

Result: '12:45'

n translate

('12:30','03','54')

Result: '12:45'

n translate
('12:30','0123','abcd')

Result: 'bc:da'

boolean
Converts the value argument to Boolean and returns true or false

Syntax: bool=boolean(value)

not
Returns true if the condition argument is false, and false if the
condition argument is true

Syntax: bool=not(condition)

not(false())

true
Returns true

Syntax: true()

number(true())

Result: 1

false
Returns false

Syntax: false()

number(false())

Result: 0

lang
Returns true if the language argument matches the language of the
xsl:lang element. Otherwise, it returns false.

Syntax: bool=lang(language)

number
Converts the value argument to a number

Syntax: number=number(value)

number('100')

Result: 100

sum
Returns the total value of a set of numeric values in a node-set

Syntax: number=sum(nodeset)
sum(/cd/price)

floor
Returns the largest integer that is not greater than the number
argument

number=floor(number)

floor(3.14)

Result: 3

ceiling
Returns the smallest integer that is not less than the number
argument

Syntax: number=ceiling(number)

ceiling(3.14)

Result: 4
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Operator Description Example

round
Rounds the number argument to the nearest integer

Syntax: integer=round(number)

round(3.14)

Result: 3

XPath References
To learn more about XPath, check these Web pages.

Topic URL

W3C Spec - XPath 1.0 spec http://www.w3.org/TR/xpath

Tutorial www.w3schools.com/xpath/default.asp
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Content Reports
The reports folder contains several reports to help you manage the workflow of
content through Ektron CMS400.NET. In most cases, you choose a report that
corresponds to the content’s status, then view all content in that status. If
appropriate, you can perform tasks on selected content. For example, you can
check in checked-out content.

This chapter explains how to access the reports folder in your Workarea, set
criteria that determine the information on the reports, and actions you can
perform on them.

This section also contains the following topics.

Accessing the Reports Folder 7-698
List of Content Reports 7-699
Common Report Topics 7-700
Approvals Reports 7-706
Checked In Report 7-708
Checked Out Report 7-709
New Content Report 7-710
Submitted Report 7-711
Content Pending Start Date Report 7-712
Refresh Reminder Report 7-713
Expired Content Report 7-714
Content to Expire Report 7-714
Site Update Activity Report 7-716
Search Phrase Report 7-719
Bad Links Report 7-720

Accessing the Reports Folder
To access the Reports folder, follow these steps.

1. From the Ektron CMS400.NET Workarea, click the Reports Tab.

2. A list of available report topics appears.
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List of Content Reports
Report Displays content in this status For more information, see

Approvals Requiring your approval ApprovalsReportson page 7-
706

Checked In Content Checked in Checked In Report on page 7-
708

CheckedOut
Content Checked out CheckedOut Report on page

7-709

New Content New (that is, created and saved but never
published)

New Content Report on page
7-710

Submitted Content Submitted for publication Submitted Report on page 7-
711

Content Pending
Start Date Approved and pending a start date Content Pending Start Date

Report on page 7-712

Refresh Reminder
Report End date hasbeen reached Refresh Reminder Report on

page 7-713

Expired Content Expired date hasbeen reached Expired Content Report on
page 7-714

Content to Expire Will expire within specified number of days Content to Expire Report on
page 7-714

Site Update Activity
Content Report

Content created or updated in selected folders
and within a selected date range

Site Update ActivityReport on
page 7-716

AsynchronousLog
File Report A log report of the Asynchronousprocess AsynchronousLog File

Reporting on page 23-13”

Search Phrase
Report Frequencyof search terms Search Phrase Report on

page 7-719

PreapprovalGroups User groups that have been assigned to folders in
order to preapprove content

PreapprovalGroupsReport on
page 12-32

Bad LinkReport Invalid links to externalURLs Bad LinksReport on page 7-
720
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Common Report Topics
The following topics apply to the reports.

n Information on the Reports below

n Report Toolbar Options on the facing page

n Selecting Content by Folder on the facing page

n Selecting Content by Type on page 7-702

n Sorting and Filtering Content Reports on page 7-703

n Performing an Action on Several Content Items on page 7-703

n Viewing/Editing Content on the Report on page 7-704

n Emailing Reports on page 7-704

Information on the Reports
Each report displays the following information about its content.

Field Description

Title Title of content.

ID Internal number assigned to content byEktron
CMS400.NET.

Managing Content in Ektron CMS400.NET

7-700 ReferenceManual
Version 8.01 Rev 4



Field Description

DateModified If a Start Date wasassigned to the content, it appears
here.

Last Editor The user who last edited the content.

Path Folder location of content.

Report Toolbar Options

Toolbar Button Description
For more
information, see

email this report to selected users Emailing Reportson
page 7-704

Select a folder whose content appears on the report.
Content in other folders is ignored.

Selecting Content
byFolder below

Go to previous screen

Select the language of the content you want to see on
the report

Selecting Content by Folder
You can select a folder and only view the content in that folder that satisfies the
other report criteria. For example, the Checked in Content Report can show
only content whose status is checked in and which resides in the Contacts
folder.

Report Toolbar Options
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Only content in the selected folder appears. The report does not include content
from subfolders of the selected folder.

To select content by a folder, follow these steps.

1. From the Smart Desktop, select a report.

2. Click the Select a Folder button ( ).
3. The top level folders appear.

4. If the folder you want is on the list, click the corresponding checkbox.

If the folder you want is a subfolder, click the parent folder’s name. A
new screen appears, showing the selected folder’s subfolders. Click the
corresponding checkbox.

5. Click the Save button ( ) to finalize your folder selection.
6. The screen displays all content items in the selected folder that

satisfy all report criteria.

Selecting Content by Type
After viewing any report, you can select a content type and only view the
content of that type that satisfies the other report criteria. For example, the
Checked in Content Report can show only Office documents.

To select a content type, follow these steps.

1. From the Smart Desktop, select a report.
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2. Use the file types pull-down to select a file type.

3. The screen refreshes and only displays files of that type.

Sorting and Filtering Content Reports
Upon viewing a report’s content, you have additional options for filtering report
data by user and content folder.

The filtering options for each content report are identical. The following section
uses the Checked-In Content report as an example.

Filter by User
To display only content that was checked in by a user, click the name of the
user in the report display. When you do, the report redisplays, showing only
content which that user checked in.

Filter by Content Folder
To display only content checked in to a selected folder, click the folder on the
report display. When you do, the report redisplays, showing only content in that
folder.

Note: You can also select a folder and view reports in that folder only. See Also: Selecting
Content by Folder on page 7-701

Performing an Action on Several Content
Items
You can perform the following actions on several or all content items in the
Approvals, Checked in, and Checked out reports.

Report Action you can perform

Approval Approve

Sorting and Filtering Content Reports
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Report Action you can perform

Checked in Submit for publication

Checked out Check in

To select several reports, check the relevant checkboxes (illustrated below). To
select all reports, click the Select All button in the upper left corner.

Then, click the button at the top left to perform the action on the selected
content items.

Viewing/Editing Content on the Report
To view (and possibly edit) any content on a report, click it. It appears on the
View Content screen (illustrated below).

The View Content screen provides several toolbar options that you can perform
on the content.

Emailing Reports
You can email any report. You might do this, for example, to notify a user that
several content items are checked out to him. All information in the report
appears in the email. A sample appears below.
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You can click any content item on the report and proceed to that page of your
Web site.

To email any report, follow these steps.

1. Display the report you want to email.

2. Click the email button ( ).
3. A list of all users and user groups in your Ektron CMS400.NET

appears.

Note: Users appear fIrst in alphabetical order (by username), followed by user groups. The
icon for user groups has two heads (see below).

4. Click inside the checkbox of every user or group to receive a copy of
the report.

Searching for Report Recipients
If you cannot easily find a user, a search of all users and groups is available. To
use it, follow these steps.

1. Display the report that you want to email.

2. Click the email button ( ).
3. A list of all users and user groups in your Ektron CMS400.NET

appears.

Searching for Report Recipients

ReferenceManual
Version 8.01 Rev 4

7-705



4. Click the Search for User button ( ).
5. The following screen appears.

6. Enter whatever information you know about the users.

7. Click the Send email button.

8. All users that satisfy the search criteria appear on a new screen.

9. Click the checkbox of every user or group to receive the report.

Approvals Reports
Each content item awaiting your approval appears on this report. Thus, you can
quickly find all such content without searching through every folder.

The View All Content Awaiting Approval screen displays the following
information about this content.

Field Description

Title Title of content.

Request Type Request made for the content. Either Publish or Delete.

Start Date Start date, if any, assigned to the content. Determineswhen content will go live
onWeb site.

DateModified Date the content wasmost recently changed

Submitted By User who submitted content for approval.

ID The ID number if the content.

Language The language of the content.

Path Path to content folder where content resides.

See Also:

n Report Toolbar Options on page 7-701

n Selecting Content by Folder on page 7-701
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n Selecting Content by Type on page 7-702

n Sorting and Filtering Content Reports on page 7-703

n Performing an Action on Several Content Items on page 7-703

n Viewing/Editing Content on the Report on page 7-704

n Emailing Reports on page 7-704

Below is an example of the View All Content Awaiting Approval screen.

Approving/Declining Content
From the approvals report, you can approve or decline content that was
submitted to you. The steps below explain how to do so.

1. Access your Approvals report in the Workarea (see Approvals
Reports on previous page).

2. Click the content you want to approve or decline.

3. The View Content Awaiting Approval page is displayed.

4. Perform an action using the following table as a reference.

Approving/Declining Content
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Button Name Description

Publish

Accept changes to content and publish it to site.

Note: If there is a subsequent approver in the content’s approval chain,
this button is replaced bya Submit button.

If you clickPublish but the content item hasan incomplete taskassigned to
another user, the content cannot
be published. Instead, the following error message appears.

The user to whom the task is assignedmust complete it before you can
publish the content.

Decline

Reject changesand keep current version of content live onWeb site.
You are prompted to enter a comment that providesa reason for the decline.
The author whomade the change is notified byemail of the decline.

The content inserted by the last editor remains in the file. If you do not want it
to remain, choose theEdit option.

Edit Checkout content andmake changes to it if desired.

View
Published/Staged

Toggle between published and submitted versionsof content. This can help
you compare differences.

Back Go back to previous screen.

Approving Multiple Content Items
See Performing an Action on Several Content Items on page 7-703.

The selected content is either submitted to the next publisher, published
immediately, or deleted, depending on the content’s approval chain.

Checked In Report
The Checked In Content report displays all the content currently in a checked-in
status.

The report displays the following information.
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Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

DateModified Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NETWeb site.

See Also:

n Report Toolbar Options on page 7-701

n Selecting Content by Folder on page 7-701

n Selecting Content by Type on page 7-702

n Sorting and Filtering Content Reports on page 7-703

n Performing an Action on Several Content Items on page 7-703

n Viewing/Editing Content on the Report on page 7-704

n Emailing Reports on page 7-704

Submitting Multiple Content Items
After selecting content, use the submit toolbar option ( ) to submit it for
approval or publication, depending on your position in the approval chain.

Checked Out Report
The Checked Out Content report displays all content currently in a checked out
status. The report displays the following information.

Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

DateModified Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NETWeb site.

SubmittingMultiple Content Items
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See Also:

n Report Toolbar Options on page 7-701

n Selecting Content by Folder on page 7-701

n Selecting Content by Type on page 7-702

n Sorting and Filtering Content Reports on page 7-703

n Performing an Action on Several Content Items on page 7-703

n Viewing/Editing Content on the Report on page 7-704

n Emailing Reports on page 7-704

After selecting content, check it in using the Checkin button ( ).

New Content Report
The New Content report displays content in a new state, that is, it was created
and saved but never published. The new content report contains the following
information.

Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

DateModified Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NETWeb site.

See Also:

n Report Toolbar Options on page 7-701

n Selecting Content by Folder on page 7-701

n Selecting Content by Type on page 7-702

n Sorting and Filtering Content Reports on page 7-703

n Performing an Action on Several Content Items on page 7-703

n Viewing/Editing Content on the Report on page 7-704

n Emailing Reports on page 7-704
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Submitted Report
The Submitted Content report displays all content in a submitted state. The
report contains the following information.

Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

DateModified Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NETWeb site.

Viewing Position in Approval Chain
While viewing the Submitted Content report, you can view the content’s
position is its approval chain. You can use this information to contact the
individuals in the chain and ask them to complete their approval. To do so,
follow these steps.

1. From the Submitted Content Report, click the content’s title.

2. The View Content page is displayed.

3. Click the Properties tab.

4. The content’s position in the approval chain is indicated by red text on
the Approvals line.

See Also:

n Report Toolbar Options on page 7-701

n Selecting Content by Folder on page 7-701

n Selecting Content by Type on page 7-702

Submitted Report
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n Sorting and Filtering Content Reports on page 7-703

n Performing an Action on Several Content Items on page 7-703

n Viewing/Editing Content on the Report on page 7-704

n Emailing Reports on page 7-704

Content Pending Start Date Report
The Pending Start Date Report displays all content that was approved, but
whose start dates haven’t occurred. Each content item on the report contains
the following information.

Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

Start Date Date and time content will go live onWeb site.

Path Folder location of content in Ektron CMS400.NETWeb site.

Editing Content with a Pending Start Date
You may edit content on the Pending Start Date Content report. To do so, follow
these steps.

1. Click the content you want to view.

2. The View Content page is displayed.

3. Using the toolbar at the top of the page, perform any action available.

See Also:

n Report Toolbar Options on page 7-701

n Selecting Content by Folder on page 7-701

n Selecting Content by Type on page 7-702

n Sorting and Filtering Content Reports on page 7-703

n Performing an Action on Several Content Items on page 7-703

n Viewing/Editing Content on the Report on page 7-704

n Emailing Reports on page 7-704
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Refresh Reminder Report
The Refresh Report displays all content whose end date has passed and whose
archive option is set to Refresh Report. This content is still visible on the Web
site. Its appearance on this report indicates that it is due for review. See Also:
Scheduling Content to Begin and End on page 7-187

Each item on the report contains the following information.

Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

DateModified Date and time the content was last updated.

Path Folder location of content in Ektron CMS400.NETWeb site.

Removing Expired Content from Site
If you review content and decide it should no longer appear on your site, follow
these steps to remove it. The content will be visible if you browse to it through
the Workarea, but won’t appear to site visitors.

1. From the Expired Content Report, click the content.

2. From the View Content screen, click the Edit button ( ).
3. Click the Schedule tab.

4. Under Action on End Date:, click Archive and remove from site
(expire).

See Also:

n Report Toolbar Options on page 7-701

n Selecting Content by Folder on page 7-701

n Selecting Content by Type on page 7-702

n Sorting and Filtering Content Reports on page 7-703

n Performing an Action on Several Content Items on page 7-703

n Viewing/Editing Content on the Report on page 7-704

n Emailing Reports on page 7-704
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Expired Content Report
The Expired Content report displays all content whose end date has passed.
Such content is no longer visible on the Web site.

Each item on the list contains the following information.

Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

End Date Date and time the content expired.

Path Folder location of content in Ektron CMS400.NETWeb site.

Editing Expired Content
You may edit any content on the Expired Content report. To do so, follow these
steps.

1. Click the content you want to view.

2. The View Content page is displayed.

3. Using the toolbar at the top of the page, perform any action available.

See Also:

n Report Toolbar Options on page 7-701

n Selecting Content by Folder on page 7-701

n Selecting Content by Type on page 7-702

n Sorting and Filtering Content Reports on page 7-703

n Performing an Action on Several Content Items on page 7-703

n Viewing/Editing Content on the Report on page 7-704

n Emailing Reports on page 7-704

Content to Expire Report
The Content to Expire report lists all content whose end date will occur between
today and a number of days that you specify. For example, if today is January 1
and you select 10 days, the report lists all content whose end date is January 1
through January 10.
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After viewing the report, you can click any content and proceed to the View
Content screen for it. From there, you can edit information about it, including
its end date if desired.

Each item on the list contains the following information.

Column Description

Title Title of content.

ID ID number assigned to content byEktron CMS400.NET.

Last Editor Last user to edit the content.

End Date Date and time the content expired.

Path Folder location of content in Ektron CMS400.NETWeb site.

Selecting the Report’s Date Range
To select the report’s date range, you have two options:

Option Illustration

Enter a number in theDays field. Then click the View

Reports button ( ).

Select a number from the dropdown list below theDays
field

Selecting the Report’s Date Range
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After selecting a number of days, click the view icon ( ) to see all content that
will expire within that time frame.

See Also:

n Report Toolbar Options on page 7-701

n Selecting Content by Folder on page 7-701

n Selecting Content by Type on page 7-702

n Sorting and Filtering Content Reports on page 7-703

n Performing an Action on Several Content Items on page 7-703

n Viewing/Editing Content on the Report on page 7-704

n Emailing Reports on page 7-704

Site Update Activity Report
The Site Activity Report provides a snapshot of the freshness of the content on
your Web site. Specifically, it lists how many content items were published
within a folder and date range you select, broken down by folder.

A sample report appears below.

Selecting Information to Appear on the
Report
To choose which content items will appear on the report, follow these steps.
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1. By default, only content in the default language appears on the
report. To change the language, use the language pull-down near the
top of the screen.

2. Choose a Start Date by clicking the calendar icon ( ).
3. A calendar appears. You can move to another month or year by

clicking it. When you get to the desired month, click inside the day.
The selected date turns red (see below).

4. Click Done.

5. If desired, select an End Date using the same procedure.

Note: If you do not select an end date, the report uses today as the end date.

6. At the Select field, choose a folder. The Root folder is the default
selection.

Note: Only folders for which you have read-only or greater permission appear.

To change that selection, click the folder name. When you do, the Select
Folder screen appears.

Selecting Information to Appear on the Report
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To select all folders on the screen, click the Select All checkbox.
Otherwise, select folders by clicking the corresponding checkbox. There
is also an option to Include Sub-folders of the selected folders.

7. Choose the Report type, which determines the information you will
see on the report. Options are explained below.

Report Type Description

Detail View

n name of each page that waspublished

n howmany times it waspublished

n date it was last published

n userswho published page

n total numbersare not provided

Detail View Example

Combined View information from Executive and Detail views

8. If you would like to exclude users or use groups from the report, use
the Exclude Users field. For example, you want to see all updates
other than those you have completed.

When you click Exclude Users, an alphabetical list of users appears,
followed by user groups. (User groups have a two- headed icon (

)).
9. Click Get Result.
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Search Phrase Report
This report displays all terms that were entered into the Search Text Field
within a selected range of dates. You can use it to discover the kind of
information site visitors are searching for.

This section also contains the following topics.

Selection Criteria 7-719
Display of Search Results 7-720

Selection Criteria
You can narrow down the search by selecting any combination of these criteria.

n language - the language of the search page (either Workarea or Web
site search). The user performing the search can choose a language
before inserting the search text. If he does not explicitly choose a
language, the search uses the default one. This report can show
results from all languages or any one that you select.

n a minimum number of occurrences of the word or phrase to return.
For example, you only want words or phrases entered into the
Search Text field at least 10 times during the last month.

n whether to include words or phrases entered into the Web site search
(the search page that site visitors use)

n whether to include words or phrases entered into the Workarea
search (accessed from the View Contents of Folder screen, this
search page is used by authorized CMS users to find content)

n date range

Search Phrase Report
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Display of Search Results
The search results show the number of times each word or phrase that satisfies
the selection criteria appears. They are arranged in this order.

n words or phrases with the most occurrences appear first

n if several words or phrases have the same number of occurrences,
they are arranged alphabetically

Also, terms entered into the Web site search or the Basic Workarea search are
surrounded by parentheses (). Terms entered into the Advanced Workarea
search have no parentheses. The Microsoft search engine uses this syntax to
find content.

Bad Links Report
The Bad Links Report notifies you of any invalid links to external URLs within
your content. (An invalid link returns an error code to your browser.)

Note: The report does not check quicklinks embedded in the content.

To accomplish this, the report scans the following types of content.

n published HTML content

n published XML content

n HTML forms

n XML Smart Forms

n menus

n active system templates

When the scan is complete, the report lists any item that includes an invalid
URL. From the list, you can click a button to access the item, then update or
remove the bad link.

This section also contains the following topics.

Running the Bad Links Report 7-720
Fixing Errors 7-721
Running the Bad Links Report on a Schedule 7-722

Running the Bad Links Report
To run the Bad Links Report, go to Smart Desktop > Reports. When you
select Bad Link Report, you immediately see its status, either Done or Running.
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To begin scanning for bad links, click the Check Links Now button ( ). When
you do, existing data is replaced by new data being collected as the report
progresses.

While the report scans content, you are free to work in other areas of Ektron
CMS400.NET. You can even sign off Ektron CMS400.NET. These actions have no
effect on the report’s collection of data.

If you want to stop the Bad Links Report at any time, click the Cancel button (
).

After all content is scanned, the report’s status changes to Done. If desired,
you can print the report by clicking the print button ( ).

You can also launch the broken link in a browser by moving the cursor over it
then clicking when the cursor turns into a hand.

Fixing Errors
The report lists the following information about each item that contains a bad
link.

n title

n error description

n Source, that is, item type (content, menu, etc.) followed in
parentheses by information about the item that has the error.

As examples

- if the error is in a content block, you see Content followed by its id
number and language locale id

Fixing Errors
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- if the error is in a Smart form, you see Smart form followed by its ID
number

- If it’s a menu, you see Menu Item (11,0,1033). The three
parameters are menu ID, menu item ID, and language ID.

- An error in a template looks like this:

- The beginning of the bad link’s source code. Use this to help you find
the bad link from Source View.

n the anchor (<a>) tag to which the bad link is assigned

n URL that could not be resolved (labeled Invalid Link)

To fix an error, click the edit button next to the title (highlighted below). The
item opens in edit mode, so you can fix the bad link.

The error report’s Source: field also indicates the text to which the bad link is
assigned. See content highlighted in the above graphic.

Within the content, you select the indicated text, right click the mouse, and
select Set Link Properties to access the hyperlink dialog. From here, you can
update or remove the bad link.

Running the Bad Links Report on a Schedule
You can set the Bad Links Report to run in the background at predetermined
times. If you do, you can view the report‘s latest results at your convenience
without having to wait while it compiles.

To set up a schedule, follow these steps.
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1. Open the following configuration file:
C:\Program Files\Ektron\EktronWindowsservice30\Ektron.ASM.EktronServices.exe.config

2. Within that file, go to the following line:
<add name="RunJob" type="Ektron.ASM.EktronServices.RunCMSJobManager.JobService,
Ektron.ASM.EktronServices" AbsoluteTime="Weekly|5, 2:27:00 PM" Enabled="true" />

3. Use the absoluteTime property to set the Bad Links Report’s start
time and frequency. By default, the report is scheduled to run every
Thursday at 2:27 p.m. The following table lists ways to indicate a
schedule.

Frequency How to indicate Example

Hourly Comma-separated list of integers representing the number of
minutes, secondsandmsbetween jobs

360,0,0 (every 360
minutesor 6 hours)

Daily A time in hh:mm:ssAM/PM format 11:30:00 PM (every day
11:30 pm)

Weekly

Weekly | followed byan

n is an integer that corresponds to a dayof the week, followed by
time. Use the time format described for the Daily frequency.

Use zero (0) to indicate Sunday, 1 for Monday, etc., through 7 for
Saturday.

Weekly| 0 12:00:00 PM
(everySundayat noon)

Monthly

Monthly | followed byan integer that corresponds to a dayof
themonth, followed by time. Use the time format described for
the Daily frequency.

Use zero (0) to indicate Sunday, 1 for Monday, etc., through 6 for
Saturday.

Monthly| 15 11:30:00
(the 15th of everymonth
at 11:30 PM)

Running the Bad LinksReport on a Schedule
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Content Reviews and Content
Ratings
Ektron provides two ways to rate and review content, Content Reviews and
Content Rating. These features allow you to determine how good your content is
by the people reading it. You can run reports to determine the highest rated
content or assets and tweak poorly rated or reviewed content to achieve
optimal ratings.

This section also contains the following topics.

Content Reviews vs. Content Rating 7-724
Content Review 7-724
ContentReview Server Control 7-732
Content Rating 7-739
ContentRating Server Control 7-742

Content Reviews vs. Content Rating
The Content Review feature allows you to place a star-based rating scale on any
page of your Web site. Site visitors use the scale to rate a content item. In
addition, depending on how the feature is used, site visitors can add reviews.
The review comments can be moderated and displayed next to content for site
visitors to see.

For additional information on the Content Review feature, see Content Review
below and ContentReview Server Control on page 7-732.

The Content Rating feature is deprecated. For optimal performance, Ektron
recommends the Content Review feature. For additional information on the
Content Rating feature, see Content Rating on page 7-739.

Content Review
Ektron CMS400.NET provides a content review system so site visitors can
provide reviews of content on your Web site. A visitor can rate content on a
scale of one through five stars and comment. The reviews are collected from
the Web page via the ContentReview server control.

Depending on the XSLT used with the ContentReview server control, you can
allow half star rating increments and let site visitors submit comments (see
illustration below).

Note: If a visitor is not logged in as a CMS or membership user, his browser must have cookies
enabled in order to submit a content review.
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In addition to consuming site visitors’ reviews and displaying the information in
the Workarea, the ContentReview server control can be used to display reviews
on your site. See Also: Displaying Reviews on the Site on page 7-727

Reviews can be moderated from the Smart Desktop or the Content Review
screen associated with a content item. See Also: Moderating Reviews on page
7-728

This section also contains the following topics.

Inserting the ContentReview Server Control 7-725
Limiting Visitors to One Review 7-725
Viewing the Content Reviews Report 7-726
Displaying Reviews on the Site 7-727
Exporting Details to Excel 7-727
Moderating Reviews 7-728
Viewing All Pending Reviews 7-728
Moderating Reviews From the Smart Desktop 7-730
Moderating Reviews From the Content Review Screen 7-731
Purging Rating and Review Data 7-732

Inserting the ContentReview Server Control
To allow site visitors to rate and review content on a Web page, your developer
inserts a server control. This procedure is described ContentReview Server
Control on page 7-732.

Limiting Visitors to One Review
Ektron CMS400.NET assumes you want to limit a user to rating a content item
once. If a regular or membership user logs in before rating a piece of content,

Inserting the ContentReview Server Control
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Ektron CMS400.NET remembers the user ID. For any other site visitor, Ektron
CMS400.NET places a cookie on his computer.

So, whenever a page with a ContentReview server control is visited, Ektron
CMS400.NET checks for the user ID or cookie. If neither exists, it displays a
rating scale. If the page has already been rated by the user, the user can edit
his existing rating and review by clicking a star, editing the comments, and
clicking the submit button.

Viewing the Content Reviews Report
All content review data for a content item can be displayed in detail and
summary format. To view this data, follow these steps.

1. Sign in to Ektron CMS400.NET.

2. Do one of the following:

n Navigate to the content item in the Workarea

- Go toWorkarea > Content.

- Navigate to the folder that contains the content.

- Navigate to the content item.

- Click the View Content Reports toolbar button ( ).

n If the review is awaiting moderation, use the Content Review section
of the Smart Desktop.

- Go to theWorkarea > Smart Desktop

- Click Content Reviews

- Select the content item

The Content Review shows a summary of all ratings submitted for the content.

3. Click the Get Reviews button to see the list of review comments at
the bottom.
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If desired, you can select a range of dates and limit the display of ratings data
to those dates. Select start and end dates (using calendar buttons at the top of
the screen) and click Get Reviews.

See Also: Content Review on page 7-724

Displaying Reviews on the Site
Reviews communicate how your site’s community feels about a product or
article. It also helps empower the community's members by giving them a
voice.

If your site displays reviews but a user does not see a review he submitted, it is
probably because moderation is enabled for the content reviews. If a user’s
review is pending or rejected, it is not displayed. A site or membership user
can determine the status of his review by logging into the site and navigating to
the Web page that hosts the review. Next to the title of his review is Rejected
or Pending. The user can submit another review if his review was rejected or
has been pending for too long.

The ContentReview server control’s DisplayXSLT property handles the displays
of site visitor reviews on the site. The server control can display reviews for
specific content or a specific user. See Also: DisplayXslt on page 7-736.

Exporting Details to Excel
If Microsoft Excel is installed on your computer, you can export the ratings
detail to Excel for further manipulation of the data. To do so, the Click Export
to Excel button located at the bottom of the Content Report for the content.

Displaying Reviews on the Site
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Moderating Reviews
Since reviews can be displayed on your Web site, Ektron CMS400.NET lets you
moderate reviews. This capability is handled by the ContentReview server
control’s Moderate property.

A site visitor can change his rating and review at any time, even if its status is
pending or rejected. When a visitor changes his rating or review, the
information is updated immediately in the Workarea, and the review’s status
changes to pending.

There are two ways to moderate reviews.

n from theWorkarea > Smart Desktop > Content Reviews area

n from the Content Rating screen associated with a content item

Viewing All Pending Reviews
You can view all pending reviews by clicking the View All link in the Smart
Desktop > Content Review screen.

From that screen you can:

n Approve or decline a review - select an Approve or Decline radio
button for each item on the list. Then, click the Submit button ( ).

n Mark all reviews approved or all declined - click the Mark all
approved link to set all the radio buttons to Approve. Click the Mark
all declined link to set all the radio buttons to Decline.
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n Edit the rating, review or status of an individual review - click a
review’s title and an Edit screen appears. Change as needed, then

click the Save button ( ).

Note: After editing a rating, click the Back Arrow to return to the content item’s Content Rating
screen.

n Print a report of all pending content reviews - click the Print button (
) to create an HTML version of the pending content review report

that is ready for printing.

n Email a pending content review report - click the Email button ( )
to email a pending content review report to Ektron CMS400.NET
users. Next, select the users to receive the report. Then, click the

Email button ( ) to send the report.

n Filter content reviews by folder - because reviews are associated
with content items which reside in a folder, you can filter reviews by
folder. This makes it easier to moderate reviews if you are
responsible for content in a specific folder. Click the Folder button (
) and navigate to the folder by which the reviews will be filtered.

Then, click the Save button ( ).

Viewing All Pending Reviews
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n Filter reviews by language - from the Language dropdown box, select
the language by which the reviews are filtered.

After you approve or decline reviews, click the Submit button ( ). Once
reviews are approved, they appear on the site.

Moderating Reviews From the Smart Desktop
To moderate reviews from the Smart Desktop, follow these steps.

1. From the Smart Desktop, choose the Content Reviews area.

2. The latest reviews awaiting moderation appear.

3. Select an Approve or Decline button for each item in the list.

4. Click the Approve Selected Reviews button.

5. Once the reviews are approved, they appear on the site.
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Note: A ContentReview server control set to display reviews must be on the page for reviews
to be displayed. See DisplayXslt on page 7-736.

Moderating Reviews From the Content Review
Screen
To moderate content reviews from Content Review screen, follow these steps:

1. Navigate to the Content Ratings screen for the content item using one
of the methods in Viewing the Content Reviews Report on page 7-726.

2. Click the Get Reviews button.

3. A list of reviews appear for the content.

4. Click the Title link of the content to be moderated.

5. The View Content Review screen appears.

- To change information on this screen, click the Edit button ( ). From
the Edit screen, you can change the rating, review, and status. When

finished, click the Save button ( ).

- To delete the review, click the Delete button ( ).

Moderating Reviews From the Content Review
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Purging Rating and Review Data
You can remove content rating data to free up space in your database. First
select the individual content and view the Ratings Report. Next select the date
range of the data you want to purge using Start Date and End Date. Then click
the Purge Reviews button. Click OK to the confirmation message and the
rating and review data will be purged.

ContentReview Server Control
The ContentReview server control allows site visitors to rate and review content
on your site. Place this control on a template page that’s used to display content
items or eCommerce products. For example, you might place this control on a
Master page and set it’s DynamicParameter property to ID. Then, when a Web
form containing a content item or product passes its ID to the QueryString, the
control can be used by a site visitor to record their rating and review.

The ContentReview server control can be used in two ways.

n It places a star-based rating scale on any page of your Web site. Site
visitors use the scale to rate a content item. Depending on the XSLT,
they can also submit review comments.

n It displays visitor reviews and comments. In this mode, the control
can display reviews of a content item or reviews by a specific site or
membership user. See Also:Displaying Content Reviews On the Site
below and Displaying a User’s Reviews On the Site on the facing
page.

Ektron CMS400.NET maintains and reports content reviews and ratings data.
For more information, see Content Review on page 7-724.

This section also contains the following topics.

Displaying Content Reviews On the Site 7-732
Displaying a User’s Reviews On the Site 7-733
Retrieving the XML Structure of a ContentReview 7-734
ContentReview Server Control Properties 7-735
Using the DisplayXSLT Property 7-737

Note: The eCommerce Product List server control can also display the star-based rating scale.
See Also: Set to true if you want the average ratings for this product to appear within the
product display, as shown below. (Notice the stars below the price of the item.) on page 17-
160

Displaying Content Reviews On the Site
To display content reviews on the site, follow these steps:

1. Drag and drop a ContentReview server control on a Web form.
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2. Set the DefaultContentID property to the ID of the content for
which reviews will be displayed.

Note: You can make the reviews for the content item dynamic by leaving DefaultContentID
blank and setting DynamicParameter to ID.

3. Set the DisplayXSLT property to Review List.

Note: If you want to change the look and feel of the review list, modify an existing XSL file or
create your own. If you modify an existing XSL, Ektron recommends saving the modified file
with a different name. Then, enter the path to the file in the DisplayXSLT property.

4. Set the GetReviews property to Content.

5. Save the Web form.

Below is example of content reviews displayed on a Web page.

Displaying a User’s Reviews On the Site
To display reviews for a specific user on the site, follow these steps:

1. Drag and drop a ContentReview server control on a Web form.

2. Set the DisplayXSLT property to Review List.

Note: If you want to change the look and feel of the review list, modify an existing XSL file or
create your own. If you modify an existing XSL, Ektron recommends saving the modified file
with a different name. Then, enter the path to the file in the DisplayXSLT property.

3. Set the GetReviews property to User.

4. Set the UserID property to the ID of the user for which reviews will
be displayed.

Note: You can make the list of reviews for a user dynamic by leaving the UserID blank and
setting the DynamicParameter to ID.

5. Save the Web form.

Below is example of a user’s reviews displayed on a Web page.

Displaying a User’s ReviewsOn the Site
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Retrieving the XML Structure of a
ContentReview
Retrieving the XML structure of XML content allows for greater control over
developing XSLs. The following is an example of how to retrieve the XML
structure:

1. Open a new Web form.

2. Drag and drop a ContentReview server control onto it.

3. Set the DefaultContentID property.

4. Drag and drop a Textbox on the Web form.

5. Set its TextMode property to MultiLine.

Note: Ektron recommends setting the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = ContentReview.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

The XML structure of the collection appears in the textbox.

For an additional example, see the ContentReview XML page on the
CMS400Developer samples page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/ContentList/ContentListXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/ContentList/ContentListXML.aspx and
ContentListXML.aspx.vb
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ContentReview Server Control Properties
The following table explains the properties of the ContentReview server control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value Data Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMS
Explorer to Browse Your Ektron CMS400.NET Site on page 24-8

Boolean

DefaultContentID

The ID of a content blockbeing rated by this server control.

If you don’t know the ID number of the content block, use the CMS
Explorer to browse to it. See Also:Using CMSExplorer to Browse
Your Ektron CMS400.NET Site on page 24-8

Long

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if
you want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes
shown.

Boolean

ContentReview Server Control Properties
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Property Value Data Type

DisplayXslt

Select the type of review to display, or enter the path to a custom
XSLT. For additional information, seeUsing the DisplayXSLT
Propertyon the facing page

Choicesare:

Ajax 5 Stars - a five star rating system utilizing Ajax for display.

Ajax 5 Stars Comment - a five star rating system utilizing Ajax
for display. In addition, when you hover over the stars, a review
boxpops-up below the stars. Comments that are added are
submitted via an Ajax call.

Ajax 5 Stars with Increments - a five star rating systemwith
half star increments that utilizesAjax for display.

5 Stars - a five star rating system that allowsvisitors to add text
reviewsof content.

5 Stars with Increments - a five star rating systemwith half star
increments that allowsvisitors to add text reviewsof content.

Review List - displaysa list of reviews for content or a user. See
Also:Displaying Content ReviewsOn the Site on page 7-732 and
Displaying a User’sReviewsOn the Site on page 7-733.

Path to Custom Xslt - enter the path to a customXSLT.

Warning! If you specify an external file or modify an existing file,
it is strongly recommended that you do not store this file in your
site'sWorkarea folder. If you store this file in theWorkarea
folder, the file will be lost when you upgrade.

String

DynamicParameter
Tomake this content review control dynamic, select id. When you
do, this server control is attached to the content blockpassed asa
URL parameter.

String

DynamicUserParameter When using this control to retrieve a user’s reviews, set this
property toUserId to make the user’s ID dynamic. String

GetReviews

Returnsa list of reviews for content or a user.

None - do not return reviews.

Content - returns reviewsbased on the content ID provided in
the DefaultContentIDproperty.

User - returns reviewsbased on the User ID provided in the
UserIdproperty.

ReviewTypes

Hide Select False to display this server control on the page. Select
True to suppress it. Boolean

Language Set a language for viewing content. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

MaxReviews
The number of reviews to retrieve if the GetReviewproperty is
set to Content or User. 0 (zero) = unlimited results.

See Also:GetReviewsabove
Integer
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Property Value Data Type

Moderate Setting this property to True allowsCMS400.NET users to
moderate reviews. See Also:Moderating Reviewson page 7-728 Boolean

RatingsMinimum
Sets aminimum number of reviewsand ratingsbefore displaying
the average rating.When set to 0 (zero), the average rating is
displayed as soon as content is rated the first time.

Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.
The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

UserID

The user ID for which to get reviews. If left blank, reviews from all
users are returned. If a user ID is specified, only reviews for that
user are returned.

Warning! The GetReviewspropertymust be set to User for the
control to use this property. See Also:GetReviewson previous
page

Long

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of
an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

Custom - Lets you use custom tag.

String

Using the DisplayXSLT Property
The table below shows an example of each XSLT as it appears on a Web page, a
description and the XSL file being used. The files are located in [Web
Root]\[Site Root]\Workarea\Xslt.

Warning! If you want to edit an existing file, it is strongly recommended that you make a copy,
change its name and move it outside of your site's Workarea folder. If you make changes to this
file and do not move it out of the Workarea, this file and the changes will be lost when you
upgrade. The files below are copies of files built, transformed and used, internally.

DisplayXSLT
Selection

Description File used

Ajax 5 Stars
A five-star rating system utilizing Ajax for display.

rating5star.xsl

Using the DisplayXSLT Property
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DisplayXSLT
Selection

Description File used

Ajax 5 Stars
Comment

A five-star rating system utilizing Ajax for display.When you hover
over the stars, a review boxpops-up. Visitor comments are
submitted via an Ajax call.

rating5starComment.xsl

Ajax 5 Stars
with
Increments

A five-star rating systemwith half-star increments that usesAjax
for display. rating5starinc.xsl

5 Stars

A five-star rating system that lets visitors add text reviewsof
content.

rating5starAddEdit.xsl

5 Stars with
Increments

A five-star rating systemwith half star increments that allows
visitors to add text reviewsof content.

rating5starincAddEdit.xsl

Review List
Displaysa list of reviews for content or a user.

See Also:Displaying Content ReviewsOn the Site on page 7-732
andDisplaying a User’sReviewsOn the Site on page 7-733.

ratinglist.xsl
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Content Rating
Ektron CMS400.NET lets you place a rating scale on any content on your Web
site. The scale lets you collect feedback by giving site visitors the opportunity
to rate the content. A visitor can rank the content on a numerical scale of one
through nine, as well as submit a text comment (see illustration below).

Note: The user’s browser must have cookies enabled in order to submit a content rating.

This section also contains the following topics.

Inserting the Content Rating Server Control 7-739
Limiting Visitors to One Rating 7-740
Viewing the Content Rating Report 7-740
Viewing Content Rating Details 7-741
Exporting Details to Excel 7-742
Purging Rating Data 7-742

Inserting the Content Rating Server Control
To have a content ratings graph appear on a Web page, your developer inserts
a Content Rating server control.See Also: ContentRating Server Control on page
7-742

Content Rating
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Limiting Visitors to One Rating
Ektron CMS400.NET assumes you want to limit a user to rating a content item
once. If a regular or membership user logs in before rating a piece of content,
Ektron CMS400.NET remembers the user ID. If any other site visitor does not
log in before rating content, Ektron CMS400.NET places a cookie on the site
visitor’s computer.

So, whenever a page with a Content Rating server control is visited, Ektron
CMS400.NET checks for the user ID or cookie. If neither exists, it displays a
rating scale as displayed in Content Rating on previous page. If the page has
already been rated by the user, the following version of the control appears.

Note: Since your developer can customize the control, it may not match the illustration.

Viewing the Content Rating Report
All Content Rating data for a content item is maintained and can be displayed in
detail and summary format. To view this data, follow these steps.

1. Sign in to Ektron CMS400.NET.

2. Either

- browse to the content item

- right click the mouse

- click View Advanced Report

or

- Go toWorkarea > Content.

- Navigate to the folder that contains the content.

- Navigate to the content item.
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- Click the View Rating Reports toolbar button ( ).

The Content Rating Report shows a summary of all ratings submitted for the
content.

If desired, you can select a range of dates and limit the display of ratings data
to those dates. Select start and end dates (using calendar buttons at the top of
the screen) and click Get Result.

Viewing Content Rating Details
Also, to view details of the ratings data, click Get Result (see illustration
below).

Viewing Content Rating Details
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Exporting Details to Excel
If Microsoft Excel is installed on your computer, you can export the ratings
detail to Excel for further manipulation of the data. To do so, the Click Export
to Excel button.

Purging Rating Data
You can to remove content rating data to free up space in your database. To do
so, select the date range of the data you want to purge using Start Date and
End Date. Then click the Purge button.

ContentRating Server Control
Warning! This server control is deprecated as of the 7.0.1 Release. For optimal performance,
Ektron recommends the ContentReview server control. See ContentReview Server Control on
page 7-732

Use the ContentRating server control to place a rating scale on any page of your
Web site. The scale lets site visitors rate a content item. A visitor can rank the
content on a numerical scale as well as submit a text comment.

The control lets a site visitor rate a content item only once. On subsequent visits
to the page, a message informs the visitor that he has previously rated the
page, which can optionally display a summary of ratings for it. As a result, the
control has two appearance modes: initial and complete.
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Ektron CMS400.NET maintains and reports content ratings data. For more
information, see Content Rating on page 7-739.

This section also contains the following topics.

Content Rating Server Control Properties 7-743
Ektron Label Properties 7-745
Initial Graph Display 7-745
Complete Graph Display 7-746

Content Rating Server Control Properties
The Ektron-specific Content Rating server control properties are divided into
two groups:

n Ektron - settings that affect properties, such as the display

n Ektron labels - settings that affect the text labels within the control

These properties are described below.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and
can use it to browse to Content, Collections, etc. See
Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Boolean

CompleteGraph
Display

Specify a value to indicate how the ratingsgraph
appears if a site visitor hasalready rated content.

n horizontal - graph appears to the right of the
AlreadyRatedMessage

n vertical - graph appears below the
AlreadyRatedMessage

n none - graph doesnot appear

Ektron.Cms.ContentAPI

.RatingGraphDisplayType

DefaultContentID

The ID of a content blockbeing rated by this server
control. It typicallywould be the content directly above
the rating scale if no other content block is identified, or
is not available.

If you don’t know the ID number of the content block,
use the CMSExplorer to browse to it. See Also:Using
CMSExplorer to Browse Your Ektron CMS400.NET
Site on page 24-8

Long
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Property Value Data Type

DoInitFill

By default, Fill occurs during the Page_Init event. Set
to false if you want to postpone the fill-action until
later. In this case, FIll is automatically called during the
Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

DynamicParameter
Tomake this content rating control dynamic, select id.
When you do, this server control is attached to the
content blockpassed asa URL parameter.

String

GraphBarColor The color of the bars in the graph. System.Drawing.Color

Hide Select False to display this server control on the page.
Select True to suppress it. Boolean

InitialGraphDisplay

Specify a value to indicate how the ratingsgraph
appears if a site visitor hasnot yet rated content.

n horizontal - graph appears to the right of the
content rating scale

n vertical - graph appears below the content rating
scale

n none - graph doesnot appear

Ektron.Cms.ContentAPI

.RatingGraphDisplayType

Language
Set a language for viewing content. This property
shows results in design-time (in VisualStudio) and at
run-time (in a browser).

Integer

Padding

Enter the number of pixels used to create space
between the rating scale and the graph.

Note: If you do not display the graph, this setting
hasno effect.

Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the
control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Value Data Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line
portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply
attributes to a blockof code.

Custom - Lets you use custom tag.

String

Ektron Label Properties
The label properties determine the text that appears in the server control. Most
of them are illustrated below.

Note that the first illustration describes the initial graph, while the second
describes the complete graph.

Initial Graph Display

Ektron Label Properties
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Complete Graph Display

Property Description Default Text

AlreadyRatedMessage Appears in place of the rating scale if the
user previously rated the page

You have already rated this
content.

BadLabel The low end of the rating scale Poor

CharsRemainingLabel Number of additional characters a user
mayenter into the comment. CharactersRemaining:

CookiesRequired
Message

Appears if browser cookieshave been
disabled

We're sorry, but youmust enable
cookies in your browser to rate this
content.

FeedbackHeader Introduces rating scale How would you rate the usefulness
of this content?

GoodLabel The high end of the rating scale Outstanding

RatingLevelLabel Appears above the graph Rating Level:

ThankYouMessage
Appears after site visitor selects a number,
optionally enters a comment, and presses
Submit.

Thank you for your feedback.

TotalRatingsLabel Appears below the graph, and lists the
number of rating submissions received. TotalRatings

UserCommentsHeader Introduces free-text comment area below
rating scale

Tell uswhy you rated the content
thisway

ValidationMessage
Appears on initial display if user clicks
Submit button before selecting rating
number

Please select a rating before
submitting your feedback.
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Analytics
Ektron CMS400.NET has two distinct types of analytics.

n Traffic Analytics - uses an outside service provider, such as
Google Analytics; monitors all aspects of Web traffic to your site. For
more information, see Web Traffic Analytics on page 7-777

n Business Analytics - uses Ektron CMS400.NET server controls to
track activity, store the information in the database, and provide
reports of that information. For more information, see Business
Analytics Feature below.

Business Analytics Feature
The Business Analytics feature lets you track statistics about visits to your Web
site. You can use it to determine the following kinds of information:

n how often your content was viewed

n how many site visitors viewed for first time, and how many returned

n the most popular referral pages (that is, the Web page from which
visitors clicked to arrive on your site)

Several options for selecting a date range let you compare activity across
different weeks, months, and years.

This section also contains the following topics.

Enabling the Business Analytics Feature 7-748
Templates Tracked by Business Analytics 7-748
Tracking Templates vs. Individual Content Items 7-748
Specifying the Frequency of Writing to the Database 7-748
The Statistical Data 7-749
Tracking Site Visitors 7-749
New Visitor Statistical Tracking 7-749
Writing to the IIS Log 7-750
Business Analytics Reporting 7-750
Summary of Statistical Data Available 7-751
Site Statistics 7-751
Content 7-752
Templates 7-753
Referrers 7-754
Changing the Date Range of the Statistical Data 7-755
Using Quick View Options 7-755
Using Jump To Options 7-755

Analytics
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Enabling the Business Analytics Feature
By default, the Business Analytics feature is disabled in the web.config file. To
enable it, set the value of the ek_enableClassicAnalytics property to true.

<add key="ek_enableClassicAnalytics" value="true" />

If you set this property to true and later change it to false, statistical data
remains within Ektron CMS400.NET, but no additional data is collected.

Templates Tracked by Business Analytics
Business Analytics data is tracked for every template that has an Analytics
Tracker server control. For details about dropping this server control onto a
template, see Analytics Tracker Server Control on page 7-756.

Best Practice
Drop the control onto an area that doesnot disrupt the template layout, such as the bottom.

Note: The Business Analytics feature can only track template views if the viewer’s browser
cookies are enabled.

Tracking Templates vs. Individual Content
Items
To track visitor activity to a template (for example, customerservice.aspx),
drop the server control onto it. To track activity for a content items within that
template, use control's properties designed for such tracking. See How the
Analytics Server Control Tracks Content IDs on page 7-757.

Specifying the Frequency of Writing to the
Database
Once you set up the Business Analytics feature, your database is subject to a
continuous barrage of write activity, generated by visits to your site.

To mitigate the effect of this activity on your database’s performance, you can
hold visit activity in application server memory until a predetermined amount of
data is collected. When that amount is collected, it is moved in one packet to
the database. So, the database is “hit” much less frequently.

You can specify the amount of data saved in memory prior to being written to
the database using these web.config file elements.

n recordsBeforeWrite - the number of unique template visits
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n timeBeforeWrite - the number of seconds since the last time a
database write occurred

When either element reaches the value set in web.config, all records stored in
application server memory are written to the database. That event also resets
the value of both elements to zero (0).

The Statistical Data
For every template view, the following statistical information is captured.

n url - the visited page

n content_id - the ID of the visited content. Captured by the Analytics
server control. See Also: How the Analytics Server Control Tracks
Content IDs on page 7-757 Tracking Templates vs. Individual Content
Items on previous page

n visitor_id - a unique GUID that identifies a visitor

n hit_date - date and time when a page view occurred

n referring_url - the URL a user was viewing before jumping to the
visited page

n visit_type - zero (0) indicates new visitor, 1 indicates returning
visitor, 2 indicates all other views. See Also: Tracking Site Visitors
below

After a user logs on, the first page hit tracks the visit as zero (0) (if
the user is new) or 1 (if the user previously visited the page). From
then on, 2 is logged for that user.

Tracking Site Visitors
The Business Analytics feature provides information about visits made by new
versus returning visitors. To capture this data, the feature asks this question
whenever a page is visited: is the user logged in as either a membership or
regular user?

n If yes, capture the user ID with the statistical data

n If no, place a cookie on the visitor’s computer

So, the first time a user visits a page, either user information is captured or a
cookie is created.

The next time the user visits that page, the feature checks the visit history for
the user ID, or for a cookie. If either is found, the visit is considered a return.

New Visitor Statistical Tracking
The same user visit may be considered new on one view but not on another. For
example, someone visits on January 30 (Monday) then again February 2
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(Thursday). On the monthly statistics, that visitor is new, but on the weekly
statistics, the February 2 hit would be a return visit (his second this week).

Now consider a second visitor, who browses to your site on the first and 20th of
the month. These visits would appear on weekly statistics as two new visits, but
on the monthly statistics, only the first visit would show up on that month's tally
of new visitors. The second visit would add to the return visitor statistics.

Writing to the IIS Log
In addition to writing Business Analytics data to the database, you can write it
to the IIS log. To do this, enable the appendToIISLog element in the
web.config file.

Note that if you set appendToIISLog to true, some Business Analytics data is
only written to the IIS log and does not appear in the Workarea.

Business Analytics Reporting
The Business Analytics feature's reports let you drill down from the entire site
to individual templates to individual content items.

Prerequisite: In your site's web.config file, the ek_enableClassicAnalytics
setting must be set to true.

Note: The Most Popular and Trends Widgets also report on Business Analytics data. See The
Most Popular Widget on page 7-759 and The Trends Widget on page 7-764.

To access Business Analytics Reports, follow these steps.

Either

1. Browse to a content item for which Business Analytics data is being
captured.

2. Right click the mouse.

3. Click View Template Activity to see Business Analytics data for the
current content item (to learn more about data captured for one
content item, see Content on page 7-752).

4. Click View Site Analytics to view Business Analytics data for the
entire site.

or

1. Go to Ektron CMS400.NET Workarea > Reports > CMS Site
Analytics to view analytic data for the entire Web site.

Five levels of reporting are available.

n Site Statistics on the facing page

n Business Analytics Feature on page 7-747

n Content on page 7-752

n Business Analytics Feature on page 7-747
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n Referrers on page 7-754

Summary of Statistical Data Available
The following table lists the kinds of analytic statistics that can be viewed at
each level of the site.

Type of Statistical Information Site-wide
Template-
Level

Content-
Level

Viewsof AnyTemplate

Visitors: New and Return

Pie Chart of New vs. Return Visitor

Pie Chart of Views/VisitorsRatio

Bar Graph of Views/VisitorsRatio

Visited Pages

Visited Content Blocks

URLs fromwhich Site Visitors
Accessed Ektron CMS400.NET

Site Statistics
The Site Statistics screen offers an overview of all tracked activity within the
selected date range. You see actual data for the

n number of views

n number of visitors

n ratio of visitors per view

n number of new and returning visitors

n ratio of new to return visitors

Below this data are pie charts of the ratio of views to visitors and new vs.
return visitors.

Summary of Statistical Data Available
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Note: To understand how new and returning visitors are tracked, see Tracking Site Visitors on
page 7-749.

See Also: Analytics Tracker Server Control on page 7-756

Content
The Content View shows the most frequently-accessed content items on your
Web site.

See Also: Tracking Templates vs. Individual Content Items on page 7-748,
Business Analytics Feature on page 7-747
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You can click any content item to view

n Content Statistics - statistics for that content item only (See Also:
Site Statistics on page 7-751)

n Content Activity - relative activity for that content item only (See
Also: Business Analytics Feature on page 7-747)

n Audit Content - all users who viewed the selected content item; to
the right of each user are the date and time when the content was
viewed

Note: Only users who viewed the content after logging in appear on the list. Visitors to your
site who do not log in affect statistics but are not tracked on this report.

Templates
The Templates View shows all viewed templates on your Web site, with the
most frequently-accessed ones on top.

By default, the templates at the top have the highest number of unique visitors.
You can change the sort by clicking on any column header. For example, to sort
templates by the number of views, click Views.

See Also: Business Analytics Feature on page 7-747

Templates
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You can click any template to view

n Template Statistics - statistics for that template only (See Also:
Site Statistics on page 7-751)

n Template Activity - relative activity for that template only (See
Also: Business Analytics Feature on page 7-747)

n Content in Template - if a content items was specified for the
template in the Content Analytic server control, this view show
statistics for the template. You can click the template to view
Template Level activity. (See Also: Business Analytics Feature on
page 7-747)

Referrers
The Referrers View shows the domains from which your site was most
frequently accessed.
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See Also: Business Analytics Feature on page 7-747

Changing the Date Range of the Statistical
Data
When you first view statistical data, the default date range is today (one day).

If you view statistics for different date ranges, when you return to the screen,
the last selected date range is the default selection. You can change it if
needed.

Using Quick View Options
Use Quick View options to view analytic statistics for any of the following time
periods.

n one day

n one week

n one month

n one year

When you click Quick View [week], [month] or [year], the current end
date is used as the last day of the range. Here are some examples.

Quick view time option If end date is today, begin date is

Week one weekearlier than today

Month onemonth earlier than today

Year one year earlier than today

Using Jump To Options
Use Jump To options to view analytic statistics for a time period before and
after the current date range. The time period is determined by the Quick View
increment. For example, if the Quick View option is Day, you can jump to the
previous day, the following day, or today.

Regardless of the Quick View increment, you can always view statistics for
today.

Quick view option If end date is today, begin date is

Day

n previousday

n next day

n today

Changing the Date Range of the Statistical Data

ReferenceManual
Version 8.01 Rev 4

7-755



Quick view option If end date is today, begin date is

Week

n previousweek

n next week

n today

Month

n previousmonth

n next month

n today

Year

n previous year

n next year

n today

Analytics Tracker Server Control
Use the Analytics Tracker server control to track Business Analytics statistics
about visits to your site, such as:

n how often your content is viewed

n how many site visitors viewed for first time, and how many returned

n the most popular referral pages (that is, the Web page from which
visitors clicked to arrive on your site)

The data recorded by this server control is used by

n the Most Popular and Trends Widgets' Most Viewed category, as
shown below.

See Also: The Most Popular Widget on page 7-759The Trends Widget on page
7-764

n the Classic Analytics Reports, available from the Ektron CMS400.NET
Workarea > Reports > CMS Site Analytics section. See Also:
Business Analytics Reporting on page 7-750
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This section also contains the following topics.

Prerequisites 7-757
How the Analytics Server Control Tracks Content IDs 7-757
Analytics Tracker Server Control Properties 7-757

Prerequisites
n Your site's license key supports Analytics See Also: License Keys on

page 1-5

n Either the control's enableanalytics property is set to true

or

n the enableanalytics property is set to ConfigSpecified, and the
enableAnalytics key in your web.config file is set to true

How the Analytics Server Control Tracks
Content IDs
The AnalyticsTracker server control provides three properties (listed below) for
determining which content items are viewed when a site visitor browses to a
page that contains the control. The properties are additive, that is they can be
used together.

n DefaultContentID property - tracks one content item

n ContentIdsList - tracks additional content items. For example, a
page contains four content blocks, and you want to track a hit for
each of them when a site visitor views the page. Insert one ID into
the ContentID property, and the other three as a comma separated
list into this property.

n DynamicParameter property - tracks the content ID in the query
string parameter of the URL used to access the page

Note: If you want to track your entire site, place the Analytics Tracker server control on your
master pages on your site templates, and use the DynamicParameter property.

Analytics Tracker Server Control Properties
Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Prerequisites
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Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

Boolean

ContentIdsList

Enter a comma-separated list of content IDs to be tracked. The
DefaultContentId and the dynamicParameter are also tracked. See
Also:How the AnalyticsServer Control TracksContent IDson pre-
viouspage

String

DefaultContentID

The ID of a content blockbeing tracked by this server control. It
typicallywould be the content directly above the analytics tracker if no
other content block is identified, or is not available.

If you don’t know the ID number of the content block, use the CMS
Explorer to browse to it. See Also:Using CMSExplorer to Browse
Your Ektron CMS400.NET Site on page 24-8

See Also:How the AnalyticsServer Control TracksContent IDson
previouspage

Long

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

DynamicParameter

Tomake this control dynamic, select id. When you do, this server
control is attached to the content blockpassed asa URL parameter.

See Also:How the AnalyticsServer Control TracksContent IDson
previouspage

String

EnableAnalytics

Set one of these values to determine if this server control tracks
BusinessAnalytics statistics.

n true - this control tracksanalytics

n false - this control doesnot trackanalytics

n ConfigSpecified - use the setting in the site root/web.config file's
enableAnalyticskey. For example, if that key=true, this control
tracksanalytics.

Note that the first two options (true and false) let you enable/disable
this particular control. Use the last option,ConfigSpecified, if you
want to use a single web.config setting to enable/disable allanalytics
controls.

String

Hide Select False to display this server control on the page. Select True to
suppress it. Boolean
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Property Value
Data
Type

Language Set a language for viewing content. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

WrapTag

Allowsa developer to specify a server control’s tag. The default is
Span.

Span - Use this tag to designate an in-line portion of an HTML
document asa span element.

Div - Use this tag when you want to apply attributes to a blockof code.

Custom - Use a custom tag.

String

The Most Popular Widget
The Most Popular widget reports on these categories of content on your Web
site.

n Most Viewed

n Most Emailed

n Most Commented

n Highest Rated

You can place the Most Popular widget onto any PageBuilder page. See Also:
Building PageBuilder Pages on page 5-1

Note: You cannot place more than one Most Popular widget on a PageBuilder page. Also, you
can hide up to three tabs if you do not want all of them seen.

This section also contains the following topics.

Content Events 7-760

Determining Which Content Appears on the Most Popular Widget
7-
760

TheMost Popular Widget
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Source of Information on the Most Popular Widget Tabs 7-761
The Content Count 7-762
Determining the Maximum Number of Results on the Widget 7-762
Editing the Most Popular Widget's Properties 7-763

Content Events
The Most Popular widget references content events, which are Ektron
CMS400.NET events that are tracked when used with various server controls.
Here are two examples of a content event:

n for the Most Viewed tab, the content was viewed and tracked by the
Analytics Tracker server control

n for the Most Emailed tab, the content was emailed from the Social
Bar server control

Determining Which Content Appears on the
Most Popular Widget
The Most Popular widget displays content items that meet these criteria.

n the content is tracked by a server control listed in Source of
Information on the Most Popular Widget Tabs on the facing page

n content events occurred within the date range set in the Most Popular
widget properties. The default value is 7 days, but you can change it
if desired. See Also: Content Events above

n the content is assigned to a selected folder or taxonomy. By default,
the widget has no folder or taxonomy restrictions. But the properties
screen lets you restrict results by folder or taxonomy.

n the content is among the highest rated content items for that tab.

For example, if the Most Viewed tab shows the top 5 content items
(the default setting), content that has not been viewed as frequently
as the top five does not appear. Consider the following example.

Content ID
Number of Times Content
has been Viewed within Date
Range

30 87

259 82

316 78

Managing Content in Ektron CMS400.NET

7-760 ReferenceManual
Version 8.01 Rev 4



Content ID
Number of Times Content
has been Viewed within Date
Range

12 78

658 67

243 62

In this case, content ID 243 does not appear on the Most Popular widget
because it is sixth in the frequency of viewing rank.

To learn how to set the maximum number of content items that can appear for
any tab, see Determining Which Content Appears on the Most Popular Widget on
previous page.

Source of Information on the Most Popular
Widget Tabs
Each time a content item is used with one of the following server controls, its
count for that day is incremented by one.

Tab
Source of
Content that
Appears

Sample Event

Most
Viewed

AnalyticsTracker
Server Control
on page 7-756

A site visitor browses to a page that is tracked by the Analytics
Tracker server control. The control lets you determine which content
is counted when the page is viewed.

Most
Emailed

SocialBar Server
Controlon page
16-235

(it must be
associated with
content)

A community groupmember browses to a page that hosts the Social
Bar server control, and emails a content item to a friend.

Most
Commented

MessageBoard
Server Control
on page 16-67

(it must be
associated with
content)

ACommunityGroupmember browsesa page that hosts theMes-
sage Board server control and comments on a content item on that
board.

Highest
Rated

ContentReview
Server Control
on page 7-732

A site visitor browses to page that hosts the Content Review server
control, and uses the control to rate a content item.

Source of Information on theMost Popular Widget
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The Content Count
Next to each content item is a count (circled below).

The count indicates the number of times a content event occurred for that
content item within the specified time frame. See Also: Content Events on page
7-760

Note that the date range (explained in Determining Which Content Appears on
the Most Popular Widget on page 7-760) may affect the count. For example, if a
content item was viewed once a day for the past 10 days but the date range is
set to 7 days, the count is 7.

Determining the Maximum Number of Results on
the Widget
By default, every Most Popular widget tab shows up to five results, as shown
below.

To change this maximum, follow these steps.

1. Open siteroot/widgets/mostpopular.ascx.cs.

2. Find the following line : privateint _PageSize = 5;.

3. Change the number at the end of the line to the maximum number of
results to display.

Note: This setting affects all tabs and instances of the Most Popular widget.
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Editing the Most Popular Widget's Properties
A logged in user can change the properties that determine what appears on the
Most Viewed tab. To do so, click the edit button (circled below).

When you do, the edit screen appears.

Property Default Value Description

Tab text Most Viewed The text that appears on this tab. In the above example, the left tab 's
text isMost Viewed.

Visible checked Determines if the tab you are editing appears on the widget. At least
one tabmust appear.

Number of
days to
report

7

The number of days for which to display the data.

The current day is not counted, since it is incomplete. So if you enter 1,
you see information for all of yesterdayand today.

The date calculation is based on the clockon theWeb site's server.

Note:  You can change this to anynumber you wish. However, the
widget can only show data for days for which data is stored in your
database.

Report

n Tab 1 - Most
Viewed

n Tab 2 - Most
Emailed

n Tab 3 - Most
Commented

n Tab 4 -
Highest Rated

Determines the information appearswhen a tab is clicked. See Also:
Source of Information on theMost Popular Widget Tabson page 7-
761

Filter By Folder

You can restrict the content appears on thiswidget by selecting a
folder or a taxonomy.

While selecting a folder/taxonomycategory, you have the option to
include all folders/categoriesunder the selected one.

If you later want to remove this restriction, click the Delete button ( ).

Editing theMost Popular Widget's Properties
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The Trends Widget
By default, the Trends widget shows the Most Viewed content on your Web site.
You can edit the widget's properties so that it displays any of the following
categories of content instead.

n Most Emailed

n Most Commented

n Highest Rated

You can place the Trends widget onto any PageBuilder page. See Also: Building
PageBuilder Pages on page 5-1

The Trends widget is a subset of the The Most Popular Widget on page 7-759, so
you should be familiar with that section before reading this. It explains topics
such as how Ektron CMS400.NET determines which content appears for each
category.

Editing the Trends Widget's Properties
A logged in user can change properties that determine the appearance of the
Trends widget. To do so, click the edit button (circled below).

When you do, the edit screen appears.
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The following table explains the screen's fields.

Property
Default
Value

Description

Report
Type

Most
Viewed

Report typesare

n Most Viewed

n Most Emailed

n Most Commented

Highest Rated

To learn about the report types, seeSource of Information on theMost
Popular Widget Tabson page 7-761

Number
of days
to report

7

The number of days for which to display the data.

The current day is not counted, since it is incomplete. So if you enter 1, you
see information for all of yesterdayand today.

The date calculation is based on the clockon theWeb site's server.

Note:  You can change to anynumber you wish. However, the widget
only showsdata for days for which data is stored in your database.

Order
Direction

Sort
Descending

The direction in which search results are sorted.

Ascending - Alphabetical results from A to Z; numeric values low to high;
dates from oldest to most recent

Descending - Alphabetical results from Z to A; numeric valueshigh to low;
dates frommost recent to oldest

The default isDescending.

Editing the TrendsWidget's Properties
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Property
Default
Value

Description

Maximum
Number
of Items

5

Enter themaximum number of content items that mayappear on the Trends
widget.

The Ektron CMS400.NET databasemaintains a count (number of hits) for
each content item, for each date. Once you select a number of days, the
Trendswidget displays the content with themost hits during that date range,
up to the number you set in this field. See Also: TheMost Popular Widget on
page 7-759

Filter By None

You can filter which content appears on thiswidget by selecting a folder or a
taxonomy.

While selecting a folder/taxonomycategory, you have the option to include all
folders/categoriesunder the selected one.

If you later want to remove this restriction, click the Delete button ( )

Business Analytics API
The Business Analytics API consists of several static methods arranged into two
groups:

n those that save events to the database

n those that retrieve the event data from the database for use in
reports

The following illustration depicts saving event data to the database.
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This illustration depicts retrieving that data into reports.

This section also contains the following topics.

Using the API 7-769
Saving Event Data 7-769
Saving an Event 7-769
Reading Event Data 7-770
GetReportNameList Method 7-771
CreateQueryRequest Method 7-771
CreateContentQueryRequest Method 7-772
GetList Method 7-773
UpdateReportData Method 7-774
Customizing the Saving and Reading Behavior 7-775
Disabling the Saving or Reading of Events 7-775
Using a Custom Provider 7-775

Note: The demonstration code in this document uses C# syntax.
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Using the API
The API's namespace is
Ektron.Cms.Framework.Analytics.BusinessAnalytics.

Saving Event Data
To save events, use the static class EventLogger, which exposes the following
methods.

n IAnalyticsEventData CreateAnalyticsEventData()

n void Log(IAnalyticsEventData eventObject)

n void Log(string eventName)

n void Log(string eventName, string xml)

n void Log(string eventName, string xml, int count)

The EventLogger class is illustrated below.

Saving an Event
As long as an event (myEvent) has been registered in the system, you can store
an event like this:

using Ektron.Cms.Framework.Analytics.BusinessAnalytics;

…

EventLogger.Log(“myEvent”);

This code saves the event data with default values.

As shown above, the Log method has several overloaded versions. Each
provides a different amount of control over the information saved to the
database. The following table lists the Log method's parameters.
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Parameter Type Description

eventName string A name that uniquely identifies the event. This namemust be registered and
enabled in the database for it to be recorded.

XML string

This parameter is purely for customization. Bydefault, its value is null.

The API stackpasses the string to the database, where the appropriate stored
procedure can use it. For example, it can store additional values that are not part of
the current event-object

count int Allows increments other than the default value of one. For example, youmaywant
a specific event to increment the event counter by5.

In addition to the parameters listed above, you can set other values by
referencing the event object that carries the information to the database. A call
to CreateAnalyticsEventData returns this object, and can be used as follows:

IAnalyticsEventData eventObject = CreateAnalyticsEventData();

Through the interface IAnalyticsEventData, the object provides the following
additional parameters, which allow more control over what information is saved
with the event.

Parameter Type Description

ObjectId long For a content related event, ObjectId should be set to a Content ID.

LanguageId int The content object's Language ID. If that is not available, the current
request's Language ID.

SiteId long

The current request'sSite ID

Note:  A value of -1means this value hasnot been set, and will be
updated appropriately at a lower level.

UserId long The current request'sUser ID (if logged in)

VisitorId string The current request'sVisitor ID (if not logged in)

EventDate DateTime Defaults to current date and time

Reading Event Data
Use the static class EventReporter to retrieve events stored in the database.
This class exposes the following methods.

n IList<string> GetReportNameList() - see GetReportNameList
Method on the facing page
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n IAnalyticsQueryRequest CreateQueryRequest() - see
CreateQueryRequest Method below

n IContentQueryRequest CreateContentQueryRequest() - see
CreateContentQueryRequest Method on next page

n IList<IAnalyticsEventItem> GetList(IAnalyticsQueryRequest
queryRequest) - See GetList Method on page 7-773

n IList<IContentEventItem> GetList(IContentQueryRequest
queryRequest)- See GetList Method on page 7-773

n void UpdateReportData(String eventName, DateTime
eventDate) - see UpdateReportData Method on page 7-774

The Eventreporter classes are illustrated below.

GetReportNameList Method
Use the GetReportNameList method to obtain a list of recognized (e.g.,
registered) report names. You can extend this list by adding custom event
types and their corresponding stored procedure handlers.

For example, to obtain a list of the allowed report names, use the following
code.

using Ektron.Cms.Framework.Analytics.BusinessAnalytics;

...

IList<String> names = EventReporter.GetReportNameList();

CreateQueryRequest Method
Use the CreateQueryRequest method to specify an event data report of the
base-level type. The method returns an object that implements the interface
IAnalyticsQueryRequest, which has the following parameters.

GetReportNameList Method
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Parameter Description Type

ReportName

Uniquely specifies the report, which is registered
and corresponds to one or more stored
procedureswhich, when run, generate the
requested data.

string

SiteId The Site ID of the data being returned. long

UserId The User ID of the data being returned. long

EventStartDate
If desired, use to determine the earliest date for
which report data is returned. Bydefault, data
from the earliest date is returned.

DateTime

EventEndDate
If desired, use to determine the latest date for
which report data is returned. Bydefault, data
through themost recent date is returned.

DateTime

PagingInfo

Page size and number allow you to display a small
portion of the report at a time.

By setting page size and number, the report data
is reduced, and performance will improve.
Conversely, performance degradesaspage size
(RecordsPerPage) increases, especially if the
amount of stored data is large.

Ektron.Cms.PagingInfo

This type has the following fields:

n CurrentPage

n EndRow

n RecordsPerPage

n StartRow

n TotalPages

n TotalRecords

OrderByDirection Descending or Ascending EkEnumeration.OrderByDirection

XML

This parameter is purely for customization. By
default, its value is null.

While saving event data, the API stackpasses the
string to the database, where the appropriate
stored procedure can use it. For example, it can
store additional values that are not part of the
current event-object.

Within the CreateQueryRequestmethod, this
parameter can returns that string.

string

CreateContentQueryRequest Method
Use the CreateContentQueryRequest method to specify a report of event data
that is related to content. It returns an object that implements the interface
IContentQueryRequest which, in addition to those provided by interface
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IAnalyticsQueryRequest (see CreateQueryRequest Method on page 7-771)
 has the following parameters.

Note: You can use either the FolderID or the TaxonomyID parameter but not both. Also, you
can only use the IncludeChild parameter related to the selected parent parameter.

Parameter Type Description

LanguageId int The Language ID of the content that the report returns.

FolderId long
The folder of the content being returned. All content in the
folder is returned. It defaults to that of the current HTTP
request.

IncludeChildFolders boolean Determineswhether the report includes children of the
folder specified in the FolderID parameter.

TaxonomyId long
The taxonomycategory of the content being returned. All
content to which the category is applied the folder is
returned. It defaults to that of the current HTTP request.

IncludeChildTaxonomy boolean Determineswhether the report includes children of the
folder specified in the FolderID parameter.

GetList Method
There are two versions of the GetList method.

n One version takes an IAnalyticsQueryRequest object, and returns
a list of objects that implement IAnalyticsEventItem. That version
has the following parameters.

Parameter Type Description

ID long The object Id s supplied when the related eventswere saved.

XML string

This parameter is purely for customization. Bydefault, its value is
null.

While saving event data, the API stackpasses the string to the
database, where the appropriate stored procedure can use it. It
can store additional values that are not part of the current event-
object.

n The other version of the GetList method takes an
IContentQueryRequest object and returns a list of objects that
implement the interface IContentEventItem . That provides the
following parameters in addition to those of IAnalyticsEventItem
(shown above).

GetList Method
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Parameter Type Description

LanguageId int The Language ID of the content that the report returns.

Quicklink string
The object'sURL.

Title string Determineswhether the report includes children of the
folder specified in the FolderID parameter.

Teaser string The content summary. See Also:Working with Content
Summaryon page 7-137

Status char The content's status. See Also:Content Statuseson page
7-130

FolderID long The FolderID of the content being reported.

Count int

The count of the object being reported. For example, if you
are retrieving themost frequently emailed content item,
the count is the number of times it wasemailed.

The count and average valuesmaybe used individually or
together, depending on the report. For example, the
rating report returnsboth the average (rating) and the
count (the number of ratings), while the commented
report usesonly the count.

Average decimal

The a numerical value divided by the count. For example,
when Ektron CMS400.NET calculatesaverage content rat-
ing, it divides the total number of rating points (on a scale of
1 thru 10) by the number of votes.

UpdateReportData Method
This method tells the database that an event's details should update that event's
aggregated data. This method is only required if the database does not
automatically do this, such as when the corresponding bit is disabled for that an
type in the database. Disabling the corresponding bit generally improves
performance, especially if the event logging rate is high. But, if you disable the
corresponding bit, you must call this update method if you want the report to
show current data.

The UpdateReportData method takes the following parameters.

Parameter Type Description

eventName string The event whose data will be updated.
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Parameter Type Description

eventDate date time

The date of the event's occurrence. For example, if you pass1/1/2009,
one row in the aggregate table is updated. If the row doesn't exist, it gets
created.

If you do not passan event date, thismethod updates the aggregate table
with summary info for that event for all dates.

For example, if today isFebruary 1, the system hasbeen in use since the
beginning of the year, and you passNULL for the date, 32 table rowsare
updated (31 days in January plus 2/1).

Customizing the Saving and Reading
Behavior

n Disabling the Saving or Reading of Events below

n Using a Custom Provider below

Disabling the Saving or Reading of Events
You can disable the saving or reading of all events or of individual events.

It is useful to disable events when you want to minimize database traffic. To
disable all events, follow these steps.

1. Open siteroot/web.config.

2. Set the following parameters to false ( as shown below).
<!-- Enable saving business-analytics events to the database (at API level) -->

<add key="ek_enableBusinessAnalyticsEventStorage" value="false"/>

<!-- Enable querying the database for business-analytics events (at API level) -->

<add key="ek_enableBusinessAnalyticsEventReports" value="false"/>

Note: These settings are set to enabled (true) by default.

You can also enable or disable individual events in the database itself, but this
does require a call to travel through the full stack.

Using a Custom Provider
Below the service level are providers that read and write event data. The
default providers simply pass calls through to the standard Ektron database-
access-level code, which reads and writes from the database. But you can
modify this behavior to almost any conceivable alternative. For example, you
can

n save the data to an alternate database on an alternate machine

n call a web service to handle the reads and writes

Customizing the Saving and Reading Behavior
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n filter the data and/or requests

n process information on its way to or from the database

The SDK contains sample providers, as well as full source code for the Ektron-
supplied providers. You can use this material as a basis for writing custom
providers, which is the preferred technique for customizing the behavior of the
Business Analytics API stack and subsystem.

The Default Providers
The default providers for saving and reading event data (respectively) are
EktronEventProvider.cs and EktronQueryProvider.cs.

Example custom-provider source code has the following names for saving and
reading event data (respectively): “DemoEventProvider.cs” and
“DemoQueryProvider.cs”

For the default providers, the siteroot/web.config file must contain the
following, inside <configuration><configSections>.

<section name="businessAnalyticsQueryProvider"
type="Ektron.Cms.Analytics.Providers.BusinessAnalyticsQueryProviderConfiguration,
Ektron.Cms.BusinessObjects" allowDefinition="MachineToApplication"
restartOnExternalChanges="true"/>

<section name="businessAnalyticsEventProvider"
type="Ektron.Cms.Analytics.Providers.BusinessAnalyticsEventProviderConfiguration,
Ektron.Cms.BusinessObjects" allowDefinition="MachineToApplication"
restartOnExternalChanges="true"/>

Additionally, the following must exist inside the <configuration> tags.

<businessAnalyticsQueryProvider defaultProvider="EktronBusinessAnalyticsQueryProvider">

<providers>

<add name="EktronBusinessAnalyticsQueryProvider"
type="Ektron.Cms.Analytics.Providers.EktronQueryProvider, Ektron.Cms.BusinessObjects"/>

</providers>

</businessAnalyticsQueryProvider>

<businessAnalyticsEventProvider defaultProvider="EktronBusinessAnalyticsEventProvider">

<providers>

<add name="EktronBusinessAnalyticsEventProvider"
type="Ektron.Cms.Analytics.Providers.EktronEventProvider, Ektron.Cms.BusinessObjects"/>

</providers>

</businessAnalyticsEventProvider

Creating Custom Providers
To override the default Ektron provider with the a custom provider, follow these
steps.

1. Create a new solution with a project named CustomProviders.
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2. Add the following references to your project.

n Ektron.Cms.BusinessObjects.dll

n Ektron.Cms.Common.dll

n Ektron.Cms.ObjectFactory.dll

3. Add files DemoEventProvider.cs and DemoQueryProvider.cs (from
the Ektron SDK).

4. Build.

5. Copy the CustomProviders.dll file to your Ektron CMS400.NET site's
bin file.

6. Update web.config by modifying the <configuration> section.
Specifically, add demo providers to the Business Analytics providers
as shown below.

<businessAnalyticsQueryProvider defaultProvider="DemoQueryProvider">

<providers>

<add name="EktronBusinessAnalyticsQueryProvider"
type="Ektron.Cms.Analytics.Providers.EktronQueryProvider, Ektron.Cms.BusinessObjects"/>

<add name="DemoQueryProvider" type="Ektron.Cms.Analytics.Providers.DemoQueryProvider,
CustomProviders"/>

</providers>

</businessAnalyticsQueryProvider>

<businessAnalyticsEventProvider defaultProvider="DemoEventProvider">

<providers>

<add name="EktronBusinessAnalyticsEventProvider"
type="Ektron.Cms.Analytics.Providers.EktronEventProvider, Ektron.Cms.BusinessObjects"/>

<add name="DemoEventProvider" type="Ektron.Cms.Analytics.Providers.DemoEventProvider,
CustomProviders"/>

</providers>

</businessAnalyticsEventProvider>

Web Traffic Analytics
By analyzing the user traffic coming to and interacting with your site, you can
better understand key elements of your Web presence. Traditional Web
analytics packages help you understand where your traffic is coming from,
when the traffic is occurring (including high and low points) and what pages
users are interacting with. But this information is often isolated from the Web
content and is, therefore, lacking the context needed to take advantage of it.

Ektron CMS400.NET has a fully-developed, Web traffic analytics provider
model. By hooking into best-of-breed analytics software, like Google Analytics,
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your Web site’s information is integrated into CMS400.NET’s Workarea and so is
at your fingertips as you use it to optimize the site experience.

Analytics can help you

n determine the popularity of areas of your site

n examine click-through rates on your calls to action

n analyze site structure and navigation

n obtain key information about your site visitors

This information is essential to optimizing your site’s content. Its seamless
integration into CMS400.NET lets you fully leverage the data.

This section also contains the following topics.

Using Web Traffic Analytics Data within Ektron CMS400.NET below

The Flow of Web Traffic Analytics Data on the facing page

Google Web Analytics Provider on page 7-780

Setting up Google Web Traffic Analytics on page 7-781

Authorization to View Web Traffic Analytics Data on page 7-784

Viewing Web Traffic Analytics Data on page 7-785

Using Web Traffic Analytics Data within
Ektron CMS400.NET
Ektron CMS400.NET’s Workarea provides customized reporting, reflecting
exactly the information you care about. The data can be broken down in many
ways, such as

n number of visits per day

n browser usage

n visitor location

n visitor language

n top content

n referring sites

Web Traffic Analytics data is available for your entire site as well as individual
pages. A sample Web Analytics display is below.
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The Web Analytics widget can be placed on your dashboard, so that you have
instant access. Also, the software is integrated into the content history. This
makes your traffic analytics more relevant: you can see what modifications
were made, when, and how they impacted traffic to that page. You can react
immediately, restoring content that performed better or changing the current
content to better reflect your goals.

This full integration makes your analysis more efficient; there is no
reconfiguration of the analytics tool and no learning curve. Customer reporting,
segmentation, and legacy data are easier to access, and Ektron CMS400.NET
becomes the central hub for all of your Web site’s information, bringing it
together so that it is no longer siloed. Having all information in one place puts it
in context, making it easier to draw the conclusions you need to optimize your
Web presence.

The Flow of Web Traffic Analytics Data
As shown above, once you set up Web Traffic Analytics, the Analytics Provider
monitors every site visit. In the Workarea, you can view this data from many
angles.
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Warning! No data is stored in Ektron CMS400.NET -- the CMS retrieves it upon demand from
your Web Analytics provider.

Google Web Analytics Provider
Google Web Traffic Analytics is an enterprise-class solution that gives you rich
insights into your Web site traffic and marketing effectiveness. Powerful,
flexible and easy-to-use features let you see and analyze your traffic data in an
entirely new way. With Google Web Analytics, you're more prepared to write
better-targeted ads, strengthen your marketing initiatives, and create higher
converting Web sites.

Its main features are:

n Advertising ROI - Measure the success of your display, search, new
media and offline advertising efforts.

n Cross Channel and Multimedia Tracking - Compare your site
usage metrics with industry averages and track Flash, video, and
social networking sites and applications.

n Visualizing Data - Uncover trends, patterns, and key comparisons
with funnel visualization, motion charts, mapping, and more.

n Customized Reporting - Create the reports, dashboards, and
segments that make the most sense for your business.

n Sharing and Communicating - Administration controls and email
reports allow you to share data across your organization.
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n Google Integration and Reliability - Google Web Analytics
complements a suite of related products, all running on the same
world renowned infrastructure that powers Google.

For a product tour, see http://www.google.com/analytics/tour.html.

Setting up Google Web Traffic Analytics
There are two options for setting up Web Traffic Analytics.

n Tracking Your Entire Web Site below

n Tracking a Single Page on page 7-784

See Also: Setting up Web Analytics for Multiple Sites or Providers on page 7-
784

Tracking Your Entire Web Site
Follow these steps to set up the default Web Analytics provider, Google
Analytics, to track your entire site.

Warning! Enabling the tracking code may cause a significant increase in CPU usage.

1. Create a Gmail account (http://mail.google.com).

2. Sign up for Google Web Analytics (www.google.com/analytics/).

When you set up a Google Web Analytics profile for your site, you are
assigned a profile ID and a User Account. You will need those to
complete Step 7.

3. On the server that hosts Ektron CMS400.NET, go to C:\Program
Files\Ektron\CMS400v80\Utilities\EncryptEmailPassword.exe.

4. Use that utility to encrypt the Gmail username and password that you
obtained in Step 1.

5. Open your site’s siteroot/web.config file.

6. Find the AnalyticsDataProvider tag, shown below.
<AnalyticsDataProvider defaultProvider="Google">

<providers>

<add name="Google" type="Ektron.Cms.Analytics.Providers.GoogleAnalyticsProvider,
Ektron.Cms.BusinessObjects" Username="" Password="" ProfileId="" SiteURL=""
UserAccount=""
GoogleAnalyticsTrackingCodePath="Analytics\template\googletrackingcode.ascx" />

</providers>

</AnalyticsDataProvider>

Note: If your web.config has several analytics providers and you want to turn off analytic
tracking for one of them, delete the value of the GoogleAnalyticsTrackingCodePath property.

7. Use the following table to complete the tag’s properties.

Setting upGoogleWeb Traffic Analytics
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Element Enter

name

The free text name of the site being tracked.

Ektron suggests the site name followed by the provider name. For example,
www.ektron.com-Google.

Site-level displaysofWeb Analytics data within the Ektron CMS400.NETWorkarea let you
choose a site from a dropdown, as shown below.

Warning! If you change the name, youmust also change the value of the
<AnalyticsDataProvider defaultProvider element to match the name.

Username TheGmail username you encrypted in Step 4.

Password TheGmail password you encrypted in Step 4.

ProfileID

TheGoogle AnalyticsProfile ID you obtained in Step 2.

Note: Tip! If you go to your Google Analytics dashboard at google.com, in the address
bar, the &id=value in the URL is your ProfileIdassigned byGoogle.

SiteURL

Your site root names. For example, you could set up one <providers> tag for the
dev.ektron.comsite, and another for the synergy.ektron.comsite.

Do not include a protocol, such ashttp://.

The SiteURL needs tomatch the development site URLwhen you test in your development
environment. For example, if the site path ishttp://MyDevMachine/default.aspx, the
SiteURL attribute needs to beMyDevMachine.

If there is nomatch, the Google beacon is not inserted onto your page.

UserAccount

TheGoogle AnalyticsSiteURL you obtained in Step 2.

Note: Tip! When you visit your Google AnalyticsSettingspage at google.com, the UA-
xxxxxx-x string next to your site domain is the UserAccount assigned byGoogle.

8. Within the web.config's <analyticsSettings> tags is a
suppressBeacon element that lets you track or suppress tracking
users on your Web site. Many site administrators do not want to track
CMS user behavior in analytics reports, as it corrupts the data.

The following table lists possible settings for this element.
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Value Description

none Trackall users, including authenticatedmembership and Ektron
CMS400.NET users.

members Trackunauthenticated and logged-in Ektron CMS400.NETusersonly.
Do not trackmembership users.

authors Trackunauthenticated and logged-in membership users only. Do not
trackEktron CMS400.NETusers.

all Trackunauthenticated users only. Do not trackmembership and Ektron
CMS400.NETusers

9. Within the web.config's <appSettings> tags is an ek_
AutoInsertBeaconScript element that either tracks or suppresses
tracking activity on your Web site.

10. Change its value to true.

11. Save web.config.

Important: No special server control is needed to track Web Analytics. After you enable Web
Analytics in the web.config file, the following JavaScript is automatically added to each
PageBuilder page and any site page that contains an Ektron CMS400.NET server control.
<!-- Start Google Code -->

<script type="text/javascript">

var gaJsHost = (("https:" == document.location.protocol) ? "https://ssl." :
"http://www.");

document.write(unescape("%3Cscript src='" + gaJsHost + "google-analytics.com/ga.js'
type='text/javascript'%3E%3C/script%3E"));

</script>

<script type="text/javascript">

try {

var pageTracker = _gat._getTracker("[USER ACCOUNT STRING]");

pageTracker._trackPageview();

} catch(err) {}</script>

<!-- End Google Code -->

Note: Your User account string is provided by Google Web Analytics.

Tracking Your EntireWeb Site
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Tracking a Single Page
As an alternative to tracking your entire site, you can track any number of
individual .aspx pages. To do that, follow these steps on every page you wish to
track.

Prerequisite: You completed all steps in Tracking Your Entire Web Site on
page 7-781

1. Open your site’s siteroot/web.config file.

2. Find the ek_AutoInsertBeaconScript tag.

3. Set its value to false.

4. Save web.config.

Note: The above steps disable the tracking code on your Web site.

5. Open Visual Studio.

6. Open the .aspx page to which you want to apply the tracking code.

7. In the Solution Explorer tree, navigate to
Workarea/Analytics/template/googletrackingcode.ascx.

8. Drag and drop that user control onto the page.

9. Assign EktronAnalyticsTrackingCode as the ID of the control.

Setting up Web Analytics for Multiple Sites or
Providers
To track multiple providers or sites, copy the contents of the <providers> tag,
paste it below the existing tag and above </AnalyticsDataProvider>, and
modify the elements listed in Step 7 above.

Authorization to View Web Traffic
Analytics Data

License Requirements
Ektron CMS400.NET Professional or Enterprise License

User Permissions
Only the following users can view Web Analytics data.

n Members of the Administrators Group
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n Users assigned to the Analytics Viewer role. See Also: Defining Roles
on page 15-31

Viewing Web Traffic Analytics Data
The Web traffic analytics feature provides two basic types of data:

n Page data - Page Level Web Traffic Analytics Data below

n Site data - Site Level Web Traffic Analytics Data on page 7-790

Page Level Web Traffic Analytics Data
After you enable Web traffic analytics tracking, your provider retains data on
every visited page (that is, a unique URL) such as
http://dev.ektron.com/articles.aspx or
http://dev.ektron.com/template.aspx?id=6572). Data is tracked when the
quicklink is used, as well as any alias assigned to the content. See Also:
Creating User-Friendly URLs with Aliasing on page 10-1

You can view any page’s Web traffic analytics data from the following locations.

n Viewing Page-Level Web Traffic Analytics from the Site below

n Viewing Page-Level Web Traffic Analytics from a PageBuilder Page
on page 7-787

n Viewing Page-Level Web Traffic Analytics from the Workarea on page
7-787

Viewing Page-Level Web Traffic Analytics from
the Site
Any authorized user can view Web traffic analytics for a page on your Web site
by following these steps.

1. Log in to the Web site.

2. Navigate to the page whose Web traffic analytics data you wish to
view.

3. Hover the cursor over the Web Site Content menu. See Also: The
Web Site Content Menu on page 7-4

4. Click View Page Activity, as shown below.

ViewingWeb Traffic Analytics Data
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The SEO page’s Traffic tab appears.

The SEO Page’s Traffic Tab

The Traffic tab of the SEO control graphs the Web traffic analytics data of any
two search criteria. Below the graph is data for the five visit criteria tracked by
the Web traffic analytics provider.

Visit Data
n Pageviews - number of pageviews for this page over the selected

date range

n Unique pageviews - number of unique visitors to this page over the
selected date range

Managing Content in Ektron CMS400.NET

7-786 ReferenceManual
Version 8.01 Rev 4



n Average time on page - how long a visitor spent on the page. It is
calculated by subtracting the initial view time for this page from the
initial view time of the subsequent page. So, this metric does not
apply to exit pages.

n Bounce rate - the percentage of single-page visits (that is, visits in
which the visitor exited your site from the entrance page)

n % Exit - the percentage of site exits that occurred from this page

Note that you can change the date range, as well as either search criterion
(Pageviews and Time on Page in the example above).

You can also replace the URL with a different one, and view the page being
analyzed (by clicking Visit this page in the green bar).

Viewing Page-Level Web Traffic Analytics from a
PageBuilder Page
Any authorized user can view Web traffic analytics for a PageBuilder page by
following these steps.

Note: You cannot drag and drop the Analytics widget onto a PageBuilder page.

1. Use the right arrow button (circled below) to open the PageBuilder
menu. See Also: Building PageBuilder Pages on page 5-1

2. From the menu, select View > Analytics.

3. The SEO page’s Traffic tab appears.

See Also: The SEO Page’s Traffic Tab on previous page

Viewing Page-Level Web Traffic Analytics from
the Workarea
The Ektron CMS400.NET Workarea provides two page-level views of Web traffic
analytics data.

Viewing Page-LevelWeb Traffic Analytics from a
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n The View Content History screen - compares Web traffic analytics
data for any two published versions

n The Analytics toolbar button - displays the SEO page’s Traffic tab.
See The SEO Page’s Traffic Tab on page 7-786.

To view a content item’s Web traffic analytics data from the Ektron CMS400.NET
Workarea, follow these steps.

1. Navigate to the folder containing the content whose Web traffic
analytics data you want to view.

2. Click the content item.

3. To compare Web traffic analytics data any two published versions,
click the History button ( ). See Also: Comparing Two Published
Versions of Content below

To view Web traffic analytics for the currently published version, click
the Analytics button ( ). When you do, you see the Traffic tab of the
SEO page. See Also: The SEO Page’s Traffic Tab on page 7-786

Comparing Two Published Versions of Content
On the View Content History screen, blue and orange radio buttons appear next
to each published version of content, as shown below.
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To compare Web traffic analytics data, click the appropriately-colored radio
button next to each version, then click the Compare button ( ). The Compare
screen for the two versions appears, as shown below.

You can change the date range for each content version. You can also

n Use the Display pull-down to graph any visit data. See Visit Data on
page 7-786

n Click the URL Filtering tab to select the URLs being displayed. See
Also: URL Filtering below

URL Filtering
Any content item can be viewed via several URLs, such as

n its quicklink. See Also: A quicklink is a special kind of hyperlink that
jumps to another content item on your Web site. (A regular hyperlink
jumps to a Web page on the internet.) on page 8-2

n manual alias

n automatic alias See Also: Creating User-Friendly URLs with Aliasing
on page 10-1

Note:While Regex-based aliases affect Analytics data, they do not appear on the URL
Filtering tab.

The URL Filtering tab of the Compare Analytics screen lets you break down
the data by each of these identifiers. So, for example, you can drill down to
view only the data collected when site visitors accessed a page by typing its
manual alias into the browser.

URL Filtering
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Site Level Web Traffic Analytics Data
You can view Web traffic analytics data for any site via the Analytics Report
Widget and several reports. See Also:Widget Reference on page 6-5

Analytics Report Widget
You can drag and drop the Analytics Report Widget onto the Smart Desktop.

When you do, you initially see the Direct Traffic report for the past seven days.
(See Also: Direct Traffic on page 7-795)

You can click the Edit button ( ) to change the display using any of the options
shown below.
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To learn about the report data options, see Site Report Descriptions below.

Note that there are three time interval choices:

n last 7 days (the default)

n last 30 days

n last 90 days

Site Report Descriptions
You can access site-level Analytics reports from within the Ektron CMS400.NET
Workarea by selecting Reports > Site Analytics.

The site level reports are described below.

Note: The following text was adapted from Google Analytics Help Center
(http://www.google.com/support/analytics/). Check that site for additional details on the reports.

Report Description

Overview Direct traffic on left side, top content on the right. See Also:Direct Traffic
on page 7-795, TopContent on page 7-796;Analyticson page 7-747

Site Report Descriptions
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Report Description

Searches
Search termsused by site visitors to find content on your site. Note that this
data is not retrieved fromGoogle Analytics. Instead, it is retrieved from
Ektron CMS400.NET’s site search.

Visitors

The number of new and returning visitorswho came to your site and how extensively they interacted with your
content. This traffic overview allowsyou to view aspects of visit quality (i.e. average pageviews, time on site,
bounce rate) and visit characteristics (i.e. first time visitors, returning visits).

Locations Countries of your site visitors.

New vs. Returning

The number of visitors to your site who are new or returning.

A high number of new visitors suggests that you are successful at driving
traffic to your site, while a high number of return visitors suggests that the
site content is engaging enough to keep visitors coming back. You can see
how frequently visitors return and howmany times they return in ‘Recency’
report and the ‘Loyalty report’, both under ‘New vs. Returning’ in the
Visitors section.

Languages

Uses the language asprovided by the HTTPRequest for the browser to
determine site visitors’ language. Valuesare given in 2- or 4-character
language code (for example, en-br for British English).

This report captures the preferred language that visitors have configured
on their computers. Understanding who your visitors are is crucial to
developing the right content and optimizing your marketing spend. Many
times, geo-location is not enough. Manycountries have diverse
populations speaking different languageswhich present important market
targeting opportunities.

User defined
If youmodified the tracking code to provide a user-defined segment, this
field identifies that segment by the string you provide when setting up a
user-defined segment.
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Report Description

Visitor Trending

Visits

The number of visits your site receives is themost basicmeasure of how
effectively you promote your site. Starting and stopping ads, changing your
keyword buys, viralmarketing events, and search rankare some
examplesof factors that influence the number of visits your site receives.

Absolute Unique Visitors
The number of unduplicated (counted only once) visitors to your Web site
over the specified time period. AUnique Visitor is determined using
cookies.

Pageviews

The total number of pages viewed on your site. It is a generalmeasure of
howmuch your site is used.

It ismore useful as a basic indicator of the traffic load on your site and
server than asamarketingmeasure.

Average Pageviews

Average pageviews is one wayof measuring visit quality. A high Average
Pageviewsnumber suggests that visitors interact extensivelywith your
site. A high Average Pageviews results from one or both of:

n Appropriately targeted traffic (that is, visitorswho are interested in
what your site offers)

n High quality content presented effectively

Conversely, a low average pageviews indicates that the traffic coming to
the site hasnot been appropriately targeted to what the site offers or that
the site doesnot deliver what waspromised to the visitor.

Time on Site

Onewayof measuring visit quality. If visitors spend a long time visiting your
site, theymaybe interacting with it extensively. However, Time on site can
bemisleading because visitors often leave browser windowsopen when
theyare not actually viewing or using your site.

Bounce Rate

The percentage of single-page visits (that is, visits in which the person left
your site from the entrance page).

Bounce rate is ameasure of visit quality, and a high bounce rate generally
indicates that site entrance (landing) pagesaren't relevant to your visitors.
You canminimize Bounce Ratesby tailoring landing pages to each
keyword and ad that you run. Landing pages should provide the
information and services that were promised in the ad copy.

Site Report Descriptions
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Report Description

Browser Capabilities

Optimizing your site for the appropriate technical capabilities helpsmake your site
more engaging and usable and can result in higher conversion ratesandmore sales.

Browsers The browsers that your visitors use.

Operating Systems The operating systems that your visitors use.

Browsers andOS The browser/operating system combinations that your visitors use.

Screen Colors The number of screen colors your visitors use.

Screen Resolutions The screen resolutions that your visitors use.

Flash Versions The versionsof Flash that your visitors have installed.

Java Support Whether Java is supported on your visitors' platforms.

Network Properties

Network Location

The internet service providers that your visitors use. This report allows you
to track the internet service provider (ISP) domains to which the user
resolves.

The domain is determined by the internet service that owns the user's
internet protocol (IP) identifier.

Hostnames Hosts fromwhich people are visiting your site. Hostnamessometimes
provide insight into organizations that are interested in what you offer.
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Report Description

Connection Speeds
Connection speeds that your visitors are using. Optimizing your site so that
it loadsquickly for most visitors can result in higher conversion ratesand
more sales.

Traffic Sources

This section providesan overview of the different kindsof sources that send traffic to your site. The graph
shows traffic trends; the pie-chart and tables show what is driving the trends.

Direct Traffic
Visits from people who clicked a bookmark to come to your site or who
typed your site URL directly into their browser. Direct traffic can include
visitors recruited via offline (i.e. print, television) campaigns.

Referring Sites Externals sites fromwhich visitors linked to your site.

Search Engines Visitorswho clicked to your site from a search engine result page.

All TrafficSources
Visitors referred from search engines, sites, and tagged links. The graph
shows the overall trendswhile the table shows the specific sources (i.e.
search engines, sites, and tagged links) driving the trends.

Keywords Compares traffic from search keywords to overall traffic to your site.

Campaigns

How people referred from your configured campaigns compare to the
“average” visitor to your site.

The graph showsoverall trends, while the table lists each configured
campaign. Since all traffic in this report results from campaigns that you
explicitly control, you can use this information to add or delete campaigns,
or to determine the effectivenessof tests that you have set up using
custom tags.

Ad Versions

Compares your AdWordsads (and configured campaigns in which you
use the “content” tag) against each other.

This report showsyou which ad copy (in AdWordsadsor in configured
campaigns) ismost effective. Adswith high clickthrough rates show that
the copy is effective at getting the user to click, while high bounce rates, for
example, indicate a need for landing pages that are consistent with what
the ad promises.

Site Report Descriptions
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Report Description

Content

Providesan overview of pageview volume and lists the pages (Top Content) that weremost responsible for
driving pageviews. You can also reach some useful reports that reveal how users interact with your site and
statistics related to how they found your site in the first place.

Note: Content reports include a link icon ( ) and a hyperlink. If you click the link icon, you
go to the page. If you click the hyperlink, you see amore detailed Analytics report about that page.

Top Content

Themost commonly viewed pageson your site, and how theyare used.

The table lists all pageswhich were viewed on your site. A high bounce
rate indicatesa landing page that should be redesigned or tailored to the
specific ad which links to it. A high 'Time on Page' may indicate content that
is particularly interesting to visitors. The significance of exits varies
according to each page. For example, it maybe common for visitors to exit
your site from a receipt or “thank you” page because theyhave completed
a conversion activity. In contrast, a high number of exits from a non-goal
page (from a funnel page, for example) may indicate that the page is
confusing or that it generatesuser errors.

Content byTitle
Themost commonly viewed groupsof pageson your site (grouped by
title), and how theyare used. This report provides the same information in
the “Top Content” report, but aggregated by title tag value.

Top Landing Pages

Data on how effectively your landing pagesentice visitors to click further
into your site. You can lower bounce ratesby tailoring landing pages to
their associated adsand referral links and placing a clear call-to-action on
each landing page.

Top Exit Pages

Pages fromwhich people exit your site.

The significance of an exit rate varies according to each page. For
example, it maybe common for visitors to exit your site from a receipt or
“thank you” page because theyhave completed a conversion activity. In
contrast, a large number of exits from a non-goal page (from a funnel
page, for example) may indicate that the page is confusing or that it
generatesuser errors
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Chapter 8

Storing Files in the Library
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The library folder stores images, files, quicklinks, and hyperlinks that can be
inserted into editor content. Before you can insert them into content, you must
copy them from your computer to a larger, file server computer that everyone
editing your site can access.

This section also contains the following topics.

Terms Used in this Chapter 8-2
Accessing the Library 8-3
Library Folders and Permissions 8-4
Performing Actions on Library Items 8-4
Library Folder Properties 8-5
Searching the Library 8-6
Files 8-10
Hyperlinks 8-18
Images 8-19
Quicklinks and Forms 8-20
Library Load Balancing 8-22

Terms Used in this Chapter
n An image is any graphic file, which can include illustrations and

photos. Common image file extensions are .gif., .jpg, .tiff, etc.

n A file is type of computer file that can be launched from a browser,
such as Internet Explorer. Examples include a Microsoft Word
document and a .PDF file.

n A hyperlink is a commonly used or hard to remember Web address
(also known as a URL). After you add hyperlinks to the library, users
can easily apply them to editor content.

So for example, if the editor content is “Contact Ektron,” the user can
select the text, click the library button, select hyperlinks to find the
Ektron hyperlink, and apply that hyperlink to the text.

Once the page is published, a person reading it can click the text to
“jump” to the Web address www.ektron.com.

n A quicklink is a special kind of hyperlink that jumps to another
content item on your Web site. (A regular hyperlink jumps to a Web
page on the internet.)

Storing Files in the Library
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n A form is a quicklink to HTML form content. Whenever content is
created, a form link is automatically created for it.

Accessing the Library
1. Click the Workarea button ( ) or icon ( ).
2. Click the Library tab menu on top of the Workarea.

3. The Library folder appears.

See Screen Sample

4. The sub-folders appear in the left frame. Files in the root folder
(library) appear in the right frame.

See Screen Sample

You can use the dropdown list (circled above) to change the type of library files
that appear.

To work with any library file, click it. When you do, the View Library screen
appears, providing additional information about the item. From here, you can

n edit its title, file name, or description

n overwrite it

n find content linked to it

n delete it

Learn About Library Toolbar Buttons

Accessing the Library
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The following table explains the toolbar buttons on the library screen.

Note: Your system administrator determines which library folders you can access, and which
functions you can perform on library items within the folders.

Button Description
For more information,
see

Search library Searching the Libraryon
page 8-6

View the library’s properties
screen

LibraryFolder Properties
on the facing page

Add an image, file, quicklink,
or hyperlink to the library

Copying Files to the
Libraryon page 8-10

Select the type of Library file
to workwith

Library Folders and Permissions
Whenever a new content folder is created and permissions given to it, a
corresponding library folder is created. The new folder inherits permissions
from the content folder.

Items added to library folders are only accessible by users with permission to
the corresponding content folder. If items are added to a library folders directly
under the main library folder, all users with at least library Read-Only
permissions can use those library items in their content.

Conversely, if a library item is uploaded to a folder to which only one person
has permissions, that is the only user who can use that library asset.

Performing Actions on Library Items
The library is made up of images, files, form Quicklinks, hyperlinks, and regular
Quicklinks that were added by Ektron CMS400.NET users. The following table
displays the actions that can be performed for each library item type.

Storing Files in the Library
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Action Files Images Hyperlinks Quicklinks Form Quicklinks

Add

Edit

View

Overwrite

Delete

Remove from server

Check links

Update URL

Most actions can be performed by a user who is granted permission to do so.

Library Folder Properties
The library folder properties screen lets you view and update image and file
types may be uploaded.

This section also contains the following topics.

Accessing the Library Properties Screen 8-5
The Library Management Settings 8-6
Editing Library Properties 8-6

Accessing the Library Properties Screen
Administrators have permission to change library properties. To view the
properties of the library folder, follow these steps.

1. Access a library folder, as explained in Accessing the Library on page
8-3.

2. Click the Properties button ( ).
3. The Library Management window appears, displaying the following

settings.

Library Folder Properties
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The Library Management Settings
Field Description

Image
Extensions

The typesof image files that a content contributor can upload to the library. You can add as
many image file extensionsas you want, or have none. If no extensionsappear, no one can
upload image files to the specified folder.

Image
Upload
Directory

Specifieswhere the uploaded imagesare saved on theWeb server. Bydefault, the image
upload directory isWeb root/ek_sitepath/

uploadedimages. The ek_sitepathvalue is set in theWeb.config file.

See Also:Managing the web.config File on page 1-71

Make
Directory
Relative to
thisWeb site

If you want to specify the image upload directory’s location as relative to your Web site root,
check this box. (Your Web site root’s location appears to the right ofMake Directory
Relative to this Web site.)

File
Extensions

Specify the typesof non-image files that a content contributor can upload to the library. You
can add asmanynon-image file extensionsas you want, or have none. If no extensions
appear, no one can upload non-image files to the specified folder.

File Upload
Directory

Specifieswhere the uploaded files are saved on theWeb server. Bydefault, the file upload
directory isWeb root/ek_sitepath/

uploadedfiles. The ek_sitepathvalue is set in theWeb.config file.

Note: Youmust create the directory in your Web root manually, before adding it in Ektron
CMS400.NET.

See Also:Managing the web.config File on page 1-71

Make
Directory
Relative to
thisWeb site

If you want to specify the file upload directory’s location as relative to your Web site root, check
this box. (Your Web site root’s location appears to the right ofMake Directory Relative to
this Web site.)

Editing Library Properties
To edit library properties, follow these steps.

1. Go to the Library Properties screen, as explained in Accessing the
Library Properties Screen on previous page.

2. Click the Edit button ( ).

Searching the Library
You can search the library to find items when you only know some information
about them. For example, you know that an image’s name includes Ektron but
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don’t know its filename or folder.

To search the library, first select the folder in which you want to begin the
search. The search only considers files in that folder and its child folders. To
search the entire library, begin by selecting the Library (root) folder.

Next, click the Search button ( ) from the library toolbar. When you do, a
search screen appears with two tabs (shown below).

The left tab, Search Published, works the same as the regular search tab of
that name. See The Search Published Tab on page 9-90.

The right tab, Advanced Search, provides several fields that let you narrow
your search.

The fields are described below.

Searching the Library
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Field Description

Enter
Keyword(s)

Specify one or more keywords that the search will use. The search looks for keywords in
the file’s title. (The title is assigned by the user when the file is added to the library.) If a file’s
title matches the keywords, the file appears on the search results screen.

The search also uses keywords to search through the file’s

n internal name (for example, airplane.gif) if the Filename Search checkbox is checked

n description if theDescription search checkbox is checked

A keyword can be a complete or partialword. But, you can only enter a partial term for one
word. For example, you can enter Adv and have the search return the content titled
“Adverse Drug Reactions.” But if you enter Adv Drug, the search returnsnothing.

You can enter several complete search termsbut theymust be in the correct sequence.
For example, to find the topic titled “Adverse Drug Reactions,” you can enter Adverse
Reactions but cannot enter Reactions Adverse.

To find all files in a selected library folder, enter nothing in this field. Or, to find all files in a
selected library folder of a type (for example, images), select the type and enter nothing in
this field.

All Types The search considers all library asset types.

Imagesonly The search only considers images.

QuicklinksOnly The search only considers quicklinks.

FormsOnly The search only considers forms.

FilesOnly The search only considers files.

Hyperlinks
Only The search only considers hyperlinks.

Description
Search

If you check this box, the search considers the library item’s description when returning
search results. Otherwise, the search ignores the description.

For example, if you enter Ektron into the keyword field, the search returnsall library files
that include that string.

Filename
Search

If you check this box, the search considers the file namewhen returning search results.
Otherwise, the file name is not considered by the search.

For example, if you enter ppt into the keyword field, the search returnsall files that include
that string (such asall Powerpoint presentations).

Only search
items last
edited by
myself

The search only considers library assets that were last modified by you.

One or more of the search criteria set by your system administrator in theMetadata Definitions screen.

Note: Some search field check boxes are circles while others are squares. If the box is a circle,
you can only choose one option. If it is a square, you can choose as many as you want.

Storing Files in the Library
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The search displays library items that meet the search criteria on the search
results screen. You can click any item to view its properties (such as Library ID
number, Last Edit Date and Description).

Displaying Search Results
Search results appear in this order.

n images

n files

n hyperlinks

n quicklinks

n form links

Result Display Options
At the top of the library search screen, a pull-down list lets you choose the how
to display the results.

View
option

Description

Mixed

If the item is an image, display the image in the left column. If not, display its title.

To the right, display the item’sDescription.

Note: Mixed search results require the Internet Explorer browser, version 6 or greater.

Text

Display item’s title in the left column. To the right, display the file type and folder name.

Displaying Search Results
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Files
This section explains how to work with library files

This section also contains the following topics.

Copying Files to the Library 8-10
Viewing Files 8-11
Editing a File 8-13
Overwriting Files 8-14
Before You Overwrite an Image 8-14
Before You Overwrite a File 8-14
Overwriting Library Assets 8-14
Library Link Searching 8-15
Performing a Library Item Link Search 8-15
Deleting Library Items 8-16
Adding a Library File to Content 8-16
Adding a Library File to Content 8-16
The Insert QuickLink Dialog 8-17
Adding a File to the Library and Inserting it into Content 8-18

For a definition of the term “files,” see Terms Used in this Chapter on page 8-2.

Copying Files to the Library
Files must be copied to the Ektron CMS400.NET library before users can insert
them into content. To copy a file to the library, follow these steps.

Warning! Ektron recommends using the Document Management system to add files. Unlike
library files, DMS files can be part of an approval chain, maintain a history, are searchable, and
can have a summary, schedule, metadata, taxonomy categories, etc.

Note: Microsoft lets users upload files of any name. However, IIS security blocks files whose
name contains an ampersand (&), colon (:), or percentage sign (%). Source:
http://support.microsoft.com/kb/826437/en-us
To allow these characters, add the following registry key to your Web server then reset IIS.
Reg Key: DWORD HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\ASP.NET
VerificationCompatibility = 1.

1. In the Workarea, browse the library folder and select a folder to
which you want to copy a file.

Note:When you copy a file to a folder, only users with permissions to that folder can insert the
file into content.

2. A list of files in that folder appears.

3. Click the Add Library button ( ).
4. The Add File screen appears.

Storing Files in the Library
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5. Enter the necessary information according to the following table.

Field Description

Title Enter a title for the file to be copied.

Filename Enter the path to the file to be copied. You can use theBrowse button to find it.

Description

You can enter a full text description to help other users identify this file.

TheDescription appears on the View File screen.

It also accompanies the file on the Search Results screen if the user selectsMixed
when viewing results. See Also:Displaying Search Resultson page 8-9

After you enter the necessary information and click the Save button, the file is
copied. Now, users with permissions to the selected folder can insert the file
into their content.

See Also: Adding a Library File to Content on page 8-16

Viewing Files
Once a file is copied to the library, you may preview it. To preview a copied
file, follow these steps.

1. Navigate to the library folder to which the file was copied.

2. Click the file you want to preview.

3. The View File screen appears.

Viewing Files

ReferenceManual
Version 8.01 Rev 4

8-11



The table below describes each field on the screen.

Field Description

Title Title assigned byuser who copied or edited it.

Filename Filename and location on the server.

Library ID ID number assigned byEktron CMS400.NET when file wasoriginally copied.

Parent Folder File’s parent folder. Users need permissions to this folder to insert the file into content.

Last User to Edit Last user who changed file.

Last Edit Date When file was last edited.

Storing Files in the Library
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Field Description

Date Created When file wasoriginally copied to library.

Description Optional, full-text description of file.

If the file can be displayed in your browser, a preview of it appears at the
bottom of the screen. If it cannot display in the browser, a link to preview it in
its host application appears instead.

Note: You may need to download some files before you can be view them (for example, .mdb,
.mp3, .zip, etc.).

The following table describes the buttons on the View Library Item screen.

Button Description For more information, see

Edit the items title and description Editing a File below

Overwrite the library item Overwriting Fileson next page

Find content linked to the library item Library LinkSearching on page 8-15

Delete library item Deleting Library Itemson page 8-16

Return to previous screen

Editing a File
You can edit the title, filename and description of any file that was copied to the
library. To do so, follow these steps.

1. Access the View File screen, as described in Viewing Files on page 8-
11.

2. Click the Edit button ( ).
3. The Edit File screen appears.

Editing a File
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4. Change the title, file name, and/or description of the file.

5. Click the Update button ( ).

Overwriting Files
If a library file becomes out of date or the wrong version was copied, you may
replace it with a new version. Overwriting files lets you minimize disk space
and the number of library files.

Note: The ability to overwrite a library file is a privilege granted by the system administrator. If
you do not see an Overwrite button ( ) on the View Library Item in Folder screen, you do not
have permission to overwrite.

Note: You can only overwrite images and files. The new image or file must have the same file
extension as the file being replaced.

Before You Overwrite an Image
When overwriting an image, the new image uses the same size dimensions and
file extension as the older image. Be sure that the two images have the same
file extension and size or make the adjustments at each occurrence of the
image.

Before You Overwrite a File
Remember, all links that point to the overwritten file now point to the new file.

Overwriting Library Assets
To overwrite a library file, follow these steps.

1. Navigate to the View File screen for the file you want to overwrite, as
described in Viewing Files on page 8-11.

2. Click the Overwrite button ( ).
3. The Overwrite File screen appears.
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4. Click the Browse button.

5. A window lets you navigate to the new file.

6. Click the file, then click the Open button.

7. You return to the Overwrite File screen with the path to the new file in
the Filename field.

8. If desired, enter a Description for the new file.

9. To overwrite the current version of the file with this version, click the
Update button ( ).

10. The following message appears.

11. To overwrite the file, click OK.

Library Link Searching
Link searching indicates all content that includes a library link. It is useful when
you want to delete a library item. With the click of a button, you see all content
that you need to update to reflect the change you are making.

Performing a Library Item Link Search
To perform a library item link search, follow these steps.

Library Link Searching
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1. Access the View Library Item for any type of library item, as
described in Viewing Files on page 8-11.

2. Click the Link Search button ( ).
3. A list of all content that references the library item is displayed.

You should edit that content before deleting the item.

Deleting Library Items
You can delete obsolete items from the library. By deleting an item, you
prevent users from adding it to their content. A deleted hyperlink, quicklink or
form quicklink remains on your Web server, so any existing links to them are
not broken.

On the other hand, if an item is a file or image, the delete window displays an
additional prompt, Remove from the server, that lets you remove the item
from the server. This feature is available to help reduce disk space taken up by
these files. Before removing an image or file from your server, you should
review all content with links to it and remove or update the link. See Also:
Library Link Searching on previous page

To delete an item from the library, follow these steps.

1. Access the View Library Item for any type of library item, as
described in Viewing Files on page 8-11.

2. Click the Delete button ( ).

3. The Delete Library Item screen is displayed.

4. If appropriate, check the box next to Remove from the server (see
above).

5. Click the Delete button ( ).

Adding a Library File to Content
After a file is copied to the library, users can add it to content. (See Adding a
Library File to Content below)

You can also insert an item into the library while adding it to content. (See
Adding a File to the Library and Inserting it into Content on page 8-18)

If you insert an image file, it appears within the content. If you add any other
type of file, the file name appears as a hyperlink within the content. When a site
visitor viewing that page clicks the hyperlink, the inserted file is launched.

Adding a Library File to Content
1. Invoke the editor by adding or editing content in Ektron CMS400.NET.

2. Place the cursor within the content where you want the library file to
appear.

3. Click the library button ( ).
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4. The library opens.

5. Navigate to the folder that contains the file you want to insert.

6. From the file types dropdown list, select the kind of file you want to
insert.

7. All library files of that type in the selected folder appear on the
screen.

8. Click the file you want to insert.

9. Click the insert button ( ) to insert the file.
10. A hyperlink to the file appears in your content.

You can click the link to open the file.

The Insert QuickLink Dialog
If you select Files from the file types list, and Aliasing is enabled for your web
site, the following screen appears.

For guidance on these choices, see http://dev.ektron.com/kb_
article.aspx?id=26950.

The Insert QuickLink Dialog
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Adding a File to the Library and Inserting it into
Content
Use this procedure to insert an image into content that has not yet been copied
to the library. This procedure inserts the item into the library then into the
content.

1. Invoke the editor by adding or editing content in Ektron CMS400.NET.

2. Place the cursor where you want the library item to appear.

3. Click the library button ( ).
4. The library opens.

5. Navigate to the folder that will contain the file after you insert it.

6. From the File types dropdown, select the type of file you want to
insert. See Also: Terms Used in this Chapter on page 8-2

7. Click the Add Library button ( ).
8. A new screen appears. Browse to the file you want to insert.

Or you can click the search button ( ) to search for a file to insert.
9. Enter a Title for the file.

10. If metadata is required for the library item, you must complete it.
Metadata fields may appear in the lower section of the screen.

11. Click the Add Library button ( ).
12. The file is inserted into the selected library folder and the content.

Hyperlinks
For a definition of the term hyperlinks, see Terms Used in this Chapter on page
8-2.

This section also contains the following topics.

Adding Hyperlinks 8-18
Viewing Hyperlinks 8-19
Editing Hyperlinks 8-19
Adding Hyperlinks to Your Content 8-19

Adding Hyperlinks
You must copy hyperlinks to the library before content creators can insert them
into content. To copy a hyperlink to the library, follow the procedure described
in Copying Files to the Library on page 8-10. The only difference is that you
insert a hyperlink instead of a file.
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Viewing Hyperlinks
To view a hyperlink, follow the procedure described in Viewing Files on page 8-
11. The only difference is that you view a hyperlink instead of a file.

Editing Hyperlinks
To edit a hyperlink, follow the procedure described in Editing a File on page 8-
13. The only difference is that you edit a hyperlink title instead of a file title.
You can also edit the URL.

Adding Hyperlinks to Your Content
Once a hyperlink is added to the library, users can add the hyperlink to their
content.

To add a hyperlink to content, follow the procedure described in Adding a
Library File to Content on page 8-16. The only difference is that you add a
hyperlink instead of a file.

Images
For a definition of the term images, see Terms Used in this Chapter on page 8-
2.

This section also contains the following topics.

Uploading Images 8-19
Viewing Images 8-20
Editing Image Titles 8-20
Overwriting Images 8-20
Adding Images to Your Content 8-20

Uploading Images
You must copy images to the library before content creators can insert them
into content. To copy an image to the library, follow the procedure described in
. The only difference is that you add an image instead of a file.

Note:When an image is uploaded to the Media tab for a product in the eCommerce feature,
the original image and any thumbnails associated with it are added to the Library. For
example, if you add an image named “TestImage” (actual file name: “case.jpg”) with a 150px
and 50px thumbnails, you will see the following entries in your library (File Name - Path):
TestImage - /~siteroot~/uploadedImages/case.jpg
case[filename]150 - /~siteroot~/uploadedImages/case[filename]150.jpg
case[filename]50 - /~siteroot~/uploadedImages/case[filename]50.jpg

Viewing Hyperlinks
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Viewing Images
To view an image, follow the procedure described in Viewing Files on page 8-
11. The only difference is that you view an image instead of a file.

Editing Image Titles
To edit an image’s title, follow the procedure described in Editing a File on page
8-13. The only difference is that you edit an image’s title instead of a file title.

Overwriting Images
When an image in the library becomes out of date, or if the wrong version of an
image was copied, you may overwrite that image with a new or correct version.
Overwriting images minimizes disk space and the number of copied library
images.

Note: Overwriting images is a permission that your system administrator may or may not
assign to you.

To overwrite an image, follow the procedure described in Overwriting Files on
page 8-14. The only difference is that you overwrite an image instead of a file.

Note: You can only overwrite an image with another image of the same extension. (that is, .gif
> .gif, not .jpg > .gif)

Adding Images to Your Content
Once an image is added to the library, users can add it to content.

To add an image to content, follow the procedure described in Adding a Library
File to Content on page 8-16. The only difference is that you add an image
instead of a file.

The image is placed into the picture properties dialog box, where you can
change it before inserting it.

Quicklinks and Forms
For a definition of the terms quicklinks and forms, see Terms Used in this
Chapter on page 8-2.

This section also contains the following topics.

Adding a Quicklink or Form to Content 8-21
Viewing Quicklinks or Forms 8-21
Updating Default Template for Multiple Quicklinks 8-22
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Adding a Quicklink or Form to Content
Users can insert a quicklink to it within any content. To do so, follow the
procedure described in Adding a Library File to Content on page 8-16. The only
difference is that you add a quicklink or form instead of a file.

You can apply a quicklink to text or an image within the content. If you do, and
a site visitor moves the cursor over the text or image, the cursor indicates that
a hyperlink is available. If he clicks the link, he “jumps” to the source content
or image.

If you do not select text or an image before inserting a quicklink, place the
cursor where you want it to appear. The title of the “jumped to” content
appears in the content.

To test a quicklink or form, select hyperlinked text or image and double click it.

When the page is published, a reader can click the link to jump to the quicklink
or form page.

Viewing Quicklinks or Forms
To view a quicklink or form, follow the procedure described in Viewing Files on
page 8-11. The only difference is that you view a quicklink or form instead of a
file.

The table below describes each field on the quicklinks display.

Field Description

Title Title given to the hyperlink or form by the user who added it, or last edited it.

URL Link URL link for the quicklink or form.

Library ID ID number assigned automatically byEktron CMS400.NET when the quicklink or formwas
originally added.

Parent
Folder

Parent folder that the quicklink or form belongs to. Users need permissions to this folder to be
able to access the quicklink or form.

Last User
to Edit Last user that made changes to the quicklink or form.

Last Edit
Date The date the quicklink or formwas last edited.

Date
Created

The date and time the quicklink or formwasoriginally added to the Ektron CMS400.NET
library.

To preview a quicklink or form, click the link at the bottom of the page.

Adding aQuicklink or Form to Content
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Updating Default Template for Multiple
Quicklinks
Warning! This procedure is only necessary if Link Management is set to false in your web.
config file. If if Link Management is set to true, Ektron CMS400.NET automatically updates the
template within the quicklink when content is moved. See your system administrator for help with
the web.config file.

Note: This action can only be performed on quicklinks.

When content is moved in Ektron CMS400.NET, its quicklink does not get
changed. After it is moved, you need to update the default template called in
the content’s quicklink.

To update the default template for one or more quicklinks, follow these steps.

1. In the library, access the quicklinks folder containing quicklinks you
want to update.

2. Click the Update Quicklinks button ( ).
3. The Update URL Link Template Quicklinks screen is displayed.

4. Check the quicklinks you want to update.

Note: Check the box in the table header to select or deselect all.

5. In the To: text field, enter the name of the template you want to
apply to the selected quicklinks.

6. Click the Update Quicklinks button ( ) to update the changes.
A confirmation message is displayed.

7. Click OK to continue.

The selected quicklinks are updated to use the specified template.

Library Load Balancing
See Load Balancing Library Images and Files on page 22-2Load Balancing
Library Images and Files on page 22-2
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This chapter describes several tools that Ektron CMS400.NET provides to let site
visitors navigate around your site.

This section also contains the following topics.

Comparing Collections, Menus, Taxonomy, and List Summary 9-3
Searching Your Web Site 9-5
Working with Collections 9-102
Working with Menus 9-133
Taxonomy 9-202
ListSummary Server Control 9-266
Breadcrumbs 9-276
Personalizing a Web Page 9-300
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Comparing Collections,
Menus, Taxonomy, and List
Summary
A menu, a collection, a taxonomy, and the ListSummary function are similar in
that they let you add a list of links to a Web page. The following table compares
these features to help you understand which one is best suited to your needs.

Note: To implement these features, the assistance of a developer is required.

Collection Menu
List

Summary
Taxonomy

Displayall content in a folder. As folder’s
content changes, display changes. (folder items

appear on a
menu)

Can displayall content in a folder’s subfolders

Display selected content

Displayexternal hyperlinks& library assets

Display content summary (optional)

Displayadditional content information:

n comment

n last modified date

n start date

n end date

n user who last edited it

n ID number

n path relative to your site’s root

Can bemulti-leveled

Comparing Collections, Menus, Taxonomy, and List
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Collection Menu
List

Summary
Taxonomy

Main purpose is navigation

Main purpose is classification

For a detailed guide to Ektron CMS400.NET navigation, see the “Best Practice –
Navigation for your Web site pamphlet,” available from
http://dev.ektron.com/uploadedFiles/Resources/navigation%20best%20practice.pdf.
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Searching Your Web Site
Note: This chapter only describes searching HTML content. To learn about searching XML
Smart Form content, see XML Indexing on page 7-380.

Ektron CMS400.NET provides two kinds of searches:

n the Web site search helps site visitors find published content on your
Web site.

Your Web developer determines where to place the Web site search.
The Ektron CMS400.NET sample site provides a link to it from every
page. When a site visitor clicks the link, he sees the search screen.

For more information, see Web Site Search on next page.

n the Workarea search helps anyone signed into Ektron CMS400.NET to
find content. To access the Workarea search, go to the folder whose
content you want to search and click Action > Search. The
following screen appears.

The left tab lets you access the default version of the Web site
search, while the right tab lets you search content by properties
(title, comments, creation date, status, etc.).

To learn more about the Workarea search, see Searching the Workarea on page
9-89.

Searching Your Web Site
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Web Site Search
Ektron CMS400.NET’s Web site search provides extremely fast results without
impacting the load on your database. To accomplish these goals, Ektron
CMS400.NET stores a separate copy of all published content in local index files
(also known as a catalog). The Microsoft Windows Indexing service constantly
indexes the catalog so that search results are returned with lightning speed.

Note: Actually, two catalogs are created: one for public content, and another for private
content.

Another advantage of the indexing service is its robust query language. Site
visitors can use it to find Web site content by combining a rich collection of
search criteria, including

n boolean and proximity operators

n wildcards

n free text queries

n vector space queries

n property value queries

These are explained in Query Language on page 9-62.

A third benefit of this architecture is scalability. If the amount of content or
number of hits begins to affect performance, you can move the catalog to a
separate server to handle the increased workload.

This section also contains the following topics.

The Catalog and Index Files on the facing page

Merging Indexing Service Catalogs on page 9-19

Basic versus Advanced Web Site Search on page 9-25

Display of Search Results on page 9-30

Synonym Sets and Suggested Results on page 9-33

Using the Integrated Search on page 9-47

Setting up a Multiple Site Search Using Virtual Directories on page 9-53

Searching for Metadata on page 9-56

Installing the Visio IFilter on page 9-56

Query Language on page 9-62

Search Troubleshooting on page 9-57

Web Search Server Control on page 9-72

Displaying WebSearch Results on a Separate Page on page 9-83
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Determining the Display of Search Results on page 9-83

Filtering Search Results by Category on page 9-84

Using Ektron’s Search APIs on page 9-87

The Catalog and Index Files
Note: Be sure that your Web server is running Indexing Service 3.0. Earlier versions of the
service do not work properly.

The Microsoft Windows Indexing Service uses catalogs to index Ektron
CMS400.NET content. The catalogs read copies of content that are saved to the
local file system whenever they are published.

This section also contains the following topics.

Local Index Files 9-7
The Catalogs 9-8
Changing a Catalog’s Name 9-9
Recreating a Catalog 9-9
Manually Recreating a Catalog 9-10
Automatically Recreating a Catalog 9-11
The SearchConfig Log 9-13
Search Data Configuration Screens 9-13
The Configuration Tab 9-13
The Advanced Tab 9-15
The Log Output Tab 9-15
Restarting the Indexing Service 9-16
Restart the Indexing Service 9-16
Run a Full Scan of a Catalog 9-17
Run an Incremental Scan of a Catalog 9-18

Local Index Files
A separate copy of all published content is maintained in local index files
(whose extension is .txt), which are stored in the siteroot/assets folder.
Within that folder is a reproduction of the CMS folder structure. However, it
uses the folder ID number, not name, to represent folders. The following
graphic illustrates this structure.

TheCatalog and Index Files
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Notice that each content item is saved as a .txt file for indexing. The file name
is derived from the content item’s

n ID number

n underscore (_)

n language ID

n file extension (content items have an .html extension)

n .txt file extension

The Catalogs
Ektron CMS400.NET stores a copy of all published content in two catalogs that
can be queried. Their default names are below.

n siteroot uniqueID Publish

n siteroot uniqueID Private

As indicated, the second catalog stores private assets. See Also: Private
Content on page 7-184

To access these catalogs within the indexing service, go to Computer
Management > Services and Applications > Indexing Service.

Within the file system, these catalogs reside in the c:\program
Files\Ektron\Catalogs\siteroot unique identifier folder. For example,
C:\Program Files\Ektron\Catalogs\CMS400Min312007131255.
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View a catalog’s properties to see the fields you can use in queries. See Also:
Property Value Queries on page 9-67

Changing a Catalog’s Name
To change a catalog’s name, open the siteroot/web.config file with an editor
such as Notepad. Then, update the catalogName element for the published
catalog name, and the privateCatalogName element for the private catalog
name.

<webSearch defaultProvider="MSIndexDialectServer">

<providers>

<add name="MSIndexDialectServer"
type="Ektron.Cms.WebSearch.SearchProviders.MSIndexDialectProvider, Ektron.Cms.WebSearch"
catalogName="localhostPublished" privateCatalogName="localhostPrivate" pageSize="10"
description="MS Index Server Dialect2 Provider"/>

<add name="MSIndexServer" type="Ektron.Cms.WebSearch.SearchProviders.MSIndexProvider,
Ektron.Cms.WebSearch" catalogName="localhostPublished"
privateCatalogName="localhostPrivate" pageSize="10" description="MS Index Server SQL
Provider"/>

</providers>

</webSearch>

Recreating a Catalog
If a catalog is accidentally deleted or becomes corrupted, follow these steps to
recreate one. There are two ways to do this.

n Manually Recreating a Catalog on next page

n Automatically Recreating a Catalog on page 9-11

Changing a Catalog’s Name
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Manually Recreating a Catalog

Part 1: Create a New Catalog and Copy Metaconfig.doc File
to it

1. Open the C:\Program Files\Ektron\Catalogs folder.

2. Create a folder for the new catalog.

3. From the Computer Management screen, select Services and
Applications > Indexing Service.

4. If the indexing service is running, right click Indexing Service and
click Stop.

5. Right click the mouse and select New > Catalog.

6. Assign the catalog a name. At the Location field, browse to the folder
you created in Step 2.

7. Navigate to the C:\Program
Files\Ektron\CMS400releasenumber\Utilities directory and find
the metaconfig.doc file.

8. If you are creating a public catalog, copy that file to the site
root/Assets folder.

If you are creating a private catalog, copy metaconfig.doc to the site
root/PrivateAssets folder.

9. From the Computer Management screen, click the new catalog you
created in step 5. Underneath it, a Directories folder appears.

10. Select the Directories folder and click New > Directory.

11. The Add Directory Screen appears. If you are creating a public
catalog, browse to the site root/Assets folder. If you are creating a
private catalog, browse to the site root/PrivateAssets folder.

12. Right click Indexing Service and click Start.

13. From the Computer Management screen, view the new indexing
service. Make sure a number appears in new catalog’s Total Docs
column, and the Docs to Index number is zero (0) before
proceeding.

Part 2: Update Metaconfig.reg
1. Navigate to the C:\Program

Files\Ektron\CMS400releasenumber\Utilities directory

2. Open the metaconfig.reg file with an editor like Notepad.

3. Update the first line of that file with the location of the new catalog
relative to the C:\Program Files\Ektron\Catalogs folder. For
example, if the new folder within the catalog folder is named mytest,
the first line of the metaconfig.reg file looks like this.
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[HKEY_LOCAL_
MACHINE\SYSTEM\CurrentControlSet\Control\ContentIndex\Catalogs\mytest\Properties]

4. Save the file.

5. Double click the file. This action updates your Windows Registry with
the new information.

6. Stop and restart Windows Indexing Service. Both commands are
available from the menu that appears when you hover over the
Indexing Service and right click the mouse.

7. View the new Indexing Service to verify that all properties exist as in
the original service.

Part 3: Update web.config
Follow the directions in Changing a Catalog’s Name on page 9-9 to update the
catalogs that are updated as content is updated.

Automatically Recreating a Catalog
If you don’t want to perform the manual steps listed above, Ektron CMS400.NET
provides a utility that automatically creates a new catalog. You would typically
use this if a catalog were corrupted or accidentally deleted.

Warning! Before running the Search Data Configuration utility, if your server has Visio
documents, install the Visio IFilter. See Query Language on page 9-62. Also, if your server has
Office 2007 documents, install the Microsoft Office SharePoint Server 2007 IFilters. See
http://technet2.microsoft.com/Office/en-us/library/c6c029bd-64ea-4617-b2da-
c269f13599e21033.mspx?mfr=true.

Warning! Make sure all Ektron CMS400.NET users are signed off before you begin this utility. If
they are not, the utility logs them off.

To launch the utility, follow this path from the Windows Start button: Start >
Programs > Ektron > CMS400 version > Utilities > SearchConfigUI

Alternatively, click the following file: C:\Program
Files\Ektron\CMS400v
versionnumber\Utilities\SOFTWARE\SearchConfig\searchconfigUI.exe

When you do, the following screen appears.

Part 3: Update web.config
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To create a new published asset catalog, follow these steps.

1. In the Published Catalog field, enter the name of a new catalog. Or,
leave the current catalog name, and the utility will overwrite the
catalog.

2. Do the same to create a new or replace the Private Catalog.

3. Check the Create New Catalogs box.

4. If you want to automatically generate a summary for all content in
the new catalog, click the Automatically generate summary for
content checkbox. See Also: Automatic Creation of a Summary on
page 7-138

5. Click the Advanced tab.

6. Check each type of content that you want to index for the search.

7. By default, new catalogs are created in the web site root/ catalogs
folder. If you want to create these in another folder, use the Specify
directory for catalogs field to enter or browse to that folder.

8. Press Start.

9. Ektron CMS400.NET creates a new catalog and index files for your
content.
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After you run this utility, the old catalog remains but no new content is written
to it. All subsequent changes are written to the new catalog.

See Also: SearchConfigUI.exe crashes while building search indexes and
catalogs on page 9-59

The SearchConfig Log
All activity generated by the Search Data Configuration screen is tracked by a
log. You can view the log top obtain a history of these changes.

The log is located in the C:\Program
Files\Ektron\CMS400versionnumber\Utilities\SOFTWARE\SearchConfig
folder. Its name is date time.LOG. The log is also available on the Search Data
Configuration Screen’s Log output tab.

Search Data Configuration Screens
Use these screens to perform the following actions.

n make all Ektron CMS400.NET content searchable (do this if you
recently switched to a new database)

n make any of the following kinds of content searchable (do this if the
search cannot find this content)

- HTML

- assets

- XML Smart Forms

- users and groups

- forums

n reindex the catalogs

n create a new catalog and index it (do this if a catalog was corrupted
or accidentally deleted)

The following table explains the fields on the screens.

See Also: The SearchConfig Log above

The Configuration Tab

The SearchConfig Log
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Field Description

WebSite Select the Ektron CMS400.NET site that you want to workwith

Connection String Review the connection string to your Ektron CMS400.NET database.
Update if needed.

AssetsPath Review the path to your site’sAssets folder. Update if needed.

Private AssetsPath Review the path to your site’sPrivate Assets folder. Update if needed.

Re-indexexisting catalogs Check this box if you want to reindex the existing catalogs.

Create New Catalogs Check this box if you want to create a new catalog.

Published Catalog Review the name of your published catalog. Update if needed. See Also:
TheCatalogson page 9-8

Private Catalog Review the name of your private catalog. Update if needed. See Also: The
Catalogson page 9-8

AutomaticallyGenerate
Summary for Content

If you want to automatically generate a summary for all content in the new
catalog, click this checkbox. See Also:
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Field Description

Status After you click theStart button, this area indicates the statusof the new
catalog creation.

The Advanced Tab

Field Description

Index the following for Search

n HtmlContent

n Users andGroups

n Documents

n Forums

n XMLContent

Checkeach type of content that the search can find.

Specify directory for catalogs
Use this field to change the location of the published and private catalogs,
if desired. Bydefault, they reside in the your web site/catalogs
directory.

The Log Output Tab
All activity generated by the Search Data Configuration screen is tracked by a
log. The Log Output Tab displays a history of these changes.

The Advanced Tab
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A permanent copy of the log is saved in the C:\Program
Files\Ektron\CMS400vversionnumber\Utilities\SOFTWARE\SearchConfig
folder. Its name is date time.LOG.

Restarting the Indexing Service
Use the Indexing Service screen to restart Windows’ Indexing Service. You can
also use the screen to rescan the catalogs.

To access the Indexing Service screen, go toWorkarea > Settings >
Configuration > Indexing Services.

From this screen, you can

n Restart the Indexing Service below

n Run a Full Scan of a Catalog on the facing page

n Run an Incremental Scan of a Catalog on page 9-18

Restart the Indexing Service
Sometimes, when resolving issues with your search, you must stop and restart
the indexing service. To restart it via the Indexing Service screen, click the
Restart Service button.
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To restart the indexing service for a particular catalog only, click Restart to
the right of the catalog name.

Alternatively, you can stop and restart the Indexing service from the Computer
Management screen, as shown below.

Run a Full Scan of a Catalog
Sometimes, when resolving issues with your search, you need to run a full scan
of a catalog. To do this, access the Settings > Configuration > Indexing
Service screen. Then, click Rebuild next to the affected catalog.

Run a Full Scan of a Catalog
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The following text explains the full scan. (Copied from Microsoft Management
Console help)

A full scan takes a complete inventory of all documents in the cataloged folders
and adds them to the list of documents to be indexed. The Indexing Service
does a full scan of disk drives attached to your computer (except for removable
devices) in the following situations:

n When it is run for the first time after installation

n When a folder is added to the catalog

n As part of recovery if a serious error occurs

Run an Incremental Scan of a Catalog
Sometimes, when resolving issues with your search, you need to run an
incremental scan of a catalog. To do this, access the Settings >
Configuration > Indexing Service screen. Then, click Update next to the
affected catalog.

The following text explains the incremental scan. (Copied from Microsoft
Management Console help)

Microsoft Windows Indexing Service cannot track changes to documents when it
is shut down. When Indexing Service restarts, it does an incremental scan to
detect all documents that were modified while it was inactive so it can update
its index.
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An incremental scan may also be performed if Indexing Service loses change
notifications. This can happen if the update rate of documents is very high and
the buffer used to get change notifications from Windows XP overflows.

Merging Indexing Service Catalogs
This section explains how to merge two Windows Indexing Service catalogs.
You need to do this if your server has more than the maximum allowed number
of 26 catalogs.

Note: The maximum number of catalogs is determined by Microsoft’s Windows Indexing
Service.

This section also contains the following topics.

Windows Indexing Service Catalogs 9-19
Why Merge Catalogs? 9-20
Conditions for Merging Catalogs 9-20
Procedure for Merging Catalogs 9-21
Using the MergeCatalog.exe Utility 9-21
Manually Merging Catalogs 9-22

Windows Indexing Service Catalogs
Warning!When you install more than three Web sites to a server, the catalogs for additional sites
are automatically merged with one of the three existing Web site’s catalogs. An existing Web
site’s catalogs are chosen for merging based on the site with the least amount of directories to
index. When a Web site’s catalogs are merged with another, the information for each site is kept
separate.

Each Ektron CMS400.NET site has three catalogs. In addition, your server may
have catalogs for other applications that use the Windows Indexing service.
Below is an example of what your Indexing Service catalogs might look like.

Merging Indexing Service Catalogs
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Note that the first six catalogs support two Ektron CMS400.NET web sites:
Cms.example2.com and CMS400Developer. Each site has three catalogs:

n Content

n Private (assets)

n Publish (assets)

Each catalog has a Directories folder, which lists the directories of the content
being indexed.

Why Merge Catalogs?
The merge reduces the number of catalogs on your server, yet still indexes
each site’s content for the search. After you merge the catalogs, each site’s
search is still limited to content on that site -- the search does not find content
from other sites even though several sites now reside in one catalog.

When merging catalogs, you copy the directory of the “merge from” catalog to
the Directories folder of the “merge to” catalog. Then, you delete the “merge
from” catalog.

Conditions for Merging Catalogs
n You can only merge Ektron CMS400.NET catalogs if the Web sites use

the same major point release. For example, you can merge catalogs
from two sites with Release 7.0.4, or a 7.5.0 site with a 7.5.1 site.
But you cannot merge a 7.0.4 site with a 7.5 site, because catalog
properties change between releases.
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n Each Ektron CMS400.NET site has three catalogs.

- publish

- private

- content

You must merge the same catalog type between sites. So, for
example, you cannot merge a publish with a private catalog.

Procedure for Merging Catalogs
As an administrator, you can merge different Web sites’ catalogs by using
Ektron's MergeCatalog.exe command line utility or by performing the merger
manually. For information on

n Ektron’s MergeCatalog.exe command line utility - see Using the
MergeCatalog.exe Utility below

n performing the catalog merger manually - see Manually Merging
Catalogs on next page

Using the MergeCatalog.exe Utility
There are two ways to use this utility. The first allows you to merge all of your
Web sites’ catalogs until you have only three catalog sets. For example, if you
have five Web sites, you can merge their catalogs down to the equivalent of
three sites. To merge your catalog sets down to three, run the
MergeCatalog.exe file located in the following folder.

C:\Program Files\Ektron\CMS400v8x\Utilities\MergeCatalog.exe

The second way allows you to merge catalogs from one specified Web site to
another. For example, you want to merge the catalogs from your
CMS400Developer site to your eIntranet site. See Also: Merging Catalogs from
One Web Site to Another below

Merging Catalogs from One Web Site to Another
To use Ektron’s MergeCatalog.exe utility, follow these steps:

1. Open a command prompt.

2. Change the directory to
C:\Program Files\Ektron\CMS400v8x\Utilities.

3. Run the MergeCatalog.exe utility.

Usage: MergeCatalog “<fromCMS400dir>” “<toCMS400dir>”

Below is an example of using the MergeCatalog.exe command line utility
to merge the CMS400Developer Web site’s catalogs with the eIntranet
site’s catalogs.
MergeCatalog "I:\inetpub\wwwroot\CMS400Developer" "I:\inetpub\wwwroot\eIntranet"

Procedure for Merging Catalogs
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Once the merge is complete, the following message appears in the command
box.

“Switching shared catalogs for site at <fromCMS400dir>
into site at <toCMS400dir>

Restarting Ektron Windows Service

Catalogs Merged”

Manually Merging Catalogs
Follow these steps for all three catalogs on each site: Content, Private and
Publish.

Part 1: Copy “From” Path to New Directory in “To” Catalog
In this part, you create a new directory in the “to” catalog. Point the new
directory to the “from” catalog folder. Then, delete the “from” catalog.

1. Open Computer Management > Services and Applications > Indexing
Service.

2. Select the first catalog that you want to merge from (that is, the
catalog you will delete after merging).

3. Click its Directories folder.

4. The directory appears in the right pane.

5. Double click it. The Add Directory dialog appears.
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6. Press <Ctrl> + <C> to copy the Path field.

7. In the left panel, select the corresponding “to” catalog, the one into
which you will merge the “from” catalog.

Warning! Make sure the catalog types match: content > content, publish > publish, private >
private.

8. Right click the mouse and select New > Directory. The Add
Directory dialog appears.

9. In the Path field, paste the path you copied in Step 7 and press OK.

10. Repeat these steps for the other two catalogs on the site that you are
merging.

11. Click Indexing Service then stop the Indexing service.

12. Delete the three “from” catalogs.

13. Click Indexing Service then restart the Indexing Service. This
action begins indexing the files in the new directory.

Part 2: Update .Config Files with the New Catalog Location
In this part, you open Windows Explorer and navigate to “from” Web site, that
is, the site whose catalog you deleted above. There, you point its web.config
and assetmanagement.config files to the new catalog.

1. Open Computer Management > Services and Applications > Indexing
Service.

2. Find the catalogs that you have merged into.

Part 2: Update .Config Files with the New Catalog
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3. Resize the window so that it occupies the left half of the screen.

4. Open Windows Explorer.

5. Navigate to the Web site whose catalog you deleted in Part 1: Copy
“From” Path to New Directory in “To” Catalog on page 9-22.

6. In the site root folder, open the web.config file.

7. Resize the window so that it occupies the right half of the screen.

You should see the Computer Management screen on the left, and the
web.config file on the right.

8. In web.config, find the element <webSearch
defaultProvider="MSIndexDialectServer">.

Note: Don’t confuse the MSIndexDialectServer tag with MSIndexServer. You only need
to change MSIndexDialectServer.

9. Shortly after that are catalogName and privateCatalogName.

10. Replace the value of catalogName with the name of the publish
catalog, visible in the Computer Management screen. For example:

catalogName="CMS400Developer11282007130734Publish"

11. Replace the value of privatecatalogName with the name of the
private catalog. For example:

catalogName="CMS400Developer11282007130734Private"

12. Save the web.config file.

13. In the site root folder, open the AssetManagement.config file.

14. Resize the window so that it occupies the right half of the screen.

You should see the Computer Management screen on the left, and the
AssetManagement.config file on the right.

15. In AssetManagement.config, find the element CatalogName.

16. Replace the value of CatalogName with the name of the content
catalog, visible in the Computer Management screen. For example:

catalogName="CMS400Developer11282007130734Content"

17. Replace the value of CatalogLoc with the path to the newly-merged
catalog. To get the path:

- open Windows Explorer.

- navigate to the folder to which the catalog is being copied. For
example, C:\Program Files\
Ektron\Catalogs\CMS400Developer11282007130734\Content

- right click the folder and select Properties.

- copy the Location field.
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- Select the assetmanagement.config file’s CatalogLoc tag.

- replace the path with the copied one. For example.

catalogName=”C:\Program Files\ Ektron\Catalogs\CMS400Developer11282007130734\Content”

18. Copy the “to” catalog name and path entered in steps 16 and 17 to the
other catalogs and locations: PublishCatalogName,
PublishCatalogLoc, PrivateCatalogName, and
PrivateCatalogLoc.

19. Save the AssetManagement.config file.

20. Stop and restart the Ektron Windows Service.

Note: If you still have the Computer Management screen open, you can quickly navigate to
Services and Applications > Services > Ektron Windows Services 2.0.

Basic versus Advanced Web Site Search
When your developer places a Web Search server control on any page, and a
site visitor browses to it, he sees the following.

This section also contains the following topics.

The Basic Search 9-26
Search Results by Content Type 9-27
Searching Multiple Terms 9-27
The Advanced Search 9-28

Basic versus AdvancedWeb Site Search
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Advanced Search Options 9-28
Advanced Result Filters 9-29
The Content Searchable Field 9-29

The Basic Search
Note: You can also create a folder with content outside of Ektron CMS400.NET that is
searched. For more information, see Using the Integrated Search on page 9-47.

The Basic Search finds content that satisfies these criteria.

n published

n active (archived content is ignored)

n its Searchable check box is checked (see The Content Searchable
Field on page 9-29)

n public. However, private content is available to those with permission
to view it, such as membership users after logging in. See Also:
Private Content on page 7-184

n resides in the CMS folder specified in the Web search server control,
or in one of that folder’s subfolders if the control’s recursive
property is set to true

n is not a non-image file added to the library. Images are searchable,
while other files added to the library are not. So, to make files
searchable, add them as assets, not library files.

n matches selected language, if site is multilingual

n satisfies text and/or query entered in the search box (no value
returns nothing) See Also: Query Language on page 9-62

- The text inserted in the search field can appear in the content or
metadata (See Also: Searching for Metadata on page 9-56)

n satisfies content type criterion selected on screen, if chosen (see
below)

Note: The search does not find documents inside compressed files, such as *.zip, *.cab, etc.
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Search Results by Content Type

Search Screen Option Finds submitted text in these content types

Site Content from all optionsbelow (except Tags) plusForums

HTML

n HTML

n Smart Form (XML)

Note: FindsXML field valuesbut not field labels. This hasnot changed
since prior releases.

n HTML Form

n Blog entries (not comments)

Documents

n MSOffice document (includesPowerpoint, Excel)

Note: The search finds text within Visio documents if the Visio IFilter has
been installed. SeeQueryLanguage on page 9-62.

n PDF file

n .txt file

Imagesadded asassets and
through the library .gif, .jpeg, etc.

MultiMedia Flash, .mp3, etc.

Tags Tagsapplied to content and library items. See Also:

Note: The search cannot find calendar events.

Searching Multiple Terms
If a site visitor enters several terms, the search only returns pages that include
all terms. This is known as an ‘and’ relationship. For example, if the user enters
cancer and cure in the Search box, only content that includes both terms (and
satisfies the other criteria) appears.

Ektron uses an ‘and’ relationship because we believe it’s what a site visitor
expects. Consider a simple Google search – the more you enter into the Google
Search text box, the fewer results you get, since your phrase is more precise.

The advanced search screen, on the other hand, lets the site visitor determine
if he wants an and, or, not, or exact phrase relationship. See Also: The
Advanced Search on next page

Search Results byContent Type
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The Advanced Search
The Advanced Search uses nearly all the same search criteria as the Basic
Search. (See The Basic Search on page 9-26). The differences are additional
options and filters (explained below) and the fact that you cannot use queries.

Advanced Search Options

Search Option Finds these pages

with all of the
words

Web pagemust include all submitted terms; their position on the page doesnot matter.

You cannot enter queries into this field.

with the exact
phrase

Web pagemust include the exact phrase. For example, if you enter Ektron
healthcare, a page with the termEktron provides healthcare is not found because
it is not an exact match.

at least one of the
words Web page can include anyone of the submitted terms

without the word
Web page doesnot contain the submitted word.

Only use this option if you also reply to one of the three fields above.
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Advanced Result Filters
Below the Advanced Search Options is a list of additional fields you can use to
refine the search. These are titled Advanced Result Filters.

Result Filter Prompts site visitor to enter

Author
Enter firstname<space>last name.

Can abbreviate byentering part of either name surrounded byasterisks (*). For
example, *Jo* findsanyauthor whose first or last name contains those letters.

Created
Before

All content created before date entered byuser.

Date format isYYYY/MM/DD.

Created After
All content created after date entered byuser.

Date format isYYYY/MM/DD.

Modified
Before

All content updated before date entered byuser.

Date format isYYYY/MM/DD.

Modified After
All content updated after date entered byuser.

Date format isYYYY/MM/DD.

File Size Enter file size in kilobytes. You can use greater and less than operators (>, <) to
find content greater or less than a value. For example, > 10000.

To add a filter, click Add Filter. To remove a filter, click Remove to the right
of the filter.

The Content Searchable Field
Each content item includes a Content Searchable field. The search only
considers content whose field is checked. See illustration below.

By default, this field is checked when content is created.

Advanced Result Filters
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Warning! Despite the value of this checkbox, if an Ektron CMS400.NET user places this content
item in a Suggested Results list, it will appear in the Suggested Results area of the Search
Results screen. See Also: Suggested Results on page 9-36. Also, this content can still be found
by the Advanced Workarea search.

Display of Search Results
Below is an example of the Web Site Search and Search Published results
screen. Your developer can customize it using the Web Search server control.

Below the search box is an optional Filter by Category link. If your developer
enables the link in the WebSearch server control, a site visitor can click it to see
a folder structure of taxonomy categories. He can then select categories of
interest. When he does, only content that includes the search term and which is
assigned to the selected categories appears. For more information, seeFiltering
Search Results by Category on page 9-84

The actual results begin with the title and last edited date. Following them is
either

n an abstract of the content, which is automatically generated by the
Windows Indexing Service, or

n the content summary See Also:Working with Content Summary on
page 7-137

Your developer makes this decision in the WebSearch server control.

Following the abstract or summary is additional information, such as content ID
number, size, last author, number of occurrences of the search term, and rank.
Your developer determines which criterion is used to order the results.
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Note: The Adobe IFilter, which is used to generate the abstract, is only supported in Tier 1
languages (English, French, German, and Japanese). If your Web site uses other languages,
the abstract may not be legible. In such a case, your developer should suppress the abstract
from the search results. This procedure is documented in Determining the Display of Search
Results on page 9-83.

When you click the title of any content item, it appears. The search term is
highlighted (see example below) if the following web.config property is set to
true: <add key=”ek_termHighlight” value=”true”/>. To remove
highlighting, set the value to false.

This section also contains the following topics.

Adjusting the Length of the Search Result Abstract 9-31
Search Result Ranking 9-32
Customizing the Postback Message 9-32

Adjusting the Length of the Search Result
Abstract
To adjust the length of the abstract, update the Indexing Service’s Properties
window > Generation tab > Maximum Size field (see below).

Adjusting the Length of the Search Result Abstract
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The abstract’s text is taken from the content. (It ignores text in tables.) If the
content text has fewer characters than the Maximum Size, Ektron
CMS400.NET tries to complete the abstract by retrieving the title, summary,
metadata, comments, and additional information stored in the content item’s
tabs.

Search Result Ranking
Each content item found by a catalog search is given a numerical rank between
0 and 1000. Search results can be sorted by rank.

Criteria used to calculate rank include the

n number of occurrences of the search term

n proximity of search term to beginning of file

n proximity of search term to other occurrences of the term

n whether the term is in the title

Customizing the Postback Message
By default, if a search term yields no results, the following message appears on
the screen.
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If you want to customize this message, follow these steps.

1. In your site root folder, find the workarea/resources folder.

2. Open the resource file that corresponds to your site’s language. For
example, if your site is in American English, open EkResource.en-
US.resources.

Note: If your site supports multiple languages, follow these steps for each corresponding
resource file. See Also:

3. Within the resource file, find the key lbl search no results.

4. The default text (shown above) follows this key. Modify the text as
needed.

5. Save the file.

Synonym Sets and Suggested Results
This section describes two search enhancements that can be used
independently but are more powerful when used together.

n Synonym Sets below

n Suggested Results on page 9-36

Synonym Sets
Prerequisite: You must be a member of the Administrators Group or assigned
the Search-Admin role to create, edit, and delete Synonym Sets. See Also:
Defining Roles on page 15-31

You can create sets of synonyms to work with the search. If a site visitor enters
any term in a synonym set into the Search box, Ektron CMS400.NET’s search
looks for that term plus all other terms in the set.

For example

Synonym Set: Tuition

Terms: tuition, bill, payment, pay, fee, charge, price, amount, cost, money,
balance

SynonymSets and Suggested Results
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If a site visitor inserts bill into the search field, Ektron CMS400.NET uses bill or
tuition or payment or pay or fee or charge, etc. to gather search results.

The Synonym Set feature will typically produce more “hits.” So, while the user
does no more work, his chances of finding the right information on your Web
site are greatly increased.

If a term exists in more than one Synonym Set, the search encompasses all
terms in all sets.

This section also contains the following topics.

Creating a Synonym Set 9-34
Editing a Synonym Set 9-35
Deleting a Synonym Set 9-36

Note: The Web Search server control has a SearchSynonyms property. This must be set to
true for a Synonym Set’s terms to be included in the search logic.

Best Practices
n Synonymsare searched acrossallHTML content and documents indexed byEktron
CMS400.NET (for example,Word documents).

n Ektron CMS400.NET’s search doesnot include plurals or verb forms. So, if you think a site
visitor might enter either ticket or tickets, enter both into the SynonymSet. Samewith bill,
billing, etc.

n A search term can consist of severalwordsas long as the term is entered the sameway in the
SynonymSet. For example, love seat is part of a SynonymSet that includes sofa.

n As long asboth love and seat are in a content item, the search finds it even if the wordsare
separated. But, entering a single term, like love, will not find that SynonymSet. So, if you think
peoplemaysearch using loveseat or love seat, enter both terms into the SynonymSet.

n Themetadata search doesnot use or support SynonymsSets.

Creating a Synonym Set
Follow these steps to create a Synonym Set.

See Also: Synonym Sets on previous page; Editing a Synonym Set on the facing
page

1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Synonyms.

2. From the language dropdown, select a language for the Synonym Set.
(The search is language-specific. When a site visitor begins using
your site, he selects a language. Only synonyms sets in that language
are considered.)

3. Click the Add button ( ).
4. The following screen appears.
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5. Enter a name for the set. Ektron CMS400.NET users will use this
name to identify the Synonym Set.

6. Enter all terms that make up the set. Separate each with a semicolon
(;). You cannot enter a comma (,) or a parenthesis character (() into
the Terms field.

7. After entering all terms, click the Check for Duplicates button.
Ektron CMS400.NET compares terms in this set against the other
Synonym Sets in this language. If the same term is found in another
set, you are notified.

It is not necessarily a problem for a term to exist in more than one
Synonym Set. So, review each Synonym Set that contains the duplicate
and decide what to do.

8. Click Save ( ).

Editing a Synonym Set
Follow these steps to edit a Synonym Set.

See Also: Synonym Sets on page 9-33

1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Synonyms.

2. From the language dropdown, select the Synonym Set’s language.

3. Click the Synonym Set that you want to edit.

4. Click the Edit button ( ).
5. The Edit Synonym Set screen appears.

6. Add or remove terms. Be sure to separate each term with a
semicolon (;).

7. Click the Check for Duplicates button. Ektron CMS400.NET
compares terms in this set against the other Synonym Sets in this
language. If the same term is found in another set, you are notified.

8. Click Save ( ).
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Deleting a Synonym Set
Note: Deleting a Synonym Set also deletes any Suggested Results associated with the
Synonym Set. The user is warned about this when deleting.

Follow these steps to delete a Synonym Set.

See Also: Synonym Sets on page 9-33

1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Synonyms.

2. From the language dropdown, select the Synonym Set’s language.

3. Click the Synonym Set that you want to delete.

4. Click the Delete button ( ).
5. You are asked to confirm your action.

6. The Synonym Set is deleted.

7. Perform an IIS reset on your server. This utility clears the cache, so
that the synonym set is no longer available to Ektron CMS400.NET.

See Also: http://technet.microsoft.com/en-us/library/cc781553(WS.10).aspx

Suggested Results
Prerequisite: You must be a member of the Administrators Group or assigned
the Search-Admin role to create, edit, and delete Suggested Results. See Also:
Defining Roles on page 15-31

For any term or Synonym Set, you can create a list of Suggested Result links.
That is, links that appear in a special area of the Search Results page whenever
someone searches for a selected term. These links can jump to your Web site
or an external Web site.
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This section also contains the following topics.

Using Suggested Results to Direct Site Visitors 9-38
Using Suggested Results to Enhance Business Opportunities 9-39
Determining the Display of Suggested Results 9-40
What Happens when a Term Appears in More than One Synonym
Set

9-
40

Creating a Set of Suggested Results 9-41
Editing a Suggested Result Set 9-43
Adding a Link to a Suggested Result Set 9-44
Editing a Link in a Suggested Result Set 9-44
Removing a Link from a Suggested Result Set 9-45
Rearranging the Sequence of Links in a Suggested Results Set 9-46
Deleting a Suggested Results Set 9-46

Note: The Web Search server control has a ShowSuggestedResults property. This must be
set to true for suggested results to appear on the page that hosts that control.

Suggested Results
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Using Suggested Results to Direct Site
Visitors
Use this feature to direct site visitors to pages that do not appear at the top of
natural search results. For example, you manage a university’s Web site. When
a site visitor wants to know where to mail a tuition payment, he enters bill into
the search field and gets these results.

Faculty member Bill McDermott
The Student Bill of Rights
How a Bill Becomes Law
Frustrated, many people call the business office to get information that exists
on the Web site but is difficult to find.

Using Ektron CMS400.NET, you can combine a Synonym Set with Suggested
Results to direct site visitors to the correct Web pages. To continue this
example, you could create

n a Synonym Set (named tuition) that includes all terms people might
enter when searching for the tuition page on your Web site. See Also:
Synonym Sets on page 9-33

n a Suggested Results list in which you assign the “Tuition & Fees” Web
page to the Tuition Synonym Set

These sets are illustrated below.

After you set up the Synonym Set and Suggested Results, here is a typical
sequence of events.

1. A site visitor enters a phrase on your site's Search page.
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2. The phrase matches a term in a Synonym Set that has Suggested
Results.

3. Suggested Result hyperlinks assigned to the set appear in a special
area of the results page. They appear in the order you defined when
setting up links.

4. The search term’s normal results can also appear. Your developer
determines their location on the results page.

Using Suggested Results to Enhance Business
Opportunities
You can also use Suggested Results to direct site visitors to business partners'
Web sites. One example is a stop smoking clinic near your hospital that has
been successful with your patients. When someone visits your Web site and
searches for smoking, you can set the clinic to be the top Suggested Result.
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As another example, your organization creates widgets but does not implement
or customize them. Over time, several agencies develop experience at
deploying and customizing your widgets. Therefore, you want to promote these
supporting businesses on your site. To do so, create a Synonym Set (for
example: deploy, install, implement, customize, modify, adapt) and assign the
Web sites of approved agencies to the Suggested Results list. Then, when a site
visitor searches for the word implement or customize, he gets links to those
agencies’ Web sites.

Suggested Results can also be used to advertise products, as used in the
sponsored results section of popular search engines like Google® search and
Yahoo!® .

Determining the Display of Suggested
Results
Suggested Results can appear on any page that contains a Websearch server
control. They can appear wherever you want: at the top of the search results
page, in the right column, etc. You can also choose if and where to display the
search term's regular results.

In the Web Search server control, your Web developer determines where
search results appear, using either a style sheet or an XSLT. For more
information, see Web Search Server Control on page 9-72.

Note: The WebSearch server control has a ResultsPageSize property. If your developer
sets it to less than the number of suggested results applied to a term or synonym set, the
ResultsPageSize property’s number of results appears. For example, if you assign five links
to a Suggested Result set but a developer sets ResultsPageSize to three, only the first three
results appear.

What Happens when a Term Appears in More than
One Synonym Set
If more than one Synonym Set contains the same word, and each set has
suggested search results, the results appear in chronological order by Synonym
Set creation date. Here is an example.

Synonym Set Terms Creation Date

Milk production Cow;Milk; Dairy January 1, 2007

Animals Horse; Sheep; Cow April 16, 2007

When a site visitor searches for Cow, the Milk production set’s links appear
above Animals links because it was created first.
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Creating a Set of Suggested Results
Follow these steps to create a set of Suggested Results. You cannot enter more
than 10 links into any Suggested Results set.

1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Suggested Results.

2. From the language dropdown, select a language for the Suggested
Results. (The search is language-specific. When a site visitor begins
using your site, he selects a language. Only Suggested Results in that
language are considered.)

3. Click the Add button ( ).
4. The following screen appears.

5. Use the following table to complete the fields.

Field Description

Type
To apply thisSuggested Results set to a single term, proceed to the next field, Term.

To apply this set to a SynonymSet, change this value to Synonym Set. (If you do, the next
field’s name changes toSynonym Set.)

Term/
Synonym
Set

If the above value isSingle Term, enter a search phrase that will trigger the Suggested
Results you will create below.

Note: You cannot enter a comma(,) or a parenthesis character (() into the Terms field.

If the above value isSynonym Set, select from the dropdown the SynonymSet that will
trigger the Suggested Results you will create below. That is, if a user enter a search phrase
that matchesany term in the SynonymSet, the Suggested Results appear.

Suggested
Results

Place the cursor in this field.When you click, amenu appears (see illustration below).
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6. Click Add.

7. The following screen appears. Here, you add the URL, text, and
summary for each Suggested Result.

8. Use the following table to complete the fields.

Field Description

Link

To create a link to

n content on your Web site, click theBrowse to CMS content button. Then, navigate to the
folder that contains the content you want to link to. Select the content and clickSave.

n an externalWeb site, enter its full address, starting with http://.
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Field Description

Title

If you created a link to

n content on your Web site, its title is retrieved and displayed here. Youmayedit it as needed.

n an externalWeb site, enter the text of the link that will appear on the Suggested
Results display.

Site visitors use this text to select the linkedWeb page. The title is circled in the example below.

Summary

If you created a link to

n content on your Web site, its summaryappears here. Youmayedit it as needed. The
summary cannot exceed 320 characters (including HTML tags).

n an externalWeb Site, nothing appears. Enter up to 320 characters (including HTML tags)
to further describe this link on the search results page.

The summary is circled in the example below.

9. Click Save ( ).
10. The Add Suggested Results screen reappears. You can add more

links, edit existing ones, etc. When done, click Save ( ).

Editing a Suggested Result Set
The following sections explain how to perform the following edits on a
Suggested Result Set.

n Adding a Link to a Suggested Result Set on next page

n Editing a Link in a Suggested Result Set on next page

n Removing a Link from a Suggested Result Set on page 9-45
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n Rearranging the Sequence of Links in a Suggested Results Set on
page 9-46

n Deleting a Suggested Results Set on page 9-46

Adding a Link to a Suggested Result Set
1. From the Ektron CMS400.NET Workarea, go to Settings >

Configuration > Search > Suggested Results.

2. From the language dropdown, select a language for the Suggested
Results. (The search is language-specific. When a site visitor begins
using your site, he selects a language. Only Suggested Results in that
language are considered.)

3. Select the Suggested Results set to which you want to add a link.

4. Click the Edit button ( ).
5. Place the cursor over the first result in the Suggested Results area of

the screen.

6. Click once and a menu appears.

7. Click Add.

8. The Add New Suggested Results screen appears.

9. See Use the following table to complete the fields. on page 9-42.

10. Click Save ( ).

11. Click Save ( ) again.

Editing a Link in a Suggested Result Set
1. From the Ektron CMS400.NET Workarea, go to Settings >

Configuration > Search > Suggested Results.

2. From the language dropdown, select a language for the Suggested
Results. (The search is language-specific. When a site visitor begins
using your site, he selects a language. Only Suggested Results in that
language are considered.)

3. Select the Suggested Results set that you want to edit.

4. Click the Edit button ( ).
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5. Place the cursor in the Suggested Results area of the screen.

6. Place the cursor on the result that you want to edit.

7. Click once and a menu appears.

8. Click Edit.

9. See Use the following table to complete the fields. on page 9-42.

10. Click Save ( ).

11. Click Save ( ) again.

Removing a Link from a Suggested Result Set
1. From the Ektron CMS400.NET Workarea, go to Settings >

Configuration > Search > Suggested Results.

2. From the language dropdown, select a language for the Suggested
Results.

3. Select the Suggested Results set from which you want to remove a
link.

4. Click the Edit button ( ).
5. Place the cursor in the Suggested Results area of the screen.

6. Place the cursor over the result that you want to delete.

7. Click once and a menu appears.

8. Click Delete.

9. A confirmation message appears. Click OK.
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10. Click Save ( ).

Rearranging the Sequence of Links in a
Suggested Results Set
Use this procedure to move Suggested Results up or down within a list.

1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Suggested Results.

2. From the language dropdown, select a language for the Suggested
Results.

3. Select the Suggested Results set from which you want to remove a
link.

4. Click the Edit button ( ).
5. Place the cursor in the Suggested Results area of the screen.

6. Place the cursor over the result that you want to move up or down.

7. Click once and a menu appears.

8. Click Move Up or Move Down.

9. Click Save ( ).

Deleting a Suggested Results Set
1. From the Ektron CMS400.NET Workarea, go to Settings >

Configuration > Search > Suggested Results.

2. From the language dropdown, select a language for the Suggested
Results.

3. Select the Suggested Results set from which you want to remove a
link.

4. Click the Delete button ( ).
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5. Click OK to the confirmation message.

Using the Integrated Search
You can expand the Web search to any Web-accessible files on your server,
even if they are not part of Ektron CMS400.NET. This feature is called
Integrated Web Search.

Note: The Integrated Search only works with a Web Search server control that is placed on a
Web page. It does not work with the Workarea search or any other search server control.

Use an Integrated Search if your site’s search should include non-Ektron
CMS400.NET files which, nevertheless, need to be searchable by site visitors.
For example, a folder of personnel policy documents should be searchable on
your intranet but you do not want to add them to Ektron CMS400.NET.

As another example, you have a Web site of static HTML pages, and are now
deploying Ektron CMS400.NET for certain parts of the site, such as job listings
or a discussion forum. You can create a page with an Integrated Search that
encompasses your entire site.

This section also contains the following topics.

Integrated Search Overview 9-47
Setting up a Virtual Directory 9-48
Setting up an Integrated Search 9-48
Creating an Integrated Search Folder Structure 9-49
Update the Ektron windows service.exe.config File 9-49
Assign the Integrated Search Folder to the WebSearch Server
Control

9-
49

Identifying Integrated Search Folder Information in the Work-
area

9-
50

Viewing All Integrated Search Folders 9-51
Viewing an Integrated Search Folder 9-52
Editing an Integrated Search Folder 9-52
Searching for non-Ektron CMS400.NET Content 9-52
Integrated Search Content in Search Results 9-52

Integrated Search Overview
To set up an Integrated Search, place the content in a Web-accessible folder on
the server’s file system. Then, create one or more virtual directories that point
to the Web-accessible folder. Next, use the Workarea's Add Integrated Search
Folder screen to identify the Integrated Search folder and, if desired, file types
to include or exclude when searching. The procedure for doing this is explained
in Setting up a Virtual Directory on next page.
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Setting up a Virtual Directory
A virtual directory is one that resides in the site root folder, but contains no
content -- instead, it points to a Web-accessible folder anywhere in the file
system. The Web-accessible folder contains the content referenced by the
Integrated Search.

Important: Although a virtual directory does not need to be on the same server as your site, it
must be on the same domain as your site’s server.

Since creating a virtual folder is a Windows procedure, it is explained in these
articles.

n IIS6:

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5adfcce1-
030d-45b8-997c-bdbfa08ea459.mspx?mfr=true.

n IIS 7: http://technet.microsoft.com/en-
us/library/cc771804%28WS.10%29.aspx

On the Access Permissions screen that appears during the setup, only check
Read (see below).

Setting up an Integrated Search
There are four parts to setting up an Integrated Search.

n Creating an Integrated Search Folder Structure on the facing page

n Update the Ektron windows service.exe.config File on the facing page

n Assign the Integrated Search Folder to the WebSearch Server Control
on the facing page
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n Identifying Integrated Search Folder Information in the Workarea on
next page

After setting up an Integrated Search, you might want to do these things:

n Viewing All Integrated Search Folders on page 9-51

n Viewing an Integrated Search Folder on page 9-52

n Editing an Integrated Search Folder on page 9-52

Creating an Integrated Search Folder Structure
1. Create a virtual folder that points to any Web-accessible folder in

your file system. See Also: Setting up a Virtual Directory on previous
page

2. Place files to be searched in the Web-accessible folder or its child
folders.

Update the Ektron windows service.exe.config
File

1. Open c:\Program Files\

Ektron\EktronWindowsService30\Ektron.ASM.EktronServices30.exe.config.

2. Update elements as shown below.

<add key="PdfGeneratorEnabled" value="true"/>

<add key="CustomSearchEnabled" value="true"/>

Assign the Integrated Search Folder to the
WebSearch Server Control
To find Integrated Search content, users must access a Web page that contains
a WebSearch server control. Further, you must assign to that control’s
CustomSearch property the names of all top-level Integrated Search folders
(see illustration below). Any child folders under the top-level folders are
included in the search.
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Identifying Integrated Search Folder Information in
the Workarea
Follow this procedure for every folder that contains Integrated Search content.

1. In the CMS Workarea, go to Settings > Configuration >
Integrated Search Folders.

2. Click the Add button ( ).
3. The Add Integrated Search Folder screen appears.

4. Complete the fields as described in the table below.

To include all files in the folder (except those that would typically not be
searched, such as .exe and .dll files), do not modify the Include
Extensions and Exclude Extensions fields.
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Field Description

Site Directory

Enter the name of the parent folder (or virtual folder) that contains the searchable, non-
Ektron CMS400.NET content. This folder must reside in the site root folder. If you are
using a virtual folder, enter its name, not the folder that contains the content.

See Also:Creating an Integrated Search Folder Structure on page 9-49

Recursive Check this box if you want the search to include all child folders under the folder in the
Site Directory field.

Exclude
Directories

If you want to exclude files in anydirectory underneath the directory listed in theSite
Directory field, enter the namesof the directories to exclude. You do not need to enter
the path to the directory -- only the name.

If you enter more than one directory, use a comma to separate them.

Bydefault, Ektron CMS400.NET places several directories that a search would typically
ignore. Edit as needed.

Exclude
Extensions

If you want the search to ignore certain file types, enter those extensions in this format:
*.filetype. For example *.xml. If you enter more than one, separate themwith a comma
(,).

Bydefault, Ektron CMS400.NET inserts several file types that a search would typically
ignore. Edit as needed.

Warning! - If you enter any value into the Include Extensions field, this field is
ignored.

Include
Extensions

If you want the search to include only certain file types, enter those extensions in this
format: *.filetype. For example *.xml. If you enter more than one, separate themwith a
comma (,).

Warning! - If you enter any value into this field, theExclude Extensions field is
ignored.

Domain/User
Name, Password
and Confirm
Password

If the parent folder is a virtual folder that points to another server, enter the domain\user
name and password needed to access that server.

The parent folder is identified at theSite Directory field.

Important: Ektron’s Windows service runs hourly to index these files. So, you will not see search
results for at least an hour after you set up this feature.

See Also: Using the Integrated Search on page 9-47

Viewing All Integrated Search Folders
To view all integrated search folders, go to Settings > Configuration >
Integrated Search Folders. The screen displays every folder that will be
included in the Integrated Search. See Also: Using the Integrated Search on
page 9-47

Click any folder to edit its properties or delete it.

Viewing All Integrated Search Folders

ReferenceManual
Version 8.01 Rev 4

9-51



If you want to create a new Integrated Search folder, click the Add button ( ).
See Also: Creating an Integrated Search Folder Structure on page 9-49

Viewing an Integrated Search Folder
This screen displays all information about one Integrated Search folder. See
Also: Using the Integrated Search on page 9-47

To see documentation for any field on the screen, go to Complete the fields as
described in the table below. on page 9-50.

To edit information assigned to this Integrated Search folder, click the Edit

button ( ).

To delete this Integrated Search, click the Delete button ( ).

Editing an Integrated Search Folder
To edit an integrated search folder, select if from the View Integrated Search

Folders screen. Then, click the Edit button ( ).

Edit the fields as needed. To see documentation for any field, go to Complete
the fields as described in the table below. on page 9-50.

Searching for non-Ektron CMS400.NET
Content
You can search for all non-Ektron CMS400.NET content by file title. For
example, you can find the file Ektron.gif by inserting Ektron into the search
field.

You can search text files (.doc, .pdf, .txt, etc.) by either file name or text within
them.

Finally, you can use the following syntax to find files by extension: #filename
*.extension. For example, to find all .gif files, use #filename *.gif. Be sure
to click the Images button.

Note: Because Ektron CMS400.NET stores all content in .txt files, you cannot use this syntax to
find files with a .txt extension.

Integrated Search Content in Search Results
To distinguish Integrated Search content from regular content, the ID number
of IS content begins with 1,000,000,000. Also, the last author name is Non_
Cms_User. See illustration below.
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Setting up a Multiple Site Search Using
Virtual Directories
Use the following procedure if you want to set up two sites but use a single
database. The steps below allow you to search from either site to find the same
content.

In this example, the first site contains the database, while the second site uses
virtual directories to point to content in the first site.

1. Set up the first site and create a database for it in the normal
manner.

2. Set up the second site, but when you are prompted to set up the
database, click No.

3. The following message appears. Press OK.

4. In the first site, open the web.config file.

5. Copy the database connection information for your database, as
indicated below.

<connectionStrings>

<!--FOR SQLSERVER-->
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<add name="Ektron.DbConnection" providerName="System.Data.SqlClient"
connectionString="server=(local);database=CMS400Min;Integrated
Security=TRUE;user=;pwd=;" />

Note: Your information may be different from the sample above.

In the second site, open the web.config file. Then, overwrite the database
information with the text you copied in Step 5.

6. Copy the catalog information from the first site to the second. To do
this, open the first site’s web.config file, and copy the contents of the
<providers> element (illustrated below).

<providers>

<add name="MSIndexServer" type="Ektron.Cms.WebSearch.SearchProviders.MSIndexProvider,
Ektron.Cms.WebSearch" catalogName="CMS400Min3152007121250Publish"
privateCatalogName="CMS400Min3152007121250Private" pageSize="10" description="MS Index
Server Provider"/>

<add name="MSIndexDialectServer"
type="Ektron.Cms.WebSearch.SearchProviders.MSIndexDialectProvider, Ektron.Cms.WebSearch"
catalogName="CMS400Min3152007121250Publish"
privateCatalogName="CMS400Min3152007121250Private" pageSize="10" description="MS Index
Server Dialect2 Provider"/>

</providers>

Note: The catalog names are examples. You catalog names may be different.

7. In the second site, open the web.config file. Then, overwrite the
<providers> information with the text you copied in Step 7.

8. Open the folder that contains the first site. Copy the
AssetManagement.config file.

9. Open the folder that contains the second site. Overwrite the
AssetManagement.config file in that folder with the file you copied in
Step 9.

10. Set up the virtual directories. To do that, follow these steps.

- In IIS, open the second Web site you created in Steps 2 and 3

- Delete the Assets folder

- Create a new virtual directory named Assets
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- When prompted to specify a path to the new Assets folder, navigate to
the first site’s Assets folder

- When you finish setting up the virtual folder to Assets directory, set up
virtual directories in the same manner for the following directories:
PrivateAssets, uploaded files, and uploaded images. Remember to
delete the folder in the second site before creating the virtual directory.

- Make sure that none of the folders is set up as an application. To do
that, open IIS, right click each folder and select properties. On the
Directory tab, the Application name field should be grayed out, as
shown below.
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Searching for Metadata
n Searchable type metadata values are returned like regular content.

See Also:

n It can take up to 30 minutes for newly-added metadata to be
available to the search.

n Searchable metadata field names must not include a space. If they
do, the search cannot find the metadata.

n To find content with searchable metadata whose style is yes or no,
enter true or false.

Installing the Visio IFilter
The search finds text within Visio documents if the Visio IFilter has been
installed to the Ektron CMS400.NET server. Use the following links to download
the Visio IFilter.

Visio
Version

Link

2003
http://www.microsoft.com/downloads/
details.aspx?FamilyID=dcee9e09-448b-4386-
b901-efea29cac808&DisplayLang=en

2002
http://www.microsoft.com/technet/
prodtechnol/Visio/visio2002/deploy/ifilter.mspx
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Search Troubleshooting
Problem Solutions

You publish content but cannot
find it using the search

1. Wait 5 or 10minutes (dependson the load on the server).

2. Make sure theMicrosoft indexing service is running (Computer
Management > Services and Applications > Indexing Service). Verify
that the Run button is grayed out. If the service is not running, start it.

3. Query the catalog using the new content’s ID. SeeQuerying the Catalog for
the Content on page 9-60.

4. Make sure the EktronWindowsservice is running (Computer Management
> Services and Applications > Services > Ektron Windows Services
2.0). Verify that the Run button is grayed out.

If the service is not running, start it. If you do, it may take a while for the service to
prepare the content for indexing.

(Continued below)
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Problem Solutions

You publish content but cannot
find it using the search
(continued)

1. Make sure the siteroot/Assets folder’sAdvanced Attributes screen’sFor
fast searching, allow Indexing Service to index this folder checkbox
is checked. To access this screen, click theAdvanced button on the
siteroot/Assets folder properties screen.

2. Check the priority of the database table. SeeChecking the Priority of the
Database Table on page 9-61

Indexing service uses too
muchmemoryor resources.

Or, toomany instancesof
cidaemon.exe are running.

Check the number of catalogsbeing serviced. To do so, follow these steps.

1. Go toComputer Management > Services and Applications >
Indexing Service.

2. You should see three Ektron CMS400.NET catalogs (Public, Private, and
Content), plusSystem andWeb. Ektron CMS400.NET doesnot use the
system andWeb catalogs, so unless your server uses them for another
purpose, delete them.

3. Delete anyother unused catalogs.

4. Restart theMicrosoft Indexing Service.

The catalog size is growing too
quickly, or is really huge

The indexing service generatesan abstract for each content item. See . Bydefault,
the abstract length is 320 characters.

To reduce the catalog size, reduce the abstract length. See

Catalog ismistakenly deleted
or corrupted Recreate it. See
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Problem Solutions

The Inheritable Settings
checkboxesare not checked

Make sure the Inheritable Settings checkboxeson theGeneration tab of the
Properties dialog are checked.

1. Go toComputer Management > Services and Applications >
Indexing Service.

2. Select the first of the three Ektron CMS400.NET catalogs (Public, Private,
and Content).

3. Right click themouse and selectProperties.

4. Click theGeneration tab.

5. Make sure the two checkboxesare checked (illustrated below).

6. Repeat for the other two catalogs.

Verify thatWindowscan find
files on your server

1. OpenWindowsExplorer.

2. Right click your C drive and selectSearch.

3. In theAll or part of the file name field, enter *.*.

4. The search should find all files on your computer.

If it doesnot, ask your system or network administrator to help you determine why
your Windowssearch is not working. For example, he should verify that you have
permission to search for files.

SearchConfigUI.exe crashes
while building search indexes
and catalogs

1. Make sure themetaconfig.doc file exists in the siteroot/uploadedfiles
directory.

If it doesnot, askEktron TechnicalSupport to send you a new file.

2. If anyone uploaded Visio documents to your server, make sure the iFilter is
installed. SeeQueryLanguage on page 9-62.
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Problem Solutions

MS Indexing Service cannot
find files in the
siteroot/assets folder.

1. OpenWindowsExplorer.

2. Navigate to the siteroot/assets folder.

3. Select the folder and right click themouse.

4. SelectProperties.

5. Click theAdvanced button.

6. Check the boxnext to For faster searching, allow Indexing Service to
index this folder.

7. PressOK.

Get error message.

An unhandled exception
has occurred: The type
initializer for
Ektron.CMS.
WebSearch.Manager
threw an exception.0

During installation, the user might have canceled the database setup. Check the
following.

1. Check the site root folder for the following folders. If theydo not exist, create
them.

n PrivateAssets

n Assets

n UploadedFiles

n UploadedImages

2. Make sureMetaConfig.docexists in the [sitepath]\UploadedFiles
folder. If it doesnot, askEktron TechnicalSupport for a copyof that file from
the same Ektron CMS400.NET version.

3. Make sure noise.enu file exists in the [sitepath] folder. If it doesnot, look in
the [sitepath]\workarea folder. If noise.enu is there, copy it to the
[sitepath] folder. If you cannot find noise.enu, askEktron Technical
Support for a copyof that file from the same Ektron CMS400.NET version.

4. Check the following registry key: HKEY_LOCAL_
MACHINE\SYSTEM\CurrentControlSet\Control\ContentIndexCommon
. For that key, make sureDefaultColumnFile has the value
C:\WINDOWS\system32\FriendlyNamesDefinitionFile.txt.

If the entry doesnot exist, create it and set the value as listed above.

Querying the Catalog for the Content
To query the catalog for a content item, follow these steps

1. Go to Computer Management > Services and Applications >
Indexing Service > sitenamePublishedAsset > Query the
Catalog.
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2. Choose Advanced Query.

3. Use the syntax @contentID64=IDnumber. For example, if the content
ID is 30, enter @contentID64=30.

4. The content should appear as shown above.

Checking the Priority of the Database Table
To check how your database is processing the documents, follow these steps.

1. Launch a database management tool, such as SQL Server
Management Studio.

2. Find the Ektron CMS400.NET database.

3. Open Tables > dbo.perform.action.
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4. A list of content blocks being processed appears.

5. Make sure the action_priority for each item is less than -8. If that is
the case, the database will process the record.

If the priority is -8 and the action status is inAction, there is a problem
with the service that processes the document. To resolve the problem,
you can

- go to Computer Management > System Tools > Error Log to find
any errors and fix them

- reset the action_priority value to zero (0) and the action status to
PerformAction

- contact Ektron Support

Query Language
Note: Following text collected from Microsoft Web site.© 2006 by Microsoft Corporation. All rights reserved.

To search for any word or phrase on a Web site, enter the word or phrase into
the Search field and click the button to begin the search.

This section also contains the following topics.

Rules for Formulating Queries 9-63
Boolean and Proximity Operators 9-64
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Tips 9-65
Localized Symbols and Keywords 9-65
Wildcards 9-66
Free-Text Queries 9-66
Vector Space Queries 9-66
Tips 9-67
Property Value Queries 9-67
Property Names 9-67
Relational Operators 9-68
Property Values 9-69
Tips for Using Property Queries 9-69
Regular Expressions 9-70
Query Examples 9-72

Rules for Formulating Queries
When a search is executed, it returns a list of Web pages that contain the word
or phrase that a user entered, regardless of where it appears in text.

Follow these rules when formulating queries.

n Multiple words are treated as individual search terms. So, the term
calendar server returns pages that have both words.

To find pages that have calendar and server in that exact order, use
quotes. “calendar server” returns pages that include both terms in
that exact order with no intervening words.

n Queries are case-insensitive. You can type a query in upper or lower
case.

n The search ignores words in the noise files. Ektron CMS400.NET’s
noise files screen from the search every single letter of the alphabet
as well as many common words, such as about, after, all, and also.
Avoid entering such words into the Search Text field, because the
search ignores them.

The list of noise words (noise.enu) is installed to your
siteroot/Workarea and Windows/System 32 folders. You can
open a noise file with a simple word processor program, such as
Notepad, to view the noise words. You can also edit the files. For
example, you can remove words that users should be able to search
on.

To make a word in the noise files searchable, remove it from both
files then restart both catalogs. See Also:

Exceptions:

- In the Ektron CMS400.NET Workarea, the Advanced Search disregards
the noise file.
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- You cannot make the indexing service operators (and, or, but)
searchable.

n Words in the noise file are treated as placeholders in phrase and
proximity queries. For example, if you search for “Word for
Windows”, the results could return “Word for Windows” and “Word
and Windows”, because “for” is in the exception list.

n Punctuation marks, such as period (.) and comma (,), are ignored by
a search.

n To use special characters, such as &, |, ^, #, @, $, (,), in a query,
enclose the query in quotation marks (“).

n To search for a word or phrase containing quotation marks, surround
the entire phrase with quotation marks and double the quotation
marks around the word to be surrounded with quotes. For example,
“World-Wide Web or ““Web””” searches for World-Wide Web or
“Web”.

n Use Boolean operators (AND, OR) and the proximity operator (NEAR)
to specify additional search criteria. See Also: Boolean and Proximity
Operators below

n Use the wildcard character (*) to find words with a given prefix. For
example, the query esc* finds Web pages with “ESC,” “escape,” and
so on. See Also:Wildcards on page 9-66

n You can specify free-text queries without regard to query syntax. See
Also: Free-Text Queries on page 9-66

n Vector space queries can be specified. See Also: Vector Space
Queries on page 9-66

n You can search on ActiveX™ (OLE) and file attribute property values.
See Also: Property Value Queries on page 9-67

Boolean and Proximity Operators
Use boolean and proximity operators to create a more precise query.

To Search
for

Example Results

Both terms
on a page

healthcare
insurance Pageswith words “healthcare” and “insurance”

Either term
on a page

kidneyor renal

—Or—

kidney | renal#

Pageswith “kidney” or “renal”
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To Search
for

Example Results

All pages that
match a
property
value

@CMSsize >
1000 Pagesgreater than 1000 kilobytes

Both terms
on a page,
close
together

treatment near
immunoglobulin

—Or—

treatment ~
immunoglobulin

Pageswith the word “treatment” near the word “immunoglobulin” See
Also: TheNEAR operator is like the AND operator because it findspages
that include both search words. below

Tips
n To nest expressions within a query, add parentheses. Expressions

within parentheses are evaluated before the rest of the query.

n Use double quotes (“) to ignore a Boolean or NEAR operator
keyword. For example, “Abbott and Costello” finds pages with the
entire phrase, not pages that match the Boolean expression. In
addition to being an operator, the word “and” is a noise word in
English.

n The NEAR operator is like the AND operator because it finds pages
that include both search words.

However, the rank assigned by NEAR depends on the proximity of
the search words. A page with the searched-for words closer
together has a higher rank than a page where they are farther apart.
If the search words are more than 50 words apart, the page is
assigned a rank of zero.

Note: The NEAR operator can be applied only to words or phrases.

n The AND operator has a higher precedence than OR. For example,
the first three queries are equal, but the fourth is not:

- a AND b OR c

- c OR a AND b

- c OR (a AND b)

- (c OR a) AND b

Localized Symbols and Keywords
The symbols (&, |,!, ~) and the English keywords AND, OR, and NEAR work the
same in all languages supported by Ektron CMS400.NET. Localized keywords
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are also available when the browser locale is set to one of the following
languages.

Language Keywords

German UND, ODER, NICHT, NAH

French ET, OU, SANS, PRES

Spanish Y, O, NO, CERCA

Dutch EN, OF, NIET, NABIJ

Swedish OCH, ELLER, INTE, NÄRA

Italian E, O, NO, VICINO

Wildcards
Wildcard operators find pages that contain words similar to a given word.

To Search For Example Results

Wordswith the same
beginning letters pharm* Pageswith words that have the prefixpharm, such as

pharmaceutical, pharmacist, and pharmacology.

Wordsbased on any
form of a verb fly** Pageswith any form of a verb. For example, if you enter fly, the search

returnspages that contain flying, flown, flies, and flew.

Free-Text Queries
A free-text query finds pages that match the meaning, not the exact wording, of
submitted words and phrases. Begin free-text queries with $contents.

You cannot use boolean, proximity, or wildcard operators in a free-text query.

To Search For Example Results

Files that match free-
text

$contents how do I print in Microsoft
Excel?

Pages that mention printing andMicrosoft
Excel

Vector Space Queries
The search supports vector space queries, which return pages that include a list
of words and phrases. Each page is ranked according to how well it matches the
query.
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To Search for Example Results

Pages that contain specific
words light, bulb Fileswith words that best match the search words

Pages that contain
weighted prefixes, words,
and phrases

invent*, light[50],
bulb[10], “light
bulb”[400]

Files that contain wordsprefixed by “invent,” the words
“light,” “bulb,” and the phrase “light bulb” (the termsare
weighted)

Tips
n Separate terms in a vector query with commas (,)

n You can weight terms in vector queries by using the [weight] syntax
(see example above)

n Pages found by vector queries do not necessarily match all words
submitted in the query

n Vector queries work best when results are sorted by rank

Property Value Queries
Use a property value query to find files whose property values match a given
criteria. Properties you can query include file information (like file name and
size), and ActiveX properties, including the document summary stored in files
created by ActiveX-aware applications.

There are two types of property queries.

n Relational property queries - consist of an “at” character (@), a
property name, a relational operator, and a property value. For
example, to find all files larger than one million kilobytes, use
@CMSsize > 1000000. See Also: Relational Operators on next page

n Regular expression property queries - consist of a number sign
(#), a property name, and a regular expression for the property
value. For example, to find all .avi files, use #filename *.avi. See
Also: Regular Expressions on page 9-70

Regular expressions do not match the contents (#contents) and all
(#all) properties.

In regular expression property queries, you can only use properties
that are retrievable at query time. Properties that are not
retrievable include HTML META properties not stored in the property
cache.

Property Names
Property names are preceded by the “at” sign (@) for relational queries, and
the pound sign (#) for regular expression queries.
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If no property name is specified, @contents is assumed.

Properties available for all files are listed below.

Property
Name

Description

All Matcheswords, phrases, and anyproperty

Contents

Wordsand phrases in the file

Note: The contents property doesnot support relational operators. If a relational operator is
specified, no results are found. For example, @contents Ektron findsdocuments
containing Ektron, but @contents=Ektron findsnone.

Filename Name of the file

CMSsize File size

Write Date file was created or last modified (whichever is later)

You can also use ActiveX property values in queries. You can search for files
created by most ActiveX-aware applications by querying for the following
properties.

Property Name Description

DocTitle Title of the document

DocSubject Subject of the document

DocAuthor The document’s author

DocKeywords Keywords for the document

DocComments Comments about the document

Relational Operators
Use relational operators to create relational property queries.

To Search for Example Results

Property values in relation to a fixed value

@CMSsize < 100
@CMSsize <= 100
@CMSsize = 100
@CMSsize != 100
@CMSsize >= 100
@CMSsize > 100

Fileswhose sizematches the query
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To Search for Example Results

Property valueswith all of a set of bits on
@attrib ^a
0x820

Compressed fileswith the archive bit
on

Property valueswith some of a set of bits
on

@attrib ^s 0x20 Fileswith the archive bit on

Property Values

To Search for Example Results

A specific value @DocAuthor = “Bill Bailey” Files authored byBill Bailey

Valuesbeginning
with a prefix

#DocAuthor George*
Fileswhose author property beginswith
George

Files of any
extension

#filename *.gif

Fileswith a .gif extension

Note: Because Ektron CMS400.NET
storesall content in .txt files, you cannot
use this syntax to find fileswith a .txt
extension.

Filesmodified
after a certain
date

@write > 2006/02/14

Note: You cannot use the equal
operator (=) with@write. Only
greater than (>) and less than (<)
operatorswork.

Filesmodified after February 14, 2006

Vectors
matching a
vector

@vectorprop = { 10, 15, 20 }
ActiveX documentswith a vectorprop value
of {10, 15, 20}

Vectorswhere
each value
matchesa
criterion

@vectorprop >^a 15
ActiveX documentswith a vectorprop value
in which all values in the vector are greater
than 15

Vectorswhere at
least one value
matchesa
criterion

@vectorprop =^s 15
ActiveX documentswith a vectorprop value
in which at least one value is 15

Tips for Using Property Queries
n Use the pound (#) character before the property name when using a

regular expression in a property value.
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Use the “at” (@) character otherwise. The equal (=) relational
operator is assumed for regular-expression queries.

n File name (#filename) is the only property that efficiently supports
regular expressions with wildcards to the left of text.

n Dates use the format yyyy/mm/dd.

You can omit the first two characters of the year. If you do, 29 or
less is interpreted as the year 2000, and 30 or greater is interpreted
as the year 1900. All dates are in Greenwich Mean Time (GMT).

n Currency values use the format x.y, where x is the whole value
amount and y is the fractional amount. There is no assumption about
units.

n Boolean values are (t) or (true) for TRUE and (f) or (false) for FALSE.

n Vectors (VT_VECTOR) are expressed as an opening brace ({), a
comma-separated list of values, and a closing brace (}).

n Single-value expressions that are compared against vectors are
expressed as a relational operator, then a (^a) for all of or a (^s) for
some of. See Also: Relational Operators on page 9-68

n Numeric values can be expressed in decimal or hexadecimal
(preceded by 0x).

Regular Expressions
Regular expressions in property queries are defined as follows.

n Any character except asterisk (*), period (.), question mark (?), and
vertical bar (|) defaults to matching itself.

n A regular expression can be enclosed in matching quotes (“). Itmust
be enclosed in quotes if it contains a space () or closing parenthesis
()).

n The characters *, ., and ? behave as in Windows. They match any
number of characters, match (.) or end of string, and match any one
character, respectively.

n The character | is an escape character. After |, the following
characters have special meaning:

- (opens a group. Must be followed by a matching).

- ) closes a group. Must be preceded by a matching (.

- [opens a character class. Must be followed by a matching (un-
escaped)].

- {opens a counted match. Must be followed by a matching}.

- } closes a counted match. Must be preceded by a matching {.

- , separates OR clauses.
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- * matches zero or more occurrences of the preceding expression.

- ?matches zero or one occurrences of the preceding expression.

- + matches one or more occurrences of the preceding expression.

Anything else, including |, matches itself.

n Between square brackets ([]), the following characters have special
meaning.

- ^ matches everything but following classes. Must be the first
character.

- ]matches]. May only be preceded by ^. Otherwise, it closes the class.

- - range operator. Preceded and followed by normal characters.

Anything else matches itself (or begins or ends a range at itself).

n Between curly braces ({}), the following syntax applies.

- |{m|} matches exactly m occurrences of the preceding expression. (0
< m < 256).

- |{m,|} matches at least m occurrences of the preceding expression. (1
< m < 256).

- |{m,n|} matches between m and n occurrences of the preceding
expression, inclusive. (0 < m < 256, 0 < n < 256).

n To match *, ., and?, enclose them in brackets (for example,
|[*]sample matches “*sample”).
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Query Examples

Example Results

@CMSsize > 10000 Pages larger than 10MB

@write > 2003/05/12

Note: You cannot use the equal operator (=) with@write.
Only greater than (>) and less than (<) operatorswork.

Pagesmodified after the date

pear tree Pageswith the phrase “pear tree”

“pear tree” Same asabove

@contents pear tree Same asabove

Ektron and@CMSsize > 10000 Pageswith the word “Ektron” that are
larger than 10 thousand kilobytes

“Ektron and@CMSsize > 10000" Pageswith the phrase specified (not the
same asabove)

#filename *.avi Video files (the # prefix is used because the
query contains a regular expression)

@attrib ^s 32 Pageswith the archive attribute bit on

@docauthor = “John Stanton” Pageswith the given author

$contentswhy is the skyblue? Pages that match the query

Web Search Server Control
The Web Search server control lets you customize the behavior of the search.
You place this control on any Web form from which a site visitor can search
your site. For more information about the site visitor experience, see Web Site
Search on page 9-6

This section also contains the following topics.

Property Usage Table 9-73
WebSearch Property Descriptions 9-73
ResultTagId 9-83
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Property Usage Table
Properties in the Search server control generally affect the control in one of
three ways:

n Search Display - the Web Search server control’s appearance on
your site.

n Search Criteria - criteria used to search the site

n Search Results Display - appearance of search results on your site

The following table shows which properties are associated with each category.
See Also:WebSearch Property Descriptions below

Search Display Search Criteria Search Results Display

ButtonImgSrc

ButtonText

DisableForumSearch

EnableAdvanced Link

Hide

Language

MaxCharacters

ShowSearchOptions

Text BoxSize

WrapTag

CustomSearch

FolderID

Language

Recursive

SearchFor

ShowCategories

ShowSearchOptions

ShowSuggested Results

CustomOrderBy

DynamicContentTemplate

DisplayXslt

Hide

Language

LinkTarget

MaxTeaserLength

OrderBy

OrderDirection

RemoveTeaserHtml

ResultsPageSize

ResultTagId

ShowCustomSummary

ShowSearchBoxAlways

WebSearch Property Descriptions
The following table describes the Web Search server control properties. See
Also: Property Usage Table above

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Description Data Type

Authenticated

Indicates if you are logged in to the CMS
Explorer. If logged in, you can browse to the folder
needed for the FolderID property.

See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

String

ButtonImgSrc If you want to display an image on the submit button,
enter the server path to it. String

ButtonText
The text used for the button if no image source is
identified. If an image source is identified, this is
alternative text for the button.

String

CustomOrderBy

Provide a property’s FriendlyName defined in the
Indexing Service to sort search results by that property.
For example, if you define DocAuthor, resultswill be
sorted by the document’s author.

Results can be ascending or descending based on
OrderDirection. If you enter an invalid property, no
search results are returned.

If you specifyCustomOrderBy and OrderBy, the
OrderByproperty is ignored. The FriendlyName of a
property can be found inComputer Management >
Services and Applications > Indexing Service >
Your Index >Properties >Friendly Name column.

String

CustomSearch

If you want the search to include folders that are not part
of Ektron CMS400.NET, enter the folder nameshere.
Separatemultiple itemswith a comma.

You do not need to enter the folder path, but it must
reside within the site root folder.

See Also: Using the Integrated Search on page 9-47

String

DisableForumSearch

Set to true if you want to remove Forums from the
dropdown list that appears on the Search server control
(see image below).

The default value is false.

Boolean
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Property Description Data Type

Regardlessof this setting, if a user selectsSite (the first option in the dropdown), forum posts are searched.

DisplayXslt

Determines the display of the search results page.

None - databind only

ecmNavigation - lists the title of every content item
found by the search

ecmTeaser - lists the title and summaryof every content
item found by the search.

ecmUnOrderedList - sorts the list in no particular
order. Shows the title and content summary.

Path to Custom Xslt - Enter the path to an Xslt that
determines the display of the page.

Warning! If you specify an external file, it is strongly
recommended that you do not store this file in your
site'sWorkarea folder. If you store this file in the
Workarea folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at the
MarkupLanguageproperty, this property value is
ignored.

See Also: Determining the Displayof Search Resultson
page 9-83

ecmNavigation -Example of ecmNavigation Displayon
page 9-127

ecmTeaser - Example of ecmTeaser Displayon page
9-128

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to
false if you want to postpone the fill-action until later. In
this case, FIll is automatically called during the Page
Render event.

Youmight do this if you need to set or change a property
on the control in codebehind and have it render with
your changes shown.

Boolean

DynamicContentTemplate Sets the template for dynamic content. This property
overridesanyquicklink template for the content. String
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Property Description Data Type

EnableAdvancedLink

Set to true to display an additional tab (Advanced) on
the Search control.

See Also: The Advanced Search on page 9-28

Boolean

FolderID

The folder at which the search begins. The starting
folder need not be the root folder.

The Recursiveproperty determines if the search
examines this folder’s subfolders.

See Also: Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

String

Hide

Used to hideWebSearch Server Control in design time
and runtime.

True =Hide control

False =Show control

Boolean

Language

If the template on which this server control resides
includesa language selection control, and you want to
let the site visitor select the language, enter zero (0).

Otherwise, click the field, then the ellipsis button ( )
and a popup boxappears. Select a language from the
list.

This property shows results in design-time (in Visual
Studio) and at run-time (in a browser).

Integer

LinkTarget

Defineshow a link on the search results display acts
when clicked. The choicesare:

_blank - loads the link in a new blankwindow. This
window is not named.

_self - loads the link in the samewindow the anchor was
clicked in. This is useful for overriding a globally assigned
base target.

_parent - loads the link in the immediate frameset
parent of the document. This defaults to acting like “_
self” if the document hasno parent.

_top - loads the link in the full bodyof the window. This
defaults to acting like “_self” if the document is alreadyat
the top. It is useful for breaking out of an arbitrarily deep
frame nesting.

String
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Property Description Data Type

MarkupLanguage

Identify the templatemarkup file that controls the display
of search results. For example, mysearchmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb
form containing the server control, just enter its name. If
the file is in another folder, enter the path relative to site
root. For example,
\siteroot\workarea\customfiles
\markup\mysearchmarkup.ekml.

Note: If you enter a valid EkML file, the
Displayxsltproperty is ignored.

See Also:

n Determining the Displayof Search Resultson page
9-83

n Controlling Output with EktronMarkup Language on
page 26-1

n websearch.ekmlon page 26-67

String

MaxCharacters

Themaximum number of characters theSearch text
boxaccepts.

If you enter a value less than 50, set the TextBoxSize
property to the same number.

Integer

MaxTeaserLength

Limits the length of any returned content’s abstract. To
allow unlimited length, set to zero.

This property is active only if both of these conditionsare
true.

n you use the DisplayXsltproperty to identify an
xslt and ecmteaserasa value of that property.

If you enter an .ekml file at the MarkupLanguage
property, this value is ignored.

n the ShowCustomSummaryproperty is set to false. If it
is set to true, the entire summaryappears in search
results.

Integer
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Property Description Data Type

OrderBy

The order of search results. For example, you want to
sort search results by last modified date.

Title - The content title (alphabetical)

ID - The content ID number

Date Created - The date the content was created

Date Modified - The date the content wasmost
recentlymodified

Editor - The user who last edited the content
(alphabetical)

Rank - The rankassigned to the content. See Also:
Search Result Ranking on page 9-32

Note: TheOrder Direction field determines the
direction of the search results. For example, if you
sort by ID andOrder Direction is set to
Descending, the results sort byContentID number
with the highest number at the top of the list.

String

OrderDirection

The direction in which search results are sorted. The
default isAscending.

Ascending - Alphabetical results from A to Z; numeric
values low to high; dates from oldest to most recent

Descending - Alphabetical results from Z to A; numeric
valueshigh to low; dates frommost recent to oldest

String

Recursive
Determineswhether to search sub-folders of the
starting folder. The starting folder is identified in the
FolderIDproperty.

Boolean

RemoveTeaserHTML Set to true if you want to remove HTML tags from the
content summarywhen it appears in search results. Boolean
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Property Description Data Type

ResultsPageSize

Use to set themaximum number of results on a page. If
a search returnsmore than this number of results, the
following text appears below the last one:

Result Page: 1 2 3 Next

The user can clickNext or a number to view additional
results.

This property defaults to the value set at the ek_
PageSize element in the web.config file.

Property’s Effect on Suggested Results

Only the number of Suggested Results up to this
maximum appear. If more than this number should
display, theydo not.

This is unlike natural search results, whose additional
links are available via numbersbelow themaximum
page size.

See Also: Suggested Resultson page 9-36

Integer

ResultTagId

Lets you designate where search results appear. You
can place search criteria in one area of aWeb form and
the results in another.

For example, you have the following tag.

<span id=”results”></span>

In this case, enter results for this property value.

See Also:ResultTagId on page 9-83

String
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Property Description Data Type

SearchFor

Choose the type of content to search.

n All

n HTML

n Documents

n Images

n Multimedia

n Discussion Forums

n Tags

n eCommerce Products

n Pagebuilder

If the value is anything other thanAll, this server control
only looks though the selected content type.

Warning! When this property is set to anything other
thanAll, the search optionsdrop down doesnot
appear.

String

SearchSynonyms

If set to true, the SynonymSearch is incorporated into
the search logic.

If false, SynonymSets are ignored.

See Also:SynonymSetson page 9-33

Boolean

ShowCategories

If set to true, when this server control appears, the user
see a Filter by Category option. This option helpsa
site visitor zero in on relevant content.

If false, the Filter by Category option doesnot
appear.

Note: To see the Filter by Category option, the
ShowSearchBoxAlwayspropertymust be set to
true.

See Also: Filtering Search Results byCategoryon page
9-84

Boolean
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Property Description Data Type

ShowCustomSummary

If set to true, the search results display the content
item’s summary instead of the characterization.

Note: If this property is set to true, the
MaxTeaserLengthproperty is ignored. So, the
entire summaryappearswith search results,
regardlessof length.

If false, the search results display the characterization.

The default is false.

See Also:Displayof Search Resultson page 9-30

Boolean

ShowSearchBoxAlways

If set to true, the search boxappears on the PostBack
screen.

If false, the search boxdoesnot appear on the
PostBack screen.

The default is true.

Boolean

ShowSearchOptions

If set to true, the following dropdown optionsappear to
the right of theSearch box.

A site visitor can click an option to limit the search by
content type. If the user accepts the default value,Site,
all content typesare searched.

Warning! If the SearchForproperty is set to anything
other thanAll, the search optionsdrop down doesnot

appear. See Also: SearchFor on previouspage

Note: If the DisableForumSearchproperty is set
to true, Forums doesnot appear in the dropdown
list.

Boolean
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Property Description Data Type

ShowSuggestedResults

If set to true, Suggested Results related to the search
term appear.

If false, Suggested Results do not appear.

Note: If the ResultsPageSizeproperty is set it to
less than the number of suggested results applied to
a term or synonym set, only the property’s number of
results appears. For example, if you assign five links
to a Suggested Result set but set ResultsPageSize
to three, only the first three results appear.

See Also: Suggested Resultson page 9-36

Boolean

Stylesheet

Specify the location of a style sheet to use for the search
results page. Set the location relative to the site root
folder. For example: Workarea\csslib\mytest.css

Leave blank to use the default style sheet,
\webroot\Workarea\csslib\search.css.

Warning! If you enter a valid EkML file at the
MarkupLanguageproperty, or a value at the
DisplayXsltproperty, this property is ignored.

See Also: Determining the Displayof Search Resultson
the facing page

String

SuppressWrapperTags

Suppresses the output of span/div tagsaround the
control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TaxonomyOperator

Select whether to use anAnd orOr operator when
filtering results by taxonomy. Bydefault, the property is
set toOr. This allows for a wider range of returned
results.

And - Only results that match all categories selected in
the Filter byCategory tree appear. For example, if you
are searching for amedical document in the Hospital
and Doctor’sOffice categories, the document must be
assigned to both categories or it is not shown.

Or - whenmore than one category is selected in the
Filter byCategory tree, resultsmust match at least one
category to be shown.

Note: For this property to be active, the
ShowCategoriespropertymust be set to True.

See Also: Filtering Search Results byCategoryon page
9-84

Enum -
TaxCategoryOperator

TextBoxSize The size of theSearch text box for user input. The width
is based on the number of characters. Integer
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Property Description Data Type

WrapTag

Use to specify a server control’s tag. The default is
Span.

Span - designatesan in-line portion of an HTML
document asa span element.

Div - use when you want to apply attributes to a blockof
code.

Custom - use a custom tag.

String

ResultTagId
The ResultTagId property lets you designate where search results appear. So,
you can place search criteria in one area of a Web form and the results in
another.

For example, you have the following tag: <span id=”results”></span>

You would enter results for the property value, as shown below.

Displaying WebSearch Results on a
Separate Page
As a developer, you can place a search dialog on one Web form and display the
WebSearch results on a second Web form. You might do this if you want the
search dialog to appear in a navigation pane, and the results in a separate Web
form. A code example is located in Ektron’s Developer samples, refer to
http://<your site>/CMS400Developer/Developer/default.aspx. From the
menu on the left, click Search >> Search on Postback.

If you do not have Ektron’s Developer Starter Site, you can download it from:

http://www.ektron.com/cms400-starter-sites.aspx.

Determining the Display of Search
Results
You have three options for determining the display of the search results.

ResultTagId
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Order of
Precedence

Option
Control
over
Styling

Control over
Element
Placement

Difficulty
Level for
Novices

More
Information

1 websearch.ekml
file limited excellent low websearch.ekml

on page 26-67

2 XSLT excellent excellent high DisplayXslt on
page 9-75

3 Style Sheet excellent not available medium Using a Style
Sheet below

You can only use one option to determine the search results display. The options
appear in the table above in order of precedence.

That is, if an .ekml file is defined, the other two properties are ignored. If no
.ekml file is defined, then an XSLT can determine the display. Finally, if neither
an ekml file nor a display xslt is defined, a style sheet is used. If you do not
specify a style sheet in the Stylesheet property, the default one is used
(siteroot\Workarea\csslib\search.css).

Using a Style Sheet
Style Sheets let you customize visual elements such as color, alignment, font,
and size. Ektron CMS400.NET’s search results style sheet has been carefully
crafted to give you precise control of even the smallest elements of the page.
For more information on working with style sheets, visit
http://www.w3.org/Style/CSS/.

You can create your own style sheet or modify the default one,
siteroot\Workarea\csslib\search.css.

Best Practice
Ektron recommendscopying and renaming the default style sheet. Then, enter the new one
into theWeb Search server control’sStylesheetproperty. This insures you alwayshave a
clean file to start with and gives you something to reference if you are not getting expected
results.

The style sheet must reside underneath the site root.

You can only define one Search style sheet for each Web page. If you place
more than one Web Search server control on a page, they share a style sheet.

Filtering Search Results by Category
The Filter by Category feature helps a site visitor zero in on relevant content.
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As explained in Taxonomy on page 9-202, the Taxonomy Feature lets users
assign information categories to content. For example, if your organization is a
university, taxonomy categories might be Athletics, Alumni, Admissions,
Academic Departments, etc.

As new content is created, users should apply relevant taxonomy categories to
it. This makes it easier to find content on your site, because a site visitor can
search by category along with search terms. For example, if the search term is
calendar, and the category is Athletics, the search would typically return
calendars of the sports teams but not other calendars, such as those for
graduation, exams, or parents weekend.

To let users filter search results by category, set the ShowCategories property
to true. (The ShowSearchBoxAlways property must also be true.)

Note: This additional search criterion depends on the assignment of taxonomy categories to
your content. If they are not, the filter hides relevant but unclassified content. For example,
someone authors an article on “Treating Heart Disease” but doesn't assign a taxonomy
category to it. If a site visitor on the search page selects Filter by Category then the Medical
Forum > Heart Disease category, he will not find that article.

As a developer, you can control whether the results must match all categories
selected in the Filter by Category tree or match at least one category. To
display results that must match all categories, set the TaxonomyOperator
property to And. To show results that match one or more categories, set
TaxonomyOperator to Or. By default, the property is set to Or. This allows for
a wider range of returned results.

Effect of Setting ShowCategories to True
If you set the ShowCategories property to true, initially the site visitor sees no
difference. However, if he enters a search term that exists in content to which a
taxonomy category is assigned and clicks the Search button, he sees Filter by
Category above the results (illustrated below).

Note: If no categories are assigned to the content in the search results, the Filter by Category
link does not appear.

Filtering Search Results by Category

If he clicks Filter by Category, the visitor sees all taxonomies with at least
one content item that contains the search term. He can then select categories

Effect of Setting ShowCategories to True

ReferenceManual
Version 8.01 Rev 4

9-85



from the taxonomies. If he does, the results refresh, and only content that
contains the search term and is assigned to the selected categories appears.

If a visitor selects more than one category, the TaxonomyOperator property
determines which content appears.

TaxonomyOperator
property value

This content appears in search results

and content assigned to all selected categories

or content assigned to any selected category

Note: If the visitor selects a parent category, all of its child categories are selected by default.

In the sample below, the site has 15 content items with the word treatment
that are assigned to the Medical Forum taxonomy.

If the user drills down to the Treatment category, only one content item is
found.
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If a site visitor performs any of the following actions, all taxonomy category
selections are cleared, and a new search is performed.

n clicks the Search button

n presses <Enter>

n uses the document type dropdown (site, multimedia, images, etc.)

n performs an Advanced Search

On the other hand, if a site visitor closes folders in the taxonomy structure, all
selected categories remain selected.

Using Ektron’s Search APIs
Ektron Provides two separate APIs for search. One is based on the “Web
Search” architecture. The other is based on Ektron’s previous “Search’
architecture.

This section also contains the following topics.

Using the Web Search API 9-87
Using the Search API 9-88
Guidelines for Creating a Search 9-88

Using the Web Search API
Ektron CMS400.NET provides an API that lets you create a programmatic Web
Search.

To see an example of the search API, go to the Developer Starter Site’s
developer page (http://[your Web
server]/cms400Developer/Developer/default.aspx) and click Search >
Search API. In this section there are several examples of using the Web
Search API for programmatic searches.
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Note that below each example on the page is run this example. Click this link
to run the search and view the results.

If you do not have the Developer Starter site installed, you can download it
from:

http://www.ektron.com/products.aspx?id=5948

The Developer site is located in the Example site section.

Using the Search API
Warning! This Search API is deprecated as of the 7.0 Release. For optimal performance, Ektron
recommends using Ektron’s Web Search API. See Using the Web Search API on previous page.

Note: The Programmatic Search API does not support recursive searches. However, using
code behind you can use the Search server control to programmatically search recursively.
See Also: Web Search Server Control on page 9-72

Ektron CMS400.NET provides an API that lets you create a programmatic search
on users and content. For example, you could use it to find all membership
users whose zip code is 03031.

Guidelines for Creating a Search
Here are guidelines to follow when creating a search.

1. A search consists of one or more conditions. Each condition consists
of an operator (and, OR, Like), a value, and the field whose value you
are setting. See illustration below.

Dim isMemberShip As UserSearchCondition = New UserSearchCondition ’’’Condition
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isMemberShip.setType = SearchType.Equal ’’’Operater

isMemberShip.setValue = 1 ’’’Value. The value can be integer,string,date and boolean
should be match with db type

isMemberShip.setVariable = Users.membership_user ’’’Field

Dim isInEktron As UserSearchCondition = New UserSearchCondition ’’’Condition

isInEktron.setType = SearchType.Equal ’’’Operater

isInEktron.setValue = "03031" ’’’Value. The value can be integer,string,date and boolean
should be match with dynamic_data_tbl labels type

isInEktron.setVariable = "customproperties.zip" ’’’Condition

Warning! If the field is a date, you can only use the following operators: EQUAL, NOT EQUAL,
GREATERTHAN or LESSTHAN.

2. After all conditions are declared, declare the logical relationship
between them. In other words, must the search criteria satisfy all or
any conditions?

In the sample code below, the search only returns users that satisfy
both declared conditions. This is indicated by the AND operator.

Dim condition As UserSearchCondition = New UserSearchCondition

condition.setType = SearchType.AND

condition.AddCondition(isInEktron)

condition.AddCondition(isMemberShip)

3. Execute the search.
Dim search As New SearchManager

Dim result As UserData() = search.Execute(condition)

search = Nothing

Searching the Workarea
You can search any folder to quickly locate content within Ektron CMS400.NET.
The following sections explains how to use the content search through the
following subtopics.

n Accessing the Search Content Folder Screen on next page

n The Search Published Tab on next page

n The Advanced Search Tab on page 9-93

n Result Display Options on page 9-99

n Information on the Advanced Search Results Screen on page 9-101

Searching theWorkarea

ReferenceManual
Version 8.01 Rev 4

9-89



Accessing the Search Content Folder
Screen
To access the Search Content Folder screen, follow these steps.

1. Navigate to the folder from which you want to begin the search.

Note: To search your entire site, start with the top-level (Root) folder. If you want to limit the
search to a folder (and its subfolders), select it then choose search criteria.

2. Click Action > Search.

3. The Search Content Folder screen appears.

The Workarea search has two tabs:

n the left tab, Search Published, is like the Site Search. See The
Search Published Tab below.

n the right tab, Advanced Search, lets you search by internal
properties, such as title, status, and comments. See The Advanced
Search Tab on page 9-93.

The Search Published Tab
The Search Published tab within the Workarea finds content that satisfies these
criteria.

n status is published

n active (archived content is ignored; however, the Advanced Search
finds archived content. See The Advanced Search Tab on page 9-93)

n you have read-only or greater permission for the content’s folder

n content is public. However, private content is available to those with
permission to view it, such as membership users after logging in. See
Also: Private Content on page 7-184
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n matches selected language, if site is multilingual. See Also:Working
with Multi-Language Content on page 14-1

n the content’s Content Searchable check box is checked

n is not a non-image file added to the library. Images are searchable,
while other files added to the library are not. So, to make files
searchable, add them as assets, not library files.

n content resides in the folder you selected before launching the search
or one of its subfolders. To search the entire Web site, begin the
search at the root folder.

n satisfies text and/or query entered in the search box (no value
returns nothing). The text inserted in the search field can appear in
the content, summary, or metadata. See Also: Query Language on
page 9-62

n satisfies content type criterion, if chosen (see below). These are
described in Search Screen Options on next page.

This section also contains the following topics.

Search Screen Options 9-92
Searching for Metadata 9-92
Display of Published Search Results 9-92
Search Result Ranking 9-93
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Search Screen Options
Search Screen Option Finds submitted text in these content types

Site Content from all options listed below.

HTML

n HTML

n Smart Form (XML)

Note: Finds field valuesbut not field labels. This hasnot changed
since prior releases.

n HTML Form

n Blog entries (not comments)

Documents

n MSOffice document (includesPowerpoint, Excel)

Note: The search finds text within Visio documents if the Visio
IFilter hasbeen installed on the server. See Installing the Visio
IFilter on page 9-56.

n PDF file

n .txt file

Imagesadded asassets or
through the library .gif, .jpeg, etc.

MultiMedia Flash, .mp3, etc.

Forums Forum posts and topics

Note: The search cannot find calendar events.

Searching for Metadata
n Searchable type metadata values are returned like regular content.

n It can take up to 30 minutes for newly-added metadata to be
available to the search.

n Searchable metadata field names must not include a space. If they
do, the search cannot find the metadata.

n To find content with searchable metadata whose style is yes or no,
enter true or false.

Display of Published Search Results
Below is an example of the Search Published results screen.
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As you can see, content on the search results screen begins with the title and
last edited date/time. Following them is either an abstract or the summary of
the content. This is determined by your web developer in the Web Search
server control.

Following the abstract is additional information, such as content ID number,
size, last author, etc.

Search Result Ranking
Each content item found by a catalog search is given a numerical rank between
0 and 1000. Search results can be sorted by rank.

Criteria used to calculate rank include the

n number of occurrences of the search term

n proximity of search term to beginning of file

n proximity of search term to other occurrences of the term

n whether the term is in the title

The Advanced Search Tab
The Advanced Search within the Workarea finds content that satisfies these
criteria.

Warning! The Advanced search finds content whether or not it is marked Searchable.

n user must have read-only or greater permission for content’s folder

n matches selected language, if site is multilingual

Search Result Ranking

ReferenceManual
Version 8.01 Rev 4

9-93



n satisfies criteria entered on the screen (see below)

The Advanced Search Tab helps you find Ektron CMS400.NET content by
specifying the following criteria. All fields are optional. However, the search
only finds content that satisfies all criteria.

n the kind of content you want to search (for example, HTML content,
forms, assets)

n a search word or words. Unlike the Search Published tab, you
cannot use a query.

n how the search words must match the content in order for a
document to be found

n whether the title is searched

n whether the comments are searched

n a range of created or modified dates

n the editor who updated the content most recently

n the content’s status

n any searchable metadata assigned to the folder

This section also contains the following topics.

Using the Advanced Search 9-95
Specifying the Kind of Content to Search 9-95
Specifying a Search Word or Phrase 9-96
The Noise File 9-96
Specifying Match Criteria 9-96
Match Criteria Examples 9-97
All the Words 9-97
Any of the Words 9-97
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Exact Phrase 9-97
Content ID 9-97
Additional Search Criteria 9-98
Fields that Apply to Content, Forms and Assets 9-98
Custom Fields 9-99

Note: To help track search activity, the Search Phrase Report provides a count of all words
and phrases searched within a date range. In Ektron CMS400.NET, this report is available
from the Smart Desktop > Reports. See Also: Search Phrase Report on page 7-719

Using the Advanced Search
When performing a search, enter one or more words into the text box, select
search preferences, then click the Search button.

You can use an asterisk as a wildcard character, in other words, to stand for
any character. For example, the phrase CMS*00 returns topics that include the
following text: CMS400, CMS300, CMS200 and CMS100.

Your system administrator can add custom search fields that only appear if a
user is logged in. For more information, see Working with Metadata on page 7-
141.

Specifying the Kind of Content to Search
Near the top of the screen, check boxes let you determine the kinds of content
to search.

Note: Assets only appears if your organization has implemented Ektron’s Document
Management feature.

Check
this box

To search

Content HTML content, blogsentries, and XMLSmart Form field values

Forms HTML forms

Assets Content that is neither HTML nor XML, such asOffice documents andmanaged files. See Also:
Using the Document Management System on page 7-399

Include
Archived

Content, formsand assets that have been archived. See Also:Setting Archive Optionson page 7-
191
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Specifying a Search Word or Phrase
In the Search Text field, enter one or more words that you want to find within
content, forms, and assets. The search returns content that includes these
words.

Entering text here is optional. That is, you can use fields on the lower portion of
the screen to find content without entering words contained in the content. For
example, you can find every piece of HTML content that was modified by a
certain user within the last 30 days.

If you check off HTML and Form content, you can enter no search criteria and
get a list of all HTML and Form content on your site. However, if you enter
search text, the search only finds items that include the search text and satisfy
other criteria on the screen.

The Noise File
Ektron CMS400.NET has a noise file that screens from the search every single
letter of the alphabet as well as common words. Examples of common words
are about, after, all, and also. Avoid entering such words into the Search
Text field, because the search ignores them.

For information on managing the noise files, see Rules for Formulating Queries
on page 9-63.

Specifying Match Criteria
Note: This field is only applicable if you entered one or more words in the Search Text field.

From this dropdown list, select criteria for how the search word or words must
appear within the content of the files being searched.

Your choices are described below.

Choice A search returns content that has For more information, see

All the words allwords in the search field All theWordson the facing page

Anyof the words anyword in the search field Anyof theWordson the facing page
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Choice A search returns content that has For more information, see

Exact Phrase allwords in the order specified in the search field Exact Phrase below

Content ID the submitted ID number Content ID below

Match Criteria Examples
The examples below assume you entered these words into the Search Text
field.

n partners

n content

n Monday

n employee

n green

All the Words
All Words is an “and” function. The search returns only content that has the
words partners and content and Monday and employee and green. The words
can be in any order within the file.

Any of the Words
Any Word is almost the opposite of All of the Words. It is an “or” function.

When you select this option, the search returns all files that have at least one of
the words entered in the search text field. In other words, it returns files with
the word partners or content or Monday or employee or green.

Exact Phrase
Exact Phrase returns content that have all five words in the order specified in
the search text field.

A better example would be to search for a phrase, such as Content Management
Solution. The search yields only content with that exact phrase.

Content ID
You can find content by its ID number. To do so, select Content ID from the
drop down box below the Search Text field. Then, enter the ID number in the
Search Text field and click Search.

Match Criteria Examples
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Additional Search Criteria
The next section of the Advanced Search Tab lets you choose one or more
customized search criteria. Note that if you enter more than one criterion, only
content satisfying all criteria appears on the search results screen.

Fields that Apply to Content, Forms and Assets

Search
criterion

Description

Title

The title of the content. You can enter a partialword. For example, enteringPart yields the
following results.

n Multi-HospitalNurse Executive Participation

n Ektron Partners and Customers

You can enter more than one word or phrase as long as theyare in the correct sequence.

Comments The content’s comments, which can be inserted via theComment tab.

Date
Created

The file’s creation date. You can enter a single date or a range of dates.

The search returnsall content with that creation date that satisfy the other criteria.

Date
Modified

The last date when the file wasmodified. You can enter a single date or a range of dates.

The search returnsall itemswith that edit date that satisfy the other criteria.

Last
Editor’s
Last Name

The last name (surname) of the user whomost recently changed the content. This is taken
from the Last Name field on the User Information screen.

The search returnsall items last edited by that user that satisfy the other criteria.

Status

The content status. See Also:Content Statuseson page 7-130

Note: Although you can search for content byany status, the search results display only the
most recently published version. If a version hasnever been approved, nothing appears.
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Custom Fields
Custom fields are defined by your system administrator and applied to content
by its author or editor. They are custom-defined, so would be different for
every site.

The custom search fields appear below the Status field.

Result Display Options
At the top of the Advanced Search Tab, a pull-down list lets you choose the how
to display the search results.

CustomFields
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View
option

Description

Graphical

If the item is content or a form, display a thumbnail of it.

If the item is an asset, display a generic icon that indicatesasset type.

In both cases, to the right are the item’s

n title

n summary

n last edited user, date and time

You can click the title to display the item inside the View Contents screen. From there, you can
perform all available functionson the item.

Note: Graphical search results require the Internet Explorer browser, version 6 or greater.

Sample HTML content

Sample Microsoft Word document

Text

Display item’s title in the left column. To the right, display the

n last edit date/time

n folder name

n size (assets only)

n DMS rank (assets only)

n language

n status

Sample Text Content
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Information on the Advanced Search
Results Screen
The following column headers describe the information displayed for all content
items that satisfy the search criteria.

Column

Header
Description

Content
Title The title of the content item

Last Edit
Date Themost recent date on which content wasedited. If it wasnever edited, its creation date.

Folder
name The folder that contains the content

Size The size of the content item in kilobytes

DMS
Rank

An indication of how well a content item pagematches the search criteria, using a range of 0 to
1000. The higher the rank, themore relevant content is to the search criteria.

Language
The locale id value of the content’s language.

Status A one-character abbreviation of the content item’s status. See Also:Content Statuseson page
7-130

Note: If you install Ektron CMS400.NET then later select a different database to search, you
must run C:\Program Files\
Ektron\releasenumber\utilities\software\searchconfig\SearchConfig.exe
against the new database. This program gets all required data from the new database.

Information on the Advanced Search Results
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Working with Collections
A collection is a list of content links offered to readers of a Web page. The
following illustration shows a collection on a Web page.

You can also use a collection to display listings such as job postings, press
releases, and knowledge base articles. The following graphic illustrates a
collection on the landing page of Ektron’s Knowledge Base.

This section explains how to find, create, and manage collections through the
following subtopics. Your system administrator then creates or updates a Web
page to display the collections using the Collection server control.

This section also contains the following topics.

Finding Collections 9-102
Viewing a Collection 9-105
Creating a Collection 9-107
Editing Content in a Collection 9-113
Reordering Collections List 9-114
Editing Collection Information 9-115
Deleting a Collection 9-116
Working with Collections in a Multi-Language System 9-116
Collection Permissions 9-118
Setting up Approval for Collections 9-119
Collection Server Control 9-122

Finding Collections
Every collection is assigned to a folder. To find the collections assigned to any
folder, navigate to the folder and click the folder. Next, Click View>
Collectionmenu.
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For more information, see Finding a Collection by Navigating to its Content
Folder below.

Since collections can be assigned to any content folder, the Content Tab
provides a central Collections folder, which displays all collections, regardless
of their content folder. For more information, see Finding a Collection Using the
Collections Tab on next page.

Finding a Collection by Navigating to its
Content Folder
To access collections for a content folder, follow these steps.

1. Click the content folder that contains the collection.

2. If you are using Ektron CMS400.NET’s multi-language support
features, select the language by clicking View > Language. See
Also:Working with Multi-Language Content on page 14-1

3. Click View > Collection.

4. The View Collections screen appears.

The screen displays each collection created for the folder. The following table
explains each column.

Finding a Collection byNavigating to its Content
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Column Description

Title The title assigned to the collection by the creator.

ID
The ID assigned to the collection byEktron CMS400.NET. This
number is used to store and retrieve the data to/from the
database.

DateModified When the collection was last edited.

URL The default template used to display the content.

Finding a Collection Using the Collections
Tab
To view all collections in all content folders, follow these steps.

1. From the Workarea, click the Content menu tab.

2. In the lower left, click Collections then Collections.

3. The View All Collections screen appears.

Note: The ek_PageSize setting in the web.config file determines the maximum number of
collections that appear on a page before it “breaks.” When a page breaks, additional
collections appear on another screen, and the following appears at the bottom of the list:
Page 1 of 2[First Page] [Previous Page] [Next Page] [Last Page]

Note: If you have a large number of collections, use the Search box to help find one.
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4. The screen has four columns, described below.

Column
Title

Description

Title Title given to collection byuser who created, or last edited, it.

ID ID number assigned byEktron CMS400.NET. (Developers use this number to reference the
collection in ecmCollection custom function.)

Description Description given to collection byuser who created, or last edited, it.

Path Folder location of the collection.

You can click any collection to view information about it and perform tasks on
it. See Viewing a Collection below.

You can also add a new collection. See Creating a Collection on page 9-107.

See Also: Finding Collections on page 9-102

Viewing a Collection
To view a collection, follow these steps.

1. Select a collection using the procedure described in Finding
Collections on page 9-102.

2. The View Collection screen appears.

To see more details about a collection, click the Properties button ( ).
Alternatively, hover the cursor over the collection,right click the mouse, and
select View Properties.

Viewing a Collection
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The Collection Properties screen appears.

The screen displays each item in the collection. To learn more about a
collection, click More Info. When you do, the lower section of the screen
displays the following information about the collection.

Collections Toolbar
The following table describes the collection toolbar buttons.

Button Name Description More Information

Add Add items to a collection. Adding a Collection on the facing page

Remove Remove items from a collection. Removing Content from the Collection on
page 9-113

Reorder Reorder items in a collection. Reordering CollectionsList on page 9-114
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Button Name Description More Information

Edit View information about the collection's
properties

Editing Collection Information on page 9-
115

Delete Delete a collection. Deleting a Collection on page 9-116

Back Return to previous screen.

Creating a Collection
Creating a collection involves two steps:

n Adding a Collection below

n Assigning Content to the Collection on page 9-109

The following sections explain each step.

Note: This section explains creating a collection in a site that does not support multiple
languages. If you want to create collections in several languages, seeWorking with
Collections in a Multi-Language System on page 9-116.

Adding a Collection
To add a new collection, follow these steps.

1. If you want to create the collection in a specified folder, navigate to
it, and click New > Collection.

To create the collection in the root folder, click Content > Collections
> Collections then click the Add button ( ).

Alternatively, hover the cursor over Collection, right click the mouse, and
click Add Collection, as shown below.

2. The Add Collection screen appears.

Creating a Collection
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3. Complete the screen using the following table.

Field Description

Title Assign a unique title to the collection.

Template

Enter the default template for the collection. This template is used to display the content of the
links generated if no template is assigned in the custom function.

If left blank, the links use their respective Quicklinks.

See Also:Default Template vs. Quicklinksbelow

Description Add amore detailed description for the collection.

Include
Subfolders Check if you want to add to the collection content in subfolders of the content folder.

Approval is
Required SeeSetting up Approval for Collectionson page 9-119.

4. Click the Save button ( ).
You can now assign content to the collection. See Assigning Content to the
Collection on the facing page.

See Also: Creating a Collection on previous page

Default Template vs. Quicklinks
You can specify a template that determines the screen display for a collection
when it is published on a Web page. (See your system administrator for
information about Ektron CMS400.NET templates.) Or, you can disable the
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template and, instead, use Quicklinks to determine the page template. (See
Also: Quicklinks and Forms on page 8-20)

If you specify a template, all content in the collection uses the same screen
elements other than the specific content. For example, the page header, footer
and information in the right frame of the screen are all the same. On the other
hand, if you use Quicklinks, every page in the collection uses its original
template. As a result, the surrounding information may change for every
content item in the collection.

Here is an example of links using Quicklinks. Notice that content uses several
templates. As a result, when a user clicks content in the collection, the screen
information around the content changes according to its template.

Here is an example of links when using a template named index.asp. In this
case, all pages have the same information surrounding the content.

Note: If a collection item is a form, ekfrm is used instead of id to denote form block .

To toggle between a default template and Quicklinks, follow these steps.

1. Access the Edit Collection screen for the collection you want to edit.

2. Modify the Template field.

3. Click the Save ( ) button.

Assigning Content to the Collection
After a collection is created, your next step is to assign content to it. To do so,
follow these steps.

Note:When viewing a Collection on the Web site, the last published version of content
appears. If the content has never been published, nothing appears.

Assigning Content to the Collection
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1. Access the collections screen for the content folder in which you want
to add the collection, as described in Finding a Collection by
Navigating to its Content Folder on page 9-103.

2. Access the View Collection Screen.

3. Click the collection to which you want to assign content.

4. The View Collection screen appears.

5. Accept or change the language.

6. Click the Add Items button ( ).
Alternatively, hover the cursor over the collection in the left panel, right click
the mouse, and click Add Items, as shown below.

As another alternative, navigate to a content folder, click items to be assigned,
right click the mouse and select Copy. Then, locate the collection, right click
the mouse, and select Paste Items to Collection.
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7. The Add Items to Collection screen appears, displaying

n all subfolders within the selected folder (subfolders are available if
the Include subfolders checkbox was checked for the collection)

n content in the selected folder that is not part of the collection.

Note that the file types pulldown remembers your most recent choice
and can filter which files appear. You can change the selection if
desired.

Assigning Content to the Collection

ReferenceManual
Version 8.01 Rev 4

9-111



8. Check boxes next to content to add to the collection. You can only add
content from the selected folder or its subfolders.

(Subfolders are available if the Include subfolders checkbox is
checked for the collection.)

Click a subfolder to view its content. To return to the parent folder, click

the folder with the up arrow ( ).

Note: If you select content from a subfolder, click the Add button to add selected content to the
collection. Navigating between subfolders deselects content.

9. Click the Save button ( ).
See Also: Creating a Collection on page 9-107

Creating New Content for a Collection
You can create new content while adding content links to a collection. To add
content, follow these steps.

1. Access the collections screen for the content folder in which you want
to add the collection, as described in Finding a Collection by
Navigating to its Content Folder on page 9-103.

2. Access the View Collection Screen.If you are using Ektron
CMS400.NET’s multi-language support, select the language of the
collection.

3. If you are using Ektron CMS400.NET’s multi-language support, select
the language of the collection.

4. Click the Add button ( ).
Alternatively, hover the cursor over the collection in the left panel, right click
the mouse, and click Add Items, as shown below.

5. The Add Items to Collection screen appears.

6. If your collection includes subfolders and you want to add the content
to one of them, navigate to that subfolder. Otherwise, proceed to the
next step.

7. Click the Add Content button ( ).
8. The Add Content screen appears. If you are using Ektron

CMS400.NET’s multi-language support, the content’s language
appears next to the title. The language is derived from the collection’s
language and cannot be changed.
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9. Create the content.

Note: Refer to Adding HTML Content on page 7-15 for additional information about creating
new content.

10. Click a workflow option in the Add Content screen.

11. The Add Content screen closes, and the new content link appears in
the list of links available to the collection.

12. Check off the content you created and other content.

13. Click the Add button ( ) to add the content to the collection.

Editing Content in a Collection
After a collection is created, you can add or remove links to and from it.

Adding Content to the Collection
For information about adding content to a collection, see Assigning Content to
the Collection on page 9-109.

Removing Content from the Collection
To remove a content link from a collection, follow these steps.

1. Access the collections screen for the content folder in which you want
to add the collection, as described in Finding a Collection by
Navigating to its Content Folder on page 9-103.

2. Access the View Collection Screen.

Editing Content in a Collection
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3. Click the Remove Items button ( ).
Alternatively, hover the cursor over the Collection, right click the mouse, and
click Remove Items, as shown below.

4. The Remove Items from Collection screen appears.

5. Check boxes next to links that you want to delete.

Click Select All to select all boxes.

Click Clear All to remove all check marks.

6. Click the Delete button ( ).
See Also: Editing Content in a Collection on previous page

Reordering Collections List
After a collection is created, and more than one content item is assigned to it,
you can reorder the collections list. To do so, follow these steps.

1. Lccess the collections screen for the content folder in which you Lant
to add the collection, as described in Finding a Collection by
Navigating to its Content Folder on page 9-103.

2. Access the View Collection Screen, as described in Reordering
Collections List above.

3. Click the Reorder button ( ).
Lccess the collections screen for the content folder in which you Lant to
add the collection, as described
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bullet text the collections screen for the content folder in which you
want to add the collection, as des.

- dash text the collections screen for the content folder in which you
want to add the collection, as des.

Alternatively, hover the cursor over the Collection, right click the mouse, and
click Reorder Items, as shown below.

4. The Reorder Collection screen appears.

5. Click the content whose order you want to change.

6. Click the up or down arrow to move the content in either direction.

7. Repeat steps five and six until you set the desired order.

8. Click the Update button ( ).

Editing Collection Information
To edit information about a collection, follow these steps.

1. Access the collections screen for the content folder in which you want
to add the collection, as described in Finding a Collection by
Navigating to its Content Folder on page 9-103.

2. Access the View Collection Screen, as described in Viewing a
Collection on page 9-105.

3. Click the collection whose information you want to change.

4. Change any of the field values. For documentation of the fields, see
Complete the screen using the following table. on page 9-108.
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Deleting a Collection
When you no longer want a collection, you can delete it. To delete a collection,
follow these steps.

1. Access the collections screen for the content folder in which you want
to add the collection, as described in Finding a Collection by
Navigating to its Content Folder on page 9-103.

2. Access the View Collection Screen, as described in Editing Content in
a Collection on page 9-113.

3. Click the Delete button ( ).

Alternatively, hover the cursor over the Collection, right click the mouse, and
click Delete collection name, as shown below.

4. A confirmation message appears.

5. Click OK to proceed.

Working with Collections in a Multi-
Language System
In a multi-language Ektron CMS400.NET system, you can create a language-
specific edition of each collection. When a site visitor selects a language then
navigates to a page with a collection, Ektron CMS400.NET displays the collection
in the selected language if available. If not, Ektron CMS400.NET displays
nothing.

Note: Notice the contrast between the collections and content: if a collection is not available in
the selected language, nothing appears. But if content is not available in the selected
language, content in the default language appears.

When creating a collection for a foreign language, decide if you want to create

n a foreign edition of an existing collection, or

n a new collection in a foreign language
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For example, if you want to provide several versions of a single page that
change depending on the language selected by the user, see Creating a
Language-Specific Collection if Another Edition Exists below.

On the other hand, if you are creating a collection to appear only on a foreign
language page, and no other edition of the collection will appear on your site,
see Creating a Language-Specific Collection if Another Edition Does Not Exist
below.

You can only add content in the language of a collection. So, create the content
first, then create the collection that links to them.

This section also contains the following topics.

Creating a Language-Specific Collection if Another Edition Exists
9-
117

Creating a Language-Specific Collection if Another Edition Does
Not Exist

9-
117

Creating a Language-Specific Collection if
Another Edition Exists

1. Click the content folder in which your collection exists. The folder’s
contents are displayed.

2. If necessary, change the language of the folder display by clicking
View > Language.

3. Click View > Collection.

4. The View Collections screen is displayed.

5. Select the collection that you want to translate.

6. From the View dropdown list, select the language of the new
collection.

7. Using the Add button ( ), select the content to add to the collection.
Navigate through the folders to the content you want to add. You can
only add content in the selected language.

Creating a Language-Specific Collection if
Another Edition Does Not Exist

1. Navigate to the folder in which you will create the collection.

2. Click View > Collection. The View Collections screen is displayed.

3. Click the Add button ( ) and enter basic information about the
collection. (This screen is described inWorking with Collections in a
Multi-Language System on previous page.)

4. The View Collections in Folder screen appears. Click the collection
you just created.

Creating a Language-Specific Collection if Another
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5. From the Add drop-down list, select the language of the new
collection.

6. Using the Add button ( ), select the content to add to the collection.
Navigate through the folders to the content you want to add. You can
only add content in the selected language.

Collection Permissions
Any of the following users have permission to create or edit a collection.

n a member of the Administrators group

n a user who has been assigned the Collection and Menu Admin role.
See Also: Defining Roles on page 15-31

n a user who has been granted collection permission for the collection’s
folder. Permission is granted on the folder Permission screen (see
graphic below). See Also: Folder Permissions on page 4-40

How a Folder is Assigned to a Collection
If you create a collection by going to the Workarea’s Content > Collections
Tab, it is assigned to the root folder.

If you create a collection by going to a folder then selecting New >
Collection, it is assigned to that folder.
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A collection’s folder appears on the Content > Collections > Collection
Report screen, in the Path column. No value there indicates root folder.

Setting up Approval for Collections
If desired, you can set up an approval system for any collection. As with a
content approval chain, you specify users who must approve changes to a
collection before it can be published.

Any collection approver can either approve or decline the modified collection.
And, if a user who is not an approver tries to delete a collection, that action also
requires approval.

This section also contains the following topics.

Differences Between Content and Collection Approval Systems
9-
120

Creating a Collection that Requires Approval 9-120
Which Users Can Approve Collections 9-120
What Happens When an non-Approver Submits Changes to a Col-
lection

9-
121
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How Approvals Affect Deleting a Collection 9-121

Differences Between Content and Collection
Approval Systems

n While content can have a chain of approvers, a collection has a list of
approvers. Any collection approver can publish or decline changes.
There is no concept of a “chain” of approvers.

n While content approval is folder-specific, collection approval is not.
Once set up, collection approval affects the collection to which it was
assigned, regardless of its folder.

Creating a Collection that Requires Approval
Only administrators or users to whom the folder-admin role has been assigned
see the Approval is Required checkbox on the Add and Edit Collection
screens. See Also: Defining Roles on page 15-31

When the collection is created, its status is set to checked out. This allows you
to add items to it. When ready, you can publish it.

Which Users Can Approve Collections
If you require a collection to be approved, only the following users have
permission to create or edit a collection and can approve a change to a
collection.

n a member of the Administrators group
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n users to whom the Collection Approver role has been assigned and
who have permission to work with the collection

n users to whom the Folder User Admin role has been assigned and
who have permission to work with the collection

See Also: Defining Roles on page 15-31

What Happens When an non-Approver
Submits Changes to a Collection
A user who has permission to edit collections but not approve changes sees the
following buttons.

After making the change, the user clicks the submit button ( ). This action
triggers an email notification to all approval users for the collection. It also
changes the collection’s status to checked out. No other users can edit it in this
status.

Next, one of the approval users must open the Edit Collection screen and click
the Publish or Decline button. If he clicks Publish ( ), the new version of the
collection is published to your Web site. If Decline ( ), the user who submitted
the changes is notified by email but no changes are made to your Web site.

If the user who made the changes realizes he made a mistake, he can go to the
screen and click the Undo Checkout button at any time before the approval. In
this case, his submitted changes are deleted, and the collection reverts to its
original state.

In fact, any user with permission to edit a collection can perform the undo
function until the content is approved.

How Approvals Affect Deleting a Collection
To delete a collection, a user who has permission to work with collections but
not approve changes clicks the Delete button ( ) from the View Collection
screen. This action changes the collection’s status to Marked for Deletion (M)
and triggers an email notification to all approval users for the collection. One of
the approval users must open the Edit Collection screen and click the Delete or
Decline button.

What HappensWhen an non-Approver Submits
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If the approval user clicks Delete ( ), the collection is removed from your Web
site. If the approval user clicks Decline ( ), the user who submitted the
deletion is notified by email but no changes are made to your Web site.

Collection Server Control
The Collection server control displays a collection, that is a list of content links
that is created in the Ektron CMS400.NET Workarea. The control lets you
customize the display of the collection on a Web page.

When added to a template and visited, collections can look like this. (The
following illustration shows three collections on the same page of a sample
site.) You can modify the display by editing its server control properties.

This section also contains the following topics.

Collection Server Control Properties 9-122
Example of ecmNavigation Display 9-127
ecmNavigation XSL code 9-128
Example of ecmTeaser Display 9-128
ecmTeaser XSL code 9-129
Retrieving the XML Structure of a Collection 9-130

Using the Collection Server Control Programmatically Example
9-
130

Collection Server Control Properties
The Collection server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Helping Users Navigate Your Web Site

9-122 ReferenceManual
Version 8.01 Rev 4



**Property Description Data Type

AddText

Override the control’s default text for the Add Content menu item. For example,
If you have a NewsWeb site, you could change Add Content toAdd News
Item.

String

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to browse to

Content, Collections, etc. See Also: Using CMSExplorer to Browse Your
Ektron CMS400.NET Site on page 24-8

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0
(zero). This is the amount of time, in seconds, a control’s data is cached.

For example, to cache data for fiveminutes, set theCacheInterval

property to 300.See Also: Caching with Server Controlson page 24-33

Warning! If theEnablePaging property is set to True, the
CacheInterval property is disabled.

Double

ContentParameter Checks theQueryString for this value and replaces the collection with a content
blockwhen specified. Leave blank to alwaysdisplay the Collection. String

DefaultCollectionID

The ID of a collection that appearswhere you insert this server control if no
other collection is identified, or is not available.

If you don’t know the ID number of the collection, use the CMSExplorer to

browse to it. See Also: Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long
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**Property Description Data Type

DisplayXslt

Determineshow the information on the page is displayed.

None-databind only

ecmNavigation - lists the title of every content block in the collection

See Also:Example of ecmNavigation Displayon page 9-127

ecmTeaser - lists the title of every content block in the collection plus the
content summary

See Also:Example of ecmTeaser Displayon page 9-128

Path to Custom Xslt - Enter the path to an Xslt that determines the display of
the page.

Warning! If you specify a customXSLT, it is strongly recommended that you
do not store this file in theWorkarea folder. If you store this file in theWorkarea
folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at theMarkupLanguage property,
theDisplayxslt property value is ignored.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you want to
postpone the fill-action until later. In this case, FIll is automatically called during
the Page Render event.

Youmight do this if you need to set or change a property on the control in
codebehind and have it render with your changes shown.

Boolean

DynamicParameter Tomake this collection dynamic, select coll_id. When you do, this server
control uses the collection passed asa URL parameter. String

EnablePaging

This property, in conjunction with theMaxResults property, lets site visitors
view an unlimited number of collection itemswhile controlling the amount of
screen space. To accomplish this, the collection display is limited to the number
set in theMaxResults property.

If you set this property to true, and the number of collection itemsexceeds the
MaxResults number, navigation aidsappear below the last item. The site
visitor uses the aids to view additional items. See example below.

So, for example, if a collection has9 itemsand theMaxResults property is
set to 4, the screen displaysonly the first four items.When the site visitor clicks
[Next], he sees items5, 6, 7 and 8, etc.

Warning! If theEnablePaging property is set to True, the
CacheInterval property is disabled.

Boolean
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**Property Description Data Type

GetAnalyticsData

Set this property to True if you want the following information for each content
in the list.

ReturnsContent View Count,Content Rating,Content Rating
Average.

Create your own XSLT styles to display this data.

Warning! This property only provides reliable data when the Business
AnalyticsFeature is on.Enabling the BusinessAnalyticsFeature on page 7-
748.

Boolean

GetHtml
Set to True if you want to retrieve and display content (html body) for all content
blocks in the collection. For example, to display content inside a web server
control such asaGridView.

Boolean

Hide

Used to hide output of collection in design time and run time.

True =Hide collection

False =Display collection

Boolean

IncludeIcons

Choose whether to display iconsnext to the collection list’s links.

Warning! This property onlyworkswhen ecmSummaryor ecmTeaser are
used in theDisplayXslt property.When the [$ImageIcon] variable
is used in an EkML file and that file is assigned to theMarkupLanguage
property, this property acts asTrue.

Boolean

Language Set a language for viewing the collection. This property shows results in design-
time (in VisualStudio) and at run-time (in a browser). Integer

Collection Server Control Properties
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**Property Description Data Type

LinkTarget

Defines the waya link actswhen a link is clicked.

Choicesare:

_blank - Target causes the link to alwaysbe loaded in a new blankwindow.
Thiswindow is not named.

_self - Target causes the link to always load in the samewindow the anchor
was clicked in. This is useful for overriding a globally assigned BASE target.

_parent - Target makes the link load in the immediate frameset parent of the
document. This defaults to acting like “_self” if the document hasno parent.

_top - Target makes the link load in the full bodyof the window. This defaults to
acting like “_self” if the document is alreadyat the top. It is useful for breaking
out of an arbitrarily deep frame nesting.

ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the display of the collection. For
example, mycollectionmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing the
server control, just enter its name. If the file is in another folder, enter the path
relative to site root. For example,
..
\workarea\customfiles\markup\mycollectionmarkup.ekml

See Also:Controlling Output with EktronMarkup Language on page 26-1 and
collection.ekmlon page 26-32

Note: If you enter a valid EkML file, theDisplayxsltproperty value is
ignored. If the EkML file contains the[$ImageIcon] variable, the
IncludeIcons property acts asTrue.

String

MaxResults

Enter themaximum number of items to appear in the initial display of this server
control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount of space
being occupied, enter themaximum number of results per page here. Then,
set theEnablePaging property to true.

If you do andmore than the number ofMaxResults are available, navigation
aidsappear below the last item to help the site visitor view additional items. See
example below. Integer
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**Property Description Data Type

MemberMenuActive

Set this property to True to hide the drop downmenu next to a content item
when amembership user is logged-in.

True - Hide the drop down next to a content item frommembership users.

False - Membership users can have access to the drop downmenu next to
content item.

Note: This only affectsmembership users. Ektron CMS400.NET user will
always see the drop downmenuwhen theyare logged-in.

Boolean

Random

Set to True if you want to randomlydisplay one collection item. The item
changeseach time a site visitor views the page.

Note: If you use a customXSLT or EkML file, the type of content displayed
can bemanipulated. For example, if you use an EkML file that has the
[$Html] variable in it, the actual content is displayed instead of a link. See
Also:Controlling Output with EktronMarkup Language on page 26-1 and
[$Html] on page 26-17.

Boolean

SelTaxonomyID
Set the ID of the taxonomy that content will be associated with when a logged-in
site visitor uses the Silver AccessPoint’sAdd HTML Content to add content
to a Collection server control.

Integer

SuppressWrapperTags
This property is set tofalse because Ajaxuses<div> tags to rewrite the
region around the tag. You cannot change the value totrue.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - Use to designate an inline portion of an HTML document asa span
element.

Div - Use to apply attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

Example of ecmNavigation Display
The following is an example of a collection being used as a navigation menu.

Example of ecmNavigation Display
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ecmNavigation XSL code
Below is the XSL code that is used to create ecmNavigation Display. You can use
this code as the basis to design your own XSLT.

Warning! If you create a custom file, it is strongly recommended that you do not store this file in
the Workarea folder. If you store this file in the Workarea folder, the file will be lost when you
upgrade.
<?xml version="1.0" encoding="ISO-8859-1"?>

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">

<xsl:template match="/">

 <table border="0" cellspacing="0" cellpadding="0" width="100%">

 <xsl:for-each select="Collection/Content">

 <tr>

 <td>

 <a>

 <xsl:attribute name="href">

 <xsl:value-of select="QuickLink"/>

 </xsl:attribute>

 <xsl:value-of select="Title"/>

 </a>

 </td>

 </tr>

 </xsl:for-each>

 </table>

</xsl:template>

</xsl:stylesheet>

Example of ecmTeaser Display
The following is an example of a collection using the ecmTeaser display style.
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ecmTeaser XSL code
Below is the XSL code that is used to create ecmTeaser Display. You can use
this code as the basis to design your own XSLT.

Warning! If you create a custom file, it is strongly recommended that you do not store this file in
the Workarea folder. If you store this file in the Workarea folder, the file will be lost when you
upgrade.
<?xml version="1.0" encoding="ISO-8859-1"?>

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">

<xsl:template match="/">

 <table border="0" cellspacing="0" cellpadding="0" width="100%">

 <xsl:for-each select="Collection/Content">

 <tr>

 <td>

 <a>

 <xsl:attribute name="href">

 <xsl:value-of select="QuickLink"/>

 </xsl:attribute>

 <xsl:value-of select="Title"/>

 </a>&#160;

 </td>

 </tr>

 <tr>

<td>

 <xsl:value-of select="Teaser" />

 </td>

 </tr>

 <tr>

 <td>&#160;</td>

 </tr>

 </xsl:for-each>

 </table>

</xsl:template></xsl:stylesheet>

ecmTeaser XSL code
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Retrieving the XML Structure of a Collection
Retrieving the XML structure of XML content allows for greater control over
developing XSLs. The following is an example of how to retrieve the XML
structure.

1. Open a new Web form.

2. Drag and drop a Collection server control onto it.

3. Set the DefaultCollectionID property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.

Textbox1.Text = Collection1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

9. The XML structure of the collection appears in the textbox.

For an additional example, see the Collection XML page on the
CMS400Developer samples page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/Collection/CollectionXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/Collection/CollectionXML.aspx and
CollectionXML.aspx.vb

Using the Collection Server Control
Programmatically Example
The following is an example of using code behind, and a drag and drop
Collection server control to display random content from a collection.

1. Drag and Drop a Collection server control on your Web form.

2. Set the properties in the properties window.

Note: In this example, the Random and GetHtml properties must be set to True.
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3. Add the following code to the code behind.
Dim str As String

str = "<h1>Hello There</h1><br>"

str &= Collection1.EkItems(0).Html

Collection1.Text = str

4. Build and browse your web form.

Using the Collection Server Control
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Working with Menus
Ektron CMS400.NET’s Menu feature lets users create and maintain a dropdown
menu system for your Web site. The menu options can link to content, library
assets, external hyperlinks, and submenus. Below is a sample menu.

In this example (delivered with Ektron CMS400.NET), the menu appears when a
site visitor moves the cursor over About Us on the home page.

However, if a content contributor with permission to edit menus signs in to
Ektron CMS400.NET then views the menu, it has additional options for editing
the menu or adding content.

Warning! If you choose to hide the border that surrounds content when you are logged in, the
Add and Edit options are also hidden. This allows you to view the page as it appears when not
logged in. If the page is set to show borders and you still do not see Add and Edit, the feature
may be turned off. Ask your administrator or Web site Developer for more information.

Managing menus is a two-step process. The first sections in this chapter
describe the first step: how Ektron CMS400.NET users create and update
menus. In the second step, a developer placing a menu server control on a Web
form. The control manages how the menu displays on your Web site.
This section also contains the following topics.

The Structure of Menus and Menu Items 9-134
Access to the Menus Feature 9-134
Permission to Use the Menus Feature 9-135
Managing Menus 9-137
Working with Menus in a Multi-Language System 9-158
Assigning Folders or Templates to a Menu 9-160

Working with Menus
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Introduction to Menu Server Controls 9-164
Prerequisites 9-164
Contrasting Menu Server Controls 9-164
Flexible Menu Server Control 9-166
Smart Menu Server Control 9-182
Menu Server Control 9-188
DhtmlMenu Server Control 9-194

The Structure of Menus and Menu Items
Menus have the following structure:

n menu - top level structure that is a placeholder for menu items and
submenus. It is assigned to a content folder.

A menu identifies a page template used to display menu options that
are content.

n menu item - the individual options on a menu; can be any of the
following

- content of any type

- library asset

- external hyperlink (link to a page outside your Web site)

- submenu (a link to another menu. In the illustration below, the menu
on the right is a submenu. It appears when the user hovers the cursor
over Company Profile. The right arrow indicates a submenu is
available.)

Access to the Menus Feature
There are three ways to access the Menus feature:

n the Workarea, by choosing the associated content folder then clicking
View > Menu

n the Workarea, by choosing Content > Menus
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n from the Web site's the Edit Menu option , as shown below

If you choose the first or second option, you select a specific menu. Then, it
appears on the View Menu screen. For the third option, the selected menu
appears on the View Menu screen.

From the View Menu screen, you can perform the following actions on a menu.

n Create a new menu

n Edit its information (for example, the URL and template link)

n Translate it

n Delete it

n Add or remove items

n Change the sequence of menu items

n Edit menu items

n For submenus

- add /remove items

- change sequence of menu items

- edit menu information

- edit menu items

Permission to Use the Menus Feature
There are two ways to create a menu. Each has its own permission model.

Permission to Use theMenus Feature
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Menu Creation
Method

Illustration How to set permissions

Via theWorkarea’s
Content>Menus tab

The user must be one of the following.

n amember of the Administrators user
group

n assigned the Collection andMenu Admin
role. See Also:Defining Roleson page 15-31

n granted permissions to Collections for the
root folder. This is an advanced permission.
See Also:Setting Permissions through the
PermissionsTable on page 4-41

Via the View
Contents of Folder
screen’sNew >
Menu option

SeePermissions for MenusCreated from the
View Contents of Folder Screen below

Permissions for Menus Created from the
View Contents of Folder Screen
Only users with permission to use the Collections feature (illustrated below) for
a folder can work with menus. If user does not have permission to Collections,
the Menu option does not appear on the New menu.
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Also, if a user has permission to Collections but Read Only permission for
content and the library, he cannot add content from a navigation link.

Managing Menus
Ektron CMS400.NET gives you the flexibility to add, edit, view and delete a
menu.

This section also contains the following topics.

Adding a New Menu 9-138
Adding a Menu via Content Folder 9-138
Fields on the Add/Edit Menu Screen 9-140
Adding a Menu via the Menus Tab 9-142
Adding a Menu Item 9-143
Adding a Menu Item via Content Folder 9-143
Fields on the Add/Edit Menu Item Screen 9-144
Adding a Menu Item via Menus Tab 9-145
Adding a Menu Item via Navigation Link on a Web Page 9-146
Adding Content as a Menu Item 9-147
Adding a Library Asset as a Menu Item 9-148
Adding an External Hyperlink as a Menu Item 9-149
Adding a Submenu as a Menu Item 9-149
Adding New Content to a Menu via Navigation Link on a Web
Page

9-
150

Editing a Menu's Properties 9-151
Editing a Menu's Properties via its Content Folder 9-151
Editing a Menu's Properties via Menus Tab 9-151
Editing a Menu's Properties via Navigation Link on a Web Page 9-152
Viewing a Menu 9-153
View a Menu via its Content Folder 9-153
Viewing a Menu via the Menus Tab 9-154
View Menus via Navigation Link on a Web Page 9-155
Reordering Menu Items 9-155
Deleting a Menu 9-156

ManagingMenus
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Deleting a Menu via Content Folder 9-156
Deleting a Menu via Menus Tab 9-156
Deleting a Menu Item 9-157
Removing a Menu Item via its Content Folder 9-157
Removing a Menu Item via Menus Tab 9-157

Adding a New Menu
You can create a menu by navigating to a folder or by choosing Content >
Menus from the left frame of the Workarea. If you choose Content > Menus,
it is automatically assigned to the root folder. In contrast, if you create a menu
after choosing a content folder, it is assigned to the selected folder.

Adding a Menu via Content Folder
1. Navigate to a content folder.

2. The current language appears as a flag next to the screen title. To
create the menu in this language, proceed to the next step.

To change the new menu's language, click View > Language and
select the new language.

3. Click New > Menu.

4. The Add Menu screen appears.
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5. Use the following table to complete the screen.

Adding aMenu via Content Folder
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Fields on the Add/Edit Menu Screen

Field Description

Title The name given to themenu by its creator. It appears on theWeb page to indicate the kind of
information on themenu.

Image Link

You can have an image appear next to or instead of themenu title. For example:

To do this, follow these steps.

Note: Before beginning these steps, the imagemust reside in the library. if it doesnot, add
it before proceeding. For more information, seeCopying Files to the Libraryon page 8-10.

1. Click the image icon ( ).

2. The librarywindow opens.

3. Navigate to the folder that contains the image you want to use.

4. Click the Insert button ( ) to insert it.

Using Image to Replace Title Text
Alternatively, you can replace themenu text with the image, so that only the image appears on
themenu. To do this, check theUse image instead of a title box.
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Field Description

URL Link

After you create amenu, your developer links it to text or an image on aWeb page by
modifying a page template.When a site visitor reading thatWeb pagemoves the cursor over
the text or image, themenu appears. In the illustration below, themenu appearswhen the site
visitor moves the cursor over Products.

You can also assign a URL link to amenu using this field. If you do, and the user clicks the link
text or image, he jumps to the specified page.

For example, in this field you assign the product landing page, siteroot/products.aspx. In
the illustration above, if the usermoves the cursor over Products, the assignedmenu
appears. However, if the user clicksProducts (as indicated by the hand), he jumps to
siteroot/products.aspx.

Entering the Path to the Landing Page

This path is relative to the site root. For example: siteroot/jobs.aspx

ThisURL path can be a static template path (like the onementioned above) or a dynamic
path, such as

wellness.aspx?id=40&wellness=Hemophilia

Fields on the Add/Edit Menu Screen
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Field Description

Template
Link

Note: This field applies to content only. It hasno effect on other typesof menu items (such
as images). Also, this field only affects content that dynamically referencesa content block,
such as/CMS400Min/therapies.aspx?id=84. If themenu option is a template that
includes content (for example, /CMS400Min/news.aspx), the template you identify here is
ignored.

If you want to apply a template to thismenu, enter the template here. If you do, all content on
thismenu uses this template when selected from themenu.

If you do not enter a template here, content on thismenu uses the template specified in its
Quicklink.

Overriding the Template Link

You can override themenu template for any content item on thismenu and, instead, use the
template specified in itsQuicklink. To do so, follow these steps.

1. Add all items to themenu. (SeeAdding aMenu Item on the facing page)

2. Go to the ViewMenusoption.

3. ClickMore Info.

4. Click themenu item you want to change.

5. At the Link field, change the value fromMenu Template toQuicklink.

Warning! If you createdmenusprior to upgrading to this version of Ektron CMS400.NET,
thosemenu itemsare assigned asQuicklinks. You cannot change them to template links
simply byentering a template link here. Instead, youmust go to eachmenu item and change
the Link field value from QuickLink to Menu Template (as illustrated above).

Description Add amore detailed description for themenu.

Folder
Associations SeeEffect of Assigning a Folder to aMenu on page 9-161.

Template
Associations SeeEffect of Assigning a Template to aMenu on page 9-163.

6. Click the Save button ( ).
With the menu added, you may assign menu items to it. See Adding a Menu
Item on the facing page.

Adding a Menu via the Menus Tab
1. From the left frame of the Workarea, click Content > Menus >

 Menus.

2. Click the Add Menu button ( ).
3. Alternatively, hover the cursor over Menus in the left panel, right

click the mouse, and click Add Menu.
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4. The Add Menu screen appears.

5. To complete the fields on the Add Menu screen, see Fields on the
Add/Edit Menu Screen on page 9-140.

With the menu added, you may assign menu items to it. See Adding a Menu
Item below.

Adding a Menu Item
Similar to being able to add, edit, view or delete a menu, Ektron CMS400.NET
also allows you to add, edit, view and delete menu items.

Adding a Menu Item via Content Folder
To add a menu item via a content folder, follow these steps.

1. Navigate to the content folder that contains the menu to which you
want to add items.

2. Click View > Menu.

3. In the View Language dropdown list, select the language of the menu.

4. Click the menu.

5. The View Menu screen opens, displaying the items already on the

menu. Submenus look like a folder with a plus sign to the left (
).

6. To add a new item to the menu , click the Add Items button ( ).
7. The Add New Item screen appears. Use the table below to select a

type of menu item and follow the steps to add it.

Assign this type of content to the
menu

For details, see

Content Adding Content asaMenu Item on page 9-
147

Any library asset: images, files, Quicklinks,
hyperlinks to themenu

Adding a LibraryAsset asaMenu Item on
page 9-148

External hyperlink Adding an ExternalHyperlink asaMenu
Item on page 9-149

Submenu to themainmenu Adding a Submenu asaMenu Item on page
9-149

Adding aMenu Item

ReferenceManual
Version 8.01 Rev 4

9-143



8. After you insert menu items, you can view and modify information
about them. To do that, click the item's title. When you do, the Edit
Menu Item screen appears.See Also: Managing Menus on page 9-137

Fields on the Add/Edit Menu Item Screen
Use the following table to complete the fields on the Edit Menu Item screen

Field Description

Title The name of themenu item. It appears on theWeb page to indicate the item.
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Field Description

Image Link

You can have an image appear next to or instead of themenu title. For example:

To do this, follow these steps.

Note: Before beginning these steps, the imagemust reside in the library. if it doesnot,
add it before proceeding. For more information, seeCopying Files to the Libraryon
page 8-10.

1. Click the image icon ( ).

2. The librarywindow opens.

3. Navigate to the folder that contains the image you want to use.

4. Click the Insert button ( ) to insert it.

Using Image to Replace Title Text
Alternatively, you can have the image replace themenu text, so that only the image appears
on themenu. To do this, check theUse image instead of a title checkbox.

Description Add amore detailed description for themenu.

Target

This field determines the type of window in which thismenu item appears.

n Popup - opens in new window

n Self -opens in samewindow.

n Parent - opens in the parent frame

n Top - opens in parent window

Adding a Menu Item via Menus Tab
To add a menu item via the Menus tab, follow these steps.

1. From the top tabs of the Workarea, click Content > Menus.

2. Click the menu to which want to add a menu item.

3. In the View Language dropdown list, select the language of the menu.

4. Click the Add button ( ).
Alternatively, hover the cursor over the menu in the left panel, right click the
mouse, and click Add Items.

Adding aMenu Item viaMenus Tab
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5. The Add New Item screen displays a list of items that you can add to
the menu. Use to the table below to select the type of menu item and
follow the steps to add it.

Menu item type For more information, see

Content Adding Content asaMenu Item on the facing page

Any library assets: images, files, Quicklinks,
hyperlinks to themenu Adding a LibraryAsset asaMenu Item on page 9-148

External hyperlinks Adding an ExternalHyperlink asaMenu Item on page
9-149

Submenu to themainmenu Adding a Submenu asaMenu Item on page 9-149

6. After you insert menu items, you can view and modify information
about them. To do that, click the item's title. When you do, the Edit
Menu Item screen appears. See Also: Managing Menus on page 9-137

Adding a Menu Item via Navigation Link on a Web
Page

1. Log in.

2. Access the Web page that contains the link to display the menu.

3. Place the cursor on the hyperlink that causes the menu to appear.

4. The menu appears.

5. Click Add.

6. The Add Menu screen displays a list of items you can add to the menu.

7. Use the table below to select the type of menu item and follow the
steps to add it.
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Assign this type of content to the
menu

For details, see

Content Adding Content asaMenu Item below

Any library assets: images, files, Quicklinks,
hyperlinks to themenu

Adding a LibraryAsset asaMenu Item on
next page

External hyperlinks Adding an ExternalHyperlink asaMenu
Item on page 9-149

Submenu to themainmenu Adding a Submenu asaMenu Item on page
9-149

8. After you insert menu items, you can view and modify information
about them. To do that, click the item's title. When you do, the Edit
Menu Item screen appears. See Also: Managing Menus on page 9-
137

Adding Content as a Menu Item
To add content as a menu item, follow these steps.

1. Follow the directions in Adding a Menu Item via Content Folder on
page 9-143, Adding a Menu Item via Menus Tab on page 9-145, or
Adding a Menu Item via Navigation Link on a Web Page on previous
page.

2. Click the radio button next to Content Item.

3. Click the Next... button.

4. The Add New item screen appears, listing all content folders.

5. By default, all content types are available. To limit your selection (for
example, Word documents), click the content types dropdown and
select a type.

6. Content items in the selected folder appear below any subfolders.
You can click any subfolder to display its content.

7. Check all content you want to add from any single screen to the
menu.

Warning! If you check items on a screen then proceed to another screen before clicking the Add
button, the items on the first screen are not added to the menu.

Adding Content as aMenu Item
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8. Click the Add button ( ).
As an alternative, navigate to a content folder, click items to be assigned, right
click the mouse and select Copy. Then, locate the menu, right click the mouse,
and select Paste Items to Menu.

9. The View Menu screen reappears, showing the new content.

10. To access the Edit Menu Item screen for the new content, hover the
cursor over the title, then click.

11. The Edit Menu Item screen lets you assign additional information to
the menu item, such as the target window. See Fields on the Add/Edit
Menu Screen on page 9-140.

12. Continue to add menu items as needed.

Adding a Library Asset as a Menu Item
To add a library asset as a menu item via a content folder or menus tab, follow
these steps.

1. Follow the directions in Adding a Menu Item via Content Folder on
page 9-143, Adding a Menu Item via Menus Tab on page 9-145, or
Adding a Menu Item via Navigation Link on a Web Page on page 9-
146.

2. Click the radio button next to Library Asset.

3. Click the Next button.
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4. The Add New Item screen appears. Enter a title for the library asset
that will be on the menu.

5. Click Browse Library.

6. The library screen opens.

7. In the right frame, select the type of asset to insert (image,
hyperlink, etc.).

Note: To insert assets, the menu’s folder must contain library assets. However, you can insert
library assets from other folders for which you have permission.

8. Select a library asset and click the Insert button ( ).
9. The Add New Item screen reappears.

10. Click the Save button ( ).

Adding an External Hyperlink as a Menu Item
To add an external hyperlink as a menu item via a content folder or the Menus
tab, follow these steps.

1. Follow the directions in Adding a Menu Item via Content Folder on
page 9-143, Adding a Menu Item via Menus Tab on page 9-145, or
Adding a Menu Item via Navigation Link on a Web Page on page 9-
146.

2. Click the circle next to External Hyperlink.

3. Click the Next button.

4. The Add New Item screen is displayed.

5. Complete the fields as needed.

Field Description

Title Title of the new external hyperlinkmenu item.

URL Link The URL of the external hyperlink. For example,
www.example.com.

6. Click the Save button ( ).

Note:When adding an External Hyperlink menu item, the URL does not get added to the
library nor is an ID assigned to it. So, when you save the menu item, it is not added to the CMS
database nor can it be retrieved for future use.

Adding a Submenu as a Menu Item
To add a submenu as a menu item via content folder or menus tab, follow these
steps.

1. Follow the directions in Adding a Menu Item via Content Folder on
page 9-143, Adding a Menu Item via Menus Tab on page 9-145, or

Adding an External Hyperlink as aMenu Item
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Adding a Menu Item via Navigation Link on a Web Page on page 9-
146.

2. Click the radio button next to Submenu.

3. The Add Menu screen is displayed.

4. Complete the fields using Fields on the Add/Edit Menu Screen on page
9-140 as a reference.

5. Click the Save button ( ).

Adding New Content to a Menu via Navigation
Link on a Web Page
Note: You can only use this feature after your Web developer has modified a page template to
display the menu. For more information, see Introduction to Menu Server Controls on page 9-
164.

To add new content to a menu via a navigation link on a Web page, follow these
steps.

1. Access the Web page that contains the link to display the menu.

2. Place the mouse on the hyperlink that causes the menu to appear.

3. The menu appears.

4. Click ( ) Add.
5. The Add Menu screen opens, displaying items you can add.

6. Refer to the table below for selecting a menu item and follow the
steps to add it.

Assign this type of content to the
menu

For details, see

Content Adding Content asaMenu Item on page 9-
147

Any library asset: images, files, Quicklinks,
hyperlinks to themenu

Adding a LibraryAsset asaMenu Item on
page 9-148
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Assign this type of content to the
menu

For details, see

External hyperlink Adding an ExternalHyperlink asaMenu
Item on page 9-149

Submenu to themainmenu Adding a Submenu asaMenu Item on page
9-149

Editing a Menu's Properties
You can edit a menu's properties via:

n its content folder

n menus tab

n navigation link on a Web page

This section describes each option.

Editing a Menu's Properties via its Content Folder
To edit a menu's properties from a content folder, follow these steps.

1. Access the Workarea and navigate to the content folder that contains
the menu.

2. Click View > Menu.

3. Click the menu you want to edit.

4. If appropriate, click the submenu that you want to edit.

5. Click the properties button ( ).

6. The View Menu screen is displayed.

7. Click the Edit button ( ).
8. Change the fields in Edit Menu screen by referencing Fields on the

Add/Edit Menu Screen on page 9-140.

9. Click the Save button ( ).

Editing a Menu's Properties via Menus Tab
To edit a menu via the Menus tab, follow these steps.

1. From the left frame of the Workarea, click Content > Menus.

2. Click the menu you want to edit.

3. Click the properties button ( ).

Alternatively, hover the cursor over the menu in the left panel, right click the
mouse, and click View Properties.
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4. The View Menu screen is displayed.

5. Click the Edit button ( ).
6. As necessary, update the fields in Edit Menu screen by referencing

Fields on the Add/Edit Menu Screen on page 9-140.

7. Click the Save button ( ).

Editing a Menu's Properties via Navigation Link on
a Web Page
To edit a menu via a navigation link on a Web page, follow these steps.

1. Navigate to the Web page that contains the link to display the menu.

2. Click the menu link.

3. The menu appears.

4. Click Edit Menu.

5. The View Menu screen for the menu appears.

6. Move the cursor over the menu that you want to edit.

7. Click Edit from the popup menu.

Note:When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected instead of
the item you want to work with.

8. The Edit Menu screen is displayed.

9. Update the fields by referencing Fields on the Add/Edit Menu Screen
on page 9-140.

10. Click the Save button ( ).
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Viewing a Menu
Just like editing a menu, you can view a menu via

n its content folder

n menus tab

n navigation link on a Web page

When viewing a menu via the content or menu folder, you get an internal view
of information entered by menu creator. When viewing via a navigation link on
a Web page, you get an external view of the menu, as seen by anyone
navigating Web site.

View a Menu via its Content Folder
To access a menu via its content folder, follow these steps.

1. From the Workarea, navigate to the content folder that contains the
menu.

2. Click View > Menu.

3. The View All Menus screen displays all menus in the folder.

4. Click the menu you want to view.

5. The menu’s options appear.

Viewing aMenu
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Viewing a Menu via the Menus Tab
To access the menu via the Content Tab, follow these steps.

1. From the Workarea, click Content > Menus.

2. The View All Menus screen appears.

3. Click the menu you want to view.

4. The menu’s options appear.
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View Menus via Navigation Link on a Web Page
To access the menu via a navigation link on a Web page, follow these steps.

1. Access the Web page on which your Web developer inserted the link
to display the menu.

2. Click the link that launches the menu on the Web page.

3. A menu is displayed.

See Also: Managing Menus on page 9-137

Reordering Menu Items
To rearrange items on a menu, follow these steps.

1. Navigate to the View Menu screen for the menu that you want to
rearrange. See Viewing a Menu on page 9-153.

2. From the menu's toolbar, click the Reorder button ( .)
Alternatively, hover the cursor over the menu in the left panel, right click the
mouse, and click Reorder Items.

3. The Reorder Items screen appears.
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4. Click the item you want to move.

5. Click the up arrow to move it up, or the down arrow to move it down.

6. When finished, click Save ( ).
See Also: Managing Menus on page 9-137

Deleting a Menu
Similar to editing and viewing a menu, you can delete a menu via

n its content folder

n menus tab

You cannot delete a menu from a navigation link on a Web page.

Deleting a Menu via Content Folder
To delete a menu via its content folder, follow these steps.

1. Access the View Menu screen, as described in View a Menu via its
Content Folder on page 9-153.

2. Click the menu you want to delete.

3. Click the delete button ( ).

4. A confirmation message is displayed.

5. Click OK to delete the menu.

Note: Deleting a menu automatically deletes all menu items associated with it. Do not confuse
the menu link with the item itself. For example, deleting a menu deletes its links to content but
has no effect on the content.

Deleting a Menu via Menus Tab
To delete a menu via its menus tab, follow these steps.

1. Access the View Menu screen, as described in Viewing a Menu via the
Menus Tab on page 9-154.

2. Click the menu you want to delete.

3. Click the delete button ( ).
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Alternatively, hover the cursor over the menu in the left panel, right click the
mouse, and click Delete menu name.

4. A confirmation message is displayed.

5. Click OK.

Note: Deleting a menu automatically deletes all menu items associated with it. Do not confuse
the menu link with the item itself. For example, deleting a menu deletes its links to content but
has no effect on the content.

Deleting a Menu Item
Similar to editing and viewing a menu, you can remove a menu item from a
menu via

n its content folder

n its menu folder

Removing a Menu Item via its Content Folder
1. Access the View Menu screen, as described in View a Menu via its

Content Folder on page 9-153.

2. Move the cursor over the triangle to the right of the item.

3. A menu appears.

4. Click Delete.

Removing a Menu Item via Menus Tab
1. Access the View Menu screen, as described in View a Menu via its

Content Folder on page 9-153.

2. Move the cursor over the triangle to the right of the item.

3. A menu appears.

4. Click Delete.

Deleting aMenu Item
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Working with Menus in a Multi-Language
System
Note: For background information about supporting multiple languages on your Web site, see
Working with Menus in a Multi-Language System on page 14-25.

You can create an edition of any menu in every supported language. When a site
visitor selects a language, navigates to a page that has a menu and clicks the
menu link, Ektron CMS400.NET displays the menu in the selected language if it
is available. If a menu in that language is not available, nothing appears.

Before creating or translating a menu, it’s a good idea to create or translate all
content that will be on the menu. In this way, you can link this content to the
new menu. However, after creating a menu, you can add new items to it.

See Also:Working with Menus on page 9-133

This section also contains the following topics.

Translating a Menu 9-158
By Navigating the Site 9-158
By Accessing the Menus Report Screen 9-159
Creating a Menu in Any Language 9-160

Translating a Menu
To translate a menu into any supported language, follow these steps. You can
navigate to the menu via the Web site or from the Workarea. Each procedure is
described below.

By Navigating the Site
1. Sign on to Ektron CMS400.NET

2. Select the menu’s current language.

3. Navigate to the page that has the menu you want to translate.

4. Click the menu and the Edit Menu option.

5. The View Menu screen appears for the selected menu.
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6. From the Add drop-down list, select the language into which you want
to translate the menu.

7. The Add Menu screen appears. Complete the screen for the menu in
the selected language. See Fields on the Add/Edit Menu Screen on
page 9-140.

8. Click the Save button ( ).
9. The View Menu screen reappears. Now, the View In drop-down list

displays the menu’s new language.

10. Add items to the menu. See Adding a Menu Item on page 9-143. If
adding content, you can only insert an item in the selected language.

11. Later, you can add more menu items, edit them, delete them, view
them, etc.

These capabilities are described in this chapter.

By Accessing the Menus Report Screen
1. From the Workarea screen, click Content > Menus.

2. Click the menu you want to translate.

3. The View Menu screen appears for the selected menu.

4. From the Add drop-down list, select the language into which you want
to translate the menu.

5. The Add Menu screen appears. Complete the screen for the menu in
the selected language. See Fields on the Add/Edit Menu Screen on
page 9-140.

6. Click the Save button ( ).

ByAccessing theMenusReport Screen
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7. The View Menu screen reappears. Now, the View In drop-down list
displays the menu’s new language.

8. Add items to the menu. See Adding a Menu Item on page 9-143. If
adding content, you can only insert an item in the selected language.

Later, you can add more menu items, edit them, delete them, view them, etc.

Creating a Menu in Any Language
To create a menu in any language, follow these steps.

1. Form the Workarea screen, click Content > Menus.

2. From the language drop-down list, select the new menu’s language.

3. Create the menu. See Adding a Menu via the Menus Tab on page 9-
142.

Assigning Folders or Templates to a
Menu
The Advanced Settings on the Edit Menu screen has Folder Associations and
Template Associations sections (see image below). Any folders or templates
currently assigned to the menu appear. You can use this section of the screen to
add new templates/folders or remove existing ones.
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This section also contains the following topics.

Effect of Assigning a Folder to a Menu 9-161
Using the Select Folder Screen 9-162
Effect of Assigning a Template to a Menu 9-163
Assigning a Template to a Menu 9-163

Effect of Assigning a Folder to a Menu
If

n you assign a folder to a menu

and

n a user navigates to any content item that resides in the folder

and

n a Flex Menu whose EnableSmartOpen property is true appears on
the screen

the Flex Menu automatically displays the items on the associated submenu.

Note: Navigation to the content item can consist of clicking a quicklink, a menu option, a list
summary item, the result of a search, etc.

In effect, you are instructing Ektron CMS400.NET to expose a menu whenever a
content item that resides in one or more selected folders appears on the
screen. As a result, a user looking for a specific item sees similar items on the
screen.

Effect of Assigning a Folder to aMenu
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As an example, assume your Web site sells books, and your folders are
organized by genre. One of your folders is “Teen Fiction.” You create a submenu
that contains the top five sellers in “Teen Fiction.” You then associate the Teen
Fiction folder with that submenu.

If a site visitor uses the site search to find any book in that category, and
proceeds to a page describing the book, the Flex Menu in the page’s left column
displays the five top Teen Fiction titles.

Using the Select Folder Screen
The Select Folder screen lets you assign new folders to the menu, reorder the
folders, and delete folders from the menu association. These tasks are
described below.

When you click Change below Folder Associations on the Edit menu screen,
the Select Folder screen appears (see image below).

The following table describes tasks you can perform on this screen.

Task Instructions

Add folder to list

1. In the top of the screen, navigate to the folder
you want to add.

2. Click the Add button ( ).

Remove folder from list
1. Click checkbox to the left of the folder.

2. Click the Delete button ( ).

Remove all folders from list

1. Click checkbox to the left of Folder.

2. Click the Delete button ( ).
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Task Instructions

Move a folder up or down on the list

Note: The sequence in which folders
appear hasno impact on how theyare used. It
merely affects the appearance of the folders on
the Select Folders screen.

1. Click checkbox to the left of the folder.

2. Click the up or down arrow buttons (

).

Save changesand return to Edit Menu screen Click the Save button ( ).

Exit screen; do not save changes Click the Exit button ( ).

Effect of Assigning a Template to a Menu
If

n you assign a template to a menu

and

n a user navigates to any content item that uses the template

and

n a Flex Menu whose EnableSmartOpen property is true appears on
the screen

the Flex Menu automatically displays the items on the associated submenu.

Note: Navigation to the content item can consist of clicking a quicklink, a menu option, a list
summary item, the result of a search, etc.

In effect, you are instructing Ektron CMS400.NET to expose a menu whenever a
content item that uses one or more selected templates appears on the screen.
As a result, a user who begins looking for a specific content item sees similar
items on the screen.

As an example, assume your Web site sells books, and your templates are
organized by genre. One of your templates is “Teen Fiction.” You create a
submenu that contains the top five sellers in “Teen Fiction.” You then associate
the Teen Fiction template with that submenu.

If a site visitor uses the Web site search to find any book in that category, and
proceeds to a page describing the book, the Flex Menu in the page’s left column
displays the five top Teen Fiction titles.

Assigning a Template to a Menu
To add a new template, follow these steps.

1. Move to the Template Associations area of the Edit menu screen.

Effect of Assigning a Template to aMenu
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2. In the box on the right, enter the template that you are assigning to
this menu. It can be a CMS template, or any file that you wish.

3. Click Add.

To later change or remove the template, select it then click Change or
Remove.

Introduction to Menu Server Controls
Managing menus is a two-step process. The previous section describes the first
step, which is how Ektron CMS400.NET users create and update menus. The
second step involves a developer placing a menu server control on a Web form.
The server control manages the display of the menu on your Web site.

Ektron CMS400.NET provides four menu server controls:

n Flexible Menu Server Control on page 9-166

n Smart Menu Server Control on page 9-182

n Menu Server Control on page 9-188

n DhtmlMenu Server Control on page 9-194

This section introduces concepts that affect all of them, and explains the
differences between them.

Prerequisites
Before you can use the server controls, you must create menus in the
Workarea. To learn about creating menus, see Working with Menus on page 9-
133.

Contrasting Menu Server Controls
n Appearance on the facing page

n Properties on page 9-166
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Appearance

Flexand
Smart Menu

or

(Other styles are available)

DHTMLMenu

(Styling is very customizable)

Menu

Appearance
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Properties

Property
Flex

Menus
Smart Menu

DHTML
Menu

Menu

508 compliant

Shutter menu

(When you click amenu, it
opensdirectly below themenu
title)

Secondarymenu openswhen
cursor hovers over it

(alternative:
secondarymenu
openswhen clicked)

(alternative:
secondarymenu
openswhen clicked)

Starts out collapsed; expandsas
site visitor selects secondary
menu (optional)

Allmenu levels open when page
displays (optional) (optional)

Can display secondarymenu to
the right of the root menu,
instead of directly below it (optional) (controlled by

style sheet)

How appearance ismodified
Server control
properties and style
sheet

Server control
properties and style
sheet

Server control
properties
and style
sheet

Xslt
and
style
sheet

How behavior ismodified Xslt

Xslt
and
style
sheet

Option to launchmenu links in a
new window

Flexible Menu Server Control
The FlexMenu server control displays a menu on a Web form. Although it looks
and acts like a Smart Menu, its architecture is substantially different.
Specifically, a FlexMenu creates XML. So, you can modify its behavior using an
XSLT file, and change its appearance using a cascading style sheet (.css) file.
This design is illustrated below.
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Note: Before you can use this server control, you must create one or more menus in the Ektron
CMS400.NETWorkarea. To learn about creating menus, seeWorking with Menus on page 9-
133.

This section also contains the following topics.

Sample Menus 9-167
Description of the Sample Menus 9-168
Copying and Editing Sample Menus 9-174
Working with the Flex Menu Xslt File 9-175
How the FlexMenu Server Control Determines Which Item is
Selected

9-
176

Flex Menu Server Control Properties 9-178

See Also: Contrasting Menu Server Controls on page 9-164

Sample Menus
To facilitate the deployment of Flex menus, Ektron CMS400.NET provides
several sample menus that show their capabilities. You can use whichever
sample meets your needs, then modify it for your site.

The sample menus can be viewed from the Developer Sample Page
(siteroot/Developer/default.aspx) > Menu - Flex.

SampleMenus
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Description of the Sample Menus
Note: The FlexMenu server control generates the same XML for all samples, and identical
copies of the Demo.xsl create identical markup for all samples. The different manifestations in
the samples are due to the CSS styling rules in the related files.
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Sample Menu Description Location on Server

AjaxDemo

The only samplemenu for which Ajax is enabled by
default. Ajax providesa quicker response time because the client
loadsmenu levels on an “asneeded” basis. This feature
eliminates the need to do a page refresh to get new content.

Youmaynot notice the speed on smallmenus, but with large
menus, the speed improvement is significant.

Note: The first time an Ajax-enabledmenu is invoked, it is
slow because the server is building it. After that, its response
time should be quicker than non-Ajaxmenus.

How the MenuWorks

n When you first click amenu, all text links are black.When you
click it a second time, theyare grayed out.

n Secondarymenusdo not change.

n There’s no way to close amenu after it opens.

Warning! This sample ismeant to visually display amenu being
populated via an Ajax call, as a user drills into it. This demo is not
meant to be part of a public site. Rather, it demonstrateshow a
FlexMenuwith Ajax improvesperformance.

Warning! When using Ajaxwith the FlexMenu (by setting
EnableAjax=”True”), it is important to set the MenuDepth
property to one (MenuDepth="1"). Otherwise, the FlexMenu
obtains the entire menu tree.
Setting the depth to one forces themenu to populate only the
first level, and causes themenu to drill only one level deep with
each click of a submenu node. It is set to this properly in the Ajax
demo.

siteroot/Developer/Menu
/FlexMenu/AjaxDemo
/FMAjaxDemo.aspx

Description of the SampleMenus
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Sample Menu Description Location on Server

Expanding

n Menu hasgradient background, which changeswhen you
hover over it.

n Menu options that display content have a plain background.
Submenus look likemainmenusbut are indented.

n When you first click amenu, it expands vertically.When you
click it a second time, it closes, so it looks like it did when you first
viewed it.

siteroot/Developer

/Menu
/FlexMenu/Expanding

/FMExpandDemo.aspx

Fly-Out

n Menushave gradient background. The color changeswhen
you hover over it.

n Menu options that display content have a plain background.
Their color changeswhen you hover over it. Submenus look like
mainmenusbut are offset to the right. (See illustration below.)

n When you first click amenu, it expandshorizontally to the
right.When you click it a second time, it closes, so it appears as it
did when you first viewed it. siteroot/Developer/Menu/

FlexMenu/FlyOut/
FMFlyOutDemo.aspx
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Sample Menu Description Location on Server

Horizontal

Site navigation often requires the placement of a horizontalmenu
in the upper part of the page. The Horizontal FlexMenu sample is
a workingmenuwith XSLT and CSS (aswell asFlexMenu
configuration settings) that providesa basis for this design.

The sample'sCSS file dramatically alters the appearance and
behavior of this FlexMenu. You will typically edit that file to
accommodate your site's design (colors, background images,
etc.).

siteroot/Developer/Menu/
FlexMenu/horizontal/
FMHorizDemo.aspx

Lightweight

Thismenu generatesmuch simpler markup (consisting of <UL>
and <LI>elements) and usesa few linesof jQuery for control,
instead of the normal, large JavaScript file ek_flexmenu.js.

The jQuery code is located on the sample page:
LightweightDemo.aspx. See this file also for an example of
disabling the automatic inclusion of themenu's JavaScript file by
setting the propertyIncludeJS="false".

siteroot/Developer/Menu/
FlexMenu/Lightweight/
LightweightDemo.aspx

Description of the SampleMenus
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Sample Menu Description Location on Server

List

n Thismenu’s appearance is similar to the AjaxDemo but it
doesn’t use Ajax.

n Themenu is an unordered list.

n When you first click amenu, all text links are black.When you
click it a second time, it closes, so it appears as it did when you first
viewed it.

siteroot/Developer/Menu
/FlexMenu
/List/FMListDemo.aspx

XMLModify

Thismenu demonstrateshow to significantlymodify amenu's
behavior byadding custom code in the code behind file. In
particular, it demonstratesuse of the control's

n PreProcessXmlevent to modify the XML before the XSLT is
run

n PostProcessXmlevent to modify themarkup after the XSLT is
run

siteroot/Developer/Menu
/FlexMenu
/XMLModify/FMXMLModDemo.aspx

Helping Users Navigate Your Web Site

9-172 ReferenceManual
Version 8.01 Rev 4



Sample Menu Description Location on Server

508 compliance

This sample demonstratesa Section 508 compliant menu. The
markup provides site navigation clues to web-page readers,
including Braille-readers and text-to-speech.

Note:  To truly be 508-compliant, youmust also implement a
color scheme that provides the intended information to blind
or visually-impaired users. Because color selection is
determined by the site design, this task is left to the site
designer.

siteroot/Developer/Menu
/FlexMenu
/508Demo/FM508Demo.aspx

Description of the SampleMenus
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Copying and Editing Sample Menus

To create a menu based on a sample, follow these steps.

1. Examine the sample menus and decide which one best meets your
needs for a particular page. See Description of the Sample Menus on
page 9-168.

2. If you want to create a new template (.aspx page) for the menu,
place the new template in a new folder. Then, copy all files in the
sample menu folder to the new folder and rename each file. For
example, change Ajaxdemo.aspx to myflexmenu.aspx,
AjaxDemo.css to myflexmenu.css, and demo.xsl to myflexmenu.xsl.

To insert a FlexMenu server control onto an existing template, copy the
.css and .xsl file into the folder that contains the template.

Warning! If you specify an external file, do not store it in your site's Workarea folder to prevent it
from being overwritten when you upgrade.

Important: The renamed .css file name must be all lowercase.

3. Open the .aspx page. Update the stylesheet and DisplayXslt
properties to refer to the new .css and .xsl files.

If the files do not reside in the template’s folder, indicate their relative
path using the syntax where slash (/) indicates the site root.

4. Open the .css file. Update the parent class name to match the new file
name. For example, if you copied the AjaxDemo.css file, the top of it
looks like this.

.ajaxdemo .ekflexmenu

{

/* DIV; wraps the entire menu */

/* (the outer-most non-user container element) */
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color: rgb(0, 0, 255);

/*width: 148px;*/

font-size: 12px;

font-family: Sans-Serif;

}

.ajaxdemo .ekflexmenu_submenu,

.ajaxdemo .ekflexmenu_submenu_hover,

.ajaxdemo .ekflexmenu_submenu_parent,

.ajaxdemo .ekflexmenu_submenu_parent_hover

{

/* DIV; holds submenu items, such as a submenu title and links. */

top: 0px;

left: 0px;

}

.ajaxdemo UL

{

/* UL; a container for menu list items (useful for non-graphical browsers). */

/*list-style: none;

/*margin: 0px;

padding: 0px;*/

}

Notice that every class begins with the file name, .AjaxDemo. Replace all
occurrences of this with the new file name. To continue the above example,
begin all classes with .myflexmenu.

Working with the Flex Menu Xslt File
This section explains some non-intuitive elements of the *.xslt file.

Working with the FlexMenu Xslt File
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Element Context Description

MenuFragment

<xsl:when test="/MenuDataResult

/Info/

menuFragment='false'">

A flag that indicates the XML data is not
complete. Instead, it’s a fragment that
beginsdeeper than the top level (for
example, a submenu fragment).

Because the data is incomplete, the XSLT
processes the fragment differently. For
example, don’t generate JavaScript
startup code.

menuConst

<xsl:attribute

name="id"><xsl:value-of

select="$menuConst"/>0_

ekflexmenu</xsl:attribute>

Eachmenu generates several elements,
which the client code (JavaScript)
accesses via a unique ID. For example,
JavaScript needs to identify the selected
submenu or itemwhen a user clicks on an
element.

menuConst is only used iswhen creating
elementswithout a corresponding XML
block, such aswhen creating a structure to
hold themenu.

#NoScroll

<xsl:attribute

name="href">#

NoScroll</xsl:attribute>

NoScroll is sent to the hrefportion of a
linkwhen there is nothing to put there (for
example, when the link is supposed to run
JavaScript).

NoScrollprevents the page from
refreshing, going to another page, or
scrolling when it should not.

event

<xsl:attribute

name="onkeydown">return

ekFlexMenu.menuBtnKeyHdlr(

event);</xsl:attribute>

Tomake the xslt cross-browser
compatible, it must support different
methodsof obtaining/passing the event
object. In this example, the global event
object is passed to the handling function.

Note: eventcorresponds to
window.event. window. is implied.

How the FlexMenu Server Control
Determines Which Item is Selected
The FlexMenu server control has the ability to select (highlight) options in a Flex
menu as site visitors navigate around the Web site. For example, a site visitor
arrives at a Web page through a link in an email. If the QueryString matches
the an item in a Flex menu, the item is shown as selected.

Below is the logic the Flex menu uses to decide when a menu item should show
as selected. The list is presented in the order in which the code checks to see if
an item should be highlighted.
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If any menu item is selected, its parent menu is marked selected. If any menu
is selected, all ancestor menus are selected. When all tests have been
performed and no matches are found, the Flex menu is rendered with no items
selected.

Warning! As soon as one condition is satisfied, the item is shown as selected and the testing
stops.

Note: Steps 2 through 9 are each repeated recursively throughout the menu data hierarchy
until either a match is found or the end is reached. If there are no matches for a test, the control
continues with the next one.

1. Inspects the QueryString to see if the ekxmensel parameter is
present with a matching menu node ID. This parameter is used to
specify the exact node a user clicked. The node, its parent, and
ancestor menus are all marked as selected.

2. Inspects the QueryString to see if a Content ID parameter value
matches a menu item. If the Content ID in the QueryString matches a
menu item, it is highlighted. For example, the QueryString includes
ExamplePage.aspx?id=123, and a menu item links to Content ID
123.

3. Inspects the QueryString to see if a Form ID parameter value
matches a menu item. If the Form ID passed in the QueryString
matches a Flex menu item, it is highlighted. For example, the
QueryString includesExamplePage.aspx?ekfrm=456, and a menu
item links to Form ID of 456.

4. Inspects the QueryString for a direct match with a menu item link. If
there is a match, the menu item is selected. For example, if the
QueryString has ExamplePage.aspx and there is an item on the menu
that matches, the menu item is shown as selected.

5. Inspects the QueryString for a id, ekfrm or pageid parameter. If one
is found, the control looks for a folder association between submenus
and the folder that contains the object with the given ID. If the
association exists, the menu item is shown as selected.

6. Inspects the QueryString to see if there is a direct match with a menu
button link. If there is a match, the menu button is selected. For
example, the QueryString has ExamplePage.aspx and there is a
button on the menu that matches.

7. Inspects the QueryString to see if there’s a template association with
the filename. If there’s a match, the menu item is shown as selected.

8. Inspects the QueryString for the id or ekfrm parameter and whether
a value greater than zero is associated with it. If so, the control
checks menu buttons for use of LinkIt.aspx. If a button is using
LinkIt.aspx and either id or ekfrm parameter matches, the menu
button is selected.

9. Tests to see if there is a URL Aliasing issue. When the FlexMenu
server control’s UseAliasRealId property is set to True, the control
scans the data to see if there is a MenuData item ID match.
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Flex Menu Server Control Properties
The Flex Menu server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc.

See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Boolean

AutoCollapseBranches
If you set to true, whenever a new submenu opens, all other
submenusclose.

If false, other submenus remain open when a new one opens.
Boolean

CacheInterval

Sets the amount of time the server control’s data is cached. The
default is 0 (zero). This is the amount of time, in seconds, a control’s
data is cached. For example, if you want to cache the data for five

minutes, set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Double

DefaultMenuID

The ID of amenu that appearswhere you insert this server control
if no other menu is identified or available.

If you don’t know the ID number of themenu, use the CMS
Explorer to browse to it.

See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Note:  If you want to change the Default menu'sStartingmenu,
use the StartMenuID property.

Long
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Property Value
Data
Type

DisplayXslt

The xsl file used to render themenu. If nothing is specified, the
menu is output as raw XML.

Flexmenusare designed to use the xsl file to control themenu’s
behavior, and the .css file to control its display.

Ektron CMS400.NET provides several samplemenus, and each
hasan xslt file. If this is a newmenu, youmay find it easier to copy

and edit an xslt file provided with a samplemenu. See Also:
SampleMenuson page 9-167

Warning! : If you want to edit this file, it is strongly recommended
that youmake a copy, change its name andmove it outside of your
site'sWorkarea folder. If youmake changes to this file and do not
move it out of theWorkarea, this file and the changeswill be lost
when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes shown.

Boolean

EnableAjax Set to true to enable Ajax, which only downloads sub-menusas
needed. See Also:AjaxDemo on page 9-169 Boolean

EnableMouseOverPopup

If you set to true, submenusappear as soon as the cursor moves
over them.

If you set to false, submenusonly appear if a site visitor clicks them
or a keyboard equivalent.

Boolean

EnableSmartOpen

If you set to true, any submenu on the Smart Menu can be set to
open automatically. To learn about how to do this, seeAssigning
Folders or Templates to aMenu on page 9-160

If you set to false, even if all required conditionsare present,
submenuson a FlexMenu do not automatically open.

This property lets you prevent submenus from opening bydefault.
Under some circumstances, such submenus look cluttered.

Boolean

IncludeJS

Enter false if you want themenu to ignore the default JavaScript
that normally loadswhen themenu is loaded. Thiswould be useful
if you redefine themenu's output with an XSLT.

Enter true if you want themenu's JavaScript to load asnormal.

Boolean

MasterControlId

Only use this property if you are setting up amaster/slavemenu
relationship, and thismenu is the slave. If both are true, enter the
ID of themaster menu.

See Also: Flexible Menu Server Controlon page 9-166

String
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Property Value
Data
Type

MenuDepth

To let site visitors browse through allmenu levels, enter zero (0).

To restrict site visitors to amenu level, enter the number of the
lowest level.

In the following example, if you set this property to 1, a site visitor
can browse through theAbout Usmenu optionsbut would not
see the level 2 options (Company Profile andCareers).

Integer

StartCollapsed If you set to true, when themenu first appears, all submenusare
closed. Boolean

Helping Users Navigate Your Web Site

9-180 ReferenceManual
Version 8.01 Rev 4



Property Value
Data
Type

StartLevel

Enter a number to indicate the level at which you want thismenu to
displaywhen it first appears. To begin themenu displayat the root
level, enter zero (0).

In the following example, theHome folder is level 0. The others are
level 1.

A site visitor can click amenu option to navigate to folders below the
displayed level.

Note:  If you set a StartMenuID, the StartLevel property is
ignored.

Integer

StartMenuId

Use this property to have the default menu begin somewhere other
than its root.That is, at any submenu under the default menu.

For example, menu ID 46 (Products) is the default menu. However
when that menu displays, you onlywant to show its submenus,
beginning with ProductsSupport (ID 58). In this case, enter 46 into
the DefaultMenuID property and 58 into the StartMenuID
property.

Note:  If you set a StartMenuID, the StartLevel property is
ignored.

Integer

Stylesheet

Enter the style sheet that will determine the appearance of the
menus. Flexmenususe an .xsl file to control their behavior, and a
.css file to control their display.

Ektron CMS400.NET provides several samplemenus, and each
hasa .css file. If this is a newmenu, youmay find it easier to copy

and edit a .css file provided with a samplemenu. See Also: Sample
Menuson page 9-167

String
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Property Value
Data
Type

SuppressAddEdit

When set to True, suppress the Add and Edit buttonson themenu
when a user is logged in to Ektron CMS400.NET. The default is
False.

True - suppress the Add and Edit button when a user is logged in to
Ektron CMS400.NET.

False - show the Add and Edit buttonswhen a user is logged in to
Ektron CMS400.NET.

Boolean

SuppressWrapperTags
This property is set to false because Ajaxuses<div> tags to
rewrite the region around the tag. You cannot change the value to
true.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag. The default is
Span.

Span - Use the <span> tag to designate an inline portion of an
HTML document asa span element.

Div - Use the <div> tag used to apply attributes to a blockof code.

Custom - Use a custom tag.

String

Smart Menu Server Control
The Smart Menu server control displays a menu on a Web page.

Before you can use this server control, you must create a menu in the Ektron
CMS400.NET Workarea. To learn about creating menus, see Working with
Menus on page 9-133.

To learn about how the Smart Menus compare to other Ektron CMS400.NET
menus, see Contrasting Menu Server Controls on page 9-164.

This section also contains the following topics.

Smart Menu Server Control Properties 9-182
Section 508 Compliance Features of Smart Menus 9-186
Retrieving the XML Structure of a Smart Menu 9-187

Smart Menu Server Control Properties
The Smart Menu server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Value
Data
Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc.

See Also:Using CMSExplorer to Browse Your Ektron CMS400.NET
Site on page 24-8

String

AutoCollapseBranches
If you set to true, whenever a new submenu opens, all other
submenusclose.

If false, other submenus remain open when a new one opens.
Boolean

CacheInterval

Sets the amount of time the server control’s data is cached. For
example, if you want to cache the data for fiveminutes, set this
property to 300. The default is zero.

See Also:Caching with Server Controlson page 24-33

Double

DefaultMenuID

The ID of amenu that appearswhere you insert this server control if
no other menu is identified or available.

If you don’t know the ID number of themenu, use the CMSExplorer
to browse to it.

See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes shown.

Boolean

DynamicParameter Selectmenu_id. When you do, this server control uses themenu
passed asa URL parameter. String

Enable508compliance If you set to true, themenuwill complywith Section 508. Boolean

EnableMouseOverPopup

If you set to true, submenusappear as soon as the cursor moves
over them.

If you set to false, submenusonly appear if a site visitor clicks them or
a keyboard equivalent.

Boolean

EnableSmartOpen

If you set to true, any submenu on the Smart Menu can be set to open
automatically. To learn about how to do this, seeAssigning Folders or
Templates to aMenu on page 9-160.

If you set to false, even if all other conditionsare present, submenus
on a Smart Menu do not automatically open.

This property lets you design pageswhose submenusdo not normally
open bydefault. Under some circumstances, such submenus look
cluttered.

Boolean
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Property Value
Data
Type

Hide

Used to hide amenu in design time and run time.

True =Hidemenu

False =Showmenu

Boolean

Language

Set a language for viewingmenus. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser).

For more information, seeWorking with Menus in aMulti-Language
System on page 9-158.

Integer

LaunchLinksinNew
Window

If you set to true and a site visitor selects amenu option, it appears in
a new browser window.

If false, the new page replaces the current page in the browser.
Boolean

ShowRootFolder If you set to true, a menu option listing the title of the root folder
appears. If you set to false, the title of the root folder doesnot appear. Boolean
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Property Value
Data
Type

SingleEditButton

Set to true if you want to a single edit button (and no add button) to
appear on themenuwhen you are logged in.

If you set to false,Edit Menu and Add Menu optionsappear at the
bottom of everymenu and submenu.

Example of SingleEditButton = true

Example of SingleEditButton = false
Boolean

StartCollapsed If you set to true, all submenusare closed when themenu initially
displays. Boolean

StartWith RootCollapsed

If you set to true, themenu initially displayswith its root menu closed.

Note: This property is ignored if the ShowRootFolderproperty is
set to set to false.

Boolean
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Property Value
Data
Type

Stylesheet

Enter the style sheet that will determine the appearance of the
menus. Menu style sheets reside in the site
root/workarea/csslib/smartmenu folder. You canmodify any
standard style sheet or create your own.

Creating a Custom Style Sheet

To support more than one SmartMenu server control per page, the
CSS file's name is used asa classand is prefixed to all selectors
(without the path or extension).

The server controlwraps the entire SmartMenu in a <div> tag,
whose classname is derived from the filename.

Only the base ASCII character set is supported. Also, spacesand
periodsbefore the extension are converted to underscores, since
these are not permitted within the selector.

So, to create your own style sheet, each selector must begin with the
style sheet name. For example, .my_custom_style_sheet
.ekmenu.

String

SuppressAddEdit

When set to True, suppress the Add and Edit buttonson themenu
when a user is logged in to Ektron CMS400.NET. The default is
False.

True - suppress the Add and Edit button when a user is logged in to
Ektron CMS400.NET.

False - show the Add and Edit buttonswhen a user is logged in to
Ektron CMS400.NET.

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default is False.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag. The default is
Span.

Span - Use the <span> tag to designate an inline portion of an HTML
document asa span element.

Div - Use the <div> tag used to apply attributes to a blockof code.

Custom -Use a custom tag.

String

Section 508 Compliance Features of Smart
Menus
Ektron CMS400.NET’s Smart Menus are 508 compliant because they adhere to
the following principles. They

n are accessible - the navigation functionality is accessible to all
users who interact with a text-based Web page.
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n can work without DHTML - Underneath the surface, Smart Menus
are rendered as an unordered list. By default, they are styled with
CSS and made dynamic with JavaScript. But, if you don’t use these
features, the menu still works although its look and feel are
different.

n are 100% navigable via the keyboard; no mouse actions are
required - Each Smart Menu has an < > header, which is used by
some screen readers (such as Jaws) to assist visually impaired users
with page navigation A list of all headers is available via a key
sequence. Also, all menu items are wrapped in links, which allow
screen readers to assist a visually impaired user with page
navigation. A list of links is available via a key sequence.

n do not rely on color to convey important information - the
standard style sheets use underlining and bold to (in addition to
color) to distinguish normal from selected menu options.

n Also, “(Selected)” follows the title of selected items. This text is
suppressed in graphical browsers (such as IE and FireFox) but is
visible in text browsers and announced when a screen reader is used.

n provide sufficient contrast - the standard style sheets emphasize
contrasting colors. In addition, because of the flexibility of Smart
Menus, you can use your creative and artistic resources to develop
menus that are attractive and have proper contrast.

n are understandable even when the style sheet is turned off

n let a screen reader skip repetitive navigation links

n when a user clicks a menu option, the screen reader
proceeds to the new page - it does not read the remaining menu
items.

Note: To be sure your menus are 508 compliant, use either the treemenuex.css or
treemenuex_images.css style sheet.

Retrieving the XML Structure of a Smart
Menu
Retrieving the XML structure of XML content allows for greater control over
developing XSLs. The following is an example of how to retrieve the XML
structure:

1. Open a new Web form.

2. Drag and drop a SmartMenu server control onto it.

3. Set the DefaultMenuID property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

Retrieving the XMLStructure of a Smart Menu
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6. On the code behind page, add the following line.
Textbox1.Text = SmartMenu1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

The XML structure of the Smart Menu appears in the textbox.

Menu Server Control
The Menu server control calls a menu to be displayed on a page. Using the Menu
server control, you can manipulate a menu by using the DisplayXslt property.
Below is a menu display with the SampleMenu XSLT.

Before you can use the Menu server control, you must create a menu in the
Ektron CMS400.NET work area. To learn about creating menus, Working with
Menus on page 9-133.

This section also contains the following topics.

Menu Server Control Properties 9-188
Using DisplayXslt Samples 9-190
SampleMenu 9-191
SampleMenu XSL code 9-192
TreeMenu 9-192
TreeMenu XSL Code 9-193
Retrieving the XML Structure of a Menu 9-193

See Also: Contrasting Menu Server Controls on page 9-164

Menu Server Control Properties
The Menu server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
this property to 300 (three hundred). See Also:Caching with Server
Controlson page 24-33

Double

DefaultMenuID

The ID of amenu that appearswhere you insert this server control if no
other menu is identified or available.

If you don’t know the ID number of themenu, use the CMSExplorer to
browse to it.

See Also:Using CMSExplorer to Browse Your Ektron CMS400.NET
Site on page 24-8

Long

DisplayXslt

The XSLT to use to render themenu.

None - databind only

SampleMenu - A sample display, formatted asa bulletedmenu list

TreeMenu - A sample display, formatted asa folder tree. You can
expand the tree by clicking on the folder icon.

Path to Custom Xslt - Enter the path to an XSLT that determines the
display of the page

For more information on using the SampleMenu and TreeMenu
DisplayXslt, seeUsing DisplayXslt Sampleson next page.

Warning! If you want to edit this file, it is strongly recommended that
youmake a copy, change its name andmove it outside of your site's
Workarea folder. If youmake changes to this file and do not move it
out of theWorkarea, this file and the changeswill be lost when you
upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

DynamicParameter Selectmenu_id. When you do, this server control uses themenu
passed asa URL parameter. String

Hide

Used to hide amenu in design time and run time.

True =Hidemenu

False =Showmenu

Boolean
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Property Value
Data
Type

Language

Set a language for viewingmenus. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser).

For more information, seeWorking with Menus in aMulti-Language
System on page 9-158.

Integer

Stylesheet

Specify the location and style sheet for themenu. For example:
\Workarea\csslib\mytest.css.

Leave blank to use the default.

global.css is the default style sheet. It is located in
\webroot\siteroot\Workarea\csslib.

String

SuppressAddEdit

When set to True, suppress the Add and Edit buttonson themenu
when a user is logged in to Ektron CMS400.NET. The default is False.

True - suppress the Add and Edit button when a user is logged in to
Ektron CMS400.NET.

False - show the Add and Edit buttonswhen a user is logged in to
Ektron CMS400.NET.

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block
of code.

Custom - Allowsyou to use a custom tag.

String

Using DisplayXslt Samples
Two DisplayXslt samples are provided with the Menu server control,
SampleMenu and TreeMenu. This section explains how to use them.

Warning! If you want to edit either of these files, it is strongly recommended that you make a
copy, change its name and move it outside of your site's Workarea folder. If you make changes to
this file and do not move it out of the Workarea, this file and the changes will be lost when you
upgrade.
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SampleMenu
The SampleMenu DisplayXslt lets you display an Ektron CMS400.NET menu as a
bulleted item list. See below for an example.

When you are logged in to your Ektron CMS400.NET site, two menu items are
added to each section of the menu: Add and Edit Menu. The user can use these
to add a new menu item or edit an existing one. See example below.

For Information on a adding a menu Item, seeAdding New Content to a Menu
via Navigation Link on a Web Page on page 9-150.

For Information on a editing a menu, seeEditing a Menu's Properties via
Navigation Link on a Web Page on page 9-152.

SampleMenu
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SampleMenu XSL code
For an example of the XSL code used in the SampleMenu, click the following link
and choose the appropriate version.

http://dev.ektron.com/kb_article.aspx?id=2114

TreeMenu
The TreeMenu DisplayXslt lets you display an Ektron CMS400.NET menu as a
clickable folder list. You can expand and collapse the menu by clicking on the
folder icons. See below for an example.

When you are logged in to your Ektron CMS400.NET site, two menu items are
added to each section of the menu: Add and Edit Menu. The user can use these
to add a new menu item, or edit an existing menu item. See example below.

For Information on a adding a menu Item, see Adding New Content to a Menu
via Navigation Link on a Web Page on page 9-150.

For Information on a editing a menu, see Editing a Menu's Properties via
Navigation Link on a Web Page on page 9-152.
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Note:When using the TreeMenu server control with Visual Studio and Windows 2003, the
folder images do not display during design-time. They do, however, display correctly during
run-time.

TreeMenu XSL Code
For an example of the XSL code used in the MenuTree, click the following link
and choose the appropriate version.

http://dev.ektron.com/kb_article.aspx?id=2114

Retrieving the XML Structure of a Menu
Retrieving the XML structure of XML content allows for greater control over
developing XSLs. The following is an example of how to retrieve the XML
structure:

1. Open a new Web form.

2. Drag and drop a Menu server control onto it.

3. Set the DefaultMenuID properties.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = Menu1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

9. The XML structure of the menu appears in the textbox.

TreeMenu XSLCode
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For an additional example, see the Menu XML page on the CMS400Developer
samples page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/Menu/MenuAsXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/Menu/MenuAsXML.aspx and MenuAsXML.aspx.vb

DhtmlMenu Server Control
Note: For optimal performance, Ektron recommends using at minimum Internet Explorer 5.5 or
Mozilla Firefox 1.0. Also, the following KB article describes a possible problem using a DHMTL
menu with Internet Explorer 8: http://dev.ektron.com/kb_article.aspx?id=26942.

The DhtmlMenu server control lets you display a menu with drop down boxes
and submenus. This lets developers add a menu to a page without taking up a
lot space. You can modify the menu’s style properties via a style sheet.

Before using the DhtmlMenu server control, you must create menus in the
Ektron CMS400.NET workarea. See Working with Menus on page 9-133.

The DhtmlMenu server control also lets logged in users add content to a menu.
When you are logged in to your Ektron CMS400.NET site, two items are added to
each menu: Add and Edit Menu. Use them to add a new menu item or edit an
existing one. See example below.

For Information on a adding a menu item, see Adding New Content to a Menu
via Navigation Link on a Web Page on page 9-150.
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For Information on a editing a menu, see Managing Menus on page 9-137.

Important: You cannot create a DHTML menu using code behind -- you must drag and drop it.
Once a DHTML menu is on a Web form, you can manipulate its properties using the code
behind.

This section also contains the following topics.

DhtmlMenu Server Control Properties 9-195
Using a Style Sheet 9-199
pop_style.css 9-199
Formatting the DhtmlMenu Server Control 9-200
Retrieving the XML Structure of a DhtmlMenu 9-200

See Also: Contrasting Menu Server Controls on page 9-164

DhtmlMenu Server Control Properties
The DhtmlMenu server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value Data Type

Align

Specifies the horizontal alignment of
the root menu text.

The default isCenter.

NotSet - Use the default setting.

Left - Aligns text to the left.

Center - Aligns text to the center.

Right - Aligns text to the right.

Justify - Aligns text justified to bothmargins.

HorizontalAlign

Authenticated

Indicates if you are logged in to the CMSExplorer
and can use it to browse to Content, Collections, etc.

See Also: Using CMSExplorer to Browse Your Ektron CMS400.NET Site
on page 24-8

String
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Property Value Data Type

CssClass

Apply a .css class to the root menu. Enter the classname from the .css
defined in the Stylesheetproperty. See Also:Stylesheet on the facing
page

Since pop_style.css is the default style sheet, you can use its classes
without defining it in the Stylesheetproperty.

For example, if you enter lowtext in the property, the root menu changes
as shown below.

String

DefaultMenuID

The ID of amenu that appearswhere you inserted this server control if no
other menu is identified or is available.

If you don’t know the ID number of themenu, use the CMSExplorer to

browse to it. See Also: Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

Long

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you want to
postpone the fill-action until later. In this case, FIll is automatically called
during the Page Render event.

Youmight do this if you need to set or change a property on the control in
codebehind and have it render with your changes shown.

Boolean

DynamicParameter Selectmenu_id. When you do, this server control uses themenu passed
asa URL parameter. String

EnableIE6FormsFix

This should only be enabled when you have a DHTMLmenu rendering
over an HTML select element. In IE6, the DHTML renders below the drop
down. This temporarily disables the element when the DHTMLMenu is
rendered.

Boolean

Hide

Used to hide amenu in design time and run time.

True =Hidemenu

False =Showmenu

Boolean
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Property Value Data Type

HorizontalDisplay

Displays submenu to the right of the root menu. This only affects the first
submenu of the root menu. All subsequent submenusappear to the right of
each submenu.

The default isFalse

True =Submenu appears to the right of the root menu

False =Submenu appears below the root menu

Boolean

Language

Set a language for viewing DhtmlMenus. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser).

For more information, seeWorking with Menus in aMulti-Language
System on page 9-158

Integer

MenuHoverOverColor Sets the background color for the root menu when hovering over it. Color

MenuStyle

A specified inline style that defines the root menu. For example:

font: bold 18px Arial;color:royalblue; background-
color:slateblue String

Stylesheet

Specify the location and style sheet for the submenu. For example:
\Workarea\csslib\mytest.css.

Leave blank to use the default.

pop_style.css is the default style sheet. It is located in
\siteroot\Workarea\csslib. For more information on style sheets,
seeUsing a Style Sheet on page 9-199.

You can use the Stylesheetproperty in conjunction with the CssClass
property to define the root menu.

See Also:CssClasson previouspage

String

SubMenuBackColor Sets the background color for the submenu. Color
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Property Value Data Type

SubMenuHoverOverColor Sets the background color for the submenuwhen the cursor hovers over it. Color

SubMenuItemHeight

Sets the height of each submenu item in pixels. The default is 20.

Example set to 20:

Example set to 30:

Int16

SubMenuItemWidth

Sets the width of each submenu item in pixels. The Default is 150

Example set to 150:

Example set to 130:

Int16

SubMenuTopOffset

Sets the location of the top of the submenu relative to its parent. This
number, in pixels, refers to the number of pixels the submenu appears
below the parent menu. The default is 5.

Example set to 5:

Example set to 0 (zero):

Example set to -10:

Int16

SuppressAddEdit

When set to True, suppress the Add and Edit buttonson themenuwhen a
user is logged in to Ektron CMS400.NET. The default is False.

True - suppress the Add and Edit button when a user is logged in to Ektron
CMS400.NET.

False - show the Add and Edit buttonswhen a user is logged in to Ektron
CMS400.NET.

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The default
isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Value Data Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of an HTML
document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof
code.

Custom - Allowsyou to use a custom tag.

String

Using a Style Sheet
You can create your own style sheet, or modify the existing default one, pop_
style.css. It is located in \site root\Workarea\csslib.See Also: pop_
style.css below

Style Sheets let you choose different text colors, text alignment, text fonts, and
text size to create a customized menu.

Best Practice
Ektron recommendscopying and renaming the default style sheet. This insures you
alwayshave a clean file to start with. This also gives you something to reference if you
are not getting the results you expect.

The style sheet must be located below the site root.

You can only define one menu style sheet for each Web page. If you have more
than one menu on a single Web page, they share a style sheet.

For more information on style sheets, visit http://www.w3.org/Style/CSS/.

pop_style.css
This file is located in webroot/siteroot/Workarea/csslib. It is used to
customize the look of the DhtmlMenu server control. The following is a list of
style sheet properties that can be modified.

Style Class Description Attribute Default Value

.lowText
Text of the floating
menu asdisplayed
on themenu.

n color

n font

n text-align

n text-
decoration

n #000000 (Black)

n 12pxArial, sans-serif

n left

n none
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Style Class Description Attribute Default Value

.highText
Text of the floating
menuwhen
highlighted.

n color

n font

n text-align

n text-
decoration

n #000000 (Black)

n 12pxArial, sans-serif

n left

n none

.roothighText

Note: This classonly
workswhen called by
the CssClass
property. Use the
Fontproperty
in the Appearance
category
to define root menu
text.

Text of the root menu
asdisplayed on a
Web page.

n color

n font

n text-align

n text-
decoration

n #000000 (Black)

n 16pxArial, sans-serif

n center

n none

.itemBorder Border color and size
of themenu. n border n 1px solid #666666

.itemBorderBlank
Separator border
color and size of the
menu.

n border n 1px solid #CCCCDD

Formatting the DhtmlMenu Server Control
Additional information on formatting the DhtmlMenu server control can be found
in the following Knowledge Base article: http://dev.ektron.com/kb_
article.aspx?id=2441

Retrieving the XML Structure of a
DhtmlMenu
Retrieving the XML structure of XML content allows for greater control over
developing XSLs. The following is an example of how to retrieve the XML
structure:

1. Open a new Web form.

2. Drag and drop a ContentList server control onto it.

3. Set the DhtmlMenuID property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: Ektron recommends setting the text box width to at least 400px.
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6. On the code behind page, add the following line.
Textbox1.Text = DhtmlMenu1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

The XML structure of the DhtmlMenu appears in the textbox.

Retrieving the XMLStructure of a DhtmlMenu
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Taxonomy
Large amounts of content can be an organizational nightmare, and it
takes a far reaching categorization model to allow content to be
efficiently repurposed, searched for, and organized on a site.
Ektron’s taxonomy, a one-to-many relationship model, follows
natural and organic methods all the way down to the content level,
enabling an intuitive organization scheme that reflects how people think.

Click the following link to see a video introduction to taxonomy in Ektron
CMS400.NET:
http://www.ektron.com/learningcenter/taxonomy/taxonomy.html.

Ektron’s taxonomy is a content-level categorization system that uses one-to-
many relationships to create a scalable organization of content. Content is
categorized in the database by how it relates to multiple categories, allowing it
to be accessed in multiple ways for multiple purposes. The hierarchy of the
content is arranged from the general to the specific, and there may be multiple
“routes” that define the content at the end of the hierarchy.

This type of categorization lets you create a navigation structure (independent
of the folder structure) that matches the way different site visitors want to find
what they are looking for.
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For example, Arnold Schwarzenegger can be thought of as an actor, Mr.
Olympia or as a California governor. Taxonomy creates a one-to-many
relationship with any content about Schwarzenegger and auto-generates
navigation which can support all of the approaches to accessing any content
about him. Site visitors can find the content whichever way that they think
about it.

Ektron’s taxonomy system plays key roles in more than just organizing content.
CMS400.NET’s URL Aliasing is able to auto-generate human readable and SEO-
friendly addresses based on the taxonomic structure of the page. Because it is
using the various ways that people relate to the content to determine the alias,
search engines will find it based on multiple terms as well.

A taxonomy directory control can automatically create the navigation on your
Web site. Once the content is tagged, it automatically shows up in the correct
section of the site. The author doesn’t need to know where the content is going
to show up, the taxonomy tagging will determine that. If you are managing
large amounts of information, this use of taxonomy is especially powerful.

Taxonomy can also improve search functionality, and Ektron’s integrated
search takes full advantage of it.

This section also contains the following topics.

Introduction to Creating a Taxonomy 9-203
Creating a Taxonomy 9-204
Assigning a Taxonomy/Category to Content, Users, or Com-
munity Groups

9-
214

Additional Taxonomy/Category Tasks 9-230
Assigning Custom Properties to a Taxonomy 9-243

Displaying a Content Item Taxonomy Search on your Web Site
9-
252

Multi-Language Support for Taxonomies 9-253
Using Taxonomies with Social Networking 9-258
Directory Server Control 9-258

Introduction to Creating a Taxonomy
When working with content, you can place a listing of those categories (a
taxonomy) on a Web page. When that page displays, the taxonomy’s categories
appear, followed by all published items in the taxonomy.

To help site visitors find your Web site’s content via a taxonomy, your
developer places a Directory server control on a Web page. It looks something
like this.
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See Also: Directory Server Control on page 9-258

There is no limit to the number of category levels you can assign to a
taxonomy.

Also, a taxonomy can provide a link to all content in a folder, so the display is
based on folder structure. Alternatively, you can assign content items from
various folders to a taxonomy.

To illustrate the benefits of a content-based taxonomy, assume your Web site is
for a college. Several items relating to the graduate school are organized under
major departments: Admissions, Academics, Faculty, Library, etc. You can
create a Graduate School taxonomy, use it to categorize all content relevant to
graduate students (regardless of their department), and display them on a
graduate students page.

Creating a Taxonomy
This section explains how to create and deploy a taxonomy.

This section also contains the following topics.

Planning the Taxonomy 9-204
Creating a Taxonomy 9-205
Taxonomy Field Description 9-207
Applying a Template to a Taxonomy or Category 9-209
Assigning a Taxonomy Configuration 9-212
Numbers on the View Categories Screen 9-213

Planning the Taxonomy
It helps to design a taxonomy on paper before creating it in Ektron
CMS400.NET. This can let you determine relationships among the kinds of
information before you try to implement the taxonomy.
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As an example, here is a hierarchy of some content in the Ektron CMS400.NET
sample site. The top level item is the taxonomy. All levels below it are
categories.

Next, review the site content and decide which content items and folders to
assign to which taxonomy categories. Some categories may map directly to a
folders. Other categories may use content from several folders.

Once you determine how content and folders will be assigned to taxonomy
categories, sign on to Ektron CMS400.NET and set up those relationships.

Creating a Taxonomy
Note: Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Content > Taxonomy option. See Also: Defining Roles on page 15-31

1. From the Workarea, go to Content > Taxonomies > Taxonomies.
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2. Use the View > Language selector pull-down to choose a language
for the taxonomy (see below).

See Also: Creating a Taxonomy in a Multi-Language Environment on page 9-253

3. Click the Add Taxonomy button ( ).
Alternatively, you can hover the cursor over Taxonomies in the right panel,
right click the mouse, and click Add Taxonomy.

4. The Add Taxonomy screen appears.

5. Use the following table to complete the screen.
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Taxonomy Field Description

Field Description
For more
information,
see

CategoryTitle Give the taxonomya title. The title identifies the taxonomywherever it
appears.

Category
Description

If desired, enter amore complete description of the taxonomy. It
appears only on the Edit Taxonomyscreen.

Taxonomy
Image

If desired, you can assign an image to this taxonomy. For example, in
the eCommerce feature, you could display this taxonomy image to
indicate the type of products that make up the taxonomy.

To display the taxonomy image, use Ektron CMS400.NET’sAPI. A
sample of how to do this is provided in the following file, which is part
of the developer sample site: site
root/developer/taxonomy/taxonomy_image.aspx.

To see the sample on aWeb page, go to theDeveloper sample
page > Taxonomy > Taxonomy Image. To download the
developer sample site, go to
http://www.ektron.com/solutions/startersites/.

Template If desired, select a template to apply to the taxonomyor category.

Applying a
Template to a
Taxonomyor
Categoryon
page 9-209

Inherit (only
appearswhen
creating a
category
underneath a
taxonomy)

Check this box if you want this category to inherit its template from
the parent category or taxonomy. If not, assign a template using the
Template field (above).

Category Link

Use this field to direct aWeb site visitor who clicks this
taxonomy/category to anypage on your Web site. For example,
when someone is using your site’s companydirectory and clicks
HumanResources>Benefits, he is directed to that area of your Web
site.

Without a Category Link, if a site visitor clicks a taxonomycategory,
the results appear on the same page.

Enter a path to a destination page relative to your site root folder. For
example, aboutus.aspx. When a site visitor clicks this
taxonomy/category, he is directed to http://your URL/Site root
folder/aboutus.aspx.

You could also direct the user to a content ID, such as
aboutus.aspx?id=62.

TaxonomyField Description
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Field Description
For more
information,
see

Display?

Check this box if you want this taxonomy/category and its
subcategories to appear when this taxonomyappears on your Web
site.

Use this field to block certain categories from appearing aspart of
this taxonomy. For example, you have not finished creating content
for the category, so you don’t want it to appear yet.

If you uncheck this box, this node and its child nodesare indicated by
a graybackground (see image below).

The graybackground also appearswhen usersworkwith this
taxonomy/category on the Edit Content screen’sCategory tab.

This setting doesnot prevent you from assigning
taxonomies/categories in the Ektron CMS400.NETWorkarea.

Configuration

Select a configuration with which to associate the taxonomy.

n Content

n User

n Group

Note:
* Bydefault, a new taxonomy’s configuration is content.
* This field only appears for a taxonomy. It doesnot appear for
categories, which are below the taxonomy.

Assigning a
Taxonomy
Configuration
on page 9-212

Custom
Properties tab

Let you extend the taxonomy's functionality by creating custom fields
to capture additional information.

Assigning
Custom
Properties to a
Taxonomyon
page 9-243

6. Click the Save button ( ).
7. The View Taxonomies screen appears.

8. Next, add categories to this new taxonomy. To do this, click the Add
Category button ( ) .

Alternatively, you can hover the cursor over the Taxonomy in the right
panel, right click the mouse, and click Add Category.

9. The Add Category screen appears.
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10. Enter the Category information. For information about these fields,
see Taxonomy Field Description on page 9-207.

11. When finished, Click the Save button ( ) to save this category.
12. Repeat this process for each category you wish to add to this

taxonomy.

Note: You can also assign a Taxonomy to content using the Edit Content in Folder screen’s
Category tab.

Applying a Template to a Taxonomy or
Category
Taxonomy categories are designed to help site visitors find content. To provide
a taxonomy-based search, your developer places a Directory server control on
a Web page.

By default, when a user clicks a hyperlink on such a Web page, it uses the
template assigned to the linked content (as illustrated below). See Also:
Creating/Updating Templates on page 7-178
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If you want to display the linked content using a different template, follow these
steps.

1. When creating or editing a taxonomy or category, select the
appropriate template at the Template pull-down field.
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Note: Any category below the root level can inherit its parent’s taxonomy template. Use the
Inherit checkbox to do this.

You may need a developer’s help with the rest of these steps.

2. In Visual Studio.Net, open the .aspx page that contains the directory
server control.

3. Look at the server control’s MarkupLanguage property.

4. If the property is blank, open the following file: site
root/workarea/template/taxonomy/taxonomy.ekml.

If the property displays an .ekml file, open that file. Its path may be
listed in the property. If the .ekml file’s path is blank, it is
workarea/template/taxonomy/.

5. Find the following line: [$HyperLink]<br/>[$Teaser]

6. Replace it with the following: <a
href="[$TemplateQuickLink]">[$Title]</a><br/>[$Teaser]

7. Save the .ekml file.

The content selected from this Directory server control will now use the
template assigned to the taxonomy/category.

Applying a Template to a Taxonomy or Category
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Assigning a Taxonomy Configuration
There are three taxonomy configurations (that is, types). Each taxonomy is one
of these types - content, user, or group.

Configuration Result

Content

Associate this taxonomywith content.When this configuration is selected

n you can assign content to the taxonomy/category

n the taxonomycategory appears on every folder’s properties screen (shown below)

User

Associate this taxonomywith CMSor membership users. You select users for this
taxonomyon the Assign Items to Taxonomyscreen.

After users are assigned to a taxonomy, they can be found via the CommunitySearch
server control’sAdvanced tab. From theAdvanced tab, selectCategory from the
Users dropdown. Next ClickSelect and a User Categories selector appears (shown
below).
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Configuration Result

Group

This taxonomy‘s categories can be assigned to community groups from theCategory tab
of the Edit CommunityGroup screen. See example below.

If you do not check this box, users can only view taxonomy/category assignments on the
Category tab.

Whether or not this box is checked, you can assign taxonomycategories to community
groups via the View AllCategories of Taxonomyscreen.

Numbers on the View Categories Screen
When editing content, if you choose the Category tab, you see the Taxonomy
that applies to this content. The number to the right of any taxonomy/category
is a cumulative total of all items assigned to it and its subcategories. In the
example below, the three subcategories have a total of 13 items (2 + 1 + 10).

Since the number to the right of the parent category equals the number
assigned to all subcategories, you know that no items are assigned to the
parent category.

Also, the number includes individual items plus all items in any assigned
folders. So, for example, if one content item and one folder are assigned to a
category, and the folder has five items, the category’s number is six.

Numbers on the View Categories Screen
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Assigning a Taxonomy/Category to
Content, Users, or Community Groups
The table below summarizes information about assigning a taxonomy/category
to content, users or community groups.

To assign a
taxonomy category
to

Available methods Prerequisites
For more information,
see

Content

Note: Regardless
of themethod you
use to assign a
taxonomy to
content, the result
is the same.

from the Edit Content
in Folder screen

n Must be
authorized to edit the
folder’s content

n You can only
select from
taxonomiesassigned
to the content’s folder

Assigning a
Taxonomy/Category to
Content, Users, or
CommunityGroupsabove

from the Content Tab
>Taxonomyscreen

Must bemember of
administrators group
or Taxonomy
administrator

Assigning Content to a
Taxonomy/Category on
page 9-218

Ektron CMS400.NET
Users

from the Assign
Item(s) to Taxonomy
screen

Taxonomy’sCon-
figuration > User
checkbox is checked

Assigning a
Taxonomy/Category to a
User on page 9-229

Membership Users

n from the Assign
Item(s) to Taxonomy
screen

n after logging into a
Community site,
editing the user profile

Taxonomy’sCon-
figuration > User
checkbox is checked

Assigning a Tax-
onomy/Category to aMem-
bership User on page 9-
226

CommunityGroup

n from the
Workarea’sAssign
Item(s) to Taxonomy
screen

n from the
Workarea’s
CommunityGroup
Area

n after logging into a
Community site,
editing the community
group profile

Taxonomy’sCon-
figuration > Group
checkbox is checked

Assigning a Tax-
onomy/Category to a Com-
munityGroup on page 9-
222

This section also contains the following topics.
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How Content Authors Assign Taxonomy Categories below

How Administrators Assign Taxonomies to a Folder on next page

How Administrators Assign a Taxonomy/Category on page 9-218

How Content Authors Assign Taxonomy
Categories
Ektron CMS400.NET lets content authors assign a taxonomy category to
content. They do this by navigating to a content block, clicking its Category
tab, opening a taxonomy, and checking the correct level.

However, all taxonomies may not be available to every content item. Use a
folder property's Taxonomy area to control which taxonomies can be assigned
to content in that folder.

How Content Authors Assign TaxonomyCategories
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For example, a folder’s content consists of restaurants, and you want to restrict
users to the Restaurant taxonomy -- users cannot assign other categories to
that folder’s content.

How Administrators Assign Taxonomies to a
Folder
To make a taxonomy available to a folder, follow these steps.

1. Navigate to the folder by clicking Content > Folders then click a
folder.

2. Choose View > Properties.

Alternatively, hover the cursor over the folder, right click the mouse, and select
View Properties.

3. Click Edit ( ).

4. On the Taxonomy tab, uncheck the Inherit parent configuration
checkbox. See Also: Inheriting Taxonomies from a Parent Folder on
the facing page

5. Check taxonomies that should be available to this folder.
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6. From now on, users editing content in this folder can assign
categories from the selected taxonomies.

Inheriting Taxonomies from a Parent Folder
Unlike some folder properties, Taxonomy settings are not inherited from a
parent folder by default. But you can cause them to be inherited if that is
appropriate.

If you are not working on the root folder and the appropriate set of Taxonomies
is applied to a folder’s parent folder, go to the folder’s properties screen and
check the Inherit parent configuration checkbox.

How Administrators Require the Assignment of at
Least One Category
In the folder properties, you can require all content to be assigned at least one
taxonomy category. If you do, when content in that folder is saved, Ektron
CMS400.NET checks to see that at least one taxonomy category has been
assigned. If none is found, the user is notified that he must assign a taxonomy
category before he can save the content.

To set a folder-level requirement for all content to be assigned a taxonomy
category, follow these steps.

1. Navigate to the folder.

2. Choose View > Properties.

Alternatively, hover the cursor over the folder, right click the mouse, and select
View Properties.

3. Click the Taxonomy Tab.

4. Check the at least one category Required checkbox.

5. Click Save ( ).

Inheriting Taxonomies from a Parent Folder
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How Administrators Assign a
Taxonomy/Category

n Assigning Content to a Taxonomy/Category below

n Assigning a Folder to a Taxonomy/Category on page 9-221

n Assigning a Taxonomy/Category to a Community Group on page 9-
222

n Assigning a Taxonomy/Category to a Membership User on page 9-226

Assigning Content to a Taxonomy/Category
Prerequisite

You can perform this procedure only if a taxonomy’s Configuration >
Content check box is checked.

Members of the administrators group or taxonomy administrators can assign
taxonomy categories to content via the View All Categories of Taxonomy
screen. See Also: Defining Roles on page 15-31

1. From the Workarea, go to Content > Taxonomies.

2. Select a language whose taxonomies you want to work with (see
image below). You can choose All.

3. Select a taxonomy.

4. Select the category to which you want to assign content.

5. Click the Assign Items to Taxonomy button ( ).
Alternatively, right click the category and choose Assign Item(s).

Helping Users Navigate Your Web Site

9-218 ReferenceManual
Version 8.01 Rev 4



As another alternative, navigate to a content folder, click items to be assigned,
right click the mouse and select Copy. Then, locate the taxonomy category,
right click the mouse, and select Paste Items to Taxonomy.

6. From the View dropdown, choose the object type of the item to
associate. See Also: Assigning a Taxonomy Configuration on page 9-
212

7. If you select Content , narrow down the type of content you wish to
see via the Type pulldown.
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n All types - both archived and active content

n Content - active content only

n Archived Content - only content that has been archived and set to
remain on site. See Also: Setting Archive Options on page 7-191

8. Navigate to the folder that contains the content you want to assign to
the taxonomy or category.

or

Search for the user or community group to assign to the taxonomy or
category.

Note: Folder content appears below the folder list (see below). Also, only content in the
selected language appears.

9. Check the box to the left of content, user, or community group you
want to assign. You can assign all types of content, even blogs.
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Assigning a Folder to a Taxonomy/Category
Prerequisite

You can perform this procedure only if a taxonomy’s Configuration >
Content check box is checked

Note: If you assign a folder, the internal relationship is between the folder’s content and
taxonomy category. The folder is merely a convenience for creating this relationship. There is
no data connection between the folder and the taxonomy category.

You can assign a folder to a taxonomy, thereby displaying published content in
the folder when the page is viewed. As content is added to or removed from the
folder, the taxonomy on the Web page changes dynamically.

For example, you have a “Top News Stories” folder, in which old news items
are frequently replaced by newer ones. The taxonomy only shows the latest
news items. The updating of the content is handled by the taxonomy
automatically.

Note: Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Content > Taxonomies option. See Also: Defining Roles on page 15-31

To assign a folder to a taxonomy category, follow these steps.

1. From the Workarea, go to Content > Taxonomies.

2. Select the language of the taxonomy on which to work.

3. Select the taxonomy or category to which you want to assign a
folder.

4. Click the Assign Folders to Taxonomy button ( ).
Alternatively, right click the category and choose Assign Folder(s).

5. Navigate to the folder you want to assign to the taxonomy or
category.

6. Check the box to the left of all folders you want to assign.
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Warning! Only checked folders are assigned to the taxonomy/category. Checking a parent folder
has no effect on its child folders.

Assigning a Taxonomy/Category to a Community
Group
Prerequisite

You can perform this procedure only if a taxonomy’s Configuration > Group
check box is checked.

You can assign a taxonomy/category to a community group from either a
Community web site or the Ektron CMS400.NET Workarea.

n Assigning a Taxonomy/Category to a Community Group from the
Workarea Community Group Area below

n Assigning a Taxonomy/Category to a Community Group from the
Workarea on page 9-224

n Assigning a Taxonomy/Category to a Community Group from a
Community Web Site on page 9-225

Assigning a Taxonomy/Category to a Community Group
from the Workarea Community Group Area

Note: To learn about how a group's the taxonomy/category assignment helps membership
users find a community group, see Filtering Search Results by Category on page 16-263
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1. Navigate to Settings > Community Management > Community
Groups .

2. Select a community group.

3. Click the Edit button ( ).
4. Click the Category Tab.

5. Check the taxonomies or categories to apply.

6. Click the Save ( ) button.
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Assigning a Taxonomy/Category to a Community Group
from the Workarea
Members of the administrators group or taxonomy administrators can assign
taxonomy categories to community groups via the View All Categories of
Taxonomy screen. See Also: Defining Roles on page 15-31

1. From the Workarea, go to Content > Taxonomies.

2. Select a language whose taxonomies you want to work with (see
image below). You can choose All.

3. Select a taxonomy.

4. Select the category to which you want to assign content.

5. Click the Assign Items to Taxonomy button ( ).
Alternatively, right click the category and choose Assign Item(s).

6. From the View dropdown, click Community Groups.

7. A search field appears. Click the search icon to see a list of all
community groups. Or, enter one or more letters, and only groups
containing them appear.
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8. Check the box to the left of the community groups you want to
assign.

9. Click the Save ( ) button.

Assigning a Taxonomy/Category to a Community Group
from a Community Web Site

1. Log into the Community Web site.

2. Click the Community Groups link. The location of this link will vary,
depending on how your site is set up.

3. Click the community group that you want to edit.

4. Click Edit Group. See example below.
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5. Click the Category tab.

6. Check the taxonomies or categories to apply.

7. Click the Save ( ) button.

Assigning a Taxonomy/Category to a Membership
User
You can assign a taxonomy/category to a membership user from a Community
web site or from the Workarea.

Prerequisite

You can perform this procedure only if a taxonomy’s Configuration > User
check box is checked.

n Assigning Taxonomy/Category to Community Group from Web Site
on the facing page

n Assigning Taxonomy/Category to Community Group from Workarea
on page 9-228
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Assigning Taxonomy/Category to Community Group from
Web Site
Log into the Community Web site.

8. Click the Community Groups link. The location of this link will vary,
depending on how your site is set up.

9. Click the community group whose members you want to edit.

10. Click Members. See example below

11. Click a user.

12. Click Edit Profile.

13. Click the Category Tab.

14. Check the taxonomies or categories to apply.

15. Click the Save ( ) button.

Assigning Taxonomy/Category to Community

ReferenceManual
Version 8.01 Rev 4

9-227



Assigning Taxonomy/Category to Community Group from
Workarea
Members of the administrators group or taxonomy administrators can assign
taxonomy categories to community group Members via the View All Categories
of Taxonomy screen. See Also: Defining Roles on page 15-31

1. From the Workarea, go to Content > Taxonomies.

2. Select a language whose taxonomies you want to work with (see
image below). You can choose All.

3. Select a taxonomy.

4. Select the category to which you want to assign content.

5. Click the Assign Items to Taxonomy button ( ).
Alternatively, right click the category and choose Assign Item(s).

6. From the View dropdown, click Members.

7. A search field appears. Click the search icon to see a list of all
community members. Or, enter one or more letters, and only
members containing them appear. You can also use the pulldown to

Helping Users Navigate Your Web Site

9-228 ReferenceManual
Version 8.01 Rev 4



specify if you are searching the membership user's first name, last
name or user name.

8. Check the box to the left of the membership users you want to
assign.

9. Click the Save ( ) button.

Assigning a Taxonomy/Category to a User
Members of the administrators group or taxonomy administrators can assign
taxonomy categories to Ektron CMS400.NET users via the View All Categories
of Taxonomy screen. See Also: Defining Roles on page 15-31

1. From the Workarea, go to Content > Taxonomies.

2. Select a language whose taxonomies you want to work with (see
image below). You can choose All.

3. Select a taxonomy.

4. Select the category to which you want to assign content.

5. Click the Assign Items to Taxonomy button ( ).
Alternatively, right click the category and choose Assign Item(s).
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6. From the View dropdown, click CMS Authors.

7. A search field appears. Click the search icon to see a list of all CMS
 users (that is, authors). Or, enter one or more letters, and only
users containing them appear. You can also use the pulldown to
specify if you are searching the user's first name, last name or user
name.

8. Check the box to the left of the users you want to assign.

9. Click the Save ( ) button.

Additional Taxonomy/Category Tasks
This section also contains the following topics.

Viewing All Taxonomies 9-231
Viewing a Taxonomy 9-231
Edit a Taxonomy/Category’s Fields 9-234
Copying and Moving a Taxonomy 9-235
Copy/Move a Taxonomy Category using a Toolbar Button 9-235
Copy/Move a Taxonomy Category using Menu Options 9-236
Delete a Taxonomy/Category 9-236
Deleting a Taxonomy from View All Taxonomies Screen 9-236
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Deleting a Category from View All Categories Screen 9-237
Add a Category to a Taxonomy/Category 9-237
Remove Content from a Taxonomy/Category 9-238
Remove Folder from a Taxonomy/Category 9-239
Background Information 9-239
Steps for Removing a Folder from a Taxonomy 9-239

Change Order of Categories Assigned to a Taxonomy/Category
9-
240

Change Order of Content Assigned to a Taxonomy/Category 9-241
Importing and Exporting a Taxonomy 9-241
Exporting a Taxonomy 9-242
Importing a Taxonomy 9-243

Viewing All Taxonomies
The View All Taxonomies screen displays all taxonomies currently in Ektron
CMS400.NET. The language pull down lets you filter the list by a language. To
work with any taxonomy, select it. When you do, it appears within the View All
Categories of Taxonomy screen.

Viewing a Taxonomy
The View All Categories of Taxonomy screen exposes all categories in a
selected taxonomy. Use this screen to perform tasks on a taxonomy or one of
its categories, such as adding new categories, assigning content to a category,
and changing the order of items.

Note: On the View All Categories of Taxonomy screen, a box indicates the selected
Taxonomy/Category (see below).

To access the View All Categories of Taxonomy screen, follow these steps.

1. From the Ektron CMS400.NET Workarea, go to Content >
Taxonomies

2. Click on the top Taxonomy node to see all taxonomies.
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3. Use the language pull-down to select the language of the taxonomy
you want to work with.

4. Click a taxonomy. The View Taxonomy screen appears.

Alternatively, you can navigate the Taxonomy structure in the left panel, click a
taxonomy category, and select View Properties.

Tasks you can perform from this screen are listed below.
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Task How to initiate For more information, see

View Languages

Choose the language of the taxonomyyou
wish to view/change. Multi-Language Support for

Taxonomieson page 9-253

View Types

Choose the type of taxonomyyou wish to
view/change. Assigning a Taxonomy

Configuration on page 9-212

Add a taxonomycategory

1. Select the taxonomy/category under
which the new category should
appear.

2. Click the Add Category button( ).

Alternatively, hover the cursor over the
category, right click themouse, and select
Add Category.

Add a Category to a
Taxonomy/Categoryon page
9-237

Change the order of items
in a taxonomy/category

1. Select the taxonomy/category you
wish to reorder

2. Click the Reorder button ( ) from
the toolbar.

ChangeOrder of Categories
Assigned to a
Taxonomy/Categoryon page
9-240

Assign content items to a
category

1. Select the taxonomy/category to
which you wish to add items.

2. ClickAssign Items ( ) from the
toolbar.

Alternatively, right click the category and
chooseAssign Item(s).

Assigning Content to a
Taxonomy/Category on page
9-218

Assign folders to a
category

1. Select the taxonomy/category to
which you wish to assign folders.

2. ClickAssign Folders ( ) from the
toolbar.

Alternatively, right click the category and
chooseAssign Folder(s).

Assigning a Folder to a
Taxonomy/Categoryon page
9-221

Edit a taxonomy’s
properties ClickEdit toolbar button ( )

Edit a Taxonomy/Category’s
Fieldson next page
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Task How to initiate For more information, see

Export a taxonomy

Note:  This option
appears for
taxonomiesonly. It
doesnot appear when
viewing a category.

ClickExport Taxonomy toolbar button (
)

Exporting a Taxonomyon
page 9-242

Move/Copy taxonomy
category

Move or copya taxonomycategory to an
other taxonomyor category.

Copying andMoving a Tax-
onomyon the facing page

Delete a taxonomyor
category

ClickDelete toolbar button ( )

Alternatively, right click the category and
chooseDelete category name.

Deleting a Taxonomy from
View All TaxonomiesScreen
on page 9-236

Remove items (content,
folders, users or com-
munity groups) from a tax-
onomy/category

Select items then click RemoveContent from a Tax-
onomy/Categoryon page 9-
238

Edit a Taxonomy/Category’s Fields
To edit a Taxonomy’s fields, follow these steps.

Note: Only administrators or users to whom the Taxonomy Administrator role has been
assigned see the Content > Taxonomies option. See Also: Defining Roles on page 15-31

1. From the Workarea, go to Content > Taxonomies.

2. Select the taxonomy from the list of taxonomies.

Alternatively, hover the cursor over a taxonomy/category, right click the
mouse, and click View Properties.

3. Click the Edit button ( ).
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4. For a description of these fields, see Taxonomy Field Description on
page 9-207

Copying and Moving a Taxonomy
You can move any taxonomy category to any other taxonomy or category.
 There are two ways to do this.

n Copy/Move a Taxonomy Category using a Toolbar Button below

n Copy/Move a Taxonomy Category using Menu Options on next page

Copy/Move a Taxonomy Category using a Toolbar
Button

1. From the Content > Taxonomies area of the Workarea, open the
category that you want to move or copy.

2. Click the Move/copy button ( ).
3. A dialog appears. Select a taxonomy/category to which you want to

move/copy the current category.
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4. Click

n the right arrow ( ) to move the taxonomy/category to
the new location

n the copy button ( ) to copy the taxonomy/category to
the new location

Copy/Move a Taxonomy Category using Menu
Options

1. Right click a category.

2. Choose Cut category name or Copy category name.

3. Hover over the destination category

4. Click Paste Taxonomy.

Delete a Taxonomy/Category
There are two ways to delete a taxonomy or category.

n Deleting a Taxonomy from View All Taxonomies Screen below

n Deleting a Category from View All Categories Screen on the facing
page

After you delete a taxonomy, it can no longer be assigned to content and
folders. Further, existing links to content (via the Category tab) are deleted.
And, if a taxonomy was assigned to a folder (via the Folder Properties screen),
it is no longer assigned.

See Also: Deleting a Taxonomy in a Multi-Language Environment on page 9-254
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Deleting a Taxonomy from View All Taxonomies
Screen
Note: Only administrators or users to whom the Taxonomy Administrator role has been
assigned see the Content > Taxonomies option. See Also: Defining Roles on page 15-31

1. From the Workarea, go to Content> Taxonomies.

2. From the View All Taxonomies Screen, check the box to the left
taxonomy you want to delete.

3. Click the delete button ( ).

Alternatively, you can hover the cursor over a taxonomy/category in the left
panel, right click the mouse, and click Delete name.

Note: The delete button does not appear if the language selector is set to All.

Deleting a Category from View All Categories
Screen

1. From the Workarea, go to Content > Taxonomies.

2. Select a taxonomy from the list of taxonomies.

3. The taxonomy items and properties appear on the right.

4. Click the Delete button ( ).

5. A confirmation message appears. Click OK.

Add a Category to a Taxonomy/Category
Follow these steps to add a category to a taxonomy, or to add a subcategory to
a category.
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Note: Only administrators or users to whom the Taxonomy Administrator role has been
assigned see the Content > Taxonomies option.See Also: Defining Roles on page 15-31

1. From the Workarea, go to Content Tab > Taxonomy.

2. Select the taxonomy or category under which you want to create a
new category.

3. Click the Add button ( ) from the menu.
Alternatively, you can hover the cursor over a taxonomy/category in the left
panel, right click the mouse, and click Add Category.

4. The Add Category screen appears.

5. Complete the fields for the new category. See Also: Taxonomy Field
Description on page 9-207

6. Click the Save button ( ).

Remove Content from a Taxonomy/Category
Note: Only administrators or users to whom the Taxonomy Administrator role has been
assigned see the Content > Taxonomies option. See Also: Defining Roles on page 15-31

1. From the Workarea, go to Content > Taxonomies.

2. Select a taxonomy or category from the left panel.

3. Check the box to the left of content you want to remove.
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4. Click the Remove Items button ( ).

Remove Folder from a Taxonomy/Category
Note: Only administrators or users to whom the Taxonomy Administrator role has been
assigned see the Content > Taxonomies option. See Also: Defining Roles on page 15-31

n Background Information below

n Steps for Removing a Folder from a Taxonomy below

Background Information
If you assign a content folder to a taxonomy category, the internal relationship
is between the folder’s content and a taxonomy category. A folder is merely a
convenience for creating this relationship. There is no data connection between
a folder and a taxonomy category.

Therefore, if you delete a content folder from a taxonomy category, all content
in that folder remains assigned to it. To remove the folder’s content from the
category, see Remove Content from a Taxonomy/Category on previous page.

However, after deleting a content folder, the connection between the folder and
taxonomy category is broken. So, content subsequently added to the folder is
not assigned to the taxonomy.

Steps for Removing a Folder from a Taxonomy
1. From the Workarea, go to Content > Taxonomies.

2. Select the taxonomy or category that has the folder that you want to
delete.

3. From the View dropdown, select Folder(s).
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4. Check the box to the left of folders you want to remove.

Note: To remove all folders, check the box in the title bar.

5. Click the Remove Items button ( ).

Change Order of Categories Assigned to a
Taxonomy/Category
Note: Only administrators or users to whom the Taxonomy Administrator role has been
assigned see the Content > Taxonomies option. See Also: Defining Roles on page 15-31

You can reorder (that is, change the sequence of) the categories below a
taxonomy or one of its categories. Reordered subcategories appear only within
the Ektron CMS400.NET Workarea.

To reorder the categories assigned to a taxonomy or category, follow these
steps.

See Also: Add a Category to a Taxonomy/Category on page 9-237

1. From the Workarea, go to Content Tab > Taxonomy.

2. Select the taxonomy or category that has content that you want to
reorder.

3. Click the Reorder button( ).
4. Set the Type pull-down list to Category.

5. Select an item that you want to move up or down.

6. Click the up or down arrow to move the item in that direction.

7. Continue steps 5 and 6 until all content is in the desired order.

8. If there are several language versions of this taxonomy, you can
automatically reorder all versions. To do that, check Apply ordering
for all languages.
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9. Click the Save button ( ).

Change Order of Content Assigned to a
Taxonomy/Category
You can reorder (that is, change the sequence of) content within a category.
Reordered content appears within the Ektron CMS400.NET Workarea and can
appear on your Web site of the Directory server control’s ItemSortOrder
property is set to taxonomy_item_display_order.

To reorder the content assigned to a category, follow these steps.

Note: Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Content > Taxonomies option. See Also: Defining Roles on page 15-31

1. From the Workarea, go to Content > Taxonomies.

2. Select the taxonomy or category that has the folder that you want to
reorder.

3. Click the Reorder button( ).
4. Set the reorder pull-down list to items.

5. All items assigned to the category appear.
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6. Select a content block that you want to move up or down.

7. Click the up or down arrow to move the item in that direction.

8. Continue steps 6 and 7 until all content is in the desired order.

9. Click the Save button ( ).

Importing and Exporting a Taxonomy
You can export any taxonomy as an xml file. Then, you can reuse it or send it to
someone else, who would import it in order to bring a copy of it onto their
computer.

You can use the Export/Import feature like a “save as” feature. For example,
you want to create a taxonomy that is similar to an existing one but has some
differences. The easiest way to do this is to export an existing one, import it
under a new name, and edit it.

Below is an example of part of a taxonomy saved as an XML document.

<ArrayOfTaxonomyData xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">

<TaxonomyData>

<TaxonomyId>959</TaxonomyId>

<TaxonomyName>Bob Taxonomy</TaxonomyName>

<TaxonomyLanguage>1033</TaxonomyLanguage>

<TaxonomyLanguageName>English (U.S.)</TaxonomyLanguageName>

<TaxonomyDescription>Sample</TaxonomyDescription>

<Taxonomy>

<TaxonomyData>

<TaxonomyId>960</TaxonomyId>

<TaxonomyName>Subnode</TaxonomyName>

<TaxonomyLanguage>1033</TaxonomyLanguage>

<TaxonomyLanguageName>English (U.S.)</TaxonomyLanguageName>

<TaxonomyDescription />

<Taxonomy />

</TaxonomyData>

</Taxonomy>

</TaxonomyData>

</ArrayOfTaxonomyData>
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Exporting a Taxonomy
Exporting a taxonomy means saving it as an .xml file on your computer or
network drive. To export a taxonomy, follow these steps.

1. From the Workarea, go to Content > Taxonomies.

2. Select the language of the taxonomy that you want to export.

3. All taxonomies in that language appear.

4. Click a taxonomy that you want to export.

5. Click the Export Taxonomy button ( ).
6. You are prompted to select a folder into which to save it.

Importing a Taxonomy
1. From the Workarea, go to Content > Taxonomies > Taxonomies.

2. Click the Import Taxonomy button ( ).
3. The Import Taxonomy screen appears.

4. In the Title field, enter a name for your new taxonomy.

5. Click the Browse button.

6. Navigate to the taxonomy file you want to import.

7. The path appears in the Files field.

Note: Alternatively, you can enter or paste the xml into the XML box.

8. Determine the taxonomy’s configuration. See Also: Assigning a
Taxonomy Configuration on page 9-212

9. Click the Save button ( ).
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Note: If you assign a name that is already given to a taxonomy, Ektron CMS400.NET appends
a number to the title, beginning with 1.

Assigning Custom Properties to a
Taxonomy
Custom properties let you extend the functionality of taxonomies by creating
custom fields to capture additional information. Custom properties act like
metadata for taxonomies and categories.

For example, your organization manages a nationwide chain of retail stores.
You create a Sales Region taxonomy, where each category represents a
different geographic region. Sample categories are northeast, southeast,
midwest (as shown below).

You could create a custom taxonomy property named Regional Manager and
use that to create a list of regional managers.
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Next, access each region, click the Custom Properties tab, and apply a
manager to the region.

This section also contains the following topics.

Creating Custom Taxonomy Properties 9-245
Editing a Custom Taxonomy Property 9-248
Deleting a Custom Taxonomy Property 9-249
Changing the Order of Custom Taxonomy Property Values 9-249
Multiple Language Support for Custom Taxonomy Properties 9-250

Translating a Custom Taxonomy Property into Another Language
9-
251

Note: Only members of the Administrator User Group can work with custom taxonomy
properties.

Creating Custom Taxonomy Properties
To create a custom taxonomy property, follow these steps.

1. Go to the Settings > Configuration > Custom Properties
screen.

2. Select the language of the new custom property. You will only be able
to apply the custom property to taxonomies/categories in this
language.

3. From the ObjectType pulldown, click TaxonomyNode (shown
below).

4. Click the Add button ( ).
5. The Add Custom Property screen appears.
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6. Use the table below to complete the screen.

Field Description

Name

Enter the custom property name. The name identifies the custom property on the Edit Taxonomy
screen'sCustom Properties tab (see image below).
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Field Description

Editable

Check this box to allow the user who is applying this custom property to choose a value or edit the
default value.

Uncheck the box if the user cannot choose or edit the value. In this case, he is only applying the
property. If a property isnot editable and has several values (type string: select from list
or boolean), only the first or selected value is applied to the property.

Example of an Editable Custom Property

Assume youmanage auto parts storesand want a custom taxonomyproperty to indicate if a car
can be repaired at a facility. You create a property namedRepair Services Available, andmake
it boolean and editable. Then, the person applying that custom property to a taxonomycategory
can chooseYes or No to indicate if repair servicesare available.

Enabled
Check this box if this property can be applied to taxonomycategories.

If you uncheck this box, this property doesnot appear on the Edit Taxonomyscreen'sCustom
Properties tab.

Data
Type

Four choices

n String - a series of characters

n Boolean - true (yes) or false (no)

n Numeric - a series of numbers

n Date - one or more dates selected from a calendar popup screen
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Field Description

Display
Type/

Value

Note:  If the Data Type is boolean, select either Yes or No.

If the Data Type isString,Numeric or DateTime, you have two choices.

n Select a single value - the property accepts only one value

n Select from a list - the property accepts several values.When you choose this option, a lower
field appears.

In the top field, insert a value then click theAdd button ( ). When you do, the valuemoves to the
lower field. Continue until all valuesare entered.

If you want to edit the order of the values, use the up/down arrows (circled above).

Note:  IfEditable is checked and you insert several values, the user applying the custom
property can choose the value. IfEditable is not checked, the first value is applied to the
custom property.

7. Click the Save button ( ).

Editing a Custom Taxonomy Property
Follow these steps to edit a custom taxonomy property.

1. In the Workarea, click Settings > Configuration > Custom
Properties.

2. Select the language of the custom property.

3. From the ObjectType pulldown, click TaxonomyNode (shown
below).

4. Click the Title of the custom taxonomy property you want to edit.

5. The Edit Custom Property screen appears.

6. Move to the field you want to change. You can edit these fields:

n Name

n Editable

n Enabled
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n Value

For descriptions of these fields, see Use the table below to complete the
screen. on page 9-246

Note: You cannot edit the ID, Language, CMS Object Type, Data Type, or Display Type
fields. If you need to change these fields, delete the custom property and create a new one.

7. Click the Save button ( ).

Deleting a Custom Taxonomy Property
If you delete a custom taxonomy property

n it remains assigned to all taxonomy categories to which it is assigned

n it can no longer be assigned to additional taxonomy categories

Follow these steps to delete a custom taxonomy property.

1. In the Workarea, click Settings > Configuration > Custom
Properties.

2. From the ObjectType pulldown, click TaxonomyNode (shown
below).

3. Select the language of the custom property.

4. Click the Title of the custom taxonomy property you want to delete.

5. Click the Delete button ( ).

6. A dialog box asks you to confirm .

7. Click OK.

Changing the Order of Custom Taxonomy
Property Values
From the Edit Custom Property screen, you can change the order in which the
values appear on the Custom Properties tab (see example below)
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To set the order of values in a custom taxonomy property, complete these
steps.

1. In the Workarea, click Settings > Configuration > Custom
Properties.

2. From the ObjectType pulldown, click TaxonomyNode (shown
below).

3. Select the language of the custom property.

4. Click the Title of the custom taxonomy property.

5. In the values field at the bottom of the screen, select the item(s) to
reorder.

6. Click the Up or Down arrows to move the value up or down.

7. Click the Save button ( ).

Multiple Language Support for Custom
Taxonomy Properties
Like most Ektron CMS400.NET objects, custom taxonomy properties have a
language attribute. Each taxonomy also has a language. You can only apply
custom properties to a taxonomy if their languages match.
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Translating a Custom Taxonomy Property into
Another Language
When creating a custom property, you select its language. See Also: Creating
Custom Taxonomy Properties on page 9-245 This section describes the
procedure for saving a custom taxonomy property in a different language. The
new version uses the same ID number as the original language version. You
can change the following fields from the original.

n Name

n Editable

n Enabled

n Data Type

n Display Type

n Value

For descriptions of these fields, see Use the table below to complete the
screen. on page 9-246

Once you create the new language version, it is no longer linked to the original
language version. For example, if you edit or delete the original language
version, that action has no effect on the new language version.

The following steps explain how to create a custom taxonomy property in
another language.

1. In the Workarea, click Settings > Configuration > Custom
Properties.

2. Select the language of the custom property.

3. From the ObjectType pulldown, click TaxonomyNode (shown
below).

4. Click the Title of the custom taxonomy property to be created in
another language.

5. From the Add pulldown, select the language in which you want to
create the custom property.
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Note: The Add dropdown shows enabled languages for which this custom property does not
already exist.

6. Information from the original language property fills the screen as
default values. Edit them as desired.

7. Click the Save button ( ).

Displaying a Content Item Taxonomy
Search on your Web Site
When your Web developer places a Directory server control on a Web page, he
can use the Enable Search property to include a Search box with the
taxonomy display (circled below). See Also: EnableSearch on page 9-261

The box helps site visitors find content by returning only items that include a
search phrase and are assigned to a selected category.

When placing a Directory server control, your Web developer defines a
Taxonomy ID number. The ID determines the top level of the taxonomy that
appears below the Search box, to the right of Breadcrumb. Below that are
categories that exist directly below that Taxonomy.

Using the Taxonomy Search
To use the search, a site visitor enters a search term and clicks the Directory
radio button (above the Search box). The screen may return links in two areas
below Breadcrumb.

n Category - all categories below the selected level with content that
includes the search term. Click a category to see a list of content that
includes the search term in that taxonomy/category level or one of
its subcategories.

n Articles - content within the currently selected taxonomy/category
level that includes the search term
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As illustrated below, within the Editor category, one category (eWebEditPro)
includes content with the word library. And, one content block (The best
Microsoft Word content processing) includes library.

Multi-Language Support for Taxonomies
This section explains of how Taxonomy is supported in a multi-language
environment.

This section also contains the following topics.

Creating a Taxonomy in a Multi-Language Environment 9-253
Upgrading and Multi-Language Taxonomy Support 9-254

Enabling Synchronization of Taxonomies Prior to 7.6.5 Upgrade
9-
254

Deleting a Taxonomy in a Multi-Language Environment 9-254

Enabling/Disabling a Language in a Multi-Language Environment
9-
255

Taxonomy Properties in a Multi-Language Environment 9-255
Assigning Content to a Multi-Language Taxonomy 9-255
Removing Content from a Multi-Language Taxonomy 9-256
Effect of Multi-Language on Folder’s Taxonomy Properties 9-256
Assigning Folders to a Multi-Language Taxonomy 9-257
Removing Folders from a Multi-Language Taxonomy 9-257
Reordering Content in a Multi-Language Taxonomy 9-257
Reordering Categories in a Multi-Language Taxonomy 9-258

Creating a Taxonomy in a Multi-Language
Environment
When you create a new taxonomy, you select a language. At that point, a
version of that taxonomy is also created for each enabled language.
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For example, you create a taxonomy in English, and French and Spanish are
also enabled (in the Settings > Language Settings screen). Ektron
CMS400.NET now has versions of that taxonomy in English, French, and
Spanish. The ID of each taxonomy is the same, but the language ID is different.
You do not need to use all language versions.

The three versions now linked and cannot be unlinked. So, for example if you
assign a category to the English taxonomy, that category is also assigned to the
French and Spanish versions. Of course, since the text is English, it will
probably have to be translated. See Also: Using the Language Export Feature on
page 14-14

Upgrading and Multi-Language Taxonomy
Support
As of version 7.6.5, any new taxonomies are synchronized. That is, if you
create a taxonomy in English, one is created with the same taxonomy ID but a
different language ID in all other enabled languages. And, if you add categories
to one language taxonomy, those categories are automatically added to the
other language versions of that taxonomy.

Previously, CMS400.NET allowed multiple language versions of a taxonomy, but
changes to one language did not affect the language-related versions. If your
Ektron CMS400.NET has such versions, the 7.6.5 upgrade does not synchronize
your taxonomy. Furthermore, no additional versions of that taxonomy will be
created in other enabled languages. Ektron assumes that, since taxonomies in
those languages already exist, you want to keep them as they are. So, for
example, assume you created a taxonomy in a previous version of Ektron
CMS400.NET in English and Spanish. The upgrade does not synchronize them.

Enabling Synchronization of Taxonomies Prior to
7.6.5 Upgrade
Suppose that, after the 7.6.5 upgrade, you want to transform an
unsynchronized taxonomy to a synchronized multi-language taxonomy, so that
changes to one are automatically reflected in the others. To accomplish this,
upgrade to 7.6.5 and delete the Spanish version. At that point, a version of that
taxonomy will be created for every enabled language and synchronized with the
English version. You now have the option of translating category names
manually or exporting the taxonomy, translating it and then importing back in.
See Also:

Deleting a Taxonomy in a Multi-Language
Environment
If you delete a taxonomy, all related language versions are also deleted.
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Enabling/Disabling a Language in a Multi-
Language Environment
If you enable a new Workarea language, a version of every taxonomy created
in version 7.6.5 and above is automatically created in that language.

If you disable a language, all of its taxonomies are deleted.

See Also: Determining Which Languages are Available on page 14-6

Taxonomy Properties in a Multi-Language
Environment
Initially, all related-language versions of a taxonomy take their properties from
the original language version. For example, if you create a taxonomy in English
and French is also enabled, the French Taxonomy description is the same as the
English one, as are the taxonomy image, taxonomy template, value of
Display? checkbox, etc.

However, after the initial creation of the multiple-language versions, changes
to taxonomy properties affect the current language only -- they do not affect
the related-language versions.

Exception - When you edit the taxonomy Display? property, you are prompted
to apply the change to all languages or the current language only. See Also:
Display? on page 9-208

Assigning Content to a Multi-Language
Taxonomy
Ektron CMS400.NET supports multiple language versions of content, as shown
below.

As you can see, Content ID=35 exists in English and Spanish.

When applying content to a taxonomy category, you can only apply content
whose language matches the taxonomy language. If that content exists in other
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languages, the related-language version is also applied to the related-language
taxonomy.

So, to continue the above example, assume there is a taxonomy in English and
you apply content item ID=30, Sample Content Block to one of its
categories. If that taxonomy exists in German, the content block titled Ektron
CMS400.NET Server Kontrollen (also ID=30) is applied to the corresponding
category in the related German taxonomy.

If there is no corresponding German content, nothing is applied to the German
taxonomy category.

Removing Content from a Multi-Language
Taxonomy
If you remove content from a taxonomy in any language, it is removed from all
language-related taxonomies.

Effect of Multi-Language on Folder’s
Taxonomy Properties
If there are several language-related versions of a taxonomy and you select
one of them then edit a folder’s taxonomy properties, content in the related
language inherits the taxonomy folder properties.

For example, assume I select English, then edit a folder’s taxonomy properties
and apply taxonomy categories. See Also:

If I later edit French content in that folder, the corresponding French
taxonomy’s categories are available to be assigned via the Category tab.

Further, the value of the At least one category is Required check box is
also inherited. This means that if a category must be applied to English content,
it is also required for French content.
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Assigning Folders to a Multi-Language
Taxonomy
When you assign a folder to a taxonomy category, you indicate that all folder
content is assigned to that node. Ektron CMS400.NET folders are language-
neutral, so the folder is also applied to the corresponding taxonomy category in
every language. However, only folder content that matches the taxonomy’s
language is assigned to the taxonomy category.

So, for example, a folder has three content blocks.

Language Content in folder in this language

English

n 100

n 101

n 102

German n 100

If you apply that folder to a taxonomy, the English version of the taxonomy has
three content blocks assigned, but the German version only gets one content
block (ID 100).

If content is later added to the folder, new English content is assigned to the
English taxonomy, and new German content is assigned to the German
taxonomy.

Note: If you apply a folder to a taxonomy, numbers on the View Taxonomy screen indicate
how many content items are applied to it. Unless you have the same number of content items
in each language, this number is different for every language.

Removing Folders from a Multi-Language
Taxonomy
If you remove a folder from its assignment to a taxonomy category, the
content in that folder is still applied. So, you must also remove all of its
content, as described in Removing Content from a Multi-Language Taxonomy on
previous page.

Reordering Content in a Multi-Language
Taxonomy
If you reorder the content assigned to a taxonomy category, there is no change
to corresponding categories in other languages. This is because there is no
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guarantee that content that exists in one language exists in the other languages.

Reordering Categories in a Multi-Language
Taxonomy
If you reorder categories assigned to a Taxonomy/Category, you have the
option of applying the changes to all language-related categories (see below).

Using Taxonomies with Social
Networking
If you have a community or social networking Web site, you can assign users
and community groups to a taxonomy. This allows site visitors to search for
users and groups by category.

To enable a taxonomy-based search of users and community groups, a
developer uses the following server controls on your site.

n CommunityGroupBrowser control - lets a site visitor browse a
taxonomy category for community groups

n CommunitySearch control - lets a site visitor search for users and
community groups based on selected criteria

See Also:

n CommunitySearch Server Control on page 16-256

n CommunityGroupBrowser Server Control on page 16-96

n Assigning a Taxonomy/Category to a Community Group on page 9-
222

Directory Server Control
The Directory server control lets you customize the behavior of the Taxonomy
feature. You place this control on any Web form to display a taxonomy. For
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more information about the site visitor experience with Taxonomy, see
Taxonomy on page 9-202.

Improving Taxonomy Performance
To minimize taxonomy’s impact on the performance of your production server,
follow these guidelines.

n Use the default page size (50). If you need to customize page size,
use Ektron CMS400’s API, but do not increase it above 800.

n For large databases, do not increase the value of the TaxonomyDepth
property above 1. Changing this value dramatically slows down your
production server’s performance. However, you can increase depth
on your staging server for testing purposes.

Directory Server Control Properties
The Directory server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Response Data Type

AddItemFolderID

Define the Ektron CMS400.NET folder ID where content is stored
when an item is added to the taxonomyvia the Add Asset link or the
Add Content link. To enable adding content itemsvia the Directory
server control, youmust use an EkML file with the [$AddAsset]

and [$AddArticle]variables. See Also: taxonomy.ekmlon page
26-59

Long

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer
to Browse Your Ektron CMS400.NET Site on page 24-8

String

CacheInterval

Sets the amount of time, in seconds, the server control’s data is
cached. The default is 0 (zero).

For example, to cache data for fiveminutes, set this property to 300.

See Also: Caching with Server Controlson page 24-33

Warning! If the EnablePagingproperty is set to True, the
CacheIntervalproperty is disabled.

Double
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Property Response Data Type

DisplayXslt

If you want to use an XSLT to control the display of the directory
server control on this page, enter the path to the XSLT file.

Warning! If you specify an external file, it is strongly
recommended that you do not store this file in your site'sWorkarea
folder. If you store this file in theWorkarea folder, the file will be lost
when you upgrade.

Warning! If you enter a valid EkML file at the MarkupLanguage
property, the Displayxsltproperty value is ignored.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes shown.

Boolean

DynamicParameter Gets or sets the QueryString parameter to read a content ID
dynamically. String

EnableAjax

Set to true to enable Ajax searches.When enabled, the
MaxResultsproperty determines themaximum number of results
per page.

True =Enable AjaxSearch (default value)

False =OriginalHTMLSearch

Boolean

EnablePaging

This property, in conjunction with the MaxResultsproperty, lets site
visitors view an unlimited number of taxonomy itemswhile
controlling the amount of screen space. To accomplish this, the
taxonomydisplay is limited to the number set in the MaxResults
property.

If you set this property to true (the default), and the number of
taxonomy itemsexceedsMaxResults, navigation aidsappear
below the last item. The site visitor uses them to view additional
items. See example below.

So, for example, if a taxonomyhas9 itemsand MaxResults is set to
3, the screen displaysonly the first three items.When the site visitor
clicks [Next], he sees items4, 5 and 6, etc.

Warning! If the EnablePagingproperty is set to True, the
CacheIntervalproperty is disabled.

Boolean
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Property Response Data Type

EnableSearch

Set to true if you want a search box (shown below) to appear above
this taxonomydisplay. A site visitor can use the search to find
content within a taxonomy/category that includes termsof interest.

To suppress the search box, set to false.

Boolean

GetAnalyticsData

Set this property to True if you want the following information for
each content in the list.

ReturnsContent View Count,Content Rating,Content
Rating Average.

Create your own XSLT styles to display this data.

Warning! This property only provides reliable data when the
BusinessAnalyticsFeature is on.Enabling the BusinessAnalytics
Feature on page 7-748.

Boolean

Hide

Used to hide the directory control in design time and run time.

True =Hide Sitemap trail

False =Show Sitemap trail

Boolean

IncludeIcon

Choose whether to display iconsnext to the taxonomy’s links.

Warning! This property onlyworkswhen ecmSummaryor
ecmTeaser are used in the DisplayXsltproperty.When the
[$ImageIcon]variable is used in an EkML file and that file is
assigned to the MarkupLanguageproperty, this property acts as
True.

True =Show icons

False =Hide icons

Boolean

Directory Server Control Properties

ReferenceManual
Version 8.01 Rev 4

9-261



Property Response Data Type

OrderItemsBy

Specify the sort order of results. Choicesare:

taxonomy_item_display_order - the order of taxonomy itemsas
set in theWorkarea. For additional information, seeChangeOrder
of Content Assigned to a Taxonomy/Categoryon page 9-241.

content_title - the content is listed in alphabetical order by title.

date_created - content is listed in the order bywhich it was created.

last_edit_date - content is listed in order by its last edit date.

content_rating_average - BusinessAnalyticsContent Rating

content_view_count - BusinessAnalyticsContent Views

You can specify the direction of the itemswith the SortDirection
property.

Language Set a language for viewing content. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

LinkTarget

Defines the waya link actswhen it is clicked. The choicesare:

_blank - loads the link in a new blankwindow. Thiswindow is not
named.

_self - loads the link in the samewindow the anchor was clicked in.
This is useful for overriding a globally assigned base target.

_parent - loads the link in the immediate frameset parent of the
document. This defaults to acting like “_self” if the document hasno
parent.

_top - loads the link in the full bodyof the window. This defaults to
acting like “_self” if the document is alreadyat the top. It is useful for
breaking out of an arbitrarily deep frame nesting.

ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the display of the
taxonomy. For example, mytaxonomymarkup.ekml.

If the .ekml file is located in the same folder as theWeb form
containing the server control, just enter its name. If the file is in
another folder, enter the path relative to site root. For example,
..\workarea\customfiles\markup\mytaxonomymarkup.ekml
.

This property is blankbydefault. If nothing is entered, the following
EkML file is used:

\[siteroot]\workarea\template\taxonomy\taxonomy.ekml

See Also:Controlling Output with EktronMarkup Language on
page 26-1and taxonomy.ekmlon page 26-59

Note: If you enter a valid EkML file, the DisplayXsltproperty
value is ignored. If the EkML file contains the [$ImageIcon]
variable, the IncludeIconsproperty acts asTrue.

String
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Property Response Data Type

MaxResults

Enter themaximum number of items to appear in the initial display of
this server control.

Note:  If you set this value to zero (0), themaximum is 50.

To let site visitors view more than themaximum but limit the amount
of space being occupied, enter themaximum number of results per
page here. Then, set the EnablePagingproperty to true.

If you do andmore than the number of MaxResultsare available,
navigation aidsappear below the last item to help the site visitor view
additional items. See example below.

Integer

PreserveUrlParameters

Set to true if this control needs to preserve the URL parameters on
the page. For example, if a server control displaysa list of content
items, the URL parameter passes to the control the template names
and idvalues that the template expects.

Set to false if the server control doesnot need to pass the URL
 parameters to the server control.

The default value isfalse.

Boolean

Recursive Set to True to include child folders of the parent folder. Boolean

ShowAllChecked When set to True, a checkboxappears in the Show All checkbox. Boolean

ShowCount

Indicates if the number of taxonomy itemsappears next to each
categorywhen displayed in theWeb site. (See example below.)

Default value is false.

Boolean
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Property Response Data Type

ShowRoot

Set to False if you want Top to represent the first node of the
taxonomypath.

Set to True if you want the name of the first node of the taxonomy
path to appear instead of Top.

Boolean

SortDirection Select the direction of the ItemSortOrderproperty. Choose
Ascending or Descending. String

TaxonomyCols Enter the number of columns in which this taxonomy/categorywill
appear on the page. Integer

TaxonomyDepth

Enter the number of taxonomy levels to retrieve below each
taxonomy/category if you are accessing a taxonomy’sXML using
code behind. For example, if the taxonomy isBusinesses >
Restaurants > Pizza, and you set Taxonomy Depth to 2, only
Businessand Restaurants are available in code behind.

This setting hasno effect on the display generated by the Directory
server control, which alwaysdisplaysonly one level below the
current.

To retrieve all categories for a taxonomy recursively, enter -1.

The default value is 1.

Warning! For a live site, Ektron strongly recommends leaving this
value at 1. Increasing this value can slow down your liveWeb
server. However, for testing on a staging server, you can increase
the depth.

Integer

TaxonomyId
Enter the ID number of the taxonomyor category to appear in this
server control. If you don’t know the number, click the button and
navigate to the taxonomyor category.

Long

TaxonomyItemCols Enter the number of columns in which this taxonomy/category items
(articles) will appear on the page. Integer
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Property Response Data Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

Custom - Allowsyou to use a custom tag.

String
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ListSummary Server Control
The ListSummary server control is used to display, on a Web page, a list of
content blocks in a selected folder. Optionally, the display can include content in
all subfolders of the selected folder.

When added to a template and visited, a List Summary looks like this.

It displays each content block’s title and summary information. You can modify
the display to suit your needs by modifying its properties.

This section also contains the following topics.

ListSummary Server Control Properties 9-266
Retrieving the XML Structure of a List Summary 9-274

Note: In contrast to a List Summary, a ContentList server control displays selected content
items from any CMS400.NET folder. See Also: ContentList Server Control on page 7-202

ListSummary Server Control Properties
The ListSummary server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Description Data Type

AddText

Override the control’s default text for the Add Content
menu item.
For example, you have a NewsWeb site. You could
change Add Content toAdd News Item.

String

Authenticated

Indicates if you are logged in to the CMSExplorer and
can use it to browse to the folder needed for the
FolderID property.

See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

String

CacheInterval

Sets the amount of time the server control’s data is
cached. The default is 0 (zero). This is the amount of
time, in seconds, a control’s data is cached. For
example, if you want to cache the data for fiveminutes,
set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Warning! If the EnablePaging
property is set to True, the CacheIntervalproperty
is disabled.

Double

ContentParameter
Checks theQueryString for this value and replaces the
list summarywith a content blockwhen specified.
Leave blank to alwaysdisplay the list summary.

String

ListSummary Server Control Properties

ReferenceManual
Version 8.01 Rev 4

9-267



Property Description Data Type

ContentType

Determines the type of content that appears in the list
summary. The default isContent. Choicesare:

AllTypes - displaysall of the content types for the
given folder

Content - displaysa list of content items. Content
itemsconsist of HTML content, PageBuilder pages,
XML Smart Formsand Blogs

Forms - formsappear in the list summary

Archive_Content - archived content blocksappear
in the list summary

Archive_Forms - archived formsappear in the list
summary

Assets - assets, such asofficesdocuments, appear in
the list summary

Archive_Assets - archived assets appear in the list
summary

LibraryItem - library itemsappear in the list summary

Multimedia - multimedia itemsappear in the list
summary

Archive_Media - archivedmultimedia itemsappear
in the list summary

NonLibraryContent - all typesof content appear in
the list summaryexcept for library items.

DiscussionTopic - forum topics appear in the list
summary.

CatalogEntry - displaysall of catalog entries
(products) for a specified catalog.

String
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Property Description Data Type

DisplayXslt

Determineshow the information on the page is
displayed

None-databind only

ecmNavigation - lists the title of every content block in

the folder

See Also:Example of ecmNavigation Displayon page
9-127

ecmTeaser - lists the title of every content block in the
folder plus the content summary

See Also:Example of ecmTeaser Displayon page 9-
128

Path to Custom Xslt - Enter the path to an Xslt that
determines the display of the page

Warning! If you specify an external file, it is strongly
recommended that you do not store this file in your
site'sWorkarea folder. If you store this file in the
Workarea folder, the file will be lost when you
upgrade.

Warning! If you enter a valid EkML file at the
MarkupLanguageproperty, the Displayxslt
property value is ignored.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set
to false if you want to postpone the fill-action until
later. In this case, FIll is automatically called during the
Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean
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Property Description Data Type

EnablePaging

This property, in conjunction with the MaxResults
property, lets site visitors view an unlimited number of
List Summary itemswhile controlling the amount of
screen space. To accomplish this, the List Summary
display is limited to the number set in the MaxResults
property.

If you set this property to true, and the number of List
Summary itemsexceeds the MaxResultsnumber,
navigation aidsappear below the last item. The site
visitor uses the aids to view additional items. See
example below.

So, for example, if a List Summaryhas9 itemsand the
MaxResultsproperty is set to 3, the screen displays
only the first three items.When the site visitor clicks
[Next], he sees items4, 5 and 6, etc.

True =Use paging feature

False = Ignore paging feature

Warning! If the EnablePagingproperty is set to
True, the CacheIntervalproperty is disabled.

Boolean

FolderID

The folder that contains the itemswhich appear in the
list summary. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

The Recursiveproperty determineswhether content
blocks in this folder’s child folders also appear.

Long

GetHtml

Set to True if you want to retrieve and display content
(that is, the HTML body) for all content in the list
summary. For example, to display content inside a
Web server control such asaGridView.

True =Get and displayHTML for each content block in
the list summary

False =Do not get and displayHTML.

Boolean
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Property Description Data Type

GetAnalyticsData

Set this property to True if you want the following
information for each content in the list.

ReturnsContent View Count,Content Rating,
Content Rating Average.

Create your own XSLT styles to display this data.

Warning! This property only provides reliable data
when the BusinessAnalyticsFeature is on.Enabling
the BusinessAnalyticsFeature on page 7-748.

Boolean

Hide

Used to hide output of the list summary in design time
and run time.

True =Hide results

False = show results

Boolean

IncludeIcons

Choose whether to display iconsnext to the list
summary’s links.

Warning! This property onlyworkswhen
ecmSummaryor ecmTeaser are used in the
DisplayXsltproperty.When the [$ImageIcon]
variable is used in an EkML file and that file is
assigned to the MarkupLanguageproperty, this
property acts asTrue. See Also:Controlling Output
with EktronMarkup Language on page 26-1

Boolean

Language
Set a language for viewing the list summary. This
property shows results in design-time (in Visual
Studio) and at run-time (in a browser).

Integer
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Property Description Data Type

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe
loaded in a new blankwindow. Thiswindow is not
named.

_self - This target causes the link to always load in the
samewindow the anchor was clicked in. This is useful
for overriding a globally assigned base target.

_parent - This target makes the link load in the
immediate frameset parent of the document. This
defaults to acting like “_self” if the document hasno
parent.

_top - This target makes the link load in the full bodyof
the window. This defaults to acting like “_self” if the
document is alreadyat the top. It is useful for breaking
out of an arbitrarily deep frame nesting.

String

MarkupLanguage

Identify the templatemarkup file that controls the
display of the list summary. For example,
mylistsummary.ekml.

If the *.ekml file is located in the same folder as the
Web form containing the server control, just enter its
name. If the file is in another folder, enter the path
relative to page hosting this control. For example,
\CMS400Developer\workarea
\Customfiles\markup\

mylistsummary.ekml See Also:Controlling Output
with EktronMarkup Language on page 26-1 and
listsummary.ekmlon page 26-38

Note: If you enter a valid EkML file, the
DisplayXsltproperty value is ignored. If the
EkML file contains the [$ImageIcon]variable, the
IncludeIconsproperty acts asTrue.

String
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Property Description Data Type

MaxResults

Enter themaximum number of items to appear in the
initial display of this server control.

If you enter no value or 0 (zero), themaximum is 250.

To let site visitors view more than themaximum but
limit the amount of space being occupied, enter the
maximum number of results per page here. Then, set
the EnablePagingproperty to true.

If you do andmore than the number of MaxResults
are available, navigation aidsappear below the last
item to help the site visitor view additional items. See
example below.

Integer

OrderbyDirection

How to order the hyperlinkson the list.

The sort field is determined by the OrderKeyproperty.

ascending - hyperlinksare arranged A, B, C or 1,2,3.

descending - hyperlinksare arranged Z, Y, X or
3,2,1

If sorting bydate, descending puts themost recent
first.

Ektron.Cms.Controls.
CmsWebService.
OrderByDirection

OrderBy

Note:  For releases8.0.1 and above, the
OrderKey property hasbeen deprecated. It has
been replaced by thisOrderByproperty.

Sort the list by one of the values.

Title - Content Title

DateModified - Date content last modified

DateCreated - Date content created

LastEditorFname - First name of user who last
edited content

LastEditorLname - Last name of user who last
edited content

Start Date - Go Live date of content

Rated - BusinessAnalyticsContent Rating

ContentViewCount - BusinessAnalyticsContent
Views

ListSummaryServer Control Propertieson page 9-
266

Ektron.Cms.Controls.
CmsWebService.
TeasersOrderBy
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Property Description Data Type

Random

Set to True if you want to randomlydisplay one
content block in the specified folder. The content
changeseach time a user views the page.

True - randomlydisplay one content block.

False - display the list summarynormally.

Note: If you use a customXSLT or EkML file, the
type of content displayed can bemanipulated. For
example, if you use an EkML file that has the
[$Html] variable in it, the actual content is displayed
instead of a link. See Also:Controlling Output with
EktronMarkup Language on page 26-1 and
[$Html] on page 26-17

Boolean

Recursive

Determines if the display includes content blocks in
child folders of the selected folder.

True - include content blocks from child folders.

False - do not include content blocks from child
folders.

Boolean

SelTaxonomyID

Set the ID of the taxonomy that content will be
associated with when a logged in site visitor uses the
Silver AccessPoint’sAdd HTML Content to add
content to a list summary server control.

Integer

SuppressWrapperTags
This property is set to false because Ajaxuses<div>
tags to rewrite the region around the tag. You cannot
change the value to true.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline
portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply
attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

Retrieving the XML Structure of a List
Summary
Retrieving the XML structure of XML content allows for greater control over
developing XSLs. The following is an example of how to retrieve the XML
structure:

1. Open a new Web form.

2. Drag and drop a ListSummary server control onto it.
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3. Set the FolderID property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: Ektron recommends setting the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = ListSummary1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

9. The list summary’s XML structure appears in the textbox.

For an additional example, see the ListSummary XML page on the
CMS400Developer samples page. It is located

In a browser:

http://<site root>/CMS400Developer/Developer/ListSummary/ListSummaryXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/ListSummary/ListSummaryXML.aspx and
ListSummaryXML.aspx.vb

Retrieving the XMLStructure of a List Summary
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Breadcrumbs
A breadcrumb is display of the trail a site visitor took to arrive at the page.
Breadcrumbs are commonly found on Web sites to help navigate the site. For
example, a simple text breadcrumb such as Products->Monitors->Flat
Panel shows that you arrived at this page by clicking Products, then
Monitors, then Flat Panel.

This section also contains the following topics.

Sitemap Breadcrumbs versus History Breadcrumbs 9-276
Creating SiteMap Breadcrumbs 9-276
BreadCrumb Server Control 9-283
FolderBreadcrumb Server Control 9-292
SiteMap Server Control 9-296

Sitemap Breadcrumbs versus History
Breadcrumbs
Ektron CMS400.NET provides two kinds of breadcrumbs:

n sitemap

n history

Sitemap breadcrumbs display the path through the sitemap to the current page,
like the path shown in a Yahoo! directory listing. Sitemap breadcrumbs always
show the same path to a page, regardless of how it is reached. To use a sitemap
breadcrumb, see Creating SiteMap Breadcrumbs below.

History breadcrumbs more accurately fulfill the breadcrumb trail metaphor.
They display a history of links to the most recently visited pages. The
BreadCrumb server control displays history breadcrumbs. Site visitors can use
a breadcrumb trail to jump to previously visited pages. To user history
breadcrumbs, see BreadCrumb Server Control on page 9-283.

Creating SiteMap Breadcrumbs
Use the Breadcrumb tab to define a folder’s site map or to inherit one from the
parent folder. Below is an example.
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The following topics explain how to create and manage sitemap Breadcrumbs
within the Workarea. BreadCrumb Server Control on page 9-283 explains how
to place them on a Web page.

n Inheritance and Breadcrumbs below

n Adding a Breadcrumb below

n Reordering Breadcrumb Items on page 9-279

n Editing a Breadcrumb Item on page 9-281

n Removing a Breadcrumb Item on page 9-282

Inheritance and Breadcrumbs
A folder’s breadcrumbs can be inherited from the parent folder, or you can
break inheritance and assign a path of breadcrumbs. Use the Folder Properties
screen’s Inherit Parent Configuration checkbox to retain or break
inheritance.

Adding a Breadcrumb
The example below adds three breadcrumbs to the trail.

1. Navigate to the folder for which you want to add the breadcrumbs.

2. On the View Contents of Folder screen, click View > Properties.

3. Click the Edit Properties button ( ).
4. Click the Breadcrumb tab.

5. The Edit Breadcrumbs screen appears.

Inheritance and Breadcrumbs
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6. In the Add New Item section of the screen, add the following
information.

n Title - the name of the breadcrumb as you want it to appear in the
breadcrumb trail

n URL Link - the URL path to the breadcrumb’s destination, typically a
Ektron CMS400.NET content item. For example, default.aspx.

If you are not sure what the file’s name is, click the Binoculars ( ),
and the library for quicklinks appears. Select the content item to add
to the breadcrumb.

You can also enter a URL, for example, www.example.com.

n Description - add a description for the breadcrumb

7. Click the Add button.

8. The first item in the breadcrumb path appears.
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9. Repeat steps 6 and 7 for each item in the breadcrumb path.

10. The items in the breadcrumb now appear like this.

11. Click the Save button ( ).

Reordering Breadcrumb Items
1. Navigate to the folder for which you want to reorder breadcrumbs.

Reordering Breadcrumb Items
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2. On the View Contents of Folder screen, click View > Properties.

3. Click the Edit Properties button ( ).
4. Click the Breadcrumb tab.

5. The Edit Breadcrumbs screen appears.

6. Click a breadcrumb item.

Warning! Clicking the Remove button deletes the breadcrumb item. See Also: Removing a
Breadcrumb Item on page 9-282.
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7. Click the green Up and Down buttons to move the item around in the
list.

8. Click the Save button ( ).

Editing a Breadcrumb Item
1. Navigate to the folder for which you want to edit breadcrumbs.

2. On the View Contents of Folder screen, click View > Properties.

3. Click the Edit Properties button ( ).
4. Click the Breadcrumb tab.

5. The Edit Breadcrumbs screen appears.

Editing a Breadcrumb Item
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6. Click a breadcrumb item.

Warning! Clicking the Remove button deletes the breadcrumb item. See Also: Removing a
Breadcrumb Item below.

7. Edit the Title, URL Link and Description information.

8. Click the Save button ( ).

Removing a Breadcrumb Item
1. Navigate to the folder for which you want to remove a breadcrumb.
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2. On the View Contents of Folder screen, click View > Properties.

3. Click the Edit Properties button ( ).
4. Click the Breadcrumb tab.

5. The Edit Breadcrumbs screen appears.

6. Click the Remove button ( ) next to the breadcrumb item you want
to remove.

7. The breadcrumb item is deleted.

8. Click the Save button ( ).

BreadCrumb Server Control
This section also contains the following topics.

The Trail Created by the Breadcrumb Server Control 9-284
BreadCrumb Properties Apply to Web Forms, Not Web Pages 9-285
Types of BreadCrumb Server Control Properties 9-285
Properties that Determine a Breadcrumb Trail’s Appearance 9-286
How Form Pages Appear on Breadcrumb Trail 9-286
BreadCrumb Server Control Properties 9-286
BreadCrumb Metadata Type 9-290
Using the BreadCrumb Server Control 9-290
Making a Content Block’s Title Appear in the Breadcrumb Trail 9-291
Steps to Use a Content Block’s Title as a Breadcrumb 9-291

BreadCrumb Server Control
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The Trail Created by the Breadcrumb Server
Control
The breadcrumb trail can appear vertically or horizontally on a Web page. In
addition, you can define how many breadcrumbs are left for site visitors to
navigate back. You can also use an image and Alt text instead of, or in addition
to, text to display the breadcrumb trail. These variations are illustrated below.

Note: If a site visitor revisits a page that is in the breadcrumb trail already, the breadcrumb trail
reverts back to that point in the trail. For example, if you visit the following pages Dev > FAQ >
WebForm > PR, and then return to FAQ, the breadcrumb trail looks like this: Dev > FAQ.

Breadcrumb Trail Type Example

Horizontal; text only

Horizontalwith images

Horizontalwith imagesand Alt text

Vertical; text only

Verticalwith images
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Breadcrumb Trail Type Example

Verticalwith imagesand Alt text

You should add a BreadCrumb server control to every Web form in your site.
Doing this ensures that a breadcrumb trail is created for each Web page.

BreadCrumb Properties Apply to Web
Forms, Not Web Pages
Keep in mind that your Web site is made up of Web forms. Each page depends
on a form to determine much of its appearance. Forms and pages have a parent
> child relationship. That is, any form can be associated with any number of
pages.

When defining breadcrumb properties, you define them for a form. All pages
that use that form inherit its breadcrumb properties.

Assume, for example, that a Web form is used for the Human Resources
section of your Web site. You might use the title Human Resources to identify
the form in the BreadCrumb server control. Whenever a page is visited that
uses that form, Human Resources appears on the breadcrumb trail -- that is,
the form title appears, not the individual page.

Types of BreadCrumb Server Control
Properties
BreadCrumb server control properties are divided into two categories:

n Properties that Determine a Breadcrumb Trail’s Appearance on next
page

n How Form Pages Appear on Breadcrumb Trail on next page

BreadCrumb Properties Apply toWeb Forms, Not
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Properties that Determine a Breadcrumb Trail’s
Appearance
For each Web form, you can customize the breadcrumb trail. For example, you
might want the breadcrumb trail to appear horizontally on one Web form and
vertically on another.

Property
Determines this aspect of breadcrumb trail
appearance on form

For more information,
see

CurrentPageIndicator Symbols or characters to identify the current page CurrentPageIndicator on
the facing page

DisplayStyle Whether it appears horizontally or vertically DisplayStyle on the facing
page

LinkLastItem Whether the last item is a hyperlink LinkLastItem on page 9-288

LinkTarget The type of window that appearswhen a user clicks
an item LinkTarget on page 9-288

MaxItems Themaximum number of items MaxItemson page 9-289

Mode whether the breadcrumb trail appears as
hyperlinked text or plain text. Mode on page 9-289

Separator Symbols or characters used to separate items Separator on page 9-289

How Form Pages Appear on Breadcrumb Trail
Use these properties define how any page that uses this form appears within a
breadcrumb trail. It does not matter where the trail appears.

Note that you can use text, an image, or both to describe the form within the
breadcrumb trail. If you use both, the image appears first, followed by the text.

Property
Determines this aspect of Web form when it appears on
breadcrumb trail

For more
information, see

DisplayTitle Text to describe it DisplayTitle on the
facing page

IconAlt “Alt” text associated with image specified in IconPath property IconAlt on page 9-288

IconPath Image to define it IconPath on page 9-
288

BreadCrumb Server Control Properties
The BreadCrumb server control properties are described in this table.
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Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Response
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer
to Browse Your Ektron CMS400.NET Site on page 24-8

String

CurrentPageIndicator

If desired, enter one or more symbols or characters that identify the
current page in the breadcrumb trail. See example below.

These characters appear after the image or title that identifies the
current page in the breadcrumb trail.

String

DefaultContentID Gets or Sets the ContentID for the BreadCrumb display title. Long

DisplayStyle
Indicate how to display the breadcrumb trail: horizontally or vertically.
The default isHorizontal. See Also:Breadcrumb Trail Type on page
9-284

String

DisplayTitle

Enter text to describe thisWeb formwhen it appears in the
breadcrumb trail. For example, if theWeb form’s properties you are
defining is used for all HumanResourcespageson your site, enter
Human Resources. See Also:
BreadCrumbPropertiesApply toWeb Forms, NotWeb Pageson
page 9-285

If you define an image in the IconPathproperty below, the image
appears in the trail, followed by this text.

Warning! This property is for code behind only. It cannot be set in
design time.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes shown.

Boolean

DynamicParameter Gets or sets the QueryString parameter to read a content ID
dynamically. String

Hide

Used to hide the breadcrumb trail in design time and run time.

True =Hide breadcrumb trail

False =Show breadcrumb trail

Boolean

BreadCrumb Server Control Properties
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Property Response
Data
Type

IconAlt

If you define an image in the IconPathproperty, enter any “Alt” text
that should appear when a site visitor hovers the cursor over that
image. Here is an example.

String

IconPath

If you want the breadcrumb trail to display an image to identify this
Web form, enter the path to the image.

Warning! The image locationmust be relative to theWeb root.

For example: \CMS400Developer\Workarea\Images\bc_meta_
icon.gif

On the breadcrumb trail, the image precedesany text defined in the
DisplayTitleproperty.

String

Language Set a language for viewing content. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

LinkLastItem

Use this property to determine whether the last breadcrumb item
appears asa hyperlink on thisWeb form. If this property is set to
true, and a user clicks the item, the current page reappears.

True = last item is a hyperlink

False = last item is an image and/or text only; the user cannot click on
it

Boolean

LinkTarget

Determines the type of window that appears on thisWeb formwhen
a user clicks an item in the breadcrumb trail. The default is_self.

_Self -opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

String
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Property Response
Data
Type

MaxItems

Enter themaximum number of items in the breadcrumb trail on this
Web form.

The default is5.

If you set a value of 1 or greater and the user navigatesbeyond that
number of pages, only themost recent pagesappear. The older
pagesdisappear from the trail.

To allows an unlimited number of breadcrumb trail
items on this Web form, enter zero (0).

Integer

MetadataName
Specify the name of aMetadata Type that you want to associate with
the page. For more information, seeBreadCrumbMetadata Type
on next page

String

Mode

Allowsyou tomake the breadcrumb trail appear asnon-hyperlinked
plain text. The default isNormal.

Normal =breadcrumb trail is hyperlinked

DisplayOnly =breadcrumb trail is plain text

String

Separator

Enter one or more characters to separate the items in a breadcrumb
trail on thisWeb form.

The default character is the greater than sign (>). String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

Custom - Allowsyou to use a custom tag.

String
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BreadCrumb Metadata Type
To associate a Metadata Type with the BreadCrumb server control, follow these
steps.

1. In the properties window for the BreadCrumb server control, click on
the MetadataName property.

2. Click the Ellipses button ( ).
If you are not logged in, log in now using the CMS Explorer window.

3. The Browsing Metadata screen appears.

4. Select a Metadata Type to apply to the BreadCrumb server control.

5. Set the DynamicParameter to ID. This allows the metadata to reflect
what ever content block appears on the page.

Using the BreadCrumb Server Control
Add the BreadCrumb server control to each Web form for which you want to
create a breadcrumb trail. Follow these steps to use the BreadCrumb server
control.

Warning! It is recommended that you do not add a BreadCrumb server control to a Web form that
contains a Calendar server control. When both server controls appear on the same page and a
site visitor clicks on different months, the BreadCrumb trail could look like this: Calendar >
Calendar > Calendar > Calendar > Calendar. This happens because each time a site visitor
clicks on a month, you are in effect opening a new Web form.

1. Open a Web form for which you want to create a breadcrumb trail.

2. Drag and drop the BreadCrumb server control onto an appropriate
location of the Web form.

3. Set the DisplayTitle property. See DisplayTitle on page 9-287.

Note: To customize the look of your breadcrumb trail, configure the other properties. For more
information, seeBreadCrumb Server Control Properties on page 9-286.

4. Save the Web form.
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5. Repeat steps one through four for all Web forms to be included in the
breadcrumb trail.

6. Open a browser.

7. View a Web page with a BreadCrumb server control in it.

8. Navigate to the rest of the Web pages that contain BreadCrumb
server controls.

9. As you move around, the pages are added to the breadcrumb trail.

Making a Content Block’s Title Appear in the
Breadcrumb Trail
By adding a line or two of code, the breadcrumb trail can display the title of a
content block. You can add a line of code to each Web form or if your content is
dynamic, add the code once and each time a new piece of content is called
dynamically a new breadcrumb is created.

Only one content block per Web form can be used with the breadcrumb. If you
have multiple content blocks on a page, select the one that describes the
overall page best.

Steps to Use a Content Block’s Title as a
Breadcrumb

1. Drag and drop a ContentBlock server control on a Web form.

2. Choose a DefaultContentID for the content block.

3. Drag and drop a BreadCrumb server control on the same form.

4. Remove the word Title from the DisplayTitle property.

5. Add the following line code to the page load event code behind:
BreadCrumb1.DisplayTitle = ContentBlock1.EkItem.Title

6. Build the project.

Making a Content Block’s Title Appear in the
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7. View the Web form in a Web browser.

The following is an example content block titles used as breadcrumbs:

The word Title appears in the breadcrumb trail when the DisplayTitle
property is left empty. Even with the added code, if the breadcrumb loads
before the content block, the breadcrumb has no information in the
DisplayTitle property and therefore displays the word title by default.

If the word Title appears in the breadcrumb trail, check to make sure the word
Title does not appear in the DisplayTitle property. Next, if Title still appears,
add the following line of code to the page load event of the code behind:

ContentBlock1.Fill()

The code in the page load event should now look like this:

ContentBlock1.Fill()

BreadCrumb1.DisplayTitle = ContentBlock1.EkItem.Title

This ensures that the content block information is loaded first.

FolderBreadcrumb Server Control
The FolderBreadcrumb server control displays sitemap breadcrumbs. This trail
typically consists of the current content’s folder path. For example, the
FolderBreadcrumb below matches the content’s folder structure.
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The FolderBreadcrumb server control does not simply read your folder
structure and display its path. Instead, administrators define a folder’s
breadcrumb trail on the content’s folder properties > Breadcrumb tab.

See Also: Creating SiteMap Breadcrumbs on page 9-276; The Trail Created by
the Breadcrumb Server Control on page 9-284

This section also contains the following topics.

BreadCrumb Server Control Properties 9-293
Using the BreadCrumb Server Control 9-295

BreadCrumb Server Control Properties
Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMS
Explorer and can use it to browse to Content,
Collections, etc. See Also:Using CMSExplorer
to Browse Your Ektron CMS400.NET Site on
page 24-8

String

DefaultContentID

Display the breadcrumb trail for the folder in
which the given content ID resides. To use this
property, breadcrumb information for a folder
must be defined in theWorkarea > [Specified
Folder] > Folder properties>Breadcrumb tab.

Long

DefaultFolderID

The folder ID for which you want the
breadcrumb trail to display. If a
DefaultContentID is given, it overrides this
property. To use this property, breadcrumb
information for a folder must be defined in the
Workarea > [Specified Folder] > Folder
properties>Breadcrumb tab.

Long
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Property Description Data Type

DisplayStyle
Indicate how to display the breadcrumb trail:
horizontally or vertically. The default is
Horizontal.

DisplayStyles

DoInitFill

By default, Fill occurs during the Page_Init
event. Set to false if you want to postpone the
fill-action until later. In this case, FIll is
automatically called during the Page Render
event.

Youmight do this if you need to set or change a
property on the control in codebehind and have
it render with your changes shown.

Boolean

DynamicParameter Gets or sets the QueryString parameter to read
a content ID dynamically. String

Hide

Used to hide the breadcrumb trail in design time
and run time.

True =Hide breadcrumb trail

False =Show breadcrumb trail

Boolean

Language
Set a language for viewing content. This
property shows results in design-time (in Visual
Studio) and at run-time (in a browser).

Integer

LinkTarget

Determines the type of window that appears on
thisWeb formwhen a user clicks an item in the
breadcrumb trail. The default is_self.

_Self -opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinktargets

Mode

Allowsyou tomake the breadcrumb trail appear
asnon-hyperlinked plain text. The default is
Normal.

Normal =breadcrumb trail is hyperlinked

DisplayOnly =breadcrumb trail is plain text

Modes

Separator

Enter one or more characters to separate the
items in a breadcrumb trail on thisWeb form.

The default character is the greater than sign
(>).

String

SuppressWrapperTags

Suppresses the output of the span/div tags
around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Description Data Type

WrapTag

Allowsa developer to specify a server control’s
tag. The default isSpan.

Span - The <span> tag is used to designate an
in-line portion of an HTML document asa span
element.

Div - The <div> tag is used when you want to
apply attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

Using the BreadCrumb Server Control
Add the FolderBreadcrumb server control to each Web form for which you want
to create a breadcrumb sitemap. Follow these steps to use the
FolderBreadcrumb server control.

1. In the Ektron CMS400.NET Workarea, define breadcrumb information
for a folder. See Adding a Breadcrumb on page 9-277.

2. Open a Web form for which you want to create a folder breadcrumb
map.

3. Drag and drop the FolderBreadcrumb server control onto an
appropriate location of the Web form.

4. Set the DefaultContentID or DefaultFolderID property. If using
DefaultContentID, make sure the content is in a folder where
breadcrumb information has been defined. If using
DefaultFolderID, make sure breadcrumb information has been
defined for that folder.

5. Save the Web form.

6. Open a browser.

7. View a Web page with the FolderBreadCrumb server control in it.

8. The FolderBreadcrumb now appears on your site as a sitemap
breadcrumb.

Using the BreadCrumb Server Control
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SiteMap Server Control
The Sitemap server control utilizes the folder breadcrumb information in the
Workarea to display a sitemap of your site. By choosing the starting point of the
sitemap, the max levels to display and applying a style class, you can
customize the sitemap. The sitemap is displayed as indented list when viewed
on a Web page.

The contents of the sitemap are defined on the Breadcrumb tab located in the
Workarea folder properties. See Also: Breadcrumbs on page 9-276

This section also contains the following topics.

Sitemap Server Control Properties 9-296
Using the Sitemap Server Control 9-298
Retrieving the XML Structure of a Site Map 9-298

Sitemap Server Control Properties
The Sitemap server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Response
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. Using CMSExplorer to Browse
Your Ektron CMS400.NET Site on page 24-8

String
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Property Response
Data
Type

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
this property to 300 (three hundred). See Also:Caching with Server
Controlson page 24-33

Double

ClassName

The style sheet classname used to format the HTML. Leave blank to
use the default. To use a new class, add it to the following file:

webroot\siteroot\Workarea\csslib\sitemap.css

Then, add the classname to the property.

String

DisplayXslt

Note: (Code
behind only)

Specify an externalXSLT file to render the control.

Warning! If you want to edit this file, it is strongly recommended that
youmake a copy, change its name andmove it outside of your site’s
Workarea folder. If youmake changes to this file and do not move it
out of theWorkarea, this file and the changeswill be lost when you
upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

FlatTopLevel When set to True, include site nodes from the parent folder but not
their items. Set to False to include all nodesand items. Boolean

FolderID The folder ID for the starting point of the sitemap. To choose the root
folder, enter 0 (zero). Long

Hide

Used to hide the Sitemap in design time and run time.

True =Hide Sitemap trail

False =Show Sitemap trail

Boolean

Language Set a language for viewing content. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

MaxLevel Set themaximum amount of levels to show. Set it to 0 (zero) for
unlimited. Integer

StartingLevel Set to the starting level of the site map. If set to 0 (zero), starts from the
root. Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

Sitemap Server Control Properties
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Property Response
Data
Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block
of code.

Custom - Allowsyou to use a custom tag.

String

Using the Sitemap Server Control
Note: Make sure you have added the sitemap information to your folders’ Breadcrumb tab in
the Ektron CMS400.NETWorkarea.

Follow these steps to use the Site server control.

1. Open a Web form for which you want to create a sitemap.

2. Drag and drop the Sitemap server control onto an appropriate
location of the Web form.

3. Add the starting folder’s ID to the FolderID property.

4. Set any of the other properties. See Also: Sitemap Server Control
Properties on page 9-296.

5. Save the Web form.

6. Open a browser.

7. View a Web page with the Sitemap server control in it.

8. The sitemap now appears on your site.

Retrieving the XML Structure of a Site Map
Retrieving the XML structure of XML content allows for greater control over
developing XSLs. The following is an example of how to retrieve the XML
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structure:

1. Open a new Web form.

2. Drag and drop a SiteMap server control onto it.

3. Set the FolderID property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = SiteMap1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

The XML structure of the Site Map appears in the textbox.

For an additional example, see the XML Site Map page in the CMS400Developer
samples page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/Sitemap/SiteMapXML.aspx

In the source code:

<site root>/CMS400Developer/Developer/Sitemap/SiteMapXML.aspx and SiteMapXML.aspx.vb

Retrieving the XMLStructure of a Site Map
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Personalizing a Web Page
Personalization is fast becoming an integral part of Web sites
like iGoogle and Facebook, and organizations see
personalization as a way to make their sites stickier and
more engaging.

The following video introduces Personalization:
http://www.ektron.com/personalization/

Ektron CMS400.NET provides tools to let membership users personalize their
experience on your site, bringing relevant information to their fingertips. By
letting users add widgets, applications, and feeds to a Web site, CMS400.NET
provides a framework on which to easily build true, personalized portals.

Helping Users Navigate Your Web Site
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Make Your Site, Their Site with
CMS400.NET
When membership users can choose and organize content on their digital
dashboard, your site becomes their site. Everyone has different needs and
preferences, and CMS400.NET’s portal functionality lets you create a more
interactive, engaging experience by giving power to the user.

How Personalization Works
On an Ektron CMS400.NET Web site, personalized areas can have multiple tabs,
letting users organize content by subject – think of tabbed browsing. Users can
easily add new tabs, switch between them, and define each one as public or
private. For example, a tab that displays personal financial information can be
private, so only that user can see it. Each tab can have multiple columns, to
further customize the view.

Ektron CMS400.NET widgets can be dragged and dropped into each tab. These
widgets can range from RSS feeds to applets to Ektron server controls. They
make it possible for a site visitor to access all information from one location,
rather than using many mouse clicks to log into separate Web sites or
applications.

Developers can give users access to any pre-built Ektron CMS400.NET widgets,
and even build their own widgets that talk to third-party systems to customize
the way site visitors are engaged. See Also: Using Widgets andWidget
Reference on page 6-5

Empower your Intranet ...
Building personalization into your intranet empowers employees with
customization that fits their work and personal life. Widgets can range from
photos, local weather, and updated news to a personal work calendar, a sales
time line and tracker, or a feed to a discussion board about a new product
release.

Make Your Site, Their Site with CMS400.NET

ReferenceManual
Version 8.01 Rev 4

9-301



Managers can use widgets to enhance their access to their team’s information.
A human resources department can update job postings on a weekly basis via a
widget rather than navigating to the company’s careers site.

… and Public Facing Web Sites
Personalization revolutionizes the way visitors interact with sites, and Ektron
CMS400.NET provides the tools to make that happen. See what some
organizations can do with personalization.

n Healthcare portals have regular site visitors who desire the same
information each time they visit. Enable visitors to receive allergy,
fitness, nutrition, and appointment information whenever they log in
– your site visitors may even save recipes to their nutrition tab.

n Clothing store customers are fashion-minded individuals who like to
view the latest styles on these Web sites. Let them view the
department they always go to first with the click of a button. Clothing
widgets can show what’s available in their size. This personalization
will increase site traffic and sales.

n Banking sites can allow users to access personal account widgets,
and separate it from their business financial information. Calculator
widgets can keep them on the site as they make financial decisions.

n Schools personalize their Web site for each student and parent.
Personalized portals let students have widgets such as school e-mail,
personalized school calendars (with their homework, project due
dates and social events), feeds linked directly to their grades, a
school library search tool, and more to keep them connected and
informed.

Personalization enables membership users to access information they want with
the click of a button. No longer do they have to navigate all over a Web site (or
sites) to find content. Ektron CMS400.NET’s personalization functionality lets
organizations create iGoogle-like interfaces integrated within content
management, so that they can serve their customers and members in a more
powerful and personal way, building user adoption and increasing site traffic.

This section also contains the following topics.

Personalization versus PageBuilder Pages on the facing page

Individual versus Group Personalization Pages on the facing page

Sample Personalization Pages on the facing page

Creating an Individual Personalization Page on page 9-304

How a Membership User Interacts with an Individual Personalization Page on
page 9-308

Creating a Community Group Personalization Page on page 9-310
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Personalization versus PageBuilder
Pages
Personalization lets a membership user or community group member
customize a single page on your site for their own use. A PageBuilder page, on
the other hand, lets an Ektron CMS400.NET user create pages that make up
your Web site.

Both page types use widgets. See Also:Widget Reference on page 6-5

Individual versus Group Personalization
Pages
An individual personalization page is used by a membership or an Ektron
CMS400.NET user to personalize a page on your Web site. A page consists of
tabs, and each tab can contain several widgets.

If a tab is private, only that user can view and edit it. If the tab is public,
anyone can view it but only the signed-in user can create and edit the content.

A group personalization page is used by group members to set up a portal page
that addresses that group’s unique needs. Any group member can view and
create or edit the page’s content.

If a tab on a group page is private, only group members can view and create or
edit it. If the tab is public, anyone can view it but only the group members can
create and edit the content.

Sample Personalization Pages
You can find examples of personalization pages in these Ektron sample sites.
You can copy and edit the samples as needed to build your personalization
pages.

Personalization versus PageBuilder Pages

ReferenceManual
Version 8.01 Rev 4

9-303



To download sample sites, go to http://www.ektron.com/solutions/startersites/.

Individual Personalization Pages
n Technology site > Login > My Profile > Dashboard

n eIntranet Site > Login > My Profile > Dashboard

n Developer Sample site > Personalization

Group Personalization Pages
n Technology site > Login > Community > Community Groups > select

group, such as Ektron Tech Web Design > Dashboard

n Intranet Site > Login > Groups > select group > Dashboard

Creating an Individual Personalization
Page
Follow these steps to create a personalization page from scratch. After you
create the page, place a link to it on your site. Then, any authenticated
membership user can use the page to create his own personal portal.

This section also contains the following topics.

Widget Spaces 9-304
Steps for Creating a Personalization Page 9-305
Verify that the User is Authenticated 9-307
The Synchronize Widgets Screen 9-308

Widget Spaces
A widget space is a mechanism that lets you determine which widgets individual
users or a community group can drop onto a personalization page.

There are two types of widget spaces:

n Group space - the set of widgets that can be applied to a community
group

n User space - the set of widgets that can be applied to an individual
user's profile

A group space can

For example, members of the NASCAR community group are only allowed to
drop weather and news feed widgets onto the group's personalization page. In
this case, you would

1. Create a widget space.
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2. Select only weather and news feed widgets.

3. Sign on to Visual Studio to create the .aspx page.

4. Drop a Personalization user control onto the page.

5. In the control’s widgetspaceID property, identify the widget space
you created in Step 1.

Steps for Creating a Personalization Page
1. Go to Ektron CMS400.NET Workarea > Settings > Configuration

> Personalization > Widgets. See Also:Widget Reference on
page 6-5

2. Click the Sync button ( ) make sure all widgets are available.
3. Go to Settings > Configuration > Personalization > Widget

Space.

4. Click the Add button ( ).
5. Enter a Title.

6. Check the Group Space radio button if this widget space will be used
for a community group personalization page.

7. Select widgets that authorized users will be able to drop onto a page.

As you select a widget, its background color changes.

These widgets appear in the personalization screen’s widget tray (shown
below) when a membership user is personalizing a page.

Steps for Creating a Personalization Page
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8. Click Save ( ).

Note: Remember your widget space’s ID number. You need it when setting up the
Personalization user control.

9. Open Visual Studio.

10. Create a new Web Form.

11. Switch to design view.

12. From the Toolbox, drag and drop an Ajax Extensions > Script
Manager control.

If you do not see a Script Manager control, install the Microsoft AJAX
Library 3.5. To do this, go to http://www.asp.net/ajax/downloads/.

13. In the Visual Studio folder browser, open the
workarea/personalization/ folder.

14. Drag and drop a Personalization user control (personalization.ascx).
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15. Set the control’s widgetspaceid property (circled below) to the ID
number of the widget space you added in Step 6.

16. Save the Web Form.

Verify that the User is Authenticated
Your page should redirect the user to the personalization page, or use an
ASP.NET panel to verify that user is authenticated.

Note: The asp.net panels are implemented in eIntranet and ektron Tech site.

Here is sample code.

Aspx.cs
// To check if user is logged in or not

Ektron.Cms.CommonApi IsUserLoggedIn = new Ektron.Cms.CommonApi();

if (IsUserLoggedIn.IsLoggedIn)

{

Response.Redirect(“dashboard.aspx”);

Or

pnlDashboard.Visible= true;

}

Verify that the User is Authenticated
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Else

{

pnlDashboard.Visible=false;

}

Aspx
<asp:Panel ID="pnlDashboard" runat="server" Visible="False">

<asp:ScriptManager ID="ScriptManager1" runat="server"
EnablePartialRendering="true"></asp:ScriptManager>

<ucEktron:Personalization ID="widgetSpace" WidgetSpaceID="1"
DynamicForeignIDParameter="id" runat="server" />

</asp:Panel>

The Synchronize Widgets Screen
This screen helps you synchronize widgets in your Web site’s site root/widgets
folder with those in your Ektron CMS400.NET Workarea. So, for example, you
recently created two new widgets. To make them available within the
Workarea, click this screen’s Synchronize button ( ).

After you click the button, you see new widgets on this screen and other
Workarea screens that let you select widgets. Conversely, clicking this button
removes any widgets that you delete from the site root/widgets folder.

This screen also lets you edit widgets by clicking the corresponding Edit button (
). For most widgets, you can change only the title and label. However, you

can change a few widgets' properties. For example, you can enter or update
properties of the BrightCove video widget.

How a Membership User Interacts with
an Individual Personalization Page
To access a personalization page, a membership user logs in then clicks My
profile > Dashboard. Initially, the dashboard looks like this.

This section also contains the following topics.

Inserting a Tab and Column 9-309
Public vs. Private Tab 9-309
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Adding Columns 9-309
Adding Widgets 9-310

Inserting a Tab and Column
The user adds a tab by clicking the down arrow circled above and choosing Add
Tab.

Public vs. Private Tab
When creating a tab, the user must decide if it is public or private.

Any logged-in user can see a user’s public tab by visiting his profile and clicking
Dashboard.

A private tab is visible only to the user who created it.

Adding Columns
Next, the user must add at least one column. To do this, he clicks the down
arrow circled below and chooses Add Column.

Here is an example of a tab with three columns.

Inserting a Tab and Column
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Adding Widgets
To add a widget, the user clicks the other down arrow (circled below), then
drags and drops the desired widgets.

The selection of widgets was determined when the widget space was created.
See Also: Creating an Individual Personalization Page on page 9-304

Creating a Community Group
Personalization Page
A community group personalization page is similar to an individual page. It lets
group members customize a page’s content by dropping widgets. For an
introduction to these concepts, see

n Personalizing a Web Page on page 9-300

n Individual versus Group Personalization Pages on page 9-303

n Sample Personalization Pages on page 9-303

n Creating an Individual Personalization Page on page 9-304

n How a Membership User Interacts with an Individual Personalization
Page on page 9-308
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This section also contains the following topics.

Setting up a Community Group Personalization Page 9-311
How a User Interacts with a Community Group Personalization
Page

9-
312

Setting up a Community Group
Personalization Page
To create a community group personalization page, follow the instructions in
Creating an Individual Personalization Page on page 9-304, with the following
differences

n When creating a Widget space, check the Group Space checkbox.

n When a developer creates an .aspx page and drops a personalization
control, the selected Widget space must be one whose Group Space
box is checked.

Setting up a Community Group Personalization
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n A private tab is visible only to groupmembers.

How a User Interacts with a Community
Group Personalization Page
To access a community group personalization page, a membership or Ektron
CMS400.NET user group member logs in then navigates to the group’s
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personalization page. See Also: Creating a Community Group Personalization
Page on page 9-310

Initially, a group personalization page looks like this.

Community group members work with a personalization page in the same way
they work with individual personalization pages. See Inserting a Tab and
Column on page 9-309 and Adding Widgets on page 9-310.

How aUser Interacts with a Community Group
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Chapter 10

Creating User-Friendly
URLs with Aliasing
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Search engine optimization (SEO) plays a key role
in every Web marketing strategy. Ektron
CMS400.NET’s URL aliasing makes it easy to
create descriptive, meaningful and SEO-friendly
URL aliases consistently, maximizing your Web
site’s placement in search results.

For a video introduction to Ektron CMS400.NET’s Aliasing feature, go to:

http://media.ektron.com/flash/urlaliasing/480x360/ektronaliasing/ektronaliasing.html

Human-readable URLs created on your Ektron CMS400.NETWeb site are
predictable and scalable, following consistent patterns that can apply to all of
your sites. The use of words and phrases that actually define the page itself
increases these aliases’ search engine rankings. By following a pattern, they
are scalable, and that pattern can be used across your sites as they grow.

Sites that are currently built migrate easily to CMS400.NET, adopting the new
aliasing scheme. No longer do you have to make changes to the web.config, and
aliasing can keep old links valid. Once the URL aliasing function is configured
and enabled, all content inherits the new aliasing structure.

URL aliases generated by CMS400.NET don’t require an extension of how the
page is built; search engines find “real” words. Web site performance affects
search engine returns as well, and Ektron’s URL aliasing takes this into account:
these aliases are cached, improving performance.

There are six important aspects of URL Aliasing

n Automatic Aliasing - Normally-generated URLs are barely human
readable, let alone search engine-friendly. With search engines using
the text in a URL to define where a page shows up on a search return,
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it has never been more important to have descriptive URLs. While
you can manually create aliases that will do the job, CMS400.NET
gives you the tools you need to generate them automatically, with
consistent structure.Automatic URL Aliasing on page 10-21

n Taxonomy-Based Alias - URL aliases can be auto-created by
Ektron CMS400.NET based on the taxonomy of y

n our Web site. It uses the levels of the taxonomy plus the title of the
page itself to produce an alias. Search engines will find those words,
increasing the page’s relevancy in any search for them. And because
it is based on the taxonomy (which lets content be established in
one-to-many relationships), multiple aliases can be created that will
have relevancy to multiple search criteria.

n Folder-Based Alias - Ektron CMS400.NET can also automate the
creation of folder-based URL aliases. Similar to taxonomy-based
aliases, deriving an alias from the folder structure produces one that
is relevant to the content’s actual location. With descriptive folder
names and good organization, this produces SEO-friendly addresses
comprised of folder structure plus title of page.

n RegEx Based Alias - For some pages with content that follows a
pattern, Regex aliasing may be the answer. It looks for a pattern in
the current URL, and then replaces it with a different pattern to
create a relevant alias. For example, a blog site may be best served
by Regex aliases that rely on entry date.

n Community Based Aliases for Users and Groups - can help
make Social Media pages within your Ektron CMS400.NETWeb site
easy to remember and find by simply using the User Name or the
Group in the URL. An example friendly URL for Steve's profile page
would be http://www.examplesite.com/steve.

n Manual Aliasing- URL aliases can be created by you to make each
content item have a unique URL. Instead of having the address to
your page include template names and parameters, a page could be
as easily name as this - www.example.com/news/.

This section also contains the following topics.

Effects of Aliasing Content 10-4
Benefits of Aliasing 10-4
Types of URL Aliasing 10-4
Features Not Supported by Aliasing 10-6
Aliasing and Relative Links 10-8
Configuring URL Aliasing 10-8
Automatic URL Aliasing 10-21
Manual Aliasing 10-28
Using RegEx Expressions 10-37
Community URL Aliasing 10-41
Site Aliasing 10-45
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Upgrading from Previous Releases 10-48
Assigning an Alias to Multi-Language Content 10-48
Aliasing with Windows 2008 Server 64 Bit 10-49

Effects of Aliasing Content
Once your content is aliased, a site visitor can enter either the original URL or
the alias into the browser to view the page. Also, if someone selects a content
link on your Web page, the alias frequently replaces the original URL in the
browser.

Also, when an Ektron CMS400.NET user is editing content and inserts a quicklink
whose content has several aliases, a screen appears, and he must select one of
the aliases. (If only one alias is assigned to the content, it is applied to the
quicklink.)

Benefits of Aliasing
Here are some examples of why you’d want to alias Ektron CMS400.NET pages.

n To provide shorter, more user-friendly URLs, which map to longer
paths. For example, www.ektron.com/training/ may be preferable
for marketing materials.

n If you have a PHP site, you can alias all php pages and use the same
query string names to pass needed information to the new .aspx
pages.

Note: Any query strings appended to an aliased page pass to the .aspx page and may be
used if necessary.

n If you have a static Web site (for example, all HTML pages) that is
indexed in a search engine, you can alias your site and retain
complete content management without affecting your search engine
ranking.

n Some search engines work better without the URL parameters that
make up an Ektron CMS400.NET Web page name. URL Aliasing
creates page names that search engines might more easily
recognize.

n You want to provide friendly URL's for Social Media pages like user
profiles or community groups.

Types of URL Aliasing
The types of URL aliasing are described below.
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n Automatic Aliasing - Can automatically change the page name
format of a group of content blocks. You determine the group by
selecting a taxonomy or a top-level Ektron CMS400.NET folder.

For example, you might choose a folder and alias its content using
the content title followed by slash (/). So, while the original URL
might be www.example.com/Human_
resources/Postings/hr.aspx?id=8745, the aliased one might be
www.example.com/jobs/.

For more information, see Automatic URL Aliasing on page 10-21.

n Manual Aliasing - You can manually alias any content block using
whatever unique name you wish. For example, you can alias your
technical support page as www.example.com/help.htm, even though
its real name is www.example.com/help.aspx?id=27.

You can assign several manual aliases to content then decide which
one is the primary. For more information, see Manual Aliasing on
page 10-28.

If both alias types are provided for a content item, a user can enter
any alias into the browser address field to access that content. If
someone hovers the cursor over (or clicks) a link to aliased content,
the primary manual alias appears.

n Regex-based Aliasing - RegEx expressions allow site visitors to
enter a human-readable URL into the browser address field and
transform that entry into the query string component of an Ektron
CMS400.NET page. The benefit is that the site visitor can “guess”
other pages based on an easily recognizable pattern. For example, a
RegEx expression aliases
blogs.aspx?blogmonth=3&blogyear=2006&blogid=41 as
blogs/2006/03/41. From that, a site visitor can infer that he can
enter blogs/2006/03/40 to see the previous post, enter
blogs/2006/03 to see all March 2006 posts, etc. For more
information, see Using RegEx Expressions on page 10-37.

n Site Aliasing - If your site supports the multi-site feature, you can
enter aliases for any site. For example, your company‘s name just
changed from Bionics to NewGen. You could use the site aliasing
feature to resolve the url www.bionics.com to www.newgen.com. For
more information, see Site Aliasing on page 10-45.

n Community Aliasing - You can create aliases that include a
community user name or community group. This provides easy-to-
use URL addresses for each person's profile or groups that others can
visit. An example Community User Alias is:
 http://www.example.com/John. For more information, Community
URL Aliasing on page 10-41.

Types of URL Aliasing
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Example of an Alias in the Browser

Features Not Supported by Aliasing
Aliasing is not supported in the following areas of Ektron CMS400.NET.

n search results

n images

n content in root folder * (cannot be automatically aliased, although
you can alias it manually and by taxonomy)

n forums (discussion boards) * (links within forum posts can be
aliased)

n forms/polls/surveys *- the form is aliased but the postback screen is
not (for a workaround, see
http://weblogs.asp.net/scottgu/archive/2007/02/26/tip-trick-url-
rewriting-with-asp-net.aspx > “Handling ASP.NET PostBacks with
URL Rewriting”)
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n a link to an HTML form

n content links within the directory server control

n If a template is assigned to a taxonomy (see below), the template
takes precedence over an alias for content found by a directory
server control

* - looking to support in future release
n eCommerce - items in a Shopping Cart control use an alias unless

you assign an .aspx page in the control’s TemplateProduct property.
If you assign a page there, that page is used in the product’s URL, not
the alias.

n If you enable .asp as an extension, the alias does not appear when a
site visitor hovers the cursor over an asset. Instead, the actual file
name appears. See Also: Extension on page 10-12

If a site visitor hovers the cursor over HTML content, the alias does
appear.

n The alias does not appear when a site visitor viewing an RSS page
hovers the cursor over an asset. Instead, the actual file name
appears.

FeaturesNot Supported by Aliasing
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Aliasing and Relative Links
After you enable Aliasing, any relative links embedded in your Web pages that
are not preceded by a slash (/) may demonstrate symptoms such as:

n Runtime error notifications

n Broken images (you see a red X where the image should be)

n Missing text styling

The following Ektron CMS400.NET Knowledge Base article analyzes this problem
and presents solutions: http://dev.ektron.com/kb_article.aspx?id=19254.

Configuring URL Aliasing
This section also contains the following topics.

Permissions for Working with Aliasing 10-8
URL Alias - Order of Priority 10-14
Restrictions on Extensions 10-15
Activating Custom Extensions 10-17
Clearing the Manual Alias Cache 10-19
Clearing the Cache for All URL Aliases 10-19
Setting Default Documents 10-20

Permissions for Working with Aliasing
Members of the Administrators group or those assigned to the Alias-Admin Role
have full permissions to work with aliasing. They can do things like

n Turn aliasing on and off

n View all manual aliases

n Activate or deactivate manual aliases

n Change the primary alias

n Create automatic aliases

n Create RegEx aliases

n Create Community Aliases

Creating User-Friendly URLswith Aliasing
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To give a user a limited ability to work with aliasing, you can assign them the
Alias-Edit role. These users can only

n view and assign a manual alias to content

n view secondary aliases assigned to content

Before you can set up aliases, you must enable the features using the URL
Aliasing Configuration screen (shown below).

Warning! If you performed a database sync and the site being synched uses URL aliasing, you

must go to its URL Aliasing Configuration screen and click the Refresh button ( ) to update its
aliasing information.

To edit the Aliasing Configuration screen, go to Ektron CMS400.NET Workarea
> Settings > Configuration > URL Aliasing > Settings. Then, click the

Edit button ( ).

Permissions for Working with Aliasing
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Note: After changing the configuration screen, if your Ektron CMS400.NET supports multisite
configurations, you must log into each site, navigate to the URL Aliasing Configuration screen,

and click the Refresh button ( ).

Use the following table to complete the screen.

Field Description

Manual

Enabled Check this box to enablemanual aliasing. See Also:ManualAliasing on page 10-28

Caching

Check this box to improve your server’s performance. It minimizes the number of database hits
byplacing allmanual aliasing information in your server’smemory.

Note: Adeveloper might want to uncheck this boxwhile developing a site, to make sure that
everything is coming out of the database.

Cache Size

If you checked theManual Caching box, enter themaximum number of manual aliases that
your server will cache. Bydefault, this is set to 1000.

An alias is cached whenever anyone uses it. It remains in the cache for the number of seconds
set in theCache Duration field.

If more than this number of aliasesneeds to be added to the cache, Ektron CMS400.NET
makes room for new onesby removing aliases that have been in the cache for the longest time.

If you increase the number, it is possible that your performance will improve. But at some point,
the size of the cachemaydegrade your server’s performance. See Also:Clearing theManual
AliasCache on page 10-19

Cache
Duration
(Seconds)

Enter the number of seconds for which anyalias is retained in the server’s cache. After this
number of secondshaspassed, the alias is flushed from the cache. See Also:Clearing the
ManualAliasCache on page 10-19

Note: If your Ektron CMS400.NET supportsmulti-site configurations, this setting only
affects the site to which you are logged on. To set a cache duration for other sites, sign in to
each site’sWorkarea > Settings > Url Aliasing > Settings, then set its cache duration
values.

Automatic

Enabled Check this box to enable automatic aliasing. See Also:AutomaticURL Aliasing on page 10-21

Caching
Check this box to improve your server’s performance. It minimizes the number of database hits
byplacing themost frequently used automatic aliases in your server’smemory.

You set the number of cached automatic aliasesat theAutomatic Alias Cache Size field.

Creating User-Friendly URLswith Aliasing
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Field Description

Cache Size

If you checked theAutomatic Caching box, enter themaximum number of automatic aliases
that your server will cache. Bydefault, this is set to 1000.

An alias is cached whenever anyone uses it. It remains in the cache for the number of seconds
set in theCache Duration field.

If more than this number of aliasesneeds to be added to the cache, Ektron CMS400.NET
makes room for new onesby removing aliases that have been in the cache for the longest time.

If you increase the number, it is possible that your performance will improve. But at some point,
the size of the cachemaydegrade your server’s performance. See Also:Clearing theManual
AliasCache on page 10-19

Cache
Duration
(Seconds)

Enter the number of seconds for which anyalias is retained in the server’s cache. After this
number of secondshaspassed, the alias is flushed from the cache. See Also:Clearing the
ManualAliasCache on page 10-19

RegEx

Enabled Check this box to enable the RegEx feature. See Also:Using RegExExpressionson page 10-
37

Caching
Check this box to improve your server’s performance. It minimizes the number of database hits
byplacing themost frequently used RegExaliases in your server’smemory.

You set the number of cached aliasesat theRegEx Cache Size field.

Cache Size

If you checked theRegEx Caching box, enter themaximum number of RegExaliases that
your server will cache. Bydefault, this is set to 1000.

An alias is cached whenever anyone uses it. It remains in the cache for the number of seconds
set in theCache Duration field.

If more than this number of aliasesneeds to be added to the cache, Ektron CMS400.NET
makes room for new onesby removing aliases that have been in the cache for the longest time.

If you increase the number, it is possible that your performance will improve. But at some point,
the size of the cachemaydegrade your server’s performance. See Also:Clearing theManual
AliasCache on page 10-19

Cache
Duration
(Seconds)

Enter the number of seconds for which anyalias is retained in the server’s cache. After this
number of secondshaspassed, the alias is flushed from the cache. See Also:Clearing the
ManualAliasCache on page 10-19

Permissions for Working with Aliasing
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Field Description

Extension

Enter file extensionsof pages for which aliases can be created. Begin each extension with a
period (.), and separate themwith a comma (,).

Bydefault, Ektron CMS400.NET supplies the following extensions.

n .aspx

n / (the slash is actually the lackof an extension at the end of a page’s name)

If you are editing this screen and delete an extension, all aliases that use it are immediately
disabled.

Where Extensions Appear

The values in this field appear asdropdowns in the Add a NewManualAlias and Add a New
AutomaticAlias screens.

See Also:Restrictionson Extensionson page 10-15

Override
Template

A template and an alias can have the same name, for example,
www.example.com/dynamic.aspx. If this happens, and a site visitor types such an address into
the browser, this checkboxdetermines if the template page or the alias appears.

If this box is checked, the alias appears instead of the template.

Note: The templatemust be defined within theWorkarea Settings>Template
Configuration screen.

Disable
Language
Awareness

Use this checkbox to determine what happensunder the following conditions:

1. A site visitor browses to content using an alias.

2. The site visitor changes the site language.

If this box is checked - If the content exists in the new language, it appears. If not the content
appears in the original language.

If this box isunchecked - Site visitor seesa 404 error.

Examples if box is checked and a site visitor browses to content using an alias.

n Content ID 33 exists in both English and Spanish. Site visitor views this content in English
then switches the site language to Spanish. The Spanish version of content ID 33 appears.

n (Assume English is the default language). Content ID doesnot exist in German. Site visitor
views this content in English then switches the site language to German. The English content
appears.

Creating User-Friendly URLswith Aliasing
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Field Description

Query
String
Action

Use this field to set up a rule to handle an alias’s query string parameters. You can set one rule
for your entire site (via this field), and separate ones that override the system-wide rule for
specificmanual aliases (using theManualAliased Page NameMaintenance screen).

Four optionsare available.

n None - If an aliased URL hasa query string, it is ignored. Anyquery string on the target
URL is used.

n Resolve matched parameters within alias - Ektron CMS400.NET tries to resolve
matching parameters (it is case sensitive). If a match is found, the alias’s query string
parameter takesprecedence. Example:

alias’s query string parameter:

http://www.example.com/Contact.aspx?id=84

Target: http://www.example.com/aboutus.aspx?id=35&UserId=10

Result: http://www.example.com/aboutus.aspx?id=84&UserId=10

(id=35 is replaced by id=84 since it matched the query string parameter. UserId=10 wasnot
affected because it did not match the alias query string parameter.)

n Replace all parameters within alias - Ektron CMS400.NET replacesall of a target’s
query parameterswith the alias’ s query parameter. Example:

alias’s query string parameter:
http://www.ektron.com/Contact.aspx?id=84

Target: http://www.ektron.com/aboutus.aspx?id=35&Userid=1

Result: http://www.ektron.com/aboutus.aspx?id=84

(The target parameters id=35&Userid=1 are replaced by the alias parameter id=84)

n Append parameters to alias - Ektron CMS400.NET appends the alias’s
parameters to the target URL. Example:

Alias: http://www.ektron.com/Contact.aspx?id=84&lang=1033

Target: http://www.ektron.com/aboutus.aspx?id=35&Userid=1

Result: http://www.ektron.com/aboutus.aspx?id=35&Userid=1 & id=84&lang=1033

(The parameter from the alias is appended to the target)

Community

Enabled Check this box to enable Community aliasing.Enabling/Disabling a CommunityURL Aliason
page 10-42

Caching
Check this box to improve your server’s performance. It minimizes the number of database hits
byplacing themost frequently used Community aliases in your server’smemory.

You set the number of cached automatic aliasesat theAutomatic Alias Cache Size field.

Permissions for Working with Aliasing
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Cache
Size

If you checked theAutomatic Caching box, enter themaximum number of Community aliases
that your server will cache. Bydefault, this is set to 1000.

An alias is cached whenever anyone uses it. It remains in the cache for the number of seconds
set in theCache Duration field.

If more than this number of aliasesneeds to be added to the cache, Ektron CMS400.NET
makes room for new onesby removing aliases that have been in the cache for the longest time.

If you increase the number, it is possible that your performance will improve. But at some point,
the size of the cachemaydegrade your server’s performance. See Also:Clearing theManual
AliasCache on page 10-19

Cache
Duration
(Seconds)

Enter the number of seconds for which anyalias is retained in the server’s cache. After this
number of secondshaspassed, the alias is flushed from the cache. See Also:Clearing the
ManualAliasCache on page 10-19

Quicklink Cache

Enabled Check this box to enable caching of URL stringsnot aliased. The effect of this setting is better
performance on page requests byeliminating a read to the database for Quicklinksnot Aliased..

Cache
Size

If you checked theNon-Alias enabled box, enter themaximum number of non-aliased URLs
that your server will cache. Bydefault, this is set to 1000.

An non-aliasURL is cached whenever anyone uses it. It remains in the cache for the number of
seconds set in theCache Duration field.

If more than this number of non-aliased Urls needs to be added to the cache, Ektron
CMS400.NET makes room for new onesby removing old ones that have been in the cache for
the longest time.

If you increase the number, it is possible that your performance will improve. But at some point,
the size of the cachemaydegrade your server’s performance. See Also:Clearing theManual
AliasCache on page 10-19

Cache
Duration
(Seconds)

Enter the number of seconds for which anynon-aliased URL is retained in the server’s cache.
After this number of secondshaspassed, it is flushed from the cache. See Also:Clearing the
ManualAliasCache on page 10-19

Note: If your Ektron CMS400.NET supportsmulti-site configurations, this setting only
affects the site to which you are logged on. To set a cache duration for other sites, sign in to
each site’sWorkarea > Settings > Url Aliasing > Settings, then set its cache duration
values.

URL Alias - Order of Priority
When URL Alias names are identical but set as Manual or Automatic etc., then
the Alias Hierarchy rules apply in the following order.
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Priority
Order

Template or Alias Type

1 Template Name (.aspx)

2 ManualAlias

3 AutomaticAlias

4 RegExAlias

5 CommunityAlias

As an example, consider the case where a template exists called help.aspx. If
an administrator decides that the new content they create should have a
manual alias called help.aspx, then the template will still display. A template
name has priority over the manual content alias. (You may change the alias
settings to override the template.)

Another example is where someone has created amanual alias like
help.aspx.Later, someone decides to turn on Community Group Aliasing and
add the community group called help with an aspx extension. In this case, the
manual alias content will be shown. Manual Alias has priority over Community
Alias.

Restrictions on Extensions
Note: The following restrictions only apply if your server runs IIS7.

This section explains how IIS7 handles Web page extensions other than .aspx.
There are two scenarios.

n Some of your site’s pages have non-.aspx extensions. So, IIS7 needs
to handle requests for those pages. See Your Site Has non-aspx
Pages below.

n You site previously had non-.aspx pages but no longer does. You
want to set up aliases for these pages, so site visitors’ bookmarks
will still work. See You Want to Set up Aliases for non-aspx Pages on
page 10-17.

Your Site Has non-aspx Pages
If any of your site’s pages have extensions other than .aspx (for example, .asp,
.php, .cfm), follow these steps to move them above ek* in the Handler
Mappings list. (Extensions below ek* are handled by aliasing.)

1. Open IIS7.

2. Right click your Web site.

3. Click Handler Mappings.

Restrictions on Extensions
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4. Click View Ordered List.

5. Move non-aspx extensions used on your site above ek*. For
example, if your site uses .asp pages, move ASPclassic above ek*.
See below.
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Once you do this, you cannot use these extensions as part of an alias. So, do
not enter them into the Extension field of the URL Aliasing Configuration
screen.

You Want to Set up Aliases for non-aspx Pages
If you want to use extensions other than .aspx for aliasing Web pages, follow
these steps.

1. Open IIS7.

2. Right click your Web site.

3. Click Handler Mappings.

4. Click View Ordered List.

5. On the Handler Mappings screen, move non-aspx extensions that you
want to alias below ek*. For example, if your site uses .asp pages,
move ASPclassic below ek*.

6. Enter the extensions in the Extension field of the URL Aliasing
Configuration screen. See Also: Configuring URL Aliasing on page 10-
8

Activating Custom Extensions
By default, Ektron CMS400.NET supplies the following extensions.

n .aspx

n / (the slash is actually the lack of an extension at the end of a page’s
name)

If you want to enable other extensions, follow these steps.

1. Go to the Ektron CMS400.NET Workarea > Settings >
Configuration > URL Aliasing > Settings screen.

2. Enter the new extension into the Extension field and click Save (
). See Also: Extension on page 10-12

3. If Wildcard Mapping in IIS is turned on, you are done.

If Wildcard Mapping in IIS is turned off, you must enter the new
extension into IIS. To do this, go to the Windows Start button >
Administrative Tools > IIS manager.

4. Open theWeb Sites folder, right click your Web site then choose
Properties.

5. Click the Home Directory tab.

6. Click the Configuration button.

7. Scroll down to and double click the .aspx extension.

YouWant to Set up Aliases for non-aspx Pages
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8. Copy the path to aspnet_isapi.dll. (The path is found in the Executable
field.)

9. On the Application Configuration window, click Add.
10. The Add/Edit Application Extension Mapping screen appears.

11. In the Executable field, paste the path to aspnet_isapi.dll (which you
copied in Step 8).

12. In the Extension field, enter the extension that you are activating.
See example below.
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13. Uncheck the Verify that file exists checkbox.

14. Click OK.

Clearing the Manual Alias Cache
Each aliasing type (Automatic, Manual, RegEx and Community) has Cache Size
and Cache Duration fields, which let you determine conditions that
automatically clear each cache. However, you can manually clear a specific
cache at any time. For example, to clear the Manual Cache, follow these steps.

Warning! If your Ektron CMS400.NET supports multi-site configurations, you must sign in to each
site’s Workarea, then manually clear its cache.

1. Click the appropriate Settings > URL Aliasing screen. For
example, to clear the Manual Aliasing cache, click Settings > URL
Aliasing > Manual.

2. Click Clear Cache ( ).

Clearing the Cache for All URL Aliases
Warning! If your Ektron CMS400.NET supports multi-site configurations, you must sign in to each
site’s Workarea, then manually clear its cache.

1. Click Settings > URL Aliasing >Settings.

Clearing theManual Alias Cache
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2. Click Refresh ( ) to clear the cache for all URL aliases.

Setting Default Documents
The concept of default document is explained in the following Microsoft KB
article:
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/dc6eb1b4-
9028-4308-9935-52b64edfad36.mspx. Essentially, it lets you establish a default
document for client requests to a Web site that do not specify a document
name. For example, www.example.com/jobs. If the default document is
default.aspx, this URL resolves to www.example.com/jobs/default.aspx.

When using Ektron CMS400.NET Release 7.6 or higher, you identify one or more
default documents in the siteroot/web.config file’s ek_DefaultPage element
(shown below).

Note: The ek_DefaultPage element determines your Web site’s default document whether or
not you are using URL Aliasing.

So when a site visitor enters an address that includes your domain but no page
name, Ektron CMS400.NET refers to ek_DefaultPage’s values. In the above
example, the first page is default.aspx. If found, that page displays. If not, it
looks for the second page listed, etc.

If none of the pages is found or a page is not specified in ek_DefaultPage, what
happens next depends on the IIS version that your server is running.
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IIS
version

Result if pages listed in ek_DefaultPage are not found

6
n if ek_DefaultPage is blank in web.config, default documents listed in IIS6 are used.

n if ek_DefaultPage hasone or more pagesbut none of them exists on the server, a Page not
Found (404) message appears.

7
Page not foundmessage appears in browser.

Because Ektron CMS400.NET assumes responsibility for letting you define the default document,
default documents specified in IIS 7 are ignored.

Automatic URL Aliasing
Automatic aliasing lets you assign an alias to several content items at once. You
identify content by either taxonomy or folder. Then, select additional elements
of the alias pattern and save all information as a configuration.

You can create one automatic aliasing configuration for each folder or
taxonomy. Since a single content block can be assigned to several taxonomies,
it can have many automatic aliases.

When an automatic alias configuration is activated, an alias is assigned to all
content in the taxonomy or folder (and its subfolders). From then on, that
content can be identified by its automatic alias. In addition, any content added
to the folder/taxonomy in the future will be assigned that alias as long as the
configuration is active.

This section also contains the following topics.

Enabling/Disabling Automatic URL Aliasing 10-21
Setting up Automatic Aliasing 10-22
Uniqueness Requirement for Automatic Alias Configuration 10-25
The Automatic Alias Pattern 10-25
Viewing and Editing Automatic Alias Configuration 10-27
Viewing an Automatic Alias 10-27
Deactivating an Automatic Aliasing Configuration 10-28
Deleting an Automatic Aliasing Configuration 10-28

Enabling/Disabling Automatic URL Aliasing
To enable automatic aliasing, follow this path: Settings > Configuration >
URL Aliasing > Settings. The screen indicates if automatic aliasing is
currently on or off.

Automatic URL Aliasing
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To change its state, click the Edit button ( ), check or uncheck the box, and
click the Save button ( ).

Setting up Automatic Aliasing
After enabling automatic URL aliasing, you can create a configuration, which
lets you

n identify the content source (that is, a taxonomy or a folder)

n choose elements of the aliasing pattern

n preview sample original and aliased URLs

To create an automatic alias configuration, follow these steps.

1. Open the Settings > Configuration > URL Aliasing > Automatic
screen.

2. If you are creating an alias based on Taxonomy, select its language
from the language dropdown.

If you creating an alias based on folder, go to Step 3.

Note: On the Auto Aliased Page Name Maintenance screen, a folder-based alias’ Lang
column shows a United Nations flag ( ). This indicates that folders are language-neutral.

3. Click the plus sign ( ) to access the Add a New Alias screen (shown
below).
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4. Use the following table to complete the screen.

Field Description

Active

Check this box to apply this configuration to content. If you do, the aliasesare applied when
you save the screen.

If you uncheck this box, automatic aliases set up via this configuration are deleted from the
associated content.

Source Type Automatic aliasesare based on either a taxonomyor a folder. Choose one.
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Field Description

AliasRoot

Navigate to and choose a taxonomyor folder to which you want to assign an automatic
alias.

If you choose a taxonomy, the automatic alias is applied to all content assigned to it and all
of its child nodes. See Also:

Furthermore, if your Ektron CMS400.NET supportsmulti-site configurations, the
automatic aliaswill apply to content in all sites. This is because taxonomy is site
independent.

Note: If the language selector was set toAll on the Auto Aliased Page Name
Maintenance screen, and you chose Taxonomy as theSource Type,No Taxonomy
appears here. This indicates that youmust return to the Auto Aliased Page Name
Maintenance screen and select a language before you can select a taxonomyas the
AliasRoot.

If you choose folder, the automatic alias applies to all content in that folder and its
subfolders. See Also:

The taxonomyor folder is part of the automatic alias pattern. See Also: The AutomaticAlias
Pattern on the facing page

AliasFormat

Use this field to help construct the automatic alias pattern. Choose one of the following
items to identify the content within the alias.

ContentTitle - Example: Sample Content Block

ContentID - Example: 30

ContentIDandLanguage - Example: 30/1033

See Also: The AutomaticAliasPattern on the facing page

Extension

Use this field to help construct the automatic alias pattern. Choose an extension from the list
to identify the end of the aliased URL.

Extensionsare defined in theExtension field of the URL Aliasing Configuration screen.

See Also: The AutomaticAliasPattern on the facing page;AutomaticURL Aliasing on page
10-21

Replacement
Character

Enter the character that replacesprohibited characters in content titleswhen theyappear
within an automatic alias. Examplesof prohibited characters are a space and question
mark (?).

So, for example, if the content title is About Us, and you enter an underscore (-) here, the
aliased version of the title isAbout_Us.

You cannot enter one of the following as the replacement character: [, \ / < > (Space): |? '] #
* &%

Note: If you're using IISdmin (Microsoft Vista or Server 2008), and specify a plus sign
(+), you get this error: HTTP Error 404.11 Not Found The request filtering
module is configured to deny a request that contains a double

escape sequence. For a solution, see http://support.microsoft.com/kb/942076/en-us.

Creating User-Friendly URLswith Aliasing

10-24 ReferenceManual
Version 8.01 Rev 4

http://support.microsoft.com/kb/942076/en-us
http://support.microsoft.com/kb/942076/en-us


Field Description

SourceQue-
ryString
Param

Enter the query string parameter for this alias. For example, if the alias usesa taxonomy,
you could enter taxid.

Here is an example of the parameter in a URL:
http://localhost/eIntranetv2/Blogs.aspx?id=238&blogid=115&taxId=281

Warning! Do not enter idhere because that will clash with the content id.

Do not enter more than one parameter.

Customize
AliasPath

Bydefault, the automatic alias pattern displaysall folders or taxonomy levels from the top to
the level you select. (The AutomaticAliasPattern below)

You can use this field to controlwhich folders/taxonomy levels appear in the pattern.

For example, your AliasRoot is based on the following folder path: /CMS400Demo/About
Us/Careers. Using this field, you can choose anyof the following to indicate the folder or
taxonomypath in the automatic alias pattern.

Preview Alias

This area of the screen displays

n a sampleOriginal URL

n an aliased example of that URL, based on the information entered on the screen

To see any content item’s fully aliased URL, navigate to it and click itsAlias tab.

Uniqueness Requirement for Automatic Alias
Configuration
A configuration must have a unique combination of Source Type, Alias Root,
Alias Format, and Extension. For example

n Source Type = taxonomy

n Alias Root = the taxonomy named Products

n Alias Format = Content title

n Extension

You cannot create a configuration whose values match an existing one.

The Automatic Alias Pattern
The Automatic Alias pattern combines the following elements in this order. Each
element is separated by a slash (/).

UniquenessRequirement for Automatic Alias
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1. site root

2. folder or taxonomy path (Spaces are replaced by the Replacement
Character specified on the Add/Edit Alias screen).

Note: Either a taxonomy or a folder is selected when creating an automatic aliasing
configuration.

By default, a taxonomy path has all taxonomy nodes from the top to the
level at which content is assigned. Here is an example:
www.example.com/Medical_Conditions/Kidney_Disease/.

By default, a folder path has all folders from the top-level to the folder
that contains the content. Here is an example:
www.example.com/CMS400Developer/CMS400Demo/About_Us/Company_
Profile/Board_of_Directors.aspx.

Note: You can use the Customize Alias Path field to determine which path components
appear in the pattern. See Also: Customize Alias Path on previous page

3. content name source (Spaces are replaced by the Replacement
Character specified on the Add/Edit Alias screen)

4. extension

Examples:

Folder-based automatic alias

www.example.com/CMS400Demo/About_Us/Company_Profile/Awards_and_Honors/

www.example.com/CMS400Demo/About_Us/Company_Profile/12548/

www.example.com/CMS400Demo/About_Us/Company_Profile/12584/1033

Taxonomy-based automatic alias

www.example.com/cms400/MapCategory/Restaurant/Chinese/You_You_Japanese_Bis-
tro/

Note: Ektron CMS400.NET lets users create content with the same title in different folders. If an
automatic alias based on a taxonomy is created, and the same taxonomy node is applied to
two content items with the same title, both items will have the same automatic alias. To avoid
this problem, do not allow users to assign the same name to more than one content item.

Creating User-Friendly URLswith Aliasing
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Viewing and Editing Automatic Alias
Configuration
To view and edit an automatic alias configuration, go to the Settings >
Configuration > URL Aliasing > Automatic screen.

Note: Use the screen’s language selector to find taxonomy-based configurations of a selected
language.

From the Auto Aliased Page Name Maintenance screen, click the alias
configuration that you want to view.

To edit an automatic alias, view it then click the Edit button ( ). To learn about
the screen’s fields, see Use the following table to complete the screen. on page
10-23.

Automatic URL Aliasing on page 10-21

Viewing an Automatic Alias
To view the automatic alias assigned to a specific content item, navigate to and
view the content. Then, click the Alias tab (shown below). A primary manual
alias appears near the top, followed by all automatic aliases.

Viewing and Editing Automatic Alias Configuration
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Deactivating an Automatic Aliasing
Configuration
Follow these steps if you want to temporarily deactivate an automatic alias
configuration. When you do, automatic aliases created by that configuration are
removed from all content to which they are applied. The configuration is saved,
so if you later want to reactive it, simply undo these steps.

1. Open the Settings > Configuration > URL Aliasing > Automatic
screen.

2. Click the alias that you want to deactivate.

3. Click the Edit button ( ).
4. Uncheck the Active checkbox.

5. Click the Save button ( ).

Deleting an Automatic Aliasing Configuration
Follow these steps if you want to delete an Automatic Aliasing Configuration.
When you do, automatic aliases are removed from all content to which they are
applied.

1. Open the Settings > Configuration > URL Aliasing > Automatic
screen.

2. Click the delete button ( ).

3. Check each configuration that you want to delete.

4. Click the delete button ( ).

5. You are asked if you are sure.

6. Click OK.

Manual Aliasing
When using manual aliasing, you choose a page name. Next, you specify the
content to appear whenever anyone enters the URL using that name into a
browser address field. For example, you can alias
www.example.com/cms/index.aspx as www.example.com/cms/Launch.html.
From then on, the content can be identified either by its original URL or its alias.

You can assign any number manual of aliases to a content block.

Note: You cannot manually alias the root of your Web site (for example, www.example.com).
You can, however, alias everything below that.

This section also contains the following topics.

Manual Aliasing and Multi-Site 10-29
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Enabling/Disabling Manual Aliasing 10-29
Assigning a Manual URL Alias to Content 10-29
Adding a Manual Alias via the Page Name Maintenance Screen 10-30
Adding a Manual Alias via the Alias Tab 10-34
Viewing a Manual Alias 10-34
Editing a Manual URL Alias 10-35
Removing a Manual Alias 10-36
Removing a Manual Alias via the Content Alias Tab 10-36

Removing Manual Alias via the Page Name Maintenance Screen
10-
37

Manual Aliasing and Multi-Site
If your Ektron CMS400.NET deployment uses multi-site, the following
restrictions apply to manual aliasing.

n Any manual alias applied to the root site cannot be applied to any of
the additional sites

n Any manual alias applied to an additional site cannot be applied to
the root site

However, the same manual alias can be applied to any number of additional
sites.

Enabling/Disabling Manual Aliasing
To activate manual aliasing, follow this path to the URL Aliasing Configuration
screen: Settings > Configuration > URL Aliasing > Settings.

The screen indicates if manual aliasing is currently on or off. To change its
state, click the Edit button ( ), check or uncheck the box, and click the Save (
) button.

Assigning a Manual URL Alias to Content
Two screens let you manually alias content.

Manual Aliasing andMulti-Site
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Screen/tab
Who is
authorized to
use

Can create/update these
manual aliases

For more information,
see

PageName
Maintenance

membersof
Administrators
group

an unlimited number of
primary and secondary

Adding aManualAlias via
the Page Name
Maintenance Screen
below

Alias tab of View
Content screen (see
image below)

n membersof
Administrators
group

n users
assigned Alias-
Edit role

primary (Alias tab displays
but doesnot let users
change secondary aliases)

Adding aManualAlias via
the AliasTab on page 10-
34

Adding a Manual Alias via the Page Name
Maintenance Screen
Prerequisites

n Manual aliasing is enabled. See Also: Enabling/Disabling Manual
Aliasing on previous page

n You are a member of the Administrators group

To add a manual alias via the Page Name Maintenance screen, follow these
steps.

1. Go toWorkarea > Settings > Configuration > URL Aliasing >
Manual.

2. The Manual Aliased Page Name Maintenance screen appears.

Creating User-Friendly URLswith Aliasing
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The following table explains the buttons on the screen.

Button Description For more information, see

Addmanual alias If Creating a New Aliason next page

Deletemanual
alias

RemovingManualAlias via the Page NameMaintenance Screen on
page 10-37

Manually clear
cache Clearing theManualAliasCache on page 10-19

The following table explains the fields on the screen.

Field Description

Primary

If you assignmore than onemanual alias to content, this field designates the primary one. If you
only assign one, it is the primary bydefault.

The primary alias appears in the browser when a user hovers the cursor over a link to associated
content, such aswithin a List Summaryor a Collection. It also appears in the browser address
field after the content is selected. SeeExample of an Alias in the Browser on page 10-6.

If a user viewsa content block’sAlias tab, he can only see and edit the primarymanual alias. See
Also:Adding aManualAlias via the AliasTab on page 10-34

Active Indicates if this alias is active.

Lang The alias’s language flag.

Alias The alias (that is, the page name) that site visitors can enter aspart of the URL into a browser to
see the associated content.

Original
Link The content template and variable being aliased.

Content
ID The ID number of the content assigned to the alias.

3. To edit an existing manual alias, use the language selector dropdown
(see image below) to choose the language of the aliases you want to
work with.

Adding aManual Alias via the Page Name
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If you are creating a new alias, click the Add Alias button ( ) and skip
to Step 8.

4. If your Ektron CMS400.NET version supports multi-site
configurations, use the Site dropdown to choose the site.

5. Click the alias you want to edit.

Note: If there are many aliases, use the search to help find one. You can filter aliases by alias
name, Content ID, etc.

6. The View Alias screen appears. Click the Edit button ( ).
7. The Add/Edit Manual Alias screen appears.

8. If Editing an Existing Alias
If this is not the primary alias, you can check or uncheck the Active
checkbox. Only active aliases can be entered into the browser address
field to display the assigned content.

If this is the primary alias, you cannot uncheck it. If you want to
inactivate a primary alias, first assign another alias to be the primary
for this content block. Then, return to this screen and make this alias
inactive. Alternatively, you can delete a primary alias.

If Creating a New Alias

Check the Active checkbox if you want this alias to be active.

Creating User-Friendly URLswith Aliasing
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9. Check the Primary box if you want this to be the primary alias. See
Also: Primary on page 10-31

If another alias is the primary when you check this box, the other alias
is no longer the primary.

10. In the Alias field, enter the alias name. It cannot include the
following characters: (comma), (space), \, <, >, “,:, |. Also, it must
be unique within this site and language.

To the right of Alias Name is a pull-down of valid extensions. Select
one to apply to this alias. Extensions are defined on the URL Aliasing
Configuration screen. See Also: Extension on page 10-12

11. Click Select a Content Block to choose content. The QuickLink
Select window appears.

Note: Only content in the language chosen on the Page Name Maintenance screen appears.

12. Navigate through the folder structure and click the content to which
you are assigning the alias.

Note: A folder’s content appears below its subfolder list. You may have to scroll down to see
the content.

13. The Title, Link and Quick Link fields fill in, using information from
the selected content.

If the content has more than one quicklink assigned to it, select the one
to which you are assigning the alias.

14. To learn about the QueryString Action field, go to .

15. Enter the Additional Variables. These are used as query string
parameters that can track how visitors arrived at the aliased page.
You might use these for marketing campaigns, to analyze the source
of an aliased page’s visitors.

For example, the Additional Variables field has ?gclid=CO7gs_L0_
ZICFRkTIgodBgV9CQ. Your Web site's analytics software can track the
source of the query through the variable.

Note:Within the page load event that returns the query string parameters, use the
Request.RawURL() property instead of request.querystring.

16. Click the Save button ( ).
See Also: Manual Aliasing on page 10-28
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Adding a Manual Alias via the Alias Tab
Once manual aliasing is enabled, every content block includes an Alias tab. You
can use that tab to view and update the content’s primary alias.

Note: If you insert/update an alias via the Alias tab, it only goes live after the content is
published.

Prerequisites

n Manual aliasing is enabled. See Also: Enabling/Disabling Manual
Aliasing on page 10-29

n You are a member of the Administrators group or assigned to the
Alias-edit Role. If neither, you do not see the Alias tab.

To add a manual URL alias via the Alias tab, follow these steps.

1. In the Workarea, select Content.

2. Navigate to and click the content you want to work with.

3. Click the Edit button ( ).
4. The Edit Content screen appears.

5. Click the Alias tab.

6. In the Primary Alias Name field, enter the name of the primary
alias.

The name cannot include the following characters: (comma), (space), \,
<, >, “,:, |. Also, it must be unique within this site and language.

7. To the right of Primary Alias Name is a pull-down of valid
extensions. Select one to apply to this manual alias.

The extensions are set up in the URL Aliasing Configuration screen’s
Extension field. See Also: Extension on page 10-12

8. Save and publish the content.

Viewing a Manual Alias
To view a manual URL alias, follow these steps.
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1. Go toWorkarea > Settings > Configuration > URL Aliasing >
Manual.

2. On Manual Aliased Page Name Maintenance screen, click the alias
you want to view.

3. The alias information appears. To learn about the screen’s fields, see
The Add/Edit Manual Alias screen appears. on page 10-32.

Editing a Manual URL Alias
You can edit any manual alias via the Edit Alias screen. This lets you change all
fields completed when the alias was created: name, assigned content, etc.

Note: You can also edit a content block’s primary alias name via the Alias tab on the content
screen. See Adding a Manual Alias via the Alias Tab on previous page.

To edit a manual URL alias, follow these steps.

1. Go toWorkarea > Settings > Configuration > URL Aliasing >
Manual.

2. On Manual Aliased Page Name Maintenance screen, click the alias
you want to edit.

3. The View Alias screen appears. Click the Edit button ( ).
4. The Edit Alias screen appears.

5. Make any changes. To learn about the fields, see If Editing an
Existing Alias on page 10-32.

If this is the only alias assigned to the content, you cannot uncheck
Primary or Active.

Editing aManual URL Alias

ReferenceManual
Version 8.01 Rev 4

10-35



If other aliases are assigned to the content, and you want to make one
of them the primary, edit that alias and check the Primary checkbox.
You cannot uncheck Primary from this screen.

Also, only secondary aliases can be inactivated by unchecking the
Active checkbox.

6. Click the Save button ( ).

Removing a Manual Alias
Just as there are two ways to add a manual alias, there are two ways to remove
one.

n Removing a Manual Alias via the Content Alias Tab below

n Removing Manual Alias via the Page Name Maintenance Screen on
the facing page

Removing a Manual Alias via the Content Alias
Tab
Using a content block’s Alias tab, you can delete a primary manual alias only if
no secondary aliases exist. If secondary aliases exist and you want to delete or
replace the primary alias, you must use the Manual Aliased Page Name
Maintenance screen. See Also: Removing Manual Alias via the Page Name
Maintenance Screen on the facing page

You can neither see nor delete secondary manual aliases from the Alias tab.

Note: If you delete an alias via the Alias tab, the change only goes live after the content is
published.

To remove the primary manual alias by editing the associated content block,
follow these steps.

1. Browse to the content block associated with the alias.

2. Click Edit.

3. Click the Alias tab.

4. Delete or replace the value in the Primary Alias Name field.

5. Click Save, Check in, or Publish.
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Removing Manual Alias via the Page Name
Maintenance Screen
Using the Page Name Maintenance Screen, you can delete the primary and any
secondary manual aliases.

Warning! If you want to delete a primary manual alias while secondary aliases exist, you must
first designate one of the secondary aliases as the primary. You can only delete the primary alias
if no secondary aliases exist.

To remove a manual alias via the Page Name Maintenance Screen, follow these
steps.

1. Go toWorkarea > Settings > Configuration > URL Aliasing >
Manual.

2. On Manual Aliased Page Name Maintenance screen, click the Remove
button ( ).

3. Check the box next to all aliases you want to remove.

4. Click the Delete button ( ).

5. Click OK to confirm.

Using RegEx Expressions
RegEx expressions allow site visitors to enter a human-readable URL into the
browser address field and transform that entry into the query string component
of an Ektron CMS400.NET page. The benefit is that the site visitor can “guess”
other pages based on an easily recognizable pattern.

For example, a RegEx expression aliases
blogs.aspx?blogmonth=3&blogyear=2006&blogid=41 as blogs/2006/03/41.
From that, a site visitor can infer that he can enter blogs/2006/03/40 to see
the previous post, enter blogs/2006/03 to see all March 2006 posts, etc.

This section provides a description of the screen’s fields, then a step-by-step
explanation of how to create and validate a RegEx expression.

This section also contains the following topics.

Add a RegularExpression Screen 10-37
Instructions for Creating a RegEx Expression 10-39
Viewing a Regular Expression 10-41
Editing a Regular Expression 10-41
Deleting a Regular Expression 10-41

Add a RegularExpression Screen
To access the Regular Expression screen, follow these steps.
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See Also: Using RegEx Expressions on previous page; Instructions for Creating
a RegEx Expression on the facing page

1. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > URL Aliasing > RegEx.

2. Click the Add button ( ).
3. The Add a Regular Expression screen appears.

4. Use the following table to complete the screen.

Field Description
For more
information, see

Active

Check this box to activate the expression. If the expression is
active, site visitors can enter an aliased URL to accessa page
on your site.

For example, they can enter
www.example/com/blogs/2006

/03/41 to accessa blog page even though the actualURL is
www.example/com/blogs/
blogs.aspx?blogmonth=3&

blogyear=2006&blogid=41

Expression
Name

Assign an easily recognizable name to this regular
expression. It appears on the RegExAliased Page Name
Maintenance screen to help users identify it.
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Field Description
For more
information, see

Expression

Enter a RegExexpression that will replace the variables (for
example, $1, $2, etc.) in the Expressionmap.

If you want to insert a questionmark into the Expression, you
must precede it with a backslash (\).

n Instructions for
Creating a RegEx
Expression below

n http://regexlib.com/

Expression
Map

Enter amap of originalURL elements. Themap lets you
replace query string parameterswith variables, such as$1,
$2, etc. Asa result, a site visitor can identify anypage that
uses this pattern by changing the variable values.

You can clickExpression Library to view examplesof
RegExexpressionmaps. To copyanymap that resembles
your page pattern, click it. You can thenmodify is as
necessary.

Instructions for Creating
a RegExExpression
below

Example
URL Displaysan example ofWeb page that follows this pattern.

Priority

Assign a priority to this expression from the following choices.

n high

n medium

n low

n none

Assign high to expressions that will be usedmost frequently.

This field helps the aliasing feature respond quicklywhen site
visitors enter expressions into the browser address field. This
is because aliasing first tries tomatch a site visitor’s entrywith
high priority expressions, thenmedium, then low.

Requested
URL

Enter a user-friendly pattern that site visitors can insert to
accesspageson your site. This pattern replaces the query
string component of a URL.

For example, blogs/2006/03/41.

Instructions for Creating
a RegExExpression
below

Transform
button

After completing all fields on the screen exceptResulting
URL, use this button to check the validity of theExpression,
Expression Map andRequested URL fields.

Resulting
URL

Valuesappear in this field after you click the Transform
button. It uses theExpression andExpression Map field
values to translate a Requested URL (one a site visitor will
enter) into a Resulting URL (the page’s actual query string
parameter).

Instructions for Creating a RegEx Expression
Use the following steps as a guide to creating a Regex expression.
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1. Find a site page (such as a blog) whose query string parameters allow
users to guess similar pages using a pattern. For example

http://ecmintranet/blogs.aspx?blogmonth=3&blogyear=2006

2. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Url Aliasing > RegEx.

3. Click the Add a Regular Expression button ( ).
4. Give your expression a name.

5. Click Expression Library.

6. Find and click an Expression Map similar to the page you found in
Step 1. To continue our example, choose

PageName.aspx?year=$1 & month=$2

7. The Expression and Example URL field values fill in, using
information from the Expression Map.

8. As needed, adjust the values in the Expression map or the RegEx
expression to match your page name. For example, change
PageName to blogs, and delete Default.aspx.

See Also: http://regexlib.com/

9. To continue the example, change the Expression Map field so that it
looks like this.

10. Click the Transform button to verify that the resulting URL matches
the original page pattern. If it does not, check all steps, especially the
Expression field.
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Viewing a Regular Expression
To view a regular expression, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > URL Aliasing > RegEx.

2. Click the expression whose information you want to view.

To learn more about the fields on the screen, see Use the following table to
complete the screen. on page 10-38.

Editing a Regular Expression
To edit a regular expression, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > URL Aliasing > RegEx.

2. Click the expression whose information you want to edit.

To learn more about the fields on the screen, see Use the following table to
complete the screen. on page 10-38.

Deleting a Regular Expression
To delete a regular expression, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > URL Aliasing > RegEx.

2. Click the delete button ( ).

3. Check the box next to the expression you want to delete.

4. Click the delete button ( ).

See Also: Using RegEx Expressions on page 10-37

Community URL Aliasing
Community aliasing lets you assign an alias for community groups or users so
that a site visitor can enter an easy to use URL to find them.

For example, if John wants to make a URL for a community group called
"Marketing", he sets the Community alias so that the following URL is used to
find this group: http://<website>/Marketing/

If he wants a friendly URL for his name, he can set the Community Alias type to
User so he can use this URL: http://<website>/John/

This section also contains the following topics.

Enabling/Disabling a Community URL Alias 10-42
Setting up a Community Alias 10-42
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Viewing and Editing Community URL Alias Configuration 10-43
Deactivating a Community URL Alias 10-44
Deleting a Community URL Alias 10-44
Troubleshooting Community URL Aliases 10-45
Notification Messages use Community URL Aliases 10-45

Enabling/Disabling a Community URL Alias
To enable Community aliasing, do the following steps.

1. In the Workarea, go to Settings > Configuration > URL Aliasing
> Settings. The URL Aliasing Configuration looks like this.

2. Click Edit ( ).
3. Check the box to enable or uncheck it to disable Community Aliasing.

4. Click Save ( ).

Setting up a Community Alias
After enabling Community URL Aliasing, you can

n Set the Community Aliasing type to be User or Group

n create a custom path for the URL string

To configure a Community Alias, follow these steps.

1. Open the Settings > Configuration > URL Aliasing >
Community screen.

2. Click Add ( ) to access the Add a New Community Alias screen
(shown below).

3. Set the following Properties. The table below shows the Properties
and Descriptions on the Community Alias screen.

Property Description

Active Check this box to Enable this configuration.When you save this page, the aliasesare
immediately applied. If you uncheck this box, this alias is not active on theWeb site.

Primary Whenmore than one Alias exists, checking this boxmakes this alias the one that is used in
Quicklinks.

AliasPath
Enter text to use in the URL before the name of the User or Group. For example, if you
enter: "people", then the URL to a user named John would look like this:
http://<sitename>/people/john
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Property Description

Extension

Use this field to help construct the automatic alias . Choose an extension from the list to
identify the end of the URL. Default choicesare /, .aspx, .htm

Extensionsare defined in theExtension field of the URL Aliasing Configuration screen.

See Also:CommunityURL Aliasing on page 10-41;CommunityURL Aliasing on page 10-
41

Replacement
Character

Enter the character that replacesprohibited characters in content titleswhen theyappear
within an automatic alias. Examplesof prohibited characters are a space and question
mark (?).

For example, if the content title is About Us, and you enter an underscore (_) here, the
aliased version of the title isAbout_Us.

You cannot enter one of the following as the replacement character: [, \ / < > (Space): |? '] #
* &%

Note: If you're using IISAdmin (Microsoft Vista or Server 2008), and specify a plus sign
(+), you get this error: HTTP Error 404.11 Not Found The request filtering
module is configured to deny a request that contains a double

escape sequence. For a solution, see http://support.microsoft.com/kb/942076/en-us.

SourceQue-
ryString
Param

Enter the query string parameter for this alias. For example, if the alias usesa taxonomy,
you could enter taxid.

Here is an example of the parameter in a URL:
http://localhost/eIntranetv2/Blogs.aspx?id=238&blogid=115&
taxId=281admin

Warning! Do not enter idhere because that will clash with the content id.

Do not enter more than one parameter.

LinkExample
Preview

This area of the screen displays

n a sampleOriginal URL

n an aliased example of that URL, based on the information entered on the screen

To see any content item’s fully aliased URL, navigate to it and click itsAlias tab.

Viewing and Editing Community URL Alias
Configuration
To view and edit a Community Alias configuration, go to the Settings >
Configuration > URL Aliasing > Community screen.

Click the Alias Path name that you want to view or edit.
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Click Edit ( ) to make changes to the configuration. To learn about the screen’s
fields, see Setting up a Community Alias on page 10-42.

Deactivating a Community URL Alias
Follow these steps to temporarily deactivate a Community URL alias. When you
do, Community aliases are removed from all users or groups to which they are
applied. The configuration is saved, so if you later want to reactive it, simply
undo these steps.

1. Open the Settings > Configuration > URL Aliasing >
Communityscreen.

2. Click the Alias Path that you want to deactivate.

3. Click Edit ( ).
4. Uncheck the Active checkbox.

5. Click Save ( ).

Warning! You cannot Deactivate a Primary Alias when secondary aliases exist. First set the other
alias to primary, then deactivate the alias that is not primary.

Deleting a Community URL Alias
Follow these steps if you want to delete an Automatic Aliasing Configuration.
When you do, automatic aliases are removed from all content to which they are
applied.

1. Open the Settings > Configuration > URL Aliasing >
Communityscreen.

2. Click delete ( ).

3. Check each configuration that you want to delete.

4. Click delete ( ) again.

5. You are asked if you are sure.

6. Click OK.

Warning! You cannot delete a Primary Alias when secondary aliases exists. First, set the another
alias to primary, then delete the alias that is not primary.
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Troubleshooting Community URL Aliases
If you do not see the Community URL Alias when you hover over or click a link
to a Group or User, check the following.

n Be sure that the Alias is set to Active. See Setting up a Community
Alias on page 10-42

n Be sure that the Alias is the Primary alias. See Setting up a
Community Alias on page 10-42.Setting up a Community Alias on
page 10-42

n Be sure that the Server Control that displays the link does not use the
"TemplateUserProfile" setting. If so, the value set in this property
will take precedence over the URL alias. For one server control
example, see ActivityStream Server Control on page 16-178.

n If using eSync, be sure to Refresh the cache after a database sync.

Notification Messages use Community URL
Aliases
Activity Steams, SMS, and Email notification messages that have links to Users
or Groups use the Community URL Alias in their links. If you wish to show the
Community URL Alias, then use the proper @SubjectUser.TemplateAlias@
token in the message. For example, if you wish to use the Alias for the
SubjectUser, then use the @SubjectUser.TemplateAlias@ token in your
message.

See Working with Tokens on page 16-146 to learn more about working with
Message Tokens.

Site Aliasing
If your site supports the multi-site feature, you can enter aliases for any site.
For example, your company’s name just changed from Bionics to NewGen. You
can use the site aliasing feature to resolve the url www.bionics.com to
www.newgen.com.

Note: If your Ektron CMS400.NET supports multi-site configurations, an automatic alias
assigned to a taxonomy will apply to content in all sites. This is because taxonomy is site
independent.

Warning! If the site being aliased resides in a folder under your server’s Web root folder (for
example, ser4325/min), you must add the subfolder to the alias. So, to continue the above
example, you could not enter http://www. myalias.com as an alias for that site. Instead, you
would enter http://www.myalias.com/min/.

This section also contains the following topics.

Creating Site Aliases 10-46
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Setting up a Site Alias in the Ektron CMS400.NET Workarea 10-46
Editing a Site Alias 10-47
Deleting a Site Alias 10-48

Creating Site Aliases
Enabling site aliasing has two steps.

n Setting up a Site Alias in the Ektron CMS400.NET Workarea below

n Add each site alias as an IIS host. To learn how do this for your
server, please consult IIS help.

Setting up a Site Alias in the Ektron CMS400.NET
Workarea
To set up site aliases, follow these steps.

Note: You cannot assign a site alias to the site root folder.

1. Open the site folder for which you want to create aliases. (Site folders
have a globe icon, like this: ).

2. Click View > Properties.

3. Click the Edit button ( ).
4. Click the Site Alias tab.

5. Enter the alias into the Alias Name field.

Note: The alias cannot end with a slash (/).

From now on, if a site visitor enters the alias into a browser address field, he is
redirected to the site URL (set on the folder properties tab’s Production
Domain field).

Creating User-Friendly URLswith Aliasing
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Editing a Site Alias
Follow these steps to edit a site alias.

1. Open the site folder for which you want to create aliases. (Site

folders have an icon, like this: ).
2. Click View > Properties.

3. Click the Edit button ( ).
4. Click the Site Alias tab.

5. From the Alias list, click the alias that you want to edit. When you do,
it is highlighted in yellow and appears in the Alias Name field.

6. Change the alias text.

7. Click the Save button directly below the Alias Name field.

8. Click the screen’s Save button ( ).

Editing a Site Alias
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Deleting a Site Alias
Follow these steps to delete a site alias.

1. Open the site folder for which you want to create aliases. (Site folders

have a globe icon, like this: ).
2. Click View > Properties.

3. Click the Edit button ( ).
4. Click the Site Alias tab.

5. From the Alias list, click the alias that you want to delete. When you
do, it is highlighted in yellow and appears in the Alias Name field.

6. Click the delete icon ( ).

7. The alias is deleted.

Upgrading from Previous Releases
See the following Ektron CMS400.NET Knowledge Base article to learn about 7.6
and up URL Aliasing upgrade issues: http://dev.ektron.com/kb_
article.aspx?id=21358

Assigning an Alias to Multi-Language
Content
If Ektron CMS400.NET has several foreign-language versions of content that
share an ID, you can alias only one of them and check the URL Aliasing
Configuration screen’s Disable Language Awareness checkbox. Then, when
a site visitor selects a language in which to view your site and enters the alias,
Ektron CMS400.NET displays the aliased content in the selected language.

If you prefer, you can assign a different alias to each language version of
content. To do this, select the content, language, go to the Alias tab, and assign
a language-specific alias. For example, your English Careers page’s alias is
careers, while your Spanish alias is carreras, and your German alias is
Karrieren.

Creating User-Friendly URLswith Aliasing
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Also, alias names must only be unique within a language. So, for example, you
cannot have two aliases named Ektron within U.S. English content. But, you
can create two aliases named Ektron if one is applied to U.S. English content,
and the other applies to Spanish content.

Aliasing with Windows 2008 Server 64
Bit
If you want to use aliasing on a 64-bit server running Windows 2008, follow
these steps.

1. Install classic ASP onto the server. It is not installed by default. See
Also: http://technet.microsoft.com/en-us/library/cc753918.aspx

2. Open your site root/web.config file.

3. Find this tag:
<add name="ek*" path="*" verb="GET,HEAD,POST"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"
modules="ManagedPipelineHandler" scriptProcessor="" resourceType="Unspecified"
requireAccess="Script" preCondition="" />

4. Add the following ASP handler above the ek handler shown above.
<add name="ASPClassic" path="*.asp" verb="GET,HEAD,POST" modules="IsapiModule"
scriptProcessor="%windir%\system32\inetsrv\asp.dll" resourceType="File" />

Aliasing withWindows 2008 Server 64 Bit
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Multivariate testing allows you to offer several variations of the same page,
then measure site visitors' reactions to each variation. The one that generates
the most conversions is automatically promoted to the design for that page,
thereby maximizing your Web site's ROI.

The variations can alter any number of page elements (images, copy, buttons,
form fields, etc.) to find the combination that most effectively compels site
visitors to take the next step. No longer do you need to speculate on the best
page design -- now, you can use actual, timely data drive those decisions.

Ektron CMS400.NET Multivariate testing is easy to implement, requiring no help
from a developer or designer.

How Multivariate Testing Works
Content variations appear to site visitors during an experiment. The page
variation that a site visitor sees is randomly selected by the system. When a
visitor navigates to a special page called the target, it is logged as a conversion.
A conversion might be a donation, registration, sales lead, etc. Conversions are
tracked, and the variation that produces the most conversions is automatically
promoted to the Web site.

Sometimes, this type of testing is called “A/B Testing”, but Multivariate Testing
is far more than that. A/B testing provides only a few variations. With
Multivariate Testing, the number of page combinations grows exponentially as
the number of layout and content combinations increase.

Important: The Multivariate Testing feature requires the use of PageBuilder templates. For more
information, see Building Pages on page 5-5.

Also, the Multivariate testing feature is part of Ektron's Marketing Optimization
Suite. For more information about the suite, including webinars, white papers,
instant demonstrations, etc., see http://ektron.com/marketingoptimization/.

An Example of Multivariate Testing
In the example below, the marketing manager wants to know which of three
ads produces the most visits to a registration page.

Optimizing Page Layout with Multivariate Testing
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n The experiment page contains ads that link to a registration form.

n A target page contains the registration form.

n A conversion is a visits to the target page produced by each ad.

When the target number of conversions occurs, the variation achieving it
automatically becomes the permanent page on the site. The optimum page runs
on the web site without further effort by the Web site Admin.

This section also contains the following topics.

Using Widgets for Multivariate Testing on next page

Using PageBuilder Pages and Content on next page

Creating a Multivariate Experiment on page 11-5

Starting and Running an Experiment on page 11-8

Additional Information on page 11-11

An Example of Multivariate Testing
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Using Widgets for Multivariate Testing
You use the following PageBuilder widgets for Multivariate Testing.

Multivariate Experiment Widget

Multivariate Section Widget

Multivariate Target Widget

The widgets look like this in the PageBuilder Widget tray.

The following table describes each widget type.

Widget Name
Page
Used

Description

Multivariate
TargetWidget
Detailson page
11-15

Target
Page

When a page view occurs on a page containing thiswidget,
the conversion count is increased.

Multivariate
Experiment
Widget Details
on page 11-16

Experiment
Page

This controls the experiment. Settings include the target
content number, start/stop button and the Report hide/show
button. This is only available when logged in and editing the
PageBuilder experiment page.

Multivariate
SectionWidget
Detailson page
11-17

Experiment
Page

Thiswidget allowsyou to drag and drop various content
widgets into it. These produce the variationsused during the
experiment.

A slider control selects each specific content used in the
variations.

More than oneMultivariate Section widget can be used on a
page.

Using PageBuilder Pages and Content
Before you create a Multivariate Experiment, you will need to have two web
pages - the Target page and the Experiment page.

Both pages are created with PageBuilder which allows you to drag and drop
widgets into your page. For more information about PageBuilder, see Building
PageBuilder Pages on page 5-1. You may choose any type of widget for your
pages.

Optimizing Page Layout with Multivariate Testing
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Creating a Multivariate Experiment
Note: To run Multivariate Tests, you must be an Administrator or have the Multivariate Tester
Role assigned. For more information see Defining Roles on page 15-31.

To create a Multivariate experiment, follow these steps:

1. Create a target page that contains the Target Widget. See Creating a
Multivariate Target Page below

2. Create an experiment page that contains the content variations with
the Experiment and Section widgets. See Creating a Multivariate
Experiment Page on next page

3. Run the experiment until it automatically ends or you stop it. See The
image below shows a completed experiment page that has two
Section Widgets. on page 11-8

Creating a Multivariate Target Page
The target page is the Web page you wish your visitors to view. It contains the
Multivariate Target Wizard. Visitors arrive here by clicking links on the
experiment page.

To create the target page, follow these steps.

1. Create or edit the PageBuilder page with the target content.

2. Note the ID of the content number on this page. (For example: 948.)
This ID number is used in Step 3 below Creating a Multivariate
Experiment Page on next page.

3. Add the Multivariate Target widget to any location on the page.

This is how the Multivariate Target widget appears on the Pagebuilder
page.

4. Publish this page

Creating aMultivariate Experiment
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After creating the Target Page, create the Multivariate Experiment Page using
the following procedure.

Creating a Multivariate Experiment Page
The Experiment page contains:

n the Experiment Widget

n the Section Widget(s)

n the content variations

The illustration below shows the basic steps to create an experiment page with
Multivariate Test widgets.

Follow these steps.

1. Create or edit the PageBuilder page you wish to use during the
experiment. See Also: Building PageBuilder Pages on page 5-1

Optimizing Page Layout with Multivariate Testing
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2. Place the Multivariate Experiment widget in any location on your web
page. For more information, see Multivariate Experiment Widget
Details on page 11-16

Note: Do not worry about the appearance of this widget. Multivariate Test Widgets do not
appear on a Web page when you are not logged in. Only the content shows.

3. Enter the Target Page Content Id number. (For example, 948.) (See
step 2 of Creating a Multivariate Target Page on page 11-5)

To help find the content, browse the content folders by clicking the
button circled below.

4. Enter the Conversions before promote value. Setting this to 1000 tells
the experiment to automatically end when one variation has reached
1000 conversions.

5. Place at least one Multivariate Section widget into the location where
your content variations should appear. For more information, see
Multivariate Section Widget Details on page 11-17

6. Drag any type of content widget into the Multivariate Section widget.

7. Configure the content widget with the appropriate settings.

Note: You may use any widget inside the Multivariate Section Widget. The Content Widget
was chosen for illustration purposes here.

8. Add more variations by clicking the Add Variations button ( ) and
repeat steps 6 and 7. You now have variation 2 of 2.

Creating aMultivariate Experiment Page
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9. If you wish to add another section and variations, go back to step 5
and continue.

The image below shows a completed experiment page that has two Section
Widgets.

10. Publish the PageBuilder page.

Now you are ready to run the experiment.

Starting and Running an Experiment
Once you create the Target Page and Experiment Page, follow these steps.

1. Select the PageBuilder page that contains the Multivariate Experiment
Widget.

2. Click File > Edit to see the Experiment Widget.

3. On the Experiment Widget, click the Start button.

After you press Start, you see the Stop and Show Report buttons.

Optimizing Page Layout with Multivariate Testing

11-8 ReferenceManual
Version 8.01 Rev 4



Now that the experiment is running, visitors see the page variations. (Also see
Visitors See Randomized Variations below.)

Note: During an experiment, testers may modify variations and content within the Multivariate
Section widget.

This section also contains the following topics.

Visitors See Randomized Variations 11-9
Clicking the Reports Button During an Experiment 11-9
Previewing a Variation 11-10
Enabling or Disabling a Variation 11-10
Stopping the Experiment 11-10
Automatically Ending the Experiment 11-11
Manually Ending the Experiment 11-11

Visitors See Randomized Variations
When an experiment is running, visitors see a randomly-chosen page variation.
The visitor continues to see this variation until the experiment is ended.

Clicking the Reports Button During an
Experiment

Click the Show Reports button ( ) to see the experiment’s
progress. The reports shows:

n the percentage of conversions compared to visits

n the number of conversions

n the total number of visits to each variation

Visitors See Randomized Variations

ReferenceManual
Version 8.01 Rev 4

11-9



For more information about Reports, see Multivariate Experiment Widget
Details on page 11-16.

The experiment continues until it is either stopped or ends automatically or
manually.

Previewing a Variation
Click the Preview button ( ) to see the page variation that the progress bar
represents.

Enabling or Disabling a Variation
At any time during the experiment, you may disable any variation. Do this by

clicking the ( ) button which currently shows the variation is enabled. The
variation then becomes disabled and cannot be viewed by site visitors.

When a variation is disabled, visitors who have seen this page no longer see it
but see another variation instead.

You may re-enable a variation by pressing the ( ) button, which currently
shows the variation as disabled. The variation then becomes enabled and
visitors can view it.

Stopping the Experiment
At any time during the experiment, click the Stop button on the Experiment
Widget.

Optimizing Page Layout with Multivariate Testing
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This suspends the experiment. Counters stop incrementing, even though
visitors continue to see the page variations.

While the experiment is stopped, cookies are neither set nor read. For more
information about cookies see Cookies in Multivariate Testing on next page.

Note:When you stop an experiment, the Multivariate Section Widget remains on the
experiment page.

You may restart the experiment again by pressing the Start button. All counters
are reset to 0 and restarted.

Automatically Ending the Experiment
When one variation reaches the target number of conversions, it automatically
becomes the page variation all visitors see. All other variations are disabled.

Manually Ending the Experiment

During the experiment, you may click on the Promote button ( ) of the
specific variation you wish to promote. This ends the experiment, and the
selected variation becomes the page variation all visitors see. All other
variations are disabled.

Note:When the experiment automatically or manually ends, the Multivariate Section Widget is
removed from the experiment page.

Additional Information
This section also contains the following topics.

Cookies in Multivariate Testing 11-12
Using a Target Page Outside of the CMS 11-12
Repeating an Experiment 11-12
Scheduling an Experiment 11-12
More Information About the Reports 11-13
Using More Than One Section Widget on a Page 11-14
The Quantity of Variations Tested 11-15

Automatically Ending the Experiment
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Cookies in Multivariate Testing
When visitors view the experiment page, a cookie is set in the browser. This
cookie indicates the specific variation seen by the visitor. From this point
forward, if they next visit the target page, this cookie is read and the proper
variation counter is increased.

A cookie persists forever or until the cookies are removed from the browser
cache. The cookie gives a visitor a consistent page variation each time they
revisit during the experiment.

Visitors that block cookies are not counted in conversions. Also, they see
random page variations each time they visit the page.

Using a Target Page Outside of the CMS
When your target page is outside of your Web Site, you must create an
intermediate page that contains the Target Widget, and redirect the visitor to
the outside address.

For example, if you want to test visitors from your page to
http://www.NFL.com, do the following:

1. Create a new Pagebuilder page.

2. Add the target widget to it.

3. Add the code that will redirect the visitor from this page to
www.NFL.com.

4. Create content with links to the target page you just created.

Now when the experiment is running, the experiment page links the visitor to
this intermediate page and the conversion is counted. Then, the redirect takes
the visitor to the external page.

Repeating an Experiment
To repeat an experiment after it has ended, you first must restore the history of
this page. To restore history of a PageBuilder page, follow the steps in
Restoring a Previous Version on page 7-125.

After you restore the previous version, you may edit the parameters of the
experiment, modify the content, and run the experiment again.

Scheduling an Experiment
The PageBuilder page has the same properties as other content types, including
the Schedule Property. To set the beginning and ending date of the page, edit
the PageBuilder page and follow the procedure for setting content schedules as
described in Scheduling Content to Begin and End on page 7-187.

Optimizing Page Layout with Multivariate Testing
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Be sure to set the Schedule End Date to be long enough past the time you
believe the experiment will automatically end.

More Information About the Reports
Reports show how each variation has performed during the experiment. Click
on the Show Report button in the Experiment Widget to see the progress and
results.

The bar graph shows the conversion percentage.

The numbers to the right of the bar graph show two values. The first value is
the percent of conversions compared to the total number of visits to the
experiment page. On variation #2 above, the “79%” means that 568 visitors to
this variation have successfully reached the target page 451 times.

The numbers after the percentage show the actual conversations. The first
number before the “/” indicates the total number of conversions during the
experiment. The second number is the total number of times this variation was
viewed by a visitor.

Note: Users that are logged in are counted as a page view to the experiment page but not
counted on the target page as a conversion.

The following table describes how to use each button.

Button Description

Preview shows the page configurations for this specific variation. Notice that not only does
the content in theMultivariate Section wizards change, but also the slider number changes
too.

Variation Enabled.

When this shows, this variation is currently selected to run. Clicking on this button disables
this variation.

More Information About the Reports
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Button Description

Variation Disabled.

When this shows, this variation is currently not selected to run. Clicking on this button
enables the variation.

Promote.

Clicking this button promotes this specific variation to become the actual page seen by
visitors. All other variationsare disabled and the experiment is ended.

Using More Than One Section Widget on a
Page
You may create a PageBuilder page with more than one Section Widget. This
provides greater flexibility in helping to identify combinations of content and
images that provide the best conversion results.

A page containing two Multivariate Section Widgets is shown below.

Optimizing Page Layout with Multivariate Testing
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The contents inside the Section Widgets are part of the variations shown
randomly during the experiment.

The Quantity of Variations Tested
The number of variations in a Multivariate Experiment grows exponentially as
you add sections and variations.

For example, if you have two sections with 3 variations in each section, there
are a total of 8 (23) pages to be tested. If you increase this to 4 variations each,
there are 16 (24) pages.

Multivariate Target Widget Details
The target widget is placed on the page containing the content you wish people
to find.

TheQuantity of Variations Tested
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The target widget does not have any configurations and need only reside
somewhere on the page.

Note: Use only one Target Widget per PageBuilder page

Below is an example of the target widget placed on a PageBuilder page.

The Target or Results Page
The Target page contains the Multivariate Target widget.

Whether you arrive at the target page (results page) by browsing to the
variations page first or by browsing to the target page directly, the views are
counted.

The exceptions to this are:

n if you are logged in

n if you have not first visited the experiment page to receive the cookie

n if you have cleared the cookies before visiting the target page

Note: Users that are logged in are counted as a page view of the experiment page but not
counted on the target page as a conversion.

Multivariate Experiment Widget Details
The Multivariate Experiment Widget contains all of the information about the
variations you use in an experiment. It also contains the Start/Stop button and
the conversion limits.

Note: Use only one Experiment Widget per PageBuilder page.

The image below is an example of the Multivariate Experiment Widget before
the experiment is started.

Field Definition

Target Page This is the content ID of the target page.

Conversionsbefore
Promote

This i the number of conversionsany variationsmust have
before the experiment is stopped automatically.
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Set the target page's ID number and the value of Conversions. Once this
value is reached, the experiment promotes the variation with the highest
percent of success, and disables all other variations.

To start the experiment, click the Start button.

Below is an example of a Multivariate Experiment widget while an experiment
is running. If desired, you can click the Stop button to stop the experiment.

The experiment widget also shows reports to indicate how each variation has
performed during the experiment.

Click the Show Report button to see the conversion information during the
experiment. For further information about reports, see More Information About
the Reports on page 11-13.

This section also contains the following topics.

Automatic Promotion 11-17
Manual Promotion 11-17

Automatic Promotion
Automatic promotion occurs when the target number of conversions occurs on
one of the variations. For more information see Automatically Ending the
Experiment on page 11-11.

Manual Promotion
During an experiment, you may choose a specific variation to be the page that
all visitors see and end the experiment. For more information see Manually
Ending the Experiment on page 11-11.

Multivariate Section Widget Details
The Multivariate Section widget contains the content variations for the
experiment. By using a variety of content combinations, the experiment tests
the best arrangement of content to accomplish the desired conversion goals.
The content is presented randomly to the site visitor.

Note: You may use one or more Section Widgets per PageBuilder page.

Below is a web page containing the Multivariate Section widget.

Automatic Promotion
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This section also contains the following topics.

Variation Selector Slider 11-18
Progress Bar 11-19

Variation Selector Slider
The slider bar at the top of the Multivariate Section widget is used to select the
variation.

The examples below demonstrates the slider control for variation 1/2 and 2/2.

Move the slider to see each variation.
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Click the Add Variation button ( ) to add another variation. Drag and drop the
content widget into this section. After configuring it, this content widget is now
one of the variations used in the experiment cycle.

Progress Bar
During the experiment, statistics are collected on:

n the number of page visits to the target page

n the number of page visits to a specific variation

The experiment will continue to progress until it is either stopped or ended.

For more information, see More Information About the Reports on page 11-13.

Progress Bar
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A task is a request from one user to another to perform an action within Ektron
CMS400.NET. Examples of a tasks include:

n updating content

n publishing content

n updating an image

n reordering a collection

If you are not in the administrators group or assigned the Task-create role, the
Tasks folder only displays tasks assigned to you or that you assigned to another
user or user group. You can also assign tasks to yourself.

Administrators can view all tasks, regardless of who they are assigned to or by.

A task may or may not be related to a specific piece of content. If it is, you can
access content then “attach” a task to it. This kind of task is managed just like
the other tasks, but you can also view and update it via the attached content.

This section also contains the following topics.

Task Permissions 12-2
Task Categories and Types 12-3
Task States 12-8
Creating a Task via the Task Folder 12-11
Creating a Task from the Web Site 12-19
Creating a Task via the View Content Screen 12-20
Viewing a Single Task 12-20
Viewing All Tasks 12-21
Viewing a Task’s History 12-25
Editing a Task 12-25
Adding Comments to Tasks 12-26
Archiving a Task 12-28
Deleting a Task 12-29
Deleting Several Tasks at Once 12-30
Automatic Creation of Tasks Associated with Content 12-30
Task Email Notification 12-35

Note: Tasks can also be created automatically when forms are submitted. See Also: Assigning
a Task to a Form on page 7-251

Task Permissions
Members of the Administrators group have permission to perform all task
activities. Alternatively, you can assign roles to give users specific task-related
permissions, as indicated below.

Assigning and Reviewing Tasks
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Permission Role

Create task Task-Create

Redirect task (that is, assign to another user) Task-Redirect

Delete task Task-Delete

Task Categories and Types
Tasks can be assigned a Task Category, then a Task Type. This gives users an
additional way to filter their tasks.

Task Categories and Task Types have a hierarchical relationship: the Task
Category is the parent, and the Task Type is the child. So, several types can be
assigned to each category.

Some examples of Task Categories might be Engineering, Sales,
Documentation, or Web Design. Examples of Task Types might be Edit Content,
Update Documents, or Contact Customer.

Note: Only members of the Administrator User Group or users assigned the following roles
can view, add, or edit task categories and types: Task-Create, Task-delete, Task-Redirect. See
Also: Defining Roles on page 15-31

You can create Task Categories and Task Types on these occasions.

n When adding a task. See Also: Creating a Task via the Task Folder on
page 12-11

n When working in the View Categorization screen.

View Categorization Screen
The View Categorization screen allows administrators to create, edit, and
delete Task Categories and Task Types.

To access the View Categorization Screen, access theWorkarea > Settings
> Configuration > Task Types. The following screen appears.

TaskCategories and Types
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Viewing Task Categories
Note: The View Categorization screen has a system-defined category (Form Submission Task)
that can only be used with forms. You can change its name but cannot delete it. For more
information, seeWorking with HTML Forms on page 7-212.

While in the View Categorization screen, you can collapse and expand Task
Categories. To collapse a Task Category, click the ( ) button next to the Task
Category name. To expand one, click the ( ) button next to the Task Category
name.

The following example shows the View Categorization screen with one Task
Category minimized.

Creating Task Categories and Task Types
From the View Categorization screen, you can create Task Categories and Task
Types by clicking the Add Task button ( ). When you do, the following screen
appears.

Assigning and Reviewing Tasks
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From this screen, you can perform these tasks.

n Adding a New Task Category and Task Type below

n Adding a New Task Type to an Existing Task Category on next page

n Editing Task Category on next page

n Editing a Task Type on page 12-7

n Task Type Availability on page 12-7

Adding a New Task Category and Task Type
To add new Task Category and Task Type, follow these steps.

See Also: Task Categories and Types on page 12-3

1. Click the Add Task Type button ( ).
2. The Add Task Type Screen appears.

3. Click the Add Task Type to New Task Category radio button or in
the text box.

4. Enter a name in the New Task Category field.

5. Add a Task Type name in the Task Type field.

6. Enter a Task Type Description.

7. Choose a Task Type Availability. See Also: Task Type Availability on
page 12-7

8. Click Save ( ).
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9. Your new Task Categories and Task Types appear on the View
Categorization screen.

Adding a New Task Type to an Existing Task
Category
To add a new Task Type to an existing Task Category, follow these steps.

1. Click the Add Task Type button ( )
2. The Add Task Type Screen appears.

3. Click the Add Task Type to New Task Category radio button or
click the drop down box.

4. Choose a category from the drop down box.

5. Add a Task Type name in the Task Type field.

6. Enter a Task Type Description.

7. Choose a Task Type Availability. See Also: Task Type Availability on
the facing page

8. Click Save ( ).
9. Your new Task Categories and Task Types appear on the View

Categorization screen.

Editing Task Category
You can edit a Task Category names. To edit a Task Category, follow these
steps.

1. Click the Task Category link.

2. A text box screen appears next to the category name. Use it to
change the name.

3. You can either save ( ) the changes, or cancel ( ) the edit.
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Editing a Task Type
From the View Categorization screen, you can edit a Task Type. This allows you
to change the Task Type name, Task Type description, and Task Type
availability.

To edit a Task Type, follow these steps.

1. On the View Categorization screen, click a Task Type.

2. The Edit Task Type screen appears.

From this screen, you can edit the following:

n Task Type

n Task Type Description

n Task Type Availability. See Also: Task Type Availability below

3. Edit the information.

4. Click Save ( ).

Task Type Availability
Task Types can be hidden from users by clicking the Not Available check box in
the Add Task Type and Edit Task Type screens. By making a Task Type not
available, you can suppress without deleting it.

When you make a Task Type not available, you see the following warning.
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After you make a Task Type not available, the assigned tasks’ Type and
Category are changed to Not Specified.

Deleting Task Categories and Task Types
You can delete Task Types by Task Category or individually.

To delete a Task Type, click the check box next to the Task Type, then click the
Delete ( ) button.

When you delete a Task Type, the following appears.

To delete all Task Types, check the Delete all check box.

The following example shows which check boxes on the screen are associated
with All Task Types, Task Categories, and individual Task Types.

Task States
During the life of a task assigned to content, it normally progresses through a
series of states. The state helps track a task’s progress from creation to
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completion and even removal from the database. When reviewing the history of
a task, the state can be used to review which actions changed the task’s state
by whom and when.

This section also contains the following topics.

User-Assigned versus System-Assigned States 12-9
Progression of Task States 12-10
Restrictions on the Task Flow Process 12-10

User-Assigned versus System-Assigned
States
Some states can only be assigned by users while others are only assigned when
an event occurs to the associated content. For example, when content is first
submitted for approval, the associated task’s state changes to Not Started.

Important: An administrator user can always change a task’s state to any other state.

The following graphic illustrates the sequence of user and system actions that
change a task’s state.
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Progression of Task States
State Description Assigned by

Not
Started Assigned when task is created. User

Active The task’s content is checked out. System

Awaiting
Data

The task is started but the assigned-to user is awaiting
data from an external source. You can use comments to
indicate the data being waited for.

User

OnHold Task cannot be worked on at this time. User

Pending

The content is submitted for approval.

A task remainspending while its content is in the approval
process.When the last person in the approval chain
approves the content, the task’s state changes to
Completed.

If anyapprover declines the content, the task’s state
changes to Reopened.

If an editor edits the content and then checks it back in, the
task’s state changes to Reopened.

System

Reopened
Content is declined byan approver in the approval
process. Also, if someone edits content whose task state is
pending, the tasks’s state changes to Reopened.

System

Completed The last user in the approval chain approves the content
and it is being published. System

Archived

After a task is completed, administrators can assign this
state. It no longer appears on open task lists but is kept for
reviewsand reports.

Only the administrator can view Archived tasks.

See Also:

User

Deleted

When an archived task is no longer needed for reporting
or reviewing, administrators can assign this state.While in
this state, the task remains in the database. See Also:

When you purge the task, it and all of its transactionsare
removed from the database. See Also:

User (user with delete
permission can delete; only
admin and user with Task-
Delete role can purge)

Restrictions on the Task Flow Process
n Only users with archive and delete permissions can set a task’s

status to archived or deleted. This can be done at any stage of the
task flow process.
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n Notes can be entered for the task at any time.

n An administrator can assign a task to any state at any time.

Creating a Task via the Task Folder
This section also contains the following topics.

Accessing the Tasks Folder 12-11
Creating a Task via the Task Folder 12-12
Selecting Content for the Task 12-15
Adding a Task Category and Task Type 12-16
Task Type Availability 12-18
Editing a Task Type 12-18

Accessing the Tasks Folder
To access the Tasks folder, follow these steps.

1. From the workarea, click the Reports Menu tab.

2. Click the Tasks folder.

3. Click the Tasks folder. The following subfolders appear:

n All Open Tasks - all tasks whose status is open

n Assigned By and To Me - tasks assigned to you and those that you
assigned to someone else

n Assigned To Me - tasks assigned to you
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n Assigned By Me - tasks that you assigned to someone else

n Created By Me - tasks you created

n Assigned To User - search for tasks assigned to a user

n Not Started - tasks whose state is set to not started

n Active - tasks whose state is set to Active

n Awaiting Data - tasks whose state is set to Awaiting Data

n On Hold - tasks whose state is set to On Hold

n Pending - tasks whose state is set to Pending

n Reopened - tasks whose state is set to Reopened

n Complete - tasks whose state is set to Complete

n Archived - tasks whose state is set to Archived

n Deleted - tasks whose state is set to Deleted

You can click any folder to view only tasks in that category.

Also, the View Tasks screen appears in the right frame, listing all tasks
assigned to you, or assigned by you.

From this page, you can view, sort, update, or add tasks. To learn more about
the View Tasks screen, see Viewing a Single Task on page 12-20.

To learn about sorting by Task Type, see Sorting Tasks By Task Type on page
12-23.

Creating a Task via the Task Folder
To create a task, follow these steps.

1. From the workarea, click Reports > Tasks.

2. Click Assigned by and to me.

3. Click the Add button ( ).
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Warning! The Add button only appears if your system administrator has granted you permission
to add tasks. For more information, see Task Permissions on page 12-2.

4. The Add Task screen appears.

Enter information for the task using the following table

Field Description

TaskTitle Enter a title for the task (for example, Update Content). The title appears in the left column of
the View Tasks screen.

Assigned
To

Your user name appears.

n If you do not have Redirect permissions, you cannot assign tasks to other users.

n If you have Redirect permissions, your user name appears followed bySelect User or
Group. To assign the task to yourself, proceed to the next field. To assign the task to someone
else, clickSelect User or Group and choose a user or group. (The user to whom the task is
being assignedmust have permission to edit the content.)

When you complete the screen, an email is sent to the selected user or user group informing
him of the assigned task.

Note: email is only sent if email notification is enabled for Ektron CMS400.NET.

Language Select the language of the user who will perform the task.

Content

If this task involvesa piece of content, select it. When you clickSelect, a new window appears.
From thiswindow, you can navigate through folders to find the content.

You can only select a piece of content whose languagematches the user language selected
above.

See Also:Selecting Content for the Taskon page 12-15

Priority
Select the priority of the task. Your choicesare High, Normal and Low.

The priority appears on the View Tasks screen. A user can sort taskson the screen bypriority.

Task
Category

Select a category for the task.When a TaskCategory is chosen, the TaskType drop down box
is auto filled with task typesassociated with that category.
See Also:Adding a TaskCategory and TaskType on page 12-16.

TaskType
Select the TaskType for this task. Youmust specify a TaskCategory before you assign a task
type. See Also:Adding a TaskCategory and TaskType on page 12-16.

Add

Byclicking the Add link, you can add TaskCategories and TaskTypes. See Also:Adding a Task
Category and TaskType on page 12-16

Note: If you Add a TaskCategory or TaskType while adding a task, the task information
(TaskTitle, Assigned To, Language, etc.) entered will be lost when the screen refreshes.
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Field Description

Edit

By clicking the Edit link, you can edit the TaskType chosen in the TaskType drop down box.
See Also:Editing a TaskType on page 12-18

Note: If you edit a TaskType while adding a task, the task information (TaskTitle, Assigned
To, Language, etc.) entered will be lost when the screen refreshes.

State

Choose a status for the task. Your choicesare:

n Not Started

n In Progress

n Completed

n Waiting on Someone else

n Deferred

If the task is not linked to content, you can assign it to any state. However, if you later link the
task to content (via theContent link above), the state switches to Not Started.

The state appears on the View Tasks screen. A user can sort taskson the screen by state.

Start Date

Using the calendar button, choose a start date for the task. The start date appears on the View
Tasks screen. A user can sort taskson the screen by start date.

Note: If you see amix-up of themonth and date of your entry (for example, you select
March 2 but see February 3), make sure the date format specified in theWindowsControl
PanelRegionalSettingsdialogmatches your current language. Also, make sure the
settingsapply to the default user.

Due Date

Using the calendar button, choose the date bywhich the taskneeds to be completed.

The due date appears on the View Tasks screen. A user can sort taskson the screen bydue
date.

Note: If you see amix-up of themonth and date of your entry (for example, you select
March 2 but see February 3), make sure the date format specified in theWindowsControl
PanelRegionalSettingsdialogmatches your current language. Also, make sure the
settingsapply to the default user.
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Field Description

Description

Add additional information to describe the task. The description appears on the View Task
screen (circled below).

5. Click the Save button ( ).
If email notification is enabled, an email is sent to the user or group to which
the task was assigned.

Selecting Content for the Task
When you click Select Content from the Add Task screen, the Select Content
screen appears. It shows only content in the selected language.
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You should only select a content folder for which you have permissions. See
Also: Folder Permissions on page 4-40

To select a piece of content to assign to the task, follow these steps.

1. Navigate to the content. (Click any folder to open it.)

2. Click the circle to the left of the content.

3. Press the Save button ( ).

Adding a Task Category and Task Type
Task Categories and Task Types let users and administrators sort task by user-
defined categories and types.

By clicking the Add link, located next to the Task Type drop down box, you can
add Task Categories and Task Types. This allows you to add categories and
types without leaving the Add Task screen.

Note: Administrators can also add and edit Task Categories and Task Types from the
Workarea by clicking Settings > Configurations > Task Types. See Also: Adding a Task
Category and Task Type above

To add a Task Category and a Task Type, follow these steps.

1. Go to the Add Task screen, as described in Creating a Task via the
Task Folder on page 12-12.

2. Click the Add link, next to the Task Type dropdown box.
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3. The Add Task Type screen appears.

From this screen you can perform the following:

n Add a task type to an existing task category

n Create a new task category

n Add a new task type

n Add a task type description

n Define task type availability

Adding a TaskCategory and Task Type
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Note: As a user, if you set the Task type to Not Available, you cannot edit the Task Type after
that. To make the Task Type available, see your administrator. Task Type availability is
explained in Task Type Availability below.

4. Enter your information.

5. Click Save ( ).
6. Your new Task Category and Task Type appear in the drop down

boxes.

Task Type Availability
Task types can be hidden from users by clicking the Not Available check box in
the Add Task Type and Edit Task Type screens. By making Task Types not
available, you can make the Task Type unavailable without deleting it.

Editing a Task Type
From the Add Task screen, you can edit a Task Type. This will allow you to
change the Task Type name, Task Type description, and Task Type availability.

To edit a task type, follow these steps.

1. Go to the Add Task screen, as described in Creating a Task via the
Task Folder on page 12-12.

2. Choose a Task Category and the Task Type to edit.

3. Click Edit, next to the Task Type dropdown box.

4. The Edit Task Type screen appears.
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From this screen you can edit the following:

n Task Type

n Task Type Description

n Task Type Availability. See Also: Task Type Availability on previous
page

Note: As a user, if you set the Task type to Not Available, you cannot edit the Task Type after
that. To make the Task Type available, see your administrator. Task Type availability is
explained in Task Type Availability on previous page.

5. Edit the information.

6. Click Save ( ).
7. The Task Type information is changed.

Creating a Task from the Web Site
To create a task from a Web page, follow these steps.

1. Browse to the content for which you want to assign a task.

2. Right click the mouse to display a menu.

3. Click the Add Task button ( ).

Warning! The Add Task button only appears if your system administrator has granted you
permission to add tasks. For more information, see Task Permissions on page 12-2.

4. The Add Task screen appears. The content you were viewing is
assigned to the task.

5. Follow the directions in Creating a Task via the Task Folder on page
12-11. The only differences are

n the content’s ID number and title appear on the screen

n the language of the content is the default language
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Creating a Task via the View Content
Screen
You can assign task via the View Content screen, as illustrated below.

To assign a task from the View Content screen, follow these steps.

1. Access the View Content screen for the content to which you want to
“attach” in a task, as described in Viewing Content on page 7-9.

2. Click the Add Task button ( ).

Warning! The Add Task button only appears if your system administrator has granted you
permission to add tasks. For more information, see Task Permissions on page 12-2.

3. Follow the directions in Creating a Task via the Task Folder on page
12-11. The only differences are

n the content’s ID number and title appear on the screen

n the language of the content is the default language

Viewing a Single Task
Once a task is added, (with the exception of Administrators and users assigned
to the Task-Create role) only the user who assigned the task and those to whom
the task was assigned can view it.

To view a task, follow these steps.

Viewing a Task from the Content Folder
1. In the Ektron CMS400.NETWorkarea, click Content.

2. Open the folder that contains the content.

3. Click the content associated with the task.

4. Click the Tasks tab.

5. The page lists all tasks assigned to the content.

6. Select a task.

From the view task page, you can add a comment to the task.
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Viewing a Task from the Tasks Folder
To view a task from the Tasks folder, follow these steps.

1. From the Ektron CMS400.NET Workarea > Reports, select the
Tasks folder.

2. Select a task category. For example, select All open Tasks.

3. Click the task you want to view.

4. The View Task screen is displayed. From here, you can perform these
tasks.

n Editing a Task on page 12-25

n Deleting a Task on page 12-29

n Adding Comments to Tasks on page 12-26

n Viewing a Task’s History on page 12-25

See Also: Sorting Tasks By Task Type on page 12-23; Viewing a Single Task on
previous page

Viewing All Tasks
The Tasks folder is located within the Ektron CMS400.NET Workarea >
 Reports tab. Here, 14 view screens display all tasks filtered by specified
categories. The categories appear in the table below.

After viewing tasks in any category, most screens let you perform an action on
the tasks (see table below). For example, you can redirect your tasks to
another user. To select all tasks on a screen, click the check box in the header
row (illustrated below).
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Screen Displays these tasks Action you can perform from view screen

AllOpen
Tasks

All open tasks (that is, tasks in one of
these states) for all users

n not started

n active

n awaiting data

n on hold

n reopened

n pending

n Edit a task

n Sort tasksby column

Assigned
ToMe All open tasksassigned to you

n Assign tasks to a different user

n View a task

n Sort tasksby column

Assigned
ByMe

All open tasks you assigned to yourself
or others

n Assign tasks to a different user

n View a task

n Sort tasksby column

Created by
Me All open tasks you created

n View a task

n Sort tasksby column

Assigned
to User

All open tasksassigned to a user you
select

n Select anyuser and view all tasksassigned to
that user.

To do so, select new user fromAssign to User
drop down list and clickGet Tasks.

n View a task

n Sort tasksby column

Not
Started Allwhose state isNot Started

n Change to anyother state

n View a task

n Sort tasksby column

Active Allwhose state isActive

n Change to anyother state

n View a task

n Sort tasksby column

Awaiting
Data Allwhose state isAwaiting Data

n Change to anyother state

n View a task

n Sort tasksby column
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Screen Displays these tasks Action you can perform from view screen

OnHold Allwhose state isOnHold

n Change to anyother state

n View a task

n Sort tasksby column

Pending Allwhose state isPending

n Change to anyother state

n View a task

n Sort tasksby column

Reopened Allwhose state isReopened

n Change to anyother state

n View a task

n Sort tasksby column

Completed Allwhose state isCompleted

n Change to anyother state

n View a task

n Sort tasksby column

Archived Allwhose state isArchived

n Change to anyother state

n View a task

n Sort tasksby column

Deleted Allwhose state isDeleted

n Change to anyother state

n Purge tasks

n View a task

n Sort tasksby column

This section also contains the following topics.

Sorting Tasks By Task Type 12-23
Determining Which Tasks a User Can View 12-24

Sorting Tasks By Task Type
On every View Task page, you can sort tasks by the Task Type assigned to the
task. You sort by Task Type using the Show Task Type drop down box. It is
located in the upper right corner of the Workarea.

Note: Task Types only appear in the Show Task Type dropdown box when they have been
added to a task.
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To sort by Task Type, click the drop down box and choose a Task Type. Words in
bold Italics are Task Categories. You cannot sort by Task Categories.

Determining Which Tasks a User Can View
To provide security, Ektron CMS400.NET restricts which users can use the task
views. These restrictions are listed on the following table.

View
option

Administrator
group member

User or group to
whom task assigned

User who
assigned
task

User who
created task

All
users

AllOpen * X

Assigned
byMe X X

Assigned
toMe * X

Created by
Me * X

Assigned
to User X X X X X

Not
Started

all tasks in
specified state only tasksassigned to

user in specified state

Active | |

Awaiting
data | |

On hold | |

Pending | |

Reopened | |

Completed | V
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View
option

Administrator
group member

User or group to
whom task assigned

User who
assigned
task

User who
created task

All
users

Archived |

Deleted V

* - user can only view open tasks, that is, not started, active, awaiting data, on hold,
pending, or reopened

Viewing a Task’s History
Ektron CMS400.NET maintains a history of all events in the life of a task, as
well as any comments entered. As examples, the task history shows when and
by whom the task was created, when it changed to Active, when it was linked to
content, when its state changed, when it was approved, etc.

You can view the task’s history until the task is purged. To view a task’s
history, follow these steps.

1. Navigate to the View Task screen, as explained in Viewing a Single
Task on page 12-20.

2. Click the History button ( ).
3. The history of task events appears (example below).

Editing a Task
You can change task information, such as

n Title

n Assigned to

n Language

n Content

n Priority
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n Task Category

n Task Type

n Status (State)

n Due Date

n Start Date

n Description

To edit a task, perform the following steps.

1. Access the View Task page for the task, as described in Viewing a
Single Task on page 12-20.

Note: You cannot edit a task after viewing it from the Content folder.

2. Click the Edit button ( ).
3. The Edit Task screen appears.

4. Edit the task.

5. Click the Update button ( ).

Adding Comments to Tasks
You can add comments to an assigned task if you want to provide additional
information about its status. For example, if you update a task’s status from In
progress toWaiting on Someone Else, you can use a comment to describe the
status change, such as:

left voice mail with John with questions about his changes to the
home page

Comments appear on the Comments Tab of the View Task screen (illustrated
below).

Several comments can be added to a task to record its progress from
assignment to completion.

To add a comment to a task, follow these steps.
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Note:When an approver approves/declines content from the Content Awaiting Approval
screen, if the content has an active task, the Add Comments to Task screen appears. The
screen lets the approver insert comments about the task associated with the content.

1. Access the View Task screen for the task, as described in Viewing a
Task from the Tasks Folder on page 12-21.

2. Click the Add Comment button ( ).
3. The Comments window appears.

4. Enter your comment in the editor. Note that you can format and spell
check the text using the toolbar buttons.

5. Click the button.
6. The View Task screen reappears with the comment at the bottom of

the page.

See Also: Adding Comments to Tasks on previous page

Updating Comments
To update a comment, follow these steps.

1. Access the View Task screen that contains the comment you want to
update, as described in Viewing a Task from the Tasks Folder on page
12-21.

2. Click the Comments tab.

3. Click the comment’s Date/Time link (illustrated below).
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4. The Comments window opens with the comment displayed.

5. Update the comment.

6. Click the button.

Archiving a Task
After a task is completed, you may want to change its state to Archived.
Archiving moves selected tasks from the Completed tasks list to the archived
list. This change cleans up the completed tasks list, making it easier to use.

Archived tasks are typically kept for a predetermined time period, at which
point an administrator deletes them (depending on your organization’s
policies).

To archive a task, follow these steps.

1. OpenWorkarea> Reports > Tasks.

2. Click the view option corresponding to the state of tasks you want to
archive. Typically, you would archive completed tasks.
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3. A list of Completed tasks appears. Select tasks one at a time, or click
the check box on the top left corner to select all.

4. Next to the Change to State field, click the down arrow to display
the drop down list.

5. Select Archived.

6. Click the Set button.

Deleting a Task
You can easily delete a task that is no longer needed. For example, the user
who assigned a task would typically delete it when it is completed.

An administrator can change any task’s state to deleted. He would typically do
so after it is completed or archived, depending on your organization’s policies.

To delete a task, follow these steps.

1. Access the View Task screen for the task, as described in Viewing a
Single Task on page 12-20.

2. Click the Delete button ( ).

Warning! The Delete button only appears if your system administrator has granted you
permission to delete tasks. For more information, see Task Permissions on page 12-2.
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3. A confirmation message appears.

4. Click OK.

Deleting Several Tasks at Once
Tasks can be deleted either one at a time, or several at once.

Prerequisite: Must be a member of the Administrators group or assigned the
Task-Delete role.

To delete several tasks at once, follow these steps.

1. OpenWorkarea> Reports > Tasks.

2. Click the view option corresponding to the state of tasks you want to
delete. Typically, you would delete archived tasks.

3. Select tasks one at a time, or click the check box on the top left
corner to select all.

4. Next to the Change to State field, click the down arrow to display
the drop down list and select Deleted.

5. Click the Set button.

Automatic Creation of Tasks Associated
with Content
In addition to the manual assignment of tasks, they can be automatically
generated whenever content, an asset, or a form is created. You would enable
and use the Automatic Task Creation feature if you want to set up a preapproval
process, which requires one or more users to review and approve content
before it enters the regular approval process. (The regular approval process is
described inWorkFlow on page 4-27.)

The most common scenario illustrated below.
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In this example, an automatically-generated task assigns the content to a
preapproval group. When any member of that group reviews his tasks, he
inspects the corresponding content and assigns it to an editor. After the editor
reviews and possibly edits the content and submits it for approval, it enters the
normal approval process.

This section also contains the following topics.

Enabling Automatic Task Creation 12-31
Assigning a Preapproval Group to a Folder 12-31
Preapproval Groups Report 12-32
How Automatic Task Creation Works 12-33
Task/Content Statuses (Author Cannot Approve) 12-34
Task/Content Statuses (Author Can Approve) 12-35

Enabling Automatic Task Creation
The Settings > Configuration > Setup screen > Workarea tab's Enable
PreApproval Group field controls Ektron CMS400.NET’s Automatic Task
feature. Check this box to enable Automatic Tasks.

Next, you create user groups and assign them to folders whose content must
complete the preapproval process before it enters the regular approval
process. See Assigning a Preapproval Group to a Folder below.

Assigning a Preapproval Group to a Folder
The ability to select or update a folder’s preapproval group is determined by the
advanced permissionModify Preapproval. Only users with this permission

Enabling Automatic TaskCreation
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see the Modify Preapproval button ( ) when viewing the Folder Properties
screen.

If you have permission to modify a folder’s preapproval group, go to the Folder

Properties screen and click the Modify Preapproval button ( ) to access the
PreApproval Group field. (The field only appears if you have enabled the
Preapproval Feature. See Enabling Automatic Task Creation on previous page.)

If you assign a user group, an automatic task can be assigned to that group
whenever content in that folder is created or updated.

If you select Inherit, this folder gets its preapproval group from the parent
folder. If you select None, you disable the preapproval feature for the folder.

Preapproval Groups Report
The Preapproval Groups Report lists all preapproval groups assigned to folders
within Ektron CMS400.NET. To access it, go to Ektron CMS400.NET
Workarea > Reports > Contents > Preapproval Groups.

Assigning and Reviewing Tasks
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How Automatic Task Creation Works
When a user submits a content item for approval, Ektron CMS400.NET checks to
see if an open task exists for it. (An open task is one whose state is Not
Started, Active, Awaiting Data, on Hold, or Pending.) If none exists and a
preapproval group is assigned to its folder, a task is created and associated
with the content.

A task has the following information.

Field Value

Title

A string formulated by joining the

n content title

n content ID number

n underscore

n Task

For example, Private Content2_Task.

Assigned to The preapproval group

Assigned by The user who submitted the content

Content The content being submitted for approval

Priority Normal

State Not Started

Due date none

Start date none

Created by User who submitted content

Description none

The task can then be reviewed by any member of the preapproval group, who
has two choices.

n review the content and submit it for publishing. This action completes
the preapproval process and submits the content into the regular
approval chain.

n assign the task to another user, such as an editor. (The user to whom
the task is being assigned must have permission to edit the content.)
The editor reviews the content, updates it as needed, and submits it
into the regular approval chain.

How Automatic TaskCreationWorks
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Note: The user submitting the content does not need permission to create tasks. Also, the user
assigned to the task should not change its state using the task system. Instead, he should
review and approve content using the regular content workflow mechanism. That mechanism
automatically changes the task’s state.

The tables below explain the sequence of changes to content and its associated
task. All changes are logged into the task’s history. See Also: Viewing a Task’s
History on page 12-25

Also, email is automatically generated for automatic tasks as it is for manually-
created tasks.

Task/Content Statuses (Author Cannot Approve)

Event
Content
Status

Task
Status

Content is created and checked in Checked In
No auto
task
assigned

Content is submitted for approval

Note: The above action creates the automatic task for the content.

Waiting for
completion of
associated tasks

Not
Started

Content is assigned byamember or preapproval group to an editor
Waiting for
completion of
associated tasks

Not
Started

Editor updates content then checks it in Checked In Active

Content is submitted for approval; it enters anyapproval chain set for the
folder

Note: Since the task requiresan approval, it appears in the task list of
the current approver.When the content is approved, the task ismoved
to the next approver's task list.

Submitted for
Approval Pending

Approver denies request Checked In Reopened

Approver approves content Approved Complete
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Task/Content Statuses (Author Can Approve)

Event
Content
Status

Task
Status

Content is created then checked in Checked In
No auto
task
assigned

Content is edited then checked in Checked In Active

Content is submitted for approval

Note: Although an author can approve content, hemust click publish
twice: once to change content status to Awaiting Completion of Associated
Task, and a second time to change it to Approved.

Waiting for
completion of
associated
tasks

Not
Started

Content is published Approved Complete

Task Email Notification
email notification for tasks is sent on these occasions.

Warning! For email notifications to be sent, the following items must be true:
 - Users have email enabled in their user profile.
 - Users have a valid email address in their user profile.
 - CMS400.NET is set up and configured to send emails.

n A task is assigned to a user.

n A task is redirected to a user.

n A task is submitted for content approval. Sent to the first user in the
approval chain.

n The approval process moves on to the next approver.

n The content is declined at an approval stage. This is sent to the
assigned user.

n The content is published. This goes to the creator, assigned user, and
the approvers.

See Also: Configuring email for Tasks and Content on page 1-83
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Business Rules allow you to define conditions for Web pages on your site. You
choose an action based on whether the conditions are true or false when a site
visitor browses your site. For example:

n Condition - a site visitor visits your site for the first time

n Action - add a cookie to the site visitor’s system and pop up a
welcome message

With Business Rules, you do not write code to set conditions and initiate actions.
You simply complete the information requested in the Business Rules wizard,
have your developer add a Business Rules server control to your Web form, and
assign the server control the Business Rules Ruleset. See Also: BusinessRules
Server Control on page 13-12

Business Rules start out with a Ruleset that is assigned an ID. Each Ruleset is
made up of one or more rules. Rules are made up of conditions and actions.
There are several predefined conditions and actions for rules in Ektron
CMS400.NET.

Conditions include:

n Cookie Parameter = value

n Form Parameter = value

n QueryString Parameter = value

n Server Variable = value

n Custom Parameter = value

Actions include:

n Displaying a calendar

n Displaying a message

n Opening a URL in a new window

n Popping up a message

n Redirecting to a new URL

n Setting a cookie value

n Displaying a content block.

Once a rule is defined, you can add it to multiple Rulesets. This is useful if you
have several groups of rules that use a common rule.

This section also contains the following topics.

Permission to Work with Business Rules 13-3
Selecting a Rule 13-3
Creating a New Business Rule Ruleset 13-3
Working with Rulesets 13-4
BusinessRules Server Control 13-12
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Permission to Work with Business Rules
Only members of the Administrators user group and those defined in the
Manage Members for Role: Add Role Member Business Rule Editor screen can
work with Business Rules. See Also: Defining Roles on page 15-31

Selecting a Rule
There are two ways to select a rule. The first, check boxes, allows you to select
a rule by clicking the check box. This method is used when turning a rule on or
off in the Ruleset. Checked, the rule is active. Unchecked the rule is inactive.

The second, highlighting a rule, is used to when you want to work with the rule.
For example, you want to add or remove a rule from a Ruleset. To highlight a
rule, click its title. Once a rule is highlighted, it is ready for an action, such as
Remove or Edit.

Creating a New Business Rule Ruleset
Note: Only members of the Administrators group or those defined in Manage Members for
Role: Rule Editor screen can create or edit Business Rules and Rulesets.

See Also: Creating a New Business Rule Ruleset above

You create Business Rules Rulesets from the Business Ruleset screen in the
Workarea.
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The Business Ruleset screen contains these columns:

n ID - the numerical ID assigned to the Ruleset.

n Name - a unique name you give to the Ruleset to help you
understand what the Ruleset does.

To add a new Ruleset, follow these steps:

1. In the Workarea, click Settings > Business Rules.

2. Click the Add New Ruleset button ( ).
3. The Add New Ruleset screen appears.

4. In the Name: text box, add a name for the rule.

5. Click the Save button ( ).
6. The View Ruleset screen appears.

At this point, you can continue to add a rule or click the Back button ( ) and
return to add a rule later.

Working with Rulesets
After creating a Ruleset, you typically add rules to it via the View Ruleset
screen.

Creating BusinessRules for Your Web Site
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The View Ruleset screen is the launch pad for working with existing Rulesets.

This section also contains the following topics.

Edit a Ruleset 13-5
Remove a Rule From a Ruleset 13-6
Change the Order of Rules in the Ruleset 13-6
Delete a Ruleset 13-7
Add a New Rule to a Ruleset 13-7
Add an Existing Rule to a Ruleset 13-10
Edit a Rule in a Ruleset 13-11
Viewing a Rule in a Ruleset 13-12

Edit a Ruleset
See Also:Working with Rulesets on previous page

You can initiate editing a Ruleset from two different locations, the Web page or
the Workarea. To edit a Ruleset from the Web page, navigate to a Business
Rule on a Web page while logged in. Then, right click the Business Rule icon and
click Edit.

If editing from the Workarea, click Settings > Business Rules and then click
the Ruleset to edit. Next, click Action > Edit Ruleset.

The Edit Ruleset screen appears.

Edit a Ruleset
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Remove a Rule From a Ruleset
Follow these steps to remove a rule from the Ruleset.

1. Navigate to the Edit Ruleset screen, as explained in Edit a Ruleset on
previous page.

2. Highlight the rule you want to remove.

Warning! The check box associated with the rule must be empty for you to remove the rule. If the
check box is not empty, the rule will look as though it has been removed

3. Click the Remove Rule button ( ).
4. A pop up appears letting you know that the rule will be removed from

this Ruleset only.

5. Click OK.

6. The rule is removed from the Edit Ruleset screen.

7. Click the Save button ( ).

Change the Order of Rules in the Ruleset
The order of rules in a Ruleset affects how rules are applied when a site visitor
views a page. For example, you want to display a welcome message before a
content item. To accomplish this, move the rule for the welcome message
above the rule for a content item.

Follow these steps to change the order of the rules in a Ruleset.

1. Navigate to the Edit Ruleset screen, as explained in Edit a Ruleset
on previous page.

2. Highlight the rule you want to reorder.

3. Click the Move Up or Move Down buttons ( ) ( ) to move the rule
up or down the list.

4. Click the Save button ( ).
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Delete a Ruleset
When you delete a Ruleset, it is removed from the system permanently.
However, rules included in a Ruleset are not deleted. This is because a rule can
be used in multiple Rulesets.

Follow these steps to delete a Ruleset.

1. Navigate to the Edit Ruleset screen, as explained in Edit a Ruleset
on page 13-5.

2. Click the Delete Ruleset button ( ).
3. A dialog asks you to confirm the deletion.

4. Click OK.

Add a New Rule to a Ruleset
Adding a new rule is easy with Ektron CMS400.NET. Just click the Add button on
the View Ruleset screen. The Rules Wizard launches and helps you define a
rule.

Follow these steps to add a new rule to your Ruleset.

1. If you arrived here from the section, continue to the next step.

Otherwise, navigate to the Business Rules screen in the Workarea by
clicking Settings > Business Rules. Next, click the Business Rule for
which you want to create a new rule.

2. Click New > Add New.

3. The Rules Wizard launches.

4. Step 1 prompts you to create conditions for the rule and decide
whether a site visitor needs to match Any or All conditions. Clicking
the param and value links opens a dialog to enter information.

Delete a Ruleset
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Place a check next to any condition you want to use. Use the table below
to help you fill out the param and value fields.

Conditions Table

Condition Description Example

TheCookie param
equals value

Use a cookie for this
condition.

param - enter Name in
this field.

value - enter the name of
the cookie in this field.

Does the site visitor's system have an Ektron cookie?

Usage:

The Cookie param “Name” equals value “Ektron”

The Form param
equals value

Use a form elements field
name andmatch the
value entered into the
element.

param - enter a form’s
element Field Name from
a form.

value - enter the value
you want the form
element to match.

A form hasa ChoicesField element with the Field Name
“Favorite_Food” and choicesof Pizza, Steakand
Chicken.When a site visitor choosesPizza and clicks
submit, your rule launchesa Pizza company’sWeb site.

Usage:

The Form param “Favorite_Food” equals value “Pizza”

TheQueryString
param equals value

Use theQueryString for
this condition

param - the name of the
QueryString. For
example, ID.

value - the value
associated with the
parameter. For example,
18.

Is content with the ID of 18 being displayed?

Usage:

TheQueryString param “ID” equals value “18”
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Condition Description Example

The Server Variable
param equals value

Use server variables
from the site visitor.

param - enter the name
of a server variable. For
example, HTTPS.

value - the value
associated with the
parameter. For example,
On.

Is the site visitor’s browser using SSL?

Usage:

The Server Variable param “HTTPS” equals value “On”

A list of server variablesand their descriptions can be found at
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/iissdk/html/21b3be8f-d4ed-4059-8e21-
6cba2c253006.asp.

The Custom param
equals value

Use custom parameters
from the user. User
parameters are defined
in the codebehind of a
web page.

param - enter the name
of a custom parameter.
For example, AcctBlnc

value - the value
associated with the
parameter. For example,
1000

Is the user's account balance $1000?

Usage:

The Custom param “AcctBlnc” equals value “1000”

5. Click Next.

Step 2 of the Wizard prompts you select an action to take if conditions are true.
Check the boxes for the actions to take. Click the blue links to add the
appropriate information.

Conditions Table
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Action Description

DisplayCalendar
ID Enter a Ektron CMS400.NET Calendar ID.

DisplayaMessage Enter amessage to be displayed.

Open URL Enter a URL. This opensa new window with the URL.

Popup AMessage Enter amessage that appears in a popup dialog box.

Redirect to a URL Enter a URL to redirect a the site visitor’s browser.

Set Cookie to Value Createsa cookie on the site visitor’s system. Enter Name for Cookie and the name of
the cookie for Value.

DisplayContent
Block ID Enter a Ektron CMS400.NET content block’s ID.

6. Click Next.

7. Step 3 of the Wizard lets you select actions to take when conditions
are false. This works the same as Step 2 of the Rules Wizard. For
descriptions of the actions, see Conditions Table on page 13-8.

8. Click Next.

9. Step 4 of the Wizard asks you to enter a name for the rule in the text
box.

10. Click Done.

11. The View Ruleset screen appears. Your rule appears in the Ruleset
box.

Add an Existing Rule to a Ruleset
Because rules are not tied to a Ruleset once they are created, you can add a
rule to more than one Ruleset. To add an existing rule to a Ruleset, follow these
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steps:

1. If you arrived here from the section, continue to the next step.

Otherwise:

Navigate to the Business Rules screen in the Workarea by clicking
Settings > Business Rules. Next, click the name of the Business Rule
for which you want to add an existing rule.

2. Click New > Add Existing.

3. The Add an Existing Ruleset screen appears.

4. Check the rules to add to the Ruleset.

5. Click the Save button ( ).

Edit a Rule in a Ruleset
Following these steps to edit a rule in a Ruleset.

1. In the Workarea, navigate to Settings > Business Rules.

2. Select the Ruleset that contains the rule to be changed.

3. Highlight the rule to be changed.

Edit a Rule in a Ruleset

ReferenceManual
Version 8.01 Rev 4

13-11



4. Click Action > Edit Rule.

5. The Rules Wizard appears with the rule loaded. Edit as necessary. The
Rules Wizard is explained in Add a New Rule to a Ruleset on page 13-
7.

Viewing a Rule in a Ruleset
To help you understand the contents of a rule, a (View) link appears next to
each rule in a Ruleset. Click this link to launch a view window for the rule. This
window displays settings for each Rules Wizard step applied to a rule.

Note: The steps are not editable from this window. To edit rules in a Ruleset, see Edit a Rule in
a Ruleset on previous page.

To navigate through the steps, use the Previous and Next Step buttons ( ).
To close the window, click the Close button.

BusinessRules Server Control
The BusinessRules server control allows you to add a Business Rule created in
the Workarea to a Web form. It also allows you to add a place holder for a

Creating BusinessRules for Your Web Site
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Business Rule. Then, a Ektron CMS400.NET administrator can create a business
rule at a later date.

For an explanation of Business Rules and how they work, see Creating Business
Rules for Your Web Site on page 13-1.

BusinessRules Server Control Properties
The following table explains the properties of the Business Rules server control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

Hide

Used to hide a control in design time and run time.

True =Hide BusinessRule

False =Show BusinessRule

Boolean

Language Set a language for viewing form content. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

RuleID
The ID of the Ruleset to evaluate. If you don’t know the ID number of

the Ruleset, use the CMSExplorer to browse to it. See Also: Using
CMSExplorer to Browse Your Ektron CMS400.NET Site on page 24-8

Long

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a block
of code.

Custom - Allowsyou to use a custom tag.

String
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Ektron CMS400.NET's content management system (CMS) features a fully-
developed, web content localization solution, incorporating powerful tools and
support for web content management, localization/translation management,
and the workflow to tie these processes together. A global CMS is the "engine"
behind a successful site, enabling authoring, organization, publishing, and
versioning of Web content - all in multiple languages. Ektron CMS400.NET
provides all the features required to deliver a truly interactive online
experience for site visitors worldwide.

Ektron CMS400.NET goes far beyond managing Web site content: it supplies
tools to manage all elements of a multilingual website presence and also
ensures a great customer experience. "Tools" include calendars, metadata,
taxonomies, menus and forms, as well as "traditional" content, such as product
information data, marketing messages, brand information and news. You can
produce far more effective results for your multilingual Web site experience by
adopting a CMS designed as a single point of control with complete integration,
one interface, and a logical approach to versioning and publishing multilingual
sites. Today's global economy demands a CMS that manages critical elements
for translation and is tightly integrated into the entire localization process.

There are several aspects to Ektron CMS400.NET's multi-language support.
They are listed below.

Type of Translation Seen by
For more information,
see

Content Content contributors; visitors to
your site

Working with Multi-
Language Content on
previouspage

Spell checkdictionary Visitors to your site Set the Language of Spell
Checking on page 14-30

SpecialCharacter Encoding Visitors to your site Character Encoding on
page 14-40

Workarea screen labels, alt text, system
messages Content contributors Translating theWorkarea

on page 14-41

Ektron CMS400.NET supports the creation of content in any language supported
by the Unicode standard. This section explains how to create and work with
content in any language.

This section also contains the following topics.

Enabling/Disabling Support for Multiple Language Content 14-4
Viewing Your Site in Another Language 14-4
What Happens if Chosen Language is Not Available 14-5
Determining Which Languages are Available 14-6
The Default Language 14-8
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Disabling a Language 14-8
Creating New Content 14-9
Translating Content 14-9
Using the Language Export Feature 14-14
Additional Multi-Language Topics 14-24
Setting Up a Multilingual Web Site 14-26
Using a Language Other than American English as the Default 14-29
Set the Language of Spell Checking 14-30
Character Encoding 14-40
Translating the Workarea 14-41
LanguageAPI Server Control 14-44
LanguageSelect Server Control 14-46

Providing Multi-language Content
To provide multi-language content, you can either create new content or copy
and edit existing content. For example, you can begin the creation of German
content by copying English content, translating that content into German, then
deleting the English content.

All editions of content have the same ID number but are differentiated by the
language attribute. As a result, your Web page template can link to a single
content item, but what is displayed is determined by the selected language.
There are two ways that content’s language can be selected:

n a language cookie, which is created when a visitor logs into your site
and selects a language

n the link to another page includes the language (langType)
parameter. For example, mytemplate.aspx?LangType=1033.

Note: For a list of the decimal values for each supported language, see Ektron CMS400.NET
Workarea > Settings > Configuration > Language Settings.

The View Contents of Folder screen’s View menu lets you choose a language
then view and create content in that language. You can also view all content in
the folder, regardless of language. This field makes it easy to find and work on
content editions in a selected language.

ProvidingMulti-language Content
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The View Contents of Folder screen also displays the language of each content
item. This helps you distinguish them when viewing all content.

Finally, you can set up a separate approval chain for each edition of a content,
and can assign collections and tasks in any supported language.

Enabling/Disabling Support for Multiple
Language Content
You enable support for multi-language content in the web.config file. To do that,
follow these steps.

1. Open the file webroot\yourwebsite\web.config.

2. To enable multi-language content, set the value of ek_
EnableMultilingual to 1. To disable it, set it to zero (0).

3. Save and close web.config.

Viewing Your Site in Another Language
It’s easy for site visitors to view your site in any enabled language. On any
screen, your developer can display a language drop-down list (circled in red
below).

See Screen Sample
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(For more information about the LanguageSelect Server Control which displays
this list, see LanguageSelect Server Control on page 14-46.) On the sample site
provided with Ektron CMS400.NET, this drop-down list appears in the lower left
corner of the home page. Your developer can place it anywhere on any page.

You can also indicate a language-edition by adding the language parameter
(langType) to the Quicklink. For example, products.aspx?LangType=1033
displays the English (US) edition of the products.aspx content. This syntax
automatically sets the language cookie.

Note: For a list of the decimalvalues for each supported language, see Ektron CMS400.NET
Workarea > Settings > Configuration > Language Settings.

See Also:What Happens if Chosen Language is Not Available below

What Happens if Chosen Language is
Not Available
When a site visitor selects a language then a page on your site, Ektron
CMS400.NET uses the following criteria to determine which language edition of
content to display.

1. If content is available in the selected language, display that.

2. If option 1 is not available, display the content in the default language
(defined in the ek_DefaultContentLanguage variable in
web.config).

Note:When Ektron CMS400.NET is installed, the default language is English.See Also: The
Default Language on page 14-8

3. If no editions are available, display nothing.

What Happens if Chosen Language is Not Available
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Determining Which Languages are
Available
To determine which languages are available for creating content, go to the
Workarea and click Settings > Configuration > Language Settings. The
Language Settings screen lists all languages in which content can be created on
your site. You can create a new locale, if needed.

Note: Only members of the Administrator User Group can view, add, or edit language settings.

See Also:Working with Multi-Language Content on page 14-1

To change the list, follow these steps.

1. Click the Edit button ( ).
2. The Edit Language Setting appears.

3. Each language has two check boxes. They are described below.

n To enable a language in the Workarea only, click ( ). If this column
is checked, the language populates the language drop-down lists
within Ektron CMS400.NET, as shown below.

See Screen Sample
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n To enable a language in the Workarea and let site visitors select it
when viewing the site, click ( ).

So, you can enable languages in the column while you are translating the
site but are not ready to make that content publicly available. When you
complete the translation, check the column.

Note: If you select , the check box in the column is checked automatically. This is
because, if you let users view the language on the site, it must be enabled in the Workarea.

Note: The default content language on a dropdown list is determined in the ek_
DefaultContentLanguage element of the web.config file.

If you choose only one language on the Language Settings screen, fields that
prompt the user to select a language do not appear in Ektron CMS400.NET.
Instead, all content is created in that language.

DeterminingWhich Languages are Available
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The Default Language

Effects of the Default Language
n The default language determines which edition of content to display if

a site visitor does not select a language.

n The default language is used if a visitor selects a language other than
the default, then navigates to page for which content does not exist in
the selected language. In that case, Ektron CMS400.NET displays that
content in the default language (if available).

Changing the Default Language
When you install Ektron CMS400.NET, the default language is US-English
(1033).

Use the following procedure to change the default language for your multi-
language Web site.

Important: You must enable a language before setting it as the default. See Also: Determining
Which Languages are Available on page 14-6

1. Open webroot\yourwebsite\web.config.

2. Set the value of ek_DefaultContentLanguage to the locale id of the
default language. For example, 1031 for German.

Note: For a list of locale ids, see Ektron CMS400.NET Workarea > Settings > Configuration >
Language Settings .

3. Save and close web.config.

See Also: Using a Language Other than American English as the Default on page
14-29

Disabling a Language
To disable any language, uncheck its checkbox on the Edit Language Setting
screen. (For more information, see Determining Which Languages are Available
on page 14-6.)

Before disabling the default language, you must assign a new default language.
See Also: The Default Language above
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What Happens to Content When You Disable
Its Language
If you disable a language for which content exists, that content remains in the
database but no one can access it, either from within Ektron CMS400.NET or
when visiting your site.

If you later enable that language, the content is once again available.

Creating New Content
To create content in any language, follow these steps.

1. Navigate to the content folder in which you want to create the
content. (You must have permission to add content to the folder.)

2. From the language drop-down list, select the language in which you
want to create the content.

If the desired language is not available, see Determining Which
Languages are Available on page 14-6.

3. Click the Add Content button ( ) and create the content as you
would any content. See Also: Adding HTML Content on page 7-15

4. In order to add metadata to content, metadata definitions must have
been created for the selected language.See Also: Adding a Metadata
Definition on page 7-151

Translating Content
When translating content into a foreign language, you have three options.

Option For more information, see

Copyoriginal content into a new content item in a new
language.
Then, translate content manually.

Translating Content Manuallyon next page

Use the computer-based translation tool provided
with Ektron CMS400.NET. UsingMachine Translation on page 14-11

Create an XLIFF or XHTML file from existing content.
The file is sent to a translation agencyand returns
translated to the new language(s). Then, import the
translated files into Ektron CMS400.NET.

Using the Language Export Feature on page 14-14

What Happens to ContentWhen YouDisable Its
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Translating Content Manually
Use this procedure when you want to initialize new foreign language content
with content from a source language, then translate the content manually. The
copying should facilitate the translation.

For example, an editor is translating content from French to German. The editor
copies the French edition to new content whose language is German. As the
editor translates the French edition into German, he deletes the French content.
Any images in the content would usually remain, and all formatting (tables,
bullets, etc.) is retained.

After signing in to Ektron CMS400.NET, you copy content into new content of a
different language by either

n navigating the Web site, or

n accessing the Workarea and navigating the folder structure

After copying the original content, translate it into the new language then delete
the original text. Both procedures are described below.

Accessing Content via the Web Site
1. Navigate to a page on which you can select the site language. See

Also: Viewing Your Site in Another Language on page 14-4

2. Select the language into which you want to translate the content.

3. Navigate to content that you want to translate. You must have
privileges to add content to this folder. See Also: Setting Permissions
through the Permissions Table on page 4-41

4. Right click a small menu appears.

5. Click the Add New Language option ( ).
6. The original language content appears. Translate into the new

language then delete the original content.

Note: At this point, you can click the Translate Content button ( ) to have the software
translate the content. You can then edit it as needed to perfect the translation.

7. In order to add metadata to content, metadata specifications must
have been created for the selected language. See Also:Working with
Metadata on page 7-141

8. When you save the content, it is saved as the edition of that content in
the selected language.

Accessing Content via its Content Folder
To copy content into a new content of a different language, follow these steps.

Working with Multi-Language Content
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1. Go to the View Content screen for the content you want to translate.
Its status must allow editing (it cannot be submitted or pending).

2. From the View drop-down list, select an original language.

3. Click the content you want to translate.

4. It appears on the View Content screen.

5. Use the Add drop down list in the upper right corner to select the
language into which you want to translate the content.

6. The original language content appears. Translate into the new
language then delete the original content.

7. In order to add metadata to content, metadata specifications must
have been created for the selected language.See Also:Working with
Metadata on page 7-141

8. When you save the content, it is saved as the edition of that content
in the selected language.

Using Machine Translation
Ektron CMS400.NET includes a machine translation feature, which can
automatically translate content from/to the following languages.

n Chinese Simplified

n Chinese Traditional

n Dutch

n English

n French

n German

n Greek

n Italian

n Japanese

n Korean

n Portuguese (Brazilian)

n Russian

n Spanish

UsingMachine Translation
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Note: Currently, machine translation is not supported for all languages in the Language
Settings screen.

Like most software-based translation, someone fluent in the new language
should verify that the translation is appropriate within the context of the page.

The machine translation feature lets you choose a glossary (that is, a field,
industry, or subject area). This helps the software find the best translation for a
term or phrase with different meanings in different fields.

To use the machine translation feature, follow these steps.

Accessing Content via the Web Site
1. Navigate to a page on which you select the site language. See Also:

Viewing Your Site in Another Language on page 14-4

2. Select the language into which you want to translate. If you do not
see the language on the language selector dropdown, you need to
enable the language. See Also: Determining Which Languages are
Available on page 14-6

3. Navigate to content you want to translate.

Note: You must have privileges to add content to the folder.See Also:

4. Right click within the content’s border. A menu appears.

5. Click the Add Content button ( ).
6. The original language content appears.

7. If the screen uses a Smart Form, select the text that you want to
translate.

Note: You cannot use Machine Translation to translate field names in a Smart Form. XLIFF
files are a good way to translate XML field names.See Also: Using the Language Export
Feature on page 14-14

8. Click the Translate Content button ( ).
9. The Translation screen appears.

10. Select the source (old) and target (new) languages.

11. If the content should refer to a specific glossary, select one from the
dropdown list.

12. Click the Translate button.

Working with Multi-Language Content
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13. The translation appears. If it looks OK, press Paste Content.

14. The translated content replaces the original content in the editor.
Modify as needed.

15. In order to add metadata to content, metadata specifications must
have been created for the selected language.See Also:Working with
Metadata on page 7-141

16. When you save the content, it is saved as the edition of that content
in the selected language.

Accessing Content via its Content Folder
To machine translate content by identifying its content folder, follow these
steps.

1. In the Workarea, navigate to the content folder that contains the
content you want to edit.

2. Click View > Language and select an original language (that is, the
language from which it will be translated).

3. Click the content you want to translate. Its status must allow editing
(that is, its status cannot be submitted or pending).

4. It appears on the View Content screen.

5. Use the Add dropdown list in the upper right corner to select a new
language for the content.

If you do not see the language on the dropdown, you need to enable the
language. See Also: Determining Which Languages are Available on
page 14-6

6. The original language content appears. Edit the title if appropriate.

7. Click the Translate Content button ( ).
8. The Translation screen appears.

9. Select the source (old) and target (new) languages.

Accessing Content via its Content Folder
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10. If the content should refer to a specific glossary, select one from the
dropdown list.

11. Click the Translate button.

12. The translation appears. If it looks OK, press Paste Content.

13. The translated content replaces the original content in the editor.
Modify as needed.

14. In order to add metadata to content, metadata specifications must
have been created for the selected language.See Also:Working with
Metadata on page 7-141

15. When you save the content, it is saved as the edition of that content in
the selected language.

Note:When the View Contents of Folders screen reappears, it is probably set to the source
language. In this case, you do not see the new content in the target language. To see it, click
View > Language and select All or the target language.

Using the Language Export Feature
The Language Export feature lets you copy content into XLIFF files that can be
submitted to a translation agency. The agency translates the files and returns
them. In the final stage, you import the translated content back into Ektron
CMS400.NET.

The Language Export feature lets you translate the following kinds of CMS
information.

n content, including summary, comments, and meta data

n forms, including response message, comments, and meta data

n all menus (you cannot choose individual menus)

n file assets (files managed by the DMS, including Office documents,
Open Office documents, managed files, etc.)

n taxonomies

This section also contains the following topics.

What is XLIFF? 14-15
Supported Versions of XLIFF 14-15
Overview of Exporting/Importing Translation Files 14-15
Creating the .zip File 14-16
File Naming Patterns 14-19
Importing Translated Files into Ektron CMS400.NET 14-20
Viewing Foreign Language Content 14-21
Applying Translated Metadata to Translated Content 14-22
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What is XLIFF?
XLIFF (XML Localization Interchange File Format) is a format that's used to
exchange localization data between participants in a translation project. This
special format enables translators to concentrate on the text to be translated,
without worrying about text layout. The XLIFF standard is supported by a large
group of localization service providers and localization tools providers.

To learn more about XLIFF, visit these Web sites:

n http://www-106.ibm.com/developerworks/xml/library/x-
localis/

n http://www.xliff.org/

See Also:

n Overview of Exporting/Importing Translation Files below

n Creating the .zip File on next page

n Importing Translated Files into Ektron CMS400.NET on page 14-20

Supported Versions of XLIFF
Ektron CMS400.NET supports the following versions of the XLIFF standard: 1.0,
1.1, and 1.2. You specify the version you are exporting in the web.config file,
using the ek_XliffVersion element. Any version listed above can be
imported.

SDL Trados Studio 2009
Trados is a commonly used translation tool.

SDL Trados Studio 2009 supports XLIFF 1.1 and 1.2, which are the
recommended versions for use with Ektron CMS.

If you are using Trados (an earlier version of the product), it only supports
XLIFF 1.0. Note that CMS 400 6.1.4 and older default to XLIFF 1.1, you need to
change the XLIFF version in the web.config file as described in Supported
Versions of XLIFF above.

Overview of Exporting/Importing Translation
Files

1. You select content to translate. You can select:

n a content item

n a folder (all content in the selected folder is selected; all subfolders
of the selected folder may be included)

n all menus

What is XLIFF?
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n one or more taxonomies

2. Ektron CMS400.NET converts the selected content to XLIFF files. You
can prepare the files for translation into several languages at once.

A separate .xlf file is created for each item. Then, all .xlf files for a
language are compressed into one .zip file. A separate .zip file is created
for each language.

3. Transmit the.zip files to a translation agency, which converts them
into the new language(s).

4. The translation agency returns the files.

5. Import them into Ektron CMS400.NET. If the editions of the content
do not exist in the target language, they are created.

Creating the .zip File
To create one or more .zip files for translation, follow these steps.

See Also: Using the Language Export Feature on page 14-14

Note: Only members of the Administrator User Group and those defined in the Manage
Members for Role: XLIFF-Admin screen can create or import XLIFF files. See Also: Using the
Roles Screens on page 15-31.

1. To translate one content item, navigate to its folder then click it.

To translate all content in a folder (and, if desired, all of its subfolders),
navigate to its View Contents of Folder screen.

To translate a menu, go to Content Tab > Menus.

To translate a taxonomy, go to Content Tab > Taxonomy and check
the taxonomies to translate.

2. Click the Export for Translation button ( ). (On the View Contents
of Folder Screen, click Action > Export for Translation.)

3. The Export for Translation screen appears.

Working with Multi-Language Content
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Note: The Include Subfolders field only appears if you click the Export for Translation button
from the View Contents of Folder screen.

4. If you want to include content in all of the selected folder’s
subfolders, check Include Subfolders. To translate just the
selected folder, uncheck it.

5. The language of items being translated appears in the Source
Language pull-down. If this is not the correct source language, click
the down arrow and select the correct one.

6. All languages enabled in the Language Settings screen are selected
under Target Language(s). (See Also: Determining Which
Languages are Available on page 14-6).

7. To translate the content into all languages, proceed to the next step.

To translate the content into some languages, uncheck the languages
that you do not want. You can uncheck the box in the header row
(illustrated below) to uncheck all, then only check the ones you want.

8. Click the Create XLIFF Files for Translation button ( ).
9. Ektron CMS400.NET creates one .zip file for each language. The .zip

file includes an XLIFF file for each selected content item.

Note: If any selected folder contains content in a target language whose edit date is more
recent than the source language edition, that content is excluded from the .zip file. Ektron
CMS400.NET assumes that, since a more recent target-language edition exists, you do not
want to translate the corresponding source language edition.

Creating the .zip File
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The History section of the Export for Translation screen displays the
translated files.

The history lists the .zip file created for each language. (.zip files are

indicated by the WinZip icon ( ).) To the right of the icon are
n the flag of the source language

n an arrow indicating the direction of the translation

n the flag and name of the destination language

n the size of the zip file

Note: The top of the history window displays the most recently exported/imported files.

10. If you want to review the items in a zip file, click the plus button next
to Extracted. When you do, each content item’s ID number, title,
and last edit date appear.

11. Click the blue text of a .zip file. The File Download window appears.
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Note: If you want to review the XLIFF files within the .zip file, click Open.

12. Click the Save button. The Save As window appears. Navigate to the
folder where you want to place the zip file and click Save.

13. Transmit the files to the translation agency.

Note:When XLIFF files are returned by the translation agency, their extension must be .xlf.
Other than that, the file name is not important.

File Naming Patterns

File
Type

Pattern

XLIFF

item identifier[item ID]_[new language hexadecimal code][two letter new language code].xlf

n item identifier options:

- content: cont

- form: form

- menu: s

- menu item: s

- taxonomy: t

n item ID varies, depending on whether the item is content, a form, amenu, or amenu item

- content: content ID number

- form: form ID number

- Menu: menu ID number

- Menu item: menu ID number

ZIP
xlf[timestamp in format yyyymmddThhmmss]_u[user ID] _ [new language hexadecimal code]-[two
letter language code].zip

The user ID indicateswhich user performed the export or import.

File Naming Patterns
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Importing Translated Files into Ektron
CMS400.NET
To import translated files into Ektron CMS400.NET, follow these steps.

See Also: Using the Language Export Feature on page 14-14

Note: Only members of the Administrator User Group and those defined in the Manage
Members for Role: XLIFF-Admin screen can create or import XLIFF files. See Also: Using the
Roles Screens on page 15-31.

1. Go toWorkarea > Settings > Import XLIFF Files.

2. Click the Browse button and navigate to the folder that contains the
translated files.

3. Select the files to import.

4. Click the Upload and Import button ( ).
5. Ektron CMS400.NET creates new or updates existing foreign-language

editions of the imported content/menu/taxonomy.

6. Information about the imported file appears in the history area of the
Import XLIFF Files screen. You can click plus signs (+) to reveal
increasing levels of information about the imported content.

When you import the file, the comment Translated appears next to it.

For each new edition:

Working with Multi-Language Content

14-20 ReferenceManual
Version 8.01 Rev 4



n If the content title is the same as the source edition, the next
available number is appended to the title to distinguish it from the
source. For example: Henry Williams(1).

n its status matches the status of the source content. Typically, its
status is checked out. When imported, it can enter the approval
process just like other content.

n its history indicates it was checked in at the time the report was run

n for content, the following properties are inherited from the original
content:

- status

- Smart Form

- content searchable

- approval method

n date created and last edit date are captured from when the content is
imported

n the last user to edit is captured by user who imported the file

After you import the translation files, Ektron CMS400.NET removes them from
the file system.

Note: If an error exists in any of the files, the erroneous files are moved into a subdirectory.
The directory is created using a timestamp. For example:
uploadedFiles\localization\merged\xlf20060208T141841_u1\error\.

Viewing Foreign Language Content
1. Navigate to the folder that contains the content.

2. Click View > Language and select the desired language.

Viewing Foreign Language Content
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3. Only content in that folder and the selected language appears.

You can perform the same activities with this content as any other content.

Applying Translated Metadata to Translated
Content
Unfortunately, translated metadata is ignored when importing XLIFF files. This
section describes how to have translated metadata applied to the translated
content.

Background Information
Although metadata exists in the XLIFF files, it does not appear in the content's
metadata even if metadata is defined for that language. This is because
metadata definitions have unique IDs across languages.

Note:While a content ID is the same for a corresponding content block in other languages, the
same is not true for metadata.

As a result, the ID for the source language (for example, English) metadata is
not automatically mapped to metadata for other languages (for example,
Spanish).

To solve this problem, create a mapping between the IDs of metadata
definitions of different languages that are synonymous. For example, consider
the following metadata definitions.

ID Name Language

102 Paper form number en-US

104 Original page count en-US

106 Número de papel de la forma es-ES

108 Cuenta de la página original es-ES

110 Estado de laminoría es-ES

In this example, IDs 102 and 106 are synonymous as are 104 and 108.
Definition 110, however, only exists in Spanish.

The mapping is stored in an XML file. The mapping informs the XLIFF import
process that metadata for ID 102 in English corresponds to ID 106 in Spanish
and likewise with 104 and 108.

Setting up the Process to Apply Translated Metadata to
Content

1. Open the folder site root/workarea/xslt/ and look for the file
metadatadefinitions.xml. If it exists, go to step 2. If it does not,
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download it from Ektron at
http://dev.ektron.com/uploadedFiles/DevCenter/Support/KB_
Articles/XliffMetadata.zip.

The zip file includes modified XSLT files that access the XML file.

2. Create metadata definitions in the other language(s). Be sure to use
the same data type.

To do this, log in, open the workarea, go to Settings > Configuration
> Metadata Definition.

3. Make note of the definitions in the original language (for example,
English).

4. Switch to view another language (for example, Spanish) and add a
new definition. Assign it the same data type and other properties as
the original. Make note of the new ID numbers.

Create metadata definitions in all languages you wish to support. You
may add other languages and define more metadata definitions at any
time.

5. Edit workarea/xslt/metadataDefinitions.xml. For each Metadata
Definition, enter a <dd> element within the <dl> element. The <dd>
element has the following form.

<dd title="Name of the metadata definition">

<dfn id="ID" xml:lang="language-country code"/>

<dfn id="ID" xml:lang="language-country code"/>

:

</dd>

For example,

<dl>

<dd title="Paper form number">

<dfn id="102" xml:lang="en-US"/>

<dfn id="106" xml:lang="es-ES"/>

</dd>

<dd title="Original page count">

<dfn id="104" xml:lang="en-US"/>

<dfn id="108" xml:lang="es-ES"/>

</dd>

</dl>

The definition for ID 110 is not included because it applies to only one language.

Setting up the Process to Apply Translated
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Now that you have set up the xml file, the XLIFF import process accesses the
metadataDefinitions.xml file to determine which definitions in the target
language (for example, Spanish) correspond to the definitions in the source
language (for example, English).

Additional Multi-Language Topics
n Multi-Language Approval Chains below

n Working with Tasks in a Multi-Language System on the facing page

n Working with Collections in a Multi-Language System on the facing
page

n Working with Calendars in a Multi-Language System on the facing
page

n Working with Menus in a Multi-Language System on the facing page

n Creating an External Link to a Page of Foreign Content on page 14-26

Multi-Language Approval Chains
Just as you can create separate editions of content for each enabled language,
you can set up a language-specific approval chain and method. When
determining a folder’s approval chain, first select a language then select users
and groups with authority to approve content in that folder and that language.

The screen below shows the language selection drop-down list on the View
Approvals screen.

Only users in the language-specific approval chain for a folder can approve
content in that language.

You can also set a language-specific approval method. See Also:
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Working with Tasks in a Multi-Language
System
If you create content then add a task to it, the task can be in any enabled
language. This would be helpful if, for example, you review English content
then want to assign the task of translating it into another language in that
language.

If you create a task then try to assign content to it, you can only choose from
content in the language of the task.

Working with Collections in a Multi-Language
System
In a multi-language Ektron CMS400.NET system, you can create a language-
specific edition of each collection. For information about doing this, see
Working with Collections in a Multi-Language System on page 9-116.

Working with Calendars in a Multi-Language
System
Calendars can be created in any supported language. Once you enter the
calendar and event information in the foreign language, the calendar display
(that is, day and month names) automatically appears in that language. Also,
regional conventions for first-last days of the week, and date and time formats
are maintained.

Working with Menus in a Multi-Language
System
Note: If you are not familiar with the Ektron CMS400.NET’s menus feature, seeWorking with
Menus on page 9-133.

You can create an edition of any menu in every supported language. When a
site visitor selects a language, navigates to a page that has a menu and clicks
the menu link, Ektron CMS400.NET displays the menu in the selected language
if it is available. If a menu in that language is not available, nothing appears.

Before creating or translating a menu, it’s a good idea to create or translate all
content that will be on the menu. In this way, you can link these content items
to the new menu. However, after creating a menu, you can always add new
items to it.

For details about translating menus, see Working with Menus in a Multi-
Language System on page 9-158.
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Working with Taxonomies in a Multi-
Language System
See Multi-Language Support for Taxonomies on page 9-253

Creating an External Link to a Page of
Foreign Content
If another Web site links to a multilingual page on your site, the URL must
include the language ID parameter. For example:

www.ektron.com/web-content-management-solutions.aspx?LangType=1036

Setting Up a Multilingual Web Site
Ektron CMS400.NET supports multilingual content. This section lists steps to
follow when setting up such a site.

See Also: Creating Web Pages that Support Several Languages on the facing
page

Step For details, see

1. In web.config, make suremultilingual support is enabled.
Enabling/Disabling Support
for Multiple Language
Content on page 14-4

2. Set a default content language, one that will be used by themajority of
your site’s content.

If you had a previous version of Ektron CMS400.NET and selected a default
language on the Database Upgrade Utility, be sure that default language
matches the one in web.config.

TheDefault Language on
page 14-8

3. Enable languages your site will support.
DeterminingWhich
Languagesare Available on
page 14-6

4. Add language selection function to templates. Viewing Your Site in Another
Language on page 14-4

5. Create ametadata definition for each supported language. Adding aMetadata
Definition on page 7-151
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Step For details, see

6. Create or translate content.

n Adding HTMLContent
on page 7-15

n Translating Content on
page 14-9

7. Set up approval chains for new content. Multi-Language Approval
Chainson page 14-24

8. Set upmultilingual collections.
Working with Collections in a
Multi-Language System on
page 14-25

9. Set upmultilingualmenus.
Working with Menus in a
Multi-Language System on
page 14-25

10. Set upmultilingual taxonomies. Multi-Language Support for
Taxonomieson page 9-253

11. Modify text on templates.
Modifying Page Content
Based on Language
Selection on next page

12. Translate graphics.
Modifying ImagesBased on
Language Selection on page
14-29

This section also contains the following topics.

Creating Web Pages that Support Several Languages 14-27
Modifying Page Content Based on Language Selection 14-28
Modifying Images Based on Language Selection 14-29

Creating Web Pages that Support Several
Languages
When thinking about setting up your Web site to support content in multiple
languages, consider these three actions.

CreatingWeb Pages that Support Several
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Action For more information, see

Create
language-
specific
content,
menus,
collections

n Translating Content on page 14-9

n Working with Collections in aMulti-Language System on page 14-25

n Working with Menus in aMulti-Language System on page 14-25

After you create these items, have the page invoke that item dynamically.When Ektron
CMS400.NET receivesa request to display an item that includesa language and item id
number, it returns the language-specific edition. To learn about letting the user select a
language from aWeb page, seeViewing Your Site in Another Language on page 14-4.

Adjust
template
content to
user
language

Modifying Page Content Based on Language Selection below

Translate
text in
images

Modifying ImagesBased on Language Selection on the facing page

Modifying Page Content Based on Language
Selection
If a template’s text should change according to a user’s language selection, use
a case statement to provide the language-specific content. A good example of
this is the template used on the RC international sample site (Illustrated below).

Assume you want to create editions of the menu that runs across the header
(Home, Products, etc.) in three languages:

n English

n French

n German

To do so, follow these steps.

Note: This procedure uses the header.asp file delivered with the RC international sample site
as an example.

1. In the template file, declare each menu option a variable. For
example:

Dim t_search, t_products, t_support, t_news, t_careers, t_calendar, t_home, t_login, t_
site_lang, t_contact, t_copyright, calendar_id
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2. Enter case statements that provide the value of each variable in each
language. (1031 is the decimal code for German, 1036 for French.)
The following illustrates how to do this for the search menu option.

Select Case ContentLanguage

Case "1031"

t_search = "Suche"

Case "1036"

t_search = “Recherche"

Case else

t_search = "Search"

End Select

Now, when a user visits a page controlled by this template and selects French
or German as the site language, the page is refreshed and the translated values
appear on the template.

Modifying Images Based on Language
Selection
Many Web page templates also include images that require translation. You can
set up templates to invoke images in the user-selected language by following
these steps.

1. Add to the library each image that should change when the language
changes. For example, if your company’s tag line is translated into
three languages, upload the three images into the library.

It‘s a good idea to include the language in the title of the image. For
example, tagline_English, tagline_French.

2. Create a separate content block for each language-specific image.
Each content block must have a unique ID number.

3. Insert the appropriate image into a content block for each language.
For example, insert the tagline_English image into the English
content block.

4. Insert the content blocks into the appropriate templates. For
example, insert the English content block into the English template.

Using a Language Other than American
English as the Default
Use this procedure if your site supports one language only, and it is not
American English (1033).

Modifying Images Based on Language Selection
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To set your site’s default language to something other than American English,
follow these steps.

1. Install a new site. Do not log in at this point.

2. Open your site’s web.config file (located in your site root folder.) Set
ek_EnableMultilingual to zero (0). Set ek_
DefaultContentLanguage to the four digit locale id for the desired
language.

3. Log in to Ektron CMS400.NET.

4. Go to Settings > Configuration > Language Settings.

5. Enable the desired language, and disable all other languages.

6. Go to Settings > Configuration > Setup.

7. Make sure the desired language is the Default Application
Language.

8. Go to Settings > Users > Edit User Information. Set the User
Language to the desired language. Do not leave App Default as the
value.

9. Repeat Step 7 for every Ektron CMS400.NET user.

Set the Language of Spell Checking
Since Ektron CMS400.NET provides two editors, there are two procedures for
doing this.

n Setting the Spell Check Language for eWebEditPro+XML below

n Setting the Spell Check Language for eWebEdit400 below

Setting the Spell Check Language for
eWebEditPro+XML
To specify which dictionary to reference when checking spelling, specify a
language in Microsoft Word, version 2000 or later. To do this, open Word and
select Tools > Language > Set Language.

Setting the Spell Check Language for
eWebEdit400
Note: Checking Spelling on page 7-43 provides basic information about spell checking.
Please read that before reading this section.

Ektron CMS400.NET’s spell checker refers to a standard dictionary of the
content’s language. So, for example, if the content is U.S. English, the U.S.
English dictionary is referenced.
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The spell checker also references a language-specific custom dictionary. Words
are added to this list when a user stops at a misspelled word and chooses the
Add to Dictionary option.

Both dictionaries reside on the server that hosts Ektron CMS400.NET.

The spell checker compares each word against both sources. If a word is in
either one, the spell checker moves to the next word. If a word is missing from
both sources, the spell check options shown below appear, and the user decides
what to do.

This section also contains the following topics.

What Happens if No Dictionary Matches the Content Language 14-31
List of Standard Dictionaries 14-31

What Happens if No Dictionary Matches the
Content Language
If Ektron CMS400.NET does not have a dictionary that matches the content
language, it proceeds through these steps in the order shown below.

1. If the language begins with en (for example, en-AU), use the en-GB
dictionary.

If it begins with zh, use zh-CHS.

2. Each language has a default version, indicated by letters before the
dash matching the ones after the dash. For example fr-FR. If the
default version’s dictionary is available, use it.

3. Use the first dictionary (alphabetically) that begins with the content
language. For example, the content language is es-AR, but its
dictionary does not exist. The first dictionary alphabetically beginning
with es that is available is es-CO, so use that.

4. If none of the above is available, use en-US.

List of Standard Dictionaries
Ektron CMS400.NET provides the following standard dictionaries.

What Happens if No DictionaryMatches the
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Code Language

uk-UA Afrikaans

ar-AR Arabic

bg-BG Bulgarian

cs-CZ Czech

da-DK Danish

de-CH German (Switzerland)]

de-DE German

en-GB English (Great Britain)

en-US English (United States)

es-ES Spanish

fr-FR French

he-IL Hebrew

it-IT Italian

nl-NL Dutch

nn-NO Norwegian (Nynorsk)

pl-PL Polish

pt-PT Portuguese

pt-BR Portuguese (Brazil)

ru-RU Russian

sl-SL Slovenian

sv-SE Swedish

uk-UA Ukrainian
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Editing eWebEdit400’s Standard Spell Check
Dictionaries
The following topics explain how to access a screen for working with standard
dictionaries, and how to update, edit, replace, and delete individual words as
well as entire dictionaries.

n Accessing the Spell Check Dictionary Update Screen below

n Adding a Word on next page

n Deleting a Word on page 14-35

Note: There is no option for editing a word. Instead of editing, delete a word then add the
correct version.

n Adding a Word List on page 14-37

n Importing a Dictionary on page 14-37

n Deleting a Dictionary on page 14-39

n Replacing a Dictionary on page 14-39

Accessing the Spell Check Dictionary Update
Screen
Ektron CMS400.NET provides a special screen that allows you to create, update,
and delete the standard dictionaries. To access this screen, use this URL:

http://your server/site root
folder/workarea/contentdesigner/dictionaryconfigurator/dictionaryconfigurator.aspx

This screen looks like this.
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Note: If you want to remove the red text from the top of the screen, open the .aspx file and
delete that text.

In order to use this screen. the ASP.NET user must be granted read and write
permission to the following folder: your server\site root
folder\Workarea\Foundation\RadControls\Spell\TDF.

Note: If ASP.NET user has full permission but you still cannot edit a dictionary, open the folder
listed above, right click the TDF file and verify it is not read-only.

Adding a Word
To add a word to any dictionary, follow these steps.

1. Open the Dictionary Update screen. See Accessing the Spell Check
Dictionary Update Screen on previous page.

2. Click Edit Dictionary.

3. At the Select Dictionary dropdown, choose the language of the
dictionary you want to update. (List of Standard Dictionaries on page
14-31 describes the codes on the list.)

4. In the Add a word field in the lower right corner of the screen, enter
the word to add.
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5. Click the Add button.

Note: Tip! Enter the word you just added into the FindWord field and click Find to verify that
the word was successfully added.

Deleting a Word
To delete a word from any dictionary, follow these steps.

1. Open the Dictionary Update screen. See Accessing the Spell Check
Dictionary Update Screen on page 14-33.

2. Click Edit Dictionary.

3. At the Select Dictionary dropdown, choose the language of the
dictionary you want to update. (The List of Standard Dictionaries on
page 14-31 describes the codes on the list.)

Deleting aWord
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4. In the Find word field in the top left of the screen, enter the word to
delete.

5. Click the Find button.

6. In the results box below, click the word.

7. Click the Delete Selected button.

Note: Enter the deleted word into the FindWord field and click Find to verify that the word was
successfully removed.
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Adding a Word List
You may add a list of words to a standard dictionary. For example, you work in
a hospital and want to add medical terms. While you can add words one at a
time using Adding a Word on page 14-34, it is more efficient to place all words
in a text file then import the file into a dictionary.

To add a list of words, follow these steps.

1. On your server, create a .txt file.

2. Place all words into the .txt file, one on each line.

3. Save the file using the language code of the dictionary you are
updating. For example, if you are adding to the French dictionary,
name the file fr-fr.txt. See Also: List of Standard Dictionaries on page
14-31

4. Open the Dictionary Configurator screen. See Accessing the Spell
Check Dictionary Update Screen on page 14-33.

5. Click Edit Dictionary.

6. Next to Import Wordlist, click Browse.

7. Navigate to the text file you saved in Step 3.

8. Click the Import button.

9. All words on the list are added to the dictionary whose name matches
the .txt file. For example, words in the fr-fr.txt file are added to the
fr-FR.TDF dictionary file.

Note:While on the screen, enter one of the words in the word list into the Find word field, then
click Find to verify that the import succeeded.

Importing a Dictionary
Typically, you want to import a dictionary because the language of some Ektron
CMS400.NET content is not on the List of Standard Dictionaries on page 14-31.
For example, your content is Japanese.
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You could also delete a standard dictionary then import one to replace it if you
have a word list that you consider superior to the standard dictionary. See Also:
Deleting a Dictionary on the facing page.

To import a dictionary, follow these steps.

Note: The following procedure assumes the words do not yet exist in a .TDF file. If they do,
open the Dictionary Configurator screen, click the Browse button, select the file, and click
Import.

Part one: Create a Blank TDF File
1. On your server, use Notepad to create a blank .tdf file named after

the language code of the dictionary you are importing. For example,
if you are importing a French dictionary, name the file fr-fr.tdf. See
Also: List of Standard Dictionaries on page 14-31

2. Open the Dictionary Configurator screen. See Accessing the Spell
Check Dictionary Update Screen on page 14-33.

3. Next to the Pick a file to import field, click Browse.

4. Navigate to the .tdf file you created in Step 1.

5. Click the Import button. This action places the TDF file into the
correct folder.

Part two: Create and Import the Word List
1. Follow the procedure described in Adding a Word List on previous

page to insert all dictionary words into a .txt file.

2. Click Edit Dictionary.

3. Next to Import Wordlist, click Browse.

4. Select the text file you created in Step 1.

5. Click the Import button.

6. All words in the list are added to the dictionary whose name matches
the .txt file name.

Note: Use the Edit dictionary screen to select the dictionary. Then, use the Find word field to
verify that the import succeeded.
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Deleting a Dictionary
You would typically delete a standard dictionary in order to replace it if you
have a word list that you consider superior to the standard dictionary.

To delete dictionary, follow these steps.

1. Open the Dictionary Configurator screen. See Accessing the Spell
Check Dictionary Update Screen on page 14-33.

2. In the available dictionaries list, find the language whose dictionary
you want to import.

3. To the right of the language, click Delete.

Replacing a Dictionary
You would typically want to replace a standard dictionary if you have a word list
that you consider superior to the one provided. The procedure for replacing a
dictionary is documented in Importing a Dictionary on page 14-37.
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Editing eWebEdit400’s Custom Dictionary
A language’s custom dictionary is created the first time a user uses the Add to
Dictionary option while spell checking content in that language.

From then on, the dictionary is updated when anyone using that server edits
content in that language and uses the Add to Dictionary option.

How the Custom Dictionary is Named
The name of the custom dictionary is formed by stringing together

n the language code of the content

n a dash (-)

n the word custom

n the file extension .txt

So, if the content is French, the file’s name is fr-fr-custom.txt. The file is saved
to the root/Workarea/Foundation/RadControls/Spell/TDF folder.

Editing the Custom Dictionary
Edit the custom dictionary using any application that updates .txt files, such as
Notepad.

Character Encoding
The following Ektron Knowledge Base articles describe issues surrounding the
display of special characters within Ektron CMS400.NET. Note that these articles
refer to eWebEditPro, Ektron’s WYSIWYG editor embedded within Ektron
CMS400.NET.
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Wherever these articles contain references to eWebEditPro’s configuration data
or file (config.xml), you should instead update the web.config file, located in
your site’s root folder.

n HOWTO: produce UTF-8 (www.ektron.com/developers/ewebeditpro_
tutorials.cfm?id=403)

n INFO: Character Encoding
(www.ektron.com/developers/ewebeditprokb.cfm?id=1807)

n INFO: Encoding special characters
(www.ektron.com/developers/ewebeditprokb.cfm?id=384)

Translating the Workarea
When Ektron CMS400.NET is delivered, the Workarea is in English. If you want
to translate it to another language, read this section.

Note: Ektron provides American English strings in a text file. You must translate them.

This section also contains the following topics.

Prerequisites 14-41
Procedure for Translating Workarea Strings 14-41
Procedure Overview 14-42
Step by Step Instructions 14-42

Prerequisites
n The alphabetical, four-character identifier of the country/ language

into which you are translating. See CultureInfo Class from the MSDN
Web site (http://msdn2.microsoft.com/en-
us/library/system.globalization.cultureinfo(vs.71).aspx).

n The server that hosts Ektron CMS400.NET must have Visual
Studio.NET

Procedure for Translating Workarea Strings
All Workarea text (that is, screen titles, Workarea menus, messages, alt text
for buttons, etc.) is stored in a resource file. Resource files are installed to the
siteroot\Workarea\resources directory.

Note:Workarea images that include text are stored in the workarea/images/language
folder. For example, Workarea\images\french_standard.

Ektron CMS400.NET provides a resource files for the following languages. The
English resource file is complete. The others are partially complete.

n German

n English (United States)

Translating theWorkarea
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n Spanish

n French

n Italian

n Dutch - Netherlands

n Dutch - Belgium

Regardless of the list above, to translate your Workarea, translate the English
file into the desired language.

Procedure Overview
A resource file is not human-readable. To make it so, use Microsoft’s resgen
utility. Next, translate the human-readable, .txt version of the file. Here is a
portion of it.

add menu title=Add Menu
lbl ad serverip=Domain Controller IP
alt: remove collection items text=Click here to remove items from this collection

Notice that, for each string in the file, an English description appears first. The
description includes information about where the text appears. For example,
btn text appears on a button. Next is an equal sign (=), then English text.

Translate the text to the right of the equal sign. You can send the file to an
agency or do it yourself.

Then, run the resgen utility on the .txt file again, indicating the translate-to
language. This converts the file back to a machine-readable format. Finally,
move that file to the appropriate language folder under workarea/images, and
enable the new language in the Workarea.

Step by Step Instructions
To perform this procedure, follow these steps.

1. The resgen.exe utility is located in C:\Program Files\Microsoft
Visual Studio 8\SDK\v2.0\Bin. Copy it to the your web
site\Workarea\resources folder.

2. Go to Windows Start button > Microsoft Visual Studio 2005 >
Visual Studio Tools > Visual Studio 2005 Command Prompt to
open a command window.
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3. Within the command window, change the directory to the your web
site\Workarea\resources folder. For example, cd
C:\Inetpub\wwwroot\CMS400Min\Workarea\resources.

4. Insert the following text: resgen EKResource.en-US.resources
anyfilename.txt

Note: You can assign any name to the .txt file.

5. A .txt file of resource strings converted to a human-readable format
is created in the resources directory. (You assigned its name in Step
4.) Open the file.

6. Replace any single backslashes (\) with a double backslash (\\).

7. Translate the text following every equal sign (=). Be careful not to
change any occurrences of n surrounded by double backslashes
(\\n\\).

Note: You can send the file to a translation house or translate the strings yourself.

8. Save and close the .txt file.

9. Open the command window (as described in Step 2) and insert the
following: resgen anyfilename.txt EKResource.two-character
country code-two-character language code.resources

Replace anyfilename.txt with the file you named in Step 4. In this
example, the .txt file is named span_translation.txt.

For example, to indicate that the Workarea is being translated into the
Spanish/Spain, enter resgen.exe span_translation.txt
EKResource.es-ES.resources.

When the conversion is complete, Writing Resource File ...Done
appears in the command window.

10. The Workarea\resources folder includes several resource files. If
one exists for the translate-to language, it is overwritten. If one does
not exist, it is created.

To follow our example, the EkResource.es-ES.resources file was
updated with changes you made in Step 7.
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11. Move the updated resource file to the appropriate language folder
under Workarea/images. To continue our example, move the file to
the Workarea/images/spanish_traditional_Sort folder.

If a folder does not exist for the new language, create one under
Workarea/images.

12. Enable the new language in the Language Settings screen. See
Determining Which Languages are Available on page 14-6

13. Make the new language the default language in the Configuration
Setup screen. See Updating Setup Information on page 2-28Fields on
the Application Setup Screen: Workarea Tab on page 2-31.

LanguageAPI Server Control
The LanguageAPI server control lets a developer force a particular language for
a Web site. You can do this by dropping the server control on the page and
setting a language in the SiteLanguage property box. You can also override site
language logic by programmatically using the LanguageAPI server control to
detect the browser’s language, and display the site in that language.

This section also contains the following topics.

LanguageSelect Server Control vs. LanguageAPI Server Control
14-
44

LanguageAPI Server Control Properties 14-44
Code Behind Only Properties and Methods 14-45
Using the LanguageAPI Server Control Programmatically 14-46

LanguageSelect Server Control vs.
LanguageAPI Server Control
The LanguageSelect server control lets users view your site in the language
they choose. The LanguageAPI server control, on the other hand, forces users
to view a site in a particular language. For information on LanguageSelect, see
LanguageSelect Server Control on page 14-46.

LanguageAPI Server Control Properties
The LanguageAPI server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Value
Data
Type

SiteLanguage Sets the site language. Runs through the IsValid function to verify that the
language is an active language in the system. String

SiteLanguageID

Numeric value of the site language. This is the property you will use if you are
using code behind to set the sites language ID.

Example: 1036 =French

For a list of supported languages, go to Ektron CMS400.NETWorkarea >
Settings>Configuration > Language Settings.

Integer

Code Behind Only Properties and Methods
The following is a list of LanguageAPI specific properties and methods that can
only be used programmatically.

Property Value
Data
Type

CurrentLanguage Read only. Returns the current language. String

CurrentLanguageID Read only. Returns the current language ID. Integer

DefaultLanguage
Read only. What the default language of the site is set to.
For example, the demo site is “English (Standard)”.

String

DefaultLanguageID
Read only. Returns the value that is the default language
ID of the site. For example, the demo site is “1033” for
English.

Integer

GetLanguage Thismethod returnsa string. Pass in a valid language ID and it will
return the language name.

Integer
Argument

GetLanguageID Thismethod returnsan integer. Pass in a valid language name and it
will return the language ID.

String
Argument

IsValid Thismethod returnsa boolean. You can pass in a language ID or a
string and it will tell you if the system is supporting it. Argument

LanguageIdList

Read only. Lists all the language IDs that are activated in Ektron
CMS400.NET.

For information on how to enable languages, seeDeterminingWhich
Languagesare Available on page 14-6.

Arrayof
Integers

LanguageTitleList Read only. Lists all the languages that are activated in Ektron
CMS400.NET.

Arrayof
Strings

Code BehindOnly Properties andMethods
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Property Value
Data
Type

MultiLanguageEnabled

Read only. Tells if the site supports multi-language
mode.

True = Multi-language enabled

False = Multi-language not enabled

Multi-language is enabled bydefault. To disable it, see
Enabling/Disabling Support for Multiple Language Content on page
14-4.

Boolean

Using the LanguageAPI Server Control
Programmatically
This example uses a logo that is not managed through Ektron CMS400.NET. It
retrieves the current language from the LanguageAPI control, and uses that
information to choose the logo version to display. The codebehind looks like
this.

Select Case LanguageAPI1.CurrentLanguageID

Case 1031

Image1.ImageUrl = "germanlogo.gif"

Case 1033

Image1.ImageUrl = "englishlogo.gif"

Case 1036

Image1.ImageUrl = "frenchlogo.gif"

End Select

LanguageSelect Server Control
The LanguageSelect server control displays a language selection dropdown list
on an Ektron CMS400.NET Web page.

This control lets a site visitor select a language in which to view the site. Here is
what the control looks like when published on a Web page.
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It lists all languages selected on the Settings > Configuration > Language
settings screen. (For more information, see Working with Multi-Language
Content on page 14-1.)

You can place this control in any location of any page on your site. On the
sample site, it appears in the lower left corner of the home page.

This section also contains the following topics.

LanguageSelect Server Control vs. LanguageAPI Server Control
14-
47

LanguageSelect Server Control Properties 14-47

LanguageSelect Server Control vs.
LanguageAPI Server Control
The LanguageSelect server control lets users view your site in the language
they choose. The LanguageAPI server control, on the other hand, forces users
to view a site in a particular language. For information on LanguageAPI, see
LanguageAPI Server Control on page 14-44.

LanguageSelect Server Control Properties
The following table explains the properties of the LanguageSelect control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Value
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to

browse to Content, Collections, etc. See Also: Using CMSExplorer
to Browse Your Ektron CMS400.NET Site on page 24-8

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes shown.

Boolean

Hide

Used to hide language select dropdown boxand label in design time
and run time.

True =Hide language select dropdown boxand label

False =Show language select dropdown boxand label

Boolean

LabelName Lets you define the label next to the language select dropdown box. String

Language
Set a language for the Language Select Box. This property shows
results in design-time (in VisualStudio) and at run-time (in a
browser).

Integer

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag. The default is
Span.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

Custom - Allowsyou to use a custom tag.

String
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Chapter 15

Managing Users and User
Groups
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Users are people who administer the Web site, create content, or publish
content. Without users, the Web site would be blank. In Ektron CMS400.NET,
you can add, edit, and delete users to and from the application through the
Settings folder in the Workarea.

Every Ektron CMS400.NET user belongs to a User Group. User groups are used
when creating permissions and an approval chain for content folders. User
groups can be departments in your company (Human Resources, Sales,
Engineering) or indicate a user’s role (Publishers, Administrators, Editors, etc.).

Important: If your system uses the Active Directory Integration Feature, proceed to Active
Directory Feature on page 15-39 to learn about user management functions. This chapter only
applies to systems that do not use Active Directory Integration.

Important: If your system uses LDAP Authentication, proceed to LDAP Authentication on page
15-80. Some functionality in this chapter does apply to LDAP. The LDAP chapter explains which
information is applied.

This section also contains the following topics.

Accessing the Users and User Groups Folders 15-2
Managing Users 15-3
Custom User Properties 15-12
Managing User Groups 15-27
Defining Roles 15-31
Active Directory Feature 15-39
Setup Guidelines 15-39
Setting Up Active Directory via the Advanced Domains Method 15-40
Setting Up Active Directory via the Legacy Method 15-41
Implementing Active Directory Integration 15-42
Active Directory Integration 15-42
User Authentication Only Mode 15-68
Logging into a System that Uses AD Integration 15-70
Single Sign On 15-71
Setting up Single Sign On 15-71
LDAP Authentication 15-80
Using LDAP with Ektron CMS400.NET 15-81
LDAP Screen Descriptions 15-89
Disabling LDAP Authentication 15-93

Note: Only members of the Administrators User Group and those defined in the Manage
Members for Role: User Admin screen can view, add, or edit users and user groups.

Accessing the Users and User Groups
Folders
All user and user group information is accessible from the Workarea.
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Accessing the User Folder
To access the user folder in Ektron CMS400.NET, follow these steps.

1. Access theWorkarea > Settings > Users.

2. All Ektron CMS400.NET users appear.

From this screen, you can add, edit, and delete users. These procedures are
explained in the next sections.

Accessing the User Group Folder
To access the user group folder in Ektron CMS400.NET, follow these steps.

1. Access theWorkarea > Settings > User Groups.

2. All user groups appear.

From this screen, you can add, edit, and delete user groups. These procedures
are explained in the next sections.

Managing Users
Warning! If you are using Active Directory to Manage users, see Active Directory Integration on
page 15-42.

This section also contains the following topics.

Creating a New User 15-3
Viewing a User 15-10
Editing a User 15-10
Deleting a User 15-11
Removing Users from User Groups 15-11

Creating a New User
Warning! If you are using Active Directory to add a new user, see Manually Adding AD Users to
Ektron CMS400.NET on page 15-59. If you are using LDAP, see Adding User Information from
an LDAP Server to Ektron CMS400.NET on page 15-84.

Before you can assign a user to a user group, you must add the user to the
system. To create a new user, follow these steps.

1. Go toWorkarea > Settings > Users.

2. Click the Add User button ( ).
3. The Add a New User to the System screen appears.

4. Enter the following information about the user.

Accessing the User Folder

ReferenceManual
Version 8.01 Rev 4

15-3



Note: Administrator group members can edit all fields for any user. Non-admin users can edit
their own profiles only, and only fields indicated in the Editable by non-admin users column
below.

Field Description

Editable
by non-
admin
user

General Tab (Tabs only appear when editing)

Username Insert a username for the user you want to create.

Path
This field is only available when using LDAPAuthentication. See Also:Adding
User Information from an LDAPServer to Ektron CMS400.NET on page 15-
84.

First Name Enter the first name of the user.

Last Name Enter the last name of the user.

Display
Name

The name that is used to identify a user in theWorkarea and on theWeb site.
This can be different from the Username, which is the name used to log in.

Note:  The DisplayName cannot be blank.

Password Enter a password for the user. See Also:PasswordManagement on page 2-
25.

Confirm
Password Confirm the password by typing it again.

User
Language

Select the language in which the user will view Ektron CMS400.NET screens
andmessages. The language also determines the default value whenever a
drop-down list of languagesappearswithin Ektron CMS400.NET.

The dropdown list is derived from the Language Settings screen, available
from theSettings > Configuration folder.

Do not confuse the system language with the user’s ability to create and edit
foreign editionsof content. This field doesnot prevent a user fromworking with
multiple language content.

See Also:Working with Multi-Language Content on page 14-1

Note: If the selected language is not English, French or German, it is only
supported after you download the Ektron CMS400.NET Language
Support Program fromEktron and translate theWeb site.

Managing Users and User Groups
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Field Description

Editable
by non-
admin
user

Email
Address

Enter the email addressof the user. Notification email is sent to this address
unless theDisable E-mail Notification field is checked. Also, this address
identifies the user sending Instant email. See Also: Instant eMailon page 1-92

Content
and Forum
Editor

Determineswhich editor will be used when this user

n replies to a Discussion Board. See Also:Using Discussion Boardson Your
Web Site on page 7-622

n edits content from the Ektron CMS400.NETWorkarea or after signing into
your Web site if the user is operating aWindowscomputer and the system
administrator has set UserPreferred as the value of the web.config file’s
ek_EditControlWinkey. See Also:Setting the Editor for Ektron
CMS400.NET Userson page 7-27

Your choicesare eWebEditPro and eWebEdit400. See Also:Ektron
CMS400.NET Editorson page 7-26

Creating a New User
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Field Description

Editable
by non-
admin
user

Avatar

An image or icon to represent you in the Forum.

Type in a web path to image. For example:
http://www.example.com/smileyface.gif

Bydefault, themaximum file size of an avatar is limited to 200 kilobytesand the
height and width of the avatar will be reduced 125 pixels preserving the aspect
ratio.

To change the file size limit, edit this file:

C:\inetpub\<wwwroot>\<YourSite>\Workarea\Upload.aspx.vb

In this file, change the line shown below to the size file you wish to allow. For
example, to allow 500kb files, change 200 to 500.

If (numFileSize > 200) Then

Remember, this number is in kilobytes.

To change the default height and width of the avatar, edit this file:

C:\intetpub\wwwroot\<YourSite>\App_Code\VBCode\Utilities.vb

In this file, change the following lines to the size you wish to allow. For example,
to make avatars have a height and width of 166 pixels, change 125 to 166 in
both these lines.

DimWidth As Integer = 125

DimHeight As Integer = 125

Disable
Receiving of
System
Notification
Email

Select to disable the email notifications for the user. If you do, the user doesnot
receive the automatic email notification described inAutomatic eMail
Notification on page 1-88. However, this field hasno effect on the user’s ability
to receive instant email.

Address Enter the addressused to find this user’s location when a search based on
location is being performed.

Managing Users and User Groups
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Field Description

Editable
by non-
admin
user

Latitude

The latitude used to find this user’s location when someone performsa search
based on location.

Googlemapsprovidesa service that takes the addressof user and returns its
latitude and longitude.

Note: You don’t need to useGoogle’s automatic retrieval of latitude and
longitude. Instead, you can enter the valuesmanually.

Longitude

The longitude used to find your location when a user is performing a search
based on location.

Googlemapsprovidesa service that takes the addressof content and returns
its latitude and longitude.

Note: You don’t need to useGoogle’s automatic retrieval of latitude and
longitude. Instead, you can enter the valuesmanually.

Forum
Signature

Addsa signature to this user’s posts in the forum. The user doesnot see the
signature in the editor. It is added after he clicks thePost button.

Tags

Select from a predefined list of Tags that describe yourself. Or, create a new
tag by clicking theClick To Add A NewTag link. Placing a checkmark in the
checkboxnext to a tag activates it for your profile. See Also: Tagson page 16-
271

User Groups Tab (Tabs only appear when editing) - Lists user groups to which the user belongs. See
Also:Assigning UsersTo User Groupson page 15-28

Workarea Tab (Tabs only appear when editing)

Full Screen When a checkmarkappears in this checkbox, theWorkarea opensup to the
size of the full screen. In addition, theWidth and Height optionsare hidden.

Width

If desired, change the width of the screen in which Ektron CMS400.NET
appears for this user. The width in pixelsmust be between 400 and 2400.

This field accommodatesuserswho have larger monitors and/or prefer a
smaller resolution, such as1280 x1024.

If a checkmarkappears in the Full Screen checkbox, this option is hidden.

Height

If desired, you can change the height of the screen in which Ektron
CMS400.NET appears for this user. The height in pixelsmust be between 300
and 1800.

This field accommodatesuserswho have larger monitors and/or prefer a
smaller resolution, such as1280 x1024.

If a checkmarkappears in the Full Screen checkbox, this option is hidden.

Creating a New User
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Field Description

Editable
by non-
admin
user

Display
button
caption in
the title bar

Check this box if you want anybutton’s caption text to appear in the screen
title’s bar whenever a user moves themouse over the button. Note the word
Publish, describing the button, in the illustration below.

If you do not check this box, the screen’s title remains in the title bar when the
user moves themouse over the button, as illustrated below.

Landing
Page after
login

If you want one page in your Web site to appear after this user signs in, enter
that page’sURL. Youmight select a page that leads to a group of pages that
youmaintain.

If you don’t know the URL, navigate to the page, go to the browser address
bar and select the text following the directory in which Ektron CMS400.NET
resides. For example, if the browser addressbar says
http://www.example.com/customers.aspx?id=945, enter
customers.aspx?id=945.

Set smart
desktop as
the start
location in
the
Workarea

If you want the Smart Desktop to appear as soon as this user enters the
Workarea, click inside this checkbox.

See Also:Personalizing the Smart Desktop on page 3-4

If you leave this checkboxblank, when this user enters theWorkarea, he goes
to the folder of the content specified at the Landing Page after login field.

Inherit Task
Permissions
FromUser
Groups

This area indicates your taskpermissionsand whether you inherit them from
user groups to which you belong.

For more information, see TaskPermissionson page 12-2.

Custom Tab

Anycustom
user
properties

SeeCustomUser Propertieson page 15-12

Activities Tab (Tabs only appear when editing)

Note: If you disable Notifications, theActivities tab (which lets the user pickNotifications to receive and
send) disappears.

Managing Users and User Groups
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Field Description

Editable
by non-
admin
user

Colleagues
Sub Tab

Select the notifications you want to receive when a colleague performsan
activity, and the agent that transmits the notification. For example, if you want
to receive email notificationswhen a colleague posts a blogmessage, you
would place a checkmark in the box for Blog Post in the email column. See
Also:Notificationson page 16-122

Community
GroupsSub
Tab

Select notifications you want to receive when amember of a community group
performsan activity relating to the group, the agent that transmits the
notification.

For example, you want to receive email notificationswhen a co-member of a
community group posts a blogmessage to group’s blog. To enable this, place
a checkmark in the box forGroup Blog Post in the email column.

See Also:Notificationson page 16-122

This tab sets preferences for all community groups.
For Developers: Ektron has created a UserGroupPreferencesuser control.
If you add the control to a community group’s profile page, users can specify
notification preferences for individual groups. This control comeswith Ektron
CMS400.NET and is located in:

[Drive:] \[webroot]\[siteroot]\Workarea\Notifications\Controls

To see this user control in an example site, download Ektron’seIntranet
starter site.
http://www.ektron.com/cms400-web-cms.aspx?id=5748

In this site, when a logged inmember of a community group accesseshis
group’s profile page, there is anEdit Group Notifications Preferences link.
Clicking this link opens the user control. When the user selects his preferences,
theyare stored for that group only.

MyActivities
Sub Tab

Select notifications you want publish when performing variousactivities on the
Web site. For example, if you want to publish notificationswhen you post a blog
message to your blog, place a checkmark in the box for Blog Post in the
Publish column.

See Also:Notificationson page 16-122

Note: If email notification is turned off in the setup page, you are notified when editing, adding,
or viewing a user.

5. Click the Save button ( ).
6. The View Users in Group Everyone screen appears with the new user

included in the table.

Note:When you add a new user, he is automatically placed in the Everyone user group. To
assign users to other groups, see Assigning Users To User Groups on page 15-28.

7. Continue this process until you add all Web site users, or reach the
maximum allowed by your license.

Note: Contact Ektron Sales for pricing of adding more users to your license.

Creating a New User
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Viewing a User
After adding a user, you can view that information. While viewing a user, you
can edit or delete the user.

To view a user, follow these steps.

1. Access the user folder as described in Accessing the User Folder on
page 15-3.

2. Click the Username of the user you want to view.

3. The View User Information screen is displayed.

To learn about the fields, see Enter the following information about the
user. on page 15-3

From the View User screen, you can edit or delete users. These actions are
described in the next sections.

Editing a User
Warning! If you are using Active Directory to edit a user, see Editing User Information in Ektron
CMS400.NET on page 15-69.

When editing a user, you can change the username, first name, last name,
password, user language, and email address. Also, while editing, you can
change three fields that were not available when the user was created.

n Account Locked

n Work Page Size

n Landing Page after login

To edit a user, follow these steps.

1. Access the view user screen of the user you want to edit as described
in Viewing a User above.

2. Click the Username of the user you want to edit.

3. The View User Information screen is displayed.

4. Click the Edit button ( ).
5. The Edit User screen is displayed. To learn about most fields, see

Enter the following information about the user. on page 15-3.

The following fields are only available when editing a user.

Field Description

Account Locked SeeRestricting Login Attemptson page 2-22
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Field Description

Content and
ForumEditor SeeContent and ForumEditor on page 15-5

ForumSignature

Addsa signature to your posts in the forum. You do not see the signature in the editor. It
is added after you click thePost button.

WorkPage Size SeeWorkarea Page Size on page 2-32

Landing Page
after login See Landing Page after login above

6. Make the necessary changes to the user information.

7. Click the Update button ( ).

Deleting a User
Warning! If you are using Active Directory to delete a user, see User Authentication Only Mode
on page 15-68.

When you need to remove a user from the application, you can easily do it from
the User’s Folder in the Workarea.

Warning! Once a user is deleted from the database, he is deleted permanently. The process
cannot be undone.

To delete a user, follow these steps.

1. Access the view user screen for the user you want to delete, as
described in Viewing a User on previous page.

2. Click the Username of the user you want to delete.

3. The View User Information screen is displayed.

4. Click the Delete button ( ).

5. A confirmation message is displayed.

6. Click OK.

Removing Users from User Groups
Warning! If you are using Active Directory to remove a user from a group, see Removing Users
from a Group on page 15-65.

Deleting a User
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Note: Removing a user from a user group does not delete the user from Ektron CMS400.NET.
Also, you cannot remove users from the Everyone group.

To remove a user from a user group, follow these steps.

1. Access the User Groups folder, as described in Accessing the Users
and User Groups Folders on page 15-2.

2. Click the User Group that includes the user you want to remove.

3. Members of the selected group appear.

4. Click the user to remove.

5. The View User Information screen is displayed.

6. Click the Delete button ( ) to delete the user from the group.

7. A confirmation message is displayed. Click OK.

Custom User Properties
Custom User Properties allow you to create custom fields. These custom fields
appear on the User Properties and Membership User Properties screens on the
Custom tab (see screen below), and on the Membership server control.

Custom User Properties are used to define information about a user beyond the
standard Ektron CMS400.NET user properties. Here are some examples.

n employee ID

n phone number

n phone extension

n instant message screen name

n position

n start date

n department

Managing Users and User Groups
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n birthday

n the IP address of the user’s machine

This section also contains the following topics.

The View Custom Properties Screen 15-13
Adding a Custom User Property 15-15
The Type Field 15-16
The Input Type Field 15-17
Validation 15-17
SelectList Field 15-19
MultiSelectList Field 15-20
Features Field 15-21
Private Profile Field 15-21
Time Zone Field 15-21
Editing Custom User Properties 15-22
Editing a Custom User Property 15-22
Deleting a Custom User Property 15-23
Setting the Custom User Properties Order 15-23
Using Custom User Properties for Non-English Languages 15-24
Create a Custom User Property for a Non-English Language 15-25
Removing a Non-English Custom User Property Title 15-26
Viewing Custom User Properties By Language 15-27

Note: Only members of the Administrator User Group can work with Custom User Properties.

The View Custom Properties Screen
Use the View Custom Properties screen to create custom properties for users
and membership users. From the View Custom Properties screen, you can:

n add a new custom property. See Adding a Custom User Property on
page 15-15

n edit a custom property. See Editing Custom User Properties on page
15-22

n reorder the way custom properties appear on the users and
membership users screen. See Setting the Custom User Properties
Order on page 15-23

n work with custom properties in different languages. See Using
Custom User Properties for Non-English Languages on page 15-24

Below is an example of the View Custom Properties screen.

The View CustomProperties Screen
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The table below describes the View Custom Properties screen.

Buttons, Dropdown Boxes
or Fields

Description
For More
Information

Add button ( ) Add custom user properties.
Adding a Custom
User Propertyon
the facing page

Reorder button ( )
Change the order in which the custom
properties appear on the Users or
Membership User Properties screen.

Setting the Custom
User Properties
Order on page 15-
23

Language Selection Dropdown

List

Allowsyou to view custom user properties by
language.

Viewing Custom
User PropertiesBy
Language on page
15-27

Object Type Dropdown List

Allowsyou to choose users or taxonomies
whose custom properties you want to manage.

Adding a Custom
User Propertyon
the facing page
Assigning Custom
Properties to a
Taxonomyon page
9-243

Title Field

Displays the title of a custom user property.
When viewing by language, the title changes to
the title used in a specific language if it hasbeen
defined. Click a Title to edit the property.

Note: The title and label are the same field.
On some screens, Title is used; on others
Label is used.

Editing Custom
User Propertieson
page 15-22

Type Field Shows the Type that was chosen for a custom
user property.

Type on the facing
page

Managing Users and User Groups
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Adding a Custom User Property
Follow these steps to add a custom user property.

1. In the Workarea, click Settings > Configuration > Custom
Properties.

2. From the Object Type pulldown, select User.

3. Choose the standard language used in your Ektron CMS400.NET
Workarea.

4. Click the Add Property button ( ).
5. The Add Custom Property screen appears.

6. Complete the screen according to the table below.

The Custom User Properties Fields

The following table describes the custom user properties fields

Field Description
More
Information

Label

Title of the property you are adding. For example, Employee ID.

Note: The Title and Label are the same field. On some screens the word
Title is used, on others the word Label is used.

Type The property’s data type. Once a type is selected and saved, you cannot
change it. Youmust delete the custom property and re-enter it.

The Type
Field on next
page

Input
Type Choose how a user is able to enter a response to the property.

The Input
Type Field on
page 15-17

Validation Ensures the right type of data is entered in a text boxor text area. Validation on
page 15-17

Adding a CustomUser Property
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Field Description
More
Information

Min Value

If desired, enter theminimum value you want to allow. TheMin Value only
appearswhen the following Validationsare used: NumericOnly, Date Only
and U.S. Zip Code.

The following is an example of a Date OnlyMin Value: 01/01/1900.

Max
Value

If desired, enter themaximum value you want to allow. TheMaxValue only
appearswhen the following Validationsare used: NumericOnly, Date Only
and U.S. Zip Code.

The following is an example of a Date OnlyMaxValue: 01/01/1987.

Message

Amessage that appearswhen information entered in a user property violates
the validation criteria.

For example, if the validation isU.S. Zip Code, youmight use the following
message:Please enter a valid zip code

7. Click the Save button ( ).
8. The new property appears on the View Custom Properties screen.

The Type Field
The following table describes the types available in the Type field.

Types Description
Input Types
Available

Validations
Available

String Accepts all alpha, numeric, and symbol
characters

n Text Box

n Text Area

n Hidden

All validations

See Also:Validation
on the facing page

Boolean Accepts a true or false response n CheckBox None

Numeric Accepts numbersonly n Text Box

No Validation

n Cannot be blank

n NumericOnly

n U.S. Zip Code

n Dollar Amount

Date Only a date can be entered. n Text Box

n NoValidation

n Cannot be blank

n Date Only

SelectList
Select a response from a list of choices.

See Also:SelectList Field on page 15-19
NA NA
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Types Description
Input Types
Available

Validations
Available

Multi
SelectList

Select anynumber of responses from a list
of choices. See Also:MultiSelectList Field
on page 15-20

NA NA

Category

A system-defined type that appearswhen
the first subscription is created. One entry
covers all subscriptions.

See Also:Defining Subscriptionson page
23-18.

NA NA

The Input Type Field
The following table describes possible responses to the Input Type field.

Input
Type

Description
An Option
When Used
With

Text Box
Createsa standard text box. Below is an example of a text box. n String

n Numeric

n Date

Text Area

Createsamulti-lined area for entering text. Typically used whenmore than
one line of text needs to be added. Below is an example.

n String

Hidden

Hides the input field. This can be used byan administrator to add additional
valuesat postback time. This requiresa developer to add client-side
JavaScript.

Note: If you change a String field’s Input Type from Text Box or
Text Area toHidden, then sign in asamember of the Administrators
group, the field and its value still appear on the user’s profile.

n String

Check
Box

Createsa checkbox. Used when the field requiresa boolean (true / false)
response. Below is an example of a checkbox.

= True =False

n Boolean

Validation
The following table describes the validations available in the Validation field.

The Input Type Field
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Validation Description
An Option
When Used
With

No Validation The entry is not checked.

n String

n Numeric

n Date

Cannot be blank A responsemust be entered.

n String

n Numeric

n Date

Numeric Only The responsemust be a number.
n String

n Numeric

Text Only The responsemust be characters. n String

Date Only The responsemust be entered in the following format:
mm/dd/yyyy.

n String

n Date

Email Only The responsemust be entered asan Email address. For
example, username@domain.domainextention. n String

Credit Card Only The responsemust be entered asa credit card number.
For example, nnnn nnnn nnnn nnnn n String

Social Security Only The responsemust consist of nine digits in this pattern: nnn-
nn-nnnn. n String

U.S. State Code A two letter state code. For example: NH =New
Hampshire. n String.

U.S. Zip Code

The responsemust consist of 5 (nnnnn) or 9 digits
separated bya dash after the fifth (nnnnn-nnnn).

Note: If you use the NumericType, you cannot have a
dash or space when using a nine digit Zip Code

n String

n Numeric

Valid US Phone
Number

The responsemust consist of a 10 digits in this pattern: nnn-
nnn-nnnn. n String

Canadian Postal Code The responsemust consist of 6 (xnxnxn) alpha or numeric
characterswith a space after the first three characters. n String

Time HH:MM or
HH:MM:SS or
HH:MM:SS.mm

Time is entered in one of the following three formats.

HH:MM - Hours andMinutes09:30

HH:MM:SS - Hours, Minutesand Seconds09:30:45

HH:MM:SS.mm - Hours, Minutes, Secondsand
milliseconds09:30:45.002

n String
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Validation Description
An Option
When Used
With

IP Address The responsemust be in the form of an IP address. n String

Dollar Amount

This validation worksdifferently depending on the Type
used. If used with theString Type, you can have a dollar
sign ($) along with themoneyamount in the text field.

When used with theNumericType, you are not allowed to
have a dollar sign ($) in the text field. The following are
examplesof each type with validation:

String - $3.00

Numeric - 3.00

n String

n Numeric

Canadian Social
Insurance Number

The responsemust consist of nine digits in this pattern (nnn
nnn nnn). n String

SelectList Field
Use a SelectList field to present the user completing the User Information or
Membership User Properties screen with a list of choices. See example below.

When you create a custom user property and specify its type to be Select List,
the screen changes as shown below.

SelectList Field
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Completing a SelectList Field Entry
To add an item to the list, enter its text in the Text field, then click the Add
button. Added items then appear in the larger box on the left.

You can then

n remove any item from the list by clicking it. It appears in the Text
field. Click Remove.

n change the text of any list item by clicking it. It appears in the Text
field. Make changes then click Change.

n change the sequence of list items by selecting an item then clicking
the up or down arrow to move the item

Using the First List Item to Prompt a Response
You can use the first list item to prompt the user to make a selection instead of
being a valid response. For example, the first list item may say Select from a
list of choices. To do this, check the First item is not a valid selection
for example, “[Select]” check box.

If you do, the field has an asterisk (*) next to it (indicating it is required) on the
User Information and Membership User Properties screens. The user
completing the screen must choose any selection other than the first item. If he
tries to file the screen without choosing a different item, the following error
message appears: Please fill in all required fields (*)

MultiSelectList Field
Use a MultiSelectList field to present the user completing the User
Information or Membership User Properties screen with a list of choices. The
user can choose as many responses as appropriate. See example below.

Selected items are indicated by a blue background.

When you create a custom user property and specify its type to be MultiSelect
List, the screen changes as shown below.
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For information about completing the screen, see Completing a SelectList Field
Entry on previous page.

Features Field
This field is automatically included on the User or Member profile Custom Tab
to allow the profile owner to edit events on a web calendar. Once this is
checked, it cannot be unchecked.

For more information about Web Calendar, see Adding Web Calendar Events on
page 7-538.

Private Profile Field
This field is automatically included on the User or Member profile Custom Tab.
It lets the profile owner determine which other users can see his community
activities. For example, Viewing ActivityStream Widget on Another User’s Page
on page 16-170 explains how this settings affects other users' ability to see
your activities.

The Private Profile field value also determines if a user's profile is visible on
a forum. See Also: Using Discussion Boards on Your Web Site on page 7-622

And, when a Micro-message server control is placed on a page in TimeLine
mode, micro-messages only appear for users whose Private Profile setting is
set to Public. See Also: TimeLine Mode on page 16-190

Time Zone Field
The Time Zone property field is a special field used by the Web Calendar
feature.

Features Field
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Select the time zone of the User or Member here. When they are logged in,
appointment times will show in this time zone. For more information, See Also:
Adding Web Calendar Events on page 7-538.

Editing Custom User Properties
When you click a custom user property’s title, you are brought to the Edit
Custom Property Screen. From this screen, you can edit and delete a custom
property or create a version of the custom property in a non-English language.

When you edit a custom user property, the changes are applied to all users and
membership users. These changes are also applied to any other language
versions of the custom properties that exist.

To learn how to:

n edit a custom user property. See Editing a Custom User Property
below.

n delete a custom property. See Deleting a Custom User Property on
the facing page.

n create a custom property for a non-English language. See Create a
Custom User Property for a Non-English Language on page 15-25.

Editing a Custom User Property
When editing a custom user property, the changes are available to users and
membership users when the save button is clicked.

Follow these steps to edit a custom user property.

1. In the Workarea, click Settings > Configuration > Custom
Properties.

2. From the Object Type pulldown, select User.

3. Click the Title of the Custom User Property you want to edit.

4. Choose the field you want to change. You can edit the following fields:

n Label

n Input Type

n Validation

n Min Value

n Max Value

n Message

For descriptions of these fields, see The Custom User Properties Fields
on page 15-15.

Note: You cannot edit the Type field. If you need to change the type, you must delete the
custom user property and create a new one.
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Warning! If you delete a custom user property, it is removed from all users and membership
users. Any information that has been collected about users and membership users for that
property will be lost. In addition, any language versions of the custom user property are deleted.

5. Click the Save button ( ).
6. When you click a user or membership user, you see your changes.

Deleting a Custom User Property
If you delete a custom user property, it is removed from all users and
membership users. Any information that has been collected about users and
membership users for that property will be lost. In addition, any language
versions of the custom user property are deleted.

Follow these steps to delete a custom user property.

1. In the Workarea, click Settings > Configuration > Custom
Properties.

2. From the Object Type pulldown, select User.

3. Click the Title of the custom user property you want to delete.

4. Click the Delete button ( ).

5. A dialog box appears asking if you are sure you would like to delete
the item.

6. Click OK.

7. The View Custom Properties screen appears, and the property is no
longer available.

Setting the Custom User Properties Order
You can change the order in which properties appear on the User and
Membership Users Properties screen. To do that, follow these steps.

1. In the Workarea, click Settings > Configuration > Custom
Properties.

2. From the Object Type pulldown, select User.

3. Click the Reorder button ( ).
4. The Reorder Custom Properties screen appears.

Deleting a CustomUser Property
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5. Click a property.

6. Click the Up or Down arrows to move the property up or down the
list.

7. Click the Save button ( ).
8. On the View Custom Properties screen, you now see the properties in

the new order. If you go to the User or Membership User Properties
screen, the order of the properties there reflects the changes.

Using Custom User Properties for Non-
English Languages
Like content, custom user properties have a language attribute. This is useful if
you have users or membership users that only use a specific language. It can
also be used if you want a custom user property to appear in the language in
which the user is signed in.

Unless a language other than English is defined for a custom user property, the
property defaults to the English version. For example, if you have two
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properties called Birthday and Phone Number in English and you can translate
the French version of Birthday to Anniversaire, when you view the properties in
French, you see the English version of Phone Number and the French version of
Birthday.

Create a Custom User Property for a Non-English
Language
When creating a custom user property, it must be created in English then
translated to the desired language. This is done by editing the property,
changing languages, filling out the Translate Custom Property Label screen and
saving the property.

Warning! All custom user properties in languages other than English are tied to the English
version of the property. If you delete the English version of the property, all other language
versions of the properties are deleted also. However, you can remove a non-English language
version of the custom properties without deleting the English version. See Removing a Non-
English Custom User Property Title on next page

The following steps illustrate how to translate the Title/Label of a property into
French.

1. In the Workarea, click Settings > Configuration > Custom
Properties.

2. From the Object Type pulldown, select User.

3. Choose a custom property to be defined in another language.

4. Choose a language from the language select dropdown box.

5. The Translate Custom Property Label screen appears.

6. Enter a Label for the property in the language you have chosen. For
example, if you are creating a French version of a Birthday custom
user property, you would enter Anniversaire in the label text field.
For information on the Label property, see Label on page 15-15

7. Click the Save button ( ).

Create a CustomUser Property for a Non-English
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Removing a Non-English Custom User Property
Title
Removing a non-English version of a custom user property title does not
remove the english version of the property. When you remove the non-English
version of a property, you are basically removing the label for that specific
language in the custom property.

1. In the Workarea, click Settings > Configuration > Custom
Properties.

2. From the Object Type pulldown, select User.

3. Choose the language in which the custom user property appears from
the Language Dropdown Box.

4. Click the Title you want to delete.

5. The Translate Custom Property Label screen appears.

6. Click the Delete button ( ).
7. A dialog box appears asking if you would like to remove the

translated custom property title.

8. Click OK.

9. The English version of the Edit Custom Property screen appears.

10. Click the Back button ( ).

Warning! Do not click the delete button on the Edit Custom Property screen. This action deletes
the English version of the custom user property. If you click the delete button, you lose all
information collected by the property and all language versions of the property.
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Viewing Custom User Properties By Language
From the View Custom Properties screen, you can view the custom users
properties by languages. When viewing by languages, it is important to
remember that if there is only an English version of the property, the English
version appears in all the languages.

All custom user properties, in languages other than English, are tied to the
English version of the property. If you delete the English version of the
property, all other language versions of the properties are deleted.

To view the custom user properties by language, follow these steps.

1. In the Workarea, click Settings > Configuration > Custom
Properties.

2. From the Object Type pulldown, select User.

3. Choose the language in which to view the properties from the
language dropdown box.

4. The View Custom Languages screen for that language appears.

Note: In the example below, some properties have not been translated, so the English
versions appear instead.

Managing User Groups
Warning! If you are using Active Directory to manage user groups, see The Screens of the Active
Directory Feature in User Authentication Mode on page 15-70.

This section also contains the following topics.

Creating a New User Group 15-28
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Assigning Users To User Groups 15-28
Viewing the Users in a User Group 15-29
Editing a User Group 15-30
Deleting a User Group 15-30
Removing Users from User Groups 15-30

Creating a New User Group
Warning! If you are using Active Directory to create a new user group, see Adding User Groups
on page 15-65.

To create a new User Group in Ektron CMS400.NET, follow these steps.

1. Access the User Groups folder in the administrator Workarea, as
described in Accessing the User Group Folder on page 15-3.

2. Click the Add User Group button ( ).
3. The Add a New User Group to the System screen is displayed.

4. Enter a name and brief description of the user group you want to
create.

5. Click the Save button ( ).

Assigning Users To User Groups
Warning! If you are using Active Directory to assign a user to a user group, see Adding a User to
a Group on page 15-65.

To add a user to a user group, follow these steps.

1. Access theWorkarea > Settings > User Groups.

2. Click the user group to which you want to add a user.

3. The View Users in Group screen appears with all current group
members.

Note:When you create a new user group, no user is initially assigned to it.

Note that you can select any number of users by checking the box to the
left of their name. To select all users, check the box in the column
header row.

You can also sort the display by Username, Lastname or Firstname.
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And, you can enter characters into the Search field and find only users
that match them. For example, you could enter bill, click the Search
button, and see only users with those characters in their name.

4. Click the Add User button ( ).
5. Users who do not belong to the group appear.

6. Click the user you want to add.

7. A confirmation message is displayed.

8. Click OK.

9. The selected user is now a member of the selected group.

10. Continue this process until you add all users into User Groups.

Viewing the Users in a User Group
To view a list of users who are members of a user group, follow these steps.

1. Access the User Group folder in the administrator Workarea, as
described in Accessing the User Group Folder on page 15-3.

2. Click the user group whose members you want to view.

3. The View Users in Group screen appears with a list of users who are
members of the group.

From this screen, you can edit or delete user groups, as well as add and
remove users to and from the user group.

Viewing the Users in a User Group
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Editing a User Group
When editing a User Group, you can only change its name.

Note: You cannot edit the default Administrators and Everyone user groups.

To edit a user group, follow these steps.

1. Access the View Users in Group screen for the user group you want to
edit, as described in Viewing the Users in a User Group on previous
page.

2. Click the User Group you want to edit.

3. The View Users In Group screen is displayed.

4. Click the Edit button ( ).
5. The Edit User Group screen is displayed.

6. Make the necessary changes.

7. Click the Update button ( ).

Deleting a User Group
Warning! If you are using Active Directory to delete a user group, see Deleting a User Group on
page 15-66.

When you do not need a User Group anymore, you can delete it from the
system.

Note: You cannot delete the Administrator and Everyone groups.

To delete a user group, follow these steps.

1. Access the View Users in Group screen for the user group you want to
delete, as described in Viewing the Users in a User Group on previous
page.

2. Click the User Group you want to delete.

3. The View Users In Group screen is displayed.

4. Click the Delete button ( ).
5. A confirmation message is displayed.

6. Click OK.

7. The User Group is deleted from the Ektron CMS400.NET Web site.

Removing Users from User Groups
See Removing Users from User Groups on page 15-11.
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Defining Roles
Ektron CMS400.NET contains an Administrators User Group. Any user who is a
member of that group automatically has full administrator privileges. See Also:
Guidelines for Using the Folder-User Admin Role on page 15-35

The Roles feature lets you assign limited or specific administrator privileges to
users who should not have full administrator privileges. For example, you can
let certain users create, redirect, or remove tasks but deny them other
privileges normally granted to administrators.

Best Practice
When creating new user groups to use with roles, assign namesasamnemonic aid
for the role, especially for folder-specific rules. For example, theMarketing Folder
Adminsuser group could be used for all role memberswho can administer the
marketing folder.

Note: The Permissions Table lets you control which users can manage a folder’s properties,
its content, library items, and create or edit collections. (See Also: Folder Permissions on page
4-40) So, together, the Roles feature and the Permission Table give you the ability to assign
administrative privileges to users who are not members of the Administrators group.

This section also contains the following topics.

Using the Roles Screens 15-31
Guidelines for Using the Folder-User Admin Role 15-35
Guidelines for Using a Custom Role 15-35
Examples of Custom Roles 15-35
Steps for Setting up a Custom Role 15-36
Information about Custom Roles for your Developer 15-37
List of Administrator Privileges 15-37

Using the Roles Screens
Use the Roles screens to assign limited administrator privileges. To access the
Roles screens, go to the Ektron CMS400.NET Workarea and select Settings >
Roles.

Note: In the screens listed below, you can select users or groups. However, you can never
select the Administrators group, because that group already has all permissions.

The following table describes the Roles screens.

Screen Lets you give a user or user group the ability to
For more
information, see

System-Wide Roles
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Screen Lets you give a user or user group the ability to
For more
information, see

Alias-Admin

This user hasall the permissions that amember of the
administrators group has, such as the ability to

n Turn aliasing on and off

n View allmanual aliases

n Activate or deactivatemanual aliases

n Change the primary alias

n Create automatic, community, and RegExRegex
aliases

Creating User-
FriendlyURLswith
Aliasing on page 10-1

Alias-Edit
n View and assign amanual alias to content

n View secondary aliases

AutomaticURL
Aliasing on page 10-
21

AnalyticsViewer

View

n Web TrafficAnalytics reports

n Analytics button on the View Content Screen

n Analytics from theWeb site'sAccesspoint menu

n Analytics from a PageBuilder page

ViewingWeb Traffic
AnalyticsData on
page 7-785

BusinessRule
Editor Create or edit BusinessRulesand Rulesets

Creating Business
Rules for Your Web
Site on page 13-1

Calendar- Admin

Create, edit and delete calendars.

Note:  This role only appears if the classic calendar
(prior to version 8.0) is enabled in web.config. For the
WebCalendar feature (version 8.0 and higher), use
Folder-Admin role to determine which users can
create, edit and delete calendars.

Using Previous
Calendar Versionson
page 7-575

Collection andMenu
Admin

Create, edit and delete CollectionsandMenusvia the
Content tab

Note: Tomanage permissions for creating collections
andmenusvia the folder’sNew >Collection or New>
Menu option, use folder permissions. See Also: Folder
Permissionson page 4-40

Collection Permissions
on page 9-
118;Permission to Use
theMenusFeature on
page 9-135

Collection Approver If approval is required for a collection, approve changes to
it, including the deletion of a collection.

Setting up Approval
for Collectionson
page 9-119

Commerce Admin Access the eCommerce screens in the Ektron
CMS400.NETWorkarea.

Conducting
eCommerce with
Ektron CMS400.NET
on page 17-1
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Screen Lets you give a user or user group the ability to
For more
information, see

Community

Lets role membersperform the following community
activities:

n Set system default preferences

n View and create new

- Activity Types

- Agents

- Messages

n Enable or Disable Notifications

Notificationson page
16-122

CommunityGroup
Admin Create, edit and delete andmanage all community groups. CommunityGroupson

page 16-83

CommunityGroup
Create

Create andmanage community groups. A user with this
role can onlymanage community groupshe has created.

CommunityGroupson
page 16-83

MasterLayout-
Create Create and edit PageBuilder Master Layouts. PageBuilder Master

Layout on page 5-28

Message Board
Admin

A user with this role can approve pending comments or
delete existing comments on amessage board.

Message board comments for users and community
groupsare administered on theWeb site. Message Board
comments for content can be administered on theWeb site
or from the Content Report screen in theWorkarea.

Content Rating on
page 7-739 and
MessageBoard
Server Controlon
page 16-67

Metadata-Admin View, create and edit metadata definitions
Working with
Metadata on page 7-
141

Search-Admin Create and edit SynonymSets and Suggested Results

Suggested Resultson
page 9-36
SynonymSetson
page 9-33

Smart FormsAdmin Create or edit Smart Forms Working with Smart
Formson page 7-278

Synchronization
Admin

Access the Workarea > Settings > Configuration >
Synchronization screen, which lets the user perform all
synchronization activities, such as

n manage sync configurationsand profiles

n run a sync

n perform content and folder-level sync

Synchronizing Servers
Using eSyncon page
18-1

TaskCreate Create tasks TaskPermissionson
page 12-2
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Screen Lets you give a user or user group the ability to
For more
information, see

TaskDelete Delete tasks TaskPermissionson
page 12-2

TaskRedirect Redirect tasks TaskPermissionson
page 12-2

Taxonomy
Administrator Create andmanage taxonomies Taxonomyon page 9-

202

Template
Configuration View, create, update, and delete system templates

Creating/Updating
Templateson page 7-
178

User-Admin Create, view, edit, and delete users and user groups
Managing Users and
User Groupson page
15-1

XLIFF-Admin Use the Language Xport feature, which copies content into
XLIFF files that can be submitted to a translation agency.

Using the Language
Export Feature on
page 14-14

Folder Specific Roles

Folder-User Admin

View and edit folder properties. These users can update
properties, permissions, the approval chain, metadata,
Web alerts, purge history, etc.

For example, create a user group and give it permission to
manage the top-levelmarketing folder. Membersof the
group can do everything to that folder and its subfolders,
but lackauthority over other folders.

See Also:Guidelines for Using the Folder-User Admin
Role on the facing page

Folder Propertieson
page 4-13

Move or Copy

Move or copy content.

An Ektron best practice is to create a User Group for this
purpose, then assign the group to this role. Ektron
recommendsagainst assigning the role to individual users.

After assigning the User Group here, go to the folders
whose content these userswill be allowed tomove or copy,
and assign to that User Group at least ReadOnly and
Traverse permissions. See Also: Folder Permissionson
page 4-40

Moving or Copying
Content on page 7-
110

Custom
Permissions

Used bya developer to extend Ektron CMS400.NET’s
standard features

Guidelines for Using a
CustomRole on the
facing page
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Guidelines for Using the Folder-User Admin
Role
When setting up users and groups for administrative access over folders, keep
these in mind.

n After being identified on the Manage Members for Role: Folder User
Admin screen, users or groups must also be given at least Read-Only
permission for individual folders on the Folder Properties > View
Permissions for Folder screen. See Also: Folder Permissions on
page 4-40

n Youmust use the same identity on the Manage Members for Role:
Folder User Admin and Folder properties screens. So, if a user group
is listed for the role, use the same group when assigning folder
permissions, not simply a group member. Conversely, if individual
users are listed on the role screen, they must be specified in the
folder permission.

n Ektron strongly recommends adding only user groups to the Folder
User Admin role, not individual users.

If you set up an individual user as a role member, he could
accidentally receive administrative rights to other folders.

Guidelines for Using a Custom Role
Note: The developer sample page installed with the sample site (http://site
root/cms400developer/developer/default.aspx) demonstrates how to use custom
roles. From the home page, click Roles > Custom Roles.
To download the developer sample site, go to
http://www.ektron.com/solutions/startersites/.

The custom permissions role lets your Web developer create a site page, and
then restrict access to that page’s content (or areas with a page) to users
assigned to a custom role.

Items you could show and hide could be as simple as a content block. But they
could be more complicated, such as displaying buttons and fields for one user
group, and something completely different for another.

Custom roles have no effect inside the workarea.

Examples of Custom Roles
n Most of your site visitors belong to different political parties, while

some are not registered with any party. By checking the user’s ID
against custom roles, you could present registered voters with
selections for their party’s primary, and prevent unregistered voters
from participating.

Guidelines for Using the Folder-User Admin Role
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n Your CMS site visitors fall into two categories: suppliers and buyers.
You could check the current user against a custom role and show
buyers one set of data and suppliers a different set.

n On your eCommerce site, registered students see a list of coupons
that are not displayed for anyone else. Or, only registered adults can
order age-controlled items, such as tobacco or alcohol.

n Control your pages’ background colors, images, and skins based on
custom roles. For example, mothers get family-oriented background
images while teenagers get rock images and related styling.

Steps for Setting up a Custom Role
To set up a custom role, follow these steps.

1. Set up user groups and add to them users who will have some level of
access to the custom page. See Also: Creating a New User Group on
page 15-28

To continue the above example, create one group of auditors (who will
have read-only access), and another group of administrators (who will
have edit access).

2. Create an Ektron CMS400.NET folder to hold the content that will
appear on the custom page. Use the folder’s permission table to
assign users and groups appropriate access to the folder’s content.
See Also: Folder Permissions on page 4-40

3. Set up a Custom role. To do this, go toWorkarea > Settings >
Roles > Custom Permissions.

4. Create a new role.

5. From the Manage Custom Roles screen, click the role you created.

6. From the user type selector, click the type of users you want to add to
the role.

7. Click the Add button ( ).
8. Check the box next to the users or groups that you want to add to the

role.

9. Your Web developer creates the custom page. See Also: Information
about Custom Roles for your Developer on the facing page

10. You create content to appear on the custom page. Place the content in
the folder you created in Step 2.
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Information about Custom Roles for your
Developer
The API provides two methods that determine if the current user is logged in,
and if he is a member of the Administrators group. The methods let you test
customizable roles with conditions outside the standard Is-Logged-In / Is-
Admin tests.

API methods are listed below.

Method Returns

GetRolePermissionSystem(RoleName
As String, nUserId As Long)

a Boolean value indicating if the user belongs to the system-wide
custom role

GetRolePermissionFolder(RoleName
As String, nFolderId As Long,
nUserId As Long)

a Boolean value indicating if the user belongs to the custom role
for the given folder. The procedure for assigning a user to a
custom role isGuidelines for Using a CustomRole on page 15-35

Usage is demonstrated in the Developer sample file site

root\CMS400Developer\Developer\Roles\CustomRoles.aspx.vb.

List of Administrator Privileges
Administrator privileges include access to most screens that appear when you
select Settings > Configuration.

Information about CustomRoles for your Developer
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Administrators can also

n edit folder properties (including Web alerts, metadata, permissions,
and the approval chain)

n manage aliasing features, such as turn aliasing on or off, activate and
deactivate manual aliases, and create automatic aliases

n manually alias content

n add, edit, or delete a calendar

n add, edit, or delete a business rule

n create, view, edit, and delete metadata definitions

n create, view, edit, and delete taxonomies

n create, redirect, and delete tasks

n require a collection to go through an approval process

n export content for translation to another language using XLIFF

n run an eSync

n access the eCommerce Module
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Active Directory Feature
The Active Directory feature allows you to retrieve user and user group
information from the Microsoft Windows Active Directory (AD) into Ektron
CMS400.NET. As a result, you can administer user information from one place
only, and users need to remember only one password/username combination
to sign on to the network and Ektron CMS400.NET.

To learn more about Active Directory, see

n Windows Server 2003:

http://www.microsoft.com/windowsserver2003/technologies/directory/activedirectory/default.mspx.

n Windows Server 2008: http://www.microsoft.com/windowsserver2008/en/us/ad-
main.aspx

This section also contains the following topics.

Setup Guidelines 15-39
Setting Up Active Directory via the Advanced Domains Method 15-40
Setting Up Active Directory via the Legacy Method 15-41
Implementing Active Directory Integration 15-42
Active Directory Integration 15-42
User Authentication Only Mode 15-68
Logging into a System that Uses AD Integration 15-70
Single Sign On 15-71
Setting up Single Sign On 15-71

To learn how to sign on using NTLM (NT Lan Manager), see
http://dev.ektron.com/kb_article.aspx?id=22100.

Setup Guidelines
Warning! Ektron strongly recommends configuring a secure socket layer (SSL), especially if you
are using Active Directory Integration. SSL encrypts passwords that are otherwise sent as clear
text to the Ektron CMS400.NET server. See Also: Configuring SSL on page 1-95

The two ways to set up Active Directory are contrasted in the table below.
Below the table are instructions for each setup option.

Active Directory Feature
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Method When to Use How setup is done

Advanced
Domains

n You are using a firewall

n The Ektron CMS400.NET server
need not be part of an Active Directory
domain

n You are connecting tomultiple
Active Directory domains, even ones
that do not see each other

Ektron CMS400.NETWorkarea. For setup
instructions, seeSetting Up Active Directory via the
Advanced DomainsMethod below.

Legacy You are using auto discovery and
Active Directory single signon

The domain connects to the AD domain within the
web.config.

For setup instructions, seeSetting Up Active
Directory via the LegacyMethod on the facing page

Setting Up Active Directory via the
Advanced Domains Method

1. Verify AD information because, after you enable AD integration, logon
name and domain are imported to Ektron CMS400.NET.

2. If your Active Directory forest has multiple domains, decide if you
want Ektron CMS400.NET to reference the listed domains or if you
want to choose a specific one. (You will use this when completing the
Domain field of the Active Directory Setup Screen.)

3. Edit the Web.config file.

- Set ek_ADEnabled to true. It should look like this:

<add key="ek_ADEnabled" value="true"/>

- Set ekADAdvanced to true. It should look like this:

<add key="ekADAdvancedconfig" value="true"/>

- Set ek_AUTH_Protocol to LDAP. It should look like this:

<add key="ek_AUTH_Protocol" value="LDAP"/>

Note: LDAP or GC are acceptable values for this property. LDAP is recommended.

- Set Identity impersonate to false. It should look like this:

<Identity impersonate= “false”

Note:When using the Advanced Domains Method, the domains screen's credentials are used.

4. Set up your domains on the Edit Domains screen. See The Edit
Domains Screen on page 15-46.

5. Configure the AD setup page. See The Active Directory Setup Screen
on page 15-48.
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6. Assign AD groups to Ektron CMS400.NET user groups. See Importing
AD User Groups to Ektron CMS400.NET on page 15-61.

Setting Up Active Directory via the
Legacy Method

1. Make sure each AD user to be used in Ektron CMS400.NET is defined
correctly in the Active Directory. Remember that, when you enable
AD integration, logon name and domain are copied from AD to Ektron
CMS400.NET.

2. If you have multiple domains in your Active Directory Forest, decide
if you want Ektron CMS400.NET to reference all domains or if you
want to choose a specific one. (You will use this when completing the
Domain field of the Active Directory Setup Screen.)

3. Set the following elements in the Web.config.

- For the authentication element, change the value of the
impersonate attribute to false. It should look like this:

<identity impersonate="false" userName="" password=""/>

- Set the ek_ADEnabled element to true. It should look like this:

<add key="ek_ADEnabled" value="true"/>

- Make sure the ekADAdvanced element is set to false. (This is the
default value.)

- Set the ek_AUTH_Protocol element to GC. It should look like this:

<add key="ek_AUTH_Protocol" value="GC"/>

- declare a domain account through ek_adusername and ek_
adpassword. It should look like this:

<add key="ek_ADUsername" value="[username]@domain" />
<add key="ek_ADPassword" value="YourPasswordHere" />

Note: Before entering the password, encrypt it using Ektron’s password encryption utility. To
access that utility, go to the Windows Start menu > All Programs > Ektron > current release >
Utilities > Encrypt Email Password.

4. Configure the AD setup page. See The Active Directory Setup Screen
on page 15-48.

5. Assign AD groups to Ektron CMS400.NET user groups. See Importing
AD User Groups to Ektron CMS400.NET on page 15-61.

Setting Up Active Directory via the LegacyMethod
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Implementing Active Directory Integration
The Active Directory feature has two implementation modes, described in the
following table. Choose the mode that best meets your needs.

Mode
Information Shared
between AD and CMS

For more information, see

user authentication only

n user logon name

n domain

n password

User Authentication OnlyMode on page 15-
68

active directory
integration

n user logon name

n domain

n password

n user’s first and last name

n email address

n user groups

n user’s groupmemberships

Active Directory Integration below

Active Directory Integration
This section also contains the following topics.

Impact of AD Integration on Use of Ektron CMS400.NET 15-43
Which AD Information is Imported to Ektron CMS400.NET 15-43
Ektron CMS400.NET Screens in Active Directory Integration
Mode

15-
46

The Edit Domains Screen 15-46
The Active Directory Setup Screen 15-48
The Active Directory Status Screen 15-52
The View Users Screen 15-55
The View User Groups Screen 15-56

Managing Users and Groups in Active Directory Integration Mode
15-
58

Importing AD User Information to Ektron CMS400.NET 15-58
Ongoing Import of User Information 15-59
Manually Adding AD Users to Ektron CMS400.NET 15-59
Editing User Information in Ektron CMS400.NET 15-60
Deleting Users 15-60
Replacing a User 15-60
Importing AD User Group Information to Ektron CMS400.NET 15-61
Importing AD User Groups to Ektron CMS400.NET 15-61

Managing Users and User Groups

15-42 ReferenceManual
Version 8.01 Rev 4



Importing a User’s AD Group Information into Ektron
CMS400.NET

15-
62

Mapping the Administrator Group 15-63
Resolving Discrepancies between Groups 15-65
Removing Users from a Group 15-65
Adding User Groups 15-65
Adding a User to a Group 15-65
Replacing a User Group 15-65
Deleting a User Group 15-66
Disabling AD Integration 15-66

For setup instructions for Active Directory, go to Setup Guidelines on page 15-
39.

Impact of AD Integration on Use of Ektron
CMS400.NET
Ektron CMS400.NET does not write to Active Directory – it only reads from it.
This results in the following changes to the way Ektron CMS400.NET manages
user and user group information.

n After you enable AD integration, many changes to user and user
group information must be made in AD -- several fields on the Edit
User and User Group screens become view-only.

n When adding new users or groups, you can only select from users
and groups in AD. If a user or group does not exist in AD, create it
there then import it to Ektron CMS400.NET.

Which AD Information is Imported to Ektron
CMS400.NET
Ektron CMS400.NET imports the following AD user information.

n Authentication (user logon name and domain) for signing in to Ektron
CMS400.NET.

Note: The AD password is not stored in Ektron CMS400.NET– CMS only refers to it during
sign in.

n User information, listed in the following table

Impact of AD Integration on Use of Ektron
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Field in
AD

AD
Attribute

Corresponding Field in Ektron
CMS400.NET

User logon name
(pre-Windows
2000)

sAMAccountName

Domain and Username

Note: Users can share a name in different domains. For
example, juser@example.com and juser@example.net.
Otherwise, user namesmust be unique.

Last Name sn Lastname

First Name givenName Firstname

Email mail email Address

n User group information, listed in the following table.

Field in
AD

AD
Attribute Corresponding Field in Ektron CMS400.NET

Group Name
(pre-Windows
2000)

cn

Domain and User group name

Note: User groups can share a name in different domains. For
example, editors@example.com and editors@example.net.
Otherwise, user group namesmust be unique.

The following diagram illustrates the components of the Active Directory
feature.
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Ektron CMS400.NET Screens in Active
Directory Integration Mode
The Active Directory feature uses these Ektron CMS400.NET screens:

n The Edit Domains Screen below

n The Active Directory Setup Screen on page 15-48

n The Active Directory Status Screen on page 15-52

n The View Users Screen on page 15-55

n The View User Groups Screen on page 15-56

This section explains each screen.

The Edit Domains Screen
Use this screen to identify each network domain you will use with Ektron
CMS400.NET’s Active Directory Integration. Use this to define domains, as
opposed to using auto discovery to find them. This feature is described through
these topics.

n Enabling the Edit Domains Screen below

n Accessing the Edit Domains Screen below

n Fields of the Edit Domains Screen on the facing page

n How Domains are Used on the facing page

Enabling the Edit Domains Screen
To have the Edit Domains screen appear, adjust web.config as explained in
Setting Up Active Directory via the Advanced Domains Method on page 15-40.

Accessing the Edit Domains Screen
Access the Edit Domains screen by going toWorkarea > Settings >
Configuration > Active Directory > Domains. Below is a sample of the
screen.
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The screen lets you add new domains, modify existing ones, or delete obsolete
ones.

Fields of the Edit Domains Screen
When defining a domain, enter the following information.

Field Description

Domain

DNS
Enter the domain’sDNS. Contact your server administrator for this information. For
example, corp.example.com.

NetBIOS
If your NetBios is the same asyour domain name, leave the checkboxbox checked.
Otherwise, uncheck the boxand enter your NetBIOS setting. Contact your server
administrator for this information.

Username Enter the name of the user with permission to sign on to the domain server. The name is in
the format username@domainDNS. For example, jsmith@corp.example.com.

Password Enter the password of the user identified above.

Domain
Controller IP

Enter the IP addressor DNSname of your domain controller.

Note: If using Active Directorywith LDAP acrossa firewall, the IP address should be
that of the firewall. On the firewall, traffic on port 389 (LDAP) should be allowed.
Active Directorywith GC usesdifferent ports.

How Domains are Used
Domains are used during signon. In addition to username and password, users
must select a domain.

Domains are referenced when defining the users and user group that map to
the Ektron CMS400.NET users and groups. See Also: Mapping the Administrator
Group on page 15-63
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ReferenceManual
Version 8.01 Rev 4

15-47



For example, while defining a user group, first select a domain. Ektron
CMS400.NET then provides a list of Active Directory user groups in that domain.

The Active Directory Setup Screen
The Ektron CMS400.NET Active Directory Setup screen (illustrated below) lets
you enable or disable AD and manage other AD issues, such as whether users
and groups are automatically updated.

To access the screen, click Settings > Configuration > Active Directory >
Setup.
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The following table describes the fields on the screen.

See Also: Messages Near the Top of the Active Directory Setup Screen on page
15-51

Field Description For more information, see

Active Directory Installed

Disable Active
Directory and
LDAP
Authentication

Disables the use of Active Directory and LDAP
Authentication. Disabling AD Integration on page 15-66

Enable LDAP
Authentication If enabled, youmust complete the following fields. Enabling LDAP on page 15-81

The Active Directory Setup Screen
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Field Description For more information, see

LDAPServer Explained in LDAPAuthentication chapter. Enabling LDAP on page 15-81

Port Explained in LDAPAuthentication chapter. Enabling LDAP on page 15-81

Organization Explained in LDAPAuthentication chapter. Enabling LDAP on page 15-81

Domain Explained in LDAPAuthentication chapter. Enabling LDAP on page 15-81

Attribute Explained in LDAPAuthentication chapter. Enabling LDAP on page 15-81

Use SSL Explained in LDAPAuthentication chapter. Enabling LDAP on page 15-81

Path Explained in LDAPAuthentication chapter. Enabling LDAP on page 15-81

Enable Active
Directory
Authentication

If enabled, user authentication is functional, and you
can enable the following three fields.

If you do not enable the following three fields, you
are usingUser Authentication OnlyMode on page
15-68.

User Authentication OnlyMode on page
15-68

For information on LDAP, see LDAP
Authentication on page 15-80

Enable Active
Directory
Integration

If enabled, the Active Directory Integration feature is
functional.

Note: Can only be enabled ifEnable Active
Directory Authentication is enabled.

Active Directory Integration on page 15-
42

Enable
automatic
addition of
user from AD

If enabled, user information is imported from AD to
Ektron CMS400.NET when that user logs in or
when the user is added to Ektron CMS400.NET.

Note: Can only be enabled ifEnable Active
Directory Authentication is enabled.

Active Directory Integration on page 15-
42

Enable
automatic
addition of
user to groups

If enabled, a user’s groupmembership is first
imported from AD when a user logs in or is added.

Note: Can only be enabled ifEnable Active
Directory Authentication is enabled.

Active Directory Integration on page 15-
42

User Property Association

EmailAddr1

Enter the Active Directory property that maps to the
user’s last name in Ektron CMS400.NET. By
default, this is mail, but you can change it to anyAD
property.

same reference asFirstName (above)
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Field Description For more information, see

FirstName

Enter the Active Directory property that maps to the
user’s first name in Ektron CMS400.NET. By
default, this isgivenName, but you can change it to
anyAD property.

MSDN Library
http://msdn.microsoft.com/en-
us/library/aa746433%28VS.85%29.aspx
.

LastName

Enter the Active Directory property that maps to the
user’s last name in Ektron CMS400.NET. By
default, this is sn, but you can change it to anyAD
property.

same reference asFirstName (above)

CMS Administrator Group Association

ADGroup
Name@AD
Domain

Enter the Active Directory user group and domain
name that map to the Ektron CMS400.NET
administrator group.

If your AD doesnot have a user group that includes
all Ektron CMS400.NET administrators, you should
create one then enter it here.

Mapping the Administrator Group on
page 15-63

Domain

If you want to restrict the search of new users and
groups to one AD domain, select that domain.

If you do, the Search Active Directory for Users and
Search Active Directory for Groups screens let you
search the selected domain only.

Also, if anyEktron CMS400.NET user or group
names include a domain (for example,
admin@saturn.example.com) that is excluded by
your selection, those users/groupsare flagged on
the Active DirectorySetup and Active Directory
Status screensbecause the names include an
invalid domain.

Messages Near the Top of the Active Directory Setup
Screen

Message Explanation

Active Directory
Authentication is
Enabled and Requires
More Configuration.

Some Ektron CMS400.NET users are not associated with AD users.

Also, if you are using full active directory integrationmode, user groupsand/or
user group relationshipsmaynot be associated.

Active Directory
Authentication is
disabled, but needs
further configuration

SomeEktron CMS400.NET users and/or groupsare no longer unique.

This happensbecause, in AD, users and groups can share a logon name as long
as their domainsare different. But, if AD authentication is disabled, two Ektron
CMS400.NET users or groups can no longer share a name -- eachmust be
unique.

MessagesNear the Top of the Active Directory
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If you see either message, click it. You proceed to the Active Directory Status
screen, which helps you resolve the discrepancies. See Also: The Active
Directory Status Screen below

The Active Directory Status Screen
Use the Active Directory Status screen to resolve these discrepancies between
Ektron CMS400.NET and AD.

n Ektron CMS400.NET user needs to be associated with an AD user

n Ektron CMS400.NET user group needs to be associated with an AD
user group

n Ektron CMS400.NET user’s group membership need to be associated
with the same AD user’s group membership

To access the screen from the Ektron CMS400.NET Workarea, click Settings >
 Configuration > Active Directory > Status.

There are several reasons why such discrepancies may occur. To learn more
about why

n an Ektron CMS400.NET user is not associated with an AD user, read
Active Directory Integration on page 15-42.

n an Ektron CMS400.NET user’s group membership is not associated
with his AD group membership, read Importing a User’s AD Group
Information into Ektron CMS400.NET on page 15-62

n an Ektron CMS400.NET group is not associated with an AD group,
read Resolving Discrepancies between Groups on page 15-65Active
Directory Integration on page 15-42

If you click a link on the Active Directory Status screen, a new screen lets you
resolve the discrepancy. For information on these screens, see the following
topics.

n Associating Ektron CMS400.NET Users with Active Directory Users on
the facing page

n Associating User Group Membership with Active Directory
Membership on the facing page
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n Associating CMS Groups with Active Directory Groups on next page

Associating Ektron CMS400.NET Users with Active
Directory Users
If you click CMS users need to be associated with Active Directory
users on the Active Directory Status screen, the Associate Ektron CMS400.NET
Users with Active Directory Users screen appears (illustrated below). Use this
screen to associate Ektron CMS400.NET users with AD users.

If a user with the same username exists in AD, that name and domain appear in
the AD Username and AD Domain fields. If the user exists in more than one
AD domain, select a domain from the pull-down list.

If there is no default and you know the AD user name to associate with an
Ektron CMS400.NET user, enter that in the AD Username and AD Domain
fields. If you do not know the AD username, click Search to find the user in AD.

If you decide to change the username in AD to match the Ektron CMS400.NET
username, make the change in AD. Then, click the Refresh button ( ) to
update Ektron CMS400.NET and resolve the discrepancy.

Finally, if a user should not exist in Ektron CMS400.NET, click the Delete box.

After you complete the changes, click the Save button ( ).

Associating User Group Membership with Active Directory
Membership
If you click CMS relationships need to be associated with Active
Directory relationships on the Active Directory Status screen, the Associate
Ektron CMS400.NET Relationships with Active Directory Relationships screen
appears (illustrated below). Use this screen to coordinate Ektron CMS400.NET
user group membership with AD user group membership.

Associating Ektron CMS400.NET Users with Active
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The screen displays a user’s group membership that exists in Ektron
CMS400.NET, but does not exist in AD.

See Also: Importing a User’s AD Group Information into Ektron CMS400.NET on
page 15-62

After viewing the discrepancy, you have two choices:

n To associate the user with the same user group in AD, go to AD and
assign the user to the group. Then, return to this screen and click the
Refresh button ( ) to update user group information in Ektron
CMS400.NET.

n To remove the user’s group membership in Ektron CMS400.NET,
check the Delete box and click the Save button ( ).

Associating CMS Groups with Active Directory Groups
If you click CMS groups need to be associated with Active Directory
groups on the Active Directory Status screen, the Associate Ektron
CMS400.NET User Groups with Active Directory Groups screen appears
(illustrated below). Use this screen to associate Ektron CMS400.NET groups
with AD groups.

If there is no default and you know the AD group name to associate with an
Ektron CMS400.NET group, enter that in the AD Group Name and AD Domain
fields. If you do not know the AD group name, click Search to find the group in
AD.

Finally, if this group should not exist in Ektron CMS400.NET, click the box under
the Delete column to delete the group.
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After you make all necessary changes, click the Save button ( ).

The View Users Screen
The View Users screen (illustrated below) lists all users in Ektron CMS400.NET.
To access the screen, click Settings > Users from the Ektron CMS400.NET
Workarea. To view more information for a user, click that user to move to the
View User Information screen.

The View User Information Screen

The View Users Screen
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If you are using user authentication mode, Username and Domain can only be
edited in AD. You can edit all other fields on this screen.

If you are using full AD Integration mode, Username, Domain, First Name,
Last Name, and email Address can only be edited in AD. You can edit all
other fields on this screen.

The screen also displays the following buttons.

Button Description

Edit information on screen

Delete user. See Also:Deleting Userson page 15-60

Retrieve latest information from AD into Ektron CMS400.NET

Active Directory Integration on page 15-42

Note: This toolbar button doesnot appear if you are using
user authenticationmode.

Replace user. See Also:Replacing a User on page 15-60

Return to previous screen

The Search Active Directory for Users Screen
The View Users screen has a toolbar button ( ) that lets you add AD users to
Ektron CMS400.NET. When you click it, the Search Active Directory for Users
screen appears.

Enter as many search criteria as you know to reduce the number of users that
the search returns. For example, if you know the user’s last name is Jackson
and he is in the planets domain, enter those criteria to get fewer results.

When the Active Directory Users screen appears, check the box next to users
you want to add to Ektron CMS400.NET. Then, click the Save button ( ).

The View User Groups Screen
The View User Groups Screen displays all AD user groups that have been
imported to Ektron CMS400.NET. (See Importing AD User Groups to Ektron
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CMS400.NET on page 15-61)

To access the screen, click Settings > User groups from the Ektron
CMS400.NET Workarea.

To view more information for a group, click it and you move to the View Users
in Group screen. That screen provides a toolbar button ( ) that lets you add AD
groups to Ektron CMS400.NET. When you click the button, the Search Active
Directory for Groups screen appears.

View Users in Group Screen
The View Users in Group Screen displays, for each user in the group

n username and domain

n first and last name

n language

The screen also displays these buttons.

Button Description

Replace group. See Also:Replacing a User Group on page 15-
65

Return to previous screen

The Search Active Directory for Groups Screen

Use this screen to add AD groups to Ektron CMS400.NET. Enter as many search
criteria as you know to reduce the number of groups that the search returns.

View Users in Group Screen
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Note: You can only select AD groups that do not exist in Ektron CMS400.NET. Also, the Active
Directory Setup screen can restrict AD integration to one domain. If it does, you can only
search for groups in that domain.

For example, if you know that a group begins with "S" and is in the planets
domain, enter those criteria to get fewer results. After you click Search, a new
screen lists all AD groups that satisfy the search criteria. Click the box next to
groups you want to create in Ektron CMS400.NET. Then, click the Save button (
) to import their information.

Managing Users and Groups in Active
Directory Integration Mode
Active Directory Integration strives to maintain consistent user and user group
information between AD and Ektron CMS400.NET. This section describes how to
work with users and user groups in Active Directory Integration Mode.

n Active Directory Integration on page 15-42

n Importing AD User Group Information to Ektron CMS400.NET on page
15-61

Importing AD User Information to Ektron
CMS400.NET
This section explains the import of AD user information when integration is first
enabled and on an ongoing basis. This section covers the following topics.

n Initial Import of AD User Information below

n Ongoing Import of User Information on the facing page

n Manually Adding AD Users to Ektron CMS400.NET on the facing page

n Editing User Information in Ektron CMS400.NET on page 15-60

n Deleting Users on page 15-60

n Replacing a User on page 15-60

Initial Import of AD User Information
This section explains how AD user information is imported to Ektron
CMS400.NET. The subtopics describe how this is handled under these
circumstances.

n The Ektron CMS400.NET database has already been populated with
users - see Ektron CMS400.NET Database Already Completed on the
facing page

n The Ektron CMS400.NET database has not yet been populated with
users - see Only a Few Users in Ektron CMS400.NET Database on the
facing page
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Ektron CMS400.NET Database AlreadyCompleted

If Enable automatic addition of user from AD is checked on the Active
Directory Setup screen, user information is imported from AD to Ektron
CMS400.NET when that user logs in or is added to Ektron CMS400.NET. See
Also: The Active Directory Setup Screen on page 15-48

At that time, AD information overwrites all Ektron CMS400.NET information. To
learn how information is updated from then on, see Active Directory Integration
on page 15-42.

If two or more AD users have the same Ektron CMS400.NET user logon name
but different domains (for example, JDoe in Eng.Example.com and JDoe in
Mkt.Example.com) and that username (JDoe) also exists in Ektron
CMS400.NET, the Active Directory Setup and Active Directory Status screens
indicate this discrepancy via this message:

CMS users need to be associated with Active Directory users.

Click the message to proceed to the Associate Ektron CMS400.NET Users to
Active Directory Users screen. From there, you can link an AD user to the
Ektron CMS400.NET user. See Also: Associating Ektron CMS400.NET Users with
Active Directory Users on page 15-53

Only a Few Users in Ektron CMS400.NET Database

Go to the Search Active Directory for Users screen and select AD users that will
use Ektron CMS400.NET. When you add a user, his AD information is imported
to Ektron CMS400.NET.

See Also: The Search Active Directory for Users Screen on page 15-56

Note: You can only select AD users that do not exist in Ektron CMS400.NET. Also, the Active
Directory Setup screen can restrict AD integration to one domain. If it does, you can only
search for users in that domain.

Ongoing Import of User Information
AD user information is imported to Ektron CMS400.NET when either of these
events occurs:

n the user logs in

n someone clicks the Refresh button ( ) on the user’s View User
Information screen

See Also: The View User Information Screen on page 15-55

Manually Adding AD Users to Ektron
CMS400.NET
Before using AD integration, add to Ektron CMS400.NET all AD users that will
use your Web site. This can be done automatically, as explained Initial Import

Ektron CMS400.NET Database AlreadyCompleted
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of AD User Information on previous page.

If you want to manually add an AD user to Ektron CMS400.NET, follow these
steps.

1. From the Workarea, click Settings > Users.

2. Click the Add Users button ( ).
3. The Active Directory Users screen appears.

4. From the Domain pull-down list, select the domain from which you
want to add a user.

5. Enter as much information as you know into the other fields.

6. Click the Search button.

7. A screen displays all users that satisfy the search criteria.

8. Check the box next to each user you want to add.

9. Click the Save button ( ).

Editing User Information in Ektron CMS400.NET
Because Ektron CMS400.NET does not write to AD, you can only change some
fields on the Edit User screen. You must edit the read-only fields from AD.

Deleting Users
If a user is deleted in AD, Ektron CMS400.NET does not delete him. However,
his login fails because he cannot be authenticated.

The user remains in Ektron CMS400.NET. You can delete the user from Ektron
CMS400.NET using the Delete User function. See Also: Deleting a User on page
15-11

Note: If you mistakenly delete all users with administrative privileges, you can still sign in using
the builtin user’s username and password. For more information, see BuiltIn User on page 2-
35.

Replacing a User
If you associate the wrong AD user with an Ektron CMS400.NET user, you can
replace the user. If you do, all Ektron CMS400.NET privileges and workflow
responsibilities transfer from the old to the new user.

Follow these steps to associate an Ektron CMS400.NET user with a new AD user.
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1. From the Workarea, click Settings > Users.

2. Click the user you want to replace.

3. Click the Associate CMS User with Different AD User button ( ).
4. Select a user to replace the user you selected in Step 2.

5. Click the Save button ( ).
When you complete this procedure, the first user is deleted from Ektron
CMS400.NET.

Importing AD User Group Information to
Ektron CMS400.NET
This section explains how a user’s group membership is imported from AD to
Ektron CMS400.NET after integration is enabled. Once assigned to a group, the
user automatically receives all Ektron CMS400.NET privileges and workflow
responsibilities associated with it.

Note: Active Directory has two kinds of user groups: security and distribution. Ektron
CMS400.NET does not distinguish between them – as long as a user is a member of either
kind of group, group information can be imported to Ektron CMS400.NET.

This section explains the following topics.

n Importing AD User Groups to Ektron CMS400.NET below

n Importing a User’s AD Group Information into Ektron CMS400.NET on
next page

n Mapping the Administrator Group on page 15-63

n Resolving Discrepancies between Groups on page 15-65

n Removing Users from a Group on page 15-65

n Adding User Groups on page 15-65

n Adding a User to a Group on page 15-65

n Replacing a User Group on page 15-65

n Deleting a User Group on page 15-66

Importing AD User Groups to Ektron
CMS400.NET
Before using AD integration, import all AD groups you will use into Ektron
CMS400.NET. To do that, follow these steps.

1. From the Workarea, click Settings > User Groups.

2. Click the Add Groups button ( ).
3. The Search Active Directory for Groups screen appears.

Importing AD User Group Information to Ektron
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4. From the Domain drop-down list, select the domain of the user group
you want to add.

Note: The Active Directory Setup screen can restrict AD integration to one domain. If it does,
you can only search within that domain.

5. Enter as much information as you know into the Active Directory
Group field.

6. Click the Search button.

7. A new screen displays all groups that satisfy the search criteria.

8. Check the box to the left of each group you want to import to Ektron
CMS400.NET.

9. Click the Save button ( ).

Importing a User’s AD Group Information into
Ektron CMS400.NET
This section explains how users' membership in AD Groups is imported to
Ektron CMS400.NET. The three subtopics describe how this process is handled
under these circumstances.

n Initially, if one or more Ektron CMS400.NET user groups have been
created - see Ektron CMS400.NET User Groups Already Set up below

n Initially, if only default Ektron CMS400.NET user groups exist - see
Only Default User Groups Exist on the facing page

n On an ongoing basis - see After AD Integration is Enabled on the
facing page

Ektron CMS400.NET User Groups Already Set up
If Enable automatic addition of user to groups is checked on the Active
Directory Setup screen, a user’s group membership is imported from AD to
Ektron CMS400.NET when a user first logs in or is added. At this time, any AD
group memberships overwrite Ektron CMS400.NET group memberships except
the Everyone group, to which all users belong.

Note: The Everyone group, unlike other Ektron CMS400.NET groups, is not associated with an
AD group. It is an all-encompassing group with no special permissions.
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If a user belongs to an AD user group that does not exist in Ektron CMS400.NET,
nothing happens. The AD Integration feature assumes that not all AD groups
are meaningful in Ektron CMS400.NET.

If a user belongs to an Ektron CMS400.NET user group that does not exist in AD,
the discrepancy is flagged on the Active Directory Setup and Active Directory
Status screens. From these screens, you can import AD group information into
Ektron CMS400.NET.

See Also: Associating User Group Membership with Active Directory
Membership on page 15-53 and Associating CMS Groups with Active Directory
Groups on page 15-54

To learn how membership is updated from then on, see After AD Integration is
Enabled below.

Only Default User Groups Exist
Follow the procedure described in Importing AD User Groups to Ektron
CMS400.NET on page 15-61to import AD user groups to Ektron CMS400.NET.
Then, as users in those groups are added to Ektron CMS400.NET, their group
memberships are applied.

After AD Integration is Enabled
A user’s group memberships in Ektron CMS400.NET are updated when all of the
following are true:

n The Enable automatic addition of user to groups field is
checked on the Active Directory Setup screen

n A user is added to Ektron CMS400.NET or his AD group membership
changes

n The user logs in or someone clicks the Refresh button ( ) on the
user’s View User Information screen

On the other hand, if Enable automatic addition of user to groups field is
unchecked, you can add the user to groups and remove him from groups
independently of his AD group memberships.

Mapping the Administrator Group
On the Active Directory Setup screen, you identify the AD user group that maps
to the Ektron CMS400.NET Administrator group. Members of this group receive
administrator privileges. See Also: List of Administrator Privileges on page 15-
37
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If such a group does not exist in AD, create it, then assign it on the Active
Directory Setup screen.

Note that only one AD group can be mapped to the Ektron CMS400.NET
Administrator group -- you cannot have an AD administrator group within each
AD domain.

Note: Unlike other Ektron CMS400.NET user groups, whose names are imported from AD, the
Ektron CMS400.NET Administrator and Everyone group names cannot be changed.

See Also: The Active Directory Setup Screen on page 15-48
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Resolving Discrepancies between Groups

User Belongs to AD Group that Does Not Exist in Ektron
CMS400.NET
If user is assigned to an AD user group that does not exist in Ektron
CMS400.NET, nothing happens. The AD integration feature assumes that an
Ektron CMS400.NET administrator only maintains user groups that are
meaningful within Ektron CMS400.NET.

Note: If a user belongs to a user group that is given Membership permissions, but also to a
group that has CMS permissions, the user only receives Membership permissions if logged
into Ektron CMS400.NET.

User Belongs to Ektron CMS400.NET Group that Does Not
Exist in AD
If a user was a member of an Ektron CMS400.NET user group before integration
was enabled, but does not belong to that group in AD, this discrepancy is
flagged on the Active Directory Setup and Active Directory Status screens.

If the user should belong to the AD group, add the group membership within
AD. Then, refresh the user on the View User Information screen to import AD
group information into Ektron CMS400.NET.

See Also: Associating CMS Groups with Active Directory Groups on page 15-54

Removing Users from a Group
If you delete a user from an AD group, the user is removed from the associated
Ektron CMS400.NET group the next time his information is updated.

Adding User Groups
If AD integration is enabled, you can only add user groups in AD. Once that is
done, log on to Ektron CMS400.NET and use the Search Active Directory for
Groups screen to import the AD user group to Ektron CMS400.NET. This
procedure is described in Importing AD User Groups to Ektron CMS400.NET on
page 15-61.

Adding a User to a Group
You cannot add a user to a user group within Ektron CMS400.NET - you must do
so in Active Directory.

Replacing a User Group
If you associated the wrong AD user group with an Ektron CMS400.NET user
group, you can replace the user group. Follow these steps to do so.

1. From the Workarea, click Settings > User Groups.
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2. Click the user group that you want to replace.

3. Click the Associate Ektron CMS400.NET Group with Different AD

Group button ( ).
4. Select a group to replace the group you selected in Step 2.

5. Click the Save button ( ).

Deleting a User Group

Deleting a User Group in AD
If you delete a user group in AD and users are assigned to the group within
Ektron CMS400.NET, the group is not deleted in Ektron CMS400.NET. However,
any Ektron CMS400.NET users who were members of the group are no longer
members the next time their Ektron CMS400.NET information is updated. The
discrepancy is flagged on the Active Directory Setup and Active Directory Status
screens.

Deleting a User Group in Ektron CMS400.NET
If you delete a user group in Ektron CMS400.NET and users are assigned to that
group within AD, nothing happens. This is because AD Integration assumes that
the Ektron CMS400.NET administrator only maintains user groups that are
meaningful to Ektron CMS400.NET, and some AD groups are not meaningful to
Ektron CMS400.NET.

Disabling AD Integration
To disable AD authentication or integration, edit the Active Directory Setup
screen and check Disable Active Directory and LDAP Authentication. See
Also: The Active Directory Setup Screen on page 15-48

If you do this, and any users or groups have the same name with different
domains, the following message appears.

Active Directory Authentication is disabled, but needs further
configuration

For example, two users are named JJackson@example.net and
JJackson@example.com. When AD was enabled, the domain names made the
users unique. However, when you disable integration, domain names are
dropped, so the names are now identical. You need to make the users unique.

If you click the message (above) on the Active Directory Setup screen, you
move to the Active Directory Status screen. The following messages may
appear.
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Click the message to proceed to the Make Ektron CMS400.NET Users Unique
screen (illustrated below).

This screen lists users whose user names are not unique and suggests a new,
unique username. The new name consists of the user name, underscore, at sign
(@), underscore, domain name. So, for example, JJackson@example.net
becomes JJackson_@_example.net.

The same is true for user groups. For example, there were two groups named
Account Operators, one in the example.com domain, and the other in the
saturn.example.com domain. In this case, the Make Ektron CMS400.NET
Groups Unique screen would look like this.

Ektron recommends that you accept the suggested new names. Click the Save (
) button to do so.

One advantage of the suggested name format is that, if you later decide to re-
enable AD integration, the software can automatically associate AD and Ektron
CMS400.NET users or groups.

Disabling  AD Integration
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User Authentication Only Mode
In user authentication mode, the sharing between AD and Ektron CMS400.NET is
limited to user logon name, domain, and password.

This section also contains the following topics.

How Information is Transferred from Active Directory to Ektron
CMS400.NET

15-
68

Which Information is Transferred from Active Directory to Ektron
CMS400.NET

15-
68

User Groups 15-68
Adding User Information from AD to Ektron CMS400.NET 15-69
Changing the User Login Name in AD 15-69
Editing User Information in Ektron CMS400.NET 15-69
The Screens of the Active Directory Feature in User Authen-
tication Mode

15-
70

How Information is Transferred from Active
Directory to Ektron CMS400.NET
Ektron CMS400.NET does not write to AD – it only reads from it. This results in
the following changes to how username, domain, and password are handled in
Ektron CMS400.NET.

n Changes to user logon name, domain and password must be made in
AD — you cannot update these fields in the Ektron CMS400.NET Edit
User screens.

n When adding a new user to Ektron CMS400.NET, you can only select
AD users. If the user does not exist in AD, create the user there, and
then import the user into Ektron CMS400.NET.

Which Information is Transferred from Active
Directory to Ektron CMS400.NET
CMS refers to the following AD sign-in authentication information during sign-
in: password, user logon name, and domain. Note that the password is not
stored in CMS — CMS only refers to the password during sign-in.

User Groups
User authentication mode has no effect on user groups. To learn more about
user groups, see Managing User Groups on page 15-27.
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Adding User Information from AD to Ektron
CMS400.NET
SeeManually Adding AD Users to Ektron CMS400.NET on page 15-59 Manually
Adding AD Users to Ektron CMS400.NET on page 15-59.

Changing the User Login Name in AD
If a user’s logon name changes in AD, it no longer matches the Ektron
CMS400.NET logon name. This discrepancy is flagged on the Active Directory
Setup and Active Directory Status screens. You should proceed to the Associate
Ektron CMS400.NET Users to Active Directory Users screen, where you can
update the user information.

Alternatively, you could

1. Go to the View User Information screen.

2. Select the user whose AD name changed.

3. Click the Associate the Ektron CMS400.NET user with Different AD

user toolbar button ( ).
4. Select the AD user and domain.

See Also: Associating Ektron CMS400.NET Users with Active Directory Users on
page 15-53

Editing User Information in Ektron
CMS400.NET
Ektron CMS400.NET does not write to AD. This means that you can only change
the Username and Domain fields from AD. You can change the following
fields on the Ektron CMS400.NET Edit User screen:

n First Name

n Last Name

n email Address

n User Language

n Disable email Notifications

Warning! If you replace a user in user authentication-only mode, the user’s first name, last name,
and email address are not overwritten with information in the active directory.
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The Screens of the Active Directory Feature
in User Authentication Mode
Since the scope of user authentication mode is limited, only some fields on AD
screens are used. For example, on the Active Directory setup screen, the only
relevant fields are authentication and domain.

See Also: The Active Directory Setup Screen on page 15-48

Also, on the Active Directory Status Screen, only one discrepancy message may
appear:

CMS user needs to be associated with an AD user

See Also: Associating Ektron CMS400.NET Users with Active Directory Users on
page 15-53

The View Users Screen works the same for both modes.

See Also: The View User Information Screen on page 15-55

Logging into a System that Uses AD
Integration
Because AD usernames and passwords are stored by domain, the AD sign-on
procedure requires the user to select a domain. So, when AD integration is
enabled, the sign-on screen includes a domain drop-down list.

Note: Your organization determines AD domain names .

For more information about logging in, see Logging into an Ektron CMS400.NET
Web Site on page 2-8.
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Single Sign On
Single Sign On is a feature retrieves a user’s login information from Active
Directory to authenticate access to Ektron CMS400.NET. So the user does not
need to enter a password - after clicking the Login button, he is immediately
logged in.

How Single Sign on Works
Single Sign On uses a variable called User.Identity.Name. This maintains the
user's account\domain in Active Directory, and has the format
[domain]\[username]. For example, EKTRON1\ssmith. This variable's value is
set when a user authenticates against a Windows server.

When a user clicks the login server control, if the variable passes successfully
and Active Directory is enabled, the server control opens the autologin.aspx
page. Next, the opening window refreshes just like a normal login, except the
user is not prompted for a username, password, and domain.

However, if the user‘s computer is not on a domain, not on the same domain as
Ektron CMS400.NET, or does not include the Ektron CMS400.NET server as a
trusted site, the following login screen appears.

If Active Directory is not enabled, the normal login.aspx page appears.

Setting up Single Sign On
The Single Sign On login process uses the autologin.aspx file (in the
workarea/SSO directory). Once set up, user authentication is enabled from any
domain that this server can reach. For example, if Ektron CMS400.NET is

Single SignOn
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located in a third level domain, users from third, second, and first level
domains can authenticate.

There are two versions of the setup instructions, depending on the IIS version
your server runs.

n Setting up Single Sign On Using IIS6 below

n Setting up Single Sign On Using IIS7 on page 15-76

After completing these procedures, enable Active Directory within Ektron
CMS400.NET (if it isn’t already enabled). See Also: Setup Guidelines on page
15-39

Ektron recommends enabling the automatic addition of users and groups. See
Also: Managing Users and Groups in Active Directory Integration Mode on page
15-58

Setting up Single Sign On Using IIS6
Setting up Single Sign On with IIS 6 involves these procedures.

n Modifying Web.config for Single Sign On below

n Adjusting Security Settings for the Site Root Folder below

n Adjusting Security Settings for autologin.aspx on page 15-74

n Adjusting the Login Server Control on page 15-76

Modifying Web.config for Single Sign On
1. Open your site root folder.

2. Open the web.config file.

3. Find the ek_AUTH_protocol element.

4. Change its value to GC or LDAP. For example:
<add key="ek_AUTH_Protocol" value="GC" />

5. Find the authentication element.

6. Change the value of the impersonate attribute to true. It should look
like this:

<authentication mode="Windows" />

<identity impersonate="true" userName="" password=""/>

Adjusting Security Settings for the Site Root
Folder

1. Go toWindows Control Panel > Administrative Tools >
Internet Information Services.

2. Within IIS, go toWeb Sites and select your Ektron CMS400.NET site.

Managing Users and User Groups

15-72 ReferenceManual
Version 8.01 Rev 4



3. Right click your Ektron CMS400.NET site folder and select
Properties.

4. Click the File/Directory Security tab then the top Edit button.

5. Uncheck everything except Anonymous Access and Integrated
Windows authentication. The anonymous access account should
be a domain account, preferably the root of the Active Directory tree.

Adjusting Security Settings for the Site Root Folder
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Adjusting Security Settings for autologin.aspx
1. Go toWindows Control Panel > Administrative Tools >

Internet Information Services.

2. Within IIS, go toWeb Sites > your Web site’s root folder >
Workarea > SSO > autologin.aspx.

3. Right click autologin.aspx and select Properties.

4. Click the File security tab and the top Edit button.
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5. Under Authenticated Access, uncheck all except Integrated
Windows Authentication.

Adjusting Security Settings for autologin.aspx
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As a result of these settings, autologin.aspx passes credentials from the logged-
in user's desktop.

Adjusting the Login Server Control
In Visual Studio.NET, open the Login server control and set the AutoLogin
property to True. See Also: Login Server Control on page 2-10

Setting up Single Sign On Using IIS7
n Modifying Web.config for Single Sign On on page 15-72

n Adjusting Security Settings for the Site Root Folder on page 15-72

n Adjusting Security Settings for autologin.aspx on page 15-74

n Adjusting the Login Server Control above

Modifying Web.config for Single Sign On
1. Open the site root/web.config file.

2. Find the ek_AUTH_protocol element.

3. Change its value to GC or LDAP. For example:
<add key="ek_AUTH_Protocol" value="GC" />

4. Find the authentication element.

5. Change the value of the impersonate attribute to false. It should
look like this:

<authentication mode="Windows" />

<identity impersonate="false" userName="" password=""/>

6. Comment out the MyDigestAuthenticationModule only.
<httpmodules>

<!--
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<add name="DigestAuthenticationModule"
type="Ektron.ASM.EkHttpDavHandler.Security.DigestAuthenticationModule,Ektron.ASM.EkHttpDavHandler"
/>

-->

<add name="ScriptModule" type="System.Web.Handlers.ScriptModule, System.Web.Extensions,
Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"
preCondition="integratedMode" />

<add name="EkUrlAliasModule" type="UrlAliasingModule" preCondition="integratedMode" />

</modules>

Adjusting Security Settings for the Site Root
Folder

1. Go toWindows Control Panel > Administrative Tools >
Internet Information Services.

2. Within IIS, go to Sites and select your Ektron CMS400.NET site.

3. From the right panel, select Authentication.

4. On the Authentication screen, enable Anonymous Authentication.
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5. Select Anonymous Authentication and click Edit.

6. Set the credentials to a specific user with a domain account,
preferably the root of the Active Directory tree.

7. Click Set to select the user.

8. Enter the username and password. Confirm the password.
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Adjusting Security Settings for autologin.aspx
1. Go toWindows > Control Panel > Administrative Tools >

Internet Information Services.

2. Within IIS, go toWeb Sites > your Web site’s root folder >
Workarea > SSO > autologin.aspx.

3. From the right panel, enableWindows Authentication.

As a result, autologin.aspx passes credentials from the logged-in user's
desktop.

Adjusting Security Settings for autologin.aspx
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LDAP Authentication
LDAP is short for Lightweight Directory Access Protocol. It is a set of protocols
that enable the hierarchical arrangement of corporate directory entries in a
structure, which may reflect geographic or organizational boundaries.

Ektron CMS400.NET’s LDAP feature lets you retrieve user Login information
from an LDAP server to Ektron CMS400.NET. As a result, you can administer
user information from one place, and users only need to remember one
password/username combination to sign on to the network and Ektron
CMS400.NET.

The hierarchical structure of LDAP authentication can look a few different ways.
For example, if you had the following LDAP structure, the domain would
typically span multiple countries.

Note: Here is a list of the abbreviations: CN = Common Name, OU = Organizational Unit, O =
Organization, DN = Distinguished Name.

CN=Pitchers Name, OU=Pitchers, O=Baseball Team, C=US, DN=example.com

By changing the order of C and DN, the hierarchy indicates that the domain
example.com is located in the US.

CN=Pitchers Name, OU=Pitchers, O=Baseball Team, DN=example.com, C=US.

In some instances, it may be necessary to have an Organization appear below
an Organizational Unit. For example, your Organizational Unit has it own
Organizations.

Below is a visual example of an LDAP hierarchical structure.

Managing Users and User Groups

15-80 ReferenceManual
Version 8.01 Rev 4



This section also contains the following topics.

Using LDAP with Ektron CMS400.NET 15-81
LDAP Screen Descriptions 15-89
Disabling LDAP Authentication 15-93

Using LDAP with Ektron CMS400.NET
Note: Active Directory and LDAP are not the same. While they perform similar functions, LDAP
(when used with Ektron CMS400.NET) only verifies login information and creates the user in
the everyone group. Active Directory can verify user login information only, or become
completely integrated with Ektron CMS400.NET. To learn more about using Active Directory
with Ektron CMS400.NET, see Active Directory Feature on page 15-39.

This section also contains the following topics.

Enabling LDAP 15-81
Using Active Directory for LDAP 15-83
Adding an Organizational Unit During Setup 15-83
Adding User Information from an LDAP Server to Ektron
CMS400.NET

15-
84

Searching an LDAP Server for Users 15-84
Manually Adding an LDAP User 15-86
Using the Browse Feature to Add an LDAP User 15-87
Editing User Information in Ektron CMS400.NET 15-89
Steps to Edit an LDAP User’s Information 15-89
Deleting Users 15-89

Enabling LDAP
You enable LDAP through the Active Directory Setup screen. To enable the LDAP
functionality in Ektron CMS400.NET, follow these steps. See Also: The Active
Directory Setup Screen on page 15-90

Warning! Before enabling LDAP in Ektron CMS400.NET, make sure your LDAP server is ready
for use. Be sure to include an Ektron CMS400.NET administrator account for yourself.
After you enable LDAP, only the BuiltIn account can access Ektron CMS400.NET without LDAP
authentication. See Also: BuiltIn User on page 2-35

1. In the siteroot\web.config file, change the ek_AUTH_Protocol
property to GC.

<add key="ek_AUTH_Protocol" value="GC"/>

2. In the Workarea, navigate to the Settings > Configuration >
Active Directory > Setup.

3. Click the Edit button ( ).
4. On the Active Directory Setup screen, check Enable LDAP

Authentication.
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5. Complete the following fields.

Field Description For more information, see

Type

Choose the type of LDAPauthentication you are using.

Note: Depending on your choices, the fields below
maybe required or disallowed.

The following choicesare available:

n Active Directory (LDAP) - Domain allowed,
Organization is not.

n Novell eDirectory/NDS - Organization allowed,
Domain is not.

n Sun Iplanet/JSDS - Domain allowed, Organization is
not.

n Other - AllowsDomain andOrganization

Using Active Directory for
LDAP on the facing page

LDAPServer The IP addressor name of the LDAP server.

Port

The LDAP server port with which Ektron CMS400.NET
communicates.

If you are unsure, consult the documentation provided
with your DirectoryService (such as, Novell, iPlanet,
Microsoft, or Red Hat).

Organization

The name of your companyor organization. For
example, Ektron, Inc.

You can leave this field blank if you enter a domain in the
Domain field.

Domain

Your domain name. For example, www.ektron.com.
This should be the name you used when purchasing
your license key.

You can leave this field blank if you enter an
organization in theOrganization field.

Attribute Enter the key value used to reference accounts inside
LDAP. Asexamples: dn, sn, cn, uid, etc.

Use SSL Check if you want to enforce a secure connection in traf-
fic to the LDAP server.

Path

The next levels below your Organization or Domain.
These can includemultiple levels of Organizational
Units. For example, Content Editors, Marketing, East
Coast.
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Field Description For more information, see

Add

Enter the path to which you would like access in the text
field. Then click theAdd link.

When addingOrganizationalUnits, pathsare comma-
separated and run from specific to general. For
example, ou=Amherst,ou=New Hampshire,o=US.

Do not add individualCommonNameshere. Only add
OrganizationalUnits that contain people who should
have access to Ektron CMS400.NET.

Warning! You can add additionalOrganizations
below anOrganization Units as long as the path on
your LDAP server is the same.

Adding anOrganizationalUnit
During Setup below

To add a single individual from
a different OrganizationalUnit,
seeAdding User Information
from an LDAPServer to Ektron
CMS400.NET on next page

6. Click the Save button ( ).

Using Active Directory for LDAP
1. In the webroot\siteroot\Web.Config file, add the Username and

Password for ek_ADUsername and ek_ADPassword. For example:
<add key="ek_ADUsername" value="mwright@ektron.com" />

<add key="ek_ADPassword" value="mypasswordisthis" />

2. When using LDAP to connect to Active Directory, use the following
settings in the Active Directory Setup screen.

Field Needed Information

Type Active Directory (LDAP)

LDAPServer [IP Addressof the AD domain controller]

Port 389

Organization [leave this blank]

Domain
[dnsname of the AD domain]

For example: intra.ektron.com

Organizational
Unit

[anyOUs that you want to draw users from]

For example: Support,Users,Ektron Corporate also Engineering,Users,Ektron
Corporate

Adding an Organizational Unit During Setup
Things to consider when adding Organizational Units.

n Should everyone in the OU have access to Ektron CMS400.NET?

Using Active Directory for LDAP
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Once LDAP is enabled, users are added to the everyone group upon
login. While everyone in the OU has access to Ektron CMS400.NET,
every user should not necessarily have permission to edit content.
To control permissions, set up user groups, add users to groups, and
assign permissions to the group. See Also: Managing Users and User
Groups on page 15-1 and Folder Permissions on page 4-40

n Do users in other Organizational Units need access?

Sometimes, managers or editors are in a different OU. They need to
be added manually, or you need to add their OU.

n When adding an Organizational Unit, several entries might cover the
same hierarchical path. For example, you might have:

- ou=Pitchers,ou=Players,o=Team

- ou=Players,o=Team

- o=Team

This allows you to authenticate users listed in Pitchers, Players, and Team.

Adding User Information from an LDAP
Server to Ektron CMS400.NET
Users at each level are automatically available for adding to Ektron
CMS400.NET. You do not have to be at the OU or CN level to add a user. If a
user is at the DC or OU level, they are available.

After LDAP is enabled, there are four ways to add LDAP user information to
Ektron CMS400.NET.

n The user logs in. As a result, the user appears in the Users list and is
added to the Everyone group.

Note: After a user logs in, some fields on the Add User screen can be filled in manually, such
as first and last name. For a description of these fields, see Fill out the fields according to
Creating a New User on page 15-3. on page 15-87

n Search an LDAP server for LDAP users using the LDAP Search feature.
See Also: Searching an LDAP Server for Users below

n Add the user’s LDAP information manually. See Also: Manually
Adding an LDAP User on page 15-86.

n A combination of browsing for the user, then manually completing the
remaining fields. See Also: Using the Browse Feature to Add an LDAP
User on page 15-87

Searching an LDAP Server for Users
The following steps explain how to search for a user on an LDAP server, and add
the user to Ektron CMS400.NET.
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1. Enable LDAP by following the instructions in Enabling LDAP on page
15-81.

2. From the left side of the Workarea, click Users.

3. Click the Add Users button ( ).
4. The Add a New User to the System screen appears.

5. Click the Browse LDAP button ( ).
6. The Search LDAP Users screen appears.

7. Enter one or more search criteria.

n Username - the username of the user on the LDAP server

n Firstname - the first name of the user on the LDAP server

n Lastname - the last name of the user on the LDAP server

n Path - select a path from the drop down list. These are the paths that
were enabled when you configured Ektron CMS400.NET for your
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LDAP server. If you select a path and enter no other information, you
get all users in that path.

8. Click the Search button.

9. The search returns users that match the criteria entered.

10. Check the box next to the user to be added.

11. Click the Save button ( )
12. The user is now added to Ektron CMS400.NET and the Everyone

group. To learn how to assign the user to another user group, see
Assigning Users To User Groups on page 15-28.

Manually Adding an LDAP User
The following steps explain how to add an LDAP user manually.

1. Enable LDAP by following the instructions in Enabling LDAP on page
15-81.

2. From the left side of the Workarea, click Users.

3. Click the Add Users button ( ).
4. The Add a New User to the System screen appears.
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5. Fill out the fields according to Creating a New User on page 15-3.

6. Click Save ( ).
7. The View Users in Group Everyone screen appears, displaying the

new user and the other Ektron CMS400.NET users. To learn how to
assign the user to another group, see Assigning Users To User Groups
on page 15-28.

Using the Browse Feature to Add an LDAP User
The Browse LDAP feature provides a friendly and intuitive way to find the
username, domain/organization and organizational unit(s).

Warning! The default server IP/DNS name and port are taken from the settings specified in the
Configuration > Setup page. These settings must be specified before connecting to the LDAP
server. See Also: Enabling LDAP on page 15-81

Warning! Before using the browse feature, you must specify an Organizational Unit that can see
the user in the Configuration > Setup page. See Also: Enabling LDAP on page 15-81

1. Enable LDAP by following the instructions in Enabling LDAP on page
15-81.

2. From the left side of the Workarea, click Users.

3. Click the Add Users button ( ).
4. The Add a New User to the System screen appears.

Using the Browse Feature to Add an LDAP User

ReferenceManual
Version 8.01 Rev 4

15-87



5. Click the Browse LDAP button ( ).
6. The LDAP Explorer appears.

7. Navigate the LDAP server’s folders by clicking on the folder images.
Each folder represents an Organizational Unit (OU). When you choose
an OU level, its users appear.

Note: In the LDAP Explorer, the Path and Org/Domain fields update dynamically as you
navigate through the LDAP tree.

8. Select a user.
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9. The user is added to Ektron CMS400.NET and the Everyone group. To
learn how to assign this user to another group, see Assigning Users
To User Groups on page 15-28.

Editing User Information in Ektron
CMS400.NET
It is important to note that Ektron CMS400.NET does not write to the LDAP
server. So, while you can change fields when editing a user in Ektron
CMS400.NET, you also need to make the same changes on the LDAP server.

Steps to Edit an LDAP User’s Information
The following steps explain how to edit an LDAP user’s information.

1. In the Workarea, click Settings > Users.

2. In the Username column, click a user to edit.

3. The View User Information screen appears.

4. Click the Edit button ( ).
5. Change the information as needed. For more information on the

fields you can edit, see Creating a New User on page 15-3.

6. Click Save ( ).

Deleting Users
If a user is deleted on the LDAP server, Ektron CMS400.NET does not
automatically delete the user. However, the user’s login fails because he
cannot be authenticated.

In this case, you should delete the user from Ektron CMS400.NET using the
Delete User function. See Also: Deleting a User on page 15-11

Note: If you mistakenly delete all users with administrative privileges, you can still sign in
using the builtin user’s username and password. For more information, see ”BuiltIn User” on
page 19-11.

LDAP Screen Descriptions
The LDAP feature uses the following screens:

n The Active Directory Setup Screen on next page

n The View Users Screen on next page

This section explains how to use each screen.
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The Active Directory Setup Screen
The Active Directory Setup screen (illustrated below) lets you enable and
disable the Active Directory or LDAP features, as well as determine other
aspects of AD management, such as whether users and groups are
automatically updated. To access the screen, click Settings > Configuration
-> Active Directory -> Setup from the left panel of the Workarea.

For a description of the fields, see the Active Directory section The Active
Directory Setup Screen above.

The View Users Screen
The View Users screen (illustrated below) lists all users in the Ektron
CMS400.NET database. To access the screen, click Users from the left panel of
the Workarea. To view more information for a user, click that user to move to
the View User Information screen.
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The View Users screen provides a toolbar button ( ) that lets you add LDAP
users manually to Ektron CMS400.NET. This is useful if you want to add a single
user from an different Organizational Unit from your others users, and you do
not want to add other users from that Organization.

The View Users Screen
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The View User Information Screen

The View User Information Screen displays all information for the user, such as

n username

n Path

n first and last name

n language

n email address and whether the user receives email notifications

n whether the account is locked

n which Forum Editor the user is using

n user groups

n user properties (if any)

n etc.

Managing Users and User Groups

15-92 ReferenceManual
Version 8.01 Rev 4



The screen also displays the following buttons.

Button Description

Edit information on screen

Delete user

See Also:Deleting Userson page 15-89

Return to previous screen

Disabling LDAP Authentication
If you decide to disable LDAP authentication or integration, edit the Active
Directory Setup screen and select Disable Active Directory and LDAP
Authentication.

See Also: The Active Directory Setup Screen on page 15-90

Disabling LDAP Authentication
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A community is a group of people who network with each other to share
information, ideas, likes and dislikes. Typically, people or members in the
community are connected by a relationship. For example, they work for the
same company, went to the same school, share the same values, or have a
friendship.

When a person visits a community site, he can look around to see what type of
information, people and groups are on the site. Typically, the person can see
only limited information on the site. To see all information, he needs to become
a member.

When a person signs up to be member, he defines information about himself.
This is known as his member profile. After becoming a member, he can

n maintain a personal profile, including an avatar

n search for other members and add them to a friends list

n join or create a community group

n invite non-members to join a community and become a friend

n add photos and documents to a personal or group profile page and
determine which other users and groups can update those files

n update his status and share that update with selected members

n post public or private mess

n ages to another member’s message board

n keep a journal of his thoughts

n create a list of favorite CMS400.NET content links

n have a list of content he’s added

n write content reviews

n flag content

The Community Platform in Ektron CMS400.NET is a group of features that allow
users to network socially on a Web site. Access to the community platform is
available from the Web site or the Workarea. Only CMS400.NET users and
administrators can access their information via the Workarea. Membership
Users, CMS400.NET users, and administrators can access their profile pages via
a Web site.

As an Administrator, you can manage Community features from the Workarea.

This section also contains the following topics.

Membership Users and Groups 16-3
Accessing a User Profile 16-30
Friends Server Control 16-34
Favorites Server Control 16-45
PhotoGallery Server Control 16-52
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Message Board Comments Associated with Content in the Work-
area

16-
66

MessageBoard Server Control 16-67
Calendars for Community Users and Groups 16-81
Discussion Boards for Community Groups 16-82
Community Groups 16-83
Community Group Server Controls 16-92
Community Folders 16-110
Distributing Content to Another Ektron CMS400.NET Folder 16-115
Notifications 16-122
Configuring SMS 16-164
Activity Streams 16-167
ActivityStream Server Control 16-178
Micro-messaging Server Control 16-184
Using Ektron's Micro-messaging Bookmarklet 16-201
Flagging 16-209
ContentFlagging Server Control 16-219
Email Invitations for Community Management 16-222
Invite Server Control 16-223
Messaging Server Control 16-226
SocialBar Server Control 16-235
CommunityDocuments Server Control 16-243
CommunitySearch Server Control 16-256
Tags 16-271
TagCloud Server Control 16-280

To learn about the controls you use to let membership users log in to an Ektron
CMS400.NET site, see Facebook Login on page 2-14 and Login Server Control on
page 2-10.

Membership Users and Groups
Membership users are a category of users who have limited privileges to Ektron
CMS400.NET. Unlike regular CMS users, they cannot use the Workarea. When a
membership user logs in, he can view, add and edit content from the Web site
(as permitted) -- all other functionality is disabled.

Membership users can also be granted permission to view private content. This
is helpful if your organization has partners who need access to Web pages that
should not be visible to the general public.

When you have a Social Network or Community Web site, membership users
can create an online area for themselves.

You can use Membership groups to group similar membership users.

To make Web page URLs friendly for Community Users and Groups, Ektron
CMS400.NET provides a feature called Community URL Aliasing. This let's
you make URLs that are easy to use and remember for Users and Groups.
Community URL Aliasing on page 10-41 for more information.

Membership Users andGroups
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This section also contains the following topics.

Privileges of Membership Users 16-4
Membership User/User Group Example 16-5
Accessing the Memberships Folder 16-5
Working with Membership Users 16-6
Adding Membership Users 16-6
Adding Membership Users to a Membership User Group 16-9
Setting Permissions on Private Content for Membership Users 16-9
Viewing Membership User Information 16-9
Editing Membership Users 16-10
Deleting Membership Users 16-11
Membership User Groups 16-11
Adding Membership User Groups 16-12
Viewing Users in a Membership User Group 16-12
Adding Membership Users to a Membership User Group 16-12
Setting Permissions on Private Content for Membership User
Groups

16-
13

Editing Membership User Group Name 16-13
Deleting User from Membership User Group 16-13
Deleting Membership User Groups 16-13
Assigning Permissions for Memberships 16-14
Assigning Templates to Groups and Members 16-15
The Templates Screen 16-16
Troubleshooting Problems with Membership Users and Groups 16-18
Membership Server Control 16-19
Items on the General Tab 16-20
Items on the Forum Tab 16-21
Items on the Tags Tab 16-22
Items on the Custom Tab 16-22
Items on the Category Tab 16-23
Membership Server Control Properties 16-24
DisplayMode 16-28
ShowTerms 16-29

Privileges of Membership Users
They can create, edit, and view content after log in.

They can be granted permission to view private content. See Also:
Membership User/User Group Example on the facing page and Private
Content on page 7-184

They can self-subscribe to receive Web Alerts. See Also: Admin-
istering the Web Alert Feature on page 23-1

If your site is a Community Web site, they become members of the
community and can use the following features provided by Ektron’s
Community Platform. See Also: Managing User Communities on page

Managing User Communities
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16-1”
Share their Document Workspace and Photo Gallery with
other site visitors

Join a community group

Mark content the member likes and allow site visitors to see
the list of these Favorites

Designate other members or site users as Colleagues

Keep a Journal

Add and read Message Board comments

Send and receive messages with other registered users

If a Discussion Board requires sign in, they can view and
post to them. See Also: Discussion Boards on page 7-576

If a blog requires authentication, they can post blog comments. See
Also: Blogs on page 7-472

If a poll or survey is set up to track participating users, membership
users’ names appear on the Form reports.

Membership User/User Group Example
A typical membership scenario is a Partners section of your Web site that
contains private content for partners only. Set up a membership user group to
include users from your partner’s organization. The group is given add and edit
permissions to the Partners section. As a result, any partner can log into Ektron
CMS400.NET and view, add, or edit the private content.

This topic is more fully explained through the following subtopics.

Accessing the Memberships Folder below

Working with Membership Users on next page

Membership User Groups on page 16-11

Assigning Permissions for Memberships on page 16-14

Troubleshooting Problems with Membership Users and Groups on
page 16-18

Accessing the Memberships Folder
Use the Membership Module folder to enter and edit membership users and
user groups. To access the folder, follow these steps.

1. Navigate toWorkarea > Settings > Community Management
> Memberships.

2. From that folder, you can access the following screens.

Membership User/User Group Example
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Screen More Information

Users Working with Membership Usersbelow

Users not Verified How UsersSign up for Subscriptionson page 23-27

User Groups Membership User Groupson page 16-11

Working with Membership Users
This section contains the following topics.

n Adding Membership Users below

n Adding Membership Users to a Membership User Group on page 16-9

n Setting Permissions on Private Content for Membership Users on
page 16-9

n Viewing Membership User Information on page 16-9

n Editing Membership Users on page 16-10

n Deleting Membership Users on page 16-11

Adding Membership Users
Note: If you are using the Web Alert feature, any site visitor can sign up to be a membership
user. That represents another way to add membership users. For more information, see How
Users Sign up for Subscriptions on page 23-27.

To add a new membership user, follow these steps.

1. Form the Workarea, click Settings > Community Management >
Memberships > Users.

2. Click the Add Membership User button ( ).
3. The Add Membership User screen is displayed.

4. Complete the form using the following table as a reference.

Field Description

Username Enter a unique username for themembership user.

First
Name Enter the first name of the user.

Last
Name Enter the last name of the user.

Managing User Communities
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Field Description

Display
Name

The name that is used to identify aMembership user on theWeb site. This can be different from
their Username, which is the name you use to log into the Ektron CMS400.NETWeb site.

Warning! This name needs to be unique inside Ektron CMS400.NET and it cannot be blank.

Password Enter a password for the user.

Confirm
Pwd Re-type the password to confirm it is correct.

User
Language

Select the language in which the user will view Ektron CMS400.NET screensandmessages.
The language also determines the default value whenever a drop-down list of languages
appearswithin Ektron CMS400.NET.

The dropdown list of choicesat this field is derived from the Language Settings screen, available
from theSettings> Configuration folder.

Do not confuse the system language with the user’s ability to create and edit foreign editionsof
content. This field doesnot prevent a user fromworking with multiple language content. See
Also:Working with Multi-Language Content on page 14-1

Note: If the selected language is not English, French or German, it is only supported after
you download the Ektron CMS400.NET Language Support Program fromEktron and
translate theWeb site.

Email
Address Enter an email address for the user.

Forum
Editor

Determineswhich editor will be used when this user replies to a Discussion Board.

See Also:Using Discussion Boardson Your Web Site on page 7-622

AddingMembership Users
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Field Description

Avatar

An image or icon to represent the user in the Forum.

Type in a web path to image. For example: http://www.example.com/smileyface.gif

Changing Maximum File Size

Bydefault, an avatar’smaximum size is 200 kilobytes. The height and width of the avatar is
reduced 125 pixels preserving the aspect ratio.

To change the file sizemaximum, edit this file:

C:\inetpub\<wwwroot>\<YourSite>\Workarea\Upload.aspx.vb

In this file, change the line shown below to the desired size:

If (numFileSize > 200) Then

For example, to allow 500kb files, change 200 to 500.

Remember, this number is in kilobytes.

Changing Default Height andWidth

To change the default height and width of the avatar, edit this file:

C:\intetpub\wwwroot\<YourSite>\App_Code\VBCode\Utilities.vb

In this file, change the following lines.

DimWidth As Integer = 125

DimHeight As Integer = 125

For example, to set avatars to a height and width of 166 pixels, change 125 to 166 in both lines.

Address The addressused to find your location when a user is performing a search based on location.

Latitude

The latitude used to find your location when a user is performing a search based on location.

Googlemapsprovidesa service that takes the addressof user and returns its latitude and
longitude.

Note: You don’t need to useGoogle’s automatic retrieval of latitude and longitude. Instead,
you can enter the valuesmanually.

Longitude

The longitude used to find your location when a user is performing a search based on location.

Googlemapsprovidesa service that takes the addressof content and returns its latitude and
longitude.

Note: You don’t need to useGoogle’s automatic retrieval of latitude and longitude. Instead,
you can enter the valuesmanually.

Managing User Communities
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Field Description

Any
custom
user
properties

SeeCustomUser Propertieson page 15-12

5. Click the Save button ( ).
See Also:Working with Membership Users on page 16-6

Adding Membership Users to a Membership User
Group
See Adding Membership Users to a Membership User Group on page 16-12.

Setting Permissions on Private Content for
Membership Users
See Assigning Permissions for Memberships on page 16-14.

Viewing Membership User Information
To view membership user information, follow these steps.

1. Access the membership users folder, as described in Accessing the
Memberships Folder on page 16-5.

Note: The ek_PageSize setting in the web.config file determines the maximum number of
users that can appear on a page before it “breaks.” When a page breaks, additional entries
appear on another screen, and the following text appears near the bottom of the list:
Page 1 of 2[First Page] [Previous Page] [Next Page] [Last Page]

The View Users in Group All Members screen lets you add new users, as
well as sort and search for existing users. See Sorting Membership
Users below and Searching for Membership Users on next page.

2. Click the user you want to view.

3. The View Membership User Information screen is displayed.

From this screen, you can edit or delete membership users.

Sorting Membership Users
You can arrange users on the View Users in Group All_Members screen by
clicking the following column headers:

Username

Last Name

First Name

AddingMembership Users to aMembership User
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By default, users are arranged alphabetically by Username, starting with the
beginning of the alphabet. To switch that arrangement so that users whose
username is last when sorted alphabetically, click the column header. To revert
to the original arrangement, click the header again.

You can also sort the list by last name or first name. Like username, clicking the
column header reverses the arrangement.

Searching for Membership Users
You can use the Search field (circled below) to display only users who meet
your criteria. This would be especially helpful to filter out a large number of
membership users.

Use the Search field to enter unique characters to find members you seek. For
example, to find all members whose username includes @example.com, enter
that into the Search field and click the Search button. Only users with those
characters in that exact sequence in their username, first name, or last name
appear on the screen.

You can also search by First and Last name fields. Click the down arrow to the
left of the Search button to select a field to search.

The sequence of search characters must match your entry in the Search field.
For example, if you are searching by last name and enter MI, anyone whose
name is Smith appears. But, if you enter IM, users with the last name of Smith
do not appear.

Also, the search is case-insensitive, so MI produces the same results asmi.

See Also:Working with Membership Users on page 16-6

Editing Membership Users
To edit a membership user, follow these steps.

1. Access the View Membership User screen of the membership user
you want to edit, as described in Viewing Membership User
Information on previous page.

2. Click the Edit button ( ).

Managing User Communities
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3. The Edit Membership User Information screen is displayed.

4. For a description of the fields on the screen, see Adding Membership
Users on page 16-6.

5. Click the Update button ( ).
See Also:Working with Membership Users on page 16-6

Deleting Membership Users
To delete a membership user, follow these steps.

1. Access the View Membership User screen of the membership user
you want to edit, as described in Viewing Membership User
Information on page 16-9.

2. Click the Delete button ( ).

3. A confirmation message is displayed.

4. Click OK.

See Also:Working with Membership Users on page 16-6

Membership User Groups
Important: Membership User Groups and Community Groups are different concepts. Community
Groups allow users with similar interest to join together in a social networking environment. See
Community Groups on page 16-83. Membership User Groups are explained below.

Membership user groups organize similar membership users, reducing the
effort required to assign identical permissions to many users. You can assign
them permission to any folder by going to Folder Properties > View
Permissions for Folder > User Type: Membership users.

This topic is explained through the following topics.

n Adding Membership User Groups on next page

n Viewing Users in a Membership User Group on next page

n Adding Membership Users to a Membership User Group on next page

n Setting Permissions on Private Content for Membership User Groups
on page 16-13

DeletingMembership Users
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n Editing Membership User Group Name on the facing page

n Deleting User from Membership User Group on the facing page

n Deleting Membership User Groups on the facing page

Adding Membership User Groups
To create a new membership user group, follow these steps.

1. Access the membership user group folder, as described in Accessing
the Memberships Folder on page 16-5.

2. Click the Add Membership User Group button ( ).
3. The Add a New User Group screen is displayed.

4. Enter a unique name for the group.

5. Click the Save button ( ).
See Also: Membership User Groups on previous page

Viewing Users in a Membership User Group
To view the information about a membership user group, follow these steps.

1. Access the membership user group folder, as described in Accessing
the Memberships Folder on page 16-5.

2. Click the membership user group you want to view.

3. The View Users In Group screen is displayed.

See Also: Membership User Groups on previous page

Adding Membership Users to a Membership User
Group
To add a membership user to a membership user group, follow these steps.

Note: Only membership users can be added to membership user groups.

1. Access the View Membership User Group screen for the membership
user group to which you want to add a membership user, as described
in Viewing Users in a Membership User Group above.

2. Click the Add Membership User button ( ).
3. The Add User to Group screen is displayed.

Note: Only membership users who do not belong to the group appear.

4. Click the user you want to add.

5. A confirmation message is displayed.

6. Click OK.

See Also: Membership User Groups on previous page
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Setting Permissions on Private Content for
Membership User Groups
See Assigning Permissions for Memberships on next page

Editing Membership User Group Name
To edit a membership user group name, follow these steps.

Note: The membership user group, All_members, cannot be edited.

1. Access the View Membership User Group screen for the membership
group you want to edit, as described in Viewing Users in a
Membership User Group on previous page.

2. Click the Edit button ( ).
3. The Edit User Group screen is displayed.

4. Change the membership group name.

5. Click the Update button ( ).
See Also: Membership User Groups on page 16-11

Deleting User from Membership User Group
To remove a user from a membership user group, follow these steps.

1. Access the View Membership User Group screen for the membership
user group that contains the membership user you want to delete, as
described in Viewing Users in a Membership User Group on previous
page.

2. Click the name of the membership user you want to remove.

3. The View User Information screen is displayed.

4. Click the Delete button ( ).

5. A confirmation message is displayed.

6. Click OK.

See Also: Membership User Groups on page 16-11

Deleting Membership User Groups
To delete a membership user group, follow these steps.

1. Access the View Membership User Group screen for the membership
user group you want to delete, as described in Viewing Users in a
Membership User Group on previous page.

2. Click the Delete button ( ).

3. A confirmation message is displayed.

4. Click OK.

Setting Permissions on Private Content for
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See Also: Membership User Groups on page 16-11

Assigning Permissions for Memberships
After you create membership users and groups, you can assign them
permissions to Community folders only. See Also: Community Folders on page
16-110

To do so, follow these steps.

1. Access the permissions table for the content or folder to which you
want to assign membership permissions.

For See

Content folders Setting Permissions for a Content Folder on page 4-44

Content Setting Permissions for Content on page 4-48

2. If necessary, break the inheritance for the content or folder. See
Also: Inheritance on page 4-42

3. If desired, set the folder or item to Private. See Also: Private
Content on page 7-184

4. Click View MemberShip Users on the right side of the permissions
table.

5. The membership users/user groups added to the permissions table
are displayed.

6. Click the Add button ( ).
7. The Add Permissions screen is displayed.

8. Click a username or user group name to add to the permissions table.

9. The Add Permissions Options screen is displayed.

10. Check appropriate permissions for the membership user or group.

11. Click the Save button ( ).

Managing User Communities
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Assigning Templates to Groups and
Members
As mentioned in Managing User Communities on page 16-1, Ektron
CMS400.NET ‘s Community Management feature supports both community and
individual member pages. Like other Ektron CMS400.NET content, Community
Management content appears on a dynamic Web page. Page templates
determine each page’s layout and location of elements (menus, content, blogs,
etc.). Below is a sample Community Management template. See Also:
Creating/Updating Templates on page 7-178

Sample Group Template within Visual Studio.NET

Sample Group Template on a Web Page

The Community Management feature includes six templates:

n Community Group

- documents

- photos

- journal

n User

- documents

- photos

- journal

Ektron CMS400.NET provides a sample for each template. You can use the
sample or create your own. If you begin with a sample template and modify it,

Assigning Templates to Groups andMembers
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be sure to save it under a different name to prevent it from being overwritten
when you upgrade.

The Templates Screen
Use the Workarea Settings > Community Management > Templates
screen to assign templates to Community Management pages.

See Also: Assigning Templates to Groups and Members on previous page

The following table explains the fields on the Templates screen.

Field Page that displays template

Group Templates

Community
Document Page hosts the CommunityDocumentsServer Control; ObjectType property is set toGroup

Photo
Gallery Page hosts the PhotoGalleryServer Control; ObjectType property is set toGroup

Journal Page hosts the Blog Server Control, and the blog wascreated for a group page

Managing User Communities
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Field Page that displays template

Profile

Page that hosts a CommunityGroup Profile server control.

Note, however, that a site visitor, while viewing a page, mayclick an icon to visit a community
group profile from there. See image below.

In this case, if the original control hasa TemplateUserProfiledefined, that value overrides
this field and defines the template in which the community group profile is displayed.

User Templates

Community
Document Page hosts the CommunityDocumentsServer Control; ObjectType property is set toUser

Photo
Gallery Page hosts the PhotoGalleryServer Control; ObjectType property is set toUser

Journal Page hosts the Blog Server Control, and the blog wascreated for a user page

The Templates Screen
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Field Page that displays template

Profile

Page that hosts a User Profile server control.

Note that a site visitor mayclick an user icon to visit a user profile from another page. See image
below.

In this case, if the original control hasa TemplateUserProfileproperty value defined, that
value overrides this field and defines the template in which the user profile is displayed.

Troubleshooting Problems with Membership
Users and Groups

Symptom Problem Solution

Error message:

Response object
error 'ASP 0251 :
80004005'

Response Buffer
Limit Exceeded

Response
Buffer
exceeded its
limit

Increase limit. To do so, follow these steps.

1. Stop IIS.

2. Locate the file
%WinDir%\System32\Inetsrv\Metabase.xml

3. Modify the AspBufferingLimit value.

4. Restart IIS.

The default value is 4194304, which is about 4MB.
Suggest changing it to 20MB (20971520) and see if that
helps.

Managing User Communities
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Membership Server Control
The Membership server control presents a tabbed form that allows a site visitor
to create or update his profile. The form prompts a site visitor to enter the
following types of information.

n General - see Items on the General Tab on next page

n Forum - see Items on the Forum Tab on page 16-21

n Tags - see Items on the Tags Tab on page 16-22

n Custom - see Items on the Tags Tab on page 16-22

n Category - see Items on the Category Tab on page 16-23

n Activities - see Enable/Disable the Notification System on page 16-
130

The Membership server control can also enable new membership users to read
and accept terms and conditions for using Discussion Boards when needed.

Below is a sample Membership server control when viewed on a Web page. See
Also: Membership Server Control Properties on page 16-24

Be sure to review the following documentation when using the Membership
server control.

n Managing Users and User Groups on page 15-1

n Administering the Web Alert Feature on page 23-1

n Working with Discussion Boards and Subjects on page 7-579

Membership Server Control
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Understanding these topics along with using this server control extends the
most functionality to your membership users.

Items on the General Tab
The General tab's fields define information about a membership user. When a
fields has an asterisk (*), it must be completed before the form can be
submitted. The following fields appear on the General Tab.

Field Description

First
Name Auser’s first name.

Last
Name Auser’s last name.

Password

If desired, enter a new password into this field.

Note: If you change your password, you do not need to log out then log back in. However,
the next time you log in, youmust use the new password.

Confirm
Pwd Confirm your new password by retyping it into this field.

E-Mail
Address

Enter a valid email address. Notification email is sent to this addressunless theDisable E-mail
Notification field is checked.

To understand how email notification operateswithin the content workflow, seeExample of an
ApprovalChain on page 4-35.

Also, this address identifies the user sending Instant email. See Also: Instant eMailon page 1-92

Display
Name

The name that identifies the user on theWeb site. This can be different from the user’s
Username, which is the name the users enters to log into the Ektron CMS400.NETWeb site.

User
Language

Select a language in which to view Ektron CMS400.NET. Click the blackdown arrow on the right
of the drop down box to see a list of choices.

Address The addressused to find a user's location when a someone is performing a search based on
location.

Latitude

The latitude used to find a user's location when a user is performing a search based on location.

Googlemapsprovidesa service that takes the addressof user and returns its latitude and
longitude.

Note: You don’t need to useGoogle’s automatic retrieval of latitude and longitude. Instead,
you can enter the valuesmanually.

Managing User Communities
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Field Description

Longitude

The longitude used to find a user's location when a user is performing a search based on
location.

Googlemapsprovidesa service that takes the addressof content and returns its latitude and
longitude. See Also:MapServer Controlon page 7-654

Note: You don’t need to useGoogle’s automatic retrieval of latitude and longitude. Instead,
you can enter the valuesmanually.

Avatar

An image or icon to represent you on theWeb site. Click theClick to upload your avatar link to
upload an avatar to the system. This link is controlled by the AllowAvatarUploadproperty.

Bydefault, themaximum file size of an avatar is 200 kilobytes. Also, the avatar's height and width
cannot exceed 125 pixels preserving the aspect ratio.

Changing the Default File Size

To change the file size limit, edit Siteroot\Workarea\Upload.aspx.vb. In this file, change
the line below to themaximum file size you wish to allow.

If (numFileSize > 200) Then

For example, to allow 500 kb files, change 200 to 500.

Note: Remember, this number is in kilobytes.

Changing the Default Height and Width

To change the default height and width, edit YourSite\App_Code\VBCode\Utilities.vb.
In this file, change the following lines to the size you wish to allow.

Dim Width As Integer = 125

Dim Height As Integer = 125

For example, to set avatars' height and width to 166 pixels, change 125 to 166 in both lines.

Items on the Forum Tab
The Forum tab allows a user select settings for the Forum. The following items
appear on the ForumTab.

Field Description

ForumEditor Select the type of editor to use when creating Forum posts.

Items on the ForumTab
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Field Description

Topics per
Page The number of Forum topics displayed on a page.

Forum
Signature

In the text area, add a signature. This signature is added to all posts submitted bya user.
For example:

Regards,

John Edit

Content Creator

Custom Content Creations, Inc.

Items on the Tags Tab
Tags allow users to identify themselves by means of a common term. A user
can select from a predefined list of Tags. Or, create a new tag by clicking the
Click To Add A New Tag link.

Placing a check mark in the check box next to a tag activates it for a user’s
profile. See Also: Tags on page 16-271

Items on the Custom Tab
The Custom tab displays custom settings for Message Boards and User
calendars as well as Privacy Settings and User Properties that are created by
the site administrator.

Managing User Communities
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The Moderate Message Board checkbox allows a member to determine if he
wants to moderate or approve comments made on his message board. See
Also: Moderating a Message Board on page 16-69

The Allow Event Edits on User Calendars checkbox allows a member to
edit events on their calendar. If this is unchecked, the calendar is displayed but
events cannot be added.

Select whether this profile is displayed to any visitor or privately to only
colleagues.

The fields that follow are created by the administrator in the Settings > User
Properties section. See Also: Custom User Properties on page 15-12

As examples, subscriptions, an employee ID, or a user’s birthday might
appear.

Unlike items on the General tab, these items change from organization to
organization. If an administrator creates a property such as Employee ID
number, it appears even when a membership user views this form. The
Membership server control’s ShowExtended property lets you decide if custom
user properties appear when the form is viewed.

Items on the Category Tab
The Category tab allows a user to select from a list of taxonomy categories that
they wish to be associated with. You determine which taxonomy appears on the
tab by setting the TaxonomyID property.

Warning! The Category tab appears only when an ID is assigned to the TaxonomyID property.

Items on the Category Tab
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Membership Server Control Properties
The following table explains the properties of the Membership server control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

AllowAvatarUpload

When set toActive, theClick to upload your avatar link appears
on theGeneral tab. This allowssite visitors to upload an avatar
when registering for the site.

When set toDisable, the link is hidden.

If you want to force site visitors to choose from a predefined gallery
of avatars, enter a path to the template containing the avatars.

The predefined gallery appears in a pop-up window. If you want to
adjust the properties of thiswindow, edit the
<siteroot>\<webroot>\workarea\java\membershiptabs.js
file.

String

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc.

See Also:

Working with Ektron CMS400.NET Server Controlson page 24-1

String

BoardID

The ID of the Discussion Board for which to show the Termsand

Conditions. See Also: ShowTermson page 16-29.

If you don’t know the ID, click the Ellipsesbutton ( ), then sign in,
browse to and select the Discussion Board. See Also: Working with
Ektron CMS400.NET Server Controlson page 24-1

Long
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Property Value
Data
Type

DisplayMode

The type of membership form displayed. Choose from the following.

n UserRegistration - Lets a site visitor register asamembership
user.

n ResetPassword - Lets amembership user reset his password.

n UnsubscribeSecured - Lets amembership user unsubscribe
using his username and password.

n UnsubscribeUnsecured - Lets amembership user
unsubscribe using hismembership username only.

n AccountActivate - Let a site visitor activate hismembership
account byentering the ID number in the account verification email.

For more information, seeDisplayMode on page 16-28.

Mode

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes shown.

Boolean

DynamicParameter Tomake this control dynamic, select id.When you do, this server
control is attached to the user passed asa URL parameter.

EnableCaptcha

Use to add Captcha interface for more security. It looks like this.

True =Show Captcha

False =Hide Captcha

If this property is set to true, Captcha appearswhile the control is in
UserRegistration,AccountActivate, andReset Password
modes.

See http://www.captcha.net for more information about Captcha.

Boolean

Hide

Used to hide login button in design time and run time.

True =Hide login button

False =Show login button

Boolean

JavascriptEditorHeight
Note: Asof version 7.6, the JavaScript editor hasbeen
removed from the product. This property hasbeen deprecated.

Set the height in pixels for the Signature editor. The default is300.

Integer

Membership Server Control Properties
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Property Value
Data
Type

JavascriptEditorWidth
Note: Asof version 7.6, the JavaScript editor hasbeen
removed from the product. This property hasbeen deprecated.

Set the width in pixels for the Signature editor. The default is360.

Integer

Language Set a language for the server control. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

RedirectFailedURL

TheURLwhere amembership user is sent if the registration fails.

n If the page resides in the same folder as the registration page,
enter the name of the page. For example,RegFailed.aspx.

n If the redirect page is located in a subfolder, add the folder path.
For example,members\RegFailed.aspx.

String

RedirectSucessURL

TheURLwhere amembership user is sent when the registration
succeeds.

n If the page resides in the same folder as the registration page,
enter the name of the page. For example,RegSucceed.aspx.

n If the redirect page is located in a subfolder, add the folder path.
For example,members\RegSucceed.aspx.

String

RegisterButtonImg

Lets you add an image in place of the text on the register button.
Enter a path to the image. For example:

http://www.example.com/buttons/registerbutton.gif

If the image is located in the site root, you do not need to enter the
full path. Only enter the subfolder path and image name. For
example: /buttons/registerbutton.gif

String

RegisterButtonText
Text that appears on the Register button. The default isRegister.

If you use a register button image, you do not see this text.
String

ResetButtonImg

Lets you add an image in place of the text on the reset button. Enter
a path to the image. For example:

http://www.example.com/buttons/resetbutton.gif

If the image is located in the site root, you do not need to enter the
full path. Only enter the subfolder path and image name. For
example: /buttons/resetbutton.gif

String

ResetButtonText Text that appears on the reset button. The default isReset. If you
use a reset button image, you do not see this text. String
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Property Value
Data
Type

SaveButtonImg

Lets you add an image in place of the text on the save button. Enter
a path to the image. For example:

http://www.example.com/buttons/savebutton.gif

If the image is located in the site root, you do not need to enter the
full path. Only enter the subfolder path and image name. For
example: /buttons/savebutton.gif

String

SaveButtonText Text that appears on the save button. The default isSave. If you use
a save button image, you do not see this text. String

ShowExtended

Decide if the CustomUser PropertiesTab is available when using
this control. The default setting isTrue.

True - Show CustomUser Properties tab.

False - Hide CustomUser Properties tab.

Note: For more information, seeCustomUser Propertieson
page 15-12.

String

ShowTerms

When set to True, this property shows the Termsand Conditionsas
defined in theWorkarea. In addition, users are asked to checka box
stating theyhave read and agree to abide by the termsand
conditionsof the forum. Default isFalse.

ShowTermson page 16-29 andWorking with Discussion Boards
and Subjectson page 7-579

Boolean

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TaxonomyID

The ID of a taxonomyavailable to users. A user editing or creating a
profile can select which categories from this taxonomy to associate
with their profiles.

See Also: Itemson the CategoryTab on page 16-23 and Taxonomy
on page 9-202

Long

UserExists

Message
Themessage that appearswhen amembership user already
exists. The default message is:Username(email) already exists! String

UserSuccessMessage

Themessage that appearswhen amembership user successfully
registers. The default message is:You have registered
successfully.

You can also use this property to set themessage that appears
when users successfully unsubscribe or reset their password. To do
this, enter the successmessage in this property and set the
DisplayModeproperty to the proper usage.

String

Membership Server Control Properties
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Property Value
Data
Type

UserUpdateSuccessMessage
Themessage that appearswhen amembership user successfully
updates their information. The default message is:You have
successfully updated your information.

String

WrapTag

Allowsa developer to specify a server control’s tag. The default is
Span.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

Custom - Allowsyou to use a custom tag.

String

DisplayMode
Lets a developer decide what type of membership form is added to the Web
form. The following table describes settings for the DisplayMode property.

Setting Description Example

User

Registration

Lets a site visitor register asa
membership user.

Thismode also allowsmembership
users to update their information and
preferenceswhen logged in.

Reset

Password
Lets amembership user reset his
password.

Unsubscribe

Secured

Lets amembership user unsubscribe
byentering his username and
password.
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Setting Description Example

Unsubscribe

Unsecured

Lets amembership user unsubscribe
byentering hismembership username
only.

Account

Activate

Let a site visitor activate his
membership account byentering the ID
number sent in the account verification
email.

ShowTerms
Prerequisite:  Terms and Conditions are defined for the Discussion Forum
specified in the Membership Server Controls 's BoardID property. See Also:
Terms & Conditions on page 7-586

If you set the ShowTerms property to True, the Terms and Conditions for the
forum identified in the control's BoardID property appear near the bottom of
the Membership Server Control. The membership user must check the
checkbox to complete his registration.

If Terms and Conditions are defined for the specified Discussion Board and
ShowTerms property is set to False, the user must accept the Terms and
Conditions the first time he creates a post or a reply.

ShowTerms
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Accessing a User Profile
A Profile collects and maintains information about a user. Administrators can
access user profiles from the Workarea. Ektron CMS400.NET users can access
their profile from the Workarea or the Web site. Membership users can only
access their profile page from the Web site.

Ektron CMS400.NETdevelopers insert a profile on a page using the UserProfile
Server Control. See Also: UserProfile Server Control below

Warning! For Ektron CMS400.NET users, some profile information in the Workarea’s View User
Information screen is not available on the Web site profile page. That information involves
Workarea settings.

Profiles in the Workarea
In the Workarea, profiles are located in the following areas:

n Ektron CMS400.NET Users - navigate to Settings > Users. See
Managing Users on page 15-3

n Membership Users - navigate to Settings > Community
Management > Memberships > Users. See Working with
Membership Users on page 16-6

UserProfile Server Control
The UserProfile control displays information about a user. A user’s Profile page
is their home on the Web site. The following information is displayed in a user’s
profile.

n The user’s Avatar

n Any Personal Tags associated with the user

n The user’s Screen Name

n Any Custom Properties associated with the user
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In addition to displaying profile information, logged in users can edit their
profile by clicking the Edit Profile link.

This dialog box is the same dialog that a membership user uses to create an
account on the site. See Items on the General Tab on page 16-20 for a
description of this dialog.

URL Aliases for UserProfiles
To automatically create a friendly URL for a UserProfile, you can use
Community Aliasing for Users. Community URL Aliasing on page 10-41 for
more information.

Sample of User Profile
You can see a sample profile on the eIntranet My Profile page's top left corner.

UserProfile Server Control Properties
The UserProfile server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer
and can use it to browse to Content, Collections,
etc.See Also:Working with Ektron CMS400.NET
Server Controlson page 24-1

String

AvatarHeight The displayheight in pixels of the avatar in the profile
area. Integer
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Property Description Data Type

AvatarWidth The displaywidth in pixels of the avatar in the profile
area. Integer

CacheInterval

Sets the amount of time, in seconds, that the server
control’s data is cached. The default is 0 (zero).

For example, to cache the data for fiveminutes, set
to 300.See Also: Caching with Server Controlson
page 24-33

Double

DefaultUserID
The default user ID for this control to use when
there is nomatching dynamicparameter value
passed.

Long

DisplayXslt

Determineshow information is displayed on the
page. Enter the path to the XSL file. It can be relative
or absolute.

Warning! If you specify an external file, it is
strongly recommended that you do not store this
file in your site'sWorkarea folder. If you store this
file in theWorkarea folder, the file will be lost when
you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event.
Set to false if you want to postpone the fill-action
until later. In this case, FIll is automatically called
during the Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

DynamicParameter
Gets or sets the QueryString parameter to read a
user ID dynamically. To use the default object ID,
leave blank.

String

EnableEmailDisplay

Set to True to display a user’s email address in his
profile. If a user’sPrivate Profile setting is set to
Private, his profile information is not visible,
regardlessof this property’s setting. If Private Profile
is set to Colleagues, only a user’s colleagues can
see email information.

True - display a user’s email address in his profile.

False - do not display a user’s email address in his
profile.

Boolean

Hide

Used to hide output of the control in design time and
run time.

True =Hide control

False =Display control

Boolean

Managing User Communities

16-32 ReferenceManual
Version 8.01 Rev 4



Property Description Data Type

Language
Set a language for viewing the server control. This
property shows information in design-time (in Visual
Studio) and at run-time (in a browser).

Integer

Stylesheet

Specify the path to a style sheet for use with the
Documents server control. The location can be
relative or absolute. Leave blank to use the default
style sheet.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround
the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TagTemplate

TheWeb page template that contains the
CommunitySearch server control. This allowsusers
to search for others userswith the same tags.

If a template is entered, Personal Tags in the Profile
appear as links. Clicking a tag forwards the user to a
User Search page that displays search results for
thematching tag.

String

TagTemplateTarget

Determines the type of window that appears on this
Web formwhen a user clicks an item in the server
control. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

TaxonomyId

The numeric ID of the taxonomy that is available to
users. A user editing a profile can select which

categories to associate with their profiles.

See Also: Itemson the CategoryTab on page 16-
23; Taxonomyon page 9-202

Long

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an
inline portion of an HTML document asa span
element.

Div - The <div> tag is used when you want to apply
attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String
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Friends Server Control
Part of the Community Platform, the Friends server control typically appears on
your profile page and displays your colleagues. If you browse to another user's
profile, you see that user's colleagues.

The control can display a list of

current colleagues—users who accepted your invitation to be a col-
league, or whose invitation to be a colleague you accepted

pending colleagues—users who sent you a colleague request, which
you have not yet accepted

invited colleagues—users to whom you have sent colleague
requests, which have not yet been accepted

The control can allow a user to navigate between views.

The Friends server control also lets a user designate a Selected Colleague, a
special category whose members can view documents and photos that regular
colleagues and the public cannot view.

This section also contains the following topics.

Friends Server Control on Sample Site 16-35
Setting the Friends Server Control’s Display Mode 16-35
Managing Colleagues 16-35
Viewing Colleague Requests 16-36
Accepting a Colleague Request 16-36
Declining a Colleague Request 16-36
Viewing Invited Colleagues 16-37
Canceling Invited Colleagues 16-37
Removing Colleagues 16-37
Designating a Selected Colleague 16-37
Grouping Colleagues by Folder 16-38
Creating a Folder 16-39
Placing a Colleague in a Folder 16-40
Changing a Folder’s Name or Description 16-40
Deleting a Folder 16-41
Friends Server Control Properties 16-42
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Friends Server Control on Sample Site
To see an example of the Colleagues Server Control on a sample site, install
the Ektron Tech site and go to My Profile > Colleagues (in left panel). To
download sample sites, go to http://www.ektron.com/solutions/startersites/.

Setting the Friends Server Control’s Display
Mode
The Friends server control's DisplayMode property controls whether a user’s
colleagues are displayed as a

n basic list

n grouped by folder

n colleagues who asked you to become their colleague

n people you invited to be your colleague

For more information, see DisplayMode on page 16-43.

Managing Colleagues
To manage existing colleagues on the Web site, find the Colleague area of
your profile page. From here, you can view, approve, and remove colleagues.

Friends Server Control on Sample Site
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The following sections explain how to manage colleagues.

n Viewing Colleague Requests below

n Accepting a Colleague Request below

n Declining a Colleague Request below

n Viewing Invited Colleagues on the facing page

n Canceling Invited Colleagues on the facing page

n Removing Colleagues on the facing page

n Designating a Selected Colleague on the facing page

Viewing Colleague Requests
Pending colleagues are users who sent you a colleague request which you have
not yet accepted. To view pending colleagues on the Web site, navigate to the
Pending Colleagues area of your profile page. From this area, you can accept
or decline colleague requests.

Accepting a Colleague Request
Accepting a colleague request adds the user to your colleagues list. This allows
you to access additional information on the colleague's profile page. To accept a
pending colleague request, follow these steps.

1. Navigate to the Pending colleagues area of your profile page.

2. Place a check in the box next to each colleague whose request you
want to accept.

3. Click the Approve link.

The page refreshes, and the selected users are removed from the Pending
Colleagues list and added to the colleagues list. See Also: Friends Server
Control on page 16-34

Declining a Colleague Request
Declining a colleague request cancels the request. Once you decline the
request, it is removed from your Pending Colleagues list and the requester’s
Invited list. To decline a colleague request, follow these steps.

1. Navigate to the Pending Colleagues area of your profile page.

2. Place a check in the box next to each colleague whose request you
want to decline.

3. Click the Remove Selected link.

4. A dialog box asks you to confirm that you are declining the colleague.

5. Click OK.

6. The page refreshes, and the selected users are removed from your
Pending Colleagues list and requester’s Invited list.
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Viewing Invited Colleagues
The Invited colleagues list displays users to whom you’ve sent colleague
invites. From this screen, you can delete requests that have not yet been
accepted. See Also: Canceling Invited Colleagues below

To view sent colleague requests, navigate to the Invited Colleagues area of
your profile page.

Canceling Invited Colleagues
To cancel a colleague request, follow these steps.

1. Navigate to the Invited Colleagues area of your profile page.

2. Place a check in the box next to each colleague whose invite you want
to cancel.

3. Click the Remove Selected link.

4. A dialog box asks you to confirm that you are canceling the colleague
invites.

5. Click OK.

6. The page refreshes, and the invited colleague is removed from the
Invited Colleagues list and the colleague’s Pending list.

Removing Colleagues
If you would like to end your association with a colleague, remove him by
following these steps.

1. Navigate to the Colleagues area of your profile page.

2. Place a check in the box next to each colleague you want to remove.

3. Click the Remove Selected link.

4. A dialog box asks you to confirm the removal.

5. Click OK.

Designating a Selected Colleague
Selected colleague is a special category of user who can be given access to
documents and photos that regular colleagues cannot view. A user makes this
designation when sharing a Workspace. The user can share with the Public, all
colleagues, or selected colleagues. See Also: Sharing Workspace Content on
page 16-249

Follow these steps to mark a colleague as a Selected Colleague.

1. Navigate to the Colleagues area of your profile page.

2. Place a check in the box next to each colleague you want to make a
Selected Colleague.

3. Click the Update link.
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4. A dialog box asks you to confirm the status change of the colleague.

5. Click OK.

6. Selected Colleague appears next to the colleague.

You can later change a selected colleague back to a colleague. To do so, place a
check in the box next to a selected colleague and click the Update link.

Grouping Colleagues by Folder
Grouping lets you organize colleagues by folder. For example, you place all
family members in a "Family" folder.

You can only group current colleagues, not colleagues who are pending or
invited.

The following sections explain how to work with Colleague folders.

Creating a Folder on the facing page

Placing a Colleague in a Folder on page 16-40
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Changing a Folder’s Name or Description on next page

Deleting a Folder on page 16-41

Creating a Folder
1. Make sure the DisplayMode property of the Friends server control is

set to Directory.

2. Log in to the Web site.

3. Navigate to your profile page or a page the contains a Friends server
control.

4. Click the Add Folder link in the Friends server control.

5. Enter a Name and Description for the folder.

6. Click OK.

Creating a Folder
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Placing a Colleague in a Folder
To move a colleague to a folder, follow these steps.

Prerequisite: At least one colleague folder. See Creating a Folder on previous
page

1. Navigate to your profile page or a page the contains a Friends server
control.

2. Check one or more colleagues.

3. Click the Move link on the Friends server control.

4. A list of folders appears. Select the folder to which you want to move
them.

5. Click OK.

6. A dialog box asks you to confirm. Click OK.

You can now find the colleague in the folder. Click it to see all colleagues in the
folder.

Changing a Folder’s Name or Description
To change a folder's name or description, follow these steps.
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1. Navigate to your profile page or a page the contains a Friends server
control.

2. In the Colleagues section of the screen, click the Edit Folder icon (
)

next to the folder’s title.

3. A dialog box appears.

4. Change the name, description or both.

5. Click the Save button.

Deleting a Folder
Warning! Deleting a folder also deletes all colleagues in the folder. If you want to retain the
colleagues, move them out of the folder before deleting it. To remove a colleague from a folder,
click the folder, check the colleague, and click Move Up One Level.

Warning! Deleting a folder also deletes all of its subfolders.

To delete a folder, follow these steps.

1. Navigate to your profile page or a page the contains a Friends server
control.

2. In the Colleagues section of the screen, click the Edit Folder icon (
)

next to the folder’s title.

3. A dialog box appears.

4. Click the Delete button.
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5. You are asked if you are sure you want to delete the folder. Press OK.

6. Click the Save button.

Friends Server Control Properties
The Friends server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can
use it to browse to Content, Collections, etc.

See Also:

Working with Ektron CMS400.NET Server Controlson page
24-1

String

AvatarHeight The displayheight in pixels of the avatar in the results box. 0
(zero) = unlimited. Integer

AvatarWidth The displaywidth in pixels of the avatar in the results box. 0
(zero) = unlimited. Integer

CacheInterval

Sets the amount of time, in seconds, that the server control’s
data is cached. The default is 0 (zero).

For example, to cache the data for fiveminutes, set to 300.
See Also: Caching with Server Controlson page 24-33

Double

DefaultUserID The default user ID for this control if nomatching dynamic
parameter value is passed. Long
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Property Description Data Type

DisplayMode

Select the way this control displays colleagues. Choicesare:

Directory—allowsusers to group colleaguesby folders. In
thismode, thesemenu itemsappear.

Add Folder—lets user add a folder.

Move—lets a user place colleagues in a folder. This option
appears only if a folder exists.

List—lists colleagues in alphabetical order

Pending— listspending colleagues, userswho have sent
colleague requests to the logged -in user. The user can
approve or decline these requests.Managing Colleagueson
page 16-35

SentInvites—lists users to whom the logged -in user sent
colleague requests. The user can cancel invitations that have
not been accepted yet.FriendsServer Controlon page 16-
34

See Also:Managing Colleagueson page 16-35

eDisplayMode

DisplayXslt

Determineshow information is displayed on the page. Enter
the path to the XSL file. It can be relative or absolute.

Warning! If you specify an external file, it is strongly
recommended that you do not store this file in your site's
Workarea folder. If you do, the file will be overwritten when
you upgrade.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theDisplayXslt
property value is ignored.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false
if you want to postpone the fill-action until later. In this case,
FIll is automatically called during the Page Render event.

Youmight do this if you need to set or change a property on
the control in codebehind and have it render with your
changes shown.

Boolean

DynamicParameter Gets or sets the QueryString parameter to read a user ID
dynamically. To use the default user ID, leave blank. String

FriendLabel Set the singular text to be used asa title for the Friends
server control. The default value isColleague. String

FriendsLabel Set the plural text to be used asa title for the Friends server
control. The default value isColleagues. String

Hide

Used to hide output of the control in design time and run time.

True =Hide control

False =Display control

Boolean
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Property Description Data Type

Language
Set a language for viewing the Friends control. This property
shows results in design-time (in VisualStudio) and at run-
time (in a browser).

Integer

Link

Enter a link to the user profile page template. The path can
be relative or absolute.

This value is referenced when a user clicks another user in
the Friends control. Upon clicking the link, the selected user’s
profile page appears.

The link requires these variables.

{0} - represents user ID

{1} - represents user display name

Below is an example.

userprofilepage.aspx?uid={0}&dn={1}

String

LinkTarget

Determines the type of window that appears on thisWeb
formwhen a user clicks an item in the Friends control. The
default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the display of
the server control. For example, mymarkup.ekml. If the
*.ekml file is located in the same folder as theWeb form
containing the server control, just enter its name. Otherwise,
the path to the file can be relative or absolute.
See Also:Controlling Output with EktronMarkup Language
on page 26-1

String

MaxResults Themaximum number of colleagues to display in the control.
0 (zero) = unlimited. Integer

RenderOutput

Allowsyou determine whether or not to generate output. If
you do not, CSSand JS are not registered.

The default value isTrue.

True –The control's output is generated.

False – The control fetchesdata from the backend but
generatesno output. You are responsible for generating
output using XML or DataClasses

Boolean
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Property Description Data Type

ShowSortingOptions

Determines if sorting optionsappear on the control. If set to
True, the following optionsappear:

Colleagues - all current colleagues

Pending - colleagueswho sent you a colleague request that
you have not yet accepted

Invited - colleagues to whom you have sent colleague
requests

Boolean

Stylesheet

Specify the path to a style sheet for use with the server
control. The location can be relative or absolute. Leave blank
to use the default style sheet.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theStylesheet property
is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the
control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag. The
default isSpan.

Span—The <span> tag is used to designate an inline portion
of an HTML document asa span element.

Div—The <div> tag is used when you want to apply
attributes to a blockof code.

Custom—Allowsyou to use a custom tag.

String

Favorites Server Control
The Favorites server control displays a list of Ektron CMS400.NETcontent and
external web links (URLs)that a user has designated as favorite content. Within
the control, Ektron CMS400.NETcontent and URLs appear in separate lists.

To view favorite content, click the Content link. To view a list of external URLs,
click the Link link.

Favorites Server Control

ReferenceManual
Version 8.01 Rev 4

16-45



To see a Favorites server control in a sample site, use the Ektron Tech site >
 My Profile > Favorite Links. To download sample sites, go to
http://www.ektron.com/solutions/startersites/.

To learn about designating Ektron CMS400.NETcontent as a favorite, see
SocialBar Server Control on page 16-235. This following topic explains how to
designate a URL link as a favorite.

This section also contains the following topics.

Adding a URL to Your Favorites via the Favorites Control 16-46
Grouping Favorites by Folder 16-47
Moving Favorites to a Folder 16-47
Deleting a Folder 16-49
Changing a Folder’s Name or Description 16-49
Favorites Server Control Properties 16-50

Adding a URL to Your Favorites via the
Favorites Control
Users can add a URL to their Favorites by clicking

the Add Link on the Favorites server control. This is described below.

the Add to Favorites link on the Social Bar server control. See Add-
ing a Web Page URL to a Favorites Via the Social Bar on page 16-236.

To add a URL using the Favorites server control, follow these steps.

1. Log-in and navigate to the profile page that hosts the Favorites
control.

2. Click Add Link.

3. In the Name field, add a name for the URL link.

4. In the Link field, add the URL.

5. In the Description text area, add a description for the URL. This is
optional.

6. Click OK.
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After a URL is added, it appears on the control's Links list.

Grouping Favorites by Folder
The DisplayMode property controls whether a user’s Favorites are displayed
as a basic list, or if they can be organized in folders. For example, a user
groups all content created by a certain author in a folder with that author’s
name.

If you add a folder to a user’s favorites, content in the folder appear in the
Content list; URLs in the folder appear in the Links list.

Moving Favorites to a Folder
To move a Favorite to a folder, follow these steps.

1. Make sure the Favorites server control's DisplayMode property is
set to Directory.

2. Log in to the Web site.

3. Navigate to your profile page or the page the contains the Favorites
server control.

4. In the Favorites server control, click the Add Folder link.

5. Enter a Name and Description for the folder.

6. Click OK.
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7. Check one or more favorite items.

8. Click the Move link on the Favorites server control.

9. Select a folder to which the items will be moved.

10. Click OK.

11. A dialog box appears asking you confirm moving the items. Click OK.

The Favorite content can now be found under the folder. Click the folder to see
all content in that folder.
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Deleting a Folder
Warning! Deleting a folder also deletes all content links and URL links in the folder. If you want
to retain the links, move them out of the folder before deleting it. To remove a link from a folder,
click the folder, check the link, and click Move Up One Level.

Warning! Deleting a folder also deletes all of its subfolders.

To delete a folder, follow these steps.

1. Navigate to your profile page or a page the contains a Favorites
server control.

2. In the Favorites section of the screen, click the Edit Folder icon ( )
next to the folder’s title.

3. A dialog box appears.

4. Click the Delete button.

5. You are asked if you are sure you want to delete the folder. Press
OK.

6. Click the Save button.

Changing a Folder’s Name or Description
You can change a folder’s name or description by clicking the Edit Folder icon (
) next to the folder’s title. Clicking the icon launches a dialog box that allows

you to edit the name or description.
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Once the changes are made, click the Save button.

Favorites Server Control Properties
The Favorites server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to browse
to Content, Collections, etc.

See Also:

Working with Ektron CMS400.NET Server Controlson page 24-1

String

CacheInterval

Sets the amount of time, in seconds, that the server control’s data is cached.
The default is 0 (zero).

For example, to cache the data for fiveminutes, set to 300.See Also:
Caching with Server Controlson page 24-33

Double

DefaultUserID The default user ID for this control to use when there is nomatching
dynamicparameter value passed. Long

DisplayMode

Select the way this control displays community group information. Choices
are:

List—showsa list of Favorites sorted in alphabetical order.

Directory—groups favorites by folder. If this selection is chosen, the
followingmenu itemsare added to the control:

Add Folder—allowsa user to add a sub folder.
Move—allowsa user to move content to a folder. This item
only appears if at least one folder exists. See Also:Grouping
Favorites byFolder on page 16-47

eDisplayMode

DisplayXslt

Determineshow information is displayed on the page. Enter the path to the
XSL file. It can be relative or absolute.

Warning! If you specify an external file, it is strongly recommended that
you do not store this file in your site'sWorkarea folder. If you store this file in
theWorkarea folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at theMarkupLanguage
property, theDisplayXslt property value is ignored.

String
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Property Description Data Type

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you want to
postpone the fill-action until later. In this case, FIll is automatically called
during the Page Render event.

Youmight do this if you need to set or change a property on the control in
codebehind and have it render with your changes shown.

Boolean

DynamicParameter Gets or sets the QueryString parameter to read a user ID dynamically. To
use the default user ID, leave blank. String

FavoritesTitle

The title shown at the top of the control.

String

Hide

Used to hide output of the control in design time and run time.

True =Hide control

False =Display control

Boolean

Language Set a language for viewing the Favorites control. This property shows
results in design-time (in VisualStudio) and at run-time (in a browser). Integer

Link

Enter a link to the contentWeb page. This allowsa user to click a link in the
Favorites control and be taken to the content.

The link's variablesare below.

{0}—represents the content ID

{1}—represents the content language

{2} - represents the content title

The linkmust have all three variables. TheWeb form can be relative or
absolute. Below is an example.

contentpage.aspx?cid={0}&lang={1}&title={2}

String

LinkTarget

Determines the type of window that appears on thisWeb formwhen a user
clicks an item in the Favorites control. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets
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Property Description Data Type

MarkupLanguage

Identify the templatemarkup file that controls the display of the server
control. For example, mymarkup.ekml. If the *.ekml file is located in the
same folder as theWeb form containing the server control, just enter its
name. Otherwise, the path to the file can be relative or absolute.

See Also:Controlling Output with EktronMarkup Language on page 26-1

String

MaxResults TheMaximum number of items to fetch. 0 (zero) = unlimited. Integer

Stylesheet

Specify the path to a style sheet for use with the server control. The location
can be relative or absolute. Leave blank to use the default style sheet.

Warning! If you enter a valid EkML file at theMarkupLanguage
property, theStylesheet property is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The default
isFalse.

True—Suppresswrap tags.

False—Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span—The <span> tag is used to designate an inline portion of an HTML
document asa span element.

Div—The <div> tag is used when you want to apply attributes to a blockof
code.

Custom—Allowsyou to use a custom tag.

String

PhotoGallery Server Control
The PhotoGallery server control helps users and community groups track and
manage images. They can organize the images in any number of taxonomy
categories. For example, a user might have the following organization.

n Science

- Biology

- Animals

- Mammals

- Lions

- Bears

Once a user uploads an image to the his Photo Gallery, site visitors can navigate
through its taxonomy and view the image.
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This section also contains the following topics.

Adding Categories 16-53
Editing a Category’s Name 16-54
Deleting a Category 16-55
Adding Photos to a Photo Gallery 16-55
Changing a Photo’s Title or Description 16-57
Moving and Copying Photos 16-58
Deleting a Photo 16-59
Sharing Photos 16-60
Saving a Photo to User’s Local System 16-61
Allowing Community Group Members to Work with Folders 16-62
PhotoGallery Server Control Properties 16-62

To see a Photo Gallery control in a sample site, use the Ektron Tech site >
 My Profile > View My Photo Gallery. To download sample sites, go to
http://www.ektron.com/solutions/startersites/.

Adding Categories
Users can add categories to their photo gallery to help them sort their photos.
They can also use categories to identify the types of users who can view the
photos. For example, one category of photos may be private, while another
may be shared with all of your colleagues.

To add categories, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Photo
Gallery.

2. Click the Manage Folder Button ( ).
3. The Add box appears.

4. Enter a Name for the folder.

5. In the Share area, select with whom you want to share your photos.

Share option Photos can be viewed by..

Public Anyone who can access your profile

Adding Categories

ReferenceManual
Version 8.01 Rev 4

16-53

http://www.ektron.com/solutions/startersites


Share option Photos can be viewed by..

Colleagues Only colleagues (either you accepted their invitation, or theyaccepted
yours)

Selected
Colleagues

Colleagues that you designated as selected. See Also:Designating a
Selected Colleague on page 16-37

Private Only you

6. Click the Add button.

7. When the page refreshes, it opens to the newly added folder.

Editing a Category’s Name
Sometimes, it is necessary to change the name of category. To accomplish this,
follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Photo
Gallery.

2. Click the category’s Edit button ( ). This button is located to the left
of the category’s title.

3. The Edit box appears.

4. Change the name of the category.
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5. Click the Save button.

Deleting a Category
A user can delete obsolete categories in his photo gallery. To delete a category,
follow these steps.

Note: You can not delete the top-level folder, Albums.

Warning! Deleting a category permanently deletes all photos, as well as its subcategories.

1. On the Web site, navigate to a User’s Profile Page > Photo
Gallery.

2. Click the category’s Edit button ( ). This button is located to the left
of the category’s title.

3. The Edit box appears.

4. Click the Delete button.

5. A dialog box appears asking you to confirm.

6. Click OK.

Adding Photos to a Photo Gallery
To add a photo to a photo gallery, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Photo
Gallery.

2. Select a category where the photo will be added. If you want to
create a new category, see Adding Categories on page 16-53

3. Click the Add Photo button ( ).
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Note: If you see the following error at this point, make sure your server’s clock is set to the
correct time.
Error: Object Expected

4. The Add Photo box appears

5. In the Photo Data area, enter a Description and Maximum Width.

6. Click Next.

7. The Add Photo dialog appears. Its appearance varies according to
your browser, as explained in Adding Documents Using the Add
Assets Button on page 7-410.

8. User the Browse or Choose File button to navigate to the photo in
your file system. Or, you may be able to click the Drag Drop tab and
drop a photo in the Add box.
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9. A status box shows the files being uploaded.

10. The page refreshes, and the photo appears in the gallery.

Changing a Photo’s Title or Description
To change a photo’s title or description, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Photo
Gallery.

2. Select the category which contains the photo you want to change.

3. Click the triangle to the right of the photo’s title.

4. From the drop down list, select Edit Properties.
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5. Edit the photo’s Title, Description, or both.

6. Click Save.

Moving and Copying Photos
A user can move a photo from one category to another. In addition, you can
copy photos to another category. To accomplish either of these actions, follow
these steps.

1. On the Web site, navigate to a User’s Profile Page > Photo
Gallery.

2. Select the category from which to move or copy the photo.

3. Click the triangle to the right of the photo’s title.

4. From the drop down list, select Copy.
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5. Select the category to which the photo will be moved.

6. Click the Manage link.

7. Click the Move ( ) or Copy ( ) button.
8. A dialog box asks you to confirm the action.

9. Click OK.

Deleting a Photo
As photos become obsolete or are no longer wanted, users can delete them.
This permanently removes the photo from the user’s photo gallery. To delete a
photo, follow these steps.
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1. On the Web site, navigate to a User’s Profile Page > Photo
Gallery.

2. Select the category which contains the photo you want to delete.

3. Click the triangle to the right of the photo’s title.

4. From the drop down list, select Delete.

5. A dialog box asks you to confirm.

6. Click OK.

Sharing Photos
The Photo Gallery lets users share photos with their colleagues. Users can share
photos with the Public, Colleagues, Selected Colleagues or keep them private.
Users apply sharing options to categories, not individual photos. See Also:
Share option on page 16-53s

To share a category, follow these steps.
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1. On the Web site, navigate to a user’s Profile Page > Photo
Gallery.

2. Click the Manage Folder Button ( ).
3. The Add box appears.

4. Click the Share Folder button ( ).
5. The Share Workspace box appears.

6. Select with whom to share your photos. Share option on page 16-53
describes each choice.

7. Click the Share button.

8. Click the close window button ( ).

Saving a Photo to User’s Local System
Users can save a photo to their computer. This enables the gallery owner to
give the photo to other members of the community.

For example, I add a photo of my child to my photo gallery. My parents can
then save the photo to their computer and either change it, print it, or upload it
to their own photo gallery.

To save a photo to a computer, follow these steps.

1. On the Web site, navigate to a User’s Profile Page > Photo
Gallery.

2. Select the category that contains the photo you want to save.

3. Click the triangle to the right of the photo’s title.
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4. Select Save As... from the drop down list.

5. A dialog asks you to open or save the file.

6. Click Save.

Allowing Community Group Members to
Work with Folders
When you associate this control with a community group, you can allow group
members to add, remove and control the sharing of folders in a workspace.
Because this feature is implemented on a group by group basis, it is controlled
in the Workarea's Edit Community Group screen. See Also: Allowing
Community Group Members to Work with Folders on page 16-87

PhotoGallery Server Control Properties
The PhotoGallery server control properties are described in this table.

Managing User Communities

16-62 ReferenceManual
Version 8.01 Rev 4



Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer
and can use it to browse to Content, Collections,
etc.See Also:Working with Ektron CMS400.NET
Server Controlson page 24-1

String

CacheInterval

Sets the amount of time the server control’s data
is cached. The default is 0 (zero). This is the
amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the
data for fiveminutes, set this property to 300
(three hundred). See Also:Caching with Server
Controlson page 24-33.

Double

DefaultObjectID
The default object ID for this control to use when
there is nomatching dynamicparameter value
passed.

Long

DisplayXslt

Determineshow information is displayed on the
page. Enter the path to the XSL file. It can be
relative or absolute.

Warning! If you specify an external file, it is
strongly recommended that you do not store this
file in your site'sWorkarea folder. If you store this
file in theWorkarea folder, the file will be lost
when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event.
Set to false if you want to postpone the fill-action
until later. In this case, FIll is automatically called
during the Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

DynamicContentBoxHeight The height of the dynamic content box in pixels. Integer

DynamicContentBoxWidth TheWidth of the dynamic content box in pixels. Integer

DynamicContentTemplate The template to use when displaying dynamic
content. Leave blank to use the dynamicbox. String

Dynamic

Parameter

Gets or sets the QueryString parameter to read a
object ID dynamically. To use the default object
ID, leave blank.

String
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Property Description Data Type

EnablePaging

This property, in conjunction with the
MaxResults property, lets site visitors view an
unlimited number of document itemswhile
controlling the amount of screen space. To
accomplish this, the display is limited to the
number set in theMaxResults property.

If you set this property to true, and the number of
itemsexceeds theMaxResults number,
navigation aidsappear below the last item.

Boolean

Hide

Used to hide output of the control in design time
and run time.

True =Hide control

False =Display control

Boolean

IncludeIcon

Choose whether to display iconsnext to the
navigation list’s links.

True =Show icons

False =Hide icons

Boolean

ItemSortOrder

Specify the sort order of results. Choicesare:

taxonomy_item_display_order - the order of
taxonomy itemsas set in theWorkarea. For
additional information, seeChangeOrder of
Content Assigned to a Taxonomy/Categoryon
page 9-241.

content_title - photos listed in alphabetical
order by title

date_created - photos listed in chronological
order bydate created

last_edit_date - photos listed in chronological
order bydate created

To specify the direction of the items, use the
SortDirection property.
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Property Description Data Type

Language
Set a language for viewing the server control.
This property shows results in design-time (in
VisualStudio) and at run-time (in a browser).

Integer

LinkTarget

Determines the type of window that appears on
thisWeb formwhen a user clicks an item in the
dynamic content box. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

String

MarkupLanguage

Identify the templatemarkup file that controls the
display of the server control. For example,
mymarkup.ekml. If the *.ekml file is located in the
same folder as theWeb form containing the
server control, just enter its name. Otherwise, the
path to the file can be relative or absolute. See
Also:Controlling Output with EktronMarkup
Language on page 26-1

String

MaxResults TheMaximum number of items to fetch. 0 (zero)
= unlimited. Integer

ObjectType

The type of object to which this control is
assigned. Choicesare:

User - this control is assigned to an individual.

Group - this control is assigned to a community
group.

String

ShowCount

Indicates if an integer representing the number of
taxonomy items in the category appears next to
each categorywhen displayed on theWeb site.
The default is False.

True - Show taxonomy itemsnumber next to
category.

False - Do not show taxonomy itemsnumber
next to category.

Boolean

SortDirection
Select the direction of theitemSortOrder
property. Choose Ascending or Descending.

String
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Property Description Data Type

Stylesheet

Specify the path to a style sheet for use with the
server control. The location can be relative or
absolute. Leave blank to use the default style
sheet.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, the
Stylesheet property is ignored.

String

TaxonomyCols Enter the number of columns in which this
taxonomy/category appear on the page. Integer

TaxonomyItemCols Enter the number of columns in which the
taxonomy item appear on the page. Integer

WrapTag

Allowsa developer to specify a server control’s
tag. The default isSpan.

Span - The <span> tag is used to designate an
inline portion of an HTML document asa span
element.

Div - The <div> tag is used when you want to
apply attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

Message Board Comments Associated
with Content in the Workarea
Message Board comments can be associated with content. This allows a user
who views the content on the site to add comments about the content.

Note: Message Boards can also be associated with users and groups. See Also:
MessageBoard Server Control on the facing page

Warning! Message Board comments are not the same as the Comments tab on the View Content
screen.

You can view these comments in the Workarea. To do so, follow these steps:

1. Click the Content folder button.

2. Navigate to the content block for which to view messages.

3. Click that content item. The View Content screen appears.

4. Click the View Content Reports button ( ).
5. Click the Messages tab.

6. A list of comments associated with the content appears.
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MessageBoard Server Control
The Message Board server control allows a user to submit comments on a Web
page about a

user

community group

content item

Comments are presented in a “wall” type format, where the newest one
appears at the top, and older comments are pushed down as new ones arrive.
See example below.

Other users can reply to comments. Replying to Message Board comments
facilitates community building by allowing members to share information and,
thereby, feel they have a personal stake in the discussion.

Comments are posted to the Message Board immediately unless the board is
moderated. See Also: Moderating a Message Board on page 16-69

This section also contains the following topics.

Message Board Controls on Sample Sites 16-68
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Authorization to Comment and Reply to a Message Board 16-69
Moderating a Message Board 16-69
Users Who Can Moderate Message Board 16-70
Comments' Appearance on Moderated Message Board 16-70
Approving Comments on a Moderated Message Board 16-71
Deleting Message Board Comments 16-72
Replying to Message Board Comments 16-73
Deleting a Reply 16-75
Message Board Notifications 16-75
Enabling Message Board Notifications 16-75
Filtering Spam 16-75
Spam Filter Usage Examples 16-76
Creating a Custom Spam Filter 16-76
MessageBoard Server Control Properties 16-77

Message Board Controls on Sample Sites
You can find examples of the MessageBoard Server Control in these Ektron
sample sites. You can copy and edit the samples as needed to build your own
pages.

Group Message Board

Ektron Technology site > Community > Community Groups > select a
group > right side, bottom of page

eIntranet Site > My Profile > Groups > select a group > right side, bot-
tom of page

Developer Sample Site > Community > Community Groups

User Message Board

eIntranet Site > Login > My Profile > right side, bottom of page

Ektron Technology site > Login > My Profile > Public Messages tab

Developer Sample Site > Community > User Message Board

Content Message Board

Developer Sample Site > Community > Content Message Board

To download sample sites, go to http://www.ektron.com/solutions/startersites/.
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Authorization to Comment and Reply to a
Message Board
If Message Board Associated with These users can add comments or replies

User

n the logged-in user

n his colleagues

n users assigned toMessage Board Admin role See Also:
Defining Roleson page 15-31

n Administrators groupmember

Group

n groupmembers

n users assigned to CommunityGroup Admin role See Also:
Defining Roleson page 15-31

n Administrators groupmember

Content item
n anyone who can view the content

For example, if a content item is set to private, a user must have at
least Read-Only permission for the folder containing the content.

Moderating a Message Board
A Message Board can be moderated, which means that comments and replies
must be approved by an authorized user before they appear. Those users can
either approve or delete the comment/reply. To learn which users are
authorized to moderate, see MessageBoard Server Control on page 16-67.

You can force all message boards associated with a MessageBoard control to
moderate comments/replies. To do this, set the Moderate property to True.
On the other hand, you can allow the users and community group
administrators who own a Message Board to decide if it will be moderated. To
do this, set the control’s Moderate property to False. Then, users and
community group administrators can set this property in their user or group
profile.

Users determine whether their Message Board is moderated by checking their
profile’s Moderate check box (see below).
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Community group members determine if the group's Message Board is
moderated by editing the Group Profile's Moderate: MessageBoard check
box.

Note: If a Group administrator submits a comment to a moderated Group Message Board, it is
automatically approved.

This topic is explained more fully through these subtopics.

Users Who Can Moderate Message Board below

Comments' Appearance on Moderated Message Board below

Approving Comments on a Moderated Message Board on the facing
page

Deleting Message Board Comments on page 16-72

Users Who Can Moderate Message Board

User Can perform these actions on a comment/reply

Who submitted comment
n view

n delete

Individual or groupmember who ownsMessage
Board to which comment/replywasadded

n view

n approve pending comments/replies

n delete

n community group administrator

n assignedMessage Board Admin role

n view

n approve pending comments/replies

n delete

If Message Board assigned to a content item,
administrators or userswith Message Board Admin
role

n view

n approve pending comments/replies

n delete

Comments' Appearance on Moderated Message
Board
If a comment is submitted to a moderated Message Board, users who can see it
notice a green dot border, as shown below. The user who submitted the

comment sees an hour glass icon ( ) until it’s approved. At any time, he can
delete the comment using the delete button ( ).

Managing User Communities

16-70 ReferenceManual
Version 8.01 Rev 4



Approving Comments on a Moderated Message
Board
There are two ways to approve comments for a moderated message board:

n Approving Comments from the Message Board Server Control below

n Approving Comments from the Ektron CMS400.NET Workarea on
next page

Approving Comments from the Message Board Server
Control
On a moderated message board, approval activity appears on the Approve tab
(circled below).

To approve a single Message Board comment, an authorized user clicks the
approval button ( ).

To delete a single comment, he clicks the delete button ( ).

An authorized user any can approve several or all comments at once. To select
several comments, place a check next to each, then click the Approve button
(circled below).

To select all comments, click Select: All, then click the Approve button.
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Approving Comments from the Ektron CMS400.NET
Workarea

1. Navigate to Settings > Community Management > Message
Board.

2. A list of all unapproved comments appears. You can restrict the list
using the dropdown shown below.

3. Place a check next to comments you want to approve.

To select all comments, check the box next to Messages in the header
row, as shown below.

4. Click the Approve button ( ).

Deleting Message Board Comments
There are two ways to delete comments for a moderated message board:

n Deleting Comments from Message Board Server Control on the facing
page
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n Deleting Unapproved Comments from Workarea below(unapproved
comments only)

Deleting Comments from Message Board Server Control
To delete unapproved comments from the Message Board Server Control,
follow these steps.

1. Find the comment.

2. Click the Delete button in the lower right corner.

Deleting Unapproved Comments from Workarea
To delete unapproved comments from the Workarea, follow these steps.

1. Navigate to Settings > Community Management > Message
Board.

2. A list of all unapproved comments appears. You can restrict the list
using the dropdown shown below.

3. Select the comments that you want to delete. To select all comments,
check the box next to Messages in the header row, as shown below.

4. Click the Delete button ( ).

Replying to Message Board Comments
Users can reply to comments on a user’s, community group’s, or content item’s
Message Board. For community groups, the group must be public and not
restricted; otherwise, only group members can reply.

Deleting Comments fromMessage Board Server
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Note: To learn which users are eligible to reply to Message Board comments, see
Authorization to Comment and Reply to a Message Board on page 16-69

To add a reply, click the Reply button ( ) in a comment’s lower right corner
(circled below).

Next, a dialog box displays the original comment and a Reply field.

When the reply is submitted, a Replies link appears below the comment. The
number of replies appears next to the link.

Click the link to view comments. They are arranged from oldest at top to
newest at bottom.
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Like comments, if the message board is moderated, replies must be approved
before everyone can see them. See Also: Moderating a Message Board on page
16-69

Deleting a Reply
To remove a reply, click the Delete button ( ).

Note: To learn which users are eligible to delete Message Board comments, see Users Who
Can Moderate Message Board on page 16-70

Message Board Notifications
You can send email notifications to Message Board owners and community
group members whenever someone posts a comment to a board. If a comment
is posted to a community group’s Message Board, all group members are
notified.

Important: Users' profiles must include a valid email address to receive email notifications.

Enabling Message Board Notifications
You can turn this feature on or off in the <site root>/Web.config file. By
default, the feature is turned off. To turn it on, open the Web.config file and set
the following key’s value to True.

<add key="ek_EnableMessageBoardEmail" value= "False"/>

Note: Message Board notifications are sent from the same email address as the invite system.

Once activated, this feature applies to all user and community group message
boards.

Filtering Spam
Ektron CMS400.NET lets you filter spam from your message boards. Ektron
defines spam filtering as setting the following limits.
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Limitation
To set, select this value in MessageBoard
server control’s SpamControlType property

User cannot post the same comment to a board
more than once per day SameUserSameMessageSameDay

User cannot post another comment for a period of
time, specified in the SpamTimeSpanproperty. SameUserTimeDelay

User cannot post the same comment for a period of
time, specified in the SpamTimeSpanproperty. SameMessageTimeDelay

You can also define custom spam filters. See Creating a Custom Spam Filter
below.

Spam Filter Usage Examples
The table below provides examples of setting up the control to filter spam.

As a developer I want to...
So I set the SpamControlType
property to...

And I set the
SpamTimeSpan
property to …

Prevent a user from posting
the same commentmore than
once a day

SameUserSameMessageSameDay

Prevent a user from posting
anyother comment for 30
minutes

SameUserTimeDelay 1800

Prevent a user from posting
identical comments for 2
hours

SameMessageTimeDelay 7200

Usemyown spam filter code
Customand add the code to the code
behind page of the template containing the
MessageBoard server control.

Creating a Custom Spam Filter
You can create your own spam filter in the codebehind of the page that hosts the
Message Board. To do this, set the SpamControlType property to Custom, call
the CustomSpamMethod in the page load event, and point it to your custom
spam filter method. Your method’s signature must include the following
parameters:

n long objectId - the numeric ID of the object defined in the object type
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n Ektron.Cms.Common.EkEnumeration.MessageBoardObjectType objectType - the type
of object with which the Message Board is associated. See Also: on
page 16-79

n long userId - The numeric ID of a user. For example, you want to
block a user with the ID 18 from posting to the board.

n string messageText - a string of text you want to block

n int interval - the amount of time, in seconds, to block posting on the
Message Board. For example, if you want to block a user from
posting for 30 minutes, set this property to 900.

Below is a C# example that blocks the text Hello World.

using System;
using System.Data;
using System.Configuration;
using System.Collections;
using System.Web;
using System.Web.Security;
using System.Web.UI;
using System.Web.UI.WebControls;
using System.Web.UI.WebControls.WebParts;
using System.Web.UI.HtmlControls;
public partial class WebformCB : System.Web.UI.Page

{
protected void Page_Load(object sender, EventArgs e)

{
this.MessageBoard1.CustomSpamMethod(SpamControl);

}
private bool SpamControl(long objectId, Ektron.Cms.Common.EkEnu-
meration.MessageBoardObjectType objectType, long userId, string messageText,
int interval)

{
if (messageText == "Hello World")

{
return true;

}
return false;

}
}

MessageBoard Server Control Properties
The MessageBoard server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Description
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Using CMSExplorer
to Browse Your Ektron CMS400.NET Site on page 24-8

String

CacheInterval

Sets the amount of time the server control’s data is cached. The
default is 0 (zero). This is the amount of time, in seconds, a control’s
data is cached. For example, if you want to cache the data for five
minutes, set this property to 300 (three hundred).

See Also:Caching with Server Controlson page 24-33

Double

CommentBoxLocation

Defines the location of the comment box. Bydefault, bottom is
selected. Choicesare:

Bottom= comment boxappears below the comments

Top = comment boxappears above the comments

Data Type: EkEnumeration.MessageBoardCommentBoxLocation

DefaultObjectID The default object ID for this control to use when there is nomatching
dynamicparameter value passed. Long

DisplayXslt

Determineshow information is displayed on the page. Enter the path
to the XSL file. It can be relative or absolute.

Warning! If you specify an external file, it is strongly recommended
that you do not store this file in your site'sWorkarea folder. If you
store this file in theWorkarea folder, the file will be lost when you
upgrade.

Warning! If you enter a valid EkML file at theMarkupLanguage
property, theDisplayXslt property value is ignored.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes shown.

Boolean

DynamicObjectParameter Gets or sets the QueryString parameter to read a object ID
dynamically. To use the default object ID, leave blank. String

EnablePaging

This property, in conjunction with theMaxResults property, lets
site visitors view an unlimited number of document itemswhile
controlling the amount of screen space. To accomplish this, the
display is limited to the number set in theMaxResults property.

If you set this property to true, and the number of itemsexceeds the
MaxResults number, navigation aidsappear below the last item.

Boolean
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Property Description
Data
Type

Hide

Used to hide output of the control in design time and run time.

True =Hide control

False =Display control

Boolean

Language
Set a language for viewing the server control. This property shows
results in design-time (in VisualStudio) and at run-time (in a
browser).

Integer

MarkupLanguage

Identify the templatemarkup file that controls the display of the
server control. For example, mymarkup.ekml. If the *.ekml file is
located in the same folder as theWeb form containing the server
control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See Also:Controlling Output with EktronMarkup
Language on page 26-1

String

MaxResults Themaximum number of items to fetch. 0 (zero) = unlimited. Integer

Moderate

Set to True to forcemoderation of theMessage Board. If set to
false, moderation is controlled by the user or community group with
which theMessage Board is associated. See Also:Moderating a
Message Board on page 16-69

Boolean

ObjectType

The type of object to which theMessage Board is assigned. Choices
are:

Content - a content item

User - an individual

CommunityGroup - a community group

Data Type: EkEnumeration.MessageBoardObjectType

ProfileParamName

The parameter name to pass in the QueryString to the
TemplateUserProfile page, if you want it to be anything other than id.

For example, youmayprefer userid, because it ismore descriptive,
as shown in the following example.

String

ShowMaxCharacter
Themaximum number of characters to display in the comment.

If the number of characters in a comment exceeds this, a... more >>
link appears. Users click the link to see the full text.

Integer
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Property Description
Data
Type

SpamControlType

Assignsa spam filter to theMessage Board. Ektron CMS400.NET
provides three spam filters, and the ability to define your own.

Note: Note: Spam control is turned off by default.

Filter choicesare:

SameUserMessageDay - a user cannot post the same comment to
a boardmore than once per day

SameUserTimeDelay - prevents user from posting another
comment for period of time, specified in theSpamTimeSpan
property.

SameMessageTimeDelay - prevents user from posting an identical
comment for a period of time, specified in theSpamTimeSpan
property.

Custom - Message Board uses your custom spam filter code. See
Creating a CustomSpamFilter on page 16-76

See Also: Filtering Spam on page 16-75

Data Type: EkEnumeration.MessageBoardSpamControlType

SpamTimeSpan

The number of seconds for which the SameUserTimeDelayor
SameMessageTimeDelayspam filters delaya user from posting a
second time.

See Also: Filtering Spam on page 16-75

Integer

Stylesheet

Specify the path to a style sheet for use with the server control. The
location can be relative or absolute. Leave blank to use the default
style sheet.

Warning! If you enter a valid EkML file at theMarkupLanguage
property, theStylesheet property is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Description
Data
Type

TemplateUserProfile

The URL path to a page that contains a UserProfile server control.
The path can be relative or absolute.

If you enter a path, a user can click anyuser’s name or avatar from
theMessage Board server control and be forwarded to his profile
page. See illustration below.

Note that user templates can be defined in the Ektron CMS400.NET
Workarea > Settings > Community Management > Templates
screen.

However, if you assign a template in this field, this setting takes
precedence over the setting on theWorkarea Template screen.

String

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span—The <span> tag is used to designate an inline portion of an
HTML document asa span element.

Div—The <div> tag is used when you want to apply attributes to a
blockof code.

Custom—Allowsyou to use a custom tag.

String

Calendars for Community Users and
Groups
Ektron's Web Calendar provides the same function as a paper calendar - it
keeps visitors informed about upcoming events. Combined with the powerful
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community features of the Ektron CMS400.NET platform, the calendar enhances
communication between individuals and groups.

Communities calendars events could include

n personal vacations

n special personal occasions

n group milestones

n group meetings

The following example shows a calendar on a personal profile page.

To use this feature, each group must add Calendar into the database before
events can be added. To do this, see Adding a WebCalendar ServerControl to a
User Profile on page 7-557 or Creating the User Calendar in the Database on
page 7-557.

For more information about using Web calendars with Ektron CMS400.NET's
Community Features, see Using Community Web Calendars on page 7-555.

Discussion Boards for Community
Groups
Using the Ektron CMS400.NET discussion board feature within a community
group provides web-based discussions targeted to topics of interest to a
community group.

Types of topics that a group may discuss include

n project requirements
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n scope and scheduling

n team issues

n frequently asked questions

The following example shows a discussion board on a community group page.

To use this feature, each group must add the Discussion Board for their group
into the database before posts can be added. To do this, see Creating a
Community Discussion Board in the Database on page 7-638.

For more information about using the Discussion Board feature, see Discussion
Boards on page 7-576.

Community Groups
Warning! Membership User Groups and Community Groups are different concepts. Membership
User Groups allow an administrator to create a group of membership users, thereby reducing the
effort required to assign identical permissions to many users. See Membership User Groups on
page 16-11. Community Groups are explained below.

Community groups are another aspect of a community sites. Being a part of a
group allows members to meet people with similar interests, for example, car
racing.

Groups have features and functions similar to users. A community group can
have a Message Board, Discussion Board, maintain a membership list, and
keep a group journal. You can manage community groups from the Web site or
the Workarea.

You can assign a taxonomy category to community groups. This lets users
browse and search for groups by category.

In addition, you can also assign Tags to a community group. This allows users
to find the group when searching by tag name.

This section also contains the following topics.

Community Groups in the Workarea 16-84
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Managing Community Groups 16-84
Adding a Community Group 16-85
Allowing Community Group Members to Work with Folders 16-87
Viewing a Community Group’s Details 16-87
Editing a Community Group’s Information 16-88
Assigning Tags to a Community Group 16-88
Viewing Members of a Community Group 16-89
Adding Members to a Community Group 16-89
Accepting/Declining Requests to Join a Community Group 16-90
Removing Members from a Community Group 16-91
Deleting a Community Group 16-92
Searching for a Community Group 16-92

Community Groups in the Workarea
You can access community group information in the following areas of the
Workarea:

n My Workspace > Community Groups - displays groups to which
you belong; also lets you remove yourself from them.

n Workarea > Settings > Community Management >
Community Groups - displays all groups. You can define a group’s
details or add and remove members from the group when you are:

- a Group’s Leader (Group’s Administrator)

- a Ektron CMS400.NET Administrator

- a Ektron CMS400.NET User or Membership user with the Community
Group Admin or Community Group Create role

Managing Community Groups
To view a list of all community groups in the Workarea, click the Settings >
Community Management > Community Groups. From this screen, the
following actions and information are available.

n Information

- Group name

- Number of members

- Language

- ID

- Whether membership is open to the public or restricted

- Short description

- Location

Managing User Communities

16-84 ReferenceManual
Version 8.01 Rev 4



n Actions

- Adding a Community Group below

- Viewing a Community Group’s Details on page 16-87

- Editing a Community Group’s Information on page 16-88

- Assigning Tags to a Community Group on page 16-88

- Viewing Members of a Community Group on page 16-89

- Adding Members to a Community Group on page 16-89

- Accepting/Declining Requests to Join a Community Group on page 16-
90

- Removing Members from a Community Group on page 16-91

- Deleting a Community Group on page 16-92

- Searching for a Community Group on page 16-92

Adding a Community Group
Administrators or Ektron CMS400.NET users with the Community Group
Administrator role can add a new community group in the Workarea. After you
create a group, you can add members to it. See Also: Adding Members to a
Community Group on page 16-89 and Community Groups on page 16-83

Note: The CommunityGroupBrowser server control also has a Create Group link, which lets
you create a community group from the Web site. See Also: CommunityGroupBrowser Server
Control on page 16-96

To add a new community group, follow these steps.

1. Click Settings > Community Management > Community
Groups.

2. Click the Add New Community Group button ( ).
3. The Add Community Group screen appears.

4. Use the table below to complete the screen.

Field Description

Properties Tab

Group Name The name of the group.
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Field Description

Administrator

A group administrator hasprivileges to delete a group or edit its properties.

Note: Membersof the Administrators group and users assigned to the
CommunityGroup Admin role also have these privileges.

Bydefault, the person who created the group is the group administrator. Click
theBrowse button to change the administrator.

Membership

Select whether the group is

n Open - anyone can join

n Restricted - only invitedmembers can join

See Also:Accepting/Declining Requests to Join a CommunityGroup on page
16-90

Note that restricted groups can be found in the sameway that appear with
open groups can. Also, their activities are published asnotifications. For
example, Tom posted a reply to the forum topic titled
'RoboTech Acquisition'.

So, do not create a group or publish activities that you want to keep secret.

Image

Upload an image to use asan avatar for the group. Here is an example of
how a group image is used.

Location The geographical location of the group.

Short Description A brief description of the group.

Description A fully detailed description of the group.

Enable Distribute
Check this box if you want the group and system administrator to be able to
distribute content to anyEktron CMS400.NET folder. See Also:Distributing
Content to Another Ektron CMS400.NET Folder on page 16-115
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Field Description

Allow member tomanage
photo/workspace folders

Checking this boxallowsmembers to add, remove and control the sharing of
folders in a community group’sPhoto Gallery or Document’sWorkspace. See
Also:Allowing CommunityGroupMembers toWorkwith Foldersbelow.

Tags Tab

Group Tags
From this screen, you can either create a new tag or select from a default list
of community group tags. See Also:Assigning Tags to a CommunityGroup
on next page.

Categories Tab

Category List

The categories tab lists all of the categories associated with the community
group.

Note: If you have not defined at least one taxonomy for community
groups, this tab doesnot appear.** See Also:Creating a Taxonomyon
page 9-204.

5. Click the Save button ( ).

Allowing Community Group Members to Work with
Folders
When you associate the CommunityDocuments or PhotoGallery server control
with a community group, you can allow members of the group to add, remove,
and control the sharing of folders in these controls. To allow a member to work
with Photo Gallery and Workspace folders, follow these steps.

1. In the Workarea, navigate to Settings > Community Management
> Community Groups.

2. Click a community group.

3. Click the Edit button ( ).
4. Place a check mark in the Allow member to manage

photo/workspace folders check box.

5. Click the Save button ( ).

Viewing a Community Group’s Details
Any user with access to the Workarea can view a group’s details. However,
they cannot see the members of the group.

If a user is the Group Leader (Group’s Administrator), an Administrator, or
Ektron CMS400.NET User with the Community Group Administrator role, he can
edit the group’s information, add and remove members, or delete the group.

To view a group’s details, follow these steps.
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1. Click Settings > Community Management > Community
Groups.

2. Click the Group Name link.

3. The group’s detailed information appears.

Editing a Community Group’s Information
Editing a group’s information allows you change certain details about the group.
Only the Group Leader (Group’s Administrator), Administrators, Ektron
CMS400.NET Users with the Community Group Admin, or Community Group
Create role can edit a group’s information.

To edit a group’s details, follow these steps:

1. Click Settings > Community Management > Community
Groups.

2. Click the Group Name link.

3. Click the Edit button ( ).
4. Change any fields as needed. These fields are described in Adding a

Community Group on page 16-85Adding a Community Group on page
16-85.

5. Click the Save button ( ).

Assigning Tags to a Community Group
On the Web site, Tag information for a group appears in the Group’s profile. In
the Workarea, Tag information is on the View Community Group’s > Tag tab.
From this tab, you can either create a new tag or select from a list of group
tags.

See Also: Tags on page 16-271

Creating New Tags for a Community Group
To create a new tag for a community group, follow these steps.

1. In the Workarea, navigate to the Settings >Community
Management > Community Group.

2. Click the community group for which to create a new tag.

3. Click the Edit button ( ).
4. Click the Tags tab.

5. Click the Add Tag button.

6. Add a tag to the Name text box.

7. Select a language.

8. Click the Save button ( ).
Once the Tag is saved, it appears in the Group Tags area with a check mark in
the check box, which means the tag is active for the community group.
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Adding a Default Tag to a Community Group
To add a default tag to a community group, follow these steps.

1. In the Workarea, navigate to the Settings > Community
Management > Community Group.

2. Click the community group for which to create a new tag.

3. Click the Edit button ( ).
4. Click the Tags tab.

5. Place a check mark in the tag’s check box that you want to use.

6. Click the Save button ( ).

Viewing Members of a Community Group
Only the Group Leader (Group’s Administrator), Administrators or Ektron
CMS400.NET Users with the Community Group Administrator role can view
members of the group. In addition to viewing community group members, you
can see add and remove members. You can also accept or decline members’
requests to join the group if the group’s membership is set to Restricted.

See Also:

n Adding Members to a Community Group below

n Removing Members from a Community Group on page 16-91

n Accepting/Declining Requests to Join a Community Group on next
page

n Community Groups on page 16-83

To view members of a community group, follow these steps:

1. Click Settings > Community Management > Community
Groups.

2. Click the Group Name link.

3. Click the View Community Group Members button ( ).
4. A list of group members appears.

Adding Members to a Community Group
Only the Group Leader (Group’s Administrator), Administrators or Ektron
CMS400.NET Users with the Community Group Administrator role can add
members to a group.

See Also: Community Groups on page 16-83

To add members to a group, follow these steps:

1. Click Settings > Community Management > Community
Groups.
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2. Click the Group Name link.

3. Click the View Community Group Members button ( ).
4. The View Community Group Members for the group screen appears.

5. Click the Add User(s) button ( ).
6. The Add Members screen appears.

7. Using the drop down box, select the type of name for which to search.

8. Enter a name in the text box.

9. Click the Search button.

Note: If you leave the text box blank and click the Search button, all results for the name type
are returned.

10. The results are returned.

11. Place a check mark in the box next to each member to add.

12. Click the Add button ( ).
13. The View Community Group Members screen appears with all

members of the group.

Accepting/Declining Requests to Join a
Community Group
If a group’s membership is set to Restricted (on the Community Group
screen), users must request to join the group. (If membership is Open, users
join a group immediately.)

In the Workarea, use the Pending tab on the View Community Group Members
screen to accept or decline a user’s request to join a group.

Only a Group Administrator, Ektron CMS400.NETAdministrator, or Ektron
CMS400.NET users with the Community Group Administrator role can do this.
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Note: In the eIntranet, on the groups page, a special tab flags users who have requested to
join a group. The administrator can click the plus sign in the top left corner to let the user join.

To accept or decline a member's request to join a group in the Workarea, follow
these steps.

1. From the Ektron CMS400.NET Workarea, go to Settings >
Community Management > Community Groups.

2. Click the group for which you want to accept or decline requests to
join.

3. Click the View Community Group Members button ( ).
4. Click the Pending tab.

5. Check the box next to each member whose request you want to
approve or decline.

To approve the request, click the approve button ( ).
To decline the request, click the decline button ( ).

Removing Members from a Community Group
Only the Group Leader (Group’s Administrator), Administrators, or Ektron
CMS400.NET Users with the Community Group Administrator role can remove
members from a group.

To remove members from a group, follow these steps.

1. Click Settings > Community Management > Community
Groups.

2. Click the Group Name link.

3. Click the View Community Group Members button ( ).
4. The View Community Group Members for the group screen appears.

5. Place a check mark in the box next to members you want to remove.

6. Click the Remove button ( ).

7. A dialog box asks you to confirm the removal.

8. Click OK.

RemovingMembers from aCommunity Group
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Deleting a Community Group
Only the Group Administrator, Ektron CMS400.NETAdministrators, or Ektron
CMS400.NET Users with the Community Group Administrator role can delete a
group.

To remove a community group, follow these steps:

1. Click Settings > Community Management > Community
Groups.

2. Click the Group Name link.

3. Click the Delete button ( ).

4. A dialog box asks you to confirm the deletion.

5. Click OK.

Searching for a Community Group
You can search for a Community Group in the Workarea by using the Search
box on the View All Community Groups page (circled below).

To search for Community Groups, click Settings > Community Management
> Community Groups. Enter text in the search box and click <Enter>.
Community Groups that match the search term appear.

Community Group Server Controls
n CommunityGroupProfile Server Control below

n CommunityGroupBrowser Server Control on page 16-96

n CommunityGroupMembers Server Control on page 16-106

n CommunityGroupList Server Control on page 16-101

CommunityGroupProfile Server Control
The CommunityGroupProfile server control displays the profile of a community
group. The profile includes:

n an image associated with the group

n a description of the group
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n tags assigned to the group

n whether the group is Public or Restricted

n the date the group was founded

n location information

n members in the group

n the group’s administrator

n an Edit link that lets you update profile information and group
settings

You can see an example of the CommunityGroupProfile Server Control in the
Ektron Tech site > Community > Community Groups > select any group.

URL Aliases for Community Groups
To automatically create a friendly URL for a UserProfile, you can use
Community Aliasing for Users. Community URL Aliasing on page 10-41for more
information.
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CommunityGroupProfile Server Control Properties
The CommunityGroupProfile server control properties are described in this
table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can use
it to browse to Content, Collections, etc. See Also:Using CMS
Explorer to Browse Your Ektron CMS400.NET Site on page
24-8

String

DefaultGroupID The default community group ID for this control to use when
there is nomatching dynamicparameter value passed. Long

DisplayXslt

Determineshow information is displayed on the page. Enter
the path to the XSL file. It can be relative or absolute.

Warning! If you specify an external file, it is strongly
recommended that you do not store this file in your site's
Workarea folder. If you store this file in theWorkarea folder,
the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theDisplayXslt property
value is ignored.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false
if you want to postpone the fill-action until later. In this case, FIll
is automatically called during the Page Render event.

Youmight do this if you need to set or change a property on
the control in codebehind and have it render with your
changes shown.

Boolean

DynamicParameter
Gets or sets the QueryString parameter to read a community
group ID dynamically. To use the default community group ID,
leave blank.

String

GroupAdminLink

Add a link to the administrator’s profile page. This allowsa
user to click a link in the profile area of the community group
page and be directed to the administrator’s profile page. Two
variables in the link identify the administrator.

{0} - represents the administrator’s ID

{1} - represents the administrator’s name

Both variablesmust be in the link. TheWeb form can be
relative or absolute. Below is an example.

adminprofilepage.aspx?aid={0}&an={1}

String
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Property Description Data Type

GroupAdminLinkTarget

Determines the type of window that appears on thisWeb form
when a user clicks the Admin’s display name link. The default is
_self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

Hide

Used to hide output of the control in design time and run time.

True =Hide control

False =Display control

Boolean

Language
Set a language for viewing the CommunityGroupProfile
control. This property shows results in design-time (in Visual
Studio) and at run-time (in a browser).

Integer

Stylesheet

Specify the path to a style sheet for use with the server control.
The location can be relative or absolute. Leave blank to use
the default style sheet.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theStylesheet property
is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.
The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Description Data Type

TagTemplate

Add a path to another Web form to create links for the tag text.
This path can be relative or absolute. Byproviding the path to
CommunitySearch server control, a user viewing the profile
can click a tag and search for other groupswith the same tag.

Five parameters, which are automatically added to the link’s
QueryString, let you pass information about the tag.

n searchgrptag - the tag’s text for community groups

n TagId - the tag’s ID

n TagLanguage - the tag’s language

n TagCount - the tag’s count. That is, the number of timesa
tag hasbeen used.

n TagType - the tag’s type:

- user

- community group

You can also add your own parameters bydefining them in the
path. If you do, these parameterswill be appended to yours.

Linking Tag Cloud Itemson page 16-281Linking Tag Cloud
Itemson page 16-281

String

TagTemplateTarget

Determines the type of window that appears on thisWeb form
when a user clicks an item in the dynamic content box. The
default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

WrapTag

Allowsa developer to specify a server control’s tag. The
default isSpan.

Span - The <span> tag is used to designate an inline portion
of an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes
to a blockof code.

Custom - Allowsyou to use a custom tag.

String

CommunityGroupBrowser Server Control
The CommunityGroupBrowser server control allows a user to browse a
taxonomy structure for community groups. As the user browses, community
groups at each level appear in a results box.

In addition, a user can click the Create Group link to create a new group.
When the group is created, it is automatically added to the taxonomy you are
viewing.
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CommunityGroupBrowser Server Control
Properties
The CommunityGroupBrowser server control properties are described in this
table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and
can use it to browse to Content, Collections, etc. See
Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

String

AvatarHeight The displayheight of the avatar in the results box. Integer

AvatarWidth The displaywidth of the avatar in the results box. Integer
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Property Description Data Type

CacheInterval

Sets the amount of time the server control’s data is
cached. The default is 0 (zero). This is the amount of
time, in seconds, a control’s data is cached. For
example, if you want to cache the data for fiveminutes,
set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Double

DisplayXslt

Determineshow information is displayed on the page.
Enter the path to the XSL file. It can be relative or
absolute.

Warning! If you specify an external file, it is strongly
recommended that you do not store this file in your
site'sWorkarea folder. If you store this file in the
Workarea folder, the file will be lost when you
upgrade.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theDisplayXslt
property value is ignored.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set
to false if you want to postpone the fill-action until later.
In this case, FIll is automatically called during the Page
Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

Hide

Used to hide output of the control in design time and
run time.

True =Hide control

False =Display control

Boolean

Language

Set a language for viewing the
CommunityGroupBrowser control. This property
shows results in design-time (in VisualStudio) and at
run-time (in a browser).

Integer

Link

Add a link to the group’s profile page. This allowsa
user to click a link in the community group list and be
taken to the group’s profile page. There are two
variablesused within the link that represent the group
ID and the group name.

{0} - represents the group’s ID.

{1} - represents the group’s name.

You need to have both variables in the link. TheWeb
form can be relative or absolute. Below is an example.

groupprofilepage.aspx?gid={0}&gn={1}

String
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Property Description Data Type

LinkTarget

Determines the type of window that appears on this
Web formwhen a user clicks an item in the dynamic
content box. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the
display of the server control. For example,
mymarkup.ekml. If the *.ekml file is located in the same
folder as theWeb form containing the server control,
just enter its name. Otherwise, the path to the file can
be relative or absolute.
See Also:Controlling Output with EktronMarkup
Language on page 26-1

String

MaxResults TheMaximum number of items to fetch. 0 (zero) =
unlimited. Integer

Stylesheet

Specify the path to a style sheet for use with the
Documents server control. The location can be relative
or absolute. Leave blank to use the default style sheet.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theStylesheet
property is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the
control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

CommunityGroupBrowser Server Control
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Property Description Data Type

TagTemplate

Add a path to another Web form to create links for the
tag text. This path can be relative or absolute. By
providing the path to CommunitySearch server
control, a user viewing the list of groups can click a tag
and search for other groupswith the same tag.

There are five parameters that are automatically
added to the link’sQueryString that allow you to pass
information about tag.

n searchgrptag - represent the tag’s text for
community groups.

n TagId - represents the tag’s ID.

n TagLanguage - represents the tag’s language.

n TagCount - represents the tag’s count. The tag’s
count is the amount of timesa tag hasbeen used.

n TagType - represents the tag’s type. The tag’s
type will be user or community group.

In addition to these parameters, you can add your own
bydefining them in the path.When you do, these
parameterswill be appended to your parameters.

See Also: Linking Tag Cloud Itemson page 16-281

String

TagTemplateTarget

Determines the type of window that appears on this
Web formwhen a user clicks an item in the dynamic
content box. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

String

TaxonomyId

Enter the ID number of the taxonomyor category to
appear in this server control. If you don’t know the
number, click the button and navigate to the taxonomy
or category.

When you select one, it appears in the center of the
VisualStudio window.

Long

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline
portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply
attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String
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CommunityGroupList Server Control
The CommunityGroupList server control, part of Ektron's Community Platform,
displays a list of community groups. It can be configured to sort groups by
name, newest, or most popular.

When associated with a user, this control can show

n community groups with which a user is associated

n community groups the user has been invited to join

n any community groups for which the user's request to join is pending

CommunityGroupList server control displays the following information about
each community group.

Field Description

Community
Group Avatar An image representing the group.

Community
Group Name The name of a community group.

Type Whether the community group isPublic or Restricted. See Also:Accepting/Declining
Requests to Join a CommunityGroup on page 16-90

Short
Description

The community group’s description, asentered in the Short Description field of the
group’s properties.

Tags Any tagsassociated with the community group. See Also:Assigning Tags to a Community
Group on page 16-88

CommunityGroupList Server Control
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Field Description

Founded When the community group wascreated.

Members The number of users in the community group.

CommunityGroupList Server Control Properties
The CommunityGroupList server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

AllowGroupCreation

If the user haspermission to create community groups
and this property is set to True, the Create Groups link
appears in the control.

True =Create Group link appears on the control.

False =Create Group link is hidden on the control.

Boolean

Authenticated

Indicates if you are logged in to the CMSExplorer and
can use it to browse to Content, Collections, etc. See
Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

String

AvatarHeight The displayheight (in pixels) of the avatar in the results
box. Integer

AvatarWidth The displaywidth (in pixels) of the avatar in the results
box. Integer

CacheInterval

Sets the amount of time the server control’s data is
cached. The default is 0 (zero). This is the amount of
time, in seconds, a control’s data is cached. For
example, if you want to cache the data for fiveminutes,
set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Double

DefaultUserID The default User ID for this control to use if no
matching dynamicparameter value is passed. Long
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Property Description Data Type

DisplayMode

Select the way this control initially displays community
group information. Choicesare:

n Newest - newly added community groups.

n MostPopular - community groupswith themost
members.

n Name - community groups sorted alphabetically by
name

n MyGroups - community groups to which the
logged-in user belongs

n MyPendingGroups - community groups to which
the logged-in user hasasked to join, but hasnot yet
been accepted

eDisplayMode

DisplayXslt

Determineshow information is displayed on the page.
Enter the path to the XSL file. It can be relative or
absolute.

Warning! If you specify an external file, it is strongly
recommended that you do not store this file in your
site'sWorkarea folder. If you store this file in the
Workarea folder, the file will be lost when you
upgrade.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theDisplayXslt
property value is ignored.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set
to false if you want to postpone the fill-action until later.
In this case, FIll is automatically called during the Page
Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

DynamicUserParameter Gets or sets the QueryString parameter to read a user
ID dynamically. To use the default user ID, leave blank. String

Hide

Used to hide output of the control in design time and
run time.

True =Hide control

False =Display control

Boolean

Language

Set a language for viewing the CommunityGroupList
control. Thelanguage property shows results in
design-time (in VisualStudio) and at run-time (in a
browser).

Integer

CommunityGroupList Server Control Properties

ReferenceManual
Version 8.01 Rev 4

16-103



Property Description Data Type

Link

Add a link to the group’s profile page. This allowsa
user to click a link in the community group list and be
taken to the group’s profile page. The link includes
these two variables.

{0} - represents the group’s ID.

{1} - represents the group’s name.

The link requiresboth variables. TheWeb form can be
relative or absolute. Below is an example.

groupprofilepage.aspx?gid={0}&gn={1}

String

LinkTarget

Determines the type of window that appearswhen a
user clicks an item in the CommunityGroupList control.
The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

MarkupLanguage

Identify the templatemarkup file that controls the
display of the server control. For example,
mymarkup.ekml. If the *.ekml file is located in the same
folder as theWeb form containing the server control,
just enter its name. Otherwise, the path to the file can
be relative or absolute. See Also:Controlling Output
with EktronMarkup Language on page 26-1

String

MaxResults TheMaximum number of items to fetch. 0 (zero) =
unlimited. Integer

ShowMySortingOptions

If this control is associated with a user and this property
is set to True, the controls displays the following sorting
options:

MyGroups - a list of community groups to which the
user belongs.

Group Requests - a list of community groups to which
a user has requested to join, but has yet to be
accepted.

Group Invitations - a list of community group that the
user hasbeen invited to join, but has yet to accept.

When set to False, Leave Selected Group is the only
option that appears.

Note: Depending on how the DisplayMode

property is set, youmaysee additional sorting
options.

Boolean
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Property Description Data Type

ShowSortingOptions

If this control is used to display a general list of
community groupsand this property is set to True, the
following sorting optionsappear.

Newest - recently added community groups

Most Popular - community groupswith themost
members.

Group Name - community groups sorted
alphabetically

Boolean

Stylesheet

Specify the path to a style sheet for use with the server
control. The location can be relative or absolute. Leave
blank to use the default style sheet.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theStylesheet
property is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the
control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TagTemplate

Add a path to another Web form to create links for the
tag text. This path can be relative or absolute. By
providing the path to CommunitySearch server
control, a user viewing the list of groups can click a tag
and search for other groupswith the same tag.

There are five parameters that are automatically
added to the link’sQueryString that allow you to pass
information about tag.

n searchgrptag - represent the tag’s text for
community groups.

n TagId - represents the tag’s ID.

n TagLanguage - represents the tag’s language.

n TagCount - represents the tag’s count. The tag’s
count is the amount of timesa tag hasbeen used.

n TagType - represents the tag’s type. The tag’s
type will be user or community group.

In addition to these parameters, you can add your own
bydefining them in the path.When you do, these
parameterswill be appended to your parameters.

See Also: Linking Tag Cloud Itemson page 16-281

String
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Property Description Data Type

TagTemplateTarget

Determines the type of window that appears on this
Web formwhen a user clicks an item in the dynamic
content box. The default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinkTargets

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline
portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply
attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

CommunityGroupMembers Server Control
The CommunityGroupMembers server control allows you display a list of
members

n in a community group

n pending approval to join the group

n invited to join the group

In addition, if a logged-in user is the community group’s administrator,
assigned the Community Group Administrator role, or a site administrator, he
can approve pending members, remove members, and cancel invitations.
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The following links appear on the CommunityGroupMembers Server Control
when a community group’s administrator or Ektron CMS400.NET administrator
is logged in and viewing the control.

Link Description

Members A list of current members.

Pending
Members

Memberswho have asked to join the community group, but have yet to be accepted. This link is
used when access to the community group is restricted. See Also:Accepting/Declining Requests
to Join a CommunityGroup on page 16-90

Invitations Memberswho have been invited to join the group but have not yet accepted the invitation. This
link is used when access to the community group is restricted.

Remove Removesmember from community group.

CommunityGroupMembers Server Control
Properties
The CommunityGroupMembers server control properties are described in this
table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer
and can use it to browse to Content, Collections, etc.
See Also:Using CMSExplorer to Browse Your
Ektron CMS400.NET Site on page 24-8

String

AvatarHeight The displayheight (in pixels) of the avatar in the
results box. Integer

AvatarWidth The displaywidth (in pixels) of the avatar in the
results box. Integer

CacheInterval

Sets the amount of time the server control’s data is
cached. The default is 0 (zero).

For example, if you want to cache the data for five
minutes, set this property to 300 (three hundred).
See Also:Caching with Server Controlson page 24-
33

Double

DefaultCommunityGroupID
The default community group ID for this control to
use if nomatching dynamicparameter value is
passed.

Long
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Property Description Data Type

DisplayMode

Select whether this control displaysa community
group’s current membersor their pendingmembers.
Choicesare:

n Members - current groupmembers

n PendingMembers - userswho asked or were
invited to join the group

eDisplayMode

DisplayXslt

Determineshow information is displayed on the
page. Enter the path to the XSL file. It can be relative
or absolute.

Warning! If you specify an external file, it is strongly
recommended that you do not store this file in your
site'sWorkarea folder. If you store this file in the
Workarea folder, the file will be lost when you
upgrade.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theDisplayXslt
property value is ignored.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set
to false if you want to postpone the fill-action until
later. In this case, FIll is automatically called during
the Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

DynamicParameter
Gets or sets the QueryString parameter to read a
community group ID dynamically. To use the default
community group ID, leave blank.

String

Hide

Used to hide output of the control in design time and
run time.

True =Hide control

False =Display control

Boolean

Language

Set a language for viewing the
CommunityGroupMembers control. This property
shows results in design-time (in VisualStudio) and at
run-time (in a browser).

Integer
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Property Description Data Type

Link

Add a link to themember profile page’sWeb form.
This allowsa user to click a link in the community
groupmembers list and be taken to amember’s
profile page. There are two variablesused within the
link that represent the user’s ID and the user’s name.

{0} - represents the user’s ID.

{1} - represents the user’s name.

You need to have both variables in the link. TheWeb
form can be relative or absolute. Below is an
example.

userprofilepage.aspx?gid={0}&gn={1}

String

LinkTarget

Determines the type of window that appears for this
Web formwhen a user clicks an item in the
CommunityGroupMembers control. The default is _
self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

ItemLinktargets

MarkupLanguage

Identify the templatemarkup file that controls the
display of the server control. For example,
mymarkup.ekml. If the *.ekml file is located in the
same folder as theWeb form containing the server
control, just enter its name. Otherwise, the path to the
file can be relative or absolute. See Also:Controlling
Output with EktronMarkup Language on page 26-1

String

MaxResults TheMaximum number of items to fetch. 0 (zero) =
unlimited. Integer

Stylesheet

Specify the path to a style sheet for use with the
server control. The location can be relative or
absolute. Leave blank to use the default style sheet.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theStylesheet
property is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround
the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Description Data Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline
portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply
attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

Community Folders
Community folders resemble regular folders in most ways. The only difference
is that membership users can add and edit content in these folders only.

Community folders have a unique icon, which looks like two people ( ).

Membership users add and edit Community folder content after signing in to the
Web site. They do not use the Workarea to add or edit content.

Note: Authorized CMS users can also create and update Community folder content.

This section also contains the following topics.

Creating a Community Folder 16-110
Assigning Permissions for a Community Folder 16-111
How a User Views and Edits Community Folder Content 16-112
How a Membership User Adds Community Folder Content 16-113
How a Membership User Adds an Asset 16-114
How a Membership User Updates an Asset 16-114

Creating a Community Folder
1. InWorkarea > Content, go to the folder in which you want to

create the community folder.

2. Select New > Community Folder.

Alternatively, you can hover the cursor over the folder, right click the mouse,
and select Add Community Folder.
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3. Assign properties as you would any other folder. See Adding Folders
on page 4-19

Note: The folder properties screen lets you require metadata for any content item. However,
membership users cannot enter metadata. Therefore, this requirement is ignored when
membership users edit community folder content. If an Ektron CMS400.NET user tries to edit
that content, he is required to enter a metadata value.

Assigning Permissions for a Community
Folder
Since Community folders are intended for membership users, this section
explains how to assign permissions for them. To assign folder permissions for
regular users, see Folder Permissions on page 4-40.

1. Navigate to the folder.

2. Click View > Properties.

3. Click the View Permissions button ( ).
4. If necessary, uncheck the Allow this object to inherit

permissions checkbox.

5. Click User Type: Membership Users.

6. Click the Add button ( ).
7. Select the membership user or group to which you want to assign

permission for this folder.

8. Check the permission boxes as appropriate.
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How a User Views and Edits Community
Folder Content
When a user with Read-only or higher permission navigates to a page whose
content is in a community folder, he can view it. If he has edit permission, a
menu appears.

Warning!  Membership users can edit only HTML content and assets. They cannot edit other
content types (HTML forms, Smart Forms, etc.).

When a membership user clicks the Edit button ( ), a new window displays the
content within an editor.

Other membership buttons are View History ( ) and Log out ( ).

Managing User Communities

16-112 ReferenceManual
Version 8.01 Rev 4



This editor has fewer capabilities than Ektron CMS400.NET’s editor. However, a
membership user can

n add images and files via the library button ( ) if the membership
user has Add Images and Add Files permission. See Also: Library
Folders and Permissions on page 8-4

n add a wiki using the page link button ( ). See Also: Using Ektron
CMS400.NET’s Wiki Feature on page 7-68

n assign a taxonomy category to the content by clicking the Category
tab. See Also: Taxonomy on page 9-202

Note: The Category tab only appears if a Taxonomy is applied to the content’s folder.

n replace the content summary with the first 40 words of the content,
using the Auto Generate New Summary check box. See Also:
Automatic Creation of a Summary on page 7-138

When a membership user finishes editing, he clicks Publish. If the content’s
folder has an approval chain, the content’s status changes to submitted, and the
border color changes to yellow. If there is no approval chain, the content is
published immediately.

How a Membership User Adds Community
Folder Content
You will need the assistance of your developer to enable this feature.
Instructions for doing so are in the developer sample site. To download the
developer sample site, go to
http://www.ektron.com/solutions/startersites/. After you install it, go
to siteroot/developer/ContentBlock/AddContentMembershipUser.aspx.

Or, from the developer home page (siteroot/developer/default.aspx), go
to Memberships > Membership Add Content.

How aMembership User AddsCommunity Folder
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How a Membership User Adds an Asset
First, your developer must create a template, then drop an Asset Server Control
onto it. While adding the Asset Server Control, the developer specifies Add at
the Upload Type property, and the community folder to which the asset will be
saved at the DefaultFolderID property.

When a membership user authorized to add content navigates to the page with
the server control, he sees an Asset control area like the one that appears when
CMS users add assets. He can then drag and drop assets into Ektron
CMS400.NET.

Additional information about administering assets is found in Using the
Document Management System on page 7-399.

How a Membership User Updates an Asset
Your developer adds the Asset Server Control, as described in How a
Membership User Adds an Asset above. The only difference is that the
developer specifies Update at the Upload Type property, and a community
folder to which the asset will be saved at the DefaultFolderID property.

Then, the developer specifies an asset ID number at the DefaultAsset ID
property. Using that control, the membership user can update the identified
asset only.
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Distributing Content to Another Ektron
CMS400.NET Folder
Ektron CMS400.NET supports the distribution of Community Documents to any
CMS folder. (A community document is either HTML content or an asset created
via the Community Documents server control.)

For example, your Marketing Department uses the Community Documents
server control to create and edit content. After completing a press release, they
use the Distribute menu option to copy it from the private collaboration folder
to a public content folder. Once there, the document can pass through an
approval chain or be published immediately.

The Distribute option can insert new content or overwrite existing content in
any folder.

This section also contains the following topics.

Enabling the Distribute Option 16-115
From the Workarea 16-115
From the Web Site 16-116
Distributing a Community Document 16-116
Prerequisites 16-117
Distributing a New Community Document 16-117
Distributing a Community Document and Overwriting 16-119
Distributing Content After the First Time 16-121

Enabling the Distribute Option
Only a member of the Ektron CMS400.NET Administrators group can enable the
Distribute option. Do this for every community group that will use it. You can do
so from the Workarea or after logging in to the Web site.

From the Workarea
1. From the Ektron CMS400.NET Workarea, go to Settings >

Community Management > Community Groups.

Distributing Content to Another Ektron
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2. Click the group for which you want to enable the Distribute option.

3. Click the Edit button ( ) .
4. Check the Enable Distribute check box.

5. Click the Save button ( ).

From the Web Site
1. Log in to a site that uses the Community Management features as a

CMS administrator or a Group Administrator.

2. Navigate to a Web page that hosts a Group Profile page.

3. Click the Edit Group link (circled below).

4. Check the Enable Distribute check box.

5. Click the Save button ( ).

Distributing a Community Document
There are two procedures for distributing a community document. When doing
so, ask yourself the following question.

What are you doing? Read this procedures

Replacing an existing file in an Ektron
CMS400.NET folder. The file typesmust match.

Distributing a CommunityDocument andOverwriting
on page 16-119

Placing a file in an Ektron CMS400.NET folder for
the first time

Distributing a New CommunityDocument on the facing
page

Warning! After a community document is distributed the first time, the original document is forever
linked to the destination document. You cannot break the link.

If you want to later revise the document, you would typically edit it in the
collaboration folder and select the Distribute option again. When you do, you
are asked to confirm replacing the document in the destination folder. You are
not allowed to select another folder.
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If you really must distribute it to another folder, delete the document in the
destination folder. This action breaks the link between documents. Once the
link is broken, you can distribute the document to another folder.

Distributing Content After the First Time on page 16-121 explains how
subsequent edits are handled.

Prerequisites
n You log in as one of the following

- Administrator of the group whose documents are being distributed

- Ektron CMS400.NET user assigned Community Group Administrator
role for that group

- CMS administrator

n The content’s status is Approved.

n You have permission to add, delete, and restore content to the
destination folder. (If you do not, the folder doesn’t appear on the
folder selection screen.) See Also: Folder Permissions on page 4-40

Distributing a New Community Document
When distributing a Community Document that does not exist in Ektron
CMS400.NET for the first time, you identify a destination folder and, if required,
metadata and taxonomy categories. This information is collected through a
series of screens that guide you through the process.

Note: If you are using Ektron CMS400.NET with Microsoft Sharepoint Integration, after
selecting the folder (in Step 8), the document is copied to that folder even if you later click the
screen’s Close button. See Also: Distributing SharePoint Content to Ektron CMS400.NET
Folders on page 19-1.

1. Log in to the Web site that contains content you want to distribute.

2. Navigate to the Web page that contains content you want to
distribute.

3. Click the triangle to the right of the content or asset you want to
distribute.

4. Click Distribute from the dropdown menu.

Prerequisites
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5. The following screen appears.

6. Click in the top box, which begins I want to distribute a copy of
this item.

7. The following screen appears

8. Select the folder to which you want to distribute the content.

9. Click Next.
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10. The following screen appears if metadata or a taxonomy category is
required for the folder.

11. Enter any required metadata or taxonomy. See Also:Working with
Metadata on page 7-141 and Taxonomy on page 9-202Taxonomy on
page 9-202

12. A confirmation screen appears. Click Done.

13. Ektron CMS400.NET copies the selected document to the designated
folder.

Distributing a Community Document and
Overwriting
Note: This process only occurs the first time you overwrite a document. For a description of
subsequent updates, see Distributing Content After the First Time on page 16-121Distributing
Content After the First Time on page 16-121.
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During this procedure, you identify a destination folder and content to be
replaced. Since the content’s type that you are distributing must match the
content being replaced, you only see content whose types match.

Upon replacing, any metadata and taxonomy categories applied to the existing
content are applied to the new. Also, the content title and ID number from the
existing content are maintained -- they are not replaced by the title and ID
number of the new content. Finally, the existing content’s summary is
maintained and can be edited if needed.

This information is collected through a series of screens that guide you through
the process.

1. Log in to the Web site that contains the content you want to distribute.

2. Navigate to the page that contains that content.

3. Click the triangle to the right of the document you want to distribute.

4. Distribute appears on the dropdown menu.

5. Click Distribute.

6. The following screen appears.

Note: The following screen only appears the first time you overwrite a file. To overwrite the file
subsequently, see Distributing Content After the First Time on the facing page.

7. Click the lower box, which begins I want to replace an existing
item.

8. The following screen appears.
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9. Navigate to and select the content you want to replace. Only content
whose type matches the document you selected in Step 3 appears.

10. Press Next.

11. A confirmation screen appears. Click Done.

12. Ektron CMS400.NET overwrites the selected document with the one
you selected in Step 3.

Distributing Content After the First Time
If you later try to Distribute the same document (whether you added a new
document or overwrote an existing one), a screen like the following appears.

Distributing Content After the First Time
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To copy the latest version of the document to the distribution folder, click the
gray box whose text begins I want to redistribute... However, you cannot
distribute the document to another folder. (If you want to do so, first delete the
document from the destination folder. Then, you can use either procedure to
distribute the document to any folder.)

When distributing content after the first time, its metadata and taxonomy
categories appear on the Metadata/Category screen by default. You can change
them if desired.

As with the replace option, the existing content’s title and ID number are
maintained -- they are not replaced by the new content’s title and ID number.
And, the existing content’s summary is maintained and can be edited if needed.

Notifications
Ektron's Notification system creates and transmits Notification messages
through various agents, based on Ektron CMS400.NET activities. The activities
may be performed by a community group, membership user, or an Ektron
CMS400.NET user.

n Activities are events, such as adding content, joining a community
group, and submitting a micro-message

n Notificationmessages consist of text and a triggering activity. When
the activity occurs, the message is sent to eligible recipients.

n Recipients could include a user’s colleagues and members of
community groups to which he belongs.

n Agents are providers that transmit the messages. Agents include
email, SMS and Activity Streams on page 16-167.

For example, Paul is a membership user who wants to notify colleagues
whenever he uploads a document to his profile page. When he does, an Ektron
CMS400.NET event is fired, which causes a Notification agent to send the
following email to his colleagues.

“Paul added a new document, ‘How to Write Code’, to his profile page.”

Users can decide
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n which activities should send a Notification to their colleagues or
community groups

n which Notifications they want to receive from colleagues and
community groups

Notifications help you build a tighter, more robust community. They drive users
to your site by notifying them of a recent event, then directing them to the
affected page.

This section also contains the following topics.

Notification System Overview 16-123
Conditions for Notification Messages 16-124
Setting Up and Sending a Notification Example 16-125
Managing the Notification System 16-130
Activities that Trigger a Notification Message 16-131
Raising Custom Activities 16-133
Set Default Notification Preferences 16-135
Setting a User’s Notification Activities 16-138
Notification Agents 16-139
Notification Messages 16-143
Notification Message Recipients 16-161
Notifications and Multi-Site 16-163
Using Notifications with SSL 16-164
Using eSync with Notifications 16-164

Notification System Overview
The following section presents an architectural overview of the Notification
system. It is intended for developers and database administrators.

1. A user performs an activity in Ektron CMS400.NET.

2. Ektron CMS400.NET raises a corresponding event.

3. The activity’s data is written to the Activity table in the database.

4. Activity information is sent to the activity queue.

5. Ektron CMS400.NET verifies that the Notification system is enabled.

6. The Notification service gets a list of users who signed up to be
notified about that activity when performed by that user. That list
also includes the agents that send the message (for example, Email
or SMS).

7. The Notification service gets the message associated with the
activity, formats it, and sends it to the appropriate Notification
agents.

8. Notification agents send the message to users compiled in Step 6.

Notification SystemOverview
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Conditions for Notification Messages
Notification messages require the following conditions.

Note: This section presents an overview of requirements. Following sections explain the how
to set up each requirement.

n Notifications must be turned on inWorkarea > Settings >
Community Management > Notifications > Settings.

n A message for the activity must be enabled inWorkarea > Settings
> Community Management > Notifications > Messages. (By
default, a message is enabled for each activity.)

n A user who wants to receive Notifications must enable each type of
Notification for each agent in his profile’s Activities tab.

Note: A user's profile Activities tab has a Community Groups subtab, which lets the user set
notification preferences for all community groups. To refine preferences further, a user can
access the profile of any community group and click the Edit Group Notification Preferences
link to set preferences for that particular group.

n The user performing the action must allow the Notification to be
generated by enabling it on his profile’s Activities tab.

n To receive Notifications for

- another user’s activities, you must be his colleague

- a community group’s activities, you must be a group member

Note: The above points regarding message recipients are general. For specific details about
which recipients receive notification messages, see Notification Message Recipients on page
16-161

n The Notification system respects Ektron CMS400.NET’s content
permissions. As a result, content-related Notifications are only sent
to users with at least read-only permission for the content. See Also:
Folder Permissions on page 4-40

For example, Julia adds content to an Ektron CMS400.NET folder for
which her colleague, Tyler, does not have permission. Tyler is not
notified when content is added, even though he signed up to be
notified about colleagues’ activities.

However Kristin, another colleague who has permission to edit the
folder’s content and who signed up to be notified about colleagues’
activities, does receive Notification of that event.

Similarly, private content is only viewable by authorized CMS users
or membership users with at least Read-Only permissions for its
folder.
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Setting Up and Sending a Notification
Example
This section illustrates how to set up email Notification to alert a user when
another user uploads a document to his Workspace.

This example uses the following characters.

Miles - Ektron CMS400.NET administrator who wants Notifications to be sent
when a user uploads a document. He needs to enable this capability and review
the message.

Paul - the user who uploads the document to his profile page’s Workspace. He
needs to edit his user profile to enable the publishing of Notifications when he
adds a document to his Workspace.

Chris - Paul’s colleague, he wants to receive email Notifications when Paul
uploads a document to his Workspace. He needs to edit his user profile to
enable the receipt of Notifications when colleagues upload documents to their
Workspace.

Steps Miles Needs To Perform
To set up Ektron CMS400.NET to send Notifications, Miles follows these steps.

Note: For this example to work, Ektron CMS400.NET must be set up to send emails. See
Configuring email for Tasks and Content on page 1-83.

1. Navigate to Settings > Community Management > Notifications
> Settings.

2. Verify that Notifications can be published. If not:

a. click the Edit button ( ).
b. click the Publish Notifications check box.

c. click the Save button ( ).

3. Make sure the email agent is enabled by navigating to Settings >
Community Management > Notifications > Agents.

a. if the EktronEmail agent does not appear in the list of agents, click the
Add Agent button

b. select EktronEmail from the Name dropdown
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c. click the Enabled check box

d. click the Save button ( )

4. Ektron provides a standard Notification message that is sent when a
user adds content to his Workspace. The message’s name is User
Workspace Content Added.

Because Miles wants to edit the message, he follows these steps.

a. navigate to Settings > Community Management > Notifications
> Messages.

b. click User Workspace Content Added.

c. click the Edit button( ).
d. update the email’s subject in the Subject text box.

e. edit the message in the text editor using a combination of Tokens and
text:

The document @Content.Title@ was added to @SubjectUser.UserName@’s Workspace.

Note: Because Miles is not dealing with SMS type messages, he leaves the Plain Text text box
empty. If he wanted SMS messages, he would typically create a shorter version of the
message in that text box.

- Click the Save button ( ).
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From now on, an email is sent whenever a user uploads a document to his
Workspace to colleagues who signed up to receive them.

Steps Miles Needs to do to Enable SMS
Messages
To receive SMS Messages, Miles performs the steps in the previous paragraph
plus these additional steps.

n Miles must configure the SMS Agent in the web.config file. See
Notification Agents on page 16-139

n Miles must instruct Chris (or any user that receives SMS messages)
to perform the Verification step on his cell phone.

n Miles must also instruct Chris to check the SMS column on his
Notifications page for Activities by Colleagues.

Note: For a quick summary on how to enable SMS, see "How to Enable SMS" on
dev.ektron.com.

Steps Paul Needs To Perform
Paul needs enable the Add User Workspace Content activity in his profile.
This way, whenever he adds content to his Workspace, a Notification is sent. To
do this, Paul follows these steps.

1. Log into the site.

2. Navigate to his profile page.

3. Click the Edit Profile link.
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4. Click the Activities tab.

5. Click the My Activities sub tab.

6. Click the Add User Workspace Content check box.

7. Click the Save button.

Steps Chris Needs To Perform
Next, Chris enables the receipt of Notifications that are sent whenever
colleagues upload an item to their Workspace. To do this, Chris follows these
steps.

1. Log into the site.

2. Navigate to his profile page.

3. Click the Edit Profile link.

4. Click the Activities tab.

5. Click the Colleagues sub tab.
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6. Click the Add User Workspace Content check box in the Email
column.

7. Click the Save button.

Note: If Chris wants to receive SMS messages, he will also click the check box in the SMS
 column.

Steps Chris Performs to Receive SMS Messages
on his Cell Phone
In addition to the steps above to enable receiving SMS notifications, Chris next
creates a trusted relationship between the Web site and his phone. To do this,
he follows these steps.

Note: The following procedure requires that your website has the template
SMSAgentSettings.aspx. If it does not, you may copy it from the Ektron cms400Developer
starter site, the Ektron eIntranet site, or download it from
http://dev.ektron.com/codedetail.aspx?id=29600.

1. Go to the Web site page: http://<host>/SMSAgentSettings.aspx.

2. Enter a phone number and carrier.

StepsChris Performs to Receive SMSMessages
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3. Click Save.

4. Within a few minutes, he receives a verification code on his phone.

5. Enter the code into the Verification Code field.

6. Click Verify.

7. The page shows that the account is verified. Chris can begin receiving
SMS notification messages on his phone.

Managing the Notification System
To manage the Notification system, follow these steps.

1. Enable/Disable the Notification System below

2. Set up Activity Types on the facing page

3. Review Notification Agents on page 16-139

4. Review Notification Messages on page 16-143

5. Set Default Notification Preferences on page 16-135

6. Set Default Notification Preferences on page 16-135

Warning! To perform Notification activities, you must be a member of the Administrators group or
be assigned the Community Admin role. See Also: Defining Roles on page 15-31

Enable/Disable the Notification System
The Notification Setting controls the Notification engine. To turn Notifications on
or off, follow these steps.

Note: If you upgrade to Version 8.0, Notifications are disabled by default.

1. Log in to the Workarea.

2. Navigate to Settings > Community Management > Notifications
> Settings.

3. Click the Edit button ( ).

4. Add or remove the check mark from the Publish Notifications
check box. When a check mark appears in the box, this feature is
activated.

Note: This screen also allows you to enable email replies. To learn about that, go to Enter the
Receiving Email Address Information.

5. Click the Save button ( ).
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Note: The Notification system requires Ektron CMS400.NET to be set up to send email. See
Also: Configuring email for Tasks and Content on page 1-83 .

Note: If you disable Notifications, the Activities tab on the User profile (which lets the user
pick Notifications to receive and send) disappears.

Activity Types
Activity Types list all Ektron CMS400.NET events that may trigger a notification.
For a list and explanation of all standard types, see Activities that Trigger a
Notification Message below.

You can also raise custom activities, as described in Raising Custom Activities
on page 16-133

Finally, Setting a User’s Notification Activities on page 16-138 explains how
users determine which activity types they want to be notified about, and about
which they want to notify others

Activities that Trigger a Notification Message
The table below lists standard activities that can trigger a Notification message,
and the Activities sub-tab on which they can be enabled or disabled. You can
also set up custom activities. See Raising Custom Activities on page 16-133.

Activity Type that Triggers
Message

Colleague
Action
(available on
Colleagues
sub-tab)

Community Group
Action (available on
Groups sub-tab)

User Action to
Notify Others
about (available
on My Activities
sub-tab

Add Colleague - user addsa
colleague

Add/Edit Group Content - user
uploads content to community
groupWorkspace

Add/Edit User Workspace Con-
tent - user uploads content to his
profile

Add Site Content - user adds
content to Ektron CMS400.NET

Add/Update Site Calendar
Event - event is added or changed
on site Calendar

Activity Types

ReferenceManual
Version 8.01 Rev 4

16-131



Activity Type that Triggers
Message

Colleague
Action
(available on
Colleagues
sub-tab)

Community Group
Action (available on
Groups sub-tab)

User Action to
Notify Others
about (available
on My Activities
sub-tab

Add/Update User Calendar
Event - event is added or changed
on user WebCalendar

Add/Update Group Calendar
Event - event is added or changed
onWebCalendar

Add User Workspace Content -
user uploads content to his profile

Blog Comment - user comments
on a blog post

Blog Post - user posts to his blog

Content Messageboard Post -
user posts to amessage board
associated with content

Create Community Group - user
createsa community group

Edit Content - user edits content

Forum Post - user posts to a
Forum

Forum Reply - user replies to a
Forum post

Group Blog Comment - user
comments on a community group’s
blog post

Group Blog Post - user posts to
community group blog

Group Messageboard Post -
user posts to a community group
message board
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Activity Type that Triggers
Message

Colleague
Action
(available on
Colleagues
sub-tab)

Community Group
Action (available on
Groups sub-tab)

User Action to
Notify Others
about (available
on My Activities
sub-tab

Join Community Group - user
joins community group

Micro-message - user posts
micro-message

User Messageboard Post - user
posts to amessage board
associated with a user

Raising Custom Activities
Ektron CMS400.NET's Notification system lets you create and raise your own
activity types. Custom activity types can generate notifications, just like
standard activity types. See Also: Notifications on page 16-122

To create a custom Activity Type, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings > Community
Management > Notifications > Activity Types.

2. Click the Add button ( ).
3. The Add Activity Type screen appears.

4. Assign a unique name.

5. Assign an Action Scope from the choices below.

User—an activity raised by users; their colleagues are notified

Group—an activity raised by a community group user; group
members are notified

6. Save the screen. Here is a sample custom activity on the View All
Activity Types screen.
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7. Interested users go to their User Profile screen’s Activities tab.
Here, they indicate if they want be notified when the custom activity
occurs, and if they want to notify others. See Setting a User’s
Notification Activities on page 16-138.

8. Raise a custom activity. To do that, call the
Ektron.Cms.Framework.Activity.Activity.Publish method. The
method takes an ActivityData class.

You must supply

the Id of the Activity Type you want to raise (1002 , a shown in Step
6)

the user causing the activity

a message

Note: Custom activity types cannot use Community Management messages as the standard
CMS activities do.

Here is an example of that method.

Activity activityApi = new Activity();
ActivityUserInfo user = new ActivityUserInfo() ;
user.Id = activityApi.UserId;
ActivityData activityData = new ActivityData();
activityData.ActionUser = user;
activityData.ActivityTypeId = 1002;
activityData.Message = "John Doe just rated Ektron a buy!";
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activityData.LanguageId = 1033;
activityApi.Publish(activityData);

When publish is called, the notification service notifies users who signed up to
be notified of this activity.

Set Default Notification Preferences
Ektron CMS400.NET provides a default set of Notifications that apply to all
newly-created users. After a user is created, he can change his preferences by
editing his profile, selecting the Activities tab, and checking or unchecking
activities and agents. See Also: Setting a User’s Notification Activities on page
16-138

Similarly, a community group member can access any community group profile
and click Edit Group Notification Preferences to set the group's
preferences.

For a list of activities, see Activities that Trigger a Notification Message on page
16-131. To learn about agents that appear across the top of the screen (for
example, SMS), see Notification Agents on page 16-139.

You can apply three types of default settings via screens on the Workarea
Settings tab (illustrated below).

n Notification of colleagues’ activities

n Notification of community group activities

n Notification of your activities to other users or community groups

Note: If you are upgrading to Version 8.0, all activities are checked for the Activity Stream
agent by default. No activities are checked for the other agents by default.
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Setting Default Colleague Notifications
To set default Notifications for colleagues, follow these steps. See Also: Set
Default Notification Preferences on previous page

1. Log in to the Ektron CMS400.NET Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications
> System Default Preferences > Colleagues.

3. Click the Edit button ( ).
4. Place a check mark next to each a default Notification.

5. Click the Save button ( ).

Setting Default Community Group Notifications
To set the default Notifications of community group activities, follow these
steps. See Also: Set Default Notification Preferences on previous page

Community group members can modify the default preferences for their group.
To do this, they access any community group's profile, then click Edit Group
Notification Preferences.

1. Log into the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications
> System Default Preferences > Community Groups.
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3. Click the Edit button ( ).
4. Place a check mark in each box you want to be a default Notification.

5. Click the Save button ( ).

Setting Default Notifications For Your Activities
To set the default Notifications of the logged-in user’s activities that will be sent
to other users and groups, follow these steps. See Also: Set Default Notification
Preferences on page 16-135

1. Log into the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications
> System Default Preferences > My Activities.

3. Click the Edit button ( ).
4. Place a check mark in each box you want to be a default Notification.

5. Click the Save button ( ).
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Setting a User’s Notification Activities
After an Ektron CMS400.NET administrator sets default notification preferences,
users can customize those preferences. That is, they can determine which
activities they want to be notified about, and about which they want to notify
others, on the User Profile screen’s Activities tab. See Also: Accessing a User
Profile on page 16-30

Note: The Activities tab appears only after the user is registered and if theWorkarea >
 Settings > Community Management >Notifications > Settings > Publish Notification setting
is checked.

Three sub-tabs group the activities.

Sub-tab Description

Colleagues Activities involving colleagues that the logged-in user wants to be notified about

Community

Groups

Activities involving community groups that the logged-in user wants to be notified about

Note: The Community Groups subtab sets notification preferences for all community
groups. To refine preferences further, a user can access the profile of any community
group and click theEdit Group Notification Preferences link to set preferences for that
particular group.

My
Activities

Activities involving the logged-in user about which he wants to inform colleaguesand
community group
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Notification Agents
A Notification agent is a pluggable component that sends Notification
messages. Each Agent is responsible for sending notifications to users when
CMS activity occurs. How that notification is sent is up to the Notification Agent
itself. Once a Notification Agent is created and registered, users can begin
setting up notification preferences that use it.

Ektron CMS400.NET has predefined Notification agents, including email, SMS,
and Activity Stream agents.

n SMS Notifications are sent to a cell phone or another device that
receives SMS messages. See Also: Configuring SMS on page 16-164

n Activity stream Notifications are posted via the ActivityStream
server control. See Also: Activity Streams on page 16-167

n email Notifications are delivered to appropriate recipients inboxes.
See Also: Generating email Based on Community Activities

You can customize these providers or create your own using the extendable
Notification agent architecture.

Agents are more fully explained through these topics.

n Enabling an Agent below

n Disabling an Agent on next page

n Creating a Custom Agent on next page

n Adding an Agent on page 16-142

n Removing an Agent on page 16-143

n Notification Agents above

Enabling an Agent
For an agent to be available for sending Notifications, it must be enabled in
Ektron CMS400.NET. See Also: Notification Agents above

Note: Ektron CMS400.NET’s predefined agents are enabled by default.

To enable an agent, follow these steps.

1. Log in to the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications
> Agents.

3. Click the name of an agent.

4. Click the Edit button.

5. Click the Enabled check box.

6. Click Save button.
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Disabling an Agent
To disable an agent, follow these steps. See Also: Notification Agents on
previous page

1. Log in to the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications
> Agents.

3. Click the name of an agent.

4. Click the Edit button.

5. Uncheck the Enabled check box.

6. Click the Save button.

Creating a Custom Agent
CMS 400.NET comes with several standard Notification Agents, including email,
SMS, and Activity Stream. You can customize these agents or create your own
using the extendable Notification Agent provider architecture. This section
explains how to extend the object model to build a customized Notification
Agent.

Each type of Notification Agent accepts configuration parameters. For example,
email and SMS require an SMTP server, username, and password. These
parameters can be specified in the web.config file, and read when the Agent is
initialized the first time.

Each agent may also require storing settings for each user receiving
notifications. For example, the SMS agent requires the user’s cell phone
number and carrier, which it stores as an SMS email address. To save these
properties, each Notification Agent has an associated
NotificatAgentSettingsData class. This class defines any properties needed to be
supplied by the user. The CMS provides APIs for storing and retrieving this
information, but the developer must create an interface for users to supply the
information. The SMSAgentSettings.aspx page, supplied with the Developer and
Intranet starter sites, provides a good example.

The following sections describe how to extend the functionality of the Ektron
CMS400.Net Notification Agent and create your own.

Implementing Your Own Notification Agent Provider
Object Model
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The NotificationAgent is the abstract base class you must extend to implement
your own notification agent. Details on the class, available properties, and
methods you are required to implement are below.

Method Description

virtual void Initialize(string name, Amenable
config);

The initializemethod comes from the ProviderBase base
class. It supplies all name value pairs specified in the
Providersweb.config section.

If custom settingsneed to be provided to your agent, add
them to your provider’sweb.config key, and theywill be
provided to you at runtime in the Initializemethod. If you
have no custom settings, this classdoesnot need to be
overridden.

abstract NotificationAgentSettingsData
GetAgentSettings();

Thismethod should return a new instance of the
NotificationAgentSettingsData classassociated with
your Agent.

abstract void Send(NotificationMessageData
message);

Thismethod should send the actual notification. It will be
called by the notification engine for each user that needs
to be notified.

TheNotificationMessageData hasall the information you
need for sending the notification, including

n themessage itself

n the user to be notified

n the NotificationAgentSettingsData for the user to be
notified.

If your agent hasa custom
NotificationAgentSettingsData, you need to cast the
supplied NotificationAgentSettingsData to the
appropriate type so that you can access the appropriate
properties.

Next, add the agent. See Adding an Agent on next page.
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Adding an Agent
To add a custom agent to Ektron CMS400.NET, follow these steps. See Also:
Notification Agents on page 16-139

1. Insert the provider between the Notification agent’s providers tags in
the site root/web.config file. Below is an example.

<notificationAgent>

<providers>

<add name="CustomAgent1"
type="Ektron.Cms.Notifications.Providers.CustomAgent1,Ektron.Cms.Providers" setting1=""
setting2=""/>

<add name="EktronEmail" type="Ektron.Cms.Notifications.Agents.EktronEmailAgent,
Ektron.Cms.BusinessObjects" useSystemSettings="false" smtpServer="amh010" smtpPort="25"
userName="" password="" fromEmail="admin@example.com"/>

<add name="SMSAgent" type="Ektron.Cms.Notifications.Agents.SMSAgent,
Ektron.Cms.BusinessObjects" smtpServer="amh010" smtpPort="25"
fromEmail="SMSAgent@example.com" validationRequired="true"/>

<add name="ActivityFeed" type="Ektron.Cms.Notifications.Agents.ActivityFeedAgent,
Ektron.Cms.BusinessObjects" validationRequired="false"/>

</providers>

</notificationAgent>

After you add an agent to web.config, it appears in the list of available agents in
the Workarea.

2. Log into the Workarea as an administrator.

3. Navigate to Settings > Community Management > Notifications
> Agents.

4. Click the Add button.

5. Select the custom agent from the Name drop down box.

Note: If you do not see the custom agent in the Name dropdown, check the web.config file to
verify it is listed between the <notificationAgent> <providers> tags.

6. Place a check mark in the Enabled check box.

7. Click the Save button.
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Removing an Agent
When you no longer need an agent, you can remove it. This can be a two step
process, depending on the level of removal you are trying to achieve.

First, remove the agent from the list of agents in the Workarea. At this time,
you can easily return the agent to the list. In the second step, you remove the
agent from the web.config file.

To remove an agent from the list of available agents, follow these steps.

1. Log in to the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications
> Agents.

3. Click the title of the agent.

4. Click the Delete button ( ).

5. In the Delete Agent dialog box, click OK.

The page refreshes, and the agent is removed from the agents list.

To completely remove the agent from Ektron CMS400.NET, follow these
additional steps.

6. Open the site root folder’s web.config file.

7. Between the <notificationagent>’s <providers> tags, remove the
agent.

Below is an example of agents that might appear in the web.config file.
<notificationAgent>

<providers>

<add name="CustomAgent1" type="Ektron.Cms.Notifications....

<add name="EktronEmail" type="Ektron.Cms.Notifications....

<add name="SMSAgent" type="Ektron.Cms.Notifications...

<add name="ActivityFeed" type="Ektron.Cms.Notifications...

</providers>

</notificationAgent>

See Also: Configuring SMS on page 16-164

Notification Messages
Messages are used by the Notification system to communicate site activities.
You can view each activity’s default message from theWorkarea > Settings
> Community Management > Notifications > Messages screen.
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You can edit any default message as well as create new ones.

Messages are more fully explained through these topics.

n Message Types below

n Assigning the Default Message for a Type and Sub Type on the facing
page

n Composing a Message on page 16-146

n Working with Tokens on page 16-146

n Adding a Message on page 16-158

n Editing a Message on page 16-160

n Removing a Message on page 16-160

Message Types
There are two message types:

n User

n Community Group

Managing User Communities

16-144 ReferenceManual
Version 8.01 Rev 4



Each type contains several sub types. The sub type is the activity that triggers
the message. For example, to edit the message that notifies colleagues when a
user uploads a document to his Workspace, select User from the Type drop
down and AddWorkspaceItem from the Sub Type drop down.

For a list of Sub types, see Notification Messages on page 16-143.

Assigning the Default Message for a Type and Sub Type
When you create a new message, you assign it to a type and sub type, such as
User Activity > Blog Post. Only the default message is active for any
combination of type and subtype.

So, while creating a new message, you must make it the default (via the Add
Notification Message screen’s Default check box) if you want it to be sent.

When you do, if another message was the default for that type and sub type, it
is no longer used.

Assigning the Default Message for a Type and Sub
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Composing a Message
You can create an HTML-based and a plain text message for each activity.
Typically, HTML messages are sent as email or to the ActivityStream server
control, while plain text is used in SMS style messages.

Messages typically combine text and tokens. See Also:Working with Tokens
below

Working with Tokens
Tokens are Ektron-defined variables surrounded by at signs (@). When a
message is generated, tokens retrieve information about Ektron CMS400.NET
users, groups, and objects. For example, the following message:

@SubjectUser.FirstName@ added a new document, ‘@Content.title@’, to his profile page.

might look like this:

“Paul added a new document, ‘How to Write Code’, to his profile

page.”

In this example, @SubjectUser.FirstName@ is the first name of the user
performing the action. @Content.title@ is the title of the object that was
uploaded.

See Also:

Token Types below

Message Tokens: User and Content-Based below

Message Tokens: Community Group-Based on page 16-153

Making Tokens into Hyperlinks on page 16-156

Token Types
A message can include several token types.

SubjectUser tokens—represent the user who performs the activity

DirectObjectUser tokens—represent the user to which the activity
is happening

Content tokens—represent the content that was a part of the activity

CommunityGroup tokens—represent the community group that
was involved in the activity

Blog tokens—represent the blog use in the activity

webEvent tokens—represents the Web Calendar used in the activity

MicroMessage tokens—represent micromessages used in the activ-
ity

The table below lists Message Sub Types and the Tokens available to each one.

Message Tokens: User and Content-Based
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Message Sub Type Associated Tokens

AddCalendar Event

Update Calendar Event

@System.SiteUrl@,

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@WebEvent.Id@

@WebEvent.Title@

@WebEvent.Quicklink@

@WebEvent.StartTime@

@WebEvent.EndTime@

AddColleague

@System.SiteUrl@,

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@DirectObjectUser.Id@

@DirectObjectUser.UserName@

@SubjectUser.DisplayName@

@DirectObjectUser.FirstName@

@DirectObjectUser.LastName@

@DirectObjectUser.TemplateAlias@
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Message Sub Type Associated Tokens

AddContent

@System.SiteURL@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@Content.Id@

@Content.Title@

@Content.Quicklink@

@Content.Icon@

AddWorkspaceItem

@System.SiteURL@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@Content.Id@

@Content.Title@

@Content.Quicklink@

@Content.Icon@

BlogComment

@System.SiteUrl@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@BlogComment.Id@

@BlogComment.Message@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@
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Message Sub Type Associated Tokens

BlogPost

@System.SiteUrl@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@Content.Id@

@Content.Title@

@Content.Quicklink@

@Content.Icon@

CreateCommunityGroup

@System.SiteUrl@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@CommunityGroup.Id@

@CommunityGroup.Name@

@CommunityGroup.TemplateAlias@
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Message Sub Type Associated Tokens

ContentMessageBoardPost

@System.SiteUrl@

@System.GroupProfileTemplate

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@Content.Id@

@Content.Title@

@Content.Quicklink@

@Content.Icon@

@MessageBoard.ObjectId@

@MessageBoard.ObjectType@

@MessageBoard.Message

EditContent

@System.SiteUrl@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@Content.Id@

@Content.Title@

@Content.Quicklink@

@Content.Icon@
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Message Sub Type Associated Tokens

EditWorkspaceItem

@System.SiteUrl

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@Content.Id@

@Content.Title@

@Content.Quicklink@

@Content.Icon@

ForumReply

@System.SiteUrl@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@Topic.Id@,@Topic.Title@

@Topic.Quicklink@

@TopicReply.Id@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

ForumPost

@System.SiteUrl@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@Topic.Id@,@Topic.Title@

@Topic.Quicklink@

@TopicReply.Id@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@
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Message Sub Type Associated Tokens

JoinCommunityGroup

@System.SiteUrl@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@CommunityGroup.Id@

@CommunityGroup.Name@

@CommunityGroup.TemplateAlias@

MicroMessage

@System.SiteUrl@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@MicroMessage.Id@

@MicroMessage.Message@
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Message Sub Type Associated Tokens

UserMessageboardPost

@System.SiteUrl@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@DirectObjectUser.Id@

@DirectObjectUser.UserName@

@DirectObjectUser.FirstName@

@DirectObjectUser.LastName@

@SubjectUser.TemplateAlias@

@MessageBoard.ObjectId@

@MessageBoard.ObjectType@

@MessageBoard.Message@

Message Tokens: Community Group-Based

Message Type Associated Tokens

AddCalendar Event

Update Calendar Event

@System.SiteUrl@,

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@WebEvent.Id@

@WebEvent.Title@

@WebEvent.Quicklink@

@WebEvent.StartTime@

@WebEvent.EndTime@
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Message Type Associated Tokens

AddWorkspaceItem

@System.SiteURL@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@DirectObjectUser.Id@

@DirectObjectUser.UserName@

@DirectObjectUser.FirstName@

@DirectObjectUser.LastName@

@CommunityGroup.Id@

@CommunityGroup.Name@

@Content.Id@

@Content.Title@

@Content.Quicklink@

@Content.Icon@

BlogComment

@BlogComment.Id@

@BlogComment.Message@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

BlogPost

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@Content.Id@

@Content.Title@

@Content.Quicklink@

CreateCommunityGroup

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@CommunityGroup.Id@

@CommunityGroup.Name@
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Message Type Associated Tokens

GroupMessageBoardPost

@System.SiteUrl@

@System.GroupProfileTemplate@

@System.UserProfileTemplate@

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.DisplayName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@SubjectUser.TemplateAlias@

@CommunityGroup.Id@

@CommunityGroup.Name@

@CommunityGroup.TemplateAlias@

@MessageBoard.ObjectId@

@MessageBoard.ObjectType@

@MessageBoard.Message@

JoinCommunityGroup

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@CommunityGroup.Id@

@CommunityGroup.Name@

UserMessageboardPost

@SubjectUser.Id@

@SubjectUser.UserName@

@SubjectUser.FirstName@

@SubjectUser.LastName@

@DirectObjectUser.Id@

@DirectObjectUser.UserName@

@DirectObjectUser.FirstName@

@DirectObjectUser.LastName@

@MessageBoard.ObjectId@

@MessageBoard.ObjectType@

@MessageBoard.Message@

Message Tokens: Email Reply Message

Message Sub Type Associated Tokens

EmailMessage Reply @System.SiteUrl@
@System.GroupProfileTemplate@@System.UserProfileTemplate@
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Making Tokens into Hyperlinks

Message tokens represent Ektron CMS400.NET users, groups and content. They
can become links that, when clicked, bring the user to content, a user’s profile,
or community group’s profile, as shown below.

To make tokens into clickable links, follow these steps.

1. Create the message as described in Adding a Message on page 16-
158.

2. While editing the message text, highlight a token and click the
Hyperlink Manager button (circled below).

3. In the URL field, enter the path to the page that displays the content,
user, or community group.
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Make sure you include the QueryString parameter used to identify the
object. The parameter should point to an ID token. For example, a
message notifies a user’s colleagues whenever he adds a new
colleague. The message might be:

@SubjectUser.UserName@ and @DirectObjectUser.UserName@ are now colleagues.

When creating a link for @SubjectUser.UserName@, insert the path to
the user’s profile page into the URL field. It might look like this:

http://localhost/Intranet/UserProfile.aspx?id=@subjectUser.Id@

Note, the QueryString parameter (?id=) points to a token that
represents the logged-in user’s ID, @subjectUser.Id@. See Also: Token
Types on page 16-146

For @DirectObjectUser.UserName@, enter the same path and change
the dynamic parameter token to ?id=@DirectObjectUser.Id@.

When hyperlinking content, use its QuickLink token in the path defined in
the URL field. For example, a message that sends a Notification when a
user adds content might look like:

@SubjectUser.username@ added new content, @Content.Title@.

4. Make sure the original token text appears in the Link Text field.
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5. Click OK.

Adding a Message
Warning! A message is limited to 3000 characters after its tokens are converted to text. After
3000, any remaining characters are removed.

To create a message, follow these steps. See Also: Notification Messages on
page 16-143

1. Log into the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notifications
> Messages.
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3. If you are using the Multi-Site feature, select the site with which this
message will be associated.

4. Click the Add Notification Message button ( ).
5. The Add Notification Message screen appears.

6. Complete the fields as described below.

Field Description

Title Enter a name for themessage.

Type

Select the type of message you want to create. Choicesare:

n User—message sent when user activity occurs

n Community Group—message sent when group activity occurs

The activity is specified at theSub Type field.

Sub
Type

Select the activitywhich triggers the sending of thismessage. See Also:Message Typeson page
16-144.

Tokens

A list of available tokens for the selected Sub Type appears.

Note: To easily insert a token into amessage, highlight a token, then copyand paste it into the
message.

For a list of tokensand their sub typeswith, seeMessage Tokens: User and Content-Based on
page 16-146.

To learn about how tomake tokens into hyperlinks, seeMaking Tokens into Hyperlinkson page
16-156.
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Field Description

Default Click this checkbox if you want themessage to be the default one that is sent. See Also:Assigning
the Default Message for a Type and Sub Type on page 16-145

Subject Enter a subject to be used if themessage is sent asemail.

Text
Enter the text and tokens that comprise themessage. The editor allows you to format the text.

Use this editor for HTML, email, and activity streammessages. See Also:Composing aMessage
on page 16-146 andMaking Tokens into Hyperlinkson page 16-156

Plain
Text

Enter the text and tokens that comprise themessage you want to send. Use this field for SMS
typemessagesandmessages to be sent asplain text.

Note: Tip! If you already composed themessage in the editor above, you can select that text,
then copyand paste it into thePlain Text field.

Warning! Most SMS systems impose a 160 character limit onmessages. If you create a plain
text message greater than 160 characters, Ektron CMS400.NET divides it into several, smaller
messages.

7. Click the Save button ( ).
The message now appears in the list of Notification messages. If it is the default
and an activity occurs on your Web site that matches the type and sub type, the
message is sent.

Editing a Message
To edit a message, follow these steps. See Also: Notification Messages on page
16-143

1. Log into the Workarea as an administrator.

2. Navigate to Settings > Community Management > Notification
> Messages.

3. If you are using Ektron's Multi-Site feature, select the site for which
this message is used.

4. Click the title of the message you want to edit.

5. Make changes as needed. For a description of the fields on this
screen, see Adding a Message on page 16-158.

6. Click the Save button ( ).

Removing a Message
When you no longer need a message, you can remove it from Ektron
CMS400.NET. To remove a message, follow these steps.

1. Log into the Workarea as an administrator.
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2. Navigate to Settings > Community Management > Notification
> Messages.

3. Click the title of the message you want to delete.

4. Click the Delete button ( ).

5. Click OK on the confirmation message.

6. The message is removed.

Notification Message Recipients
The table below connects Notification message activities with users who
receive the notification.

Prerequisites:

n users performing the activity must have the Publish check box
checked for the activity in their profile

n users being notified must have the Activity Stream, SMS, or email
box checked for that activity in their profile

For more information, see Setting a User’s Notification Activities on page 16-
138.

Activity that Triggers Message
Users who receive
notification

Add Colleague - user addsa colleague
n colleaguesof user who adds

n added colleague his colleagues

Add Group Content - user uploads content to
community groupWorkspace Community groupmembers

Add/Edit User Workspace Content - user uploads
content to his profile

Dependson folder’s share setting,
which can be

n Public - all colleagues

n Colleagues– all colleagues

n Selected colleagues See Also:
Designating a Selected Colleague on
page 16-37

n Private – no email

Add Site Content - user adds content to Ektron
CMS400.NET User's colleagues

Add/Update Site Calendar Event - event is added
or changed on siteWeb calendar User's colleagues

NotificationMessage Recipients
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Activity that Triggers Message
Users who receive
notification

Add/Update User Calendar Event - event is
added or changed on siteWeb calendar User's colleagues

Add/Update Group Calendar Event - event is
added or changed on siteWeb calendar Community groupmembers

Blog Post - user posts to his blog User's colleagues

Content Messageboard Post - user posts to a
message board associated with content

Userswho have permission to view the
content

Create Community Group - user createsa
community group Colleaguesof user who createsgroup

Edit Content - user edits content User's colleagues

Edit Group Content - user edits community group
content Community groupmembers

Forum Post - user posts to a Forum
n Posting user's colleagues

n Forum owner and his colleagues

Forum Reply - user replies to a Forum post Posting user's colleagues

Group Blog Comment - user comments on a
community group’s blog post Community groupmembers

Group Blog Post - user posts to community group
blog Community groupmembers

Group Messageboard Post - user posts to a
community groupmessage board Community groupmembers

Join Community Group - user joins community
group

n Community groupmembers

n Colleaguesof user who joined

Micro-message - user postsmicro-message User's colleagues

User Messageboard Post - user posts to a
message board associated with a user

n colleaguesof user who posts

n message board owner and his
colleagues

User or Community Blog Comment - user
comments on a blog post Posting user's colleagues
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Notifications and Multi-Site
In a Multi-site environment, Notifications stay within the site where the activity
happened. For example, I have two sites: an Intranet and Social Club site.
When a user from the Intranet site performs an activity that generates a
message, it does not trigger Notifications on the Social Club site.

Exception: A user’s colleagues receive notifications regardless of the site from
which the message originated.

Notification Messages and Multi-Site
When creating Notification messages in a Multi-Site environment, you specify
the site associated with message. This allows you to create customized
messages for each site.

When a message type is created, it becomes the default message and is used
by all sites. New messages of the same type can be assigned to each site in
your environment.

To view the messages assigned to each site, go to the View All Notification
Messages screen, click the Site dropdown, and select the site.

For example, you want a “Status Update” message targeted one way for an
Intranet site and another way for your Social Club site. To accomplish this,
create a two messages. The message for the Intranet site might state:

@SubjectUser.username@ has updated his status on Intranet with the following:
@MicroMessage.Message@.

While your Social Club site might have a message that states:

Notifications andMulti-Site
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@SubjectUser.username@ has updated his status on the Social Club with the following:
@MicroMessage.Message@

Using Notifications with SSL

If your site uses SSL, you need to update the link in the Ektron notification
service configuration file with that information. The file is located here: your
server\Program
Files\Ektron\EktronNotificationService\Ektron.Notification.Service.exe.config.

Below are the tags to be changed.

<siteNotification>

<sites>

<add name="769723537" url="https://your server" connectionString="server=your
server;database=Intranet2;Trusted_Connection=true;User ID=;Password=;" />

</sites>

</siteNotification>

You must restart the Ektron Notification Service in order to enable these
changes.

Using eSync with Notifications
When using eSync with Notifications, any new agents are not synched. This
means that you must manually add new agents to each server in your
configuration.

Once the agent exists on all servers in your configuration, eSync keeps them
updated. For example, assume a membership user logs into the production
server and updates his profile’s Activities tab by changing the activities a
custom agent will perform. eSync will sync those changes with the staging
server.

See Also: Adding an Agent on page 16-142

Configuring SMS
SMS (Short Message Service) sends community notification messages from the
Ektron CMS400.NET Web site to wireless devices such as Cell Phones or PDA's
(Personal Data Assistants).

To accomplish this, you must configure several items.

To set up Do this For more information, see

Web.config Add SMSAgent
information SeeConfiguring web.config for SMS on the facing page
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To set up Do this For more information, see

Cell phone Verify your Cell Phone
with your Web Site

SeeVerifying Your Cell Phone for SMS Messageson
next page

SMS Notification Agent Configure the SMS Agent
in the CMS400Workarea SeeNotificationson page 16-122

Messages you send to the
community

Set your activities to pub-
lish bySMS in your com-
munity profile

SeeNotificationson page 16-122

Messages you receive
from the community

Set activities to receive by
SMS in your community
profile.

SeeNotificationson page 16-122

For a complete Knowledge Base Article entitled "How to Enable SMS
 Notifications", go to the following page in the Ektron Developer Center:
http://dev.ektron.com/kb_article.aspx?id=29586.

This section also contains the following topics.

Configuring web.config for SMS 16-165
Verifying Your Cell Phone for SMS Messages 16-166

Configuring web.config for SMS
To enable SMS in the web.config file of your Web site, follow these steps.

1. Find web.config in your Web site root directory.

2. Make a copy of it for safe keeping.

3. Find the SMSAgent tag.

4. Enter the proper value for smtpServer for the server that sends
emails in your company. For example:

smtpServer="EKMAIL291.intra.mycompany.com"

5. Replace the value of fromEmail with the email from whom the notices
are sent. For example:

fromEmail = "noreply@mycompany.com"

6. Save the file.

The completed code looks like this.
<add name="SMSAgent" type="Ektron.Cms.Notifications.Providers.SMSAgent,
Ektron.Cms.Providers" smtpServer="EKMAIL291.intra.mycompany.com" smtpPort="25"
fromEmail="noreply@mycompany.com" validationRequired="true" />

Configuring web.config for SMS
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Verifying Your Cell Phone for SMS Messages
In order to verify that you have made a proper connection to your cell phone,
you must send a verification message from the CMS400.NET Web site to your
phone. To verify your phone, do the following steps.

Note: The following procedure requires that your website has the template
SMSAgentSettings.aspx. If it does not, you may copy it from the Ektron cms400Developer
starter site, the Ektron eIntranet site, or download it from
http://dev.ektron.com/codedetail.aspx?id=29600.

1. In a browser, enter the following address:
http://<hostname>/SMSAgentSettings.aspx.

2. A screen appears that looks like this.

3. Enter your cell phone area code and phone number.

4. Select your provider.

5. Click Save.

6. In a few minutes, your phone receives a message with a validation
code.

7. Enter that code into the Verification Code field.

8. Click Verify.

9. If the proper code is entered, the follow screen appears, showing that
the SMS account is verified. If not, check the other configuration
settings and try again
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Note: Once the phone number is verified, the Account Verified checkmark appears. This will
not change unless you change the cell phone number or provider.

Activity Streams
As explained in Notifications on page 16-122, Ektron CMS400.NET users are
notified about other user's activities by agents such as

SMS

Ektron email

Activity Stream

This section explains how to manage the display of notification messages via
the Activity Stream agent.

This section also contains the following topics.

Sample Activity Stream 16-168
Displaying an Activity Stream on Your Web Site 16-168
Making the ActivityStream Widget Available 16-169
The ActivityStream Widget on a Personalization Page 16-169
Viewing the ActivityStream Widget on Your Personalization
Page

16-
170

Viewing ActivityStream Widget on Another User’s Page 16-170
Filtering the ActivityStream Widget 16-171
Removing an Entry from the ActivityStream Widget Filter 16-174
ActivityStream Widget on a PageBuilder Page 16-175
Displaying Notifications in Activity Stream Widget 16-175
Sharing an Activity Stream Event on Your Profile 16-176
Viewing an Activity Stream Event in a Browser Window 16-176
RSS Feed Links 16-177
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Sample Activity Stream

As you can see, an Activity Stream is a series of chronologically-arranged
notification messages describing activities within Ektron CMS400.NET.

Before reading this section, you should be familiar with Notifications on page
16-122, which describes when messages get generated, for whom, how their
text is created, etc.

Displaying an Activity Stream on Your Web
Site
The following table describes the various ways of presenting an Activity Stream
on your Web site.

For this kind of
Web page

Use this To see Notifications for
For more information,
see

.aspx ActivityStream server
control

The user or group identified in
the page’s query string.

If none is identified, the logged-
in user seeshis own
notifications.

ActivityStreamServer
Controlon page 16-178
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For this kind of
Web page

Use this To see Notifications for
For more information,
see

PageBuilder ActivityStreamwidget
ActivityStreamWidget on a
PageBuilder Page on page 16-
175

Ektron
CMS400.NET
Personalization

ActivityStreamwidget

n Yourself

n Your colleagues

n Your community groups

ActivityStreamWidget on
a PageBuilder Page on
page 16-175

Community
Feature: your
profile page

No action required -
ActivityStream
appears bydefault

Yourself

Community
Feature: a
colleague’s profile
page

No action required -
ActivityStream
appears bydefault

Colleagues

See Also:Viewing
ActivityStreamWidget on
Another User’sPage on next
page

Community
Feature: group
profile page

No action required -
ActivityStream
appears bydefault

Community group of which you
are amember

Making the ActivityStream Widget Available
The ActivityStream widget is installed with Ektron CMS400.NET. However, if
you are upgrading from a previous version, you should sync your Widget list to
make sure ActivityStream is available. To do this:

1. Navigate to theWorkarea > Settings > Configuration >
Personalizations >Widgets screen.

2. Click the Sync button ( ).

The ActivityStream Widget on a
Personalization Page
Note: To learn about Ektron CMS400.NET‘s Personalization feature, see Personalizing a Web
Page on page 9-300.

There are two scenarios to explain how the Activity Stream widget works on a
personalization page.

Viewing the ActivityStream Widget on Your Personalization Page on
next page

Viewing ActivityStream Widget on Another User’s Page on next page

Making the ActivityStreamWidget Available
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Viewing the ActivityStream Widget on Your
Personalization Page
When you drag and drop an ActivityStream widget on a Personalization page, it
displays activities performed by

you, the logged-in user

your colleagues

community groups to which you belong

Viewing ActivityStream Widget on Another User’s
Page
When you view another user’s personalization page containing this widget, the
activities you see are controlled by that user’s Private Profile setting (see
illustration below) and whether he is your colleague.
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The table below describes when you can see another user’s Activity Stream.

If the user’s Private Profile
Setting is...

and the user is... you can...

Public a colleague view his activities

Public not a colleague view his activities

Private a colleague view his activities

Private not a colleague only view his activities if you are an
administrator

Colleague a colleague view his activities

Colleague not a colleague only view his activities if you are an
administrator

If you can view another user’s activities, you see activities that he performs
and activities his colleagues perform that relate to him.

From this widget, you can filter the Activity Stream to view only activities from
specific users and community groups. See Also: Filtering the ActivityStream
Widget below

Filtering the ActivityStream Widget
Filtering the ActivityStream widget means restricting notifications to those
from selected users or groups. For example, you want to see only activities

Filtering the ActivityStreamWidget
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performed by Kay Milford. In the filter, select Kay Milford, and the
ActivityStream widget shows messages only from her.

As another example, you are the head of the Engineering department and want
to see your employees’ activities. To accomplish this, add them as colleagues.
Then, in an ActivityStream widget, create a filter with their names. That widget
only shows your employees’ activities.

If your department has a community group, you could add that group to the
filter. Then, in addition to your employees’ activities, you would see the group’s
activities.

This feature, combined with the ability to add multiple ActivityStream widgets
to a page, allows you to create separate activity streams that focus on people
and groups of interest.

Below is an image showing one ActivityStream widget that displays all of a
user’s colleagues (on the left), and three other widgets with filters that focus on
individual users.
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You could take this example one step further. If Leah Mathis and Scott Markey
both work in “Sales & Marketing” and Bill Smith, Works in “Engineering,” you
might only have two widgets, one for Scott and Leah and another for Bill.

Procedure for Filtering an ActivityStream Widget
To filter the ActivityStream widget, follow these steps.

1. Click the Filter button at the bottom of the widget.
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2. Enter the name of a user or community group in the Users and
Groups text box by which to filter.

As you start typing, an AutoComplete feature helps you narrow down the
selection.

3. Click the Add button.

Important: A valid name is one that exactly matches a user’s Display Name or community
group’s Group Name. If your entry does not match, the widget refreshes and no filter is added.

4. The ActivityStream widget refreshes and only activities performed by
the selected user or community group members appear.

Also, the users or community groups you selected in Step 3 appear in
the widget’s filter area (see example below).

You can add as many users or community groups to the filter as you like, one at
time. After you finish, you can hide the filter by clicking the Hide button.

Removing an Entry from the ActivityStream
Widget Filter
To remove a user or community group from an ActivityStream widget filter,
follow these steps.

Note: If you remove all users and groups from the filter, the widget shows notifications from all
users whose activities you can view.
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1. If you cannot see the filter’s users or community groups, click the
Filter button at the bottom of the widget.

2. Click the Delete button ( ) next to the user or community group you
want to remove.

3. The ActivityStream widget refreshes, and the removed user or
community group’s activities disappear from the stream.

ActivityStream Widget on a PageBuilder
Page
Note: To learn about Ektron's PageBuilder functionality, see Building PageBuilder Pages on
page 5-1.

When used on PageBuilder page, the ActivityStream widget shows the logged-in
user’s activities by default. However, you can modify the widget to focus on
another user’s or community group’s activities.

For example, you create a PageBuilder page about the CEO of your company
and want to display notifications about activities that he, his colleagues, and his
community groups perform on the site.

To accomplish this, add the ActivityStream Widget to a “See what the CEO is Up
To” page. While doing that, specify the user ID assigned to your CEO (available
from his User Profile). When an Intranet user visits the page, he sees a list of
the CEO’s activities.

Displaying Notifications in Activity Stream Widget
To display another user’s or community group’s activities in the ActivityStream
widget, follow these steps.

Prerequisite: The ID number of the user or community group whose
notifications will appear

1. Drag and drop the ActivityStream widget.

2. The following dialog appears.

3. Use the Feed Type dropdown to select User or Community Group.

4. In the Object ID Field, enter the user’s or community group’s ID.

5. Click Save.

ActivityStreamWidget on a PageBuilder Page
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Sharing an Activity Stream Event on Your
Profile
Each activity in a stream has a Share link below its text (see example below).

You can click any activity's Share link to post it to your profile's status (see
example below).

The Share link makes it easy for you to share activity stream events with
people who view your status updates.

Viewing an Activity Stream Event in a
Browser Window
You can set up an activity stream to assign a time ago link to each event, as
circled below.

When a site visitor clicks that link, the activity stream event is launched in a
new browser. From there, the site visitor can use the page's URL to uniquely
identify the event. For example, he can forward the URL to other users to notify
them about the event.
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To add a time ago link to a page, follow these steps.

1. Create a Template Activity page. It must be an .aspx template with
an activity stream server control that includes these properties.

n ObjectType - enter Activity

n DynamicObjectParameter - enter id

Note: A sample of this page, activity.aspx, is provided with the Ektron Tech site, in the site root
folder.

2. Open the template that hosts the Activity Stream server control to
which you want to add a time ago link.

3. To the Activity Stream server control, add the TemplateActivity
property. As the value for that property, enter the template page you
created in Step 1. That page appears when a site visitor clicks the
time ago link.

Here is an example of an Activity Stream server control with a sample value for
that property.

<CMS:ActivityStream ID="ActivityFeed1" runat="server" EnablePaging="true"
DynamicObjectParameter="id" TemplateUserProfile="profile.aspx"
TemplateActivity="activity.aspx" />

Note: A sample of this page, profile.aspx, is provided with the Ektron Tech site, in the site root
folder.

RSS Feed Links
Ektron CMS400.NET provides the following RSS feed links that can display
activity stream events.

RSS Feed Links
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RSS feed link Displays this information

 http://your web site/workarea/webservices/feeds.svc/userstatuses/user ID
 number.rss

For example:

 http://your zweb site/workarea/webservices/feeds.svc/userstatuses/1.rss

The specified user’s status
updates. For example, 1.rss
showsall status updatesof
the user whose ID is 1.

http://your web site/workarea/webservices/feeds.svc/publictimeline.rss All public statusupdates

http://your web
site/workarea/webservices/feeds.svc/publictimeline.rss?search=new

All public statusupdates that
include the term "new"

You can use these feeds with Ektron CMS400.NET's API to access and display
status updates.

Note: If Notifications do not appear in your Activity Stream, this Knowledge Base article may be
helpful. http://dev.ektron.com/kb_article.aspx?id=30764

ActivityStream Server Control
The ActivityStream server control displays notification messages generated by
Ektron CMS400.NET’s Notification system. For background information on the
Activity Streams, see Activity Streams on page 16-167.

Below are some pages where you might use this control.

a landing page where a user arrives after logging in

a user’s profile page

a group’s profile page

any page where you want to show a user’s or group’s activities

The image below shows an intranet Home page with the ActivityStream server
control highlighted. Whenever a user logs into the site, he sees a list of his
colleagues’ activities.
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This section also contains the following topics.

How the Control Determines which Activities to Display 16-179
How to Exclude a User or a Group from the Activity Stream 16-179
Quick Setup Instructions 16-180
ActivityStream Server Control Properties 16-180

How the Control Determines which Activities
to Display
When this control is added to a Web page, Ektron CMS400.NET looks for a
DefaultObjectID defined in server control properties. If one is found, the
activity stream is based on that user or group. If none is found, notifications
are based on the pages’s dynamic query string parameter, which typically
identifies the logged-in user.

How to Exclude a User or a Group from the
Activity Stream
You can exclude any user or a group from the activity stream. To achieve this,
open the page that hosts the Activity Stream server control, find the control,
and add the following to the control’s codebehind.

How the Control Determines which Activities to
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//activityStream
cmsActivityStream.ExcludeUserIds.Add(this.ProfileId);
You can also exclude groups.
cmsActivityStream.ExcludeGroupIds.Add(GroupId1);
cmsActivityStream.ExcludeGroupIds.Add(GroupId2);
:
cmsActivityStream.ExcludeGroupIds.Add(GroupIdN);

Quick Setup Instructions
To add this control to a page, drag and drop it on a Web form and set the
following properties.

DefaultObjectID—If you want a user’s or community group’s activ-
ity stream to appear in the control, enter that ID.

DefaultObjectParameter—enter the default object parameter used
on the QueryString to define an object’s ID. For example, if you are
passing the ID value of a community group, you might enter ‘gid’ for
this property. So, if you pass http://~-
yoursite~/CGHome.aspx?gid=21 in the query string to a page con-
taining this control, you see the activity stream for the community
group whose ID is 21.

ObjectType—select the whether the control is associated with a user
or Community Group

TemplateUserProfile and ProfileParamName—If you want a
user’s avatar in the activity stream to be a clickable link that leads to
his profile page, set these properties.

ActivityStream Server Control Properties
The ActivityStream server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMS

Explorer and can use it to browse to Content, Collections, etc.
See Also:Using CMSExplorer to Browse Your Ektron
CMS400.NET Site on page 24-8

String
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Property Description Data Type

CacheInterval

Sets the amount of time the server control’s data is cached. The
default is 0 (zero). This is the amount of time, in seconds, a
control’s data is cached. For example, if you want to cache the
data for fiveminutes, set this property to 300 (three hundred).
See Also:Caching with Server Controlson page 24-33

Double

DefaultObjectID

The ID of the object whose activity streamwill appear where you
place this server control.

For example, if you want this control to displayScott Markey’s
activities, and hisUSER ID is 142, place 142 here, and set the
ObjectTypeproperty toUser.

To display the activity stream for the logged-in user, enter zero
(0).

Long

DisplayXslt

Determineshow information is displayed on the page. Enter the
path to the XSL file. It can be relative or absolute.

Warning! If you specify an external file, it is strongly
recommended that you do not store this file your site’sWorkarea
folder. If you store this file in theWorkarea folder, the file will be
lost when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if
you want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes
shown.

Boolean

DynamicObjectParameter

Gets or sets the QueryString parameter to read a object ID
dynamically. To use the default object ID, leave blank.

For example, if you are passing the ID value of a community
group, youmight enter ‘gid’ for this property. So, if you passed
http://~yoursite~/CGHome.aspx?gid=21 on the
QueryStrings to a page containing this control, you would see the
activity stream for the group with an ID of 21.

String

EnablePaging

This property, in conjunction with theMaxResults property,
lets site visitors view an unlimited number of notificationswhile
controlling the amount of screen space. To accomplish this, the
display is limited to the number set in theMaxResults property.

If you set this property to true, and the number of itemsexceeds
theMaxResults number, navigation aidsappear below the last
item.

Boolean

Hide

Used to hide output of the control in design time and run time.

True =Hide control

False =Display control

Boolean
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Property Description Data Type

Language
Set a language for viewing the ActivityStream control. This
property shows results in design-time (in VisualStudio) and at
run-time (in a browser).

Integer

MarkupLanguage

Identify the templatemarkup file that controls the display of the
server control. For example, mymarkup.ekml. If the *.ekml file is
located in the same folder as theWeb form containing the server
control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See Also: Controlling Output with Ektron
Markup Language on page 26-1

String

MaxResults TheMaximum number of notifications to fetch. 0 (zero) =
unlimited. Integer

ObjectType

The type of object to which this control is assigned. Choicesare:

User—control is assigned to an individual

Group—control is assigned to a community group

ActivityFeedType

ProfileParamName

The parameter name to pass in the QueryString to the
TemplateUserProfile page, if you want it to be anything other
than id.

For example, youmayprefer userid, because it ismore
descriptive, as shown in the following example.

String

Stylesheet
Specify the path to a style sheet for use with the Documents
server control. The location can be relative or absolute. Leave
blank to use the default style sheet.

String

Suppress

WrapperTags

Suppresses the output of the span/div tagsaround the control.
The default isFalse.

True—Suppresswrap tags.

False—Allow wrap tags.

Boolean
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Property Description Data Type

TemplateActivity

The URL path to a page that contains another ActivityStream
server control.
When this property contains a path and the destination page has
an ActivityStream controlwhose ObjectType property is set to
Activity, a user can click an ActivityStream’s time span on the
first page to open a second page that contains just that activity.
See Also:Viewing an ActivityStreamEvent in a Browser Window
on page 16-176

String

Template

UserProfile

The URL path to a page that contains the UserProfile server
control. This path can be relative or absolute.

If you enter a path, a user can click anyuser’s name or avatar
from theMessage Board server control and be forwarded to his
profile page. See illustration below.

Note that user templates can be defined in the Ektron
CMS400.NET Workarea > Settings > Community
Management > Templates screen.

However, if you assign a template in this field, this setting takes
precedence over the setting on theWorkarea Template screen.

String

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span—The <span> tag is used to designate an inline portion of
an HTML document asa span element.

Div—The <div> tag is used when you want to apply attributes to a
blockof code.

Custom—Allowsyou to use a custom tag.

String
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Micro-messaging Server Control
The Micro-messaging server control allows users to post brief messages. It
resembles micro-blogging services like Twitter. An example of the Micro-
messaging control, within Ektron CMS400.NET’s sample Ektron Tech site, is
circled below.

A user can reply to another user’s micro-message, as illustrated below. See
Also: Replying to a Micro-message on page 16-195.

The control also lets users search micro-messages. See Also: Searching for
Micro-messages on page 16-192
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In addition, Micro-messages are a type of notification, so can appear in Activity
Streams on page 16-167.

This feature builds tighter-knit communities by allowing members to share
information and feel they have a personal stake in that information.

This section also contains the following topics.

Micro-Message Controls on Sample Sites 16-185
Micro-messages are an Activity Type 16-186
Micro-messaging Display Modes 16-187
Associating the Control with a User 16-187
User Mode 16-188
Colleagues Mode 16-189
TimeLine Mode 16-190
Message Mode 16-190
Making a Hyperlink to a Single Page Version of a Micro-mes-
sage

16-
190

Searching for Micro-messages 16-192
Enabling the Micro-message Search 16-193
Entering Multiple Search Terms 16-194
Replying to a Micro-message 16-195
Filtering Micro-message Spam 16-196
Creating a Custom Spam Filter 16-196
Micro-messaging Server Control Properties 16-197

Note: A user’s Private Profile setting has three possible values: Public, Private and
Colleague. When discussing this control and these settings, Private and Colleague both act
as Colleague.

Micro-Message Controls on Sample Sites
You can find examples of the Micro-message server control in these Ektron
sample sites. You can copy and edit the samples as needed to build your own
pages.

Micro-Message Controls on Sample Sites
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Ektron Technology site > Login
user or colleague mode—User Profile page (top right corner)

time line mode—http://your server/Ek-
trontech/timeline.aspx

Developer Sample Site > Social Networking > MicroMessage and
MicroMessage Api

To download sample sites, go to http://www.ektron.com/solutions/startersites/.

Micro-messages are an Activity Type
A micro-message is type of Ektron CMS400.NET activity, like adding content or
joining a Community Group. As such, a new micro-message can generate a
notification. See Also: Notifications on page 16-122

Like other notifications, Micro-messages can appear on an Activity Stream
control. Micro-messages are circled in the example below.

Also like other activities, users can determine if they want to be notified about
colleagues' Micro-messages on the User Profile > Activities Tab >
Colleagues subtab, and to notify others on the My Activities subtab.

Managing User Communities

16-186 ReferenceManual
Version 8.01 Rev 4



Micro-messaging Display Modes
This Micro-messaging server control has four modes, which let you control the
messages being displayed.

Mode Displays this type of micro-message For more information, see

User From the user associated with the control User Mode on next page

Colleagues From the user associated with the control and his
colleagues

ColleaguesMode on page 16-
189

TimeLine For all site userswhosePrivate Profile setting is set to
Public

TimeLineMode on page 16-
190

Message A singlemicro-message on a page MessageMode on page 16-190

Associating the Control with a User
Like other Ektron CMS400.NET server controls, there are two ways to specify
the user associated with the control.

the server control’s DefaultObjectID property. Do this to display a
particular user’s micro-messages on a page.

Micro-messaging DisplayModes
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the user ID is retrieved from the page URL, which typically contains
the logged-in user ID (see example below). Do this to display micro-
messages of the logged-in user.

User Mode
This mode displays micro-messages from the user associated with the control.
See Also: Associating the Control with a User on previous page

Use this mode to show micro-messages for a specified user, such as on a User
Profile page. For example, when Mark views his own page in User Mode, he can

see his messages

submit a new micro-message. For example, he updates his status.

search all micro-messages. See Also: Searching for Micro-messages
on page 16-192.

Below is an example of the Micro-messaging server control with the Mode
property set to User.

Using User Mode while Viewing Another User’s Profile
In User Mode, a user can view the control that is associated with another user.
For example, one user views another's profile, which contains the Micro-
messaging control in User Mode.
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The visitor sees only micro-messages of the user who owns the profile. The
visitor cannot submit a micro-message from his colleague’s profile page, nor
can he search micro-messages.

For example, Bob and Steve are colleagues. When Bob views Steve’s profile
page, he

sees all of Steve’s messages

sees messages from colleagues they have in common

cannot update his status

cannot search messages

Colleagues Mode
Colleagues Mode displays micro-messages from the user associated with the
control and his colleagues. Use this mode to show micro-messages for these
users, such as on a user profile page.

When a logged-in user visits a page containing a Micro-messaging control in
colleagues mode, he can

see his messages

see his colleagues’ messages

update his profile

search micro-messages. See Also: Searching for Micro-messages on
page 16-192

Using Colleagues Mode while Viewing Another User’s
Profile
A user can also view the control in Colleagues Mode when it is associated with
another user. For example, one user views another user’s profile, which
contains the Micro-messaging control in Colleagues Mode.

The first user only sees micro-messages from the user who owns the profile
and colleagues he has in common with the other user. The first user cannot
submit a micro-message from his colleague’s profile page, nor can he search
micro-messages.

For example, Bob and Steve are colleagues. When Bob views Steve’s profile
page, he

sees all of Steve’s messages

sees messages from colleagues they have in common

cannot update his status

cannot search messages

ColleaguesMode
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TimeLine Mode
This mode displays micro-messages for all of a site’s users whose Private
Profile setting is set to Public. This mode displays a chronological stream of
micro-messages from all such users, with the most recent at top.

Whenever a user whose profile is set to Public submits a micro-message, it’s
added to the time line.

From the time line page, logged in users can reply to and search micro-
messages. See Also: Replying to a Micro-message on page 16-195, Searching
for Micro-messages on page 16-192

Message Mode
This mode displays a single micro-message on a page.

For example, John sends his boss a link to a micro-message that praises his
work. When his boss clicks the link, he is taken to a page that contains this
control. See Also: Making a Hyperlink to a Single Page Version of a Micro-
message below

Making a Hyperlink to a Single Page Version
of a Micro-message
Each micro-message includes a time lapse, that is, the length of time since a
message was submitted. See example below.
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Each micro-message’s time lapse can become a hyperlink that contains the ID
of that message and a destination window. As a result, users can click the link
to view that message in the new window, as shown below.

The destination window must

be identified in the properties of the Micro-messaging server control
that displays the original message

contain a Micro-messaging server control in Message Mode

Users can also copy the link and send it to another user, who can then view the
message. To copy a time lapse’s link information, hover over the link, right
click, and select Copy Shortcut (if using Internet Explorer) or Copy Link
Location (if using Firefox).

Note: If someone sends a micro-message link to another user who is ineligible to see the
message, it does not appear. To see the message, either the user who submitted it has his
profile set to Public, or the link recipient must be a colleague of the message's creator.

Below is an example of how to set up this capability.

Page1.aspx contains a Micro-messaging server control that displays a
user’s micro-messages. The messages’ time lapses are hyperlinks.

Page2.aspx has a Micro-messaging server control in Message Mode.
It displays the individual message whose time lapse was clicked on
the first page.

Making a Hyperlink to a Single Page Version of a
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Note: For a full description of the Micro-message server control properties, see Micro-
messaging Server Control Properties on page 16-197.

1. On Page1.aspx, add a Micro-messaging server control.

2. Set the DynamicObjectParameter to id.

3. Set the TemplateMessage to the path to Page2.aspx.

4. Set the Mode property to anything other than Message.

5. Save Page1.aspx.

6. On Page2.aspx, add a Micro-messaging server control.

7. Set the DynamicObjectParameter to id.

8. Set the Mode property to Message.

9. Save Page2.aspx.

Now, when you log in to your site and navigate to Page1.aspx, you see a list of
your micro-messages. If you click the time lapse on any message, Page2.aspx
loads, showing the message you clicked.

Searching for Micro-messages
The Micro-messaging server control includes search functionality that prompts
a user to enter terms and returns micro-messages that match them. The search
looks through micro-messages only. It does not search content, products,
users, or groups.

When searching, a user can only find micro-messages submitted by

one's self

one's colleagues

users whose profile is set to public

The following topics explain how to enable and use the micro-message search.

n Enabling the Micro-message Search on the facing page

n Entering Multiple Search Terms on page 16-194
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Enabling the Micro-message Search
The micro-message search requires your server to have the Full Text Search
component of Microsoft SQL Server.

You can install the Full Text Search component during the installation of
Microsoft SQL Server.

Installing the Full Text Search Component
If the Full Text Search component is not installed, and you want to use the
Micro-messaging search functionality, insert the SQL Server installation disc
into your computer and look for Full Text Search.

After the Full Text Search is installed, run the FullTextIndex.sql script on your
database. This script is located in:

Program Files\Ektron\CMS400v80\Utilities\SiteSetup\Database\FullTextIndex.sql

Running a Micro-message Search
When Micro-message search is enabled, a Search tab appears on the control.
To use the search, click the tab and enter search terms.

Enabling theMicro-message Search

ReferenceManual
Version 8.01 Rev 4

16-193



When results appear, you can click any message’s time span to proceed to the
message itself. If a reply appears among search results, you can click the link
indicated below to view the original message.

Entering Multiple Search Terms
You can enter more than one search term. If you do, the terms have an “and”
relationship. For example, if you enter Community and Group, only messages
containing both Community and Group are found.

Multiple Search Term Example
Consider the following micro-messages:

Peter:Wow, this is a great community.

Paul: I just joined the Motorcycle group

Mary: I just created a new community group for Scrapbooking called “Clippers”

If you enter Community Group in the search box, the search returns only
Mary’s message, since it is the only one with both words.
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Replying to a Micro-message
The Micro-message control lets users reply to micro-messages and nests the
reply with the original message. Anyone who can see a message can reply to it,
and see all other replies.

To add a reply, hover over a message and click the Reply button ( ). When
you do, a dialog box prompts you to submit a reply of up to 2000 characters.
The box also displays the original message.

Replies do not appear when a micro-message is viewed. Instead, a Replies
link appears below the comment. The number of replies appears next to the
link.

Click Replies to view them. The newest replies are at the top.

Replying to aMicro-message
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To remove a reply, click the Delete button ( ),which appears when you hover
over the reply. Only the user who submitted the reply and the message board
owner can delete replies.

Filtering Micro-message Spam
You can filter spam from Micro-messages. Ektron defines spam filtering as
preventing users from posting a micro-message or replying using:

the same message more than once a day

any second message within a specified time period after posting a
first

the same message within a specified time period

Note: If a user enters a micro-message and a reply that have the same text, each can be sent
once without being stopped by the spam filter. However, if either is sent a second time within
the specified time period, the spam filter blocks it.

The Micro-messaging server control also lets you define custom spam filters.

To define a spam filter, use the SpamControlType property on the
MessageBoard server control. The table below provides possible values and
examples of how to set that property.

As a developer I want to...
So I set the SpamControlType
property to...

And I set the
SpamTimeSpan
property to …

Prevent the same user from
posting the samemessagemore
than once a day

SameUserSameMessageSameDay

Prevent a user from posting any
additionalmessages for 30
minutes

SameUserTimeDelay 1800

Prevent a user from posting the
samemessage for 2 hours SameMessageTimeDelay 7200

Usemyown spam filter code

Customand add the code to the code
behind page of the template containing the
Micro-messaging server control. See Also:
Creating a CustomSpamFilter below

Creating a Custom Spam Filter
You can create your own spam filter in the code behind of the page that contains
the Micro-messaging control. To do this, set the SpamControlType property to
Custom, call the CustomSpamMethod in the page load event, and point it to your
custom spam filter method.
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The following Visual Basic example blocks the text “Hello World.”

Partial Class Default

Inherits System.Web.UI.Page

Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles
Me.Load

Me.MicroMessaging1.CustomSpamMethod(AddressOf SpamHandler)

End Sub

Private Function SpamHandler(ByVal data As Ektron.Cms.MicroMessageData) As Boolean

If data.MessageText = "Hello World" Then

Return True

End If

End Function

End Class

Micro-messaging Server Control Properties
The Micro-messaging server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and
can use it to browse to Content, Collections, etc. See
Also: Working with Ektron CMS400.NET Server
Controlson page 24-1

String

CacheInterval

Sets the amount of time the server control’s data is
cached. The default is 0 (zero). This is the amount of
time, in seconds, a control’s data is cached.

For example, if you want to cache the data for five
minutes, set this property to 300 (three hundred). See
Also:Caching with Server Controlson page 24-33

Double

DefaultObjectID The default object ID for this control to use when there is
nomatching dynamicparameter value passed. Long
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Property Description Data Type

DisplayXslt

Determineshow information is displayed on the page.
Enter the path to the XSL file. It can be relative or
absolute.

Warning! : If you specify an external file, it is strongly
recommended that you do not store this file your site’s
Workarea folder. If you store this file in theWorkarea
folder, the file will be lost when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to
false if you want to postpone the fill-action until later. In
this case, FIll is automatically called during the Page
Render event.

Youmight do this if you need to set or change a property
on the control in codebehind and have it render with your
changes shown.

Boolean

DynamicObjectParameter

Gets or sets the QueryString parameter to read a object
ID dynamically. To use the default object ID, leave blank.

For example, if you are passing the ID value of a user,
youmight enter ‘uid’ for this property. So, if you passed
http://~yoursite~/UPpage.aspx?uid=21
on theQueryStrings to a page containing this control,
you would see the list of Micro-messages for the user
with an ID of 21.

String

EnablePaging

This property, in conjunction with theMaxResults
property, lets site visitors view an unlimited number of
notificationswhile controlling the amount of screen
space. To accomplish this, the display is limited to the
number set in theMaxResults property.

If you set this property to true, and the number of items
exceeds theMaxResults number, navigation aids
appear below the last item.

Boolean

Hide

Used to hide output of the control in design time and run
time.

True =Hide control

False =Display control

Boolean

Language
Set a language for viewing the ActivityStream control.
This property shows results in design-time (in Visual
Studio) and at run-time (in a browser).

Integer

MaxResults Themaximum number of messages to return. 0 (zero) =
unlimited. Integer

MaxSearchResults
Themaximum number of messages to return when
performing amicro-message search.
0 (zero) = unlimited.

Integer

Managing User Communities

16-198 ReferenceManual
Version 8.01 Rev 4



Property Description Data Type

Mode

Specify the type of micro-messages you want to display.
Choicesare:

User—micro-messages for logged-in user with
search option

Colleagues—micro-messages for logged-in user and
colleaguesof a specified user with search option

TimeLine—micro-messages from all site userswhose
Private Profile setting is set to Public; includes search
option

Message—a singlemessage

See Also:Micro-messaging DisplayModeson page 16-
187

ActivityFeedType

ProfileParamName

The parameter name to pass in the QueryString to the
TemplateUserProfile page, if you want it to be anything
other than id.

For example, youmayprefer messageid, because it is
more descriptive.

String

SpamControlType

Assignsa spam filter to themicro-messages. The control
supplies three predefined spam filters, and the ability to
define your own.

Note: Spam control is turned off by default.

Filter choicesare:

SameUserMessageDay—prevents a user from
posting the samemessage to the boardmore than once
per day

SameUserTimeDelay—prevents a user from posting
another message for specified period of time. The
amount of time is specified, in seconds, in the
SpamTimeSpan property.

SameMessageTimeDelay—prevents a user from
posting an identicalmessage for a specified period of
time. The amount of time is specified, in seconds, in the
SpamTimeSpan property.

Custom—control uses custom spam filter code. See
Creating a CustomSpamFilter on page 16-196.

See Also: FilteringMicro-message Spam on page 16-
196

SpamTimeSpan

Sets the amount of time, in seconds, for which the
SameUserTimeDelayor SameMessageTimeDelay
spam filter delaysa user from posting. These values can
be selected in theSpamControlType property.

See Also: FilteringMicro-message Spam on page 16-
196

Integer
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Property Description Data Type

Stylesheet
Specify the path to a style sheet for use with the
Documents server control. The location can be relative
or absolute. Leave blank to use the default style sheet.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the
control. The default isFalse.

True—Suppresswrap tags.

False—Allow wrap tags.

Boolean

TemplateMessage

The URL path to a page that contains another Micro-
messaging server control.

When this property contains such a path, and the
destination page hasaMicro-messaging controlwhose
Modeproperty is set to Message, a user can click amicro-
message’s time span on the first page to open a second
page that contains just that message.

See Also:Making a Hyperlink to a Single Page Version of
aMicro-message on page 16-190

String

TemplateUserProfile

The URL path to the page that contains the UserProfile
server control. This path can be relative or absolute.

If you enter a path, a user can click anyuser’s name or
avatar from theMicro-message server control and be
forwarded to his profile page. See illustration below.

Note that user templates can be defined in the Ektron
CMS400.NET Workarea > Settings > Community
Management > Templates screen.

However, if you assign a template in this field, this setting
takesprecedence over the setting on theWorkarea
Template screen.

String
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Property Description Data Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span—The <span> tag is used to designate an inline
portion of an HTML document asa span element.

Div—The <div> tag is used when you want to apply
attributes to a blockof code.

Custom—Allowsyou to use a custom tag.

String

Using Ektron's Micro-messaging
Bookmarklet
A Micro-messaging bookmarklet, a feature of Ektron CMS400.NET's Community
Management, lets users inform colleagues about Web pages using a micro-
message without leaving the Web page they are viewing.

Here is an example of such a micro-message.

To create this micro-message, a user

1. Navigates to a Web page.

2. Clicks a link on the browser's Bookmark or Favorites menu/toolbar.

3. That action automatically posts a link to that Web page as a micro-
message. The user can add a comment. For example:

Using Ektron'sMicro-messaging Bookmarklet
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Note: In Internet Explorer, these toolbar shortcuts are known as favorites. In Firefox, they are
known as bookmarks. This documentation calls them bookmarks.

This documentation covers the following aspects of providing the bookmarklet
feature.

User Experience: Using Ektron's Micro-messaging Bookmarklet on pre-
vious page

Developer Experience: Placing a Bookmarklet Link on a Web Page on
page 16-205

Micro-messaging Bookmarklet Server Control on page 16-205

See Also: Micro-messaging Server Control on page 16-184

How a User Submits a Web Page Link as a
Micro-message
Prerequisite: A developer has placed a Micro-messaging bookmarklet link on
a Web page See Also: Placing a Bookmarklet Link on a Web Page on page 16-
205

Before a user can use the Micro-messaging bookmarklet feature, he must add a
Bookmarklet link to his bookmark toolbar or menu. To do that, he follows these
steps.

Adding a Bookmarklet Link to a Browser
1. The user navigates to a page that contains a Micro-messaging

bookmarklet link (see examples below).
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Note: The text of the Micro-messaging bookmarklet link changes according to the user's
browser. Also, the image above text reflects the default text; developers can easily change it.

2. He right clicks a bookmarklet link and follows the screen instructions
to add it as a Bookmark.

3. The Bookmarklet appears on the toolbar (see example below).

Note: There is no limit to the number of Bookmarklets you can have. Each instance within a
site is customized for that site, and there would be no conflict between them.

Posting a Web Page Link as a Micro-message
1. A user navigates to a page that he wants to post as a micro-message.

2. He clicks the bookmarklet link (circled above).

3. The following screen appears.

Note: If the user is not logged in to Ektron CMS400.NET, he is prompted to do so.

Posting aWeb Page Link as aMicro-message
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4. He can add comments to replace What would you like to say?

5. He can click to edit the title and description.

6. He clicks the Share button.

7. His post is now shared in a micro-message with colleagues, as shown
below.

The micro-message appears in the user's Activity Stream if it is set up to track
micro-messages. See Also: Micro-messaging Server Control on page 16-184
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Placing a Bookmarklet Link on a Web Page
You can place a micro-messaging bookmarklet on any template using the
Bookmarklet Server Control. To enable the Bookmarklet feature, a developer

n places a Micro-messaging Bookmarklet Server Control below on a
page

n if desired, he can Review and Modify the Post to Profile Form on page
16-207

Micro-messaging Bookmarklet Server
Control
You drop a Micro-messaging Bookmarklet Server Control onto a page as you do
any Ektron CMS400.NET server control. See Also:Working with Ektron
CMS400.NET Server Controls on page 24-1

Bookmarklet Server Control Samples
Three samples of this control appear on the Developer Sample > Social
Networking > MicroMessage > Bookmarklet page. Within the Ektron
CMS400.NET developer sample site, this template (bookmarklet.aspx) is
installed to site root/Developer/Micromessaging.

Note: The Micro-messaging Bookmarklet Server Control detects the user's browser and
modifies the text accordingly.

The Bookmarklet Server Control is a template-based server control. For more
information on these types of server controls, see Building Templated Server
Controls on page 24-32.

The FormURL Property
The most significant property of this server control is FormURL, which specifies
the form that appears when a user clicks the Micro-messaging bookmarklet
link. See Also: Adding a Bookmarklet Link to a Browser on page 16-202
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By default, when a user clicks a Micro-messaging bookmarklet link, he is
redirected to the site rootWorkarea/share.aspx page. See Also: Review and
Modify the Post to Profile Form on the facing page

Micro-messaging Bookmarklet Server Control
Properties
The following table explains the properties of the Micro-messaging Bookmarklet
server control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value
Data
Type

ID A unique name you apply to this instance of the control. String

Authenticated

Indicates if you are logged in to the CMSExplorer and can use it to browse to
Content, Collections, etc.

See Also:Using CMSExplorer to Browse Your Ektron CMS400.NET Site on
page 24-8.

String

CssClass

Use this field if you want to change the .css classused in the default template’s
outermost wrapper (DIV tag).

This lets you change the styling and appearance of the server controlwithout
having to change themarkup.

String

FormURL The path to the page that appearswhen a user clicks theMicro-messaging
bookmarklet link. See Also: The FormURL Propertyon previouspage String

Hide

Used to hide a control in design time and run time.

True =Hide Bookmarklet control

False =Show Bookmarklet control

Boolean

IncludeCSS Lets you include or exclude the control's default .css file, which provides the
"lookand feel" of the control on aWeb page. Boolean

Language Set a language for viewing form content. This property shows results in design-
time (in VisualStudio) and at run-time (in a browser). Integer
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Property Value
Data
Type

LinkText

The text that appears on theMicro-messaging bookmarklet link.

You canmodify the lookand feel of this area byediting the
ektron.micromessaging.bookmarklet.css file in the site
root/Workarea/csslib folder.

String

OutputLinkIcon

True = show theMicro-messaging bookmarklet link icon (circled below) on the
button

False = suppress the icon

You canmodify the lookand feel of this icon byediting the
ektron.micromessaging.bookmarklet.css file in the site
root/Workarea/csslib folder.

Boolean

Popup Height The height of theMicro-messaging bookmarklet linkwindow in pixels Integer

PopupWidth The width of theMicro-messaging bookmarklet linkwindow in pixels Integer

SiteName

The name of the web site using this server control. The SiteName value is
embedded in the instructions for adding the bookmarklet to the toolbar. See
example below.

String

Visible
True = the control is visible and rendered

False = the control is not visible
Boolean

Review and Modify the Post to Profile Form
Ektron CMS400.NET provides the following sample form to appear when a user
clicks the Micro-messaging bookmarklet link on his browser's Bookmarks
menu. See Also: Adding a Bookmarklet Link to a Browser on page 16-202

Review andModify the Post to Profile Form

ReferenceManual
Version 8.01 Rev 4

16-207



The sample form, share.aspx, is installed to the site root/Workarea/ folder.
If you want to modify this form or create your own, enter the new path into the
Micro-messaging Bookmarklet server control's FormURL property.

Note: If you want to create your own form, Ektron recommends making a copy and placing it in
a folder other than Workarea since upgrades may overwrite it.

Here are a few things to note about this form's behavior.

If a user is not logged it, a Login server control must be added to
prompt him to do so.

The form lets the user enter or update three fields
comment entered by user

title tag text

meta description

All text on the form (including the URL) cannot exceed 2000 char-
acters.

The form accepts plain text only -- no formatting or images are
allowed.

This size of the screen is determined by the Bookmarklet server con-
trol's PopupHeight and PopupWidth properties.

The form generates a Micro-message, so it follows the conditions for
how Micro-messages are published. See Also: Micro-messaging
Server Control on page 16-184
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Flagging
Flagging allows a site visitor to flag a piece of content and provide feedback.
Flagging enables your site visitors to moderate your site. This is especially
important for sites with large amounts of visitor-generated content. Flagging
also helps site visitors feel invested in the site.

For example, you create a flagging definition with the following options that let
your site visitors decide if content is inappropriate.

n Sexually Explicit

n Mature (over 18 only) content

n Graphic Violence

n Hate Speech

Flagging can also be used to let site visitors leave an opinion about a content
item. Below is a sample list of options.

n Loved This Content

n Hated This Content

n I Could Take It or Leave It

Flagging is similar in function to the ContentReview server control. The main
differences are

n Flagging feedback is not displayed on the site

n The Flagging control provides a user-defined list describing the
reason for the flag

So, a flagging definition describes how a content item may be reviewed, and
provides a list of choices that may be applied to content in a folder. Here is
what one might look like on your site.

After you create a flagging definition, you assign it to relevant folders. All
content in the folders can then be flagged with that definition.

As the final step in allowing site visitors to flag content, a developer must add a
ContentFlagging server control to a Web page, and assign to it the ID of the
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content being flagged. See Also: ContentFlagging Server Control on page 16-
219.

Flagged content appears in the following Workarea locations.

n Content Flags list on the Smart Desktop

n Settings > Community Management > Flagging > Flagged
Content

n a content item’s View Content Reports > Flagging tab

This section also contains the following topics.

Flagging Definitions 16-210
Adding a Flagging Definition 16-211
Edit a Flagging Definition 16-211
Deleting a Flagging Definition 16-212
Assigning a Flagging Definition to a Folder 16-212
Flagged Content 16-213
Content Flags on the Smart Desktop 16-214
Flagged Content in Settings > Community Management 16-214
Viewing a Content Item’s Flags 16-216
Viewing a Flag’s Details 16-218
Editing a Flag’s Details 16-218
Deleting a Flag 16-219

Flagging Definitions
The Flagging Definitions screen is located in theWorkarea > Settings >
Community Management > Flagging. From here, you can view a list of
flagging definitions, work with them, or create new ones. In addition, you can
filter the list by language.

This screen contains the following information about a flagging definition.

Field Description

ID The ID of the flagging definition.

Name The name of the flagging definition.

Description A description of the flagging definition.

Language An image of a national flag associated with the language. For example,
American English appears as .
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Field Description

Items

The number of flags in a definition. For example, if you have a flag definition
for thesemovie ratings:

n G

n PG

n PG-13

n R

The itemscount for this definition is four.

This section contains the following topics.

n Adding a Flagging Definition below

n Edit a Flagging Definition below

n Deleting a Flagging Definition on next page

n Assigning a Flagging Definition to a Folder on next page

Adding a Flagging Definition
To create a flagging definition, follow these steps.

1. In theWorkarea, navigate to Settings > Community
Management > Flagging > Flagging Definitions.

2. Select a language with which the flagging definition will be
associated.

3. Click the Add button ( ).
4. The Add Flagging Definition screen appears.

5. Enter a Name and Description for the flagging definition.

6. Click the Option button ( ) to add a flag to this flagging definition.
7. Continue to click the Option button to add additional flags.

8. If necessary, change the order of the flags by clicking the Sorting
buttons ( ). If you create a definition you want to remove, click
the Remove button ( ).

9. Click the Save button ( ).

Edit a Flagging Definition
To edit a flagging definition, follow these steps.

1. In theWorkarea, navigate to Settings > Community
Management > Flagging > Flagging Definitions.

2. Click the flagging definition Name link or the ID link.

Adding a Flagging Definition
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3. Edit the options. If desired, you can change the order of the flagging
options by clicking the Sorting buttons ( ).

4. Click the Save button ( ).

Deleting a Flagging Definition
When you no longer want to use a flagging definition, delete it. When a flagging
definition is deleted, it is removed from all folders with which it is associated.

To delete a flagging definition, follow these steps.

1. In theWorkarea, navigate to Settings > Community
Management > Flagging > Flagging Definitions.

2. Click the flagging definition Name link or the ID link.

3. Click the Delete button ( ).

Assigning a Flagging Definition to a Folder
After creating a flagging definition, you assign it to one or more folders. When
you do, the flagging definition may be applied to content in that folder.

Like other folder properties, a folder’s flagging definitions may be inherited by
its child folders, although this does not occur by default.

To assign a flagging definition to a folder, follow these steps.

1. Create a flagging definition, as explained in Adding a Flagging
Definition on previous page.

2. Click the Content tab on the Smart Desktop.

3. Navigate to the folder that contains the content that may be flagged.

4. Select View > Properties from the View menu.

5. The View Properties screen appears.
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6. Click the Edit button ( ).
7. Click the Flagging tab.

8. Make sure the Inherit Parent Flagging Configuration check box
is not checked.

9. Select a flagging definition from the Flagging drop down.

10. Click the Save button ( ).

Flagged Content
There are three places in the Workarea to work with flagged content.

n The Smart Desktop, which indicates the most recent flags applied
to any content. See Content Flags on the Smart Desktop on next
page.

n Settings > Community Management > Flagging > Flagged
Content shows all flagged content. See Flagged Content in Settings
> Community Management on next page.

n A tab on the Content Reports screen displays a list of content flags
for a specific content item - See Viewing a Content Item’s Flags on
page 16-216.

Flagged content is more fully explained through the following topics.

n Content Flags on the Smart Desktop on next page

n Flagged Content in Settings > Community Management on next page

n Viewing a Content Item’s Flags on page 16-216

n Viewing a Flag’s Details on page 16-218

n Editing a Flag’s Details on page 16-218

n Deleting a Flag on page 16-219
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Content Flags on the Smart Desktop
This area lists the ten most recently added content flags. From there, you can
view a flag by clicking its Title.

To view all recent flags, click the View recent flags link. Clicking this link
takes you to the Content Reports: Recent Flags screen. See Also: Flagged
Content in Settings > Community Management below

Flagged Content in Settings > Community
Management
The Flagged Content area in Settings > Community Management >
Flagging > Flagged Content allows you to display a list of flags assigned to
content. By default, the list shows flags for the last ten days. You can change
this by entering a new number in the Show flags for the last # days field.

See Also: Flagging on page 16-209

The information for each flag is explained in this table.

Field Description

Title The title of the content blockbeing flagged. Clicking this link brings you to a
detailed description of the content’s flag.

DisplayName The name of the user who flagged the content as it is displayed on theWeb
site.

Date The date the content was flagged.

Flag The specific flag from the flagging definition for this content.

Comment Comments added by the site visitor who flagged the content.
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From this screen, you can perform the following actions:

n View the details of a submitted content flag - see Viewing a Flag’s
Details on page 16-218

n Generate a Flagged Content report - see Generating a Flagged
Content Report below

n Print a list of flagged content - see Printing a List of Flagged Content
below

n Filter flagged content by folder - see Filtering Flagged Content by
Folder below

n Filter flagged content by language - Filtering Flagged Content by
Language on next page

Generating a Flagged Content Report
By default the Content Reports: Recent Flags screen shows content flagged
within the last ten days. To view a different date range, follow these steps.

1. In the Workarea, navigate to Settings > Community Management
> Flagging > Flagged Content.

2. In the Showing flags for the last # days field, enter a new
number of days for which to show Flagged Content.

3. Click the Report button ( ).
4. The page refreshes and displays the new report.

Printing a List of Flagged Content
On the Content Reports: Recent Flags screen, you can output the flagged
content report to a printer by clicking the Print button ( ). This creates an
HTML version of the list that opens in a browser. From there, you can print the
list using the browser’s print options.

Filtering Flagged Content by Folder
From the Content Reports: Flagged Content screen, you can filter flagged
content by folder. This allows you to see flagged content for one folder. To do
so, follow these steps.

1. In the Workarea, navigate to Settings > Community Management
> Flagging > Flagged Content.

2. Click the Filter button ( )

Generating a Flagged Content Report

ReferenceManual
Version 8.01 Rev 4

16-215



3. The Select Folder screen appears.

4. Select a folder.

5. Click the Save button ( ).
6. The page refreshes, and any flagged content in the folder is shown.

Note: Only flagged content that falls within the time frame for the Showing flags for the past #
days field is shown. For example, if the field is set to five when you filter by a folder, only
content that’s been flagged in the last five days appears.

Filtering Flagged Content by Language
To see flagged content for a specific language, select the language from the
Language drop down box. When the page refreshes, only flagged content
associated with the language appears.

Viewing a Content Item’s Flags
You can also view flags for a specific content item. To see them, go to the
Content Report screen > Flagging tab. From this screen, you can filter flags
by a date range or see all flags associated with the content.

In addition, this screen contains a purge button, which allows you to remove all
flags associated with this content. This subsection contains the following topics:

n Viewing Flags Applied to a Content Item on the facing page

n Purging a Content Item’s Flags on the facing page
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Viewing Flags Applied to a Content Item
Follow the steps below to get flags for a content item.

1. In theWorkarea, find the content block for which to retrieve content
flags.

2. Click the title of the content block.

3. The View Content screen appears.

4. Click the Content Reports button ( ).

5. Click the Select Date button ( ) next to Start Date to select a start
date.

6. Click the Select Date button ( ) next to End Date to select an end
date.

Note: To retrieve all flags for a content item, leave the Start Date and End Date blank.

Note: To remove a Start Date or End Date, click the Delete Date button ( ).

7. Click the Get Flags button.

8. A list of flags applied to that content within the selected date range is
displayed.

Purging a Content Item’s Flags
If you need to delete flags for a content item, follow these steps.

1. In the Workarea, find the content block for which to purge content
flags.

2. Click the title of the content block.

3. The View Content screen appears.

4. Click the Content Reports button ( ).
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5. Click the Select Date button ( ) next to Start Date to select a start
date.

6. Click the Select Date button ( ) next to End Date to select an end
date.

Note: To purge all flags for a content item, leave the Start Date and End Date blank.

Note: To remove a Start Date or End Date, click the Delete Date button ( ).

7. Click the Purge Flags button.

8. The flags are removed.

Viewing a Flag’s Details
Viewing a flag’s detail information allows you to read the entire comment if it is
truncated in one of the lists. You can also edit or delete a flag from this screen.

To view detailed flag and comment information, follow these steps.

1. Navigate to one of these area in the Workarea:

- Smart Desktop > Content Flags widget

- Settings > Community Management > Flagging > Flagged
Content

- Reports > Contents > Content Flags

2. Click either a flag’s content title or the flag’s date.

3. The flag’s detail information appears.

See Also: Editing a Flag’s Details below; Deleting a Flag on the facing page

Editing a Flag’s Details
Editing a flag allows you to change the flag’s selection or the comments for a
flagged content item. This can be useful if a user selects a flag by mistake, or
you want edit a flag’s comments. For example, a user selects the “Offensive
Content” flag but he meant to click “Copyright Violation”.

To edit a flag or its comment information, follow these steps.

1. Navigate to one of these area in the Workarea:

- Smart Desktop > Content Flags

- Settings > Community Management > Flagging > Flagged
Content

- Reports > Contents > Content Flags

2. Click either a flag’s content title or the flag’s date.

3. The flag’s detail information appears.

4. Click the Edit button ( ).
5. Change the flag or edit the comments.
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6. Click the Save button ( ).
7. The flag’s information is changed.

Deleting a Flag
When you do not need a flag, you can delete it from the system. When you do,
the flag is permanently removed.

To delete a flag, follow these steps.

Note: To remove all flags associated with a specific content item, see Purging a Content Item’s
Flags on page 16-217.

1. Navigate to one of these area in theWorkarea:

- Smart Desktop > Content Flags

- Settings > Community Management > Flagging > Flagged
Content

- Content Reports > Flagging tab for a content item

2. Click either a flag’s content title or the flag’s date.

3. The flag’s detail information appears.

4. Click the Delete button ( ).
5. A dialog appears asking you to confirm the deletion.

6. Click OK.

ContentFlagging Server Control
Note: To learn about creating and managing the content flags used in this server control, see
Flagging on page 16-209.

After you add this control to a Web form, a site visitor who views nearby
content can flag it and provide feedback. This is similar to the ContentReview
server control. The main differences are:

n The feedback is not displayed on the site

n The control provides is a user-defined list describing the reason for
the flag

Lists can be centered on content that is inappropriate for some viewers. For
example:

n Sexually Explicit

n Mature (over 18 only) content

n Graphic Violence

n Hate Speech

Deleting a Flag
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Flagging can also be used to notify administrators about the quality of the
content, helping you to create a recommended content list. Below is an example
of a flagging definition’s options.

n Loved This Content

n Hated This Content

n I Could Take It or Leave It

Having a way to flag content is a necessity for sites with a large quantity of site-
visitor generated content. Content flagging spreads moderation of your site to
your visitor base and helps site visitors feel invested in the site.

ContentFlagging Server Control Properties
The ContentFlagging server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description
Data
Type

Authenticated

Indicates if you are logged in to the CMSExplorer
and can use it to browse to Content, Collections, etc.

See Also:

Working with Ektron CMS400.NET Server Controls
on page 24-1

String

DefaultContentID
The default content ID for this control to use when
there is nomatching dynamicparameter value
passed.

Long

DisplayXslt

Determineshow information is displayed on the
page. Enter the path to the XSL file. It can be relative
or absolute.

Warning! If you specify an external file, it is strongly
recommended that you do not store this file in your
site'sWorkarea folder. If you store this file in the
Workarea folder, the file will be lost when you
upgrade.

String
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Property Description
Data
Type

DoInitFill

By default, Fill occurs during the Page_Init event. Set
to false if you want to postpone the fill-action until
later. In this case, FIll is automatically called during
the Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

DynamicParameter
Gets or sets the QueryString parameter to read a
content ID dynamically. To use the default content ID,
leave blank.

String

FlagImage
Enter a path to an image that overrides the text in the
FlagTextproperty.When the image is clicked, the
flag dialog appears.

String

FlagText

Text for the link that is shown to allow flagging. For
example, youmight use “Click here to flag this
content.” The FlagImageproperty overrides this
property.When the text link is clicked, the flag dialog
appears.

String

Hide

Used to hide output of the control in design time and
run time.

True =Hide control.

False =Display control.

Boolean

Language
Set a language for viewing the ContentFlagging
control. This property shows results in design-time (in
VisualStudio) and at run-time (in a browser).

Integer

Stylesheet
Specify the path to a style sheet for use with this
server control. The location can be relative or
absolute. Leave blank to use the default style sheet.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround
the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

ContentFlagging Server Control Properties
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Property Description
Data
Type

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline
portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply
attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

Email Invitations for Community
Management
The Community Platform’s email notification feature enables Ektron
CMS400.NET to generate email that invites other users to

n join a community group

n join the site

n be a colleague

To create a message, follow these steps.

1. In the Workarea, go to Settings > Community Management >
Messages.

2. Click the Add button ( ).
3. Enter a title that describes the message.

4. At the Type field, click the dropdown arrow to choose the message
type.

5. Select whether to make the email message a Default message.

6. In the editor, enter the message text. Use the variables in the table
below to retrieve information into the invitation.

7. Click the Save button ( ).

Including Variables in the Default Message
Messages can include variables that retrieve information about the user sending
the invitation or the link to join a group and display it in the message text.

Variables are surrounded by at signs (@). For example: @appSenderName@
displays the name of the user sending the invitation. In the email, this text
might read:

Alan Administrator has invited you to join the Marketing Community Group.
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You can use the following variables in the body of email notifications.

Variable Displays this information in the email

@appOptionalText@ Text a user types into theOptional Message boxon the Invite server control.

@appSenderName@ The sender of the invitation

@appFriendDisplayName@ The recipient's name.

@appInvitedEmail@ The recipient's email address.

@appInviteId@

Appends the invite ID to the registration URL. For example:

Click<a
href=http://www.example.com/register.aspx&fInvId=@appInviteId@>here</a>
to accept.

@appGroupName@ The group a person is being invited to join.

Invite Server Control
Warning! The default From email address used to send all invitations is
invitation@example.com. Ektron, Inc. strongly recommends changing this address. See Also: An
Invitation’s "From" email Address on next page.

The Invite server control allows site visitor to invite people to join the site or
become a colleague. The control displays a dialog box that prompts for several
email addresses. The dialog includes an optional message, which appears in the
body of the email.

The site visitor can edit or delete the message.

Invite Server Control
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Note: Messages are defined in the Ektron CMS400.NETWorkarea. For more information on
that, see Email Invitations for Community Management on page 16-222.

This section also contains the following topics.

An Invitation’s "From" email Address 16-224
Invite Server Control Properties 16-224

An Invitation’s "From" email Address
All invitations have a single "from" email address. Its default value is
invitations@example.com. Your site administrator should change it to one
that is appropriate for your organization. To change all invitations' "from"email
address, open your site’s web.config file and change the value of following key.

<add key="ek_InvitationFromEmail" value="invitations@example.com"/>

Invite Server Control Properties
The Invite server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMS
Explorer and can use it to browse to Content,
Collections, etc.

See Also:

Working with Ektron CMS400.NET Server
Controlson page 24-1

String

DisplayXslt

Determineshow information is displayed on the
page. Enter the path to the XSL file. It can be
relative or absolute.

Warning! If you specify an external file, it is
strongly recommended that you do not store
this file in your site'sWorkarea folder. If you
store this file in theWorkarea folder, the file will
be lost when you upgrade.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, the
DisplayXslt property value is ignored.

String
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Property Description Data Type

DoInitFill

By default, Fill occurs during the Page_Init event.
Set to false if you want to postpone the fill-action
until later. In this case, FIll is automatically called
during the Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

FriendMessageId

The ID of themessage to send in the link section
of a FriendInvitation type email.

Thismessage is defined in theWorkarea >
Settings >Community Management >
Messages. See Also:Email Invitations for
CommunityManagement on page 16-222

If set to 0 (zero), the server control uses the
default message.

Long

Hide

Used to hide output of the control in design time
and run time.

True =Hide control

False =Display control

Boolean

InviteMessageId

The ID of themessage to send in the link section
of a GroupInvitation or FriendInvitation email.

Thismessage is defined in theWorkarea >
Settings >Community Management >
Messages. See Also:Email Invitations for
CommunityManagement on page 16-222

If set to 0 (zero), the server control uses the
default message.

String

Language

Set a language for viewing the Invite server
control. This property shows results in design-
time (in VisualStudio) and at run-time (in a
browser).

Integer

OptionalMessageText

The body text of the emailmessage. The text
appears in the Invite server control’s dialog box
and can be edited by site visitorswhen theyuse
the Invite control.

String

Stylesheet

Specify the path to a style sheet for use with the
server control. The location can be relative or
absolute. Leave blank to use the default style
sheet.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, the
Stylesheet property is ignored.

String
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Property Description Data Type

SuppressWrapperTags

Suppresses the output of the span/div tags
around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s
tag.

The default isSpan.

Span - The <span> tag is used to designate an
inline portion of an HTML document asa span
element.

Div - The <div> tag is used when you want to
apply attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

Messaging Server Control
The Messaging server control allows site users to send and receive messages.
Sent messages appear in their recipients' Inbox and the Sent Items list of users
who sent them.

Message recipients can be limited to a user’s colleagues or expanded to all
Ektron CMS400.NET users.

To learn how a site user interacts with this control on the site, see Messaging
Server Control above.

This section also contains the following topics.

Messaging 16-227
Sent Messages 16-227
Viewing a Message 16-228
Replying to a Message 16-228
Forwarding a Message 16-229
Moving to the Next or Previous Message 16-229
Printing a Message 16-229
Deleting a Message 16-229
Composing a New Message 16-230
Pre-Populating the Message's To: Field 16-230
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Messaging Server Control Properties 16-232

Messaging
The Messages control can appear on a site. It also appears in the Ektron
CMS400.NET Workarea.

Example of Messaging Server Control on Sample Site

Messaging Server Control in Ektron CMS400.NET Workarea

This initial messages screen displays the following information about each
message sent to the logged-in user: the user who sent the message, its
subject, and when it was sent.

From this screen, users can:

n view a list of messages sent to them. See Viewing a Message on next
page.

n compose a new message. See Composing a New Message on page
16-230.

n delete a message. See Deleting a Message on page 16-229.

n navigate to the sent messages list. See Sent Messages below.

Sent Messages
Sent Messages provides a list of messages you sent to others. The screen
displays the message recipients, subject, and when it was sent.
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From the Sent Messages list, you can:

n view a message's details. See Viewing a Message below.

n compose a new message. See Composing a New Message on page
16-230.

n delete a sent message. See Deleting a Message on the facing page.

Viewing a Message
To view a message’s details, click its subject. The details include: user who sent
message, recipients, subject, date sent, and message body.

Actions you can take from the message details screen include:

n Reply - see Replying to a Message below.

n Forward - see Forwarding a Message on the facing page.

n Move to Next or Previous message - see Moving to the Next or
Previous Message on the facing page

n Print - see Printing a Message on the facing page.

n Delete - see Deleting a Message on the facing page.

n Compose new message - See Composing a New Message on page 16-
230.

Replying to a Message
When replying to a message, your reply goes only to the person who sent the
message.

By default, a reply contains the original message's subject and body text. But,
they can be edited or removed from the new message.

To reply to a message, follow these steps.

1. Find the message to which you want to reply

2. Click the subject.

3. Click Reply ( in the Workarea).
4. The editor appears with the original message’s subject and body text.

5. Compose your reply.

6. Click the Send button.
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Forwarding a Message
When forwarding a message, you select any number of recipients. A forwarded
message initially contains the original message's subject and body text, but
they can be edited or removed from the new message.

To forward a message, follow these steps.

1. Select the message you want to print.

2. Click Forward ( in the Workarea).
3. The editor appears with the original message’s subject and body text.

4. Select recipients.

5. Edit the message as desired.

6. Click the Send button.

7. The message is sent.

Moving to the Next or Previous Message
Web site users can navigate through their messages by clicking the Next or
Previous link, located in the message header. Next (  in the Workarea)
opens the next newest message in the list, while Previous (  in the
Workarea) opens the next oldest message.

Printing a Message
To print a message, follow these steps.

1. Select the message you want to print.

2. Click Print ( in the Workarea).
3. The Print dialog box appears.

4. Select a printer.

5. Click the Print button.

Deleting a Message
Deleting a message permanently deletes it from Ektron CMS400.NET. To delete
a message, follow these steps.

1. From the Messages area, select a message then click the Delete
button ( in a sample site, in the Workarea).

2. A dialog asks you to confirm the deletion.

3. Click OK.

4. The message is deleted.
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Composing a New Message
Clicking Compose launches the Compose a Message screen. To compose a
message, follow these steps.

1. From a Web site's Messages area, click Compose. From the Ektron
CMS400.NET Workarea Messages area, click the circled toolbar
button.

2. The Compose Message screen appears (Workarea version appears
below).

3. Click the Browse Users link.

4. Select recipients.

5. Add a subject in the Subject field.

6. Add the message body in the editor.

7. Click the Send button ( in the Workarea).

Pre-Populating the Message's To: Field
You can populate a message's To: field with user names by setting the
RecipientParamName property to a QueryString parameter. This feature lets
you create a link on a page, such as Send a Message to this user or Send a
message to all users in this group.
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For example, you create a Web page link to a template containing the
Messaging server control, pass a user’s ID in the QueryString as UID, and
populate the RecipientParamName property with UID. As a result, the server
control reads the user’s ID and completes the To: field with the user’s name.

Here is how the link might look: messaging.aspx?g=pmessage&uid=1

You can pass multiple user IDs. For example:
messaging.aspx?g=pmessage&uid=1&uid=20&uid=12&uid=18

Warning! You must include the g=pmessage parameter in the QueryString to open the
Messaging server control to its editor. Otherwise, the server control opens to the Inbox.

The VB example below creates a dynamic hyperlink that populates a message's
To: field with a logged in user’s colleagues. For this example to work, add a
Literal control to a Web form and name it Lit1.

Notes are included as comment text.

Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs)
Handles Me.Load

Dim frnds As New Ektron.Cms.API.Community.Friends()
Dim apicontent As New Ektron.Cms.ContentAPI
Dim dirUsrData() As Ektron.Cms.DirectoryUserData

If (apicontent.UserId > 0) Then
dirUsrData = frnds.GetFriends(apicontent.UserId)
If ((Not IsNothing(dirUsrData)) AndAlso (dirUsrData.Length > 0))

Then
Dim idx As Integer
Dim friendsList As String = String.Empty
For idx = 0 To dirUsrData.Length - 1

'friendsList += "&uid=" + dirUsrData(idx).Id.ToString()
friendsList = friendsList + "&uid=" +

dirUsrData(idx).Id.ToString()
Next
Lit1.Text = "<a href=""MsgSample.aspx?g=pmessage" +

friendsList + """>Send a message to my friends</a>"
'
'Replace MsgSample.aspx with the Web form that contains the messaging server
control.
'Set the RecipientParamName property to "uid" for this example.
'

Else
Lit1.Text = "The logged in user currently has no friends"

End If
Else

Lit1.Text = "You must be logged in to run this demo"
End If
apicontent = Nothing
frnds = Nothing

End Sub
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Messaging Server Control Properties
The Messaging server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMS
Explorer and can use it to browse to Content,
Collections, etc. See Also:Working with Ektron
CMS400.NET Server Controlson page 24-1

String

DisplayXslt

Determineshow information is displayed on the
page. Enter the path to the XSL file. It can be
relative or absolute.

Warning! If you specify an external file, it is
strongly recommended that you do not store
this file in your site'sWorkarea folder. If you
store this file in theWorkarea folder, the file will
be lost when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event.
Set to false if you want to postpone the fill-action
until later. In this case, FIll is automatically called
during the Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

EnablePreSearch

When set to True, all users are pre-loaded and
displayed in the search resultswhen browsing
for users (an empty string search). If the
FriendsOnly property is set to True, only
colleaguesare pre-loaded and displayed.

Boolean

FriendsOnly

When set to True, users can only send
messages to their colleagues. Default is True.

True = sendmessages to colleaguesonly

False = sendmessages to all Ektron
CMS400.NET users

Boolean

GroupParamName

Enter the QueryString parameter used to pass
the ID of a community group. The default isgid.

Use this property to email allmembersof a
group.

String

Managing User Communities

16-232 ReferenceManual
Version 8.01 Rev 4



Property Description Data Type

Hide

Used to hide output of the control in design time
and run time.

True =Hide control

False =Display control

Boolean

JavascriptEditorHeight

Set the height in pixels for the editor. The default
is400.

Note: Asof version 7.6, the JavaScript editor
hasbeen removed from Ektron
CMS400.NET. This property hasbeen
deprecated.

Integer

JavascriptEditorHTMLMode

Note: Asof version 7.6, the JavaScript editor
hasbeen removed from Ektron
CMS400.NET. This property hasbeen
deprecated.

Set to True to allow users to edit their posts and
replies in HTML. The default isFalse.

String

JavascriptEditorToolbar

Note: Asof version 7.6, the JavaScript editor
hasbeen removed from Ektron
CMS400.NET. This property hasbeen
deprecated.

Decide which buttonsare available in the
Javascript Editor.

String

JavascriptEditorWidth

Set the width in pixels for the editor. The default
is625.

Note: Asof version 7.6, the JavaScript editor
hasbeen removed from Ektron
CMS400.NET. This property hasbeen
deprecated.

Integer

Language
Set a language for viewing the server control.
This property shows results in design-time (in
VisualStudio) and at run-time (in a browser).

Integer

Messaging Server Control Properties

ReferenceManual
Version 8.01 Rev 4

16-233



Property Description Data Type

ProfileParamName

TheQueryString parameter used to pass the ID
of a user to a profile page or location template
when a user name is clicked in the Browse User
screen. The default is ID.

The parameter defined in this property is
appended to the QueryString of the path defined
in theProfileUrl property. The default is ID.

Warning! This parameter must match the
parameter set in the UserProfile server
control’sDynamicParameter property on
the page defined in theProfileUrl
property.

String

ProfileUrl

The URL of the profile page template. This page
opens in a new window when a user clicks a
display name on the Browse Users screen.

This providesadditional profile information about
the potentialmessage recipient.

String

RecipientParamName

Enter the QueryString parameter used to passa
user ID. For example, if the QueryString is
?uid=1, enter uid in this property.

To pass several users, enter a comma -
separated list of user IDs. For
example:?uid=1,20,12,18

This property is typically used when you want to
populate amessage's To: field. See Also:Pre-
Populating theMessage'sTo: Field on page 16-
230

String

Stylesheet

Specify the path to a style sheet for use with the
server control. The location can be relative or
absolute. Leave blank to use the default style
sheet.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, the
Stylesheet property is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tags
around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Description Data Type

UserSearchDisplayXslt

The XSLT used to display the user search
control inside theMessaging server control. The
default isMsgUserSelect.xsl.

Warning! : If you want to edit this file, it is
strongly recommended that youmake a copy,
change its name andmove it outside of your
site'sWorkarea folder. If youmake changes to
this file and do not move it out of theWorkarea,
this file and the changeswill be lost when you
upgrade.

String

WrapTag

Allowsa developer to specify a server control’s
tag. The default isSpan.

Span - The <span> tag is used to designate an
inline portion of an HTML document asa span
element.

Div - The <div> tag is used when you want to
apply attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String

SocialBar Server Control
The SocialBar server control allows users of a community Web site to
bookmark colleagues, community groups, and content. The following table
explains the details.

Item being
bookmarked

Description

Users
n Sends colleague requests

n Removes colleagueswhen a user visits another user’s profile page

Group
n Join and leave community group

n Invite others to join group

Content Add or remove content and URLs from a user’s Favorites. See Also: Favorites
Server Controlon page 16-45

The Social Bar control is also used to bookmark Web pages with Social
Bookmarking services, such as Digg.com or del.icio.us. By default, Digg.com
and del.icio.us are loaded in the Items property of the server control. See
Also: Items Property on page 16-242

In addition, the Social Bar control can print or email a Web page, and invite
non-site users to become members of the site. Clicking Invite links to a Web
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page that hosts the Invite server control. See Also: Invite Server Control on
page 16-223.

This section also contains the following topics.

Adding a Web Page URL to a Favorites Via the Social Bar 16-236
Private Messaging from the Social Bar 16-238
Tweeting the URL a User is Currently Browsing 16-238
SocialBar Server Control Properties 16-239
Items Property 16-242

Adding a Web Page URL to a Favorites Via
the Social Bar
See Also: Adding a URL to Your Favorites via the Favorites Control on page 16-
46

You can allow users to add a Web page’s URL to their Favorites when they click
Add to Favorites on the Social Bar. Typically, you would do this if more than
one content item appears on a Web page, but you want only one Social Bar
control on the page.

The image below shows a web page with several content items. A Social Bar
control is associated with each one. In this example, when a user clicks Add to
Favorites, he adds the associated content item to his Favorites.
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In the second image, one Social Bar appears on the Web page with several
content items. In this example, if a user clicks Add to Favorites on the Social
Bar, he adds the Web page’s URL to his Favorites.

To allow users to add a URL to their Favorites from the SocialBar server
control, follow these steps.

1. Drag and drop a SocialBar server control on a Web form.

2. Set the DefaultObjectID property to 0 (zero).

3. Leave the DynamicObjectParameter property blank.

Adding aWeb Page URL to a Favorites Via the
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4. If it is not already there, copy the comma-separated list of items
from the Items property to the Addto item property.

5. Set the ObjectType property to Content.

Private Messaging from the Social Bar
Users can send private messages to another user or the community group
administrator from the Social Bar control. To enable this feature, follow these
steps.

1. Drop a SocialBar server control on a user’s profile or community
group’s page.

2. Set the ObjectType property to User or Group.

3. Add either PrivateMessageUser or PrivateMessageAdmin to
Items property.

- Use PrivateMessageUser to let a user send a message to the user
whose profile is being viewed.

- Use PrivateMessageAdmin to let a user send a message to the group
administrator.

4. In the MessagingUrl property, identify a page that contains the
Messaging server control. See Also: Messaging Server Control on
page 16-226

5. Make sure the DynamicObjectParameter is set, if necessary.

See Also: Items Property on page 16-242

Tweeting the URL a User is Currently
Browsing
You can allow site visitors to use Twitter to tweet their current browsing
location. You do this by adding the Twitter item to the list of parameters in the
SocialBar’s Items property.

After the item is added, a Twitter icon and link appear in the Social Bar. When a
user clicks the link, Twitter is launched. After a user logs into his Twitter
account, his current browsing location appears in the “What are you doing?”
status box. The user can then click Twitter’s Update button to post the status.

To allow users to tweet the URL they are currently browsing, follow these steps.

1. Drag and drop a SocialBar server control on a Web form.

2. Make sure the DefaultObjectID property is set to 0 (zero).

3. Leave the DynamicObjectParameter property blank.

4. If it is not already there, add the Twitter item to the comma-
separated list in the Items property.
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5. Set the ObjectType property to Content, User or Group,
depending on the type of page you are editing.

SocialBar Server Control Properties
The SocialBar server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and
can use it to browse to Content, Collections, etc. See
Also: Working with Ektron CMS400.NET Server
Controlson page 24-1

String

CacheInterval

Sets the amount of time the server control’s data is
cached. The default is 0 (zero). This is the amount of
time, in seconds, a control’s data is cached. For
example, if you want to cache the data for fiveminutes,
set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Double

DefaultObjectID

The default object ID for this control to use when there
is nomatching dynamicparameter value passed. If you
set this property set to 0 (zero) and leave the
DynamicObjectParameter blank, the social bar can be
used to addWeb pages to your favorites.

Long
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Property Description Data Type

DisplayXslt

Determineshow the Social Bar itemsare displayed on
the page. Enter the path to a customXSLT file. The
path can be relative or absolute.

Warning! If you specify an
external file, it is strongly recommended that you do
not store this file in your site'sWorkarea folder. If you
do, the file will be overwritten when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to
false if you want to postpone the fill-action until later. In
this case, FIll is automatically called during the Page
Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

DynamicObjectParameter
Gets or sets the QueryString parameter to read a
object ID dynamically. To use the default object ID,
leave blank.

String

Hide

Used to hide output of the control in design time and run
time.

True =Hide control

False =Display control

Boolean

IncludeIcons

Select whether iconsare displayed next to each item.

True =Display iconsnext to each item.

False =Do not display iconsnext to each item.

Boolean

InviteURL

TheURL to the Invite server control’sWeb page. Two
variablesused within the URL.

{0} - represents the object ID

{1} - represents the object type

The linkmust have both variables. TheWeb form can
be relative or absolute. Below is an example.

invitepage.aspx?id={0}&type={1}

String

Items
A comma separated list of items that you want to
appear on the Social Bar. See ItemsPropertyon page
16-242 for information.

String

Language
Set a language for viewing the server control. This
property shows results in design-time (in VisualStudio)
and at run-time (in a browser).

Integer
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Property Description Data Type

MarkupLanguage

Identify the templatemarkup file that controls the
display of the server control. For example,
mymarkup.ekml. If the *.ekml file is located in the same
folder as theWeb form containing the server control,
just enter its name. Otherwise, the path to the file can
be relative or absolute. See Also:Controlling Output
with EktronMarkup Language on page 26-1

String

MessagingUrl

TheWeb page that hosts theMessaging server control.
This property is used when either
PrivateMessageUseror PrivateMessageAdmin
appears in the Items property. See ItemsPropertyon
next page for information on these items.

Note: If a value appears in theek_
RedirectFromLoginKeyName key in the
web.config file, the user is returned to the original
URL after sending themessage. Bydefault, this
value isRedirectUrl. If you remove this value
and do not add another, the person sending a
message seesa note stating “Your message has
been sent.”

String

ObjectType

The type of object to which this control is assigned. Choicesare:

Content - this control is assigned to content.

User - control assigned to an individual

Group -control assigned to a community group

Data Type: Ektron.Cms.Common.EkEnumeration.CMSSocialBarTypes

Stylesheet

Specify the path to a style sheet for use with the server
control. The location can be relative or absolute. Leave
blank to use the default style sheet.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theStylesheet
property is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the
control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

WrapTag

Allowsa developer to specify a server control’s tag. The
default isSpan.

Span - The <span> tag is used to designate an inline
portion of an HTML document asa span element.

Div - The <div> tag is used when you want to apply
attributes to a blockof code.

Custom - Allowsyou to use a custom tag.

String
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Items Property

The Items property controls which items appear in the Social Bar. Below is a
list of items that can appear in the Social Bar.

Item Description

Addto

n If this control is associated with a user, the Addto item appears as:

- Add aColleague - if user is viewing another user’s profile page
and can add them asa colleague.

- Cancel ColleagueRequest - if user is viewing another user’s
profile page who he asked to be a colleague but the user hasnot yet
accepted.

- Remove FromColleagues - if user is viewing a current
colleague’s profile page.

n If the control is associated with a community group, the Addto item appears
as:

- Join Group - if user visits a community group that he hasnot
joined.

- LeaveGroup - if user alreadybelongs to a community group.

- Cancel Request to Join - if user has tried join a restricted group
and hasnot yet been accepted.

n If the control is associated with content, the Addto item appears as:

- Add to Favorites - if user viewscontent that is not in their
Favorites.

- Remove Favorites - if user viewscontent that is in their Favorites.

Invite

A link to theWeb page that contains the Invite server control. This control
allows you to invite people to register on the site and become a colleague.

Warning! For the Invite item to be active, youmust enter a link to the page
hosting the Invite control into theInviteURL property.See Also: InviteURL
on page 16-240.

GroupInvite Opensa dialog that invites colleaguesor people who are not registered on the
site to join the group.

Email
Email thisWeb page. Clicking this item launchesa user’s emailwith the subject
and body loaded with the information about the content, user or community
group.

Digg Appears asDigg It. LaunchesDigg.com, a social bookmarking service.

Delicious Appears asBookmark It. Launchesdel.icio.us, a social bookmarking service.

Facebook Appears asFacebook. LaunchesFacebook, a social network service.

Google Appears asGoogle It. LaunchesGoogle’s social bookmarking service.
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Item Description

Furl Appears asFurl It. LaunchesFurl, a social bookmarking service.

Technorati Appears asTechnorati. LaunchesTechnorati, a social bookmarking service.

Twitter

LaunchesTwitter, a social network service, which allowsusers to
communicate with other Twitter users.

If the Twitter link is clicked, and a user logs in to a Twitter account, a link to the
current page is inserted into the Statusbox. See Also: Tweeting the URL a
User isCurrentlyBrowsing on page 16-238

Yahoo Appears asYahoo! It. LaunchesYahoo’s social bookmarking service.

Print Print theWeb page.

PrivateMessageUser Createsa link that allowsyou to send a PrivateMessage to a user. See Also:
PrivateMessaging from the Social Bar on page 16-238

PrivateMessageAdmin
Createsa link that allowsyou to send a PrivateMessage to a community
group’s administrator. See Also:PrivateMessaging from the Social Bar on
page 16-238

CommunityDocuments Server Control
Part of the Community Platform, this server control allows users to create and
upload either individual user content to the user profile or group content to the
group profile. The content can be HTML content or an asset, such as a PDF
 document or a .jpeg file.

The control displays a list of uploaded content filtered by category. In addition,
a logged-in member can manage files, create categories, and decide which
users can view the documents. This server control is typically placed on a
user’s or a group profile page.

Note:When you drag and drop this control on a Web form in Visual Studio, the following
message appears in the label of the control: “Workspace for user does not exist”. This
happens because no ID is assigned to the control. Once you assign an ID, the control’s name
and the ID are displayed. If you use the DynamicParameter property to dynamically pass an
ID from the QueryString, the above message is displayed because an ID is not assigned to the
control.

This section now divides into two major sections.

Using the CommunityDocuments Server Control in an Individual User
Profile on next page

Using the CommunityDocuments Server Control with a Group Profile
on page 16-250

See Also: CommunityDocuments Server Control Properties on page 16-253
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Using the CommunityDocuments Server
Control in an Individual User Profile

Adding Folders
Users can add folders to their Workspace to help them organize items in the
documents area. To add folders, follow these steps.

1. On the Web site, navigate to a User’s Profile Page >Workspace.

2. Click the Manage Folder Button ( ).
3. The Add Folder box appears.

4. Enter a Name for the folder.

5. Determine with whom you want to share the folder's documents. For
a description of the Share options, see Sharing Workspace Content
on page 16-249.

6. Click the Add button.

7. The page refreshes and displays the newly added folder.

Editing a Folder Name
Sometimes, it is necessary to change the folder name. To accomplish this,
follow these steps.

1. On the Web site, navigate to a User’s Profile Page >Workspace.

2. Click the folder’s Edit button ( ), located to the left of the folder’s title,
as circled below.
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3. The Edit Folder dialog appears.

4. Change the name of the folder.

5. Click the Save button.

6. The page refreshes and shows the folder's new name.

Deleting a Folder
A user can delete obsolete folders from his Workspace. To delete a folder,
follow these steps.

Note: You can not delete the top-level folder, Workspace.

Warning! Deleting a folder permanently deletes all of the assets and HTML content in the folder,
as well as its subfolders.

1. On the Web site, navigate to a User’s Profile Page >Workspace.

2. Click the folder’s Edit button ( ), located to the left of the folder’s
title.
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3. The Edit Folder dialog appears.

4. Click the Delete button.

5. A dialog box asks you to confirm.

6. Click OK.

Adding Assets to a Workspace
Assets are files that are not HTML content, such as Office documents and PDFs.
To add an asset to a user’s Workspace, follow these steps.

1. On the Web site, navigate to a User’s Profile Page >Workspace.

2. Select a folder to which the asset will be added. If you want to create
a new folder, see Adding Folders on page 16-244

3. Click the Add Asset button ( ).
4. The Add Asset box appears. Its appearance varies depending on your

browser, etc. To learn about these variations, see Methods for
Importing Documents on page 7-405.

5. Import one or more assets, depending on the screen.

6. A status box shows the files being uploaded.

7. The asset(s) appear in the file list.
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Creating HTML Content
To create HTML content in your Workspace, follow these steps.

1. On the Web site, navigate to a User’s Profile Page >Workspace.

2. Select a folder where the content will be added. If you want to create
a new folder, see Adding Folders on page 16-244

3. Click the Add HTML Content button ( ).
4. The Add HTML Content window appears. The editor page looks like

this.

5. Add a title and content.

6. Click the Publish button to publish the content.

7. The HTML content appears in the file list.
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Moving and Copying Content
You can move or copy assets and HTML content from one folder to another. To
accomplish either action, follow these steps.

1. On the Web site, navigate to a User’s Profile Page >Workspace.

2. Select the folder from which to move or copy the content.

3. Click the drop down triangle to the right of the content title (circled
below).

4. From the drop down list, select Copy.

5. Select the folder to which the content will be moved.

6. Click the Manage link.
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7. Click the Move Items ( ) or Copy button ( ).
8. A dialog box asks you to confirm.

9. Click OK.

10. The moved or copied content appears in the folder.

Sharing Workspace Content
The Workspace area allows users to share content with colleagues. Users can
share content with the Public, Colleagues, Selected Colleagues or keep the
content private.

Users apply sharing options to folders, not individual content items. To share a
folder, follow these steps.

1. On the Web site, navigate to a user’s or community group's Profile
Page >Workspace.

2. Locate the folder you want to share.

3. Click its Manage Folder button ( ).
4. The Add or Share Folder dialog box appears.

5. Click the Share Folder button ( ) in the top right corner.
6. The Share Folder dialog box appears.
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7. Select with whom to share your folders. The table below describes
each option.

Viewer Type People who can view your documents

Public Everyone viewing your Workspace

Colleagues Only colleagues See Also: FriendsServer Controlon page 16-34.

Selected Colleagues Only selected colleagues See Also:Designating a Selected Colleague on
page 16-37

Private Only you

8. Click the Share button.

Documents in the folder are now available for viewing by the selected viewer
type.

Using the CommunityDocuments Server
Control with a Group Profile

Adding Folders
Community group members can add folders to the Workspace to help organize
items in the Documents area. To add folders, follow these steps.

1. On the Web site, navigate to a community group’s Profile Page >
Workspace.

2. Click the Manage Folder Button ( ).
3. The Add Folder dialog appears.
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4. Enter a Name for the folder.

5. Determine with whom you want to share the folder's documents.

Public - anyone can view and edit the document

Private - only group members can view and edit the document

Note: If you want to later change a folder's share setting, follow the directions in Sharing
Workspace Content on page 16-249.

6. Click the Add button.

7. The page refreshes and displays the newly added folder.

Editing a Folder Name
Sometimes, it is necessary to change the folder name. To accomplish this,
follow these steps.

1. On the Web site, navigate to a community group Profile Page >
Workspace.

2. Click the folder’s Edit button ( ), located to the left of the folder’s
title, as circled below.

3. The Edit Folder dialog appears.
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4. Change the name of the folder.

5. Click the Save button.

6. The page refreshes and shows the folder's new name.

Deleting a Folder
A user can delete obsolete folders from his Workspace. To delete a folder,
follow these steps.

Note: You can not delete the top-level folder, Workspace.

Warning! Deleting a folder permanently deletes all of the assets and HTML content in the folder,
as well as its subfolders.

1. On the Web site, navigate to a community group's Profile Page >
Workspace.

2. Click the folder’s Edit button ( ), located to the left of the folder’s title.

3. The Edit Folder dialog appears.
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4. Click the Delete button.

5. A dialog box asks you to confirm.

6. Click OK.

See Also: Adding Assets to a Workspace on page 16-246, Creating HTML
Content on page 16-247, Moving and Copying Content on page 16-248, Sharing
Workspace Content on page 16-249

CommunityDocuments Server Control
Properties
The CommunityDocuments server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it
to browse to Content, Collections, etc. See Also:Working with
Ektron CMS400.NET Server Controlson page 24-1

String

CacheInterval

Sets the amount of time the server control’s data is cached. The
default is 0 (zero). This is the amount of time, in seconds, a
control’s data is cached. For example, if you want to cache the
data for fiveminutes, set this property to 300 (three hundred).
See Also: Caching with Server Controlson page 24-33

Double

DefaultObjectID The default object ID for this control to use when there is no
matching dynamicparameter value passed. Long

DisplayXslt

Determineshow information is displayed on the page. Enter the
path to the XSL file. It can be relative or absolute.

Warning! : If you specify an external file, it is strongly
recommended that you do not store this file your site’sWorkarea
folder. If you store this file in theWorkarea folder, the file will be
lost when you upgrade.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theDisplayXslt property
value is ignored.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if
you want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes
shown.

Boolean
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Property Description Data Type

DynamicContentBoxHeight The height of the dynamic content box in pixels Integer

DynamicContentBoxWidth TheWidth of the dynamic content box in pixels Integer

DynamicContentTemplate The template to use when displaying dynamic content. Leave
blank to use the dynamicbox. String

DynamicParameter Gets or sets the QueryString parameter to read a object ID
dynamically. To use the default object ID, leave blank. String

EnablePaging

This property, in conjunction with theMaxResults property,
lets site visitors view an unlimited number of document items
while controlling the amount of screen space. To accomplish this,
the display is limited to the number set in theMaxResults
property.

If you set this property to true, and the number of itemsexceeds
theMaxResults number, navigation aidsappear below the last
item.

Boolean

Hide

Used to hide output of the control in design time and run time.

True =Hide control

False =Display control

Boolean

IncludeIcon

Choose whether to display iconsnext to the navigation list’s links.

True =Show icons

False =Hide icons

Boolean

Managing User Communities

16-254 ReferenceManual
Version 8.01 Rev 4



Property Description Data Type

ItemSortOrder

Specify the sort order of results. Choicesare:

taxonomy_item_display_order - the order of taxonomy items
as set in theWorkarea. For additional information, seeChange
Order of Content Assigned to a Taxonomy/Categoryon page 9-
241

content_title - content ordered in alphabetical order by title

date_created - content ordered in the chronological order by
creation date

last_edit_date - content ordered in the chronological order by
last edit date.

You can specify the direction of the itemswith the
SortDirection property.

Language
Set a language for viewing the CommunityDocuments control.
This property shows results in design-time (in VisualStudio) and
at run-time (in a browser).

Integer

LinkTarget

Determines the type of window that appears on thisWeb form
when a user clicks an item in the dynamic content box. The
default is _self.

_Self - opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

String

MarkupLanguage

Identify the templatemarkup file that controls the display of the
server control. For example, mymarkup.ekml. If the *.ekml file is
located in the same folder as theWeb form containing the server
control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See Also:Controlling Output with Ektron
Markup Language on page 26-1

String

MaxResults Themaximum number of items to display in the control. 0 (zero) =
unlimited. Integer

ObjectType

The type of object to which this control is assigned. Choicesare:

User - this control is assigned to an individual.

Group - this control is assigned to a community group.

CommunityDocuments
ObjectType

CommunityDocuments Server Control Properties

ReferenceManual
Version 8.01 Rev 4

16-255



Property Description Data Type

ShowCount

Determines if an integer representing the number of items in a
category appears next to the category. The default is False.

True - Show itemsnumber next to category

False - Do not show itemsnumber next to category

Boolean

SortDirection
Select the direction of theitemSortOrder property. Choose
Ascending or Descending.

String

Stylesheet

Specify the path to a style sheet for use with the Documents
server control. The location can be relative or absolute. Leave
blank to use the default style sheet.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theStylesheet property is
ignored.

String

TaxonomyCols Enter the number of columns in which this taxonomy/category
appear on the page. Integer

TaxonomyItemCols Enter the number of columns in which the taxonomy item
appears on the page. Integer

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of
an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

Custom - Allowsyou to use a custom tag.

String

CommunitySearch Server Control
The CommunitySearch server control allows a site user to find users or
community groups registered on the Web site. Upon viewing the results, a user
can add a colleague or join a community group.

When a user hovers over a user or community group link, profile information
appears. Which information appears depends on the status of the user
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performing the search and the profile settings of the user or group returned in
the results.

The CommunitySearch control provides these types of searches:

n Directory - filter users by a letter in the alphabet. A user can select
whether to search by first or last name. See Using the Directory Tab
to Filter for Users below.

n Basic Search - allows users to search for users and groups. See
Performing a Basic Community Search below.

n Advanced Search - allows users to search based on individual or
multiple criteria. See Advanced Community Searching on next page.

n Location Search - allows users to search by the location of a user
or group. See User Location Searches on page 16-259.

This section also contains the following topics.

Using the Directory Tab to Filter for Users 16-257
Performing a Basic Community Search 16-257
Advanced Community Searching 16-258
User Location Searches 16-259
Using Community Search Results 16-260
When is a User’s Profile Accessible in Search Results 16-261
Restricting the CommunitySearch to Membership Users 16-263
Filtering Search Results by Category 16-263
Effect of Setting EnableFilteringResults to True 16-264
Showing a User’s Custom Properties 16-265
CommunitySearch Server Control Properties 16-266

Using the Directory Tab to Filter for Users
The Community Search's Directory tab lets a user filter users based on a letter
in the alphabet. For example, John wants to find all users whose first name
begin with the letter S. He navigates to the CommunitySearch control on his
site, clicks the Directory tab, and selects First Name from the Sort By list.
Then, he clicks the letter S. Next, the control displays all users whose first
name begins with S.

Performing a Basic Community Search
A Basic search is the easiest to perform and returns the most results.
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A Basic search uses the following criteria:

n Email

n Display Name

n First Name

n Last Name

n Custom User Properties

n Personal Tags

n Group Name

n Group Description

n Group Tags

To use a basic search, a user enters a name, email, group name, tag, or a word
he believes might appear in a group’s description. Then, he clicks the Search
button. All matches are returned in the results. See Also: Using Community
Search Results on page 16-260.

Users can also perform wildcard searches, but the wildcard must appear after
the first letter in the search. For example, you can search for J*, but not *J. J*
returns all users and community groups that start with J or have a word that
starts with J in their email, tags, or description.

Advanced Community Searching
The CommunitySearch's Advanced Search tab lets a user apply multiple
search criteria on community groups and users.

In addition to the basic search criteria, advanced search lets users search by
taxonomy category if taxonomy ID is defined in the GroupTaxonomyID
property, UserTaxonomyID property, or both properties.

Warning! If both the GroupTaxonomyID and UserTaxonomyID properties are set to 0 (zero) or
if there are no users or groups assigned to the selected taxonomy, the Category option does not
appear on the Group or User drop down list.

See Also: Performing a Basic Community Search on previous page
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Multiple search criteria have an “and” relationship, so results must match each
filter. For example, if you select the Tags filter and the Display Name filter,
users or groups must match both criteria to appear in the results. If a user or
community group matches only one criterion, it does not appear in the results.

To search using the Advanced Search tab, follow these steps.

1. Navigate to a Web page that hosts the CommunitySearch control.

2. Click the Advanced Search tab.

3. Select the criteria by which to filter the search results.

4. Click Add Filter to add additional filter.

5. Enter text in one of the text boxes.

Note: If a user enters text in both the Users and Groups text boxes, the search returns any
matching users or groups.

6. Click the Search button.

User Location Searches
The Location tab lets a user search for another user based on location. User
results are displayed as pins on a map.
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For users to be found in the search, they must fill out the Address field in their
profile. Ektron CMS400.NET retrieves the longitude and latitude for the address
to populate the user location search.

Warning! This tab imports the Map server control. To learn about the Map server control and how
to enable location searches for your site, it is strongly recommended that you review the Map
server control chapter. See Map Server Control on page 7-654.

If you have not enabled location searches for you site, you can suppress the
Location Search tab by setting the EnableMap property to false. This also
suppresses the Map icon next to a user’s name in search results.

Using Community Search Results
Once a search is complete, a list of users and groups who match the search
term appears. This list shows an avatar, display name, and status for each user
or group. In addition, if a user has entered a valid address in his profile, a map

icon ( ) appears below the user’s name. Clicking this icon launches the
location tab with a map showing the user’s location.
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The Status column indicates whether the user is already a colleague, or if you
can add him as a colleague via a colleague request. It also allows you to join a
community group if you are not already a member.

Click the Add as Colleague link to send the colleague request or the Join this
Group link to join the community group. Status information for each user or
group is only displayed when you are logged into the site.

When is a User’s Profile Accessible in Search
Results
When a user is logged in and hovers the mouse over the display name link, a
floating profile window pops-up. Several factors determine whether a user’s
profile is displayed in the pop-up. The table below shows an example of when a
user’s profile is accessible in the search results. This example uses John and
Jane. John is a user with a profile, while Jane is performing a search.

John’s
Profile is ...

Jane is a
...

and Her Login
Status is ...

The ResultsProfile
Property is ...

Therefore John’s
Profile is ...

Public User LoggedOut Full Accessible

Public User LoggedOut NonPrivate Accessible

Public User LoggedOut NonPrivate-
Authenticated Not accessible

Public User LoggedOut None Not accessible

Public User Logged In Full Accessible

When is a User’s Profile Accessible in Search
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John’s
Profile is ...

Jane is a
...

and Her Login
Status is ...

The ResultsProfile
Property is ...

Therefore John’s
Profile is ...

Public User Logged In NonPrivate Accessible

Public User Logged In NonPrivate-
Authenticated Accessible

Public User Logged In None Not accessible

Public Colleague LoggedOut Full Accessible

Public Colleague LoggedOut NonPrivate Accessible

Public Colleague LoggedOut NonPrivate-
Authenticated Not accessible

Public Colleague LoggedOut None Not accessible

Public Colleague Logged In Full Accessible

Public Colleague Logged In NonPrivate Accessible

Public Colleague Logged In NonPrivate-
Authenticated Accessible

Public Colleague Logged In None Not accessible

Private User LoggedOut Full Accessible

Private User LoggedOut NonPrivate Not accessible

Private User LoggedOut NonPrivate-
Authenticated Not accessible

Private User LoggedOut None Not accessible

Private User Logged In Full Accessible

Private User Logged In NonPrivate Not accessible

Private User Logged In NonPrivate-
Authenticated Not accessible

Private User Logged In None Not accessible

Private Colleague LoggedOut Full Accessible

Private Colleague LoggedOut NonPrivate Not accessible
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John’s
Profile is ...

Jane is a
...

and Her Login
Status is ...

The ResultsProfile
Property is ...

Therefore John’s
Profile is ...

Private Colleague LoggedOut NonPrivate-
Authenticated Not accessible

Private Colleague LoggedOut None Not accessible

Private Colleague Logged In Full Accessible

Private Colleague Logged In NonPrivate Accessible

Private Colleague Logged In NonPrivate-
Authenticated Accessible

Private Colleague Logged In None Not accessible

Restricting the CommunitySearch to
Membership Users
When searching for users, the CommunitySearch server control can return all
users or Membership Users only. You can limit the search to Membership Users
by setting the control's MembersOnly property to true.

You might want to restrict searches to Membership Users when creating a
public facing site. This prevents site visitors from finding Ektron CMS400.NET
users. Alternatively, if your site is internal , such as a company intranet, you
could allow searching of all users.

Filtering Search Results by Category
The Filter by Category feature helps a site visitor zero in on relevant users and
groups. As explained in Assigning Content to a Taxonomy/Category on page 9-
218, the Taxonomy Feature lets users assign information categories to user and
groups. For example, you might categorize employees by department, such as:

n accounting

n human resources

n purchasing

n manufacturing

As new users and groups are created, apply relevant taxonomy categories to
them. This makes it easier to find them on your site, because a visitor can
search by category along with search text. For example, you might quickly find
all employees in manufacturing whose first name is Tom.

Note: This search criterion relies on the assignment of taxonomy categories to users and
groups. If they are not categorized, the filter hides relevant but non-categorized users/groups.
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For example, someone enters a new user (Tom in Manufacturing) but doesn't assign a
department to him. If a site visitor on the search page enters Tom and selects the
Manufacturing category, he will not find that user even though he exists in Ektron
CMS400.NET.

Effect of Setting EnableFilteringResults to True
If you set the EnableFilteringResults property to true, initially the site visitor
sees no difference. However, if he enters a search term that returns one ore
more users or groups to whom a taxonomy category is assigned and clicks the
Search button, he sees Filter by Category above the results (illustrated
below).

Note: If no categories are assigned to the users in the search results, the Filter by Category
link does not appear.

If he clicks Filter by Category, the visitor sees all taxonomies with at least
one user or group that contains the search text. He can then select categories
from the taxonomy structure. If he does, the results refresh, and only user and
groups that contain the search text and are assigned to the selected categories
appear. If a visitor selects several categories, content that is assigned to any
selected category appears.

Note: If the visitor selects a parent category, all of its child categories are selected by default.
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In the example above, the site has four users or groups with the letter S. If the
user selects Filter by Category then drills down to Management, only one
user is found.

If a site visitor performs any of the following actions, all taxonomy category
selections are cleared, and a new search is performed.

n clicks the Search button

n presses <Enter>

n performs an Advanced Search

On the other hand, if a site visitor closes folders in the taxonomy structure, all
selected categories remain selected.

Showing a User’s Custom Properties
In search results, you can have a user’s custom properties appear in the
information pop-up box when his link is hovered over. To have custom
properties appear, add a comma delimited list of custom property IDs to the
CustomPropertyID property.

Custom properties are created by the site administrator and applied by a user.
See Also: Custom User Properties on page 15-12
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CommunitySearch Server Control Properties
The CommunitySearch server control properties are described in this table.

Property Description Data Type

Authenticated

Indicates if you are logged in to
the CMSExplorer and can use it to browse to Content, Collections,
etc. See Also:Working with Ektron CMS400.NET Server Controls
on page 24-1

String

CacheInterval

Sets the amount of time the server control’s data is cached. The
default is 0 (zero). This is the amount of time, in seconds, a control’s
data is cached. For example, if you want to cache the data for five
minutes, set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Double
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Property Description Data Type

CustomPropertyID

Specify a comma delimited list of custom property IDs. These
custom properties appear in the pop-up information box for a user
when search results are returned. See Also:Showing a User’s
CustomPropertieson page 16-265

Integer

DisplayXslt

Determineshow information is displayed on the page. Enter the
path to the XSL file. It can be relative or absolute. The default file is
CommunitySearchDirectory.xsl.

Warning! If you want to edit this file, it is strongly recommended
that youmake a copy, change its name andmove it outside of your
site'sWorkarea folder. If youmake changes to this file and do not
move it out of theWorkarea, this file and the changeswill be lost
when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes shown.

Boolean

EnableFilteringResults

Set to true to display a Filter by Category option when this server
control appears. This option helpsa site visitor zero in on relevant
content by selecting taxonomycategories.

Set to false to suppress the Filter by Category option. See Also:
Filtering Search Results byCategoryon page 16-263

Boolean

EnableGroup

Results

Set to true to include community groups in the search results. Set to
false to prevent community groups from appearing in search
results.

Boolean

EnableMap

Set to false to hide themap functionality in this control. This hides
the Location tab when the control is displayed on aWeb site and the
map properties in VisualStudio. See Also:User Location Searches
on page 16-259

Boolean

EnableMouseOver

True =Enable the profile pop-up when hovering over a display
name in search results.

False =Disable the profile pop-up when hovering over a display
name in search results.

Boolean
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Property Description Data Type

EnableMouseOutHidesInfo

If this property is set to True and a user moveshismouse away
from a search result’s information pop-up box, the boxdisappears.

If this property is set to False, a user must click the close button in
the upper right corner of the information pop-up box to hide it.

Boolean

EnableUnauthorizedSearching
True =a user doesnot need to be logged in to perform a user
search.

False =a user must be logged in to perform a user search.
Boolean

EnableUserResults
Set to true to include users in search results.

Set to false to exclude users from search results.
Boolean

FriendsOnly Set to True to limit the results to a user’s colleagues.When set to
False, returnsallmatches. Boolean

GroupTaxonomyID

Enter the ID of the taxonomyyou want to associate with this control.
This allowsusers to search for community groupsbased on
assigned taxonomies.

If set to 0 (zero), the Category option doesnot appear in the Group
drop down list on theAdvanced tab. See Also: Filtering Search
Results byCategoryon page 16-263

Long

Hide

Used to hide output of the control in design time and run time.

True =Hide control

False =Display control

Boolean

InfoBoxShowsEmail

Set this property to True if you want a user’s email to appear when
hovering over his name in the search results.

Boolean

Language
Set a language for viewing the server control. This property shows
results in design-time (in VisualStudio) and at run-time (in a
browser).

Integer

LoadingImage

The image to displaywhile the User Search is loading. The default
is<site
root>\Workarea\images\application\ajax-
loader_circle_lg.gif.

String
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Property Description Data Type

MapControl

This property allowsyou to set properties for the Location Tab’s
map. These properties are identical to the properties in theMap
server control. For information on theMap control’s properties, see
MapServer Controlon page 7-654. TheEnableMap property
must be set to true to see theMap control properties. See Also: on
page 16-267

Note: OnlyEktron'sMap server control properties are
described in this section. It doesnot describe native .NET
properties such as font, height, width and border style. For
documentation of these properties, see VisualStudio help.

Ektron.Cms.
.Controls.Map

MarkupLanguage

Identify the templatemarkup file that controls the display of the
server control. For example, mymarkup.ekml. If the *.ekml file is
located in the same folder as theWeb form containing the server
control, just enter its name. Otherwise, the path to the file can be
relative or absolute. See Also:Controlling Output with Ektron
Markup Language on page 26-1

String

MaxTagCount Themaximum number of personal tags to display for each user in
the search results. Integer

MembersOnly
When set to True, this server control only returnsMembership
Users.When set to False, the control returnsEktron CMS400.NET
andMembership users.

Boolean

PageSize Themaximum number of user results to show per page. Integer

ResultsProfile

Determineswhether profile information is displayed. This is based
on the state of the user performing the user search. SeeWhen is a
User’sProfile Accessible in Search Resultson page 16-261.

Choicesare:

full - always show user profile information.

nonprivate - display user profile information onlywhen a user’s
profile is not marked private.

nonprivate-authenticated - display user profile information only
when a user’s profile is not marked private and the user performing
the search is logged in.

none - never show user profile information.

String

SearchPrivate When set to False, this property excludesuserswith private profiles
from search results. Boolean
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Property Description Data Type

ShowNameEmail

When set to True, populates the drop down list with these
additional options:

First Name - perform searchesbased on a user’s first name.

Last Name - perform searchesbased on a user’s last name.

Email - perform searchesbased on a user’s email address.

When set to False, the drop down list is populated with these
properties:

Tags - perform searchesbased on a user’s tags.

Display Name - perform searchesbased on a user’s display
name.

Boolean

StartingTab

Select which tab appearswhen the control is first rendered on a
Web page. Choicesare:

n basic

n advanced

n location

String

Stylesheet

Specify the path to a style sheet for use with this server control. The
location can be relative or absolute. Leave blank to use the default
style sheet.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theStylesheet property is
ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TemplateGroupProfile The URL path of the community group template. This path can be
relative or absolute. String

TemplateParamName

Sets a QueryString parameter for the ID of users or groups that are
returned in the search results. This parameter is passed to the
template page defined in theTemplateUserProfile or
TemplateGroupProfile propertywhen a user clicks the
Location (map) icon associated with a search result.

String
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Property Description Data Type

TemplateTarget

Defines the waya the template appearswhen the Location link is
clicked.

Choicesare:

_blank - This target causes the link to alwaysbe loaded in a new
blankwindow. Thiswindow is not named.

_self - This target causes the link to always load in the same
window the anchor was clicked in. This is useful for overriding a
globally assigned BASE target.

_parent - This target makes the link load in the immediate
frameset parent of the document. This defaults to acting like “_self”
if the document hasno parent.

_top - This target makes the link load in the full bodyof the window.
This defaults to acting like “_self” if the document is alreadyat the
top. It is useful for breaking out of an arbitrarily deep frame nesting.

ItemLinkTargets

TemplateUserProfile The URL path of the user profile template. This path can be relative
or absolute. String

UserTaxonomyID

Enter the ID number of the taxonomyassociated with users to
appear in this server control. This allowssearching for users based
on an assigned taxonomy.

If set to 0 (zero), theCategory option doesnot appearon the
Advanced tab'sUser drop down list . See Also: Filtering Search
Results byCategoryon page 16-263

Long

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

Custom - Allowsyou to use a custom tag.

String

Tags
Note: This section discusses Tags for use with the Community Platform. Information on
tagging blog entries can be found in Tags on the Summary Page on page 7-497.

Tags are keywords that can be assigned to users, groups, content, and library
items.

On a Web site, tags for a user or group appear in a profile, helping site visitors
to learn about a user or group.

Tags
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Tags also allows users to perform tag-based searching, as shown below.

So, for example, you could tag all content related to a new product release with
the name “Widgets 2.0.” Anyone could enter that term into the Search box, click
Tags from the dropdown list (shown above), then the Search button to find all
related content.

In the Workarea, tags are used in the following locations.

Location Image

User Information screen’sTags area, for
users or membership users
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Location Image

TheCommunityGroup screen’sTags tab

A content item’sMetadata tab >Tags area

A library item’sMetadata tab >Tags area

Tags
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Location Image

Settings > Community Management >
Tags

Note: The CommunityGroupBrowser, CommunityGroupProfile, and CommunityGroupList
Server Controls can display group tags and link them to a list of all groups that share the tag.
Also, the TagCloud server control displays a weighted list of tags. See Also: TagCloud Server
Control on page 16-280

This section also contains the following topics.

Tag Types 16-274
Creating Default Tags 16-275
Adding Default Group Tags 16-276
Adding Default User Tags 16-276
Adding Default Content Tags 16-277
Adding Default Library Tags 16-277
Creating User-Created Tags 16-278
Managing Tags 16-278
Viewing a Tag’s Details 16-279
Deleting Tags 16-279

Tag Types
There are basic two types of tags, and they are contrasted below.

Type Description For more information, see

Default
n created by system administrator inSettings >
Community Management > Tags area

n appear as checkboxoptionswherever tags can be applied

Creating Default Tagson the
facing page

User-
created n created byuser asneeded wherever tags can be applied Creating User-Created Tags

on page 16-278

Managing User Communities

16-274 ReferenceManual
Version 8.01 Rev 4



Creating Default Tags
An Ektron CMS400.NET administrator can create default tags for each object
(user, user group, content or library item). For example, you want to allow
users to associate themselves with a favorite race car driver. You create a
default user tag for each driver’s name.

When a user creates or edits an item for which you created the default tags,
they appear and the user clicks inside check boxes to assign them.

Ektron CMS400.NET provides separate screens for creating default tags for user
groups, users, content and library items. They are available via Settings >
Community Management > Tags (shown below).

See Also:

n Adding Default Group Tags on next page

n Adding Default User Tags on next page

n Adding Default Content Tags on page 16-277

n Adding Default Library Tags on page 16-277
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Adding Default Group Tags
The Default Group Tags screen lets you add tags that may be assigned to
community groups.

See Also: Tags on page 16-271

To add a Default Group Tag, follow these steps.

1. In the Workarea, navigate to Settings > Community Management
> Tags > Default Group Tags.

2. Select a language for the tag.

3. Add the tag in the empty text box. If no empty box appears, click the
Add button ( ) then enter the tag.

4. Click the Save button ( ).

Adding Default User Tags
The Default User Tags screen allows you to add tags that may be assigned to a
user.

See Also: Tags on page 16-271

To add a Default User Tag, follow these steps.

1. In the Workarea, navigate to Settings > Community Management
> Tags > Default User Tags.

2. Select a language for the tag.

3. Add the tag in the available text box. If no text box is available, click
the Add button ( ) then enter the tag.

4. Click the Save button ( ).
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Adding Default Content Tags
The Default Content Tags screen allows you to add tags that may be assigned to
a content.

See Also: Tags on page 16-271

To add a Default Content Tag, follow these steps.

1. In the Workarea, navigate to Settings > Community
Management > Tags > Default Content Tags.

2. Select a language for the tag.

3. Add the tag in the available text box. If no text box is available, click
the Add button ( ) then enter the tag.

4. Click the Save button ( ).

Adding Default Library Tags
The Default Library Tags screen allows you to add tags that may be assigned to
a library.

See Also: Tags on page 16-271

To add a Default Library Tag, follow these steps.

1. In the Workarea, navigate to Settings > Community
Management > Tags > Default Library Tags.

2. Select a language for the tag.

3. Add the tag in the available text box. If no text box is available, click
the Add button ( ) then enter the tag.
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4. Click the Save button ( ).

Creating User-Created Tags
In addition to applying default tags, users, community group leaders, and
content editors can create their own tags. This allows for a more diverse and
creative list of tags.

For example, a user is editing content. He reviews the default tags but decides
that none is correct. So, he creates and assigns a new tag: Rosebud. That tag
is now applied to that content.

The user-created tag also appears on the Settings > Community
Management > Tags screen, where you can see its ID number.

If someone creates another tag with the same exact name, the new tag will
share the ID number with the previous one, and the Times Used will increase
from 1 to 2. However, the new tag will not appear as a default on any screen.

Managing Tags
Administrators manage tags from the Settings > Community Management
> Tags screen. This screen displays all default and user-created tags. You can
filter the list by language. Click any tag’s name to see its details. See Also:
Viewing a Tag’s Details on the facing page and Tags on page 16-271
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This screen displays the following information about each tag.

Field Description

ID Its integer ID

Name Its title

TimesUsed The number of timesa tag hasbeen assigned

Language
Its language. This appears asa national flag. For example,
American English appears as .

Viewing a Tag’s Details
When you click a tag’s name, its details appear on the View Tag screen.

Field Description

ID The integer ID of the tag.

Language The language assigned to the tag.

Name The title of the tag.

Tagged Type
Showshow the tag is assigned: to a community group, user,
content, or library item. See Also:Adding Default Group Tagson
page 16-276 andAdding Default User Tagson page 16-276

TimesUsed The number of times this tag is assigned to each Tagged Type.

Deleting Tags
As mentioned above, there are two basic tag types: user-created and default.
(See Also: Tag Types on page 16-274). The following table contrasts how to
delete tags.
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Tag
Type

Result Procedure

User-
created

Delete a single tag

1. Open the item’sTags area. For example, for
content, edit theMetadata tab.

2. Uncheck the checkboxnext to the tag.

3. Publish the content.

Delete all occurrencesof a tag

1. Go to theSettings > Community Management
> Tags screen.

2. Click the tag.

3. Click the delete button ( ).

4. A confirmation screen appears.

5. ClickOK.

Default

There are twomethods for deleting default tags. Each hasdifferent results.

Deleting a Default Tag

n No longer available for assignment
to users, content, etc.

n Existing links to it remain

1. Go toSettings > Community Management >
Tags

2. Select the screen for the kind of tag you want to
delete (group, user, content or library).

3. Select the language.

4. Click the red ( ) to the right of the tag you want
to delete (see below).

5. You are asked if you are sure. ClickOK.

6. Click the save button ( )

Deleting a Default Tag and All
of its Links

n No longer available for assignment
to users, content, etc.

n Existing links to it are deleted

1. Go to theSettings > Community Management
> Tags screen.

2. Click the tag.

3. Click the delete button ( ).

4. A confirmation screen appears.

5. ClickOK.

TagCloud Server Control
The TagCloud server control depicts a weighted list of tags assigned to users,
community groups, content, or library items. Each tag’s size is proportional to
the number of times it is assigned.

For example, there are two tags, Mom and Dad. If the Mom tag is used five
times and the Dad tag is used twice, the Mom tag is approximately twice as
large.
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See Also: Tags on page 16-271

This section also contains the following topics.

Determining the Contents of the Tag Cloud 16-281
Setting a Maximum Number of Tags 16-281
Sorting the Tags 16-281
Linking Tag Cloud Items 16-281
TagCloud Server Control Properties 16-282

Determining the Contents of the Tag Cloud
Use the TagType property to determine which types of tags appear in the
cloud. For example, set TagType to User to display user tags.

Setting a Maximum Number of Tags
You can set a maximum number of tags to display via the MaxTagsDisplayed
property. This property makes sense if the Orderby property is set to
Taggedcount. In this case, the cloud only displays items with the highest
number of tags.

Sorting the Tags
Use the OrderBy property to sort tags within a cloud. Your choices are
alphabetical or by Taggedcount (the number of times an item is tagged).
Then, use the OrderByDirection property to determine if items are sorted
in ascending or descending order.

Linking Tag Cloud Items
Within a tag cloud, you can link tags to their source items. If you do, site
visitors can click a tag to launch a search of all users, community groups,
content, or library items to which the tag is assigned. For example, if someone
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views a user-based tag cloud and clicks Motorcycles, the community search
page appears, showing all users tagged with Motorcycles.

To make a tag cloud’s items searchable, add a path to the Web form containing
the Search server control in the TagTemplate property.

TagCloud Server Control Properties
The TagCloud server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can
use it to browse to Content, Collections, etc. See Also:
Working with Ektron CMS400.NET Server Controlson
page 24-1

String

CacheInterval

Sets the amount of time the server control’s data is
cached. The default is 0 (zero). This is the amount of time,
in seconds, a control’s data is cached. For example, if you
want to cache the data for fiveminutes, set this property to
300 (three hundred). See Also:Caching with Server
Controlson page 24-33

Double
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Property Description Data Type

DisplayXslt

Determineshow information is displayed on the page.
Enter the path to the XSL file. It can be relative or absolute.

Warning! If you specify an external file, it is strongly
recommended that you do not store this file in your site's
Workarea folder. If you store this file in theWorkarea
folder, the file will be lost when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to
false if you want to postpone the fill-action until later. In
this case, FIll is automatically called during the Page
Render event.

Youmight do this if you need to set or change a property
on the control in codebehind and have it render with your
changes shown.

Boolean

DynamicParameter

Bydefault, theTagTemplate property passesaTagId
parameter, whose value is the tag that a site visitor clicked
in the tag cloud. Use this property to manually override
that parameter and set the TagID value byhand.

String

Hide

Used to hide output of the control in design time and run
time.

True =Hide control

False =Display control

Boolean

Language
Set a language for viewing the server control. This
property shows results in design-time (in VisualStudio)
and at run-time (in a browser).

Integer

MarkupLanguage

Identify the templatemarkup file that controls the display of
the server control. For example, mymarkup.ekml.

If the *.ekml file is located in the same folder as theWeb
form containing the server control, just enter its name.
Otherwise, the path to the file can be relative or absolute.
See Also:Controlling Output with EktronMarkup
Language on page 26-1

String

MaxTagsDisplayed

Themaximum number of tags to display. Set to 0 (zero)
for unlimited.

If you set amaximum, andmore than that number of tags
are applied, then only themost frequently-used tags
appear. For example, if you enter ten, the ten tagsapplied
themost number of timesappear.

Integer
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Property Description Data Type

OrderBy

The criteria bywhich the tagsare ordered within the tag
cloud. Choicesare:

n TaggedCount - sort by how many
times a tag is assigned

n Text - sort alphabetically by tag
name

String

OrderByDirection
Select the direction of theOrderBy property. Choose
Ascending or Descending.

String

Stylesheet

Specify the path to a style sheet for use with this server
control. The location can be relative or absolute. Leave
blank to use the default style sheet.

Warning! If you enter a valid EkML file at the
MarkupLanguage property, theStylesheet
property is ignored.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the
control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Description Data Type

TagTemplate

If you want a tag cloud’s items to link to a page that shows
all itemswith that tag, add a path to aWeb form page that
hosts the appropriate search control. The path can be
relative or absolute.

See Also: Linking Tag Cloud Itemson page 16-281

n If theTagType isUser or Community Group,
enter a page hosting a CommunitySearch server control.

n If theTagType isContent or Library, enter a
page hosting aWeb Search server control.

For example, in the Ektron CMS400.NET Intranet starter
site’stagcloud.aspx page, the first two TagCloud
controls link to users and community groups. So, this
property is set toCommunitySearch.aspx, aWeb
form that hosts the CommunitySearch server control.

When a site visitor clicks a tag cloud item, the Community
Search page displays, populated with search results for
the clicked tag. The visitor can click any result to seemore
about it.

The following five parameters are added to the link’s
QueryString, and pass tag information to the destination
Web form. Its search server control uses the parameters
to populate the search.

n searchtag or searchgrptag - searchtag represents
the tag’s text for users; searchgrptag represent the tag’s
text for community groups

n TagId - the clicked tag’s ID

n TagLanguage - the clicked tag’s language; only
search results in this language appear

n TagCount - the number of times the tag hasbeen
assigned

n TagType - the tag’s type: user, community group,
content or library item. This value is obtained from the
TagType property (described below).

In addition to these parameters, you can add your own by
defining them in the path. If you do, the above five
parameters are appended to yours.

String
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Note: The eCommerce feature requires special license from Ektron, Inc. If you do not see this
feature under Ektron CMS400.NET’s Settings area, it may be because your license does not
support eCommerce. For licensing information, contact sales@ektron.com.

This section also contains the following topics.

Introduction 17-3
Sample eCommerce Site 17-6
Access to eCommerce 17-7
Cart Server Control 17-8
Checkout Server Control 17-20
Images in eCommerce 17-32
Steps to Set Up a Basic eCommerce Web Site 17-33
eCommerce Configuration Screens 17-49
eCommerce Shipping Screens 17-85
eCommerce Tax Screens 17-94
eCommerce Products 17-103
eCommerce Analytics 17-180
eCommerce Recommendations 17-181
eCommerce Order Management 17-189
Customer Information 17-203
MyAccount Server Control 17-206
eCommerce Coupons 17-215
Using eSync with eCommerce 17-225
The eCommerce Audit Screen 17-226
eCommerce Reports and Widgets 17-228
eCommerce Server Controls 17-234
Customizing eCommerce 17-239
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Introduction
No matter what kind of sales you need to support, Ektron eCommerce brings
you all functionality you need, giving you an entire toolset for building out the
online marketplace you want. As part of Ektron Ektron CMS400.NET, you’ll have
a single application running both your Web site and online marketplace, letting
you manage both from the same interface.

Total integration means total control over your site via the author-friendly
Workarea, and you’ll open the doors to even more possibilities for marketing
and revenue!

This section also contains the following topics.

Core eCommerce Features 17-3
Coupons, Taxes and Pricing 17-4
Developer Flexibility 17-5
Related Webinars 17-5

Core eCommerce Features
eCommerce supports all product types, from single items, to complex products
(think movies available in DVD, Blu-ray or other formats), bundles, and kits.

eCommerce takes advantage of key CMS400.NET technologies, including Smart
Forms and market-leading taxonomy and search. Product entry Smart Forms
standardize how product information is entered; all information, attributes, and
descriptive text is entered in one place and goes into the database as structured
XML data (making it easy to repurpose this content wherever and whenever you
need it).

Enhance product SEO in the Smart Form by setting attributes, adding metadata,
and including photos and other media. Adding images of products auto-
generates thumbnails and gives you complete control over sizes and number of
images, as well as a clickthrough image gallery. Images can also be defined for
a product type via the taxonomy.

Control over your product catalog extends to cross-sell and upsell features, and
Ektron’s taxonomy enables products to be classified in multiple ways, providing
more options for you to help customers find what they are looking for.

CMS400.NET’s Web 2.0 content review tools find new uses here, letting your
customers post opinions and ratings on products. The product search uses
Ektron’s unparalleled taxonomy, and can be filtered by price, ratings, reviews,
and more.

Existing product data can be imported into eCommerce and the CMS using
Ektron’s flexible, scalable API.

Introduction
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When a customer is a member of your eCommerce site, they can name and
save shopping baskets for future purchases or as wish lists and registries. Your
site administrators can always see which baskets are open.

Checking out is a multi-step process: you can display all steps on a single page
or distribute them across multiple pages. While site visitors are checking out,
they can save as many shipping addresses as they want, or simply check “same
as billing.”

Shipping uses real-time rates by plugging into external providers, or you can
use your own rates by setting up an internal shipping provider. Rates are quite
customizable: they can be set up by package size, product weight, and even
product price ranges.

Payment options are flexible with eCommerce too: you can decide if you want
to accept credit cards, checks, and PayPal accounts. Also, payment gateways
(such as Payflow and Authorize.Net) are supported out-of-the-box to authorize
and capture transactions. Or, create your own payment gateway (one that
allows terms or any other payment option).

Once the order is reviewed and submitted (and payment is authorized), it can
go through a simple or complex routing through your own processing setup or
plug-in to your existing CRM or ERP to process the order. When the order is
processed, the CRM/ERP notifies CMS400.NET that it is complete. Online
inventory is kept up to date; you can set properties so that when items on hand
drop below a certain level, it triggers a sequence to notify your inventory
control.

Ektron eCommerce leverages the advanced core functionality of CMS400.NET to
give developers a complete toolset that works out-of-the-box or can be
completely customized (and everything in between). Powerful Web 2.0 controls
of CMS400.NET, including memberships, ratings, forums and commenting,
enabling you to quickly implement an eCommerce site with the community-
based information they want to help them to make buying decisions.

As a .NET application, eCommerce uses the same database as CMS400.NET to
maximize efficiencies and takes advantage of SQL cluster capabilities to be
truly scalable. There is no need for “glue code” to tie a third-party eCommerce
application to your Web site. Ektron eCommerce utilizes CMS400.NET’s existing
customizability to enable integration into any IT infrastructure. Open
architecture and a new ektron.cms.commerce API makes any commerce
configuration possible, letting you tie it to your back end systems.

Coupons, Taxes and Pricing
eCommerce supports a complete array of pricing schemes: individual pricing,
separate pricing within complex products, tiered pricing to support volume
discounts, and more. Online coupon capability is also included, letting you set
the type (dollar amount, percentage) and at what level those coupons are
applied (product level, basket level and type of item).
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For global business opportunities, all international currencies are available. You
are able to use conversion rates to determine prices or set flat costs for each
product. This goes hand in hand with the tax options available. Set tax classes,
including country, state, and local (by postal code) as well as taxes for specific
classes of goods, and be able to sell to even more customers.

Developer Flexibility
Ektron eCommerce leverages the advanced core functionality of Ektron
CMS400.NET to give developers a complete toolset that works out-of-the-box
or can be completely customized (and everything in between). Powerful Web
2.0 controls of CMS400.NET, including memberships, ratings, forums and
commenting, enabling you to quickly implement an eCommerce site with the
community-based information they want to help them to make buying
decisions.

As a .NET application, eCommerce uses the same database as Ektron
CMS400.NET to maximize efficiencies and takes advantage of SQL cluster
capabilities to be truly scalable. There is no need for “glue code” to tie a third-
party eCommerce application to your Web site. Ektron eCommerce utilizes
Ektron CMS400.NET’s existing customizability to enable integration into any IT
infrastructure. Open architecture and a new ektron.cms.commerce API makes
any commerce configuration possible, letting you tie it in to your back end
systems.

Related Webinars
Ektron provides the following webinars to further your understanding of the
eCommerce solution.

n Introduction to the Ektron eCommerce Platform
(http://www.ektron.com/webinars/Introduction-to-the-Ektron-
Ecommerce-Platform)

n Building Your First Ektron eCommerce Site
(http://www.ektron.com/webinars/Building-Your-First-Ektron-
Ecommerce-Website)

n Utilizing the Ektron eCommerce APIs
(http://www.ektron.com/webinars/ecommerce_api)
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Sample eCommerce Site
To see a sample eCommerce site, download the Developer Sample Site. Within
that site, you can try out a customer shopping experience by going to
http://site root/cms400developer/developer/default.aspx then
Commerce > Cart. The following shopping cart screen appears.

You can add items to the cart then proceed through a sample checkout process.

The following eCommerce server controls are used to facilitate this process.

n Cart Server Control on page 17-8

n Checkout Server Control on page 17-20
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Access to eCommerce
Only members of the Administrators group or those assigned the eCommerce
Admin role can access the eCommerce screens within the Ektron CMS400.NET
Workarea. See Also: Defining Roles on page 15-31
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Cart Server Control
The Cart server control allows a site visitor to work with products they have
selected to purchase. Think of this as a shopping basket. As a site visitor
navigates around your site selecting products to purchase, they are added to a
cart.

A site visitor typically reaches the Cart server control from a product
description or list page. A product description page is one that contains a
Product server control. Product list pages contain server controls that create a
list of products; for example, the ProductList, ProductSearch or
Recommendation controls. Inside these controls, there is a button or link that
allows a site visitor to add the product to the cart.

You could also create a link from a master page or menu that allows site
visitors to view their cart. This allows a site visitor to navigate directly to their
cart when they arrive at your site.

This section also contains the following topics.

Cart Server Control Areas 17-9
Flow of the Cart Server Control 17-10
Working with a Cart 17-10
Adding an Item to a Cart 17-11
Creating a New Cart 17-11
Displaying an Item’s information 17-12
Assigning or Changing the Name of the Cart 17-13
Changing an Item’s Quantity 17-13
Removing an Item from the Cart 17-14
Continuing to Shop 17-14
Applying Coupons 17-14
Emptying the Current Cart 17-15
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Checking Out 17-16
Deleting a Saved Cart 17-16
Cart Server Control Properties 17-16

Cart Server Control Areas
The Cart server control is made up of two major areas. The top part of the
control represents the current cart a site visitor is working with. This area is
known as Your Cart. The bottom represents a site visitor’s saved carts. This
area is known as Your Saved Carts. The saved cart information appears only
when a site visitor is logged in. See Also: Creating a New Cart on page 17-11.

The Your Cart area displays the Item, SKU, Quantity, Manufacturer’s
Suggested Retail Price, Sale Price, Subtotal and Total. From this cart, a site
visitor can update the quantity and subtotal information, apply coupons and
check out. The site visitor can also choose to continue shopping or empty the
cart.

The Your Saved Cart area contains a list of carts the site visitor has saved
and are awaiting checkout. This allows the site visitor to select products and
save them for future purchase. This area contains:

n the name of each cart

n the last time it was updated

n how many products in each cart

n the subtotal of each cart

n an option to delete a saved cart

n an option to create a new cart

Cart Server Control Areas
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Clicking a saved cart makes it the current cart and its products are displayed in
the Your Cart area. A site visitor can then proceed with checking out.

The following topics are discussed in this section:

n Flow of the Cart Server Control below

n Working with a Cart below

n Cart Server Control Properties on page 17-16

Flow of the Cart Server Control
A site visitor typically arrives at this control by clicking the Add to Cart button
in the Product, ProductList, ProductSearch or Recommendation server controls.

Below is an image depicting the flow of the Cart server control.

Working with a Cart
This section explains how a logged in site visitor would use the Cart server
control. It contains these subsections.

n Adding an Item to a Cart on the facing page

n Creating a New Cart on the facing page

n Displaying an Item’s information on page 17-12

n Assigning or Changing the Name of the Cart on page 17-13
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n Changing an Item’s Quantity on page 17-13

n Removing an Item from the Cart on page 17-14

n Continuing to Shop on page 17-14

n Applying Coupons on page 17-14

n Emptying the Current Cart on page 17-15

n Checking Out on page 17-16

n Deleting a Saved Cart on page 17-16

Adding an Item to a Cart
Items are added to a cart when a site visitor clicks the Add to Cart link or
button in the following server controls.

n Product

n ProductList

n ProductSearch

n Recommendation

Once Add to Cart is clicked, the item is appended to the current cart’s list of
items. If the site visitor does not have an existing cart, a new one is created.

Creating a New Cart
A site visitor automatically creates a new cart the first time he adds a product
to the cart. If needed, a site visitor can create multiple carts while using the
Cart server control. This allows for the grouping of products being purchased.
For example:

n site visitors might wish to create carts based on concepts, such as,
Son’s Birthday or Item Type.

n site visitors want to use separate payment types. For example, a site
visitor might want to place some products on one credit card and
place the rest on another. By having two carts, the site visitor can
proceed with two separate checkouts allowing them to use multiple
credit cards.

n site visitor needs to prioritize purchases. For example, a site visitor
knows they want to purchase certain products, but cannot afford
them until a later date. He can add these products to a separate cart
then continue to purchase products he can afford now. This helps the
site visitor remember purchases they want to make and drives
additional sales for your site.

To create a new cart, click the Create New Cart button in the Saved Cart
area.
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The button is replaced with a text box. Next, enter the name of the new cart in
the text box and click the OK button.

Once the site visitor clicks OK, the cart is added to the list of Saved Carts and
becomes the active cart. A site visitor can then click the Continue Shopping
button to select products to add to the new cart.

Displaying an Item’s information
In the Cart server control, a product’s title is a link. When clicked, it takes you
to the product’s detail page. To navigate back to the cart, click the back button.
By default, the server control uses the product’s QuickLink information to
provide a path to the product. You can override this functionality by adding a
new path to the TemplateProduct property.

Conducting eCommerce with Ektron CMS400.NET
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Assigning or Changing the Name of the Cart
Assigning a name to a cart makes it easier for site visitors to identify a cart in
their saved cart list. A site visitor can assign or change the name of a cart by
clicking the Edit button located next to the cart’s name.

Once clicked, the button and name are replaced with a text box that allows the
site visitor to enter a new name for the cart. When finished, click the OK
button.

Changing an Item’s Quantity
To change a product’s quantity, enter the new amount in the Quantity column’s
textbox located in the same row as the product you want to change. Next, click
the Update Subtotal button. This will recalculate the total price for the product
and update the subtotal. The image below shows the Atrium Table quantity
change to three.

Assigning or Changing the Name of the Cart
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Removing an Item from the Cart
A site visitor can remove a product from the cart by clicking its Remove From
the Cart button ( ) in the Remove column. Once the site visitor clicks the
button, the product is removed from the cart and the Subtotal is updated.

Continuing to Shop
A site visitor can continue to shop by clicking the Continue Shopping button.
This takes the site visitor back to a template defined in the cart server control’s
TemplateShopping property. For example, you might send the site visitor to
a page containing a ProductList or ProductSearch server control. See Also:
Product List Server Control on page 17-156 and ProductSearch Server Control
on page 17-163.

As a developer, you need to add the path to this page to the TemplateShopping
property. If the page is in the same folder as the page that contains the Cart
server control, just enter the page’s name.

Applying Coupons
If you have coupons defined in the Workarea and the EnableCoupons property
is set to True, a site visitor can enter coupons to discount the purchase. How
coupons affect the purchase is defined in the Workarea > Settings > Commerce
> Catalog > Coupons. See Also: eCommerce Coupons on page 17-215

To apply a coupon, a site visitor clicks the Apply Coupon button.
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The button area changes to text box where the site visitor can enter the
Coupon Code. The site visitor then enters a code and clicks the OK button.

Once a site visitor clicks OK, the discount appears above the Subtotal and he
can continue to shop, checkout, view other carts or delete the coupon.

A site visitor can remove the coupon by clicking the Remove Coupon button.

Emptying the Current Cart
To clear all of the products in the current cart, a site visitor clicks the Empty
Cart button. Once clicked, a dialog box appears and the site visitor can click
the OK or Cancel button.

Emptying the Current Cart
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Checking Out
Once a site visitor is satisfied that the current cart contains all products they
want, the quantity of each product is correct and all coupons have been applied,
he can click the Checkout button. At that point, the site visitor is taken to the
page that contains the Checkout server control. The path to the page is defined
in the TemplateCheckout property. If the page containing the Checkout server
control is in the same folder as the Cart server control, just enter the page
name.

If a site visitor has an item in his cart that is out of stock, the Checkout button
is disabled (hidden).

Deleting a Saved Cart
A site visitor can delete a saved Cart by clicking on the Delete Cart button.
Clicking this button instantly deletes the cart.

Cart Server Control Properties
The following table explains the properties of the Cart control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description
Data
Type

Authenticated Indicates if you are logged in to the CMSWorkarea
and can use it to browse to Content, Collections. String
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Property Description
Data
Type

CustomXml

(Code BehindOnly)

Enter a string of XML that you want to make available to the XSLT.
This property providesamechanism to inject customXML into the
generated XML before being processed by the XSLT. The sting is
added inside the CustomXml tag as follows:

<root><customXml>custom-xml-inserted-
here</customXml></root>

See Also:Displaying CustomXML in Ektron’sServer Controlson
page 24-38

String

DisplayXslt

Specify an externalXSLT file to render the control. Bydefault, the
control usesCart.xsl. This file is located in
<Site Root>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly recommended
that youmake a copy, change its name andmove it outside your
site’sWorkarea folder. If youmake changes to this file and do not
move it out of theWorkarea folder, this file and the changeswill be
lost when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes shown.

Boolean

DynamicProductParameter

TheQueryString parameter namewhich is used to pass the
product ID to the product details page. For example, if your
QueryString parameter for products is ID, enter that in this
property. Then, when site visitors clicks a product’s title, this
parameter is passed with the product’s ID to the product details
page.

String

EnableCoupons

Set to true to allow a site visitor to enter coupon codes for discounts.
When set to false, theApply Coupon button is hidden. See Also:
Applying Couponson page 17-14

True = coupon entry is available. (Default value isTrue if this
property is not set.)

False = coupon entry is not available.

Couponsare created in theWorkarea >Settings>Commerce >
Catalog >Coupons section. See Also: eCommerce Couponson
page 17-215

Boolean

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language Set a language for viewing the cart. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer

Cart Server Control Properties
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Property Description
Data
Type

LoadingImage

The image to displaywhile the cart is loading.

The default isajaxloader_circle_lg.gif.

This file is located in<siteroot>\Workarea
\images\application.

String

Stylesheet

Specify the path to a style sheet for use with this server control. The
location can be relative or absolute. Leave blank to use the default
style sheet. The default isCart.css.

This file is located in:

<Site Root>\Workarea\csslib\Commerce

Important: If you want to edit this file, it is strongly recommended
that youmake a copy, change its name andmove it outside of the
Workarea folder. If youmake changes to this file and do not move it
out of theWorkarea, this file and the changeswill be lost when you
upgrade.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TemplateCheckout

The template location that contains the Checkout server control.
This is the page a site visitor is sent to when he clicks theCheckout
button. If the template file is located in the same folder as theWeb
form containing this server control, just enter its name. Otherwise,
the path to the file can be relative or absolute. See Also:Checking
Out on page 17-16

String

TemplateProduct

The template location that contains the Product server control. This
is the page a site visitor is sent to when he clicks the name of a
product in his cart. This page providesdetails about the product.
See Also:Displaying an Item’s information on page 17-12.

When this property is left blank, the server control uses the
Product’sQuickLink information.

If the template file is located in the same folder as theWeb form
containing this server control, just enter its name. Otherwise, the
path to the file can be relative or absolute. See Also:Displaying an
Item’s information on page 17-12

String

TemplateShopping

The URL to navigate to when the site visitor clicks theContinue
Shopping button. ThisURL could lead to a template containing a
ProductSearch or ProductList server control that would allow a site
visitor to select additional products. See Also:Continuing to Shop
on page 17-14.

For information the ProductSearch or ProductList controls, see
ProductSearch Server Controlon page 17-163 or Product List
Server Controlon page 17-156

String
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Checkout Server Control
Important:When using the Checkout server control, you should always have an SSL certificate
installed for your Web site and set the control’s IsSSLRequired property to True. This protects
your customers’ payment information while it is being transmitted. Do not use a self-signed SSL
certificate -- obtain one from a trusted certificate authority.

The Checkout server control allows a site visitor to navigate through the
checkout process. This process includes:

n adding billing and shipping information

n selecting a shipping method

n reviewing the order

n submitting the order and credit card information

n notification that checkout process is complete

Site visitors typically arrive at this server control by clicking the Checkout
button on the Cart server control. They also might reach this server control
from a Checkout link you create on your site.

The control provides a navigational aid that indicates the customer’s step in the
checkout process. At any point, the customer can move forward to the next step
or back to a previous one.

As appropriate, some steps do not appear. For example, if merchandise is not
tangible, the shipping screen does not appear.

This section also contains the following topics.

Logging In or Setting Up an Account 17-21
Existing Customers' Login 17-21
Customer's First Time Login 17-21
Guest Account Registration 17-22
Checkout Server Control Screens 17-22
Billing Information 17-23
Shipping Information 17-23
Shipping Method 17-24
Review Order 17-24
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Submit Order 17-25
Order Complete 17-25
Flow of the Checkout Server Control 17-26
Checkout Server Control Properties 17-27

Logging In or Setting Up an Account
The login portion of the Checkout server control accommodates these types of
customers.

n existing customers

n customers who have not logged in before but who wish to create an
account

n customers who wish to make one-time only purchase and not set up
an account

Existing Customers' Login
If an existing customer is not logged in when he reaches this server control, it
prompts him to log in. Optionally, this screen could have a link that allows an
existing user to recover his password. To enable this link, add a template path
to the control's TemplateRecoverPassword property.

After a site visitor who previously purchased from this site logs in, billing and
shipping information are retrieved and appear by default. The visitor can
review and edit this information. However, Ektron CMS400.NET does not store
credit card numbers, so that information must be entered each time.

Customer's First Time Login
If a site visitor has not purchased from your site before and wants to set up an
account, he clicks Create Profile and Checkout. On the new screen, he
enters billing information including a password.

After completing that screen, a membership user account is created, and he is
logged in. The new user can then proceed through the checkout. The next time
this visitor logs in, he is treated as an existing customer.

Logging In or Setting Up an Account
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Guest Account Registration
The Checkout server control also provides a guest checkout feature (circled
below) for site visitors who don't want to set up an account on your site. To
enable this feature, set the AllowGuestcheckout property of the Checkout
server control to true.

If a user clicks Checkout Without Profile, he proceeds to a version of the
billing screen that version does not ask for a password. The rest of the checkout
is exactly the same.

Although the customer can proceed through the checkout like other customers,
if he wants to checkout again in the future, he must re-enter all billing and
shipping information.

Site visitors who use the guest checkout feature can view their orders using the
Order List server control if its GuestOrderView property is set to true. See
Also: OrderList Server Control on page 17-196

Checkout Server Control Screens
The Checkout server control is broken up into several sections. Each section
represents a portion of the checkout process.

n Billing Information on the facing page

n Shipping Information on the facing page

n Shipping Method on page 17-24

n Review Order on page 17-24

n Submit Order on page 17-25

n Order Complete on page 17-25
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Billing Information
This section prompts site visitors to enter or update billing information,
including:

n Name

n Company (Optional)

n Street Address, City, State, Postal Code, Country

Note: If a site visitor chooses a country other than the United States, no field validation is
applied to the postal code by default. To apply country-specific postal code validation, see this
Ektron Knowledge Base article:http://dev.ektron.com/kb_article.aspx?id=26072 .

n Phone

n email address (appears when a visitor is creating a new account or
doing a guest checkout)

n Password (appears when a visitor is creating a new account or doing
a guest checkout)

Shipping Information
This page allows site visitors to add or edit shipping information. By default, it
uses the billing address as the shipping address. From this screen, site visitors
can

n add new addresses

n edit or delete existing addresses

n if more than one address is entered, pick address for current order

n proceed to the next step or back to the previous page

Billing Information
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When a logged-in site visitor adds a new address, it’s stored with the account
information in Ektron CMS400.NET.

Shipping Method
This page allows site visitors to select the type of shipping for their products.
Shipping methods that appear here are defined in theWorkarea > Settings >
Commerce > Shipping > Methods. For information on setting up shipping
methods, see Shipping Methods on page 17-89.

Review Order
The Review Order page displays information about the products being
purchased, their price, shipping charges, discounts, and taxes. At this point, if a
site visitors wants to modify their cart, they click the Edit your cart link. For
example, a site visitor wants to apply a coupon to his cart.

For this link to work properly, you need to add the path to the template that
contains the Cart server control to the Checkout server control’s TemplateCart
property.
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Submit Order
On the Submit Order page, a site visitor enter payment information. He can pay
by check, credit card, or PayPal, depending on what has been set up in your
Ektron CMS400.NET Workarea’s eCommerce > Configuration > Payment
Options screen.

Once a site visitor enters the information, he clicks the Submit button. At that
point, the charge is submitted to the payment gateway, and the order is posted
in Ektron CMS400.NET. See Also: Orders on page 17-189

Order Complete
This page displays a Thank You note, the order ID, and links to continue
shopping or view an order’s history.

The Continue Shopping link appears when you add the path of a template that
allows a site visitor to find products to the TemplateShopping property. For
example, you might send them to a template containing a ProductSearch or
ProductList server control.

Submit Order
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The Order History link appears when you add the path of a template
containing the OrderList server control to the TemplateOrderHistory
property.

Flow of the Checkout Server Control
Below is a flow chart that represents the options & processes in the Checkout
Server Control.
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Checkout Server Control Properties
The following table explains the properties of the Checkout control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer and can
use it to browse to Content, Collections, etc.
See Also:Working with Ektron CMS400.NET Server
Controlson page 24-1

String

CacheInterval

Sets the amount of time the server control’s data is cached.
The default is 0 (zero). This is the amount of time, in seconds,
a control’s data is cached. For example, if you want to cache
the data for fiveminutes, set theCacheInterval property
to 300 (three hundred).
See Also:Caching with Server Controlson page 24-33

Double
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Property Description Data Type

CurrentPhase

(Code BehindOnly)

Reports or selects the current page (or phase) of the
checkout control. This allowsyou to customize the flow of the
control. For example, if you only have one shipping option,
you would skip the ShippingInfoEntry phase.

For an example of working with the CurrentPhase property in
code behind, download Ektron’sDeveloper Sample Site and
view these files.
[Site Root]/Developer/Commerce
/CheckoutDemo_Advanced.aspx

[Site Root]/Developer/Commerce
/CheckoutDemo_Advanced.aspx.cs

Phasesare listed below in the order which theyhappen within
the control.

Login - allowsexisting users to log in. See Also: Logging In or
Setting Up an Account on page 17-21.

BillingInfo - displaysa site visitor’s billing information. See
Also:Billing Information on page 17-23

BillingInfoEntry - allowsentry of a site visitor’s billing
information. See Also:Billing Information on page 17-23.

ShippingInfo - allowsentry of a site visitor’s shipping
information.

ShippingInfoEntry - pallowsentry of a site visitor’s shipping
information. See Also:Shipping Information on page 17-23.

ShippingMethodSelect - allows selection of themethod of
shipping. See Also:ShippingMethod on page 17-24.

ReviewOrder - displays the current order’s details for review.
See Also:Review Order on page 17-24.

SubmitOrder - lets site visitors add payment information.
See Also:Submit Order on page 17-25.

Complete - displays completionmessage. See Also:Order
Complete on page 17-25.

Error_EmptyBasket - used when a cart hasno itemsand
the site visitor somehow enters the control.

Error_UnhandledException - occurswhen there’s an
error that the control cannot resolve.

ControlPhase

CustomXml

(Code BehindOnly)

Enter a string of XML that you want to make available to the
XSLT. This property providesamechanism to inject custom
XML into the generated XML before being processed by the
XSLT. The sting is added inside the CustomXml tag as
follows:

<root><customXml>custom-xml-inserted-
here</customXml></root>

See Also:Displaying CustomXML in Ektron’sServer Controls
on page 24-38

String
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Property Description Data Type

DefaultCountryId

The ID of the default country that appears in the Billing
Addressand Shipping Address. Set this ID to the country
fromwhich themajority of your customerswill bemaking
purchases. If the site visitor is from a different country, he can
change it when editing the Billing or Shipping Address.

To find a country’s numeric ID, sign into the Ektron
CMS400.NETWorkarea. Then go toSettings >
Commerce > Configuration > Countries. The Numeric
ID is in the left column of that screen.

Integer

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false
if you want to postpone the fill-action until later. In this case,
FIll is automatically called during the Page Render event.

Youmight do this if you need to set or change a property on
the control in codebehind and have it render with your
changes shown.

Boolean

DynamicPhaseParameter The name of the parameter on theQueryString that identifies
desired phase ID. String

DisplayXslt

Specify an externalXSLT file to render the control. Bydefault,
the control usesCheckout.xsl. This file is located in
<SiteRoot>\Workarea\Xslt\Commerce
\Checkout\Standard

Important: If you want to edit this file, it is strongly
recommended that youmake a copy, change its name and
move it outside your site’sWorkarea folder. If youmake
changes to this file and do not move it out of theWorkarea
folder, this file and the changeswill be lost when you upgrade.

String

FriendlyErrorMessage

Themessage that is shown to a site visitor when an
unhandled error occurs. Details are sent to the event log. The
default message is
“We're sorry, an error occurred while processing your
request. Please try again later...”

String

AllowGuestCheckout Set to true if you wish to allow theGuest Checkout feature.
See Also:Guest Account Registration on page 17-22 Boolean

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean
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Property Description Data Type

IsSSLRequired

When set to True, switches to an SSL encrypted URL. For
the SSL encryption to work, youmust have an SSL certificate
installed for your site. See Also:Configuring SSL on page 1-
95

Information on SSL can be found at the followingWeb sites.

http://www.tech-faq.com/understanding-ssl.shtml

http://www.verisign.com/ssl/ssl-information-
center/how-ssl-security-works/index.html

Installing and using an SSL is one of themost important things
you can do to protect your customer’s credit card data.

Note: Ektron, Inc. is not associated with TechFAQor
VeriSign. However, both sites offer good explanationsof
Secure Sockets Layer.

Boolean

Language
Set a language for viewing the checkout control. This
property shows results in design-time (in VisualStudio) and at
run-time (in a browser).

Integer

LoadingImage
The image to displaywhile the control is fetching data. The
default is<siteroot>\Workarea\images
\application\ajax-loader_circle_lg.gif.

String

Stylesheet
Specify the path to a style sheet for use with this server
control. The location can be relative or absolute. Leave blank
to use the default style sheet.

String

SuppressWrapperTag

Suppresses the output of the span/div tagsaround the
control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TemplateCart

The URL path of the template that contains the Cart server
control. This path can be relative or absolute.

When a path is entered, a link appears in the Review Order
part of the process that allowsa user to navigate to the
template containing the Cart server control. See Also:Review
Order on page 17-24 andCart Server Controlon page 17-8.

String

TemplateOrderHistory

The URL path of the template that contains the OrderList
server control. This path can be relative or absolute.

When a path is entered, a link appears at the end of checkout
process that allowsa user to navigate to the template
containing theOrderList server control. See Also:Order
Complete on page 17-25 andOrderList Server Controlon
page 17-196.

String
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Property Description Data Type

TemplateRecoverPassword

The URL path of the template that helps site visitors recover
their password. This path can be relative or absolute.

When a path is entered and a site visitor hasnot logged in, a
link appears at the beginning of checkout process that allows
him to navigate to a template containing information to
recover his password. TheMembership server control
contains an option for recovering passwords. See Also:
Logging In or Setting Up an Account on page 17-21 and
Membership Server Controlon page 16-19

String

TemplateShopping

The URL path of the template that allows the site visitor to
continue shopping.

If a path is entered, a link appears at the end of checkout
process that allowsa user to navigate to a template that letys
him continue shopping; for example, the template containing
a ProductList or ProductSearch server control. See Also:
Order Complete on page 17-25,Product List Server Control
on page 17-156 andProductSearch Server Controlon page
17-163

String
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Images in eCommerce
When using eCommerce, a site visitor sees images that represent products or
services for sale. The following table lists each image that appears on an
eCommerce Web site, and the source of each one.

Where Image
Appears

Example Image Location in Workarea

Product Server
Control, main
image

Image on Product control

On the catalog entry’sContent tab

Note: The sample catalog entries
are based on Product Types
whose XMLSmart Form includes
an Image field. Asa result, the
product description, (which
appears at the top of the Product
Server control) includesan image.
This is not required, merely a
suggested implementation.

Product Server
Control,
thumbnails

Thumbnails on lower portion of Product
control

Note: To control the thumbnail display, use
the Xslt files generated by the Product,
Product List, Product Search, and
Recommendation server controls.

On the catalog entry’sMedia screen.

If an image’sGallery Display field is
set toYes, its smallest thumbnail
appears on the Product server control,
below the content area. (This
assumesyou are using the control’s
default xslt.)

When a site visitor clicks a thumbnail,
the corresponding full image appears.

Since theMedia screen can have
several images, several thumbnails
can appear. Theyappear left to right
reflecting their sequence (top to
bottom) on theMedia screen.

See Also:Determining Thumbnail Size
on page 17-141

Product List,
Product Search,
and
Recommendation
server controls

Image on Product List control

On the catalog entry’sMedia tab, the
image designated asProduct Icon

See Also:Entering a Catalog Entry’s
Media on page 17-139
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Steps to Set Up a Basic
eCommerce Web Site
This section describes how to set up a basic eCommerce Web site. This walk
through explains everything you need to set in the web.config file and the
Workarea. It also includes a list of templates needed and how to set up Ektron’s
eCommerce Server Controls on them.

Steps Description

Step 1.

In theWeb
site’s
web.config file,
set the following
keys:

<add key=”ek_ecom_DefaultCurrencyId” value=”840” />

n this keydetermines the base currency for your Web site. The default is 840 (the US
Dollar). If needed, change this to the Numeric ISOcode for the default currency. See
Also: TheDefault Currencyon page 17-56

Warning! Do not change this once the site is live.

<add key=”ek_MeasurementSystem” value=“English” />

n For each item sold on your Web site, you define a height, length, depth, and weight. If
English, the units are inchesand pounds. If Metric, the units are centimeters and
kilograms.

This information is used to calculate shipping costs. Bydefault, this is set to English.
Change to “Metric” to use theMetric system. See Also:Packageson page 17-87

Warning! Do not change this once the site is live.

<add key=”ek_ecom_ComplianceMode” value=”false” />

n set this key to “true” when you want your site to be SecurityCompliant. Thismeans
theWorkarea will be encrypted in an SSL session and Logging is started.

More Information:

A list of currencies and their Numeric ISO code can be found in the
Workarea > Settings > Commerce > Configuration > Currencies section.
The ID is the Numeric ISO code.

Step 2.

Decide whether
you want to use
Ektron
CMS400.NET’s
inventory
system or
another
inventory
system.

If you are not using Ektron CMS400.NET’s inventory system, create a custom inventory
provider and add it to the web.config file’s InventoryProvider. Ektron’s InventoryProvider
feature allowsyou to workwith an existing inventory system. This is set in the web.config
file.

n Add the custom provider between the InventoryProvider’s <providers> tagsand
change the default provider to the name of your custom inventory provider. For example:

<inventoryProvider defaultProvider=”MyCustomInventoryProvider”>

More Information: Customizing the Inventory Provider on page 17-285
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Steps Description

Step 3.

Select a
default
Payment
Gateway.

To use one of the payment gateways shipped with Ektron CMS400.NET, you can set it in
theWorkarea.

1. Navigate to Settings > Commerce > Configuration > Payment
Gateway.

2. Click a payment gateway’s name.

3. Click the Edit button.

4. Add your User ID, Password and any needed Custom Values.

5. Click the Default check box to make that selection the default.

6. Click the Save button.

If you are not using one of these gateways, create a custom payment provider and add it
to the web.config file’sEktronPaymentGateway. Add the custom provider between the
EktronPaymentGateway’s<providers> tags. Once added, the option should appear in
theWorkarea’sPayment Gatewayscreen.

If you want to override theWorkarea settings, change the default provider in the
web.config file from “Automatic” to the name of the desired payment gateway. For
example:

<EktronPaymentGatewaydefaultProvider=”AuthorizeNet”>

More Information: Payment Gateway on page 17-70

Step 3a
(optional) Set
up PayPal
Support

SeePayPalSupport on page 17-62

Step 4.

Set up a
shipping
provider.

If you are not using the default flat rate shipping provider, open the shipment.config file
and set the default provider in formation in: <shipmentProvider
defaultProvider=”FlatRateShipmentProvider”> to either “FedExShipmentProvider” or
“UPSShipmentProvider”. If you are using either of these shippingmethods, make sure
you fill in the following information in the <providers> tags. This information is provided by
FedExand UPS. (If you don’t see these items, scroll the window to the right.)

n key=””

n password=””

n accountNumber=””

meterNumber=””

In addition to using these providers, you can add additional providers.

More Information: Defining Shipping Providers on page 17-90
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Step 5.

Enable
countries
where your
Web site will
sell its
products

Note: The
United
States is
enabled by
default.

Enabling a country in Ektron CMS400.NET:

n makes it available for site visitors to use aspart of an address for shipping and billing
purposes

n makes it available when you add a warehouse

n automatically enables its corresponding tax table in the CountryTaxTable section of
theWorkarea

Enable Countries in the Workarea.

1. Navigate toSettings >Commerce >Configuration >Countries.

2. Click a country’s name.

3. Click theEdit button.

4. Click theEnabled checkbox.

5. Click theSave button.

More Information: Countries on page 17-49

Step 6.

Add and
enable
regions for
each country
your
eCommerce
site will
service.

Note: All
states in the
USare
enabled by
default.

Regions can represent states, provinces, territories, etc. and further define areasof a
country. Adding and enabling regions:

n makes it available for site visitors to use aspart of an address for shipping and billing
purposes

n makes it available when you add a warehouse

automatically enables its corresponding tax table in the RegionsTaxTable section of the
Workarea

Add Regions in theWorkarea.

- Prerequisite: The region’s country is defined in the Countries
screen.

1. Navigate toSettings >Commerce >Configuration >Regions.

2. ClickNew>Region.

3. Enter a Name.

4. Click theEnabled checkbox.

5. In the Code box, enter an abbreviation for this region.

6. Select this region’s country from the pull down list.

7. Click theSave button.

More Information: Regions on page 17-52
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Step 7.

Enable
Currencies
for your
eCommerce
site.

Note: By
default, U.S.
dollar, Euro
and
Australian
dollar are
enabled.

If your Web site is selling products in another country and you want to
display prices in that country’s currency, enable it in the Workarea.

1. Navigate to Settings > Commerce > Configuration >
Currencies.

2. Click a currency.

3. Click the Enable button.

4. Set the Exchange Rate.

Note: The default currency set in the web.config file is the base reference currency
when setting an exchange rate.

5. Click the Save button.

More Information: Currencies on page 17-54

Step 8.

Decide which
credit cards
your
eCommerce
site will
accept.

Credit cards are used during the checkout process, by the Checkout server
control, during the submit phase. During this phase, all enabled credit
cards appear in a drop down which site visitors use to select their choice.

Add credit card types in the Workarea.

1. Navigate toSettings >Commerce >Configuration >Credit Card.

2. ClickNew>Credit Card Type.

3. Enter the credit card’s name; for example, Visa.

4. Check theAccepted checkbox.

5. Add an image.

6. Add a RegexExpression to validate the credit card number.

7. Click theSave button.

More Information: Credit Card Types on page 17-77

To learn about the Checkout server control, see Checkout Server Control
on page 17-20.
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Steps Description

Step 9.

Add or edit
eCommerce
notification
messages.

email notificationsare sent to your customersafter their order hasbeen received,
cancelled, shipped or completed. Ektron provides four predefinedmessages, one for
each event.

For messages to be sent, content notificationsmust be enabled and the customer must
enter a valid email address.

Add or edit messages in theWorkarea. To edit a message:

1. Navigate toSettings >Commerce >Configuration >Messages.

2. Click the title of themessage.

3. Click theEdit button.

4. Change the properties and fields asnecessary.

5. Change the text asneeded.

More Information: eCommerce Messages on page 17-81

To learn about content notifications, see Configuring email for Tasks and
Content on page 1-83

Step 10.

Create Tax
Classes.

(Optional)

If you are collecting taxes for transactionson your eCommerce site, create a TaxClass
for each taxable category of products. For example, if your eCommerce site sells alcohol
and tobacco, set up a tax class for each type.

Ektron provides four tax classesbydefault:

n Alcohol

n Goods

n Services

n Tobacco

Tax classesare applied to Postal, Regional and CountryTaxTables. In those tables you
define a separate rate for each TaxClass.

TaxClassesare created in theWorkarea.

1. Navigate toSettings >Commerce >Tax >Tax Classes.

2. Click theNew>Tax Class.

3. Enter a name; for example, Food.

4. Click theSave button.

More Information: The Tax Class Screens on page 17-95
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Step 11.

Set your tax
rates in Ektron
CMS400.NET
TaxTables

Once your TaxClassesare set up, you need to set a tax rate for each class in the Postal,
Regional, or CountryTaxTables.

n Postal TaxTables - use when there is a city or county tax. If there are postal, regional
and country taxesapplied to a given area, roll them all into this table.

n Regional Tax Tables - use when there is a state, provincial or territorial
tax. If only regional and country taxes are applied to a given area, roll them
into this table.

n Country Tax Tables - use when there is country-wide tax. If only country
level taxes are applied to a given area, use this table.

Ektron CMS400.NET checks these tables in the following order: Postal,
Regional, then Country. Once it finds a tax, it stops. Therefore, if a postal
zone has several taxes (for example, a local tax and a regional tax), build
the combined percentage into the postal code tax. So, assume New York
City has a 4% tax, and New York state has a 3% tax. In this case, enter a
combined total of 7% into all Postal Tax Tables within New York City.

While you need to create each Postal Tax Table, Regional and Country
Tax Tables are automatically generated when a country or region is added
to Ektron CMS400.NET. However, there are no tax rates defined in these
tables.

Create Postal TaxTablesor edit Region and CountryTaxTables in theWorkarea.

To create a new Postal TaxTable:

1. Navigate toSettings >Commerce >Tax >Postal Tax Tables.

2. Click theNew>Postal Code.

3. Enter a PostalCode.

4. Select the Country and Region.

5. Enter a tax rate for each TaxClassasneeded.

6. Click theSave button.

To edit a Region’s or Country’s TaxTable:

1. Navigate toSettings >Commerce >Tax >Regional Tax Tables or Country
Tax Tables.

2. Click the Id or Code of the Region or Country.

3. Click theEdit button.

4. Change the information asneeded.

5. Click theSave button.

More Information: Postal TaxTables on page 17-97, Regional Tax Tables
on page 17-99, Country Tax Tables on page 17-101
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Step 12.

Add and
select
shipping
methods in
the
Workarea.

Note: If you
have not set
up a
shipping
provider,
seeSet up a
shipping
provider. on
page 17-34

Once you have a shipping provider set up (see Set up a shipping provider.
on page 17-34), define the shipping options from which your site visitors
can select. For example, if you use UPS, define whether to allow Next Day,
2nd Day, 3rd Day, Ground, World Wide Standard, etc. Once a Shipping
Method is enabled, it will appear in the Shipping Method phase of the
Checkout server control. Shipping Methods are defined in the Workarea.

1. Navigate toSettings >Commerce >Shipping >Methods.

2. ClickNew>Shipping Method.

3. Enter a Name. This name represents the option in the ShippingMethod phase of
the checkout server control.

4. Click theActive checkbox to enable thismethod.

5. Click theViewOptions link.

6. From the Provider Service drop down, select a shippingmethod.

7. Click theSave button.

Repeat these steps until you’ve added all the necessary shipping methods.

More Information: Shipping Methods on page 17-89

Step 13.

Add a
warehouse
from which
your products
will be
shipped.

This does not have to be the actual shipping address for the products.
Ektron CMS400.NET uses this information to determine the “from” address
when calculating shipping cost.

Add warehouse information in the Workarea.

1. Navigate to settings >Commerce >Shipping >Warehouses.

2. ClickNew>Warehouse.

3. Complete the address information fields.

Note: Only countries and regions that have been enabled for eCommerce appear in
the drop down lists.

4. Click theDefault Warehouse checkbox if you want this to be the default
warehouse. Only the default warehouse is used in the checkout process.

5. Click theSave button.

More Information:Warehouse on page 17-85
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Step 14.

Define each
package size
your shipping
department
uses to ship
your products.

Tangible products have size and weight dimensions. Ektron CMS400.NET’s shipping
calculator uses this information with the package size information to fit the order into the
smallest-sized and fewest packages. It then passespackaging information (number,
sizesand weight) to the shipping provider, which returns the order’s shipping costs.

Define package information in the Workarea.

1. Navigate toSettings >Commerce >Shipping >Packages.

2. ClickNew>Package.

3. Enter aName, Length,Height,Width andMaximumWeight a package can
handle.

4. Click theSave button.

Repeat these stepsuntil you’ve added all the package sizes your companyuses.

More Information: Packages on page 17-87

Step 15a.

Create
Product Type
definitions for
each type of
product you
are selling.

Note: The
remaining
steps in this
example are
based on
selecting a
Product for
the Product
Type Class.

Product typesare applied to your catalog folders and allow you to control the way
product information is added to a catalog. This concept is similar to the waySmart Form
configurationsare applied to content folders to control the waycontent blocksare
created. You can applymultiple product types to a catalog.

Define product types in theWorkarea.

1. Navigate toSettings >Commerce >Catalog >Product Types.

2. ClickNew>Product Type.

3. Define the Product Type.

4. Click theSave button andmove to the next step.

More Information: Product Types on page 17-103

Step 15b.

Create the
content page.

After clicking the Save button from the previous step, a content editor appears and allows
you to enter XML Smart Form information. ThisSmart Form iswhat a user fills out when
creating a Catalog Entry (Product).

The information added bya user appears on a product’s details page on your Web site.

Here are some fields youmight want to create in your smart form.

n Title

n Description

n Image

Once you have the Smart Form complete, click theSave button.

More Information: Product Types on page 17-103,Working with Smart
Forms on page 7-278
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Step 16.

Create a
catalog and
assign it a
product type.

A catalog folder is a Ektron CMS400.NET folder designed to hold eCommerce entries
(products). This is similar to the waycontent folders hold HTML or Smart Form content.
Byassigning a product type to the folder, you can control the wayproducts are added to
the catalog.

Catalogsare created in theWorkarea.

1. Click theContent folder bar to display the list of content folders.

2. Click New > Catalog.

3. Set the catalog’s Properties, Metadata, Web Alerts and Breadcrumb
information. (Similar to creating a Content Folder.)

4. On the Product Types Tab, select a Product Type from the drop down
list.

5. Click the Add link.

6. Click theSave button.

More Information: Creating a Catalog Folder on page 17-121, Assigning
a Catalog Folder’s Product Type on page 17-122
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Step 17.

Add Catalog
Entries to a
Catalog.

Catalog Entries are the products you are offering on your eCommerce Web
site. For example, a catalog entry could be a CD, a subscription-based
service, or a computer that a site visitor can customize and the price
adjusts accordingly.

Create catalog entries in theWorkarea.

1. Navigate to a catalog folder.

2. ClickNewand select a product type.

3. In the Title field, enter a name for the catalog entry.

4. Fill out the fields in the Smart Form asnecessary.

5. Select the Summary tab and add a summary. (Optional)

6. Select the Properties tab and enter an SKU and the number of units that equal one
purchase. Next, select a TaxClass. If the product is a tangible product, click the
Expand link next to Dimensions, click the Tangible checkboxand enter the
product’s physical dimensions. If you are using Ektron CMS400.NET asyour
inventory system, click theExpand link next to Inventoryand enter the information.

7. Select the Pricing tab and enter the product’s list price and salesprice. If you are
offering a quantity discount, click the Add Pricing Tier button and add a quantity and
a tier price. If you enabledmultiple currencies, select a currency from the drop down
and add pricing information asneeded.

8. Select the Attributes tab and fill-out or change attributesasneeded.

Note: If you did not define attributes inStep 15a. on page 17-40, the Attributes tab
doesnot appear.

9. Select theMedia tab and click theAdd Images button to associate imageswith the
catalog entry.

10. The Items tab is used to create a complexproduct. This allowsyou to offer variants
of a product at different price points. For this example, we will skip this tab. See Also:
Creating a ComplexProduct on page 17-112.

11. Enter information asneeded on these tabs: Metadata, Taxonomyand Schedule.

12. ClickAction >Publish.

To add CrossSell or Up Sell itemsassociated with this catalog entry, click its Title and
then clickView>Cross Sell or Up Sell. These itemsappear in the Recommendation
server controlwhen it is associated with this catalog entry.

More Information: Creating a Catalog Entry on page 17-123
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Overview:

CreateWeb
site templates
site visitorswill
use to interact
with your
eCommerce
site.

Here is a list of templatesneeded to create a basic eCommerce site.

n Master page - recommended, but not absolutely necessary. This template could
contain anyof the following:

- CurrencySelect server control - allow site visitors to choose a
currency.

- View Cart link - links to the template containing the Cart server
control.

- View My Account / Orders link - links to the template containing
the MyAccount and OrderList server control.

- Login server control - allows site visitors and users to log in from
any page.

n Landing page - this page should have a way for site visitors to start the shopping
processand could contain a ProductList, ProductSearch server control.

n Product Display page - use the Product server control on a template to display the
details of a catalog entry (product). If you are using the CrossSell or Up Sell functionality,
add a recommendation server control to this template.

n Product Search page - use the ProductSearch server control on a template to allow
site visitors to search for product.

n Cart page - use the Cart server control on a template to allow a site visitor to work
with the items theyhave selected to purchase.

n Checkout page - use the Checkout server control on a template to facilitate the
checkout process.

n My Account / Order History page - use aMyAccount server control and an
OrderList server control to display a site visitor’s account information and a list their order
history.

The steps below are an example of creating a Web site using Ektron’s
eCommerce Server Controls.

Steps to Set Up a Basic eCommerceWeb Site

ReferenceManual
Version 8.01 Rev 4

17-43
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Step 18.

Create a
Master page.

Create amaster page and add the following items to a header area or left side column.

n CurrencySelect server control - allows site visitors to select from available
monetary types. This control displays currencies that have been enabled in the
Workarea duringStep 7. on page 17-36.AMy Cart link that leads to a template
containing the Cart server control.

n My Account / Order History link that leads to a template containing the
MyAccount andOrderList server controls.

n Product Search link - (optional) add a link that leads to a template containing a
ProductSearch server control.

n Product Search server control - (optional) allowsa user to search for a product
from anywhere on the site. Note: Adding this option is involvesmore than just dragging
and dropping a server control to the header or the left side column. It includes some
advanced customizationsand coding that allowsa search term to be passed from one
form to another. Ektron’sDeveloper Sample site showsan example of doing thiswith the
WebSearch server control.

n Login server control - (optional) this allowsexisting customers to login once they
arrive at your site. If you onlywant site visitors logging in through this control, set the
OnlyAllowMemberLogin property to True.

More Information:

CurrencySelect Server Controlon page 17-60

MyAccount Server Controlon page 17-206

OrderList Server Controlon page 17-196

ProductSearch Server Controlon page 17-163

Login Server Controlon page 2-10
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Step 19.

Create a
Landing
page.

This template should be the first page a site visitor sees when they arrive at
your site. It should have a mechanism that lets site visitors start shopping.
Make sure this page has one of the following:

n ProductList server control - use this control to display products byTaxonomy,
Catalog or ID.

- To display a single taxonomy, set the SourceType property to
Taxonomy and enter a single Taxonomy ID in the SourceId
property.

- To display multiple taxonomies, set the SourceType property to
TaxonomyList and enter a comma separated list of Taxonomy IDs
in the IdList property.

- To display a single catalog, set the SourceType property to
Catalog and enter a single catalog ID in the SourceId property. If
you want to display sub catalogs for a given ID, set the Recursive
Property to True.

- To display multiple catalogs, set the SourceType property to
CatalogList and enter a comma separated list of catalog IDs in the
IdList property.

- To display products by their ID, set the SourceType property to
IdList and enter a comma separated list of product IDs in the
IdList property.

- Set the TemplateProduct property to the template containing
the Product server control.

n ProductSearch server control - this control provides themeans for site visitors to
search your Web site for products. If this control is not on your landing page or part of
your master page, you should create a separate template containing this control.

- Set the CatalogId property to the ID of the catalog to search.

- Set the TemplateCart property to the template containing the
Cart server control.

- Set the TemplateProduct property to the template containing
the Product server control.

More Information:

Product List Server Controlon page 17-156

ProductSearch Server Controlon page 17-163
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Step 20.

Create a
Product page

This is the template where a site visitor views a product’s details. It contains
a Product server control and optionally a Recommendation server control.

n Product server control - this control displays a product’s
details.

- Make sure the DynamicParameter property is set to the
parameter name used to pass product IDs to the QueryString.

- If you want a default product to display when no ID is passed, set
the DefaultProductID property to the ID of a product.

- Set the TemplateCart property to the template containing the
Cart server control.

n Recommendation server control- this control displays Cross
Sell and Up Sell opportunities associated with a product.
These are set in Workarea, under the View menu’s Cross Sell
and Up Sell selections for a catalog entry

- Set the RecommendationType property to CrossSell or UpSell.

- Make sure the DynamicProductParameter property is set to
the parameter name used to pass product IDs to the QueryString.

- If you want a product’s default Cross Sell or Up Sell items to
display when no ID is passed, set the DefaultProductID
property to the ID of a product.

- Set the TemplateCart property to the template containing the
Cart server control.

- Set the TemplateProduct property to the template containing
the Product server control.

More Information:

Product Server Controlon page 17-146

Recommendation Server Controlon page 17-183

Step 21.

Create a
Product Search
page.

This page allows site visitors to search for products on your Web site.

n ProductSearch server control - this control provides themeans for site visitors to
search your Web site for products. If this control is not on your landing page or part of
your master page, you should create a separate template containing this control.

- Set the CatalogId property to the ID of the catalog to search.

- Set the TemplateCart property to the template containing the
Cart server control.

- Set the TemplateProduct property to the template containing
the Product server control.

More Information:

ProductSearch Server Controlon page 17-163
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Step 22.

Create a Cart
page.

This template contains a Cart server control.

n Cart server control - this control allowsa site visitor to workwith products theyhave
selected to purchase. Asa site visitor navigatesaround your site selecting products to
purchase, theyare added to a cart.

- Set the TemplateCheckout property to the template containing
the Checkout server control.

- Set the TemplateProduct property to the template containing
the Product server control.

- Set the TemplateShopping property to the Landing page
template or a template containing a ProductList or ProductSearch
server control.

- If you are using coupons, make sure the EnableCoupons
property is set to True.

More Information:

Cart Server Controlon page 17-8

Step 23.

Create a
Checkout
page

This template contains a Checkout server control.

n Checkout server control - this control allowsa site visitor to navigate through the
checkout process.

- Set the DefaultCountryID property to the country you want to
be the default selection in the Billing and Shipping address
sections.

- Set the TemplateCart property to the template containing the
Cart server control.

- Set the TemplateOrderHistory property to the template
containing the OrderList server control.

- Set the TemplateShopping property to the landing page
template or a template containing a ProductList or ProductSearch
server control.

- If you are using SSL Encryption, set the IsSSLRequired
property to True.

Warning! Because Credit Card information is entered into the Checkout server
control, Ektron strongly recommendsusing SSL Encryption for this page.

More Information:

Checkout Server Control on page 17-20
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Step 24.

Create a My
Account
page.

This template contains a MyAccount and an OrderList server control.

n MyAccount server control - this server control allows site visitors to view billing,
shipping and alternative shipping information associated with their account.

- Set the DefaultCountryID property to the country you want to
be the default selection in the Billing and Shipping address
sections.

- (Optional) Set the CustomPropertyID property to the ID or list of
comma separated IDs that represent custom properties associated
with users. Custom Properties are set up in Ektron CMS400.NET’s
Workarea > Settings > Configuration > Custom Properties.

n OrderList server control - this server control allows site visitors to view a list of their
processed orders.

- Make sure the DynamicOrderParameter is set to the parameter
name used to pass order IDs to the QueryString.

- Make sure the DynamicProductParameter is set to the
parameter name used to pass product IDs to the QueryString.

More Information:

MyAccount Server Controlon page 17-206

OrderList Server Controlon page 17-196
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eCommerce Configuration
Screens
This section also contains the following topics.

Countries 17-49
Regions 17-52
Currencies 17-54
CurrencySelect Server Control 17-60
Payment Options 17-61
Credit Card Types 17-77
eCommerce Messages 17-81

Countries
Use the Countries screen to modify existing country information or add new
countries to eCommerce.

This section also contains the following topics.

How Countries are Used 17-49
Default Countries 17-49
Creating a Country 17-50
Editing a Country 17-51
Deleting a Country 17-51

How Countries are Used
n to define country tax tables. For example, assume Canada has a

national tax of 5% that applies to the sale of certain goods. National
tax tables are defined in the Country Tax Tables screen.

n to determine shipping costs. In the Order checkout process, the
purchaser selects a shipping address, which includes country. So, be
sure to enable all countries from which site visitors can enter orders.

Countries are also part of the location on the Warehouse screen. An
order’s shipping cost is determined by the distance between the
warehouse and the destination.

Default Countries
By default, Ektron CMS400.NET provides information for all countries on the
ISO list of English country names and code elements
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(http://www.iso.org/iso/country_codes/iso_3166_code_lists/english_country_names_and_
code_elements.htm).

The following is provided for each country.

n name

n numeric ISO code

n long alphabetical ISO code

n short alphabetical ISO code

The countries screen lets you enter new countries, as well as edit information
for any provided countries.

Creating a Country
Prerequisite: The new country’s ISO codes

To add a new country, follow these steps. See Also: Countries on previous page

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Countries.

2. Click New > Country.

3. Use the following table to complete the screen.

Field Description

Name Enter the country’s name.

Numeric
ISO

Enter the country’s ISO3166-1 three digit numeric ISOcode. See Also:
http://en.wikipedia.org/wiki/ISO_3166-1_numeric
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Field Description

Enabled

Check this box if you want this country to be active. Only active countries can be
selected on the Edit Billing Information screen, which appears during the
Checkout procedure.

Long ISO Enter the country’s ISO3166-1 alpha-3, three letter country code. See Also:
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-3

Short ISO Enter the country’s ISO3166-1 alpha-2, two letter country code. See Also:
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2

Editing a Country
Follow these steps to edit a country. See Also: Countries on page 17-49

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Countries.

2. Click the name of the country that you want to edit.

3. Click the Edit button ( ).
4. Edit any of the fields, which are described in Use the following table

to complete the screen. on previous page

Deleting a Country
Follow these steps to delete a country. See Also: Countries on page 17-49

Editing a Country

ReferenceManual
Version 8.01 Rev 4

17-51

http://en.wikipedia.org/wiki/ISO_3166-1_alpha-3
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-3
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-3
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-3
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-3
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2
http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2


1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Countries.

2. Click the name of the country that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The country is deleted.

Regions
The Regions screen lets you define geographic regions within countries that
your eCommerce site services. For example, in the United States of America,
each state is a region.

Regions are used in the same way that countries are used. See Also: How
Countries are Used on page 17-49

This section also contains the following topics.

Default Regions 17-53
Creating a Region 17-53
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Editing a Region 17-54
Deleting a Region 17-54

Default Regions
By default, the Regions screen includes all 50 United States of America, the
District of Columbia, and 9 Canadian Provinces.

Creating a Region
Prerequisite: The region’s country is defined in the Countries screen

To add a new region, follow these steps. See Also: Regions on previous page

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Regions.

2. Click New > Region.

3. Use the following table to complete the screen.

Field Description

Name Enter the region’s name.

Enabled

Check this box if you want this region to be active. Only active regions can be selected on the
Edit Billing Information screen, which appearswhen site visitors enter billing information
during the Checkout procedure.

Code Enter an abbreviation for this region.

Country Select this region’s country from the pull down list. If the country is not there, exit this screen,
and create the country using the Countries screen.

Default Regions
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Field Description

Add another
region to this
country?

This field saves the effort of selecting a countrywhen entering several regions for one
country.

To addmore regions for this country, check this boxand press the Save button ( ). When
you do, the screen refreshes, and themost recently selected country appears as the
default.

Editing a Region
Follow these steps to edit a region. See Also: Regions on page 17-52

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Regions.

2. Click the name of the region that you want to edit.

3. Click the Edit button ( ).
4. Edit any of the fields, which are described in Use the following table

to complete the screen. on previous page

Deleting a Region
Follow these steps to delete a region. See Also: Regions on page 17-52

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Regions.

2. Click the name of the region that you want to delete.

3. Click the Delete button ( ).
4. A confirmation message appears.

5. Click OK.

Currencies
eCommerce supports all currencies. However, site visitors can only choose
enabled currencies. The Currency screen lets you enable and edit information
for all installed currencies.
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This section also contains the following topics.

Installed Currencies 17-55
Enabling Currencies 17-55
The Default Currency 17-56
Viewing and Changing the Default Currency 17-57

How Currencies Are Used in the Currency Select Server Control
17-
57

How Exchange Rate Affects an Item’s Price 17-58
Updating the Exchange Rate 17-58
Using the Ektron CMS400.NET API 17-58
Using the Update Exchange Rates Screen 17-58
Editing a Currency 17-59
Deleting a Currency 17-59

Installed Currencies
By default, Ektron CMS400.NET provides all currencies on the ISO 4217
currency names and code elements list
(http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_
used_standards_other/currency_codes/currency_codes_list-1.htm).

The following information is provided for each installed currency.

n name

n enabled (yes or no)

n numeric ISO code

n alpha ISO code

n exchange rate

Enabling Currencies
When users are setting prices in the Ektron CMS400.NET Workarea or site
visitors are shopping, they can only choose enabled currencies. When you
install Ektron CMS400.NET, the following currencies are enabled.
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ReferenceManual
Version 8.01 Rev 4

17-55

http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_used_standards_other/currency_codes/currency_codes_list-1.htm
http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_used_standards_other/currency_codes/currency_codes_list-1.htm
http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_used_standards_other/currency_codes/currency_codes_list-1.htm
http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_used_standards_other/currency_codes/currency_codes_list-1.htm
http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_used_standards_other/currency_codes/currency_codes_list-1.htm
http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_used_standards_other/currency_codes/currency_codes_list-1.htm
http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_used_standards_other/currency_codes/currency_codes_list-1.htm
http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_used_standards_other/currency_codes/currency_codes_list-1.htm
http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_used_standards_other/currency_codes/currency_codes_list-1.htm
http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_used_standards_other/currency_codes/currency_codes_list-1.htm
http://www.iso.org/iso/support/faqs/faqs_widely_used_standards/widely_used_standards_other/currency_codes/currency_codes_list-1.htm


n U.S. dollar (the default currency. See Also: The Default Currency
below)

n Euro

n Australian dollar

Note: To see which currencies (other than the default) are enabled, click Action > Edit
Exchange Rates from the Currencies screen. Only non-default, enabled currencies appear.

Warning! The Euro and Australian dollar are shipped with a default exchange rate. If you will
support these currencies, you should update the rate to its current value before going live. See
Also: Updating the Exchange Rate on page 17-58

To enable any installed currency, follow these steps.

1. Click Ektron CMS400.NET Workarea > Settings > Commerce>
Configuration > Currencies.

2. Click the currency you want to enable.

Note: You can use the Search box to quickly find a currency.

3. The Edit Currency screen appears.

4. Check the Enabled check box.

5. Click Save ( ).

The Default Currency
The default currency is the reference currency when setting the exchange rate
on the Edit Currency screen. For example, if the default is US dollars, USD
appears on the left of the exchange rate equation, as shown below.
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The default currency is also used as the default choice in the Currency Selector
server control, and on the Pricing tab of the View/Edit Catalog Entry screen
(shown below).

See Also: CurrencySelect Server Control on page 17-60

Viewing and Changing the Default Currency
When you install Ektron CMS400.NET, the default currency is the Numeric ISO
code for U.S. dollars (Id 840). At that time, you can change this in the
web.config file’s ek_ecom_DefaultCurrencyId tag. You must enable the new
default currency in the Ektron CMS400.NETWorkarea before changing it in the
web.config file. See Also: Enabling Currencies on page 17-55

However, once you begin to deploy eCommerce, do not change the default
currency.

Warning! After your eCommerce feature goes live, do not change the ek_ecom_
DefaultCurrencyId value in web.config.

How Currencies Are Used in the Currency
Select Server Control
If your developer places a Currency Select server control on a page, a site
visitor can use it to select any enabled currency.

After a currency is selected, the prices on the page change to that currency.
See Also: How Exchange Rate Affects an Item’s Price on next page
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From that point on, the cart and order use the selected currency. See Also:
CurrencySelect Server Control on page 17-60

How Exchange Rate Affects an Item’s Price
The Edit Currency screen lets you define an exchange rate between the default
and any other currency. See Also: The Default Currency on page 17-56;
Updating the Exchange Rate below

The exchange rate can dynamically adjust prices when the rate changes. See
Also: Alternate Currency Pricing on page 17-135

Updating the Exchange Rate

Using the Ektron CMS400.NET API
The following Ektron API supports calling an exchange rate service to update
rates automatically: Ektron.Cms.Commerce.ExchangeRateApi. For more
information, see the Ektron CMS400.Net API documentation.

Using the Update Exchange Rates Screen
The Edit Exchange Rates screen lets you update the exchange rate for enabled
currencies. See Also: How Exchange Rate Affects an Item’s Price
above;Currencies on page 17-54

Note: A good Web site for finding exchange rates is http://www.xe.com/ucc/.

To use the screen, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings > Commerce
> Configuration > Currencies.

2. Click Action > Edit Exchange Rates.

3. The Edit Exchange Rates screen appears, showing all enabled
currencies and their exchange rates.
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4. Update rates as needed.

5. Click Action > Update.

Editing a Currency
Follow these steps to edit a currency. See Also: Currencies on page 17-54

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Currencies.

2. Click the currency you want to edit.

3. You can only edit the Name, Enabled, and Exchange Rate fields.
All fields are described below.

Field Description

Name Enter the currency’s name.

Numeric ISO
Code

The currency’s ISO4217 three-digit numeric ISOcode appears. See Also: Installed
Currencieson page 17-55

Alpha ISOCode The country’s ISO4217 alphabetic, three-letter currency code appears. See Also:
Installed Currencieson page 17-55

Enabled Check this box to enable this currency. See Also:Enabling Currencies on page 17-55

Exchange Rate
Enter the exchange rate between this currencyand the default one. See Also:How
Exchange Rate Affects an Item’sPrice on previouspage; TheDefault Currencyon
page 17-56

4. Click the Save button ( ).

Deleting a Currency
Follow these steps to delete a currency. See Also: Currencies on page 17-54

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Currencies.

2. Check the box next to the currency that you want to delete.

3. Click Action > Delete Selected.

4. A confirmation message appears. Click OK.
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5. The currency is deleted.

CurrencySelect Server Control
Warning! In addition to reading this section on the CurrencySelect server controls,
Ektron strongly recommends readingCurrencies on page 17-54.

The Currency server control allows site visitors to select the monetary type
they will use to make purchases. Once the site visitor selects his currency, all
eCommerce server controls use it for that order. If a site visitor closes the
browser, the currency will need to be selected the next time he visits the site.

For a currency to appear in the CurrencySelect server control, it must be
enabled in the Ektron CMS400.NET Workarea > Settings > Commerce >
Currencies screen. To enable a currency, click its name in the list and place a

check in the enable checkbox. Next, click the Save button ( ).

CurrencySelect Server Control Properties
The following table explains the properties of the CurrencySelect control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Working with Ektron
CMS400.NET Server Controlson page 24-1

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
theCacheInterval property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Double
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Property Description
Data
Type

CustomXml

(Code BehindOnly)

Providesamechanism to inject customXML into the generated XML
before being processed by the XSLT. The injected XML is appended to
the end of the XML produced by this control.

See Also:Displaying CustomXML in Ektron’sServer Controlson page
24-38

String

DisplayXslt

Specify an externalXSLT file to render the control. Bydefault, the
control usesCurrencySelect.xsl. This file is located in
<Site Root>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly recommended that
youmake a copy, change its name andmove it outside your site’s
Workarea folder. If youmake changes to this file and do not move it out
of theWorkarea folder, this file and the changeswill be lost when you
upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language
Set a language for viewing the currency selection tool. This property
shows results in design-time (in VisualStudio) and at run-time (in a
browser).

Integer

Stylesheet
Specify the path to a style sheet for use with this server control. The
location can be relative or absolute. Leave blank to use the default style
sheet.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

Payment Options
The Payment Options screen lets you determine which options are available for
your customers to pay for their purchases.

PayPal - See Also: PayPal Support on next page

a Payment Gateway, such as AuthorizeNet - See Also: Payment Gate-
way on page 17-70
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Both options can be enabled, but only one gateway can be enabled at a time.

PayPal Support
“PayPal is an eCommerce business allowing payments and money transfers to
be made through the Internet. PayPal serves as an electronic alternative to
traditional paper methods such as checks and money orders.

A PayPal account can be funded with an electronic debit from a bank account or
by a credit card. The recipient of a PayPal transfer can either request a check
from PayPal, establish their own PayPal deposit account or request a transfer to
their bank account. PayPal is an example of a payment intermediary service
that facilitates worldwide e-commerce.” source: wikipedia

See Also:

Using PayPal with Ektron CMS400.NET’s eCommerce below

PayPal Documentation on page 17-64

Enabling PayPal Support on page 17-64

Customizing the PayPal Page on page 17-69

Using PayPal with Ektron CMS400.NET’s
eCommerce
Your customers can use PayPal to pay for purchases from either of two points in
the checkout process

the shopping cart screen

the payment screen

If a site visitor accesses PayPal via the shopping cart screen, he follows these
steps.
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Here is the sequence illustrated above.

1. From the Cart screen, a site visitor clicks the PayPal button.

2. He logs into his PayPal account.

3. Information from that account is used to populate the default
shipping and billing addresses.

4. The site visitor can change addresses if needed.

Note: If the PayPal account address is used for the order, it is saved as part of the site visitor’s
Ektron CMS400.NET eCommerce account information.

5. Shipping costs are added.

6. The order is confirmed.

7. Site visitor checks out via PayPal.

Alternatively, the site visitor can use the standard eCommerce checkout
process, select PayPal on the payment screen, and complete his order using the
PayPal payment screen. That sequence is illustrated below.

Using PayPal with Ektron CMS400.NET’s
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PayPal Documentation
Use the following resources to familiarize yourself with integrating PayPal into
your eCommerce site.

PayPal Technical Documentation - https://cms.paypal.com/us/cgi-
bin/?cmd=_render-content&content_ID=developer/library_doc-
umentation

PayPal Express Checkout Integration Guide - https://cms-
.paypal.com/cms_content/ennuis/files/developer/PP_Express-
Checkout_IntegrationGuide.pdf

Payflow ACH Payment Service Guide - https://cms.paypal.com/cms_
content/US/en_US/files/developer/PP_ACHPayment_Guide.pdf

Warning! An important PayPal requirement is to place the Pay with PayPal option on both the
shopping cart and payment screens.

Enabling PayPal Support
To enable PayPal support in Ektron CMS400.NET, follow these steps.

Create a Sandbox Account on the facing page. This step includes updat-
ing Ektron CMS400.NET’s web.config file.

Enable PayPal in the Ektron CMS400.NET Workarea on page 17-68
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Create a Sandbox Account
1. Sign on to http://www.sandbox.paypal.com.

2. Sign up for an account.

3. After a short while, you receive an email confirmation that directs
you to another page.

4. Log in using the information you provided in Step 2.

5. Under Test Accounts, click Create a preconfigured buyer or
seller account.

6. Create a buyer account. You will use this to test the customer
experience.

Note: It's a good idea to change the password to one you can easily remember.

7. Click Home > Test Accounts > Create a preconfigured buyer
or seller account.

8. This time, click Account Type Seller.
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9. Create a seller account. You will use this to test the merchant
experience.

Note: It's a good idea to change the password to one you can easily remember.

10. In the upper left corner of the screen, click API Credentials.

11. Open your siteroot/web.config file.

12. Copy the following values from the API Credentials screen into the
web config’s providers/paypal element. Save web.config.

PayPal Test Account Value web.config PayPal Element

API Username PayPalUser

API Password PayPalPwd

Signature PayPalSignature

The following illustration shows the PayPal API Username copied into the
web.config file’s PayPalUser property.
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If you want to encrypt these values, see Encrypting PayPal Authentication
Values below.

Encrypting PayPal Authentication Values
Follow these steps to encrypt the following values in the web.config file’s
providers/paypal element.

PayPalUser

PayPalPwd (password)

PayPalSignature

1. Open the site root/web.config file.

2. Set the AuthValuesEncrypted element to true.

3. Save and close web.config.

4. Open C:\Program Files\Ektron\CMS400v8x\Utilities.

5. Run EncryptEmailPassword.exe.

6. The Encrypt Utility dialog appears.

Encrypting PayPal Authentication Values
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7. Enter the PayPal user name into the Text field.

8. Click the Encrypt button.

9. The screen displays encrypted text in the Encrypted field.

10. Copy the encrypted text and paste it into the web.config file’s
PayPalUser element value.

11. Repeat Steps 7 through 10 for PayPalPwd and PayPalSignature.

Test the Sandbox Account
After creating a sandbox account, you should test it.

1. Sign into the Developer Sample site > eCommerce > Cart.

2. Click the PayPal button.

3. Enter the buyer account user name and password that you created in
Create a Sandbox Account on page 17-65.

4. You proceed to the Ektron CMS400.NET Checkout screen.

After completing these steps, you have verified your PayPal buyer experience.

Enable PayPal in the Ektron CMS400.NET Workarea
To enable PayPal in the Ektron CMS400.NET Workarea, follow these steps.

1. Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Payment Options.

2. Click Action > Edit Payment options.
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3. Check PayPal.

4. Click the Save button ( ).

Customizing the PayPal Page
If you are using Ektron CMS400.NET’s sample site and PayPal is enabled, the
login screen contains an Ektron logo for demonstration purposes.

You can replace the logo using the following property of the web config’s
providers/add name=”PayPal” element.

To change the logo, change the referenced image.

To learn how to customize other aspects of the page, see PayPal’s “Express
Checkout Integration Guide” section “PayPal Page Style.”
(https://cms.paypal.com/cms_content/en_US/files/developer/PP_
ExpressCheckout_IntegrationGuide.pdf)

When setting values in the web.config’s providers/add name=” PayPal”
element, prefix any variable with apiparam. For example, to set the header
background color, enter apiparamHDRBACKCOLOR=”FFF666”.
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Payment Gateway
A payment gateway is a “service that automates the payment transaction
between a shopper and merchant. It is usually a third-party service that
processes, verifies, and accepts or declines credit card transactions or checks
on behalf of the merchant through secure Internet connections.” (source:
webopedia)

Ektron CMS400.NET provides two standard payment gateways authorize.net
and Payflow, along with manual. The manual gateway accepts all credit cards.
In this case, the merchant emails the credit card information to the credit card
company.

Note: For details on implementing a custom payment gateway provider, see Customizing the
Payment Gateway Provider on page 17-264

Within Ektron CMS400.NET, a gateway can support credit cards, checks, or
both, depending on how you implement it.

Ektron CMS400.NET lets you edit information on any provided gateway as well
as create a new one.

See Also:

How a Payment Gateway Works below

The Default Gateway on page 17-72

Adding a Payment Gateway on page 17-73

Editing a Payment Gateway on page 17-73

Deleting a Payment Gateway on page 17-74

Check Support on page 17-74

Credit Card Types on page 17-77

PayPal Support on page 17-62

How a Payment Gateway Works

Processing Credit Card Transactions
The following sequence explains how credit card transactions are typically
processed. (source: www.authorize.net)

1. The payment gateway provider (PGP) receives secure transaction
information and passes it via secure connection to the Merchant
Bank’s Processor.

2. The Merchant Bank’s Processor submits the transaction to the Credit
Card Interchange (a network of financial entities that manage credit
card transactions).
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3. The Credit Card Interchange sends the transaction to the customer’s
Credit Card Issuer.

4. The Credit Card Issuer approves or declines the transaction, based on
the customer’s available funds. It then passes the transaction results
and, if approved, the appropriate funds back through the Credit Card
Interchange.

5. The Credit Card Interchange relays the transaction results to the Mer-
chant Bank’s Processor.

6. The Merchant Bank’s Processor relays the transaction results to PGP.

7. The PGP stores transaction results and sends them to the customer
and/or the merchant. This communication process averages three sec-
onds or less.

8. The Credit Card Interchange passes the transaction’s funds from the
Credit Card Issuer to the merchant’s bank account.

Processing Check Transactions
The following sequence explains how a payment gateway processes checks.
(source: www.authorize.net)

1. Customer authorizes merchant to charge his bank account for an
amount.

2. Order and payment information is securely transmitted via the Inter-
net to the payment gateway.

3. The transaction is accepted or rejected based on initial data validation
and security criteria defined by the payment gateway.

4. If accepted, the transaction is sent to the ACH Network for set-
tlement.

5. The ACH Network uses the transaction’s bank account information to
determine the bank that holds the customer’s account (the RDFI).

6. The ACH Network instructs the RDFI to charge or refund the cus-
tomer’s account.

7. The RDFI transfers funds from the customer’s account to the ACH Net-
work. The RDFI also notifies the ACH Network of any returns (if funds
could not be collected from the customer’s bank account) or charge
backs (if a customer disputes a purchase).

8. The ACH Network transfers funds for the transaction to the payment
gateway’s bank.

9. After a holding period, the payment gateway provider initiates a ACH
transaction that deposits the funds into the merchant’s bank account.
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Establishing a Relationship with a Payment
Gateway Provider
You need to set up an account with a third-party payment service before using a
payment provider. This includes payment providers such as Authorize.NET and
PayFlow, which are included with CMS400.NET’s eCommerce Module.

To do this with Authorize.Net, go to
http://www.authorize.net/solutions/merchantsolutions/onlinemerchantaccount/
.

To set up an account with PayFlow, go to https://www.paypal.com/cgi-
bin/webscr?cmd=_payflow-gateway-overview-outside.

Each payment gateway provider accepts configuration parameters. For
example, Authorize.NET requires a username and password, while PayFlow
requires a Username, password, vendor, and partner.

In addition, some payment gateways do not support subscription payments.
This is something to consider if your site relies on subscriptions. See Also:
Creating a Subscription on page 17-114

The Default Gateway
The eCommerce checkout process only uses the default gateway. Additional
gateways are unused unless one is changed to be the default.

You cannot delete the default gateway. If you want to delete it, you must first
make another gateway the default.

To change the default gateway, follow these steps.

1. Go to Settings > Commerce > Configuration > Payment
Options.

2. The currently-defined default has a check in the Default column.

3. Click the radio button to the left of the gateway you want to make the
default.

4. Click Action > Mark as Default.

5. A confirmation message appears. Click OK.
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Adding a Payment Gateway
Note: To learn how to create a new payment gateway provider, see Customizing the Payment
Gateway Provider on page 17-264.

To add a new payment gateway to Ektron CMS400.NET, follow these steps. See
Also: Payment Options on page 17-61

1. In Ektron CMS400.NET, go to Settings > Commerce >
Configuration > Payment Options.

2. Click New > Payment Gateway.

3. Use the following table to complete the screen.

Field Description

Name Enter the name of the gateway.

Default Check this box if this is the default gateway. If you do, and another gateway is currently the
default, it is replaced by this one. See Also: TheDefault Gatewayon previouspage

User ID Enter your User ID. This ID will identify your account with this gatewayprovider.

Password Enter the password for your account with this gatewayprovider.

Expand
Custom
Values

If this gatewayprovider needsadditional fields of information, enter those values into the
Custom 1 andCustom 2 fields.

Credit
Cards Check if this payment gatewayaccepts credit cards.

Checks Check if this payment gatewayaccepts checks.

Editing a Payment Gateway
Follow these steps to edit a payment gateway. See Also: Payment Options on
page 17-61

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Payment Options.

2. Click the payment gateway that you want to edit.

3. Click the Edit button ( ).
4. Edit any of the fields, which are described in Use the following table to

complete the screen. above.

5. Click the Save button ( ).
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Deleting a Payment Gateway
Follow these steps to delete a payment gateway.

Note: You cannot delete the default gateway. If you want to delete it, you must first make
another gateway the default.

See Also: Payment Options on page 17-61

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Payment Options.

2. Click the payment gateway that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The payment gateway is deleted.

PayFlow credential Ektron CMS400.NET field Example

API signature user API Username

password API Password 1234567891

customfield1 Signature

Check Support
Payment gateways generally offer two payment mechanisms: credit cards and
checks. You can enable or disable check support for a gateway via the Settings
> Commerce > Configuration > Payment options > Edit Payment
Gateway screen (shown below).
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When checks are enabled for the default payment gateway, a site visitor can
choose to pay by Check on the payment screen. If check support is not
enabled, the Payment Method field does not appear.

Check Support Integration Documentation
Use the following resources to familiarize yourself with integrating checks into
your eCommerce site.

Authorize.Net: http://ww-
w.authorize.net/files/echecknetuserguide.pdf

PayFlow: https://cms.paypal.com/cms_content/US/en_US/files/de-
veloper/PP_PayflowLink_Guide.pdf ; see the chapter “Integrating Tel-
eCheck Transactions.”

Effect of Check Payment on Order Processing
The following describes a typical sequence of events when processing a check
for eCommerce payment.

However, Ektron CMS400.NET is very flexible and does not enforce this
sequence. For example, you can enter a tracking number and mark an order
shipped even though its payment has not been captured yet.

1. eCommerce user accesses the View Payment screen’s Capture
option, which submits a payment request to the customer’s bank.
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2. A few days later, the funds are transferred to the merchant’s account.

3. The eCommerce user accesses the View Payment screen’s Mark as
Settled option to confirm that the funds have been received.

4. If the goods are tangible

- The eCommerce user ships the merchandise, using the View Payment
screen’s Enter Tracking Number option to insert the tracking number
and confirm the shipment.

If the goods are not tangible

- The workflow sends the customer an email with details about the
purchase, such as how to download it.

Conducting eCommerce with Ektron CMS400.NET

17-76 ReferenceManual
Version 8.01 Rev 4



Credit Card Types
Use this screen to enter all types of credit cards that your eCommerce system
may use. By default, Ektron CMS400.NET’s developer sample site provides the
following card types.

n American Express

n Diners Club (not accepted by default)

n Discover

n MasterCard

n Visa

You can edit the information provided for these types or enter a new one.

This section also contains the following topics.

Where Credit Card Types are Used 17-77
Creating a Credit Card Type 17-78
Editing a Credit Card Type 17-80
Deleting a Credit Card Type 17-80

Where Credit Card Types are Used
During the checkout process (managed by the Checkout server control), screen
5 (Submit Order) has a dropdown list of all enabled credit cards. See below.
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Creating a Credit Card Type
To create a new credit card within Ektron CMS400.NET, follow these steps.

1. In Ektron CMS400.NET, go to Settings > Commerce >
Configuration > Credit Card.

2. Click New > Credit Card to see the Add Card Type screen.

3. Use the following table to complete the screen.

Field Description

Name Enter the credit card’s name.
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Field Description

Accepted

Check this box if site visitors can use this card tomake purchaseson your Web site. Only
Accepted cardsappears in the Checkout procedure >Submit Order screen’sCredit Card Type
dropdown, as shown below.

Image

Use this field to specify an image for the credit card.

The image doesnot appear on the standard checkout screen. But it is a field in the XML, so you
can enable it using an XSLT.

Adding or Changing the Image

If you are entering a new credit card image or editing an existing one, follow these steps.

Prerequisite: The image resideson your computer.

1. ClickChange.

2. The LibraryUpload screen appears.

3. Click the Add button ( ).

4. ClickBrowse and navigate to the folder that contains the image.

5. Choose the image.

6. Assign a Title.

7. Click the Add Library button ( ).

8. The image appears on the screen.
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Field Description

Regex

ARegexexpression is a simple way to validate a credit card account number. (See Also:
http://regexlib.com/.) Validation occurswhen a site visitor completes the Checkout procedure’s
Submit Order screen, as shown below.

Regexprevents the submission of invalid account numbers to a payment gateway, whichmay
charge a fee for such failures.

Ektron CMS400.NET providesasRegexexpression for the credit cards supplied with medical
sample site. You canmodify them asneeded. If you enter a new credit card, you can enter a
Regexexpression for it.

Editing a Credit Card Type
Follow these steps to edit a Credit Card Type. See Also: Credit Card Types on
page 17-77

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Credit Card.

2. Click the Credit Card Type that you want to edit.

3. Click the Edit button ( ).
4. Edit any of the fields, which are described in Use the following table

to complete the screen. on page 17-78.

5. Click the Save button ( ).

Deleting a Credit Card Type
Follow these steps to delete a Credit Card Type. See Also: Credit Card Types on
page 17-77

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Configuration > Credit Card.

2. Click the Credit Card Type that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The Credit Card Type is deleted.
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eCommerce Messages
Ektron’s eCommerce feature provides a messaging feature that can notify a
purchaser when these events occur:

n Order is submitted

n Order is cancelled

n Order is shipped

Each message has a unique type that corresponds to an event. The message
types are

n OrderReceived

n OrderCancelled

n Order Shipped

You can create any number of messages for each event, assigning one as the
default. Only the default message is sent when the corresponding event occurs.

Here is a sample message as set up within Ektron CMS400.NET.

Here is the same message as delivered to a recipient’s inbox.

eCommerceMessages
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This section also contains the following topics.

How Messages are Created and Generated 17-82
Creating or Editing an eCommerce Message 17-83
Message Variables 17-83

How Messages are Created and Generated
Ektron CMS400.NET provides sample text for each type of message. To view
and edit a message, go to Ektron CMS400.NET Workarea > Settings >
Commerce > Configuration > Messages.

The Message Type determines the event that causes a message to be sent. For
example, the Orderreceivedmessage is sent to a purchaser when he submits an
order.

If regular content notification emails are being generated, the site visitor
provided a valid email address, and a message has been defined for the event,
emails are sent as eCommerce events occur. No additional set up is required.
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Note: eCommerce messages are distributed in the same way that content notification emails
are. For information on setting this up, see Configuring email for Tasks and Content on page
1-83.

Creating or Editing an eCommerce Message
1. Go toWorkarea > Settings > Commerce > Configuration >

Messages.

2. If a message of the type you want to create already exists, select it.
Otherwise, click the Add Message button ( ).

3. Assign a Title, Subject (for the email subject line), Message Type,
and message text.

Message Variables
eCommerce message text can use the following variables to retrieve order
information from the database into the message text.

Variable Description

@CustomerFirstName@ Customer’s first name

@CustomerLastName@ Customer’s last name

@OrderId@ The order’s ID number

@OrderSubTotal@ The order’s subtotal, that is the amount of all ordered itemsprior to shipping
costs, taxes, and coupon discounts

@OrderTotal@ The order’s final cost (which includes taxes, shipping, and coupon discounts)

@OrderShippingTotal@ The order’s shipping cost

@OrderCouponTotal@ The order’s coupon discounts

@OrderTaxTotal@ The order’s tax amount

@OrderItemTitle@ The title of any item on the order

@OrderItemSalePrice@ The sale price of any item on the order

@OrderItemQuantity@ The quantity of any item on the order

@OrderItemTotal@ The total cost of one item. For example, if orderItemSalePrice=$10 and
orderItemQuantity=2, orderItemTotal=$20.
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Variable Description

@OrderItemStart@ and
@OrderItemEnd@

Use the start and endmarkers to show information for all ordered items.

Themarkers show no information by themselves. Instead, they repeat the
variablesbetween them for every item on the order.

So, for example, assume an order has10 items, and your message looks like
this:

@OrderItemStart@
@OrderItemTitle@
@OrderItemQuantity@
@OrderItemSalePrice@
@OrderItemTotal@
@OrderItemEnd@

Themessage prints the title, quantity, sale price, and total for each item on the
order.

@TrackingUrl@ The link to aWeb page that tracks your package. It is usually a combination of
the shipper’sURL and the tracking number.

Conducting eCommerce with Ektron CMS400.NET

17-84 ReferenceManual
Version 8.01 Rev 4



eCommerce Shipping
Screens
This section also contains the following topics.

Warehouse 17-85
Packages 17-87
Shipping Methods 17-89

Warehouse
Use the Warehouses screen to enter information about warehouses that stock
your catalog entries. eCommerce uses this location to determine the “from”
address when calculating shipping costs.

Only the default warehouse is used by the checkout process. Additional
warehouses are unused until they are made the default. See Also: Changing the
Default Warehouse on next page

Prerequisite: Regions and countries must be set up. See Also: Regions on
page 17-52

This section also contains the following topics.

Creating a Warehouse 17-85
Changing the Default Warehouse 17-86
Editing a Warehouse 17-87
Deleting a Warehouse 17-87

Creating a Warehouse
To create a new warehouse within Ektron CMS400.NET, follow these steps. See
Also:Warehouse above

1. In Ektron CMS400.NET, go to Settings > Commerce > Shipping >
Warehouses.

2. Click New > Warehouse.

3. Use the following table to complete the screen.
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Field Description

Name Enter the warehouse’s name.

Street1, Street2 Enter the warehouse’s street address.

City Enter the warehouse’s city.

PostalCode Enter the warehouse’s postal code.

Country Select the warehouse’s country from the pull-down list.

State/Province Select the warehouse’s state or province from the pull-down list.

Default
Warehouse

This box indicates if this is the default warehouse. If you want to make
thiswarehouse the default, use theMarkasDefault toolbar button (

Only the default warehouse is used by the checkout process. Additional
warehousesare unused until theyaremade the default.

4. Click the Save button ( ).

Changing the Default Warehouse
To change the default warehouse, follow these steps.

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Shipping > Warehouses.

2. Click the radio button next to the warehouse that you want to make
the default.

3. Click Action > Mark Default Warehouse.

Note: You can also specify a warehouse as the default via the Edit Warehouse screen’s Mark

Default Warehouse toolbar button .

4. A confirmation dialog appears. Click OK.
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Editing a Warehouse
Follow these steps to edit a warehouse. See Also:Warehouse on page 17-85

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Shipping > Warehouses.

2. Click the warehouse that you want to edit.

3. Click the Edit button ( ).
4. Edit any of the fields, which are described in Use the following table

to complete the screen. on page 17-85.

5. Click the Save button ( ).

Deleting a Warehouse
Follow these steps to delete a warehouse. See Also:Warehouse on page 17-85

Note: You cannot delete the default warehouse. However, you can designate another
warehouse as the default, then delete the one that was the default. See Also: Changing the
Default Warehouse on previous page

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Shipping > Warehouse.

2. Click the warehouse that you want to delete.

3. Click the Delete button ( ).
4. A confirmation message appears. Click OK.

5. The warehouse is deleted.

Packages
The Packages screen lets you define standard sizes of packaging. Use it to
define every package size that your shipping department uses to ship your
products.

If you use a provider such as UPS® or FedEx®, it is likely they provide boxes.

This section also contains the following topics.

How Packaging Information Is Used 17-88
Size and Weight Units of Measure 17-88
Creating a New Package 17-88

Editing aWarehouse

ReferenceManual
Version 8.01 Rev 4

17-87



Editing a Package 17-89
Deleting a Package 17-89

How Packaging Information Is Used
Each item in an order has size and weight dimensions. The shipping calculator
uses this information to fit the order into the smallest-sized and fewest
packages. It then passes packaging information (number, sizes and weight) to
the shipping provider, which returns the order’s shipping costs.

If a catalog entry’s dimensions exceed all box sizes, eCommerce passes that
product’s dimensions to the shipping provider.

Note: Some shipping providers, FedEx and UPS for example, have limits on the size & weight
of packages they are willing to ship. If the size or weight exceeds their limits, shipping rates
may not be returned when a site visitor is going through the checkout process. If shipping rates
are not returned during checkout, an Application error is logged in the Event Viewer. This
prevents a site visitor from continuing the checkout process.

Size and Weight Units of Measure
Packages use size and weight measurements. By default, Ektron CMS400.NET
uses English units of measure (inches and pounds). At the beginning of your
eCommerce implementation, you can change to metric units of measure by
updating the web.config file’s ek_measurementsystem tag value to metric.

Warning! After your eCommerce feature goes live, do not change the ek_measurementsystem
value in web.config.

Creating a New Package
To create a new package, follow these steps. See Also: Packages on previous
page

1. Go to Settings > Commerce > Shipping > Packages.

2. Click New > Package.

3. Use the following table to complete the screen.

Field Description

Name Enter a text description of this package size.

Length Enter the package’s length in the units of measure that appear to the right (inchesor centimeters).
See Also:Size andWeight Units of Measure above

Height Enter the package’s height in the units of measure that appear to the right (inchesor centimeters).

Conducting eCommerce with Ektron CMS400.NET

17-88 ReferenceManual
Version 8.01 Rev 4



Field Description

Width Enter the package’swidth in the units of measure that appear to the right (inchesor centimeters).

Max
Weight Enter the package’sweight in the units of measure that appear to the right (poundsor kilograms).

4. Click the Save button ( ).

Editing a Package
Follow these steps to edit a package. See Also: Packages on page 17-87

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Shipping > Packages.

2. Click the package that you want to edit.

3. Click the Edit button ( ).
4. Edit any of the fields, which are described in Use the following table

to complete the screen. on previous page.

5. Click the Save button ( ).

Deleting a Package
Follow these steps to delete a package. See Also: Packages on page 17-87

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Shipping > Packages.

2. Click the package that you want to delete.

3. Click the Delete button ( ).
4. A confirmation message appears. Click OK.

5. The package is deleted.

Shipping Methods
Use the Shipping Methods to define all choices your site visitors will have for
delivering their purchases.

Prerequisites
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n Default warehouse with an address

n A default shipping provider is defined in the
siteroot\shipment.config file

This section also contains the following topics.

Defining Shipping Providers 17-90
Defining a Custom Shipping Provider 17-91
Defining the Default Shipping Provider 17-91
Adding a Shipping Method 17-91
Editing a Shipping Method 17-92
Deleting a Shipping Method 17-92
Changing the Order of the Shipping Method 17-93

Defining Shipping Providers
When you install Ektron CMS400.NET, several providers exist in the
siteroot\shipment.config file:

n FedExShipmentProvider

n FlatRateShipmentProvider

n UPSShipmentProvider

However, the FedEx and UPS information is for testing purposes only. In order
to use FedEx, UPS or another shipping provider, obtain the following
information from them.

n service URL

n key

n password

n account number

n meter number

n transactionId

Note: The above list can vary slightly for each provider.

Then, enter that information into shipment.config, following the format of
providers already in the file.

The shipment.config file also contains name and type properties for each
provider (shown in red below).

name="FedExShipmentProvider"
type="Ektron.Cms.Commerce.Shipment.Services.FedExShipmentProvider, Ektron.Cms.Commerce"

The red text that you insert (above) is not important, but the two strings must
match.
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Defining a Custom Shipping Provider
See Customizing the Shipment Provider on page 17-274.

Defining the Default Shipping Provider
While you can define any number of shipping providers in the shipment.config
file, only one can be active. The active provider appears on the Settings >
Commerce > Shipping > Methods > New > Shipping Method screen
when you click View Options.

Specify the default (active) shipping provider via the defaultprovider
property (highlighted in red below) in siteroot\shipment.config.

<?xml version="1.0" encoding="utf-8" ?>

<shipmentProvider defaultProvider="FedExShipmentProvider">

<providers>

<add name="FedExShipmentProvider" .

.

.</shipmentProvider>

Adding a Shipping Method
Use the Add Shipping Method screens to select shipping methods you will
support. When a site visitor submits an order, these shipping choices appear on
the Shipping screen. See Also: Shipping Methods on page 17-89

To add shipping methods, follow these steps.

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Shipping > Methods.

2. Click New > Shipping Method.

3. The Add Shipping Method screen appears.

Defining a CustomShipping Provider

ReferenceManual
Version 8.01 Rev 4

17-91



4. Use the following table to complete the screen.

Field Description

Name

Enter the name of the shippingmethod. Site visitors select a shippingmethod for their order using
this name (see example below).

Note: Tip! First clickView Options and select a shippingmethod. Then enter its name here.

Active Check this box if you want site visitors to be able to select this shippingmethod.

Provider
Service

Asexplained inDefining the Default Shipping Provider on previouspage, a default shipping
provider is defined in your site’s shipment.config file. To view allmethodsoffered by that provider,
clickView Options. Then, select from the dropdown list that appears.

Editing a Shipping Method
See Also: Shipping Methods on page 17-89

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Shipping > Methods.

2. Click the Shipping Method that you want to edit.

3. The View Shipping Method screen appears.

4. Click the Edit button ( ).
5. See Use the following table to complete the screen. above.

Deleting a Shipping Method
See Also: Shipping Methods on page 17-89

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Shipping > Methods.

2. Click the Shipping Method that you want to edit.

3. The View Shipping Method screen appears.

4. Click the Delete button ( ).
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Changing the Order of the Shipping Method
Each shipping method you define has an Order field. This determines the
sequence in which shipping methods appear on the Shipping Rates screen when
a site visitor is submitting an order.

The shipping method with 1 in the Order field appears at the top of the list.

By default, every shipping method’s order is set to 1. To set a sequence for
shipping methods, follow these steps

See Also: Shipping Methods on page 17-89

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Shipping > Methods.

2. Click Action > Reorder.

3. Use the selection bar and arrows to arrange methods in the desired
sequence.

4. Click Action > Save.
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eCommerce Tax Screens
eCommerce provides a set of tax screens in the Ektron CMS400.NET Workarea
that lets you

n set up tax classes (for example, goods, services, tobacco)

n define tax rates for these geographic entities (from most to least
specific)

- postal code

- region

- country

This section also contains the following topics.

How an Order’s Tax Amount is Calculated 17-94
The Tax Class Screens 17-95
Postal TaxTables 17-97
Regional Tax Tables 17-99
Country Tax Tables 17-101

How an Order’s Tax Amount is
Calculated
During checkout, Ektron CMS400.NET tries to find a tax rate for each catalog
entry’s Tax Class (shown below) and the shipping address’s postal code.

The following table describes what happens next.
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Ektron CMS400.NET
checks for this tax

If it finds a tax rate for
geographic entity

If it does not find a tax rate for
geographic entity

1. Postal code

It adds that amount and stops.

For example

n an item costs $100.00

n the postal code tax rate = 5%

n the adjusted cost is $105.00

It checks the customer’s address for
a regional tax code.

2. Region

It adds that amount and stops.

For example

n an item costs $100.00

n the regional tax rate = 7%

n the adjusted cost is $107.00

It checks the customer’s address for
a country tax code.

3. Country

It adds that amount.

For example

n an item costs $100.00

n the country tax rate = 10%

n the adjusted cost is $110.00

No tax is added to the order.

Note: If a postal zone has several taxes (for example, a local tax and a regional tax), build the
combined percentage into the postal code tax. So, assume New York City has a 4% tax, and
New York state has a 3% tax. In this case, enter a combined total of 7% into all postal zones
within New York City. See Also: The Tax Class Screens below

The Tax Class Screens
Use the Tax Class screen to define all classes of catalog entries that can be
taxed. When you install eCommerce, the following tax classes are installed.

n alcohol

n goods

n service

n tobacco

You can modify or delete these, and add new classes at any time.

You assign a tax class to a catalog entry via its Properties tab’s Tax Class
field (shown below).

The TaxClass Screens
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This section also contains the following topics.

Creating a New Tax Class 17-96
Editing a Tax Class 17-97
Deleting a Tax Class 17-97

See Also:

n How an Order’s Tax Amount is Calculated on page 17-94

n eCommerce Tax Screens on page 17-94

Creating a New Tax Class
To create a new tax class, follow these steps. See Also: The Tax Class Screens
on previous page

1. Go to Settings > Commerce > Tax > Classes.

2. Click New > Tax Class.

3. Enter the name of the tax class.

4. Press the Save button ( ).
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Editing a Tax Class
To edit a tax class, follow these steps. See Also: The Tax Class Screens on page
17-95

1. Go to Settings > Commerce > Tax > Classes.

2. Click the Tax Class that you want to edit.

3. Click the Edit button ( ).
4. Edit the name of the tax class.

5. Press the Save button ( ).

Deleting a Tax Class
Warning! If a tax class has been assigned to a catalog entry that appears on any order, the
Delete button does not appear.

To delete a tax class, follow these steps.

1. Go to Settings > Commerce > Tax > Classes.

2. Click the Tax Class that you want to delete.

3. Click the Delete button ( ).
4. A confirmation message appears. Click OK.

5. The Tax Class is deleted.

Postal TaxTables
Use postal code tax tables to identify local areas (cities, counties, etc.) that
apply taxes to eCommerce catalog entries. The areas are identified by their
postal code. For example, London, England taxes alcohol delivered to
addresses within it.

You only need to create a postal tax table if the area that applies the tax is
smaller than a country’s geographical regions (states, provinces, etc.). If an
entire region applies a tax, use a regional tax table.

This section also contains the following topics.

Creating a New Postal Code Tax Table 17-97
Editing a Postal Code Tax Table 17-99
Deleting a Postal Code Tax Table 17-99

Creating a New Postal Code Tax Table
Prerequisite: The postal code’s country and region are defined in the Regions
and Countries screens

Editing a TaxClass
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To create a new postal code tax table, follow these steps. See Also: Postal
TaxTables on previous page

1. Go to Settings > Commerce > Tax > Postal Tax Tables.

2. Click New > Postal Code.

3. Use the following table to complete the screens.

Field Description

PostalCode Enter the postal code for which you want to enter a tax rate. If this is for a US state, the
codemust consist of five or nine digits.

Country Enter the country in which the postal code resides.

Region Enter the geographic region (for example, state or province) in which the postal code
resides.

TaxRates:

Alcohol

Goods

Services

Tobacco

Note:
Your list
may vary.

For any tax class, enter a tax rate asa whole number. For example, if the tax is 7%, enter
7. See Also: The TaxClassScreenson page 17-95
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4. Press the Save button ( ).

Editing a Postal Code Tax Table
To edit a postal code tax table, follow these steps. See Also: Postal TaxTables
on page 17-97

1. Go to Settings > Commerce > Tax > Postal Tax Tables.

2. Click the ID of the tax table that you want to edit.

3. Click the Edit button ( ).
4. Edit the fields as needed. See Use the following table to complete the

screens. on previous page

5. Press the Save button ( ).

Deleting a Postal Code Tax Table
To delete a postal code tax table, follow these steps.

1. Go to Settings > Commerce > Tax > Postal Tax Tables.

2. Click the ID of the tax table that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The postal code tax table is deleted.

Regional Tax Tables
Use regional tax tables to identify regions (states, provinces, etc.) that apply
taxes to eCommerce catalog entries. For example, within the United States of
America, the state of New Jersey applies a 5% tax on goods purchased on the
internet and shipped to it.

You only need to define a regional tax table if the area that applies the tax is
smaller than a country. If an entire country applies a tax, use a country tax
table.

This section also contains the following topics.

Editing a Regional Tax Table 17-99
Deleting a Regional Tax Table 17-101

Editing a Regional Tax Table
A regional tax table is automatically created for every existing region. By
default, all tax rates are zero (0). To change any tax rate, follow these steps.
See Also: Regional Tax Tables above

1. Go to Settings > Commerce > Tax > Regional Tax Tables.

Editing a Postal Code Tax Table
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2. Click on the name of the region for which you want to set tax rates.

3. The View Region Tax Rate screen appears.

4. Click the link that says “Click here to edit the tax rates”.

5. Click the Edit button ( ).
6. Use the following table to complete the screen.

Field Description

Name Select the region for which you want to enter a tax rate.

TaxRates:

Alcohol

Goods

Services

Tobacco

Note: Your list may
vary.

For any tax class, enter a tax rate. See Also:Regional TaxTableson previous
page

7. Press the Save button ( ).

Conducting eCommerce with Ektron CMS400.NET

17-100 ReferenceManual
Version 8.01 Rev 4



Deleting a Regional Tax Table
To delete a regional tax table, follow these steps.

1. Go to Settings> Commerce > Tax > Regional Tax Tables.

2. Click the ID of the tax table that you want to delete.

3. Click the Delete button ( ).
4. A confirmation message appears. Click OK.

5. The regional tax table is deleted.

Country Tax Tables
Use country tax tables to identify nations that apply taxes to eCommerce
catalog entries. For example, Ethiopia applies a 5% tax on goods purchased on
the internet and shipped to it.

This section also contains the following topics.

Editing a Country Tax Table 17-101
Deleting a Country Tax Table 17-102

See Also:

n How an Order’s Tax Amount is Calculated on page 17-94

n eCommerce Tax Screens on page 17-94

Editing a Country Tax Table
A country tax table is automatically created for every existing country. By
default, all tax rates are zero (0). To change any country tax rate, follow these
steps. See Also: Country Tax Tables above

1. Go toWorkarea > Settings > Commerce > Tax > Country Tax
Tables.

2. Select the country for which you want to edit a tax table.

3. The View Country Tax Rate screen appears.

Deleting a Regional Tax Table
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4. Click the link that says “Click here to edit the tax rates”.

5. Click the Edit button ( ).

6. Use the following table to complete the screen.

Field Description

Name Select the country for which you want to enter a tax rate.

TaxRates:

Alcohol

Goods

Services

Tobacco

Note: Your list may
vary.

For any tax class, enter a tax rate. See Also: The TaxClassScreenson page 17-
95

7. Press the Save button ( ).

Deleting a Country Tax Table
To delete a country tax table, follow these steps.

1. Go toWorkarea > Settings > Commerce> Tax > Country Tax
Tables.

2. Click the ID of the tax table that you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears. Click OK.

5. The country tax table is deleted.
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eCommerce Products
As mentioned in Steps to Set Up a Basic eCommerce Web Site on page 17-33,
you typically set up configuration screens before you build eCommerce
products. Next, you build the products in the sequence listed below

1. Product Types below

2. Creating a Catalog Folder on page 17-121

3. Creating a Catalog Entry on page 17-123

This section also contains the following topics.

Product Types 17-103
Creating a Catalog Folder 17-121
Creating a Catalog Entry 17-123
Product Server Control 17-146
Product List Server Control 17-156
ProductSearch Server Control 17-163

Product Types
Create a separate product type definition for each category of catalog entries
that you sell. For example, you might have a product type for movies, another
for books, a third for electronics, etc.

When thinking about creating new product types, the most significant
differences are the Class field (described below) and the content page, which
defines the XML Smart Form for products you will create of a Product Type.

This section also contains the following topics.

Product Classes 17-103
How Product Types Affect the Creation of Catalog Entries 17-104
Step 1: Properties, Attributes & Media Defaults 17-105
Creating a Kit 17-109
Creating a Bundle 17-111
Creating a Complex Product 17-112
Creating a Subscription 17-114
Step 2: Creating the Content Page 17-120
Editing a Product Type 17-120
Deleting a Product Type 17-121

Product Classes
A catalog entry’s product class affects site visitors’ purchasing options. Classes
are explained below.

eCommerce Products
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Class Description Example

Kit
Let a site visitor select from anynumber of free-text
options. Options can increase or decrease the overall
price. See Also: Creating a Kit on page 17-109

A computer whose price changes
asa site visitor selectsRAM, hard
drive, monitor, etc.

Bundle

A catalog entry consisting of several other catalog
entries bundled together. Its pricing, shipping, images,
etc. are independent of the individual items. See Also:
Creating a Bundle on page 17-111

A living room set: couch, end tables
and lamps. Instead of buying each
item separately, the site visitor
buysall for a “package” price.

Product

Simple or complex catalog entries.

A complexproduct is a “wrapper” that provides links to
related simple products. Each simple product has its
own SKU, price, inventory data, etc. See Also:
Creating a ComplexProduct on page 17-112

Amovie in three formats and
prices:

n VHS ($12.95)

n DVD ($14.95)

n Blu-ray ($17.95)

Subscription

A catalog entrywhich can provide access to
designated site pages, andmaybilled on a recurring
basis. See Also:Creating a Subscription on page 17-
114

Web site content that is only
available to subscribedmembers

How Product Types Affect the Creation of
Catalog Entries
Catalog folders generally contain the same kind of catalog entries, such as
DVDs or digital cameras. Some information applied to a catalog folder is
inherited by all entries in the folder.

After you create product types, apply appropriate ones to catalog folders using
the Catalog Properties screen’s Product Types tab (shown below).

Then, when creating a new catalog entry, you first navigate to a catalog folder.
Next, click New and choose a product type assigned to the folder (shown
below).

Conducting eCommerce with Ektron CMS400.NET

17-104 ReferenceManual
Version 8.01 Rev 4



A product type determines the following aspects of the catalog entries based on
it.

Catalog entry property For more information, see

Product class Product Classeson page 17-103

Content page Step 2: Creating the Content Page on page
17-120

Attributes AttributesTab on page 17-107

Media defaults (that is, size of thumbnail imagesadded to a
catalog entry) Media Defaults Tab on page 17-109

There are two steps to creating a product type.

n Step 1: Properties, Attributes & Media Defaults below

n Step 2: Creating the Content Page on page 17-120

See Also: Deleting a Product Type on page 17-121

Step 1: Properties, Attributes & Media
Defaults
To create a product type, goWorkarea > Settings > Commerce > Catalog
> Product Types > New > Product Type. Use the following table to
complete the Add Product Type screens.

See Also: Product Types on page 17-103

Tab/Field Description

Properties Tab

Step 1: Properties, Attributes & Media Defaults
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Tab/Field Description

Title

Give the product type a unique title. The title identifies this entry on the View Product Types
screen.

Also, when creating a new catalog entry, usersmust pick a product type from the catalog’s
Newmenu (shown below).

Description Enter a description for the product type.

Class Enter a class for the product type. See Also:Product Classeson page 17-103
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Tab/Field Description

Attributes
Tab

Define additional information about catalog entries based on this product type. Bydefault,
Attributesappear on the Product server control (illustrated below).

Asanother example, if the Product Type is for movies, attributesmight beActors,Running
Time,Rating,Year Released, etc.

Follow these steps to define a Product Type’s attributes.

1. Click the Product Type Attributes tab.

2. Click theAdd Attribute button.

3. Assign a name to the attribute, such ascolor.

4. Choose from these data types.

n text

n date

n number

n boolean (yesor no)

5. ClickOK.

(continued on next page)
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ReferenceManual
Version 8.01 Rev 4

17-107



Tab/Field Description

Attributes
Tab
(continued)

For example, you want an attribute that describesa chair’s dimensions. You create a text-
based attribute for the Product Type you will use to add chairs to a catalog.

Then, whenever you add a new chair to the catalog, you enter its dimensions into the
Attributes tab’sDimensions field.

Attributes
Tab
(continued)

When a site visitor views the chair’s product page, he sees the attribute text below the
thumbnails.

Attribute Statuses

Note: You can delete an attribute only if it isnot applied to a catalog entry. If you try to
delete an attribute applied to a catalog entry, it ismarked “Inactive.” Inactive attributes
can no longer be assigned.

n Active - Attribute can be assigned to catalog entries

n Inactive - Attribute alreadyassigned to one or more catalog entries, but can no longer be

assigned. Tomake an attribute inactive, click the correspondingMark for Delete button (
).

n Not Published - Attribute hasbeen created but Product Type not saved yet

n Active - Marked for delete. Attribute will be deleted when Product Type is saved.
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Tab/Field Description

Media
Defaults Tab

If desired, enter sizesof thumbnail images. If you do, thumbnails are automatically generated
for images (added on theMedia tab) applied to catalog entries based on this product type.

To add a new thumbnail size, clickAdd Thumbnail. To remove one, click the corresponding

Remove button ( ).

To edit a thumbnail, click the correspondingEdit button ( ). After making the edit, click

the Save button ( ).

Viewing a Catalog Entry’s Thumbnails

You can see a catalog entry’s thumbnails by clicking itsMedia tab, thenView Thumbnails.

See Also:Product Server Control, thumbnailson page 17-32

Creating a Kit
A kit is a type of catalog entry that allows a site visitor to select from free-text
options, which can affect the item’s price. The options can also be placed into
logical groups.

For example, if a catalog entry is a laptop computer, one group may let you
enter options for RAM, another for operating system version, and a third could
present hard drive options. This is illustrated below.

Creating a Kit
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There is no limit to the number of groups you can add, nor the number of
options in a group. All groups and options are simple text, created on a kit’s
Items tab as needed, and can accommodate a price modifier. The example
below shows how to set up chair color combinations.

In this example, the options do not affect the price. Here is how the options
appear on a product page.

Consider another example in which the price does change. In this case, use the
Item screen’s Price Modifier field to adjust price based on the chair frame. As
shown below, if the chair frame is teak, the sale price increases by $25.00.
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Other chair materials might adjust the price as shown below.

Frame material Price Modifier

Wrought Iron $0.00

Aluminum +$15.00

Steel -$10.00

Note how the Price Modifier can either increase or decrease the sale price.
Here are these options on the product page.

The chair’s base price is $79.99, and the teak frame increases it to $104.99.

Creating a Bundle
A bundle consists of several simple products. You would use it to combine
several existing products into one “umbrella” catalog entry. That entry captures
pricing, SKU number, shipping, and inventory information for the bundle. The
information for the individual entries that make up the bundle are not affected
when one is ordered.

As an example of a bundle using furniture, assume your eCommerce site sells a
chair, a table, and an ottoman separately. You also sell them together as a set.

Creating a Bundle
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Use a bundle to define the set, add pictures, pricing, etc. On the bundle’s Items
tab, you select the individual catalog entries that make up the bundle, as shown
below.

Here is how this bundle looks on a product page.

Creating a Complex Product
A Complex Product is similar to a bundle in that one catalog entry serves as an
“umbrella” for other entries. However, unlike a bundle, a site visitor must
select one of the catalog entries. So, the price is that of the selected entry, not
the umbrella item.
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The advantage of a Complex Product is its ability to consolidate several related
items under one title, yet allow site visitors to choose the item they want.
Because each item under the umbrella is its own catalog entry, it is priced and
tracked separately.

For example, a site sells movies in three formats: VHS, DVD, and Blu-ray. Each
is priced differently. To accommodate this, create catalog entries for the movie
in each format, assigning images, SKU number, pricing, dimensions, etc. Then,
create a Complex Product, make its title the title of the movie, and use the
Items tab to select the catalog entries of the individual formats.

The Product List or Product Search control displays the Complex Product, which
is the movie title. When a site visitor selects that, he sees the product page,
which lists the format and price of each assigned catalog entry. He can only
choose one. See example below.

Steps in Creating a Complex Product
Unlike the Kit or Bundle, a complex product does not have its own product
class. Instead, you create a catalog entry whose product class is product, then
assign other catalog entries to it via the Items tab. As soon as you assign one
catalog entry via the Items tab, the original catalog entry is converted to a
Complex Product.

Steps in Creating a Complex Product
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Note that the price of the “umbrella” product appears on the Product List and
Product Search server controls. This can be misleading, since the price of
individual items within the complex product can vary.

Note: You cannot apply tier pricing to a complex product. See Also: Tier Pricing on page 17-
135

Creating a Subscription
A subscription is a good or service which

n can be billed on a one-time or a recurring basis

n places users who purchase it into a designated membership group,
letting you grant them access to private content

Examples include

n content only available to members who purchase a subscription

n a gym membership

n a book club, in which a customer makes the same payment and
receives a different book each month

n anti-virus software that expires after 12 months

n a 3-year maintenance contract on a digital television, payable yearly

If you use the recurring billing feature, the bill can be generated for any number
of months or years, but no other time increments. Each payment must be the
same for the subscription’s term. The term begins when a customer submits the
order.

Below is an example of a subscription-based product.
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Note: Site visitors cannot apply a cart-level coupon to a subscription-based catalog entry. See
Also: Creating a Coupon on page 17-215

Creating a Subscription Based Catalog Entry
Creating a subscription is the similar to creating a regular catalog entry. The
table below lists everything you need to do, highlighting tasks that are unique
to subscriptions.

Step For more information, see

1. Create a subscription-based Product Type.

On the Product Type screen’sProduct Class dropdown, select
Subscription (illustrated below).

Product Typeson page 17-103

2. Assign the Product Type to a catalog folder.

n How Product TypesAffect the
Creation of Catalog Entrieson page
17-104

n Creating a Catalog Folder on page
17-121

3. In that folder, create a catalog entry for each subscription. Creating a Catalog Entryon page 17-
123

Creating a Subscription Based Catalog Entry
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Step For more information, see

4. On thePricing tab, enter the cost. If using recurring billing,
enter the term of the subscription.

If this product doesnot use recurring billing, clickNo at theUse
Recurring Billing dropdown.

n To learn about theUnit Pricing
fields, seeEntering a Catalog Entry’s
Price Information on page 17-133

Note: Subscription-based
products do not support tier pricing.
See Also: Tier Pricing on page 17-
135

n To learn aboutRecurring Billing
fields, seeEntering Recurring Billing
Information below

5. On the Items tab, assignmembership and CMSuser groups. AssigningGroups to a Subscription-
Based Catalog Entryon page 17-118

6. If a subscription providesaccess to Ektron CMS400.NET
content, use its folder Permission Table to grant permission to
themembership and CMSuser groups you defined in Step 5.

Subscriptions that Involve Ektron
CMS400.NET Content on page 17-
119

Entering Recurring Billing Information

Warning! Due to differences in the way payment gateways work, Ektron recommends testing
recurring payments with your gateway before processing live transactions.

The Pricing tab’s Recurring Billing area of a subscription-based catalog entry
(highlighted below) lets you determine if a subscription is billed on a one-time
or a recurring basis. If recurring, it helps you define the terms.

Conducting eCommerce with Ektron CMS400.NET

17-116 ReferenceManual
Version 8.01 Rev 4



To set up recurring billing (that is, a series of scheduled payments), click Yes
at the Use Recurring Billing dropdown. The recurring billing term begins
when a customer submits an order, and is based on a number of months or
years. You use the Billing Cycle dropdown to choose a time interval.

Next, enter a number of Billing Intervals for which a customer is charged.
For example, if a customer should be charged once a month for 12 months,
complete the screen as shown above. If a customer purchases the item on June
1, 2008, his credit card will be billed on these dates.

n June 1, 2008 (purchase date)

n July 1, 2008

n August 1, 2008

n September 1, 2008

n October 1, 2008

n November 1, 2008

n December 1, 2008

n January 1, 2009

n February 1, 2009

n March 1, 2009

n April 1, 2009

n May 1, 2009

As another example, if a customer should be charged once a year for 3 years,
complete the screen as shown below.

If a customer purchases the item on June 1, 2008, his credit card will be
charged on the following dates.

n June 1, 2008 (purchase date)

n June 1, 2009

n June 1, 2010

Entering Recurring Billing Information
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Assigning Groups to a Subscription-Based Catalog Entry
Youmust assign a membership user group to a subscription-based catalog
entry. Optionally, you can assign an Ektron CMS400.NET user group. You assign
groups via the subscription’s Items tab.

See Also: Membership User Groups on page 16-11; Managing User Groups on
page 15-27

So, as part of setting up a subscription, you must either create new
membership and (possibly user) groups, or use existing groups.

All users (identified by their email address) who purchase the product are
automatically added to one of the groups.

n Ektron CMS400.NET users are added to the group defined in the CMS
Author Group field

n Non-Ektron CMS400.NET users are added to the membership group
defined at the Member Group field

Note: Ektron CMS400.NET checks a user’s email address to determine if he is a CMS or a
membership user.

Subscriptions that do not Involve Ektron CMS400.NET
Content
If a subscription does not involve access to Ektron CMS400.NET content, the
membership group provides a list of customers who purchased the subscription.
You can use the list to manage the accounts, notify them when the subscription
is about to expire, etc.

Subscriptions that Involve Ektron CMS400.NET Content
If a subscription involves access to Ektron CMS400.NET content, create a folder
and enable one or more subscription-based product types on its Product Type
screen (illustrated below).
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Place the subscription products in that folder. Site visitors shop for and
purchase this content on your Web site as they do all products, via eCommerce
server controls.

Then, create a regular content folder in which to create the confidential content.
Next, use the content folder’s permission table to grant the subscription user
groups access to that folder (illustrated below).

See Also: ”Folder Permissions” on page 5-56 and ”Assigning Permissions for
Memberships” on page 16-22

Step 2: Creating the Content Page
After you complete and save the Add Product Type screen, a new screen allows
you to enter XML Smart Form information. On this screen, you set up fields to
collect information for the content page of catalog entries based on this product
type. See example below.

Step 2: Creating the Content Page
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The content page appears on the Product server control, describing this catalog
entry to site visitors. See example below.

The process of creating a product type content page is the same as creating an
XML Smart Form, described in Before You Manage Smart Forms on page 7-280.

Editing a Product Type
1. In the Ektron CMS400.NET Workarea, go to Settings > Commerce

> Catalog > Product Types.

2. Click the product type that you want to edit.

3. See A product type determines the following aspects of the catalog
entries based on it. on page 17-105.

Note: You cannot edit a Product Type’s Class.

Deleting a Product Type
Prerequisite: The product type is not assigned to any catalog entries

1. In the Ektron CMS400.NET Workarea, go to Settings > Commerce
> Catalog > Product Types.

2. Click a product type you want to delete.

3. Click the Delete button ( ).

4. A confirmation message appears.

5. Click OK.

Note: Although you cannot delete a product type that is being used, you can prevent users
from creating new catalog entries based on it. To do this, go to each applicable folder’s
Catalog Properties > Product Types screen and remove that product type.
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Creating a Catalog Folder
Prerequisite: One or more product types (See Also: Product Types on page
17-103)

A catalog folder is a special kind of Ektron CMS400.NET folder designed to hold
eCommerce entries. Its unique icon ( ) distinguishes it from other folder
types. If you are familiar with content folders, much of that information applies
to catalog folders. See Also: Managing Folders on page 4-1

A Catalog folder's properties screen has several tabs/screens, as shown below.

These screens are the same as regular content folders.

n Properties - see Fields on the Folder Properties Screen on page 4-
15

n Taxonomy - see Taxonomy on page 9-202

n Templates - see Creating/Updating Templates on page 7-178

n Flagging - Flagging on page 16-209

n Metadata - see Assigning Metadata to a Folder on page 7-159

n Breadcrumb - see Creating SiteMap Breadcrumbs on page 9-276

The unique screen is Product Types. See Also: Assigning a Catalog Folder’s
Product Type below

Creating a Catalog Folder
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Like content folders, the following catalog folder information can be inherited
from its parent or uniquely set for each catalog. You can only make changes
after creating the catalog.

n Permissions - see Setting Permissions for a Content Folder on page
4-44

n Approvals - see Creating an Approval Chain for a Content Folder on
page 4-30

n Purge History - Purge History on page 4-26

n Restore Web Alert Inheritance - Inheriting Content-Level Web Alert
Information from Its Folder on page 23-26

This section also contains the following topics.

Assigning a Catalog Folder’s Product Type 17-122
Deleting a Catalog Folder 17-123
Searching a Catalog Folder 17-123

Assigning a Catalog Folder’s Product Type
A catalog folder’s Product Types screen lets you identify product types upon
which catalog entries can be based. See Also: Product Types on page 17-103
and How Product Types Affect the Creation of Catalog Entries on page 17-104

For example, you created a lawn mower Product Type, and want only lawn
mowers to be entered in a catalog folder. In this case, open a catalog folder’s
Product Types tab, break inheritance if necessary, and select Lawn Mower as
the catalog’s only product type.

Then, when a Ektron CMS400.NET user creates an entry in this catalog, he must
use the Lawn Mower product type.
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Deleting a Catalog Folder
Prerequisite: No catalog entries in the folder have been placed on an order

To delete a catalog folder, follow these steps.

1. Navigate to the folder that you want to delete.

2. Click Delete > This Catalog.

3. A confirmation message appears.

4. Click OK.

Searching a Catalog Folder
Searching a Catalog folder is the same as searching any other type of Workarea
folder. This procedure is described in Searching the Workarea on page 9-89.

Creating a Catalog Entry
Prerequisite: One or more catalog folders (See Also: Creating a Catalog
Folder on page 17-121)

A Catalog entry is the eCommerce term that describes a product sold on your
Web site. It is similar to content in the rest of Ektron CMS400.NET, so those
concepts apply to catalog entries.

Catalog entries are built from Ektron CMS400.NET XML Smart Forms, so use the
same content and folder structure as other Smart Forms. See Also:Working
with Smart Forms on page 7-278

Catalog entries share the following features with regular content.

n content status

n approvals and permissions

n metadata

n schedule

n can be private

n history and the ability to restore previous versions

n search

n taxonomies to categorize products

Catalog entries also have unique information, such as

n Tax Class - determines which taxes apply to item

n Physical dimensions - used to calculate shipping costs

n Inventory tracking

Deleting a Catalog Folder
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n Pricing - can be fixed or variable for any currency

- tier pricing, that is, price adjusts when quantity reaches new plateau.
For example, 1-9 items cost $500 each. But if 10 are sold, the price
drops to $450 each.

n Images (full sized and thumbnail) to display the product on your Web
Site

Because there is so much information to provide about managing catalog
entries, this section takes two approaches

n Catalog Entry Screens and Menu Options below describes all
accessible options (tables, menus, etc.) from the catalog entry
screen

n Catalog Entry Tasks below describes how to do things with catalog
entries: create them, delete them, etc.

Catalog Entry Screens and Menu Options
n Tabs on the Catalog Entry Screen on page 17-128

n Menu Options on the Catalog Entry Screen on page 17-130

n Folder View Menu options on page 17-142

n Content View Menu Options on page 17-144

Catalog Entry Tasks
n Creating/Updating Content on the facing page

n Deleting a Catalog Entry on next page

n Adding Cross Sell and Upsell Recommendations to a Catalog Entry on
page 17-181

n View and restore a previous version of a catalog entry - Navigate to
catalog folder > select catalog entry > View Menu > Content
History option. See Also: Content History on page 17-144

n Edit permissions for a catalog entry - To enable this, break
permission inheritance. Then, assign permissions to selected users.
See Also: Setting Permissions for Content on page 4-48

n Edit inherited approval chain - First break permission inheritance,
and assign permission to users who need to be in the approval chain.
Then, update the catalog entry’s approval chain. See Also: Editing an
Approval Chain For Content on page 4-33

n Make a catalog entry private, so that the Web site search does not
find it - See Private Content on page 7-184

n Archive a catalog entry - See Archived on page 17-132
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n Displaying Catalog Entries on your Web Site on page 17-146

Creating/Updating Content
Follow these steps to create a new catalog entry or update an existing one.

1. Navigate to a catalog folder in which you want to create or update a
catalog entry. See Also: Creating a Catalog Folder on page 17-121

2. Click New then select a product type on which to base the entry. See
Also: Product Types on page 17-103

3. Complete the screens as needed. The required fields are:

- content Title

- Properties tab > SKU Number

- any fields on the content screen that your Ektron CMS400.NET
administrator has designated as required

For information on the catalog entry screens, see Tabs on the Catalog
Entry Screen on page 17-128

4. Check in or submit/publish the content. See Action Menu on page 17-
145.

Note: After signing in to your Web site, you can also update a catalog entry’s information from
there.

Creating/Updating Content
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Note: See Also: The Web Site Content Menu on page 7-4

Deleting a Catalog Entry
Prerequisites:

n Catalog entry is not on an order, or checked out.

n You have delete permission for this catalog folder. See Also: Folder
Permissions on page 4-40

Ektron Best Practice
Do not delete catalog entries. For example, if you delete an entry from your
staging site, then run an eSync, that entry is removed from all active carts on
your live site.
Instead of deleting entries, Ektron recommendsarchiving them using the
Properties tab’sArchived checkbox (shown below).

Note: If you want to prevent site visitors from purchasing an item, but you cannot delete it
because it has been placed on existing orders, you have two options.
* Uncheck its Buyable checkbox, located on the Properties screen (circled below). If you do,
the product still appears on your Web site, but the Add to Cart button does not appear next to
it.
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* Archive it, using the Archived check box on the Properties screen (circled above). In this
case, the product does not appear on your Web site. See Also: Archived on page 17-132

Follow these steps to delete a catalog entry.

1. Navigate to the catalog folder that contains the entry.

2. Click the entry.

3. Click Action > Delete.

4. A warning message appears. Click OK.

5. The catalog entry is deleted.

Deleting a Catalog Entry
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Tabs on the Catalog Entry Screen

Tab Description
For more information,
see

Content The entry’s content page. Entering a Catalog Entry’s
Content on page 17-130

Summary The content summary, bydefault the first 40 characters of the
content text.

AutomaticCreation of a
Summaryon page 7-138
andWorking with Content
Summaryon page 7-137

Properties

eCommerce information about the catalog entry:

n SKU number

n Number of Units

n TaxClass

n Archived

n Buyable

n Dimensions

n Inventory

Entering a Catalog Entry’s
Propertieson page 17-
131

Pricing

n Lets you define list and salesprice

n For each enabled currency, you can set a fixed price or have it
float with exchange rate

n Allows tier pricing

n For subscription products, you enter recurring billing interval
and term

Entering a Catalog Entry’s
Price Information on page
17-133

Attributes Additional information to help describe a catalog entry Entering a Catalog Entry’s
Attributeson page 17-138

Media Lets you add images that appear on several eCommerce server
controls

Entering a Catalog Entry’s
Media on page 17-139

Items

Catalog entries that you are adding to this “umbrella” item.

n If you add catalog entries to a simple product, it becomesa
complexproduct.

n For bundles, add catalog entries that make up a bundle.

n For kits, enter groupsand their options.

n For subscription products, definemembership and Ektron
CMS400.NET user groups to which users are assigned when
theypurchase the subscription.

Entering a Catalog Entry’s
Itemson page 17-142

Creating a Complex
Product on page 17-112

Creating a Bundle on
page 17-111

Creating a Kit on page 17-
109

Creating a Subscription
on page 17-114
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Tab Description
For more information,
see

Metadata

Enter meta tags, title tags, etc.

Note: When viewing themetadata screen in view mode only,
you see the catalog entry’sProduct Icon. The product icon is
set on themedia tab. See Also:Product List, Product Search,
and Recommendation server controlson page 17-32

Working with Metadata on
page 7-141

Alias

Note: This tab only appears if Aliasing is enabled.

n View and edit the catalog entry’s primarymanual alias

n View all automatic aliasesassigned to this catalog entry

Creating User-Friendly
URLswith Aliasing on
page 10-1

Schedule

Lets you controlwhen a version of a catalog entry becomesvisible
on theWeb site. Similarly, you can remove a catalog entry on a
predetermined date and time.

Note: TheArchive and remain on the site option is not
available with catalog entries.

Scheduling Content to
Begin and End on page 7-
187

Comment

View comments on changesmadewhen editing a catalog entry.

Note: To view and edit catalog entry comments, open the
editor and chooseChange > Comment.

The comment also appears on the View Content and Content
History screens. Use it to help distinguish one version from
another.

Tasks

View tasksassigned to this catalog entry.

Note: To add a task from the View Entry screen, clickAction
> Add Task.

Assigning and Reviewing
Taskson page 12-1
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Tab Description
For more information,
see

Category

Add a taxonomycategory to the catalog entry.

A list of available taxonomiesand whether one is required are
defined on the Catalog properties screen.

Note: This tab only appears if at least one taxonomy is
assigned to the catalog folder.

Taxonomyon page 9-202

Menu Options on the Catalog Entry Screen

Menu Option Description

Action Menu

Save
Saves the catalog entry without leaving the editor. It is a good idea to save
your work frequently.

Check in
Save and check-in the document. This action returns the changed content to the database
and exits the editor. It doesnot submit the content into the approval chain. Rather, it allows
you and other users to continue changing it.

Submit/Publish

Submit the content into the approval chain. This action also returns the new or updated
content to the database and exits the editor.

Publish the content to theWeb site.

Note: Only the last approver in the approval chain sees this button. If no approval chain
is assigned to the content’s folder, every authorized user sees this button. See Also:
ApprovalChainson page 4-27

This action also returns the changed content to the database and exits the editor.

Undo checkout Exit screen and do not save changesmade since you began editing this catalog entry.

Change Menu

Comment
Enter comments on changesmadewhen editing a catalog entry.

The comment also appears on the View Content and Content History screens. Use it to
help distinguish one version from another.

Template
A folder’s default template is automatically applied to all content in the folder. However, you
can change a content item’s template to anyof those assigned to the folder. See Also:
Creating/Updating Templateson page 7-178

Entering a Catalog Entry’s Content
The Content tab displays the content page of this catalog entry’s product type.
See Also: Step 2: Creating the Content Page on page 17-120
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Because the format is customized for your system, this documentation cannot
explain how to respond to the fields.

To learn about working with the editor, see Ektron CMS400.NET Editors on page
7-26.

Entering a Catalog Entry’s Summary
See Working with Content Summary on page 7-137 .

Entering a Catalog Entry’s Properties
The Properties screen collects eCommerce-specific information about your
catalog entries.

Use the following table to complete the Properties screen.

Entering a Catalog Entry’s Summary
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Property Description

SKU Enter a unique SKU code for this catalog entry. This is a required field that does
not accept a value of zero (0) or a space character.

Number of Units

If this item hasa quantity other than one (1) for internal record-keeping purposes
only, enter that number.

For example, a 12 packof soda. SetQuantity is 12 to represent the number of
units. But a site visitor still orders 1 of the item.

The quantity is not used when this item is ordered, nor does it affect inventory
levels. It is used for clerical purposesonly.

TaxClass Select the catalog entry’s TaxClass. See Also: The TaxClassScreenson page
17-95

Archived

Check this box if you want to archive this catalog entry. Once archived, site
visitors can no longer see nor order it.

Also, Ektron CMS400.NET users cannot view an archived catalog entry in its
catalog folder via the View Folders screen. To view it, open its catalog folder then
selectView > Archive.

Tomake the entry available again on your Web site, open its archive folder, edit
the entry byunchecking theArchived checkbox, and publish it.

Note: A catalog entry can also be set to Archived status if it reaches its
expiration date and itsSchedule tab >Action on End Date field is set to
Archive and remove from site (expire).See Also: Setting Archive
Optionson page 7-191

Buyable

To let site visitors add this catalog entry to a shopping cart, check this box.
Otherwise, uncheck it.

If a product isnot buyable, it can still be seen by site visitors, but its product page
doesnot display anAdd to Cart button.

Note: Tip! To remove a catalog entry from your site, use theArchive field.

Dimensions- Used to calculate packaging containers and shipping costs. See Also:
Packages on page 17-87
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Property Description

Tangible Item

Check this box if the item is tangible, that is, it hasdimensions, weight, and will be
shipped to a customer. Examplesof non-tangible itemsare services, warranties,
and downloadable software.

If a catalog entry is tangible, youmust enter its height, width, length, and weight.

Height
Enter the catalog entry’s height. The units of measure are specified in the
web.config file’sek_measurementsystemproperty.

Required if Tangible Item is checked.

Width Enter the catalog entry’swidth. Required if Tangible Item is checked.

Length Enter the catalog entry’s length. Required if Tangible Item is checked.

Weight Enter the catalog entry’sweight. Required if Tangible Item is checked.

Inventory - eCommerce’s inventory system is a provider model, allowing you to connect
with third-party inventory systems.

Disable Inventory
Check this box if you do not want to track inventory activity for this catalog entry.
Asexamples, it is a service contract or a subscription to confidential content on
your site.

In Stock

Enter the number of itemson hand for this catalog entry.

This number is automatically adjusted when an order containing this entry is
submitted. For example, there are 100 items in stock.When an order for 10 is
submitted, the In Stock value changes to 90.

If the amount placed on an order exceeds the In Stock amount, the site visitor
see thismessage “The item ... is not available for purchase. Please remove from
cart before submitting order.”

OnOrder The number of items that have been ordered but not yet delivered appears.

Reorder
Enter the In Stock quantity at which you need to reorder this item.When the In
Stock quantity reaches this level, an event is triggered which can be used byan
external inventory system to generate a new order.

Entering a Catalog Entry’s Price Information
Use the Pricing screen to enter price information for catalog entries.

Entering a Catalog Entry’s Price Information
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Use the following table to complete the Pricing screen.

Field Description

Currency selector

Use this dropdown to select a currency for the prices. See Also:
Alternate CurrencyPricing on the facing page

Only enabled currenciesappear. See Also:Enabling Currencies on
page 17-55

List price

Enter the catalog entry’s list, or manufacturer’s suggested retail,
price.

The list price appears onmost eCommerce controls (see examples
below) but isnot used in any calculations.

Cart server control

Product Search server control

Our SalesPrice

Enter the catalog entry’s sale price. This price is used to calculate line
item totals, coupon discounts, shipping costs, etc.

The salesprice appears onmost eCommerce controls. See
examplesabove.
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Field Description

Add Pricing Tier
button Tier Pricing below

Recurring Billing
(appears only for
subscription-based
products)

Creating a Subscription on page 17-114

Alternate Currency Pricing
By default, the Pricing screen converts prices to every enabled currency (see
screen below), using the exchange rate. Site visitors who select a non-default
currency see these prices. See Also: Updating the Exchange Rate on page 17-58

The Float checkbox (checked by default) indicates that prices change as the
exchange rate changes.

If you do not want to float a catalog entry’s price, but instead fix it for a
currency, select the currency, uncheck Float, edit the price, and publish. From
then on, if a site visitor selects that currency and catalog entry, the price set on
this screen is used. The exchange rate is ignored.

For example, a television costs 700 Euros, regardless of its cost in US dollars or
the exchange rate. To incorporate this, do not check the Float checkbox.

When you first select EUR on the Pricing screen, the default currency’s prices
are converted using the exchange rate. For example, the television’s sale price
is $1000 US dollars, and today’s exchange rate is .7811. When you select Eur
from the Pricing screen’s currency selector, the television’s cost is set at
781.10 Euros. You change the price to 700.00 Euros.

From that point on, the Euro price only changes if an authorized user accesses
this screen and changes it manually.

Tier Pricing
eCommerce supports tier pricing, that is, a pricing schedule that adjusts
according to order quantity. Typically, the price is reduced as more items are
ordered. For example, if a visitor orders 1-5, items are $10.00 each; 6-10,
$9.00 each; 11 or more, $8.50 each.

Alternate Currency Pricing
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Note: Tier pricing is not supported for subscription products, nor for complex products. See
Also: Creating a Subscription on page 17-114, Creating a Complex Product on page 17-112

To set up tier pricing, follow these steps.

1. In the Workarea, open the catalog folder containing the entry to
which you want to apply tier pricing.

2. Edit the catalog entry.

3. Click the Pricing tab

4. Click the Add Pricing Tier button (shown below).

5. The following screen section appears.

6. In the left column, enter the quantity of items above which the tier
price is used.

7. In the right column, enter the price to be used when an order quantity
exceeds the number in the left column.

8. Enter as many tiers as necessary.

Note: To remove a tier, check the box to its left, then click the Remove Pricing Tier button.

Tier Pricing and Non-Default Currencies: When Floated
If a non-default currency is floated, then that currency’s pricing tiers mirror the
default currency’s pricing tier values. The amounts are adjusted by the
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exchange rate.

These values appear on pricing screen in view-only mode and cannot be
changed. This is illustrated below.

If pricing tiers are set up for the default currency and the user unchecks the
Float box, he is notified that the pricing tiers can now be edited. Next, Tier
Pricing fields are loaded with the existing values but the user can change
values, remove existing tiers, and add new ones.

Tier Pricing and Non-Default Currencies: When Not Floated
If a non-default currency is not floated, its pricing tiers are independent of the
default currency’s. That is, they do not exist initially regardless of whether they
exist for the default currency. If the user clicks Add Pricing Tier, Tier
Pricing fields appear and let the user enter number of units and corresponding
tier price per unit.

If pricing tiers are set up for a non-default currency and the user checks the
Float box, the pricing tiers are changed to mirror those of the default currency.
If the default currency has no pricing tiers, then that currency has none. You
cannot independently edit a non-default currency’s pricing tiers if Float is
checked.

Tier Pricing and Non-Default Currencies: WhenNot
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Entering a Catalog Entry’s Attributes
Attributes are additional pieces of information that help describe a catalog
entry. To illustrate the concept, the following attributes are applied to furniture
in Ektron CMS400.NET’s sample site.

In the Workarea, you select a catalog entry then click the Attributes tab to
enter or modify attribute values. In the above example, you could change
model year to 2009, or style toWoodland. You cannot however change fields,
field names, or data types.

Note: If no attributes are assigned to the product type on which a catalog entry is based, you
will not see an Attributes tab when working with that catalog entry.

On your Web site, a catalog entry’s Attribute field names and values appear by
default on the Product server control, as shown below.
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Origin of Attributes
Attribute fields, data types, and default values are created as part of a Product
Type. See Also: Attributes on page 17-128

When you create a catalog entry, you base it on a product type. The product
type’s Attribute information is imported to the catalog entry.

What Happens to a Catalog Entry’s Attributes When Moved
Like metadata that follows Ektron CMS400.NET content, if a catalog entry is
moved to another folder, its attributes stay with it.

Entering a Catalog Entry’s Media
Use the Media tab to add product images that appear on the following server
controls.

n Product (the smallest thumbnail may appear)

n Product List

n Product Search

n Recommendation

See Also: Images in eCommerce on page 17-32

Origin of Attributes

ReferenceManual
Version 8.01 Rev 4

17-139



Adding a New Image
Follow these steps to add a new image. See Also:
http://www.w3schools.com/tags/tag_IMG.asp

1. Click the Media tab.

2. Click Add New Image .

3. Enter an image Title. This is a required field.

4. Enter the image’s Alt text. This is a required field.

5. Click the Browse button and navigate to the image you want to add.

6. Click the Upload button.

7. The image is uploaded to the siteroot/uploadedimages folder.

Note:When an image is uploaded to the Media tab, the original image and any thumbnails
associated with it are added to the Library. For example, if you add an image named
“TestImage” (actual file name: “case.jpg”) with a 150px and 50px thumbnails, you see the
following entries in your library (File Name - Path):
TestImage - /~siteroot~/uploadedImages/case.jpg
case[filename]150 - /~siteroot~/uploadedImages/case[filename]150.jpg
case[filename]50 - /~siteroot~/uploadedImages/case[filename]50.jpg

8. The image appears on the screen, below any existing images.

9. Determine if you want the image’s smallest thumbnail to appear on
the product server control by selecting Yes or No next to Gallery
Display. (See example below). See Also: Product Server Control,
thumbnails on page 17-32

10. If you want to designate the image as the product icon, click Set as
Product Icon. See Also: Product List, Product Search, and
Recommendation server controls on page 17-32

To learn about the image thumbnails, see Determining Thumbnail Size on the
facing page.

Editing an Existing Image

Note: You cannot change an existing image. If you need to do this, delete the image you do
not want, then add the correct one. You can only edit the Title and Alt Text.

1. Click the Media tab.

2. Move the cursor to the field that you want to edit.

3. Click the pencil icon to the right of the field (shown below).
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4. Update the text as needed.

5. Click the OK button ( ).

Determining Thumbnail Size
When you create a catalog entry, you base it on a Product Type. The selected
product type’s Media Defaults information determines the sizes of thumbnails
created for each image assigned to the Media tab. See Also: Media on page 17-
128

n If the image is less than both thumbnail dimensions (height and
width), it appears full size.

n If the image is greater than the thumbnail’s dimensions, the image is
reduced proportionately, scaling its dimensions to the thumbnail
size.

The Default Image
If you do not assign an image to a catalog entry, but one is assigned to appear
on a server control, the following default image is used.

Determining Thumbnail Size
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If you want to change the default image, edit the following file:

siteroot/WorkArea/images/application/Commerce/productImageBackground.gif

Entering a Catalog Entry’s Items
Use the Items tab to add additional information to the current entry. It is used
in these situations.

n to select the catalog entries that make a product into a complex
product. See Also: Creating a Complex Product on page 17-112

n to select the catalog entries that make up a bundle. See Also:
Creating a Bundle on page 17-111

See Also: Product Classes on page 17-103

n to select the groups and their options that make up kits. See Also:
Creating a Kit on page 17-109

Note: You can only choose a catalog entry whose language matches the language of the
original item.

n to select a subscription-based catalog entry’s user groups. See Also:
Assigning Groups to a Subscription-Based Catalog Entry on page 17-
118

Folder View Menu options
The following menu options are available when you open a catalog folder.

Menu option Description

New Menu

Catalog Create a new catalog folder underneath the current one. See Also:Creating a
Catalog Folder on page 17-121
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Menu option Description

product types
assigned to folder

Create a new catalog entry based on one of the displayed product types. Your
product typesmaynot match the ones shown below.

Product typesare assigned to a catalog’s via theProduct Types screen. See
Also:Product Typeson page 17-103

View Menu

All types, products, kits,
bundles

Lets you change the displayof catalog entries. You can see all entries in folder, or
only those of a selected product class. See Also:Product Classeson page 17-
103

Language
Limits display of catalog entries to one language.

Also determines the language of anynew catalog entries you create in this folder.

Archive Displaysarchived catalog entries. See Also:Archived on page 17-132

Catalog Properties Lets you view and edit catalog folder information. See Also:Creating a Catalog
Folder on page 17-121

Delete Menu

Note: You cannot
delete a catalog entry
that hasbeen placed
on anyorder. The
order’s status is
irrelevant.

Lets you delete a catalog folder or a catalog entrywithin it.

See Also:Deleting a Catalog Entryon page 17-126,Deleting a Catalog Folder
on page 17-123

Catalog Deleting Folderson page 4-25

Entries

See

n Deleting a Catalog Entryon page 17-126

n Deleting SeveralContent Items in a Folder on page 7-128

Action Menu

Move entry
Viewing and Restoring PreviousContent on page 7-115

Note: You can onlymove catalog entries -- you cannot copy them.

Search The Search Published Tab on page 9-90

Folder View Menu options
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Content View Menu Options
The following menu options are available when you are viewing a catalog entry.

Menu option Description

Action Menu

Edit Edit the catalog entry. See Also: Tabson the Catalog EntryScreen on page 17-
128

Delete

See

n Deleting a Catalog Entryon page 17-126

n Deleting Content on page 7-127

LinkSearch

Locatesall content that includesaQuicklink to the displayed catalog entry.

This feature is useful before deleting a catalog entry, because it informsyou of
every entry that will include a “dead” link if you delete that entry. You should then
edit those catalog entries and remove or change the obsolete Quicklinks.

Add Task Assigning and Reviewing Taskson page 12-1

View Menu

Content History
Lists every version of the content available in Ektron CMS400.NET. After viewing
the View Content Historywindow, you can click any version to see its detail.

See Also: Viewing and Restoring PreviousContent on page 7-115

View Approvals Access the catalog folder’s approval chain. See Also:WorkFlow on page 4-27

View Permissions Access the catalog folder’s permissions table. Folder Permissionson page 4-40

CrossSell Lets you assign cross sell items to this catalog entry. See Also:Adding CrossSell
and UpsellRecommendations to a Catalog Entryon page 17-181
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Menu option Description

UpSell Lets you assign up sell items to this catalog entry. See Also:Adding CrossSell
and UpsellRecommendations to a Catalog Entryon page 17-181

View Properties

Lets you

n view the

- catalog entry’s product type See Also: Product Types on
page 17-103

- Flagging Definitions assigned to the catalog entry’s folder
See Also: Flagging on page 16-209

n view and edit theContent Searchable setting - The search only considers
content if this field is checked. Bydefault, this field is checked when an entry is
created.

Reports Menu

Content Statistics Content Rating on page 7-739

Analytics Providesa visual display of order information for a selected catalog entry. See
Also: eCommerce Analyticson page 17-180

Editor View Menu Options
The following options are available when you are editing a catalog entry’s
content.

Menu Option Description

Action Menu

Save Save the content without leaving the editor. It is a good idea to save your work frequently.

Check in
Save and check-in the document. This action returns the changed content to the
database and exits the editor. It doesnot submit the content into the approval chain.
Rather, it allows you and other users to continue changing it.

Editor View MenuOptions

ReferenceManual
Version 8.01 Rev 4

17-145



Menu Option Description

Submit or Publish

Submit the content into the approval chain. This action also returns the new or updated
content to the database and exits the editor.

Publish the content to theWeb site.

Note: Only the last approver in the approval chain sees this button. If no approval
chain is assigned to the content’s folder, every authorized user sees this button. See
Also:WorkFlow on page 4-27

This action also returns the changed content to the database and exits the editor.

Undo Checkout Close the editor without saving changes.

Change Menu

Comment Briefly describe the content, or comment on changesmadewhen editing content. The
history comment appears on the View Content and Content History screens.

Template
Lets you specify one or more templates for catalog entries in this folder. These entries
use the specified template when appearing on your Web site. See Also:
Creating/Updating Templateson page 7-178

Displaying Catalog Entries on your Web Site
The eCommerce Module provides three server controls for displaying catalog
entries on your Web site.

n Product Server Control below

n Product List Server Control on page 17-156

n ProductSearch Server Control on page 17-163

Product Server Control
The Product server control allows site visitors to view the details of a product
and add it to their cart. To display a product on a Web page, drag and drop a
Product server control on a template and enter a product ID in the
DefaultProductID property. You could also dynamically pass a product’s ID to
the control by setting DynamicProductParameter property to the QueryString
parameter used for product IDs.

This control handles each class of product Ektron provides. This means the
Product server control displays Products, Kits, Bundles or Subscriptions without
having to make any adjustments to the control.

Site visitors typically reach this server control when they click a product from
either the ProductSearch or ProductList server control. When site visitors clicks
a product, title or image in either of these controls, they are forwarded to the
Product server control.
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In addition, site visitors can reach this control from the Cart server control. In
that control, site visitors click a product’s title and are taken to the Product
server control.

Once a site visitor has viewed the product and decided to purchase it, they click
the Add to Cart button displayed in the control.

This section also contains the following topics.

Displaying a Product 17-147
Using the Add to Cart Button with Aliasing 17-148
Displaying a Bundled Product 17-149
Displaying a Complex Product 17-150
Displaying a Kit 17-151
Product Server Control Properties 17-151
The OverrideXslt and DisplayXslt Properties 17-155

Displaying a Product
A product is an item that has no kit, bundle or subscription information
associated with it.

When displaying a simple product, the Product server control displays the
following information.

Area Where information comes from

Title

(This field
is optional.)

The Title field in the product’sSmart Form. A content editor enters this information when
creating a product in theWorkarea. This area doesnot use the title of the product in Ektron
CMS400.NET’sWorkarea.
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Area Where information comes from

Description

(This field
is optional.)

The Description field in the product’sSmart form. A content editor enters this information when
creating a product in theWorkarea.

Image
Gallery

TheMedia tab when creating or editing a product. TheGalleryDisplayproperty for each image
on theMedia tabmust be set to Yes.

In the ImageGallery, imagesare displayed at their smallest size. Once a site visitor clicks an
image, the full size version is displayed. Below is an example of a product’s image gallery.

See Also:Entering a Catalog Entry’sMedia on page 17-139

Price
The Pricing tab when creating or editing a product. This is the price defined in theOurSales
Price area. This is not the list price.

See Also:Entering a Catalog Entry’sPrice Information on page 17-133

Add to
Cart
button

This button appears in the server controlwhen

n a path to the Cart server control is defined in the
Templatecart property

n the product is buyable.When a product is not buyable, information about the product is
displayed, but site visitors cannot add it to their cart. This property is set in theWorkarea when
creating or editing a product.

n theShowAddToCart property is set to True

When site visitors click this button, the product is added to their cart and theyare sent to a
template containing the Cart server control.

You can hide this button by setting the ShowAddToCart property to false. This allowsyou to
show details of a product, but not offer it for sale. For example, you have a product that is no
longer for sale, but you want to allow people who purchased the product to view its details.

Also, byusing code behind to dynamically set the property, you could create code that looksat
your inventory system and hides the button depending on whether a product is in stock.

See Also:Using the Add to Cart Button with Aliasing below

Using the Add to Cart Button with Aliasing
When a product has an alias path associated with it, you need to do the
following:

n Make sure the TemplateCart property’s path is relative to the site
root. For example:

TemplateCart="Developer/Commerce/CartDemo.aspx"
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n Add the following to the code behind page. This example is in C#:

protected void Page_Init(object sender, EventArgs e)

{

Utilities.RegisterBaseUrl(this.Page);

}

Displaying a Bundled Product
A bundled product is made up of multiple products that have been grouped
together for sale as one product.

See Also: Creating a Bundle on page 17-111

When displaying a bundled product, the Product server control displays all
information displayed in a Product as well as the following information.

Area Where the information comes from:

This
Bundle
Includes:

Products listed on the Items tab for a Product Bundle in theWorkarea. A content editor adds
existing products to this tab when creating the bundle.

Anyproducts on the tab are displayed with the image, title and description for each product. A
link to additional information about each product is also displayed.
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Displaying a Complex Product
A Complex Product allows the site visitor to choose between variations of a
product. For example, if your site sells books, variant selections might be
Paperback or Electronic.

See Also: Creating a Complex Product on page 17-112

When displaying a Complex Product, the Product server control displays all of
the information displayed in a Product in addition to the following information:

Area Where the information comes from:

Variants:

Products listed on the Items tab. A content editor addsproducts to this tab when creating
content.

Products on the Items tab are displayed with a radio button, image, title and description. A link to
additional information about each product is also displayed. The radio buttonsare used to select
which product will be added to the cart.

Conducting eCommerce with Ektron CMS400.NET

17-150 ReferenceManual
Version 8.01 Rev 4



Displaying a Kit
A kit allows the site visitor to select product options, which can affect the
product’s price. There is no limit to the types of options you can add, nor to the
number of items in an option. For example, a site visitor purchasing a computer
can add RAM, a hard drive, and a larger monitor.

See Also: Creating a Kit on page 17-109

When displaying a kit, the Product server control displays all information
displayed in a product in addition to the following information.

Area Where the information comes from:

Options The Item tab for a kit in theWorkarea. Optionsare divided into groups. A radio button, name and
price appears for each item. The radio button allowsyou to select one item from each group.

Subtotal: The updated cost of the product with all options.

Product Server Control Properties
The following table explains the properties of the Product control.
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Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer
and can use it to browse to Content, Collections,
etc. See Also:Working with Ektron CMS400.NET
Server Controlson page 24-1

String

CacheInterval

Sets the amount of time the server control’s data is
cached. The default is 0 (zero). This is the amount
of time, in seconds, a control’s data is cached. For
example, if you want to cache the data for five
minutes, set theCacheInterval property to
300 (three hundred). See Also:Caching with
Server Controlson page 24-33

Double

CustomXml

(Code BehindOnly)

Enter a string of XML that you want to make
available to the XSLT. This property providesa
mechanism to inject customXML into the
generated XML before being processed by the
XSLT. The sting is added inside the CustomXml
tag as follows:

<root><customXml>custom-xml-inserted-
here</customXml></root>

See Also:Displaying CustomXML in Ektron’s
Server Controlson page 24-38

String

DefaultProductID

Enter a default product’s ID. This is the default
product that’s displayed when the template
containing this control is viewed bya site visitor
and a product ID is not dynamically passed.

Tomake this server control dynamic, enter zero
(0) for this property and set the
DynamicProductParameter to the
QueryString parameter used to pass the product
ID.

Integer
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Property Description Data Type

DisplayXslt

Specify an externalXSLT file to render the control.
Bydefault, the control usesproduct.xsl. This
file is located in
<SiteRoot>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly
recommended that youmake a copy, change its
name andmove it outside your site’sWorkarea
folder. If youmake changes to this file and do not
move it out of theWorkarea folder, this file and the
changeswill be lost when you upgrade.

See Also: TheOverrideXslt and DisplayXslt
Propertieson page 17-155

String

DoInitFill

By default, Fill occurs during the Page_Init event.
Set to false if you want to postpone the fill-action
until later. In this case, FIll is automatically called
during the Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

DynamicParameter

TheQueryString parameter namewhich is used
to read the product ID. For example, if your
QueryString parameter for products is ID, enter
that in this property. Then, when site visitors views
a product’s details, the product’s ID is passed to
this control.

String

Hide

Used to hide the control in design time and run
time.

True =Hide the control

False =Show the control

Boolean
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Property Description Data Type

ImageGallery

Determine if the image gallery is displayed along
with a product’s information. Images that appear
in the gallery are set in theWorkarea’sMedia tab
when creating or editing a product. TheGallery
Displayproperty for each image on theMedia tab
must be set to Yes.

Note: To set imageson theMedia tab,
thumbnail informationmust be defined on the
Media Defaults tab at the Product Type level.
See Also:Media Defaults Tab on page 17-109

Choicesare:

List =displaygallery images

None =hide gallery images

In the ImageGallery, imagesare displayed at their
smallest size. If a site visitor clicks an image, a full
size version is displayed.

See Also: ImageGalleryon page 17-148

ImageGalleryType

Language
Set a language for viewing product information.
This property shows results in design-time (in
VisualStudio) and at run-time (in a browser).

Integer

OverrideXslt

Specifies an XSLT identified in the Edit Product
Type Configuration screen. See Also: The
OverrideXslt and DisplayXslt Propertieson the
facing page.

Integer

ShowAddToCart

Set to true if you want to theAdd to Cart button to
appear. The default is True. See Also:Add to Cart
button on page 17-148

Setting this property to false allowsyou to show
details of a product, but not offer it for sale. For
example, you have a product that is no longer for
sale, but you want to allow people who purchased
the product to view its details.

Also, byusing code behind to dynamically set the
property, you could create code that looksat your
inventory system and hides the button depending
on whether a product is in stock.

You could also accomplish this for a specific
product by removing the check from the Buyable
propertywhen creating or editing a product in the
Workarea.

Boolean
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Property Description Data Type

SuppressWrapperTags

Suppresses the output of the span/div tags
around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

Stylesheet
Specify the location of a style sheet to use for the
product page. Set the location relative to the site
root folder.

String

TemplateCart

Enter the URL path of the template that contains
the Cart server control. This path can be relative
or absolute. See Also:Cart Server Controlon
page 17-8 andUsing the Add to Cart Button with
Aliasing on page 17-148.

String

The OverrideXslt and DisplayXslt Properties
The DisplayXslt property is optional. If used, it specifies an external XSLT
file. If the DisplayXslt property is not defined, the OverrideXslt property
specifies an XSLT identified in the Edit Product Type screen. The following table
provides more information about these properties.

TheOverrideXslt and DisplayXslt Properties
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To use this display XSLT
Enter this value for
DisplayXslt

Enter this
value for
OverrideXslt

The default XSLT specified in the Edit Smart Form
Configuration screen (illustrated below). Note that, in
this example, the XSLT Packaged option is the default
XSLT, since it is selected.

XSLT Packaged is the XSLT from the Edit Smart
Form Configuration screen (that is, the XSLT created
in the Data Designer).

0

XSLT 1 from the Edit Smart FormConfiguration screen 1

XSLT 2 from the Edit Smart Form Configuration
screen

2

XSLT 3 from the Edit Smart Form Configuration
screen

3

An absolute or relative path to an XSLT file.

An externalXSLT file not
specified in the Edit
Product Type
Configuration screen.
For example

sample.xslt

doesnot matter -
if XSLT value
exists,
OverrideXSLT is
ignored

Product List Server Control
The ProductList Server control displays a list of products on a Web page.
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Note: Private catalog entries appear in display of the Product List server control only if the
user is logged in and has at least Read-Only permissions for its catalog folder. See Also:
Private Content on page 7-184

You decide which products appear by selecting a SourceType and populating
either the SourceId or the IdList property, depending on the source type.
You can choose from these source types.

This section also contains the following topics.

Source Type Table 17-158
Sorting the Product List 17-158
Flow of the ProductList Server Control 17-159
ProductList Server Control Properties 17-159
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Source Type Table

If you want to display
Set the
SourceType
property to

In the SourceId
property, enter

In the IdList property,
enter

All products for a selected
catalog Catalog The ID of the

catalog

All products across
multiple catalogs CatalogList A comma separated list of

catalog IDs

All products for a selected
taxonomy Taxonomy The ID of the

Taxonomy

All products across
multiple taxonomies TaxonomyList A comma separated list of

taxonomy IDs

All products for a selected
collection Collection The ID of the Col-

lection

Displaya list of products IdList A comma separated list of
product IDs

Sorting the Product List
The ProductList server control allows a site visitor to sort by:

n Title

n SKU

n Price High to Low

n Price Low to High

n Highest Rated

n Lowest Rated and Most Ratings

You can set the default sort order by setting the SortMode property.

For the Highest Rated, Lowest Rated and Most Ratings sorting options to work
as intended, ContentReview server control should be associated with each
product. (See Also: ContentReview Server Control on page 7-732) This allows
site visitors to rate your products.

For example, place a ContentReview control on the Master page of the template
that display products, and set its DynamicParameter property to ID. Then, when
site visitors view the product, they can rate and comment on it.
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Flow of the ProductList Server Control
There are several ways site visitors might arrive at the ProductList server
control, such as

n when a list of products appears on the side of a page

n through a link in a master page

n when they click the Continue Shopping button on the Cart or
Checkout server control.

ProductList Server Control Properties
The following table explains the properties of the ProductList server control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated
Indicates if you are logged in to the CMSExplorer
and can use it to browse to Content, Collections, etc. See Also:Using CMS
Explorer to Browse Your Ektron CMS400.NET Site on page 24-8

String

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0
(zero). This is the amount of time, in seconds, a control’s data is cached. For
example, if you want to cache the data for fiveminutes, set the
CacheInterval property to 300 (three hundred). See Also:Caching with
Server Controlson page 24-33

Double

CustomXml

(Code BehindOnly)

Providesamechanism to inject customXML into the generated XML before
being processed by the XSLT. The injected XML is appended to the end of the
XML produced by this control.

See Also:Displaying CustomXML in Ektron’sServer Controlson page 24-38

String
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Property Description Data Type

DisplayXslt

Specify an externalXSLT file to render the control. Bydefault, the control uses
ProductList.xsl. This file is located in
<SiteRoot>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly recommended that you
make a copy, change its name andmove it outside your site’sWorkarea folder.
If youmake changes to this file and do not move it out of theWorkarea folder,
this file and the changeswill be lost when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you want to
postpone the fill-action until later. In this case, FIll is automatically called during
the Page Render event.

Youmight do this if you need to set or change a property on the control in
codebehind and have it render with your changes shown.

Boolean

DynamicParameter
Sets the QueryString parameter to read a source’s ID dynamically. For
example, if your QueryString parameter for a source ID isSID, enter that. See
Also:SourceId on page 17-162.

String

GetAnalyticsData

Set to true if you want the average ratings for this product to appear within
the product display, as shown below. (Notice the stars below the price of the
item.)

Below the rating (shown asone through five stars) is a number indicating how
manysite visitors have rated the product.

Note: For more information on letting customers rate your products, see
ContentReview Server Controlon page 7-732.

Warning! This property only provides reliable data when the Business
AnalyticsFeature is on.Enabling the BusinessAnalyticsFeature on page 7-
748.

Boolean

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

IdList
Enter a comma separated list of IDswhen the SourceTypeproperty is set to
IdList, TaxonomyList or CatalogList. See Also:Source Type Table on page
17-158

String

Language Set a language for viewing a product list. This property shows results in
design-time (in VisualStudio) and at run-time (in a browser). Integer
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Property Description Data Type

LoadingImage

The image to displaywhile the Product List is loading.

The default is<siteroot>\Workarea\images
\application\ajaxloader_circle_lg.gif.

String

OrderBy

(SortMode property
must be set toNone)

For further definition of the values shown here, see the entryProperty
enumeration in theAPI documentation. Documents are located at this
URL: http://www.ektron.com/documentation

AverageRating

CatalogId

CollItemsDisplayOrder (only available if SourceTypeproperty =Collection)

ContentStatus

CurrencyId

EndDate

EntryType

GoLIve

Html

Id

IsArchived

IsBuyable

IsPublished

LanguageId

LastEditDate

LastEditorFirstName

LastEditorLastName

ListPrice

Media

NumberRated

ProductTypeId

SalesPrice

Sku

Status

Summary

TaxClassId

TaxItemsDisplayOrder (only available if SourceTypeproperty =Taxonomy)

Title

ViewCount

PageSize

Specify the number of items to show per page when a site visitor views the
product list. If the number of itemsexceeds the quantity defined in this
property, the list is paged and the site visitor can use the paging navigation
system tomove through the list.

Integer
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Property Description Data Type

PageSpan

The number of pages to show before and after the current page. Enter zero to
show all pages.

For example, if you set this property to 2 and you are on page four of the
product list, you see:

Integer

SortMode

Select the default way the product list is sorted when a site visitor first views the
page. Once the page is loaded, a site visitor can change the sort via a drop
down list. Choicesare:

Title - sorts in alphabetical order.

SKU - sorts by the product number. This number is typically a unique number
supplied by the producer of the product.

Price Descending - sorts byprice from highest to lowest.

Price Ascending - sorts byprice from lowest to highest.

Highest Rated - sorts by rating from highest to lowest.

Lowest Rated - sorts by rating from lowest to highest.

Most Rated - sorts byproducts that havemost ratings from highest to lowest.

None - Use this setting to useOrderByproperty.

See Also:Sorting the Product List on page 17-158

SortModes

SourceId

The ID of the catalog, collection or taxonomy that is being used asa product
list. This property is used when the SourceTypeproperty is set toCatalog,
Collection or Taxonomy.

See Also:Source Type Table on page 17-158

Integer
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Property Description Data Type

SourceType

The type of source being used to create the list. Choicesare:

Catalog - use the SourceIdproperty to specify the ID of a single catalog
when this source type is selected.

CatalogList - use the IdListproperty to specify a list of catalog IDswhen
this source type is selected.

Taxonomy - use the SourceIdproperty to specify the ID of the single
taxonomywhen this source type is selected.

TaxonomyList - Use IdList property to specify a list of taxonomy IDs
when this type is selected.

IdList - Use the IdListproperty to specify a list of product IDswhen this
source type is selected.

Collection - use the SourceIdproperty to specify the ID of a collection
when this source type is selected.

See Also:Source Type Table on page 17-158

SourceObjectType

Stylesheet Specify the path to a style sheet for use with this server control. The location
can be relative or absolute. String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The default is
False.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TaxonomyDepth

Enter the number of taxonomy levels to retrieve below each
taxonomy/category. Only the top level is displayed in the control. The rest of
the levels are available through XML in code behind. For example, if the
taxonomy isDVDs > Movies > Comedies, and you set Taxonomy Depth to
2, onlyDVDsandMoviesare available in code behind.

To retrieve all categories for a taxonomy recursively, enter -1.

A depth greater than 1 or using -1 is only useful if you create a custom output
using the Taxonomy’sXML.

The default value is 1.

For a live site, Ektron strongly recommends leaving this value at 1. Increasing
this value can slow down your liveWeb server. However, for testing on a
staging server, you can increase the depth.

Integer

TemplateProduct Specify the URL that contains the Product server control. This allowsa site
visitor to see the details of the product when the product link is clicked. String

ProductSearch Server Control
The ProductSearch server control allows site visitors to search for products on
your site. Products are the same as catalog entries in the Workarea. For an
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eCommerce site, the ability to find products or services on your site is key to
generating more sales.

The ProductSearch server control is based on Ektron’s WebSearch server
control. Products are similar to content, and information about them is stored in
Ektron’s Indexing Catalogs. This provides extremely fast results without
impacting the load on your database.

For information on how the Indexing Service works with search, see The
Catalog and Index Files on page 9-7.

Note:While the ProductSearch server control is based on the WebSearch server control, some
functionality described in Searching Your Web Site on page 9-5 does not apply to the
ProductSearch server control. For example, the ProductSearch only searches for products
added to a Catalog in the Workarea. It does not find images, documents or multimedia.

When you place a ProductSearch server control on a Web page, and a site
visitor browses to it, he sees the following.

The control is divided into two sections:

n Basic Search (shown above)

n Advanced Search (access this by clicking the Advanced Search tab
from the Basic Search screen)

Basic Search
The Basic Search finds content that satisfies these criteria.

n published

n active (archived content is ignored)

n its Searchable check box is checked. See Also: The Content
Searchable Field on page 17-166.

n public. However, private content is available to those with permission
to view it, such as membership users after logging in. See Also:
Private Content on page 7-184

n resides in the CMS catalog specified in the ProductSearch server
control’s CatalogId property, or in one of that folder’s subfolders if
the control’s Recursive property is set to true

n satisfies text and/or query entered in the search box (no value
returns nothing)
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- The text inserted in the search field can appear in the content or
metadata

Searching Multiple Terms
If a site visitor enters several terms, the search only returns pages that include
all terms. This is known as an ‘and’ relationship. For example, if the site visitor
enters cancer and cure in the Search box, only content that includes both terms
(and satisfies the other criteria) appears.

Ektron uses an ‘and’ relationship because we believe it’s what a site visitor
expects. Consider a simple Google search – the more you enter into the Google
Search text box, the fewer results you get, since your phrase is more precise.

The advanced search screen, on the other hand, lets the site visitor determine
if he wants an and, or, not, or exact phrase relationship.

Advanced Search
The Advanced Search uses nearly all the same search criteria as the Basic
Search. See Also: Basic Search on previous page.

The differences are additional options and filters (explained below) and the fact
that you cannot use queries.
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Advanced Search Options

Search
Option

Finds these pages

with all of the
words

Web pagemust include all submitted terms; their position on the page doesnot matter.

You cannot enter queries into this field.

advanced
search exact
phrase

Web pagemust include the exact phrase. For example, if you enter Large RoundWindow,
a page with the term Large Round Tinted Window is not found because it is not an exact
match.

at least one
of the words Web page can include anyone of the submitted terms.

without the
words

Web page contains none of the submitted terms.

Only use this option if you also reply to one of the three fields above.

Advanced Result Filters
Below the Advanced Search Options is a list of additional fields you can use to
refine the search. These are titled Filter Results.

Result
Filter

Prompts site visitor to enter

Price
Below

the highest price for which a site visitor iswilling to search. This is based off of a product’sSale Price
not its List Price.

Price
Above

the lowest price for which a site visitor iswilling to search. This is based off a product’sSale Price
not its List Price. For example, if you are searching for a product above $350.00, products that lists
for $400.00 and are on sale for $300.00 do not show up in the results.

Product
SKU

the StockKeeping Unit for product. This information is set on the product’sProperties tab in the
Workarea. See Also:Entering a Catalog Entry’sPropertieson page 17-131

To add a filter, click Add Filter. To remove a filter, click Remove to the right of
the filter.

The Content Searchable Field
Each content item includes a Content Searchable field. The search only
considers catalog entries whose field is checked. See illustration below.
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By default, this field is checked when a product is created.

Display of Search Results
Below is an example of the ProductSearch server control’s results page. You
can customize it through the use of XSLTs and CSS files.

Optionally, below the search box, a Filter by Category link can appear. When
you set the ShowCategories property to True, a site visitor can click it to see a
folder structure of taxonomy categories. He can then select categories of
interest. When he does, only products that include the search term and which
are assigned to the selected categories appear.

Display of Search Results
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Note: Filtering by category works the same way as in the WebSearch server control. See the
section Filtering Search Results by Category on page 9-84 in that chapter for additional
information.

Query Language
Searching by Query Language is described in Query Language on page 9-62.
This functionality works the same for product searches as it does for Web
searches except for properties related to documents, images and multi-media.
Instead, the following properties can be queried for products.
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Product Search Query Properties Table

Property Descriptions Example Results

edescription

Searchesonly the description of a product for the
matching text.

The description of a product is set in theContent
tab’s editor for a product in theWorkarea. See Also:
Step 2: Creating the Content Page on page 17-120

@edescription
chair

Productswith
“chair” in the
description.

eheight

Searchesbased on the height of a product.

The height of a product is set on the product’s
Properties tab in theWorkarea. See Also:Entering
a Catalog Entry’sPropertieson page 17-131

@eheight = 40

@eheight > 40

@eheight < 40

Products that
have a height
equal to 40
inchesor
centimeters.

Products that
have a height
greater than 40
inchesor
centimeters.

Products that
have a height
less than 40
inchesor
centimeters.

eimage

Searchesbased on an image name associated with
a product; for example, chair.jpg.

Imagesare associated with a product when they
are added to a product’sMedia tab in the
Workarea. See Also:Entering a Catalog Entry’s
Media on page 17-139

@eimage
chair.jpg

Productswith an
associated
“chair.jpg”
image.

elength

Searchesbased on the length of a product.

The length of a product is set on the product’s
Properties tab in theWorkarea. See Also:Entering
a Catalog Entry’sPropertieson page 17-131”

@elength = 15

@elength > 15

@elength < 15

Products that
have a length
equal to 15
inchesor
centimeters.

Products that
have a length
greater than 15
inchesor
centimeters.

Products that
have a length
less than 15
inchesor
centimeters.
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Property Descriptions Example Results

elistprice

Searchesbased on the list price of the product.

The list price for a product is set on the product’s
Pricing tab in theWorkarea. See Also:Entering a
Catalog Entry’sPrice Information on page 17-133

@elistprice =
299.00

@elistprice >
299.00

@elistprice <
299.00

Products that
have a list price
equal to 299.00.

Products that
have a list price
greater than
299.00.

Products that
have a list price
less than
299.00.

ereorderlevel

Searches for a product based on its reorder level.

The reorder level for a product is set on the
product’sProperties tab in theWorkarea. See
Also:Entering a Catalog Entry’sPropertieson page
17-131

@ereorderlevel
= 125

@ereorderlevel
> 125

@ereorderlevel
< 125

Products that
have a reorder
level equal to
125.

Products that
have a reorder
level greater
than 125.

Products that
have a reorder
level less than
125.

esaleprice

Searchesbased on the sale price of the product.

The sale price for a product is set on the product’s
Pricing tab in theWorkarea.See Also:Entering a
Catalog Entry’sPrice Information on page 17-133

@esaleprice =
249.00

@esaleprice >
249.00

@esaleprice <
249.00

Products that
have a sale price
equal to 249.00.

Products that
have a sale price
greater than
249.00.

Products that
have a sale price
less than
249.00.

eskunumber

Searchesbased on the StockKeeping Unit for
product.

This information is set on the product’sProperties
tab in theWorkarea. See Also:Entering a Catalog
Entry’sPropertieson page 17-131”

@eskunumber
52-154

Products that
have amatching
SKU.
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Property Descriptions Example Results

eunitsinstock

Searches for a product based on its level of units in
stock.

The units in stock for a product is set on the
product’sProperties tab in theWorkarea. See
Also:Entering a Catalog Entry’sPropertieson page
17-131

@eunitsinstock
= 63

@eunitsinstock
> 63

@eunitsinstock
< 63

Products that
have a unit stock
level equal to 63.

Products that
have a unit stock
level greater
than 63.

Products that
have a unit stock
level less than
63.

eunitsonorder

Searches for a product based on the amount of
units on order.

The amount of units on order for a product is set on
the item’sProperties tab in theWorkarea. See
Also:Entering a Catalog Entry’sPropertieson page
17-131

@eunitsonorder
= 30

@eunitsonorder
> 30

@eunitsonorder
< 30

Products that
have an on
order level equal
to 30.

Products that
have an on
order level
greater than 30.

Products that
have an on
order level less
than 30.

eweight

Searchesbased on the weight of a product.

The weight of a product is set on the product’s
Properties tab in theWorkarea.See Also:Entering
a Catalog Entry’sPropertieson page 17-131”

@eweight = 45

@eweight > 45

@eweight < 45

Products that
have a weight
equal to 45 units.

Products that
have a weight
greater than 45
units.

Products that
have a weight
less than 45
units.

ewidth

Searchesbased on the width of a product.

The width of a product is set on the product’s
Properties tab in theWorkarea. See Also:Entering
a Catalog Entry’sPropertieson page 17-131

@ewidth = 7

@ewidth > 7

@ewidth < 7

Products that
have a width
equal to 7 inches
or centimeters.

Products that
have a width
greater than 7
inchesor
centimeters.

Products that
have a width less
than 7 inchesor
centimeters.
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The Add to Cart Link in a Search Result
Site visitors can add a product to their cart directly from the search results by
clicking an Add to cart link in a search result. This link appears below the price
and allows them to skip the product’s information page and add the product
directly to their cart.

By default, this link appears when the following conditions are met:

n The product is a simple product, kit or bundle. The link does not
appear for complex product types. In complex product types, site
visitors must select one variation of a product. For example, you are
selling movies and the site visitor needs to select between either DVD
or Blue-Ray format.

n The product is buyable. That is, there is a check mark in the Buyable
property for a product in the Workarea. See Also: Entering a Catalog
Entry’s Properties on page 17-131

n The product has an In Stock quantity of at least one.
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n The TemplateCart property has a cart’s template location defined.

Property Usage Table
Properties in the ProductSearch server control generally affect the control in
one of three ways:

n Search Display - the ProductSearch server control’s appearance on
your site.

n Search Criteria - criteria used to search the site

n Search Results Display - appearance of search results on your site

The following table shows which properties are associated with each category.
See Also: ProductSearch Server Control Properties on next page

Search Display Search Criteria Search Results Display

ButtonImgSrc

ButtonText

EnableAdvancedLink

Hide

Language

MaxCharacters

TextBoxSize

CatalogId

Language

Recursive

ShowCategories

TaxonomyOperator

CustomOrderBy

CustomXml

DisplayXslt

Hide

Language

LinkTarget

LoadingImage

MaxTeaserLength

OrderBy

OrderDirection

ResultsPageSize

ResultTagId

ShowCustomSummary

ShowSearchBoxAlways

Stylesheet

SuppressWrapperTags

TemplateCart

TemplateProduct
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Flow of the ProductSearch Server Control
The following image depicts the flow of the ProductSearch Server Control.

ProductSearch Server Control Properties
The following table explains the properties of the ProductSearch control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer
and can use it to browse to Content, Collections, etc.
See Also:Working with Ektron CMS400.NET Server
Controlson page 24-1

String

ButtonImgSrc If you want to display an image on theSubmit button,
enter the server path to it. String

ButtonText
The text used for theSubmit button if no image source
is identified. If an image source is identified, this is
alternative text for the button.

String
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Property Description Data Type

CatalogId

The catalog at which the search begins. The starting
folder need not be the root folder.

The Recursive property determines if the search
examines this folder’s subfolders. See Also:Working
with Ektron CMS400.NET Server Controlson page
24-1

String

CustomOrderBy

Provide a property’s FriendlyName defined in the
Indexing Service to sort search results by that property.

Results can be ascending or descending based on
OrderDirection. If you enter an invalid property, no
search results are returned.

If you specifyCustomOrderBy and OrderBy, the
OrderByproperty is ignored. The FriendlyName of a
property can be found inComputer Management >
Services and Applications > Indexing Service >
Your Index >Properties >Friendly Name column.

String

CustomXml

(Code BehindOnly)

Providesamechanism to inject customXML into the
generated XML before being processed by the XSLT.
The injected XML is appended to the end of the XML
produced by this control. See Also:

Displaying CustomXML in Ektron’sServer Controlson
page 24-38

String

DisplayXslt

Specify an externalXSLT file to render the control. By
default, the control usesProductSearch.xsl.
This file is located in
<SiteRoot>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly
recommended that youmake a copy, change its name
andmove it outside your site’sWorkarea folder. If you
make changes to this file and do not move it out of the
Workarea folder, this file and the changeswill be lost
when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to
false if you want to postpone the fill-action until later. In
this case, FIll is automatically called during the Page
Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

DynamicProductParameter

TheQueryString parameter namewhich is used to
pass the product ID to the product details page. For
example, if your QueryString parameter for products is
ID, enter that in this property. Then, when site visitors
click a product in their search results, this parameter is
passed with the product’s ID to the product details
page.

String
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Property Description Data Type

EnableAdvancedLink

Set to True to display anAdvanced Search tab on the
ProductSearch control.

Boolean

Hide

Used to hide ProductSearch Server Control in design
time and runtime.

True =Hide control

False =Show control

Boolean

Language

If the template on which this server control resides
includesa language selection control, and you want to
let the site visitor select the language, enter zero (0).

Otherwise, click the field, then the ellipsis button ( )
and a popup boxappears. Select a language from the
list.

This property shows results in design-time (in Visual
Studio) and at run-time (in a browser).

Integer

LinkTarget

Defineshow a link on the search results display acts
when clicked. The choicesare:

_blank - loads the link in a new blankwindow. This
window is not named.

_self - loads the link in the samewindow the anchor
was clicked in. This is useful for overriding a globally
assigned base target.

_parent - loads the link in the immediate frameset
parent of the document. This defaults to acting like “_
self” if the document hasno parent.

_top - loads the link in the full bodyof the window. This
defaults to acting like “_self” if the document is already
at the top. It is useful for breaking out of an arbitrarily
deep frame nesting.

String

LoadingImage

The image to displaywhile the product search is
loading.

The default isajaxloader_circle_lg.gif.

This file is located in:<siteroot>
\Workarea\images\application

String

MaxCharacters

Themaximum number of characters theSearch text
boxaccepts.

If you enter a value less than 50, set the TextBoxSize
property to the same number.

Integer
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Property Description Data Type

MaxTeaserLength

Limits the length of any returned content’s abstract. To
allow unlimited length, set to zero.

This property is active only if both of these conditions
are true.

You usethe DisplayXsltproperty to identify an
XSLT andecmteaser asa value of that property.

the ShowCustomSummaryproperty is set to false. If
ShowCustomSummary is set to true, the entire
summaryappears in search results.

Integer

OrderBy

The order of search results. For example, you want to
sort search results by last modified date.

Note: TheOrder Direction field determines the
direction of the search results. For example, if you sort
by ID andOrderDirection is set toDescending, the
results sort byContentID number with the highest
number at the top of the list.

String

OrderDirection

The direction in which search results are sorted. The
default isAscending.

Ascending - Alphabetical results from A to Z; numeric
values low to high; dates from oldest to most recent

Descending - Alphabetical results from Z to A;
numeric valueshigh to low; dates frommost recent to
oldest

String

Recursive
Set to True to search sub-folders of the starting folder.
The starting folder is identified in the CatalogID
property.

Boolean

ResultsPageSize

Set themaximum number of results on a page. If a
search returnsmore than this number of results, the
following text appears below the last one:

Result Page: 1 2 3 Next

The site visitor can clickNext or a number to view
additional results.

This property defaults to the value set at the ek_
PageSize element in the web.config file.

Integer

ResultTagId

Lets you designate where search results appear. You
can place search criteria in one area of aWeb form and
the results in another.

For example, you have the following tag.

<span id=”results”></span>

In this case, enter results for this property value.

Additional information can be found in theWebSearch
server control sectionResultTagId on page 9-83.

String
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Property Description Data Type

ShowCategories

If set to true, when this server control appears, the site
visitor see a Filter by Category option. This option
helpsa site visitor zero in on relevant content.

If false, the Filter by Category option doesnot
appear.

Note: To see the Filter by Category option, the
ShowSearchBoxAlwayspropertymust be set to
true.

See Also: Filtering Search Results byCategoryon
page 9-84

Boolean

ShowCustomSummary

If set to true, the search results display the content
item’s summary instead of the characterization.

Note: If this property is set to true, the
MaxTeaserLengthproperty is ignored. So, the entire
summaryappearswith search results, regardlessof
length.

If false, the search results display the characterization.

The default is false.

See Also:Displayof Search Resultson page 17-167

Boolean

ShowSearchBoxAlways

If set to true, the search boxappears on the PostBack
screen.

If false, the search boxdoesnot appear on the
PostBack screen.

The default is true.

Boolean

Stylesheet

Specify the location of a style sheet to use for the
search results page. Set the location relative to the site
root folder. For example:
Workarea\csslib\mytest.css

String

SuppressWrapperTags

Suppresses the output of span/div tagsaround the
control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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Property Description Data Type

TaxonomyOperator

Select whether to use anAnd orOr operator when
filtering results by taxonomy. Bydefault, the property is
set toOr. This allows for a wider range of returned
results.

And - Only results that match all categories selected in
the Filter byCategory tree appear. For example, if you
are searching for amedical document in the Hospital
and Doctor’sOffice categories, the document must be
assigned to both categories or it is not shown.

Or - whenmore than one category is selected in the
Filter byCategory tree, resultsmust match at least one
category to be shown.

Note: For this property to be active, the
ShowCategoriespropertymust be set to True.

See Also: Filtering Search Results byCategoryon
page 9-84

Enum -
TaxCategoryOperator

TemplateCart

Controlswhether theAdd to Cart link appearswith
search results. Enter the URL path of the template that
contains the Cart server control. This path can be
relative or absolute.

See Also: The Add to Cart Link in a Search Result on
page 17-172 andCart Server Controlon page 17-8.

String

TemplateProduct

Specify the URL that contains the Product server
control. This allowsa site visitor to see the details of the
product when the product link is clicked. This path can
be relative or absolute.

String

TextBoxSize The size of theSearch text box for user input. The
width is based on the number of characters. Integer
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eCommerce Analytics
The eCommerce Analytics screen provides a visual display of order information
for a selected catalog entry.

n The top left section graphs the quantity of this catalog entry ordered
over the past seven days

n The top right charts the number of orders that used a coupon versus
the number that did not

n Below that pie chart is another that shows the number of returning
customers versus the number of new ones

n The lower part of the screen shows the following order information

- order number

- date/time when order was entered

- site from which order was entered

- order status

- customer information: new or returning, name, number of orders
entered, value of all orders entered, average order monetary value

- order monetary value

- whether or not a coupon was used
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eCommerce
Recommendations

Adding Cross Sell and Upsell
Recommendations to a Catalog Entry
Cross sell and upsell tactics are designed to increase the amount of cart sales.

Cross sell offers items related to a catalog entry. So, for example, if someone
is purchasing a digital camera, cross sell items might be a carrying bag, digital
photo printer, larger memory cards, additional warranty, etc.

Up Sell refers to similar but more expensive items. So, for example, if
someone is viewing a 7 megapixel digital camera, upsell items might be a 10
megapixel camera, or a digital SLR camera.

The following sections explain how to assign cross sell and up sell items to any
catalog entry, and how to display those options on your Web site.

See Also:

n Assigning Cross Sell and Upsell Items to a Catalog Entry below

n Displaying Cross Sell and Upsell Items on Your Web Site on next
page

Assigning Cross Sell and Upsell Items to a
Catalog Entry

1. Open the catalog folder containing the catalog entry to which you
want to assign cross sell items.

2. Click that entry.

3. Click View > Cross Sell or Up Sell.
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4. Click the Add button ( ).
5. A screen displays all catalog folders.

6. Open the folder that contains the cross sell or upsell catalog entry.

7. Click that catalog entry.

8. Press OK.

9. Enter additional cross sell entries as needed.

10. Click Action > Save.

Displaying Cross Sell and Upsell Items on
Your Web Site
Use the Recommendation server control to place cross sell or upsell items
anywhere on a Web page. A single control can only show either cross sell or
upsell items.

See Also: Recommendation Server Control on the facing page

Conducting eCommerce with Ektron CMS400.NET

17-182 ReferenceManual
Version 8.01 Rev 4



Recommendation Server Control
Prerequisite: Cross sell or upsell products have been assigned to a catalog
entry. See Also: eCommerce Recommendations on page 17-181

The Recommendation server control allows you to cross-sell or up-sell products
to a site visitor based on another product’s ID. After a user creates a product in
the Workarea, he can define a list of other products he wants to associate with
the newly-created product. This can be done while viewing a product in the
Workarea and selecting the View menu > Cross Sell or Up sell. Then, by adding
the Recommendation server control to a Web form that contains a Product
server control, the site visitor sees the recommendations when he views the
details of the product.

Typically, this control appears on a page along with a “Product server control.”
By using this control in conjunction with the Product control, a site visitor can
view the details of a product and also receive suggestions on additional
purchases. A site visitor can click the title to view the suggested product to
view its details.

For example, if your site is selling a hat, mitten and scarf set, you might use
this server control to cross-sell winter jackets. You could also use the control to
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up-sell a more expensive hat, mitten and scarf set, or a set that includes
additional items.

For information on adding cross sell and upsell information to a product in the
Workarea, see Adding Cross Sell and Upsell Recommendations to a Catalog
Entry on page 17-181”.

Setting the RecommendationType property determines whether the
Recommendation server control is used for up-selling or cross-selling.

This section also contains the following topics.

Enabling the Add to Cart Button 17-184
Recommendation Server Control Properties 17-185

Enabling the Add to Cart Button
Site visitors can add a product to their cart directly from the Recommendation
server control by clicking an Add to cart button next to a product. This link
appears below the price and allows them to skip the product’s information page
and add the product directly to their cart.

By default, this button appears when the following conditions are met:

n The product is buyable. That is, there is a check mark in the Buyable
property for a product in the Workarea. See Also: Buyable on page
17-132
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n The product has an In Stock quantity of at least one.

n The TemplateCart property has a cart’s template location defined.

In addition, when a product has an alias path associated with it, you need to do
the following:

n Make sure the TemplateCart property’s path is relative to the site
root. For example:

TemplateCart="Developer/Commerce/CartDemo.aspx"

n Add the following to the code behind page. This example is in C#:

protected void Page_Init(object sender, EventArgs e)

{

Utilities.RegisterBaseUrl(this.Page);

}

Recommendation Server Control Properties
The following table explains the properties of the Recommendation control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.
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Property Description Data Type

Authenticated

Indicates if you are logged in to the
CMSExplorer and can use it to browse to
Content, Collections, etc. See Also: ”Using CMS
Explorer to Browse Your Ektron CMS400.NET
Site” on page 21-12

String

CacheInterval

Sets the amount of time the server control’s data is
cached. The default is 0 (zero). This is the amount
of time, in seconds, a control’s data is cached. For
example, if you want to cache the data for five
minutes, set theCacheInterval property to
300 (three hundred). See Also: ”Caching with
Server Controls” on page 21-42

Double

CustomXml

(Code BehindOnly)

Enter a string of XML that you want to make
available to the XSLT. This property providesa
mechanism to inject customXML into the
generated XML before being processed by the
XSLT. The sting is added inside the CustomXml
tag as follows:

<root><customXml>custom-xml-inserted-
here</customXml></root>

See Also: ”Displaying CustomXML in Ektron’s
Server Controls” on page 21-49

String

DefaultProductID

Enter a default product ID that contains either
cross sell or up sell products. Tomake the server
control dynamic, enter zero (0) in this property
and set theDynamicProductParameter to
QueryString parameter used to pass the product’s
ID.

Integer

DisplayXslt

Specify an externalXSLT file to render the control.
Bydefault, the control uses
Recommendation.xsl. This file is located in
<SiteRoot>\Workarea\Xslt\Commerce

Warning! If you want to edit this file, it is strongly
recommended that youmake a copy, change its
name andmove it outside your site’sWorkarea
folder. If youmake changes to this file and do not
move it out of theWorkarea folder, this file and
the changeswill be lost when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event.
Set to false if you want to postpone the fill-action
until later. In this case, FIll is automatically called
during the Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean
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Property Description Data Type

DynamicCartParameter

The QueryString parameter name which is
used to pass the product ID to the Cart
server control. For example, if your
QueryString parameter for products is
Product, enter that in this property. Then,
when site visitors click the Add to Cart
button, this parameter is passed with the
product’s ID Web form containing the Cart
server control. See Also: Cart Server
Control on page 17-8

String

DynamicProductParameter

TheQueryString parameter namewhich is used
to pass the product ID to the product details page.
For example, if your QueryString parameter for
products is ID, enter that in this property. Then,
when site visitors click a product’s title, this
parameter is passed with the product’s ID to the
product details page.

String

Hide

Used to hide the Server Control in design time and
runtime.

True =Hide control

False =Show control

Boolean

Language

If the template on which this server control resides
includesa language selection control, and you
want to let the site visitor select the language,
enter zero (0).

Otherwise, click the field, then the ellipsis button (

) and a popup boxappears. Select a
language from the list.

This property shows results in design-time (in
VisualStudio) and at run-time (in a browser).

Integer

PageSize

Specify the number of items to show per page
when a site visitor views recommendations. If the
number of itemsexceeds the quantity defined in
this property, the list is paged and the site visitor
can use the paging navigation system tomove
through the list.

Integer
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Property Description Data Type

RecommendationType

The type of recommendation to show. Choicesare:

n CrossSell - used to help sell additional products that a site visitor might be
interested in. For example, if you are selling Denim Jackets, youmight want to
cross sell them pants or shirts.

n UpSell - used to sell additional products that improve on the product being
purchased. For example, if you are selling 7megapixel digital cameras, you
might want show the site visitor 10megapixel digital cameras.

See Also:Adding CrossSell and UpsellRecommendations to a Catalog Entry
on page 17-181

Data Type: EkEnumeration.RecommendationType

Stylesheet

Specify the location of a style sheet to use for the
recommendation. Set the location relative to the
site root folder. For example:
Workarea\csslib\mytest.css

Leave blank to use the default style sheet.

String

SuppressWrapperTags

Suppresses the output of span/div tagsaround
the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TemplateCart

The URL to navigate to when the site visitor clicks
theAdd to Cart button. This path can be relative
or absolute.

When a path is entered, theAdd to Cart button
appears next to the product and allowsa site
visitor to add the product directly to their cart. See
Also:Enabling the Add to Cart Button on page 17-
184 andCart Server Controlon page 17-8.

String

TemplateProduct

Specify the URL that contains the Product server
control. This allowsa site visitor to see the details
of the product when the product link is clicked. This
path can be relative or absolute.

String
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eCommerce Order
Management
The fulfillment aspect of eCommerce involves

n tracking submitted orders, including

- order status

- charge capture

- shipping

- cumulative sales information on customers

n customer information, such as

- orders submitted

- addresses

- current shopping carts

This section also contains the following topics.

Orders 17-189
OrderList Server Control 17-196

Orders
The orders screen provides information about all orders in your eCommerce
system. To access it, go to Ektron CMS400.NET Workarea > Settings >
Commerce > Fulfillment > Orders.

Warning! In order to process orders, the Distributed Transaction Coordinator (DTC) Windows
service must be running. It is started by default when you install Ektron CMS400.NET.

eCommerceOrder Management
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Initially, orders are sorted by submission date and time, with the most recent at
the top.

This section also contains the following topics.

Selecting Orders by Criteria 17-190
Order Statuses 17-190
The View Order Screen 17-191
Capturing the Order 17-192
Authorization versus Capture 17-192
The Capture 17-193
Canceling the Order 17-194
Entering a Tracking Number 17-194
Viewing the Tracking Number 17-194
Marking the Order as Fraud 17-195
Marking the Order as Shipped 17-195
Editing an Order’s Billing and Shipping Addresses 17-195
Order Workflow 17-195

Selecting Orders by Criteria
You can select orders by any of the following criteria.

n entry date range

n customer

n catalog entry

To use any filter, click Reporting (see below) then the appropriate filter option.

Note: The Most Recent menu option is the default select and sort order: all orders with the
most recent on top.

See Also: Orders on previous page

Order Statuses
Note: The following table assumes you use the default workflow installed with eCommerce. If
you customize the workflow, the following table may be inaccurate. See Also: Customizing
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Workflows on page 17-239”

Status Description How Set

Received Order hasbeen submitted. Site visitor submits order

Fraud Your organization hasdetermined that
the order is fraudulent.

View Order Screen >ActionMenu >Markas
Fraud

Shipped

Order hasbeen shipped

Note: This status can be the
workflow’s end point. You do not need
to use the Completed status.

View Order Screen >ActionMenu >Ship Order

or

View Order Screen >ActionMenu >Enter/Edit
Tracking Number >CheckMark as Shipped
checkboxand save

Completed All order activities are finalized. No events
can occur to a Completed order.

View Order Screen >ActionMenu >Process
Order

Cancelled Order hasbeen cancelled. View Order Screen >ActionMenu >Cancel
Order

InProcess Automatically assigned when order is
submitted. Order placed but not yet captured

The View Order Screen
To view the details of any order, click it. When you do, the View Order screen
appears. From this screen you may view the following about the order.

n Summary (shown below)

n Status

n Payment

n Coupons

n Address

n Description

n Workflow

The View Order Screen
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Note: If the View Workflow option does not display a flowchart, verify that the server’s
Distributed Transaction Coordinator (DTC) Windows service is running. It is started by default
when you install Ektron CMS400.NET, but if it stops for some reason, the Workflow does not
appear on this screen.

The View Order screen’s Actionmenu has the following options.

n Capture - See Capturing the Order below

n Mark as Fraud - Marking the Order as Fraud on page 17-195

n Edit Tracking Number - Entering a Tracking Number on page 17-194

n Cancel Order - Canceling the Order on page 17-194

You can also edit the order’s billing and shipping addresses. See Editing an
Order’s Billing and Shipping Addresses on page 17-195.

These options are explained below.

Capturing the Order

Authorization versus Capture
Authorization occurs while a customer is using the Checkout server controls. It
submits a customer’s payment information to a payment gateway, bank, or
PayPal, and returns either an approval with an authorization number
(transaction ID) or a decline along with an explanation.

Capture is the process of submitting encrypted order information (including the
transaction ID) to a payment gateway account, bank, or PayPal. At this time,
the account is charged for the order amount.

Note: * In many states, you must ship an item before you can charge a customer’s credit card
for it.
* Items that are not tangible are automatically captured if paid by PayPal or a credit card. See
Also: Tangible Item on page 17-133

Next, you receive confirmation from the paying agency that the money has
been deposited to your account and is available. At this time, you use the Mark
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as Settled option to inform the eCommerce feature that payment has been
received. This changes the order status to Complete.

Payment Method Tangible item Intangible Item

PayPal or credit card When goodsare shipped When customer submits order

Check When check clears When check clears

See Also: Payment Options on page 17-61

The Capture
To capture an order, follow these steps.

1. Workarea > Settings > Commerce > Fulfillment > Orders.

2. Click the order that you want to capture.

3. Click the Payment link (see illustration below).

4. The View Payment screen appears, showing information about the
transaction captured when the site visitor submitted his payment
information.

5. Click Action > Capture.

6. You are asked to confirm the action.

7. Click OK.

TheCapture
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Canceling the Order
Click Action > Cancel Order to stop all processing on the order. If you do,
the order’s status changes to Canceled.

Entering a Tracking Number
When an order is shipped, the shipping provider typically provides a tracking
number to help locate the shipment within the delivery chain. Use the Enter
Tracking Number option to enter this part of the order information.

After entering the tracking number, you can indicate whether the order has
shipped.

Viewing the Tracking Number
You can see an order’s tracking number on the View Order screen, under the
Shipping Address (as illustrated below).
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Marking the Order as Fraud
Use this option if your organization determines that the order is fraudulent.
These orders cannot be processed any further.

Marking the Order as Shipped
To denote that an order has shipped, follow these steps.

Note: If that order has not yet been captured, it will be captured as part of the shipping of the
order.

1. Go to Settings > Commerce > Fulfillment > Orders.

2. Click the order that is being shipped.

3. Click Action > Ship Order.

Alternatively, you can mark the order as shipped while entering its tracking
number. See Also: Entering a Tracking Number on previous page

Editing an Order’s Billing and Shipping
Addresses
To edit an order’s billing or shipping address, click Edit as circled below.

Order Workflow
Ektron CMS400.NET uses Microsoft’s Windows Workflow Foundation to create
and implement order process workflows to handle the ordering process. The
workflow can be as simple or complex as your business requires.

Marking theOrder as Fraud
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For example, you could have a simple workflow that sends one email to the
customer when an order is received, and another to your shipping department.
Or, you could have a more complex workflow that:

n sends an email to the customer when the order is received

n checks to see whether the item is a tangible product or a virtual
product. Then, continues down the workflow path that’s appropriate
for the item.

n handles shipping notifications and updates the account throughout the

n shipping process

n handles the order if it is canceled

n handles the order if it is determined to be fraudulent

n marks the order as complete once all activities are finished

For more information on workflows, see Customizing Workflows on page 17-
239.

OrderList Server Control
The OrderList server control allows site visitors to view a list of processed
orders. Site visitors typically reach this server control by clicking a link on your
site, such as the View Order History link (shown below).

Site visitors can also reach this control is through a link at the end of the
Checkout process. The link appears when the Checkout server control’s
TemplateOrderHistory property contains the path to the template containing
the OrderList server control. See Also: Checkout Server Control on page 17-20.

This section also contains the following topics.

Viewing a Site Visitor’s Orders List 17-196
Viewing an Order’s Details 17-197
Flow of the OrderList Server Control 17-199
OrderList Server Control Properties 17-199

Viewing a Site Visitor’s Orders List
When site visitors arrive at this server control, they see the View All Orders
portion of the server control.
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This part of the server control allows site visitors to view a list of submitted
orders. They can view each order's date, confirmation number and status.
When the number of orders exceeds the number defined in the MaxResults
property, the list is paged and a user can navigate among pages with the links
provided.

A site visitor can click the confirmation number to view the Order Details
screen.

To navigate back to the list of all orders, site visitors click the View All Orders
button.

Viewing an Order’s Details
The order details portion of this control displays the following information.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Viewing anOrder’s Details
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Field Description

Status The statusof the order. See Also:Order Statuseson page 17-190

Order Date The date the order was submitted. This is the date an order went through the checkout
process.

Order
Number The ID number of the order.

Ship To:

Information needed to ship the order to customer. The following information is included in this
area.

Person to which the product is being shipped

CompanyName (optional)

Street Address

City and State or Region

Country

Zip Code

Tracking Number - this field appears if a tracking number hasbeen entered in the View Order
screen in theWorkarea.See Also:Entering a Tracking Number on page 17-194

Bill To:

Displays information about who is being billed for the order.

Person paying for the order

Credit Card information - For security purposes, only the last four digits appear.

CompanyName (optional)

Street Address

City and State or Region

Country

Zip Code

Description A list of products in the order.When the path to the product server control is entered in the
TemplateProduct property, the product’s title becomesa hyperlink.

Quantity The total number of each product.

Sale Price The per unit price of each product.

Total The total amount paid for each product ordered. This is the Unit Pricemultiplied by the
Quantity.

Subtotal The sum of all the order’s line products before additional chargesor discounts, such as tax,
shipping and coupons.

Coupon
Total The total amount discounted, based on all applied coupons.
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Field Description

Tax The taxamount applied to this order. See Also:How anOrder’s TaxAmount isCalculated on
page 17-94

Shipping This is the amount being charged to ship the order to the recipient. See Also: eCommerce
Shipping Screenson page 17-85

Total The sum of all charges, including all line items, tax, shipping and handling.

Flow of the OrderList Server Control
The following image depicts the flow of the OrderList Server Control.

OrderList Server Control Properties
The following table explains the properties of the OrderList control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description Data Type

Authenticated

Indicates if you are logged in to the CMSExplorer
and can use it to browse to Content, Collections,
etc. See Also: Working with Ektron CMS400.NET
Server Controlson page 24-1

String

Flow of the OrderList Server Control
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Property Description Data Type

CacheInterval

Sets the amount of time the server control’s data is
cached. The default is 0 (zero). This is the amount
of time, in seconds, a control’s data is cached. For
example, if you want to cache the data for five
minutes, set theCacheInterval property to
300 (three hundred). See Also:Caching with
Server Controlson page 24-33

Double

DoInitFill

By default, Fill occurs during the Page_Init event.
Set to false if you want to postpone the fill-action
until later. In this case, FIll is automatically called
during the Page Render event.

Youmight do this if you need to set or change a
property on the control in codebehind and have it
render with your changes shown.

Boolean

CustomXml

(Code BehindOnly)

Enter a string of XML that you want to make
available to the XSLT. This property providesa
mechanism to inject customXML into the
generated XML before being processed by the
XSLT. The sting is added inside the CustomXml
tag as follows:

<root><customXml>custom-xml-inserted-
here</customXml></root>

See Also:Displaying CustomXML in Ektron’s
Server Controlson page 24-38

String

DefaultUserId The default ID of the user for which to display a list
of orders. Long

DisplayXslt

Specify an externalXSLT file to render the control.
Bydefault, the control usesOrderList.xsl.
This file is located in
<SiteRoot>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly
recommended that youmake a copy, change its
name andmove it outside your site’sWorkarea
folder. If youmake changes to this file and do not
move it out of theWorkarea folder, this file and the
changeswill be lost when you upgrade.

String

DynamicProductParameter

TheQueryString parameter namewhich is used
to pass the product ID to the product details page.
For example, if your QueryString parameter for
products is ID, enter that in this property. Then,
when site visitors click a product in their order list,
this parameter is passed with the product’s ID to
the product details page.

String

DynamicOrderParameter
Sets the QueryString parameter namewhich is
used to passan order ID dynamically. Bydefault,
this parameter isOID.

String
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Property Description Data Type

GuestOrderView

Set to true to allow guest account visitors to view
their orders. If you do, a visitor can go to the View
Orders screen, enter an order number and an
email address, then view all submitted orders.

See Also:Guest Account Registration on page 17-
22

Viewing a Site Visitor’sOrders List on page 17-
196

Boolean

Hide

Used to hide the control in design time and run
time.

True =Hide the control

False =Show the control

Boolean

Language
Set a language for viewing theOrderList control.
This property shows results in design-time (in
VisualStudio) and at run-time (in a browser).

Integer

MaxResults

Specify the number of orders to show per page
when a site visitor views their order history. If the
number of orders exceeds the quantity defined in
this property, the list is paged and the site visitor
can use the paging navigation tomove through
the list.

Integer

PageSize Themaximum number of orders to show per
page. Integer

Stylesheet

Specify the path to a style sheet for use with this
server control. The location can be relative or
absolute. Leave blank to use the default style
sheet.

String

SuppressWrapperTags

Suppresses the output of the span/div tags
around the control. The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

TemplateProduct

The URL path of the template that allowsa site
visitor to view the details of a product in an order.
When a path is entered, the product’s title
becomesa link that allowssite visitors to navigate
to the template containing details of the product;
for example, the template containing a Product
server control. on next page

String
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Customer Information
Customers create an account the first time they complete the checkout
procedure. The Customers screen provides information about all customers
who order from your Web site. The first screen presents the

n customer ID number

n user name

n number of orders

n amount of all orders

n average order amount

You can click any customer’s ID number or name to see more details about his
order history. The View Customer screen (shown below) provides information
about the customer’s

n summary information (name, number of orders, total of all orders,
average order amount)

n orders (see Customer Information above)

n addresses

- You can edit any address or enter a new one (see Entering a New
Customer Address on next page)

- Whenever a user creates a new order and enters a new or selects an
existing billing/shipping address, that becomes the new default

n shopping carts (see Viewinga Customer’s Shopping Cart on page 17-
205)

Customer Information
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This section also contains the following topics.

The My Account Server Control 17-204
Entering a New Customer Address 17-204
Viewinga Customer’s Shopping Cart 17-205
Deleting a Shopping Cart from the Workarea 17-205

The My Account Server Control
While you use this screen to view and update customer information within the
Ektron CMS400.NET Workarea, your site visitors use the My Account server
control on your Web site to enter and update their information. For more
information, see MyAccount Server Control on page 17-206.

Entering a New Customer Address
Use this screen to enter a new address for a customer or edit an existing one. It
may be used as the default billing address, shipping address, or both.

Use the following table to complete the screen.

Field Description

Name Enter the customer’s name.

Company If available, enter the name of the customer’s company.

Street Address Enter the customer’s street address.

City Enter the customer’s city.

PostalCode Enter the customer’s postal code.

Country Select the customer’s country from the pull-down list. See Also:
Countrieson page 17-49

State/Province Select the customer’s state or province from the pull-down list.
See Also:Regionson page 17-52

Phone
Enter the customer’s phone number.

You can add characters or spacesbetween groupings if you
wish. For example: 603-594-0249.

Default Billing
If you want this address to appear bydefault as the billing
addresswhenever this customer makesa purchase, check this
box.
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Field Description

Default Shipping
If you want this address to appear bydefault as the shipping
addresswhenever this customer makesa purchase, check this
box.

Viewinga Customer’s Shopping Cart
To view active shopping carts for a customer, follow these steps. After viewing
the carts, you can delete any of them.

1. Settings > Settings >Commerce > Customers.

2. Click a customer ID number.

3. Click the Baskets tab.

4. Click the ID number of the shopping cart that you want to view.

5. A View Cart screen shows information for items in the cart.

Deleting a Shopping Cart from the Workarea
Follow these steps to delete a shopping cart from the Ektron CMS400.NET
Workarea.

1. Access the View Cart screen by following the steps in Viewinga
Customer’s Shopping Cart above.

2. Click the Delete button ( ).

3. A confirmation message appears. Click OK.

Viewinga Customer’s Shopping Cart
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MyAccount Server Control
The MyAccount server control allows logged in site visitors to view and edit
their Personal Information, Billing Address and Shipping Address. If the site
visitor is not logged in and arrives at this control, one of the following happens:

n he receives a message that states he is not logged in. This happens
when the server control’s RedirectUrl property is empty and the
web.config file’s <add key=”ek_RedirectToLoginURL” value=””
/> value is blank.

n he is redirected to a login page and once logged in, he is sent back to
the template containing the MyAccount server control. This happens
when either the server control’s RedirectUrl property contains the
path of a template that contains a Login server control or when the
web.config file’s < add key=”ek_RedirectToLoginURL” value
=”” /> value is set to the path of a template that contains a Login
server control. If the control’s RedirectUrl property and the
web.config file contain different locations, the RedirectUrl
property in the control overrides the web.config file.

Typically, the information displayed in this control is collected the first time a
site visitor goes through the checkout process. A site visitor’s information might
appear in the Personal Information area before they have been through the
checkout process if they are a current CMS400.NET user or registered
membership user.

If a logged in site visitor arrives at this server control and is missing required
information, he must enter it before continuing. For example, a site visitor
needs to provide his Last Name or E-mail Address.
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As a developer, you need to create a link to this control in a site location that
appears only after log in. For example, you might place the link on a menu or
on a master page that appears after a site visitor logs in.

This section also contains the following topics.

Flow of the MyAccount Server Control 17-207
The Personal Information Area 17-208
Editing Personal Information 17-209
The Billing Address Area 17-209
Editing the Billing Address 17-209
The Shipping Address Area 17-210
Editing the Shipping Address 17-211
Adding a New Shipping Address 17-211
MyAccount Server Control Properties 17-212

Flow of the MyAccount Server Control
A site visitor typically arrives at this control by clicking a link placed on a main
page, master page, or menu. Below is an example image.

Below is an image depicting the flow of the MyAccount server control.

Flow of theMyAccount Server Control
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The Personal Information Area
The Personal Information area allows site visitors to view and edit some
information contained in their profile. By default, a site visitor can edit their
First Name, Last Name, email Address, and Password. By adding a list of
Custom User Property IDs to the CustomPropertyID property, you can allow
site visitors to view and edit custom properties in their profile. See Also:
Custom User Properties on page 15-12
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Editing Personal Information
A site visitor can change the information in the Personal Information area by
clicking Edit in the lower left corner of this area.

If the site visitor clicks the link, a page allows him to change any information in
this area.

When done, the site visitor clicks Save Changes to save the changes and
return to the My Account page.

The Billing Address Area
The Billing Address area allows site visitors to view and edit their billing
address information. A site visitor can edit their Name, Company, Address,
City, State, Postal Code, Country, and Phone number.

This information is used for billing purposes when the site visitor makes a
purchase. Credit card companies typically want part or all of this information to
match a customer’s credit card account information when making a purchase.

Editing the Billing Address
To edit a site visitor’s billing address, click the Edit link in the lower left corner
of the Billing Address area.

Editing Personal Information
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Once a site visitor clicks the link, a page allows him to change any information
in this area.

When done, a site visitor clicks Save Changes to save the changes and return
to the My Account page.

The Shipping Address Area
The Shipping Address area allows site visitors to view, edit, or add a new
address to their shipping address information. The fields in this area are the
same as those in the Billing Address area with two exceptions: a Same as
Billing check box, and a Default Address check box.

The Same as Billing Address check box allows site visitors to place a check
mark in the box and use their billing address information as their shipping
address.
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The Default Address check box allows site visitors to specify the current
shipping address as the default they want to use when making future
purchases.

Editing the Shipping Address
To edit a site visitor’s shipping address, click Edit in the lower left corner of the
Shipping Address area.

Note: The image below shows the (Same as Billing Address) message because this person
has the Same as Billing checkbox checked.

If a site visitor clicks the link, a page allows him to change any information in
this area. Note that a site visitor must uncheck Same as Billing to be able to
edit the shipping address. Otherwise, it is locked to the billing address.

When done, a site visitors clicks Save Changes to save the changes and return
to the My Account page.

Adding a New Shipping Address
To add a new shipping address, the site visitor clicks the Add New Address
link located in the bottom center of the Shipping Address area.

Editing the Shipping Address
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If a site visitor clicks the link, a page appears where he can enter new shipping
address information. Note that the Same as Billing checkbox is not available
when adding a new address.

When done, a site visitor clicks Save Changes to save the changes and return
to the My Account page.

MyAccount Server Control Properties
The following table explains the properties of the MyAccount control.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Description
Data
Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it to
browse to Content, Collections, etc. See Also:Working with Ektron
CMS400.NET Server Controlson page 24-1

String
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Property Description
Data
Type

CacheInterval

Sets the amount of time the server control’s data is cached. The default
is 0 (zero). This is the amount of time, in seconds, a control’s data is
cached. For example, if you want to cache the data for fiveminutes, set
theCacheInterval property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Double

CustomerPropertyID

An ID or comma separated list of IDs for a CustomUser Property (or
properties) to expose in the UI. These properties are used to define
information about a user beyond the standard Ektron CMS400.NET
user properties; such asUsername, First Name, Password and email
Address. See Also: The Personal Information Area on page 17-208.

IDs for these properties can be found in theWorkarea >Settings>
Configuration >CustomProperties screen. See Also:CustomUser
Propertieson page 15-12

String

CustomXml

(Code BehindOnly)

Enter a string of XML that you want to make available to the XSLT. This
property providesamechanism to inject customXML into the
generated XML before being processed by the XSLT. The sting is
added inside the CustomXml tag as follows:

<root><customXml>custom-xml-inserted-here</customXml></root>

Displaying CustomXML in Ektron’sServer Controlson page 24-38

String

DefaultCountryID

The ID of the default country that appears in the Billing Addressand
Shipping Address. Set this ID to the country fromwhich themajority of
your customerswill bemaking purchases. If the site visitor is from a
different country, he can it change when editing the Billing or Shipping
Address.

Note: If a site visitor enters information in the Billing Addressarea, his
Billing Country seeds the Shipping Countrywhen adding a new
Shipping Address.

To find a country’s numeric ID, sign into the Ektron CMS400.NET
Workarea. Then go toSettings > Commerce > Configuration >
Countries. The Numeric ID is in the left column of that screen.

Integer

DisplayXslt

Specify an externalXSLT file to render the control. Bydefault, the
control usesMyAccount.xsl. This file is located in
<Site Root>\Workarea\Xslt\Commerce

Important: If you want to edit this file, it is strongly recommended that
youmake a copy, change its name andmove it outside your site’s
Workarea folder. If youmake changes to this file and do not move it out
of theWorkarea folder, this file and the changeswill be lost when you
upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if you
want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the control
in codebehind and have it render with your changes shown.

Boolean
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Property Description
Data
Type

Hide

Used to hide the control in design time and run time.

True =Hide the control

False =Show the control

Boolean

Language
Set a language for viewing the account information. This property
shows results in design-time (in VisualStudio) and at run-time (in a
browser).

Integer

LoadingImage
The image to displaywhile the control is fetching data. The default is
<siteroot>\Workarea\images\application\ajax-
loader_circle_lg.gif.

String

RedirectUrl

Enter the path of a template that contains the Login server control.
When a site visitor arrivesat this control and is not logged in, the control
checks this property for a path to template containing a Login server
control. If one exists, the site visitor is sent to that template. Once he’s
logged in, he’s returned to the template containing theMyAccount
server control.

If no path exists, the control checks theweb.config file’s <add
key=”ek_RedirectToLoginURL” value=”” /> value for a path.

String

Stylesheet
Specify the path to a style sheet for use with this server control. The
location can be relative or absolute. Leave blank to use the default style
sheet.

String

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control. The
default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean
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eCommerce Coupons
Most eCommerce sites periodically offer coupons to provide discounts to
customers, either to attract new business or reward loyalty. Ektron
CMS400.NET’s eCommerce feature provides a coupon generation capability
with the following features.

discount can be an amount or percentage - if percentage, you can set
a maximum coupon value regardless of the amount calculated by per-
centage

restrict coupon to catalog entries that you accept

restrict coupon to most or least expensive entry

limit to one use per customer

prevent coupon from being used with other coupons

specify a maximum number of redemptions

specify a minimum order amount required to activate coupon

designate a date range when coupon is active

This section also contains the following topics.

Creating a Coupon 17-215
Disabling a Coupon 17-222
Deleting a Coupon 17-223

Creating a Coupon
Create coupons in the Ektron CMS400.NET Workarea by going to Settings >
Commerce > Catalog > Coupons. To make it easy to complete the
information, the screens are arranged in numbered steps. Subsequent screens
are context-sensitive, so that you only see fields that are a logical result of
previous decisions.

The following table summarizes the information collected on each screen.

Screen Information collected For more information, see

1. Type

n code (that is, unique identifier)

n description

n whether discount is based on amount or
percentage

n currency (applicable to amount-based
couponsonly)

n enabled or disabled

Completing the First Coupon Screen
(Type) on next page
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Screen Information collected For more information, see

2. Discount
n If amount, dollar amount

n If percentage, percentage andmaximum
coupon value

Completing the Second Coupon Screen
(Discount) on page 17-218

3. Scope

n applies to entire cart, accepted itemsonly,
most/least expensive item only

n limit to one per customer?

n allow combination with other coupons?

n maximum number of redemptions

n minimum cart value

n start and end dates

Completing the Third Coupon Screen
(Scope) on page 17-219

4. Items If coupon is restricted to certain items,
designate the items

Completing the Fourth Coupon Screen
(Items) on page 17-220

See Also:

n Disabling a Coupon on page 17-222

n Deleting a Coupon on page 17-223

Completing the First Coupon Screen (Type)

Use the following table to complete the first coupon screen.
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Field Description

Type

Select the type of coupon you are creating/editing.

n Amount - discount is a dollar amount.

If you select this type, choose a currencyat theCurrency field (below).
Then, enter the dollar amount on theDiscount screen. See Also:
Amount Based Coupon on next page

n Percentage - discount is a percentage.

If you select this type, enter the percentage on theDiscount screen. That
screen also lets you enter amaximum amount. See Also:Percentage
Based Coupon on next page

Also, if the coupon type ispercentage, theCurrency field is disabled.
Percentage-based couponsare currencyneutral.

Code

Enter the coupon code. The code cannot contain

n spaces

n angle brackets (<, >)

n single (‘) or double quotes (“)

n ampersand (&)

n slash (/) or back slash (\)

n plus sign (+)

When done, click theValidate Code button.When you do, Ektron
CMS400.NET verifies that the code contains the correct characters and is
not already in use.

Note: Tip! The following page gives suggestionsabout eCommerce
coupons, including coupon-naming strategies:
http://www.ecommerce-
guide.com/solutions/advertising/article.php/3667331

Site visitors enter this code to redeem the coupon on a page that hosts the
Cart server control (see image below).

Description Enter a free text description of the coupon. This helpsdescribe it on the
initialCoupons screen in the Ektron CMS400.NETWorkarea.

Completing the First Coupon Screen (Type)
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Field Description

Currency

Select the currency to which this coupon applies. A dropdown list of all
enabled currencies is available. See Also:Currencieson page 17-54

If the coupon type is percentage, this field is disabled.

Warning! The coupon is only valid if a site visitor selects this currency.
So, for example, if you create a coupon for a USD amount, and a site
visitor selectsEuroswhen shopping on your site, the coupon is not
accepted. To workaround this restriction, create a coupon for every
applicable currency.

Status

Set to enabled to let site visitors uses this coupon (providing all other
conditionsaremet).

Or, set to disabled to keep the coupon in the eCommerce feature but
prevent it from being used.

Completing the Second Coupon Screen
(Discount)

n Amount Based Coupon below

n Percentage Based Coupon below

Amount Based Coupon

Use the following table to complete the second coupon screen if the coupon is
based on amount.

Field Description

Amount

Enter the coupon’s discount amount.

Note: If the coupon amount exceeds the sum of all items to which it is applied, it is reduced to
the sum of the items. For example, a coupon amount is $10.00 and applies to the least
expensive item. If that item is $3.00, the amount changes to $3.00.

Percentage Based Coupon
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Use the following table to complete the second coupon screen if the coupon is
based on percentage.

Field Description

Percentage Enter the percentage of the discount.

Maximum
Amount

Enter themaximum value of this coupon.

For example, if you set a discount of 10%and aMaximum Amount of $20.00, the discount will
never exceed $2.00 (that is, 10%of theMaximum Amount) regardlessof the amount of the
goodsordered.

Typically, you would include aMaximumAmount in the email or announcement that describes
the coupon.

Completing the Third Coupon Screen
(Scope)

Use the following table to complete the coupon Scope screen.
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Field Description

Apply
Coupon to

n Entire cart - coupon applies to all items in cart

n All accepted items - coupon applies allaccepted items in cart. Itemsare accepted on
the Items screen.

n Most expensive accepted item - coupon applies tomost expensive accepted item in
the cart. Itemsare accepted on the Items screen.

n Least expensive accepted item - coupon applies to least expensive accepted item in
the cart. Itemsare accepted on the Items screen.

Important: If you selectAll accepted items,Most expensive accepted item, or Least
expensive accepted item, youmust identify accepted itemson the Items tab. If you do
not, the coupon is effectively inactive.

Note: You cannot apply a cart-level coupon to a subscription product.
However, you can apply an item-level coupon to a subscription product.
(An an item-level coupon is one that applies to all accepted items, or the
most or least expensive item.) See Also: Creating a Subscription on page
17-114

One Per
Customer

Check this box if you want to limit each customer to one use of the coupon. If you do and a site
visitor completesan order with the coupon then tries to use it a second time, he is notified that
the coupon is not valid.

Can be
combined
with other
coupons

Check this box if this coupon can be combined with other coupons in the same order.

If you do not check this boxand a site visitor tries to add this coupon to an order to which a
coupon is alreadyapplied, he is notified that the coupon is not valid.

Maximum
Redemptions

If desired, enter amaximum number of times this coupon can be used. It doesnot matter
which site visitors use the coupon.

If you set amaximum, and the coupon is applied that number of times, the next time someone
tries to use the coupon, he is informed it is not valid.

Minimum
Required
Cart Value

If desired, enter theminimum order amount required to activate this coupon. The order
amount doesnot include taxor shipping charges.

For example, enter $50.00. If a shopping cart total is $40.00, and a site visitor adds this
coupon to an order, he is informed the coupon is not valid.

Start
Date/End
Date

Enter the date range within which this coupon is valid.

For example, you enter aStart Date of January 1, 2008 and anEnd Date of December 31,
2008. If a site visitor inserts this coupon on February 9, 2009, he is informed the coupon is not
valid.

Completing the Fourth Coupon Screen
(Items)
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Use the following table to complete the Items coupon screen.

Field Description

Include/
Exclude

Use this screen to identify items to which this coupon applies if the Coupon Scope screen’sApply
Coupon to field is set to

n All accepted Items

n Most Expensive accepted Item

n Least Expensive accepted Item

Warning! - Item-level coupon typesapplyonly to itemsselected on this screen. If a site visitor
orders a catalog entry that’s not defined on this screen, an item-level coupon doesnot apply to the
item.

For example, you create a coupon worth 10%off anydigital camera. The coupon is only applicable
if a digital camera is in the shopping cart. Typically, the email or announcement that describes the
coupon includes item restrictions.

The discount is applied to each accepted item in the cart. For example, a coupon providesa 10%
savingson items1, 3, and 5 but not 2 and 4 because 2 and 4 are not on the accepted items list.

See Also:Selecting a Coupon’sAccepted Itemsbelow; Include vs. Exclude on next page

Selecting a Coupon’s Accepted Items
There are three ways to select items to add to the Include or Exclude list. You
can select

n individual items - click the Include Product button and navigate
through the Ektron CMS400.NET folder system to that content. You
can only select items in a category folder (which are blue to
distinguish them from regular folders).
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n all items in a catalog folder - click the Include Catalog button
and navigate through the Ektron CMS400.NET folder system to that
folder. You can only select items in a category folder (which are blue
to distinguish them from regular folders).

n all items in a taxonomy or category - click the Include
Category button and navigate through the Ektron CMS400.NET
taxonomies to the desired taxonomy or category. All content applied
to the category will be eligible for the coupon.

Include vs. Exclude
You can both include and exclude using any of the criteria listed above. If any
product appears on both lists, it is excluded from coupon eligibility.

So for example, one of your folders contains 500 digital cameras that your site
offers. You want the coupon to apply all but a few cameras.

On the Include tab, select the cameras folder. Then, use the Exclude tab to
select the few cameras to which the coupon does not apply. In this way, you can
easily select the majority of items but exclude a few.

Disabling a Coupon
When the coupon’s status is Disabled, site visitors can no longer apply it to an
order.

Coupons can be disabled automatically (according to a schedule) or manually.

This section also contains the following topics.

Using an Expiration Date to Disable a Coupon 17-222
Manually Disabling a Coupon 17-223

Using an Expiration Date to Disable a
Coupon
When you create a coupon, a default end date is set for 10 years from the end
of the current year. At that time or at any time the coupon is active, you can
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change its end date.

When the coupon’s end date is reached, its status changes to Disabled.

Manually Disabling a Coupon
To disable an active coupon, follow these steps.

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Coupons.

2. Locate the coupon that you want to delete.

3. Go to its Type screen.

4. Change its Status field to Disabled (see below).

Deleting a Coupon
Warning! You cannot delete a coupon that is applied to any order within Ektron CMS400.NET.

Follow these steps to delete a coupon that is not applied to an order. If a
coupon is applied to an order, you cannot delete it but you can disable it. See
Also: Disabling a Coupon on previous page

1. Go to Ektron CMS400.NET Workarea > Settings > Commerce >
Coupons.

2. Locate the coupon that you want to delete.

3. Click the delete button on the far right of the coupon information
(circled below).
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4. A strike through line appears over all coupon text, and a Restore
button ( ) replaces the delete button.

Note: If you change your mind and do not want to delete the coupon, click the Restore button.

5. Click the Save button ( ).
If the coupon cannot be deleted (because it is applied to an order), it remains
on the main Coupons screen and No appears in the Enabled field. This coupon
can no longer be used.
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Using eSync with
eCommerce
When using eSync with an eCommerce site, you will want to prevent orders
from being processed on your staging server. This is to prevent orders from
being processed twice.

For example, a customer on your production site purchases a product. If the
staging server and production server are synced before the credit card is
processed, the potential exists for the customer’s credit card to be charged
twice; once from the production server and again from the staging server.

To prevent orders from being processed on your staging server, edit your
staging site’s web.config file. Next, set the following property to true.**

<add key="ek_ecom_OrderProcessingDisabled" value="true" />

Once the property is set to true, you cannot process or edit orders from the
Workarea’s View Order screen on the staging server. Also, if you try to create
an order from the staging server’s Web site, you receive the following
message.

“We're sorry, an error occurred while processing your request.
Please try again later...”

It is important to note that all other eSync functions still work properly. For
example, when you create catalog entries on a staging server and perform a
sync, the entries will be moved to the production server. This key only affects
the processing of orders.
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The eCommerce Audit
Screen
As an administrator, you should regularly review the eCommerce Audit log. This
is vital to keeping your site secure and will help you determine the source when
data is compromised.

While it is important that Ektron CMS400.NET captures this information, it is
even more important that you review, analyze and use it. For example, while
reviewing eCommerce event logs in CMS400.NET, you might find that one of
your eCommerce administrators has an unusually large amount of login
failures. This could be a sign someone is trying to break into your system.

You can view a log of your CMS400.NET Web site's eCommerce activity in the
Workarea > Settings >Commerce >Audit.

To turn eCommerce Logging on, open the Web site’s web.config file and change
the following key to true.

<add key="ek_ecom_ComplianceMode" value="false"/>

When compliance mode is turned on, Ektron CMS400.NET logs and displays the
following events.

Actions affecting administrators (Administrator Group member, Com-
merce Admin Role, Builtin Account).

An administrator logs in or out

An administrator's login attempt fails

An administrator password is changed

Actions affecting an Ektron CMS400.NET user’s rights to eCommerce.
Adding a user to the Commerce Admin Role

Removing a user from the Commerce Admin Role
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Adding a user to the Admin group

Removing a user from the Admin group

Actions affecting order information.
Updates to an order's address

The transaction ID and response from the payment gateway

Any action conducted with the payment gateway. For exam-
ple, when capturing a previously authorized transaction.

Workflow activities. For example, sending an email.

Whenever the default gateway or payment options are
changed in the Workarea.

The eCommerce Audit Screen
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eCommerce Reports and
Widgets
eCommerce provides a set of standard reports to measure your commerce
activity. View these reports by clicking the Settings Tab then choose the
Commerce > Reports folder. These are also found in the Reports >
Commerce section.

eCommerce Reports Widgets
The eCommerce reports are also available as Widgets for the Smart Desktop.
See also Personalizing the Smart Desktop on page 3-4.

This section also covers the following topics.

Customer Reports below

Key Performance Indicators Report on the facing page

Payment Reports on page 17-230

Sales Trends Report on page 17-231

Top Products Report on page 17-232

Customer Reports
The Customer Report shows 5 customers ranked according to account date,
sales, and orders.
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The following table describes the report’s fields.

Field Description

Name Customer first and last name

Orders Total number of orders by this customer

Order Value Total amount of sales to this customer

Date Created The date this person first became a customer

To change the report type, do the following.

1. Click the Most Recent link next to the Calendar Button ( )
2. Click the type of report to view.

The types of reports are:

n Most Recent - the newest customers joining the site

n Most Valuable - customers ranked by order value

n Most Active - customers ranked by number of orders

Key Performance Indicators Report
The Key Performance Indicators report lets you compare the sales and orders
for two different time periods.
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Change the current and previous periods for comparison by doing the following.

1. Click the link called This Month in the Period column. The list of
choices is shown below.

2. Click the appropriate period.

3. Repeat steps 1 and 2 for the current period.

4. Click the Refresh button ( ) to update the report.

Payment Reports
The Payments report lists payments for a specific time period. It may be used
by the accounting department to reconcile bank statements with the order
system.
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The following table describes the report’s fields.

Field Description

Date Captured Date the payment was captured. See Also:Capturing theOrder on page 17-192.

CardID The last four digits of the credit or debit card used for payment.

Type Type of payment used. See Also:Payment Optionson page 17-61.

TransactionId The unique number returned from the Payment Provider for this payment. See
Also:Capturing theOrder on page 17-192.

Amount Total amount of the payment for this transaction.

Voided Total amount voided in the transaction.

To run a report, do the following.

1. Click the Calendar button ( ) next to Start Date to open the
calendar.

2. Click the date on the calendar to set the start date.

3. Click the Calendar button ( ) next to End Date to open the calendar.
4. Click the date on the calendar to set the end date.

5. Click the Set New Dates link (circled below) to refresh the report.

Sales Trends Report
The Sales Trends reports shows the number of orders for the past 8 periods.
You can choose monthly or daily orders. At the top of the graph, you see the
total number of orders and sales.
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Set the time period for the graph by doing the following.

1. Click the period link circled below.

2. Click the proper time period .

Top Products Report
The Top Products reports shows the most popular products on your site.

Create the report by doing the following.

1. Click the link next to the calendar icon ( ).
2. Click the time period of sales from the choices shown in the select

box.
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3. Click the Quantity link (circled below) to change this value.

4. Enter the maximum number of products to show.

5. Click the Update button.
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eCommerce Server Controls
Ektron provides a complete set of eCommerce server controls that allow you to
set up an online marketplace where site visitors can purchase merchandise,
services or content. Site visitors interact with these server controls on your site
to the following:

To do this See

Select the type of currency CurrencySelect Server Controlon page 17-60

Search for products or view a list of
products

ProductSearch Server Controlon page 17-163 and the
Product List Server Controlon page 17-156

View the details of a product and add it to
their shopping cart Product Server Controlon page 17-146

Get recommendationson other products Recommendation Server Controlon page 17-183

View products in a shopping cart, create
new carts, and apply discounts Cart Server Controlon page 17-8

Go through the checkout process Checkout Server Controlon page 17-20

View a list of processed orders OrderList Server Controlon page 17-196

View and change account information MyAccount Server Controlon page 17-206

Most eCommerce server controls allow site visitors to move from one control to
another. In these controls, template properties allow you to define the location
of another server control. For example, if you define the path to the Cart server
control in the Product server control’s TemplateCart property, site visitor are
sent to the Cart control when they click the Add to Cart button in Product
control.

This section also contains the following topics.

Using the eCommerce Server Controls 17-234
Using eCommerce Server Control Events 17-236

Using the eCommerce Server Controls
The following table shows typical actions a site visitor might perform when
visiting your eCommerce site and how you can facilitate these actions.
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Site
Visitor
Action

How you accomplish this When to Use

View
account
information

Create a link in themaster page that leads to the
template containing the MyAccountserver control.

This link should be available from
anypage.

View
previous
and
current
orders

Create a link in themaster page that leads to the
template containing the OrderListserver control.

This link should be available from
anypage.

Change
the
currency
type

Add the CurrencySelectserver control to amaster
page.

This server control should be
available from anypage.

Search for
products

Either create a link to the template containing the
ProductSearchserver control.

- Or -

On themaster page, add a textbox that passes the
text to a hidden ProductSearchserver control and
post the results to a separate template.

This link or textbox should be
available from anypage.

View a list
of products

Create a template that contains the ProductList
server control. This templatemight be the first page
site visitors see when they view the eCommerce
portion of your site.

Whenever you want to display a list
of products based on a catalog,
taxonomyor a list content IDs. For
example, you could create a list of
products in a panel on the right
side of your Web site.

View a
product’s
details

Create a template that contains the Productserver
control. Set anyof the following server control’s
TemplateProductproperty to the path of this
control. Thismakesa product’s title being displayed
byone of these controls a clickable link that takes the
site visitor to this control.

n ProductSearch

n ProductList

n OrderList

n Cart

n Recommendation

When ever a site visitor needs to
view details of a product.
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Site
Visitor
Action

How you accomplish this When to Use

View
additional
products
associated
with
another
product

Add the Recommendationserver control to a
template that contains a Product server control
and set the Recommendation control’s
DynamicProductParameterproperty to the
QueryString parameter that’s used to passa
products ID.

When ever you want to present a
site visitor with cross-sell and upsell
opportunities associated with a
given product.

Add a
product to
their
shopping
cart

Set the TemplateCartproperty in the following
server controls to the path of the Cartserver control.
Setting this property is one of the requirements for
theAdd to Cart button or link to appear in these
controls.

n ProductSearch

n ProductList

n Product

n Recommendation

Note: In addition to setting the above property, a
product must be in-stock, not archived and
buyable. Otherwise, theAdd to Cart button or
link doesnot show for a product.

When you want to allow site visitors
to add products to their shopping
cart.

View
products in
their
shopping
cart

When a site visitor addsa product to their cart, they
are sent to the Cart server control. You should also
create a link in themaster page that leads to a
template containing this control.

The link should be available from
anypage.

Checking
out and
paying for
their
selected
product.

Add the Checkout server control to a template and
add that template’s path to the Cartserver control’s
TemplateCheckoutproperty.When you do, the
Checkout button in the Cart server control becomes
active.

Youmust set this up in order for
site visitors to checkout.

Using eCommerce Server Control Events
The eCommerce server controls contain event hooks that allow you to
customize or manipulate them.

To use these event hooks, create a handler for each needed event in the code
behind of the ASPX page that contains an eCommerce server control. Then, in
that page’s OnInit method, hook each event.
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For an example of working with the eCommerce server control’s event hooks in
code behind, download Ektron’s Developer Sample Site and view these files.

For the Checkout server control:

[Site Root]/Developer/Commerce/CheckoutDemo_Advanced.aspx

[Site Root]/Developer/Commerce/CheckoutDemo_Advanced.aspx.cs

For the Cart server control:

[Site Root]/Developer/Commerce/CartDemo_Advanced.aspx

[Site Root]/Developer/Commerce/CartDemo_Advanced.aspx.cs

For the Product server control:

[Site Root]/Developer/Commerce/ProductDemo_Advanced.aspx

[Site Root]/Developer/Commerce/ProductDemo_Advanced.aspx.cs

Event
This Hook
is Called...

Description

PhaseChange

(Used only in the
Checkout server
control.)

when the
current
phase is
about to
change.

Supervise phase changesand allow or prevent changing asneeded. It
also allowsyou to jump to a specified phase. For example, you could
jump to a passed phase, prevent the phase from changing from the
current one under certain conditions, or jump to a phase that is not
necessarily the next one in line.

PreProcessXml

immediately
before the
control’s
XML is
transformed.

Inspect or manipulate the server control’sXML before being
processed.

This is the only time the XmlDocproperty should be used to access the
controlsXML.

PostProcessXml

immediately
after the
control’s
XML is
transformed.

Workwith processed transformed XML output inside the Text property
before sending it to the browser. This allowssimple stringmanipulation
of the server control’smarkup.

FilterAjaxCallback

when an
Ajax-
Callback
event
occurs.

Inspect or modify callbackparameters. For example, you could use this
event to receive custom valuesentered in a page.

Using eCommerce Server Control Events

ReferenceManual
Version 8.01 Rev 4

17-237

http://www.ektron.com/download.cfm?product_id=360&purchase=0
http://www.ektron.com/download.cfm?product_id=360&purchase=0
http://www.ektron.com/download.cfm?product_id=360&purchase=0


Event
This Hook
is Called...

Description

PostLogin

(Used only in the
Checkout server
control.)

immediately
after a
(possibly
new) user
logs in with
this control

Calls custom code immediately after a returning user logs in with his
email and password. Or, immediately after a new customer fills out the
billing info screen. For example, you could add code that allowsnew
customers to sign up for Web Alerts after theyadd their information to
the billing screen.

Using the EkItems Property with eCommerce
Server Controls
When using the EkItems property with eCommerce server controls it can only
be used with the Product and ProductList server controls. This property gets
EntryData for a product and can only be called during the PreProcessXml or
PostProcessXml event. If you use it outside of these events, it will return empty
values for the entry data.
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Customizing eCommerce
Ektron’s Ektron CMS400.NET eCommerce Module allows you to set up an eCommerce
Web site which delivers a full set of functionality for building an online marketplace.

As a developer, you can use Ektron’s standard functionality and out of the box Server
Controls to quickly create an eCommerce Web site. Ektron also provides the ability to
partially or fully customize your Web site. For example, you can customize your site’s order
process workflow.

This section also contains the following topics.

Customizing Workflows 17-239
AdvancedEmailActivity 17-247
BasicEmailActivity 17-250
OrderCapturedEventActivity 17-252
CaptureOrderActivity 17-253
CheckStockActivity 17-254
OrderCancelledEventActivity 17-255
OrderFraudEventActivity 17-257
OrderProcessedEventActivity 17-258
OrderReceivedEventActivity 17-259
OrderShippedEventActivity 17-260
OrderUpdatedEventActivity 17-261
UpdateOrderActivity 17-262
Customizing the Payment Gateway Provider 17-264
Customizing the Shipment Provider 17-274
Customizing the Inventory Provider 17-285
Customizing Shipping Calculations 17-291

Customizing Workflows
Important: If you customize the workflow then upgrade to a new version of Ektron CMS400.NET,
you need to point to the new references then compile the workflow.

Ektron utilizes Microsoft’s WindowsWorkflow Foundation to create and implement order
process workflows in Ektron CMS400.NET.Within Ektron CMS400.NET eCommerce
functionality, you use a workflow to handle the ordering process after your site has
received an order. The workflow can be as simple or complex as your business requires.

For example, you could have a simple workflow that sends an email to the customer when
their order is received and sends another to the person shipping product for you. Or, you
could have amore complex workflow that:

n sends an email to the customer when the order is received

n checks to see whether the item is a tangible product or a virtual product. Then,
continues down the workflow path that’s appropriate for the item.

n handles shipping notifications and updates the account throughout the
shipping process

n handles the order if it is canceled
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n handles the order if it is determined to be fraudulent

n marks the order as complete once all activities are finished

Ektron’s default sample workflow is shown below.

WindowsWorkflow Foundation is a development tool that allows you to automate a
business process. Releasedwith Microsoft’s .NET 3.0, it allows you to create an activities
basedworkflow that has the ability to persist over a given length of time or be paused and
restarted depending on events. From Microsoft’s MSDN:

WindowsWorkflow Foundation (WF), originally introduced as part of the .NET
Framework 3.0 with extensions for Visual Studio 2005’s designers, has continued
to be enhanced for the .NET Framework 3.5 and Visual Studio 2008.WF makes it
possible, and for many workflow scenarios, even easy to create robust,
manageable workflow-based applications. WF is actually many things: It’s a
programmingmodel, and runtime engine, and a set of tools that help you create
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workflow-enabled applications hosted by Windows. For more information on WF,
drop by the portal site here:
http://msdn.microsoft.com/en-us/netframework/aa663328.aspx.

Workflows are comprised of Activities; each activity represents a portion of your Business
Process. Once all activities have finishedwithin a workflow, the workflow terminates.
There are two types of activities:

n Activities - executed inside the workflow once the activity is reached. For
example, an email might be sent to a customer once their order is received by
using the AdvancedEmailActivity placed after the OrderReceivedEventActivity.
This email would be automatically sent with no human interaction needed and
the workflow would continue on.

n Event Activities - cause the workflow to pause until the event has taken
place. Once the event takes place, the activity associated with it is executed.
Think of events as road blocks in the workflow that don’t open unless a
matching action happens. Once the event happens, the workflow follows the
path associated with that event. For example, an OrderFraudEventActivity in a
workflow would keep the workflow from going through the Fraud Event
portion of the workflow unless the order is marked as fraud.

Ektron supports Sequential Workflows and State Machine Workflows. Sequential
Workflows are structured; a step based process where one activity leads to the next. State
Machine Workflows typically move from one activity to another when their state has
changed.

Only one workflow project can be run at a time. You can have multiple workflows projects
associated with your eCommerce site and you can change workflow projects at anytime.
Note however, once an order process is started with a specified workflow, it will continue
through that Workflow.

Note: To see the webinar "Introduction to the Ektron eCommerce Workflow Engine," go to
http://www.ektron.com/webinars/Introduction_to_the_Ektron_eCommerce_Workflow_Engine/.

Installing Ektron’s Sample Workflow
Template
Prerequisites - Ektron’s Ektron CMS400.NET SDK is installed. See Also: Ektron’s
Developer SDK

Warning! If you use Visual Studio 2005 and want to work with Microsoft Windows Workflow
Foundation, install Microsoft’s Visual Studio 2005 Extensions for Windows Workflow Foundation.
http://www.microsoft.com/downloads/details.aspx?FamilyId=5D61409E-1FA3-48CF-8023-
E8F38E709BA6&displaylang=en

Ektron provides a C# workflow template sample for a sequential workflow. This sample
can be modified or used to create new workflows. It is based on the default workflow
includedwith Ektron CMS400.NET.

To install Ektron’s sample workflow template, simply copy the “Ektron Ordering Sequential
Flow.zip” file using the From & To information below.

Note: If you are using Visual Studio 2005, replace 2008 with 2005 in paths below.

From:
C:\Program Files\Ektron\CMS400SDK\Commerce\Workflow\Templates\VS2008
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To:

Note: Make sure you replace ~user name~ in the path below with the user name under which
Visual Studio project templates are saved.

C:\Documents and Settings\~user name~\My Documents\Visual Studio
2008\Templates\ProjectTemplates\Visual C#\Workflow

Once the Workflow zip file is saved to the ProjectTemplate location, you are ready to start
working with a sample workflow.

Working with the Sample Workflow
Follow the steps below to open andwork with Ektron’s sample workflow.

Prerequisites - Install Ektron’s sample workflow template. See Installing Ektron’s
Sample Workflow Template on previous page.

1. Open Visual Studio.

2. Click File > New > Project.

3. If you are using C#, expand the Visual C# project type. Otherwise, expand the
Visual Basic project type.

4. ClickWorkflow.

5. Select Ektron Ordering Sequential Flow from the My Templates area.

6. Select a new Name, and if necessary, change the Location, Solution and Solu-
tion Name.

7. ClickOK.

8. If you have a prior version of the software developer's kit (SDK)
installed, the assemblies in the sample may be older than those in
your site. To avoid an issue, do the following:

a. Remove the Ektron.Cms.Common.dll and Ektron.Wor-
kflow.dll files from your project's bin folder.

b. Add them in again by copying them from the bin folder of your
Ektron site to the bin folder of the newly created workflow
project.

c. Re-establish the References to these dlls from the project's bin
folder.
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9. Open theWorkflow.cs file in the Solution Explorer.

10. Make any necessary changes to the workflow. For information on Ektron’s
Workflow Activities, see List of Workflow Activities on page 17-246. For infor-
mation on Microsoft’s Workflow Activities, see

11. Debug as needed.

12. Build the workflow. This creates a DLL of the workflow and places it in the
project’s bin/debug folder.

13. Navigate to the folder where the DLL is stored. For example, C:\Documents
and Settings\~user name~\My Documents\Visual Studio 2008\Proje-

cts\MyWorkFlow\MyWorkFlow\bin\Debug.

14. Move or copy the newly created workflow DLL file to your Web site’s bin folder.

Making Ektron’s Workflow Activities Available
To add Ektron’s Workflow Activities to your Toolbox, follow these steps.

1. Open or create aWorkflow in Visual Studio 2005/2008.

2. Display the Toolbox (View > Toolbox).
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ReferenceManual
Version 8.01 Rev 4

17-243



3. Right click the mouse within the Toolbox.

4. Click Add Tab.

5. Type Ektron Workflow Activities then press <Enter>.

6. Click the Ektron Workflow Activities tab.

7. Right click the mouse in the empty area.

8. Click Choose Items.

9. The Choose Toolbox Items dialog appears.

10. Select the Activities tab.

11. Browse to the directory that stores Ektron CMS400.NET’s DLL files, [Web
root]\[Site Root]\bin
Ektron.Workflow.dll file. This file provides access to Ektron CMS400.NET’s
workflow activities.

Alternatively, you could use the following location, C:\Program
Files\Ektron\CMS400v8x\bin. The file is identical in both places.
Using the bin folder in your site provides better speed. However, if you use the bin
folder located in Program Files, you do not have to worry about deleting the .dll file
if you change or delete your site.

12. ClickOK.
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For easier viewing, once the workflow activities are installed, you can right click on them
and select Sort Items Alphabetically.

Note: Ektron’s workflow activities appear only when the workflow is opened in design mode.

Removing Ektron’s Workflow Activities
1. Display the Visual Studio toolbox (View > Toolbox).

2. Right click the mouse within the Toolbox.

3. Click Choose Items.

4. Click the Activities tab.

5. ClickNamespace or Assembly Name to sort the Workflow Activities by
manufacturer.

6. Uncheck all boxes that are Ektron.Workflow.Activities.

7. ClickOK.

8. Right click the Ektron Workflow Activities tab.

9. ClickDelete Tab to remove it.

Updating Ektron’s Workflow Activities
To update the workflow activities, you must first remove the existing ones in Visual
Studio, then add the new workflow activities.

For information on removing workflow activities, see Removing Ektron’s Workflow
Activities above.

For information on adding workflow activities, seeMaking Ektron’s Workflow Activities
Available on page 17-243.

Inserting Workflow Activities Using Drag and
Drop
Because Visual Studio is a visual environment, you can see the workflow change as you
add or remove activities. Lines that connect the different events and activities change
depending on what you add, move, or remove.

Adding an Activity to a Workflow
1. Display the Visual Studio toolbox (View > Toolbox).

2. Click the Ektron Workflow Activities tab. Ektron’s Workflow Activities
appear.
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3. Drag an activity and drop it into the desired location in the Workflow.

4. As desired, modify the activity’s properties using the Properties area of Visual
Studio.

For a description of server control properties, see List of Workflow Activities below.

List of Workflow Activities
You can customize your workflow using the following activities.
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Activity Description

AdvancedEmailActivitybelow Send an email based on the order ID and a specifiedmessage type.

BasicEmailActivityon page 17-
250

Send a generic emailmessage when this activity is reached in the
workflow.

CaptureOrderActivityon page 17-
253 Submits order information to a payment gateway.

CheckStockActivityon page 17-
254 Verifieswhether the item is an in-stock item or not.

OrderCancelledEventActivityon
page 17-255 Customize the handling of an order when it’s cancel.

OrderCapturedEventActivityon
page 17-252 Customize the handling of an order when it’s captured.

OrderFraudEventActivityon page
17-257 Customize the handling of an order when it’smarked as fraud.

OrderProcessedEventActivityon
page 17-258 Customize the handling of an order when it’s being processed.

OrderReceivedEventActivityon
page 17-259 Customize the handling of an order when it’smarked as received.

OrderShippedEventActivityon
page 17-260 Customize the handling of an order when it’smarked as shipped.

OrderUpdatedEventActivityon
page 17-261 Customize the handling of an order when it’s updated.

UpdateOrderActivityon page 17-
262 Updates the order when once this activity is reached.

AdvancedEmailActivity
Add the Advanced Email activity to a workflow when you want to send an email
notification, based on an order ID in Ektron CMS400.NET, after an event takes place in the
workflow. For example, after an order is shipped, you might choose to send an email that
notifies customers when their orders are shipped. Or, you might send an email to a
customer when their order is received.

With this activity you can choose to send a predefined email message. These messages are
defined in the Workarea under Settings> Commerce > Configuration >Messages.
For more information, see eCommerce Messages on page 17-81.

AdvancedEmailActivity
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There are two event handler properties in this activity that allow you to add custom code to
the SendingEmail and SentEmail events. The SendingEmail event fires right before the
email is sent. The SentEmail event fires right after the email sent.

This section also contains the following topics.

Key Properties 17-248
AdvancedEmailActivity vs. BasicEmailActivity 17-248
AdvancedEmailActivity Properties 17-248

Key Properties
n EmailArgs - Set this property to OrderId to associate the activity with orders

in Ektron CMS400.NET.

n MessageTypes - Set this property to the type of email message this activity
sends.

AdvancedEmailActivity vs. BasicEmailActivity
The AdvancedEmailActivity allows you to associate email activity with orders in Ektron
CMS400.NET. You can either supply information such as, To:, From:, Body:, etc. or use
information associated with the order. It also allows you to specify the type of message
type that’s sent.

The BasicEmailActivity, on the other hand, is a generic email activity where you specify
To:, From:, Body:, and other email information.

AdvancedEmailActivity Properties
The following table explains the properties of the AdvancedEmailActivity workflow activity.

Property Description
Data
Type

Activities

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Email Message
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Property Description
Data
Type

Bcc

A blind carbon copyof the email is sent to the addressentered in this property.

If you selectOrderId for the EmailArgsproperty, theBcc property is
dynamically populated with the order’s information.

String

Body

Enter themain content of the email.

If you select a parameter from the MessageTypeproperty, theBody property
uses the corresponding content for that message type.

String

CC

A carbon copyof the email is sent to the email addressentered in this property.

If you selectOrderId for the EmailArgsproperty, theCC property is
dynamically populated with the order’s information.

String

From

The address fromwhich the email is sent.

If you selectOrderId for the EmailArgsproperty, theCC property is
dynamically populated with the order’s information.

String

HtmlBody

Select whether to send the email in HTML or plain text. Default isTrue.

Choicesare:

True - send the bodyof the email in HTML.

False - send the bodyof the email as plain text.

Boolean

ReplyTo Specify the address to which the recipient of the email replies. String

Subject

Enter subject information for the email.

If you select a parameter from the MessageTypeproperty, theSubject
property uses the subject information for that message type.

String

To

The email is sent to the address in this property.

If you selectOrderId for the EmailArgsproperty, theTo property is
dynamically populated with the order’s email information.

String

Email Server

Port

Set this value to the port your system usesaccess to retrieve email. In most
cases, the port is set to 25. If that is not the case, see your SystemAdministrator.

The default is25

If blank, this property uses theek_SMTPPort value in the site’sweb.config file.

Integer

SmtpHost
The addressof the server hosting the email system.

If blank, this property uses theek_SMTPServer in the site’sweb.config file.
String

Handlers

SendingEmail Event handler to add custom code to the sending email event. This event fires
right before the email is sent. String
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Property Description
Data
Type

SentEmail Event handler to add custom code to the sent email event. This event fires right
after the email is sent. String

Misc

EmailArgs

SelectOrderId to dynamically associate this activitywith orders in Ektron
CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

MessageType

Select the type of message that is sent for this activity. If you select None, the
message is sent with the text in the Bodyproperty, The default isNone. Choices
are:

n None - uses the text in the Bodyproperty.

n OrderReceived - Sends theOrder Received email defined in theWorkarea
>Settings >eCommerce >Configuration >Messages screen when an
order is received.

n OrderCancelled - Sends theOrder Cancelled email defined in the
Workarea >Settings >eCommerce >Configuration >Messages screen
when an order is received.

OrderShipped - Sends theOrder Confirmation email defined in theWorkarea
>Settings >eCommerce >Configuration >Messages screen when an
order is received.

For additional information on defining thesemessages, see eCommerce
Messageson page 17-81.

BasicEmailActivity
Add the Basic Email activity to a workflow when you want to send an email after an event
takes place in the workflow. These emails are usually generic and contain the same
information for To:, From:, Subject, Body, etc.

There are two event handler properties in this activity that allow you to add custom code to
the SendingEmail and SentEmail events. The SendingEmail event fires right before the
email is sent. The SentEmail event fires right after the email sent. For example, you want
to notify a supervisor when orders are received, but you don’t want the notification to
contain any order specific information.

This section also contains the following topics.

Key Properties 17-250
BasicEmailActivity vs. AdvancedEmailActivity 17-251
BasicEmailActivity Properties 17-251

Key Properties
n To - enter the address to receive the email.
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n From - enter the address from which the email is being sent.

n Subject - enter a brief summary for the email.

n Body - enter the main subject text of the email.

BasicEmailActivity vs. AdvancedEmailActivity
BasicEmailActivity sends a generic email. In the activity, you specify To:, From:, Body:,
and other email information.

The AdvancedEmailActivity, on the other hand, allows you to send an email associated
with orders in Ektron CMS400.NET. You can either supply information such as, To:, From:,
Body:, etc. or use information associated with the order. It also allows you to specify the
type of message type that’s sent.

BasicEmailActivity Properties
The following table explains the properties of the BasicEmailActivity workflow activity.

Property Description
Data
Type

Activities

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Email Message

Bcc A blind carbon copyof the email is sent to the addressentered in this property. String

Body Enter themain content of the email. String

CC A carbon copyof the email is sent to the email addressentered in this property. String

From The address fromwhich the email is sent. String

HtmlBody

Select whether to send the email in HTML or plain text. Default isTrue.

Choicesare:

True - send the bodyof the email in HTML.

False - send the bodyof the email as plain text.

Boolean

BasicEmailActivity vs. AdvancedEmailActivity
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Property Description
Data
Type

ReplyTo Specify the address to which the recipient of the email replies. String

Subject Enter a brief summary for the email. String

To The email is sent to the address in this property. String

Email Server

Port

Set this value to the port your system access to retrieve email. In most cases, the
port is set to 25. If that is not the case, see your SystemAdministrator.

The default is25

If blank, this property uses theek_SMTPPort value in the site’sweb.config file.

Integer

SmtpHost
The addressof the server hosting the email system.

If blank, this property uses theek_SMTPServer in the site’sweb.config file.
String

Handlers

SendingEmail Event handler to add custom code to the sending email event. String

SentEmail Event handler to add custom code to the sent email event. String

OrderCapturedEventActivity
Add the OrderCapturedEventActivity to a workflow when you want to block the workflow
from continuing down a path until the order has actually been captured.

This activity does not capture the order. It waits for a user or API code tomark the order as
captured in Ektron CMS400.NET before it continues down the path. Think of it as gate
that’s waiting for a certain event to happen before it can continue. Once the event
happens, the path is opened in the workflow.

For information on how an order is captured in the Workarea, see Capturing the Order on
page 17-192.

This section also contains the following topics.

Key Properties 17-252
OrderCapturedEventActivity Properties 17-253

Key Properties
n OrderId - dynamically associate this activity with orders in Ektron

CMS400.NET.
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OrderCapturedEventActivity Properties
The following table explains the properties of the OrderCapturedEventActivity workflow
activity.

Property Description
Data
Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles

Handlers

Invoked Specify code that executeswhen the order hasbeen captured. String

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in Ektron
CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

CaptureOrderActivity
The CaptureOrderActivity initiates the capture of an order in Ektron CMS400.NET.When
the Workflow reaches this activity, the process of submitting encrypted order information
(including the transaction ID) to a payment gateway account happens. At this time, the
account is changed for the order amount.

Use this activity when you want the capture to take place automatically in the Workflow.
This activity is the same as a Ektron CMS400.NET user going to the Workarea and
marking an order as Captured. For information on how a Capture works in the Workarea,
see Capturing the Order on page 17-192.

This section also contains the following topics.

Key Properties 17-254
CaptureOrderActivity Properties 17-254
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Key Properties
n orderId - associate this activity with orders in Ektron CMS400.NET.

CaptureOrderActivity Properties
The following table explains the properties of the CaptureOrderActivity workflow activity.

Property Description
Data
Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Handlers

MethodInvoking Select amethod to call before the order is captured.

Misc

orderId

SelectOrderId to dynamically associate this activitywith orders in Ektron
CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

CheckStockActivity
Add the CheckStockActivity to a workflow when you want to verify the quantity of items
ordered is available for shipping. When the workflow reaches this activity, the quantity of
each product in the order is checked. If the required quantity exists for each item, the
activity returns True. Otherwise, the activity returns False.
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Key Properties
n orderId - dynamically associate this activity with orders in Ektron

CMS400.NET.

CheckStockActivity Properties
The following table explains the properties of the CheckStockActivity workflow activity.

Property Description
Data
Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Handlers

MethodInvoking Select amethod to call before the stock level is checked.

Misc

orderId

SelectOrderId to dynamically associate this activitywith orders in Ektron
CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

ReturnValue

Default isFalse.Choicesare:

True - the quantity of each product ordered is in stock.

False - there is not enough product in stock to fulfill the order.

Boolean

OrderCancelledEventActivity
Add the OrderCancelledEventActivity to a workflow when you want to block the workflow
from going down a cancel path until the order has actually been canceled.

This activity does not cancel the order. It waits for a user, API code or
UpdateOrderActivity to mark the order cancelled in Ektron CMS400.NET before it
continues down the order cancel path. Think of it as gate that’s waiting for a certain event
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to happen before it can continue. Once the event happens, the path is opened in the
workflow.

For information on how to cancel an order in the Workarea, see Canceling the Order on
page 17-194.

This section also contains the following topics.

Key Properties 17-256
OrderCancelledEventActivity Properties 17-256

Key Properties
n OrderId - dynamically associate this activity with orders in Ektron

CMS400.NET.

OrderCancelledEventActivity Properties
The following table explains the properties of the OrderCancelledEventActivity workflow
activity.

Property Description
Data
Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles

Handlers

Invoked Specify code that executeswhen the order is cancelled. String

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in Ektron
CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.
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OrderFraudEventActivity
Add the OrderFraudEventActivity to a workflow when you want to block the workflow from
going down a path that handles fraudulent orders until the order has actually been
marked as fraud.

This activity does not mark the order as fraudulent. It waits for a user, API code or the
UpdateOrderActivity to mark the order as fraud in Ektron CMS400.NET before it continues
down the path. Think of it as gate that’s waiting for a certain event to happen before it can
continue. Once the event happens, the path is opened in the workflow.

For information on how tomark an order as fraud in the Workarea, seeMarking the Order
as Fraud on page 17-195.

This section also contains the following topics.

Key Properties 17-257
OrderFraudEventActivity Properties 17-257

Key Properties
n OrderId - dynamically associate this activity with orders in Ektron

CMS400.NET.

OrderFraudEventActivity Properties
The following table explains the properties of the OrderFraudEventActivity workflow
activity.

Property Description
Data
Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles

Handlers

OrderFraudEventActivity
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Property Description
Data
Type

Invoked Specify code that executeswhen the order hasbeenmarked as fraud. String

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in Ektron
CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

OrderProcessedEventActivity
Add the OrderProcessedEventActivity to a workflow when you want to block the workflow
from going down an order process path until the order has actually been processed. This is
a generic event activity that allows you to specify custom code to somehow process the
order.

This activity does not start the process. It waits for a user, API code or the
UpdateOrderActivity to kick off the Process Order action in Ektron CMS400.NET before it
continues down the path. Think of it as gate that’s waiting for a certain event to happen
before it can continue. Once the event happens, the path is opened in the workflow.

For information on how to cancel an order in the Workarea, see Canceling the Order on
page 17-194.

This section also contains the following topics.

Key Properties 17-258
OrderProcessedEventActivity Properties 17-258

Key Properties
n OrderId - dynamically associate this activity with orders in Ektron

CMS400.NET.

OrderProcessedEventActivity Properties
The following table explains the properties of the OrderProcessedEventActivity workflow
activity.

Property Description
Data
Type

Activity

(Name) Enter a name for the Activity. String
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Property Description
Data
Type

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles

Handlers

Invoked Specify code that executeswhen the order hasbeen processed. String

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in Ektron
CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

OrderReceivedEventActivity
The OrderReceivedEventActivity is usually the first item in an order workflow. This activity
does not mark the order as received, but insteadwaits for Ektron CMS400.NET to register
a new order. Once the order is received, this activity allows the workflow to start. Think of
it as gate that’s waiting for a certain event to happen before it can continue. Once the
event happens, the path is opened in the workflow.

This section also contains the following topics.

Key Properties 17-259
OrderReceivedEventActivity Properties 17-259

Key Properties
n OrderId - dynamically associate this activity with orders in Ektron

CMS400.NET.

OrderReceivedEventActivity Properties
The following table explains the properties of the OrderReceivedEventActivity workflow
activity.

OrderReceivedEventActivity
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Property Description
Data
Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles

Handlers

Invoked Specify code that executeswhen the order hasbeen received. String

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in Ektron
CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

OrderShippedEventActivity
Add the OrderShippedEventActivity to a workflow when you want to block the workflow
from going down a shipped order path until the order has actually been shipped.

This activity does not mark the order as shipped. It waits for a user, API code or
UpdateOrderActivity to mark the order as shipped in Ektron CMS400.NET before it
continues down the path. Think of it as gate that’s waiting for a certain event to happen
before it can continue. Once the event happens, the path is opened in the workflow.

For information on how tomark an order as shipped in the Workarea, seeMarking the
Order as Shipped on page 17-195.

This section also contains the following topics.

Key Properties 17-260
OrderShippedEventActivity Properties 17-261

Key Properties
n OrderId - dynamically associate this activity with orders in Ektron

CMS400.NET.
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OrderShippedEventActivity Properties
The following table explains the properties of the OrderShippedEventActivity workflow
activity.

Property Description
Data
Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles

Handlers

Invoked Specify code that executeswhen the order is shipped. String

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in Ektron
CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

OrderUpdatedEventActivity
Add the OrderUpdatedEventActivity to a workflow when you want to block the workflow
from going down an updating order path until the order has actually been updated.

This activity does not update the order as shipped. It waits for a user, API code or
UpdateOrderActivity to update an order in Ektron CMS400.NET before it continues down
the path. Think of it as gate that’s waiting for a certain event to happen before it can
continue. Once the event happens, the path is opened in the workflow.

This section also contains the following topics.

Key Properties 17-262
OrderUpdatedEventActivity Properties 17-262
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Key Properties
n OrderId - dynamically associate this activity with orders in Ektron

CMS400.NET.

OrderUpdatedEventActivity Properties
The following table explains the properties of the OrderUpdatedEventActivity workflow
activity.

Property Description
Data
Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Roles

Handlers

Invoked Specify code that executeswhen the order hasbeen updated. String

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in Ektron
CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.

UpdateOrderActivity
Add the UpdateOrderActivity to a workflow when you want to automate the updating of an
order’s status in one of the these ways:

n Received -marks an order as received

n InProcess -marks the order as in process

n Shipped -marks the order as shipped
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n Completed -marks the order as completed

n Canceled -marks the order as canceled

n OnHold - puts the order on hold

n Fraud -marks the order as fraud

This activity is the same as a Ektron CMS400.NET user going to the Workarea and
performing any of the above actions on an order. For information on how tomanually
complete these tasks in the Workarea, see Orders on page 17-189.

This section also contains the following topics.

UpdateOrderActivity Properties 17-263

UpdateOrderActivity Properties
The following table explains the properties of the UpdateOrderActivity workflow activity.

Property Description
Data
Type

Activity

(Name) Enter a name for the Activity. String

Description Enter a description for the Activity. String

Enabled

Set to true to enable this activity in the workflow.

Default isTrue.

Choicesare:

True - enable the activity.

False - disable the activity.

Boolean

Handlers

MethodInvoking

Misc

OrderId

SelectOrderId to dynamically associate this activitywith orders in Ektron
CMS400.NET.

Click the Ellipsis ( ) button and selectOrderId from the list.
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Property Description
Data
Type

orderStatus

Default isReceived. Choicesare:

Received - marksan order as received

InProcess -

Shipped - marks the order as shipped

Completed - marks the order as completed

Canceled - marks the order as canceled

OnHold - puts the order on hold

Fraud - marks the order as fraud

Customizing the Payment Gateway
Provider
Note: To see a webinar on this topic, go to http://www.ektron.com/webinar/creating-your-own-
payment-gateway-provider/.

A Payment Gateway Provider is a pluggable component that is integrated into
Ektron’s Ektron CMS400.NET eCommerce module. A Payment provider handles
eCommerce customer payments by utilizing third party payment gateways.
Ektron CMS400.NET’s eCommerce module accepts payments such as credit
cards. Then, it passes that information to a third party service. The third party
service processes the payment, and returns a transaction ID that’s stored with
the customer's order.

Note: Your company needs to set up an account with a third party payment service before
utilizing the payment provider. This includes payment providers such as Authorize.NET and
PayFlow, which are included with Ektron CMS400.NET’s eCommerce Module.

Ektron CMS400.NET comes with several payment providers, including
Authorize.NET and PayFlow. You can customize these providers or create your
own using the extendable Payment Gateway Provider architecture.

Each type of payment gateway provider accepts configuration parameters. For
example, Authorize.NET requires a username and password while PayFlow
requires a username, password, vendor, and partner.

In addition, some payment gateways may support recurring payments, while
others may not. Recurring payments provide the ability to create a payment
that recurs at a given interval for a specified period of time. For example, you
could create a payment for $9.99 that occurs on the first of every month for the
next 12 months. This is something to consider if your site relies on a
subscription service. Contact your provider to find out if they support recurring
payments.
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The following table shows the flow of payment information for a customer
purchasing a product from your site through you receiving the money in your
account.

Step Description

1. A customer purchasesa product from your site and submits his payment information.

2. Ektron Ektron CMS400.NET’spasses the information to your payment gateway.

3. Your payment gatewayprovider passes the information to your bank’s processor.

4. The bank’s processor submits the information to a credit card interchange for processing,
clearing and settlement.

5. The interchange notifies the customer’s credit card companyof the transactionsdetails.

6. The credit card companyaccepts or declines the transaction based on the customers
account information.

7. If the transaction is approved, the fundsare transferred to the interchange.

8. The credit card interchange sends information about whether the transaction is approved to
your bank’s processor.

9. This information is passed to your payment gatewayprovider.

10. The provider notifies your site of the information. The results of the transaction are displayed
on the page the customer is viewing.

11. The credit card interchange sends funds to your merchant account.

This section explains how to extend Ektron’s Payment Gateway Provider
Architecture to build your own customized Payment Gateway Provider.

See Also: Payment Options on page 17-61

This section also contains the following topics.

Payment Gateway Provider Object Model 17-265
Creating a Custom Payment Gateway Provider 17-266
Making Your Custom Provider Appear as an Option in the Work-
area

17-
271

CustomGatewayProvider Code Example 17-272

Payment Gateway Provider Object Model
Below is the Object Model for Ektron’s Payment Gateway Provider.
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The PaymentGatewayProvider is the abstract base class you must extend to
implement your own payment gateway. Details and descriptions of the
PaymentGatewayProvider API can be found in the Ektron CMS400.NETAPI
Reference Manual’s Providers API > PaymentGatewayProvider section.

Creating a Custom Payment Gateway
Provider
In addition to the out-of-the-box payment gateways providers shipped with
Ektron CMS400.NET, you can create your own custom payment providers that
connect with any payment gateway you choose. Below are the basic code steps
you need to complete when creating a custom gateway provider. Additional
code examples used by Ektron to create the PayFlow and Authourize.NET
providers are located in: C:\Program
Files\Ektron\CMS400SDK\Commerce\Providers\Commerce.Providers\PaymentGateways

Note: The complete C# code sample used in this example is available at the end of this
section. See CustomGatewayProvider Code Example on page 17-272

1. Create a class library project in Visual Studio.

2. Add references to these DLLs:
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Ektron.Cms.Commerce

Ektron.Cms.Common

Ektron.Cms.ObjectFactory

Ektron.Cms.Instrumentation

System.Configuration

3. Add these using statements to the code behind:

using System;

using System.Collection;

using System.Collection.Specialized;

using Ektron.Cms;

using Ektron.Cms.Common;

using Ektron.Cms.Commerce;

4. Change the namespace to:

namespace Ektron.Cms.Extensibility.Commerce.Samples

{

5. Rename your class and inherit as below:

public class CustomPaymentProvider :
Ektron.Cms.Commerce.PaymentGatewayProvider

{

6. Add the following constructor.

#region constructor, member variables

public CustomPaymentProvider() { }

#endregion

7. Add the methods required by the PaymentGatewayProvider base
class. The Initialize method reads configuration information, the
others are related to the payments and will be completed later in the
example.
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#region PaymentProvider Implementation

public override void Initialize(string name,
System.Collections.Specialized.NameValueCollection config)

{

if (config == null)

throw new ArgumentNullException("config");

// Assign the provider a default name if it doesn't have one

if (String.IsNullOrEmpty(name))

name = "CustomPaymentProvider";

if (string.IsNullOrEmpty(config["description"]))

{

config.Remove("description");

config.Add("description", "CustomPaymentProvider");

}

// Call the base class's Initialize method

base.Initialize(name, config);

// Throw an exception if unrecognized attributes remain

if (config.Count > 0)

{

foreach (string key in config.AllKeys)

{

EkException.WriteToEventLog("Unrecognized Payment Gateway Provider attribute:
" + key, System.Diagnostics.EventLogEntryType.Warning);

}

}

}

public override string Authorize()

{

}

public override string AuthorizeAndCapture()

{
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}

public override string CapturePreauthorization(string transactionId)

{

}

public override string VoidPreAuthorization(string transactionId)

{

}

#endregion

8. Implement the Authorize method that you added in the previous
step. This method is called to authorize a given amount of money
when an order is submitted.

public override string Authorize()

{

if (PaymentMethod.GetType() != typeof(CreditCardPayment))

throw new Ektron.Cms.Commerce.Exceptions.AuthorizationException("Invalid
Payment Type");

CreditCardPayment creditCard = (CreditCardPayment)this.PaymentMethod;

if (creditCard.ExpirationDate.IsExpired())

throw new
Ektron.Cms.Commerce.Exceptions.Payment.CreditCard.CardExpiredException("Card
Is Expired");

IsSubmissionSuccess = true;

Authorization.AuthorizedOn = DateTime.Now;

Authorization.TransactionId = new Guid().ToString();

return Authorization.TransactionId;

}

Note: In this example, the card number and card holder name are not checked. In a real world
scenario, there would be additional validation (for example, via checksum) and the
authorization may be obtained via a Web service or HTTP post.

Note: If the authorization fails, you can choose to either throw an exception or manually set the
failure. For example:
SubmissionError = "Not enough Funds";IsSubmissionSuccess =
false;
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9. Implement the AuthorizeAndCapture, CapturePreauthorization and
VoidPreAuthorization methods you added earlier.

- AuthorizeAndCapture requires that Authorization.CapturedOn be
set, as the capture occurs at the same time as the Authorization.

- For CapturePreauthorization and VoidPreAuthorization, set the
appropriate dates for these actions, so they are recorded in the system
properly.

public override string AuthorizeAndCapture()

{

IsSubmissionSuccess = true;

Authorization.AuthorizedOn = DateTime.Now;

Authorization.CapturedOn = DateTime.Now;

Authorization.TransactionId = new Guid().ToString();

return Authorization.TransactionId;

}

public override string CapturePreauthorization(string transactionId)

{

IsSubmissionSuccess = true;

Authorization.CapturedOn = DateTime.Now;

return Authorization.TransactionId;

}

public override string VoidPreAuthorization(string transactionId)

{

IsSubmissionSuccess = true;

Authorization.VoidedOn = DateTime.Now;

return Authorization.TransactionId;

}

10. Save and build the project.

11. Copy your project’s DLL file to your Ektron Web site’s bin directory.

12. Register the provider in your site’sWeb.config file. The Web.config
file provides the facility to manage payment gateway providers within
Ektron CMS400.NET.

To do this, locate the EktronPaymentGateway section and change the
defaultProvider parameter to the name of your custom provider. Note
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that changing this from “Automatic” to the name of your provider
overrides the settings inWorkarea > Settings > Commerce >
Configuration > Payment Gateways. Ektron CMS400.NET will now
use the new provider.

Note: If you start your search from the top of the file, it is the second instance.

<EktronPaymentGateway defaultProvider="CustomPaymentProvider">

13. Add your custom payment provider between the
EktronPaymentGateway’s <providers> tags. Note that the name
defined here must match the defaultProvider from the previous
step.

<providers>

<add name="CustomPaymentProvider"
type="Ektron.Cms.Extensibility.Commerce.Samples.CustomPaymentProvider,
CustomPaymentProvider" />

</providers>

14. Save the Web.config file.

Next, add the payment gateway to the Workarea with the following steps.

15. Go toWorkarea > Commerce > Configuration > Payment
Options.

16. Select New > Payment Gateway.

17. In the Name dropdown, select customerPaymentProvider.

18. Check both Cards and Checks checkboxes.

19. Save these changes.

Your custom payment provider is now the default provider. Whenever a
payment provider needs to be contacted, the information routes through the
new custom provider.

Making Your Custom Provider Appear as an
Option in the Workarea
In the example above, you changed the web.config file’s
EktronPaymentGateway defaultProvider parameter to the name of your custom
payment provider. This overrides the payment provider settings in the
Workarea. If you want to manage all payment providers from theWorkarea >
Settings > Commerce > Configuration > Payment Gateways screen,
follow these steps:
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1. In the Web.config file, locate the EktronPaymentGateway section
and make sure the defaultProvider parameter is set to Automatic.

<EktronPaymentGateway defaultProvider="Automatic">

2. Save the Web.config file.

3. Navigate to theWorkarea > Settings > Commerce >
Configuration > Payment Gateways screen.

4. Click New > Payment Gateway.

5. Use the following table to complete the screen.

Field Description

Name From the drop down list, select the name of the your new custom gateway.

Default
Check this box if you want this to be the default payment gateway. The
default payment gateway is the gatewayall payment information is routed
through.

User ID Enter the User ID for this payment gateway. This ID will identify your
account with this gatewayprovider.

Password Enter the password for your account with this gatewayprovider.

Expand Custom
Values

If this gatewayprovider expects additional parameterswhen contacting it,
enter those values into the Custom 1 and Custom 2 fields.

6. Click the Save button ( ).
The custom gateway provider has been added and can now be managed from
the Workarea.

CustomGatewayProvider Code Example
Warning! Copying and pasting the code below and using it without modification to create a DLL
will not result in a working custom payment provider. This code is provided as an outline of what
is needed to create an actual custom payment provider.

Below is the full C# code example used in this section. See Also: Creating a
Custom Payment Gateway Provider on page 17-266.

using System;
using System.Collections;
using System.Collections.Specialized;
using System.Configuration.Provider;
using Ektron.Cms;
using Ektron.Cms.Common;
using Ektron.Cms.Commerce;
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namespace Ektron.Cms.Extensibility.Commerce.Samples
{
public class CustomPaymentProvider : Ektron.Cms.C-

ommerce.PaymentGatewayProvider
{
public CustomPaymentProvider() { }

public override void Initialize(string name, Sys-
tem.Collections.Specialized.NameValueCollection config)

{
if (config == null throw new ArgumentNullException(;
// Assign the provider a default name if it doesn't have one

if (String.IsNullOrEmpty(name))
name = CustomPaymentProvider"
if string.IsNullOrEmpty(config(["description"]))

{
config.Remove("description");
config.Add("description", "CustomPaymentProvider";
}
// Call the base class's Initialize method

base.Initialize(name, config);
// Throw an exception if unrecognized attributes remain

if (config.Count > 0)
{
foreach (string key in config.AllKeys)
{
EkException.WriteToEventLog("Unrecognized Payment Gateway Provider attrib-

ute: " + key, System.Diagnostics.EventLogEntryType.Warning);
}

}
}
public override string Authorize()
{

if (PaymentMethod.GetType() != typeof(CreditCardPayment))
throw new Ektron.Cms.Commerce.Exceptions.AuthorizationException("Invalid

Payment Type");
CreditCardPayment creditCard = (CreditCardPayment) this.PaymentMethod;
if (creditCard.ExpirationDate.IsExpired())
throw new Ektron.Cms.C-

ommerce.Exceptions.Payment.CreditCard.CardExpiredException( "Card Is
Expired";

IsSubmissionSuccess = true;
Authorization.AuthorizedOn = DateTime.Now;
Authorization.TransactionId = new Guid().ToString();
return Authorization.TransactionId;

}
public override string AuthorizeAndCapture()

{
IsSubmissionSuccess = true;
Authorization.AuthorizedOn = DateTime.Now;
Authorization.CapturedOn = DateTime.Now;
Authorization.TransactionId = new Guid().ToString();
return Authorization.TransactionId;
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}
public override

string CapturePreauthorization(string transactionId)
{
IsSubmissionSuccess = true;
Authorization.CapturedOn = DateTime.Now;
return Authorization.TransactionId;

}
public override string VoidPreAuthorization(string transactionId)

{
IsSubmissionSuccess = true;
Authorization.VoidedOn = DateTime.Now;
return Authorization.TransactionId;
}

}
}

Customizing the Shipment Provider
A Shipping Provider is a pluggable component integrated into Ektron's Ektron
CMS400.NET eCommerce module. The Shipping provider handles eCommerce
real-time shipping rate retrieval by utilizing third party shipping services such
as FedEx or UPS, or you can create your own fixed rate logic. Ektron
CMS400.NET's eCommerce shipping module calculates the package(s) needed
for an order and then passes the following information to the company
providing the shipping services via a Shipping Provider.

n package information - for example, how many, height, width,
depth and weight of each package.

n warehouse address - the address from which the items will be
shipped. A warehouse’s information can be set in theWorkarea >
Settings > Commerce > Shipping >Warehouses screen.

n destination address - the address a customer entered as his
shipping address when making the purchase.

n desired shipping options - for example, if you have Next Day, 2-
Day Ground and 3-Day Ground as shipping options, you can pass the
option chosen by the customer.

Ektron CMS400.NET comes with several shipping providers, including FedEx and
UPS. You can customize these providers or create your own using the
extendable Shipping Provider architecture.

Note: Your company will need to set up or have an existing account with a third party shipping
service before utilizing the shipping provider. This includes shipping providers such as, FedEx
or UPS, which are included with Ektron CMS400.NET's eCommerce Module.

Each type of shipping provider accepts configuration parameters. For example,
FedEx requires a username, password, account number, and meter number
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while UPS requires a Username, password, and account number. These
configuration parameters along with the provider definitions are stored in the
SiteRoot/shipment.config file. Below is a provider definition example for
FedEx.

<add name="FedExShipmentProvider" type="Ektron.Cms.C-
ommerce.Providers.Shipment.FedExShipmentProvider, Ektron.Cms.C-
ommerce.Providers" serviceUrl="https://gatewaybeta.fedex.com/web-services"
key="" password="" accountNumber="" meterNumber="" transactionId="Ektron
FedEx v3

The following steps show the flow of shipping calculations for a customer
purchasing a product from your site.

1. A customer adds two books his to cart and clicks checkout.

2. The shipping calculator looks for the smallest possible package that
will fit the items.

3. The shipping calculator calls the registered shipping provider for each
package in the order.

4. The shipping calculator combines all the rates received if more than
one package is being shipped and returns the shipping method rates
to the checkout control.

5. The customer selects the desired shipping method and it is saved
with the cart.

Note: Many Ektron CMS400.NET settings affect your shipping calculations. A default
warehouse must be defined with a valid shipping address. Shipping methods you would like
to offer customers must be defined. For example, the FedEx provider supports over 10
possible shipping methods, but you may only be concerned with Priority, 2 Day, and Ground.
This must be defined in Ektron CMS400.NET. You can also define the shipping packages your
business uses. The Shipping calculator will try and fit the order items into any packages
defined in the CMS. If no packages are defined, the item's dimensions are passed to the
provider instead.

This section also contains the following topics.

Shipment Provider Object Model 17-275
Creating a Custom Shipment Provider 17-276
CustomShipmentProvider Code Example 17-282

Shipment Provider Object Model
Below is the Object Model for Ektron’s Shipment Provider.
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The ShipmentProvider is the abstract base class you must extend to implement
your own Shipping Provider. Details and descriptions of the ShipmentProvider
API can be found in the Ektron CMS400.NET API Reference Manual’s Providers
API > Shipment > Provider > ShipmentProvider.

Creating a Custom Shipment Provider
In addition to the out-of-the-box shipment providers that come with Ektron
CMS400.NET, you can create a custom provider that connects with any shipping
company you choose. Below are the basic code steps you need to complete
when creating a custom shipment provider. Additional code examples used by
Ektron to create FedEx, Flat Rate and UPS shipment providers are located in:
C:\Program
Files\Ektron\CMS400SDK\Commerce\Providers\Commerce.Providers\Shipping

Note: The complete C# code sample used in this example is available at the end of this
section. See CustomShipmentProvider Code Example on page 17-282

1. Create a class library project in Visual Studio.

2. Add references to these DLLs:

- Ektron.Cms.Commerce

- Ektron.Cms.Common

- Ektron.Cms.ObjectFactory

- Ektron.Cms.Instrumentation

- System.Configuration

3. Add these using statements to the code behind:
- using System.Configuration.Provider;

- using Ektron.Cms.Commerce.Shipment.Provider;

- using Ektron.Cms.Commerce;
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- using Ektron.Cms.Instrumentation;

4. Change the namespace to:
namespace Ektron.Cms.Extensibility.Commerce.Samples

{

5. Rename your class and inherit as below:
public class CustomShipmentProvider : ShipmentPovider

{

6. Add the following constructor private variables and properties. The
items added to the shippingOptionList are the shipping methods
exposed as a service type in the management screen inside the
Workarea.

#region constructor, member variables

public CustomShipmentProvider()

{

IsTrackingSupported = false;

_shippingOptionList = new List<string>();

_shippingOptionList.Add("CustomOption_1");

_shippingOptionList.Add("CustomOption_2");

}

private List<string> _shippingOptionList;

#endregion

7. Add the following methods required by the ShipmentProvider base
class.

Initialize - reads configuration information

GetServiceTypes - returns a List <string> of the shipping options
available

GetTrackingUrl - exposes tracking support

GetRates - returns a list of shipping rates for the items being
shipped. The contents of this method will be added in the next step.

#region ShipmentProvider Implementation

public override void Initialize(string name,
System.Collections.Specialized.NameValueCollection config)
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{

if (config == null)

throw new ArgumentNullException("config");

// Assign the provider a default name if it doesn't have one

if (string.IsNullOrEmpty(name))

name = "CustomShipmentProvider";

if (string.IsNullOrEmpty(config["description"]))

{

config.Remove("description");

config.Add("description", "CustomShipmentProvider Provider");

}

// Call the base class's Initialize method

base.Initialize(name, config);

// Throw an exception if unrecognized attributes remain

if (config.Count == 0)

throw new ProviderException("Shipment provider attribute
missing.");

else

{

//read all config attributes.

ServiceUrl = config["serviceUrl"];

Key = config["key"];

Password = config["password"];

AccountNumber = config["accountNumber"];

MeterNumber = config["meterNumber"];

TransactionId = config["transactionId"];

}

}

public override List<string> GetServiceTypes()
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{

return _shippingOptionList;

}

public override string GetTrackingUrl(string trackingId)

{

return "";

}

public override List<ShippingOptionData>
GetRates(IEnumerable<ShippingMethodData> expectedOptions,
AddressData origin, AddressData destination, Weight weight,
Dimensions dimensions)

{

}

#endregion

8. Implement the GetRates method. Add this code to public override for
GetRates which was added during the previous step. When complete,
the code should look like this.

Note: This example uses flat rates for your shipping methods. In a real world scenario, the
shipping methods and their corresponding rates can be obtained via FedEx, UPS, a third party
application or a Web service.

public override List<ShippingOptionData>
GetRates(IEnumerable<ShippingMethodData> expectedOptions, AddressData
origin, AddressData destination, Weight weight, Dimensions dimensions)

{

List<ShippingOptionData> availableOptions = new
List<ShippingOptionData>();

try

{

foreach (ShippingMethodData expectedOption in expectedOptions)

{

Log.WriteInfo("Custom Shipping Provider. ExpectedOption:" +
expectedOption.Name);
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switch (expectedOption.ProviderService.ToLower())

{

case "customoption_1":

ShippingOptionData customOption1 = new ShippingOptionData();

customOption1.Id = expectedOption.Id;

customOption1.Name = expectedOption.Name;

customOption1.ShippingFee = 25.00M;

customOption1.ProviderService = "CustomOption_1";

availableOptions.Add(customOption1);

break;

case "customoption_2":

ShippingOptionData customOption2 = new ShippingOptionData();

customOption2.Id = expectedOption.Id;

customOption2.Name = expectedOption.Name;

customOption2.ShippingFee = 50.00M;

customOption2.ProviderService = "CustomOption_2";

availableOptions.Add(customOption2);

break;

}

}

}

catch (Exception e)

{

Log.WriteError("Custom Shipping Provider: Error retrieving
shipping rates." + e.Message);

throw;

}

return availableOptions;

}
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}

}

Note: You can use the GetRates method to restrict countries to which you ship. For example, if
you want to prevent shipping to all countries except Canada, add these lines of code to the
GetRates method.

if (destination.Country.Id != 124)

throw new
Ektron.Cms.Commerce.Exceptions.Shipping.
InvalidAddressException("We only ship to Canada.");

9. Save and build the project.

10. Copy your project’s DLL file to your Ektron Web site’s bin directory.

11. Register the provider in your site’s shipment.config file. This file
provides the facility to manage shipping providers within Ektron
CMS400.NET. Locate the shipmentProvider section and change the
defaultProvider parameter to the name of your custom provider.

<shipmentProvider defaultProvider="CustomShipmentProvider">

12. Add your custom shipping provider between the shipmentProvider’s
<providers> tags. Note that the name defined here needs to match
the name defined as the defaultProvider in the previous step.

<providers>

<add name="CustomShipmentProvider"
type
=
"Ektron.Cms.Extensibility.Commerce.Samples.CustomShipmentProvider,
CustomShipmentProvider" serviceUrl="" key="" password=""
accountNumber="" meterNumber=""
transactionId="CustomShipmentProvider based transaction" />

</providers>

13. Save the Web.config file.

Your custom shipping provider is now the default provider. Whenever
you need to obtain shipping rate information, the information routes
through the new custom provider.
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14. Add the shipping methods that are available for your provider in the
Workarea > Settings > Commerce -> Shipping > Methods
screen.

a. Select New > Shipping Method.

b. Enter a name. This is what a customer sees during the
checkout process. An example is “Ground” or “Next Day”.
For this example, use “Custom1”.

c. Check the Active checkbox.

d. Click the View Options link and select CustomOption_1
from the list.

e. Click the Save button ( ).
f. Repeat this process for the CustomOption2 shipping
method type.

The options are now available in the checkout process, and are shown on the
shipping method selection screen.

CustomShipmentProvider Code Example
Warning! Copying and pasting the code below and using it without modification to create a DLL
does not result in a working “real time” shipping provider. This example uses fixed rates and
should be modified to meet your needs.

Below is the full C# code example used in this section. See Also: Creating a
Custom Shipment Provider on page 17-276.

using System.Configuration.Provider;

using Ektron.Cms.Commerce.Shipment.Provider;

using Ektron.Cms.Commerce;

using Ektron.Cms.Instrumentation;

namespace Ektron.Cms.Extensibility.Commerce.Samples

{

public class CustomShipmentProvider : ShipmentProvider

{

#region constructor, member variables

public CustomShipmentProvider()

{

IsTrackingSupported = false;

_shippingOptionList = new List<string>();
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_shippingOptionList.Add("CustomOption_1");

_shippingOptionList.Add("CustomOption_2");

}

private List<string> _shippingOptionList;

#endregion

#region ShipmentProvider Implementation

public override void Initialize(string name,
System.Collections.Specialized.NameValueCollection config)

{

if (config == null)

throw new ArgumentNullException("config");

// Assign the provider a default name if it doesn't have one

if (string.IsNullOrEmpty(name))

name = "CustomShipmentProvider";

if (string.IsNullOrEmpty(config["description"]))

{

config.Remove("description");

config.Add("description", "CustomShipmentProvider Provider");

}

// Call the base class's Initialize method

base.Initialize(name, config);

// Throw an exception if unrecognized attributes remain

if (config.Count == 0)

throw new ProviderException("Shipment provider attribute missing.");

else

{

//read all config attributes.

ServiceUrl = config["serviceUrl"];

Key = config["key"];

Password = config["password"];

AccountNumber = config["accountNumber"];
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MeterNumber = config["meterNumber"];

TransactionId = config["transactionId"];

}

}

public override List<string> GetServiceTypes()

{

return _shippingOptionList;

}

public override string GetTrackingUrl(string trackingId)

{

return "";

}

public override List<ShippingOptionData>
GetRates(IEnumerable<ShippingMethodData> expectedOptions, AddressData origin,
AddressData destination, Weight weight, Dimensions dimensions)

{

List<ShippingOptionData> availableOptions = new
List<ShippingOptionData>();

try

{

foreach (ShippingMethodData expectedOption in expectedOptions)

{

Log.WriteInfo("Custom Shipping Provider. ExpectedOption:" +
expectedOption.Name);

switch (expectedOption.ProviderService.ToLower())

{

case "customoption_1":

ShippingOptionData customOption1 = new ShippingOptionData();

customOption1.Id = expectedOption.Id;

customOption1.Name = expectedOption.Name;

customOption1.ShippingFee = 25.00M;

customOption1.ProviderService = "CustomOption_1";
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availableOptions.Add(customOption1);

break;

case "customoption_2":

ShippingOptionData customOption2 = new ShippingOptionData();

customOption2.Id = expectedOption.Id;

customOption2.Name = expectedOption.Name;

customOption2.ShippingFee = 50.00M;

customOption2.ProviderService = "CustomOption_2";

availableOptions.Add(customOption2);

break;

}

}

}

catch (Exception e)

{

Log.WriteError("Custom Shipping Provider: Error retrieving shipping rates." +
e.Message);

throw;

}

return availableOptions;

}

#endregion

}

}

Customizing the Inventory Provider
An Inventory Provider is a pluggable component that’s integrated into Ektron's
Ektron CMS400.NET eCommerce module. An Inventory Provider handles the
retrieving and updating of inventory information for products within the CMS.
Out of the Box, the Ektron CMS400.NET comes with a default Ektron Inventory
Provider that tracks inventory within the CMS database.

If your business has an Accounting or Enterprise Resource Management
solution that manages inventory, you can create a custom Inventory Provider
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that retrieves and updates inventory information directly from that system.
Inventory data can be stored in any number of locations, including databases,
ERP or CRM systems, or even XML files.

This section also contains the following topics.

Inventory Provider Object Model 17-286
Creating a Custom Inventory Provider 17-286
CustomInventoryProvider Code Example 17-289

Inventory Provider Object Model
Below is the Object Model for Ektron’s Inventory Provider.

The InventoryProvider is the abstract base class you must extend to implement
your own Inventory Provider. Details and descriptions of the InventoryProvider
API can be found in the Ektron CMS400.NET API Reference Manual’s Providers
API > Inventory > Provider > InventoryProvider.

Creating a Custom Inventory Provider
In addition to the out-of-the-box inventory provider that comes with Ektron
CMS400.NET, you can create your own custom provider that connects with an
existing inventory system. Below are the basic code steps you need to complete
when creating a custom inventory provider. A code example for the inventory
provider used by Ektron CMS400.NET is located in:

C:\Program Files\Ektron\CMS400SDK\Commerce\Providers\Commerce.Providers\Inventory

Note: The complete C# code sample used in this example is available at the end of this
section. See CustomInventoryProvider Code Example on page 17-289

1. Create a class library project in Visual Studio.

2. Add references to these DLLs:

Ektron.Cms.Commerce

Ektron.Cms.Common
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Ektron.Cms.ObjectFactory

System.Configuration

3. Add these using statements to the code behind:

using Ektron.Cms.Commerce.Inventory.Provider;

using Ektron.Cms.Commerce.Data;

using Ektron.Cms.Commerce;

using Ektron.Cms.Common;

using Ektron.Cms.Extensibility;

using Ektron.Cms.Extensibility.Commerce;

4. Change the namespace to:

namespace Ektron.Cms.Extensibility.Commerce.Samples

{

5. Rename your class and inherit as below:

public class CustomInventoryProvider : InventoryPovider

{

6. Add the following constructor, private variables and properties.

public CustomInventoryProvider() { }private CmsInventory _inventory;

protected CmsInventory Inventory

{

get

{

if (_inventory == null)

{

_inventory = new CmsInventory(RequestInformation);

}

return _inventory;
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}

}

7. Override the following methods. These methods area called when the
inventory system is queried.

GetInventory - returns an InventoryData data class for a given prod-
uct id.

SaveInventory - persists updates to the stock levels inside the inven-
tory system.
In this example, we trigger Ektron CMS400.NET extensibility events,
such as OnBeforeInventorySave() and OnAfterInventorySave(). In a
real world scenario, your existing inventory system may have its own
inventory events that are used.

public override InventoryData GetInventory(long entryId)

{

return Inventory.GetInventory(entryId);

}

public override void SaveInventory(InventoryData inventory)

{

OnBeforeInventorySave(inventory);

Inventory.SaveInventory(inventory);

OnAfterInventorySave(inventory);

if (inventory.UnitsInStock < inventory.ReorderLevel)

{

OnInventoryReorderLevelReached(inventory);

}

}

}

}

8. Save and build the project.

9. Copy your project’s DLL file to your Ektron web site’s bin directory.
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10. Register the provider in your site’sWeb.config file. The Web.config
file provides the facility to manage inventory providers within Ektron
CMS400.NET. Locate the InventoryProvider section and change the
defaultProvider parameter to the name of your custom provider.

Note: If you start your search from the top of the file, it will be the second instance.

<inventoryProvider defaultProvider="CustomInventoryProvider">

11. Add your custom payment provider between the
EktronPaymentGateway’s <providers> tags. Note that the name
defined here needs to match the name defined as the defaultProvider
in the previous step.

<providers>

<add name="CustomInventoryProvider"
type
=
"
Ektron.Cms.Extensibility.Commerce.Samples.CustomInventoryProvider,
CustomInvnetoryProvider" />

</providers>

12. Save the Web.config file.

Your custom inventory provider is now the default provider. Whenever the
inventory is queried, the call routes through the new custom provider.

CustomInventoryProvider Code Example
Warning! Copying and pasting the code below and using it without modification to create a DLL
does not result in a working “real time” shipping provider. This example uses fixed rates and
should be modified to meet your needs.

Below is the full C# code example used in this section. See Also: Creating a
Custom Inventory Provider on page 17-286.

using Ektron.Cms.Commerce.Inventory.Provider;

using Ektron.Cms.Commerce.Data;

using Ektron.Cms.Commerce;

using Ektron.Cms.Common;

using Ektron.Cms.Extensibility;

using Ektron.Cms.Extensibility.Commerce;
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namespace Ektron.Cms.Extensibility.Commerce.Samples

{

public class CustomInventoryProvider : InventoryProvider

{

public CustomInventoryProvider() { }private CmsInventory _inventory;

protected CmsInventory Inventory

{

get

{

if (_inventory == null)

{

_inventory = new CmsInventory(RequestInformation);

}

return _inventory;

}

}

public override InventoryData GetInventory(long entryId)

{

return Inventory.GetInventory(entryId);

}

public override void SaveInventory(InventoryData inventory)

{

OnBeforeInventorySave(inventory);

Inventory.SaveInventory(inventory);

OnAfterInventorySave(inventory);

if (inventory.UnitsInStock < inventory.ReorderLevel)

{

OnInventoryReorderLevelReached(inventory);

}

}
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}

}

Customizing Shipping Calculations
The shipping system provides an easy and extensible way to override the
shipping calculations insideEktron CMS400.NET. This example sets up a custom
shipping calculator to get shipping rates with a different source location for a
class of products. It has two major parts.

n Creating the Calculator Code below

n Register the Event with the System on page 17-297

Creating the Calculator Code
1. Create a class library project in Visual Studio named

Commerce.CustomShippingCalculator. You need to import the
necessary Ektron namespaces. To do this, add references to

n Ektron.Cms.Api

n Ektron.Cms.Commerce

n Ektron.Cms.Common

n Ektron.Cms.Instrumentation

n Ektron.Cms.ObjectFactory

n Microsoft.Practices.EnterpriseLibrary.Validation

n System.Configuration

2. Add the following using statements.

using System.Collections.Generic;

using Microsoft.Practices.EnterpriseLibrary.Validation;

using Ektron.Cms;

using Ektron.Cms.Common;

using Ektron.Cms.Commerce;

using Ektron.Cms.Commerce.Shipment.Provider;

using Ektron.Cms.Extensibility;

using Ektron.Cms.Extensibility.Commerce;

using Ektron.Cms.Instrumentation;

using Ektron.Cms.Commerce.Exceptions;

using Ektron.Cms.Commerce.Exceptions.Shipping;

Customizing Shipping Calculations

ReferenceManual
Version 8.01 Rev 4

17-291



3. Change the namespace to
Ektron.Cms.Extensibility.Commerce.Samples. Then, rename your
class to CustomShippingCalculator and inherit from the
ShippingCalculatorStrategy class. See sample code below.

namespace Ektron.Cms.Extensibility.Commerce.Samples

{

public class CustomShippingCalculator : ShippingCalculatorStrategy

{

4. Add a few helper variables, properties, and functions. The function
GetFlatPackageList "flattens" the items in the basket, returning 1
for each item quantity. So, if we have 4 widgets, we'll have 4
packages, each with one widget.

Here we can implement logic to fit the goods into packages. We also add
a function to get another warehouse location. (In this example, we just
hardcode it).

namespace Ektron.Cms.Extensibility.Commerce.Samples

{

public class CustomShippingCalculator : ShippingCalculatorStrategy

{

private EkRequestInformation _requestInfo;

private IShippingMethod _shippingService;

protected EkRequestInformation RequestInformation {

get {

if (_requestInfo == null) {

_requestInfo =
ObjectFactory.GetRequestInfoProvider().GetRequestInformation();

}

return _requestInfo;

}

}

protected IShippingMethod ShippingService {

get {

if (_shippingService == null) {

_shippingService = ObjectFactory.GetShippingMethod();

}

return _shippingService;

}

}
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protected List<ShippingMethodData> GetActiveShippingMethodList()

{

Criteria<ShippingMethodProperty> criteria = new
Criteria<ShippingMethodProperty>(ShippingMethodProperty.DisplayOrder,
EkEnumeration.OrderByDirection.Ascending);

criteria.AddFilter(ShippingMethodProperty.IsActive,
CriteriaFilterOperator.EqualTo, true);

return ShippingService.GetList(criteria);

}

protected List<ShippingPackageData>
GetFlatPackageList(List<AdjustedBasketItem> basketItems)

{

List<ShippingPackageData> flatList = new List<ShippingPackageData>();

foreach (AdjustedBasketItem item in basketItems)

{

if (item.IsTangible)

{

for (int x = 1; x <= item.Quantity; x++)

{

ShippingPackageData package = new ShippingPackageData(item.Dimensions,
item.Weight);

package.Items.Add(item);

flatList.Add(package);

}

}

}

return flatList;

}

private AddressData GetWarehouseAddressData()

{

AddressData address = new AddressData();

address.Name = "Ektron";

address.AddressLine1 = "542 Amherst St.";

address.City = "Nashua";

address.Country = new CountryData();

address.Country.Id = 840; // USA

address.Region = new RegionData();

address.Region.Id = 31; // NH

address.PostalCode = "03063";

return address;

}
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5. Override the OnBeforeCalculate method, which is called when
shipping is calculated for the basket.

public override void OnBeforeCalculate(BasketCalculatorData basketData,
ShippingMethodData shippingMethod, CancellableEventArgs eventArgs)

{

}

6. In this method, we add code to ship items with a tax class id of 4 from
another warehouse, versus the default one specified
(package.Items[0].TaxClassId == 4).

public override void OnBeforeCalculate(BasketCalculatorData basketData,
ShippingMethodData shippingMethod, CancellableEventArgs eventArgs))

{

bool hasTangibles = basketData.Basket.HasTangibleItems;

List<ShippingMethodData> availableShippingMethods =
GetActiveShippingMethodList();

List<ShippingPackageData> shippingPackages =
GetOrderPackages(basketData.AdjustedItems);

//convert list of items into flat list - all 1 quantity.

List<ShippingPackageData> shippingPackages =
FlattenItemsIntoPackages(basketData.AdjustedItems);

if (shippingPackages.Count == 0)

{

Log.WriteInfo("No packages to calculate shipping for.");

return;

}

Dictionary<string, int> rateCount = new Dictionary<string, int>();

//Get Rate for each package

foreach (ShippingPackageData package in shippingPackages)

{

List<ShippingOptionData> shippingRateList;

Log.WriteVerbose(string.Format("Shipping package: {0} x {1} x {2} {3}, {4}
{5}",

package.Dimensions.Height, package.Dimensions.Length,
package.Dimensions.Width, package.Dimensions.Units.ToString()

, package.TotalItemWeight.Amount, package.TotalItemWeight.Units.ToString()));

//Get rate for each available option and populate the
BasketCalculatorData.ShippingRates list.

if (package.Items[0].TaxClassId == 4)

shippingRateList =
ShipmentProviderManager.Provider.GetRates(availableShippingMethods,
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GetWarehouseAddressData(), basketData.ShipTo, package.TotalItemWeight,
package.Dimensions);

else

shippingRateList =
ShipmentProviderManager.Provider.GetRates(availableShippingMethods,
basketData.ShipFrom, basketData.ShipTo, package.TotalItemWeight,
package.Dimensions);

if (shippingRateList.Count == 0) {

EkException.ThrowException(new NoRatesAvailableException("No shipping rates
are available for the supplied item."));

}

//add rates to basket.ShippingRates

foreach (ShippingOptionData rate in shippingRateList) {

//if there are multiple packages, we need to total up rates for each shipping
method.

//NOTE: we can only return rates that are applicable to ALL packages.

//For example, package 1 has rates for ground, priority, freight

// package 2 has rates for ground, priority

//only return rates for ground and priority since freight will only be a
partial quote.

//check if this shipping method has already been added.

ShippingOptionData existingMethodRate =
basketData.ShippingRates.Find(delegate(ShippingOptionData match) {

return match.ProviderService == rate.ProviderService;

});

if (existingMethodRate == null) {

basketData.ShippingRates.Add(rate);

}

else {

existingMethodRate.ShippingFee += rate.ShippingFee;

}

//need to keep count of how many times this shipping method rate is added to

//to make sure we have a method rate for each package.

if(rateCount.ContainsKey(rate.ProviderService)){

rateCount[rate.ProviderService]++;

}else{

rateCount.Add(rate.ProviderService, 1);

}

}

}

//default exchange rate

ExchangeRateData exchangeRate = new ExchangeRateData(0, 0, 1m, null);
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if (basketData.ShippingRates.Count > 0 &&
basketData.ShippingRates[0].CurrencyId !=
RequestInformation.CommerceSettings.CurrencyId) {

IExchangeRate rateService = ObjectFactory.GetExchangeRate();

exchangeRate = rateService.GetCurrentExchangeRate();

if (exchangeRate == null) {

Log.WriteError(string.Format("No exchange rate found for current currency
{0}. Shipping rates could not be converted to current currency.",
RequestInformation.CommerceSettings.CurrencyId));

EkException.ThrowException(new CmsException(string.Format("No exchange rate
found for current currency {0}. Shipping rates could not be converted to
current currency.", RequestInformation.CommerceSettings.CurrencyId)));

}

}

//go through all shipping methods and remove any that don't have rates for
all packages.

for(int x = 0; x < basketData.ShippingRates.Count; x++){

bool removed = false;

if(rateCount[basketData.ShippingRates[x].ProviderService] <
shippingPackages.Count){

basketData.ShippingRates.RemoveAt(x);

x--; //need to decrement loop counter so we don't skip any as we loop through

removed = true;

}

if (!removed) {

if (basketData.ShippingRates[x].CurrencyId !=
RequestInformation.CommerceSettings.CurrencyId) {

//if shipping rate currency is not current currency, convert it

basketData.ShippingRates[x].ShippingFee =
exchangeRate.ConvertPrice(basketData.ShippingRates[x].ShippingFee);

}

//is this the selected shippingmethod for basket? If so, set shipping cost
on basket

if (shippingMethod != null && shippingMethod.ProviderService ==
basketData.ShippingRates[x].ProviderService) {

basketData.TotalShippingCost += basketData.ShippingRates[x].ShippingFee;

}

}

}

if (basketData.ShippingRates.Count == 0 && hasTangibles)

{

basketData.ValidationResults.AddResult(new ValidationResult("No shipping
rates are available for the supplied item.", this, "", "", null));

}

eventArgs.IsCancelled = true;

Conducting eCommerce with Ektron CMS400.NET

17-296 ReferenceManual
Version 8.01 Rev 4



}

Note:When shipping is calculated for the basket, the above function runs first. Setting the
IsCancelled property to true on eventArgs instructs the CMS to stop further execution of
the shipping calculations. This, in effect, overrides the shipping functionality.

7. Build the project, and copy the assembly into the CMS400.NET site's
bin directory.

Register the Event with the System
After you create the event assembly and place it inside the bin directory, you
need to register the event. Use the objectfactory.config file to register custom
events within the CMS. To do that, follow these steps.

1. Open the site root/objectfactory.config file.

2. Find the objectStrategies section of the file.

3. Within that section, locate or add this key:
name="ShippingCalculator".

4. Add a reference to the class created earlier in the <strategies> key,
as shown below.

<objectStrategies>

<add name=ShippingCalculator">

<strategies>

<add name="CustomShippingCalculator"
type="Ektron.Cms.Extensibility.Commerce.Samples.CustomShippingCalculator,
Commerce.CustomShippingCalculator"/>

</strategies>

</add>

</objectStrategies>
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Ektron’s eSync revolutionizes the way that Web sites are built, deployed and
maintained and is the only synchronization solution that can keep Web sites up-
to-date efficiently, giving you a level of control over your site that was
impossible before. From single sites, to global multi-sites, to server farms,
eSync gives you scalable, geo-synchronization capabilities that allow you to
easily update exactly what you want, when you want to.

The following videos introduce eSync.

n http://media.ektron.com/flash/esync/800x600/esync.html

n http://media.ektron.com/webinars/esync/esyncwebinar.html

eSync moves only the changes you want to move, from single pieces of content
to entire sites, making updates efficient and eliminating site downtime. With its
intelligent synchronization technology, eSync is able to securely move selected
content bidirectionally: Web 2.0 sites have a wealth of user-generated content
and membership information. That data can now be synchronized back to the
development side of the firewall.

By employing certificate-based authentication to secure your Web site, Ektron’s
eSync lets CMS users update content anywhere safely, whether it is on a
production server or within the development environment. Alternatively, all of
your updates can take place on the safe side of your firewall before they are
moved to the live site.

If conflicting versions of content exist, eSync’s configurable conflict resolution
engine ensures that you won’t lose your most up-to-date content. The version
that isn’t posted is saved in a history, along with other previous versions,
enabling you to track changes or restore content if the need arises.

Within complex IT infrastructures, eSync can synchronize content, assets, HTML
pages and other components of your Web site, whether it is managed by
CMS400.NET or not.
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Synchronization can be scheduled to take place at strategic times that assure
optimal performance while facilitating site updates. Global multi-site setups
can take advantage of this to coordinate synchronizations with servers around
the world, taking advantage of low traffic periods. Or, use eSync’s scheduling
feature to set up time-sensitive events. Synchronization can take place with
single or multiple servers, whatever your needs are.

eSync’s ability to move and copy data is unparalleled, and it offers a host of
options for managing multiple servers. If there is a need for multiple
development servers, eSync can create another copy of the live site for you to
work with. As your developers build out changes to the site, their updates can
by synchronized to the staging and production servers. eSync can also support
advanced infrastructures, including load balancing and failover server
configurations.

Ektron’s eSync is the only solution in the marketplace today that gives you the
level of control you need to keep your Web sites completely up-to-date.
Whatever your Web site structure is, Ektron’s synchronization technology lets
updates happen efficiently and quickly, and provides the tools to deal with
today and tomorrow’s information-hungry world.

This section also contains the following topics.

Setting Up eSync 18-4
Using eSync 18-35
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Setting Up eSync
This chapter helps you install and start using Ektron CMS400.NET’s eSync. For
full details about the feature, see Using eSync on page 18-35.

For this configuration See this section

Two sites on same server Scenario 1: Synching Two Sites on the SameServer below

One Local to one Remote server Scenario 2: Synching an Ektron CMS400.NET Server with Another
Server on the facing page

Development to Staging to
Production servers

Scenario 3: Setting up a Development >Staging >Production
Environment on page 18-14

Scenario 1: Synching Two Sites on the
Same Server
Although it is unlikely that you will use this configuration in “real-life”
situations, it the simplest way to begin testing and learning how eSync works.

1. Install the first site. See Also: Installing Ektron CMS400.NET on page
1-18and Installing the Minimum and Starter Sites on page 1-20

2. Near the end of the installation, the following dialog appears.

3. Click Yes.

4. Install a second site on the same server.

5. Near the end of the installation, the same dialog appears.

6. Click Yes.

Both sites’ security certificates have been set up and configured. Continue from
Part Three: Connect the Local and Remote Servers on page 18-9
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Scenario 2: Synching an Ektron
CMS400.NET Server with Another
Server

This scenario assumes you have Ektron CMS400.NET on one server (call it
local), and want to sync it with another (call it remote). To accomplish this, you
install a minimal Ektron CMS400.NET site to the new, remote server. Next, use
eSync to upload your Ektron CMS400.NET site from the local to the remote
server.

After the you complete the initial and template syncs explained in this chapter,
the two sites are a mirror image of each other.

Follow these steps to configure two servers to sync with each other.

Prerequisites - See eSync Requirements on page 18-35

n Part One: Set up a Min Site on the Remote Server below

n Part Two: Generate and Copy Security Certificates on next page

n Part Three: Connect the Local and Remote Servers on page 18-9

n Part Four: Upload the Local Server’s Database to the Remote Server
on page 18-11

n Part Five: Upload the Local Server’s Templates to Remote on page
18-13

Part One: Set up a Min Site on the Remote Server
1. Upgrade the local server to the latest version of Ektron CMS400.NET

if necessary.

2. On the remote server, install a minimum site whose Ektron
CMS400.NET version matches the version on the local server.

3. To do this, run the Ektron CMS400.NET base installation file
(CMS400Base8x.exe). For more information, see Installing Ektron
CMS400.NET on page 1-18.

Scenario 2: Synching an Ektron CMS400.NET
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4. If the current site with which you will sync is precompiled, you must
also precompile the min site.

Part Two: Generate and Copy Security
Certificates
Security certificates authorize the synchronization of files between servers. In
this part, you generate security certificates on the local server, then copy them
to the remote.

Follow these steps to complete this procedure.

1. Sign on to the local server.

2. Click theWindows Start Button> All programs > Ektron >
CMS400 v8x > Utilities > Security Configurator.

3. The following screen appears.

4. At theWeb Site Description field, select the Web site on the local
server.

5. Press Generate.

Synchronizing Servers Using eSync
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6. The certificates are created on the local server.

7. Close the Security Configurator dialog.

8. Open two Windows Explorer windows side-by-side: one showing the
local server’s file system, and the other showing the remote server’s
file system.

9. In the remote server window, create a folder underneath the root
folder. Name the folder local security certificates.

Warning! Do not create the new folder under the web root, C:\inetpub\wwwroot.

10. In the local server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400v8x\Utilities\Software\SecurityConfigurator
.

11. From that folder, copy these files.

n servername_SyncClient.pfx

n servername_SyncClient.pvk

n servername_SyncClient.cer

n servername_SyncServer.pfx

n servername_SyncServer.pvk

n servername_SyncServer.cer

12. Paste the files into the folder you created in Step 9. Make sure there
are no other security files in the folder.

13. Close both windows you opened in Step 8.

Note: After copying security certificates to the remote folder, you need to register and move
them to the correct folders. The Security Configurator screen does this.

14. Sign on to the remote server.

15. Open the security configurator screen using this path:Windows
Start Button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator.

16. The security configurator screen appears.

Part Two: Generate and Copy Security Certificates
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17. Click the Apply Remote Server Certificates button (circled
above).

18. Click the Browse button next to that field.

19. Browse to the folder to which you pasted the security certificates in
Step 12.

20. Click the Apply button.

21. The security configurator copies the certificates you pasted in Step 12
to the correct folder, and configures them for the remote server.

Next, you need to generate security certificates on the remote server, then
copy them to the local.

To accomplish this, follow all steps in Part Two: Generate and Copy Security
Certificates on page 18-6, but this time, consider the remote server to be the
local server and vice versa.

Now that you have generated and copied security certificates between servers,
you can set up eSync.

Synchronizing Servers Using eSync

18-8 ReferenceManual
Version 8.01 Rev 4



Part Three: Connect the Local and Remote
Servers

Warning! Back up your database before beginning this procedure!

1. On the local server, sign on to Ektron CMS400.NET.

2. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Synchronization.

3. The View All Synchronization Configurations screen appears.

4. Click the Add button ( ).
5. The Create Synchronization Server Relationship screen appears.

6. At the Remote Server field, enter the name of the remote server.

7. At the Choose Certificate field, the name of the remote server
appears.

8. Click the Connect button. This action connects the local with the
remote server.

9. After you connect to the remote server, a new screen appears
showing its database.

Part Three: Connect the Local and Remote Servers
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10. A new screen appears, showing both servers.

11. Click the Switch Synchronization Direction button.

12. Now the screen indicates that the database will be uploaded from
your local server (which contains the CMS400 Developer site) to the
new, remote server. See below.
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13. Click Create. This action connects the local and remote servers.

Part Four: Upload the Local Server’s Database to
the Remote Server

1. From the View All Synchronization Configurations screen, click the
Start Initial Sync button (circled below).

2. The initial sync uploads the local server’s database to the remote
server.

3. A screen tracks the progress.

Part Four: Upload the Local Server’s Database to
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4. When the sync is finished, Synchronization is Complete appears.

The initial sync also creates a default database profile. The profile remembers
information about the sync, such as source and destination databases, sync
direction, and the fact that it syncs the database and resource files (see
example below). You can reuse this profile to sync your database/resource files
any time in the future.
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Part Five: Upload the Local Server’s Templates to
Remote

1. From the View All Synchronization Configurations screen, click the

Add Sync Profile button ( ).
2. The Add Synchronization Profile screen appears.

3. At the Synchronization name field, give this profile a name, such
as Local - Remote Template Sync.

4. At the Items to Synchronize field, select Templates.

5. For Direction, choose Upload.

6. For Schedule, choose None. (See example below.)

7. Save the profile.

8. Click the Run button to the right of the template sync (circled below).

Part Five: Upload the Local Server’s Templates to
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9. A screen tracks the sync’s progress.

10. When the sync is complete, Synchronization is Complete appears.

You can reuse the template sync profile to sync templates any time in the
future.

Scenario 3: Setting up a Development >
Staging > Production Environment
Before

After
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In this scenario, a version of Ektron CMS400.NET resides on one server. You
will consider that your production server and use it to initialize the staging and
development servers.

Warning! In this scenario, you cannot sync between the development and production servers.
The sync can only be run between Development and Staging or Staging and Production.

Here’s a preview of the steps you will follow.

n Part 1: Set up Min Site on Staging and Development Servers below

n Part 2: Generate and Copy Security Certificates below

n Part 3: Connect Staging and Production Servers on page 18-24

n Part 4: Download Production Server Database to Staging Server on
page 18-27

n Part 5: Download Production Server’s Templates to Staging on page
18-28

n Part 6: Connect Development and Staging Servers on page 18-30

n Part 7: Download Staging Server Database to Development Server
on page 18-32

n Part 8: Download Staging Server Templates to Development on page
18-33

Prerequisite - See eSync Requirements on page 18-35

Part 1: Set up Min Site on Staging and
Development Servers

1. Upgrade your existing server to the current version of Ektron
CMS400.NET if necessary.

2. Install a minimum site on the staging and development servers.

3. To do this, run the Ektron CMS400.NET base installation file
(CMS400Base8x.exe) version 7.6 or higher. (For more information,
see Installing Ektron CMS400.NET on page 1-1.)

Part 2: Generate and Copy Security Certificates
Security certificates authorize synchronization between servers. In an eSync
configuration, every server needs a security certificate from every other
server, as shown below.

Part 1: Set upMin Site on Staging and Development

ReferenceManual
Version 8.01 Rev 4

18-15



To generate and copy these certificates, follow these steps.

n A. Generate Certificates on Production and Copy to Staging and
Development below

n B. Generate Certificates on Staging and Copy to Development and
Production on page 18-19

n C. Generate Certificates on Development and Copy to Staging and
Production on page 18-22

A. Generate Certificates on Production and Copy to Staging
and Development

Follow these steps to complete this procedure.

1. Sign on to the production server.

Synchronizing Servers Using eSync

18-16 ReferenceManual
Version 8.01 Rev 4



2. Click theWindows Start Button> All programs > Ektron >
CMS400 v8x > Utilities > Security Configurator.

3. The following screen appears.

4. At theWeb Site Description field, select the Web site on the
production server.

5. Press Generate.

6. The certificates are created on the production server.

7. Open two Windows Explorer windows: one showing the production
server’s file system, and the other showing the staging server’s file
system.

8. In the staging server window, create a folder underneath the root
folder. Name the folder Prod security certificates.

Warning! Do not create the new folder under the web root, C:\inetpub\wwwroot.

9. In the production server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400v8x\Utilities\Software\SecurityConfigurator
.

10. From that folder, copy these files.

n servername_SyncClient.pfx

n servername_SyncClient.pvk

n servername_SyncClient.cer

n servername_SyncServer.pfx

n servername_SyncServer.pvk

n servername_SyncServer.cer

A. Generate Certificates on Production and Copy to
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11. Paste the files into the folder you created in Step 9. Make sure there
are no other security files in the folder.

12. Close both windows you opened in Step 8.

13. After copying the security certificate files to the staging folder, you
need to register and move them to the correct folders. The Security
Configurator screen does this.

14. Sign on to the staging server.

15. Open the security configurator screen using this path:Windows
Start Button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator.

16. The security configurator screen appears.

17. Click the Apply Remote Server Certificates button (circled
above).

18. Click the browse button next to that field.

19. Browse to the folder to which you pasted the security certificates in
Step 12.

20. Click the Apply button.

21. The security configurator copies the certificates you pasted in Step 12
to the correct folder, and configures them for the staging server.

22. Follow the same procedure to move production certificates to the
development server. To do this, begin at Step 8 and follow all steps.
Wherever the instructions mention a staging server, substitute the
development server.
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B. Generate Certificates on Staging and Copy to
Development and Production

Follow these steps to complete this procedure.

1. Sign on to the staging server.

2. Click theWindows Start Button> All programs > Ektron >
CMS400 v8x > Utilities > Security Configurator.

3. The following screen appears.

4. At theWeb Site Description field, select the Web site on the
staging server.

5. Press Generate.

6. The certificates are created on the staging server.

B. Generate Certificates on Staging and Copy to
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7. Open two Windows Explorer windows: one showing the staging
server’s file system, and the other showing the production server’s
file system.

8. In the production server window, create a folder underneath the root
folder. Name the folder staging security certificates.

Warning! Do not create the new folder under the web root, C:\inetpub\wwwroot.

9. In the staging server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400v8x\Utilities\Software\SecurityConfigurator
.

10. From that folder, copy these files.

n servername_SyncClient.pfx

n servername_SyncClient.pvk

n servername_SyncClient.cer

n servername_SyncServer.pfx

n servername_SyncServer.pvk

n servername_SyncServer.cer

11. Paste the files into the folder you created in Step 9. Make sure there
are no other security files in the folder.

12. Close both windows you opened in Step 8.

13. After copying the security certificate files to the production folder,
you need to register and move them to the correct folders. The
Security Configurator screen does this.

14. Sign on to the production server.

15. Open the security configurator screen using this path:Windows
Start Button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator.

16. The security configurator screen appears.
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17. Click the Apply Remote Server Certificates button (circled
above).

18. Click the browse button next to that field.

19. Browse to the folder to which you pasted the security certificates in
Step 12.

20. Click the Apply button.

21. The security configurator copies the certificates you pasted in Step 12
to the correct folder, and configures them for the production server.

22. Follow the same procedure to move staging certificates to the
development server. To do this, begin at Step 8 and follow all steps.
Wherever the instructions mention a production server, substitute the
development server.

B. Generate Certificates on Staging and Copy to
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C. Generate Certificates on Development and Copy to
Staging and Production

1. Sign on to the development server.

2. Click theWindows Start Button> All programs > Ektron >
CMS400 v8x > Utilities > Security Configurator.

3. The following screen appears.

4. At theWeb Site Description field, select the Web site on the
development server.

5. Press Generate.

6. The certificates are created on the development server.
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7. Open two Windows Explorer windows: one showing the development
server’s file system, and the other showing the staging server’s file
system.

8. In the staging server window, create a folder underneath the root
folder. Name the folder Dev security certificates.

Warning! Do not create the new folder under the web root, C:\inetpub\wwwroot.

9. In the development server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400v8x\Utilities\Software\SecurityConfigurator
.

10. From that folder, copy these files.

n servername_SyncClient.pfx

n servername_SyncClient.pvk

n servername_SyncClient.cer

n servername_SyncServer.pfx

n servername_SyncServer.pvk

n servername_SyncServer.cer

11. Paste the files into the staging server folder you created in Step 9.
Make sure there are no other security files in the folder.

12. Close both windows you opened in Step 8.

13. After copying the security certificate files to the staging folder, you
need to register and move them to the correct folders. The Security
Configurator screen does this.

14. Sign on to the staging server.

15. Open the security configurator screen using this path:Windows
Start Button > All programs > Ektron > CMS400 v8x >
Utilities > Security Configurator.

16. The security configurator screen appears.

C. Generate Certificates on Development and Copy
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17. Click the Apply Remote Server Certificates button (circled
above).

18. Click the browse button next to that field.

19. Browse to the folder you created in Step 9.

20. Click the Apply button.

21. The security configurator copies the certificates you pasted in Step 12
to the correct folder, and configures them for the staging server.

22. Follow the same procedure to move development certificates to the
production server. To do this, begin at Step 8 and follow all steps.
Wherever the instructions mention a staging server, substitute the
production server.

Part 3: Connect Staging and Production Servers

Warning! Back up your database before beginning this procedure!

1. On the staging server, sign on to Ektron CMS400.NET.
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2. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Synchronization.

3. The View All Synchronization Configurations screen appears.

4. Click the Add button ( ).
5. The Create Synchronization Server Relationship screen appears.

6. At the Remote Server field, enter the name of the production
server.

7. At the Choose Certificate field, the name of the production server
appears.

8. Click the Connect button. This action connects the staging with the
production server.

9. After you connect to the production server, a new screen appears
showing its database.

Part 3: Connect Staging and Production Servers
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10. Click Next.

11. A new screen appears, showing both servers.

12. Click Create. This action connects the staging and production
servers.
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Part 4: Download Production Server Database to
Staging Server

1. From the View All Synchronization Configurations screen, click the
Start Initial Sync button.

2. The initial sync downloads the production server’s database to the
staging server.

3. A screen tracks the sync’s progress.

4. When the sync is complete, Synchronization is Complete appears.

The initial sync also creates a default database profile. The profile remembers
information about the sync, such as the source and destination databases, sync
direction, and the fact that it syncs the database and resource files (see
example below). You can reuse this profile to run database/resource syncs any
time in the future.

Part 4: Download Production Server Database to

ReferenceManual
Version 8.01 Rev 4

18-27



Part 5: Download Production Server’s Templates
to Staging

1. From the View All Synchronization Configurations screen, click the
Add Sync Profile button.

2. The Add Synchronization Profile screen appears.

3. At the Synchronization name field, give this profile a name, such
as Prod - Staging Template Sync.

4. At the Items to Synchronize field, select Templates.

5. For Direction, choose Download.

6. For Schedule, choose None. (See example below.)
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7. Save the profile.

8. Click the Run button to the right of the template sync (circled below).

9. A screen tracks the sync’s progress.

10. When the sync is complete, Synchronization is Complete appears.

You can reuse the template sync profile to sync templates any time in the
future.

Part 5: Download Production Server’s Templates to
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Part 6: Connect Development and Staging Servers

1. Sign on to Ektron CMS400.NET development server.

2. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Synchronization.

3. The View All Synchronization Configurations screen appears.

4. Click the Add button ( ).
5. The Create Synchronization Server Relationship screen appears.

6. At the Remote Server field, enter the name of the staging server.

7. At the Choose Certificate field, the name of the staging server
appears.

8. Click the Connect button. This action connects the development with
the staging server.

9. After you connect to the staging server, a new screen appears
showing its database.
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10. Click Next.

11. A new screen appears, showing both servers.

12. Click Create. This action connects the development and staging
servers.

Part 6: Connect Development and Staging Servers
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Part 7: Download Staging Server Database to
Development Server

1. From the View All Synchronization Configurations screen, click the
Start Initial Sync button.

2. The initial sync downloads the staging server’s database to the
development server.

3. A screen tracks the sync’s progress.

4. When the sync is complete, Synchronization is Complete appears.

The initial sync also creates a default database profile. The profile remembers
information about the sync, such as the source and destination databases, sync
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direction, and the fact that it syncs the database and resource files (see
example below). You can reuse this profile to sync the database/resources
between these two servers at any time in the future.

Part 8: Download Staging Server Templates to
Development

1. From the View All Synchronization Configurations screen, click the
Add Sync Profile button.

2. The Add Synchronization Profile screen appears.

3. At the Synchronization name field, give this profile a name, such
as Staging-Dev Template Sync.

4. At the Items to Synchronize field, select Templates.

5. For Direction, choose Download.

6. For Schedule, choose None. (See example below.)

Part 8: Download Staging Server Templates to
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7. Save the screen.

8. Click the Run button to the right of the template sync (circled below).

9. A screen tracks the sync’s progress.

10. When the sync is complete, Synchronization is Complete appears.

You can reuse the template sync profile to sync templates any time in the
future.
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Using eSync
This section explains the following eSync topics.

n eSync Requirements below

n Characteristics of eSync on next page

n Managing eSync Security Certificates on page 18-43

n Using eSync to Initialize a New Site on page 18-53

n Setting up eSync Profiles on page 18-53

n Optional Steps before Running a Sync on page 18-65

n Running a Sync on page 18-66

n Synchronization Screens

n Reviewing Resolved Collisions on page 18-74

n Content and Folder Sync Options on page 18-76

n eSync in a Load Balanced Environment on page 18-82

n Using eSync in a Multi-site Environment on page 18-90

n Using eSync with Web Alerts on page 18-93

n Using eSync with eCommerce on page 18-94

n eSync Troubleshooting on page 18-96

eSync Requirements

Ektron Software and Files
n Ektron CMS400.NET version 7.6 or higher

Warning! The version of Ektron CMS400.NET on every server in the sync configuration must
match. You cannot upgrade nor downgrade Ektron CMS400.NET using eSync.

n An Ektron CMS400.NET base installation file (for example,
cms400Base7x.exe). Use this file to install a second site with which
you will sync your current site.

n Ektron CMS400.NET licenses that support Enterprise or Professional
with eSync on every server being synched.

n Matching security certificates on every server being synched. See
Also: Managing eSync Security Certificates on page 18-43
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Microsoft Software
n Windows Server 2003 or higher; Vista Ultimate or Business

n Microsoft .NET Framework 3.5

Ektron CMS400.NET’s installation checks for this version of the
framework during installation/upgrade. If it’s not on your server,
you are asked for permission to install it.

Note: It is not a problem if your templates were created using the 2.0 Framework.

n Microsoft SQL 2005 SP2 or higher

User Permissions
n You are a member of the Administrators group or assigned the

Synchronization Admin role. See Also: Defining Roles on page 15-31

n The user performing the sync has either a db_ddladmin or dbowner
role for the SQL database

Server
The GMT time on each server’s clock must be within 5 minutes of each other.

Characteristics of eSync
This section also contains the following topics.

Easy and Flexible Setup and Usage 18-37
Sync Configurations 18-37
Configuration 1: One Staging Server, One Production Server 18-38
Configuration 2: One Development, One Staging, One Production
Server

18-
38

Configuration 2a: Multi-site Staging and Production Servers 18-38
Configuration 3: Several Dev. Servers, One Staging, One Pro-
duction Server

18-
39

Configuration 4: One Dev., One Staging, One Production Site, One
Production DB Server

18-
39

Configuration 5: Configuration 4 Plus Pre-Production Server 18-40
Configuration 6: Multi-site: Each Site and DB on own Production
Server

18-
40

The Server Number 18-41
Unique ID Numbering 18-42
eSync Moves Changes Only 18-43
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Easy and Flexible Setup and Usage
You administer eSync through Ektron CMS400.NET’sWorkarea > Settings >
Configuration > Synchronization screens. The screens let you establish a
sync configuration between two databases, then specify any number of sync
profiles for each configuration.

- See Screen Sample

Each profile lets you specify data to sync, a direction, and a schedule. You can
always sync immediately by clicking the sync ( ) button.

You create profiles to sync these kinds of data.

n all content, assets, and library assets

n all Workarea folder files

n the remaining site files (with a few exceptions)

n a selection of Windows files in your site root folder and its subfolders

See Also: Setting up eSync Profiles on page 18-53

Individual file types can be included or excluded from the sync. In addition, you
can sync Ektron CMS400.NET content or folders. See Also: Content and Folder
Sync Options on page 18-76

Sync Configurations
Several eSync configurations are shown below. You can synchronize any server
to or from any other server with one important exception: you cannot initiate a
sync from a server outside the firewall. You can only initiate a sync from a
server inside the firewall and copy to a server outside the firewall. This is
because the outside server does not know the address of servers inside the
firewall. However, you can use a staging server to push and pull updated
information to and from a production server.

Warning! All eSync transmissions use port 8732. This is not configurable.
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ReferenceManual
Version 8.01 Rev 4

18-37



Configuration 1: One Staging Server, One
Production Server
This is the most basic eSync configuration, showing one staging and one
production server. Each server has a database and one site.

The eSync feature can automatically create a production server from your
staging server. See Also: Using eSync to Initialize a New Site on page 18-53

For installation instructions for this configuration, see Scenario 2: Synching an
Ektron CMS400.NET Server with Another Server on page 18-5.

Configuration 2: One Development, One Staging,
One Production Server
This configuration includes a development server. Developers can use it to
create new features and modify existing ones. When they are done, they can
sync the changes to the staging server, where the changes can be verified
before being moved to production.

For installation instructions for this configuration, see Scenario 3: Setting up a
Development > Staging > Production Environment on page 18-14.

Configuration 2a: Multi-site Staging and
Production Servers
The following configuration illustrates synching several sites on a staging server
with those sites on production.
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Configuration 3: Several Dev. Servers, One
Staging, One Production Server
As shown in the illustration, any number of development servers can sync to
each other and to your staging servers.

Configuration 4: One Dev., One Staging, One
Production Site, One Production DB Server
In this configuration supported by eSync, the production site has two servers:
one for site files, and another for the database.

Configuration 3: Several Dev. Servers, One
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To synchronize these servers, set up several eSync profiles. One syncs the
database, assets, and templates to the production database server. Use
additional profiles to sync the staging server’s workarea files with the
production site server.

Note:When using separate site and database servers, assets are stored on the site server.

Configuration 5: Configuration 4 Plus Pre-
Production Server
This eSync configuration adds an extra server between staging and production.
The preproduction server can be used for review and testing of changes before
they are moved to production.

Configuration 6: Multi-site: Each Site and DB on
own Production Server
In this configuration, each production server has its own database plus the site
files. As an alternative, you could have a separate server for each production
database, with all sites on one production server.
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Note: The above configuration also supports separate site and database servers.

To synchronize this type of configuration, set up several eSync profiles, one for
each site.

n Three database and template profiles

n Three Workarea profiles

The Server Number
Every server in a sync configuration is assigned a unique number. The
originating server is numbered 1, the first server with which it establishes a
relationship is numbered 2, etc.

The server number is in the serverinfo.xml file, located in the
c:\sync\inetpub\wwwroot\siteroot folder, as shown below.

<SyncServerInfoList>

<SyncServerInfo IsSyncRunning="true" MaxId="2" ServerNumber="1" IsMulti-
SiteStaged="false">

<ServerId>b0cccb5a-1d45-4262-8857-79f1333696dc</ServerId>

The Server Number
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<ServerUrl>http://localhost:8732/Ektron.Sync.Communication/SyncCommunicationScheduleService.svc</ServerUrl>

<ConnectionInfo>server=WS10080\SQLExpress;database=CMS400Developer;Integrated
Security=TRUE;user=;pwd=;</ConnectionInfo>

</SyncServerInfo>

</SyncServerInfoList>

Unique ID Numbering
All Ektron CMS400.NET data is assigned a unique ID number to distinguish it
from similar objects. Examples are content (see illustration below), folders,
menus, users, etc.

- See Screen Sample

When you create a sync relationship, Ektron CMS400.NET applies to each server
a new ID numbering range to ensure that, from then on, objects created on
either server have a unique ID. This prevents collisions when synching between
servers. For example, since membership users created on a production server
have a different ID number range from those created on the staging server,
eSync does not overwrite them.

To view a server’s ID number range, open its serverinfo.xml file, located in the
c:\sync\inetpub\wwwroot\siteroot folder, and check the MaxId value
(highlighted in red below).

<SyncServerInfoList>

<SyncServerInfo IsSyncRunning="true" MaxId="1" ServerNumber="1" IsMulti-
SiteStaged="false">

<ServerId>b0cccb5a-1d45-4262-8857-79f1333696dc</ServerId>

<ServerUrl>http://localhost:8732/Ektron.Sync.Communication/SyncCommunicationScheduleService.svc</ServerUrl>

<ConnectionInfo>server=WS10080\SQLExpress;database=CMS400Developer;Integrated
Security=TRUE;user=;pwd=;</ConnectionInfo>

</SyncServerInfo>

</SyncServerInfoList>
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Multiply that number by 1 trillion to get the largest ID number which that server
can assign. So for example, if MaxId = 3, possible ID numbers range from
2,000,000,000,001 to 3,000,000,000,000.

eSync Moves Changes Only
eSync only copies data that changed since the last sync. So, for example, if
your site has 100 menus but only 3 changed since the last sync, it only copies
three. As a result, eSync is very quick.

To track changes to Ektron CMS400.NET data between syncs, eSync sets up a
c:\sync folder structure that mirrors your site’s Windows folder structure. This
structure is created on each server when sync relationships are first
established.

- See Screen Sample

No Ektron CMS400.NET files reside in the \sync folders. Instead, each folder
has four .sync files that monitor changes to the Ektron CMS400.NET files in the
corresponding folder.

Managing eSync Security Certificates
Ektron CMS400.NET’s eSync feature uses security certificates to ensure secure
communication between servers. That is, all servers in an eSync configuration
must have matching, encrypted security certificates in order to establish an
eSync relationship.

eSyncMovesChangesOnly
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Note: If your configuration features separate database servers, you do not need to install
security certificates on them. You only need to install certificates on servers that host Ektron
CMS400.Net.

This section also contains the following topics.

The Client and Server Certificates 18-44
Installing Security Certificates 18-45
Step 1: Create Security Certificates on Your Local Server 18-45
Step 2: Create Security Certificates on the Remote Server 18-47
Step 3: Copy Local Client Certificate to Remote Server 18-48
Step 4: Copy Remote Client Certificate to Local Server 18-50
Step 5: Test the Security Certificates 18-50
Regenerating Security Certificates 18-50
Troubleshooting Security Certificates 18-51
Could Not Connect Error 18-51
No Endpoint Error 18-52

See Also: Create eSync Security Certificates for a Load Balanced Cluster on
page 18-85

The Client and Server Certificates
Before you can establish an eSync relationship between servers, each server
must have its own (local) security certificate and one from every other server
in the configuration, as shown below.

- See Illustration

As another example, if an eSync configuration consists of five servers, each
server would require five security certificates: one local and four remote
certificates.
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Each server creates two sets of certificates: a server and a client set. Then, you
copy the certificates to the other server. The local machine’s server certificate
must match a client certificate on the remote server, and vice versa.

Certificates are typically copied only when you first establish an eSync
relationship between servers. After that, any eSync activity triggers a
background check, and the user can proceed only if the certificates match.

Each certificate consists of the following files.

n Server certificate

- servername_SyncServer.pfx

- servername_SyncServer.pvk

- servername_SyncServer.cer

n Client certificate

- servername_SyncClient.pfx

- servername_SyncClient.pvk

- servername_SyncClient.cer

The security certificates can apply to one site or all sites on a server. You
determine this when installing them.

See Also: Installing Security Certificates below

Installing Security Certificates
Prerequisite: Permission to copy and paste files between local and remote
servers

To create and place eSync security certificates in the correct locations, follow
these steps.

n Step 1: Create Security Certificates on Your Local Server below

n Step 2: Create Security Certificates on the Remote Server on page
18-47

n Step 3: Copy Local Client Certificate to Remote Server on page 18-48

n Step 4: Copy Remote Client Certificate to Local Server on page 18-50

n Step 5: Test the Security Certificates on page 18-50

Step 1: Create Security Certificates on Your Local
Server

1. At the end of the Ektron CMS400.NET installation, you are asked if
you want to install eSync security certificates. If you agree, the
following screen prompts you to enter information needed to create
the certificates.

Installing Security Certificates
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Note: You can access this screen at any time screen by openingWindows Start Button> All
programs > Ektron > CMS400 v8x > Utilities > Security Configurator.

- See Screen Sample

Use the following table to complete this screen.

Field Description

Generate Certificates - Use this screen area to create security certificates that must be
copied to a remote server with which you want to sync.

WebSite Description
If more than one site is set up on this server, use the pull-down list to
select theWeb site for which you are installing security certificates.
Or, clickAll to apply the certificates to all sites on this server.

Apply Remote Server Certificates - Use this screen area to apply eSync security certificates that were
copied from a remote server to your local server. See Also:Step 3: CopyLocalClient Certificate to Remote
Server on page 18-48

2. Click Generate.

3. Local security certificates are created and configured (illustrated
below).
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Note: Only click OK once. The status field at the bottom of the screen updates the status as it
progresses. If you click OK more than once, you delay the certificates’ creation.

Step 2: Create Security Certificates on the
Remote Server

1. Sign on to remote server.

2. Generate security certificates for the remote server, following
instructions in Step 1: Create Security Certificates on Your Local
Server on page 18-45.

3. When you complete this procedure, remote client and server security
certificates are created and configured (illustrated below).

Step 2: Create Security Certificates on the Remote
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Step 3: Copy Local Client Certificate to Remote
Server

1. On the local server, open two Windows Explorer windows: one
showing the local server’s file system, and the other showing the
remote server’s file system.

2. In the remote server window, create a folder underneath the root
folder. The folder name is not important.

Warning! Do not place it under the web root folder, C:\inetpub\wwwroot.

3. In the local server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400V7x\Utilities\Software\SecurityConfigurator
.

4. Copy the following files.

n servername_SyncClient.pfx

n servername_SyncClient.pvk

n servername_SyncClient.cer

n servername_SyncServer.pfx

n servername_SyncServer.pvk

n servername_SyncServer.cer

Note: These files were created when you completed the eSync Security Configurator Screen
in Step 1.

5. Paste the files into the remote server folder that you created in Step
2. Make sure there are no other security files in the folder.
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After the local server’s security certificates are copied to the remote server,
you need to register and move them to the correct folders. The Security
Configurator screen does this.

6. On the remote server, open the security configurator screen using
this path:Windows Start Button > All programs > Ektron >
CMS400 v8x > Utilities > Security Configurator.

7. The security configurator screen appears.

8. Click the Apply Remote Server Certificates button (circled
above).

9. Click the browse button next to that field.

10. Browse to the folder to which you pasted the security certificates in
Step 5.

11. Click the Apply button.

12. The utility copies the security certificates you pasted in Step 5 to the
correct folder, and configures them for the remote server.

Step 3: Copy Local Client Certificate to Remote
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Step 4: Copy Remote Client Certificate to Local
Server

1. Sign on to the remote server.

2. Follow the steps described in Step 3: Copy Local Client Certificate to
Remote Server on page 18-48, except substitute remote for local.

Step 5: Test the Security Certificates
1. From the local server, sign on to Ektron CMS400.NET.

2. In the Workarea, go to Settings > Configuration >
Synchronization.

3. Click the plus sign ( ).
4. Insert the name of the Remote Server.

5. Select the security certificate you are testing.

6. Click Connect.

7. If the next screen appears, the security certificates are working
properly.

Regenerating Security Certificates
Follow these steps to regenerate security certificates. You may need to do this
if they stop working, or you are concerned about a security breach.

1. Access the eSync Security Configurator screen viaWindows Start
Button > All programs > Ektron > CMS400 v8x > Utilities >
Security Configurator.
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2. Use theWeb Site pulldown field to select a site on your server, or
choose All sites.

3. Click the Discard Existing Keys checkbox (circled below).

4. Click Generate.

5. The existing security certificates are removed from your local server.

6. Reopen the Security Configurator screen.

7. Choose the correct Web Site, verify the other settings, and click
Generate. See Also: Step 1: Create Security Certificates on Your
Local Server on page 18-45

8. This action generates new security certificates on your server.

9. Copy the new certificates to all other servers in the eSync
configuration. This is explained in Step 3: Copy Local Client
Certificate to Remote Server on page 18-48.

Troubleshooting Security Certificates
n Could Not Connect Error below

n No Endpoint Error on next page

Could Not Connect Error
When trying to connect to a remote server, after selecting a security
certificate, you may see the following message.

Troubleshooting Security Certificates

ReferenceManual
Version 8.01 Rev 4

18-51



Here are some steps to resolve the problem.

n Check the Windows Event Viewer > EktronL2 log for the error. If the
service is hosted but already exists, stop then start the service (do
not restart).

n The certificates may be corrupted. To resolve this, see Regenerating
Security Certificates on page 18-50.

No Endpoint Error
- See Screen Sample

The above error indicates that
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n the remote site may not be on the same Ektron CMS400.NET version
as the local site, or

n the Ektron Windows Service is not started

Using eSync to Initialize a New Site
Typically, before you begin using eSync, one server hosts an Ektron
CMS400.NET Web site, and you want to bring other servers into the
configuration. After the servers are synchronized, one will be the staging
server (the one on which content is created or updated, then approved).
Another server, production, hosts your live Web site.

Warning! The names of the site and all folders mustmatch on both servers. This is because
paths to images, xslt files, etc. refer to a site and its folders. If the servers’ site and folder names
do not match, the links break.

First, use eSync to initialize the new servers from the existing one. This
process is described in Setting Up eSync on page 18-4. Afterwards, use eSync
to periodically sync updated content, folders, users, menus, etc.

Setting up eSync Profiles
To minimize data entry, eSync saves your specifications about an individual
eSync job in a sync profile. So, after you enter specifications the first time, just
select the profile every subsequent time you want to sync. A profile contains
information about the

n source and destination databases

n type of data being synched

n files to include/exclude

n direction

n schedule

Use the Add Synchronization Profile screen to create and update eSync profiles.

Using eSync to Initialize a New Site
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While following the steps in Setting Up eSync on page 18-4, you created a
default database and a template profile. This section explains how to modify
those profiles and create new ones.

To eSync an entire Web site, you need a minimum of two profiles: one for your
web site root/Workarea folder, and another for all other site files.

To create a profile for

n your Workarea folder, clickWorkarea Files under Items to
Synchronize.

n all other site files, click Database/Resources, Templates and Bin
under Items to Synchronize.
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The following table explains the kinds of files synched by each category.

Items to Synchronize Type of data synched Exceptions
For setup
instructions,
see

Workarea Files
All files in the site’sWorkarea
folder other than the
exceptions

Files in these folders:

n ewebeditpro

n help

n explorer

n ewebdiff

n documents

n foundation

n resources

n sync

See Also:Global File Type
Exceptionson next page

Setting up a
Profile to Sync
Workarea
Fileson page
18-58

Database/Resources

The database plus the
following site root folders

n assets

n Privateassets

n uploadedimages

n uploadedfiles

SeeGlobal File Type
Exceptionson next page

Setting up a
Profile to Sync
a Database
and Assetson
page 18-57

Setting up eSync Profiles
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Items to Synchronize Type of data synched Exceptions
For setup
instructions,
see

Templates

Warning! If you run a
template syncandBin is
checked, and one server
is running is 32-bit mode
while the other is running
in 64-bit mode, userswill
not be able to drag and
drop DMS files on the
staging server.

All files in your site root folder
other than the exceptions

Note: If you perform an
initial syncof a recently-
installedmin site with your
staging site, themin site’s
templates could overwrite
templateson your staging
site. This is because, when
two templateshave the
same name, themost
recentlymodified one
overwrites the other.
To avoid this, rename the
only template installed with
themin site (login.aspx)
before performing the
initial template sync. You
should also rename
login.aspx’s supporting
files, such as login.aspx.vb.

Files in these folders:

n workarea (covered by
Workarea Files sync)

n assets, privateassets,
uploadedfiles,
uploadedimages
(covered by
Database/Resources
sync)

n bin (covered byBin
checkbox, below)

n app_webreferences

n latestchanges

n app_globalresources

These files:

n
assetManagement.config

n web.config

See Also:Global File Type
Exceptionsbelow

Setting up a
Profile to Sync
Template and
Bin Fileson
page 18-61

Bin The bin folder

You can also set up a profile that syncs Windows folders. See Also:
Synchronizing Windows Files on page 18-64

This section also contains the following topics.

Global File Type Exceptions 18-56
Setting up a Profile to Sync a Database and Assets 18-57
Setting up a Profile to Sync Workarea Files 18-58
Setting up a Profile to Sync Template and Bin Files 18-61
Pausing the Sync Schedule 18-63
Bidirectional Sync 18-63
Conflict Resolution Policy 18-64
Synchronizing Windows Files 18-64

Global File Type Exceptions
The following file types are not synched by default.

n .config files

n .txt files
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n .sln files

Note: Ektron CMS400.NET creates a large number of .txt files to support the search
functionality.

However, you can add these file types to a sync profile via the
Include/Exclude Files field. See Also: At the Include/Exclude files field,
include files not normally synched, or exclude files or directories that are
synched by default. on page 18-59

Setting up a Profile to Sync a Database and
Assets
To set up a profile to sync an Ektron CMS400.NET database and its assets,
follow these steps.

Prerequisite

n You created a Sync configuration and ran an initial sync. See Also:
Setting Up eSync on page 18-4

1. Go to the Settings > Configuration > Synchronization screen.

2. If you are eligible to add a profile to a configuration, the Add Sync
Profile button appears, as shown below.

3. Click the Add Sync Profile button (circled above). The Add
Synchronization Profile screen appears.

4. At the Synchronization name field, enter a name for this profile.

5. At the Items to Synchronize field, select Database/Resources.

6. At the Synchronization Direction field, select the direction of the
data copy that will occur. Your choices are:

n Bidirectional (that is, both directions). Changed data on either
server is updated on the other. If the same data (for example, a
membership user profile) is updated on both servers, the conflict
resolution policy determines the outcome. See Also: Bidirectional
Sync on page 18-63; Conflict Resolution Policy on page 18-64
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Note: If you are using bidirectional sync and only one version was updated since the last sync,
the updated version overwrites the unchanged version.

n Upload - the database and assets are copied from the local server
(the one to which you signed on) to the remote server (specified at
the Remote Site field above). Items on the remote server are
overwritten.

n Download - the database and assets are copied from the remote
server to the local server. Items on the local server are overwritten.

7. At the Conflict Resolution Policy field, decide what to do if
Synchronization Direction is Bidirectional, and the data has changed
on both servers since the last sync. Your choices are.

n Version on Remote Site Wins - the remote version overwrites
the local version

n Version on Local Site Wins - the local version overwrites the
remote version

8. If desired, select a schedule for when the sync will run automatically.
The choices are

n None - Don’t set up a schedule. Run this sync profile as needed
via the Sync Profile screen‘s Start Now button.

n One Time - you specify a start time and date

n Hourly - you specify a start date and time. eSync begins on the
start date and time, then runs every hour at that time.

n Daily - you specify a start time and date; this sync profile will
run every day at this time

n Weekly - you specify a start time, date, and day. After the start
date, this sync profile will run this day every week at this time.

n Monthly - you specify a start time and date (numbers 1 through
31). After the start date, this sync profile will run this day every
month at this time.

Warning! Do not schedule more than one sync to begin at the same time.

Note:While the above options let you schedule a sync profile, you can sync at any time by

accessing the Sync Profile and clicking the Sync button ( ). See Also: Running a Sync on
page 18-66

Note: If you enter a date greater than 28, the sync will not run in a month that does not include
that date. For example, if you enter 31, the sync will not run in February, April, June,
September, and November.

Setting up a Profile to Sync Workarea Files
Prerequisite

Synchronizing Servers Using eSync

18-58 ReferenceManual
Version 8.01 Rev 4



n You created a Sync configuration and ran an initial sync. See Also:
Setting Up eSync on page 18-4

1. Go to the Settings > Configuration > Synchronization screen.

2. If you are eligible to add a profile to a configuration, the Add Sync
Profile button appears on the right side, circled below.

3. Click the Add Sync Profile button. The Add Synchronization Profile
screen appears.

4. At the Synchronization name field, enter a name for this profile.

5. At the Items to Synchronize field, selectWorkarea files.

6. At the Include/Exclude files field, include files not normally
synched, or exclude files or directories that are synched by default.

For example, .txt files are not normally included in a sync, but you want
to copy several on your staging server to the production server. In this
case, check Only Include and enter *.txt into the adjacent field
(illustrated below). If you do, only files with that extension are synched.

As an example of the Exclude option, assume you do not want to sync
Flash (.swf) files. If you check the Exclude button, and enter .swf into
the Files field, eSync ignores them.

Note: By default, eSync ignores .config and .txt files.

An another example of the Exclude option, assume you do not want to sync
files in the XXX folder. If you check the Exclude button, and enter XXX into the
Directories field, eSync ignores them.

When excluding, you can enter file types and directories. eSync ignores all files
that satisfy either criterion.

7. At the Synchronization Direction field, select the direction of the
data copy that will occur. Your choices are:

Setting up a Profile to SyncWorkarea Files
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n Bidirectional (that is, both directions). Changed data on either
server is updated on the other. If the same data (for example, a
membership user profile) is updated on both servers, the conflict
resolution policy determines the outcome. See Also: Bidirectional
Sync on page 18-63; Conflict Resolution Policy on page 18-64

Note: If you are using bidirectional sync and only one version was updated since the last sync,
the updated version overwrites the unchanged version.

n Upload - if the file on the local server was modified more recently
than the one on the remote server, the local file replaces the remote.
Otherwise, nothing happens.

n Download - if the file on the remote server was modified more
recently than the one on the local server, the remote file replaces the
local. Otherwise, nothing happens.

8. At the Conflict Resolution Policy field, decide what to do if
Synchronization Direction is Bidirectional, and the data has changed
on both servers since the last sync. Your choices are.

n Version on Remote Site Wins - the remote version overwrites
the local version

n Version on Local Site Wins - the local version overwrites the
remote version

9. If desired, select a schedule for when the sync will run automatically.
The choices are

n None - Don’t set up a schedule. Run this sync profile as needed
via the Sync Profile screen‘s Start Now button.

n One Time - you specify a start time and date

n Hourly - you specify a start date and time. eSync begins on the
start date and time, then runs every hour at that time.

n Daily - you specify a start time and date; this sync profile will
run every day at this time

n Weekly - you specify a start time and date. After the start date,
this sync profile will run every week on the same day at the specified
time.

n Monthly - you specify a start time and date (numbers 1 through
31). After the start date, this sync profile will run every month on the
same day at the specified time.

Warning! You cannot schedule more than one sync to begin at the same time.

Note:While the following options let you schedule a sync profile, you can sync at any time by

accessing the Sync Profile and clicking the Sync button ( ). See Also: Running a Sync on
page 18-66
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Note: If you enter a date greater than 28, the sync will not run in a month that does not include
that date. For example, if you enter 31, the sync will not run in February, April, June,
September, and November.

Setting up a Profile to Sync Template and
Bin Files
Prerequisite:

n You created an eSync configuration and ran an initial sync. See Also:
Setting Up eSync on page 18-4

1. Go to the Settings > Configuration > Synchronization screen.

2. If you are eligible to add a profile to a configuration, Add Sync
Profile appears, as shown below.

3. Click the Add Sync Profile button. The Add Synchronization Profile
screen appears.

4. At the Synchronization name field, enter a name for this profile.

5. At the Items to Synchronize field, select Templates and Bin.

6. At the Include/Exclude files field, include files not normally
synched, or exclude files or directories that are synched by default.

For example, .txt files are not normally included in a sync, but you want
to copy several on your staging server to the production server. In this
case, check Only Include and enter *.txt into the adjacent field
(illustrated below). If you do, only files with that extension are synched.

As an example of the Exclude option, assume you do not want to sync
Flash (.swf) files. If you check the Exclude button, and enter .swf into
the Files field, eSync ignores them.
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Note: By default, eSync ignores .config and .txt files.

As another example of the Exclude option, assume you do not want to sync
files in the Marketing folder. If you check the Exclude button, and enter
Marketing into the Directories field, eSync ignores those files.

When excluding, you can enter file types and directories. eSync ignores all files
that satisfy either criterion.

7. At the Synchronization Direction field, select the direction of the
data copy that will occur. Your choices are:

n Bidirectional (that is, both directions). Changed data on either
server is updated on the other. If the same data (for example, a
membership user profile) is updated on both servers, the conflict
resolution policy determines the outcome. See Also: Bidirectional
Sync on the facing page; Conflict Resolution Policy on page 18-64

Note: If you are using bidirectional sync and only one version was updated since the last sync,
the updated version overwrites the unchanged version.

n Upload - if the file on the local server was modified more
recently than the one on the remote server, the local file replaces the
remote. Otherwise, nothing happens.

n Download - if the file on the remote server was modified more
recently than the one on the local server, the remote file replaces the
local. Otherwise, nothing happens.

8. At the Conflict Resolution Policy field, decide what to do if
Synchronization Direction is Bidirectional, and the data has changed
on both servers since the last sync. Your choices are.

n Version on Remote Site Wins - the remote version overwrites
the local version

n Version on Local Site Wins - the local version overwrites the
remote version

9. If desired, select a schedule for when the sync will run automatically.
The choices are

n None - Don’t set up a schedule. Run this sync profile as needed
via the Sync Profile screen‘s Start Now button.

n One Time - you specify a start time and date

n Hourly - you specify a start date and time. eSync begins on the
start date and time, then runs every hour at that time.

n Daily - you specify a start time and date; this sync profile will
run every day at this time

n Weekly - you specify a start time, date, and day. After the start
date, this sync profile will run this day every week at this time.
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n Monthly - you specify a start time and date (numbers 1 through
31). After the start date, this sync profile will run this day every
month at this time.

See Also: Pausing the Sync Schedule below

Warning! You cannot schedule more than one sync to begin at the same time.

Note:While the following options let you schedule a sync profile, you can sync at any time by

accessing the Sync Profile and clicking the Sync button ( ). See Also: Running a Sync on
page 18-66

Note: If you enter a date greater than 28, the sync will not run in a month that does not include
that date. For example, if you enter 31, the sync will not run in February, April, June,
September, and November.

Pausing the Sync Schedule
If a sync profile runs on a schedule, you can temporarily pause it. To do this
click the profile's pause/play button (circled below).

While paused, the sync will not run. To resume the schedule, press the
pause/play button a second time.

For example, a sync is scheduled to run every hour @ :50: 1:50, 2:50, 3:50,
etc.

At 10:30 a.m., you pause the sync profile. So, at 10:50 a.m., the sync does not
run .

At 12:00 noon, you click the pause/play button again to resume the schedule. In
this case, the next sync will start at 12:50 p.m.

Bidirectional Sync
Although most CMS data is created and updated on the staging server, certain
types of data are collected on the production server. This information can be
viewed and edited on the staging server. Here are some examples:

n membership users

n content ratings data

n forum and blog posts

n community folders

When you set up a sync profile to copy this kind of data (maintained in the
database), you typically would choose Bidirectional as the direction. In this
case, if a membership user creates or updates his profile on the production
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server, those changes are transmitted to staging. On the other hand, if your
administrator needs to change that membership user’s information, the next
eSync transfers that from staging to production.

If changes are made to the same file on both servers since the last sync, your
conflict resolution policy determines which data is saved. See Also: Conflict
Resolution Policy below

Note: The first time you run a sync for templates or Workarea files, the sync is bidirectional,
regardless of the direction you specify on the Synchronization Direction screen.

Conflict Resolution Policy
If you are using bidirectional synchronization (See Also: Bidirectional Sync on
previous page), and the same item changed on both servers since the last sync,
eSync must decide which version should be kept, and which version
overwritten.

Note: If you are using bidirectional sync and only one version was updated since the last sync,
the updated version overwrites the unchanged version.

Use the Conflict Resolution Policy field to determine which version ends up
on both servers after synchronization. The following choices are available.

n Version on Remote Site Wins - the remote version overwrites the
local version

n Version on Local Site Wins - the local version overwrites the
remote version

Synchronizing Windows Files
As an alternative to selecting a type of data to sync (using the File types radio
button), you can sync individual Windows files. For example, you updated a few
template files and their related .css files on the staging server, and now want to
update the production server without moving everything else.

Note: If you create new HTML content and insert a Library image into it, then sync just that
content, the image is not inserted into the destination library nor is it searchable from the
destination site. To remedy this problem, perform a database/ resources sync.

See Also: Using eSync on page 18-35

Unlike the full sync, you cannot schedule a Windows file sync. Instead, you
select files then sync immediately.

Like the profile sync, the local file replaces the corresponding remote one only
if the local file was modified more recently than the one on the remote server.
Otherwise, nothing happens.

To synchronize Windows files, follow these steps.

1. Create a sync configuration between the two servers whose files you
want to sync. See Setting Up eSync on page 18-4.
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2. From the View All Synchronization Configurations screen, click the
Add Sync Profile button (see below).

3. Complete the fields on the screen except for Schedule, which the file
sync ignores. See Setting up a Profile to Sync Workarea Files on page
18-58.

4. Save the profile.

5. From the View All Synchronization Configurations screen, click the

Synchronize files button ( ) next to the profile.
6. All folders in your Ektron CMS400.NET site root folder appear. Open

folders as needed, and check all files to be synched.

7. Click the Sync now button ( ).
8. A dialog tracks the sync’s progress, and notifies you when it is

completed.

Optional Steps before Running a Sync
You may want to adjust the web.config and db.config settings before running a
Sync. The following topics explain eSync features that you control via the
.config files.
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n Content and Folder Sync Options on page 18-76

n Using eSync with Web Alerts on page 18-93

n Using eSync with eCommerce on page 18-94

n Force Initial Sync on the facing page

n Backing up the Destination Server During an eSync on page 18-69

Running a Sync
Important: The names of the site and all folders mustmatch on both servers. This is because
paths to images, xslt files, etc. refer to a site and its folders. If the servers’ site and folder names
do not match, the links break.

Warning! You cannot run two eSyncs simultaneously.

This section also contains the following topics.

Prerequisites for Running a Sync 18-66
Force Initial Sync 18-67
Force Initial Sync Prerequisites 18-68

Prerequisites for Running a Sync
n eSync Requirements on page 18-35

n You created an eSync configuration and profile. See Setting Up eSync
on page 18-4.

n You are not signed on to a production server that is outside the
firewall. This is because you cannot sync from a production server
outside the firewall to other servers - you can only sync to this
production server.

As mentioned in Setting up eSync Profiles on page 18-53, you can set up eSync
to run on a schedule. However, you can also sync at any time. Follow these
steps to sync a profile immediately.

1. Go to the Settings > Configuration > Synchronization screen.

2. If a profile is ready for you to sync, a sync button appears in the right
column, as circled below.

- See Screen Sample
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3. Click the sync button ( ).

Note: If another sync is running, you are notified. You cannot begin a new sync until the
current one finishes.

4. A screen monitors the sync’s progress.

- See Screen Sample

5. The screen indicates when the sync is complete.

Note: You can close the window and reopen it at any time by clicking the sync button ( ). If
you do, the sync’s current status appears.

Warning! If you performed a database sync and the site being synched uses URL aliasing, you

must go to its URL Aliasing Configuration screen and click the Refresh button ( ) to update its
aliasing information.

Force Initial Sync
Use the Force Initial Sync button to reinitialize a server that was previously
initialized.
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Here’s a scenario in which you would want to use Force Initial Sync.

1. You initialized a test server from your current Ektron CMS400.NET
server.

2. You experimented on the test server by adding new content, deleting
content, etc.

3. You no longer want the test server’s database. Instead, you want to
reinitialize the test server from the Ektron CMS400.NET server.

To accomplish step 3, use the Force Initial Sync button. The button only appears
when all prerequisites are present. See Also: Force Initial Sync Prerequisites
below

Note: The Force Initial Sync procedure ignores the following checks that are normally made
prior to synching:
* the destination database is smaller than the source database
* the site has not been previously staged

Force Initial Sync Prerequisites
In order to use the Force Initial Sync feature, these conditions must exist.

n The server’s web.config file’s ek_ForceReInit property is set to
true.

Note: If the ForceReInit property is set to false, and you click the Force Initial Sync button,
you are informed that you need to change the property to true if you want to force an initial
sync.

n The site to which you are signed on is not part of a multi-site
configuration.

n The server has only one sync server relationship.

n The server is the destination in the sync server relationship. In other
words, the server must be on the download side of the relationship.

The following image illustrates the last two conditions.
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Backing up the Destination Server
During an eSync
You can create a backup of the destination server’s database. If you do and
problems occur during the sync, the database is automatically restored to its
state prior to beginning the backup.

You can specify the backup to occur on the initial sync only, or every time you
sync.

Note: No backup is made when you sync a folder or content. See Also: Content and Folder
Sync Options on page 18-76

Setting up the Destination Database Backup
To set up the database backup, follow these steps.

1. Open C:\Program
Files\Ektron\EktronWindowsService30\dbsync.config.

2. Find the following line (near the top).
<DatabaseRuntime name="EktronDbSync" logPath="C:\Program
Files\Ektron\EktronWindowsService30\Database\">

3. Add the following properties to that tag
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n device - Following device, enter the path to the backup file. Ektron
recommends using C:\Program Files\Microsoft SQL

Server\MSSQL.1\MSSQL\Backup\.

n backupOption - possible values

- 1 - backup on initial sync only

- 2 - backup every time you run a sync

4. The line should now look something like this:
<DatabaseRuntime name="EktronDbSync" device="C:\Program Files\Microsoft SQL
Server\MSSQL.1\MSSQL\Backup\" backupOption="1" logPath="C:\Program
Files\Ektron\EktronWindowsService30\Database\">

5. Save the file.

6. Restart the Ektron Windows Service.

- See Screen Sample

Once this is set up, a backup file is created either after the initial sync (if
backupOption="1") or after every sync (if backupOption="2").

Here is the file’s format:
[dbname][yyyy][mm][dd][hh][mm][ss][mmm].[product].bak

For example: cms400min20090216075946765.esync.bak.

(continued in Synchronization Screens)

Sync Logs
eSync provides the following logs of previous sync activity.

n the most recent sync for any profile - see Viewing a Log of a Profile’s
Most Recent Sync on the facing page
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n the most recent sync for any sync server relationship - see Viewing a
Log of a Sync Server Relationship’s Most Recent Sync on next page

n all syncs for a sync server relationship - see Viewing a Log of all
Syncs for a Sync Server Relationship on next page

Viewing a Log of a Profile’s Most Recent
Sync
You can view a log of any profile’s most recent sync by clicking the log icon (
) next to that profile (circled below).

The Last Sync Status icon appears only for profiles that have been previously
synched.

The sync log (shown below) has the same appearance as the log that appears
upon completion of a sync.
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Viewing a Log of a Sync Server
Relationship’s Most Recent Sync
You can view a log of a Sync Server Relationship’s most recent sync by clicking

the log icon ( ) (circled below) in the header section of the screen.

The sync log (shown above) has the same appearance as the log that appears
upon completion of a sync.

Viewing a Log of all Syncs for a Sync Server
Relationship
The View All Synchronization Configurations screen provides a toolbar button
(circled below) that displays a chronological log of all syncs on your server,
with the most recent one at the top.
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You can click the icon in the Status column to view details about the sync.

If the column contains a green check mark, the sync was successful.

If the column contains a warning ( ), the sync failed for some items. If you
click the icon, a new screen appears listing causes for the failure, as shown
below. Ektron support staff can use this log to troubleshoot the problem.
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Reviewing Resolved Collisions
To verify the accuracy of the data being synchronized, eSync checks for and
resolves the followingmatching items

n user names

n folder names

n metadata definitions

n messages

For example, on the staging server, a user creates a folder directly under the
root folder called Marketing, and a user on the production server does the
same.

Note: * In order for folders to match, they must have the same name and folder path.
* Both CMS and membership users are included.

This problem only occurs if the matching items were both entered since the last
synchronization.

Although matching items have different ID numbers, users cannot tell them
apart. So, eSync appends the ID number to the more recently-created one to
distinguish it from the other. For example, Marketing becomes
Marketing11329.

This section also contains the following topics.

The Review Resolved Collisions Button 18-74
The Review Synchronization Collisions Screen 18-75

The Review Resolved Collisions Button
To help track these changes, the View All Synchronization Configurations screen
has a button ( ) that appears only after such a collision is resolved.

- See Screen Sample

The server on which the button appears is explained below.
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eSync Direction
Collision Resolution Information Appears on
this Server

download local

upload remote

When you click this button, the Review Synchronization Collisions screen
appears, showing the original and changed items.

The Review Synchronization Collisions
Screen
This screen shows how collisions between matching items were resolved. See
Also: Reviewing Resolved Collisions on previous page

Each type of resolved collision appears on its own tab.

- See Screen Sample

After noting these changes, you can click the box to the left of each change,
then click the Mark Reviewed button to remove it from the screen.
Alternatively, you can click the box in the header row to select all.

The Users tab has an additional button, Mark Reviewed and Email. Use it to
remove the user from the screen and send an email to him/her (using the
address from the Add/Edit User screen’s E-Mail Address field). The email text
is below.

lbl sync collision email subject = Your username has been changed

lbl sync collision email body = For security purposes, your username has been changed.
Your new username is {0}. You will need to use this new username the next time you
login. Thank you.

Note: You can change the text in the resource file. To learn about editing it, see Procedure for
Translating Workarea Strings on page 14-41.

See Also: Using eSync on page 18-35
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Synching Custom Database Tables
You can use eSync to synchronize a custom SQL database table. To do so, follow
these steps.

1. Add a new, empty table to the target SQL database.

2. On the server that hosts the source database, navigate to C:\Program
Files\Ektron\EktronWindowsService30.

3. Open the DbSync.config file.

4. Find the section that begins <Release version="7.6.6.

5. Within the 7.6.<Groups> tag, you see these names:
<add name="default" scope="ektron"
<add name="folder" scope="ektron"
<add name="content" scope="ektron"
<add name="folderrecursive" scope="ektron"
<add name="workflow" scope="workflow"
<add name="custom" scope="custom" schema=""/>

6. Enter your custom table schema within the last line’s schema="" tag.

Note: Follow the pattern of the existing schemata when adding yours.

7. Save DbSync.config.

8. Sign on the source server.

9. Follow steps 1 through 7 on that server.

10. Restart the Ektron Windows Service on both servers.

11. Run a DB sync from local to remote (local win).

Content and Folder Sync Options
Members of the Administrators group or those assigned to the Synchronization
Admin role can sync individual content items and Ektron CMS400.NET folders
using context menu options, as shown below.

See Screen Sample
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This section also contains the following topics.

Prerequisites for Content/Folder Sync 18-77
Enabling the Content and Folder Level Sync 18-78
Using Content and Folder Level Sync 18-79
Synching a Content Item 18-79
Synching a Folder 18-82

Prerequisites for Content/Folder Sync
See Also: eSync Requirements on page 18-35

n You are a member of the Administrators group or assigned to the
Synchronization Admin role

n Content/folder sync is enabled in web.config. See Enabling the
Content and Folder Level Sync on next page.

n The server has a sync configuration whose initial sync has been run

n Existing folders: folder information has not been updated since the
last database sync using the selected profile.

If any folder property is changed (for example, a new metadata
value is assigned), a database sync must be run before you can
synchronize content in that folder and the folder itself.
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Furthermore, any child folder (and its content) that inherits that
property from the parent folder can only be synchronized after the
next database sync.

n New folders: a database sync must be run before you can
synchronize content in the new folder and the folder itself

n Content: No new tags or taxonomy categories have been added since
the last time the selected profile was synched. If either event has
occurred, a database sync must be run before you can synchronize
that content. You must also run a database sync for all other profiles
that use those tags or taxonomy.

The following graphic illustrates adding new tags and a taxonomy category to
content.

See Screen Sample

n For a folder sync, the content is not a blog or forum post. For a
content sync, the content is not a forum post.

See Also: Content and Folder Sync Options on page 18-76

Enabling the Content and Folder Level Sync
To set up the content and folder Synchronize options, follow these steps.

1. Log on to the server on which content editors will sync content and
folders.

2. Open Windows Explorer > your site root folder > the web.config file.

3. Go to the following area.
<eSyncSettings>

<!-- enables or disables eSync feature -->

<add key="eSyncEnabled" value="false"/>
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</eSyncSettings>

4. Set the value of eSyncEnabled to true.

5. Save web.config.

See Also: Content and Folder Sync Options on page 18-76

Using Content and Folder Level Sync
You would typically use eSync in the following manner.

1. Create, update, and get content approved on a staging server.

2. Synchronize content blocks or an Ektron CMS400.NET folder with the
production server.

See Also: Prerequisites for Content/Folder Sync on page 18-77; Content and
Folder Sync Options on page 18-76

The eSync feature is available if you see Synchronize menu options (shown
below) on Approved content or a folder.

See Screen Sample

See Also: Synching a Content Item below; Synching a Folder on page 18-82

Synching a Content Item
Content sync copies a selected content item to another computer. The sync also
copies library resources within that content, such as images and quicklinks.
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Note:When you sync one content item, all physical files (DMS assets and library files) in the
selected content’s folder are also synched.

Only Approved content can be synchronized. See Also: Prerequisites for
Content/Folder Sync on page 18-77

To sync a content item, follow these steps.

1. Navigate to the content. You can

n go to the Web page that displays it

n sign into the Ektron CMS400.NET Workarea and

- navigate to its folder, or

- use the Search to find it (see below)

See Screen Sample

2. Click the arrow to the right of the content to see its dropdown menu.

See Screen Sample
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A Synchronize button (shown below) is also available from the View Content
screen.

Note:

3. Click Synchronize.

4. All relationships with at least one Database profile whose direction is
Upload or Bidirectional appear. Select the appropriate one. See
Also: Setting up eSync Profiles on page 18-53

See Screen Sample

5. Click Sync Now.

6. The content is synchronized with the selected database.

Synching a Content Item

ReferenceManual
Version 8.01 Rev 4

18-81



Synching a Folder
The folder sync updates all content in a folder with another computer. It does
not affect content in folders underneath the selected folder. See Also:
Prerequisites for Content/Folder Sync on page 18-77

To sync a folder, follow these steps.

1. Navigate to the folder.

2. Click Action > Synchronize Folder.

See Screen Sample

3. A screen asks you to select a sync relationship.

See Screen Sample

4. Click the Start Sync button.

5. All content in the folder is synched with the selected database.

eSync in a Load Balanced Environment
Ektron CMS400.NET supports a load-balanced environment, in which several
servers share your Web site’s processing load. This feature is explained in
Balancing the Load on Your Servers on page 22-1.

If your site uses load balancing, you can set up eSync such that, after one
server in a load balance cluster is synchronized, the other servers will be
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automatically synchronized. Note that if a separate database server is outside
the load balance cluster (as shown below), eSync only synchronizes documents
and files used by the search among the clustered servers. It does not touch the
database.

A typical load balanced cluster is below.

See Illustration

Warning! Ektron’s eSync feature does not synchronize all databases in a SQL database cluster.
If you have such a configuration, it is your responsibility to ensure that eSync updates all the
databases.

Warning! In a load balanced environment, only update templates on the staging server. Do not
update them on the production server and assume they will be synchronized with the staging
server.

Warning! Assume your load balanced cluster consists of two staging servers (S1 and S2) and
two production servers (P1 and P2).
If you add/modify/delete a file on S1, to get the file to S2, you must run either a download sync on
S2, or an upload sync on S1, or a bidirectional sync from either server. If you run a download
sync on S2, you also need to run an upload sync to push the file to P2, which will then Load
Balance with P1.
The best way to make sure that the added/modified/deleted file is changed on all servers is to
initiate the sync from the server on which the file was changed. In this example, since you
changed the file on S1, if you initiate a sync from S1, it will be automatically updated on S2, P1,
and P2.

Prerequisites

n The connection string on all servers in the cluster match

n Youmust initiate eSync relationships, and the actual synchronization,
from a staging server
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n If your staging servers are clustered, you must remove one from the
cluster before you can sync

Follow these steps to set up this capability.

n Install a Min Site on Every Server in the Cluster below

n Update the Assetmanagement.config File below

n Update the Ektron Windows Service Config File below

n Create eSync Security Certificates for a Load Balanced Cluster on the
facing page

Install a Min Site on Every Server in the
Cluster

1. Upgrade each server to the same version of Ektron CMS400.NET. If
Ektron CMS400.NET is already installed to one server, you can install
a minimum site on the other servers.

2. To do this, run the Ektron CMS400.NET base installation file
(CMS400Base8x.exe). For more information, see the Ektron
CMS400.NET Setup manual.

3. If the current site with which you will sync is precompiled, you must
also precompile all min sites.

Update the Assetmanagement.config File
1. Sign on to the first server in your load balanced cluster.

2. In the site root folder, open site root\assetmanagement.config.

3. Change the value of LoadBalanced to 1 and save.

4. Do this on every server in the cluster.

Update the Ektron Windows Service Config
File

1. Sign on to the first server in your load balanced cluster.

2. Open
C:\ProgramFiles\Ektron\EktronWindowsService30\Ektron.ASM.EktronServices30.exe.Config
.

3. Change the value of LoadBalanced to 1 and save.

4. Do this on every server in the cluster.

See Illustration
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5. Stop and then Start the Ektron Windows Service on every server in
the cluster.

See Screen Sample

Create eSync Security Certificates for a Load
Balanced Cluster
You should be familiar with eSync security certificates before beginning this
procedure. If you are not, read the following section: Managing eSync Security
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Certificates on page 18-43.

Assume the load balance cluster has three servers: mach1, mach2, and mach3.

This procedure has two major parts.

n Generating Security Certificates on mach1.

n Applying Security Certificates to mach2 and mach3

Generate Security Certificates on mach1
In the first nine steps, you copy mach1’s security certificate files, then paste
them into the same folder, and rename them beginning with mach2 and mach3.

1. Sign on to mach1 and generate security certificates. To do this, click
the Windows Start Button> All programs > Ektron > CMS400
v8x > Utilities > Security Configurator.

2. The security configurator screen appears.

3. See Use the following table to complete this screen. on page 18-46.

4. Click Generate Certificates then click OK. This action creates
security certificates on mach1.

5. On mach1, open the following folder:
C:\ProgramFiles\Ektron\CMS400v8x\Utilities\Software\SecurityConfigurator
.

6. Copy the following files.

n mach1_SyncClient.pfx

n mach1_SyncClient.pvk

n mach1_SyncClient.cer

n mach1_SyncServer.pfx

n mach1_SyncServer.pvk

n mach1_SyncServer.cer

7. Paste them into the same folder.

8. Rename each file according to the following pattern: mach2_file
name. (This assumes the second server in your load balance cluster
is mach2.)

9. Repeat steps 7 and 8 for every server in your load balance cluster. So
the number of certificate files in the folder is 6 x the number of
servers.

10. Copy all security certificate files to the following mach1 folder:
C:\Program Files\Ektron\EktronWindowsService30.

11. Stop and start the Ektron Windows Service.

In the second part of this procedure, you

n open the Ektron.ASM.EktronServices30.exe.config file

n copy mach1’s certificate’s key value
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n create new keys, and apply mach1’s encoded value to them

So, when you finish, the affected part of the file looks like this:

<add key="mach1_SyncClient.cer" encodedValue="MIIB7TCCAVag....
<add key="mach2_SyncClient.cer" encodedValue="MIIB7TCCAVag....
<add key="mach3_SyncClient.cer" encodedValue="MIIB7TCCAVag....

Note: The encodedvalue above is abbreviated to fit the page.

12. Open the following file:
C:\Program Files\Ektron\CMS400v8x
\Utilities\EWSUpdates\3.0\Ektron.ASM.EktronServices30.exe.config

13. Find the <publickCertKeys> element.

14. Following that line is the encoded certificate value for mach1, which
looks something like this.

<add key="mach1_SyncClient.cer" encodedValue="MIIB7TCCAVag....

Note: The encodedvalue above is abbreviated to fit the page.

15. Copy the entire <add key> element, including the value, into the
Notepad file.

16. Open a text processing application like Notepad.

17. Into the Notepad file, paste the text you copied in Step 13 three
times.

18. Change the second line’s add key value to mach2_SyncClient.cer.

19. Change the third line’s add key value to mach3_SyncClient.cer.

20. Copy the second and third lines of the Notepad file (the lines you just
changed).

21. Return to the Ektron.ASM.EktronServices30.exe.config file.

22. Locate the <add key> element.

23. Place the cursor directly below that line.

24. Paste the text you copied in Step 18.

25. Save the Ektron.ASM.EktronServices30.exe.config file.

Apply Security Certificates to mach2 and mach3
1. On the local server, open two Windows Explorer windows: one

showing the mach1’s file system, and the other showing the mach2’s
file system.

2. In the mach1 window, open C:\Program
Files\Ektron\EktronWindowsService30.

3. Copy all security certificate files in that folder.

4. In the mach2 window, open the following folder: C:\Program
Files\Ektron\EktronWindowsService30.

5. Paste all security certificate files you copied in Step 3 to that folder.

Apply Security Certificates tomach2 andmach3
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6. Stop and start the Ektron Windows Service.

7. In the mach2 window, create a folder underneath the root folder.
Name it Ektron Security Certificates.

Warning! Do not place it under the web root folder, C:\inetpub\wwwroot.

8. Return to the mach1 window, which is still open to the following
folder: C:\Program Files\Ektron\EktronWindowsService30.

9. Copy the following files.

Warning! Copy - do not move - the files from the mach1 folder.

n mach2_SyncClient.pfx

n mach2_SyncClient.pvk

n mach2_SyncClient.cer

n mach2_SyncServer.pfx

n mach2_SyncServer.pvk

n mach2_SyncServer.cer

10. Paste the files into the mach2 folder you created in Step 6. Make sure
there are no other security files in the folder.

Next, you need to register and move the files to the correct folders. The
Security Configurator screen does this.

11. On mach2, open the security configurator screen using this path:
Windows Start Button > All programs > Ektron > CMS400
v8x > Utilities > Security Configurator.

12. The security configurator screen appears.

See Screen Sample
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13. Click the Apply Remote Server Certificates button (circled
above).

14. Click the browse button next to that field.

15. Browse to the folder to which you pasted the security certificates in
Step 9.

16. Click the OK button.

17. The utility copies the security certificates you pasted in Step 9 to the
correct folder, and configures them for the remote server.

18. Repeat the above steps for every server in the load balance cluster.
Note that the files to be copied will start with the server name you’re
currently setting up.

Setting Up and Running eSync
You set up and run eSync in a load balanced environment the same way you run
it normally. See these sections for details.

n Using eSync to Initialize a New Site on page 18-53

n Setting up eSync Profiles on page 18-53

n Optional Steps before Running a Sync on page 18-65

n Running a Sync on page 18-66

Note: If your first load balanced sync fails, you must run the Search Config Utility on the load
balanced server in order for search to work. See Also: Automatically Recreating a Catalog on
page 9-11

Setting Up and Running eSync
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Using eSync in a Multi-site Environment
If you want to use eSync in a multi-site environment, youmust do so before the
initial synchronization of a configuration. That is, you cannot set up a eSync
configuration in a single-site environment and then later change to multi-site.
You can set up a new configuration at any time.

This section also contains the following topics.

Limitations on Using eSync in a Multi-site Environment 18-90
Setting up eSync in a Multi-Site Environment 18-90
Setting up Staging Multi-sites 18-93

Limitations on Using eSync in a Multi-site
Environment

n In a multi-site environment, you cannot create a staging site from a
production site (as described in ”Using eSync to Initialize a New Site
on page 18-53). You must first create all sites on the staging server,
then set up production sites with which they will sync.

n Ektron recommends logging into the main site then synchronizing it
and all multi-sites from there.

Setting up eSync in a Multi-Site Environment
To set up eSync in a multi-site environment, follow these steps.

Warning! Back up your database before beginning this procedure!

1. Set up all sites on the staging server, following the instructions in
”Multi-Site Support” on page 60the Ektron CMS400.NET Administrator
Manual section “Multi-Site Support”.

2. Install an Ektron CMS400.NET min site on each production server that
will host a site. To do this, run the Ektron CMS400.NET base
installation file. (For more information, see the Ektron CMS400.NET
Setup manual.)

3. Install security certificates between the staging server and all
production servers. This procedure is described in Managing eSync
Security Certificates on page 18-43.

4. Sign on to the staging server.

5. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Synchronization.

6. The View All Synchronization Configurations screen appears.

7. Click the Add button ( ).
8. The Create Synchronization Server Relationship screen appears.

Synchronizing Servers Using eSync
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Note: If you see the following error, The system cannot find the file specified, you must set
up security certificates. See Also:Managing eSync Security Certificates on page 18-43

9. Use the following table to complete the screen.

Warning! The first time you sync a Ektron CMS400.NETWeb site, all of its data is overwritten.
Make sure that no important information resides on the production server before beginning the
first sync.

Field Description

Remote
Server

Select a production server by choosing the path to the site’s

physical location on the remote server.

Choose
Certificate

If you selected a single server above, its name appears here. Proceed to the next step.

If you selected a domain or IP addressabove, click the dropdown arrow to view all servers
whose client security certificates reside on this server. Then, select the server with which you
want to set up an eSync relationship.

10. Click the Connect button.

11. After you connect to the production server, all eligible databases on it
appear. The top one has a green check mark, indicating it is selected
by default.

Setting up eSync in aMulti-Site Environment
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12. Click the database with which you want to sync. When you do, a green
check mark appears on it, and its background color changes.

13. Click Next.

14. A new screen appears, showing both servers and allowing you to
change the direction of the initial database copy. Make sure you are
copying from staging to production.

Because the staging server is multi-site, the screen’s staging server
area has a Site Path pulldown field (circled below), which lets you
select a site.

15. When you are satisfied, click Create. This sets up the server
configuration but does not launch the initial sync.

16. The View All Synchronization Configurations screen appears with the
new configuration.

If you are ready to overwrite the production database with the staging
one, click the Start Initial Sync button ( ).
17. A confirmation screen appears.

18. A screen monitors the sync’s progress.

19. The initial sync creates a default profile, which appears on the View
All Synchronization Configurations screen.

Synchronizing Servers Using eSync
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20. Set up and launch sync profiles to sync workarea files and templates
on the staging server with those on the production server. (This is
described in Setting up eSync Profiles on page 18-53 and Running a
Sync on page 18-66.) For synchronization direction, choose Upload.

Setting up Staging Multi-sites
By default, if you sign on to a staging server then insert library items (images,
quicklinks, etc.) into content, the path to those items includes the production
server.

For example, your server setup includes two multi-sites: sales.ektron.com and
support.ektron.com.

Note: The multi-site names are defined in the site’s folder properties screen’s Production
Domain field, as described in ”Step 3: Assign Multi-Site Capabilities in Ektron CMS400.NET
on page 20-14.

So, any library links in the sales.ektron.com site’s content look like this:
http://sales.ektron.com/template?id=id number.

However, you may wish to change library links so they refer to the staging
server. This would help you verify that the linked items exist on the staging
server.

To change library links so they refer to your staging server, follow these steps.

1. In the Ektron CMS400.NET Workarea, go to Settings > Configuration >
Setup.

2. Click the Edit button ( ).

3. Check the This is a Staging Server check box.

4. Save the screen.

5. Go to Content > the staging site folder.

6. Click View > Folder Properties.

7. Click the Edit button( ).

8. Scroll down to the section labeledMulti-Site Domain Configuration:

9. In the Staging Domain field, enter the URL of your staging server.

10. Save the screen.

From now on, when a user signs on to the staging server and works with library
links, the links include the staging server instead of the production server.

Using eSync with Web Alerts
The Web Alert feature enables Ektron CMS400.NET to generate email for a list
of registered users whenever new content appears on your site, or existing

Setting up StagingMulti-sites
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content is updated. For more information, see Administering the Web Alert
Feature on page 23-1.

In an eSync environment, you need to determine which servers send Web
Alerts. For example, Web Alerts should probably not be generated when content
is published on a staging server, but you would want them when content is
published on a production server.

To determine if a server generates Web alerts, use the following property of
each Web site’s web.config file.

<add key="ek_DisableWebAlerts" ..... />

Set the property’s value to true to suppress Web Alerts on a server.

Set the property’s value to false to generate Web Alerts to on a server.

Also, the server clock on the download side of the eSync relationship must be
exactly the same time as or slightly ahead of the clock on the sending server.

eSync and Integrated Search Folders
In a multi-site environment, Integrated Search folders on the source server are
not synched with the destination server. See Also: Using the Integrated Search
on page 9-47

Using eSync with eCommerce
When using eSync with an eCommerce site, you will want to prevent orders
from being processed on your staging server. This is to prevent orders from
being processed twice.

For example, a customer on your production site purchases a product. If the
staging server and production server are synced before the credit card is
processed, the potential exists for the customer’s credit card to be charged
twice; once from the production server and again from the staging server.

To prevent orders from being processed on your staging server, edit your
staging site’s web.config file. Next, set the following property to true.

<add key="ek_ecom_OrderProcessingDisabled" value="true" />

Once the property is set to true, you cannot process or edit orders from the
Workarea’s View Order screen on the staging server. Also, if you try to create
an order from the staging server’s Web site, you receive the following
message.

“We're sorry, an error occurred while processing your
request. Please try again later...”

It is important to note that all other eSync functions still work properly. For
example, when you create catalog entries on a staging server and perform a
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sync, the entries will be moved to the production server. This key only affects
the processing of orders.

Using eSync with Notifications
When using eSync with Notifications, any new agents are not synched. This
means that you must manually add new agents to each server in your
configuration.

Once the agent exists on all servers in your configuration, eSync keeps them
updated. For example, assume a membership user logs into the production
server and updates his profile’s Activities tab by changing the activities a
custom agent will perform. eSync will sync those changes with the staging
server.

See Also: Adding an Agent on page 16-142

Using eSyncwith Notifications
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eSync Troubleshooting
Symptom Cause Possible Solutions

Synchronization has failed

There wasno endpoint listening at

http://alphatest:8732/

Ektron.Sync.Communication/

SyncCommunicationScheduleService.svc

that could accept themessage.
This is often caused byan incorrect
addressor SOAPaction. See
InnerException, if present, for more
details.

One server in the configuration
cannot resolve the addressof the
other server. Thismaybe due to
security restrictionsor because
the EktronWindowsservice is
off.

n Modify the hostname of the
other server so that it can be found.

n Restart theWindowsservice

n Reconfigure security

The identity check failed for the outgoing
message. The expected identity is xxx for
the xxx target endpoint.

Local site can't communicate with
service

1. Load the security
configuration utility:

C:\Program
Files\
Ektron\CMS400V7x\utilities\
software\
securityconfigurator\
securityconfigurator.exe.

2. Select the web site that is
failing.

3. ClickOK.

This recopies client certificates to
the site and updatesweb.config to
use them.

No viable CMSsiteswere found on the
remote server specified. Please check the
remote server and try again.

No Ektron CMS400.NET site
exists on the remote server.

Install an Ektron CMS400.NET min
site on the remote server.
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Using this tool, Ektron’s customers can take full advantage of SharePoint’s
collaborative workspace to create documents. These documents can then be
delivered to a public facing Web site, corporate intranet or extranet enabled
with all the latest search, navigation, Web 2.0 and social networking
functionality provided by Ektron CMS400.NET

Ektron CMS400.NET supports the distribution of SharePoint content to any
Ektron CMS400.NET folder. For example, your Marketing Department uses
Microsoft SharePoint to create and edit content. After completing a press
release, they use the Publish to Ektron CMSmenu option to copy it from
SharePoint to a content folder. Once there, the document can pass through an
approval chain or be published immediately.

This section also contains the following topics.

Enabling Ektron's SharePoint Connector 19-2
Distributing SharePoint Content to CMS400.NET 19-2

Enabling Ektron's SharePoint Connector
To enable Ektron's SharePoint Connector in Microsoft SharePoint, simply copy
the SharePoint_To_CMS.exe file from C:\Program
Files\Ektron\CMS400v80\Utilities to your SharePoint server and follow the
on screen dialog.

If you successfully log in during Step 1of the Publish To CMS400 process, then
get a Please Loginmessage in Step 2, make sure your web browser is
configured to accept cookies from the Ektron CMS400.NET server. For example,
if your Sharepoint server is on sharepoint.company.com, and Ektron
CMS400.NET is on cms.company.com, your web browser must allow cookies
from cms.company.com.

If cookies are being blocked, a stop sign symbol appears at the bottom of
Internet Explorer (shown below).

Distributing SharePoint Content to
CMS400.NET
Once the SharePoint Connector is setup on a SharePoint server, navigate to a
content item and click the dropdown arrow next to the content's title. A menu
appears with the item Publish to Ektron CMS. Clicking this item starts a
simple wizard that publishes the document into your Ektron CMS400.NET site's
folder structure and taxonomy-based information architecture. This information
is collected through a series of screens that guide you through the process.

Distributing SharePoint Content to Ektron CMS400.NET
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After SharePoint content is distributed to Ektron CMS400.NET the first time, the
original content is forever linked to the destination content. You cannot break
the link. However, deleting the destination content in Ektron CMS400.NET
allows you to select a new folder when you republish the content from
SharePoint.

Note: If you delete the destination content, you will not be able to access history revisions of
the content in CMS400.NET.

If you want to later revise the document, you would typically edit it in
SharePoint and select the Publish to Ektron CMS option again. When you do,
you are asked to confirm replacing the document in the destination folder. You
are not allowed to select another folder.

Prerequisites
When you click the Publish to Ektron CMSmenu item, it will check to see if
you can log into Ektron CMS400.NET using Active Directory. If so you will be
logged in. If not, you will be prompted for your username and password. You
must have the following permissions:

n Add

n Delete

n Restore Content.

If you do not have these permissions, the folder doesn't appear on the folder
selection screen.

Prerequisites
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Ektron CMS400.NET’s multi-site support feature lets you set up and manage
several Web sites under one CMS. For example:

n www.example.com

n support.example.com

n forums.example.com

All sites share a single database. The multi-site support feature does not
support multiple databases.

This section also contains the following topics.

Advantages of Multi-Site Configurations 20-2
Prerequisites 20-2
Using Multi-Site Configurations 20-2
Installing the Multi-Site Support Feature 20-3

Advantages of Multi-Site Configurations
n The URL can indicate the nature of the site to visitors.

n All sites can share

- common content, but appear within their own site and templates

- the library of images and files. These files can be stored once, yet
authors can insert them into content from any site.

Prerequisites
n The server must run Windows Server 2003 or 2008

Note:Windows XP supports only one Web site.

n All sites must reside on the same server

n For each new site, you have a license key that supports Multi-site. To
purchase additional licenses, contact Ektron sales. See Also: License
Key Types on page 1-5

Using Multi-Site Configurations
Within the Workarea, sites appear under Ektron CMS400.NET’s folder structure
but the icon is a globe (see illustration below). So, an author can create and edit
content in the additional site the same way he works with content in the root
site.

SupportingMulti-Site Configurations
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Authors log into a root site then begin editing content in the additional site.
Regardless of which site he is using, an author can use the library to insert
hyperlinks, images, files, and quicklinks.

When a folder has a production domain assigned to it, it is a domain folder.
Links to content in a domain folder are activated via linkit.aspx, which redirects
to the appropriate domain name and uses the appropriate template for the
folder or content.

Warning! You cannot create a hyperlink within content, a collection, menu, etc. to a form that
resides in another site.

Installing the Multi-Site Support Feature
There are two ways to install multi-site support.

n Automatic Multi-Site Setup below

n Manual Multi-Site Setup on page 20-7

Ektron Best Practice
For ease of use and tominimize errors, Ektron recommends theAutomatic
Multi-Site Setupmethod.

Automatic Multi-Site Setup
There are four major steps in setting up a new site via the Site Setup wizard.

n Step 1: Create New Site in IIS on next page

n Step 2: Run the Multi-Site Setup Wizard on next page

n Step 3: Assign Multi-Site Capabilities in Ektron CMS400.NET on page
20-6

Important: Before creating a multi-site configuration, you must have installed an Ektron
CMS400.NETWeb site. All installed folders mustImportant: remain in that site. The original site
cannot have virtual folders.

Installing theMulti-Site Support Feature
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Step 1: Create New Site in IIS
Follow these steps to create each new site in IIS.

1. Go to Start > Programs > Administrative Tools > Internet
Services Manager.

2. Right click the Web Sites folder and click New > Web Site.

3. A wizard screen appears. Click Next.

4. Enter a name for the new site.

5. On the IP Address and Port Settings screen, enter the IP address of
your new Web site or the host header. Press Next.

6. On the Web Site Home Directory screen, browse to the new site’s
folder.

7. On the Web Site Access Permission screen, make sure that Read and
Write are checked.

8. You are notified that you have completed the new site.

9. Make the new site an application. To do this, right click the site, and
select Properties. Then, click the Home Directory tab. If you see
nothing in the Application name field (under Application
Settings), click the Create button then click OK.

Step 2: Run the Multi-Site Setup Wizard
1. Double click C:\Program

Files\Ektron\CMS400v80\Utilities\MultiSiteInstall\Multisite.exe
.
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2. When prompted to select a site, use the pulldown to select the site
you created in Step 1 .

3. You are prompted to enter a path to the new site. A good choice is
c:\Inetpub\wwwroot.

4. You are prompted to identify your main Web site. That is, the site to
which this multi-site is being added. See example below.

Step 2: Run theMulti-Site SetupWizard
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5. When you are prompted to add a multi-site key, click Yes.

This step copies the new sites' license keys to the database.

6. You are prompted to enter a license key for the new site.

7. You are prompted to enter information about the new site's database.

8. Follow the remaining screens in the wizard.

Step 3: Assign Multi-Site Capabilities in Ektron
CMS400.NET

1. Log in the Ektron CMS400.NET Workarea.

2. Click Content.

3. Click the site root folder.

Note: Site folders must reside within the site root folder.

4. Create a new top-level site folder for each site by clicking New >
Site.

5. Assign site folder properties as you did for the root folder.

6. The Multi-site Configuration fields appear on the lower section of the
screen (illustrated below).
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7. In the Production Domain field, insert your production domain.

8. In the Stage Domain field, insert your staging domain.

9. Click the Save button ( ).
Within Ektron CMS400.NET, the new domains are indicated by a globe
icon.

Manual Multi-Site Setup
There are three major, manual steps in setting up a new site.

n Step 1: Create New Folders in the File System on next page

n Step 2: Create New Sites in IIS on page 20-9

n Step 3: Assign Multi-Site Capabilities in Ektron CMS400.NET on page
20-14

Ektron CMS400.NET provides a utility (Multisite.exe) that automatically
completes Steps 1 and 2 for you. If you run this utility, you only need to
complete Step 3: Assign Multi-Site Capabilities in Ektron CMS400.NET on page
20-14 on page 19-40.

The utility is located C:\Program
Files\Ektron\CMS400v80\Utilities\MultiSiteInstall.

Manual Multi-Site Setup
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Step 1: Create New Folders in the File System
Important: Before creating a multi-site configuration, you must have installed an Ektron
CMS400.NETWeb site. All installed folders must remain in that site. The original site cannot have
virtual folders.

1. Using Windows Explorer, navigate to the C:\Inetpub\wwwroot
folder.

2. Create a new folder for each site.

3. Copy the following CMS files and folders from the original CMS site to
your new multi-site folder.

n all individual files (not subdirectories)

n all .config files in all directories under the site root

n these subdirectories:

- bin

- WorkArea

- widgets

- App_Code

- AssetManagement

- App_GlobalResources

4. Within each new site folder, open the web.config file and update the
ek_sitePath and WSPath elements with your CMS site path.

For example, if your CMS site is in the Web site root, enter slash (/). If it
is in a subdirectory of the Web site, enter the subdirectory name. For
example, If your web site root is C:\inetpub\wwwroot and you have a
subdirectory called CMS400Min, enter CMS400Min as the site path.

SupportingMulti-Site Configurations

20-8 ReferenceManual
Version 8.01 Rev 4



Step 2: Create New Sites in IIS
Follow these steps to create each new site in IIS.

1. Go to Start > Programs > Administrative Tools > Internet
Services Manager.

2. Right click the Web Sites folder and click New > Web Site.

3. A wizard screen appears. Click Next.

4. Enter a name for the new site.

5. On the IP Address and Port Settings screen, enter the IP address of
your new Web site or the host header. Press Next.

6. On the Web Site Home Directory screen, browse to the new site’s
folder. You created it in Step 1: Create New Folders in the File
System on previous page.

7. On the Web Site Access Permission screen, make sure that Read and
Write are checked.

8. You are notified that you have completed the new site.

9. Make the new site an application. To do this, right click the site, and
select Properties. Then, click the Home Directory tab. Under
Application Settings area, click the Create button then click OK.

10. Set Execute permissions to Scripts only.

Step 2: Create New Sites in IIS
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Create Virtual Folders in IIS
In IIS, for each new Web site, create one new virtual folder for the following
shared folders:

n assets

n privateassets

n uploadedfiles

n uploadedimages

These folders are created when you install Ektron CMS400.NET. If you did a
normal installation, they reside under the site directory. For example,
C:\Inetpub\wwwroot\your site root\uploadedimages.

To create virtual versions of these folders, follow these steps.

n Creating Virtual Folders in IIS6 below

n Creating Virtual Folders in IIS7 on the facing page

Creating Virtual Folders in IIS6
1. In IIS, select the new site folder you created in Step 2: Create New

Sites in IIS on previous page.

2. Right click the mouse and select New > Virtual Directory.

3. Identify the corresponding subfolder in the root folder.

SupportingMulti-Site Configurations
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4. Assign Read and Write permissions to the virtual directory.

5. Follow this procedure for all four folders: assets, privateassets,
uploadedfiles, uploadedimages.

Creating Virtual Folders in IIS7
1. In IIS, select the new site folder you created in Step 2: Create New

Sites in IIS on page 20-9.

2. Right click the mouse and select Add Virtual Directory.

Creating Virtual Folders in IIS7
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3. Identify the corresponding subfolder in the root folder.

4. Follow this procedure for all four folders: assets, privateassets,
uploadedfiles, uploadedimages.

Set File System Permissions on New Folders
To do this, follow these steps:

1. Using Windows Explorer, navigate to the new folder(s) you created in
Step 1: Create New Folders in the File System on page 20-8.

2. Right click the folder and click Properties.

3. Click the Security tab.

4. Click the Advanced button.

5. Click the check box next to Allow Inheritable Permissions from
the Parent to Propagate…
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Install the aspnet_isapi.dll File
Follow this procedure to install the aspnet_isapi.dll file for every new site.

1. Open IIS.

2. Navigate to an Ektron CMS400.NET Web site.

3. Right click the site and select Properties.

4. On the Properties screen’s Home Directory tab, click the
Configuration button.

5. The Application Configuration screen appears.

Install the aspnet_isapi.dll File
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6. In theWildcard application maps area, click Insert.

7. The Application Extension Mapping screen appears.

8. Browse to
C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_
isapi.dll.

9. Uncheck the Verify that file exists check box.

10. Click OK.

Step 3: Assign Multi-Site Capabilities in Ektron
CMS400.NET

1. In the Ektron CMS400.NET Workarea, click Content.

2. Click the site root folder.

Note: Site folders must reside within the site root folder.

3. Create a new top-level site folder for each site by clicking New >
Site.

4. Assign site folder properties as you did for the root folder.
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5. The Multi-site Configuration fields appear on the lower section of the
screen (illustrated below).

6. In the Production Domain field, insert your domain.

7. Save the screen.

Within Ektron CMS400.NET, the new domains are indicated by a globe
icon.

Step 3: AssignMulti-Site Capabilities in Ektron
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Web Services (WS) are reusable software components that can be consumed by
variety of clients, independent of operating system, programming language, or
Web server, using standard Internet technologies. Because Web Services allow
heterogeneous systems to communicate with each other in a standard way,
they have received quick acceptance for data interchange over the Web.

It’s easy for anyone to integrate your WS into their application. The client
application can be a Web application, a Windows application, a Java application,
a Visual Studio.net application, or a host of others -- it does not matter as long
as it supports Web Services.

A Web Service consists of one or more methods that expose functionality. In
this sense, a Web Service is an API that can be accessed using SOAP over HTTP.
(SOAP is an XML-based, lightweight protocol that defines the message format of
Web Services.)

For example, you might develop a purchasing application that automatically
obtains price information from several vendors, lets the user select a vendor,
submits the order and then tracks the shipment until it is received. The vendor
application, in addition to exposing its services on the Web, might in turn use
XML Web services to check a customer's credit, charge the customer's account
and set up the shipment with a shipping company.

This manual does not explain how Web Services work. To learn more about
them, try these sites.

n http://msdn2.microsoft.com/en-
us/library/aa480728.aspx#wsmsplat_topic2

n http://aspalliance.com/jnuckolls/articles/introws/default.aspx

n http://aspnet.4guysfromrolla.com/articles/062602-1.aspx

n http://www.15seconds.com/Issue/010430.htm

This section also contains the following topics.

Ektron CMS400.NET’s Implementation of Web Services 21-2
Benefits of Using Web Services 21-3
WS Components and Ektron CMS400.NET Architecture 21-3
Software and Hardware Requirements 21-3
Ektron CMS400.NET Methods 21-3
Ektron CMS400.NET Web Services Examples 21-7

Ektron CMS400.NET’s Implementation of
Web Services
Ektron CMS400.NET supports XML Web Services. This means that you can
create pages that offer your content to any Web-enabled device, and you can
create pages that consume existing Web Services. Ektron CMS400.NET’s Web
Services feature can return data separated from presentation. In combination
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with XML support, this feature lets consumers retrieve your XML data
independent of presentation information and act on it however they see fit.

Benefits of Using Web Services
Web Services make it easy to connect with partners. They can also deliver
more personal, integrated experiences to users via smart devices, including
PCs. WSs can save time and money by reducing development time, and
increase revenue by making your own XML Web services available to others.

WS Components and Ektron
CMS400.NET Architecture
Web Services require the installation of the .NET Framework on the server.

Ektron’s Web Service runs within the .NET Framework. Through Application API
classes in the Ektron.cms.API, .NET managed code can communicate with .NET
Framework code.

Software and Hardware Requirements
n .NET framework, version 2.0, must be installed on the server (for

more information, see http://msdn.microsoft.com/netframework/).

n Ektron CMS400.NET, version 6.0 or higher

Ektron CMS400.NET Methods
Ektron CMS400.NET implements Web Services that exposes methods for
accessing Ektron CMS400.NET functionality. These methods mirror their
Ektron.Cms.API equivalent that are avail lab le in the .NET Assemblies.

The methods determine the kind of content that is made available (for
example, a content block, a collection of content blocks, a summary list) along
with the presentation of that information (for example, an HTML string or an
XML data structure representing content block information).

Ektron’s API documentation contains a list of methods that are exposed with a
brief description of functionality. You can access Ektron’s API documentation
through the following resources.

n API Help inside Visual Studio

- In Visual Studio click Help > Contents

- When the help window appears, expand Ektron CMS400.NET API
Documentation in the frame on the left. If you do not see this entry,
use the filter and choose (unfiltered) or Ektron Documentation.

n HTML online help from www.ektron.com

Benefits of UsingWeb Services
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- http://www.ektron.com/web-content-management-
solutions.aspx?id=4020

- Under the Ektron CMS400.NET SDK header, click CMS400.NET API
Reference manual (HTML)

n PDF from the Desktop

- Click Start > Programs > Ektron > CMS400 > Documentation > API
Reference Manual

n PDF From the Workarea

- Click Settings > Help > Developer’s API Reference Manual

n PDF From www.ektron.com

- http://www.ektron.com/web-content-management-
solutions.aspx?id=4020

- Under the Ektron CMS400.NET SDK header, click CMS400.NET API
Reference manual (PDF)

These methods are made available through various .asmx files. Below is a list
of features, the associated .asmx files and the location on your server. Each of
these files, when viewed in a browser shows a list of the methods available for
that feature.

Feature File & Location Location

Activity
Activity.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

BusinessRules
BusinessRules.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Calendar
Calendar.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Calendar

Calendar
CalendarEvent.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Calendar

Calendar
CalendarEventType.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Calendar

Community - Social
Networking

CommunityGroup.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Community
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Feature File & Location Location

Community - Social
Networking

Favorites.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Community

Community - Social
Networking

Flag.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Community

Community - Social
Networking

Friends.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Community

Community - Social
Networking

MessageBoard.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Community

Community - Social
Networking

Tags.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Community

Content
Asset.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Content

Content
Blog.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Content

Content
Content.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Content

Content
ContentRating.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Content

Content
Form.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Content

Content
ThreadedDiscussion.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Content

Custom Fields
CustomFields.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Folders
Folder.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Fonts
Font.asmx
webroot\siteroot\Workarea\webservices\WebServiceAPI

Ektron CMS400.NETMethods
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Feature File & Location Location

Library
Library.asmx
webroot\siteroot\Workarea\webservices\WebServiceAPI

Metadata
Metadata.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Navigation - Menus
FlexMenu.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Navigation

Notification System
Notification.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Permissions
Permissions.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Search
SearchManager.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Search

Site
Site.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

SiteMap
SiteMap.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI

Tasks
Task.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Task

Tasks
TaskCategory.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Task

Tasks
TaskCategoryType.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Task

Taxonomy
Taxonomy.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\Taxonomy

Users
ActiveDirectoryUser.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\User

Users
User.asmx

webroot\siteroot\Workarea\webservices\WebServiceAPI\User
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Ektron CMS400.NET Web Services
Examples
Ektron CMS400.NET Web Services Example are available through in the
Developer sample site.You can download the sample site from
http://www.ektron.com/cms400-web-cms.aspx?id=5278.

Once you’ve downloaded the Developer sample site, you can view Web
Services examples by accessing the developer sample site at
http://localhost/CMS400Developer/developer/default.aspx and
selecting a feature from the side bar menu. If a feature has Web service
examples associated with it, a folder containing the letters WS will appear in
the list of items (illustrated below).

In addition to the examples, a link to the .asmx file appears. Clicking this link
shows a lists all of the methods available for a given Web service.

The code examples for these Web Services are located on your server in
[Drive:]
\[webroot]\CMS400Developer\Developer\dotNetAssemblies\WebServicesAPI
folder. This folder contains sub folders based on each feature for which there is
an example.
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Load Balancing has two purposes:

n Provides redundancy for your Web site - if one server fails, a second
can still handle requests

n Balances requests - distributes requests across multiple servers

To enable load balancing, set up several servers that include the same files.

Warning! The physical path to the Ektron CMS400.NETWeb site must be the same on all servers
being load balanced.

Then, purchase load balancing equipment to evenly distribute content requests
among the servers. Whenever an image or file gets uploaded to your Web site,
regardless of the Web server the user is working on, the asset is replicated on
both servers.

The client browser is unaware that more than one server is involved. All URLs
point to a single Web site. The load balance software resolves them.

Ektron provides different strategies for load balancing library images and files
and DMS assets.

This section also contains the following topics.

Load Balancing Library Images and Files 22-2
Load Balancing Assets 22-3
Refreshing Load Balanced Files 22-4
Load Balancing Status 22-5

See Also: eSync in a Load Balanced Environment on page 18-82

Load Balancing Library Images and Files
Library load balancing is important when your configuration consists of two or
more Web sites that share a single database. Library files are not saved in the
database but in the site root folders uploadedfiles and uploadedimages.

To support load balancing, the library files on all servers must be identical. To
maintain this state, whenever a user uploads an item to the library, it must be
replicated on all other servers. After following the setup instructions, any image
or file added to the library of one server will be copied to the corresponding
folder on the other servers in the configuration.

Setting up Library Load Balancing
1. Open the file C:\Program

Files\Ektron\EktronWindowsService30
\Ektron.ASM.EktronServices30.exe.config using a word
processor such as Notepad.

2. Set the value of the LibraryLoadBalanced property to 1.
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3. Set the value of the LoadBalServerCount property to the number of
servers in your load balance cluster.

4. Save the config file.

5. Restart the Ektron Windows Service.

See Also: Ektron Windows Service on page 22-7

Load Balancing Assets
Asset load balancing is important when your configuration consists of two or
more Web sites that share a single database. Ektron CMS400.NET can balance
requests to view or work with assets among multiple servers by ensuring that
each server has its own copy of every asset.

After setting up asset load balancing, any asset added to one server will be
automatically copied to the corresponding folder on the other servers in the
configuration.

There is no limit to the number of servers that can be load balanced.

This section also contains the following topics.

Load Balance Settings Summary 22-4
Setting up Asset Load Balancing 22-4
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Load Balance Settings Summary

File Settings (on all servers)

<webroot>\AssetManagement.config
LoadBalanced=1

(0 to disable)

c:\Program
Files\Ektron\Ektron.ASM.EktronServices30\

Ektron.ASM.EktronServices30.exe.config

LibraryLoadBalanced=1

LoadBalServerCount=x

Where x is the number of servers in load balanced
configuration

Setting up Asset Load Balancing
To set up load balancing for assets, follow these steps on all servers that are
load balanced together.

1. Within the site root folder, open the AssetManagement.config file
using a word processor such as Notepad.

2. Change the value of the LoadBalanced element to 1.

3. Save the config file.

4. Open the following file using a word processor such as Notepad:
C:\Program Files\Ektron\EktronWindowsservice30\Ektron.ASM.EktronServices30.exe.config

5. Set the value of the LibraryLoadBalanced property to 1.

6. Set the value of the LoadBalServerCount property to the number of
servers in your load balance cluster.

7. Save the config file.

8. After updating these files for each server in the load balance cluster,
sign on to Ektron CMS400.NET. This action sets up the load balance
software in the database.

Refreshing Load Balanced Files
Note: You must be a member of the Administrator user group to use this feature.

Asset and Library files may become out of date or lost due to equipment
failures, power outages or other events. In addition to your Load Balance
system, Ektron CMS400.NET provides a way to refresh the files contained in the
DMS Assets folders and Library Files and Images folders.

Note: Open Port 8732 on Load Balanced Servers for Load Balancing Refresh to work
properly.
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Important: Previously, Ektron CMS400.NET used Port 6079 for communication between load
balancing servers. Starting with version 8.01, this port is no longer used and can be closed in
your firewall.

Steps To Refresh Load Balanced Files
To refresh the load balanced files, follow these steps.

1. In the Workarea, go to Settings > Configuration > Load
Balancing.

2. The page looks like this.

Note: If the status button says Disabled, check that you have configured the
AssetManagement.config file correctly and you are a member of the Administrator user group.

3. Click Start.

4. A status screen appears as shown below.

5. Check that the status screen above shows the servers you expect to
be refreshed. Server name WS10155 is circled above.

Warning! If after you click Start the screen quickly returns and files do not refresh, or if a server is
missing from the status list, check your Load Balancing settings in
Ektron.ASM.EKtronServices30.exe.config.

6. Click Close when finished viewing the status.

Load Balancing Status
To check the Load Balancing Status, click the button circled below.
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The Status screen will show the Load Balancing screen showing either the
previous refresh or the current refresh in progress.
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Ektron Windows Service
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Ektron CMS400.NET provides a Windows Service to handle background
processing functions. This section explains the service, including

n the CMS functions it performs

n how it propagates updates to the connection string and site path

n where it resides in IIS and the file system

n its activity log

This section also contains the following topics.

Functions Performed by the Ektron Windows Service 22-8
Changing the Update Time 22-9
Disabling PDF Generation 22-9
Viewing the Ektron Windows Service 22-9

Functions Performed by the Ektron
Windows Service
The Ektron Windows Service performs the following processes.

n XML Indexing on page 7-380

n Load Balancing Assets on page 22-3

n PDF Generation on page 7-445

n Bad Links Report on page 7-720

n Publication of content scheduled to go live at a future time, and
removal of content scheduled to expire. See Scheduling Content to
Begin and End on page 7-187.

n When a new metadata definition is created, the Windows service
applies it to all content in the CMS database. However, the metadata
definition is only activated for the content when it is enabled for the
content’s folder. See Also:Working with Metadata on page 7-141

In addition, the Ektron Windows Service propagates updates made to the
database connection string or the site path in the web.config file. The service
copies the new value to the data.config and sitedb.config files (respectively).
These are located in C:\Program Files\Ektron\EktronWindowsservice30.
Any CMS components that reference these values can retrieve the current
information from these files.

Warning! Do not edit the data.config and sitedb.config files. They are dynamically generated by
Ektron CMS400.NET. If these files have incorrect values, edit the web.config file, which is used to
generate them.
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Changing the Update Time
The update of the data.config and sitedb.config files occurs once a day at a time
prescribed in the C:\Program
Files\Ektron\EktronWindowsservice30\Ektron.ASM.EktronServices.exe.config
file’s updateTime value. If desired, you can change this time.

Disabling PDF Generation
By default, PDF generation is enabled. If you want to disable it within the
Ektron Windows Services configuration file, follow these steps.

1. On the server to which you installed Ektron CMS400.NET, open
C:\Program Files\Ektron\EktronWindowsservice30.

2. Open Ektron.ASM.EktronServices30.exe.config.

3. Find this line:
<add name="PdfFileRead"
type="Ektron.ASM.EktronServices.PdfFileManagerRead.PdfFileManagerReadService,
Ektron.ASM.EktronServices20" IntervalSeconds="101" Enabled="true" />

4. Set enabled to false.

Viewing the Ektron Windows Service
This section also contains the following topics.

Viewing in IIS 22-9
The Activity Log 22-10
Viewing in the File System 22-11

Viewing in IIS
The Windows Service starts automatically when Ektron CMS400.NET is
installed, and again whenever the server is restarted.

1. To see the status of the service, go to Computer Management >
Services and Applications > Services.

2. Look for Ektron Windows Services. You can see its status in the
Status column.
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The Activity Log
The service has an Activity Log, which tracks all related events. To see it, go to
Computer Management > System Tools > Event Viewer > Ektron Log.

To view detail for any event, double click it.

A common source of errors is that the service cannot find Ektron CMS400.NET
sites, because they have not been created yet, as shown in the sample below.
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Viewing in the File System
On your file system, the Ektron Windows Service is located in C:\Program
Files\Ektron\EktronWindowsservice30. Within that folder, the
Ektron.ASM.EktronServices.exe.config file runs the Ektron Windows service.

Viewing in the File System

ReferenceManual
Version 8.01 Rev 4

22-11



(This page intentionally blank.)



Chapter 23

Administering the Web Alert
Feature

ReferenceManual
Version 8.01 Rev 4 23-1



The Web Alert feature enables Ektron CMS400.NET to generate email for a list
of registered users whenever new content appears on your site, or existing
content is updated.

For example, anyone may register to be notified when new information about
your product is published. As soon as a page is published on your site,
registered users receive an email announcement with a link to the new/updated
page. The recipient clicks the link to immediately access the page.

As a result, a self-selected group of users can be instantly notified of changes
on your Web site relating to their interests. Once the system is set up, you don’t
need to do anything -- everything happens in the background.

Note: Only members of the Administrator User Group and users identified on the Manage
Members for Role: Folder User Admin screen can work with Web Alerts.

This section also contains the following topics.

How Web Alert Works 23-3
Server Configuration 23-4
Enabling the Web Alert Feature 23-5
Setting Up the Message Queue and Asynchronous Processor 23-7
Creating the email Message 23-14
Defining Subscriptions 23-18
Assigning Web Alert Information to Folders and Content 23-20
How Users Sign up for Subscriptions 23-27
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Sample Web Alert email

See Also: Using eSync with Web Alerts on page 18-93

How Web Alert Works
The following explains how Web Alert email works.

1. Content is published.

2. Ektron CMS400.NET checks the This is a staging server checkbox
on the Settings > Configuration > Setup screen. If it is unchecked,
proceed to the next step. If the box is checked, no Web alerts will be
issued for this server.

3. Ektron CMS400.NET checks to see if any subscriptions are assigned to
the folder or content. (Subscriptions can be assigned at the folder or
content level.)

If no subscriptions are assigned, theWeb Alerts tab does not appear
when editing content.

4. If any subscription is assigned, Ektron CMS400.NET checks to see if
an email should be created for this content. The settings appear
underWeb Alerts tab.

For example, some content only triggers an email when it is first
published, while other items always generate an email.

SampleWeb Alert email
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5. If an email should be generated, Ektron CMS400.NET builds the email
content by retrieving information from fields on the Folder Properties
screen. These are identified under theWeb Alert Contents section
of the Web Alerts tab.

6. Ektron CMS400.NET determines which subscription lists should
receive the email. These are identified on the Available Web Alerts
area of the Web Alerts tab. Each list contains the email address of
every subscribed user.

Server Configuration
The following illustration depicts a typical Web server configuration you would
use with the Web Alerts feature.

n Firewall - the Ektron CMS400.NET business tier must have Web
access to the asynchronous server. The business tier maintains the
CMS files. This configuration enables proper communication between
Ektron CMS400.NET and the asynchronous processor.

- The asynchronous processor must have port 25 (SMTP) access to a
valid mail server to send emails

- The mail server (omitted from the illustration) must be allowed to send
out port 25 (SMTP) traffic and can be on the Async server
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n Queuing - Message queuing must be installed on the Async server.

You must create a message queue on the Async machine and record
its name. The message queue is specified in the exe.config file for
the service, and in the web.config file for the Web Service interface.

n CMS - The web.config file includes a key for the location of the
asynchronous processor. This needs to be verified as working.

n Other - IIS must be installed on the asynchronous processor. IIS
allows a Web service call to schedule a file download and send
commands.

Ektron recommends that the Async machine only allow HTTP traffic
from Ektron CMS400.NET servers. This provides additional security
on the Async processor.

Verifying Connections
n You can verify the Web service > queue connection by

- leaving the Ektron asynchronous processor service off, submitting
content with notifications, and verifying that a message arrived in the
queue

- turning on journaling for the queue. Submit a message in the queue.
The Ektron asynchronous processor service picks it up and places it in
the journaled messages.

- turning on logging for the Ektron asynchronous processor service

n To verify the CMS > Web service connection, open the asynchronous
processor location inside a Web browser and test the Web services.

To verify the writing of files, ensure that Ektron CMS400.NET has
write access to the [sitepath]subscriptions directory and submit
content that will trigger notifications. This action places a file inside
that directory.

n To verify that the Ektron asynchronous processor service can
download a file, open a Web browser on the Async machine and
connect to the location of the notification command files. Attempt to
download one.

Enabling the Web Alert Feature
Enabling the Web Alert feature involves the following steps.

Verifying Connections
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Step Description
For more
information, see

1. Set up
message
queue and
asynchronous
processor.

Setting Up theMessage
Queue and
Asynchronous
Processor on the facing
page

2. Create
messages.

Define components of the email to be sent to
subscribers.

Creating the email
Message on page 23-14

3. Define
subscriptions.

Categories of information on your site. Site visitors can
subscribe to be notified when content in a category is
added or updated.

Defining Subscriptions
on page 23-18

4. AssignWeb
Alert
information to
folders and
content.

AssignWeb Alert information to folders and content
itemswhich, when published, trigger emails.

For each folder or content item to which you assign
subscriptions, determine

n activities that trigger emails (for example, only upon
initial publication of content)

n the content of the email

n the subscription list(s) to whom the email is sent

AssigningWeb Alert
Information to Folders
and Content on page
23-20

5. Create and
publish site
visitor
registration
page.

Create a newWeb form and drop themembership
server control onto it. Then, publish that form on your
Web site.

Note:  This task is typically done bya developer.

Membership Server
Controlon page 16-19

6. Site visitors
subscribe to
lists of
interest.

Someone signsup to be notified when changes in a
selected subscription (category) are published on your
Web site.

How UsersSign up for
Subscriptionson page
23-27

7. CMSusers
can also
subscribe.

CMSUser Subscription
Sign Up on page 23-31

8. Subscribers
are
automatically
notified when
content is
updated.

Web content is either first published or updated. If at
least one subscription is assigned to the content or its
folder, email is sent according to pre-defined criteria for
the folder.
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Setting Up the Message Queue and
Asynchronous Processor
After installing Ektron CMS400.NET version 5.1 or higher, you need to set up
the Microsoft Message Queuing and the Ektron Asynchronous Processor. It is
assumed that the following directories and files are installed on your server:

n C:\Program Files\Ektron\CMS400versionnumber\EktronAsyncProcessor_Service\

n C:\inetpub\wwwroot\your site root\bin\EktronAsyncProcessorWS.dll

n C:\inetpub\wwwroot\your site
root\Workarea\webservices\EktronAsyncProcessorWS.asmx

Note: If you need to move Web services file, use the Asynchronous Processor Location field
in the Configuration > Setup screen to specify the new folder location.

1. On the server that hosts Ektron CMS400.NET, go to Control Panel >
Add/Remove programs > Add/Remove Windows
Components.

2. If it is not checked, check Message Queuing Services.

Note: On Windows 2003, it is within the Application Server Components group.

3. If Message Queuing Services was checked when you viewed it, go
to step 4.

If it was not checked, click Next. A wizard creates the component.

Setting Up theMessageQueue and Asynchronous
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Note: The rest of this procedure employs a wizard that saves you several manual steps. If you
have a problem using the wizard, or prefer to install Web Alerts manually so you can track the
files being installed to your server, see Manual Setup of Message Queue and Asynchronous
Processor on page 23-11.

4. From the Windows Start Menu, click All Programs > Ektron >
CMS400 > Utilities > Web Alerts Setup.

5. The Web Alert Wizard setup screen appears.

6. Press Next. The wizard begins installing the Web Alerts feature.
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7. The following screen appears.

8. Enter the username and password that will be used to send and
receive email.

9. At the Log File Name field, enter the name of the file that will track
Web Alert activities. If you enter nothing, the file is named
listener.log.

The file resides in the C:\Program
Files\Ektron\CMS400versionnumber\EktronAsyncProcessor_
Service folder. It is also available from the Workarea. See
Asynchronous Log File Reporting on page 23-13.

10. If you want a very detailed log file, click Logfile Verbose.

11. Press Next. The following screen appears.

Setting Up theMessageQueue and Asynchronous
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12. Either insert or browse to the folder that contains your web.config
file. This is your site root folder. Then press Next.

13. If your Asynchronous Processor service is not running, the following
message appears.

14. If you see this message, press OK then click Finish.

15. Go to Control Panel > Administrative Tools > Computer
Management > Services and Applications > Services. Start
the Ektron Async Processor Service.

This section also contains the following topics.

Manual Setup of Message Queue and Asynchronous Processor 23-11
Asynchronous Log File Reporting 23-13
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Manual Setup of Message Queue and
Asynchronous Processor
This section describes manual steps for setting up the Message Queue and
Asynchronous Processor. You can use this procedure if you had a problem using
the wizard, or you want to know which files are being installed to your server.

1. Go to Control Panel > Administrative Tools > Computer
Management > Services and Applications > Message
Queuing.

2. Right click the Private Queues folder and select New > Private
Queue.

3. Create a private queue named msmq_web.

4. Right click msmq_web and select Properties.

Manual Setup of MessageQueue and
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5. Go to the Security tab. You can give the Everyone group Full Control
if you are in a testing environment. If you are on a production server
or want better security, give the local system account (the account
which the EktronAsyncProcessor Service runs as) the following
permissions:

n Delete

n Receive Message

n Peek Message

n Send Message

Give the ASP.NET account (the account that the Web services interface
runs as) Send Message permission.

6. Click OK.

7. Open the following file:
C:\Program Files\Ektron\CMS400v52\EktronAsyncProcessor_
Service\RegEktron.Services.EktronAsyncProcessor.bat

8. Review and update as necessary the paths to the .NET directory and
Ektron.Services.EktronAsyncProcessor.exe file.

Warning! Update the paths to the .NET Directory and the .exe file if necessary.

9. Execute the .bat file.

Or, from a command line or Start Menu > Run, enter:
C:\Windows\Microsoft.NET\Framework\v2.0.50727\installutil
“C:\program Files\Ektron\CMS400v80\EktronAsyncProcessor_
Service\Ektron.Services.EktronAsyncProcessor.exe”

10. Open the following file and enter your SMTP connection settings:
C:\Program Files\Ektron\CMS400v80\EktronAsyncProcessor_
Service\Ektron.Services.EktronAsyncProcessor.exe.config.

11. Go to Control Panel > Administrative Tools > Computer
Management > Services and Applications > Services. Start
the Ektron Async Processor Service.
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Asynchronous Log File Reporting
Once the Message Queuing and Asynchronous Process are set up and running,
you can access a log report about the Asynchronous process. This report shows
any problems with the Asynchronous Processor.

In addition to viewing the report, you can email it to any Ektron CMS400.NET
user. See Emailing Reports on page 7-704.

To access the Asynchronous Process log, follow these steps.

1. From the Workarea’s Smart Desktop, click Reports.

2. Click Contents > Asynchronous Log File Report.

3. Any problems appear on the screen.

Asynchronous Log File Reporting
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Creating the email Message
This section also contains the following topics.

Predefining Message Components 23-14
Creating Default Message Text 23-14
Including Variables in the Default Message 23-14
Creating Opt Out Message Text 23-15
Creating Unsubscribe Message Text 23-16
Creating “From” Addresses 23-16
Combining Message Components to Create the Message 23-16
Previewing the email Message 23-17

Predefining Message Components
Before you can create an email message, define the following information.

n default message text

n opt out message

n unsubscribe message

n “from” address

You can define as many as you want of each item. You must, however, define at
least one opt-out message, unsubscribe message, and “from” address to use
the Web Alert feature.

These message components are later inserted into an email message that is
sent to your subscribers. See Also: Creating the email Message above

Creating Default Message Text
You can create one or more default messages to contain the text of the email. A
simple editor lets you apply some XHTML formatting the message.

Including Variables in the Default Message
The default message can include variables that retrieve information about the
content and display it in the message text. The variables are surrounded by at
signs (@). For example

The following content was recently updated: @AppContentLink@

In the email, this text might read:

The following content was recently updated: The Effect of Coumadin on Cardiac Patients

You can use the following variables in the body of a Web Alert message.
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Variable Displays this information in the email

@appContentTitle@ The title of the content block.

@appCRLF@ Acarriage return. Moves the text down one line.

@appContentLink@
The link to the content blockon theWeb site.

Note: Youmust be logged in to see the changes.

@appContentURL@ TheURL of the content, from the quicklink and domain.

@appSubscriptionNames@ Comma separated list of subscriptions that a user selected.

@appComment@ The comments for the content block.

@appSubmitterFirstName@ The first name of the user who submitted the content block.

@appSubmitterLastName@ The last name of the user who submitted the content block.

To create default message text, follow these steps.

1. In the Workarea, go to Settings > Configuration > Web Alerts >
Messages.

2. Click the Add button ( ).
3. Enter a title that describes the message.

4. At the Type field, select DefaultMessage.

5. In the editor, enter the message text.

6. Click the Save button ( ).

Creating Opt Out Message Text
An Opt-Out message appears as the first line of every email. It directs the
reader to the Unsubscribe message at the bottom. Here is an example:

You have subscribed to receive alerts from the Ektron CMS400.NET email alert system. See
below for removal instructions.

You can add variables to the Opt Out text. See Also: Including Variables in the
Default Message on previous page

To create Opt Out message text, follow these steps.

1. Go to Settings > Configuration > Web Alerts > Messages.

2. Click the Add button ( ).
3. Enter a title that describes the Opt-Out message.

4. At the Type field, select OptOut.

5. In the editor, enter the message text.

6. Click the Save button ( ).

Creating Opt Out Message Text
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Creating Unsubscribe Message Text
An Unsubscribe message lets the person receiving the email remove himself
from the subscription list.

You can add variables to the Unsubscribe text. See Also: Including Variables in
the Default Message on page 23-14

To create Unsubscribe message text, follow these steps.

1. Go to Settings > Configuration > Web Alerts > Messages.

2. Click the Add button ( ).
3. Enter a title that describes the Unsubscribe message.

4. At the Type field, select Unsubscribe.

5. In the editor, enter the message text.

6. Click the Save button ( ).

Creating “From” Addresses
Any email generated by the Web Alert feature must have a “from” address. To
create one or more “from” addresses, follow these steps.

1. Go to Settings > Configuration > Web Alerts > Email From
List.

2. Click the Add button ( ).
3. Enter an email address that will be used in the From field of

messages generated by the Web Alert feature.

4. Click the Save button ( ).

Combining Message Components to Create
the Message
You create the content of an email message by configuring the following
components. Some are required. Then, when content is published, Ektron
CMS400.NET retrieves the field values to create the email Web Alert.

Note: If you reached this screen while creating an eCommerce message, see eCommerce
Messages on page 17-81.

Note: To set or modify this information, you must have permission to edit the folder.

Component Comment Required?

1. Subject line Plain text you enter on theWeb Alerts tab of the Folder Properties screen No
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Component Comment Required?

2. From
address SeeCreating “From” Addresseson previouspage Yes

3. Opt out
message SeeCreating Opt Out Message Text on page 23-15 Yes

4. Default
message SeeCreating Default Message Text on page 23-14 No

5. Content
Summary

The Summaryof the content itemwhose creation or change generates
the email.

Note: The Summary can include variables that retrieve information
about the content item. See Including Variables in the Default Message
on page 23-14

No

6. AnyCMS
content item

IdentifyCMScontent to include within the email content.

n To identify an existing content item, clickSelect next to theUse
Content checkbox. Then, navigate to the content item.

Note: If the content item is anOffice document or amanaged file, a link
to that item appearswithin the emailmessage, not the item itself.

n To insert this content item (that is, the one whose creation or change
triggers thisWeb Alert), clickUse Current.

n To create a new content block to insert into thismessage, clickSelect
next to theUse Content checkbox.When the folder navigation window

appears, click the Add Content button ( ). Then, seeAdding HTML
Content on page 7-15.

No

7. Unsubscribe
message SeeCreating UnsubscribeMessage Text on previouspage Yes

The elements appear within the email in the sequence shown above.

Previewing the email Message
You can preview the email message at any time by clicking the preview button,
which appears to the right of theWeb Alert Contents: label on the Web Alerts
tab (see below).

Previewing the email Message
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The button appears on the Web Alerts tab for folders as well as content.

When you click the preview button, a new window displays the body of the
email message. (The components used in an email message are listed in
Combining Message Components to Create the Message on page 23-16.)

After previewing the message, you can change any message components and
click the button again to review the updated message. You don’t need to save or
check in the content to update the preview.

Defining Subscriptions
Create a subscription for each type of information site visitors might want to be
notified about. For example, if your site sells electronics, you could set up one
subscription for televisions, another for computers, and a third for stereo
equipment. Site visitors can then subscribe to appropriate areas of interest.

CMS and membership users can also sign up for subscriptions.

See Also: Server Configuration on page 23-4

To create one or more subscriptions, follow these steps.

1. Go to Settings > Configuration > Web Alerts > Subscriptions.

2. Click the Add Subscription button ( ).
3. Enter a name for the subscription. The name should indicate the kind

of information that it will cover.
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4. Use the Enabled check box to indicate if the subscription is currently
active.

5. Press the Save button ( ).
This section also contains the following topics.

Effect on Custom User Properties 23-19
Using Subscriptions in a Multi-Language System 23-20

Effect on Custom User Properties
When you create the first subscription, a new entry is automatically created in
the Custom User Properties screen. By default, its name is Subscriptions, and
its type is Category. This occurs because all custom user properties appear on
the Site Visitor Registration screen. In this way, users visiting that page can
select areas of interest about which to be notified when content is updated.

The default name (Subscriptions) appears on the Site Visitor Registration
screen. You may want to change it to something more helpful, such as Select
Areas of Interest. To do this, select the Subscriptions entry and edit the
Label field in the Custom User Properties screen.

The following graphic illustrates the relationship among the Subscriptions,
Custom Properties, and Site Visitor Registration screens.
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If you add more subscriptions later, they have no effect on the Subscriptions
entry in the Custom User Properties screen -- that single entry covers all
subscriptions.

Using Subscriptions in a Multi-Language
System
When you create a subscription, a version of it is created for every enabled
language in your system. You can edit the subscription name and Enabled
values for any language but the ID number cannot be changed.

To translate any subscription, follow these steps.

1. Go to Settings > Configuration > Subscriptions.

2. From the View Languages dropdown list, select the language into
which you want to translate the subscription.

3. Click the subscription that you want to translate.

4. Click the Edit button ( ).
5. Enter the translation for the subscription name. If desired, you can

check or uncheck the Enabled checkbox. Only enabled subscriptions
appear on the Site Visitor Registration screen.

6. Click the Save button ( ).

Assigning Web Alert Information to
Folders and Content
After creating predefined messages (as explained in Predefining Message
Components on page 23-14) and subscriptions (as explained in Assigning Web
Alert Information to Folders and Content above), you need to identify which
folders include content that, when updated, trigger a Web Alert. For example,
new product announcements are placed in the Marketing folder.

Note: In order to set or modify Web Alert information, you must have permission to edit the
folder.

For each folder, you can assign the following kinds of message information.
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n whether Web Alert information is inherited from a parent folder or
customized

n whether a folder’s Web Alert information is inherited by all content
items in the folder

n when email is sent: always, only on initial publication, or never

n the content of the Web Alert email

n the subscriptions assigned to the folder. These determine which
recipients receive email when content in this folder is created or
updated.

This section also contains the following topics.

Customizing Web Alert Information for a Folder 23-21
Web Alert Fields 23-23
Assigning Web Alert Information to Content 23-23

Inheriting Content-Level Web Alert Information from Its Folder
23-
26

How Content that is Dragged and Dropped is Handled 23-27

Customizing Web Alert Information for a
Folder
Like other folder-level information in Ektron CMS400.NET, Web Alert
information is inherited from a parent folder. By default, all folders inherit
these settings from the root (Content) folder.

However, inheritance can be broken and customized at any folder level or even
the content level. Breaking inheritance means that custom settings can be
made at any folder level. Subsequent changes to Web Alert settings at the
parent level are ignored.

See Also: Assigning Web Alert Information to Content on page 23-23

To view, enter, or modify folder-level Web Alert information, follow these
steps.

1. Navigate to the folder whose Web Alert information you want to edit.

2. Click View > Properties.

3. Click theWeb Alerts tab.

4. Scroll down to view the Web Alert options.
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5. To change any value, click the Edit Properties button ( ).
6. The following table describes the fields.
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Web Alert Fields

Field

Group
Description

WebAlert
Settings:

Break
Inheritance

To inherit Web Alert settings (described below) from this folder’s parent folder, leave this box
(Break Inheritance) empty.

To assign customWeb Alert settings for this folder, check this boxand use the fields below to
customize the settings.

Web Alert
Options

CheckwhenWebAlert emails are sent as content in this folder is published.

n Notify Always - send emailwhenever any content is published. It doesn’t matter if the
content is being published for the first time or being updated.

n Notify only on Initial Publication - send email the first time content is published. After
that, email is not sent.

n Notify Never - email is never sent for content in this folder.

Web Alert
Subject Enter the subject line of the email.

Web Alert
email From
Address

Select the addressof the person fromwhom the emailwill be sent. See Also:Creating “From”
Addresseson page 23-16

Web Alert
Contents

Checkanyor all of the following components to determine the text of the email. See Also:
CombiningMessage Components to Create theMessage on page 23-16

n OptOut Message - seeCreating Opt Out Message Text on page 23-15

n UseDefault message - seeCreating Default Message Text on page 23-14

n Use Summary - include the content summary in the email

n UseContent - seeAnyCMScontent item on page 23-17

n Unsubscribemessage - SeeCreating UnsubscribeMessage Text on page 23-16

The components appearswithin the email in the order listed above.

Available
Web Alerts

All enabled subscriptions set up in the Subscriptions screen appear. Check those to be
notified when content in this folder is added or updated.

See Also:AssigningWeb Alert Information to Folders and Content on page 23-20

Note: If you uncheckall subscriptions, you disable theWeb Alert feature for this folder
and all of its content. This applies even if unique subscription information hasbeen
assigned to content itemswithin the folder.

Assigning Web Alert Information to Content
You can customize Web Alert settings for any content item. If you do, you break
the inheritance from its folder. This means that any subsequent changes to the
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folder settings do not affect the content’s Web Alert settings. From then on, its
settings are independent of the folder’s settings.

See Also: Server Configuration on page 23-4

Warning! If all subscriptions are unchecked for a folder, the Web Alert feature is disabled for all
content in the folder. This applies even if unique Web Alert information has been assigned to
content.

To customize the Web Alert settings for any content item, follow these steps.

1. Navigate to the folder that contains the content.

2. Click the content. The View Content screen appears.

3. Click the Edit button ( ).
4. Click theWeb Alerts tab.

Note: The Web Alerts tab only appears if required messages, “from” email addresses, and at
least one subscription are assigned to the content’s folder.

5. The Web Alert settings for the content appear.
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The following table describes the settings.

AssigningWeb Alert Information to Content
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Field

Group
Description

Web
Alert
Options

CheckwhenWebAlert emails are sent as this content is published.

n Notify Always - send emailwhenever content is published. It doesn’t matter if the content is
being published for the first time or being updated.

n Suspend Next Notification (override) - Check this box if you want to suspend the next
email to be sent for this content. Youmight use this feature is you notice a small error in the
content and don’t want to notify all subscribers that the page wasupdated.

Warning! - This setting only applies until the next time this content is published.When
that happens, this box is automatically unchecked.

n Notify only on Initial Publication - send email the first time content is published. After
that, email is not sent.

n Send Next Notification (override) - Send an email to all subscribers the next time this
content is published. Use this checkbox to send a one-timemailing to all subscribers about
content that hasalreadybeen published.

Warning! - This setting only applies until the next time this content is published.When
that happens, this box is automatically unchecked.

n Notify Never - email is never sent when content in this folder is published.

Web
Alert
Subject

Same as for a content folder. SeeWebAlert Subject on page 23-23

Web
Alert
email
From
Address

Same as for a content folder. SeeWebAlert email FromAddresson page 23-23

Web
Alert
Contents

Same as for a content folder. SeeWebAlert Contentson page 23-23

Available
Web
Alerts

OnlyWeb Alerts assigned to the folder appear. Checkones that you want to assign to this
content item. For more information, seeAvailableWeb Alertson page 23-23.

Inheriting Content-Level Web Alert Information
from Its Folder
If you customized Web Alert information for content items and later decide to
standardize that information for all content in a folder, use the Restore Web
Alert Inheritance toolbar button ( ).
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This button copies folder-level Web Alert information to every content item in
the folder, replacing whatever content-level information exists. In this way, all
content in a folder will have the same Web Alert information.

See Also: Server Configuration on page 23-4

How Content that is Dragged and Dropped is
Handled
Web Alert emails are not generated for files that are dragged and dropped into
Ektron CMS400.NET and immediately published. To generate email for these
files, you must manually publish them.

Like HTML content, these files must reside in a folder for which the Web Alert
feature is enabled.

How Users Sign up for Subscriptions
Once subscriptions are set up, you create a page on your Web site to let site
visitors subscribe to areas of interest. An example of that page is below.

Note: The email address collected on the screen is used for the membership Username field.

To place this form on a Web page, your developer inserts a Membership Server
Control. See Also: Membership Server Control on page 16-19

Any user who subscribes via the above screen becomes an Ektron CMS400.NET
membership user, and is automatically added to the All Members user group.
For more information, see Membership Users and Groups on page 16-3.

What happens next depends on the Enable Verify email check box in the
Application Setup screen (shown below).

How Content that is Dragged and Dropped is
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This section also contains the following topics.

What Happens if Verification email is Not Used 23-28
What Happens if Verification email is Used 23-28
The Verification Message 23-29
The View Not Verified Users Screen 23-30
Setting up Other Web Pages for Site Visitor 23-30
CMS User Subscription Sign Up 23-31

This topic is explained through the following subtopics.

What Happens if Verification email is Not
Used
If the Enable Verify email checkbox is not checked, everyone who signs up
automatically becomes a membership user.

What Happens if Verification email is Used
Warning!When using the Checkout Server Control on an eCommerce site, the Enable Verify
Email setting must be unchecked. Otherwise, new users will receive an error message when they
sign-up using this control. See Also: Checkout Server Control on page 17-20

Typically, when managing a self-subscribe list, you want new users to confirm
their interest in being on the list. This prevents people from being subscribed by
someone else without their permission.

If the Enable Verify email checkbox is checked, everyone who signs up is
placed on the Users Not Verified list. (To see this list, go toWorkarea >
Settings > Community Management > Memberships > Users Not
Verified.)

These people then receive an email. You define the content of this email in
Workarea > Settings > Community Management > Messages. The
email should direct the unverified user to a new Web page that asks him to
confirm his interest in signing up for the subscription. (See The Verification
Message on the facing page.) New users are activated when the subscriber
confirms his interest.

To create such a page, your Web developer creates or updates a Web Form
using the Membership Server Control. For this purpose, set the control’s
DisplayMode property to AccountActivate.

Note: Users can also be manually activated or removed via the View Not Verified Users
screen. For more information, see The View Not Verified Users Screen on page 23-30.
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The Verification Message
By default, Ektron CMS400.NET supplies a generic message asking the user to
confirm his password and directing him to the acitvatemyaccount.aspx page
on your Web site. If you want to customize that message, follow these steps.

1. Go toWorkarea > Settings > Community Management >
Messages.

2. Click the Add button ( ).
3. Assign a title to the message, such as Verification Message.

4. Click to place a check mark in the Default box.

5. Enter the text of the confirmation message you want the subscriber
to receive. Be sure to place the @appQueryLink@ variable in the
message to create a link to the confirmation page. For example:

Welcome to example.com. You have registered to be notified of updates to our site.

Before we can do this, you need to activate your account. To do so, please visit
@appQueryLink@.

The @appQueryLink@ variable places a link in the message that gets
resolved as follows:

http://sitepath/workarea/activateuser.aspx?uid=[username]&acc=[accountID]

For example:
http://ww-
w.example.com/Workarea/activateuser.aspx?uid=john.edit@example.com&acc=ce5w84o936477

The following table lists all variables that may be placed in the confirmation
message.

Variable
Retrieves this Membership user
information

@appEmail@ email address

@appActivateId@ Account ID

@appUserName@ UserName

@appFirstName@ First name

@appLastName@ Last name

@appDisplayName@ Displayname

@appAvatar@ Avatar

@appSignature@ Signature

The VerificationMessage
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The View Not Verified Users Screen
All users who have signed up for a subscription but who have not yet verified
that subscription appear on the View Not Verified Users Screen. This screen is
available via Settings > Community Management > Memberships >
Users not Verified.

After viewing membership users on the screen, you can manually activate their
account. To do so, selecting one or more users then click the Activate button (
). Alternatively, you can delete members by selecting one or more and

clicking the Delete button ( ).

Note: The ek_PageSize setting in the web.config file determines the maximum number of
users that can appear on a page before it “breaks.” When a page breaks, additional entries
appear on another screen, and the following text appears near the bottom of the list:
Page 1 of 2[First Page] [Previous Page] [Next Page] [Last Page]

To select all members, click the check box in the header line, next to
Username (circled below).

You can also change the way membership users are sorted, or use the Search
button to find users that match your criteria (for example, users whose
username includes example.com.) These features are explained in Sorting
Membership Users on page 16-9 and Searching for Membership Users on page
16-10.

Setting up Other Web Pages for Site Visitor
You can set up other Web pages that let the subscriber perform the following
actions:

n Activate their account

n Reset their password

n Unsubscribe

To create these pages on your web site, place the membership server control
on the page. Then use the control’s DisplayMode property to determine the
kind of screen you want to place. For example, to create a screen that lets the
user reset his password, set the Membership server control’s DisplayMode
property to ResetPassword.

For more information, see Membership Server Control on page 16-19.
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CMS User Subscription Sign Up
CMS users can also subscribe to any subscription list. This would be particularly
useful on an intranet where, for example, employees are notified when job-
related information is updated.

Another example would be for your internet site. The manager of the Marketing
Department could sign up to be notified whenever Marketing content is added
or updated.

To do so, users go to Settings > Users > Edit User > Custom tab (see
illustration).

CMS User Subscription Sign Up

ReferenceManual
Version 8.01 Rev 4

23-31



(This page intentionally blank.)



Chapter 24

Working with Ektron
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Ektron CMS400.NET provides an extensive list of server controls that can be
dragged and dropped onto any ASPX page to coexist with other components.
This includes control for everything from content to user management to
breadcrumbs to social network controls, all in order to provide out-of-the-box
markup and functionality.

With Ektron’s server controls there is a great deal of flexibility. In addition to
having a set of properties that can be used to change the controls' output and
behavior, developers can access the Server Control API. See Ektron’s
CMS400.NET API Reference Manual for information on the Server Controls API.

Ektron CMS400.NET’s server controls let you insert many standard methods and
properties within the Visual Studio environment. This means that you can see
the effect of your changes in real time -- you don’t have to modify a page then
compile a sample project to see the results.

You can insert server controls using drag and drop or programmatically. You
can also use databinding to retrieve and display data from Ektron CMS400.NET.

Additional information and examples for Ektron Server Controls are available
online after you install the Developer sample site. Here is the path:

http://localhost/CMS400Developer/Default.aspx

Replace localhost with the webroot where you installed the Developer site.

This section also contains the following topics.

Opening the Sample Project 24-3
Setting Up a Template 24-4
Making the Server Controls Available 24-5
Removing the Server Controls 24-6
Updating the Server Controls 24-6
Inserting Server Controls Using Drag and Drop 24-6
Build the Project 24-10
Inserting Server Controls Programmatically 24-10
Using Drag & Drop and Programmatically Together 24-24
Data Binding with Server Controls 24-26
Building Templated Server Controls 24-32
Caching with Server Controls 24-33
Using Ajax Enabled Server Controls and Custom Code 24-37
Displaying Custom XML in Ektron’s Server Controls 24-38
List of Server Controls 24-39
RssAggregator Server Control 24-45
DesignTimeDiagnostic Server Control 24-49
Learning About Visual Studio 24-51
Grid Layout vs. Flow Layout 24-51
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Opening the Sample Project
To help get you started, these directions explain how to open the sample site
delivered with Ektron CMS400.NET.

1. Browse to and double click Ektron CMS400.NET‘s solution file,
localhost/siteroot/CMS400Developer.sln.

2. The sample site project opens.

3. To work on a template page, click it from the Solution Explorer.

When you select a page, its properties appear in the Properties area (below
Solution Explorer), and the page appears in the center of the screen. A control’s
properties include several standard .NET properties along with Ektron-specific
ones. The Ektron properties are labeled as illustrated below.

Opening the Sample Project
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Setting Up a Template
To create a new template (.aspx) page, follow these steps.

1. Click Project > Add Web Form.

2. On the Add New Item screen, click Web Form and assign a name.

3. Add controls to determine the page content.

Working with
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Making the Server Controls Available
Note: You must copy the dlls to a local drive before installing them. You cannot copy them
from a network drive.

1. Display the Visual Studio toolbox (View > Toolbox).

2. Right click the mouse within the Toolbox.

3. Click Add Tab.

4. Type Ektron Server Controls then press <Enter>.

5. Click the Ektron Server Controls Tab.

6. Right click the mouse in the empty area.

7. Click Add/Remove Items. If using Visual Studio, click Choose
Items.

8. The Customize Toolbox dialog appears.

9. Select the .NET Framework Components tab.

10. Browse to the directory that stores Ektron CMS400.NET‘s dll files,
localhost/CMS400Developer/bin, and add the
Ektron.Cms.Controls.dll file. This file provides access to Ektron
CMS400.NET’s server controls.

Making the Server Controls Available
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Alternatively, you could use the following location, C:\Program
Files\Ektron\CMS400v8x\bin. The file is identical in both places.

Using the bin folder in your site provides better speed when loading Web
pages. However, if you use the bin folder located in Program Files, you
do not have to worry about deleting the .dll file if you change or delete
your site.

11. Click OK.

For easier viewing once the server controls are installed, you can right click on
them and select Sort Items Alphabetically. Note that you can only see the
server controls when an aspx template is selected.

Removing the Server Controls
1. Display the Visual Studio toolbox (View > Toolbox).

2. Right click the mouse within the Toolbox.

3. Click Add/Remove Items. If using Visual Studio, click Choose
Items.

4. Click Namespace or Assembly Name to sort the Server Controls
by manufacturer.

5. Uncheck all boxes that are Ektron.Cms.Controls.

6. Click OK.

7. Right click the Ektron Server Control tab.

8. Click Delete Tab to remove it.

Updating the Server Controls
To update the server controls you must first remove the existing server controls
in Visual Studio, then add the new server controls.

For information on removing server controls, see Removing the Server Controls
above

For information on adding server controls, see Making the Server Controls
Available on previous page

Inserting Server Controls Using Drag and
Drop
Because Visual Studio is a visual environment, you can watch the page layout
change as you add or move a control and adjust its properties. And, whenever
you need to identify an Ektron CMS400.NET object (such as content block or
collection), you can use the CMS Explorer to visually browse to and select it.
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Adding a Server Control to a Template
1. Display the Visual Studio toolbox (View > Toolbox).

2. Click the Ektron Server Control tab. The Ektron CMS400.NET’s
server controls appear.

3. Drag a server control and drop it into the desired location on the
page.

Adding a Server Control to a Template
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4. As desired, modify the control’s properties using the Properties area
of Visual Studio.

For a description of server control properties, see List of Server Controls on
page 24-39.

ServerControlWS.asmx

Best Practice
For improved security, Ektron recommends renaming or removing theWeb services file when
youmove it to your production server. After installation, this file is named ServerControlWS.asmx
and resides in the  /siteroot/Workarea/ folder in your Web root.

ServerControlWS.asmx is the Web service that lets the server controls talk to
Ektron CMS400.NET. The path is coded in the web.config file. This is how it
appears:

<!-- Web Service URL for Server Controls design time --> <add key="WSPath"
value="http://localhost/siteroot/Workarea/ServerControlWS.asmx" />

You need to edit this line if you change the location or name of the
ServerControlWS.asmx file.

Using CMS Explorer to Browse Your Ektron
CMS400.NET Site
Ektron CMS400.NET provides a window (called the CMS Explorer) that lets you
browse through your Web site to identify CMS objects such as folders,
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calendars, blogs, and content blocks. For example, if you insert a List Summary
Server Control, its FolderID property identifies the folder whose contents are
displayed. If you are not sure of the folder path, click the gray button.

When you do, a login screen appears (illustrated below).

Note: A user cannot be logged into the CMS Explorer and the Ektron CMS400.NETWorkarea
at the same time. If you log into the CMS Explorer while logged into the Workarea, you will
receive the following error when you try to use the Workarea: Error: The current user
does not have permission to carry out this request [CBR R31]. If you log into
the Workarea while logged into the CMS Explorer, you will need to re-login to the CMS
Explorer when you return to using it.

Enter your Ektron CMS400.NET username and password. When you do, the CMS
Explorer window appears, providing a visual way to browse your Ektron
CMS400.NET Web site.

Navigate through the folders, select an object, then click the Select button. The
selected object is pasted to the server control property.

Note: Although you see the object in the selected language in Visual Studio, the language is
not stored. For example, if you select a German content block whose ID=2, Ektron
CMS400.NET only stores content block ID=2. When a visitor to your site browses to that

Using CMS Explorer to Browse Your Ektron
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page, the content block does not appear in the selected language. Instead, it is determined by
a cookie or the user’s language selection.

Build the Project
After you open the solution file in Visual Studio and add the required files, build
the project. This may take a while the first time you do so. After the project is
built, a browser opens and it is displayed as a Web page.

You can also view a Web page while working on it by right clicking on the Web
form and clicking View in Browser.

Inserting Server Controls
Programmatically
Besides using the drag-and-drop method to insert a server control (explained in
Inserting Server Controls Using Drag and Drop on page 24-6), you can insert
one programmatically. You might prefer to insert server controls
programmatically for several reasons, such as

n you want the control to be loaded into memory only under certain
conditions. In this case, insert the logic that only displays the control
if the condition exists.

n you want to display only certain properties of an object, such as the
title of last edited date of a content block.

Note that you can drag and drop controls on your page then customize them
using code behind. For more information, see:Using Drag & Drop and
Programmatically Together on page 24-24.

This section also contains the following topics.

Steps to Insert a Server Control Programmatically 24-11
Step 1: Declare the Namespace 24-11
Step 2: Create an Instance of the New Control 24-11
Step 3: Set the Properties 24-12
Step 4: Call the Fill Method 24-13
Step 5: Use .text Property to Display the Control 24-13
Server Control Properties in Code Behind 24-14
Displaying Properties for a Control 24-14
Mutual Server Control Properties in Code Behind 24-15
Accessing Additional Properties 24-16
Accessing Items in an Array 24-20
Referencing the Page Property 24-21
Customizing Server Controls 24-22
Recognizing the Server Control Within the HTML 24-22
Recognizing the Server Control Within the Code Behind 24-23
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Customizing the Server Control in the Code Behind 24-23
Troubleshooting Error Creating Control Message 24-24

Steps to Insert a Server Control
Programmatically
To insert an Ektron server control programmatically, follow these steps.

Step 1: Declare the Namespace below

Step 2: Create an Instance of the New Control below

Step 3: Set the Properties on next page

Step 4: Call the Fill Method on page 24-13

Step 5: Use .text Property to Display the Control on page 24-13

Each step is described below. These steps show an example of using the
Collection Server Control.

Step 1: Declare the Namespace
Before inserting the server control, you can declare the namespace at the top
of the code behind Visual Basic file, as shown below.

Note: You do not need to declare a namespace. However if you do not, you must fully qualify
objects that you create.

Best Practice
For any customization of the CMS, classesor controls that inherit from Ektron
classes, it is recommend that you create your own namespace within
'Ektron.Cms.Custom'. For example, if your company is 'AcmeExampleTech, Inc.' you
should create all of your custom classeswithin the namespace
'Ektron.Cms.Custom.AcmeExampleTech'.

Step 2: Create an Instance of the New Control
Next, declare a control as an object in the code behind. In this example, we
create a collection named MyColl.

Steps to Insert a Server Control Programmatically
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dim MyColl as New Collection

or

dim MyColl as new Ektron.Cms.Controls.Collection

With C#, use this syntax.

Ektron.Cms.Controls.Collection MyColl = new

Ektron.Cms.Controls.Collection();

You can declare any server control as an object by using the server control
name in the List of Server Controls on page 24-39. Another example would be:
Dim MyMdl as New MetaDataList.

Step 3: Set the Properties
Note: For descriptions of the properties and how to use them, see Server Control Properties in
Code Behind on page 24-14.

After inserting the control, you can set the properties that you want to display
on the page. For example:

Dim MyColl as New Collection

MyColl.DefaultCollectionID = 4

MyColl.Page = Page

or if you are using code behind to insert the control,

dim MyColl as new Ektron.Cms.Controls.Collection

MyColl.DefaultCollectionID = 4

MyColl.ID = “Collection1”

MyColl.Page = Page

With C#, use this syntax.

Ektron.Cms.Controls.Collection MyColl = new

Ektron.Cms.Controls.Collection();

MyColl.DefaultCollectionID = 4;

MyColl.ID = “Collection1”;

MyColl.Page = Page;

These lines tell the page to display CollectionID 1 unless otherwise specified.

Warning!When using code behind to add a server control to your Web form, you must set the
Page object for the server control to Page. For example, Mycoll.Page = Page This line needs
to appear between Dim new server control line and the Fill() line. This line is not added when
dragging and dropping a server control on a Web form. See Also: Referencing the Page
Property on page 24-21.
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Note: If you do not know an object’s ID number, you can switch to Design mode, drag and
drop the object, then use the CMS Explorer to find the ID number. (See Using CMS Explorer to
Browse Your Ektron CMS400.NET Site on page 24-8.) If you do this, remember to delete the
dropped object when you are done.

You can also obtain the ID number via the Workarea.
Dim MyColl as New Collection
MyColl.ID = “Collection1”
MyColl.DefaultCollectionID = 4
MyColl.Page = Page
MyColl.Random = True

This line sets the Random property to true. See Also: Random on page 9-274.

Step 4: Call the Fill Method
Because there is no render event when using objects as components not as
controls, use the Fill method to fill an object’s properties on the page. An
example is below.

Dim MyColl as New Collection

MyColl.ID = “Collection1”

MyColl.DefaultCollectionID = 4

MyColl.Page = Page

MyColl.Random = True

 MyColl.Fill()

Step 5: Use .text Property to Display the Control
Finally, use the .text property to determine what appears on the Web page.
For example, to display the first item in a collection, use this syntax.

Note: Before adding this line you need to drag and drop a label on your Web form.

Dim MyColl as New Collection

MyColl.ID = “Collection1”

MyColl.DefaultCollectionID = 4

MyColl.Page = Page

MyColl.Random = True

MyColl.Fill()

Label1.Text = myColl.EkItems(0).Title

To display all items in a collection, use this syntax.

 Dim myColl As New Ektron.Cms.Controls.Collection

 Dim ekitem As New Ektron.Cms.Common.ContentBase

Step 4: Call the Fill Method
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 MyColl.DefaultCollectionID = 2

 MyColl.ID = “Collection1”

 MyColl.Page = Page

 MyColl.Fill()

 Label1.Text = "<ul>"

 For Each ekitem In myColl.EkItems

 Label1.Text &= "<li><a href=""" & ekitem.QuickLink & """>" & ekitem.Title &
"</a>"

 Next

 Label1.Text &= "</ul>"

This example displays the quick link for every content block in the collection,
formatted as a bulleted list. You can use similar code to display a List Summary
or search results. The following explains the new (red) code above.

n label1.Text = "<ul>" displays the opening tag for the bulleted list

n For Each ekitem In myColl.EkItems creates a loop for all content
blocks in the collection

n label1.Text &= "<li><a href=" & ekitem.QuickLink & ">" &
ekitem.Title & "</a></li>" for each content block in the
collection, displays its quicklink and title

n Next loops through all content blocks in the collection

n label1.Text &= "</ul>" closes the bulleted list

Server Control Properties in Code Behind
Every server control has properties associated with it that you can only access
programmatically. This subsection explains, what they are, how to access
them, and how to use them.

n Displaying Properties for a Control below

n Mutual Server Control Properties in Code Behind on the facing page

n Accessing Additional Properties on page 24-16

n Accessing Items in an Array on page 24-20

n Referencing the Page Property on page 24-21

Displaying Properties for a Control
You can use Visual Studio’s intellisense feature to display a control’s properties.
The intellisense box appears as soon as you insert the period (.) after the
object, as illustrated below.
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The intellisense box displays all properties that can be applied. For a
description of Ektron’s standard server control properties, see List of Server
Controls on page 24-39. To learn about native VS properties, see its
documentation.

The property’s tooltip text indicates its type. In the above example, you can see
that the DefaultCollectionID’s type is integer.

For more information about accessing Ektron CMS400.NET object properties,
see Customizing the Server Control in the Code Behind on page 24-23.

Mutual Server Control Properties in Code Behind
There are several read-only properties that can be called in the code behind
and used by every server control. The list below explains these properties.

Note: The properties do not display values within Visual Studio during design time. Instead,
they only display values at run time, which are dependent on the user’s login status.

Property Value Data Type

IsLoggedIn

Tells if a user is logged in to Ektron CMS400.NET.

True =User is logged in

False =User is not logged in

Boolean

LoggedInUserName Gets the Ektron CMS400.NET user name to display. String

LoggedInUserID Gets the Ektron CMS400.NET ID of the user to display. Integer

These properties will allow you to personalize any page with your users names
and IDs, and show if they are logged in. Here is an example of using these
properties in code behind.

Note: You must be logged in to Ektron CMS400.NET for this example to show your name and
ID.

1. Drag an Ektron CMS400.NET server control onto a Web form.

2. Drag three Literals onto the Web form.

Mutual Server Control Properties in Code Behind
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3. Open the code behind for the Web form.

4. Add the following code to the Page_Load event.
Literal1.Text = ContentBlock1.IsLoggedIn

If ContentBlock1.IsLoggedIn Then

 Literal2.Text = ContentBlock1.loggedInUserName & " is logged in "

 Literal3.Text = ContentBlock1.loggedInUserID & " is the User ID "

End If

5. Build and run the solution.

6. Browse to the login page and log in.

7. Browse to the new Web form you added.

8. The login information is displayed.

Accessing Additional Properties
In addition to the standard properties, Ektron CMS400.NET provides access to
additional properties for the following objects.

n ListSummary

n Collection
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n Search

n ContentBlock

n FormBlock

To access additional properties, use the same syntax you use for standard
properties but add .ekitem or .ekitems after the object. Here is an example.

dim MyCB as New ContentBlock

MyCB.DefaultContentID = 30

MyCB.ID = “ContentBlock1”

MyCB.Page = Page

MyCB.Fill()

label1.text = MyCB.EkItem.dateCreated

or

dim MyCB as new Ektron.Cms.Controls.ContentBlock

MyCB.DefaultContentID = 30

MyCB.ID = “ContentBlock1”

MyCB.Page = Page

MyCB.Fill()

label1.text = MyCB.EkItem.dateCreated

Warning! To access additional properties for the Collection, ListSummary, and Search objects,
use ekitems, not ekitem. For example: MyColl.ekitems(0).dateCreated. where (0) is the index of
the array. For more Information on using ekitems, see Accessing Items in an Array on page 24-
20.

You can use intellisense to select from a list of additional object properties, as
shown below.

The additional properties are listed below.

Accessing Additional Properties
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Note: The following properties are read-only. For example, you can get a content block’s ID
and pass it through to another part of the code, however you cannot set a content blocks ID to
be shown. mycb.Ekitem.id = 8 will not set a content block’s ID. The correct way to set a
content blocks ID is DefaultContentID = 8.

Property Description For more information, see

Comment The content block’s comment.

ContentStatus

The statusof the content block.

n approved

n checked out

n checked in

n expired

n pending deletion

n pending expiration

n pending start date

n submitted

Content Statuseson page 7-130

ContentType

One of the following

n all types

n archived content

n archived forms

n content

n forms

To learn about archived content,
seeScheduling Content to Begin
and End on page 7-187.

DateCreated The date when the content blockwascreated,
formatted asa .NET date type.

DateModified The date when the content blockwas
modified, formatted asa .NET date type.

DefaultXslt The default XSLT used to display the content.

DisplayDateCreated
The date when the content blockwascreated.
It is formatted asa string that represents
Ektron CMS400’s display of the date.

DisplayDateModified
The date when the content blockwasedited. It
is formatted asa string that representsEktron
CMS400’s display of the date.

DisplayEndDate
The content block’s end date. It is formatted as
a string that representsEktron CMS400’s
display of the date.

Setting an EndDate on Content
on page 7-190
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Property Description For more information, see

DisplayGoLiveDate
The content block’s start date. It is formatted
asa string that representsEktron CMS400’s
display of the date.

Setting a Start Date on page 7-
188

DisplayStartDate
The content block’s start date. It is formatted
asa string that representsEktron CMS400’s
display of the date.

Setting a Start Date on page 7-
188

EndDate The content block’s end date, formatted asa
.NET date type.

Setting an EndDate on Content
on page 7-190

EndDateAction

n archive display

n archive expire

refresh report

Setting Archive Optionson page
7-191

FolderID The ID of the folder that contains each content
block.

GoLiveDate The content block’s start date formatted asa
.NET date type.

Setting a Start Date on page 7-
188

Html
The content that makesup the content block. If
content block is in XML it will return it as raw
XML content.

Hyperlink Content block title wrapped by <a href>
tags.

Id The content block ‘s ID number.

InheritedFrom If folder permissionsare inherited, the folder
fromwhich theyare inherited. Inheritance on page 4-42

IsInherited Whether a content block’s permissionsare
inherited. Inheritance on page 4-42

IsPrivate Whether or not a content block is private. Private Content on page 7-184

Language The content block’s language. Working with Multi-Language
Content on page 14-1

LastEditorFname The first name of the last person to edit the
content block.

LastEditorLname The last name of the last person to edit the
content block.

PackageDisplayXSLT If the content block isXML, the name of its
XSLT.

Accessing Additional Properties
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Property Description For more information, see

QuickLink The content block’s quicklink. Quicklinksand Formson page 8-
20

StartDate The content block’s start date formatted asa
.NET date type.

Setting a Start Date on page 7-
188”

Status

The statusof the content block

n approved

n checked out

n checked in

n expired

n pending deletion

n pending expiration

n pending start date

n submitted

Content Statuseson page 7-
130”

Teaser The content block summary. Adding HTMLContent on page
7-15

TemplateLink Currently empty and not being used with the
ContentBlock server control.

Title The content block title.

UserID Last user who edited the content.

Xslt1 The content block’s first Xslt, as defined in
Ektron CMS400.NET.

Xslt2 The content block’s second Xslt, as defined in
Ektron CMS400.NET.

Xslt3 The content block’s third Xslt, as defined in
Ektron CMS400.NET.

Xslt4
The developer can use this property
programmatically. Ektron CMS400.NET only
usesXslt1, 2 and 3 in the workarea.

Xslt5
The developer can use this property
programmatically. Ektron CMS400.NET only
usesXslt1, 2 and 3 in the workarea.

Accessing Items in an Array
To access and manipulate content blocks returned by an object, use the
common class Ektron.Cms.Common.ContentBase. EkItems is an array of
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Ektron.Cms.Common.ContentBase. EkItem is a single
Ektron.Cms.Common.ContentBase.

Search, Collection and ListSummary have EkItems (an array of ContentBase),
while ContentBlock has a single EkItem. Here is an example of how to use this
feature.

dim MyC as new Ektron.Cms.Controls.Collection

MyC.DefaultCollectionID = 1

MyC.ID = “Collection1”

MyC.Page = Page

MyC.Fill()

dim item as Ektron.Cms.Common.ContentBase

MyC.Text = "<ul>"

for each item in MyC.EkItems

MyC.Text &= "<li>" & item.Title & "</lI>"

next

MyC.Text &= "</ul>"

Response.Write(MyC.Text())

This example formats every item in the collection in a bulleted list.

Note: For information on using ekitems with the eCommerce server controls, see Using the
EkItems Property with eCommerce Server Controls on page 17-238 and Using eCommerce
Server Control Events on page 17-236.

Referencing the Page Property
Server controls require a reference to their parent page (for example, utilizing
the DynamicParameter property on a content block to check for a query string),
you must provide access to the page object if you declared your control in the
code behind. To do this, set the control's Page property to the Web page you're
working on. For an example, see the code in red and italics below.

dim search as new Ektron.Cms.Controls.Search()

MySearch.ID = “Search1”

MySearch.Page = Page

MySearch.Fill()

With C#, use this syntax.

Ektron.Cms.Controls.Search MySearch = new Ektron.Cms.Controls.Search();

MySearch.Page = Page;

Referencing the Page Property
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MySearch.Fill();

This relationship is only required when inserting a control in the code behind.
When dragging and dropping, even if you make changes in code behind, the
relationship is automatically generated.

Best Practice
Ektron recommends including the Pageproperty reference when using the server
controls as components in the code behind.

Customizing Server Controls
One of Visual Studio’s strengths is its separation of coding and logic from
presentation. Web page formatting is handled by a page’s HTML, while the logic
is handled by the code behind, which is stored in the corresponding .vb file. For
example, if the ASP.NET page is mypage.aspx, the code behind file is
mypage.aspx.vb.

Note: If you do not see the code behind files, click the Show All Files button on the VS Solution
Explorer toolbar.

Within the vb file, you can use Visual Basic to insert code to manipulate the
events that occur on the page.

This subsection contains the following topics:

n Recognizing the Server Control Within the HTML below

n Recognizing the Server Control Within the Code Behind on the facing
page

n Customizing the Server Control in the Code Behind on the facing page

n Troubleshooting Error Creating Control Message on page 24-24

Recognizing the Server Control Within the HTML
Within a Web page’s HTML, a <cms> tag wraps the Visual Studio object, as
shown below.

<cms:Search id="Search1" runat="server" ButtonText="Search"
Display="Vertical"></cms:Search>

Above is an example of a Search Server Control. Below is an example of a
ContentBlock Server Control.
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<cms:ContentBlock id="ctrlMainContentBlock" runat="server" DefaultContentID="1"
DynamicParameter="id” OverrideXslt="Default"></cms:ContentBlock>

Recognizing the Server Control Within the Code
Behind
Within the Visual Studio code behind file, the Ektron server controls appear
(along with the VS controls) in the Web Form Designer Generated Code section.
When you click the plus sign (+) to display this section, you see something like
the following. The content block listed in HTML above is circled below to help
you see their relationship.

The next section of the code behind page loads the page into the browser.

Private Sub Page_Load(ByVal sender As System.Object, ByVal e As System.EventArgs)
Handles MyBase.Load

We want our events to occur while the page is loading, so we’ll add custom
code following this line.

Customizing the Server Control in the Code
Behind
To customize an Ektron server control in the code behind, insert code similar to
the following after the Page_load command.

Dim MyObj As New Ektron.Cms.Controls.ContentBlock

This code declares a variable named MyObj and assigns to it the value of a
content block. The content block is part of the Ektron.CMS.Controls content
base, so it has access to the Ektron CMS400.NET database.

After defining MyObj as a content block, you can access its properties. For
example, to assign a defaultID of 24, insert the following.

Dim MyObj As New Ektron.Cms.Controls.ContentBlock

MyObj.DefaultContentID = 24

Now, the content block can be specified dynamically in the URL of the hyperlink
that calls it. If not, content block 24 displays.

Recognizing the Server ControlWithin the Code
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This is just an example of programmatically applying property values to content
blocks. For a complete list of properties available to Ektron CMS400.NET
objects, see List of Server Controls on page 24-39.

Troubleshooting Error Creating Control Message
If you get an Error Creating Control message while trying to use a server
control, you can view the text of the error message by hovering the mouse over
the control. See illustration below.

Using Drag & Drop and Programmatically
Together
All server controls can be further manipulated after dragging and dropping them
on a web form by using the code behind. Here is an example of using a drag and
drop ListSummary Server Control then modifying it programmatically.

First, drag and drop a List Summary on your Web form and set your properties.
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Then add the following code to the code behind.

Dim myString As String

Dim i

For i = LBound(ListSummary1.EkItems) To UBound(ListSummary1.EkItems)

myString &= "<a href=""" & ListSummary1.EkItems(i).QuickLink & """>" &
ListSummary1.EkItems(i).DateCreated & "</a><br>"

ListSummary1.Text = myString

Next

An Explanation of the code:

ListSummary1 is the ID of the object. It is used to get access to its properties.

Create a string that contains the output (myString).

Dim myString As String

Set the object’s Text property to that string.

myString &= "<a href=""" & ListSummary1.EkItems(i).QuickLink & """>" &
ListSummary1.EkItems(i).DateCreated & "</a><br>"

Wrap in a loop so it loops through each of the items.

Dim i

For i = LBound(ListSummary1.EkItems) To UBound(ListSummary1.EkItems)

Next

Using Drag & Drop and Programmatically Together
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This example outputs the date created for each content block in a List
Summary.

Data Binding with Server Controls
With data binding, you can bind Ektron server controls to a GridView Control,
DataList Control, or Repeater Control. This gives more flexibility when you use
data from the Ektron server controls. Benefits of data binding include ease of
data manipulation and the ability to format data.

Warning!When HTML is bound to a column, you need to add HtmlEncode = False to it.
Otherwise, the HTML appears as code. For example, <p>Ektron Inc., an innovator in
Web content management software, today announced...</p>.

The following are data bindable Ektron Server Controls.

n Collection

n ContentList

n IndexSearch

n ListSummary

n MetaDataList

n RssAggregator

The following is an example of code behind that uses a GridView to display a
Collection:

Note: For the example code below to work properly, you need to drag and drop a GridView
server control on a Web form.

Dim myCol As New Ektron.Cms.Controls.Collection

MyCol.ID = “Collection1” ‘‘‘Create an ID for the Collection

myCol.DefaultCollectionID = 4

myCol.Page = Page

myCol.Fill()
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GridView1.DataSource = myCol

GridView1.DataBind()

This section also contains the following topics.

Steps to Data Binding Using Drag and Drop Server Controls 24-27

Steps to Data Binding Using Drag and Drop
Server Controls
The following example uses a Collection.

1. Create a new Web form.

2. Drag and drop a data bindable Server Control on the Web form. For
example, a Collection server control.

3. In properties, choose a DefaultCollectionID for the Server Control
and make sure DisplayXslt is set to None- DataBind Only.
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4. Drag and drop a GridView on the Web form.

5. In the GridView Tasks, choose the DataSourceID.
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6. In code behind, add the following line of code to the Page add
field.gifnit event:

Collection1.Fill()

7. Select the columns to be databound by clicking Add New Column in
GridView Tasks.

8. Complete the Add Field window according to the table below.

Field Entry

Choose a field type: BoundField

Header text: The title name for each column.

Steps to Data Binding Using Drag and Drop Server
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Field Entry

Data field:

The data to bind to each column. Choose one of the following:

ID - the content block ID

Title - the content block title

Teaser - the content summary

Html - the html content

StartDate - the content’s start date

DateModified - the content’s last modified date

EndDate - the content’s end date

LastEditorFname - the last editor’s first name

LastEditorLname - the last editor’s last name

QuickLink - the content’s quicklink

HyperLink - the content’s hyperlink

DisplayStartDate - the string representation of the start date

FolderID - the folder ID where the content is located

ContentStatus - the content’s status

Language - the content’s default language

DisplayDateModified - string representation of the content’s last modified date

DisplayEndDate - string representation of the content’s end date

EndDateAction - an action tied to end date. For example, Refresh_Report

Comment - the content’s comments

9. Click OK.

10. Repeat steps six, seven and eight for each column you want to add.

11. If you want to add all of the columns automatically, in the GridView
Task menu click Edit Columns. Otherwise, skip to step thirteen.
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12. Click the Auto-generate fields checkbox.

13. Click OK.

14. From the Build menu, click Build Page.

15. In design view, right click the form and select View in Browser.

For more information on GridView, DataList, Repeater and DetailsView, see the
help inside Visual Studio.
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Building Templated Server Controls
The Micro-messaging Bookmarklet server control is template-based. This style
has several advantages over non-template based controls. For example, you do
not need to use separate files to control the page's appearance, such as an XSLT
 or .ekml file.

The Javascript used to render the Bookmarklet control is loaded into the Href
property of the control's anchor tag, as shown below.

Below is the markup for the first Bookmarklet server control in
bookmarklet.aspx.

<li>

<div class="controlWrapper">

<h3>Default</h3>

<CMS:micromessagingbookmarklet ID="bookmarkletDefault" runat="server" />

</div>

</li>

Because Bookmarklet is a template-based server control, you can enter any
 valid markup, and it will be rendered exactly as you entered it. As examples,
you could enter the following items within the <div> tags that surround the
control.

n another Ektron CMS400.NET server control

n any third-party server control

n HTML syntax
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n databinding syntax

n style classes

n style tags, such as <strong>

Caching with Server Controls
A key factor in building high-performance, scalable Web applications is the
storage of items in memory after the first time they are requested. The items
include data objects, pages, and parts of a page.

Known as caching, this process saves and later reuses page output or
application data across HTTP requests. You can store items on the Web server
or other software in the request stream, such as the proxy server or browser.

Caching saves time and resources because the server does not have to recreate
information, particularly things that demand significant processor time or other
resources.

The following illustrates data flow in non-cached and cached environments.

Ektron CMS400.NET provides two kinds of caching.

n Caching Individual Content - lets you cache part of a Web page;
available with some server controls

Caching with Server Controls
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n Page Level Caching - lets you cache an entire page; available with all
server controls

Each is explained below.

Caching Individual Content
There are two kinds of caching of individual content.

n Caching While not Logged In below

n Caching While Logged In below

Caching While not Logged In
For a description of how Caching While not Logged In works, see Caching with
Server Controls on previous page.

Caching While Logged In
When a user is logged in, caching prevents any changes from appearing on the
site for the number of seconds defined in the cache interval. This reduces the
number of database hits, which improves your server’s performance.

For example, if you add a new item to a Collection, the change only appears on
the site when the cache interval expires. However, the user can switch to
Preview mode to see the updated Collection immediately. See Also: Site
Preview on page 2-9

Warning! Caching while logged in does not work with Private content. See Also: Private
Content on page 7-184

Setting up Caching of Individual Content
To set up caching of individual content for any Web page, follow these steps.

1. Make sure the Web.config file’s ek_CacheControls property’s value
= “1” (one). This is the default. This setting lets you control caching
with server controls.

2. Add a server control that supports caching of individual content to a
Web form. See The caching of individual content is available for the
server controls listed below. on the facing page.

3. Set the server control ‘s CacheInterval property to the length of
time the data should be cached. For example, to cache data for five
minutes, set CacheInterval to 300 (three hundred).

The default value is 0 seconds. So, you must change the default to
enable caching.
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Server Controls that Support Caching of Individual
Content
The caching of individual content is available for the server controls listed
below.

Control
Caching available while not
logged in

Caching available while
logged in

ActiveTopics X

All blog controls X

Collections X X

CommunityDocuments X

CommunityGroupBrowser X

CommunityGroupList X

CommunityGroupMembers X

CommunitySearch X

ContentBlock X

ContentList X X

DhtmlMenu X X

Directory X

Favorites X

FlexMenu X

FormBlock X

Forum X

Friends X

ListSummary X X

MetadataList X X

Menu X X

Poll X

Server Controls that Support Caching of Individual
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Control
Caching available while not
logged in

Caching available while
logged in

PostHistory X

SiteMap X

SmartMenu X X

TagCloud X

UserProfile X

Page Level Caching
Below is an example of a page level cache for non logged-in users. In this
example, you use a Server Control to define whether a user is logged in or not.
Then, define if the time is cached, based on the user’s status.

1. Create a new Web form in your Ektron CMS400.NET project.

2. Add the following text to the Web form:
Refresh the page. The page will cache for 20 seconds when
not logged in:

Time is =

3. Next to Time is =, add a literal.

4. Below that, add a ContentBlock Server Control.

5. Set the DefaultContentID. For this example, DefaultContentID =
20.

6. Add the following to the Page_Load event in the code behind.

If Not ContentBlock1.IsLoggedIn Then

Response.Cache.SetExpires(DateTime.Now.AddSeconds(20))

Response.Cache.SetCacheability(HttpCacheability.Public)

Response.Cache.SetValidUntilExpires(True)

Response.Cache.VaryByParams("id") = True

Response.Cache.SetVaryByCustom("cmsCache")
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End If

Literal1.Text = Now()

7. Build your Web form.

8. Browse to your Web form using your browser.

9. Press your browser’s refresh button.

If you are not logged in to Ektron CMS400.NET, the time remains for twenty
seconds. After twenty seconds, when you refresh, the new time appears.

Note: You can use the same code in a user control to cache output in a particular region of the
page.

Using Ajax Enabled Server Controls and
Custom Code

Best Practice
When using Ajax server controls and custom code, wrap the custom code in a check
for “is not a callback,” so it is not executed when a callback from an Ajax server control
occurs.

If you use an Ajax-enabled server control and write custom code, it may
generate an exception, indicating the server control does not work. This issue
happens during callback for the Ajax server control when custom code accesses
a property that is filled during page load, but not filled during callback.

For example, a Poll server control is on a Web form, and you want the title of a
content block to appear in a literal on that form. The EkItem.Title property for
the content block is filled upon page load. When a site user answers the poll
question, an exception occurs during the callback because the EkItem.Title
property is not refilled. However, the site user does not see the exception. It
just looks like the Poll server control is not working.

Below is an example of custom code that makes the content block’s title appear
in the literal:

Literal1.Text = ContentBlock1.EkItem.Title

To solve this issue, wrap the custom code in a check for “is not a callback”. This
prevents the code execution when callback occurs. For example,

[C#]

If( !IsCallback ) {

Literal1.Text = ContentBlock1.EkItem.Title

}

[VB]

If ( Not IsCallback )

Using Ajax Enabled Server Controls and Custom
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Literal1.Text = ContentBlock1.EkItem.Title

End If

Displaying Custom XML in Ektron’s
Server Controls
Ektron provides a CustomXml property in several server controls that allows
you to add custom XML to a control’s generated XML before being processed by
its XSLT.

This property is available in code behind when using these server controls:

n Cart

n Checkout

n CurrencySelect

n MyAccount

n OrderList

n Product

n ProductList

n ProductSearch

n Recommendation

CustomXml Property Usage Example
Below is a C# example of using the CustomXml property in code behind.

protected void Page_Load(object sender, EventArgs e)

{

product1.CustomXml = "<banner>Save $$$ While Christmas
Shopping!</banner><specials><special><link>ProductDemo.aspx?id=1013</link><text>A great
gift for Dad!</text></special><special><link>ProductDemo.aspx?id=1015</link><text>A
great gift for Mom!</text></special></specials>";

}

Example of CustomXml XSLT Output
Below is an example of the XML sent to the XSLT file.

<root>

<customXml>

<banner>Save $$$ While Christmas Shopping!</banner>

<specials>
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<special>

<link>ProductDemo.aspx?id=1013</link>

<text>A great gift for Dad!</text>

</special>

<special>

<link>ProductDemo.aspx?id=1015</link>

<text>A great gift for Mom!</text>

</special>

</specials>

</customXml>

<otherTags>

 ... (for illustration only, there would be many other tags here)

</otherTags>

</root>

List of Server Controls
To customize your Ektron CMS400.NET application, use these server controls.

Server Control
Names

Description More Information

AnalyticsTracker Track statistics about visits to your Web site. AnalyticsTracker Server Control
on page 7-756

AssetControl
When viewed on aWeb form, displaysa drag and
drop box for users to upload assets to Ektron
CMS400.NET or update an existing asset.

AssetControlServer Controlon
page 7-466
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Server Control
Names

Description More Information

Blog

Ektron providesnine server controls that relate to
displaying a Blog on aWeb site. Theyare:

n The Blog server control

n The BlogCalendar server control

n The BlogCategories server control

n The BlogEntries server control

n The BlogPost server control

n The BlogRecentPost server control

n The BlogRoll server control

n The BlogRSS server control

n The BlogArchive server control

Introduction to Blog Server
Controlson page 7-507

BreadCrumb
Createsa breadcrumb trail of where site visitors
have been and allows them to navigate back to
previouspages.

BreadCrumbServer Controlon
page 9-283

For information on other
Breadcrumb types, see
FolderBreadcrumb Server
Controlon page 9-292 and
SiteMap Server Controlon page
9-296

BusinessRules Addsa BusinessRule created in the Ektron
CMS400.NETWorkarea to aWeb form.

BusinessRulesServer Controlon
page 13-12

Calendar Displaysan event calendar. WebCalendar Server Controlon
page 7-563
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Server Control
Names

Description More Information

Community
Platform

These controls enable you to build a community
site.

CommunityDocumentsServer
Controlon page 16-243

CommunityGroupBrowser
Server Controlon page 16-96

CommunityGroupList Server
Controlon page 16-101

CommunityGroupMembers
Server Controlon page 16-106

”CommunityGroupProfile Server
Control” on page 16-123

FavoritesServer Controlon
page 16-45

FriendsServer Controlon page
16-34

Invite Server Controlon page 16-
223

MessageBoard Server Control
on page 16-67

Messaging Server Controlon
page 16-226

PhotoGalleryServer Controlon
page 16-52

SocialBar Server Controlon
page 16-235

UserProfile Server Controlon
page 16-30

CommunitySearch Server
Controlon page 16-256

TagCloud Server Controlon
page 16-280

ActivityStreamServer Controlon
page 16-178

Micro-messaging Server Control
on page 16-184

ContentFlagging Server Control
on page 16-219

Collection Displays links generated by collections. Collection Server Controlon
page 9-122

ContentBlock Displaysandmanagesa content block. ContentBlockServer Controlon
page 7-194

ContentList Displaysa list of content blocks created from a
comma delimited list.

ContentList Server Controlon
page 7-202
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Server Control
Names

Description More Information

ContentRating

Place a rating scale on anypage of your Web site.
The scale letsEktron CMS400.NET collect
feedbackbygiving site visitors the opportunity to
rate a particular content item.

ContentRating Server Controlon
page 7-742

ContentReview

Placesa star based rating scale on anypage of
your Web site. This control can also be used to
retrieve and display visitor reviewsand
comments.

ContentReview Server Control
on page 7-732

DesignTime
Diagnostic

The DesignTimeDiagnostic server control is used
to verify the connection to Ektron’s server
controlsWeb service.

DesignTimeDiagnosticServer
Controlon page 24-49

DhtmlMenu Displaysa drop downmenuwith submenus. DhtmlMenu Server Controlon
page 9-194

Directory

The Directory server control lets you customize
the behavior of the Taxonomy feature. You place
this control on anyWeb form to display a
taxonomy.

DirectoryServer Controlon page
9-258

eCommerce
The eCommerce server controls allow you to set
up an onlinemarket place where site visitors can
purchasemerchandise, servicesor content.

Cart Server Controlon page 17-
8

Checkout Server Controlon
page 17-20

CurrencySelect Server Control
on page 17-60

MyAccount Server Controlon
page 17-206

OrderList Server Controlon
page 17-196

Product Server Controlon page
17-146

Product List Server Controlon
page 17-156

ProductSearch Server Control
on page 17-163

Recommendation Server
Controlon page 17-183

FlexMenu

The FlexMenu server control displaysamenu on
aWeb form. A FlexMenu createsXML, so, you
canmodify its behavior using an XSLT file, and
change its appearance using a cascading style
sheet (.css) file.

Flexible Menu Server Controlon
page 9-166
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Server Control
Names

Description More Information

FolderBreadcrumb FolderBreadcrumbsshow you the path through
the sitemap to the current page.

FolderBreadcrumb Server
Controlon page 9-292

For information on other
Breadcrumb types, see
BreadCrumbServer Controlon
page 9-283 andSiteMap Server
Controlon page 9-296

FormBlock Displaysa content block that is associated with a
form.

FormBlockServer Controlon
page 7-271

Forum

Forumsprovide a Discussion Board where topics
can be discussed on your Web site. There are
three server controls associated with Discussion
Boards. Theyare:

n The Forum server control

n The ActiveTopics server control

n The PostHistory server control

Discussion Board Server
Controlson page 7-639

ImageControl

Displaya CMS400.NET image on aWeb page.
In addition, if a user haspermission to edit the
image, he can right click the image and a drag
and drop boxappears. This boxallowsa user to
overwrite the existing file.

ImageControlServer Controlon
page 7-469

IndexSearch Perform XML index searcheson XML content.
(XML content is created using Smart Forms.)

IndexSearch Server Controlon
page 7-384

For information on searching
other content types, seeWeb
Search Server Controlon page
9-72

LanguageAPI Allowsdevelopers to force a language for aWeb
site.

LanguageAPI Server Controlon
page 14-44

LanguageSelect Lets user select language of site. LanguageSelect Server Control
on page 14-46

ListSummary Displaysa list of content block summaries. ListSummaryServer Controlon
page 9-266

Login Displays the login or logout button, which lets the
user log in and use Ektron CMS400.NET.

Login Server Controlon page 2-
10

Map
Displaysamap that flags locationsof interest to
your site visitors. Each location is a CMScontent
item to whichmap information wasadded.

MapServer Controlon page 7-
654
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Server Control
Names

Description More Information

Membership Createsa form for site visitors to add themselves
to your Membership users list.

Membership Server Controlon
page 16-19

Menu Calls a definedmenu to be used with an XSLT to
display themenu.

Menu Server Controlon page 9-
188

MetaData Addsmetadata contained in content blocks to a
Web page.

MetaData Server Controlon
page 7-165

MetaDataList Createsa list of content blocksbased on the
metadata contained in the content blocks.

MetaDataList Server Controlon
page 7-169

Personalization

Personalization server controls allow you to
create aWeb page that site users can
personalize. The following server controls allow
for personalization:

n EktronCatalogPart

n EktronCommunityCatalogPart

n EktronWebPartZone

n PersonalizationManager

Personalization Server Controls

Poll Displaysa poll or survey created from an Ektron
CMS400.NET form on aWeb page.

Poll Server Controlon page 7-
274

RssAggregator Aggregatesan RSS feed from anRSSWeb site. RssAggregator Server Control
on the facing page

Sitemap
The Sitemap server control utilizes the folder
breadcrumb information in theWorkarea to
display a sitemap of your site.

SiteMap Server Controlon page
9-296

For information on other
Breadcrumb types, see
BreadCrumbServer Controlon
page 9-283 and
FolderBreadcrumb Server
Controlon page 9-292

SmartMenu

The Smart Menu server control displaysamenu
on aWeb page. Thismenu style is themost
robust of the three delivered with Ektron
CMS400.NET.

Smart Menu Server Controlon
page 9-182

WebSearch TheWeb Search server control lets you
customize the behavior of the search.

WebSearch Server Controlon
page 9-72
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RssAggregator Server Control
An RSS Aggregator or reader takes an RSS feed and displays the information in
a readable format. The RssAggregator server control lets you do the same by
processing and displaying an RSS feed from any Web site. This allows you to
create an information Web page for news, stories, images, lists of music, or for
whatever purpose someone creates an RSS feed.

You can create a multi-level information Web page by using multiple
RssAggregator server controls on the same page. For example, you could
create a world news Web page by adding RSS feeds from the NY Times, The
BBC, and AFP (Agence France-Presse).

The process of adding an RSS Aggregator to your Web site is simple.

1. Choose a Web form where the RSS Aggregator will reside

2. Drag and drop the RssAggregator server control on that Web form

3. Set the URL property to point at the RSS feed. For example,
http://msdn.example.com/rss.xml

4. Save the Web form

When a visitor to your site views the Web form in a browser, he sees the RSS
feed displayed properly. When he refreshes the Web page, any information that
the RSS feed provider has updated is now reflected. See Also: Using the
RssAggregator Server Control on page 24-47

By creating a custom XSLT, you can change the way an RSS feed is viewed by
your site visitors.

This section also contains the following topics.

RSSAggregator Server Control Properties 24-45
Using the RssAggregator Server Control 24-47
Retrieving the XML Structure of an RssAggregator Control 24-48

RSSAggregator Server Control Properties
The RSSAggregator server control properties are described in this table.

Note: The following table only lists Ektron-specific properties. It does not describe native .NET
properties such as font, height, width and border style. For documentation of these properties,
see Visual Studio help.

Property Value Data Type

Authenticated
Indicates if you are logged in to the CMSExplorer and can use it
to browse to Content, Collections, etc.Using CMSExplorer to
Browse Your Ektron CMS400.NET Site on page 24-8

String
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Property Value Data Type

DisplayXslt

Determineshow the information on the page is displayed

None-databind only

ecmNavigation - lists the title of everyRSS feed item

Example of ecmNavigation Displayon page 9-127

ecmTeaser - lists a title and a description of everyRSS feed item

Example of ecmTeaser Displayon page 9-128

Path to Custom Xslt - Enter the path to an Xslt that determines
the display of the page

Warning! If you specify an external file, it is strongly
recommended that you do not store this file in your site's
Workarea folder. If you store this file in theWorkarea folder, the
file will be lost when you upgrade.

String

DoInitFill

By default, Fill occurs during the Page_Init event. Set to false if
you want to postpone the fill-action until later. In this case, FIll is
automatically called during the Page Render event.

Youmight do this if you need to set or change a property on the
control in codebehind and have it render with your changes
shown.

Boolean

Hide

Used to hide an RSSAggregator server control in design time
and run time.

True =HideMetadata server control

False =ShowMetadata server control

boolean

Language
Set a language for viewing the RssAggregator. This property
shows results in design-time (in VisualStudio) and at run-time (in
a browser).

Integer

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe loaded in a new
blankwindow. Thiswindow is not named.

_self - This target causes the link to always load in the same
window the anchor was clicked in. This is useful for overriding a
globally assigned base target.

_parent - This target makes the link load in the immediate
frameset parent of the document. This defaults to acting like “_
self” if the document hasno parent.

_top - This target makes the link load in the full bodyof the
window. This defaults to acting like “_self” if the document is
alreadyat the top. It is useful for breaking out of an arbitrarily
deep frame nesting.

ItemLinkTarget

MaxResults TheMaximum number of items from anRSS feed that are
returned (0=unlimited). Integer
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Property Value Data Type

SuppressWrapperTags

Suppresses the output of the span/div tagsaround the control.
The default isFalse.

True - Suppresswrap tags.

False - Allow wrap tags.

Boolean

URL
TheRSS feed path for the server control.

For example:
http://msdn.example.com/rss.xml

String

WrapTag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an inline portion of
an HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

Custom - Allowsyou to use a custom tag.

String

Using the RssAggregator Server Control
These steps show how to use the RssAggregator server control.

1. Drag an RssAggregator server control into a template.

2. Set the URL property with the path of the RSS feed you want to
display. This example use the following RSS feed:

http://ax-
.ph-
obos.apple.com.edgesuite.net/WebObjects/MZStore.woa/wpa/MRSS/topsongs/limit=10/rss.xml

This feed displays the top 10 songs according to the iTunes Music Store.

Note: In addition to the URL property, other Ektron properties are available to customize this
server control. For more information on these properties, see RSSAggregator Server Control
Properties on page 24-45

3. Build the Web form.

4. Browse to the Web page in your browser.
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5. The page appears with an RSS list of information.

Retrieving the XML Structure of an
RssAggregator Control
Retrieving the XML structure of XML content allows for greater control over
developing XSLs. The following is an example of how to retrieve the XML
structure:

1. Open a new Web form.

2. Drag and drop a RssAggregator server control onto it.

3. Set the URL property.

4. Drag and drop a Textbox on the Web form.

5. Set the TextMode property to MultiLine.

Note: It is also recommended that you set the width of the text box to at least 400px.

6. On the code behind page, add the following line.
Textbox1.Text = RssAggregator1.XmlDoc.InnerXml

7. Build the project.

8. View the Web form in a browser.

The XML structure of the RssAggregator Menu appears in the textbox.

For an additional example, see the RssAggregator XML page on the
CMS400Developer samples page. It is located at:

In a browser:

http://<site root>/CMS400Developer/Developer/RSS/RssAggregatorXML.aspx
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In the source code:

<site root>/CMS400Developer/Developer/RSS/RssAggregatorXML.aspx and
RssAggregatorXML.aspx.vb

DesignTimeDiagnostic Server Control
Warning! This control is for use in design-time only. Nothing is rendered at run-time.

The DesignTimeDiagnostic server control is used to verify the connection to
Ektron’s server controls Web service. When added to a Web form, this control
provides the following information:

n Web Service Path - displays the server control Web service path in
your web.config file.

n Web Service Exists - calls a method in the Web service that
returns True when the Web service exists. When it does not, it
returns False.

n Test Login Control - displays the Login server control to show that
the Web service is connected and working properly. When not
connecting properly, an error message is displayed.

Below is an example of the control on a page connected to the Web service.

Below is an example of the control on a page not connecting to the Web service.
Note that the path is not the correct path. It should be:
http://192.168.0.82/siteroot/Workarea/ServerControlWS.asmx

DesignTimeDiagnostic Server Control
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DesignTimeDiagnostic Server Control
Properties
The DesignTimeDiagnostic server control has no definable ektron properties.

Working with
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Learning About Visual Studio
This section provides background information about Microsoft’s Visual Studio.
For more information, use the help feature installed with Visual Studio and
Microsoft’s developer Center (http://msdn.microsoft.com/vstudio/).

Grid Layout vs. Flow Layout
Note: The following definitions are from Visual Studio Help:

Grid Layout - Absolute positioning attributes are inserted into elements that
are added, and updated in elements that are moved. Elements can be dragged
across the Design view surface. The positioning grid and Snap to Grid are
available.

Flow Layout - Elements are added without absolute positioning attributes.
Web browsers arrange elements in the order that they occur on the page, from
top to bottom. You cannot drag elements across the Design view surface or use
the positioning grid.

Grid layout is the default, which means that all controls drawn to the Web form
in the designer window will have absolute positioning. Here is an example.

<body MS_POSITIONING="GridLayout">

 <form id="Form1" method="post" runat="server">

 <asp:Button id="Button1" style="Z-INDEX: 101; LEFT: 160px; POSITION: absolute; TOP:
80px" runat="server" Text="Button"></asp:Button>

 <asp:Button id="Button2" style="Z-INDEX: 102; LEFT: 480px; POSITION: absolute; TOP:
88px" runat="server" Text="Button"></asp:Button>

 <asp:GridView id="GridView1" style="Z-INDEX: 103; LEFT: 208px; POSITION: absolute;
TOP: 152px" runat="server"></asp:GridView>

 </form>

</body>

In Grid layout, you can position your controls like a WYSIWYG editor with no
knowledge of HTML. However, because absolute positioning is not rendered
consistently by all browsers, the page layout can be flexible based on the size
of other controls on the page, and the Web browser window.

When other controls are dynamically populated, such as a GridView, controls
that appear beneath it in the Web form would be obscured if they were
positioned absolutely at design time. In addition, when utilizing globalization of
pages with different languages, the size of text areas can vary and cause
obstructions.

Learning About Visual Studio
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CMS Extensions are developer-defined software modules that modify the
behavior of the CMS.

In versions previous to Ektron CMS400.NET version 8.0, developers used the
Plug-in Extension Wizard to extend the system. As of version 8.0, CMS
Extensions are preferred over the Plug-in system.

The benefits of CMS Extensions include the following.

n You have full access to the Web application context, the HTTP
 context, the session information, data stored in cache, and the APIs.

n Extensions are easy to debug because you can attach and set
breakpoints the same way you debug Web applications.

n Performance is enhanced because no Web Services are required.

n No Windows Services are required because CMS extensions run
within the context of your Web application.

n Because extensions have access to the API, more functionality is
available, such as using the Notification system.

This section also contains the following topics.

Event Handlers 25-2
Using Visual Studio to Create a New CMS Extension 25-2
Register the New Extension in the ObjectFactory 25-5
More Information about ObjectFactory objectStrategies 25-6
Test the New Extension 25-6
More Examples of CMS Extensions 25-7

Event Handlers
An event handler is a method that executes when an event occurs within Ektron
CMS400.NET. Events are a type of activity that occurs in the CMS and are
exposed through the CMS Extension Framework.

Using Visual Studio to Create a New
CMS Extension
The following steps explain how to create a new CMS Extension in Visual Studio.

1. In Visual Studio, click File > New > Project...

2. The New Project screen appears.

Customizing CMS Behavior with Extensions
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3. Under Project Type, choose either Visual Basic or Visual C#.
(This example uses Visual C#.)

4. Under Templates, click Class Library.

5. Fill out the Name, Location and Solution Name text boxes.

6. Click OK.

7. The Class1.cs code page appears in the editor.

8. Add references to the following assemblies.

Ektron.CMS.Common
Ektron.CMS.ObjectFactory

Using Visual Studio to Create a New CMS
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You will find these in your <siteroot>/bin directory if they are not
already installed in your Visual Studio.

9. Add the following using statements to the top of the class.

using Ektron.Cms;
using Ektron.Cms.Common;
using Ektron.Cms.Extensibility;
using Ektron.Cms.Extensibility.Content;

10. Update the class to extend
Ektron.Cms.Extensibility.ContentStrategy.

namespace Cms.Extensions.Samples
{
public class ContentExtensionsSample : ContentStrategy

{
}

}

Note: The namespace in the code above is Cms.Extensions.Samples. This information is
needed for steps 12 below.

11. Override the method for the event you wish to catch. In this example,
override OnBeforeAddContent(). The code to modify the Title
looks like this.

public override void OnBeforeAddContent(ContentData contentData, CmsEventArgs
eventArgs)
{

contentData.Title += " modified";
}

12. This is what the final code looks like.

Customizing CMS Behavior with Extensions
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using System;
using System.Collections.Generic;
using System.Text;
using Ektron.Cms;
using Ektron.Cms.Common;
using Ektron.Cms.Extensibility;
using Ektron.Cms.Extensibility.Content;
namespace Cms.Extensions.Samples
{
public class ContentExtensionsSample : ContentStrategy

{
public override void OnBeforeAddContent(ContentData contentData,

CmsEventArgs eventArgs)
{
contentData.Title += " modifed";
}

}
}

13. Compile this assembly.

14. Copy the resulting dll into the <webroot>\bin directory.

Register the New Extension in the
ObjectFactory
After creating the extension in the steps above, register it in the
<webroot>/ObjectFactory.config file.

This file already contains GoogleGeoCoder objectStrategies, so you need to add
a new Name in the Content area.

In this example, the code looks like this.

<objectFactory>
<objectStrategies>

<add name="Content">
<strategies>

<add name="MyFirstExample"
type="Cms.Extensions.Samples.ContentExtensionsSample,
ContentExtensionsSample"/>

<add name="GoogleGeoCoder"
type="Cms.Extensions.GoogleGeoCoder.ContentStrategy,
Cms.Extensions.GoogleGeoCoder"/>

</strategies>
</add>
<add name="User">

<strategies>
<add name="GoogleGeoCoder"

type="Cms.Extensions.GoogleGeoCoder.UserStrategy,
Cms.Extensions.GoogleGeoCoder"/>

</strategies>
</add>

Register the New Extension in the ObjectFactory
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</objectStrategies>
</objectFactory>

More Information about ObjectFactory
objectStrategies
In order for the CMS to execute the CMS Extension properly, it must be
registered in the objectStrategies section of the ObjectFactory.config file found
in the Web site root.

The node <add name="Content"> tells the CMS that we are defining "Content"
extensions. This is required.

In the <strategies> section, one or more extensions can be added for content.

To add a strategy, you must define two properties: Name and Type.

n Name is any unique name which identifies the extension. See the list
of valid names in the table below.

n Type is a fully qualified name of the type you register as the
extension. It contains type name (the NameSpace + type) and the
assembly name of the type.

List of Valid Names

Inventory

Coupon

BasketCalculator

CouponCalculator

ShippingCalculator

TaxCalculator

Country

Region

Basket

Blog

Order

Customer

CatalogEntry

CommunityGroup

Tag

MessageBoard

MicroMessage

Content

Folder

User

Forum

WebEvent

Taxonomy

Test the New Extension
The new CMS extension created in the examples above modifies the title of a
new content item by adding "modified" to the end of the title. To test this,
create new content in the workarea. The new content title will have the word
"modified" appended to the end of it.
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More Examples of CMS Extensions
More examples of CMS Extensions are found in the SDK folder of the CMS. The
default location for this folder is : Program Files\Ektron\CMS400SDK\CMS
Extensions.
Also, samples of eCommerce extensions are found in Program
Files\Ektron\CMS400SDK\Commerce\Events.

Video Tutorial about CMS Extensions
To see more code samples and a video tutorial on CMS Extensions, visit the
Ektron Developer Center at this address:
http://dev.ektron.com/blogs.aspx?id=29648&blogid=68.

More Examples of CMS Extensions
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The Ektron Markup Language (EkML) makes it easy for web developers to
manage the output presentation of server controls. EkML uses a simple markup
that resembles HTML in syntax. The EkML is cached and .NET watches for file
changes.

The MarkupLanguage property in the Ektron server controls and Ektron
Dreamweaver functions is used to select the template file that contains the
Ektron Markup Language. This language is made up of tags and variables that
assign formatting information to a control or function when displayed on a Web
page.

Important: If the markup template file is located in the same folder as the form that contains the
server control, just type the file’s name in the server control’s MarkupLanguage property. For
example, mycollectionmarkup.ekml. If the file is in another folder, enter the path relative to
site root. For example,
\CMS400Developer\workarea\customfiles\markup\mycollectionmarkup.ekml.

This section also contains the following topics.

EkML Templates 26-2
EkML Example 26-3
EkML Tags 26-5
EkML Variables 26-5
EkML Template Examples 26-31

EkML Templates
Ektron, Inc. has provided an .ekml basic template for each control. These
templates are located in [webroot]/Workarea/Templates. At the top of each
template is a list of variables that can be used with that control.

Warning! Ektron strongly recommends that you save the template under another name and use
that template. This prevents your file from being overwritten when upgrades occur.

Note: If you install the CMS400Developer site, .ekml template files reside in various project
folders. These files exemplify using the .ekml with a specific server control.

The following server controls and Dreamweaver functions currently use the
Ektron Markup Language:

n Collection - collection.ekml on page 26-32

n ContentList - contentlist.ekml on page 26-36

n ListSummary - listsummary.ekml on page 26-38

n Map - map.ekml on page 26-42

n MessageBoard - messageboard.ekml on page 26-44

n MetadataList - metadatalist.ekml on page 26-57

n Taxonomy/Directory - taxonomy.ekml on page 26-59

n WebSearch - websearch.ekml on page 26-67
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EkML Example
By customizing the provided EkML templates, you can create a custom layout
for the content you are displaying. For example, if you have a Collection and
you want to display it as a numbered list containing a content’s hyperlink, the
date it was last updated and its summary, you would create the following .ekml
file and assign that file to a Collection server control’s MarkupLanguage
property.

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink] Updated:<i>[$DateModified]</i><br/>[$Teaser] <hr/>

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

Once the Collection is displayed, it is formatted as follows:

Because you can use HTML in the Ektron Markup Language, you can format the
variables using common HTML tags.

Let’s breakdown the example collection.ekml code found above.

n The <ekmarkup> tags open and close the markup language.
Everything to do with the EkML needs to be between these tags.

n The specific information you want displayed and any HTML
formatting are added between the <ekoutput> tags.

EkMLExample
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n <table width=”100%” border=”0”></table> sets up a table. This
is HTML formatting.

n The <ekrepeat> tags contain formatting information and variables
for items in the Collection. It repeats this information for each item in
the list.

n The [$Index] variable creates a numbered list for each content item
in the Collection. Note, you can add a period (.) or other separator
depending on how you want the list to look.

n The [$HyperLink] variable adds a hyperlink for each content item in
the Collection. The hyperlink use the content’s title as the text for the
link. There is no need for anchor tags, the variable creates them for
you. If you want to use anchor tags for formatting you own links, you
can use the [$QuickLink] variable.

n Updated: is plain text.

n The <i></i> tags are HTML that cause the [$DateModified] variable
to appear in italics.

n The [$DateModified] variable displays the date and time each
content item in the Collection was last modified.

Controlling Output with EktronMarkup Language
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n <br/> is HTML. It adds a line break.

n The [$Teaser] variable displays the summary for each content item
in the Collection.

n <hr/> is HTML. It adds a horizontal rule line.

EkML Tags
The EkML tags define functions that occur when using the language to display
content. The Ektron Markup Language includes the following tags.

EkML Tag Description

<ekmarkup> Use these tags to open and close the Ektron Markup Language.

<ekoutput>
Define what information is output from the server control between these
tags.

<ekrepeat>

These tags cause what ever formatting information that appears between
them to be applied to each item in the list.

They always appear between the <ekoutput> tags.

<ekbubbleinfo>

Creates a pop-up bubble. This tag is invoked when you use the
[$ShowBubble] or [$ShowBubble(width)] variables. By adding
different variables between the <ekbubbleinfo> tags, you define what
information appears in the bubble.

These tags are placed outside the <ekoutput> tags but within the
<ekmarkup> tags.

<ekcontentinfo>
Places the information defined between the tags in the specified HTML tag
ID. This tag is invoked when you use the
[$ShowContent(‘htmltagid’)] variable.

EkML Variables
The Ektron Markup Language uses variables that appear between the tags in a
template file to define the information that appears in a control’s display. Some
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variable are used in more than one template. These are known as common
EkML variables.

Another type of variable is a server control specific variable, these variables
can only be used with a specific server control. For example,
[$SearchSummary] can only be used in WebSearch.

EkML Variable List
Below is a list of EkML variables with a short description, a link to additional
information and whether the variable is common or specific.

Variable Description
Common or
Control Specific

[$AddCommentBox]

Displays the Add
Comment text box and button for a
message board.

More information:[$AddCommentBox] on
page 26-45

MessageBoard

[$AddArticle]

Adds a link that allows a logged in user
to add HTML content to Ektron
CMS400.NET.

More information: [$AddArticle] on page
26-65

Directory

[$AddAsset]

Adds a link that allows a logged in user
to add assets to Ektron CMS400.NET.

More information:[$AddAsset] on page
26-65

Directory

[$ApproveMessageLink]

Display an Approve link to approve
comments when message board
moderation is active.

More information:
[$ApproveMessageLink] on page 26-47

MessageBoard

[$Avatar]

Display the profile image of the member
who entered comments on a message
board.

More information: [$Avatar] on page 26-
48

MessageBoard
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Variable Description
Common or
Control Specific

[$CollectionDescription]

Display the collection’s description.

More information:
[$CollectionDescription] on page 26-34

Collection

[$CollectionTitle]

Display the collection’s title.

More information: [$CollectionTitle] on
page 26-35

Collection

[$Comment]

The content’s comment information is
displayed.

More information: [$Comment] on page
26-13

Common Except:
Map,
WebSearch and
Taxonomy

[$ContentByteSize]

Displays the content item’s size in KB.
Works only with taxonomy search.
<ekoutput mode=”article_search”>

[$ContentByteSize] on page 26-69

Directory

WebSearch

[$ContentId]

Displays the content item’s ID.

More information: [$ContentId] on page
26-14

Common Except:
Map

[$DateCreated]

Display the date the content was created.

More information: [$DateCreated] on
page 26-14

Common Except:
Map and
WebSearch

[$DateModified]

Display the date and time he content was
last modified.

More information: [$DateModified] on
page 26-15

Common Except:
Map

[$DeleteMessageLink]

Displays the Delete link for the comment
on a message board.

More information: [$DeleteMessageLink]
on page 26-49

MessageBoard

[$DisplayName]

Display the display name of the member
who left the message on the board.

More information: [$DisplayName] on
page 26-50

MessageBoard

EkMLVariable List
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Variable Description
Common or
Control Specific

[$EditorFirstName]

Display the last editor’s first name for a
content item.

More information: [$EditorFirstName] on
page 26-16

Common Except:
Map

[$EditorLastName]

Display the last editor’s last name for a
content item.

More information: [$EditorLastName] on
page 26-161

Common Except:
Map

[$EmailAddress]

Displays the email address of the
member.

More information: [$EmailAddress] on
page 26-51

MessageBoard

[$FirstName]

Display the first name of the person who
left the comment on a message board.

More information: [$FirstName] on page
26-52

MessageBoard

[$FolderDescription]

Displays the folder’s description.

More information: [$FolderDescription]
on page 26-40

ListSummary

[$FolderId]

Display the folder ID of a content item.

More information: [$FolderId] on page
26-17

Common Except:
Map and
WebSearch

[$FolderName]

Displays the folder’s name.

More information: [$FolderName] on
page 26-41

ListSummary

[$Html]

Display the HTML contained in the
content item.

More information: ”[$Html] on page 26-17

Common Except:
Map and
WebSearch

[$HyperLink]

Adds a hyperlink using the title of the
content block as the text.

More information:[$HyperLink] on page
26-18

Common Except:
Map and
WebSearch
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Variable Description
Common or
Control Specific

[$Image]

Displays the path for the image defined in a
content item’sMetadata.Whenwrapped in <img
src=””/> tag, the image is displayed. For
example:
<img src=”[$Image]”/>

More information: [$Image] on page 26-19

Common Except:
Map

[$ImageIcon]

Displays an image icon for the content
item. For example, if the content item is

HTML, the ( ) icon is displayed.

More information: [$ImageIcon] on page
26-19

Common Except:
Map

[$ImageThumbnail]

Displays the path for the image’s thumbnail
defined in a content item’sMetadata.When
wrapped in <img src=””/> tag, a thumbnail
version of the image is displayed. For example:
<img src=”[$ImageThumbnail]”/>

More information: [$ImageThumbnail] on page
26-20

Common Except:
Map

[$Index]

Serialize the content items in a
numbered list.

More information: [$Index] on page 26-20

Common Except:
Map and
WebSearch

[$ItemCount]

The total number of items in a list.

More information: [$ItemCount] on page
26-21

Common Except:
Map

[$Language]

Display the language ID for the content
item.

More information: [$Language] on page
26-21

Common Except:
Map and
WebSearch

[$LastName]

Display the last name of the person who
left the comment on a message board.

More information: [$LastName] on page
26-53]

MessageBoard

[$LinkTarget]

When added to an <a href=””> tag’s
target=”” attribute, this variable reads
the server control’s LinkTarget property
and uses its setting.

More information: [$LinkTarget] on page
26-21

Common Except:
Map

EkMLVariable List
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Variable Description
Common or
Control Specific

[$MessageText]

Displays the text of a message on a
message board.

More information: [$MessageText] on
page 26-54

MessageBoard

[$NumberComments]

Displays the number of comments posted
to a message board.

More information: [$NumberComments]
on page 26-55

MessageBoard

[$PagingCurrentEndIndex]

The end count number of the items on
the page. For example, if you are
displaying items 11 - 20 on a page, this
variable represents the number 20.
Works only with taxonomy search.
<ekoutput mode=”article_search”>

More information:
[$PagingCurrentEndIndex] on page 26-
70

Directory and

WebSearch

[$PagingCurrentStartIndex]

The numerical record of the first item on a
page. For example, if you are displaying
items 1 through 10 out of 50 total items
on a page, this variable represents the
number 1. Works only with taxonomy
search. <ekoutput mode=”article_
search”>

More information:
[$PagingCurrentStartIndex] on page 26-
71

Directory and

WebSearch

[$QuickLink]

This property displays the Quicklink
information for the content item. When
wrapped in an <a href=””> tag, you
can create a Hyperlink.

More information:[$QuickLink] on page
26-21

Common Except:
Map

[$SearchDuration]

Displays the amount of time, in seconds,
it has taken to execute the search. Works
only with taxonomy search. <ekoutput
mode=”article_search”>

More information:[$SearchDuration] on
page 26-72

Directory and

WebSearch
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Variable Description
Common or
Control Specific

[$SearchSummary]

Creates a summary from information
stored in the indexing service for each
item in the search results. Works only
with taxonomy search. <ekoutput
mode=”article_search”>

More information:[$SearchSummary] on
page 26-69

Directory and

WebSearch

[$SearchText]

Displays the text for which a user is
searching. This information is same as
what a user entered in the search text
box. Works only with taxonomy search.
<ekoutput mode=”article_search”>

More information: [$SearchText] on page
26-71

Directory and

WebSearch

[$SERVER_NAME]

Displays the server name. For example, If
this variable is applied to
http://www.example.com/demo.aspx
, the return is www.example.com.

More information: [$SERVER_NAME] on
page 26-23

Common Except:
Map and
WebSearch

[$ShortDateModified]

Displays the date the content was
modified. To display the date and time a
content item was updated, use
[$DateModified] on page 26-15

More information: [$ShortDateModified]
on page 26-23

WebSearch

[$ShowAllcategory]

Adds to the Taxonomy search screen a
checkbox that lets the user decide if he
wants to display categories that have no
items.

More information: [$ShowAllcategory] on
page 26-24

Directory
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Variable Description
Common or
Control Specific

[$ShowBubble(width)]

This is similar to [$ShowBubble]. It calls
the <ekbubbleinfo> tags and allows
you to set the width and height of the
bubble. For example,
[$ShowBubble(300,400)]. The first
number represents the width. The
second number represents the height.

More information:
[$ShowBubble(width,height)] on page
26-25

Common Except:
Map and
WebSearch

[$ShowBubble]

Calls the <ekbubbleinfo> tags and
places the information contained within
those tags in a pop-up bubble.

[$ShowBubble] on page 26-24

Common Except:
Map and
WebSearch

[$ShowContent(‘htmltagid’)]

Calls the <ekcontentinfo> tags an
places the information in those tags
within the specified HTML tag ID.
Replace the htmltagid with the ID of the
tag.

[$ShowContent(‘htmltagid’)] on page 26-
26

Common Except:
Map and
WebSearch

[$Status]
Displays the status of a content item.

[$Status] on page 26-27

Common Except:
Map and
WebSearch

[$Teaser]

Display the content item’s summary
information.

Note: If the item is an HTML form, this
variable isnot supported with this ekml file.

[$Teaser] on page 26-27

Common Except:
Map and
WebSearch

[$TemplateQuickLink]

This property displays the Template
Quicklink information assigned to the
taxonomy item in the Workarea. When
wrapped in an <a href=””> tag, you
can create a Hyperlink.

See Also: Applying a Template to a
Taxonomy or Category on page 9-209

More information : [$TemplateQuickLink]
on page 26-66

Directory
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Variable Description
Common or
Control Specific

[$Title]
Displays the content item’s title.

[$Title] on page 26-28

Common Except:
Map

[$UrlEncode(‘str’)]

Encodes the string information. Replace
str with the string you want to encode.
This variable can be used to encode
another EkML variable and place it in an
email.

[$UrlEncode(‘str’)] on page 26-30

Common Except:
Map and
WebSearch

[$UrlParam(‘paramname’)]

Displays the value of a query string’s
given parameter. For example, if the
query string is ?id=27 and the variable is
[$UrlParam(‘id’)], 27 is displayed.

[$UrlParam(‘paramname’)] on page 26-
29

Common Except:
Map and
WebSearch

[$UserName]

Display the Username of user who left a
comment on a message board.

[$UserName] on page 26-56

MessageBoard

[$Comment]
The content’s comment information is displayed. Comment information can be
added in the Workarea via the content item’s Comment tab.

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Comment]
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[$Index]. [$HyperLink] <br/> [$Comment]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$ContentId]
Displays the content item’s ID.

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink] Content ID = [$ContentId]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$DateCreated]
Display the date the content was created.
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<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink] - <i>[$DateCreated]</i>

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$DateModified]
Display the date and time the content was last modified. To display the date
only, use [$ShortDateModified] on page 26-23].

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

[$DateModified]
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<tr>

<td>

[$Index]. [$HyperLink] <br/>Date Modified: <b>[$DateModified]</b>

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$EditorFirstName]
Display the last editor’s first name for a content item.

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink] Last Editor: [$EditorFirstName]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$EditorLastName]
Display the last editor’s last name for a content item.
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<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink] Last Editor: [$EditorLastName]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$FolderId]
Display the folder ID of a content item.

[$Html]
Display the HTML contained in the content item. In the server control, the
control’s GetHTML property must be set to True; otherwise nothing is
displayed. The exception to this is when the [$Html] appears between the
<ekbubbleinfo> tags. In that case, the GetHTML property can be set to True or
False.

[$FolderId]
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<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$HyperLink]<br/>[$Html]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$HyperLink]
Adds a hyperlink using the title of the content block as the text. You do not add
an <a href=””> tag when using this variable. That functionality is built into the
EkML. Use this variable when you do not want to create a custom hyperlink. If
you want to create a custom hyperlink, use the [$QuickLink] variable. See
Also: [$QuickLink] on page 26-21

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink]

</td>

</tr>

</ekrepeat>
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</table>

</ekoutput>

</ekmarkup>

[$Image]
Displays the path for the image defined in a content item’s Metadata. When
wrapped in <img src=””/> tag, the image is displayed. For example, <img
src=”[$Image]”/>.

An example of using this variable is on the developer sample page > List
Summary > Flash news. That sample (flashnews.aspx) refers to
flashnews.ekml, which illustrates using this variable.

[$ImageIcon]
Displays an image icon for the content item. Except for HTML content, these
icons are the same icons used in the Workarea to show the content type. HTML
content uses the Internet Explorer icon ( ). For example, Forms use the Form
icon ( ).

When using this variable with the server control, the IncludeIcons property is
automatically set to True.

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink] [$ImageIcon]

</td>

</tr>

</ekrepeat>

</table>

[$Image]
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</ekoutput>

</ekmarkup>

[$ImageThumbnail]
Displays the path for the image’s thumbnail defined in a content item’s
Metadata. When wrapped in <img src=””/> tag, the image thumbnail is
displayed. For example, <img src=”[$ImageThumbnail]”/>.

An example of using this variable is on the developer sample page > List
Summary > Flash news. That sample (flashnews.aspx) refers to
flashnews.ekml, which illustrates using this variable.

[$Index]
Serialize the content items in a numbered list.

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink] [$ImageIcon]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>
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[$ItemCount]
The total number of items in a list. In the server control, the EnablePaging
property must be set to True; otherwise nothing is displayed

[$Language]
Display the language ID for the content item.

[$LinkTarget]
When added to an <a href=””> tag’s target=”” attribute, this variable reads
the server control’s LinkTarget property and uses its setting. For example, If
you want to create a custom hyperlink that opens in a new window, you set the
server control’s LinkTarget property to _Blank. Then, in the Ektron Markup
Language file, add the [$LinkTarget] variable to the <a href=””> tag’s
Taget=”” attribute. A code example appears below.

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

<a href=”[$QuickLink]” target=”[$LinkTarget]”>[$Title]</a>

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$QuickLink]
This property displays the Quicklink information for the content item. When
wrapped in an <a href=””> tag, you can create a Hyperlink. Use this property
instead of the [$HyperLink] if you want to customize your hyperlinks. See
Also: [$HyperLink] on page 26-18

The first image shows the variable displaying the Quicklink information. The
second image shows the Quicklink as a Hyperlink with a custom text.

[$ItemCount]
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<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$QuickLink]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. <a href="[$QuickLink]">Click Here For Item #[$Index]</a>

</td>
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</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$SERVER_NAME]
Displays the server name for the page on which this variable appears. For
example, If this variable is applied to
http://www.example.com/demo.aspx, the return is www.example.com.

[$ShortDateModified]
Display the date the content was last modified. The variable show the date
only. To show the Date and Time, use the [$DateModified] on page 26-15]
variable.

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink] <br/>Date Modified: <b>[$ShortDateModified]</b>

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$SERVER_NAME]
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[$ShowAllcategory]
If a Directory server control’s EnableSearch property is set to true, this
variable adds the checkbox circled below to the right of the search field.

By default, the Directory server control only shows categories to which at least
one content block is assigned. If you check this box, all categories appear, even
those with no content assigned.

[$ShowBubble]
Calls the <ekbubbleinfo> tags and places the information contained within
those tags in a pop-up bubble. This bubble is typically assigned to the onclick
or onmouseover attribute in an <a href=””> tag. See the example EkML code
below.

<ekmarkup>

<ekbubbleinfo>

<table border="0">

<tr>

<td>[$Html]</td>

</tr>

</table>

</ekbubbleinfo>

<ekoutput>
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<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index].<a href="#" onmouseover="[$ShowBubble]">[$Title]</a>

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$ShowBubble(width,height)]
This is similar to [$ShowBubble]. It calls the <ekbubbleinfo> tags and places
the information contained within those tags in a pop-up bubble. This variable
allows you to set the width and height of the bubble. For example,
[$ShowBubble(300,400). In this example, the first number represents the
width. The second number represents the height.

If you enter a single number, it sets the width. The height of the bubble is then
limited to the length of the content. For example, if you had a video that was
formatted at 200 pixels wide and you wanted to launch it in a bubble, you would
add the function as [$ShowBubble(200)].

The minimum width for a bubble is 287. The minimum height is 101.

<ekmarkup>

<ekbubbleinfo>

<table border="0">

<tr>

<td>[$Html]</td>

</tr>

</table>

</ekbubbleinfo>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$ShowBubble(width,height)]
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[$Index].<a href="#" onmouseover="[$ShowBubble(200)]">[$Title]</a>

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$ShowContent(‘htmltagid’)]
Calls the <ekcontentinfo> tags and places the information contained within
those tags in the specified HTML tag ID. Replace the htmltagid with the ID of the
tag. This tag is typically assigned to the onclick or onmouseover attribute in an
<a href=””> tag. See the example EkML code below.

<ekmarkup>

<ekcontentinfo>

<table border="0">

<tr>

<td>[$Html]</td>

</tr>

</table>

</ekcontentinfo>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index].<a href="#" onmouseover="[$ShowContent(‘contarea’)]">[$Title]</a>

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

Controlling Output with EktronMarkup Language

26-26 ReferenceManual
Version 8.01 Rev 4



[$Status]
Displays the status of a content item. For example, Approved, Checked in, or
Submitted for Approval. For additional information, see Content Statuses on
page 7-130.

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$Hyperlink]

The content status is <i>[$Status]</i>

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$Teaser]
Display the content item’s summary information. Summary information is
added to content in the Workarea via the Summary tab. A code example
appears below.

<ekmarkup>

[$Status]
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<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink] <br/> [$Teaser]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$Title]
Displays the content item’s title. Use this variable if you want to display the title
as normal text. If you want to display the title as a hyperlink, use
[$HyperLink].See Also: [$HyperLink] on page 26-18. If you want to create a
custom hyperlink with the title as the text of the hyperlink, use this property in
conjunction with the <a href=””> tag and the [$QuickLink] variable. See
Also: [$QuickLink] on page 26-21.
<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. <a href="[$QuickLink]">[$Title]</a>

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>
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[$UrlParam(‘paramname’)]
Displays the value of a query string’s parameter. For example, if you have a
collection and want to display its ID, add the [$UrlParam(‘coll_id’)] where you
want the collection’s ID to appear.

<ekmarkup>

<ekbubbleinfo>

<table border="0">

<tr>

<td>[$Html]</td>

</tr>

</table>

</ekbubbleinfo>

<ekoutput>

<table width="100%" border="0">

<tr>

<td>

<b>This Collection's ID is: [$UrlParam('coll_id')]</b>

<br/><hr/>

</td>

</tr>

<ekrepeat>

<tr>

[$UrlParam(‘paramname’)]
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<td>

[$Index].<a href="#" onclick="[$ShowBubble]">[$Title]</a>[$Teaser]<hr/>

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$UrlEncode(‘str’)]
Encodes the string information in the variable. This variable can be used to
encode another EkML variable and place it in an email. For example, You want
the title of the content block to appear as the subject of an email. A code
example appears below.

<ekcontentinfo>

<table border="0">

<tr>

<td>

<strong>Title:&#160;</strong>

<span style="color:red;">[$Title]</span>

<a href="mailto:?subject=[$UrlEncode('[$Title]')]&body=http://[$SERVER_
NAME]/CMS400Developer/wiki.aspx?id=[$ContentId]">&nbsp;<img
src="WorkArea/images/application/icon_email.gif" align="absmiddle" alt="[$Title]"
border="0"/></a>

<hr />

</td>

</tr>
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<tr>

<td>[$Html]</td>

</tr>

</table>

</ekcontentinfo>

EkML Template Examples
This section also contains the following topics.

collection.ekml 26-32
collection.ekml Variables 26-32
[$CollectionDescription] 26-34
[$CollectionTitle] 26-35
contentlist.ekml 26-36
contentlist.ekml Variables 26-36
listsummary.ekml 26-38
ListSummary.ekml Variables 26-38
[$FolderDescription] 26-40
[$FolderName] 26-41
map.ekml 26-42
__Map 26-43
Search Txt Result Pane 26-43
__RouteInfoPane 26-44
messageboard.ekml 26-44
messageboard.ekml Variables 26-44
[$AddCommentBox] 26-45
[$ApproveMessageLink] 26-47
[$Avatar] 26-48
[$DeleteMessageLink] 26-49
[$DisplayName] 26-50
[$EmailAddress] 26-51
[$FirstName] 26-52
[$LastName] 26-53
[$MessageText] 26-54
[$NumberComments] 26-55
[$UserName] 26-56
metadatalist.ekml 26-57
metadatlist.ekml Variables 26-57
taxonomy.ekml 26-59
Taxonomy <ekoutput> modes 26-60
taxonomy.ekml Variables 26-61
[$AddArticle] 26-65
[$AddAsset] 26-65
[$TemplateQuickLink] 26-66
[$categorybacklink] 26-66
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websearch.ekml 26-67
websearch.ekml Variables 26-67
[$SearchSummary] 26-69
[$ContentByteSize] 26-69
[$PagingCurrentEndIndex] 26-70
[$ItemCount] 26-70
[$SearchText] 26-71
[$PagingCurrentStartIndex] 26-71
[$SearchDuration] 26-72

collection.ekml
This file defines which items and information are included when displaying
content item information in a collection using the Collection server control. For
an example of using this file with a Collection server control, see the CMS400
demo example: http://your
site/siteroot/Developer/Collection/TemplateMarkup.aspx.

collection.ekml Variables
Below is a list of variables used with the collection.ekml file.

Variable Description More Information

[$CollectionDescription]
Display the collection’s
description.

[$CollectionDescription] on
page 26-34

[$CollectionTitle] Display the collection’s title.
[$CollectionTitle] on page
26-35

[$Comment]
The content’s comment information is
displayed.

[$Comment] on page 26-13

[$ContentId] Displays the content item’s ID. [$ContentId] on page 26-14

[$DateCreated] Display the date the content was created.
[$DateCreated] on page 26-
14

[$DateModified]
Display the date the content was last
modified.

[$DateModified] on page 26-
15

[$EditorFirstName]
Display the last editor’s first name for a
content item.

[$EditorFirstName] on page
26-16

[$EditorLastName]
Display the last editor’s last name for a
content item.

[$EditorLastName] on page
26-16
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Variable Description More Information

[$FolderId] Display the folder ID of a content item. [$FolderId] on page 26-17

[$Html]
Display the HTML contained in the
content item.

[$Html] on page 26-17

[$HyperLink]
Adds a hyperlink using the title of the
content block as the text.

[$HyperLink] on page 26-18

[$Image]

Displays the path for the image defined in a
content item’sMetadata.Whenwrapped in <img
src=””/> tag, the image is displayed. For
example: <img src=”[$Image]”/>

[$Image] on page 26-19

[$ImageIcon]
Displays an image icon for the content
item. For example, if the content item is

HTML, the ( ) icon is displayed.
[$ImageIcon] on page 26-19

[$ImageThumbnail]

Displays the path for the image’s thumbnail
defined in a content item’sMetadata.When
wrapped in <img src=””/> tag, a thumbnail
version of the image is displayed. For example:
<img src=”[$ImageThumbnail]”/>

[$ImageThumbnail] on page
26-20

[$Index]
Serialize the content items in a
numbered list.

[$Index] on page 26-20

[$ItemCount] The total number of items in a list. [$ItemCount] on page 26-21

[$Language]
Display the language ID for the content
item.

[$Language] on page 26-21

[$LinkTarget]

When added to an <a href=””> tag’s
target=”” attribute, this variable reads
the server control’s LinkTarget property
and uses its setting.

[$LinkTarget] on page 26-21

[$QuickLink]

This property displays the Quicklink
information for the content item. When
wrapped in an <a href=””> tag, you
can create a Hyperlink.

[$QuickLink] on page 26-21

[$SERVER_NAME]

Displays the server name. For example, If
this variable is applied to
http://www.example.com/demo.aspx
, the return is www.example.com.

[$SERVER_NAME] on page
26-23

[$ShowBubble(width)]
This is similar to [$ShowBubble]. It calls
the <ekbubbleinfo> tags and allows
you to set the width of the bubble.

[$ShowBubble(width,height)]
on page 26-25
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Variable Description More Information

[$ShowBubble]
Calls the <ekbubbleinfo> tags and
places the information contained within
those tags in a pop-up bubble.

[$ShowBubble] on page 26-
24

[$ShowContent(‘htmltagid’)]

Calls the <ekcontentinfo> tags an places
the information in those tags within the
specified HTML tag ID. Replace the
'htmltagid' with the ID of the tag.

[$ShowContent(‘htmltagid’)]
on page 26-26

[$Status] Displays the status of a content item. [$Status] on page 26-27

[$Teaser]

Display the content item’s summary
information.

Note: If the item is an HTML form, this
variable isnot supported with this ekml file.

[$Teaser] on page 26-27

[$Title] Displays the content item’s title. [$Title] on page 26-28

[$UrlEncode(‘str’)]
Encodes the string information. This
variable can be used to encode another
EkML variable and place it in an email.

[$UrlEncode(‘str’)] on page
26-30

[$UrlParam(‘paramname’)]

Displays the value of a query string’s
parameter. For example, if the query
string is ?id=27 and the variable is
[$UrlParam(‘id’)], 27 is displayed.

[$UrlParam(‘paramname’)]
on page 26-29

[$CollectionDescription]
Display the collection’s description.

<ekmarkup>

<ekoutput>

<h3><b>[$CollectionTitle]</b></h3><p/>[$CollectionDescription]<br/>

<table width="100%" border="0">
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<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$CollectionTitle]
Display the collection’s title.

<ekmarkup>

<ekoutput>

<h3><b>[$CollectionTitle]</b></h3>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$CollectionTitle]
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contentlist.ekml
This file defines which items and information are included when displaying
content item information in a content list using the ContentList server control.

contentlist.ekml Variables
Below is a list of variables used with the contentlist.ekml file.

Variable Description More Information

[$Comment] The content’s comment information is displayed. [$Comment] on page 26-13

[$ContentId] Displays the content item’s ID. [$ContentId] on page 26-14

[$DateCreated] Display the date the content was created.
[$DateCreated] on page 26-
14

[$DateModified] Display the date the content was last modified.
[$DateModified] on page 26-
15

[$EditorFirstName] Display the last editor’s first name for a content item.
[$EditorFirstName] on page
26-16

[$EditorLastName] Display the last editor’s last name for a content item.
[$EditorLastName] on page
26-16

[$FolderId] Display the folder ID of a content item. [$FolderId] on page 26-17

[$Html] Display the HTML contained in the content item. [$Html] on page 26-17

[$HyperLink]
Adds a hyperlink using the title of the content block
as the text.

[$HyperLink] on page 26-18

[$Image]

Displays the path for the image
defined in a content item’s Metadata. When wrapped
in <img src=””/> tag, the image is displayed. For
example:

<img src=”[$Image]”/>

[$Image] on page 26-19

[$ImageIcon]
Displays an image icon for the content item. For

example, if the content item is HTML, the ( ) icon is
displayed.

[$ImageIcon] on page 26-19
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Variable Description More Information

[$ImageThumbnail]

Displays the path for the image’s thumbnail defined
in a content item’s Metadata. When wrapped in <img
src=””/> tag, a thumbnail version of the image is
displayed. For example:

<img src=”[$ImageThumbnail]”/>

[$ImageThumbnail] on page
26-20

[$Index] Serialize the content items in a numbered list. [$Index] on page 26-20

[$ItemCount] The total number of items in a list. [$ItemCount] on page 26-21

[$Language] Display the language ID for the content item. [$Language] on page 26-21

[$LinkTarget]
When added to an <a href=””> tag’s target=””
attribute, this variable reads the server control’s
LinkTarget property and uses its setting.

[$LinkTarget] on page 26-21

[$QuickLink]
This property displays the Quicklink information for
the content item. When wrapped in an <a href=””>
tag, you can create a Hyperlink.

[$QuickLink] on page 26-21

[$SERVER_NAME]

Displays the server name. For example, If this
variable is applied to
http://www.example.com/demo.aspx, the return
is www.example.com.

[$SERVER_NAME] on page
26-23

[$ShowBubble(width)]
This is similar to [$ShowBubble]. It calls the
<ekbubbleinfo> tags and allows you to set the
width of the bubble.

[$ShowBubble(width,height)]
on page 26-25

[$ShowBubble]
Calls the <ekbubbleinfo> tags and places the
information contained within those tags in a pop-up
bubble.

[$ShowBubble] on page 26-
24

[$ShowContent(‘htmltagid’)]
Calls the <ekcontentinfo> tags an places the
information in those tags within the specified HTML
tag ID. Replace the 'htmltagid' with the ID of the tag.

[$ShowContent(‘htmltagid’)]
on page 26-26

[$Status] Displays the status of a content item. [$Status] on page 26-27

[$Teaser]

Display the content item’s summary information.

Note: If the item is an HTML form, this variable isnot
supported with this ekml file.

[$Teaser] on page 26-27

[$Title] Displays the content item’s title. [$Title] on page 26-28
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Variable Description More Information

[$UrlEncode(‘str’)]
Encodes the string information. This variable can be
used to encode another EkML variable and place it
in an email.

[$UrlEncode(‘str’)] on page
26-30

[$UrlParam(‘paramname’)]
Displays the value of a QueryString’s parameter. For
example, if the QueryString is ?id=27 and the
variable is [$UrlParam(‘id’)], 27 is displayed.

[$UrlParam(‘paramname’)]
on page 26-29

listsummary.ekml
This file defines which items and information are included when displaying
content item information in a list summary using the ListSummary server
control. For an example of using this file with a ListSummary server control,
see the CMS400 demo example: http://<your
site>/CMS400Developer/Developer/ListSummary/TemplateMarkup.aspx.

ListSummary.ekml Variables
Below is a list of variables used with the listsummary.ekml file.

Variable Description More Information

[$Comment]
The content’s comment
information
is displayed.

[$Comment] on page 26-13

[$ContentId] Displays the content item’s ID. [$ContentId] on page 26-14

[$DateCreated] Display the date the content was created.
[$DateCreated] on page 26-
14

[$DateModified]
Display the date the content was last
modified.

[$DateModified] on page 26-
15

[$EditorFirstName]
Display the last editor’s first name for a
content item.

[$EditorFirstName] on page
26-16

[$EditorLastName]
Display the last editor’s last name for a
content item.

[$EditorLastName] on page
26-16

[$FolderDescription] Displays the folder’s description.
[$FolderDescription] on
page 26-40

[$FolderId] Display the folder ID of a content item. [$FolderId] on page 26-17
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Variable Description More Information

[$FolderName] Displays the folder’s name.
[$FolderName] on page 26-
41

[$Html]
Display the HTML contained in the
content item.

[$Html] on page 26-17

[$HyperLink]
Adds a hyperlink using the title of the
content block as the text.

[$HyperLink] on page 26-18

[$Image]

Displays the path for the image defined in a
content item’sMetadata.Whenwrapped in <img
src=””/> tag, the image is displayed
For example: <img src=”[$Image]”/>

[$Image] on page 26-19

[$ImageIcon]
Displays an image icon for the content
item. For example, if the content item is

HTML, the ( ) icon is displayed.
[$ImageIcon] on page 26-19

[$ImageThumbnail]

Displays the path for the image’s thumbnail
defined in a content item’sMetadata.When
wrapped in <img src=””/> tag, a thumbnail
version of the image is displayed. For example:
<img src=”[$ImageThumbnail]”/>

[$ImageThumbnail] on page
26-20

[$Index]
Serialize the content items in a
numbered list.

[$Index] on page 26-20

[$ItemCount] The total number of items in a list. [$ItemCount] on page 26-21

[$Language]
Display the language ID for the content
item.

[$Language] on page 26-21

[$LinkTarget]

When added to an <a href=””> tag’s
target=”” attribute, this variable reads
the server control’s LinkTarget property
and uses its setting.

[$LinkTarget] on page 26-21

[$QuickLink]

This property displays the Quicklink
information for the content item. When
wrapped in an <a href=””> tag, you
can create a Hyperlink.

[$QuickLink] on page 26-21

[$SERVER_NAME]

Displays the server name. For example, If
this variable is applied to
http://www.example.com/demo.aspx
, the return is www.example.com.

[$SERVER_NAME] on page
26-23
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Variable Description More Information

[$ShowBubble(width)]
This is similar to [$ShowBubble]. It calls
the <ekbubbleinfo> tags and allows
you to set the width of the bubble.

[$ShowBubble(width,height)]
on page 26-25

[$ShowBubble]
Calls the <ekbubbleinfo> tags and
places the information contained within
those tags in a pop-up bubble.

[$ShowBubble] on page 26-
24

[$ShowContent(‘htmltagid’)]

Calls the <ekcontentinfo> tags an places
the information in those tags within the
specified HTML tag ID. Replace the
'htmltagid' with the ID of the tag.

[$ShowContent(‘htmltagid’)]
on page 26-26

[$Status] Displays the status of a content item. [$Status] on page 26-27

[$Teaser]

Displays the content item’s summary
information.

Note: If the item is an HTML form, this
variable isnot supported with this ekml file.

[$Teaser] on page 26-27

[$Title] Displays the content item’s title. [$Title] on page 26-28

[$UrlEncode(‘str’)]
Encodes the string information. This
variable can be used to encode another
EkML variable and place it in an email.

[$UrlEncode(‘str’)] on page
26-30

[$UrlParam(‘paramname’)]

Displays the value of a QueryString’s
parameter. For example, if the
QueryString is ?id=27 and the variable
is [$UrlParam(‘id’)], 27 is displayed.

[$UrlParam(‘paramname’)]
on page 26-29

[$FolderDescription]
Displays the folder’s description.

<ekmarkup>

<ekoutput>
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<h3><b>[$FolderName]</b></h3><p/>[$FolderDescription]<br/>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$FolderName]
Displays the folder’s name.

<ekmarkup>

<ekoutput>

<h3><b>[$FolderName]</b></h3><p/>[$FolderDescription]<br/>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

[$Index]. [$HyperLink]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

[$FolderName]
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</ekmarkup>

map.ekml
The map.ekml file defines which items and information are included when using
the Map server control. Unlike most other .ekml files, the map.emkl has some
variables that cannot be changed or moved around.

The file’s variables appear in three <tr></tr> table rows. These rows are
located below the main table. In the first two table rows, you can modify a tag’s
style information only. In the third, you can change the style information and
the order of the variables to create different layouts for your page. It is
recommended you hide the first two table rows if you are not changing their
style information. For example:

When using the map.ekml file remember these three rules.

1. Do not change any of the IDs.

2. You can change any tag’s style information.

3. You can move the variables in the third table row around to create
different layouts. For example, you can display these sections
horizontally or vertically.

Variable Description More Information

__Map
Displays the map section of the
Map server control.

__Map on the facing page

__
SearchTxtResultPane

Displays the results pane from the
search.

Search Txt Result Pane on
the facing page
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Variable Description More Information

__RouteInfoPane
Displays the direction information
pane.

__RouteInfoPane on next
page

__Map
Displays the map section of the Map server control.

Search Txt Result Pane
Displays the results pane from the search.

__Map
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__RouteInfoPane
The panel that displays driving directions from the starting address to the
arrival address.

messageboard.ekml
This file defines which items and information are included when displaying
message information for a message board using the MessageBoard server
control.

messageboard.ekml Variables
Below is a list of variables used with the metadatalist.ekml file.
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Variable Description More Information

[$AddCommentBox]
Displays the Add Comment text box and
button for a message board.

[$AddCommentBox]
below

[$ApproveMessageLink]
Display an Approve link to approve
comments when message board moderation
is active.

[$ApproveMessageLink]
on page 26-47

[$Avatar]
Display the profile image of the member who
entered the comments on the message
board.

[$Avatar] on page 26-48

[$DateCreated] Display the date the content was created.
[$DateCreated] on page
26-14

[$DateModified]
Display the date the content was last
modified.

[$DateModified] on
page 26-15

[$DeleteMessageLink]

Displays the Delete link for a comment on the
message board. Only Administrators, the
person who left the message or the person
who owns the board.

[$DeleteMessageLink]
on page 26-49

[$DisplayName]
Displays the display name of the member
who left the message.

[$DisplayName] on
page 26-50

[$EmailAddress] Displays the email addressof themember who left
themessage on the board.

[$EmailAddress] on
page 26-51

[$FirstName]
Display the first name of the person who left
the comment on the message board.

[$FirstName] on page
26-52

[$LastName]
Display the last name of the person who left
the comment on the message board.

[$LastName] on page
26-53

[$MessageText] Displays the message on a message board.
[$MessageText] on
page 26-54

[$NumberComments]
Displays the number of comments posted to
a message board.

[$NumberComments]
on page 26-55

[$UserName]
Display the Username of a user who left a
comment on a message board.

[$UserName] on page
26-56

[$AddCommentBox]
Displays the Add Comment text box and button for a message board.

[$AddCommentBox]
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<ekoutput>

<div class="ContributionForm">

<h4>[$NumberComments] Comments</h4>

<ul>

<ekrepeat>

<li class="ekMessagePost">

<div class="avatar">[$Avatar]</div>

<div class="message">

<div class="metaData">

<span class="username">[$UserName]</span>

<span class="time">[$DateCreated]</span>

</div>

<p class="Body">[$MessageText]</p>

<ul class="commands">

<li class="ekDeleteMessage">[$DeleteMessageLink]</li>

<li class="ekApproveMessage">[$ApproveMessageLink]</li>

</ul>

</div>

</li>

</ekrepeat>

</ul>

[$AddCommentBox]

</div>
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</ekoutput>

[$ApproveMessageLink]
Displays the Approve link for the message. This link is used to approve the
message for display when the Moderate property is set to true. Only
Administrators, the person who left the message, or the person who owns the
board can see this link.

<ekoutput>

<div class="ContributionForm">

<h4>[$NumberComments] Comments</h4>

<ul>

<ekrepeat>

<li class="ekMessagePost">

<div class="avatar">[$Avatar]</div>

<div class="message">

<div class="metaData">

<span class="username">[$UserName]</span>

<span class="time">[$DateCreated]</span>

</div>

<p class="Body">[$MessageText]</p>

<ul class="commands">

<li class="ekDeleteMessage">[$DeleteMessageLink]</li>

<li class="ekApproveMessage">[$ApproveMessageLink]</li>

</ul>

</div>

[$ApproveMessageLink]
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</li>

</ekrepeat>

</ul>

[$AddCommentBox]

</div>

</ekoutput>

[$Avatar]
Display the profile image of the member who entered the comments on the
message board.

<ekoutput>

<div class="ContributionForm">

<h4>[$NumberComments] Comments</h4>

<ul>

<ekrepeat>

<li class="ekMessagePost">

<div class="avatar">[$Avatar]</div>

<div class="message">

<div class="metaData">

<span class="username">[$UserName]</span>

<span class="time">[$DateCreated]</span>

</div>

<p class="Body">[$MessageText]</p>

<ul class="commands">

<li class="ekDeleteMessage">[$DeleteMessageLink]</li>

<li class="ekApproveMessage">[$ApproveMessageLink]</li>

</ul>
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</div>

</li>

</ekrepeat>

</ul>

[$AddCommentBox]

</div>

</ekoutput>

[$DeleteMessageLink]
Displays the Delete link for a comment on the message board. Only
Administrators, the person who left the message or the person who owns the
board.

<ekoutput>

<div class="ContributionForm">

<h4>[$NumberComments] Comments</h4>

<ul>

<ekrepeat>

<li class="ekMessagePost">

<div class="avatar">[$Avatar]</div>

<div class="message">

<div class="metaData">

<span class="username">[$UserName]</span>

<span class="time">[$DateCreated]</span>

</div>

[$DeleteMessageLink]
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<p class="Body">[$MessageText]</p>

<ul class="commands">

<li class="ekDeleteMessage">[$DeleteMessageLink]</li>

<li class="ekApproveMessage">[$ApproveMessageLink]</li>

</ul>

</div>

</li>

</ekrepeat>

</ul>

[$AddCommentBox]

</div>

</ekoutput>

[$DisplayName]
Displays the display name of the member who left the message.

<ekoutput>

<div class="ContributionForm">

<h4>[$NumberComments] Comments</h4>

<ul>

<ekrepeat>

<li class="ekMessagePost">

<div class="avatar">[$Avatar]</div>

<div class="message">

<div class="metaData">

<span class="username">[$DisplayName]</span>

<span class="time">[$DateCreated]</span>

</div>
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<p class="Body">[$MessageText]</p>

<ul class="commands">

<li class="ekDeleteMessage">[$DeleteMessageLink]</li>

<li class="ekApproveMessage">[$ApproveMessageLink]</li>

</ul>

</div>

</li>

</ekrepeat>

</ul>

[$AddCommentBox]

</div>

</ekoutput>

[$EmailAddress]
Displays the email address of the member who left the message on the
board. To create a hyperlinked email, wrap the [$EmailAddress]
variable in a <a> tag with the mailto: variable. For example:
<a href="Mailto:[$EmailAddress]">[$EmailAddress]</a>

<ekoutput>

<div class="ContributionForm">

<h4>[$NumberComments] Comments</h4>

<ul>

<ekrepeat>

<li class="ekMessagePost">

<div class="avatar">[$Avatar]</div>

<div class="message">

<div class="metaData">

[$EmailAddress]
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<span class="username">[$UserName]&#160;&#160;<a
href="Mailto:[$EmailAddress]">[$EmailAddress]</a>

</span>

<span class="time">[$DateCreated]</span>

</div>

<p class="Body">[$MessageText]</p>

<ul class="commands">

<li class="ekDeleteMessage">[$DeleteMessageLink]</li>

<li class="ekApproveMessage">[$ApproveMessageLink]</li>

</ul>

</div>

</li>

</ekrepeat>

</ul>

[$AddCommentBox]

</div>

</ekoutput>

[$FirstName]
Displays the first name of the user who left a comment on a message board.

<ekoutput>

<div class="ContributionForm">

<h4>[$NumberComments] Comments</h4>

<ul>

<ekrepeat>
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<li class="ekMessagePost">

<div class="avatar">[$Avatar]</div>

<div class="message">

<div class="metaData">

<span class="username">[$FirstName] [$LastName]</span>

<span class="time">[$DateCreated]</span>

</div>

<p class="Body">[$MessageText]</p>

<ul class="commands">

<li class="ekDeleteMessage">[$DeleteMessageLink]</li>

<li class="ekApproveMessage">[$ApproveMessageLink]</li>

</ul>

</div>

</li>

</ekrepeat>

</ul>

[$AddCommentBox]

</div>

</ekoutput>

[$LastName]
Displays the last name of the user who left a comment on a message board.

<ekoutput>

<div class="ContributionForm">

[$LastName]
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<h4>[$NumberComments] Comments</h4>

<ul>

<ekrepeat>

<li class="ekMessagePost">

<div class="avatar">[$Avatar]</div>

<div class="message">

<div class="metaData">

<span class="username">[$FirstName] [$LastName]</span>

<span class="time">[$DateCreated]</span>

</div>

<p class="Body">[$MessageText]</p>

<ul class="commands">

<li class="ekDeleteMessage">[$DeleteMessageLink]</li>

<li class="ekApproveMessage">[$ApproveMessageLink]</li>

</ul>

</div>

</li>

</ekrepeat>

</ul>

[$AddCommentBox]

</div>

</ekoutput>

[$MessageText]
Displays the text of a message on a message board.

<ekoutput>

<div class="ContributionForm">

Controlling Output with EktronMarkup Language

26-54 ReferenceManual
Version 8.01 Rev 4



<h4>[$NumberComments] Comments</h4>

<ul>

<ekrepeat>

<li class="ekMessagePost">

<div class="avatar">[$Avatar]</div>

<div class="message">

<div class="metaData">

<span class="username">[$UserName]</span>

<span class="time">[$DateCreated]</span>

</div>

<p class="Body">[$MessageText]</p>

<ul class="commands">

<li class="ekDeleteMessage">[$DeleteMessageLink]</li>

<li class="ekApproveMessage">[$ApproveMessageLink]</li>

</ul>

</div>

</li>

</ekrepeat>

</ul>

[$AddCommentBox]

</div>

</ekoutput>

[$NumberComments]
Displays the number of comments posted on the message board.

<ekoutput>

<div class="ContributionForm">

[$NumberComments]
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<h4>[$NumberComments] Comments</h4>

<ul>

<ekrepeat>

<li class="ekMessagePost">

<div class="avatar">[$Avatar]</div>

<div class="message">

<div class="metaData">

<span class="username">[$UserName]</span>

<span class="time">[$DateCreated]</span>

</div>

<p class="Body">[$MessageText]</p>

<ul class="commands">

<li class="ekDeleteMessage">[$DeleteMessageLink]</li>

<li class="ekApproveMessage">[$ApproveMessageLink]</li>

</ul>

</div>

</li>

</ekrepeat>

</ul>

[$AddCommentBox]

</div>

</ekoutput>

[$UserName]
Display the Username of a user who left a comment on a message board.

<ekoutput>

<div class="ContributionForm">
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<h4>[$NumberComments] Comments</h4>

<ul>

<ekrepeat>

<li class="ekMessagePost">

<div class="avatar">[$Avatar]</div>

<div class="message">

<div class="metaData">

<span class="username">[$UserName]</span>

<span class="time">[$DateCreated]</span>

</div>

<p class="Body">[$MessageText]</p>

<ul class="commands">

<li class="ekDeleteMessage">[$DeleteMessageLink]</li>

<li class="ekApproveMessage">[$ApproveMessageLink]</li>

</ul>

</div>

</li>

</ekrepeat>

</ul>

[$AddCommentBox]

</div>

</ekoutput>

metadatalist.ekml
This file defines which items and information are included when displaying
content item information for a metadata list using the MetadataList server
control.

metadatlist.ekml Variables
Below is a list of variables used with the metadatalist.ekml file.

Variable Description More Information

[$Comment] The content’s comment information is displayed. [$Comment] on page 26-13

[$ContentId] Displays the content item’s ID. [$ContentId] on page 26-14

metadatalist.ekml
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Variable Description More Information

[$DateCreated]
Display the date the
content was created.

[$DateCreated] on page 26-
14

[$DateModified] Display the date the content was last modified.
[$DateModified] on page 26-
15

[$EditorFirstName]
Display the last editor’s first name for a content
item.

[$EditorFirstName] on page
26-16

[$EditorLastName]
Display the last editor’s last name for a content
item.

[$EditorLastName] on page
26-16

[$FolderId] Display the folder ID of a content item. [$FolderId] on page 26-17

[$Html] Display the HTML contained in the content item. [$Html] on page 26-17

[$HyperLink]
Adds a hyperlink using the title of the content block
as the text.

[$HyperLink] on page 26-18

[$Image]
Displays the path for the image defined in a content item’s
Metadata.Whenwrapped in <img src=””/> tag, the
image is displayed.

[$Image] on page 26-19

[$ImageIcon]
Displays an image icon for the content item. For

example, if the content item is HTML, the ( ) icon
is displayed.

[$ImageIcon] on page 26-19

[$ImageThumbnail] Displays the path for the image’s thumbnail defined in a
content item’sMetadata.

[$ImageThumbnail] on page
26-20

[$Index] Serialize the content items in a numbered list. [$Index] on page 26-20

[$ItemCount] The total number of items in a list. [$ItemCount] on page 26-21

[$Language] Display the language ID for the content item. [$Language] on page 26-21

[$LinkTarget]
When added to an <a href=””> tag’s target=””
attribute, this variable reads the server control’s
LinkTarget property and uses its setting.

[$LinkTarget] on page 26-21

[$QuickLink]
This property displays the Quicklink information for
the content item. When wrapped in an <a
href=””> tag, you can create a Hyperlink.

[$QuickLink] on page 26-21

[$SERVER_NAME]

Displays the server name. For example, If this
variable is applied to
http://www.example.com/demo.aspx, the
return is www.example.com.

[$SERVER_NAME] on page
26-23
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Variable Description More Information

[$ShowBubble(width)]
This is similar to [$ShowBubble]. It calls the
<ekbubbleinfo> tags and allows you to set the
width of the bubble.

[$ShowBubble(width,height)]
on page 26-25

[$ShowBubble]
Calls the <ekbubbleinfo> tags and places the
information contained within those tags in a pop-
up bubble.

[$ShowBubble] on page 26-
24

[$ShowContent(‘htmltagid’)]

Calls the <ekcontentinfo> tags an places the
information in those tags within the specified HTML
tag ID. Replace the 'htmltagid' with the ID of the
tag.

[$ShowContent(‘htmltagid’)]
on page 26-26

[$Status] Displays the status of a content item. [$Status] on page 26-27

[$Teaser]

Display the content item’s summary information.

Note: If the item is an HTML form, this variable isnot
supported with this ekml file.

[$Teaser] on page 26-27

[$Title] Displays the content item’s title. [$Title] on page 26-28

[$UrlEncode(‘str’)]
Encodes the string information. This variable can
be used to encode another EkML variable and
place it in an email.

[$UrlEncode(‘str’)] on page
26-30

[$UrlParam(‘paramname’)]
Displays the value of a QueryString’s parameter.
For example, if the QueryString is ?id=27 and the
variable is [$UrlParam(‘id’)], 27 is displayed.

[$UrlParam(‘paramname’)]
on page 26-29

taxonomy.ekml
This file defines which items and information are included when displaying
taxonomy item information using the Directory server control. Similar to
maps.ekml, the taxonomy.ekml works differently than other .ekml files.

The Directory server control produces multiple areas where content or
functionality is defined. To specify these areas in a template, you would call the
<ekoutput> tag with the mode attribute equaling the area you want to define.
For example, in the Directory server control, you can define information in the
breadcrumb area of the server control by using <ekoutput
mode=”breadcrumb”>.

Additional descriptions and commenting in the taxonomy.ekml file will assist
you with learning about EkML with taxonomy. This file is located in <web
root>/CMS400Developer/Workarea/template/taxonomy/taxonomy.ekml.

taxonomy.ekml
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Taxonomy <ekoutput> modes
The following <ekoutput modes=””> are used with the taxonomy.ekml
template.

EkML Tag Description

<ekoutput
mode=”breadcrumb”>

Defines the display of the breadcrumb portion of the
taxonomy. Within these tags you can define:

n <bctitle> - title for the breadcrumbs

n <bcrootlink> - root link text

n <bcseparator> - separator used to between breadcrumbs in the
breadcrumb trail

n <bchyperlink> - hyperlinks in the breadcrumb trail

n <bcactivelink> - the current active breadcrumb item

<ekoutput
mode=”category”>

Defines how the category information is displayed. Within
these tags you can define:

<ekcolrepeat> takes the category links and spreads them
over the amount of columns that are defined in the Directory
server control's TaxonomyCol property. This tag must appear
within <ekrepeat> tags.
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EkML Tag Description

<ekoutput
mode=”categorybacklink”>

Defines information about the link that moves the category up
one level. This can be a text link or an image link. In this mode,
you need to define the following tags:

n <ekactivebacklink></ekactivebacklink> - between these
tags, define what appearswhen a user is in a sub
category. Add the [$categorybacklink] variable between
these tagsand an clickable image appears that allowsa
user to navigate one level up.

n <ekdisablebacklink></ekdisablebacklink> - between these
tags, define what happenswhen a user is at the top level
category. Add the [$categorybacklink] variable between
these tagswith an <a> tag have users navigate to another
location. For example:

<a href="http://www.example.com" target="_
blank">[$categorybacklink]</a>

See Also: [$categorybacklink] on page 26-66

<ekoutput mode=”article_
search”>

Defines how the search results from the taxonomy are
displayed.

<ekoutput
mode=”article”>

Defines the display of an individual content item in your
taxonomy.

<ekoutput mode=”view”>
This section defines the overall output view of the Taxonomy. It
denotes the locations of the Search box, Breadcrumb,
Category and Articles.

taxonomy.ekml Variables
Below is a list of variables used with the taxonomy.ekml file.**

Variable Description More Information

[$AddArticle]
Adds a link that allows a logged
in user to add HTML content to Ektron
CMS400.NET.

[$AddArticle] on page 26-65

taxonomy.ekml Variables
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Variable Description More Information

[$AddAsset]
Adds a link that allows a logged in user
to add assets to Ektron CMS400.NET.

[$AddAsset] on page 26-65

[$categorybacklink]

When place between
<ekactivebacklink> tags, this variable
adds a clickable image that allows a user
to navigate up one category level.

When placed between
<ekdisablebacklink> tags and in the
text area of an <a> tag, this variable adds
a clickable image that allows a user to
navigate to another URL once they reach
the top level category.

categorybacklink

and

[$categorybacklink] on page 26-66

[$CategoryID] The ID of a taxonomy’s category.

[$ContentByteSize]
Displays the content item’s size in KB.
Works only with taxonomy search.
<ekoutput mode=”article_search”>

[$ContentByteSize] on page 26-
69

[$ContentId] Displays the content item’s ID. [$ContentId] on page 26-14

[$DateCreated] Display the date the content was created. [$DateCreated] on page 26-14

[$DateModified]
Display the date the content was last
modified.

[$DateModified] on page 26-15

[$EditorFirstName]
Display the last editor’s first name for a
content item.

[$EditorFirstName] on page 26-
16

[$EditorLastName]
Display the last editor’s last name for a
content item.

[$EditorLastName] on page 26-
16

[$FolderId] Display the folder ID of a content item. [$FolderId] on page 26-17

[$Html]
Display the HTML contained in the
content item.

[$Html] on page 26-17

[$HyperLink]
Adds a hyperlink using the title of the
content block as the text.

[$HyperLink] on page 26-18

[$ImageIcon]
Displays an image icon for the content
item type. For example, if the content item

is HTML, the ( ) icon is displayed.
[$ImageIcon] on page 26-19
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Variable Description More Information

[$Index]
Serialize the content items in a
numbered list.

[$Index] on page 26-20

[$ItemCount] The total number of items in a list. [$ItemCount] on page 26-21

[$Language]
Display the language ID for the content
item.

[$Language] on page 26-21

[$LinkTarget]

When added to an <a href=””> tag’s
target=”” attribute, this variable reads
the server control’s LinkTarget property
and uses its setting.

[$LinkTarget] on page 26-21

[$PagingCurrentEndIndex]

The end count number of the items
on the page. For example, if you are
displaying items 11 - 20 on a page, this
variable represents the number 20.
Works only with taxonomy search.
<ekoutput mode=”article_search”>

[$PagingCurrentEndIndex] on
page 26-70

[$PagingCurrentStartIndex]

The numerical record of the first item on a
page. For example, if you are displaying
items 1 through 10 out of 50 total items
on a page, this variable represents the
number 1. Works only with taxonomy
search. <ekoutput mode=”article_
search”>

[$PagingCurrentStartIndex] on
page 26-71

[$QuickLink]

This property displays the Quicklink
information for the content item. When
wrapped in an <a href=””> tag, you
can create a Hyperlink.

[$QuickLink] on page 26-21

[$SearchDuration]

Displays the amount of time, in seconds,
it has taken to execute the search. Works
only with taxonomy search. <ekoutput
mode=”article_search”>

[$SearchDuration] on page 26-
72

[$SearchSummary]

Creates a summary from information
stored in the indexing service for each
item in the search results. Works only
with taxonomy search. <ekoutput
mode=”article_search”>

[$SearchSummary] on page 26-
69

taxonomy.ekml Variables

ReferenceManual
Version 8.01 Rev 4

26-63



Variable Description More Information

[$SearchText]

Displays the text for which a user is
searching. This information is same as
what a user entered in the search text
box. Works only with taxonomy search.
<ekoutput mode=”article_search”>

[$SearchText] on page 26-71

[$SERVER_NAME]

Displays the server name. For example, If
this variable is applied to
http://www.example.com/demo.aspx
, the return is www.example.com.

[$SERVER_NAME] on page 26-
23

[$ShowAllcategory]

Adds to the Taxonomy search screen a
checkbox that lets the user decide if he
wants to display categories that have no
items.

[$ShowAllcategory] on page 26-
24

[$ShowBubble]
Calls the <ekbubbleinfo> tags and
places the information contained within
those tags in a pop-up bubble.

[$ShowBubble] on page 26-24

[$ShowBubble(width)]
This is similar to [$ShowBubble]. It calls
the <ekbubbleinfo> tags and allows
you to set the width of the bubble.

[$ShowBubble(width,height)] on
page 26-25

[$ShowBubble(width,height)]

This is similar to [$ShowBubble]. It calls
the <ekbubbleinfo> tags and allows
you to set the width and height of the
bubble.

[$ShowBubble(width,height)] on
page 26-25

[$ShowContent(‘htmltagid’)]

Calls the <ekcontentinfo> tags an places
the information in those tags within the
specified HTML tag ID. Replace the
'htmltagid' with the ID of the tag.

[$ShowContent(‘htmltagid’)] on
page 26-26

[$Status] Displays the status of a content item. [$Status] on page 26-27

[$Teaser]

Display the content item’s summary
information.

Note: If the item is an HTML form, this
variable isnot supported with this ekml file.

[$Teaser] on page 26-27
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Variable Description More Information

[$TemplateQuickLink]

This property displays the Template
Quicklink information assigned to the
taxonomy item in the Workarea. When
wrapped in an <a href=””> tag, you
can create a Hyperlink.See Also:
Applying a Template to a Taxonomy or
Category on page 9-209

[$TemplateQuickLink] on next
page

[$Title] Displays the content item’s title. [$Title] on page 26-28

[$UrlEncode(‘str’)]
Encodes the string information. This
variable can be used to encode another
EkML variable and place it in an email.

[$UrlEncode(‘str’)] on page 26-
30

[$UrlParam(‘paramname’)]

Displays the value of a QueryString’s
parameter. For example, if the
QueryString is ?id=27 and the variable
is [$UrlParam(‘id’)], 27 is displayed.

[$UrlParam(‘paramname’)] on
page 26-29

[$AddArticle]
This variable adds a link that allows a user to add HTML content to Ektron
CMS400.NET. Clicking the link opens an editor. When the content is added, it’s
automatically added to the taxonomy category associated with the Directory
server control. When you allow users to add content using this variable, you
should set the AddItemFolderID property in the Directory server control to the
folder ID where the content will be stored. This variable should not be added
between the <ekrepeat></ekrepeat> tags. See Also: AddItemFolderID on
page 9-259

<tr>

<td>

[$AddArticle]

</td>

</tr>

[$AddAsset]
This variable adds a link that allows a user to add assets to Ektron CMS400.NET
via a drag and drop box. When the asset is added, it’s automatically added to
the taxonomy category associated with the Directory server control. When you
allow users to add assets using this variable, you should set the
AddItemFolderID property in the Directory server control to the folder ID

[$AddArticle]
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where the asset will be stored. This variable should not be added between the
<ekrepeat></ekrepeat> tags.See Also: AddItemFolderID on page 9-259
<tr>

<td>

[$AddAsset]

</td>

</tr>

[$TemplateQuickLink]
This variable displays the Template Quicklink information assigned to the taxonomy item
in the Workarea.When wrapped in an <a href=””> tag, you can create a Hyperlink.

<ekmarkup>

<ekoutput>

<table width="100%" border="0">

<ekrepeat>

<tr>

<td>

<a href="[$TemplateQuickLink]">[Title]</a><br/>[$Teaser]

</td>

</tr>

</ekrepeat>

</table>

</ekoutput>

</ekmarkup>

[$categorybacklink]
When place between <ekactivebacklink> tags, this variable adds a clickable
image that allows a user to navigate up one category level.

When placed between <ekdisablebacklink> tags and in the text area of an <a>
tag, this variable adds a clickable image that allows a user to navigate to
another URL once they reach the top level category. See Also:
categorybacklink
<ekoutput mode="categorybacklink">

<ekactivebacklink>

[$categorybacklink]
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</ekactivebacklink>

<ekdisablebacklink>

<a href="http://www.example.com" target="_blank">[$categorybacklink]</a>

</ekdisablebacklink>

</ekoutput>

websearch.ekml
This file defines which items and information are included when displaying
search results with the WebSearch server control.

The websearch.ekml template needs two <ekoutput> nodes.

n The first <ekoutput> node formats the results of non-image
searches

n The second <ekoutput> node formats results that include images

websearch.ekml Variables
Below is a list of variables used with the websearch.ekml file.

Variable Description More Information

[$ContentByteSize]
Displays the
size of the content item.

[$ContentByteSize] on
page 26-69

[$ContentId]
Display the content ID number
assigned to the content.

[$ContentId] on page 26-
14

[$DateModified]
Display the date the content was last
modified.

[$DateModified] on page
26-15

[$EditorFirstName]
Display the last editor’s first name
for a content item.

[$EditorFirstName] on
page 26-16

websearch.ekml
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Variable Description More Information

[$EditorLastName]
Display the last editor’s last name
for a content item.

[$EditorLastName] on
page 26-16

[$Image]

Displays the path for the image defined in a
content item’sMetadata.Whenwrapped in
<img src=””/> tag, the image is
displayed.

[$Image] on page 26-19

[$ImageIcon]

Used in non-image searches to
display an image icon for the
content item. For example, if the

content item is HTML, the ( ) icon
is displayed.

[$ImageIcon] on page 26-
19

[$ImageThumbnail] Displays the path for the image’s thumbnail
defined in a content item’sMetadata.

[$ImageThumbnail] on
page 26-20

[$ItemCount]
Displays the total number of results
produced by the search.

[$ItemCount] on page 26-
70

[$LinkTarget]

When added to an <a href=””>
tag’s target=”” attribute, this
variable reads the server control’s
LinkTarget property and uses its
setting.

[$LinkTarget] on page 26-
21

[$PagingCurrentEndIndex]

The end count number of the items
on the page. For example, if you are
displaying items 11 - 20 on a page,
this variable represents the number
20.

[$PagingCurrentEndIndex]
on page 26-70

[$PagingCurrentStartIndex]

The numerical record of the first item
on a page. For example, if you are
displaying items 1 through 10 out of
50 total items on a page, this
variable represents the number 1.

[$PagingCurrentStartIndex]
on page 26-71

[$QuickLink]

This property displays the Quicklink
information for the content item.
When wrapped in an <a href=””>
tag, you can create a Hyperlink.

[$QuickLink] on page 26-
21

[$SearchDuration]
Displays the amount of time, in
seconds, it has taken to execute the
search.

[$SearchDuration] on page
26-72
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Variable Description More Information

[$SearchSummary]

Creates an abstract from information
stored in the indexing service for
each item in the search results.

Note: The Adobe IFilter, which is used
to generate the abstract, is only
supported in Tier 1 languages (English,
French, German, and Japanese). If
your Web site usesother languages,
the abstract maynot be legible. In such
a case, Ektron recommends
suppressing the abstract from the
search results.

[$SearchSummary] below

[$SearchText]

Displays the text for which a user is
searching. This information is same
as what a user entered in the search
text box.

[$SearchText] on page 26-
71

[$ShortDateModified]

Displays the date the content was
modified. To display the date and
time a content item was modified,
use [$DateModified]

[$ShortDateModified] on
page 26-23

[$Title] Displays the content item’s title. [$Title] on page 26-28

[$SearchSummary]
Gets the first 300 characters from the body content and creates an abstract.

For content items that do not get indexed, such as images, the SearchSummary
uses the image’s title, summary, and metadata information.

[$ContentByteSize]
Display the size of the content item in the results list.

[$SearchSummary]
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[$PagingCurrentEndIndex]
The numerical record of the last item on a page. For example, if you are displaying items 1
through 10 out of 50 total items on a page, this variable represents the number 10.

This variable is typically used in the following context:

Results [$PagingCurrentStartIndex] - [$PagingCurrentEndIndex] of [$ItemCount] for
item [$SearchText] ([$SearchDuration]).

[$ItemCount]
Displays the total number of results produced by the search.

This variable is typically used in the following context:

Results [$PagingCurrentStartIndex] - [$PagingCurrentEndIndex] of [$ItemCount] for
item [$SearchText] ([$SearchDuration])

.
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[$SearchText]
Displays the text for which a user is searching. This information is same as
what a user entered in the search text box.

This variable is typically used in the following context:

Results [$PagingCurrentStartIndex] - [$PagingCurrentEndIndex] of
[$ItemCount] for item [$SearchText] ([$SearchDuration]).

[$PagingCurrentStartIndex]
The numerical record of the first item on a page. For example, if you are displaying items 1
through 10 out of 50 total items on a page, this variable represents the number 1.

This variable is typically used in the following context:

Results [$PagingCurrentStartIndex] - [$PagingCurrentEndIndex] of
[$ItemCount] for item [$SearchText] ([$SearchDuration]).

[$SearchText]
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[$SearchDuration]
Displays the amount of time, in seconds, it has taken to perform the search.

This variable is typically used in the following context:

Results [$PagingCurrentStartIndex] - [$PagingCurrentEndIndex] of
[$ItemCount] for item [$SearchText] ([$SearchDuration]).
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Chapter 27

Using Other Development
Frameworks

ReferenceManual
Version 8.01 Rev 4 27-1



n Standard ASP.NET Methods on page 27-188

n Custom ASP Functions on page 27-196

n Custom ColdFusion Functions on page 27-276

n Custom PHP Functions on page 27-300

n Custom JSP Functions on page 27-324
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Supporting Dreamweaver
Extensions
Ektron CMS400.NET has a custom Adobe® Extension Package, which allows you
to not only create your templates in Dreamweaver® or UltraDevTM, but also to
insert the custom functions through Dreamweaver®.

To do this, all you need is Ektron CMS400.NET, Dreamweaver®/UltraDevTM,
and to keep reading.

Ektron supports Dreamweaver extensions for the following scripting languages:

n ASP.NET - for .NET pages

n ASP - for Active Server Pages

n CFM - for ColdFusion pages

n JSP - Java Server Pages

n PHP - Hypertext Preprocessor

This section also contains the following topics.

Requirements 27-3
Preparing Dreamweaver for Ektron CMS400.NET Functions 27-3
Installing the Extensions 27-4
Setup 27-8
Editing and Saving Content in Dreamweaver 27-11
Using the Ektron CMS400.NET Extensions 27-17
Inserting Custom Functions 27-29

Requirements
To use a Dreamweaver extension supplied by Ektron, you need to have
Dreamweaver 7.0.1 or higher installed, as well as Ektron CMS400.NET.

Preparing Dreamweaver for Ektron
CMS400.NET Functions
To have Ektron CMS400.NET function symbols appear in Dreamweaver, while
editing a Web page, you must edit two PreviewModeCustomTags.edml
Dreamweaver files. The steps below explain how to edit the files.

1. In Windows Explorer, navigate to the Translator > ASP.NET_VB
location in the Dreamweaver install location. For example:

Supporting Dreamweaver Extensions
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 C:\Program Files\Adobe\Dreamweaver X\Configuration\Translators\ASP.NET_VB\

Note: In the path above, X represents the version of Dreamweaver you are using. For
example, Dreamweaver 8 or Dreamweaver MX.

2. Open the PreviewModeCustomTags.edml file using Notepad.

3. Search for the following line of code in the file.
<searchPattern
requiredLocation="openTag"><![CDATA[/runat\s*=\s*"?server"?/i]]></searchPattern>

4. Add the following line after it.
 <searchPattern

requiredLocation="tagName"><![CDATA[/^(?!cms:)/i]]></searchPattern>

Warning! This line must be inserted after the line above. Order is important.

5. Save and close the file.

6. Navigate to the Translator > ASP.NET_Csharp location in the
Dreamweaver install location. For example:

 C:\Program Files\Adobe\Dreamweaver X\Configuration\Translators\ASP.NET_Csharp\

Note: In the path above, X represents the version of Dreamweaver you are using. For
example, Dreamweaver 8 or Dreamweaver MX.

7. Open the PreviewModeCustomTags.edml file using Notepad.

8. Search for the following line of code in the file.
<searchPattern
requiredLocation="openTag"><![CDATA[/runat\s*=\s*"?server"?/i]]></searchPattern>

9. Add the following line after it.
 <searchPattern

requiredLocation="tagName"><![CDATA[/^(?!cms:)/i]]></searchPattern>

Warning! This line must be inserted after the line above. Order is important.

10. Save the file.

You are now ready to Install the Ektron CMS400.NET extension. See Also:
Installing the Extensions below

Installing the Extensions
There are two extensions that can be installed on your server:

n Ektroncms400.mxp - Adds ASP.NET extensions

n C400_ASP_PHP_CF_JSP.mxp - adds ASP, PHP, CF and JSP extensions

You can have both extensions installed at the same time. The extensions do not
affect each other. When you install the second extension, you might receive the
following message:
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If you see this message or one that say the files are newer, click Yes to All to
continue. Overwriting the files will not affect the extensions.

Before you can insert the Ektron CMS400.NET custom functions through
Dreamweaver®, you must install at least one of the extensions. Listed below
are the steps to install an extension.

Note: For additional information about installing an extension, refer to your Dreamweaver®
Manual.

To install an extension, follow these steps.

1. Begin by following the path in Dreamweaver:

Commands > Manage Extensions...

2. The Extension Manager is displayed.

Installing the Extensions
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3. From this dialog box, follow the path:

File > Install Extension...
4. The Select Extension to Install window opens.

5. Locate the Extension Package (.mxp) file that corresponds to Ektron
CMS400.NET. By default, the file gets installed to the following
directory:

C:\Program Files\Ektron\CMS400vXX\Utilities
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Note: In the folder path, vXX represents the version of Ektron CMS400.NET you have
installed.

6. After you select the file, click the Install button.

7. The installation begins with the Extension Manager Disclaimer. Click
Accept.

8. The extension begins to install. Once installed, you see a
confirmation box.

9. Click OK to continue.

10. The Extension Manager is again displayed, but with the added
extension.

11. If needed, exit Dreamweaver®, then start it back up.

Now you can use the Ektron CMS400.NET Extension Pack.

Installing the Extensions
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Refer to Using the Ektron CMS400.NET Extensions on page 27-17 for more
information on using Dreamweaver® to create and edit templates for Ektron
CMS400.NET.

Setup
Before you can use Dreamweaver®/UltraDevTM to create and edit Ektron
CMS400.NET templates, you should configure the Ektron CMS400.NET
Extension. Listed below are the configurative options for the extension in
Dreamweaver:

n Username

n Password

n Domain

n Server File

n Server

n Include

n Check for Include

To change these options, follow these steps.

1. If you use ASP, ColdFusion, JSP or PHP, follow this path:

Commands > Ektron CMS400 - (ASP CF JSP PHP) >
Setup...
If you use ASP.NET, follow this path:

Commands > Ektron CMS400.NET (Server Controls) >
Setup...

UsingOther Development Frameworks
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2. The Setup dialog box is displayed on the screen.

3. Use the following table to help you update your setup information.
This table refers to Ektron CMS400.NET (Server Controls) setup.
For Ektron CMS400 - (ASP CF JSP PHP), see Ektron CMS400 - (ASP CF
JSP PHP) Dreamweaver Setup Table. below

Ektron CMS400.NET(Server Control) Dreamweaver Setup Table.

Field Description

Username
Valid username of a user of your Ektron CMS400.NETWeb site.When using the extension, the
username is used to log in to the database to retrieve information about content blocksand
other Web site information

Password Enter the password for the user.

Domain Only required if Active Directory hasbeen enabled for your Web site. Enter the domain
corresponding to the username entered.

Server
File

Specify the location and file name for the dreamweaver.aspx file needed for the extension to
properlywork andmake connection with your Ektron CMS400.NET database.

Include Each Ektron CMS400.NET template requiresan include file to point to the API with the
definitions for the custom functions. Here, specify the include file.

Ektron CMS400 - (ASP CF JSP PHP) Dreamweaver Setup Table.

Setup
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Field Description

Username
Valid username of a user of your Ektron CMS400.NETWeb site.When using the extension, the
username is used to log in to the database to retrieve information about content blocksand
other Web site information

Password Enter the password for the user.

Domain Only required if Active Directory hasbeen enabled for your Web site. Enter the domain
corresponding to the username entered.

Server
File

Specify the location and file name for the dreamweaver.aspx file needed for the extension to
properlywork andmake connection with your Ektron CMS400.NET database.

Server

Choose the language of the server.

n ASP - for Active Server Pages

n CFM - for ColdFusion pages

n JSP - Java Server Pages

n PHP - Hypertext Preprocessor

Note: If you want to use a different language, you need to run this setup again and choose a
different language.

Include

Each template requiresan include file to point to the API with the definitions for the custom
functions. Here, specify the include file.

n For ASPuse: <!-- #include file="applicationAPI.asp" -->

n For CFM use: Leave blank

n For JSP use: <%@ include file="applicationAPI.jsp" %>

n For PHPuse: <?php include "applicationAPI.php"; ?>

Check for
Include

If checked the Include statement is added to your page. Checked is the default.

n Checked - include statement added to your page

n Unchecked - include statement is not added to your page

4. Click Update Setup.

5. A message appears.

Note: A message other than this is probably due to an incorrect server file, username, or
password. Recheck your settings and try again.

6. Click OK to continue.

UsingOther Development Frameworks
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7. The setup dialog box closes. You are ready to create templates using
Dreamweaver.

Editing and Saving Content in
Dreamweaver
Making the process of setting up and managing your Web site easier, the Ektron
CMS400.NET Dreamweaver extensions allow you to perform content related
tasks directly from Dreamweaver saving you time and effort.

Through Dreamweaver, you can perform the following tasks:

n Add new content blocks to Ektron CMS400.NET

n Edit existing Ektron CMS400.NET content block

The following sections explain how to perform these tasks.

Note: The user specified in the setup information for the extension will only be able to perform
tasks they have permissions to in Ektron CMS400.NET.

Accessing Manage Content Commands
To access the CMS Manage commands menu, follow this path:

Commands > Ektron CMS400.NET (Server Controls) >
Edit via Dreamweaver...

Or

Commands > Ektron CMS400 - (ASP CF JSP PHP) >
Edit via Dreamweaver...

The path you follow depends on which Dreamweaver Extension you installed. If
you installed both extensions, you can use either one.

A list of all CMS Manage Content commands that can be performed is displayed.

Editing and Saving Content in Dreamweaver
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The following sections explain how to use the manage content commands.

Edit Content
The edit content command allows you to get a content block from the Ektron
CMS400.NET Web site, and edit it within Dreamweaver.

To edit a content block within Dreamweaver, perform the following steps:

1. Create a new HTML document in Dreamweaver.

2. In the Ektron CMS400.NET Manage Content menu, click Edit
Content.

3. The Insert Content tag dialog box is displayed.
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4. Choose the Ektron CMS400.NET content block you would like to edit
by:

- Typing the ID number of the content

or

- Using the drop down lists to locate the content folder and content block

5. Click Get when you have chosen the content block.

6. The content block is inserted into Dreamweaver.

7. Make the necessary changes to the content block using
Dreamweaver’s editing capabilities.

See Saving Existing Ektron CMS400.NET Content on page 27-17 for
information about saving the content back to Ektron CMS400.NET.

Edit Content
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Save Content
Content that has been created, or edited, in Dreamweaver can be saved to your
Ektron CMS400.NET Web site by using the Save Content command.

The following section explains how to save content created, and edited, to
Ektron CMS400.NET.

Saving New Content
To save a content block that was created in Dreamweaver, perform the
following steps:

1. If you haven’t already, create the new content in Dreamweaver.

2. In the Ektron CMS400.NET Manage Content menu, click Save
Content.
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3. The Save Content dialog box is displayed.

4. Using the following table, enter the necessary information to
complete the form.

Field Description

Title Type a unique title for the content block.

Comment Enter a comment for the content block.

Start Date

If desired, type in a start date for the content block.

Note: Date format MUST match what is set for the ek_dateFormat element, in the
Web.config file, located in the site’swebroot.
Bydefault, this isdd-mmm-yyyy hh:mm:ss tt (for example, 24-Dec-2005 10:15:00 AM)

Saving New Content
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Field Description

EndDate

If desired, type in an end date for the content block.

Note: Date format MUST match what is set for the ek_dateFormat element, in the
Web.config file, located in the site’swebroot.
Bydefault, this isdd-mmm-yyyy hh:mm:ss tt (for example, 24-Dec-2005 10:15:00 AM)

Content
Folder Select the content folder you would like to save the new content block to.

Here is an example of this form filled out.

5. Click Save to save and add the new content block the selected
content folder in Ektron CMS400.NET.

The content block is added, and a confirmation message is displayed.

Here is the new content block in the Ektron CMS400.NET Workarea.

6. Once the content has been saved to Ektron CMS400.NET, you can
close the page in Dreamweaver.
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Saving Existing Ektron CMS400.NET Content
When Ektron CMS400.NET content has been edited in Dreamweaver, you can
use the save content command to save your changes back to Ektron
CMS400.NET.

To save existing Ektron CMS400.NET content, perform the following steps.

1. Make changes to an existing Ektron CMS400.NET content block as
described in Edit Content on page 27-12.

2. In the Ektron CMS400.NET Manage Content Menu, click on Save
Content.

3. The Save Ektron Content dialog box is displayed.

4. Use the following table to complete the form.

Field Description

Title Editing this field will rename the content block in Ektron CMS400.NET.

Comment Enter a comment for the content block.

Start Date

If desired, type in a start date for the content block.

Note: Date format MUST match what is set for the ek_dateFormat element, in the
Web.config file, located in the site’swebroot.
Bydefault, this isdd-mmm-yyyy hh:mm:ss tt (for example, 24-Dec-2005 10:15:00 AM)

End Date

If desired, type in an end date for the content block.

Note: Date format MUST match what is set for the ek_dateFormat element, in the
Web.config file, located in the site’swebroot.
Bydefault, this isdd-mmm-yyyy hh:mm:ss tt (for example, 24-Dec-2005 10:15:00 AM)

Content
Folder Disabled.

5. Click Save to save the changes made to the content.

The content is saved, and a confirmation message is displayed.

Note: If you receive a message other than one confirming your content has been saved, check
your settings and try again.

Using the Ektron CMS400.NET
Extensions
Once the Extension Package has been installed for Dreamweaver, you can
create and edit templates for Ektron CMS400.NET.

The following subsections are contained in this section:

Saving Existing Ektron CMS400.NET Content
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n Custom Function Symbols below

n Ektron CMS400.NET Command Menus on page 27-22

Custom Function Symbols
During the process of inserting functions, symbols are used to represent the
custom display functions. The following table explains each symbol and for
which scripting languages the functions are available.

Symbol Represents ASP.NET

ASP
- CF
JSP
-
PHP

More Information

Active Topics ActiveTopicson page 27-29

Analytics Analyticson page 27-32

Asset Control AssetControlon page 27-34

Blog Blog on page 27-36

BlogArchive Blog Archive on page 27-40

Blog Calendar Blog Calendar on page 27-42

Blog
Categories Blog Categorieson page 27-44

Blog Entries Blog Entrieson page 27-47

Blog Posts Blog Post on page 27-50
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Symbol Represents ASP.NET

ASP
- CF
JSP
-
PHP

More Information

Blog Recent
Posts Blog Recent Postson page 27-52

Blog Roll Blog Rollon page 27-55

Blog RSS Blog RSS on page 27-57

BreadCrumb BreadCrumb on page 27-59

Calendar Calendar on page 27-64

Collection Collection on page 27-67

Content Block Content Blockon page 27-73

Content List Content List on page 27-76

Content Rating Content Rating on page 27-81

Content XSLT
Tag Content XSLT Tag... on page 27-83

DHTMLMenu DHTMLMenu on page 27-85

Directory -
Taxonomy Directory-Taxonomyon page 27-91

CustomFunction Symbols
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Symbol Represents ASP.NET

ASP
- CF
JSP
-
PHP

More Information

Discussion
Forum Discussion Forum on page 27-96

DisplaybyMeta
Value DisplayByMeta Value on page 27-99

Dynamic
Content Block

DynamicContent Blockon page 27-
105

Folder Bread
Crumb Folder Bread Crumb on page 27-107

FormContent
Block Form on page 27-110

Image Control ImageControlon page 27-113

Language API Language API on page 27-115

Language
Select Language Select Boxon page 27-117

List Summary List Summaryon page 27-119

Login/Logout
button Login on page 27-126

Map MapControlon page 27-130

Membership Membership Controlon page 27-136
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Symbol Represents ASP.NET

ASP
- CF
JSP
-
PHP

More Information

Metadata

Metadata for ASP.NET Pageson page
27-140

or

Metadata Function for ASP, CF, JSP
or PHPPages on page 27-143

Multipurpose
content block.

Multipurpose Content Blockon page
27-145

Poll Pollon page 27-147

Post History PostHistoryon page 27-149

Random
Content RandomContent on page 27-152

Random
Summary RandomSummaryon page 27-153

RSS
Aggregator RSSAggregator on page 27-155

Old Search Old Search on page 27-157

Search display
function Search Displayon page 27-166

Single
Summary Single Summaryon page 27-167

Site Map SiteMap on page 27-169

StandardMenu StandardMenu on page 27-175

CustomFunction Symbols
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Symbol Represents ASP.NET

ASP
- CF
JSP
-
PHP

More Information

Smart Menu Smart Menu on page 27-172

Web Search WebSearch on page 27-178

XML Index
Search XML IndexSearch on page 27-183

Ektron CMS400.NET Command Menus
The following section explains how to locate Ektron CMS400.NET commands in
Dreamweaver.

There are two Ektron command menus available. One menu is for ASP.NET
pages and the other is used for ASP, ColdFusion, JSP and PHP pages:

n Commands > Ektron CMS400.NET (Server Controls)

n Commands > Ektron CMS400 - (ASP CF JSP PHP)

To locate a command menu in Dreamweaver, perform the following steps:

1. Open Dreamweaver.

2. In the top menu, follow one of these paths:

n If you are using ASP.NET pages, click

Commands > Ektron CMS400.NET (Server Controls)
n If you are using ASP, ColdFusion, JSP or PHP pages, click

Commands > Ektron CMS400 - (ASP CF JSP PHP)

For a list of commands in Ektron CMS400.NET (Server Controls), see
Ektron CMS400.NET (Server Controls) Functions on page 27-24.

For a list of commands in Ektron CMS400 - (ASP CF JSP PHP), see Ektron
CMS400 - (ASP CF JSP PHP) Functions on page 27-28.

3. The Ektron CMS400.NET commands menu is displayed.

In Ektron CMS400.NET (Server Controls) the functions are broken
up into the following groups:

- Content Controls...

- CMS Module Controls...

- Community Controls...
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In Ektron CMS400 - (ASP CF JSP PHP) the functions are broken up
into the following groups:

- CMS Function...

- XML Function...

Note: For a description of the Setup... and Edit via Dreamweaver... groups, see Setup on
page 27-8 and Editing and Saving Content in Dreamweaver on page 27-11.

Below are images showing the different views.

4. Click on the command for the task you would like to perform.

The following tables explain each command. The first table explains the
Ektron CMS400.NET (Server Controls) Functions on next page. The
second table explains the Ektron CMS400 - (ASP CF JSP PHP) Functions
on page 27-28.

Ektron CMS400.NET CommandMenus
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Ektron CMS400.NET (Server Controls)
Functions

Command Description
More
Information

Content Controls...

Login Inserts an Ektron CMS400.NET login function into the template. Login on page
27-126

Content Inserts an Ektron CMS400.NET content block function into the template.
Content Block
on page 27-
73

Form Inserts an Ektron CMS400.NET form content block into the template. Form on page
27-110

Poll Displaysa poll or survey created from an Ektron CMS400.NET form on a
Web page.

Pollon page
27-147

Collection Inserts an Ektron CMS400.NET collection function into the template. Collection on
page 27-67

List Summary Inserts an Ektron CMS400.NET list summary function into the template.
List Summary
on page 27-
119

Metadata Inserts an Ektron CMS400.NET metadata function into the template.

Metadata for
ASP.NET
Pageson
page 27-140

DisplayBy
Meta Value

Inserts an Ektron CMS400.NET displaybymeta value block into the
template.

DisplayBy
Meta Value
on page 27-
99

Content List Displaysa list of content blocks created from a comma delimited list.
Content List
on page 27-
76

Language
Select Inserts an Ektron CMS400.NET language select box into the template.

Language
Select Boxon
page 27-117

Language API Inserts an Ektron CMS400.NET Language API into the template.
Language
API on page
27-115
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Command Description
More
Information

ContentRating
Place a rating scale on anypage of your Web site. The scale letsEktron
CMS400.NET collect feedbackbygiving site visitors the opportunity to
rate a particular content item.

Content
Rating on
page 27-81

WebSearch
The Web Search server control lets you customize the
behavior of the search.

WebSearch
on page 27-
178

Old Search Inserts an Ektron CMS400.NET search function into the template. Old Search on
page 27-157

XML Index
Search Inserts an Ektron CMS400.NET XML IndexSearch into the template.

XML Index
Search on
page 27-183

Directory-
Taxonomy

Lets you customize the behavior of the Taxonomy feature.
You place this control on any Web form to display a
taxonomy.

Directory-
Taxonomyon
page 27-91

CMS Module Controls...

Analytics Track statistics about visits to your Web site. Analyticson
page 27-32

Calendar Inserts an Ektron CMS400.NET event calendar function into the
template.

Calendar on
page 27-64

RssAggregator Aggregatesan RSS feed from anRSSWeb site.

RSS
Aggregator
on page 27-
155

MapControl
Displays a map that flags locations of interest to your site
visitors. Each location is a CMS content item to which map
information was added.

MapControl
on page 27-
130

CMS MENU Controls...

Folder Bread
Crumb

FolderBreadcrumbsshow you the path through the sitemap to the
current page.

Folder Bread
Crumb on
page 27-107

BreadCrumb Createsa breadcrumb trail of where site visitors have been and allows
them to navigate back to previouspages.

BreadCrumb
on page 27-
59

SmartMenu Displaysamenu on aWeb page. Thismenu style is themost robust of
the three delivered with Ektron CMS400.NET.

Smart Menu
on page 27-
172

Ektron CMS400.NET (Server Controls) Functions
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Command Description
More
Information

DHTMLMenu Inserts an Ektron CMS400.NET DHTMLmenu into the template.
DHTML
Menu on
page 27-85

Standard
Menu Inserts an Ektron CMS400.NET standardmenu into the template.

Standard
Menu on
page 27-175

Site Map The Sitemap utilizes the folder breadcrumb information in theWorkarea
to display a sitemap of your site.

SiteMap on
page 27-169

Community Controls...

Membership AddsaMembership form to your Web form. This allowssite visitors to
self-register themselves to your site.

Membership
Controlon
page 27-136

Discussion
Forum

Forumsprovide a Discussion Board where topics can be discussed on
your Web site.

Discussion
Forum on
page 27-96

ActiveTopics
Displays either the most active topics or the most recent
topics.

ActiveTopics
on page 27-
29

PostHistory Displays a list of posts for a given users
PostHistory
on page 27-
149

Blog The Blog function allowsyou to quickly add a blog to aWeb form. It hasall
of the itemscommonly found on a blog page in one server control.

Blog on page
27-36

Blog Calendar Displaya calendar on aWeb page and associate it with a blog.
Blog
Calendar on
page 27-42

Blog
Categories Display the blog categories for a blog on aWeb form.

Blog
Categorieson
page 27-44

Blog Roll Display the blog roll for a blog on aWeb form. Blog Rollon
page 27-55

Blog RSS Display the icon ( ) for the blog’sRSS feed on theWeb form.
Blog RSS on
page 27-57

Blog Entries Displaya list of multiple blog posts on aWeb form.
Blog Entries
on page 27-
47
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Command Description
More
Information

Blog Recent
Posts Displaya list of recent blog posts links on aWeb form.

Blog Recent
Postson page
27-52

Blog Post Displayan individual blog post on aWeb form. Blog Post on
page 27-50

Blog Archive Display a list of past months or years that have posts.
Blog Archive
on page 27-
40

AssetControl
The AssetControl server control, when viewed on a Web
form, displays a drag and drop box for users to upload assets
to Ektron CMS400.NET or update an existing asset.

AssetControl
on page 27-
34

ImageControl
Displaya CMS400.NET image on aWeb page. In addition, if a user has
permission to edit the image, he can right click the image and a drag and
drop boxappears. This boxallowsa user to overwrite the existing file.

ImageControl
on page 27-
113

Ektron CMS400.NET (Server Controls) Functions
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Ektron CMS400 - (ASP CF JSP PHP)
Functions
Command Description More Information

Content Controls...

Login Inserts an Ektron CMS400.NET login function into the
template. Login on page 27-126

Content Inserts an Ektron CMS400.NET content block function into
the template.

Content Blockon page 27-
73

Dynamic Inserts an Ektron CMS400.NET dynamic content block
placeholder function into the template.

DynamicContent Blockon
page 27-105

Collection Inserts an Ektron CMS400.NET collection function into the
template. Collection on page 27-67

List Summary Inserts an Ektron CMS400.NET list summary function into
the template.

List Summaryon page 27-
119

Metadata Inserts an Ektron CMS400.NET metadata function into the
template.

Metadata for ASP.NET
Pageson page 27-140

Search Inserts an Ektron CMS400.NET search function into the
template. Old Search on page 27-157

Search
DisplayTag

Inserts an Ektron CMS400.NET search display function
into the template.

Search Displayon page 27-
166

Single
Summary
Tag

Inserts an Ektron CMS400.NET single summary function
into the template.

Single Summaryon page
27-167

Random
Content Tag

Inserts an Ektron CMS400.NET random content function
into the template.

RandomContent on page
27-152

Random
Summary
Tag

Inserts an Ektron CMS400.NET random summary function
into the template.

RandomSummaryon page
27-153

Calendar Inserts an Ektron CMS400.NET event calendar function
into the template. Calendar on page 27-64

Form Inserts an Ektron CMS400.NET form content block into the
template. Form on page 27-110

Multipurpose
Tag

Insert a content blockor form content block into the
template.

Multipurpose Content Block
on page 27-145
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Command Description More Information

XML Function...

Content
XSLT Tag

Inserts an XML content blockwith your choice of XSLT in
the template.

Note: Used to insert an XML content blockwith an
XSLT other than the default applied to it.

Content XSLT Tag... on
page 27-83

Inserting Custom Functions

CMS Function
The CMS Function commands let you insert standard Ektron CMS400.NET
display functions into your template.

The following sections explain how to insert each function.

ActiveTopics
For a description of the ActiveTopics function, see ActiveTopics Server Control
on page 7-650 .

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls... > Forums

To insert the ActiveTopics function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click ActiveTopics.

3. The Insert Ektron CMS400.NET ActiveTopics box appears.

Inserting CustomFunctions
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4. Use the following table to assist you with inserting the ActiveTopics
function.

Field Description

Control ID A unique name for the function you are inserting.

BoardID
The ID of the Discussion Board.

If you do not know the board ID, you can navigate to it using the Select folder drop down
box.

DisplayMode

Choose between Active or Recent. In Activemode, the server control displays themost
active topics. In Recent mode, the server control displays the topicswith themost recent
posts.

The default isActive.

MaxNumber Themaximum number of topics listed.

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to
cache the data for fiveminutes, set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Hide

Used to hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

An ActiveTopics icon appears to indicate the location of the active topics
list.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:ActiveTopics BoardID="106" id="ActiveTopics1"
runat="server"></cms:ActiveTopics>

ActiveTopics
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Platform Code View

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Analytics
This tag appears on the following menu:

n Commands > Ektron CMS400.NET (Server Controls) >
CMS Module Controls...

To insert the Analytics function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Analytics.

3. The Insert Ektron CMS400.NET Analytics box appears.

4. Use the following table to assist you with inserting the Analytics
function.

Field Description

Control ID A unique name for the function you are inserting.

Content ID
Specify the ID number of a content item being tracked by this function. If you do not
know the Content ID, you can navigate to it using the Select Category and Select
Content drop down boxes.
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Field Description

DynamicContent
Parameter

Tomake this content analytic control dynamic, select id. When you do, this server
control is attached to the content blockpassed asa URL parameter.

Hide

Used to hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

An Analytic icon appears to indicate that content is being tracked. If you
are logged in as a CMS user and visit the web page, you see the Analytic
information. If you are not logged in, you see nothing.

Analytics
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:AnalyticsTracker id="AnalyticsTracker1" DefaultContentID="30"
runat="server"></cms:AnalyticsTracker>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

AssetControl
For a description of the AssetControl function, see AssetControl Server Control
on page 7-466.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls...

To insert the AssetControl function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click AssetControl.

3. The Insert Ektron CMS400.NET AssetControl box appears.

4. Use the following table to assist you with inserting the AssetControl
function.
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Field Description

Control ID A unique name for the function you are inserting.

FolderID

The ID of the folder where assets are added. This property is used when the
UploadTypeproperty is set to Add. See Also:UploadType below

If you do not know the Folder ID, you can navigate to it using the Select Folder drop
down box.

DefaultAssetID The ID of the asset you want to update. This property is use when the UploadType
property is set to Update. See Also:UploadType belowUploadType below

UploadType

Select whether the control addsnew assets or update existing ones. Select Add to add
assets and use the FolderIDproperty. See Also: FolderID above. Select Update to
update assets and use the DefaultAssetID. See Also:DefaultAssetID above.

The default isNone.

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

An AssetControl icon appears and indicates the AssetControl’s location
on the template.

AssetControl
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:AssetControl id="AssetControl1" DefaultFolderID="0"
runat="server"></cms:AssetControl>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog
For a description of the Blog function, see Blog Server Control on page 7-508
and Introduction to Blog Server Controls on page 7-507.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls... > Blogs

To insert the Blog function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog.

3. The Insert Ektron CMS400.NET Blog box appears.
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4. Use the following table to assist you with inserting the Blog function.

Field Description

Control ID A unique name for the function you are inserting.

Blog ID The ID of the blog in Ektron CMS400.NET. If you do not know the Blog ID, you can
choose it from the Select Folder drop down box.

ShowRSS

Displays the icon for the RSS feed ( ) when the box is checked. The default is
Checked.

Checked =DisplayRSS feed

Unchecked =Do not displayRSS feed

ArchiveMode

Select whether the archive appears inmonth format or year format. The default is
month.

Blog
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Field Description

MaxResults

Set themaximum number of posts to display. If set to 0 (zero), there is no limit. If set to -
1, all posts for the dayare shown. If set to -2, the all post for themonth are shown, If set
to -3, the control uses the # of Post Visible setting in theWorkarea. The default is -3.

For information on theWorkarea setting # of post visible, seeBlog Propertieson
page 7-476.

DateToStart
The date of the last blog entries you want to appear. For example, if you want to display
blog entries for January 1, 2006 and before, you enter 1/1/2006. Clicking the dropdown
boxprovides you with a calendar.

EditorHeight Sets the height of the blog editor in pixels.

EditorWidth Sets the width of the blog editor in pixels.

RecentPosts The number of post links contained in the Recent Posts list. The default is 5 (five).

PostParameter

Works like the DynamicParameter for content blocks.When id is selected, this server
control passes the blog post ID asa URL parameter.

The default setting is id.

Blank - the list of blog posts is static. The links in the blog posts are inactive.

id - the id of the blog post is passed to the URL asa parameter.

None use default - the list of blog posts is static. The links in the blog posts are inactive.

ShowHeader

Shows the title and tagline when this box is checked.

The default isChecked.

Checked = show title and tagline

Unchecked =do not show header and tagline

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to
cache the data for fiveminutes, set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33.

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Blog icon appears and indicates the Blog’s location on the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET <cms:Blog id="Blog1" BlogID="41" runat="server"></cms:Blog>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog
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Blog Archive
For a description of the Blog Archive function, see BlogArchive Server Control
on page 7-524.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls... > Blogs

To insert the Blog Archive function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Archive.

3. The Insert Ektron CMS400.NET Blog Archive box appears.

4. Use the following table to assist you with inserting the Blog Archive
function.

Field Description

Control ID A unique name for the function you are inserting.

Blog ID The ID of the blog in Ektron CMS400.NET. If you do not know the Blog ID, you can
choose it from the Select Folder drop down box.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to
cache the data for fiveminutes, set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33
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Field Description

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A BlogArchive icon appears and indicates the Blog Archive’s location on
the template.

Shown below is an example of the code that is inserted:

Blog Archive
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Platform Code View

.NET
<cms:BlogArchive id="Blogarchive1" BlogID="41"
runat="server"></cms:BlogArchive>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog Calendar
For a description of the Blog Calendar function, see BlogCalendar Server
Control on page 7-518.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls... > Blogs

To insert the Blog Calendar function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Calendar.

3. The Insert Ektron CMS400.NET Blog Calendar box appears.

4. Use the following table to assist you with inserting the Blog Calendar
function.

Field Description

Control ID A unique name for the function you are inserting.
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Field Description

Blog ID The ID of the blog in Ektron CMS400.NET. If you do not know the Blog ID, you can
choose it from the Select Folder drop down box.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to
cache the data for fiveminutes, set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Blog Calendar icon appears and indicates the Blog Calendar's location
on the template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:blogcalendar id="blogcalendar1" BlogID="41"
runat="server"></cms:blogcalendar>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog Categories
For a description of the Blog Categories function, see BlogCategories Server
Control on page 7-520.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls... > Blogs

To insert the Blog Categories function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog
Categories.

3. The Insert Ektron CMS400.NET Blog Categories box appears.
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4. Use the following table to assist you with inserting the Blog
Categories function.

Field Description

Control ID A unique name for the function you are inserting.

Blog ID The ID of the blog in Ektron CMS400.NET. If you do not know the Blog ID, you can
choose it from the Select Folder drop down box.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to
cache the data for fiveminutes, set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"
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Field Description

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Blog Categories icon appears and indicates the Blog Categories’
location on the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:BlogCategories id="BlogCategories1" BlogID="41"
runat="server"></cms:BlogCategories>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.
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Blog Entries
For a description of the Blog Entries function, see BlogEntries Server Control on
page 7-513.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls... > Blogs

To insert the Blog Entries function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Entries.

3. The Insert Ektron CMS400.NET Blog Entries box appears.

4. Use the following table to assist you with inserting the Blog Entries
function.

Field Description

Control ID A unique name for the function you are inserting.

Blog ID The ID of the blog in Ektron CMS400.NET. If you do not know the Blog ID, you can
choose it from the Select Folder drop down box.

DateToStart
The date of the last blog entries you want to appear. For example, if you want to display
blog entries for January 1, 2006 and before, you enter 1/1/2006. Clicking the dropdown
boxprovides you with a calendar.
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Field Description

PostParameter

Works like the DynamicParameter for content blocks.When id is selected, this server
control passes the blog post ID asa URL parameter. If you do not set this parameter to
id, you will not be forwarded to the blog post’s page when you click on any links in the
post.

The default setting is id.

Blank - the list of blog posts is static. The links in the blog posts are inactive.

id - the id of the blog post is passed to the URL asa parameter and

None use default - the list of blog posts is static. The links in the blog posts are inactive.

MaxResults

Set themaximum number of posts to display. If set to 0 (zero), there is no limit. If set to -
1, all posts for the dayare shown. If set to -2, the all post for themonth are shown, If set
to -3, the control uses the # of Post Visible setting in theWorkarea. The default is -3.

For information on theWorkarea setting # of post visible, see ”# of Visible Posts” on
page 648.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to
cache the data for fiveminutes, set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

DisplayXslt

Specify an externalXSLT file. See Also: TheOverrideXslt and DisplayXslt Propertieson
page 7-199.

Warning! If you specify an external file, it is strongly recommended that you do not
store this file in your site'sWorkarea folder. If you store this file in theWorkarea folder,
the file will be lost when you upgrade.

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"
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Field Description

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Blog Entries icon appears and indicates the Blog Entries’ location on
the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:BlogEntries id="BlogEntries1" BlogID="41"
runat="server"></cms:BlogEntries>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.
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Blog Post
For a description of the Blog Post function, see BlogPost Server Control on page
7-516.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls... > Blogs

To insert the Blog Post function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Post.

3. The Insert Ektron CMS400.NET Blog Post box appears.

4. Use the following table to assist you with inserting the Blog Post
function.

Field Description

Control ID A unique name for the function you are inserting.

DefaultContent ID The ID of a blog post in Ektron CMS400.NET. If you do not know the Blog Post’s ID,
you can navigate to it using the Select Category and Select Content drop down boxes.

DynamicParameter Tomake this blog post dynamic, select id. When you do, this server control uses the
blog post passed asa URL parameter.
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Field Description

ShowType

Showsa blog post’s content and its comments or just the comments. The default is
Content.

Content - Show a blogpost’s content and its comments.

Description - Show a blogpost’s comments only.

DisplayXslt

Specify an externalXSLT file. See Also: TheOverrideXslt and DisplayXslt Properties
on page 7-199

Warning! If you specify an external file, it is strongly recommended that you do not
store this file in your site'sWorkarea folder. If you store this file in theWorkarea folder,
the file will be lost when you upgrade.

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to
cache the data for fiveminutes, set this property to 300 (three hundred). See Also:
”Caching with Server Controls” on page 43.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document
asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.
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A Blog Post icon appears and indicates the Blog Post’s location on the
template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:BlogPost id="BlogPost1" DefaultContentID="370"
runat="server"></cms:BlogPost>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog Recent Posts
For a description of the Blog Recent Posts function, see BlogRecentPosts Server
Control on page 7-522.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls... > Blogs

To insert the Blog Recent Posts function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Recent
Posts.

3. The Insert Ektron CMS400.NET Blog Recent Posts box appears.
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4. Use the following table to assist you with inserting the Blog Recent
Posts function.

Field Description

Control ID A unique name for the function you are inserting.

Blog ID The ID of the blog in Ektron CMS400.NET. If you do not know the Blog ID, you can
choose it from the Select Folder drop down box.

NumberofPosts Sets the number of post links to display.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to
cache the data for fiveminutes, set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Blog Recent Posts icon appears and indicates the Blog Recent Posts’
location on the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:BlogRecentPosts id="BlogRecentPosts1" BlogID="41"
runat="server"></cms:BlogRecentPosts>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.
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Blog Roll
For a description of the Blog Roll function, see BlogRoll Server Control on page
7-519.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls... > Blogs

To insert the Blog Roll function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog Roll.

3. The Insert Ektron CMS400.NET Blog Roll box appears.

4. Use the following table to assist you with inserting the Blog Roll
function.

Field Description

Control ID A unique name for the function you are inserting.

Blog ID The ID of the blog in Ektron CMS400.NET. If you do not know the Blog ID, you can
choose it from the Select Folder drop down box.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to
cache the data for fiveminutes, set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33
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Field Description

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click Insert.

A Blog Roll icon appears and indicates the Blog Roll’s location on the
template.

Shown below is an example of the code that is inserted:
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Platform Code View

.NET <cms:BlogRoll id="BlogRoll1" BlogID="41" runat="server"></cms:BlogRoll>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Blog RSS
For a description of the Blog RSS function, see BlogRSS Server Control on page
7-523.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls... > Blogs

To insert the Blog RSS function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Blog RSS.

3. The Insert Ektron CMS400.NET Blog RSS box appears.

4. Use the following table to assist you with inserting the Blog RSS
function.

Field Description

Control ID A unique name for the function you are inserting.
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Field Description

Blog ID The ID of the blog in Ektron CMS400.NET. If you do not know the Blog ID, you can
choose it from the Select Folder drop down box.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to
cache the data for fiveminutes, set this property to 300 (three hundred). See Also:
Caching with Server Controlson page 24-33

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click Insert.

A Blog RSS icon appears and indicates the Blog RSS’s location on the
template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET <cms:BlogRSS id="BlogRSS1" BlogID="41" runat="server"></cms:BlogRSS>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

BreadCrumb
For a description of the BreadCrumb function, see BreadCrumb Server Control
on page 9-283.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
CMS MENU Controls...

To insert a BreadCrumb Trail:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click BreadCrumb.

3. The BreadCrumb dialog box appears.
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4. Use the following table to assist you with inserting a BreadCrumb
Trail.

Field Description

Control ID A unique name for the function you are inserting.

Meta tag to use -
MetadataName

Specify the name of aMetadata Type that you want to associate with the page. For
more information, seeBreadCrumbMetadata Type on page 9-290

DisplayTitle

Enter text to describe thisWeb formwhen it appears in the breadcrumb trail. For
example, if theWeb formwhose properties you are defining is used for all Human

Resourcespageson your site, enter Human Resources.See Also:
BreadCrumbPropertiesApply toWeb Forms, NotWeb Pageson page 9-285

The default isTitle.

If you define an image in the IconPathproperty below, the image appears in the
trail, followed by this text.
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Field Description

CurrentPageIndicator

If desired, enter one or more symbols or characters that identify the current page in
the breadcrumb trail. See example below.

These characters appear after the image or title that identifies the current page in
the breadcrumb trail.

Content ID
Gets or Sets the ContentID for the BreadCrumb display title. If you do not know the
Content ID, you can navigate to it using the Select Category and Select Content
drop down boxes.

DynamicContent
Parameter Gets or sets the QueryString parameter to read a content ID dynamically.

IconPath

If you want the breadcrumb trail to display an image to identify thisWeb form, enter
the path to the image.

Warning! The image locationmust be relative to theWeb root.

For example: \CMS400Developer\Workarea\Images\bc_meta_icon.gif

IconAlt

If you define an image in the IconPathproperty, enter any “Alt” text that should
appear when a site visitor hovers the cursor over that image. Here is an example.

LinkTarget

Determines the type of window that appears on thisWeb formwhen a user clicks an
item in the breadcrumb trail. The default is_self.

_Self -opens in samewindow

_Top - opens in parent window

_Blank - opens in new window

_Parent - opens in the parent frame

LinkLast Item

Use this property to determine whether the last breadcrumb item appears asa
hyperlink on thisWeb form. If this property box is checked, and a user clicks the item,
the current page reappears.

Checked = last item is a hyperlink

Unchecked = last item is an image and/or text only; the user cannot click on it
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Field Description

Create Hyperlinks

Unchecking this boxmakes the breadcrumb trail appear asnon-hyperlinked plain
text. The default isChecked.

Checked =breadcrumb trail is hyperlinked

Unchecked =breadcrumb trail is plain text

MaxItems

Enter themaximum number of items in the breadcrumb trail on thisWeb form.

The default is5.

If you set a value of 1 or greater and the user navigatesbeyond that number of
pages, only themost recent pagesappear. The older pagesdisappear from the trail.

To allowsan unlimited number of breadcrumb trail itemson thisWeb form, enter
zero (0).

Separator

Enter one or more characters to separate the items in a breadcrumb trail on this
Web form.

The default character is the greater than sign (>).

DisplayStyle

Indicate how to display the breadcrumb trail: horizontally or vertically. The default is
Horizontal.

This is an example ofHorizontal.

This is an example ofVertical.
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Field Description

Mode

Allowsyou tomake the breadcrumb trail appear asnon-hyperlinked plain text. The
default isNormal.

Normal =breadcrumb trail is hyperlinked

DisplayOnly =breadcrumb trail is plain text

Hide

Used to hide a BreadCrumb in design time and run time.

Checked =Hide BreadCrumb

Unchecked =Show BreadCrumb

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document
asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

Style (Positioning Info
- GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb
page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

5. When completed, click Insert.

A graphic defines where the BreadCrumb Trail appears on your
template.

BreadCrumb

ReferenceManual
Version 8.01 Rev 4

27-63



Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:BreadCrumb id="BreadCrumb1" CurrentPageIndicator="*"
myDisplayTitle="Home Page" LinkLastItem="True"
runat="server"></cms:BreadCrumb>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Calendar
This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS
Function...

or

n Commands > Ektron CMS400.NET (Server Controls) >
CMS Modules Controls...

To insert an Calendar function:

Note: Inserting a calendar function does not add a reference to a calendar style sheet. This
step must be performed manually.

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click on Calendar

3. The Insert Calendar box is displayed.
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Warning!When inserting an event calendar using ASP, CF, JSP or PHP, the dialog box that
appears only allows you to set the Calendar ID or choose one from the list.

4. Use the following table to assist you with inserting a calendar.

Field Description

Control ID

Warning! Used
in ASP.NET only.

A unique name for the function you are inserting.

Content ID Type in the Content ID of the calendar that you want to insert. If you do not know the
Content ID, you can navigate to it using the Select Calendar drop down box.

Select Calendar
The drop-down box is populated with a list of all the calendar titles.When a title is
selected, the content ID textbox is filled with that content block's id number. If you insert
the calendar ID, you do not need to select a calendar.

DynamicContent
Parameter

Warning! Used
in ASP.NET only.

Tomake this calendar dynamic, select calendar_id. When you do, this server control
uses the calendar passed asa URL parameter.

Calendar
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Field Description

DisplayType

Warning! Used
in ASP.NET only.

Specify the Calendar view type. The default isMonth.

n Month - A 30 day calendar month view.

n Day - Single day view.

n Inline - Displayevents that occur from the start date of the calendar through the end
date.

n MonthUpWithEvent - Displaysamonth calendar. Events appear to the right of the
calendar when you click on a day.

ShowXML

Warning! Used
in ASP.NET only.

At runtime, output the raw XML data instead of the calendar.With thisXML data, you
can apply your own XSL to create your own custom display formats.

Default isUnchecked.

Checked =Show raw XML data

Unchecked =Show Calendar

EndDate

Warning! Used
in ASP.NET only.

Specify the end date the calendar displays. Used in conjunction with the StartDate
property. For example, you have a calendar that showsonly classes for the next three
month semester.

StartDate

Warning! Used
in ASP.NET only.

Specify the start date the calendar displays. Used in conjunction with the EndDate
property. For example, you have a calendar that showsonly classes for the next three
month semester.

Hide

Warning! Used
in ASP.NET only.

Used to hide a calendar in design time and run time.

Checked =Hide calendar

Unchecked =Show calendar

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Warning! Used
in ASP.NET only.

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Warning! Used
in ASP.NET only.

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Warning! Used
in ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.
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Field Description

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the calendar appears on your template.

Shown below is an example of the code that is inserted.

Platform Code View

.NET
<cms:Calendar id="Calendar1" DefaultCalendarID="1"
runat="server"></cms:Calendar>

ASP <% ecmEvtCalendar (1) %>

ColdFusion
<cfmodule Calendar_id="1"
template="#request.ecm.AppPath#ecmEvtCalendar.cfm">

JSP <%= ecmEvtCalendar(1) %>

PHP <?php ecmEvtCalendar (1); ?>

Collection
For a description of the Collection function, see Collection Server Control on
page 9-122

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) >
CMS Function...

or

Collection
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n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert a collection:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Collection.

3. The Insert Ektron Collection box is displayed.

Warning!When inserting a collection using ASP, CF, JSP or PHP, a different dialog box appears.

4. Use the following table to assist you with inserting a Collection.

Field Description

Control ID

Warning! Used
in ASP.NET only.

A unique name for the function you are inserting.

Collection ID
If you know the collection ID, enter it into the textbox. If you do not know the
Collection ID, you can navigate to it using the Select Collection drop down
box.

Select Collection

The drop-down list is filled with a list of all the Collection titles that you have
privileges to.When a title is selected, the Collection ID textbox is filled with
that Collection's id number. If you insert the Collection ID, you do not need
to select a category.
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Field Description

DisplayXslt

Determineshow the information on the page is displayed.

None - databind only

ecmNavigation - lists the title of every content block in the collection

See Also: Example of ecmNavigation Displayon page 9-127
ecmTeaser - lists the title of every content block in the collection plus the
content summary

See Also: Example of ecmTeaser Displayon page 9-128

Warning! If you specify an external file, it is strongly recommended that
you do not store this file in your site'sWorkarea folder. If you store this file
in theWorkarea folder, the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at the MarkupLanguage
property, the Displayxsltproperty value is ignored.

LinkTarget

Warning! Used
in ASP.NET only.

Defines the waya link actswhen a link is clicked.

Choicesare:

_blank - This target causes the link to alwaysbe loaded in a new blank
window. Thiswindow is not named.

_self - This target causes the link to always load in the samewindow the
anchor was clicked in. This is useful for overriding a globally assigned
BASE target.

_parent - This target makes the link load in the immediate frameset
parent of the document. This defaults to acting like “_self” if the document
hasno parent.

_top - This target makes the link load in the full bodyof the window. This
defaults to acting like “_self” if the document is alreadyat the top. It is useful
for breaking out of an arbitrarily deep frame nesting.

DynamicContent
Parameter

Warning! Used
in ASP.NET only.

Checks theQueryString for this value and replaces the collection with a
content blockwhen specified. Leave blank to alwaysdisplay the collection.

Dynamic
Collection
Parameter

Warning! Used
in ASP.NET only.

Tomake this collection dynamic, select coll_id. When you do, the function
uses the collection passed asa URL parameter.

GetHtml

Warning! Used
in ASP.NET only.

Check this box if you want to retrieve and display content (html body) for all
content blocks in the collection. For example, to display content inside a
web server control such asaGridView.

Checked = retrieve and display content (html body) for all content blocks
in the collection

Unchecked =do not retrieve and display content (html body) for all
content blocks in the collection

Collection
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Field Description

Random

Warning! Used
in ASP.NET only.

Check this box if you want to randomlydisplay one collection item. The
item changeseach time a site visitor views the page.

Checked = randomlydisplay one collection item

Unchecked =display collection list

# of seconds -
CacheInterval

Warning! Used
in ASP.NET only.

Sets the amount of time the server control’s data is cached. The default is
0 (zero). This is the amount of time, in seconds, a control’s data is cached.
For example, if you want to cache the data for fiveminutes, set this

property to 300 (three hundred).See Also: Caching with Server
Controlson page 24-33

Warning! If the EnablePagingproperty is set to True, the
CacheIntervalproperty is disabled.

MarkupLanguage

Warning! Used
in ASP.NET only.

Identify the templatemarkup file that controls the display of the collection.
For example, mycollectionmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing
the server control, just enter its name. If the file is in another folder, enter
the path relative to site root. For example,

..\CMS400Developer\workarea\customfiles\

markup\mycollectionmarkup.ekml.

See Also: Controlling Output with EktronMarkup Language on page
26-1 and collection.ekmlon page 26-32

Note: Note: If you enter a valid EkML file, the Displayxsltproperty
value is ignored. If the EkML file contains the [$ImageIcon]variable,
the IncludeIconsproperty acts asTrue.

IncludeIcons

Warning! Used
in ASP.NET only.

Choose whether to display iconsnext to the collection list’s links.

Warning! This property onlyworkswhen ecmSummaryor ecmTeaser
are used in the DisplayXsltproperty.When the [$ImageIcon]
variable is used in an EkML file and that file is assigned to the
MarkupLanguageproperty, this property acts asTrue.

UsingOther Development Frameworks

27-70 ReferenceManual
Version 8.01 Rev 4



Field Description

EnablePaging

Warning! Used
in ASP.NET only.

This property, in conjunction with the MaxResultsproperty, lets site
visitors view an unlimited number of collection itemswhile controlling the
amount of screen space. To accomplish this, the collection display is limited
to the number set in the MaxResultsproperty.

If you set this property box is checked, and the number of collection items
exceeds the MaxResultsnumber, navigation aidsappear below the last
item. The site visitor uses the aids to view additional items. See example
below.

So, for example, if a collection has9 itemsand the MaxResultsproperty is
set to 4, the screen displaysonly the first four items.When the site visitor
clicks [Next], he sees items5, 6, 7 and 8, etc.

Checked =enable paging

Unchecked =disable paging

Warning! If the EnablePagingproperty is set to True, the
CacheIntervalproperty is disabled.

MaxResults

Warning! Used
in ASP.NET only.

Enter themaximum number of items to appear in the initial display of this
server control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount of
space being occupied, enter themaximum number of results per page
here. Then, check the EnablePagingproperty box.

If you do andmore than the number of MaxResultsare available,
navigation aidsappear below the last item to help the site visitor view
additional items. See example below.

Collection
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Field Description

Hide

Warning! Used
in ASP.NET only.

Used to hide a collection in design time and run time.

Checked =Hide collection

Unchecked =Show collection

Note: Note: If Hideand Visibleare both checked, the property is
hidden.

Visible

Warning! Used
in ASP.NET only.

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is
hidden.

Style (Positioning
Info - GridLayout)

Warning! Used
in ASP.NET only.

Set position information of a control as absolute, when using aGridLayout
Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Warning! Used
in ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML
document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof
code.

SuppressWrapper

Warning! Used
in ASP.NET only.

Suppresses the output of the span/div tagsaround the control. The default
isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the collection appears on your template.
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Shown below is an example of the code that is inserted.

Platform Code View

.NET
<cms:Collection id=”Collection1” DefaultCollectionID=”6”
DisplayXslt=”ecmTeaser” runat=”server”></cms:Collection>

ASP <% ecmCollection 6,"ecmNavigation" %>

ColdFusion
<cfmodule id="6" displayFunction="ecmNavigation"
template="#request.ecm.AppPath#ecmCollection.cfm">

JSP <%= ecmCollection(6,"ecmTeaser") %>

PHP <?php ecmCollection(6,"ecmNavigation"); ?>

Content Block
This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) >
CMS Function...

or

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

For a description of the Content Block function, see ContentBlock Server
Control on page 7-194.

To insert a content block:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Content.

3. The Insert Content box is displayed

Content Block
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Warning!When inserting a Content Block using ASP, CF, JSP or PHP, a different dialog box
appears.

4. Use the following table to help you insert a content block.

Field Description

Control ID

Warning! Used in ASP.NET only.
A unique name for the function you are inserting.

Content ID

Specify the ID number of the content block that you wish to use asa
content blockon theWeb page. If you do not know the Content ID,
you can navigate to it using the Select Category and Select Content
drop down boxes.

Select Category Choose the folder where the content is located. If you insert the
content ID, you do not need to select a category.

Select Content Select the content block to use from the list. If you insert the content
ID, you do not need to select content.

DynamicContent Parameter

Warning! Used in ASP.NET only.

Determines if content is displayed as static or passed dynamically. By
making content dynamic, when the content displayed on aWeb page
contains a link to another piece of content, you can display the second
piece of content in the sameWeb page space.

None: Displaysa static content block.

id: Content block is passed asa URL parameter.

Warning! If you are using an ASP, CF, JSP or PHPpage, youmust
use the DynamicContent BlockTag to create a dynamic content
block. SeeDynamicContent Blockon page 27-105

DisplayXslt

Warning! Used in ASP.NET only.

Specify an externalXSLT file.See Also: TheOverrideXslt and
DisplayXslt Propertieson page 7-199

Warning! If you specify an external file, it is strongly recommended
that you do not store this file in your site'sWorkarea folder. If you
store this file in theWorkarea folder, the file will be lost when you
upgrade.
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Field Description

Hide

Warning! Used in ASP.NET only.

Used to hide a collection in design time and run time.

Checked =Hide collection

Unchecked =Show collection

Note: Note: If Hideand Visibleare both checked, the property
is hidden.

Visible

Warning! Used in ASP.NET only.

Used to show or hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property
is hidden.

# of seconds - CacheInterval

Warning! Used in ASP.NET only.

Sets the amount of time the server control’s data is cached. The
default is 0 (zero). This is the amount of time, in seconds, a control’s
data is cached. For example, if you want to cache the data for five

minutes, set this property to 300 (three hundred).See Also:
Caching with Server Controlson page 24-33

Style (Positioning Info - GridLayout)

Warning! Used in ASP.NET only.

Set position information of a control as absolute, when using a
GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:
240px"

Wrap Tag

Warning! Used in ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

SuppressWrapper

Warning! Used in ASP.NET only.

Suppresses the output of the span/div tagsaround the control. The
default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

Note: You see only the list of Ektron CMS400.NET content blocks if you are working online.

5. Click insert.

A graphic indicates the static content block’s location on the template.
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Shown below is an example of the code that is inserted.

Platform Code View

.NET <cms:contentblock id="ContentBlock1" DefaultContentID="12"
runat="server"></cms:contentblock>

ASP <%ecmContentBlock(1) %>

ColdFusion <cfmodule id=”1” template=”#request.ecm.AppPath#ecmContentBlock.cfm”>

JSP <%=ecmContentBlock(12) %>

PHP <?php ecmContentBlock(1); ?>

Content List
For a description of the Content List function, see ContentList Server Control on
page 7-202 .

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert the Content List function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Content List.

3. The Insert Ektron CMS400.NET Content List box appears.
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4. Use the following table to assist you with inserting the Content List
function.

Field Description

Control ID A unique name for the function you are inserting.

ContentIds
A comma delimited list of content blocks IDs.

See Also: Using the ContentID Property to Displaya Content List on page 7-210

MetaTag

Specify aMetadata definition whose type isContent Selector.When you do, the
associated list of content itemswill appear where you place the server control.

Warning! You cannot insert other metadata types.

Thisworkswith the DefaultContentIDproperty.

See Also: UsingMetadata to Displayan Associated Content List on page 7-208
For more information about usingmetadata to assign a list of related content to a
content item, seeRelated Content Metadata on page 7-146.

DefaultContentID
Set content id value. Once set, content IDsare generated from theMetaTag value for
this content. If you do not know the content’s ID, you can navigate to it using the Select
Category and Select Content drop down boxes.

DynamicParameter Tomake the content dynamic, select id. When you do, this server control uses the
content passed asa URL parameter.

Content List
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Field Description

Random

Check this box if you want to randomlydisplay one content list item. The item changes
each time a site visitor views the page.

Checked = randomlydisplay one content list item

Unchecked =display the content list

GetHtml

Check this box if you want to retrieve and display content (html body) for all content
blocks in the content list. For example, to display content inside a web server control
such asaGridView.

Checked = retrieve and display content (html body) for all content blocks in the
content list

Unchecked =do not retrieve and display content (html body) for all content blocks in
the content list

Order By

Sort the list by one of the valuesbelow.

n Title - the order of the content’s title.

n Date Modified - the last date the content wasmodified.

n Date Created - the date the content was created.

n Last Author First Name - the last editor’s first name.

n Last Author Last Name - the last editor’s last name.

n OrderOfTheIds - preserves the content ID order based on the list in the
ContentIdsproperty.

Direction Choose whether the list is sorted in Ascending or Descending order.

DisplayXslt

Determineshow information on the page is displayed.

None-databind only

ecmNavigation - lists the title of each content block

See Also: Example of ecmNavigation Displayon page 9-127

ecmTeaser - lists the title of each content blockplus the content summary

See Also: Example of ecmTeaser Displayon page 9-128

ecmUnOrderedList - sorts the list in no particular order. Shows the title and content
summary

Warning! If you specify an external file, it is strongly recommended that you do not
store this file in your site'sWorkarea folder. If you store this file in theWorkarea folder,
the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at the MarkupLanguageproperty, the
Displayxsltproperty value is ignored.
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Field Description

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe loaded in a new blankwindow. This
window is not named.

_self - This target causes the link to always load in the samewindow the anchor was
clicked in. This is useful for overriding a globally assigned base target.

_parent - This target makes the link load in the immediate frameset parent of the
document. This defaults to acting like "_self" if the document hasno parent.

_top - This target makes the link load in the full bodyof the window. This defaults to
acting like "_self" if the document is alreadyat the top. It is useful for breaking out of an
arbitrarily deep frame nesting.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to

cache the data for fiveminutes, set this property to 300 (three hundred).See Also:
Caching with Server Controlson page 24-33

IncludeIcons

Choose whether to display iconsnext to the content list’s links.

Warning! This property onlyworkswhen ecmSummaryor ecmTeaser are used in
the DisplayXsltproperty.When the [$ImageIcon]variable is used in an EkML file
and that file is assigned to the MarkupLanguageproperty, this property acts asTrue.

MarkupLanguage

Identify the templatemarkup file that controls the display of the content list. For
example, mycontentlistmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing the server
control, just enter its name. If the file is in another folder, enter the path relative to site
root. For example, ..\CMS400Developer\workarea\customfiles\

markup\mycontentlistmarkup.ekml.

See Also: Controlling Output with EktronMarkup Language on page 26-1 and
contentlist.ekmlon page 26-36

Note: Note: If you enter a valid EkML file, the DisplayXsltproperty value is
ignored. If the EkML file contains the [$ImageIcon]variable, the IncludeIcons
property acts asTrue.

Content List
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Field Description

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document
asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Content List icon appears and indicates the Content List’s location on
the template.

Shown below is an example of the code that is inserted:
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Platform Code View

.NET
<cms:ContentList ID="ContentList1" DynamicParameter="id"
DefaultContentID="30" OrderKey="DateCreated" DisplayXslt="ecmTeaser"
runat="server"></cms:ContentList>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Content Rating
For a description of the Content Rating function, see ContentRating Server
Control on page 7-742 .

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert the Content Rating function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click ContentRating.

3. The Insert Ektron CMS400.NET Content Rating box appears.

4. Use the following table to assist you with inserting the Content Rating
function.

Content Rating
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Field Description

Control ID A unique name for the function you are inserting.

Content ID
Specify the ID number of a content item being tracked by this function. If you do not
know the Content ID, you can navigate to it using the Select Category and Select
Content drop down boxes.

DynamicContent
Parameter

Tomake this content rating control dynamic, select id. When you do, this server control
is attached to the content blockpassed asa URL parameter.

CompleteGraph
Display

Specify a value to indicate how the ratingsgraph appears if a site visitor hasalready
rated content.

n horizontal - graph appears to the right of the AlreadyRatedMessage

n vertical - graph appears below the AlreadyRatedMessage

none - graph doesnot appear

GraphBarColor The color of the bars in the graph.

InitialGraphDisplay

Specify a value to indicate how the ratingsgraph appears if a site visitor hasnot yet
rated content.

n horizontal - graph appears to the right of the content rating scale

n vertical - graph appears below the content rating scale

none - graph doesnot appear

Padding

Enter the number of pixels used to create space between the rating scale and the
graph.

Note: Note: If you do not display the graph, this setting hasno effect.

Hide

Used to hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"
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Field Description

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

An Content Rating icon appears and indicates the Content Rating’s
location on the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:ContentRating id="ContentRating1" DefaultContentID="30"
runat="server"></cms:ContentRating>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Content XSLT Tag...
The insert content XSLT command allows you to insert an XML content block,
and specify an XSLT (other than the default) to be applied to it.

This tag appears on the following menu(s):

Content XSLT Tag...
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n Commands > Ektron CMS400 - (ASP CF JSP PHP) > XML
Function...

To insert a content XSLT tag, perform the following steps:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET XML functions, click on Insert
Content XSLT Tag...

3. The Insert Ektron CMS400.NET Content and Apply an XSLT Tag box is
displayed.

4. Use the following table to assist you with this form.

Field Description

Content
ID Either type in, or select from the drop down lists, the ID number of the XML content to insert.

Select
XSLT From the drop down list, select the XSLT you would like to apply to the XML content block.

Enter
XSLT

If “Enter XSLT” is selected, you can insert the path and file name of the XSLT to apply to the
content.

Warning! If you specify an external file, it is strongly recommended that you do not store this file
in your site'sWorkarea folder. If you store this file in theWorkarea folder, the file will be lost when
you upgrade.

5. Click insert.

A graphic showing you where the XML content block will be placed on the
template is inserted.

UsingOther Development Frameworks

27-84 ReferenceManual
Version 8.01 Rev 4



Shown below is the code that will be inserted according to the platform that has
been specified in the setup:

Platform Code View

.NET This function is not available asan Ektron Dreamweaver Extension for .NET.

ASP <% ecmContentBlockEx 30, "", 1 %>

ColdFusion
<cfmodule id="5" xsltpath="" xslttype="1"
template="#request.ecm.AppPath#ecmContentBlockEx.cfm">

JSP <%= ecmContentBlockEx(24, "", 0 ) %>

PHP <?php ecmContentBlockEx (5, ““, 1); ?>

DHTML Menu
For a description of the DHTML Menu function, see DhtmlMenu Server Control
on page 9-194 .

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
CMS MENU Control...

To insert a DHTML Menu:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click DHTML Menu

The DHTML Menu Control box appears.

DHTMLMenu
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3. Use the following table to assist you with inserting a DHTML Menu.

Field Description

Control ID A unique name for the function you are inserting.

DefaultMenuID
The numeric id of themenu that you want to insert. If you do not know the
DefaultMenuID path, you can navigate to it using the Select Menu drop down
box.

Select Menu
Select amenu to be used.When amenu is selected, the DefaultMenuID textbox
is filled with that menu's id number. If you insert the DefaultMenuID, you do not
need to select amenu.
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Field Description

Align

Specifies the horizontal alignment of the root menu text.

The default isCenter.

NotSet - Use the default setting.

Left - Aligns text to the left.

Center - Aligns text to the center.

Right - Aligns text to the right.

Justify - Aligns text justified to bothmargins.

HorizontalDisplay

Displays submenu to the right of the root menu. This only affects the first
submenu of the root menu. All subsequent submenusappear to the right of
each submenu.

The default isUnchecked

Checked =Submenu appears to the right of the root menu

Unchecked=Submenu appears below the root menu

DHTMLMenu
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Field Description

CssClass

Apply a .css class to the root menu. Enter the classname from the .cssdefined
in the Stylesheetproperty.

Since pop_style.css is the default style sheet, you can use its classeswithout
defining it in the Stylesheetproperty.

For example, if you enter lowtext in the property, the root menu changesas
shown below.

MenuHoverOverColor Sets the background color for the root menu when hovering over it.

SubMenuBackColor Sets the background color for the submenu.

SubMenuHoverOverColor Sets the background color for the submenuwhen hovering over it.

BackColor Sets the background color for the root menu. This property appears in the
Appearance category

ForeColor Sets the color of the font for the root menu. This property appears in the
Appearance category.

Font-Bold Checking this boxallows the font to appear bold.

Font_Italic Checking this boxallows the font to appear italics.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0
(zero). This is the amount of time, in seconds, a control’s data is cached. For
example, if you want to cache the data for fiveminutes, set this property to 300

(three hundred).See Also: Caching with Server Controlson page 24-33

FontNames Enter the name of a font to use.

Font-Size The size of the font.

SubMenuItemHeight

Sets the height of each submenu item in pixels. The Default is 20

Example set to 20:

Example set to 30:
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Field Description

SubMenuItemWidth

Sets the width of each submenu item in pixels. The Default is 150

Example set to 150:

Example set to 130:

SubMenuTopOffset

Sets the location of the top of the submenu. This number is in pixels. The default
is 3

Example set to 5:

Example set to 0 (zero):

Example set to -10:

MenuStyle

A specified inline style that defines the root menu.

For example, if you enter the following in the MenuStyleproperty box:

font: bold 18px Arial;color:royalblue; background-
color:slateblue

StyleSheet

Specify the location and style sheet for the submenu. For example:
\Workarea\csslib\mytest.css.

Leave blank to use the default.

pop_style.css is the default style sheet. It is located in
\webroot\CMS400Developer\Workarea\csslib.

The Stylesheetproperty can be used in conjunction with the CssClass
property to define the root menu.
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Field Description

DynamicMenu Parameter

Checks theQueryString for themenu value and replaces themenuwith content
when ID is specified. Leave blank to alwaysdisplay themenu.

None - Use Default

menu_ID - The control uses themenu passed asa URL parameter.

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML
document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Hide

Used to hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning Info -
GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb
page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

4. When completed, click insert.

A graphic defines where the DHTML Menu appears on your template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:DhtmlMenu id="DhtmlMenu1" DefaultMenuID="16" ForeColor=""
runat="server"></cms:DhtmlMenu>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.
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Platform Code View

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Directory-Taxonomy
For a description of the Directory-Taxonomy function, see Directory Server
Control on page 9-258.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert a Directory-Taxonomy:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Directory-
Taxonomy

The Directory-Taxonomy Control box appears.

3. Use the following table to assist you with inserting a Directory-
Taxonomy.
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Field Description

Control ID A unique name for the function you are inserting.

TaxonomyId

Enter the ID number of the taxonomyor category to appear in this server control. If
you don’t know the number, click the button and navigate to the taxonomyor
category.

When you select one, it appears in the center of the VisualStudio window.

ItemsControlId Specify the id of the <span>or <div> tag you will use to format the display of
taxonomy items.

TaxonomyCols Enter the number of columns in which this taxonomy/categorywill appear on the
page.

TaxonomyDepth

Enter the number of taxonomy levels to retrieve below each taxonomy/category. Only
the top level is displayed in the control. The rest of the levels are available through
XML in code behind. For example, if the taxonomy isBusinesses > Restaurants >
Pizza, and you set Taxonomy Depth to 2, onlyBusinessand Restaurants are
available in code behind.

To retrieve the all of the categories for a taxonomy recursively, enter -1.

A depth greater than 1 or using -1 is only useful if you create a custom output using
the Taxonomy’sXML.

The default value is 1

Warning! For a live site, Ektron strongly recommends leaving this value at 1.
Increasing this value can slow down your liveWeb server. However, for testing on a
staging server, you can increase the depth.

DynamicParameter Gets or sets the QueryString parameter to read a content ID dynamically.

LinkTarget

Defines the waya link actswhen it is clicked. The choicesare:

_blank - loads the link in a new blankwindow. Thiswindow is not named.

_self - loads the link in the samewindow the anchor was clicked in. This is useful for
overriding a globally assigned base target.

_parent - loads the link in the immediate frameset parent of the document. This
defaults to acting like “_self” if the document hasno parent.

_top - loads the link in the full bodyof the window. This defaults to acting like “_self” if
the document is alreadyat the top. It is useful for breaking out of an arbitrarily deep
frame nesting.
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Field Description

MaxResults

Enter themaximum number of items to appear in the initial display of this server
control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount of space being
occupied, enter themaximum number of results per page here. Then, check the
EnablePagingproperty box.

If you do andmore than the number of MaxResultsare available, navigation aids
appear below the last item to help the site visitor view additional items. See example
below.

EnableAjax

Check this box to enable Ajax searches.When enabled, the MaxResultsproperty
determines themaximum number of results per page.

Checked =Enable AjaxSearch

Unchecked =OriginalHTMLSearch

EnablePaging

This property, in conjunction with the MaxResultsproperty, lets site visitors view an
unlimited number of taxonomy itemswhile controlling the amount of screen space. To
accomplish this, the taxonomydisplay is limited to the number set in the MaxResults
property.

If you check this property box, and the number of taxonomy itemsexceeds the
MaxResultsnumber, navigation aidsappear below the last item. The site visitor uses
the aids to view additional items. See example below.

So, for example, if a taxonomyhas9 itemsand the MaxResultsproperty is set to 3,
the screen displaysonly the first three items.When the site visitor clicks [Next], he
sees items4, 5 and 6, etc.

Checked =enablespaging

Unchecked =disablespaging

Warning! If the EnablePagingproperty is set to True, the CacheInterval
property is disabled.
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Field Description

TaxonomySearch

Check this box if you want a search box (shown below) to appear above this
taxonomydisplay. A site visitor can use the search to find content within a
taxonomy/category that includes termsof interest.

Checked =a search boxappears above the taxonomydisplay

Unchecked = suppress the search box

DisplayXslt

Determineshow the information on the page is displayed. Optionsare

None - databind only

ecmNavigation - lists the title of every content block in the folder

See Also: . Example of ecmNavigation Displayon page 9-127
ecmTeaser - lists the title of every content block in the folder plus the content
summary

See Also: Example of ecmTeaser Displayon page 9-128

Path to Custom Xslt - Enter the path to an Xslt that determines the display of the
page

Warning! If you specify an external file, it is strongly recommended that you do not
store this file in your site'sWorkarea folder. If you store this file in theWorkarea
folder, the file will be lost when you upgrade.

Note: If an EkML file is inserted into the MarkupLanguageproperty, this value is
ignored.

NaviDisplayControlId
Specify the id of the <span>or <div> tag to format the display of this taxonomy’s
navigation. Here is an example.

Top : Restaurant : Italian (0)

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero).
This is the amount of time, in seconds, a control’s data is cached. For example, if you

want to cache the data for fiveminutes, set this property to 300 (three hundred).See
Also: Caching with Server Controlson page 24-33

Warning! the EnablePagingproperty is set to True, the CacheIntervalproperty
is disabled.
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Field Description

MarkupLanguage

Identify the templatemarkup file that controls the display of the taxonomy. For
example, mytaxonomymarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing the server
control, just enter its name. If the file is in another folder, enter the path relative to site
root. For example, \CMS400Developer\workarea\customfiles\

markup\mytaxonomymarkup.ekml.

See Also: . Controlling Output with EktronMarkup Language on page 26-1 and
taxonomy.ekmlon page 26-59

Note: Note: If you enter a valid EkML file, the Displayxsltproperty value is
ignored.

Hide

Used to hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document
asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

4. When completed, click insert.

A graphic defines where the Directory-Taxonomy appears on your
template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:Directory id="Directory1" TaxonomyId="2" DisplayXslt="ecmTeaser"
DynamicParameter="id" runat="server"></cms:Directory>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Discussion Forum
For a description of the Discussion Forum function, see Discussion Board Server
Controls on page 7-639.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls... > Forums

To insert the Discussion Forum function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Discussion
Forum.

3. The Insert Ektron CMS400.NET Discussion Forum box appears.
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4. Use the following table to assist you with inserting the Blog function.

Field Description

Control ID A unique name for the function you are inserting.

Board ID The ID of the Discussion Board in Ektron CMS400.NET. If you do not know the
Board ID, you can choose it from the Select Folder drop down box.

JavascriptEditorToolbar
Note: Note: Asof version 7.6, the JavaScript editor hasbeen removed from
Ektron CMS400.NET. This property hasbeen deprecated.

Decide which buttonsare available in the JavaScript Editor.

JavascriptEditorWidth
Note: Note: Asof version 7.6, the JavaScript editor hasbeen removed from
Ektron CMS400.NET. This property hasbeen deprecated.

Set the width in pixels for the editor. The default is625.

JavascriptEditorHeight
Note: Note: Asof version 7.6, the JavaScript editor hasbeen removed from
Ektron CMS400.NET. This property hasbeen deprecated.

Set the height in pixels for the editor. The default is400.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero).
This is the amount of time, in seconds, a control’s data is cached. For example, if
you want to cache the data for fiveminutes, set this property to 300 (three

hundred).See Also: Caching with Server Controlson page 24-33

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning Info -
GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb
page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML
document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Discussion Forum icon appears and indicates the Discussion Forum’s
location on the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET <cms:Forum id="Forum1" BoardID="106" runat="server"></cms:Forum>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.
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Platform Code View

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Display By Meta Value
For a description of the Display By Meta Value function, see MetaDataList
Server Control on page 7-169.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert Display By Meta Value:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Display By
Meta Value

The Display By Meta Value box appears.
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3. Use the following table to assist you with inserting Display By Meta
Value.

Field Description

Control ID A unique name for the function you are inserting.

FolderID The numeric id of the folder that you want to use. If you do not know the folder ID, you
can navigate to it using the Select folder drop down box.

Select Folder
Select a folder path to be used.When a folder is selected, the folderID textbox is filled
with that folder's id number. If you insert the Folder ID, you do not need to select a
folder.

IncludeIcons

Choose whether to display iconsnext to themetadatalist’s links.

Warning! This property onlyworkswhen ecmSummaryor ecmTeaser are used in the
DisplayXsltproperty.When the [$ImageIcon]variable is used in an EkML file and
that file is assigned to the MarkupLanguageproperty, this property acts asTrue.

Recursive Determineswhether the DisplayByMeta Value control uses this folder’s child folders.
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Field Description

EnablePaging

This property, in conjunction with the MaxResultsproperty, lets site visitors view an
unlimited number of taxonomy itemswhile controlling the amount of screen space. To
accomplish this, the taxonomydisplay is limited to the number set in the MaxResults
property.

If you check this property box, and the number of taxonomy itemsexceeds the
MaxResultsnumber, navigation aidsappear below the last item. The site visitor uses
the aids to view additional items. See example below.

So, for example, if a taxonomyhas9 itemsand the MaxResultsproperty is set to 3, the
screen displaysonly the first three items.When the site visitor clicks [Next], he sees
items4, 5 and 6, etc.

Checked =enablespaging

Unchecked =disablespaging

Warning! If the EnablePagingproperty is set to True, the CacheIntervalproperty
is disabled.

Order By

Specify how you want to order the results that are generated. Also specify if you want
the results in ascending or descending order.

n Title - The title of the content block

n Date Created - The date the content blockwascreated

n Date Modified - The date the content blockwas last modified

n Last Author Last Name - The last author’s last name

n Last Author First Name - The last author’s first name

n ID - The content blocks ID

n Ascending - Alphabetic or numerical order

n Descending - Reverse alphabetic or numerical order

Display ByMeta Value
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Field Description

MaxResults

Enter themaximum number of items to appear in the initial display of this server control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount of space being
occupied, enter themaximum number of results per page here. Then, check the
EnablePagingproperty box.

If you do andmore than the number of MaxResultsare available, navigation aids
appear below the last item to help the site visitor view additional items. See example
below.

ExactPhrase

Determineswhether the KeyWordValue needs tomatch the phrase exactly.

For example, if “site” is the KeyWordValue and the title of a content block is “Welcome to
the site” and the ExactPhrase box is checked, you would not see the content block in the
metadata list. This is because “site” doesnot equal “Welcome to the site”.

Checked =Match the exact phrase

Unchecked =Doesn’t need tomatch exact phrase

LinkTarget

Defines the waya link actswhen a link is clicked.

Choicesare:

_blank - This target causes the link to alwaysbe loaded in a new blankwindow. This
window is not named.

_self - This target causes the link to always load in the samewindow the anchor was
clicked in. This is useful for overriding a globally assigned BASE target.

_parent - This target makes the link load in the immediate frameset parent of the
document. This defaults to acting like “_self” if the document hasno parent.

_top - This target makes the link load in the full bodyof the window. This defaults to
acting like “_self” if the document is alreadyat the top. It is useful for breaking out of an
arbitrarily deep frame nesting.

KeyWordName

The KeyWordName is the container where the KeyWordValuesare located.

Some examplesof a KeyWordNamemight be “Keywordsor Title.”

For information on creating KeyWordNames for Metadata, seeAdding aMetadata
Definition on page 7-151.

KeyWordValue
The value that is associated with the KeyWordName.

Some examplesof a KeyWordValuemight be “Home; page; or company”
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Field Description

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to

cache the data for fiveminutes, set this property to 300 (three hundred).See Also:
Caching with Server Controlson page 24-33

Warning! If the EnablePagingproperty is set to True, the CacheIntervalproperty
is disabled.

DisplayXslt

Determineshow the information on the page is displayed.

None-databind only

ecmNavigation - lists the title of every content block in the folder

See Also: Example of ecmNavigation Displayon page 9-127
ecmTeaser - lists the title of every content block in the folder plus the content summary

See Also: Example of ecmTeaser Displayon page 9-128

Warning! If you specify an external file, it is strongly recommended that you do not
store this file in your site'sWorkarea folder. If you store this file in theWorkarea folder,
the file will be lost when you upgrade.

Warning! If you enter a valid EkML file at the MarkupLanguageproperty, the
Displayxsltproperty value is ignored.

MarkupLanguage

Identify the templatemarkup file that controls the display of themetadata list. For
example, mymetadatalistmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing the server
control, just enter its name. If the file is in another folder, enter the path relative to site
root. For example, ..\CMS400Developer\workarea\customfiles\

markup\mymetadatalist.ekml.

See Also: Controlling Output with EktronMarkup Language on page 26-1 and
metadatalist.ekmlon page 26-57

Note: Note: If you enter a valid EkML file, the DisplayXsltproperty value is
ignored. If the EkML file contains the [$ImageIcon]variable, the IncludeIcons
property acts asTrue.

DynamicContent
Parameter

Checks theQueryString for the content block ID value and replaces the DisplayByMeta
Value Controlwith content when an ID is specified. Leave blank to alwaysdisplay the
DisplayByMeta Value Control.

None - Use Default

ID - The control uses the content blockpassed asa URL parameter.

Display ByMeta Value

ReferenceManual
Version 8.01 Rev 4

27-103



Field Description

Content Type

Defineswhat type of list summaryappears.

Content - Displaysonly content blocks in the folder.

All Types - Displaysall content in the folder.

Forms - Displaysonly forms in the folder.

Archive_Content - Displaysarchived content from the folder.

Archive_Forms - Displaysarchived forms from the folder.

GetHtml

Check this box if you want to retrieve and display content (html body) for all content
blocks in the collection. For example, display content inside a web server control such as
aGridView.

Checked = retrieve and display content (html body) for all content blocks in the
metadata list

Unchecked =do not retrieve and display content (html body) for all content blocks in
themetadata list

Hide

Used to hide the function in design time and run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.
For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

4. When completed, click insert.
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A graphic defines where the Display By Meta Value appears on your
template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:metadatalist id="Metadatalist1" FolderId="6"
DisplayXslt="ecmTeaser" runat="server"></cms:metadatalist>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Dynamic Content Block
This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) >
CMS Function...

For a description of a dynamic content block, see Dynamic Content Block on
page 27-204

To insert a dynamic content block tag:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click on
Dynamic Tag...

3. The Insert Ektron Dynamic Tag box is displayed
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4. Use the following table to assist you with inserting a dynamic content
block function.

Field Description

Insert Default
Content

If you want a static content block to be displayed if no ID is passed through the URL, place
a check in this box.

Default Content
ID

Specify the ID number of the content block that you wish to use asa default content block
on theWeb page.

Select Content If you are working online, youmayselect the content block to use asa default content
block from the list.

5. When completed, click Insert.

A graphic to define where the dynamic content block has been placed on
your template is inserted.

Shown below is the code that will be inserted according to the platform that has
been specified in the setup:
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Platform Code View

.NET For ASP.NET pages, use the CMS400.NET (Server Control) Content Block tag and set the
dynamicparameter to id. SeeContent Blockon page 27-73

ASP
<% if request.QueryString(“id”)<> “” then
ecmContentBlock(request.QueryString(“id”)) else ecmContentBlock(1) end
if %>

ColdFusion

<cfif isdefined(“url.id”)>
<cfmodule id=”#url.id#”
template=”#request.ecm.AppPath#ecmContentBlock.cfm”>
<cfelse>
<cfmodule id=”1” template=”#request.ecm.AppPath#ecmContentBlock.cfm”>
</cfif>

JSP Inserting a DynamicContent Blockusing Ektron’sDreamweaver Extensions is not supported in
JSP.

PHP <?php $id =GetURL_Id(1); ecmContentBlock($id); ?>

Folder Bread Crumb
For a description of the Folder Bread Crumb function, see FolderBreadcrumb
Server Control on page 9-292.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
CMS MENU Controls...

To insert a Folder Bread Crumb Trail:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Folder
BreadCrumb.

3. The Folder Bread Crumb dialog box appears.

Folder Bread Crumb
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4. Use the following table to assist you with inserting a Folder Bread
Crumb.

Field Description

Control ID A unique name for the function you are inserting.

FolderID The numeric id of the folder that you want to use. If you do not know the folder ID, you
can navigate to it using the Select folder drop down box.

Content ID Gets or Sets the ContentID. If you do not know the Content ID, you can navigate to it
using the Select Category and Select Content drop down boxes.

DynamicParameter Gets or sets the QueryString parameter to read a content ID dynamically.

DisplayStyle Indicate how to display the folder bread crumb: horizontally or vertically. The default is
Horizontal.

Hide

Used to hide a FolderBreadcrumb in design time and run time.

Checked =Hide FolderBreadcrumb

Unchecked =Show FolderBreadcrumb

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document
asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click Insert.

A graphic defines where the Folder Bread Crumb appears on your
template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:FolderBreadcrumb id="FolderBreadcrumb1" DefaultContentID="65"
runat="server"></cms:FolderBreadcrumb>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Folder Bread Crumb
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Form
For a description of the Form function, see FormBlock Server Control on page
7-271

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS
Function...

or

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert a form:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click Form

3. The Insert Form box is displayed.

Warning!When inserting a form tag using ASP, CF, JSP or PHP, a different dialog box appears.

4. Use the following table to assist you with inserting a form.
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Field Description

Control ID

Warning! Used
in ASP.NET only.

A unique name for the function you are inserting.

Form ID Type in the form ID that you want to insert. If you do not know the Form ID, you can
navigate to it using the Select Form drop down box.

Select Form
The drop-down box is populated with a list of all the form titles.When a title is selected,
the form ID textbox is filled with that form's id number. If you insert the Form ID, you do
not need to select a form.

DynamicForm
Parameter

Warning! Used
in ASP.NET only.

Tomake this form blockdynamic, select ekfrm. When you do, this control uses the form
blockpassed asa URL parameter.

# of seconds -
CacheInterval

Warning! Used
in ASP.NET only.

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to

cache the data for fiveminutes, set this property to 300 (three hundred).See Also:
Caching with Server Controlson page 24-33

Add Validation

Warning! Used
in ASP.NET only.

When checked, addsValidation to your main runat=server form.

Checked =add validation

Unchecked =Do not add validation

Include Form
Tags

Warning! Used
in ASP.NET only.

Determines if tagsare generated automatically or manually.See Also: Automatic
versusManualGeneration of Form Tagson page 7-273

Checked =automatically generate form tags

Unchecked =generate form tagsmanually

Hide

Warning! Used
in ASP.NET only.

Used to hide a form in design time and run time.

Checked =Hide form

Unchecked =Show form

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Warning! Used
in ASP.NET only.

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Form
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Field Description

Style (Positioning
Info - GridLayout)

Warning! Used
in ASP.NET only.

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Warning! Used
in ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click Insert.

A graphic defines where the form appears on your template.

Shown below is an example of the code that is inserted.

Platform Code View

.NET
<cms:FormBlock id="FormBlock1" DefaultFormID="13"
runat="server"></cms:FormBlock>

ASP <% ecmFormBlock (1) %>

ColdFusion <cfmodule id="1" template="#request.ecm.AppPath#ecmFormBlock.cfm">

JSP <%= ecmFormBlock(1) %>

PHP <?php ecmFormBlock (1); ?>
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ImageControl
For a description of the ImageControl function, see AssetControl Server Control
on page 7-466.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls...

To insert the ImageControl function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click ImageControl.

3. The Insert Ektron CMS400.NET ImageControl box appears.

4. Use the following table to assist you with inserting the ImageControl
function.

Field Description

Control ID A unique name for the function you are inserting.

FolderID

The ID of the folder where Imagesare located. This property is used when the
UploadTypeproperty is set to Update.

If you do not know the Folder ID, you can navigate to it using the Select Folder drop
down box.

UploadType Select whether the control addsnew assets or update existing ones. Select Add to add
assets and use the FolderIDproperty. The default isNone.

ImageControl
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Field Description

Hide

Used to hide a function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document
asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

An ImageControl icon appears and indicates the ImageControl’s location
on the template.

Shown below is an example of the code that is inserted:
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Platform Code View

.NET
<cms:ImageControl id="ImageControl1" DefaultFolderID="14"
UploadType=”Update” runat="server"></cms:AssetControl>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Language API
For a description of the Language API function, see LanguageAPI Server Control
on page 14-44.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert a Language API:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Language API

3. The Language API box appears.

4. Use the following table to assist you with inserting a Language API
box.

Field Description

Control ID A unique name for the function you are inserting.

Language API
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Field Description

Hide

Used to hide a Language API in design time and run time.

Checked =Hide Language API

Unchecked =Show Language API

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is
hidden.

Style (Positioning Info -
GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb
page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML
document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the Language API appears on your template.

Shown below is an example of the code that is inserted:
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Platform Code View

.NET <cms:LanguageAPI id="LanguageAPI2" runat="server"></cms:LanguageAPI>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Language Select Box
For a description of the Language Select Box, see LanguageSelect Server
Control on page 14-46.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert a Language Select Box:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Language
Select

3. The Language Select box appears.

4. Use the following table to assist you with inserting a Language Select
box.

Field Description

Control ID A unique name for the function you are inserting.

Language Select Box
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Field Description

Hide

Used to hide a function in design time and run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is
hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hide and Visibleare both checked, the property is hidden.

Style (Positioning Info -
GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb
page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML
document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the Language Select appears on your template.

Shown below is an example of the code that is inserted.
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Platform Code View

.NET
<cms:LanguageSelect id="LanguageSelect1"
runat="server"></cms:LanguageSelect>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

List Summary
For a description of the List Summary function, see ListSummary Server
Control on page 9-266.

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) >
CMS Function...

or

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert a list summary:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click List Summary.

3. The Insert Ektron List Summary box is displayed.

List Summary
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Warning!When inserting a list summary using ASP, CF, JSP or PHP, a different dialog box
appears.

4. Use the following table to assist you with inserting a metadata
control.
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Field Description

Control ID

Warning! Used
in ASP.NET only.

A unique name for the function you are inserting.

Folder ID Enter the folder ID. If you do not know the folder path, you can navigate to it using the
Select folder drop down box.

Select Folder
Select the folder the summary information comes from. The folder drop-down contains
folders from your site. If you insert the folder path, you do not need to select a folder
from the dropdown box.

Recursive If checked, summary information is gathered from the folder selected and all of its child
folders.

IncludeIcons

Warning! Used
in ASP.NET only.

Choose whether to display iconsnext to the list summary list’s links.

Warning! This property onlyworkswhen ecmSummaryor ecmTeaser are used in the
DisplayXsltproperty.When the [$ImageIcon]variable is used in an EkML file and
that file is assigned to the MarkupLanguageproperty, this property acts asTrue.

List Summary
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Field Description

EnablePaging

Warning! Used
in ASP.NET only.

This property, in conjunction with the MaxResultsproperty, lets site visitors view an
unlimited number of taxonomy itemswhile controlling the amount of screen space. To
accomplish this, the taxonomydisplay is limited to the number set in the MaxResults
property.

If you check this property box, and the number of taxonomy itemsexceeds the
MaxResultsnumber, navigation aidsappear below the last item. The site visitor uses
the aids to view additional items. See example below.

So, for example, if a taxonomyhas9 itemsand the MaxResultsproperty is set to 3, the
screen displaysonly the first three items.When the site visitor clicks [Next], he sees
items4, 5 and 6, etc.

Checked =enablespaging

Unchecked =disablespaging

Warning! If the EnablePagingproperty is set to True, the CacheIntervalproperty
is disabled.

OrderKey

Specify how the summariesare ordered. Sort by the following criteria.

n Title - The title of the content block

n Date Created - The date the content blockwascreated

n Date Modified - The date the content blockwas last modified

n Last Author Last Name - The last author’s last name

n Last Author First Name - The last author’s first name

n Ascending - Alphabetic or numerical order

n Descending - Reverse alphabetic or numerical order
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Field Description

MaxNumber of
results

Warning! Used
in ASP.NET only.

Enter themaximum number of items to appear in the initial display of this server control.

To set nomaximum, enter zero (0).

To let site visitors view more than themaximum but limit the amount of space being
occupied, enter themaximum number of results per page here. Then, check the
EnablePagingproperty box.

If you do andmore than the number of MaxResultsare available, navigation aids
appear below the last item to help the site visitor view additional items. See example
below.

DisplayXslt

Warning! Used
in ASP.NET only.

Determineshow the information on the page is displayed. Select:

None - databind only

ecmNavigation - lists the title of every content block in the folder

See Also: Example of ecmNavigation Display on page 9-127
ecmTeaser - lists the title of every content block in the folder plus the content summary

See Also: Example of ecmTeaser Displayon page 9-128
Path to Custom Xslt - Enter the path to an Xslt that determines the display of the page

Warning! If you specify an external file, it is strongly recommended that you do not
store this file in your site'sWorkarea folder. If you store this file in theWorkarea folder,
the file will be lost when you upgrade.

Note: Note: If an .ekml file is inserted into the MarkupLanguageproperty, this value
is ignored.

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe loaded in a new blankwindow. This
window is not named.

_self - This target causes the link to always load in the samewindow the anchor was
clicked in. This is useful for overriding a globally assigned base target.

_parent - This target makes the link load in the immediate frameset parent of the
document. This defaults to acting like "_self" if the document hasno parent.

_top - This target makes the link load in the full bodyof the window. This defaults to
acting like "_self" if the document is alreadyat the top. It is useful for breaking out of an
arbitrarily deep frame nesting.

List Summary
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Field Description

DynamicContent
Parameter

Warning! Used
in ASP.NET only.

Checks theQueryString for this value and replaces the list summarywith a content block
when specified. ChooseNone to alwaysdisplay List Summary.

RandomOutput

Warning! Used
in ASP.NET only.

Displays random content within a list summary.

Checked =display random content from list summary

Unchecked = show a list summary

GetHtml

Warning! Used
in ASP.NET only.

Check this box if you want to retrieve and display content (html body) for all content
blocks in the collection. For example, to display content inside a web server control such
asaGridView.

Checked = retrieve and display content (html body) for all content blocks in the
collection

Unchecked =do not retrieve and display content (html body) for all content blocks in
the collection

Content Type

Warning! Used
in ASP.NET only.

Defineswhat type of list summaryappears.

Content - Displaysonly content blocks in the folder.

All Types - Displaysall content in the folder.

Forms - Displaysonly forms in the folder.

Archive_Content - Displaysarchived content from the folder.

Archive_Forms - Displaysarchived forms from the folder.

# of seconds -
CacheInterval

Warning! Used
in ASP.NET only.

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to

cache the data for fiveminutes, set this property to 300 (three hundred).See Also:
Caching with Server Controlson page 24-33

Warning! If the EnablePagingproperty is set to True, the CacheIntervalproperty
is disabled.

Hide

Warning! Used
in ASP.NET only.

Used to hide a list summary in design time and run time.

Checked =Hide list summary

Unchecked =Show list summary

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Warning! Used
in ASP.NET only.

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Style (Positioning
Info - GridLayout)

Warning! Used
in ASP.NET only.

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Warning! Used
in ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

MarkupLanguage

Warning! Used
in ASP.NET only.

Identify the templatemarkup file that controls the display of the list summary. For
example, mylistsummary.ekml.

If the *.ekml file is located in the same folder as theWeb form containing the server
control, just enter its name. If the file is in another folder, enter the path relative to site
root. For example, ..\CMS400Developer\workarea\customfiles\

markup\mylistsummary.ekml.

See Also: ”EktronMarkup Language” on page 35 and ”listsummary.ekml” on page
 77

Note: Note: If you enter a valid EkML file, the Displayxsltproperty value is
ignored. If the EkML file contains the [$ImageIcon]variable, the IncludeIcons
property acts asTrue.

5. When completed, click insert.

A graphic defines where the list summary appears on your template.

Shown below is an example of the code that is inserted:

List Summary
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Platform Code View

.NET
<cms:ListSummary id="ListSummary1" FolderId="14" DisplayXslt="ecmTeaser"
runat="server"></cms:ListSummary>

ASP
<% ecmListSummary "\Human Resources",1,1,"","DateModified,desc",
"DateCreated",0,"","" %>

ColdFusion
<cfmodule template="#request.ecm.AppPath#ecmListSummary.cfm"
Folder="\Human Resources" MaxNumber="0" Recursive="1" ShowSummary="1"
StyleInfo="" OrderBy="DateModified,desc" ShowInfo="DateCreated">

JSP
<%= ecmListSummary("\Human Resources",0,1,"",
"Title,asc","DateModified",0,"","") %>

PHP
<?php ecmListSummary("\Human Resources",1,1,"",
"DateModified,desc","DateCreated",0,"",""); ?>

Login
For a description of the Login button, see Login Server Control on page 2-10.

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS
Function...

or

n Commands > Ektron CMS400.NET (Server Controls) >
CMS Content Controls...

To insert a login button:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Login.

3. The Insert Ektron CMS400.NET Login box appears.

UsingOther Development Frameworks

27-126 ReferenceManual
Version 8.01 Rev 4



Warning!When inserting a login function using ASP, CF, JSP or PHP, the dialog box that
appears has no settings.

4. Use the following table to assist you with inserting a Login button.

Field Description

ID

Warning! Used in
ASP.NET only.

A unique name for the function you are inserting.

OnlyAllowMemberLogin

Warning! Used in
ASP.NET only.

This changes the Login button so onlymembership users can log in. This prevents
someone from trying to login asan Ektron CMS400.NET user and gain access to
the Ektron CMS400.NETWorkarea. The default isUnchecked.

Checked =Allow onlymembership users to login.

Unchecked =Allow Ektron CMS400.NET users andmembership users to
login.

Login
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Field Description

PromptLogout

Warning! Used in
ASP.NET only.

When set to False, the logout processwill not include the Logout Prompt window
(shown below).

True =Usersmust click the Logout button in the Logout prompt window before
theyare logged out.

False =Users are logged out without having to use the Logout prompt window.

AutoLogin

Warning! Used in
ASP.NET only.

When this box is checked, users are automatically logged in using Active Directory
authentication. Theydo not need to enter a username or password. The default is
Unchecked.

Checked =Use Active Directory authentication when logging in.

Unchecked =Do not use Active Directory authentication when logging in.

Warning! For this property to function properly, youmust be using Active
Directory authentication with your Ektron CMS400.NET Site.

AutoAddType

Warning! Used in
ASP.NET only.

Set this type to define automatically added users asmembership users or Ektron
CMS400.NET content authors.

Author=Ektron CMS400.NET content authors

Member=membership users

SuppressHelpButton

Warning! Used in
ASP.NET only.

Hides the Help button that appears below the Login button when this box is
checked. The default isUnchecked.

Checked =Do not display the Help button.

Unchecked =DisplayHelp button.

Hide

Warning! Used in
ASP.NET only.

Used to hide a Login button at run time.

Checked =Hide Login button

Unchecked =Show Login button

Note: Note: If Hide and Visible are both checked, the property is hidden.
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Field Description

Visible

Warning! Used in
ASP.NET only.

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hide and Visible are both checked, the property is hidden.

Style (Positioning Info -
GridLayout)

Warning! Used in
ASP.NET only.

Set position information of a control as absolute, when using aGridLayoutWeb
page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Warning! Used in
ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML
document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Warning! Used in
ASP.NET only.

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A login icon indicates where the Login button appears on the template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET <cms:Login id="Login1" runat="server"></cms:Login>

ASP <% ecmlogin %>

ColdFusion <cfmodule template="#request.ecm.AppPath#ecmLogin.cfm”>

Login
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Platform Code View

JSP <%= ecmLogin() %>

PHP <?php ecmlogin() ?>

Map Control
For a description of the Map Control, see Map Server Control on page 7-654 .

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
CMS Module Controls...

To insert a Map Control button:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click Map Control.

3. The Ektron Map Control dialog box appears.

4. Use the following table to assist you with inserting a Map Control.

Field Description

Control ID A unique name for the function you are inserting.
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Field Description

Folder ID Enter the folder ID. If you do not know the folder path, you can navigate to it using the
Select folder drop down box.

Recursive In the FolderIDproperty, you specify a folder whose content is searched on thismap.
To extend the search to all folders below this folder, check this box.

Latitude To set a default map center via latitude and longitude (asopposed to an address), enter
the latitude here.

Longitude To set a default map center via latitude and longitude (asopposed to an address), enter
the longitude here.

MyAddress

To set a default map center, enter its addresshere. If you only enter a zip code, themap
centers on its post office.

The addressappears in theSearch field when themap first displays.

If you enter an address,
the latitudeand longitudeproperties are ignored.

MapCategory

Enter the ID number of the taxonomywhose categories appear when a site visitor clicks
thismap’sDisplay on Map button.

When amap first appears, all eligible content appears. If a site visitor clicks theDisplay
on Map button, he can choose one or more categories and limit themap to items
assigned to them. For example, the user could view restaurants only (as shown below).

Asanother example, your map could display all campuses in your state’s college system.
A site visitor could use theDisplay on Map popup window to limit themap to
community colleges.

To learnmore about Taxonomy, see Taxonomyon page 9-202.

MapControl

ReferenceManual
Version 8.01 Rev 4

27-131



Field Description

MinZoomLevel
If you want to set amap zoom level below whichmap locationswill not appear, enter that
value.

The default value is 4. Possible valuesare between 1 (most detailed) and 19.

StartZoomLevel Enter the zoom level at which themap initially appears.See Also: Determining a
Map’s Initial Boundarieson page 7-663

MapStyle
Enter themap’s displaymode: Road, Satellite or Hybrid.

Note: This setting only affectsBingMaps for Enterprisemaps.

PageSize

Enter the number of locations that can appear on one page of the text boxafter a search

is executed.See Also: Displaying/SuppressingMap Elementson page 7-662
If more than this number of locationsare available, the site visitor sees [First]
[Previous] [Next] [Last] at the bottom of the page. He can use the navigation aids to
view additional locations.

MapProvider Select the service that provides themap, either Google or BingMaps for Enterprise.

DistanceUnit Enter the units of distance on themap. Choicesaremiles and kilometers. The default
value ismiles.
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Field Description

CustomIcon

Use this field if you want the Category popup box to display an icon to the left of each
category, as shown below.

Prerequisite

To use this value, open the webroot/images/application/maps/tree folder. In
that folder, create a new folder whose name is the same as the Taxonomycategory
assigned to theMap server control at the MapCategoryproperty. In the sample site, this
Taxonomy’s name isMapCategory.

Then, place the icons in that folder by category title namewith a .png extension. Use an
underscore (_) to separate taxonomy levels. For example, the image for the category
Restaurant >Americanmust be named Restaurant_American.png.

DisplayTextResult

If you want the site visitor to see a boxof information about eachmap item to the right of
amap, check this box. To suppress the text box, uncheck this box.

See Also: Displaying/SuppressingMap Elementson page 7-662
Checked =display text results about eachmap item

Unchecked = suppress text box

MapControl
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Field Description

TypeControl

If thismap usesBingMaps for Enterprisemaps, this property enablesor disables the
zoom/direction/type control (highlighted below). It lets a site visitor zoom themap in and
out, move the center in anydirection, and change the display style (Road or Aerial).

If thismap usesGoogle Earthmaps, this property enablesor disables the type control
(highlighted below). It lets the site visitor change the display style (Map, Satellite, or
Hybrid). Use the ZoomControlproperty to display or suppressGoogle Earth’s zoom
and direction controls.

Checked =display zoom/direction/type controls

Unchecked = suppress zoom/direction/type controls

ZoomControl

Use this property to display or suppress theGooglemap zoom control (highlighted
below).

For BingMaps for Enterprisemaps, the display of the zoom control is determined by the
TypeControlproperty.

Checked =displayGooglemap zoom control

Unchecked = suppressGooglemap zoom control
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Field Description

Hide

Used to hide a Login button at run time.

Checked =Hide Login button

Unchecked =Show Login button

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

A Map Control icon indicates where the Map Control appears on the
template.

Shown below is an example of the code that is inserted:

MapControl
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Platform Code View

.NET <cms:Map id="Map1" FolderId="14" runat="server"></cms:Map>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Membership Control
For a description of the Membership function, see Membership Server Control
on page 16-19.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls...

To insert a Membership Control:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Membership.

3. The Membership dialog box appears.
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4. Use the following table to assist you with inserting a Membership
Control.

Field Description

ID A unique name for the function you are inserting.

DisplayMode

The type of membership form displayed. Choose from the following:

n UserRegistration - Lets a site visitor to register asamembership user.

n ResetPassword - Lets amembership user to reset his password.

n UnsubscribeSecured - Lets amembership user unsubscribe. The
membership user needs to enter his username and password to
unsubscribe.

n UnsubscribeUnsecured - Lets amembership user unsubscribe by
entering hismembership username only.

n AccountActivate - Let a site visitor activate hismembership account by
entering the ID number sent him in the account verification email.

For more information on the DisplayModeproperty, seeDisplayMode on
page 16-28.

Membership Control
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Field Description

RedirectedFailedURL

TheURLwhere amembership user is sent if the registration fails. If the
page resides in the same folder as the registration page, you only need to
enter the name of the page. For example, RegFailed.aspx. If the redirect
page is located in a subfolder, you need to add the folder path. For example,
members\RegFailed.aspx.

RedirectedSuccessURL

TheURLwhere amembership user is sent if the registration is successful. If
the page resides in the same folder as the registration page, you only need
to enter the name of the page. For example, RegSuccess.aspx. If the
redirect page is located in a subfolder, you need to add the folder path. For
example, members\RegSuccess.aspx.

RegisterButtonImg Lets you add an image in place of the text on the register button.

RegisterButtonText Text that appears on the Register button. The default isRegister. If you use
a register button image, you do not see this text.

ResetButtonImg Lets you add an image in place of the text on the reset button.

ResetButtonText Text that appears on the reset button. The default isReset. If you use a
reset button image, you do not see this text.

ShowExtended

Decide if the CustomUser Properties are available when using this control.
The default setting is checked.

Checked = show CustomUser Properties

Unchecked =hide CustomUser Properties

Note: Note: For more information , seeCustomUser Propertieson
page 15-12.

ShowTerms

When set to True this property shows the Termsand Conditionsasdefined
in theWorkarea. In addition, users are asked to checka box stating they
have read and agree to abide by the termsand conditionsof the forum.
Default isFalse.

See Also: ShowTermson page 16-29 and Terms&Conditionson page
7-586

UserExistsMessage Themessage that appearswhen amembership user alreadyexists. The
default message is: Username(email) alreadyexists!

UserSuccessMessage Themessage that appearswhen amembership user successfully registers.
The default message is: You have registered successfully.

UserUpdateSuccessMessage
Themessage that appearswhen amembership user successfully updates
their information. The default message is: You have successfully updated
your information.
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Field Description

Hide

Used to hide aMembership in design time and run time.

Checked =HideMembership

Unchecked =ShowMembership

Note: Note: If Hideand Visibleare both checked, the property is
hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is
hidden.

Style (Positioning Info -
GridLayout)

Set position information of a control as absolute, when using aGridLayout
Web page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML
document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof
code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the Membership Control appears on your
template.

Shown below is an example of the code that is inserted:

Membership Control
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Platform Code View

.NET <cms:membership id="Membership1" runat="server"></cms:membership>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Metadata for ASP.NET Pages
For a description of the Metadata function, see MetaData Server Control on
page 7-165.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert a metadata function:

1. Move the blinking cursor to the area that you want to place it.

Note: The Ektron CMS400.NET Metadata function should be inserted within the <head> tags
of your template to work properly.

2. From the list of Ektron CMS400.NET Functions, click onMetadata.

3. The Insert Ektron Metadata box is displayed.

4. Use the following table to assist you with inserting metadata.
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Field Description

Control ID A unique name for the function you are inserting.

Content ID
Enter a valid content ID in the Content ID textbox. If you do not
know the Content ID, you can navigate to it using the Select
Category and Select Content Blockdrop down boxes.

GenerateDublinCore

When enabled, this property automatically creates seven of the
Simple Dublin Coremetadata fields from standard Ektron
CMS400.NET system properties. The default isUnchecked.

Checked = Generate Simple Dublin Coremetadata fields

Unchecked =Do not generate Simple Dublin Coremetadata
fields

The seven fields and how theyare associated with the Ektron
CMS400.NET properties is explained inSimple Dublin Core
Metadata on page 7-149

Select Category The drop-down list contains a list of content folders. If you insert
the content ID, you do not need to select a category.

Select Content Block

The drop-down box is populated with a list of all the content block
titleswithin that folder.When a title is selected, the content ID
textbox is filled with that content block's id number. If you insert the
content ID, you do not need to select a content block.

DefaultItemList
A comma delimited list of content block IDs to get metadata from.
DefaultContentID must be set to 0 (zero) so you can add IDs to the
list. For example: [2,4,46]

DynamicContent Parameter Gets or sets the QueryString parameter to read a content ID
dynamically.

Hide

Used to hide aMembership in design time and run time.

Checked =HideMembership

Unchecked =ShowMembership

Note: Note: If Hideand Visibleare both checked, the
property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the
property is hidden.

Metadata for ASP.NET Pages
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Field Description

Style (Positioning Info - GridLayout)

Set position information of a control as absolute, when using a
GridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP:
240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an
HTML document asa span element.

Div - The <div> tag is used when you want to apply attributes to a
blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control.
The default isUnchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

6. The following line appears in the <body> of the HTML code.
 <cms:MetaData id="MetaData2" runat="server"

DefaultContentID="12"></cms:MetaData>

7. Move that line from the <body> tag into the <head> tag.

8. Save the Web form.

9. Open the Web page in the browser.

10. Right click on the Web page and click View Source. Look in the head
tag. The meta tags from the content block are added to the page.

The metadata information added is shown below.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:MetaData id="MetaData2" runat="server"
DefaultContentID="12"></cms:MetaData>

ASP,

ColdFusion,

JSP or PHP

SeeMetadata Function for ASP, CF, JSP or PHPPages below

Metadata Function for ASP, CF, JSP or PHP
Pages
For a description of the Metadata function, see MetaData Server Control on
page 7-165.

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) >
CMS Function...

To insert a metadata function:

1. Move the blinking cursor to the area that you want to place it.

Note: The Ektron CMS400.NET Metadata function should be inserted within the <head> tags
of your template to work properly.

2. From the list of Ektron CMS400.NET Functions, click onMetadata.

3. The Insert Ektron Metadata box is displayed.

Metadata Function for ASP, CF, JSP or PHP Pages
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4. Use the following table to assist you with inserting metadata.

Field Description

Metadata List
When you select a content ID and click the Add toMetadata List button, The content
ID is added to this text box. This allowsyou to create a list of content blocks for which
themetadata of each content block is added to the page.

Content ID
Enter a valid content ID in the Content ID textbox. If you do not know the Content ID,
you can navigate to it using the Select Category and Select Content Blockdrop down
boxes.

GenerateDublinCore

When enabled, this property automatically creates seven of the Simple Dublin Core
metadata fields from standard Ektron CMS400.NET system properties. The default
isUnchecked.

Checked = Generate Simple Dublin Coremetadata fields

Unchecked =Do not generate Simple Dublin Coremetadata fields

The seven fields and how theyare associated with the Ektron CMS400.NET
properties is explained inSimple Dublin CoreMetadata on page 7-149

Select Category The drop-down list contains a list of content folders. If you insert the content ID, you
do not need to select a category.

Select Content Block
The drop-down box is populated with a list of all the content block titleswithin that
folder.When a title is selected, the content ID textbox is filled with that content block's
id number. If you insert the content ID, you do not need to select a content block.

Metadata types for
exclusion

Select themetadata types that you do not want added to themetadata function you
are inserting. Hold the control keydown for multiple selections.

5. When completed, click insert.

6. The following line appears in the <body> of the HTML code.
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 <cms:MetaData id="MetaData2" runat="server"
DefaultContentID="12"></cms:MetaData>

7. Move that line from the <body> tag into the <head> tag.

8. Save the Web form.

9. Open the Web page in the browser.

10. Right click on the Web page and click View Source. Look in the head
tag. The meta tags from the content block are added to the page.

The metadata information added is shown below.

Shown below is an example of the code that is inserted:

Platform Code View

.NET For ASP.NET pages, seeMetadata for ASP.NET Pageson page 27-140

ASP <% ecmMetadata "[1;Title][9][3;Keywords,Title]","" %>

ColdFusion
<cfmodule template="#request.ecm.AppPath#ecmMetadata.cfm"
ItemList="[1;Title][9][3;Keywords,Title]">

JSP <%= ecmMetadata("[12;keywords,Title]","") %>

PHP <?php ecmMetadata("[1;Title][9][3;Keywords,Title]",""); ?>

Multipurpose Content Block
This tag appears on the following menu(s):

Multipurpose Content Block
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n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS
Function...

To insert a Multipurpose content block function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click on
Multipurpose Tag...

3. The Insert Ektron CMS400.NET Multipurpose Tag box is displayed.

4. Use the following table to assist you with inserting a Multipurpose tag.

Field Description

Default
Content ID

Type in the default content ID, or select a category from the drop down list, then select a
content block from the second dropdown list.

5. When completed, click insert.

A graphic to define where the Multipurpose tag will appear on your
template is inserted.

Shown below is the code that will be inserted according to the platform that has
been specified in the setup:

Platform Code View

.NET In ASP.NET, the Content BlockTag functionsasaMultipurpose Content block.

ASP <% ecmMultiPurpose(24) %>
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Platform Code View

ColdFusion
<cfmodule DefaultID="24"
template="#request.ecm.AppPath#ecmMultipurpose.cfm">

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP <?php ecmMultiPurpose(12); ?>

Poll
For a description of the Poll function, see Poll Server Control on page 7-274.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert a Poll:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click Poll.

3. The Insert Poll box is displayed.

4. Use the following table to assist you with inserting a poll.

Field Description

Control ID A unique name for the function you are inserting.

Poll ID Type in the Poll ID that you want to insert. If you do not know the Poll ID, you can
navigate to it using the Select Poll drop down box.

Poll
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Field Description

Select Poll
The drop-down box is populated with a list of all the form titles.When a title is selected,
the Poll ID textbox is filled with that form's id number. If you insert the Poll ID, you do not
need to select a form.

DynamicForm
Parameter

Tomake this form blockdynamic, select ekfrm. When you do, this control uses the form
blockpassed asa URL parameter.

Ajax

Displays the poll or results, using an iFrame, in the area of the page that contains the poll
without disturbing its surrounding contents. The default is checked.

Checked =Polls and results are shown in an iFramewithout anymodification or
refresh of the surrounding contents.

Unchecked =The poll and the results replace theWeb page’s content.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to

cache the data for fiveminutes, set this property to 300 (three hundred).See Also:
Caching with Server Controlson page 24-33

Include Form
Tags

Determines if tagsare generated automatically or manually.See Also: Automatic
versusManualGeneration of Form Tagson page 7-273

Add Validation

When checked, addsValidation to your main runat=server form.

Checked =add validation

Unchecked =do not add validation

Hide

Used to hide a poll in design time and run time.

Checked =Hide poll

Unchecked =Show poll

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.
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Field Description

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click Insert.

A graphic defines where the form appears on your template.

Shown below is an example of the code that is inserted.

Platform Code View

.NET <cms:Poll id="Poll1" PollID="300" runat="server"></cms:Poll>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

PostHistory
For a description of the PostHistory function, see PostHistory Server Control on
page 7-652.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Community Controls... > Forums

To insert the PostHistory function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click PostHistory.

PostHistory
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3. The Insert Ektron CMS400.NET PostHistory box appears.

4. Use the following table to assist you with inserting the ActiveTopics
function.

Field Description

Control ID A unique name for the function you are inserting.

BoardID
The ID of the Discussion Board.

If you do not know the board ID, you can navigate to it using the Select folder drop down
box.

UserID The ID of the user for whom to get the post history.

URLPath The URL path to the page the where the Forum server control is located.

MaxNumber Themaximum number of topics listed.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to

cache the data for fiveminutes, set this property to 300 (three hundred).See Also:
Caching with Server Controlson page 24-33

Hide

Used to hide the function at run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. Click insert.

An PostHistory icon appears to indicate the location of the post history
list.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:PostHistory BoardID="106" id="PostHistory1" URLPath="forum.aspx"
UserID="14" runat="server"></cms:PostHistory>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

PostHistory
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Platform Code View

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Random Content
For a description of the Random Content function, see Random Content on page
27-254

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS
Function...

To insert a Random Content function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click on
Insert Random Content Tag...

3. The Insert Random Content Tag box is displayed.

4. Use the following table to assist you with inserting a Random Content
tag.

Field Description

Collection ID Type in the collection ID, or select it from the drop down list, of the collection where the
random content function will retrieve content from.

XSLT to
apply

XML
Content
only

If desired, youmayspecify an XSLT to apply to the content that gets displayed.

5. When completed, click Insert.
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A graphic to define where the Random Content tag will appear on your
template is inserted.

Shown below is the code that will be inserted according to the platform that has
been specified in the setup:

Platform Code View

.NET This function is not available asan Ektron Dreamweaver Extension for .NET

ASP <% ShowRandomContent 3, 0 %>

ColdFusion
<cfmodule id="3" displayFunction="0"
template="#request.ecm.AppPath#ecmShowRandomContent.cfm">

JSP <%= ShowRandomContent(3, 0) %>

PHP <?php ShowRandomContent(3, 0); ?>

Random Summary
For a description of the Random Summary function, see Random Summary on
page 27-255

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) >
CMS Function...

To insert a Random Summary function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click on
Random Summary Tag...

3. The Insert Ektron CMS400.NET Random Summary Tag box is
displayed.

RandomSummary
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4. Use the following table to assist you with inserting a Random
Summary tag.

Field Description

Collection
ID

Type in the collection ID, or select it from the drop down list, of the collection where the random
summary function will retrieve summaries from.

5. When completed, click Insert.

A graphic to define where the Random Summary tag will appear on your
template is inserted.

Shown below is the code that will be inserted according to the platform that has
been specified in the setup:

Platform Code View

.NET This function is not available asan Ektron Dreamweaver Extension for .NET

ASP <% ShowRandomSummary (2) %>

ColdFusion
<cfmodule id="2"
template="#request.ecm.AppPath#ecmShowRandomSummary.cfm">

JSP <%= ShowRandomSummary(2) %>

PHP <?php ShowRandomSummary (2); ?>
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RSS Aggregator
For a description of the RSS Aggregator function, see RssAggregator Server
Control on page 24-45.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
CMS Module Control...

To insert an RSS Aggregator:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click RSS
Aggregator.

3. The RSS Aggregator dialog box appears.

4. Use the following table to assist you with inserting an RSS
Aggregator.

Field Description

Control ID A unique name for the function you are inserting.

URL TheRSS feed path for the server control. For example:
http://example.com/rss.xml

MaxResults TheMaximum number of items from anRSS feed that are returned (0=unlimited).
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Field Description

LinkTarget

Defines the waya link actswhen a link is clicked. The choicesare:

_blank - This target causes the link to alwaysbe loaded in a new blankwindow. This
window is not named.

_self - This target causes the link to always load in the samewindow the anchor was
clicked in. This is useful for overriding a globally assigned base target.

_parent - This target makes the link load in the immediate frameset parent of the
document. This defaults to acting like “_self” if the document hasno parent.

_top - This target makes the link load in the full bodyof the window. This defaults to
acting like “_self” if the document is alreadyat the top. It is useful for breaking out of an
arbitrarily deep frame nesting.

DisplayType

Determineshow the information on the page is displayed

None-databind only

ecmNavigation - lists the title of everyRSS feed item

See Also: . Example of ecmNavigation Displayon page 9-127
ecmTeaser - lists a title and a description of everyRSS feed item

See Also: Example of ecmTeaser Displayon page 9-128

Path to Custom Xslt - Enter the path to an Xslt that determines the display of the page

Warning! If you specify an external file, it is strongly recommended that you do not
store this file in your site'sWorkarea folder. If you store this file in theWorkarea folder,
the file will be lost when you upgrade.

Hide

Used to hide an RssAggregator in design time and run time.

Checked =Hide RssAggregator

Unchecked =Show RssAggregator

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.
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Field Description

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the RSS Aggregator appears on your template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<CMS:RssAggregator id="RssAggregator1" URL="http://example.com/rss.xml"
DisplayXslt="ecmTeaser" runat="server"></CMS:RssAggregator>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Old Search
This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) >
CMS Function...

or

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert a Old Search function:

1. Move the blinking cursor to the area that you want to place it.
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2. From the list of Ektron CMS400.NET Content functions, click on Old
Search

3. The Insert Ektron Search box is displayed.
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Warning!When inserting a list summary using ASP, CF, JSP or PHP, a slightly different dialog
box appears.

4. Use the following table to assist you with inserting a search.

Field Description

Ajax

Check this box to enable Ajax searches.When enabled, the MaxResultsproperty
determines themaximum number of results per page, and the ResultTagId
property becomesactive.

Checked =Enable AjaxSearch

Unchecked =OriginalHTMLSearch

ButtonImgSrc
(ASP.NET)

Button Image Source
(ASP, CF, JSP or PHP)

If you wish to use an image for the search button, insert the location of the image in
this field. If no image is specified, a standard submit button is used.

ButtonText The button text is the text that is displayed on the standard submit button, or the alt
text of a search button image.

Control ID

Warning! Used in
ASP.NET only.

A unique name for the function you are inserting.
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Field Description

DisplayHorizontally The search can be displayed either vertically or horizontally on your Web page.
Checkoff this box if you want it to appear horizontally.

DisplayType

Warning! Used in
ASP.NET only.

Determineshow the information on the page is displayed

None-databind only

ecmNavigation - lists the title of every content block in the folder

ecmTeaser - lists the title of every content block in the folder plus the content
summary

See Also: Example of ecmNavigation Display on page 9-
127
Example of ecmTeaser Displayon page 9-128

EmptyResultMsg

Warning! Used in
ASP.NET only.

The returnmessage displayed, if the search returnsno hits.

The default is:
Search returned zero results

EnableAdvancedLink

Warning! Used in
ASP.NET only.

Check this box to display the link that makes the advanced properties available.

Checked =DisplayAdvanced link

Unchecked =Hide Advanced link

EnableArchived

Warning! Used in
ASP.NET only.

Enablesusers to search archived content. The archived content must be archived
asArchived Remain On Site.The default isUnchecked.

Checked =Searching archived content is enabled.

Unchecked =Searching archived content is disabled, unless Include Archived is
checked in the Advanced search.

EnableArchivedBtn

Warning! Used in
ASP.NET only.

Providesa checkbox so users can decide if theywant to perform an archive
search. The default isUnchecked.

Checked =The Include Archive checkbox is enabled in the advanced search
properties. If used with EnableArchived, the checkbox is checked bydefault.

Unchecked =The Include Archive checkbox is disabled in the advanced search
properties.

EnableContent

Warning! Used in
ASP.NET only.

Enablesusers to search content. The default isUnchecked.

Checked =Searching content is enabled.

Unchecked =Searching content is disabled, unlessContent is checked in the
Advanced search.

EnableContentBtn

Warning! Used in
ASP.NET only.

Providesa checkbox so users can decide if theywant to perform a content search.
The default isUnchecked.

Checked =The Content checkbox is enabled in the advanced search properties.
If used with EnableContent, the checkbox is checked bydefault.

Unchecked =TheContent checkbox is disabled in the advanced search
properties.
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Field Description

EnableContentFieldset

Warning! Used in
ASP.NET only.

Createsa border around the group of content items in an advanced search.
These content items include Content, Formsand DMSAssets.

The default isUnchecked.

Checked =Show border around content items.

Unchecked =No border around content items.

EnableDMSAssets

Warning! Used in
ASP.NET only.

Enablesusers to search DMSAssets. The default isUnchecked.

Checked =Searching DMSAssets is enabled.

Unchecked =Searching DMSAssets is disabled, unlessDMSAssets is checked
in the Advanced search.

EnableDMSAssetsBtn

Warning! Used in
ASP.NET only.

Providesa checkbox so users can decide if theywant to perform aDMSAsset
search. The default isUnchecked.

Checked =The DMSAsset checkbox is enabled in the advanced search
properties. If used with EnableContent, the checkbox is checked bydefault.

Unchecked =The DMSAsset checkbox is disabled in the advanced search
properties.

EnableForms

Warning! Used in
ASP.NET only.

Enablesusers to search Forms. The default isUnchecked.

Checked =Searching Forms is enabled.

Unchecked =Searching Forms is disabled, unlessForms is checked in the
Advanced search.

EnableFormsBtn

Warning! Used in
ASP.NET only.

Providesa checkbox so users can decide if theywant to perform a Formssearch.
The default isUnchecked.

Checked =The Formscheckbox is enabled in the advanced search properties. If
used with EnableContent, the checkbox is checked bydefault.

Unchecked =The Formscheckbox is disabled in the advanced search
properties.

EnableLibFiles

Warning! Used in
ASP.NET only.

Enablesusers to search LibraryFiles. The default isUnchecked.

Checked =Searching LibraryFiles is enabled.

Unchecked =Searching LibraryFiles is disabled, unlessFiles is checked in the
Advanced search.

EnableLibFilesBtn

Warning! Used in
ASP.NET only.

Providesa checkbox so users can decide if theywant to perform a LibraryFiles
search. The default isUnchecked.

Checked =The Files checkbox is enabled in the advanced search properties. If
used with EnableLibFiles, the checkbox is checked bydefault.

Unchecked =The Files checkbox is disabled in the advanced search properties.

EnableLibHyperlinks

Warning! Used in
ASP.NET only.

Enablesusers to search LibraryHyperlinks. The default isUnchecked.

Checked =Searching LibraryHyperlinks is enabled.

Unchecked =Searching LibraryHyperlinks is disabled, unlessHyperlinks is
checked in the Advanced search.
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Field Description

EnableLibHyperlinksBtn

Warning! Used in
ASP.NET only.

Providesa checkbox so users can decide if theywant to perform a Library
Hyperlinks search. The default isUnchecked.

Checked =The Hyperlinks checkbox is enabled in the advanced search
properties. If used with EnableLibHyperlinks, the checkbox is checked by
default.

Unchecked =The Hyperlinks checkbox is disabled in the advanced search
properties.

EnableLibImages

Warning! Used in
ASP.NET only.

Enablesusers to search Library Images. The default isUnchecked.

Checked =Searching Library Images is enabled.

Unchecked =Searching Library Images is disabled, unless Images is checked in
the Advanced search.

EnableLibImageBtn

Warning! Used in
ASP.NET only.

Providesa checkbox so users can decide if theywant to perform a Library Images
search. The default isUnchecked.

Checked =The Images checkbox is enabled in the advanced search properties.
If used with EnableLibImages, the checkbox is checked bydefault.

Unchecked =The Images checkbox is disabled in the advanced search
properties.

Folder Type in the folder path to be searched. If you do not know the folder path, you can
navigate to it using the Select folder drop down box.

Font Color

Warning! Used in
ASP, CF, JSP and
PHPonly.

The color of the font used in the search function.

Font Face

Warning! Used in
ASP, CF, JSP and
PHPonly.

The type of font to use for search function.

Font Size

Warning! Used in
ASP, CF, JSP and
PHPonly.

The size of the font used in the search function.

Hide

Warning! Used in
ASP.NET only.

Used to hide a search in design time and run time.

Checked =Hide search

Unchecked =Show search

Note: Note: If Hideand Visibleare both checked, the property is hidden.
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Field Description

LinkTarget

Warning! Used in
ASP.NET only.

Defines the waya link actswhen a link is clicked. The choicesare:

_blank - This target causes the link to alwaysbe loaded in a new blankwindow.
Thiswindow is not named.

_self - This target causes the link to always load in the samewindow the anchor
was clicked in. This is useful for overriding a globally assigned base target.

_parent - This target makes the link load in the immediate frameset parent of the
document. This defaults to acting like “_self” if the document hasno parent.

_top - This target makes the link load in the full bodyof the window. This defaults
to acting like “_self” if the document is alreadyat the top. It is useful for breaking out
of an arbitrarily deep frame nesting.

MaxCharacters
(ASP.NET)

Text BoxMaxChar
(ASP, CF, JSP or PHP)

Specify themaximum amount of characters that is accepted in the text box.

MaxNumber of results

Warning! Used in
ASP.NET only.

Enter a number to specify howmany results are displayed on the page
(0=unlimited).

When the Ajaxproperty is checked, this property changes from themaximum
amount of results to themaximum results per page. This takesadvantage of Ajax’s
ability to have paging in the searches. If zero is entered, all results appear on the
same page.

Order By

Warning! Used in
ASP.NET only.

Specify how you want to order the search results that are generated when a
search is performed on youWeb site. Also specify if you want the results in
ascending or descending order.

n Title - The title of the content block

n Date Created - The date the content blockwascreated

n Date Modified - The date the content blockwas last modified

n Last Author Last Name - The last author’s last name

n Last Author First Name - The last author’s first name

n Ascending - Alphabetic or numerical order

n Descending - Reverse alphabetic or numerical order

PostResultsAt
(ASP.NET)

Target Page (ASP, CF,
JSP or PHP)

The path of theWeb page where the search resultswill be posted.

The # symbol appears in the text boxbydefault. The # symbol tells the control to
post back to theWeb page that created the search.

Warning! A search controlmust exist on the posting page.

Recursive If checked, search information is gathered from the folder selected and all of its
child folders.

RemoveTeaserHtml

Warning! Used in
ASP.NET only.

An optional search result formatting parameter that removesall the HTML from
each content item’s teaser/summarybefore sending it to the browser.

Checked =Remove HTML

Unchecked =Do not remove HTML

Old Search

ReferenceManual
Version 8.01 Rev 4

27-163



Field Description

ResultTagId

Warning! Used in
ASP.NET only.

Specify the div tag control ID to display the search results. This property is only
active when the EnableAjaxproperty is checked.

Select Folder Select a folder path to be searched. If you insert the folder path, you do not need to
select a folder.

ShowExtendedSearch

Allowsa user to search via themetadata type: Searchable Property.

Checked =Show extended search.

Unchecked =Hide extended search.

For more information onMetadata and Searchable Property, seeWorking with
Metadata on page 7-141.

ShowSearchBoxAlways

Warning! Used in
ASP.NET only.

If unchecked, the search boxdoesnot appear on PostBack.

ShowSearchOptions

Warning! Used in
ASP.NET only.

If this box is checked, the following choicesappear along with the search box. This
type of search is also known asa Standard search. The default setting isChecked.

n All the words

n Anyof the words

n Exact phrase

Match Partialwords

Checked =Show search options

Unchecked =Hide search options

Style (Positioning Info -
GridLayout)

Warning! Used in
ASP.NET only.

Set position information of a control as absolute, when using aGridLayoutWeb
page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

TextBoxSize Specify the size of the text box that is displayed on theWeb page for users to enter
the search keywords. The width is based on the number of characters.

Visible

Warning! Used in
ASP.NET only.

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

UsingOther Development Frameworks

27-164 ReferenceManual
Version 8.01 Rev 4



Field Description

Wrap Tag

Warning! Used in
ASP.NET only.

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML
document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Warning! Used in
ASP.NET only.

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the search appears on your template.

Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:Search id="Search1" FolderID="41" MaxResults="50"
DisplayXslt="ecmTeaser" runat="server"></cms:Search>

ASP
<% ecmSearch "\Products",1,"SearchDisplay.asp",10,25,"","Search",
"Verdana","Blue","2",0,"" %>

ColdFusion

<CFMODULE template=”#request.ecm.AppPath#ecmSearch.cfm”
StartingFolder=”\Products” Recursive="1" TargetPage="SearchDisplay.cfm"
TextBoxSize="10" MaxCharacters="25" ButtonImageSrc=""
ButtonText="Search" FontFace="Verdana" FontColor="Blue" FontSize="2"
Horizontal="0">

JSP
<%= ecmSearch("\Products",1,"SearchDisplay.jsp",10,25,"","Search",
"Verdana","Blue","2",0,"") %>

PHP
<?php ecmSearch("\Products",1,"SearchDisplay.php",10,25,"","Search",
"Verdana","Blue","",0,""); ?>
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Search Display
The search display custom tag creates the area where search results appear
after a search is executed.

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) > CMS
Function...

To insert a search display function:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Content functions, click on
Insert Search Display Tag...

3. The Insert Ektron Search Display Tag box is displayed.

4. Use the following table to assist you with inserting a search display
function.

Field Description

MaximumNumber
of Documents

Specify themaximum amount of results that will be returned to the user when a search
is performed.

Style Info Insert an inline style sheet that will be used to format all the hyperlinks that are
returned.

Show Last Modified
Date

Checkoff this box to show the last modified date with the search result. This allows
users to distinguish between updated and old content.

5. When completed, click insert.

A graphic to define where the search display tag has been placed on your
template is inserted.
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Shown below is the code that will be inserted according to the platform that has
been specified in the setup:

Platform Code View (with no default content block set)

.NET In ASP.NET, you do not need to add a separate search display.

ASP <% ecmSearchDisplay 0, "", 1 %>

ColdFusion
<cfmodule template="#request.ecm.AppPath#ecmSearchDisplay.cfm"
MaxNumber="0" StyleInfo="" ShowDate="1">

JSP <%= ecmSearchDisplay(0, "", 1)%>

PHP <?php ecmSearchDisplay(0, "", 1)?>

Single Summary
For a description of the Single Summary function, see Single Summary
Function on page 27-234

This tag appears on the following menu(s):

n Commands > Ektron CMS400 - (ASP CF JSP PHP) >
CMS Function...

To insert a Single summary:

1. Move the blinking cursor to the area that you want to place it.
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2. From the list of Ektron CMS400.NET Content functions, click on
Single Summary Tag...

3. The Insert Ektron Single Summary Tag box is displayed.

4. Use the following table to assist you with inserting a single summary
tag.

Field Description

Content ID

n WorkingOffline - Enter a valid content ID into the Content ID textbox.

n WorkingOnline - The top drop-down list will be filled with a list of content
folders that you have privileges to. After choosing a content folder, the
bottom drop-down boxwill be filled with a list of all the content block titles
within that category.When a title is selected, the content ID textboxwill be
filled with that content block's id number.

Show Summary If checked, content summarieswill be displayed.

Style Info Insert any inline style information, which will be applied to the generated text
hyperlink, here.

Show Info Select the type of information that will be displayed next to the generated
hyperlinks.

5. When completed, click insert.

A graphic to define where the single summary tag will appear on your
template is inserted.
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Shown below is the code that will be inserted according to the platform that has
been specified in the setup:

Platform Code View

ASP <% ecmSingleSummary "1",1,"","DateModified","" %>

ColdFusion
<cfmodule template="#request.ecm.AppPath#ecmSingleSummary.cfm"
ContentID="1" ShowSummary="1" StyleInfo="" ShowInfo="DateModified">

JSP <%= ecmSingleSummary("1",1,"","DateModified","") %>

PHP <?php ecmSingleSummary("1",1,"","DateModified","") ?>

Site Map
For a description of the Site Map function, see SiteMap Server Control on page
9-296.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
CMS Menu Controls...

To insert a Site Map:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Site Map.
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3. The Site Map dialog box appears.

4. Use the following table to assist you with inserting a SiteMap.

Field Description

Control ID A unique name for the function you are inserting.

FolderID The numeric id of the folder that you want to use. If you do not know the folder ID, you
can navigate to it using the Select folder drop down box.

DisplayStyle Indicate how to display the site map: horizontally or vertically. The default isHorizontal.

DisplayXslt

Determineshow the information on the page is displayed.

None - databind only

ecmNavigation - lists the title of every content block in the collection

See Also: Example of ecmNavigation Displayon page 9-127

ecmTeaser - lists the title of every content block in the collection plus the content
summary : If you specify an external file, it is strongly recommended that you do not
store this file in your site'sWorkarea folder. If you store this file in theWorkarea folder,
the file will be lost when you upgrade.

See Also: Example of ecmTeaser Displayon page 9-128

StartLevel Set to the starting level of the site map. If set to 0 (zero), starts from the root.

MaxLevel Set themaximum amount of levels to show. Set it to 0 (zero) for unlimited.

FlatTopLevel

When this box is checked, include site nodes from the parent folder but not their items.
Unchecking this box includesall nodesand items.

Checked = include site nodes from the parent folder but not their items

Unchecked = includesall nodesand items

UsingOther Development Frameworks

27-170 ReferenceManual
Version 8.01 Rev 4



Field Description

Hide

Used to hide a SiteMap in design time and run time.

Checked =Hide the SiteMap

Unchecked =Show the SiteMap

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

# of seconds -
CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to

cache the data for fiveminutes, set this property to 300 (three hundred).See Also:
Caching with Server Controlson page 24-33.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click Insert.

A graphic defines where the Site Map appears on your template.

SiteMap

ReferenceManual
Version 8.01 Rev 4

27-171



Shown below is an example of the code that is inserted:

Platform Code View

.NET <cms:sitemap id="sitemap1" folderid="32" runat="server"></cms:sitemap>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Smart Menu
For a description of the Smart Menu function, see Smart Menu Server Control
on page 9-182.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
CMS Menu Controls...

To insert a Smart Menu:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Smart Menu

The Smart Menu Control box appears.

3. Use the following table to assist you with inserting a Smart Menu.
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Field Description

Control ID A unique name for the function you are inserting.

DefaultMenuID The numeric id of themenu that you want to insert. If you do not know the
DefaultMenuID, you can navigate to it using the Select Menu drop down box.

Select Menu
Select amenu to be used.When amenu is selected, the DefaultMenuID textbox is
filled with that menu's id number. If you insert the DefaultMenuID, you do not need
to select amenu.

DynamicParameter

Checks theQueryString for themenu value and replaces themenuwith content
when ID is specified. Leave blank to alwaysdisplay themenu.

None - Use Default

menu_ID - The control uses themenu passed asa URL parameter.

Stylesheet
Enter the style sheet that will determine the appearance of themenus. Menu style
sheets reside in the site root/workarea/csslib/smartmenu folder. You can
modify anyof the standard style sheets or create your own.

LaunchLinksinNew
Window

Check this boxand when a site visitor selects amenu option, it appears in a new
browser window.

If unchecked, the new page replaces the current page in the browser.

Checked =when a site visitor selects amenu option, it appears in a new browser
window

Unchecked = the new page replaces the current page in the browser

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero).
This is the amount of time, in seconds, a control’s data is cached. For example, if
you want to cache the data for fiveminutes, set this property to 300 (three

hundred).See Also: Caching with Server Controlson page 24-33

Enable508compliance

If you check this box, themenuwill complywith Section 508.See Also: Section
508 Compliance Featuresof Smart Menuson page 9-186

Checked =menuwill complywith Section 508

Unchecked =menu doesnot complywith Section 508

StartCollapsed

If you check this box, all submenusare closed when themenu initially displays.

Checked =all submenusare closed when themenu initially displays

Unchecked = initially display submenus

AutoCollapseBranches

If you check this box, whenever a new submenu opens, all other submenusclose.

If unchecked, other submenus remain open when a new one opens.

Checked =whenever a new submenu opens, all other submenusclose

Unchecked = submenus remain open when a new one opens

Smart Menu
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Field Description

StartWith
RootCollapsed

If you check this box, themenu initially displayswith its root menu closed.

Note: Note: This property is ignored if the ShowRootFolderproperty is
unchecked.

Checked = themenu initially displayswith its root menu closed

Unchecked = themenu initially displayswith its root menu open

ShowRootFolder

If you check this box, amenu option listing the title of the root folder appears. If
unchecked, the title of the root folder doesnot appear.

Checked =amenu option listing the title of the root folder appears

Unchecked = the title of the root folder doesnot appear

Hide

Used to hide a Smart Menu in design time and run time.

Checked =Hide Smart Menu

Unchecked =Show Smart Menu

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning Info -
GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb
page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML
document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

4. When completed, click insert.

A graphic defines where the Smart Menu appears on your template.
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Shown below is an example of the code that is inserted:

Platform Code View

.NET
<cms:SmartMenu DefaultMenuID="6" id="SmartMenu1"
Enable508Compliance="True" DynamicParameter="menu_id"
Stylesheet="shuttermenu_blue.css" runat="server"></cms:SmartMenu>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Standard Menu
For a description of the Standard Menu function, see Menu Server Control on
page 9-188.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
CMS Menu Controls...

To insert a Standard Menu:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET Functions, click Standard Menu

The Standard Menu Control box appears.
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3. Use the following table to assist you with inserting a Standard Menu.

Field Description

Control ID A unique name for the function you are inserting.

DefaultMenuID The numeric id of themenu that you want to insert. If you do not know the
DefaultMenuID, you can navigate to it using the Select Menu drop down box.

Select Menu
Select amenu to be used.When amenu is selected, the DefaultMenuID textbox is filled
with that menu's id number. If you insert the DefaultMenuID, you do not need to select a
menu.

MenuType

The type of menu to render.

None - databind only

SampleMenu - A sample display, formatted asa bulletedmenu list

TreeMenu - A sample display, formatted asa folder tree. You can expand the tree by
clicking on the folder icon.

For more information on using the SampleMenu and TreeMenuDisplay, seeUsing
DisplayXslt Sampleson page 9-190 .

DynamicMenu
Parameter

Checks theQueryString for themenu value and replaces themenuwith content when
ID is specified. Leave blank to alwaysdisplay themenu.

None - Use Default

menu_ID - The control uses themenu passed asa URL parameter.

CacheInterval

Sets the amount of time the server control’s data is cached. The default is 0 (zero). This
is the amount of time, in seconds, a control’s data is cached. For example, if you want to

cache the data for fiveminutes, set this property to 300 0* *(*three hundred).See
Also: Caching with Server Controlson page 24-33

UsingOther Development Frameworks

27-176 ReferenceManual
Version 8.01 Rev 4



Field Description

Hide

Used to hide amenu in design time and run time.

Checked =Hide function

Unchecked =Show function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning
Info - GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb page.

For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML document as
a span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

4. When completed, click insert.

A graphic defines where the Standard Menu appears on your template.

Shown below is an example of the code that is inserted:
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Platform Code View

.NET <cms:Menu id="Menu1" DefaultMenuID="15" runat="server"></cms:Menu>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Web Search
For a description of the Web Search Function, see Web Search Server Control
on page 9-72.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert an Web Search:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, clickWeb Search.

3. The Insert Web Search box is displayed.
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4. Use the following table to assist you with inserting an Web Search.

Field Description

Control ID A unique name for the function you are inserting.

FolderID The numeric id of the folder that you want to search. If you do not know the folder
path, you can navigate to it using the Select folder drop down box.

Recursive In the FolderIDproperty, you specify a folder whose content is searched on this
map. To extend the search to all folders below this folder, check this box.

Select Folder
Select a folder path to be searched.When a folder is selected, the folderID textbox
is filled with that folder's id number. If you insert the Folder ID, you do not need to
select a folder.

ButtonImgSrc If you want to display an image on the submit button, enter the server path to it.

ButtonText The text used for the button if no image source is identified. If an image source is
identified, this is alternative text for the button.

WebSearch
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Field Description

DisplayXslt

Determineshow the information on the page is displayed

None-databind only

ecmNavigation - lists the title of every content block in the folder

See Also: Example of ecmNavigation Displayon page 9-127

ecmTeaser - lists the title of every content block in the folder plus the content
summary

Warning! If you specify an external file, it is strongly recommended that you do
not store this file in your site'sWorkarea folder. If you store this file in the
Workarea folder, the file will be lost when you upgrade.

See Also: Example of ecmTeaser Displayon page 9-128

PostResultsAt

Enter theWeb form onwhich the search resultswill post.

To display results on theWeb page fromwhich the search was initiated, enter a
pound sign (#) or leave the field blank.

Warning! AWeb Search server controlmust exist on the posting page.

ResultTagId

Lets you designate where search results appear. You can place search criteria in
one area of aWeb form and the results in another.

For example, you have the following tag.

<span id=”results”></span>

In this case, enter results for the property value.

Stylesheet

Specify the location of the style sheet for the search results page. Set the location
relative to the site root folder. For example: csslib\mytest.css.

Leave blank to use the default style sheet,
\webroot\Workarea\csslib\global.css.

MarkupLanguage

Identify the templatemarkup file that controls the display of the search results. For
example, mysearchmarkup.ekml.

If the *.ekml file is located in the same folder as theWeb form containing the server
control, just enter its name. If the file is in another folder, enter the path relative to
site root. For example, \CMS400Developer\workarea\customfiles\

markup\mysearchmarkup.ekml.

Note: Note: If you enter a valid EkML file, the Displayxsltproperty value is
ignored.

See Also: Controlling Output with EktronMarkup Language on page 26-1
andwebsearch.ekmlon page 26-67

Text BoxSize The size of theSearch text box for user input. The width is based on the number of
characters.
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Field Description

ShowSearchBoxAlways

If set to unchecked, the search boxdoesnot appear when the results are posted
to theWeb page.

Checked = search boxalwaysappears

Unchecked = the search boxdoesnot appear when the results are posted to the
Web page

ShowSearchOptions

If this box is checked, the following optionsappear above theSearch box.

n Site

n Html

n Documents

n Images

Multimedia

Checked = show search options

Unchecked =hide search options

EnableAdvancedLink

Set to true to display the link to the Advanced Search page (see image below).

MaxCharacters
Themaximum number of characters theSearch text boxaccepts.

If you enter a value less than 50, it is a good idea to set the TextBoxSizeproperty
to the same number.

Order By

Specify how you want to order the search results that are generated when a
search is performed on youWeb site.

n Title - The title of the content block

n Date Created - The date the content blockwascreated

n Date Modified - The date the content blockwas last modified

n Last Author Last Name - The last author’s last name

n Last Author First Name - The last author’s first name

OrderDirection

Specify if you want the results in ascending or descending order.

n Ascending - Alphabetic or numerical order

n Descending - Reverse alphabetic or numerical order

WebSearch
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Field Description

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe loaded in a new blankwindow.
Thiswindow is not named.

_self - This target causes the link to always load in the samewindow the anchor
was clicked in. This is useful for overriding a globally assigned base target.

_parent - This target makes the link load in the immediate frameset parent of the
document. This defaults to acting like “_self” if the document hasno parent.

_top - This target makes the link load in the full bodyof the window. This defaults
to acting like “_self” if the document is alreadyat the top. It is useful for breaking out
of an arbitrarily deep frame nesting.

Hide

Used to hide anWeb Search in design time and run time.

Checked =HideWeb Search

Unchecked =ShowWeb Search

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning Info -
GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb
page. For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML
document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

5. When completed, click insert.

A graphic defines where the Web Search appears on your template.
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Shown below is an example of the code that is inserted.

Platform Code View

.NET
<cms:WebSearch id="WebSearch1" ButtonText="Search!" FolderId="14"
runat="server"></cms:WebSearch>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.

ColdFusion This function is not available asan Ektron Dreamweaver Extension for ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

XML Index Search
For a description of the XML Index Search Function, see IndexSearch Server
Control on page 7-384.

This tag appears on the following menu(s):

n Commands > Ektron CMS400.NET (Server Controls) >
Content Controls...

To insert an XML Index Search:

1. Move the blinking cursor to the area that you want to place it.

2. From the list of Ektron CMS400.NET functions, click XML Index
Search.

3. The Insert XML Index Search box is displayed.
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4. Use the following table to assist you with inserting an XML Index
Search.

Field Description

Control ID A unique name for the function you are inserting.

XMLConfigID
ID of the Smart Formwhose indexed fields appear on the search screen. If you do
not know the XMLConfigID, you can navigate to it using the Select Smart Form
drop down box.

Select XML
Configuration

The drop-down box is populated with a list of all the XMLConfiguration titles.
When a title is selected, the XMLConfigID textbox is filled with that XML
Configuration's id number. If you insert the XMLConfigID, you do not need to
select a XMLConfiguration.

FolderID The numeric id of the folder that you want to search. If you do not know the folder
path, you can navigate to it using the Select folder drop down box.

Select Folder
Select a folder path to be searched.When a folder is selected, the folderID textbox
is filled with that folder's id number. If you insert the Folder ID, you do not need to
select a folder.

Search Parm XML This property preserves settings that a developer would create in VisualStudio.
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Field Description

Weighted

If this value ischecked, content blocksare ranked by the number of criteria
matches.

For example, if a content blockmatchesall search criteria, it appears at the top of
the results page. A hit marker appears for eachmatch.

If a second content blockonlymatchesone criterion, it also appears on the results
page underneath the first content block. One asterisk appears above the page’s
title to indicate the singlematch.

Checked- display every content block that matchesat least one search criteria

Unchecked - show only content blocks that match all search criteria

ShowSearchBoxAlways If set to unchecked, the search boxdoesnot appear on when the results are
posted to theWeb page.

Recursive Determineswhether the XML IndexSearch Control uses this folder’s child folders
in the search.

LinkTarget

Defines the waya link actswhen a link is clicked.

_blank - This target causes the link to alwaysbe loaded in a new blankwindow.
Thiswindow is not named.

_self - This target causes the link to always load in the samewindow the anchor
was clicked in. This is useful for overriding a globally assigned base target.

_parent - This target makes the link load in the immediate frameset parent of the
document. This defaults to acting like “_self” if the document hasno parent.

_top - This target makes the link load in the full bodyof the window. This defaults
to acting like “_self” if the document is alreadyat the top. It is useful for breaking out
of an arbitrarily deep frame nesting.

Order By

Specify how you want to order the search results that are generated when a
search is performed on youWeb site. Also specify if you want the results in
ascending or descending order.

n Title - The title of the content block

n Date Created - The date the content blockwascreated

n Date Modified - The date the content blockwas last modified

n Last Author Last Name - The last author’s last name

n Last Author First Name - The last author’s first name

n Ascending - Alphabetic or numerical order

n Descending - Reverse alphabetic or numerical order

When you choose weighted search results, Ascending and Descending use how
manycriteria match your search. For example, if you have weighted results, and
you choose Ascending, the results that match themost criteria appear first.

MaxNumber of results TheMaximum number of content blocks returned (0=unlimited).
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Field Description

DisplayType

Determineshow the information on the page is displayed

None-databind only

ecmNavigation - lists the title of every content block in the folder

See Also: Example of ecmNavigation Displayon page 9-127

ecmTeaser - lists the title of every content block in the folder plus the content
summary

See Also: Example of ecmTeaser Displayon page 9-128

DynamicContent
Parameter

Checks theQueryString for the content block ID value and replaces the search
with content when ID is specified. Leave blank to alwaysdisplay the search. By
making content dynamic, when the content displayed on aWeb page contains a
link to another piece of content, you can display the second piece of content in the
sameWeb page space.

None - Use Default

ID - The control uses the content blockpassed asa URL parameter.

EncodeContentHtml

When checked, Content HTML is encoded when it is returned.

Checked =Content HTML is encoded

Unchecked =Content HTML is not encoded

Hide

Used to hide an IndexSearch in design time and run time.

Checked =Hide IndexSearch

Unchecked =Show IndexSearch

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Visible

Used to show or hide the function at run time.

Checked =Show function

Unchecked =Hide function

Note: Note: If Hideand Visibleare both checked, the property is hidden.

Style (Positioning Info -
GridLayout)

Set position information of a control as absolute, when using aGridLayoutWeb
page. For example:

style="Z-INDEX: 101; LEFT: 328px; POSITION: absolute; TOP: 240px"

Wrap Tag

Allowsa developer to specify a server control’s tag.

The default isSpan.

Span - The <span> tag is used to designate an in-line portion of an HTML
document asa span element.

Div - The <div> tag is used when you want to apply attributes to a blockof code.
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Field Description

SuppressWrapper

Suppresses the output of the span/div tagsaround the control. The default is
Unchecked.

Checked =Suppresswrapper tags

Unchecked =Do not suppresswrapper tags

Button Text The text that appears on the button.

HitsMarker

This symbol showshowmanysearch criteria each hit matched.

The following example shows the first hit met three of the criteria. The second
groupmet one criterion.

5. When completed, click insert.

A graphic defines where the XML Index Search appears on your
template.

Shown below is an example of the code that is inserted.

Platform Code View

.NET
<cms:IndexSearch id="IndexSearch1" XmlConfigId="10"
FolderId="14" DisplayXslt="ecmTeaser"
runat="server"></cms:IndexSearch>

ASP This function is not available asan Ektron Dreamweaver Extension for ASP.
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Platform Code View

ColdFusion This function is not available asan Ektron Dreamweaver Extension for
ColdFusion.

JSP This function is not available asan Ektron Dreamweaver Extension for JSP.

PHP This function is not available asan Ektron Dreamweaver Extension for PHP.

Standard ASP.NET Methods
Use these methods to customize Ektron CMS400.NET. To use them, insert them
onto your template pages to invoke content blocks, list summaries, and other
objects stored in your database. They are the primary building blocks of your
Ektron CMS400.NET Content Management System.

Replacement of Standard Methods
Beginning with Release 4.7, Ektron CMS400.NET utilizes ASP.NET server
controls, which replace most Standard ASP.NET methods. With Ektron
CMS400.NET’s new toolbox of pre-built, reusable, data-bindable ASP.NET
controls, Ektron empowers developers working in Visual Studio to rapidly
integrate Ektron CMS components into their templates and sites. For more
Information on Ektron CMS400.NET controls, see Working with Ektron
CMS400.NET Server Controls on page 24-1.

The following examples shows the Login server control added by drag and drop
vs. adding a Login method by the ASP.NET method.

Drag and Drop Login server control
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Adding a Login function via an ASP.NET method.

<tr>

<td>

<%=AppUI.ecmLogin()%>

</td>

</tr>

Best Practice
Ektron recommendsusing CMS400.NET server controlswhen available over
Ektron standard ASP.NET methods. Themethodsare being replaced by the
server controls.

Note: You can still use the standard ASP.NET methods in Ektron CMS400.NET.

Referencing Methods in Visual Basic
Before you can use methods with Visual Basic, you must add a reference to
them from Visual Basic. Follow these steps to do so.

1. Open Visual Basic.

2. Choose or add a project.

3. In Solution Explorer, right click References and choose Add
Reference.

ReferencingMethods in Visual Basic
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4. In the Add Reference dialog box, click Browse.

5. Go to webroot/siteroot/Bin.

6. To load the standard methods click Ektron.Cms.UI.CommonUI.dll.
To load the XML Indexing methods, click Ektron.Cms.Common.dll.

7. Click Open, then OK.

Adding a New Web Form
To add a new Web form, follow these steps.

1. Open your project in Visual Studio.

2. Right click the project.

3. Click Add > Add Web Form.

4. ClickWeb Form.

5. In the code behind, add an Imports Ektron.Cms.UI.CommonUI
statement.
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Requirements for Standard Methods
Ektron CMS400.NET maintains and displays content through the use of Ektron
ASPX methods and ASP.NET assembly objects. To use the methods, include the
following code in your template:

<%@ Page Language="vb" AutoEventWireup="false" %>

<%@ Import Namespace="Ektron.Cms.UI.CommonUI" %>

<% Dim AppUI As New ApplicationAPI %>

Each line is explained below.

Line Description

<%@ Page Language="vb"
AutoEventWireup="false" %>

Ageneric .net line of code that should alwaysbe placed in the
template

<%@ Import
Namespace="Ektron.Cms.UI.CommonUI"
%>

An import statement that calls the namespace
Ektron.CMS.UI.CommonUI to display information
from the .net assembly file

<% Dim AppUI As New ApplicationAPI
%>

Createsan instance of the ApplicationUI class that is used by
eachmethod

These lines call the Ektron .net assembly object to allow the page to function
properly. They must appear at the top of each template file.

Standard Methods
To customize your Ektron CMS400.NET application, you need to be familiar with
these methods.

Method Description
More
Information

AddContent Programmatically addsa content blocks to Ektron
CMS400.NET

AddContent on
page 27-207

Collection Displays links generated by collections.
Collection Server
Controlon page 9-
122

Content Block Displaysandmanagesa content block.
ContentBlock
Server Controlon
page 7-194
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Method Description
More
Information

Event Calendar Displaysan event calendar

Form Displaysa content block that is associated with a form.
FormBlockServer
Controlon page 7-
271

IndexSearch Displayson aWeb page a set of search fields. A site visitor uses
the page to search for information on your Web site.

IndexSearch
Server Controlon
page 7-384

List Summary Displaysa list of content block summaries.
ListSummary
Server Controlon
page 9-266

Login Displays the login or logout button, which lets the user log in and
use Ektron CMS400.NET.

Login Server
Controlon page 2-
10

Metadata Displays themetadata in the source of theWeb page displaying
the content.

MetaData Server
Controlon page 7-
165

Menu Customizes the DHTMLmenus feature
DhtmlMenu
Server Controlon
page 9-194

Search
Inserts a text boxwith a search button in the template.When
the user completes the search screen, it looks through XHTML
content on theWeb site.

WebSearch
Server Controlon
page 9-72

ShowSiteLanguage Lets a site visitor select a language in which to view site.
LanguageSelect
Server Controlon
page 14-46

AddContent
The AddContent method lets you programmatically add a new content block to
Ektron CMS400.NET without logging in. This method can be used for several
applications, such as

n A Web form allowing you to collect data from users about the content
block

n A loop function that moves information from a database to an Ektron
CMS400.NET database

Warning! Every string that you pass to the function must be HTML encoded. Here is the VB.Net
syntax for encoding a string.
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myTitle = “John’s Book”

myTitle = Server.HtmlEncode(myTitle)

Explained in the table below are the attributes for the add content block
function.

Attribute Description

Username The username of the user to be authenticated for permissions to see whether the user
is able to add a content block.

Password The password for the username being authenticated.

Domain If using Active Directory, specify the domain needed to authenticate the user.

Content_title Specify a title for the content blockbeing added.

Content_
comment Specify a historical comment for the content being added.

ContentHTML Actual content for the content block.

SummaryHTML Summary information about the content block.

ContentLanguage Language of content.

FolderID ID number of the content folder where the content blockwill be added to.

GoLive
Date and time the content will go live.

Note: Must match date/time format set in theWeb.config keyek_dateFormat.

EndDate
Date and time the content will expire.

Note: Must match date/time format set in theWeb.config keyek_dateFormat.

MetaInfo

Specify the information for themetadata which will be used asa reference point for
finding other wordsor information.

An example is:

<metadata><meta id="3">Title</meta></metadata>

Where ID is themetadata definition ID whose value is being set. The value is set
between themeta tagsand themeta tag is repeatable for asmanymetadata definitions
as you want to set for the given content block.

ErrString If there is a error then errString contains the error, otherwise errString is empty.

AddContent
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Add Content Example
The following is an example of the add content function in a template.

Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles
Me.Load

Dim m_apiObj As Ektron.Cms.UI.CommonUI.ApplicationAPI

Dim newContentId As Integer = 0

Try

m_apiObj = New Ektron.Cms.UI.CommonUI.ApplicationAPI

newContentId = m_apiObj.AddContent( _

"admin", _

"admin", _

"", _

"Content Title", _

"Comment - this content added through API!", _

"This is the <b>body</b> of the content.", _

"This is the <i>summary</i> for the content.", _

"1033", _

"0", _

"06-27-2006 4:09 PM", _

"", _

"<metadata><meta id=""3"">ContentTitle</meta></metadata>", _

"")

Literal1.Text = "Content Added, ID = " + newContentId.ToString

Catch ex As Exception

Literal1.Text = "Error, AddContent Failed: " + ex.Message

Finally

m_apiObj = Nothing

End Try

End Sub

The previous example has the following properties:

n The user “admin” is used to be authenticated.

n The title of the new content block is “Content Title”.
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n The comment for the content is “Comment”.

n The body of the content is “This is the body of the content”.

n The summary of the content block is “This is the summary for the
content.

n The language ID = 1033, or English.

n The folder ID = 0 is where the content is added.

n The start date is 06-27-2006.

n No end date is specified.

n The metadata definition ID being set is “3” and the value is
ContentTitle.

When this function is executed, the content is added to Ektron CMS400.NET.
Displayed here is the record of the content in the workarea.

AddContent Example
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Custom ASP Functions
Important: As of 8.01 SP2, the platforms/ASP folder is installed to the program
files/Ektron/utilities folder. In order for ASP platform support to function, move the
platforms/ASP folder to the Workarea folder and configure it.
Previously, the platforms folder was installed to the Workarea folder by default.

Ektron CMS400.NET displays content on your Web site through the use of
custom Ektron ASP functions and ComObjects. Your template you must include
the following file to be able to use the custom functions:

<!-- #include file="applicationAPI.asp" -->

This file (application.asp) calls the file with the custom Ektron functions to
allow the page to function properly. The include statement must appear at the
top of every template file that uses an Ektron CMS400.NET custom ASP
function.

Warning! ContentWS.asmx is the web services (WSDL) file that the custom ASP functions use to
talk to Ektron CMS400.NET. The WSDLpath located in the applicationAPI.asp file must be
set to location of the WSDL file. The default WSDLpath is
http://localhost/CMS400Developer/WorkArea/WebServices/ContentWS.asmx. If you
have changed the location of ContentWS.asmx you need to update the WSDLpath. For example,
if your site is www.example.com, the WSDLpath would be
http://www.example.com/WorkArea/WebServices/ContentWS.asmx.

To customize Ektron CMS400.NET, you need to be familiar with these tags.

Function Description
More
Information

Calendar Functions

Calendar
Displaysa calendar with different display types.

For example, a daily view calendar.

Calendar
Function on
page 27-257

Event Calendar Displaysamonth view event calendar

Event
Calendar
Function on
page 27-256

Collection Functions

Collection Displays links generated by collections
Collection
Function on
page 27-242
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Function Description
More
Information

CollectionXML
CreatesXML for a collection bywrapping tagsaround all of the
collection itemsand their properties. This allowsyou to use an
XSLT to define how the XML collection is displayed.

XMLCollection
Function on
page 27-250

RandomContent Randomlydisplays the content of a collection item
Random
Content on
page 27-254

RandomSummary Randomlydisplays the summaryof a collection item
Random
Summaryon
page 27-255

RSSCollection Createsan RSS feed out of the items in a collection.
RSSCollection
Function on
page 27-247

Content Functions

AddContent Allowsa user to add content to Ektron CMS400.NET
programmatically.

AddContent
on page 27-
207

Content Block Displaysandmanagesa content block
Content Block
Function on
page 27-201

Form Displaysa content blockassociated with a form
Form Function
on page 27-
261

Multipurpose Displayseither a content blockor a form
MultiPurpose
Function on
page 27-263

List Summary Functions

Archive

ListSummary
Displays summariesof archived content blocks

Archive List
Summary
Function on
page 27-234

List Summary Displaysa list of content block summaries
List Summary
Function on
page 27-222

CustomASP Functions
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Function Description
More
Information

List SummaryXML
CreatesXML for a list summarybywrapping tagsaround all of
the collection itemsand their properties. This allowsyou to use
an XSLT to define how the XML collection is displayed.

XML List
Summary
Function on
page 27-229

RSSList Summary Createsan RSS feed out of the items in a list summary.
RSSSummary
Function on
page 27-237

Single Summary Displays the summary for a content block

Single
Summary
Function on
page 27-234

Login Functions

Login Adds the login or logout button
Login Function
on the facing
page

Menu Functions

DropHTMLMenu Used to display a DHTMLmenu
DHTML
Menuson
page 27-270

GenerateMenu Workswith DropHTMLmenu to displayDHTMLmenus
DHTML
Menuson
page 27-270

XMLMenu CreatesXML for amenu bywrapping tagsaround all of the
menu itemsproperties.

XMLMenu on
page 27-274

Metadata Functions

Metadata Displays themetadata for the currentWeb page
Metadata
Function on
page 27-263

Search Functions

Search Inserts a text boxwith a search button

Search
Functions
(ASP) on page
27-210
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Function Description
More
Information

Search Display Createsan area to display search results
Search Display
Function on
page 27-219

Site Language Functions

ShowSiteLanguage Lets a site visitor select a language in which to view site.

Show Site
Language
Function on
page 27-269

Login Function
The login function adds a login button on the template when displayed in a
browser. Here it the format of the login function.

<% ecmLogin
%>

This tag is responsible for displaying the following buttons on the Web page.

Button Name Description

Login When user is not logged into Ektron CMS400.NET, this button appears. Click
this button to let the user log in to the application.

Logout Once logged in, this button replaces the login button to allow the user to log
out from the Ektron CMS400.NETWeb site.

Workarea When logged in, this button appears under the logout button allowing the user
to access their workarea.

Preview
On

Lets the user to preview the entireWeb site as if all checked-in content was
published.

Login Function

ReferenceManual
Version 8.01 Rev 4

27-199



Button Name Description

Preview
Off Turnsoff preview mode.

Login Tag Example
The following example places a login button in a table cell inside an asp
template.

<tr>

<td>

<% ecmLogin %>

</td>

</tr>

When inserted properly, a login button appears on the Web page.

Clicking the login button opens a login window in which a user enters the
username and password. Upon successful completion, the user is logged in to
the Ektron CMS400.NET Web site.
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Placing Your Login Button
You can add as many login buttons to a template as you like. You might want to
include a login button on each template, or have a special Web page called
login.asp, from which users can log in without the public being able to access
the login page.

Content Block Function
The content block tag displays a content block on an Ektron CMS400.NET Web
page. There are two functions to choose from:

n ecmContentBlock

n ecmContentBlockEX

ecmContentBlock allows you display a content block without having to define an
XSLT.

With ecmContentBlockEX, you can display XML content by defining an XSLT or
applying one of the predefined XSLTs located in Ektron CMS400.NET. For more
information on predefined XSLTs, see Adding a Smart Form Using External XML
Files on page 7-283.

Here is the format for the ecmContentBlock function.

<%ecmContentBlockEX ID %>

Here is the format for the ecmContentBlockEX function.

<%ecmContentBlockEX

ID,

“XSLT”,

Override

%>

Note: As an alternative, you can use the multipurpose function, which can display either a
content block or a content block associated with a form. For more information, see
MultiPurpose Function on page 27-263.

The table below explains the attributes of the ecmContentBlock function.

Attribute Description Required

ID ID number assigned of the content block that will appear Yes

The table below explains the attributes of the ecmContentBlockEX function.

Placing Your Login Button
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Attribute Description Required

ID ID number assigned of the content block that will appear Yes

XSLT

File name and path to a valid XSLT to transform the XML content.See Also:
The Function’sArgumentson page 27-206

Warning! : If you specify an external file, it is strongly recommended that you do
not store this file in your site'sWorkarea folder. If you store this file in theWorkarea
folder, the file will be lost when you upgrade.

No

Override
If no XSLT is specified, then enter 1 to use XSLT1, 2 for XSLT2, or 3 for XSLT3.

See Also: The Function’sArgumentson page 27-206
No

In normal view, these tags retrieve the content block from the database and
displays it in the template.

If a user is logged into Ektron CMS400.NET, the content block tag displays a
silver access point in the upper left of the block to show the edit options when
hovering over it. .
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Content Block Examples
Ektron CMS400.NET has two types of content blocks.

Type Displays More information

Static One content blockon theWeb page StaticContent Blockbelow

Dynamic A content blockwhose ID is passed through the URL DynamicContent Blockon next page

In addition, a content block can contain XHTML or XML content. For more
information, see XML Content Block on page 27-205.

Static Content Block
The following illustrates how to insert a static content block on a template.

<tr>

<td>

<% ecmContentBlock(329) %>

</td>

</tr>

In the example above, the function retrieves the content block with an id of 329
from the database to the browser.

Content Block Examples

ReferenceManual
Version 8.01 Rev 4

27-203



Dynamic Content Block
The following example shows the content block tag where the id is being passed
as a URL parameter. Use this format with dynamic template.

<tr>

<td>

<% ecmContentBlock(request.QueryString(“id”)) %>

</td>

</tr>

When a user accesses this page, it adds the content block ID number to the
tag’s template, and the content block with the corresponding ID appears on the
Web page in the specified template.
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The id= convention is used by Ektron CMS400.NET to generate quicklinks when
content blocks are created.

The dynamic ecmContentBlock function is almost the same as the static one
(see Static Content Block on page 27-203). The only difference is the
parameter, which makes the function dynamic. The parameter uses a query
string call (Request.QueryString) to read the URL from the browser’s address
bar. It treats everything after the question mark as a list of key/value pairs
separated by ampersands. So, Request.QueryString passes the key as a
parameter and returns its associated value. For example, in URL
<http://localhost/CMS400Developer/index.asp?id=1&LangType=1036>,
the following QueryString calls return these values.

QueryString Call Return value

Request.QueryString(“id”) 1

Request.QueryString(“LangType”) 1036

XML Content Block
Here is an example of displaying an XML content block. Note that you specify a
content block and an XSLT, which determines how the content block is
displayed.

XMLContent Block
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<tr>

<td>

<% ecmContentBlockEx 13, “”, 1 %>

</td>

</tr>

This example displays the content block ID=13, using XSLT1 as the display
XSLT.

The Function’s Arguments
The ecmContentBlockEx takes three arguments. The first argument identifies
the content block to display. The second one is optional and, if used, specifies
an external XSLT file.

If the second argument does not exist, the third argument specifies an XSLT
identified in the Edit Smart Form screen. The following table provides additional
detail about the second and third arguments.

To use this display XSLT
Enter this for
argument 2

Enter this for
argument 3

The default XSLT specified in the Edit Smart Form
screen (illustrated below). Note that, in this example, the
XSLT Packaged option is the default XSLT since it is
selected.

““ none

XSLT Packaged: from the Edit Smart Form
screen (that is, the XSLT created in the Data
Designer)

Note: If an XSLT package hasnot been created, and
zero (0) is the third argument, the default XSLT
specified in the Edit Smart Form screen is used.

““ 0
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To use this display XSLT
Enter this for
argument 2

Enter this for
argument 3

XSLT 1 from the Edit Smart Form screen ““ 1

XSLT 2 from the Edit Smart Form screen ““ 2

XSLT 3 from the Edit Smart Form screen ““ 3

An absolute or relative path to an XSLT

An externalXSLT file
not specified in the Edit
Smart Form screen.

For example

<%
ecmContentBlockEx
13,
"samplexslt.xsl"%>

doesnot matter - if
a value exists in
argument 2,
argument 3 is
ignored

Dynamic and Static Combination
Here is an example of how you can use the two different content tags in the
same table cell by using an IF statement

<tr>

<td>

<% if request.QueryString("id")<> "" then

ecmContentBlock(request.QueryString("id"))else

ecmContentBlock(14) end if %>

</td>

<tr>

In this sample code, when a person accesses this page without passing through
the content’s ID number, the content with an ID=14 will be displayed. If you
pass a content id through the URL like index.asp?id=4, the content block
ID=4 will be displayed.

Add Content
The add content function allows you to programmatically add a new content
block to Ektron CMS400.NET without the need of logging in.

This function can be for several applications including, but not limited to:

n Applied to a Web form, allowing you to collect data from users about
the content block

Dynamic and Static Combination
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n Creating a loop function that moves information from a database to
an Ektron CMS400.NET database

Here is the format for the add content function:

<%
AddContent

Username,Password,Domain,content_title,content_
comment,
ContentHtml,
SummaryHTML,ContentLanguage,FolderID,GoLive,EndDate,MetaInfo

%>

Warning! Every string that you pass to the function must be HTML encoded. Here is the VB.Net
syntax for encoding a string.
myTitle = “John’s Book”
myTitle = Server.HtmlEncode(myTitle)

Explained in the table below are the attributes for the add content block
function.

Attribute Description

Username The username of the user to be authenticated for permissions to see whether the user
is able to add a content block.

Password The password for the username being authenticated.

Domain If using Active Directory, specify the domain needed to authenticate the user.

Content_title Specify a title for the content blockbeing added.

Content_
comment Specify a historical comment for the content being added.

ContentHTML Actual content for the content block.

SummaryHTML Summary information about the content block.

ContentLanguage Language of content.

FolderID ID number of the content folder where the content blockwill be added to.

GoLive
Date and time the content will go live.

Note: Must match date/time format set in theWeb.config keyek_dateFormat.

EndDate
Date and time the content will expire.

Note: Must match date/time format set in theWeb.config keyek_dateFormat.
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Attribute Description

MetaInfo

Specify the information for themetadata which will be used asa reference point for
finding other wordsor information.

An example is:

<metadata><meta id="3">Title</meta></metadata>

Where ID is themetadata definition ID whose value is being set. The value is set
between themeta tagsand themeta tag is repeatable for asmanymetadata definitions
as you want to set for the given content block.

Add Content Example
The following is an example of the add content function in a template:.

<tr>

 <td>

 <% AddContent "admin", "admin", "", "Content Title", "Comment",  "This is
the <b>body</b> of the content.", "This is the <i>summary</i> for the content.",
1033, 31, "06-14-2004 11:55 AM", "", "<metadata><meta
id=""3"">ContentTitle</meta></metadata>","" %>

 </td>

</tr>

The previous example has the following properties:

n The user “admin” is used to be authenticated.

n The title of the new content block is “Content Title”.

n The comment for the content is “Comment”.

n The body of the content is “This is the body of the content”.

n The summary of the content block is “This is the summary for the
content.

n The language ID = 1033, or English.

n The folder ID = 31 is where the content is added.

n The start date is 06-14-2004”.

n No end date is specified.

n The metadata definition ID being set is “3” and the value is
ContentTitle.

When this function is executed, the content is added to Ektron CMS400.NET.
Displayed here is the record of the content in the workarea.

AddContent Example
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Search Functions (ASP)
The search tag is used to display a text box, with a search button on the
template. When seen on the template of a Web page, users can enter text and
click on the search button to search through all the HTML content on the Web
site. To create a search, Ektron has created two search functions:

n ecmSearch

n ecmSearchNoFormTag

Both functions have the same parameters and perform the same search. The
only difference is ecmSearch automatically inserts form tags,
ecmSearchNoFormTag does not.

The following is an example of form tags.

<form name="ecmsearch" method="post" action='search-display.asp'>

</form>
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When using ecmSearch, form tags are added automatically. When using
ecmSearchNoFormTag you need to add the tags manually

When using the search function, ecmSearch and ecmSearchNoFormTag can be
interchanged. Shown here is the format for the ecmSearch and
ecmSearchNoFormTag:

<% ecmSearch
 or
 ecmSearchNoFormTag

“Starting Folder”,
Recursive,
“Target Page”,
Text Box Size,
Maximum Characters,
“Button Image Source”,
“Button Text”,
‘Font Face’,
“Font Color”,
“Font Size”,
Horizontal,
‘Spare”

%>

The following table provides information about all the attributes for the search
tags.

Attribute Description Required?
For more
information,
see

Starting
Folder The folder you wish to search. Yes Starting Folder

on page 27-213

Recursive Whether to search subfolders. 0=No, 1 =Yes Yes Recursive on
page 27-214

Target
Page TheWeb page to output the search results. Yes Target Page on

page 27-214

Text Box The size of the text box for user input. Yes Text Boxon
page 27-214

Maximum
Characters

Themaximum number of characters that the input text box
can accept. No

Maximum
Characterson
page 27-215

Search Functions (ASP)
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Attribute Description Required?
For more
information,
see

Button
Image
Source

The image location for the search button. Blank (““) =
standard submit button. No

Button Image
Source on page
27-215

Button
Text

The text used for the button if the standard submit button is
chosen, or alternative text for the button if an image is
chosen.

No Button Text on
page 27-216

Font Face The font of the search tag text. No Font Face on
page 27-216

Font Color The font color of the search tag text. Blank (““) =Black. No

Font Size The font size of the search tag text. No Font Size on
page 27-217

Horizontal Determines if the search optionsare in a row or a column. 1
= horizontal, 0 = vertical Yes Horizontalon

page 27-218

Spare1 Currently not used. Must be ““ Spare 1 on
page 27-219

Search Tag Example
The following example places a text field and a search button in a table cell
inside an ASP template.

<tr>

<td>

<% ecmSearch "\",1,"search-

display.asp",25,200,"","Search","Verdana",

"#808080","2",0,"" %>

</td>

</tr>

The previous example has the following properties:

n Searches the root folder, in this case the \content folder.

n Search is recursive.

n The target page is “search-display.asp”.

n The size of the text box is 25.
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n The search text box allows up to 200 characters.

n No image is used for a button. Instead, a standard submit button is
used.

n The text on the submit button is “Search”.

n The search options appear in Verdana with a color of #808080 and a
size of 2pt.

n The search options are arranged vertically.

When added to a template, and visited, the search tag will appear similar to the
following:

Search Tag Attributes
The search tag’s attributes are described below.

Starting Folder
In this attribute, specify the content folder where the search begins. There are
two options for this attribute.

Value Search begins in

“\“

“\folder path” specified folder

Search Tag Attributes
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Recursive
When you setup the search to be recursive, you are allowing the search to
search all the sub-folders associated with the starting folder you had specified.
You have two options for this attribute:

Value Search begins in

1 Recursive search (will search sub-folders of the starting folder).

0 Non-Recursive search (will only search starting folder).

Target Page
The page that displays the search results. You may enter any form of a URL for
this page.

Note: The target page must include the searchdisplay function to display search results.

To use the same page, enter a pound sign (#) into the field.

Text Box
This attribute sets the size of the search text box. It can be any number,
depending on the size of the search text box that you want.

Text Box
Size

Web Page View

10

50

UsingOther Development Frameworks

27-214 ReferenceManual
Version 8.01 Rev 4



Maximum Characters
This attribute determines the maximum number of characters that a user can
enter for search text.

Button Image Source
To use an image for the search button, enter the image’s filename and path.

Button Image Source Web Page View

““

“search.jpg”

“http://www.example.com/images/search.jpg”

MaximumCharacters
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Button Text
If no search button image is specified, the text in this field appears on the
button. If an image is being used for the search button, this text is the image’s
alt text.

Button Text Web Page View

“ClickMe to Search”

“ClickMe to Search”

Font Face
This font is used for the search options displayed on the Web page.

Font Face Web Page View

Cooper Black
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Font Face Web Page View

Kristen ITC

Font Color
The color of the text in the search tag. You may enter the color name or a hex i
decimal value of the color.

Font Color Web Page View

Red

#14DA14

Font Size
This is the size of the text on the search tag.

Font Color
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Font Size Web Page View

1

5

Horizontal
This attribute determines whether the search options are displayed vertically or
horizontally.

Attribute Web Page View

0

(vertical)

1

(horizontal)
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Spare 1
At the end of the Search tag is a attribute called Spare 1. This attribute has not
yet been assigned an function. As of now, when you enter a search tag, you
must pass this attribute ““.

Search Display Function
The search display custom tag creates the area where search results appear
after a search is executed.

Here is the format of the ecmSearchDisplay tag.

<% ecmSearchDisplay
“MaxNumberReturn”,
“StyleInfo”,
ShowDate %>

Below is a description of the tag’s attributes.

Attribute Description Required For more
information, see

MaxNumber of
content blocks
Returned

Maximum number of content blocks
returned. (0=Unlimited) Yes

MaxNumber of
Content Blocks
Returned on next
page

Style Info

An HTML style string used within the
HTML “hyperlink” generated by the
search output. Can control font, color,
size, etc.

No Style Info on page
27-221

ShowDate Displays the last modified date of the
content block. 0=No 1=Yes No Show Date on page

27-222

Search Display Example
Insert the following on the page that displays search results. You may place it
on the same page as the search tag or a separate page.

<tr>

<td>

<% ecmSearchDisplay 0,"","1" %>

</td>

</tr>

Spare 1
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This search display example has the following properties:

n Returns unlimited results when the search is performed.

n Contains no style information.

n Shows the last modified date of the content.

Search Display with Default Content
You can also set up the search display tag to display a default content block if a
search is not performed. Then, if a search is performed, the results replace the
content block. The sample code below does that:

<tr>

<% if (Request.Form("ecmsearchtype") <> "") then %>

<td>

<% ecmSearchDisplay 0,"" %>

</td>

<% else %>

<td>

<% ecmContentBlock(1) %>

</td>

<% end if %>

</tr>

Search Display Attributes
Listed below are the attributes for the SearchDisplay tag.

Max Number of Content Blocks Returned
This attribute determines the number of search results displayed on a page. You
may enter any integer. To display unlimited results, enter 0 (zero).
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Max Returns Web Page View

0

3

Style Info
An HTML style string used within the HTML “hyperlink” generated by the search
output. Can control font, color, size, etc.

Style Info Web Page View

““

Style Info
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Style Info Web Page View

“font-family:arial; font-weight:bold;
background-color:#cccccc; border:solid blue
1pt; margin:2px; width:50%;”

Show Date
This attribute determines if the content block’s last modified date appears next
to the title. This is useful when determining which content block is the most
recent. You have two choices.

Attribute Web Page View

0

1

List Summary Function
The list summary function is used to display the list of content summaries on a
Web page.
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Shown here is the format of the list summary function:

<% ecmListSummary

"Folder",
Recursive,
ShowSummary,
"StyleInfo",
"OrderBy, Asc/Desc",
"ShowInfo",
MaxNumber,
“ObjType”,
“OptionList” %>

A list and description of the attributes are shown in this table:

Attribute Description Options

Folder This is the folder the summary information will come from. Any folder

Recursive Allow the tag to get summary info from the child folders.
0 =Not
Recursive

1 =Recursive

ShowSummary Do you want the content summary to be displayed?

0 =No

1 =Yes

StyleInfo Inline style information for the generated text hyperlink. Any string

OrderBy,
ASC/DESC

Order the hyperlinksby:

“Title”

“DateModified”

“DateCreated”

“Startdate”

“AuthorFname”

“AuthorLname”

Order the hyperlinks in ascending or descending order.
“Title,asc”

“Title,desc”

ShowInfo Information that will appear to the right of the hyperlink.

“DateModified”

“DateCreated”

“AuthorFname”

“AuthorLname”

List Summary Function
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Attribute Description Options

MaxNumber Maximum number of summaries returned. 0 =Unlimited

ObjType

Determineswhether the list summary is for the folder or a single piece of
content.

For example:

If the Folderproperty = \books and “Folder” is chosen as the
ObjType, the list summary for the folder with booksappears.

If the folderproperty =1 and you choose “Content”as the ObjType,
a single summary for content with an ID =1 appears.

See Also: Single SummaryFunction on page 27-234

The default ObjType is “Folder”when left blank.

““

“Folder“

“Content”

OptionList Not yet implemented MUST BE ““

List Summary Example
Shown below is an example of the ListSummary function in an ASP Web page.

<TR>

<TD>

<% ecmListSummary "\Marketing\News",0,1,"",

"Title,asc","DateModified",0,"","" %>

</TD>

</TR>

The previous example has the following properties:

n Displays summaries from the \Marketing\News folder.

n Not recursive.

n The summaries will be shown.

n No style was applied to the hyperlinks.

n The results will be displayed in ascending order by title.

n The date modified of each content block will be displayed.

n Unlimited results will be shown.

Here is how the summaries will appear on the web page.
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List Summary Attributes
Listed below are all the different attributes and descriptions about them.

Starting Folder
In this attribute, you will need to specify which content folder you will want to
get all the summaries from. There are two options for this attribute:

Value Description

““ By leaving the value blank, all the summaries from the root content folder will be displayed.

“\Folder Path You can specify a specific folder to display the summaries from by inserting the folder path

Recursive
When you setup the search to be recursive, you are allowing the search to
search all the subfolders associated with the starting folder you had specified.
You have two options for this attribute:

Value Description

1 Recursive - summaries in the starting folder’s subfolderswill also be displayed.

0 Non-recursive - only summaries in the starting folder will be displayed.

List Summary Attributes
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Show Summary
The show summary attribute displays or suppresses the summary in the
summary list. You have two options for this attribute.

Attribute Web Page View

0

1

Style Info
In this field, you may enter inline style information for the generated text
hyperlinks displayed on the screen.

Style Info Web Page View

““
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Style Info Web Page View

"font-family:arial; font-weight:bold; background-
color:#cccccc; border:solid blue 1pt; margin:2px;
width:100%;"

Order By
This attribute will sort the summary results by different options. There are five
different ways to sort the summaries:

Value Summaries sorted by

Title title

DateModified datemodified

Date Created date created

Startdate The Start Date assigned to the content blockwhen created.

AuthorFname author’s first names

AuthorLname author’s last name

Ascending/Descending
This attribute is an addition to the previous OrderBy attribute. By default, the
list of the summaries are descending, meaning they will follow the path of A-B-
C, or 1-2-3. When set to ascending, they will order by Z-Y-X or 3-2-1.You will
have the option to re arrange these to display either in ascending or descending
order.

To do this, add the following to the OrderBy attribute:

Value Description

asc, 1 Thiswill order the Summaries in an ascending order

desc, 0 Thiswill order the Summaries in a descending order. This is the default setting.

Order By
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By using the ascending/descending option, you will have the option to set the
order of content blocks from most recent to oldest, or vice versa. As well as
ordering the list by the user’s first names or last names in ascending or
descending order.

Show Info
The show info field determines what sort of information is displayed to the right
of the hyperlinked title. There are four different options that you may choose
from:

Value Description Web Page View

DateModified Displays the date the
content was last modified.

DateCreated
Displays the date when
the content was first
created.

AuthorFname
Displays the first name of
the user who last edited
the content block.

AuthorLname
Displays the last name of
the user who last edited
the content block.

Max Number
This attribute determines how many summaries appear on a page. Enter the
number of summaries to be displayed. To display all summaries, enter 0 (zero)
and you will display unlimited results.
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XML List Summary Function
The XML List Summary function wraps XML around the properties of a list of
content that’s created as a list summary in the Ektron CMS400.NET Workarea.
Once created, you can use the XML to display the list summary information. The
ecmListSummaryXML function allows you to easily define how the list summary
data appears on the Web page.

Shown here is the format of the ecmListSummaryXML function.

<%
ecmListSummaryXML

“Folder”,
“Recursive”,
“OrderBy”,
“MaxNumber”,
“ObjType”,
“SummaryType” %>

The ecmListSummaryXml function attributes are explained below.

Attribute Description Options

Folder

This is the folder the summary information will come
from.

See Also: Starting Folder on page 27-225

Any folder

Recursive

Allow the tag to get summary info from the child
folders.

See Also: Recursive on page 27-225

0 =Not Recursive

1 =Recursive

OrderBy,
ASC/DESC

Order the hyperlinksby:

See Also: Order Byon page 27-227

“Title”

“DateModified”

“DateCreated”

“Startdate”

“AuthorFname”

“AuthorLname”

Order the hyperlinks in ascending or descending
order.

“Title,asc”

“Title,desc”

XML List Summary Function
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Attribute Description Options

MaxNumber
Maximum number of summaries returned.

See Also: . MaxNumber on page 27-228
0 (Zero) =Unlimited

ObjType

Determineswhether the list summary is for the
folder or a single piece of content.

For example:

If the Folderproperty = \books and “Folder” is
chosen as the ObjType, the list summary for the
folder with booksappears.

If the Folderproperty =1 and you choose
“Content”as the ObjType, a single summary for
content with an ID =1 appears.

See Also: Single SummaryFunction on page
27-234

The default ObjType is “Folder”when left blank.

““

“Folder“

“Content”

SummaryType
Used asa filter, this property determines the type of
content that appears in the list summary. The
default is “Content”when left blank.

“AllTypes” - displaysall of the
content types for the given folder.

“Content” - displaysa list of
content blocks.

“Forms” - formsappear in the list
summary.

“Archive_Content” - archived
content blocksappear in the list
summary.

“Archive_Forms” - archived
formsappear in the list summary.

“Assets” - assets, such asoffices
documents, appear in the list
summary.

“Archive_Assets” - archived
assets appear in the list summary.

“LibraryItem” - library items
appear in the list summary.

“NonLibraryContent” - all types
of content appear in the list
summaryexcept for library items.

When using the XML list summary function, the following tags are created
around the properties of each item in the list summary.

XML Tags Description

<Content></Content> Declaresa new section of content in the XML collection.
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XML Tags Description

<ID></ID>

The content block ID.

For example:

<ID>27</ID>

<Title></Title>

The title of the content block.

For example:

<Title>HTML for the World Wide Web with XHTML
and CSS</Title>

<QuickLink></QuickLink>

The quicklink associated with the content block.

For example:

<QuickLink>/CMS400Developer/
collection.aspx?id=27</QuickLink>

<Teaser></Teaser>

The summaryof the content block.

For example:

<Teaser>The easiest HTML book weve seen that
still manages to be comprehensive.</Teaser>

<StartDate></StartDate>

The content block’s start date formatted asa .NET date
type

For example:

<StartDate>1/1/0001 12:00:00 AM</StartDate>

<DateModified></DateModified>

The last date the content blockwasmodified.

For example:

<DateModified>1/19/2005 4:18:06
PM</DateModified>

<EndDate></EndDate>

The date the content block stops running on theWeb site

For example:

<EndDate>12/31/9999 12:00:00 AM</EndDate>

<LastEditorFname></LastEditorFname>

The first name of the last person who edited the content
block.

For example:

<LastEditorFname>John</LastEditorFname>

<LastEditorLname></LastEditorLname>

The last name of the last person who edited the content
block.

For example:

<LastEditorLname>Johnson</LastEditorLname>

<DisplayStartDate></DisplayStartDate> The content block’s start date. It is formatted asa string that
representsEktron CMS400’s display of the date.

XML List Summary Function
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XML Tags Description

<FolderID></FolderID>

The ID of the folder in which the content block is contained.

For example:

<FolderID>0</FolderID>

<ContentStatus></ContentStatus> The statusof the content block.

<Language></Language>

The language of the content block.

For example:

<Language>1033</Language>

<DisplayDateModified></DisplayDateModified>

edited. It is formatted asa string that representsEktron
CMS400’s display of the date.

For example:

<DisplayDateModified>1/19/2005 4:18:06
PM</DisplayDateModified>

<DisplayEndDate></DisplayEndDate>

The content block’s end date. It is formatted asa string that
representsEktron CMS400’s display of the date.

For example:

<DisplayEndDate>12/31/9999 12:00:00
AM</DisplayEndDate>

Here is how the raw XML list summary output appears before an XSLT is
applied.
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<Content>

<ID>24</ID>

<Title>ASP.NET Unleashed</Title>

<QuickLink>/CMS400Developer/collection.aspx?id=24</QuickLink>

<Teaser><p><em>ASP.NET Unleashed, Second Edition</em> is really big, really thorough,
and really <i>good</i>.</p></Teaser>

<StartDate>1/1/0001 12:00:00 AM</StartDate>

<DateModified>1/12/2005 7:53:31 PM</DateModified>

<EndDate>12/31/9999 12:00:00 AM</EndDate>

<LastEditorFname>Application</LastEditorFname>

<LastEditorLname>Administrator</LastEditorLname>

<DisplayStartDate></DisplayStartDate>

<FolderID>0</FolderID>

<ContentStatus></ContentStatus>

<Language>0</Language>

<DisplayDateModified>1/12/2005 7:53:31 PM</DisplayDateModified>

<DisplayEndDate></DisplayEndDate>

</Content>

<Content>

<ID>25</ID>

<Title>Microsoft ASP.NET Programming with Microsoft Visual C#.NET</Title>

<QuickLink>/CMS400Developer/collection.aspx?id=25</QuickLink>

<Teaser><p>Teach yourself how to write high-performance Web applications with ASP.NET
and Visual C# .NET--one step at a time.</p></Teaser>

<StartDate>1/1/0001 12:00:00 AM</StartDate>

<DateModified>1/4/2005 7:16:21 PM</DateModified>

<EndDate>12/31/9999 12:00:00 AM</EndDate>

<LastEditorFname>Application</LastEditorFname>

<LastEditorLname>Administrator</LastEditorLname>

<DisplayStartDate></DisplayStartDate>

<FolderID>0</FolderID>

<ContentStatus></ContentStatus>

<Language>0</Language>

<DisplayDateModified>1/4/2005 7:16:21 PM</DisplayDateModified>

<DisplayEndDate></DisplayEndDate>

</Content>
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Archive List Summary Function
The Archive list summary function displays on a Web page a list of content
summaries for archived content blocks. For example, you might have a current
news page and an archived news page. Use the List Summary Function to
display current news, and this function to display older news stories.

On the Content Block schedule screen, the user must set an End Date then
choose the Archive and Display option to have the content blocks appear via this
function.

Shown here is the format of the Archive List Summary function:

<% ecmListArchiveSummary

“StartingFolder”,

Recursive,

ShowSummary,

"StyleInfo",

"OrderBy, Asc/Desc",

"ShowInfo",

MaxNumber,

"Spare1",

"Spare2"

%>

This function has the same parameters as the List Summary Function. See List
Summary Function on page 27-222 for details.

Single Summary Function
The single summary tag is used to display the summary of one content block in
the Ektron CMS400.NET Web site, instead of a list of all the summaries in a
content folder. Seen below is the single summary tag:

<% ecmSingleSummary

"ContentID",
ShowSummary,
"StyleInfo",
"ShowInfo",
"Spare1" %>

You can look at the single summary tag as just a simpler form of the List
summary tag. The format for each of them is almost identical, but the single
summary tag does not require as many attributes to be passed.

A list and description of the attributes are shown in this table:
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Attribute Description Required?

Content ID This is the ID number of the content block the summary information will
come from. Yes

ShowSummary Do you want the content summary to be displayed? Yes

StyleInfo Inline style information for the generated text hyperlink. No

ShowInfo Information that will appear to the right of the hyperlink. No

Spare1 Not yet implemented MUST BE
““

Single Summary Example
Shown below is an example of the single summary function in an ASP Web
page.

<TR>

<TD>

<% ecmSingleSummary "14",1,"","DateModified","" %>

</TD>

</TR>

The previous example had the following properties:

n Displays the summary for the content block with an ID=14

n The summary will be shown

n No style was applied to the hyperlinks

n The last date the content was modified will be displayed

Here is how the summary will appear on the web page.

Single Summary Attributes
Listed below are all the different attributes and descriptions about them.

Single Summary Example
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Content ID
In this attribute, you will need to specify which content block you will want the
summary to be displayed from.

Show Summary
The show summary attribute will allow or disallow the summary to be displayed
in the summary list. You have two options for this attribute:

Value Web Page View

0

1

Style Info
In this field, you may enter inline style information for the generated text
hyperlinks displayed on the screen.

Style Info Web Page View

““

font-family:arial; font-weight:bold; background-
color:#cccccc; border:solid blue 1pt; margin:2px;
width:100%;

Show Info
The show info field determines what sort of information is displayed to the right
of the hyperlinked title. There are five different options that you may choose
from:
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Value Displays the... Web Page View

ID ID number for the content block.

DateModified date the content was last modified.

DateCreated date when the content was first created.

AuthorFname first name of the user who last edited
the content block.

AuthorLname last name of the user who last edited the
content block

Spare 1
There is one attribute fields at the end that are currently not used. This is here
for future scalability. When you insert a single summary tag into your template,
you must leave this attributes as ““

RSS Summary Function
The RSS summary function is used to create an XML list of content summaries
formatted for RSS Syndication.

Shown here is the format of the RSS summary function:

Spare 1
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<%
ecmRssSummary

“Folder”,
Recursive,
"OrderBy,
Asc/Desc",
MaxNumber, %>

A list and description of the attributes are shown in this table:

Attribute Description Options

Folder This is the folder the summary information will come from. Any folder

Recursive Allow the tag to get summary info from the child folders.
0 =Not Recursive

1 =Recursive

OrderBy, ASC/DESC

Order the hyperlinksby:

“Title”

“DateModified”

“DateCreated”

“Startdate”

“AuthorFname”

“AuthorLname”

Order the hyperlinks in ascending or descending order.
“Title,asc”

“Title,desc”

MaxNumber Maximum number of summaries returned. 0 =Unlimited

RSS Summary Example
Shown below is an example of the ecmRssSummary function in an ASP Web
page.

<TR>

<TD>

<% ecmRssSummary "\CMS400Developer\", 0, "Title,asc", 0 %>

</TD>

</TR>

The previous example has the following properties:

n Displays summaries from the \CMS400Developer\ folder.

n Not recursive.
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n The results will be displayed in ascending order by title.

n Unlimited results will be shown.

Here is how an RSS summary appears when viewed without an RSS reader on a
web page.

RSS Summary Example
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<?xml version=”1.0” ?>

- <rss xmlns:xsd="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" version="2.0">

- <channel>

<title>example listsummary</title>

<link>http://localhost/CMS400Developer/developer/ListSummary/RSS.aspx?show=true</link>

<description />

- <item>

<title>eWebEditPro+XML V4.2 supports the vision of create content once, reuse many
times</title>

<link>http://192.168.0.82/CMS400Developer/Developer/ListSummary/pr.aspx?id=290</link>

- <description>

- <![CDATA[ &lt;p&gt;Ektrons XML Authoring Tool Makes it Easier to Create Structured,
Validated Content to Support an Organizations Information and Content Management
Strategies&lt;/p&gt; ]]>

</description>

<author>Application Administrator</author>

<pubDate>3/7/2006 2:00:46 PM</pubDate>

</item>

- <item>

<title>Ektron Offers a Visual Development Environment for Rapid CMS Integration and
Deployment</title>

<link>http://192.168.0.82/CMS400Developer/Developer/ListSummary/pr.aspx?id=282</link>

- <description>

- <![CDATA[&lt;p&gt;Ektron leverages strong capabilities of Visual Studio to give
developers a truly visual environment for integrating CMS components into Web
templates&lt;/p&gt; ]]>

</description>

<author>Application Administrator</author>

<pubDate>3/7/2006 2:02:19 PM</pubDate>

</item>

- <item>

<title>Ektron Announces Winner of All-Stars Customer Competition</title>

<link>http://192.168.0.82/CMS400Developer/Developer/ListSummary/pr.aspx?id=292</link>

- <description>

- <![CDATA[ &lt;p&gt;&lt;em&gt;-- All-Stars competition identifies the most innovative
and effective implementations of Ektrons Web solutions and tools --
&Lt.;/em&gt;&lt;/p&gt; ]]>

</description>

<author>Application Administrator</author>

<pubDate>3/6/2006 10:51:52 AM</pubDate>

</item>

</channel>

</rss>
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RSS Summary Attributes
Listed below are all the different attributes and descriptions about them.

Starting Folder
In this attribute, you will need to specify which content folder you will want to
get all the summaries from. There are two options for this attribute:

Value Description

““ By leaving the value blank, all the summaries from the root
content folder will be displayed.

“\Folder Path You can specify a specific folder to display the summaries from by
inserting the folder path

Recursive
When you setup the search to be recursive, you are allowing the search to
search all the subfolders associated with the starting folder you had specified.
You have two options for this attribute:

Value Description

1 Recursive - summaries in the starting folder’s subfolderswill also
be displayed.

0 Non-recursive - only summaries in the starting folder will be
displayed.

Order By
This attribute will sort the summary results by different options. There are five
different ways to sort the summaries:

Value Summaries sorted by

Title title

DateModified datemodified

Date Created date created

Startdate The Start Date assigned to the
content blockwhen created.

AuthorFname author’s first names

AuthorLname author’s last name

RSS Summary Attributes
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Ascending/Descending
This attribute is an addition to the previous OrderBy attribute. By default, the
list of the summaries are descending, meaning they will follow the path of A-B-
C, or 1-2-3. When set to ascending, they will order by Z-Y-X or 3-2-1.You will
have the option to re arrange these to display either in ascending or descending
order.

To do this, add the following to the OrderBy attribute:

Value Description

asc, 1 Thiswill order the Summaries in an ascending order

desc, 0 Thiswill order the Summaries in a descending order. This is the
default setting.

By using the ascending/descending option, you will have the option to set the
order of content blocks from most recent to oldest, or vice versa. As well as
ordering the list by the user’s first names or last names in ascending or
descending order.

Max Number
This attribute determines how many summaries appear on a page. Enter the
number of summaries to be displayed. To display all summaries, enter 0 (zero)
and you will display unlimited results.

Collection Function
The collection function is used to display the list of links that were created as a
collection in the Ektron CMS400.NET Workarea. The ecmCollection function is
highly customizable, allowing you to easily define how the collection data
appears on the Web page.

Shown here is the format of the ecmCollection function.

<%
ecmCollection

“id”,
“Display
Function” %>

The ecmCollection function attributes are explained below.

Attribute Description

id The id of the collection that you would like to be displayed is defined here.
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Attribute Description

displayFunction
Specify a function that is defined in the API and determineshow the appearance of the
collection data on aWeb page. The display functionmust also be defined in the
ecmCollection function.

See Also: ”Comparison of Collections, Menus, Taxonomy, and the List Summary
Features” on page 1229

Collection Examples
The following are examples of the collection function in the Ektron CMS400.NET
sample Web site. One example uses the ecmNavigation display function, and
the other uses the ecmTeaser display function.

The ecmNavigation and ecmTeaser display functions are sample display
functions included with Ektron CMS400.NET.

The ecmNavigation Display Function
The following sample collection function is being used as a navigation menu in
the Ektron CMS400.NET sample Web site.

<% ecmCollection 1, “ecmNavigation”
%>

In this example, the collection with an ID=1 is displayed, and the
ecmNavigation function defines the appearance of the collection data on a Web
page.

Here is how a collection might appear on a Web page.

Collection Examples
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Below is the source code for the ecmNavigation display function.

Function ecmNavigation(cInfo)

dim html, info

html = "<table border=""0"" cellspacing=""0"" cellpadding=""0""

width=""100%"">"

for each info in cInfo

html = html & "<tr><td>&nbsp;&nbsp;<a href="""

html = html & info("ContentLinks")

html = html & """>"

html = html & Cstr(info("ContentTitle"))

html = html & "</a></td></tr><tr><td>&nbsp;</td></tr>"

next

html = html & "</table> "

ecmNavigation = html

end Function

As you can see, the ecmNavigation function is a simple ASP function that
creates a table of the links to the specified collection. It displays the title of the
content blocks by using the info(“ContentTitle”)) building block.
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The ecmTeaser Display Function
The following is an example of a collection function being used as a navigation
menu in the Ektron CMS400.NET sample Web site.

<% ecmCollection 2, “ecmTeaser” %>

In this example, the collection with an ID=2 is displayed, and the ecmTeaser
function defines the appearance of the collection data on the Web page.
ecmTeaser displays the title and summary of each content block in the
collection.

Here is how the collection might appear on a Web page.

The format of the collection on the Web page depends on the displayFunction
that is used. Below is the source code for the display function ecmTeaser.

The ecmTeaser Display Function

ReferenceManual
Version 8.01 Rev 4

27-245



Function ecmTeaser(cInfo)

dim html, info

html = "<table border=""0"" cellspacing=""0"" cellpadding=""0""

width=""100%"">"

for each info in cInfo

html = html & "<tr><td><a href="""

html = html & CStr(info("ContentLinks"))

html = html & """ >"

html = html & Cstr(info("ContentTitle"))

html = html & "</a>&nbsp;("

html = html & info("DateModified")

html = html & ")</td></tr><tr><td>"

html = html & Cstr(info("ContentTeaser"))

html = html & "</td></tr><tr><td>&nbsp;</td></tr>"

next

html = html & "</table>"

ecmTeaser = html

end Function

As you can see, the ecmTeaser function is an ASP function that creates a table
of links to the specified collection. The ecmTeaser function displays the:

n Content title

n Date modified

n Content block summary

Collection Attributes

ID
The collection ID number is assigned to the collection when it is created.

UsingOther Development Frameworks

27-246 ReferenceManual
Version 8.01 Rev 4



DisplayFunction
A display function determines which elements of the content blocks in a
collection appear on a Web page. Via ASP scripting, you can create display
functions or use any of the three included functions. You must define the display
function in two places.

n In the ecmCollection function as a case

n In the API file as a function

RSS Collection Function
The RSS collection function is used to create an XML list of links that were
created as a collection in the Ektron CMS400.NET Workarea. The
ecmRssCollection function is highly customizable, allowing you to easily define
how the collection data appears on the Web page.

DisplayFunction
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Shown here is the format of the ecmRssCollection function.

<%
ecmRssCollection “id” %>

The ecmRssCollection function attributes are explained below.

Attribute Description

id The id of the collection that you would like to be displayed is defined here.

See Also: ”Comparison of Collections, Menus, Taxonomy, and the List Summary
Features” on page 1229

Here is how an RSS Collection appears when viewed without an RSS reader on a
web page.
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<?xml version=”1.0” ?>

<rss xmlns:xsd=”http://www.w3.org/2001/XMLSchema”
xmlns:xsi=”http://www.w3.org/2001/XMLSchema-instance” version=”2.0”>

<channel>

<title>Books</title>

<link>http://localhost/cms400Developer/WorkArea/WebServices/ContentWS.asmx</link>

<description></description>

<item>

<title>Visual Basic.NET How to Program</title>

<link>http://localhost/cms400Developer/collection.aspx?id=23</link>

<description>Visual Basic .NET How to Program, Second Edition is an awesome resource for
the beginning VB.NET developer who is serious about the craft of programming. In 1,500
pages, this book covers an incredible amount of territory, from the evolution of programming
languages and web development all the way to advanced data structures and web
services.</description>

<author>Application Administrator</author>

<pubDate>3/3/2005 5:15:30 PM</pubDate>

</item>

<item>

<title>Simply Visual Basic.NET 2003</title>

<link>http://localhost/cms400Developer/collection.aspx?id=26</link>

<description>An Application-Driven Tutorial Approach</description>

<author>Application Administrator</author>

<pubDate>1/8/2005 10:50:30 AM</pubDate>

</item>

<item>

<title>Microsoft ASP.NET Programming with Microsoft Visual C#.NET</title>

<link>http://localhost/cms400Developer/collection.aspx?id=25</link>

<description>Teach yourself how to write high-performance Web applications with ASP.NET
and Visual C# .NET--one step at a time.</description>

<author>Application Administrator</author>

<pubDate>1/4/2005 7:16:21 PM</pubDate>

</item>

<item>

<title>HTML for the World Wide Web with XHTML and CSS</title>

<link>http://localhost/cms400Developer/collection.aspx?id=27</link>

<description>The easiest HTML book we’ve seen that still manages to be comprehensive, and
to stay firmly grounded in the reality of today’s demanding users and complex
browsers.</description>

<author>Application Administrator</author>

<pubDate>1/19/2005 4:18:06 PM</pubDate>

</item>

</channel>

</rss>

RSS Collection Function
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XML Collection Function
The XML collection function wraps XML around the parameters of a list of
content that’s created as a collection in the Ektron CMS400.NET Workarea. Once
created you can use the XML to display the collection information. The
ecmCollectionXML function allows you to easily define how the collection data
appears on the Web page.

Shown here is the format of the ecmCollectionXML function.

<% ecmCollectionXML “id”, “GetHtml” %>

The ecmCollectionXML function attributes are explained below.

Attribute Description

id The id of the collection that you would like to be displayed is defined here.

GetHtml

Determineswhether the HTML contained within the content is included in the XML output.

0 =Do not get HTML

1 =Get HTML

Note: Ektron recommendsusing 0 (zero). HTML content can be large and this could cause
displayproblemswhen your XML collection is displayed on your Web page.

See Also: ”Comparison of Collections, Menus, Taxonomy, and the List Summary
Features” on page 1229

When using the XML Collection function, the following tags are created around
the properties of each item in the collection.

XML Tags Description

<Content></Content> Declaresa new section of content in the XML collection.

<ID></ID>

The content block ID.

For example:

<ID>27</ID>

<Title></Title>

The title of the content block.

For example:

<Title>HTML for the World
Wide Web with XHTML and CSS</Title>
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XML Tags Description

<QuickLink></QuickLink>

The quicklink associated with the content block.

For example:

<QuickLink>/CMS400Developer/
collection.aspx?id=27</QuickLink>

<Teaser></Teaser>

The summaryof the content block.

For example:

<Teaser>The easiest HTML book weve seen that
still manages to be comprehensive.</Teaser>

<Html></Html>

All of the HTML content contained in a content block.See
Also: GetHtmlon previouspage

For example:

<Html><em>ASP.NET Unleashed, Second
Edition</em> is really big, really thorough,
and really <i>good</i>. The explanations are
simple and clear as anything weve seen in a
.NET book. The sample code addresses
virtually every facet of ASP.NET
development, from little gems (code for
validating credit cards) to full-fledged web
stores. Best of all, Stephen Walther
identifies the mistakes ASP.NET developers
are most likely to make -- and presents
detailed solutions. </Html>

<StartDate></StartDate>

The content block’s start date formatted asa .NET date
type

For example:

<StartDate>1/1/0001
12:00:00 AM</StartDate>

<DateModified></DateModified>

The last date the content blockwasmodified.

For example:

<DateModified>1/19/2005 4:18:06
PM</DateModified>

<EndDate></EndDate>

The date the content block stops running on theWeb site

For example:

<EndDate>12/31/9999
12:00:00 AM</EndDate>

<LastEditorFname></LastEditorFname>

The first name of the last person who edited the content
block.

For example:

<LastEditorFname>John</LastEditorFname>

XMLCollection Function
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XML Tags Description

<LastEditorLname></LastEditorLname>

The last name of the last person who edited the content
block.

For example:

<LastEditorLname>Johnson</LastEditorLname>

<Hyperlink></Hyperlink>

The hyperlink shown in the collection for linking to the
content block.

For example:

<Hyperlink><a href="/CMS400Developer
/collection.aspx?id=27">
HTML for the World Wide Web with XHTML and
CSS</a></Hyperlink>

<DisplayStartDate></DisplayStartDate> The content block’s start date. It is formatted asa string
that representsEktron CMS400’s display of the date.

<FolderID></FolderID>

The ID of the folder in which the content block is contained.

For example:

<FolderID>0</FolderID>

<ContentStatus></ContentStatus> The statusof the content block.

<Language></Language> The language of the content block.

<DisplayDateModified></DisplayDateModified>

edited. It is formatted asa string that representsEktron
CMS400’s display of the date.

For example:

<DisplayDateModified>1/19/2005 4:18:06
PM</DisplayDateModified>

<DisplayEndDate></DisplayEndDate>

The content block’s end date. It is formatted asa string that
representsEktron CMS400’s display of the date.

For example:

<DisplayEndDate>12/31/9999 12:00:00
AM</DisplayEndDate>

<EndDateAction></EndDateAction>

What should happen to the content blockon its end date.

n archive display

n archive expire

refresh report

For example:

<EndDateAction>Archive_
Expire</EndDateAction>
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XML Tags Description

<Comment></Comment>

Comments contained in the content block.

For example:

<Comment>move picture below text</Comment>

Here is how the raw XML Collection output appears before an XSLT is applied.
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<Content>
<ID>24</ID>
<Title>ASP.NET Unleashed</Title>
<QuickLink>/CMS400Developer/collection.aspx?id=24</QuickLink>
<Teaser><p><em>ASP.NET Unleashed, Second Edition</em> is really big, really thorough,
and really <i>good</i>.</p></Teaser>
<Html></Html>
<StartDate>1/1/0001 12:00:00 AM</StartDate>
<DateModified>1/12/2005 7:53:31 PM</DateModified>
<EndDate>12/31/9999 12:00:00 AM</EndDate>
<LastEditorFname>Application</LastEditorFname>
<LastEditorLname>Administrator</LastEditorLname>
<Hyperlink><a href=”/CMS400Developer/collection.aspx?id=24”>ASP.NET
Unleashed</a></Hyperlink>
<DisplayStartDate></DisplayStartDate>
<FolderID>0</FolderID>
<ContentStatus></ContentStatus>
<Language>0</Language>
<DisplayDateModified>1/12/2005 7:53:31 PM</DisplayDateModified>
<DisplayEndDate></DisplayEndDate>
<EndDateAction>Archive_Expire</EndDateAction>
<Comment></Comment>
</Content>
<Content>
<ID>25</ID>
<Title>Microsoft ASP.NET Programming with Microsoft Visual C#.NET</Title>
<QuickLink>/CMS400Developer/collection.aspx?id=25</QuickLink>
<Teaser><p>Teach yourself how to write high-performance Web applications with ASP.NET
and Visual C# .NET--one step at a time.</p></Teaser>
<Html></Html>
<StartDate>1/1/0001 12:00:00 AM</StartDate>
<DateModified>1/4/2005 7:16:21 PM</DateModified>
<EndDate>12/31/9999 12:00:00 AM</EndDate>
<LastEditorFname>Application</LastEditorFname>
<LastEditorLname>Administrator</LastEditorLname>
<Hyperlink><a href=”/CMS400Developer/collection.aspx?id=25”>Microsoft ASP.NET
Programming with Microsoft Visual C#.NET</a></Hyperlink>
<DisplayStartDate></DisplayStartDate>
<FolderID>0</FolderID>
<ContentStatus></ContentStatus>
<Language>0</Language>
<DisplayDateModified>1/4/2005 7:16:21 PM</DisplayDateModified>
<DisplayEndDate></DisplayEndDate>
<EndDateAction>Archive_Expire</EndDateAction>
<Comment></Comment>
</Content>

Random Content
The random content function is used to randomly display the content of a
content block that belongs in a specified collection.
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Displayed here is the format for the random content function

<% ShowRandomContent “id”,
XSLTId %>

Where the “id” represents the ID number of the collection the content blocks,
that will be displayed, belong to

And “XSLTId” is the ID number of the display XSLT that will be applied to the
content blocks in the collections.

Random Summary
Similar to the random content function, the random summary function
randomly displays a content block summary that belongs in a specified
collection.

Here is the format for the random content function

<% ShowRandomSummary
“id” %>

The “id” represents ID number of the collection to which the content blocks
belong.
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Event Calendar Function
The ecmEvtCalendar function displays a month view event calendar that has
been created in Ektron CMS400.NET. Here is the format for the event calendar
custom function.

<% ecmEvtCalendar
“id” %>

Note: You can use ecmCalendar to call a calendar and display a different view, such as daily.
For more Information, see Calendar Function on the facing page

The “id” argument represents the ID number of the event calendar in the
Workarea.

Event Calendar Style Sheet
Before you insert an event Calendar into your Ektron CMS400.NET template,
you should make a reference to the style sheet,
\siteroot\Workarea\csslib\calendarStyles.css, in your template. This
style sheet contains styles that define the Calendar.

Event Calendar Sample
Here is an example of an event Calendar in an Ektron CMS400.NET template.

<tr>

<td>

<% ecmEvtCalendar "1" %>

</td>
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</tr>

When this code is displayed in a browser, the Calendar with an ID-1 is
displayed. Here is the calendar displayed on a Web Page

If... Calendar Display

Logged
in

Logged
Out

As you can see, when you are logged into the Web site, you can add and view
Calendar events. When logged out, you can only view calendar events.

Calendar Function
The ecmCalendar function displays a calendar that has been created in Ektron
CMS400.NET. Here is the format for the event calendar custom function.

Calendar Function
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<% ecmCalendar “id”, “DisplayType” %>

Note:While you can display a month view calendar with ecmCalendar, you can also use
ecmEvtCalendar to display a month view calendar. For more Information, see Event Calendar
Function on page 27-256

The ecmCalendar function attributes are explained below.

Attribute Description

id

The “id”argument represents the ID number of the event calendar in theWorkarea.
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Attribute Description

DisplayType

Specify the Calendar display type.

n Month - A 30 day calendar month view.

n Day - Single day view.

n Inline - Displayevents that occur from the start date of the calendar through the end date.

n MonthUpWithEvent - Displaysamonth calendar. Events appear to the right of the
calendar when you click on a day.

Calendar Function
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Calendar Style Sheet
Before you insert an event Calendar into your Ektron CMS400.NET template,
you should make a reference to the style sheet,
\siteroot\Workarea\csslib\calendarStyles.css, in your template. This
style sheet contains styles that define the Calendar.

Event Calendar Sample
Here is an example of an event Calendar in an Ektron CMS400.NET template.

<tr>

<td>

<% ecmCalendar "1", “MonthUpWithEvent” %>

</td>

</tr>

When this code is displayed in a browser, the Calendar with an ID of 1 and
DisplayType of MonthUpWithEvent is displayed. Here is the calendar displayed
on a Web Page

If... Calendar Display

Logged in

Notice the add event and view event buttons that appear when logged in.

LoggedOut
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As you can see, when you are logged into the Web site, you can add and view
Calendar events. When logged out, you can only view calendar events.

Form Function
The ecmFormBlock and ecmFormBlockNoFormTag functions display an HTML
form content block. Both functions have the same parameters and display the
form the same way. The only difference is ecmFormBlock automatically inserts
form tags, ecmFormBlockNoFormTag does not.

The following is an example of form tags.

<form name="myform" action="#" onsubmit="return EkFmValidate(this);" method="post">

</form>

When using ecmFormBlock, form tags are added automatically. When using
ecmFormBlockNoFormTag, form tags need to be added manually.

For more information about HTML forms, see Working with HTML Forms on
page 7-212.

Warning! If you create a template for an existing form content block, you must manually change
its quicklink to point to the new template. This change does not occur automatically. This
procedure is described in Updating Default Template for Multiple Quicklinks on page 8-22.

Here are the two formats for the form custom function.

<% ecmFormBlock “id” %>

or

<% ecmFormBlockNoFormTag “id” %>

Note: As an alternative, you can use the multipurpose function, which can display either a
content block or a content block associated with a form. For more information, see
MultiPurpose Function on page 27-263.

The “id” argument represents the form’s ID number, visible when viewing the
form from the View Form screen.
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ecmFormBlock and ecmFormBlockNoFormTag are interchangeable when using
this function. Here is an example of a form content block in an Ektron
CMS400.NET template.

<tr>

<td>

<% ecmFormBlock "367" %>

</td>

</tr>

When this code is read by a browser, the following is displayed.

When a visitor to your site submits a form, the form uses the form information
to process the data.
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MultiPurpose Function
The ecmMultiPurpose function displays either a content block or an content
block associated with a form. As a result, you can use one template to display
both types of content block.

Here is the format for the Multipurpose function:

<% ecmMultiPurpose
“id” %>

To pass in a standard content block, pass the id value in the url parameter, as
illustrated below.

http://localhost/cms400sample/index.asp?id=2

To pass in a Form content block, pass the ekfrm value in the url parameter, as
illustrated below.

http://localhost/cms400sample/index.asp?ekfrm=2

Note: For more information about passing the id value as a URL parameter, see Dynamic
Content Block on page 27-204.

If the id value or ekfrm value does not exist, a blank template appears.

If the url parameter is not passed in or recognized, the function calls
ecmContentBlock and passes the DefaultID value as the id argument. If the
DefaultID value is zero (0), ecmContentBlock is not called.

Metadata Function
The metadata tag is used to display the metadata for one or more content
blocks in the Ektron CMS400.NET Web site. This custom tag lets you generate
the list of metadata edited by the authors and insert it in the source of the Web
page. Below is an example of the metadata custom tag.

<% ecmMetaData
“ItemList”,”Spare1” %>

The attributes are described below.
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Attribute Description Required?

ItemList
List of the content block ID numbers, and

exclusionsSee Also: ot exist. Creating
an Item List below and Item List on page 27-267

No

Spare1 Not yet implementedSee Also: Spare 1 on
page 27-269

MUST BE ““

Creating an Item List
The Item List for the ecmMetadata tag has the following format.

“[content block id; Exclusion list]...[content block id; Exclusion list]”

Attribute Description Required?

[ (left bracket) Delineates the beginning of a content block id/exclusion
list pair Yes

Content Block ID The ID of the content blockwhosemetadata you want to
retrieve Yes

; (semicolon) Separator: Separates content block id from the exclusion
list

No (Yes if including an
exclusion list)

Exclusion List A comma delimited list of metadata you do not want to be
retrieved for this content block. No

] (right bracket) Delineates the end of a content block id/exclusion list pair Yes

ecmMetadata Example
For this example, our administrator has defined the following metadata types
for Ektron CMS400.NET.

Name Style Type Editable Required
Remove
Dups

Case
Sensitive

Title n/a HTML Yes Yes No n/a

Keywords Name Meta Yes Yes Yes No

Content-
Type

http-
equiv Meta No Yes Yes n/a

Our example Web page has two content blocks displayed.

n content block 1, the company’s home page introduction text
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n content block 2, a sidebar containing the lead story for the week

The metadata entered by your content editors for these two content blocks are:

Content Block 1:
Title – “Welcome to Our Home Page”
Keywords – “Home; page; company; Welcome”
Content-Type -- “text/html; charset=iso-8859-1“

Content Block 2:
Title – “Announcing our New Product!”
Keywords – “Announce; company; product; widget”
Content-Type -- “text/html; charset=iso-8859-1“

To include both content blocks’ metadata in a Web page, the ecmMetadata call
looks like this.

<html>

<head>

<% ecmMetadata “[1][2;Title,Content-Type]”, “” %>

(rest of head)

</head>

<body>

(rest of web page document)

</body>

</html>

In the above example, the ecmMetadata call is contained in the <head> of the
HTML document (since all HTML metadata is required to exist there). When the
Web page is viewed, the Web page source contains the following information:

<html>

<head>

<Title>Welcome to Our Home Page</Title>

<meta name=”Keywords” content= Home; page; company; Welcome; Announce;

product; widget”>

<meta http-equiv=”Content-Type” content=”text/html; charset=iso-8859-1”>

(rest of head)

</head>

<body>

(rest of web page document)

</body>

ecmMetadata Example

ReferenceManual
Version 8.01 Rev 4

27-265



</html>

The ecmMetadata constructed three HTML tags based on the administrator
defined parameters and the ecmMetadata call.

The metadata tag was constructed in the page because:

n [1] - Displays all metadata content for the content block ID=1. In
this example, the title, keywords, and content-type were defined, so
they were displayed as:

<Title>Welcome to Our Home Page</Title>

<meta name=”Keywords” content= Home; page; company; Welcome;

Announce; product; widget”>

<meta http-equiv=”Content-Type” content=”text/html;

charset=iso-8859-1”>

n [2;title,content-type] - Displays all metadata content for content
block ID=2, except for its title and content-type definitions.

<Title>Welcome to Our Home Page</Title>

<meta name=”Keywords” content= Home; page; company; Welcome;

Announce; product; widget”>

<meta http-equiv=”Content-Type” content=”text/html;

charset=iso-8859-1”>

The next section provides more examples.

More ecmMetadata Examples
Shown below is an example of the metadata function in an ASP Web page.

<TR>

<TD>

<% ecmMetaData "[1][2;title][14;keywords]","" %>

</TD>

</TR>

The previous example has the following properties:

n All metadata for content block ID=1 is inserted into the page

n All metadata for the content block ID=2 except for its title is inserted
into the page

n All metadata for the content block ID=14 except for its keywords is
inserted into the page
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Using a Dynamic Metadata Tag
You can use a metadata tag in a template to define the metadata for a specific
content block. However, you can also use a dynamic metadata tag combined
with a content block tag to show the metadata for all content blocks on a Web
page.

This allows you to create a template and not have to keep updating the tag by
adding the new ID and exclusion list. Shown below is the sample code for this.

<!-- #include virtual="/Ektron CMS400.NETsample/Ektron CMS400.NETscripts/ektronAPI.asp"
-->

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN">

<html>

<head>

<% Dim id

if (request.QueryString("id")<> "") then

id = request.QueryString("id")

else

id = 1

end if

ecmMetadata "[" & id & "]", ""

%>

</head>

<body>

<% ecmContentBlock(request.QueryString("id")) %>

</body>

</html>

In this example, if you specify a content block in the URL and the page is
displayed, the metadata takes that ID and displays the proper metadata in the
source for the content block.

ecmMetadata Attributes
Below are the attributes and their descriptions.

Item List
In this attribute of the ecmMetadata tag, you need to specify two values.
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Value Specifies

ID The content block ID whosemetadata will appear

Exclusion List Themetadata to be excluded.See Also: Creating an Item
List on page 27-264

Some examples might be:

<% ecmMetaData "[1][2]","" %>

In this example, all metadata from content block ID=1 and 2 is displayed.

<% ecmMetaData "[1;title][2;keywords]","" %>
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In this example, all the metadata from content block ID=1 will be displayed
except for the title. Also, all the metadata for content block ID=2 is displayed
except its keywords.

<% ecmMetaData "[1][2;title,keywords]","" %>

In this example, all metadata from content block ID=1 is displayed, and all
metadata from content block ID=2 is displayed except its title and keywords.

Spare 1
One attribute field at the end is currently not used. It is for future scalability.
When you insert a single metadata tag into a template, you must leave this
attributes as ““.

Show Site Language Function
This function lets a visitor to your Web site select a language in which to view
the site. Here is what the function looks like when published on a Web page.

Spare 1
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It lists all languages selected on the Settings > Configuration > Language
settings screen. (For more information, see ”Multi-Language Support” on page
 1755.)

Below is an example of the Show Site Language custom tag.

<% ecmShowSiteLanguage(FieldName)%>

You can place this function in any location of any page on your site. By default,
it appears in the lower right corner of the home page.

Note: This function only works with Asp and ASP.Net.

The attribute is described in this table.

Attribute Description

FieldName

An optional argument. You can leave it blankand allow the drop-
down list to be populated by the available languages for your Web
site. For example:

<%=ecmShowSiteLanguage(‘’)%>

Or you can pass in an argument such as:

<%=ecmShowSiteLanguage(‘mysitelanguage’)%>

DHTML Menus
Ektron CMS400.NET’s Menu feature lets users create and maintain a dropdown
menu system for your Web site. The Menu feature lets you display menu
options that link to content blocks, library assets, external hyperlinks and
submenus.

To learn more about menus, see Working with Menus on page 9-133.
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Additional Documentation in Ektron
Knowledge Base
This chapter explains how to implement standard menus that ship with Ektron
CMS400.NET. Ektron’s Web site also provides Knowledge Base articles that
explain how to extend the standard menu features.

Displaying a Menu on a Web Page

GenerateMenu and DropMenu
Warning! The menu functions described below are only one example of how to implement
menus. The scripts reside in the Application API file. You can implement your own menu system
using JavaScript.

Use the GenerateNextGenMenu and DropNextGenMenu custom functions to
display a DHTML menu on a Web page. Place GenerateNextGenMenu once on
the page to provide an infrastructure for DropNextGenMenu. Then, place
DropNextGenMenu as needed to implement individual menus.

Follow these steps to display a menu on a Web template.

1. Place the following code directly after the page’s <body> tag.
<%=(ecmDHTML_GenerateNextGenMenu("menu id number"))%>

For example:
<%=(ecmDHTML_GenerateNextGenMenu("1"))%>

To display more than one menu, separate each id number with a
comma. For example:

<%=(ecmDHTML_GenerateNextGenMenu("1,2,3"))%>

2. If the user clicks text to display the menu, place the following code
within the template file where the text would appear.

 <%= ecmDHTML_DropNextGenMenu(menu id number,"text user clicks to display menu")%>

For example:
<%= ecmDHTML_DropNextGenMenu(1,"Products")%>

If the user clicks a graphic to invoke the menu, use this syntax:
 <%= ecmDHTML_DropNextGenMenu(menu id number,'<img src=graphic file name>')%>

For example:
 <%= ecmDHTML_DropNextGenMenu(1,'<img src=mymenugraphic.jpg>')%>

Additional Documentation in Ektron Knowledge
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Displaying Menus in a Multi-language System
If your Web site supports multiple languages, and the user selects a language
before viewing the menu, if an edition of the menu is available in that language,
it appears. If not, nothing appears.

For more information, see ”Working with Menus in a Multi-Language System” on
page 1423.

Customizing the Menu’s Appearance
You can customize a menu’s appearance, such as the font style, color, and size.
So, you have the flexibility to coordinate a menu with the design your Web site.

To customize a menu in Ektron CMS400.NET, you can change the ek_menu.js
file. See Also: ek_Menu.js below

ek_Menu.js
You can change the look and feel of a menu by changing the ek_menu.js file. If
you used the default settings when installing Ektron CMS400.NET, this file is in
webroot/siteroot/Workarea/java/.

Use the following table to help you change menu attributes.

Attribute name Specifies the Default value

fontSize Size of menu text 14

fontWeight
Thicknessof menu text

You can set FontWeight byname (Boldor Plain)
or value. Values range from 0 -1000.

Plain

fontFamily
Font style of menu text

See Also: FontFamilyon the facing page
arial,helvetica,espy,

sans-serif

fontColor

Color of menu text

Note: When changing the color, you can
specify the color name or code.

#000000

fontColorHiLite Color of text whenmenu item is highlighted #ffffff

bgColor Color of border betweenmenu items #555555

menuBorder Width (in pixels) of border aroundmainmenu 1
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Attribute name Specifies the Default value

menuItemBorder Width (in pixels) of border around eachmenu item 1

menuItemBgColor Background color of menu items #6699ff

menuLiteBgColor
Color of mainmenu border highlight

See Also:menuLiteBgColor on next page

menuBorderBgColor Color of themainmenu border #6699ff

menuHiLiteBgColor Background color of highlightedmenu item #000084

menuContainerBgColor

Background color of the container

Note: The container is like a <div> tag that
displays themenu.When you set the container
color, it appears at the top and left side of the
menu frame only.

childMenuIcon

Path to the submenu icon (the image used to
indicate that a submenu is available from thismenu
item).

To displaya different image, either provide an
external path to it or upload the image to Ektron
CMS400.NET then provide a local path.

./Workarea/images/
application/arrows.gif

childMenuIconHiLite

The path to the icon that appearswhen you hover
themouse over amenu item that leads to a
submenu.

To displaya different image, either provide an
external path to it or upload the image to Ektron
CMS400.NET then provide a local path.

./Workarea/images/
application/arrows2.gif

FontFamily
Use the fontFamily attribute to specify the menu font. It must be supported by
the browser.

You can assign to this property several, comma-separated values.

Note: To display a font family other than the browser default, specify only the font name and
no other comma-separated values. If you specify more than one value for the font family,
Ektron CMS400.NET uses the default IE settings.

FontFamily
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menuLiteBgColor

Example

XML Menu
The ecmGetMenuXML function wraps XML around the properties of a menu
created in the Ektron CMS400.NET Workarea. Once created you can use the XML
to display the menu. The ecmGetMenuXML function allows you to easily define
how the menu data appears on the Web page.

Shown here is the format of the ecmGetMenuXML function.

<% ecmGetMenuXML (id) %>

The ecmGetMenuXml function attributes are explained below.

Attribute Description

Id The id that associated with themenu.

When using the XML Menu function, the following tags are created around the
properties of each item in the menu.

XML Tags Description

<Item></Item>

<ItemID></ItemID>
For example:

<ItemID>1</ItemID>

<ItemType></ItemType>
For example:

<ItemType>Submenu</ItemType>
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XML Tags Description

<ItemTitle></ItemTitle>
For example:

<ItemTitle>MenuExample</ItemTitle>

<ItemImage></ItemImage>

<ItemImageOverride></ItemImageOverride>

For example:

<ItemImageOverride>
False</ItemImageOverride>

<Menu></Menu>

<ID></ID>
For example:

<ID>1</ID>

<Title></Title>
For example:

<Title>MenuExample</Title>

<Type></Type>
For example:

<Type>content</Type>

<Link></Link>

<ParentID></ParentID>
For example:

<ParentID>0</ParentID>

<AncestorID></AncestorID>
For example:

<AncestorID>1</AncestorID>

<FolderID></FolderID>
For example:

<FolderID>0</FolderID>

<Description></Description>

<Image></Image>

<ImageOverride></ImageOverride>
For example:

<ImageOverride>False</ImageOverride>

<ItemLink></ItemLink>

For example:

<ItemLink>/CMS400Example/
contentblock.aspx?id=12</ItemLink>

<ItemTarget></ItemTarget>
For example:

<ItemTarget>2</ItemTarget>

<Template></Template>

XMLMenu
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Here is how the raw XML Menu output appears before an XSLT is applied.

<Item>
<ItemID>1</ItemID>
<ItemType>Submenu</ItemType>
<ItemTitle>MenuExample</ItemTitle>
<ItemImage></ItemImage>
<ItemImageOverride>False</ItemImageOverride>
<Menu>
<ID>1</ID>
<Title>MenuExample</Title>
<Template></Template>
<Type>content</Type>
<Link></Link>
<ParentID>0</ParentID>
<AncestorID>1</AncestorID>
<FolderID>0</FolderID>
<Description></Description>
<ImageOverride>False</ImageOverride>
</Item>
<Item>
<ItemID>2</ItemID>
<ItemType>Submenu</ItemType>
<ItemTitle>Book</ItemTitle>
<ItemImage></ItemImage>
<ItemImageOverride>False</ItemImageOverride>
<Menu>
<ID>2</ID>
<Title>Book</Title>
<Template></Template>
<Type>content</Type>
<ParentID>1</ParentID>
<ImageOverride>False</ImageOverride>
<Item>
<ItemID>23</ItemID>
<ItemType>content</ItemType>
<ItemTitle>VB.NET How to</ItemTitle>
<ItemImage></ItemImage>
<ItemLink>/CMS400Developer/collection.aspx?id=23</ItemLink>
<ItemTarget>2</ItemTarget>
</Item>
</Menu>
</Item>
</Menu>
</Item>

Custom ColdFusion
Functions
Important: As of 8.01 SP2, the platforms/ColdFusion folder is installed to the program
files/Ektron/utilities folder. In order for ColdFusion platform support to function, move the
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platforms/ColdFusion folder to the Workarea folder and configure it.
Previously, the platforms folder was installed to the Workarea folder by default.

Ektron CMS400.NET maintains and display content through the use of custom
Ektron ColdFusion functions and ComObjects.

When using custom ColdFusion functions, the following paths must be updated
in the application.cfm.

<cfset application.WSDLpath =
"http://localhost/siteroot/WorkArea/WebServices/ContentWS.asmx?WSDL" />

and

<cfset application.AppPath = "/siteroot/WorkArea/platforms/ColdFusion/" />

The application.WSDLpath needs to updated with the location of the WSDL
file. For example, For example, if your site is www.example.com, the WSDL
path would be
http://www.example.com/WorkArea/WebServices/ContentWS.asmx.

The application.AppPath needs to updated with the path to the ColdFusion
custom Functions.

To customize your Ektron CMS400.NET application, you will need to be familiar
with these tags

Function Description
More
Information

Calendar Functions

Event Calendar Displaysamonth view event calendar
Event Calendar
Function on
page 27-293

Collection Functions

Collection Displays links generated by collections
Collection
Function on
page 27-288

CollectionXML
CreatesXML for a collection bywrapping tagsaround all of the
collection itemsand their properties. This allowsyou to use an XSLT
to define how the XML collection is displayed.

XMLCollection
Function on
page 27-292

RandomContent Randomlydisplays the content of a collection item

Random
Content
Function on
page 27-282

Random
Summary Randomlydisplays the summaryof a collection item

Random
Summary
Function on
page 27-282

CustomColdFusion Functions
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Function Description
More
Information

RSSCollection Createsan RSS feed out of the items in a collection.
RSSCollection
Function on
page 27-292

Content Functions

Add Content
Allows a user to add content to Ektron CMS400.NET
programmatically.

Add Content
on page 27-
281

Content Block Displaysandmanagesa content block
Content Block
Function on
page 27-280

Form Displaysa content blockassociated with a form Form Function
on page 27-295

Multipurpose Displayseither a content blockor a form
MultiPurpose
Function on
page 27-295

Language Functions

Language Select Lets a site visitor select a language in which to view site.
Language
Select Function
on page 27-300

List Summary Functions

Archive

ListSummary
Displays summariesof archived content blocks

Archive List
Summary
Function on
page 27-287

List Summary Displaysa list of content block summaries
List Summary
Function on
page 27-284

List Summary
XML

CreatesXML for a list summarybywrapping tagsaround all of the
collection itemsand their properties. This allowsyou to use an XSLT
to define how the XML collection is displayed.

XML List
Summary
Function on
page 27-285

RSSList
Summary Createsan RSS feed out of the items in a list summary.

RSSList
Summary
Function on
page 27-286
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Function Description
More
Information

Single Summary Displays the summary for a content block.

Single
Summary
Function on
page 27-287

Login Functions

Login Adds the login or logout button Login Function
below

Menu Functions

DropHTMLMenu Used to display a DHTMLmenu DHTMLMenus
on page 27-298

GenerateMenu Workswith DropHTMLmenu to displayDHTMLmenus DHTMLMenus
on page 27-298

XMLMenu
Creates XML for a menu by wrapping tags around all of
the menu items properties.

XMLMenu
Function on
page 27-299

Metadata Functions

Metadata Displays themetadata for the currentWeb page
Metadata
Function on
page 27-296

Search Functions

Search Inserts a text boxwith a search button
Search
Function (cf) on
page 27-283

Search Display Createsan area to display search results
Search Display
Function on
page 27-284

Login Function
This tag is responsible for displaying the following buttons on the Web page.

This function is basically the same as the Login function in ASP. See Login
Function on page 27-199 for details. The only difference is the syntax used to
implement the function. This is listed below.
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Login Tag Example
<tr>

<td>

<cfmodule template="#request.ecm.AppPath#ecmLogin.cfm">

</td>

</tr>

Content Block Function
The content block and content blockEX tags are used to display a content block
on an Ektron CMS400.NET Web page.

Shown here is the format for the content block function:

<CFMODULE template="#request.ecm.AppPath#ecmContentBlock.cfm"

ID=""

>

Shown here is the format for the content blockEX function:

<CFMODULE template="#request.ecm.AppPath#ecmContentBlockEx.cfm"

ID=""

XSLT=""

Override=""

>

This functions are basically the same as the ContentBlock and ContenBlockEX
function in ASP. See Content Block Function on page 27-201 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The ColdFusion examples are below.

Static Content Block
 <tr>

<td>

<CFMODULE id="1" template="#request.ecm.AppPath#ecmContentBlock.cfm">

 </td>

 </tr>
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Dynamic Content Block
 <tr>

 <td>

<CFMODULE id="#id#"
template="#request.ecm.AppPath#ecmContentBlock.cfm">

 </td>

 </tr>

XML Content Block
 <tr>

 <td>

 <CFMODULE id="13" XSLT= “” override= “1”

 template="#request.ecm.AppPath#ecmContentBlockEx.cfm">

 </td>

 </tr>

Add Content
The add content function allows you to programmatically add a new content
block to Ektron CMS400.NET without the need of logging in.

Here is the format for the add content function:

<CFModule template=”#request.ecm.AppPath#ecmAddContent.cfm”

Username=””,
Password=””,
Domain=””,
content_title=””,
content_comment=””,
ContentHtml=””,
SummaryHTML=””,
ContentLanguage=””,
FolderID=””,
GoLive=””,
EndDate=””,
MetaInfo=””

>

This function is basically the same as the Add Content function in ASP. See Add
Content on page 27-207 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The ColdFusion example is below.

Dynamic Content Block
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Add Content Example
The following is an example of the add content function in a template:.

<tr>

<td>

<CFModule template="#request.ecm.AppPath#ecmAddContent.cfm "AddContent UserName="admin",
Password="admin", Domain="", content_title="Content Title", content_comment="Comment",
ContentHTML="This is the <b>body</b> of the content.", SummaryHTML="This is the <i>summary</i>
for the content.", ContentLanguage="1033", FolderID="0", GoLive="", EndDate="", MetaInfo="">

</td>

</tr>

Random Content Function
The random content function is used to randomly display the content of a
content block that belongs to a specified collection. Below is the format for the
random content function:

<CFMODULE template="#request.ecm.AppPath#ecmShowRandomContent.cfm"

ID=""

XSLT=""

Override=""

>

This function is basically the same as the Random Content function in ASP. See
Random Content on page 27-254 for details.

Random Summary Function
SImilar to the random content function, the random summary function can
randomly display a content block summary that belongs to a specified
collection. Here is the format for the random content function

<CFMODULE template="#request.ecm.AppPath#ecmShowRandomSummary.cfm"

ID=""

>

This function is basically the same as the Random Summary function in ASP.
See Random Summary on page 27-255 for details.
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Search Function (cf)
The search tag is used to display a text box, with a search button on the
template. When seen on the template on the Web page, the users will be
allowed to enter text and click on the search button to search through all the
content on the Web site.

Shown here is the format for the ecmSearch tag.

<CFMODULE template="#request.ecm.AppPath#ecmSearch.cfm"

StartingFolder=""

Recursive=""

TargetPage=""

TextBoxSize=""

MaxCharacters=""

ButtonImageSrc=""

ButtonText=""

FontFace=""

FontColor=""

FontSize=""

Horizontal=""

>

This function is basically the same as the Search function in ASP. See Search
Functions (ASP) on page 27-210 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The ColdFusion example is below.

Search Tag Example
<tr>

<td>

<CFMODULE template="#request.ecm.AppPath#ecmSearch.cfm"

StartingFolder="\marketing" Recursive="1" TargetPage="search-

display.cfm" TextBoxSize="25" MaxCharacters="200"

ButtonImageSrc="" ButtonText="Search" FontFace="Verdana"

FontColor="##808080" FontSize="2" Horizontal="0">

</td>

Search Function (cf)
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</tr>

Search Display Function
The search display custom tag created the area where all the search results
show after the search has been executed.

Shown here is the format of the ecmSearchDisplay tag:

<CFMODULE template="#request.ecm.AppPath#ecmSearchDisplay.cfm"

MaxNumber=""

StyleInfo=""

ShowDate=""

>

This function is basically the same as the Search Display function in ASP. See
Search Display Function on page 27-219 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The ColdFusion example is below.

Search Display Example
<tr>

<td>

<CFMODULE template="#request.ecm.AppPath#ecmSearchDisplay.cfm"

MaxNumber="0" StyleInfo="" ShowDate="1">

</td>

</tr>

List Summary Function
The list summary function is used to display the list of content summaries on a
Web page. Shown here is the format of the list summary function:

<CFMODULE template="#request.ecm.AppPath#ecmListSummary.cfm"

Folder=""

MaxNumber=""

Recursive=""

ShowSummary=""

StyleInfo=""
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OrderBy=""

ShowInfo=""

>

This function is basically the same as the List Summary function in ASP. See
List Summary Function on page 27-222 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The ColdFusion example is below.

List Summary Example
<TR>

<TD>

<CFMODULE template="#request.ecm.AppPath#ecmListSummary.cfm"

Folder="\Marketing\News" MaxNumber="0" Recursive="0"

ShowSummary="1" StyleInfo="" OrderBy="Title,asc" ShowInfo="" >

</TD>

</TR>

XML List Summary Function
The XML List Summary function wraps XML around the properties of a list of
content, created as a list summary in the Ektron CMS400.NET Workarea. Once
created you can use the XML to display the list summary information. The
ecmListSummaryXML function allows you to easily define how the list summary
data appears on the Web page.

<TR>

<TD>

<CFMODULE template="#request.ecm.AppPath#ecmListSummaryXML.cfm"

Folder="" Recursive="" OrderBy=""

MaxNumber="" ObjType="" SummaryType="" >

</TD>

</TR>

This function is basically the same as the List Summary XML function in ASP.
See XML List Summary Function on page 27-229 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The ColdFusion example is below.

List Summary Example
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XML List Summary Example
<TR>

<TD>

<CFMODULE template="#request.ecm.AppPath#ecmListSummaryXML.cfm"

Folder="\books\" Recursive="0" OrderBy="Title,asc"

MaxNumber="0" ObjType="folder" SummaryType="alltypes">

</TD>

</TR>

RSS List Summary Function
The RSS summary function is used to create an XML list of content summaries
for RSS Syndication. Shown here is the format of the RSS list summary
function:

<CFMODULE template="#request.ecm.AppPath#ecmListSummary.cfm"

Folder=""

MaxNumber=""

Recursive=""

OrderBy=""

>

This function is basically the same as the RSS Summary function in ASP. See
RSS Summary Function on page 27-237 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The ColdFusion example is below.

List Summary Example
<TR>

<TD>

<CFMODULE template="#request.ecm.AppPath#ecmListSummary.cfm"

Folder="\books" MaxNumber="0" Recursive="0"

OrderBy="Title,asc" >

</TD>

</TR>

UsingOther Development Frameworks

27-286 ReferenceManual
Version 8.01 Rev 4



Archive List Summary Function
The Archive list summary function displays on a Web page a list of content
summaries for archived content blocks. For example, you might have a current
news page and an archived news page. Use the List Summary Function to
display current news, and this function to display older news stories.

On the Content Block schedule screen, the user must set an End Date then
choose the Archive and Display option to have the content blocks appear via
this function.

This function has the same parameters as the List Summary Function. See List
Summary Function on page 27-222 for details.

Single Summary Function
The single summary tag is used to display the summary of one content block in
the Ektron CMS400.NET Web site, instead of a list of all the summaries in a
content folder. Seen below is the single summary tag:

<cfmodule template="#request.ecm.AppPath#ecmSingleSummary.cfm"

ContentID=""

ShowSummary="1"

StyleInfo=""

ShowInfo=""

>

This function is basically the same as the Single Summary function in ASP. See
Single Summary Function on page 27-234 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The ColdFusion example is below.

Single Summary Example
<TR>

<TD>

<cfmodule template="#request.ecm.AppPath#ecmSingleSummary.cfm"

ContentID="14" ShowSummary="1" StyleInfo=""

ShowInfo="DateModified">

</TD>

</TR>
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Collection Function
The collection function is used to display the list of links that were created as a
collection in the Ektron CMS400.NET Workarea. The ecmCollection function is
highly customizable, allowing you to easily define how the collection data will
be displayed on the Web page.

Shown here is the format of the ecmCollection function.

<CFMODULE template="#request.ecm.AppPath#ecmCollection.cfm"

id="2"

displayFunction="ecmTeaser"

>

This function is basically the same as the Collection function in ASP. See
Collection Function on page 27-242 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The ColdFusion example is below.

Example Using the ecmNavigation Display
Function
The following is an example of a collection function being used as a navigation
menu in the Ektron CMS400.NET sample Web site.

<CFMODULE id="1" displayFunction="ecmNavigation"

template="#request.ecm.AppPath#ecmCollection.cfm">

As stated earlier, the format of the collection on the Web page depends on the
displayFunction that is used. Below is the source code for the display function
“ecmNavigation”.

<cfparam name="Attributes.nId" default="">

<cfparam name="Attributes.href" default="">

<cfparam name="Attributes.target" default="">

<cfparam name="Attributes.startStyle" default="">

<cfparam name="Attributes.endStyle" default="">

<cfset LocalError = "">

<cfobject class="Ektron CMS400.NETContentBrv2.Ektron CMS400.NETContent" Action="Create"
name="cmsObj">
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<cfset cNavs =
cmsObj.GetEcmCollectionItems(request.ecm.AppConfStr,Attributes.nId,0,request.ecm.cmsPreview,request.ecm.user_
id,request.ecm.site_id,LocalError)>

<cfif cNavs.Count()>

<cfset nString = "">

<cfloop collection=#cNavs# Item=nav>

<cfset nString = nString & "<a href=""">

<cfif len(Attributes.href)>

<cfif FindNoCase("?", Attributes.hrefs)>

<cfset nString = nString & Attributes.href & "&id=" &

nav.Item("ContentID")>

<cfelse>

<cfset nString = nString & Attributes.href & "?id=" &

nav.Item("ContentID")>

</cfif>

<cfelse>

<cfset nString = nString & nav.Item("ContentLinks")>

</cfif>

<cfset nString = nString & """ ">

<cfif len(Attributes.target)>

<cfset nString = nString & "target=""" & Attributes.target & """ ">

</cfif>

<cfset nString = nString & ">">

<cfif len(Attributes.startStyle)>

<cfset nString = nString & Attributes.startStyle>

</cfif>

<cfset nString = nString & nav.Item("ContentTitle")>

<cfif len(Attributes.endStyle)>

<cfset nString = nString & Attributes.endStyle>

</cfif>

<cfset nString = nString & "</a>">

</CFLOOP>

<cfmodule str="#nString#" nId="#Attributes.nId#"
template="#request.ecm.AppPath#ecmshowCollectionsContent.cfm">
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</cfif>

<cfset nNavs = "Nothing">

<cfset cmsObj = "Nothing">

As you can see, the ecmNavigation function is a simple ASP function that
creates a table of the links that belong to the collection specified. The function
also displays the title of the content blocks by using the “info(“ContentTitle”))
building block.

Example Using the ecmTeaser Display
Function
The following is an example of a collection function being used as a navigation
menu in the Ektron CMS400.NET sample Web site.

<CFMODULE id="2" displayFunction="ecmTeaser"

template="#request.ecm.AppPath#ecmCollection.cfm">

In this example, the collection with an ID=2 is displayed, and the function
“ecmTeaser” defines how to display the collection data on a Web page. Here is
how the collection would appear on a Web page.

As stated earlier, the format of the collection on the Web page depends on the
displayFunction that is used. Below is the source code for the display function
“ecmTeaser”.

<cfparam name="Attributes.nID" default="">

<cfparam name="Attributes.href" default="">

<cfparam name="Attributes.ShowSummary" default="">

<cfparam name="Attributes.StyleInfo" default="">

<cfparam name="Attributes.target" default="">

<cfset ErrorString = "">

<cfobject class="Ektron CMS400.NETContentBrv2.Ektron CMS400.NETContent" Action="Create"
name="tObj">
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<cfset cTeasers = tObj.GetEcmCollectionItems(request.ecm.AppConfStr, Attributes.nId, 0,
request.ecm.cmsPreview, request.ecm.user_id, request.ecm.site_id, ErrorString)>

<cfset tString = "<table border=""0"" cellspacing=""0"" cellpadding=""0""
width=""100%"">">

<cfif cTeasers.Count()>

<cfloop collection=#cTeasers# Item=cT>

<cfset tString = tString & "<tr><td>">

<cfset tString = tString & "<a href=""">

<cfif len(Attributes.href)>

<cfif FindNoCase("?", Attributes.hrefs)>

<cfset tString = tString & Attributes.href & "&id=" &

cT.Item("ContentID")>

<cfelse>

<cfset tStringi = tString & Attributes.href & "?id=" &

cT.Item("ContentID")>

</cfif>

<cfelse>

<cfset tString = tString & cT.Item("ContentLinks")>

</cfif>

<cfset tString = tString & """ ">

<cfif len(Attributes.target)>

<cfset tString = tString & "target=""" & Attributes.target & """ ">

</cfif>

<cfset tString = tString & ">">

<cfset tString = tString & cT.Item("ContentTitle") & "</a>" & "&nbsp;(" &

DateFormat(cT.Item("DateModified"), "mm/dd/yyyy") & " " &

TimeFormat(cT.Item("DateModified"), "h:mm:ss tt") & ")</td></tr><tr><td>" &

cT.Item("ContentTeaser")>

<cfset tString = tString & "</td></tr><tr><td>&nbsp;</td></tr>">

</cfloop>

<cfset tString = tString & "</table>">

<cfmodule str="#tString#" nId="#Attributes.nId#"
template="#request.ecm.AppPath#ecmshowCollectionsContent.cfm">

</cfif>
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As you can see, the ecmTeaser function is a simple ASP function that creates a
table of the links that belong to the collection specified.

The ecmTeaser function also displays the:

n Content Title

n Date Modified

n Content Teaser

Collection Variables
See Collection Attributes on page 27-246

Display Function
The display function defines how collection data appears on a Web page. Using
ColdFusion scripting, you can create your own display functions, or use the
three included functions.

XML Collection Function
The XML collection function wraps XML around the parameters of a list of
content that’s created as a collection in the Ektron CMS400.NET Workarea. Once
created you can use the XML to display the collection information. The
ecmCollectionXML function allows you to easily define how the collection data
appears on the Web page.

Shown here is the format of the ecmCollection function.

<CFMODULE template="#request.ecm.AppPath#ecmCollectionXML.cfm"

id=""

getHtml=""

>

This function is basically the same as the XML Collection function in ASP. See
XML Collection Function on page 27-250 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The ColdFusion example is below.

<CFMODULE template="#request.ecm.AppPath#ecmCollectionXML.cfm" id="3" getHtml="0">

RSS Collection Function
The RSS collection function is used to create an XML list of links that were
created as a collection in the Ektron CMS400.NET Workarea and display them in
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RSS Syndication.

Shown here is the format of the ecmRssCollection function.

<CFMODULE template="#request.ecm.AppPath#ecmRssCollection.cfm"

id="2"

>

This function is basically the same as the RSS Collection function in ASP. See
RSS Collection Function on page 27-247 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it.

Event Calendar Function
The ecmEvtCalendar function is used to display an event calendar that has been
created in the Ektron CMS400.NET Workarea.

Displayed here is the format for the event calendar custom function:

 <CFMODULE template="#request.ecm.AppPath#ecmEvtCalendar.cfm" Calendar_ID=""
DisplayType="">

This function is basically the same as the Event Calendar function in ASP. See
Event Calendar Function on page 27-256 for details.

The only differences between the Coldfusion function and the ASP one are the
use of the DisplayType parameter and the syntax for implementing it. The
ecmEvtCalendar function parameters are defined below.

Attribute Description

id

The “id”argument represents the ID number of the event calendar in theWorkarea.

Event Calendar Function
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Attribute Description

DisplayType

Specify the Calendar display type.

n Month - A 30 day calendar month view.

n Day - Single day view.

n Inline - Displayevents that occur from the start date of the calendar through the end date.

n MonthUpWithEvent - Displaysamonth calendar. Events appear to the right of the
calendar when you click on a day.
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Attribute Description
Here is a sample of the Event Calendar syntax.

Event Calendar Sample
 <tr>

 <td>

 <CFModule template="#request.ecm.AppPath#ecmEvtCalendar.cfm" calendar_
id="24" DisplayType="monthupwithevent">

 </td>

 </tr>

Form Function
The ecmFormBlock function displays an HTML form content block. For more
information about HTML forms, see Working with HTML Forms on page 7-212.

Warning! If you create a template for an existing form content block, you must manually change
its quicklink to point to the new template. This change does not occur automatically. This
procedure is described in Updating Default Template for Multiple Quicklinks on page 8-22.

Here is the format for the form custom function

<CFMODULE template="#request.ecm.AppPath#ecmFormBlock.cfm" ID="" >

This function is basically the same as the Form function in ASP. See Form
Function on page 27-261 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The ColdFusion example is below.

Here is an example of a form content block in an Ektron CMS400.NET template.

 <tr>

 <td>

 <CFModule template="#request.ecm.AppPath#ecmFormBlock" form_
id="1">

 </td>

 </tr>

MultiPurpose Function
The ecmMultiPurpose function displays either a content block or an content
block associated with a form. As a result, you can use one template to display
both types of content block.

Event Calendar Sample
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Here is the format for the Multipurpose function

 <CFMODULE template="#request.ecm.AppPath#ecmMultiPurpose.cfm"
DefaultID="" >

To pass in a standard content block, pass the id value in the url parameter, as
illustrated below.

http://localhost/CMS400Developer/index.asp?id=2

To pass in a Form content block, pass the ekfrm value in the url parameter, as
illustrated below.

http://localhost/CMS400Developer/index.asp?ekfrm=2

Note: For more information about passing the id value as a URL parameter, see Dynamic
Content Block on page 27-281.

If the id value or ekfrm value does not exist, a blank template appears.

If the url parameter is not passed in or recognized, the function calls
ecmContentBlock and passes the DefaultID value as the id argument. If the
DefaultID value is zero (0), ecmContentBlock is not called.

Metadata Function
The metadata tag is used to display the metadata for one or more content
blocks in the Ektron CMS400.NET Web site. Inserting this custom tag will allow
you to generate the list of metadata that is edited by the authors, and insert it in
the source of the Web page. Shown below is an example of what the metadata
custom tag looks like.

<cfmodule template="#request.ecm.AppPath#ecmMetadata.cfm" ItemList="" >

This function is basically the same as the Metadata function in ASP. See
Metadata Function on page 27-263 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The ColdFusion examples are below.

<cfmodule template="#request.ecm.AppPath#ecmMetadata.cfm" ItemList="[1][2]">
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<cfmodule template="#request.ecm.AppPath#ecmMetadata.cfm"

ItemList="[1;title][2;keywords]>

<cfmodule template="#request.ecm.AppPath#ecmMetadata.cfm"

ItemList="[1][2;title,keywords]>
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DHTML Menus
Ektron CMS400.NET’s Menu feature lets users create and maintain a dropdown
menu system for your Web site. The Menu feature lets you display menu
options that link to content blocks, library assets, external hyperlinks and
submenus.

To learn more about menus, see Working with Menus on page 9-133.

Additional Documentation in Ektron
Knowledge Base
This chapter explains how to implement standard menus that ship with Ektron
CMS400.NET. Ektron’s Web site also provides Knowledge Base articles that
explain how to extend the standard menu features.

Displaying a Menu on a Web Page

GenerateMenu and DropMenu
Warning! The menu functions described below are only one example of how to implement
menus. You can implement your own menu system using JavaScript.

Use the GenerateNextGenMenu and DropNextGenMenu custom functions to
display a DHTML menu on a Web page. Place GenerateNextGenMenu once on
the page to provide an infrastructure for DropNextGenMenu. Then, place
DropNextGenMenu as needed to implement individual menus.

Follow these steps to display a menu on a Web template.

1. Place the following code directly after the page’s <body> tag.
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<CFMODULE Ids=”menu id number” template="#request.ecm.AppPath#ecmDHTML_
GenerateNextGenMenu.cfm">

For example:
 <CFMODULE Ids="1" template="#request.ecm.AppPath#ecmDHTML_

GenerateNextGenMenu.cfm">

To display more than one menu, separate each id number with a
comma. For example:

 <CFMODULE Ids="1,2,3" template="#request.ecm.AppPath#ecmDHTML_
GenerateNextGenMenu.cfm">

2. If the user clicks text to display the menu, place the following code
within the template file where the text would appear.

<CFMODULE MenuId="menu id number" Title="text user clicks to display menu"
template="#request.ecm.AppPath#ecmDHTML_DropNextGenMenu.cfm">

For example:
<CFMODULE MenuId="1" Title="Products" template="#request.ecm.AppPath#ecmDHTML_
DropNextGenMenu.cfm">

If the user clicks a graphic to invoke the menu, use this syntax:
<CFMODULE MenuId="menu id number" Title= '<img src=graphic file name>'
template="#request.ecm.AppPath#ecmDHTML_DropNextGenMenu.cfm">

For example:
<CFMODULE MenuId="1" Title= '<img src=mymenugraphic.jpg>'
template="#request.ecm.AppPath#ecmDHTML_DropNextGenMenu.cfm">

Customizing the Menu’s Appearance
You can customize a menu’s appearance, such as the font style, color, and size.
So, you have the flexibility to coordinate a menu with the design your Web site.

To customize a menu in Ektron CMS400.NET, you can change the ek_Menu.js
file.

ek_Menu.js
You can change the look and feel of a menu by changing the ek_menu.js file. If
you used the default settings when installing Ektron CMS400.NET, this file is in
webroot/CMS400Developer/Workarea/java/. For a description of the ek_
menu.js file, see ek_Menu.js on page 27-272.

XML Menu Function
The ecmGetMenuXML function wraps XML around the properties of a menu
created in the Ektron CMS400.NET Workarea. Once created you can use the

Customizing theMenu’s Appearance

ReferenceManual
Version 8.01 Rev 4

27-299



XML to display the menu. The ecmGetMenuXML function allows you to easily
define how the menu data appears on the Web page.

<CFMODULE id=””
template=”#request.ecm.AppPath#ecmGetMenuXML.cfm”>

This function is basically the same as the XML Menu function in ASP. See XML
Menu on page 27-274 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it. The Coldfusion example is below.

<CFMODULE id="1" template="#request.ecm.AppPath#ecmGetMenuXML.cfm">

Language Select Function
This function lets a visitor to your Web site select a language in which to view
the site. Here is what the function looks like when published on a Web page.

Shown here is the format of the ecmLanguageSelect function.

<CFMODULE template="#request.ecm.AppPath#ecmLanguageSelect.cfm">

This function is basically the same as the Show Site Language function in ASP.
See Show Site Language Function on page 27-269 for details.

The only difference between the Coldfusion function and the ASP one is the
syntax for implementing it.

Custom PHP Functions
Important: As of 8.01 SP2, the platforms/PHP folder is installed to the program
files/Ektron/utilities folder. In order for PHP platform support to function, move the
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platforms/PHP folder to the Workarea folder and configure it.
Previously, the platforms folder was installed to the Workarea folder by default.

Ektron CMS400.NET maintains and displays content via custom Ektron PHP
functions and ComObjects. For the custom PHP functions to work properly, do
the following:

n Make sure the php_soap.dll file is in the c:\php folder on the
server where you installed PHP.

n Add the following line to the php.ini file.

extension=php_soap.dll

The php.ini file is located in C:\Windows\php.ini.

n In the ApplicationAPI.php file, set the WSDLpath. The
applicationAPI.php file is located by default in:

http:/-
/loca-
lhost/siteroot/WorkArea/platforms/PHP/applicationAPI.php

Warning! ContentWS.asmx is the web services (WSDL) file that the custom PHP functions use
to talk to Ektron CMS400.NET. The WSDLpath located in the applicationAPI.php file must be
set to location of the WSDL file. The default WSDLpath is
http://localhost/siteroot/WorkArea/WebServices/ContentWS.asmx. If you have
changed the location of ContentWS.asmx you need to update the WSDLpath. For example, if
your site is www.example.com, the WSDLpath would be
http://www.example.com/WorkArea/WebServices/ContentWS.asmx.

n Add the following line to the top of each template.

<?php include 'applicationAPI.php'; ?>

This file calls the Ektron custom functions file to allow the page to
function properly. Itmust appear at the top of the template file.

n If you have upgraded your Ektron CMS400.NET from an Ektron
CMS300 version, add the following line between the head tags for
each template.

Warning! This only needs to be done if you are upgrading from CMS300 to CMS400.NET
<meta http-equiv="Content-type" content="text/html; charset=utf-8"
/>

To customize you Ektron CMS400.NET application, you need to be familiar with
these functions.

Function Description
More
Information

Calendar Functions
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Function Description
More
Information

Event Calendar Displaysamonth view event calendar
Event Calendar
Function on
page 27-316

Collection Functions

Collection Displays links generated by collections
Collection
Function on
page 27-311

CollectionXML
CreatesXML for a collection bywrapping tagsaround all of the
collection itemsand their properties. This allowsyou to use an XSLT
to define how the XML collection is displayed.

XMLCollection
Function on
page 27-315

RandomContent Randomlydisplays the content of a collection item

Random
Content
Function on
page 27-315

Random
Summary Randomlydisplays the summaryof a collection item

Random
Summary
Function on
page 27-316

RSSCollection Createsan RSS feed out of the items in a collection.
RSSCollection
Function on
page 27-315

Content Functions

Add Content
Allows a user to add content to Ektron CMS400.NET
programmatically.

Add Content
on page 27-
306

Content Block Displaysandmanagesa content block
Content Block
Function on
page 27-305

Form Displaysa content blockassociated with a form Form Function
on page 27-318

Multipurpose Displayseither a content blockor a form
MultiPurpose
Function on
page 27-319

List Summary Functions

Archive

ListSummary
Displays summariesof archived content blocks

Archive List
Summary
Function on
page 27-287
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Function Description
More
Information

List Summary Displaysa list of content block summaries
List Summary
Function on
page 27-309

List Summary
XML

CreatesXML for a list summarybywrapping tagsaround all of the
collection itemsand their properties. This allowsyou to use an XSLT
to define how the XML collection is displayed.

XML List
Summary
Function on
page 27-310

RSSList
Summary Createsan RSS feed out of the items in a list summary.

RSSList
Summary
Function on
page 27-311

Single Summary Displays the summary for a content block

Single
Summary
Function on
page 27-310

Login Functions

Login Adds the login or logout button Login Function
on next page

Menu Functions

DropHTMLMenu Used to display a DHTMLmenu DHTMLMenus
on page 27-322

GenerateMenu Workswith DropHTMLmenu to displayDHTMLmenus DHTMLMenus
on page 27-322

XMLMenu
Creates XML for a menu by wrapping tags around all of
the menu items properties.

XMLMenu
Function on
page 27-323

Metadata Functions

Metadata Displays themetadata for the currentWeb page
Metadata
Function on
page 27-319

Search Functions

Search Inserts a text boxwith a search button
Search
Function on
page 27-307

Search Display Createsan area to display search results
Search Display
Function on
page 27-308
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Function Description
More
Information

Language Functions

Language Select Lets a site visitor select a language in which to view site.
Language
Select Function
on page 27-323

Login Function
This function is responsible for displaying the following buttons on the Web
page.

Button Name Description

Login
When user is not logged into Ektron CMS400.NET, this button
appears. Click this button to let the user log in to the application.

Logout
Once logged in, this button replaces the login button to allow the
user to log out from the Ektron CMS400.NETWeb site.

Workarea
When logged in, this button appears under the logout button
allowing the user to access their workarea.

Preview
On

Lets the user to preview the entire Web site as if all checked-in
content was published.

Preview
Off

Turns off preview mode.

This function is basically the same as the Login function in ASP. See Login
Function on page 27-199 for details. The only difference is the syntax used to
implement the function. This is listed below.

Login Function Example
<tr>

<td>
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<?php ecmlogin(); ?>

</td>

</tr>

Content Block Function
The ecmContentBlock and ecmContentBlockEX functions are used to display a
content block on an Ektron CMS400.NET Web page.

Shown here is the format for the ecmContentBlock function:

<?php ecmContentBlock (ID) ?>

Here is the format for the ecmContentBlockEX function:

<?php ecmContentBlockEx (ID, “XSLT”, Override) ?>

Note: As an alternative, you can use the multipurpose function, which can display either a
content block or a content block associated with a form. For more information, see
MultiPurpose Function on page 27-319.

This function is basically the same as the Content Block function in ASP. See
Content Block Function on page 27-201 for details.

The only differences between the PHP function and the ASP one are the
examples of implementing it. The PHP examples are below.

Static Content Block
<tr>

 <td>

 <?php ecmContentBlock(1) ?>

 </td>

</tr>

Dynamic Content Block
<tr>

 <td>

 <?php ecmContentBlock($id) ?>

 </td>

</tr>

XML Content Block
<tr>

Content Block Function
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 <td>

 <?php ecmContentBlockEx (13, “”, 1) ?>

 </td>

</tr>

Add Content
The add content function allows you to programmatically add a new content
block to Ektron CMS400.NET without the need of logging in.

Here is the format for the add content function:

<? AddContent

(“Username”
“Password”,
“Domain”,
‘content_title”,
“content_comment”,
“ContentHtml”,
“SummaryHTML”,
“ContentLanguage”,
“FolderID”,
“GoLive”,
“EndDate”,
“MetaInfo”); ?>

This function is basically the same as the Add Content function in ASP. See Add
Content on page 27-207 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it. The PHP example is below.

Add Content Example
"The following is an example of the add content function in a template:

<tr>
<td>
<? AddContent ("admin", "admin", "", "Content Title", "Comment",
"This is the <b>body</b> of the content.", "This is the

<i>summary</i>
for the content.", "1033", "0", "", "", ""); ?>
</td>

</tr>
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Search Function
The search function is used to display a text box with a search button on the
template. When seen on the template on the Web page, a user can enter text
and click the search button to search through all the content on the Web site.

Ektron has created two search functions:

n ecmSearch

n ecmSearchNoFormTag

Both functions have the same parameters and perform the same search. The
only difference is ecmSearch automatically inserts form tags,
ecmSearchNoFormTag does not.

The following is an example of form tags.

<form name="ecmsearch" method="post" action='search-display.asp'>

</form>

When using ecmSearch, form tags are added automatically. When using
ecmSearchNoFormTag you need to add the tags manually

Here is the format for the search function. You can interchange ecmSearch and
ecmSearchNoFormTag when using this function.

<?php ecmSearch( “StartingFolder”,

Recursive,

"targetpage",

textbox,

MaxCharacters,

"ButtonImgSrc",

"ButtonText",

"FontFace",

"FontColor",

"FontSize",

Horizontal,

"Spare" );

?>

This function is basically the same as the Search function in ASP. See Search
Functions (ASP) on page 27-210 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it. The PHP example is below.

Search Function
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Search Function Example
<TR>

 <TD>

 <?php ecmSearch("\\Marketing",1,"search-
 display.php",25,200,"","Search","Verdana","#808080","2",0,""); ?>

 </TD>

</TR>

Search Display Function
The search display custom function created the area where all the search
results show after the search has been executed.

Here is the format of the ecmSearchDisplay function:

<?php ecmSearchDisplay( MaxNumbers,"StyleInfo", ShowDate ); ?>

This function is basically the same as the Search Display function in ASP. See
Search Display Function on page 27-219 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it. The PHP example is below.

Search Display Function Example
 <tr>

 <td>

 <?php ecmSearchDisplay( 0,"",1); ?>

 </td>

 </tr>

List Summary Function
The list summary function is used to display the list of content summaries on a
Web page. Here is the format of the list summary function.

<?php ecmListSummary ( "Folder",

Recursive,

ShowSummary,

"StyleInfo",
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"OrderBy",

"ShowInfo",

MaxNumber,

"Spare 1",

"Spare2");

?>

This function is basically the same as the List Summary function in ASP. See
List Summary Function on page 27-222 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it. The PHP example is below.

List Summary Example
<TR>

<TD>

<?PHP ecmListSummary ("\Marketing\News",0,1,"",

"Title,asc","DateModified",0,"",""); ?>

</TD>

</TR>

Archive List Summary Function
The Archive list summary function displays on a Web page a list of content
summaries for archived content blocks. For example, you might have a current
news page and an archived news page. Use the List Summary Function to
display current news, and this function to display older news stories.

On the Content Block schedule screen, the user must set an End Date then
choose the Archive and Display option to have the content blocks appear via
this function.

This function has the same parameters as the List Summary Function. See List
Summary Function on previous page for details.

Single Summary Function
The single summary function is used to display the summary of one content
block in the Ektron CMS400.NET Web site, instead of a list of all the summaries
in a content folder. Seen below is the single summary function:

<?php ecmSingleSummary( “ContentID”,
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ShowSummary,

“StyleInfo”,

“ShowInfo”,

“Spare1”);

?>

This function is basically the same as the Single Summary function in ASP. See
Single Summary Function on page 27-234 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it. The PHP example is below.

Single Summary Example
<TR>

 <TD>

 <?PHP ecmSingleSummary ("14",1,"","DateModified",""); ?>

 </TD>

</TR>

XML List Summary Function
The XML List Summary function wraps XML around the properties of a list of
content, created as a list summary in the Ektron CMS400.NET Workarea. Once
created, you can use the XML to display the list summary information. The
ecmListSummaryXML function allows you to easily define how the list summary
data appears on the Web page.

<?php ecmListSummaryXML (“Folder”, Recursive, “OrderBy”, MaxNumber, “ObjType”, “SummaryType”); ?>

This function is basically the same as the List Summary XML function in ASP.
See XML List Summary Function on page 27-229 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it. The PHP example is below.

<?php ecmListSummaryXML("\books\\",0,"Title,asc",0,"folder",""); ?>

RSS List Summary Function
The RSS summary function is used to create an XML list of content summaries
for RSS Syndication. Shown here is the format of the RSS list summary
function:
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<?php ecmRssSummary (“Folder”, Recursive, “OrderBy”,
MaxNumber); ?>

This function is basically the same as the RSS Summary function in ASP. See
RSS Summary Function on page 27-237 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it. The PHP example is below.

<?php ecmRssSummary("\CMS400Developer\\", 0, "Title,asc", 0); ?>

Collection Function
The collection function is used to display the list of links that were created as a
collection in the Ektron CMS400.NET Workarea. The ecmCollection function is
highly customizable, allowing you to easily define how the collection data will
be displayed on the Web page.

Here is the format of the ecmCollection function.

<?PHP ecmCollection( “id”,

“displayFunction”;

?>

This function is basically the same as the Collection function in ASP. See
Collection Function on page 27-242 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it. The PHP example is below.

Collection Examples

Example Using the ecmNavigation Display
Function
The following is an example of a collection function being used as a navigation
menu in the Ektron CMS400.NET sample Web site.

<?php ecmCollection(1, "ecmNavigation") ?>

In this example, the collection with an ID=1 is displayed, and the function
“ecmNavigation” is used to define how the collection data is displayed on the
Web page.

Here is how the collection would appear on the Web page.
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The format of the collection on the Web page depends on the displayFunction
that is used.

Below is the source code for the display function “ecmNavigation”.

Function ecmNavigation($cInfo){

global $html, $info;

$html = "<table border=\"0\" cellspacing=\"0\" cellpadding=\"0\"

width=\"100%\">";

$mycount = $cInfo->count();

for ($iloop=0; $iloop < $mycount; ++$iloop) {

$info = $cInfo->Item($iloop+1);

$html = $html."<tr><td>&nbsp;&nbsp;<a href=\"";

$html = $html.$info->Item("ContentLinks");

$html = $html."\">";

$html = $html.$info->Item("ContentTitle");

$html = $html."</a></td></tr><tr><td>&nbsp;</td></tr>";

}

$html = $html."</table>";

return $html;

}
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As you can see, the ecmNavigation function is a simple PHP function that
creates a table of the links that belong to the collection specified.

The ecmNavigation function also displays the title of the content blocks by using
the “info(“ContentTitle”)) building block.

Example Using the ecmTeaser Display Function
The following is an example of a collection function being used as a navigation
menu in the Ektron CMS400.NET sample Web site.

<?php ecmCollection (2, "MyDisplayFunction"); ?>

In this example, the collection with an ID=2 is displayed, and the function
“ecmTeaser” is used to define how the collection data is displayed on the Web
page.

Shown here is how the collection would appear on the Web page.

As stated earlier, the format of the collection on the Web page depends on the
displayFunction that is used.

Shown below is the source code for the display function “ecmTeaser”

Function ecmTeaser($cInfo){

global $html, $info;

$html = "<table border=\"0\" cellspacing=\"0\" cellpadding=\"0\" width=\"100%\">";

$mycount = $cInfo->count();

for ($iloop=0; $iloop < $mycount; ++$iloop) {

$info = $cInfo->Item($iloop+1);

$html = $html."<tr><td><a href=\"";

$html = $html.$info->Item("ContentLinks");

$html = $html."\" >";

$html = $html.$info->Item("ContentTitle");

$html = $html."</a>&nbsp;(";

$html = $html.date("m/d/Y g:i:s A", $info->Item("DateModified"));

Example Using the ecmTeaser Display Function
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$html = $html.")</td></tr><tr><td>";

$html = $html.$info->Item("ContentTeaser");

$html = $html."</td></tr><tr><td>&nbsp;</td></tr>";

}

$html = $html."</table>";

return $html;

}

As you can see, the ecmTeaser function is a simple ASP function that creates a
table of the links that belong to the collection specified.

The ecmTeaser function also displays the:

n Content Title

n Date Modified

n Content Teaser

Collection Variables
See Collection Attributes on page 27-246

Display Function
As explained earlier, the display function is a function that you create that will
define how the collection data will be displayed on the Web page.

By using simple PHP scripting, you can create your own display functions, or
use the three included functions.

XML Collection Function
The XML collection function wraps XML around the parameters of a list of
content that’s created as a collection in the Ektron CMS400.NET Workarea. Once
created you can use the XML to display the collection information. The
ecmCollectionXML function allows you to easily define how the collection data
appears on the Web page.

Shown here is the format of the ecmCollection function.

<?php ecmCollectionXML (id, GetHtml); ?>

This function is basically the same as the XML Collection function in ASP. See
XML Collection Function on page 27-250 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it. The PHP example is below.
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<?php ecmCollectionXML (3,0); ?>

RSS Collection Function
The RSS collection function is used to create an XML list of links that were
created as a collection in the Ektron CMS400.NET Workarea and display them in
RSS Syndication.

Shown here is the PHP format of the ecmRssCollection function.

<?php ecmRssCollection (id); ?>

This function is basically the same as the RSS Collection function in ASP. See
RSS Collection Function on page 27-247 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it.

Random Content Function
The random content function is used to randomly display the content of a
content block that belongs in a specified collection.

Displayed here is the format for the random content function

<?php ShowRandomContent (id);
?>

This function is basically the same as the Random Content function in ASP. See
Random Content on page 27-254 for details.

Random Summary Function
SImilar to the random content function, the random summary function is used
to randomly display the summary of a content block that belongs in a specified
collection.

Displayed here is the format for the random content function

<?php ShowRandomSummary (id, XsltID);
?>

This function is basically the same as the Random Summary function in ASP.
See Random Summary on page 27-255 for details.

RSS Collection Function
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Event Calendar Function
The ecmEvtCalendar function is used to display an event calendar that has been
created in the Ektron CMS400.NET Workarea.

<?php ecmEvtCalendar(id, “Displaytype”); ?>

This function is basically the same as the Event Calendar function in ASP. See
Event Calendar Function on page 27-256 for details.

The only differences between the PHP function and the ASP one are the use of
the DisplayType parameter and the syntax for implementing it. The
ecmEvtCalendar function parameters are defined below.

Attribute Description

id

The “id”argument represents the ID number of the event calendar in theWorkarea.
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Attribute Description

DisplayType

Specify the Calendar display type.

n Month - A 30 day calendar month view.

n Day - Single day view.

n Inline - Displayevents that occur from the start date of the calendar through the end
date.

n MonthUpWithEvent - Displaysamonth calendar. Events appear to the right of the
calendar when you click on a day.

Event Calendar Function
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Event Calendar Sample
Here is an example of the event Calendar in an Ektron CMS400.NET template.

<tr>

<td>

<?php ecmEvtCalendar(24, “MonthUpWithEvent”); ?>

</td>

</tr>

Form Function
The ecmFormBlock and ecmFormBlockNoFormTag functions display an HTML
form content block. Both functions have the same parameters and display the
form the same way. The only difference is ecmFormBlock automatically inserts
form tags, ecmFormBlockNoFormTag does not.

The following is an example of form tags.

<form name="myform" action="#" onsubmit="return EkFmValidate(this);" method="post">

</form>

When using ecmFormBlock, form tags are added automatically. When using
ecmFormBlockNoFormTag, form tags need to be added manually.

For more information about HTML forms, see Creating a New Form on page 7-
214.

Warning! If you create a template for an existing form content block, you must manually change
its quicklink to point to the new template. This change does not occur automatically. This
procedure is described in ”Updating Default Template for Multiple Quicklinks” on page 1226.

Here is the format for the form custom function

<?php ecmFormBlock(id); ?>

<?php ecmFormBlockNoForTag(id); ?>

This function is basically the same as the Form function in ASP. See Form
Function on page 27-261 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it. The PHP example is below.

<tr>

 <td>

 <?php ecmFormBlock(1); ?>

 </td>
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</tr>

Note: As an alternative, you can use the multipurpose function, which can display either a
content block or a content block associated with a form. For more information, see
MultiPurpose Function on page 27-263.

MultiPurpose Function
The ecmMultiPurpose function displays either a content block or a content block
associated with a form. As a result, you can use one template to display both
types of content block.

Here is the format for the Multipurpose function

<?php ecmMultiPurpose(ID); ?>

To pass in a standard content block, pass the id value in the url parameter, as
illustrated below.

http://localhost/CMS400Developer/index.asp?id=2

To pass in a Form content block, pass the ekfrm value in the url parameter, as
illustrated below.

http://localhost/CMS400Developer/index.asp?ekfrm=2

Note: For more information about passing the id value as a URL parameter, see Dynamic
Content Block on page 27-204.

If the id value or ekfrm value does not exist, a blank template appears.

If the url parameter is not passed in or recognized, the function calls
ecmContentBlock and passes the DefaultID value as the id argument. If the
DefaultID value is zero (0), ecmContentBlock is not called.

Metadata Function
The metadata function is used to display the metadata for one or more content
blocks in the Ektron CMS400.NET Web site. Inserting this custom function
allows you to generate the list of metadata that is edited by the authors, and
insert it in the source of the Web page. Shown below is an example of what the
metadata custom function looks like.:

<?php ecmMetaData ("ItemList","Spare1";) ?>

This function is basically the same as the Metadata function in ASP. See
Metadata Function on page 27-263 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it. The PHP examples are below.
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To include both content blocks’ metadata in the web page, an ecmMetadata call
would look like this.

<html>

<head>

<?php ecmMetadata (“[1][2;Title,Content-Type]”, “”); ?>

(rest of head)

</head>

<body>

(rest of web page document)

</body>

</html>

In the above example the ecmMetadata call is contained in the <head> of the
HTML document (since all HTML metadata is required to exist there). Once the
Web page is viewed the Web page source will contain the following information:

<html>

<head>

<Title>Welcome to Our Home Page</Title>

<meta name=”Keywords” content= Home; page; company; Welcome; Announce;

product; widget”>

<meta http-equiv=”Content-Type” content=”text/html; charset=iso-8859-1”>

(rest of head)

</head>

<body>

(rest of web page document)

</body>

</html>

<?PHP ecmMetaData ("[1][2]","") ?>
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<?PHP ecmMetaData ("[1;title][2;keywords]","") ?>

<?PHP ecmMetaData ("[1][2;title,keywords]","") ?>
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DHTML Menus
Ektron CMS400.NET’s Menu feature lets users create and maintain a dropdown
menu system for your Web site. The Menu feature lets you display menu
options that link to content blocks, library assets, external hyperlinks and
submenus.

To learn more about menus, see Working with Menus on page 9-133.

Additional Documentation in Ektron
Knowledge Base
This chapter explains how to implement standard menus that ship with Ektron
CMS400.NET. Ektron’s Web site also provides Knowledge Base articles that
explain how to extend the standard menu features.

Displaying a Menu on a Web Page

GenerateMenu and DropMenu
Warning! The menu functions described below are only one example of how to implement
menus. You can implement your own menu system using JavaScript.

Use the GenerateNextGenMenu and DropNextGenMenu custom functions to
display a DHTML menu on a Web page. Place GenerateNextGenMenu once on
the page to provide an infrastructure for DropNextGenMenu. Then, place
DropNextGenMenu as needed to implement individual menus.

Follow these steps to display a menu on a Web template.

1. Place the following code directly after the page’s <body> tag.
<?php ecmDHTML_GenerateNextGenMenu("menu id number"); ?>

For example:
<?php ecmDHTML_GenerateNextGenMenu("1"); ?>

To display more than one menu, separate each id number with a
comma. For example:

<?php ecmDHTML_GenerateNextGenMenu("1,2,3"); ?>

2. If the user clicks text to display the menu, place the following code
within the template file where the text would appear.

 <?php ecmDHTML_DropNextGenMenu menu ID number,"text user clicks to display
menu"; ?>"

For example:
<?php ecmDHTML_DropNextGenMenu 1,"MyMenu1"; ?>

If the user clicks a graphic to invoke the menu, use this syntax:
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 <?php ecmDHTML_DropNextGenMenu menu ID number, '<img src=graphic file
name>'; ?>

For example:
<?php ecmDHTML_DropNextGenMenu 1,'<img src=mymenugraphic.jpg>'; ?>

Customizing the Menu’s Appearance
You can customize a menu’s appearance, such as the font style, color, and size.
So, you have the flexibility to coordinate a menu with the design your Web site.

To customize a menu in Ektron CMS400.NET, you can change the ek_Menu.js
file.

ek_Menu.js
You can change the look and feel of a menu by changing the ek_menu.js file. If
you used the default settings when installing Ektron CMS400.NET, this file is in
webroot/siteroot/Workarea/java/. For a description of the ek_menu.js file,
see ek_Menu.js on page 27-272.

XML Menu Function
The ecmGetMenuXML function wraps XML around the properties of a menu
created in the Ektron CMS400.NET Workarea. Once created you can use the
XML to display the menu. The ecmGetMenuXML function allows you to easily
define how the menu data appears on the Web page.

<?php ecmGetMenuXML($Id); ?>

This function is basically the same as the XML Menu function in ASP. See XML
Menu on page 27-274 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it. The PHP example is below.

<?php ecmGetMenuXML(1); ?>

Language Select Function
This function lets a visitor to your Web site select a language in which to view
the site. Here is what the function looks like when published on a Web page.
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Shown here is the format of the ecmLanguageSelect function.

<?php ecmLanguageSelect();
?>

This function is basically the same as the Show Site Language function in ASP.
See Show Site Language Function on page 27-269 for details.

The only difference between the PHP function and the ASP one is the syntax for
implementing it.

Custom API
As you have seen, the formatting for the custom functions used in Ektron
CMS400.NET for PHP are defined in the file ApplicationAPI.php. As a developer,
you may make changes to this file to further enhance how the custom functions
appear on your Web site.

However, Ektron recommends creating a copy of the file, and renaming it to an
arbitrary name, for example, MyCustomAPI.php, and including that file when
creating Ektron CMS400.NET templates. This ensures that your custom API will
not be overwritten if you upgrade to another version of Ektron CMS400.NET.

Custom JSP Functions
Important: As of 8.01 SP2, the platforms/JSP folder is installed to the program
files/Ektron/utilities folder. In order for JSP platform support to function, move the
platforms/JSP folder to the Workarea folder and configure it.
Previously, the platforms folder was installed to the Workarea folder by default.
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Ektron CMS400.NET maintains and displays content via custom Ektron JSP
functions. For the custom JSP functions to work properly, do the following:

n In the applicationapi.jsp file, set the WSSoap_address. The
applicationapi.jsp file is located by default in:

http:/-
/loca-
lhost/siteroot/WorkArea/platforms/JSP/applicationapi.jsp

Warning! ContentWS.asmx is the web services file that the custom JSP functions use to talk to
Ektron CMS400.NET. The WSSoap_address located in the applicationapi.jsp file must be
set to location of the Web services file. The default WSSoap_address is
http://localhost/siteroot/WorkArea/WebServices/ContentWS.asmx. If you have
changed the location of ContentWS.asmx you need to update the WSSoap_address. For
example, if your site is www.example.com, the WSSoap_address would be
http://www.example.com/WorkArea/WebServices/ContentWS.asmx.

n Add the following line to the top of each template.

<%@ include file=”applicationapi.jsp” %>

This file calls the Ektron custom functions file to allow the page to
function properly. Itmust appear at the top of the template file.

n Make sure the contentws.jar file is included in your JSP
environment

n Ektron recommends running Axis when using a JSP environment. We
have tested on TomCat and JRUN with Axis v1.2.1. You can download
Axis from http://ws.apache.org/axis/java/.

To customize your Ektron CMS400.NET application, you need to be familiar with
these functions.

Function Description
More
Information

Calendar Functions

Calendar
Displays a calendar with different display types.
For example, a daily view calendar.

Calendar
Function on
page 27-330

Event Calendar Displaysamonth view event calendar

Event
Calendar
Function on
page 27-331

Collection Functions

Collection Displays links generated by collections
Collection
Function on
page 27-328
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Function Description
More
Information

CollectionXML
CreatesXML for a collection bywrapping tagsaround all of the
collection itemsand their properties. This allowsyou to use an XSLT
to define how the XML collection is displayed.

XMLCollection
Function on
page 27-328

RandomContent Randomlydisplays the content of a collection item

Random
Content
Function on
page 27-329

Random
Summary Randomlydisplays the summaryof a collection item

Random
Summary
Function on
page 27-329

RSSCollection Createsan RSS feed out of the items in a collection.
RSSCollection
Function on
page 27-329

Content Functions

Add Content
Allows a user to add content to Ektron CMS400.NET
programmatically.

AddContent
on page 27-
330

Content Block Displaysandmanagesa content block
Content Block
Function on
page 27-331

Form Displaysa content blockassociated with a form
Form Function
on page 27-
332

Language Functions

Language Select Lets a site visitor select a language in which to view site.

Language
Select Function
on page 27-
334

Login Functions

Login Adds the login or logout button
Login Function
on page 27-
334

Menu Functions

DropHTMLMenu Used to display a DHTMLmenu
DHTMLMenus
on page 27-
335
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Function Description
More
Information

GenerateMenu Workswith DropHTMLMenu to displayDHTMLmenus.
DHTMLMenus
on page 27-
335

XMLMenu
Creates XML for a menu by wrapping tags around all of
the menu items properties.

XMLMenu
Function on
page 27-337

Metadata Functions

Metadata Displays themetadata for the currentWeb page.
Metadata
Function on
page 27-337

Search Functions

Search Inserts a text boxwith a search button.
Search
Function on
page 27-340

Search Display Createsan area to display search results.
Search Display
Function on
page 27-341

Summary Functions

List Summary Displaysa list of content block summaries.
List Summary
Function on
page 27-341

List Summary
XML

CreatesXML for a list summarybywrapping tagsaround all of the
collection itemsand their properties. This allowsyou to use an XSLT
to define how the XML collection is displayed.

XML List
Summary
Function on
page 27-342

RSSList
Summary Createsan RSS feed out of the items in a list summary.

RSSList
Summary
Function on
page 27-342

Single Summary Displays the summary for a content block.

Single
Summary
Function on
page 27-342
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Collection Function
The collection function is used to display the list of links that were created as a
collection in the Ektron CMS400.NET Workarea. The ecmCollection function is
highly customizable, allowing you to easily define how the collection data will
be displayed on the Web page.

Shown here is the format of the ecmCollection function.

<%= ecmCollection(int id, String
“displayFunction”) %>

This function is basically the same as the Collection function in ASP. See
Collection Function above for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it.

Collection Sample
Here is an example of the Collection function in an Ektron CMS400.NET
template.

<tr>

<td>

<%= ecmCollection(24, “ecmTeaser”) %>

</td>

</tr>

XML Collection Function
The XML collection function wraps XML around the parameters of a list of
content that’s created as a collection in the Ektron CMS400.NET Workarea. Once
created you can use the XML to display the collection information. The
ecmCollectionXML function allows you to easily define how the collection data
appears on the Web page. Shown here is the format of the ecmCollection
function.

<%= ecmCollectionXML (int id, boolean GetHtml)
%>

This function is basically the same as the XML Collection function in ASP. See
XML Collection Function on page 27-250 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it. The JSP example is below.
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<tr>

<td>

<%= ecmCollectionXML(24, True) %>

</td>

</tr>

Random Content Function
The random content function is used to randomly display the content of a
content block that belongs in a specified collection.

Displayed here is the format for the random content function

<%= ecmShowRandomContent (int collectionID, int
xsltId) %>

This function is basically the same as the Random Content function in ASP. See
Random Content on page 27-254 for details.

Random Summary Function
SImilar to the random content function, the random summary function is used
to randomly display the summary of a content block that belongs in a specified
collection.

Displayed here is the format for the random content function

<%= ShowRandomSummary (int
collectionID) %>

This function is basically the same as the Random Summary function in ASP.
See Random Summary on page 27-255 for details.

RSS Collection Function
The RSS collection function is used to create an XML list of links that were
created as a collection in the Ektron CMS400.NET Workarea and display them in
RSS Syndication.

Shown here is the JSP format of the ecmRssCollection function.

<%= ecmRssCollection (int id)
%>

This function is basically the same as the RSS Collection function in ASP. See
RSS Collection Function on page 27-247 for details.
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Add Content
The add content function allows you to programmatically add a new content
block to Ektron CMS400.NET without the need of logging in.

Here is the format for the add content function:

<%= ecmAddContent (String UserName, String Password, String Domain, String content_title,
String content_comment, String ContentHtml, String SummaryHTML, String ContentLanguage, String
FolderID, String GoLive, String EndDate, String MetaInfo) %>

This function is basically the same as the Add Content function in ASP. See Add
Content on page 27-207 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it. The JSP example is below.

Add Content Example
The following is an example of the add content function in a template:.

<tr>

<td>

<%= ecmAddContent ("admin", "admin", "", "Content Title", "Comment", "This is
the <b>body</b> of the content.", "This is the <i>summary</i> for the
content.", "1033", "0", "", "", "") %>

</td>

</tr>

Calendar Function
The ecmCalendar function displays a calendar that has been created in Ektron
CMS400.NET. Here is the format for the event calendar custom function.

<%= ecmCalendar (int calendarID, String
“displayType”) %>

Note:While you can display a month view calendar with ecmCalendar, you can also use
ecmEvtCalendar to display a month view calendar. For more Information, see Event Calendar
Function on the facing page

This function is basically the same as the Calendar function in ASP. See
Calendar Function on page 27-257 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it.
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Calendar Sample
Here is an example of the Calendar function in an Ektron CMS400.NET
template.

<tr>

<td>

<%= ecmEvtCalendar(24, “MonthUpWithEvent”) %>

</td>

</tr>

Event Calendar Function
The ecmEvtCalendar function is used to display an event calendar that has been
created in the Ektron CMS400.NET Workarea.

<%= ecmEvtCalendar(int calendar id)
%>

This function is basically the same as the Event Calendar function in ASP. See
Event Calendar Function on page 27-256 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it.

Event Calendar Sample
Here is an example of the event Calendar in an Ektron CMS400.NET template.

<tr>

<td>

<%= ecmEvtCalendar(24) %>

</td>

</tr>

Content Block Function
The ecmContentBlock and ecmContentBlockEX functions are used to display a
content block on an Ektron CMS400.NET Web page.

Shown here is the format for the ecmContentBlock function:

<%= ecmContentBlock (int id)
%>
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Here is the format for the ecmContentBlockEX function:

<%= ecmContentBlockEX (int id, String xslt, int
OverrideId) %>

These function is basically the same as the Content Block functions in ASP. See
Content Block Function on page 27-201 for details.

The only difference between the JSP function and the ASP one is the examples
of implementing it. The JSP examples are below.

Static Content Block
<tr>

 <td>

 <%= ecmContentBlock(1) %>

 </td>

</tr>

Dynamic Content Block
<tr>

 <td>

 <%= ecmContentBlock($id) %>

 </td>

</tr>

XML Content Block
<tr>

 <td>

 <%= ecmContentBlockEx (13, “”, 1) %>

 </td>

</tr>

Form Function
The ecmFormBlock function displays an HTML form content block. This function
has a parameter that lets you decide whether to have form tags added
automatically or manually. The following is an example of form tags.

<form name="myform" action="#" onsubmit="return EkFmValidate(this);" method="post">

</form>
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For more information about HTML forms, see Working with HTML Forms on
page 7-212.

Warning! If you create a template for an existing form content block, you must manually change
its quicklink to point to the new template. This change does not occur automatically. This
procedure is described in Updating Default Template for Multiple Quicklinks on page 8-22.

Here is the format for the ecmFormBlock function:

<%= ecmFormBlock (int id, boolean
formTagReqd) %>

The ecmFormBlock function attributes are explained below.

Attribute Description

id

The “id” argument represents the form’s ID number, visible when viewing the form from
the View Form screen.

formTagReqd

Allows form tags to be added automatically.

This is an example of form tags.

<form name="myform" action="#" onsubmit="return EkFmValidate(this);"
method="post">
</form>

true =Add form tagsautomatically

false =Add form tagsmanually

This function is basically the same as the Form function in ASP. See Form
Function on page 27-261 for details.

The only differences between the JSP function and the ASP one are the
formTagReqd parameter and the syntax for implementing it. The JSP example
is below.

<tr>

 <td>

 <%= ecmFormBlock(1, true) %>
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 </td>

</tr>

Language Select Function
This function lets a visitor to your Web site select a language in which to view
the site. Here is what the function looks like when published on a Web page.

Shown here is the format of the ecmLanguageSelect function.

<%= ecmLanguageSelect()
%>

This function is basically the same as the Show Site Language function in ASP.
See Show Site Language Function on page 27-269 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it.

Login Function
This function is responsible for displaying the following buttons on the Web
page.

Button Name Description

Login
When user is not logged into Ektron CMS400.NET, this button
appears. Click this button to let the user log in to the application.
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Button Name Description

Logout
Once logged in, this button replaces the login button to allow the
user to log out from the Ektron CMS400.NETWeb site.

Workarea
When logged in, this button appears under the logout button
allowing the user to access their workarea.

Preview
On

Lets the user to preview the entire Web site as if all checked-in
content was published.

Preview
Off

Turns off preview mode.

Shown here is the format of the ecmLogin function.

<%= ecmlogin()
%>

This function is basically the same as the Login function in ASP. See Login
Function on page 27-199 for details. The only difference is the syntax used to
implement the function. This is listed below.

Login Function Example
<tr>

<td>

<%= ecmlogin() %>

</td>

</tr>

DHTML Menus
Ektron CMS400.NET’s Menu feature lets users create and maintain a dropdown
menu system for your Web site. The Menu feature lets you display menu
options that link to content blocks, library assets, external hyperlinks and
submenus.

To learn more about menus, see Working with Menus on page 9-133.
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Additional Documentation in Ektron
Knowledge Base
This chapter explains how to implement standard menus that ship with Ektron
CMS400.NET. Ektron’s Web site also provides Knowledge Base articles that
explain how to extend the standard menu features.

Displaying a Menu on a Web Page

GenerateMenu and DropMenu
Warning! The menu functions described below are only one example of how to implement
menus. You can implement your own menu system using JavaScript.

Use the GenerateNextGenMenu and DropNextGenMenu custom functions to
display a DHTML menu on a Web page. Place GenerateNextGenMenu once on
the page to provide an infrastructure for DropNextGenMenu. Then, place
DropNextGenMenu as needed to implement individual menus.

Follow these steps to display a menu on a Web template.

1. Place the following code directly after the page’s <body> tag.
<%= ecmDHTML_GenerateNextGenMenu("menu id number") %=>

For example:
<%= ecmDHTML_GenerateNextGenMenu("1") %>

To display more than one menu, separate each id number with a
comma. For example:

<%= ecmDHTML_GenerateNextGenMenu("1,2,3") %>

2. If the user clicks text to display the menu, place the following code
within the template file where the text would appear.

 <%= ecmDHTML_DropNextGenMenu menu ID number,"text user clicks to display menu"
%>"

For example:
<%= ecmDHTML_DropNextGenMenu 1,"MyMenu1" %>

If the user clicks a graphic to invoke the menu, use this syntax:
 <%= ecmDHTML_DropNextGenMenu menu ID number, '<img src=graphic file name>'

%>

For example:
<%= ecmDHTML_DropNextGenMenu 1,'<img src=mymenugraphic.jpg>' %>
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Customizing the Menu’s Appearance
You can customize a menu’s appearance, such as the font style, color, and size.
So, you have the flexibility to coordinate a menu with the design your Web site.

To customize a menu in Ektron CMS400.NET, you can change the ek_Menu.js
file.

ek_Menu.js
You can change the look and feel of a menu by changing the ek_menu.js file. If
you used the default settings when installing Ektron CMS400.NET, this file is in
webroot/siteroot/Workarea/java/. For a description of the ek_menu.js file,
see ek_Menu.js on page 27-272.

XML Menu Function
The ecmGetMenuXML function wraps XML around the properties of a menu
created in the Ektron CMS400.NET Workarea. Once created you can use the
XML to display the menu. The ecmGetMenuXML function allows you to easily
define how the menu data appears on the Web page.

<%= ecmGetMenuXML(int id)
%>

This function is basically the same as the XML Menu function in ASP. See XML
Menu on page 27-274 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it. The JSP example is below.

<%= ecmGetMenuXML(1) %>

Metadata Function
The metadata function is used to display the metadata for one or more content
blocks in the Ektron CMS400.NET Web site. Inserting this custom function
allows you to generate the list of metadata that is edited by the authors, and
insert it in the source of the Web page. Shown below is an example of what the
metadata custom function looks like:

<%= ecmMetadata(String itemlist, java.lang.object
spare1) %>

This function is basically the same as the Metadata function in ASP. See
Metadata Function on page 27-263 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it. The JSP examples are below.
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To include both content blocks’ metadata in the web page, an ecmMetadata call
would look like this.

<html>

<head>

<%= ecmMetadata (“[1][2;Title,Content-Type]”, “”) %>

(rest of head)

</head>

<body>

(rest of web page document)

</body>

</html>

In the above example the ecmMetadata call is contained in the <head> of the
HTML document (since all HTML metadata is required to exist there). Once the
Web page is viewed the Web page source will contain the following information:

<html>

<head>

<Title>Welcome to Our Home Page</Title>

<meta name=”Keywords” content= Home; page; company; Welcome; Announce;

product; widget”>

<meta http-equiv=”Content-Type” content=”text/html; charset=iso-8859-1”>

(rest of head)

</head>

<body>

(rest of web page document)

</body>

</html>

<%= ecmMetaData ("[1][2]","") %>
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<%= ecmMetaData ("[1;title][2;keywords]","") %>

<%= ecmMetaData ("[1][2;title,keywords]","") %>

Metadata Function
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Search Function
The search function is used to display a text box with a search button on the
template. When seen on the template on the Web page, a user can enter text
and click the search button to search through all the content on the Web site.

Ektron has created two search functions:

n ecmSearch

n ecmSearchNoFormTag

Both functions have the same parameters and perform the same search. The
only difference is ecmSearch automatically inserts form tags,
ecmSearchNoFormTag does not.

The following is an example of form tags.

<form name="ecmsearch" method="post" action='search-display.asp'>

</form>

When using ecmSearch, form tags are added automatically. When using
ecmSearchNoFormTag you need to add the tags manually

Here is the format for the search function. You can interchange ecmSearch and
ecmSearchNoFormTag when using this function.

<%= ecmSearch(java.lang.String startingFolder, boolean recursive,
java.lang.String target, int textBoxSize, int maxCharacters, java.lang.String
buttonImageScr, java.lang.String buttonText, java.lang.String fontFace,
java.lang.String fontColor, java.lang.String fontSize, boolean horizontal,
java.lang.Object spare1) %>

This function is basically the same as the Search function in ASP. See Search
Functions (ASP) on page 27-210 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it. The JSP example is below.

Search Function Example
<TR>

 <TD>

 <%= ecmSearch("\\",true,"search-
display.jsp",25,200,"","Search","Verdana","#808080","2",false,"") %>

 </TD>

</TR>
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Search Display Function
The search display custom function creates the area where all the search
results are shown after the search has been executed.

Here is the format of the ecmSearchDisplay function:

<%= ecmSearchDisplay(int maxNumber, String styleInfo, boolean
ShowDate, boolean showSummary) %>

This function is basically the same as the Search Display function in ASP. See
Search Display Function on page 27-219 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it. The JSP example is below.

Search Display Function Example
 <tr>

 <td>

 <%= ecmSearchDisplay(0,"",true,true) %>

 </td>

 </tr>

List Summary Function
The list summary function is used to display a list of content summaries on a
Web page. Here is the format of the list summary function.

<%= ecmListSummary (String folder, boolean recursive, boolean
showSummary, String styleInfo, String OrderBy, String showInfo, int
maxNumber, String objType, String optionList, String summaryType) %>

This function is basically the same as the List Summary function in ASP. See
List Summary Function on page 27-222 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it. The JSP example is below.

List Summary Example
<TR>

<TD>

<%= ecmListSummary ("\Marketing\News",false,true,"",

"Title,asc","DateModified",0,"","","") %>

Search Display Function
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</TD>

</TR>

XML List Summary Function
The XML List Summary function wraps XML around the properties of a list of
content, created as a list summary in the Ektron CMS400.NET Workarea. Once
created, you can use the XML to display the list summary information. The
ecmListSummaryXML function allows you to easily define how the list summary
data appears on the Web page.

<%= ecmListSummaryXML (String Folder, int Recursive, String OrderBy, int
MaxNumber, String ObjType, String SummaryType) %>

This function is basically the same as the List Summary XML function in ASP.
See XML List Summary Function on page 27-229 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it. The JSP example is below.

<%= ecmListSummaryXML("\\CMS400Developer\\",0,"Title,asc",0,"folder",""); ?>

RSS List Summary Function
The RSS summary function is used to create an XML list of content summaries
for RSS Syndication. Shown here is the format of the RSS list summary
function:

<%= ecmRssSummary (java.lang.String Folder, boolean Recursive,
java.lang.String OrderBy, int MaxNumber) %>

This function is basically the same as the RSS Summary function in ASP. See
RSS Summary Function on page 27-237 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it. The JSP example is below.

<%= ecmRssSummary("\\CMS400Developer\\", false, "Title,asc", 0) %>

Single Summary Function
The single summary function is used to display the summary of one content
block in the Ektron CMS400.NET Web site, instead of a list of all the summaries
in a content folder. Seen below is the single summary function:

<%= ecmRssSummary (int contentID, boolean showSummary, java.lang.String
showInfo, java.lang.String styleInfo, java.lang.String spare1) %>
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This function is basically the same as the Single Summary function in ASP. See
Single Summary Function on page 27-234 for details.

The only difference between the JSP function and the ASP one is the syntax for
implementing it. The JSP example is below.

Single Summary Example
<TR>

 <TD>

 <%= ecmSingleSummary ("14",true,"","","") %>

 </TD>

</TR>
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As an administrator, you can add, edit, and delete fonts to and from the Ektron
CMS400.NET application. By adding fonts, you are allowing the content
contributors to use them when creating content. Administrators can also edit
the name of a font, and delete a font from the system.

Minimizing the number of available fonts makes the Web site look more
uniform.

Below is the Font Manager screen.

Note: Only members of the Administrator User Group can view, add, or edit fonts.

This section also contains the following topics.

Adding Fonts 28-2
ViewingFonts 28-3
Editing Fonts 28-3
Deleting Fonts 28-4

Adding Fonts
To add a font to the application, follow these steps.

1. From the left frame of the Workarea, click Settings >
Configuration > Fonts.

2. Click the Add button ( ).
3. The Add Font screen is displayed.

4. Enter the font name or family into the text field provided.

5. Click the Save button ( .)
The new font is available to use when adding or editing content if the Application
Setup screen’s Enable Font Buttons field is checked. See Also: Updating
Setup Information on page 2-28
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ViewingFonts
When viewing fonts, you can also edit or delete them.

To view a font, follow these steps.

1. Access the font manager in your Workarea as described in Adding
Fonts on previous page.

2. Click the font you want to view.

3. The view font screen is displayed.

Editing Fonts
When you edit a font, the font or family name is changed. Editing does not
change any fonts in existing content.

To edit a font name, follow these steps.

1. Access the view font screen, as described in ViewingFonts above.

2. Click the font that you want to edit.

3. Click the Edit button ( ).
4. The Edit Font screen is displayed.

ViewingFonts
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5. Edit the font name or family in the text field specified.

6. When finished, click the Update button ( ).

Deleting Fonts
By deleting a font from the system, you are taking away the content
contributors’ use of that font in their content. To delete a font, follow these
steps.

1. Access the view font screen, as described in ViewingFonts on
previous page.

2. Click the font that you want to delete.

3. Click the Delete button ( ).
4. A confirmation message is displayed.

5. Click OK.

6. The screen is refreshed, and the updated fonts table is displayed.

Note:When you delete a font from Ektron CMS400.NET, you do not delete it from your
computer.
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Developers can use these tables to determine constant values when working
with Ektron CMS400.NET users and content.

User Constants

Constant Description

999999999 Builtin

18611864 InternalAdmin

1 Image

2 File

888888 AllMemberShip Group

2 EveryoneGroup

1 AdminGroup
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Content Constants

Constant Description

-1 CMSContentType_AllTypes

1 CMSContentType_Content

2 CMSContentType_Forms

3 CMSContentType_Archive_Content

4 CMSContentType_Archive_Forms

7 CMSContentType_Library

9 CMSContentType_NonImageLibrary

10 CMSContentType_PDF

104 CMSContentType_Media

101 CMSContentType_OfficeDoc

12 CMSContentType_Archive_Media

13 CMSContentType_BlogComments

14 CMSContentType_XmlConfig

98 CMSContentType_NonLibraryForms

99 CMSContentType_NonLibraryContent

1111 CMSContentType_DiscussionTopic

3333 CMSContentType_CatalogEntry

100 ManagedAsset_Min

1099 ManagedAsset_Max

1100 Archive_ManagedAsset_Min

2099 Archive_ManagedAsset_Max

1000 MaxNumManagedAssetTypes
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pricing 17-133
reorder level 17-133

items
entering 17-142

media 17-139
overview 17-123
pricing
list price 17-134
non-default currency 17-135
salesprice 17-134
tier 17-135
tier, for non-default currency 17-

136
properties 17-131
SKU code 17-132
summary 17-131
tangible item 17-133
tax class 17-132
template 17-130
thumbnail size 17-141
thumbnails 17-139

catalog folders
assigning product type 17-122
deleting 17-123
overview 17-121

complexproduct 17-112
countries 17-49
country tax table
deleting 17-102
editing 17-101
overview 17-101

coupons
creating 17-215
discount 17-217
eligible catalog entries 17-221
minimum order amount 17-220
overview 17-215
start/end dates 17-220

credit card types
creating 17-78
deleting 17-80
editing 17-80
introduction 17-77
where used 17-77

cross sell items 17-181
currencies 17-54
enabled 17-55
installed 17-55

currency
default 17-56

customer information
address 17-204
overview 17-203
shopping cart 17-205

kits 17-109
messages
creating 17-83
editing 17-83
how created 17-82
overview 17-81
variables 17-83

orders
cancelling 17-194
capturing 17-192
marking fraud 17-195
overview 17-189
statuses 17-190



tracking number 17-194
view screen 17-191

overview 17-3
packages
creating 17-88
deleting 17-89
editing 17-89
how used 17-88
introduction 17-87

payment gateway
creating 17-73
default 17-72
deleting 17-74
editing 17-73
introduction 17-61

postal tax table
creating 17-97
deleting 17-99
editing 17-99
overview 17-97

product types
classes 17-103
deleting 17-121
editing 17-120
effect on catalog entries 17-104
overview 17-103

regional tax table
deleting 17-101
editing 17-99
overview 17-99

regions 17-52
shippingmethods 17-89
adding 17-91
changing sequence 17-93
deleting 17-92
editing 17-92

shipping providers
default 17-91
defining 17-90

shopping cart
deleting 17-205
viewing 17-205

tax class
creating 17-96
deleting 17-97
editing 17-97
screens 17-95

taxes
how calculated 17-94
overview 17-94

upsell items 17-181
warehouse 17-85
creating 17-85
default, changing 17-86
deleting 17-87
editing 17-87

edit in context
defined 7-22

editing
content block, overview 2-5, 2-6

editor
introduction 7-26
setting in web.config 7-27

email
disabling notification for a user 15-6

display in user profile 16-32
system address 2-29

emailing workflow reports 7-704
end date, setting for content 7-190
eSync
bidirectional 18-63
CMScontent and folder
prerequisites 18-77
using 18-79

collisions 18-74
conflict resolution 18-64
content 18-79
ID numbering 18-42
initializing a new site 18-53
introduction 18-4, 18-35
items to synchronize 18-64
load balanced system 18-82
manually running 18-66
multisite environment 18-90
profile
setting up 18-53

security certificates
installing 18-45
introduction 18-43
regenerating 18-50
replacing 18-50
testing 18-50

software requirements 18-35
troubleshooting 18-96
Windows files 18-64

eWebDiff window 7-122
eWebEdit400
alignment toolbar buttons 7-35
anchor tag toolbar button 7-32
bold toolbar button 7-33
bookmarks 7-59
bullet toolbar button 7-35
cells
background color 7-100
background color, deleting 7-100
background image, deleting 7-101
background image, inserting 7-100
border size 7-97
deleting 7-99
merging 7-105
padding 7-106
spacing 7-106
splitting 7-104
text alignment 7-103
width 7-98

copy
information from other appli-
cations

7-
38

toolbar button 7-31
cut toolbar button 7-30
email links 7-65
finding text 7-39
font
background color toolbar button 7-34
color toolbar button 7-34
relative size toolbar button 7-33
size, absolute, toolbar button 7-34
style toolbar button 7-34

form elements toolbar 7-36
horizontal line toolbar button 7-32

HTML, editing 7-66
HTML, viewing 7-66
hyperlink toolbar button 7-32
hyperlinks 7-61
creating 7-62
editing 7-64
enteringmanually 7-62
preventing 7-65
removing 7-65
to a bookmark in another web
page

7-
64

images
deleting 7-46
inserting 7-45

indent toolbar button 7-35
insert symbol toolbar button 7-32
introduction 7-28
italic toolbar option 7-33
library toolbar button 7-32
number toolbar button 7-34
paragraph style toolbar button 7-33
paste fromWord toolbar button 7-31
paste plain text toolbar button 7-31
paste toolbar button 7-31
print toolbar button 7-31
redo toolbar button 7-32
remove hyperlink toolbar button 7-32
replace toolbar button 7-31
replacing text 7-39
search 7-39
considering case of search term 7-42
direction 7-41
whole wordmatch 7-43

select all toolbar button 7-30
spell check toolbar button 7-32
spelling 7-43
strikethrough toolbar button 7-33
style class toolbar button 7-33
subscript toolbar button 7-33
superscript toolbar button 7-33
table
add row above toolbar button 7-35
add row below toolbar button 7-35
adding columns 7-78
adding rows 7-78
alignment 7-83
background color 7-84
background color,deleting 7-86
background image 7-87
background image,deleting 7-89
border color 7-90
border lines 7-91
border size 7-90
cell properties toolbar button 7-36
columns, specifying 7-77
creating 7-72
delete cell toolbar button 7-36
delete column toolbar button 7-36
delete row toolbar button 7-36
deleting 7-76
insert column left toolbar button 7-35
insert column right toolbar button 7-35
insert toolbar button 7-35
inserting within a table 7-77
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merge cell horizontally toolbar
button

7-
36

merge cell vertically toolbar but-
ton

7-
36

properties 7-74
properties toolbar button 7-36
removing columns 7-78
removing rows 7-78
rows,specifying 7-77
section 508 7-92
abbreviation 7-96
categories 7-96
table caption 7-95
table summary 7-95

show/hide border toolbar button7-36
span rowsand columns 7-101
split cell toolbar button 7-36
width,setting bypercentage 7-80
width,setting bypixels 7-81
word wrap 7-105

table row
background color 7-86

text, searching 7-39
text,aligning in columns 7-77
toolbar buttons 7-30
translate toolbar button 7-32
underscore toolbar button 7-33
undo toolbar option 7-31
wiki toolbar button 7-32

eWebEditPro+XML
using 7-28

expanding, flexible menu sample 9-170
extensions
creating 25-1
Dreamweaver, using 27-17

F

Facebook
bookmarking current page 16-242
login
overview 2-14
samples 2-14
setup 2-16
user experience 2-15

favorites
adding URL link 16-46
folder, deleting 16-49
group by folder 16-47
server control 16-45

file extensions
library folder property 8-6

File LinkField, data designer 7-339
file types, determining allowed 7-435
file upload path
library folder property 8-6

file upload tab 7-411
files
copying to library 8-10
library
editing title 8-13
inserting into content 8-16
overwriting 8-14

viewing 8-11
finding
content block 7-20

FireFoxplugin for DMS
installing 7-401

flagging
content
report 16-215

flexible menu
samples 9-167
508 compliance 9-173, 9-173
ajaxdemo 9-169
expanding 9-170
fly-out 9-170
horizontal 9-171
lightweight 9-171
list 9-172
xmlmodify 9-172

samples, copying and editing 9-174
server control
overview 9-166
properties 9-178

working with XLSTfile 9-175
fly-out, flexible menu sample 9-170
folders
assigningmetadata 7-159
assigning smart forms 7-369
assigningWeb Alerts 23-20
colleague See colleagues, group by

folder
community See community folders
content
applying
style sheet 4-15
template 4-16

creating on server to match CMS
folders

2-
34

deleting 4-25
managing 4-1
properties 4-13
toolbar 4-17

copy See folders, move/copy
information available when viewing 4-4
move/copy
authorized users 4-22
folder types 4-23
introduction 4-21

permissions
setting 4-44

private 7-185
templates
assigning 7-182
removing 7-183

traverse 4-44
using to group favorites 16-47
viewing 4-3

font buttons, enabling 2-31
fonts
adding 28-2
deleting 28-4
editing 28-3
managing 28-1
viewing 28-3

Force All Approvers 4-39

formblock server control
overview 7-271

forms
adding to content 8-21
HTML
adding field to screen 7-222
assigning task 7-251
buttons, inserting on form 7-244
buttons, properties 7-244
chart types 7-219
creating 7-214
creating content block 7-220
custom validation 7-232
database 7-264
deleting 7-264
editing
content block 7-263
introduction 7-262
summary 7-263

editing field 7-243
field validation options 7-229
forward form data 7-217
implementing onWeb page 7-245
inserting fields
calendar field 7-240
checkbox 7-225
choices 7-236
text 7-226

introduction 7-212
mailto 7-264
permissions 7-213
postbackmessage, compose 7-216
processing overview 7-213
redirect to action page 7-217
redirecting submitted data 7-249
reports, exporting 7-258
reports, viewing 7-252
results, making available to
users

7-
218

sending data asXML 7-245
structure of data 7-214
toolbar options 7-221
validation 7-224
viewing 7-258
XML email structure 7-247

viewing 8-21
forums See discussion boards, forums
friends See also colleagues
server control 16-34
server control properties 16-42

Front Page server extensions,
removing

7-
466

full screen, work page, customizing
for user

15-
7

Furl
bookmarking current page 16-243

G

gallery See photo gallery
GetReportNameList Method 7-771
Google
bookmarking current page 16-242



web analytics provider 7-780
group box field, data designer 7-299
groups See community groups

H

height, screen, adjusting 2-32
height, work page, customizing for
user

15-
7

history
content
accessing fromWeb page 7-116
accessing viaWorkarea 7-115
window 7-116

horizontal, flexible menu sample 9-171
HTML
editing 7-66
saving Office document as 7-425

HTML forms See forms, HTML
hyperlinks 7-61
adding asmenu option 9-149
definition 8-2
library
adding 8-18
adding to content 8-19
editing 8-19
viewing 8-19

I

ical export of calendar events 7-546
Ignore All field, eWebDiff 7-123
Ignore Case field, eWebDiff 7-123
Ignore Format Attributes field, eWeb-
Diff

7-
123

image extensions
library folder property 8-6

image only field
data designer 7-337

image upload path
library folder property 8-6

imagecontrol server control 7-469
images
adjusting brightnesswithin eWe-
bEdit400

7-
57

aligning within eWebEdit400 7-52
cropping within eWebEdit400 7-58
editing within eWebEdit400 7-54
inserting into eWebEdit400 editor 7-45
letting community users update 7-469
library
adding to content 8-20
editing titles 8-20
overwriting 8-20
uploading 8-19
viewing 8-20

login, changing 2-24
properties
editing within eWebEdit400 7-47

resizing within eWebEdit400 7-55
rotating within eWebEdit400 7-58
thumbnail, inserting 7-47

in context editing 7-22
include file
ASP 27-196

index search server control 7-384
using programmatically 7-393

indexing service catalog 9-7
changing name 9-9
full scan 9-17
incremental scan 9-18
manual setup 7-449
merging
conditions 9-20
manual steps 9-22
overview 9-19
utility 9-21

overview 9-7
recreating automatically 9-11
recreatingmanually 9-10
restart 9-16

indexing service, disabling 7-456
indexing service, enabling 7-461
indexing, XML See XML indexing
inheritance
breaking 4-42
restoring 4-42

invited colleagues
canceling 16-37
viewing 16-37

IP address, restricting for a forum 7-611

J

JavaScript
adding to content 7-67

K

kits, eCommerce 17-109

L

landing page after login, customizing
for user

15-
8

language export feature, seemulti-lan-
guage content

14-
14

language, for-
eign

Seemulti-language con-
tent

LDAPauthentication
Active DirectorySetup screen 15-89
adding organizational unit 15-83
adding user information from LDAP
server to CMS400

15-
84

deleting users 15-89
disabling 15-93
editing user information in CMS
400

15-
89

enabling 15-81
overview 15-80
using with CMS400.NET 15-81
view users screen 15-90

library
accessing 8-3
asset, adding asmenu item 9-148
copying files to 8-10
definition 8-1
files
deleting 8-16
editing 8-13
inserting into content 8-16
overwriting 8-14
viewing 8-11

folder properties 8-5
folders
creating 8-4

forms
adding to content 8-21
viewing 8-21

hyperlinks
adding 8-18
adding to content 8-19
editing 8-19
viewing 8-19

images
adding to content 8-20
editing titles 8-20
overwriting 8-20
uploading 8-19
viewing 8-20

items
actions that can be performed 8-4

permissions 8-4
quicklinks
adding to content 8-21
viewing 8-21

search results
include images 8-9, 9-100
text only 8-9, 9-100

searching 8-6
license key
modifying 2-29

lifecycle, content block 2-6
lightweight, flexible menu sample 9-171
link checker 7-129
links, bad, report 7-720
list
flexible menu sample 9-172, 9-172

list summary
ASP 27-222, 27-237
example 27-224, 27-238
variables 27-225, 27-241
maxnumber 27-228, 27-242
order by 27-227, 27-241
recursive 27-225, 27-241
show info 27-228
show summary 27-226
starting folder 27-225, 27-241
style info 27-226

ASP.Net 9-266
ColdFusion 27-284, 27-286
example 27-285, 27-286, 27-286
format 27-284, 27-286

PHP 27-309
example 27-309
format 27-309
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ListSummary, compared with col-
lection andmenu

9-
3

load balancing 8-22
assets 22-3
setting up 22-4

introduction 22-1
library imagesand files 22-2

lock
discussion boards 7-582
discussion forum 7-590

locked user account, unlocking 2-23
locking out a user 2-23
login
ASP 27-199
example 27-200
placing 27-201

ASP.Net 2-10
placing 2-11

attempts, disabling 2-23
ColdFusion 27-279
example 27-280

Facebook See Facebook, login
images, changing 2-24
locking out a user 2-23
PHP 27-304
example 27-305

preventing all users from 2-24
preventing CMSusers from 2-24
procedure for CMS400.NET 2-8
restricting number of attempts 2-22

M

Macromedia Extension Package 27-3
managed files
creating 7-429
deleting 7-431
editing 7-430
importing one 7-429
overview 7-428

mapped network folder
addingOffice documents 7-416
drag and drop assets 7-418
editing Office document 7-421
language restrictions 7-416
removing 7-419
setting up 7-416
viewing files 7-419

marked for deletion, content
status

7-130, 7-
135

mashups
calendar
web 7-569

master lay-
out

See PageBuilder, master lay-
out

master
zone

See PageBuilder, master
zone

maximum summary size, setting 2-29
membership
ASP.Net 16-19

membershipmodule
accessing 16-5

membership user
groups

16-11, 16-11, 16-14,
16-18

adding 16-12
adding users 16-12
deleting 16-13
deleting users 16-13
name, editing 16-13
viewing users 16-12

membership users
activating 23-30
adding 16-6
deleting 16-11
editing 16-10
permissions, assigning 16-14
unverified, confirmationmessage 23-

29
unverified, viewing 23-30
viewing 16-9

menus
accessing 9-134
add new content block via navi-
gation link

9-
150

adding new
via content folder 9-138
viaMenusmodule 9-142

appearance
to content contributor 9-133
to site visitor 9-133

assigning users permission to edit
via the Roles screen

15-
32

compared with collection and List
Summary

9-
3

creating
in any language 9-160

definition 9-133
deleting 9-156
editing 9-151
via content folder 9-151
viamenusmodule 9-151
via navigation link 9-152

items
adding
content blockas 9-147
external hyperlink as 9-149
library asset as 9-148
submenu 9-149
via content folder 9-143
viamodules folder 9-145
via navigation link onWeb
page

9-
146

definition 9-134
deleting
via content folder 9-157
viamenusmodule 9-157

rearranging 9-155
multi-language issues 9-158
permissions 9-135
structure 9-134
submenu, definition 9-134
template link field 9-142
translating 9-158
URL link field 9-141
viewing
via content folder 9-153

viamenusmodule 9-154
via navigation link 9-155

message board
comments, appearance 16-70
comments, approving 16-71
comments, authorization to sub-
mit

16-
69

comments, deleting 16-72
comments, replying 16-73
moderating 16-69
users authorized 16-70

notification of postings 16-75
on sample sites 16-68
replies, authorization to submit 16-69
server control 16-67
properties 16-77

spam filtering 16-75
messages
eCommerce 17-81

meta tags 7-142
metadata
adding to content 7-161
ASP 27-263
creating item list 27-264
dynamic 27-267
example 27-264
format 27-263
variables 27-267
item list 27-267
spare 27-269

assigning to a folder 7-159
ColdFusion 27-296
format 27-296

definition fields 7-153
definitions
adding 7-151
converting style 7-156
deleting 7-159
editing 7-158

Dublin Core 7-149
impact of folder inheritance 7-161
inheritance from parent folder 7-161
making publicly viewable 7-155
meta tag additional fields 7-153
PHP 27-319
format 27-319

property definitions, viewing 7-158
related content
compared with MetadataList
server control

7-146,
7-147

requiring users to enter 7-160
response field style 7-155
search data
adding to content 7-159

micromessaging book-
marklet

See book-
marklet

Microsoft Office
documents

See also document man-
agement feature

adding via Add Assets button 7-410
adding via DMSDocument
Option

7-
408

adding viamapped network
folder

7-
416



adding viaMultiple DMSDoc-
uments option

7-
409

checking out 7-423
compatability pack 7-405
deleting 7-422
editing in mapped network folder 7-421
editing in Office 7-420
importing 7-405
naming 7-407
prerequisites 7-404
publish asPDF 7-445
replacing 7-423
saving 7-424
saving in html format 7-425

MicrosoftWindows
Indexing Service

See indexing serv-
ice catalog

MIME types, seemultimedia assets 7-440
moderatingmessage board 16-69
most popular widget 7-759
determiningmaximum number of
results

7-
762

determining which content
appears

7-
760

editing properties 7-763
information source 7-761

move content 7-110
multi-language content
approval chains 14-24
creating new content 14-9
creatingWeb pages in several lan-
guages

14-
27

default language 14-8
determining available languages 14-6
disabling a language 14-8
enabling/disabling 14-4
introduction 14-1
language export
introduction 14-14

setting upWeb site 14-26
spell checking 14-30
translating content 14-10
bymachine 14-11

translation files
importing 14-20

viewing site in another language 14-4
working with calendars 14-25
working with menus 14-25, 14-26
working with tasks 14-25

multi-languagemenus 9-158
multimedia assets
addingMIME types 7-440
adding players for aMIME type 7-440
changing file properties 7-442
changing style properties 7-444
file types supported 7-439
importing into CMS400 7-441
inserting into content 7-442
listening to 7-444
overview 7-438
replacing 7-443
viewing 7-444

multimedia players
changing supported 7-441
downloading 7-439

supported 7-439
Multiple DMSDocuments option 7-409

N

network folder
mapped
addingOffice documents 7-416

noise files 9-63
notifications
displaying in activity stream
widget

16-
175

message board postings 16-75

O

object tag support 7-67
Office doc-
uments

SeeMicrosoft Office doc-
uments

orders, eCommerce 17-189
organizational unit, LDAP, adding 15-83

P

packages
eCommerce 17-87

PageBuilder
code samples 5-37
dropzone user control
customizing 5-41
letting users add columns 5-42
letting users resize 5-42
set columnwidth pro-
grammatically

5-
42

master layout
asigning to pages folder 5-33
creating 5-30
overview 5-28
using to create new page 5-33

master zone 5-28
changing to layout zone 5-35
setting dropzone to 5-31

menu control
changing cache interval 5-41
customizing 5-40

overview 5-1
page
create 5-17
place widgets 5-19
steps to creating 5-7

wireframe
assign to folder 5-14
assigning custom taxonomy to 5-45
assigning default page to 5-43
creating 5-7
customizing 5-43

workflow 5-5
passwords
making case sensitive 2-25
setting for user 15-4

payment gateway 17-61

PDF
generation
destination folder, designating 7-448
disabling 22-9
enabling/disabling 7-447
local 7-447

publishing Office documents as 7-445
pending deletion, content status 7-130
pending go live date, content status 7-130
pending start date content 7-136
permissions
advanced 4-44
assigning to community folders 16-111
assigning to content block 4-48
assigning tomembership users 16-14
collections 9-118
document management feature 7-436
folder, setting 4-44
inheritance
breaking 4-42
restoring 4-42

list of 4-43
menus 9-135
standard 4-43, 4-43, 4-43
table
accessing 4-45
adding user or group 4-47
deleting user or group 4-48
editing user or group 4-47

task 12-2
to workwith HTML forms 7-213

personalization
introduction 9-300

photo gallery
adding photos 16-55
copying photos 16-58
deleting photos 16-59
moving photos 16-58
saving photo to computer 16-61
server control 16-52
server control, adding categories 16-53
server control, deleting categories16-55
sharing photos 16-60

PHP
custom functions 27-300
include file 27-301

poll server control 7-274
polls
creating 7-264
creating inWorkarea 7-266
editing fromWeb site 7-268
replacing fromWeb site 7-267

postal tax table, eCommerce 17-97
preserveMSWord
classes 2-30
styles 2-30

preview
button, Add Content screen 7-18
site 2-9

pricing. tier, eCommerce 17-135
private content 7-184
privatemessage
send from social bar control 16-238

privileges, administrator, list 15-37
product types, eCommerce 17-103
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properties
content 7-13

publish
button, Add Content screen 7-18
content to web site 4-34

purge history 4-26

Q

quicklinks
adding to content 8-21
definition 8-2
using for a collection 9-108
viewing 8-21

R

ranking users, for discussion
boards

7-
591

recurring
web calendar events 7-541

referrers
businessanalytics reporting 7-754

regional tax table, eCommerce 17-99
regions, eCommerce 17-52
relevance tab
data designer group box field 7-303

remove XSLT fromXML content
block

7-
118

replies
message board
authorization to submit 16-69

reports
bad links 7-720
content
approving content from report 7-707
awaiting approval 7-706
checked in content 7-708
checked out content 7-709
content to expire 7-714
declining content from report 7-707
editing content blocks 7-704
expired content 7-714
new 7-710
pending start date 7-712
refresh reminder 7-713
sorting and filtering 7-703
submitted 7-711
viewing content blocks 7-704
workflow
emailing 7-704
selecting content by folder 7-701

folder, accessing 7-698
site update activity 7-716

resource selector field
adding 7-347
appearance options 7-351
data designer 7-343
examples 7-344
how content author adds content7-348

how content author adds con-
tentresource selector field
how content author adds folder 7-

354
overview 7-343

restart
button 2-33
indexing service 9-16

restoring content 7-115, 7-125
retrieving XML structure of content 7-201
roles
alias edit screen 15-32
business rules screen 15-32
calendar admin screen 15-32
community group admin 15-33
community group create 15-33
custom permissions 15-34
defining 15-31
folder user admin screen 15-34
metadata admin screen 15-33
permission to workwith col-
lections

15-
32

permission to workwith menus 15-32
screens 15-31
task create screen 15-33
taskdelete screen 15-34
task redirect screen 15-34
user admin screen 15-34, 15-34
XLIFF admin screen 15-34

rotating image within eWebEdit400 7-58
RSS
discussion board forum output 7-630

rulesets See business rules, rulesets

S

scheduling content 7-187
screen height, adjusting 2-32
screen width, adjusting 2-32
search
ASP 27-210
examples 27-212
variables 27-213
button image source 27-215
button text 27-216
font color 27-217
font face 27-216
font size 27-217
horizontal 27-218
maximum characters 27-215
spare1 27-219
starting folder 27-213
target page 27-214
text box 27-214

ASP.Net 9-72
catalog and index files 9-7
catalog, recreating 9-9
ColdFusion 27-283
example 27-283
format 27-283

content folder 9-89
library 8-6

PHP 27-307
example 27-308, 27-308
format 27-307

phrase report 7-719
Web site
advanced 9-28
basic 9-26
basic, multiple terms 9-27
boolean operators 9-64
free text queries 9-66
overview 9-5
property value queries 9-67
proximity operators 9-64
query language 9-62
rankdefined 9-32
vector space queries 9-66
wildcards 9-66

search data
configuration screen 9-8, 9-11
definitions
viewing 7-158

search data configuration screens 9-13
search display
ASP 27-219
example 27-219
variables 27-220
max returns 27-220
show date 27-222
style info 27-221

with default content 27-220
ColdFusion 27-284
example 27-284
format 27-284

PHP 27-308
format 27-308

search screen
noise files 9-96
specifying
kind of content to search 9-95
match criteria 9-96
word or phrase 9-96

searchable properties
adding to content 7-161
definitions
adding 7-151
deleting 7-159
editing 7-158
HTML tag additional fields 7-153
meta tag additional fields 7-153
searchable additional fields 7-155
searchable property fields 7-153

making publicly viewable 7-155
response field style 7-155

security certificates, eSync 18-43
selected colleague
designating 16-37

server controls
assetcontrol 7-466
bookmarklet 16-205
community group list 16-101
community groupmembers 16-106
community group profile 16-92
favorites 16-45
flexible menu 9-166
formblock 7-271
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